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Chapter 1
SailWind Layout QuickStart

Welcome to SailWind Layout, a powerful yet easy to use printed circuit board layout application.

PCB Layout Quickstart

PCB Layout Quickstart
SailWind Layout provides the tools you need to lay out your PCB design, from creating a decal library for 
your components to generating output for fabrication.

To get started quickly, click on any of the topics.

• Create a library for your decals (footprints)

◦ Creating a New Library

• Add decals to your parts:

◦ Create decals for your parts  on page 160

◦ Assign a decal to a part type (Netlist project)  on page 235

• Import the schematic design:

◦ Import a netlist  on page 249

• “Set up the PCB layer structure”  on page 315

• Create vias for routing

◦ Creation of vias  on page 330

• Create a board outline  on page 261

• Set up design rules or constraints

◦ Creation of Rules for Your Design

• Set grids  on page 352

• Place parts  on page 473

• Route traces  on page 699
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• Check for rules violations  on page 883

• Annotate the design  on page 916

• Generate reports  on page 856

• Output the design  on page 934
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Chapter 2
User Interface

The SailWind Layout interface contains standard menus and buttons for accessing commands and 
settings.

User Interface Elements
Panning Overview
Zooming Overview
Design Origin and Workspace
Redraw of the Display
Cycling Through Design Views
Saving and Restoring a View
Software Launch Options
Adding Start-up Options to a Shortcut
Disabling Check for Updates
Typing Modeless Commands
Project Explorer
Output Window
The Status Tab
Changing the Default Text Editor
Locked Files
SailWind Layout Default Settings
Software Interface Customization
Window Placement
Transparent View Mode
Outline View Mode
Bottom View
Fonts

User Interface Elements
The SailWind Layout interface elements are described below.

Note:
Pictures in this document are for reference only, to help users better understand the software 
operation. In the case of interface difference due to version changes, the interface of SailWind 
Layout in practice shall prevail.
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Figure 1. Main Interface

Table  1. GUI Elements

Elements Description

Title Bar The application icon, document name, and application name 
appear on the title bar. Click the application icon to open the 
Windows-standard control menu, which contains commands for 
working with the application window.
The document name changes to reflect the state of the current 
document. For example, when no design file is loaded “Untitled 
- SailWind Layout” appears as the document name. When 
a design file is loaded, the path, the file name, and the file 
extension (.pcb) appear on the title bar.

Menu bar The menu bar lists SailWind Layout commands. The menus 
also show the appropriate command icons, access keys, and 
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User Interface Elements

Table  1. GUI Elements  (continued)

Elements Description
shortcuts. When a command ends with ellipses (...), additional 
information is needed to complete the command.

Standard Toolbar The Standard toolbar contains commands that open and save 
designs, change the view, redraw, and access the Drafting, 
Design, Dimensioning, ECO, and BGA toolbars.

Work Area The area in which you enter all design information is called 
the work area or the workspace. The work area contains two 
editors: the Layout editor and the PCB Decal editor. The Layout 
editor appears when you open SailWind Layout. You can place, 
route, and otherwise modify your board in this editor. The PCB 
Decal Editor is an editor that you start (through the Tools menu) 
where you can create or edit a decal.
The maximum work area is a 56 by 56 inch square. You can 
measure it in inches, mils, or metric units. Set the units of 
measure in Global Options. The work area is divisible by an 
X,Y, or horizontal and vertical grid, which you can set to a 
minimum of .00001" between points. You can set the X and Y 
values separately. This is called the Design Grid on the Grids 
tab of the Options dialog box.

Status Bar The status bar displays a command name or information on a 
selected connection, route, or component. The layer on which a 
selected trace exists appears on the status bar.

System Status Indicator The system status indicator shows the processing state of the 
application in the upper left corner of the work area. It appears 
green when the system is idle or ready for operation, and red 
when the system is unavailable either because the system is 
processing or the work space cannot receive user input, such 
as when in CAM.

Point of Origin The 0,0 coordinate location. X,Y coordinates are calculated 
from this point. When you create a new file, the default drawing 
format is centered at medium magnification in the work area 
with the origin, or the 0,0 point, in the lower left corner. The 
origin appears as a large white dot. As you move the cursor, 
its position relative to the origin appears in the X,Y Coordinates 
area. The numbers change in multiples of the design grid.

Layout-Router Synchronization 
Mode Indicator

Displays whether SailWind Layout and SailWind Router are 
in Synchronization mode. Also indicates which program is 
the active one versus the inactive one or whether the inactive 
program is out of sync.

Trace/Line Width Displays the current line width setting.

Design Grid X,Y Spacing Displays the setting of the Design grid. When you move an 
object or use a drafting command, the grid readout is replaced 
by a Delta X and Y reading, calculated from the cursor selection 
point when the command starts. Negative numbers indicate left 
and down.
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Table  1. GUI Elements  (continued)

Elements Description

X,Y Coordinates Displays the horizontal distance of the cursor from 0,0 as the 
x-coordinate. Also indicates the polar radius if you are using a 
polar grid.
Displays the vertical distance of the cursor from 0,0 as the 
y-coordinate. Also indicates the polar angle if you are using a 
polar grid.

Units Displays the current units used in the design (mils, millimeters, 
inches).

Panning Overview
The are many ways to pan around your design. Use the middle mouse button or the middle mouse wheel 
as the most efficient ways to pan.

• Center the view based on the pointer location  — Point in the workspace to where you want to 
locate the new center of the view and middle-click or press the Insert key. The screen repaints the 
design with the point you chose at the center of the screen.

• Dynamically pan in the workspace  — Hold down the Alt key and the middle mouse button 
and drag the pointer in the direction you want to move. When the design is in the spot you want, 
release the middle mouse button.

• Move the view based on a miniature representation of the design area  — In the Status 
window  on page 1733 click on the design representation to center the view and pan to that area.

• Scroll vertically and horizontally  — Use the pointer and the scroll bars, or use the mouse 
wheel for vertical scrolling and press the Shift key while you use the wheel for horizontal scrolling.

• Move the view one-half screen horizontally or vertically  — Turn on the NumLock and use the 
arrow keys on the number pad.

• Move the view one grid unit horizontally or vertically  — Use the arrow keys with NumLock 
Off.

Zooming Overview
The most efficient way to zoom is using the middle mouse button. There are also shortcuts to zoom to the 
board outline, the extents of all design items, or a selected item.

There are many ways to zoom:
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Zooming Overview

• Zoom to the board outline  — Press Ctrl+B, or on the Standard Toolbar click the Board  button, 
or on the View menu click Board, or press the Home key. This zooms to and centers the board 
outline in the workspace.

• Zoom to the extents of all design items  — Press Ctrl+Alt+E, or on the Standard Toolbar click 
the Extents  button, or on the View menu click Extents. This zooms to fit all objects, including 
those outside the board outline, into the workspace.

• Zoom to the selection  — Select a design object and press Alt+Z, or on click the View  > 
Selection  menu item. Any object you select becomes centered in the view of the workspace.

Alternatively, in the Project Explorer window, right-click and click the Zoom to Selection  popup 
menu item. Then click a component, PCB decal, or net in the Project Explorer. In the Project 
Explorer, the right-click > Allow Selection  popup menu item must be selected in order for the 
Zoom to Selection feature to work. If either of these options already have a check mark, and you 
click them again, you turn them off.

• Zoom in to a defined area with the middle mouse button  — Move the pointer to the center 
of the desired zoom area. Hold down the middle mouse button and drag the pointer diagonally 
up across the design, indicating both the horizontal and vertical limits of the bounding box that 
defines your next view. When the area want to magnify is within the bounding box, release the 
mouse button. The zoom-in ratio also appears with the cursor.

Alternatively, instead of zooming from the center as in the above, you can also zoom from the 
corner by holding down the Shift key while you drag the pointer with the middle mouse button.

• Zoom out of a defined area with the middle mouse button  — Move the pointer to the center 
of the desired zoom area. Hold down the middle mouse button and drag the pointer diagonally 
down across the design, indicating both the horizontal and vertical limits of the bounding box that 
defines your next view. The box in the center represents the current view size. The outer box that 
expands from the center box represents the new view size in proportion to the old. The zoom-out 
ratio also appears with the cursor.

Alternatively, instead of zooming from the center as in the above, you can also zoom from the 
corner by holding down the Shift key while you drag the cursor.

• Zoom in and out with a two button mouse  — On the Standard Toolbar, click the Zoom  button. 
This button is a toggle. The left mouse button now functions like a middle mouse button (see 
instructions earlier in this topic) allowing you to define an area for zooming. You can also place 
the pointer at the desired view center and click the left mouse button to zoom in, or click the right 
mouse button to zoom out. Click the Zoom  button or press the Esc key to exit zoom mode to 
return the mouse to its normal functionality.

• Zoom using the mouse wheel  — Press and hold the Ctrl key as you rotate the wheel button.

• Zoom using the keyboard  — To zoom with a defined area, press the 5 key on the numeric 
keypad with NumLock on. This puts the pointer in zoom mode like holding the middle mouse 
button. To zoom in at the pointer, press the Page Up key on the numeric keypad. To zoom out at 
the pointer, press the Page Down key on the numeric keypad.
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Design Origin and Workspace
The design space measures 56 inches X 56 inches. New designs begin with the design origin located at 
the -18”, -18” of the overall workspace. With the origin at this point in the workspace, it is helpful to keep 
the origin at the lower left of your board outline. Otherwise, you can change the location of the design 
origin within the workspace.

When you change the location of the origin, you receive a message that references the new location 
based on the old origin location and also provides coordinates in parenthesis based on the centerpoint 
of the workspace. By displaying your origin location based on the design space centerpoint, you can 
determine by the size requirements of your board whether you will reach the limits of the design space 
based on the placement of your design origin. From the workspace centerpoint, you have from -28” to 
+28” on both the x and y axis.

Setting the Origin by Click
Setting a Precise Origin Location

Setting the Origin by Click
Use the pointer to set the origin location for the design.

Procedure
1. Setup  > Set Origin.

2. Click where you want the new origin to be. You are prompted to accept the new origin and are 
given the coordinates of the new origin location based on the grid of the original origin.

Tip
The message also displays coordinates in parentheses, of the new origin location based 
on the centerpoint of the workspace.

Related Topics
Design Origin and Workspace

Setting a Precise Origin Location
If you want a more precise location, you can set the origin to any of the following: a component origin, a 
pin, a drawing corner, a via, text, the center of a circle, or a line (or arc) Intersection.

Procedure
1. Select the object with the point you want the new origin to be.

2. Click the Setup  > Set Origin  menu item. Alternatively, you can use the SO Modeless commands 
on page 83. The SO modeless command also allows you to set the origin to absolute 
coordinates of the design space.
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Redraw of the Display

Related Topics
Design Origin and Workspace

Redraw of the Display
Occasionally, fragments or an outline of an object might appear where the object no longer exists. If 
you see remnants of objects that you have moved, or you see lines where there are actually no design 
objects, you can force a complete full screen redraw from the video card. On the Standard Toolbar, click 
the Redraw  button.

Cycling Through Design Views
Each time you change the view of your design workspace, SailWind Layout records the view. You cycle 
back and forth through views that you have created by panning and zooming the workspace.

Procedure
1. Change the view of the workspace.

2. To return to the previous view, click the View  > Previous View  menu item.

3. To restore the original view, click the View  > Next View  menu items.

Related Topics
Saving and Restoring a View

Saving and Restoring a View
If you are frequently viewing an area of your design, you can save a view of the design area and quickly 
restore it instead of panning and zooming to the view every time. You can save up to nine views. The 
ability to save views is not available in the PCB Decal Editor.

Procedure
1. Pan to and set the zoom level of the view you want to save.

2. Click View  > Save View. The Save View Dialog Box  appears.

3. Click Capture.

4. In the Capture a New View box, type a name and click OK.

Results
The view names appear at the bottom of the View menu for quick selection. You can also click View  > 
Save View  to revisit the views that you captured, and then manage the list of views. You can delete ones 
that are no longer useful. The Save View dialog box displays the current view as a blue square in the 
miniature representation of the design area. Any selected view names are displayed as red squares.
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Software Launch Options
You can use software launch options, known as command line switches, to control the initial SailWind 
Layout configuration. These switches can open a file, start macros, and record a SailWind Layout 
session. You can use multiple command line options.

You add command line switches to the Start menu shortcut. See “Adding Start-up Options to a Shortcut”.

Table  2. SailWind Layout Command Line Options

Option Description

full path to a file Opens the specified design file when you start SailWind Layout. Type the full 
path. Do not use a forward slash ( / ) before the file name in the command line. 
Use double quotation marks for folders or file names with spaces. For example:

“SailWind_Folder\SailWind version\Samples\preview.pcb”

Note:  SailWind_Folder is the root directory of SailWind; version indicates the 
software version.

/BMW[=initials] ( [ ] represents optional text.)
Opens the Basic Media Wizard. Note the capitalization. Use the Basic Media 
Wizard to start recording a session log or to convert the previous session log to 
media that can be replayed by Basic Log Test.
For example, type /BMW or /BMW=xx, where xx is your initials, in the command 
line. To create session media files for the current SailWind Layout session, use 
the BMW modeless command  on page 83. This option is associated with the 
BLT modeless command. BLT is the Log Test; it finds and runs the session media 
created by BMW to play back a recorded SailWind Layout session. For more 
information, see “Typing Modeless Commands”.

/dotest Runs the integrity test on every file that you open.

/l Opens the last file you had open when you start SailWind Layout.

-log:<full path> Records your software session as a macro file in the specified location.
Make sure to type a space between ..\SailWindPCB.exe  and the -log command. 
Use double quotation marks for folders or file names with spaces. For example:

-log:“C:\SailWind Projects\mymacro.log”

/M<macro file> Specifies the file to use as the default macro file. Note the required capitalization 
of M. Macros must be located in the \SailWind Projects  folder.
/m<macro name> — Runs the specified Sub procedure or Function procedure 
macro within the default macro file specified with the /M command. For 
example, to run the macro SubMacro contained in the file user1.mcr, 
type /Muser1.mcr /mSubMacro.
If you need to launch a macro at software launch that is not located in the 
\SailWind Projects  folder, see the /run command line option.

/nc Starts SailWind Layout without displaying the splash screen that includes 
copyright information.
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Table  2. SailWind Layout Command Line Options  (continued)

Option Description

/NTL Disables true layer associations. Note the required capitalization of NTL.
When you use Flip Side, the layer attributes will not move to the new layer with 
the component. TrueLayer is enabled by default and moves layer definitions with 
a part that is placed on the opposite side of the board.
Parts are built specifying the generic “Mounted Side” and “Opposite Side” layers 
for electrical objects and more specific layers for documentation objects. For 
example, a surface mount decal’s pads are placed on the generic Mounted Side 
layer, while the silkscreen information is placed on the more specific Silkscreen 
Top layer.
By default, this TrueLayer feature is enabled and when you move a surface 
mount component from the top layer to the bottom layer in your design, any 
documentation information you placed on the Silkscreen Top, Solder Mask Top, 
Paste Mask Top, and Assembly Drawing Top layers are automatically flipped 
and associated with the Silkscreen Bottom, Solder Mask Bottom, Paste Mask 
Bottom, and Assembly Drawing Bottom, without needing to redesign the part to 
be a bottom mounted part or needing to design both a top mount and bottom 
mount component.
For more information, see “TrueLayer and Layer Association”.

/run=[full path] Runs the specified macro when you launch the software. Make sure to type a 
space between "SailWindPCB.exe" and the "-run" command. When there are 
spaces in paths or file names you must use double quotes around the full path. 
For example:

/run=“C:\SailWind Projects\Samples\mymacro.mcr”

/s<full path> Starts a Basic script when you start SailWind Layout. Use double quotation marks 
for file names with spaces. For example:

/s“C:\SailWind Projects\Attributes to Excel.bas”

Adding Start-up Options to a Shortcut
You can add various start-up options to the properties of a shortcut, such as starting up SailWind Layout 
with a specific project already opened.

Tip
If you create your own shortcuts, copy the Start menu shortcuts instead of generating ones from 
the executables in the install directory. Start menu shortcuts contain a “wrapper” that allows the 
proper environment variables to be defined as the program launches.

Procedure
1. In the shortcut properties, click in the box with the pathname.

2. Press the End key, press the Spacebar key, and then type the command line switch you want to 
use. Enclose with double quotes " " each string that contains a space. When specifying a file to 
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start, do not use a / before the file name. You can specify multiple command line switches. For 
example, to start the program with preview.pcb, the command line might read:

“\<install_folder>\<version>\Programs\SailWindPCB.exe” “C:\SailWind projects\Samples
\preview.pcb”

Related Topics
Software Launch Options

Disabling Check for Updates
If you do not want to automatically check to see if there is a new version available, you can disable the 
Check for Updates feature. You can enable the check at any time in the future, or you can manually check 
for updates at any time.

Procedure
1. Click the Help  > Check for updates  menu item.

2. In the Check for Updates Dialog Box, select the Disable “Check for Updates” functionality check 
box.

Typing Modeless Commands
You can set or change some settings and apply commands at any time using an abbreviated command 
in a pop-up window command line. Many of the modeless commands duplicate menu commands and 
Options settings. There are also many modeless commands that activate unique commands that cannot 
be accessed anywhere else.

Procedure
1. Type the modeless command  on page 83 for the command you want. Use a space between the 

command and the argument. For example: N GND or GD 50.

2. Press the Enter key.

Related Topics
Modeless Command Dialog Box

Keyboard Shortcuts
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Project Explorer
The Project Explorer shows a hierarchical structure for design layers, components, PCB decals, and nets. 
When you update your design, the hierarchical structure of the Project Explorer automatically reflects the 
changes. Open a design to access its hierarchical structure of components, PCB decals and nets. The 
Project Explorer is not available in the PCB Decal Editor.

You can use the Project Explorer to interact with objects in the design:

Selecting Design Objects Using the Project Explorer
Zooming to a Design Object Using the Project Explorer

Selecting Design Objects Using the Project 
Explorer
You can set up SailWind Layout so that selecting a design object in the Project Explorer automatically 
selects it in the workspace as well.

Procedure
1. If the Project Explorer window is not open, on the Standard Toolbar, click the Project Explorer 

Window  button.

2. In the Project Explorer window, right-click.

3. Make sure the Allow Selection  popup menu item is checked. If needed, click Allow Selection  to 
check it.

4. In the Project Explorer hierarchy, select a design object (component, PCB decal, net). It also 
selects in the workspace.

Zooming to a Design Object Using the Project 
Explorer
You can set up SailWind Layout so that it zooms in on a design object in the workspace when you select 
the corresponding design object in the Project Explorer.

Procedure
1. If the Project Explorer window is not open, on the Standard Toolbar, click the Project Explorer 

Window  button.

2. In the Project Explorer window, right-click.

3. Make sure the Zoom to Selection  popup menu item is checked. If needed, click Zoom to 
Selection  to check it.

4. In the Project Explorer hierarchy, select a design object (component, PCB decal, net). The entire 
workspace view displays the selected object.
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Output Window
Use the Output Window for displaying reports and session logs, macro editing, and debugging.

The Output Window is located in the bottom section of the display window. You can dock or float, and 
display or hide the Output Window.

See the following for more information on the tabs of the Output Window:

• The Status Tab

• The Macros Tab
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The Status Tab
The Status tab displays information on the current session. You can use the Status tab to work with HTML 
documents. Although it is not a Web browser, you can use it to open Internet Web pages that any links 
reference.

If the Status tab is closed, and you get an error while performing tasks, the output window automatically 
opens with the Status tab active.

Use the Status tab to:

• Record, display, and print the session log.

• Print and display report files.

• Print and display web pages.

• Open program files.

A software session status log, which appears in the Status  tab of the Output window, contains all 
program output for the current session, including names of opened and saved files, integrity test results, 
and messages.

The default path for the session log comes from the .ini  file entry FileDir=C:\SailWind Projects.

The status log presents different types of information in different colors. Text color representations are 
shown in the following table:

Table  3. Status Log Text Color Representations

Color Meaning

Red Errors

Green Warnings

Black Messages

Blue Links to files, Web pages, and database objects. These items 
are also underlined.

Page Navigation in the Status Tab
Filtering the Messages in the Status Tab
Searching Text in the Status Tab
Printing Status Log Messages
Reports Inside the Status Tab

Page Navigation in the Status Tab
Instead of reports opening in your default text editor, you can set up SailWind Layout so they can open 
and display them inside the Status  tab like new pages in a web browser. Using the toolbar buttons, you 

SailWind Layout Guide and Reference 55



User Interface
Filtering the Messages in the Status Tab  
can navigate to the previous page, the next page, and refresh a display of reports and other pages. You 
can also stop updates to pages, and return to the status log display.

To perform these functions, use the following Status  tab toolbar buttons:

Table  4. Status Tab Navigation Toolbar Buttons

Button Description

Back Displays the previous page.

Forward Displays the next page.

Stop Stops page updates.

Refresh Refreshes the display of reports and other pages.

Home Returns to the session status log.

Filtering the Messages in the Status Tab
You can choose which types of messages to display in the status log of the Output Window.

Procedure
1. Right-click in the log area of the Status  tab, point to the Filter  popup menu item, and on the popup 

submenu, click to place a check beside any one or combination of the following items:
Table  5. Filter Popup Submenu Items

Menu Item Description

Message Displays messages (black text)

Warning Displays warning messages (green text)

Error Displays error messages (red text)

Show all Displays all messages types (error, warning, and message).

Tip
Check marks indicate which message types are turned on for viewing in the log.

2. Click a checked menu item to clear the check and filter the log removing the display of those 
messages. Those message types are hidden until they are displayed again. They are not deleted 
from the log.

Searching Text in the Status Tab
Similar to searching in a document, you can search text in the Status  tab. For example, after a long 
software session, you might want to look for a report from a previous state of the design. You can search 
for the report name instead of visually searching by scrolling through the log.
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Printing Status Log Messages

Procedure
1. In the Output Window, in the Status  tab, click the Search  button.

2. In the Find dialog box, type the text you want to find and set any other options if required. The 
search begins as soon as you start typing a word and scrolls through the log to the first occurrence 
of the work, highlighting the word.

3. If the search does not immediately find the correct occurrence of your search, click the Next  or 
Previous  buttons to cycle through the occurrences.

4. When finished, close the Find dialog box.

Printing Status Log Messages
You can print a hard copy of the session’s status log for review purposes.

Procedure
1. In the Output Window, in the Status  tab, click the Print button.

2. In the Windows Print dialog box, set options as needed.

3. Click the Print  button.

Reports Inside the Status Tab
The session status log contains links to reports that you can view and print. Links appear in blue, 
underlined lettering. While most reports open in your default text editor, you can design some reports to 
open within the Status  tab.

If you click a link and a report opens in the Status  tab instead of your default text editor, you must use the 
Home  button to return to the status log. For more information, see “Page Navigation in the Status Tab”.

To print a report that appears in the Status  tab, follow the same instructions for printing the status log. For 
instructions, see “Printing Status Log Messages”.

Changing the Default Text Editor
Reports open in the default text editor. You can change the default text editor used with SailWind Layout 
by changing the “Editor” entry in the SailWindpcb.ini  file.

If you choose Notepad as the default text editor, longer files may not be loaded because of size 
constraints in Notepad.

Procedure
1. Open the SailWindpcb.ini  file in a text editor. By default it is located in the following folder —C:

\<install_folder>\<version>\Settings.

2. In the [general] section, specify a new text editor executable name after “Editor=”. Include the drive 
and folder if the new editor is not in your Windows folder.

3. Save the .ini  file and close the text editor.
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Locked Files
The SailWind products help you avoid making changes to a file that another user has already opened. 
The first user to open a file in a shared location becomes the owner of the file for the duration the file is 
open; the file locks out all other users. If you try to open a file that someone else has already opened, you 
get a warning message letting you know the current owner and the name of the computer from where the 
file is locked.

You have the option to view a read-only version of the file, but you will not be able to update it while the 
owner still has it open. You can save the file with another name using the File  > Save As  menu item.

SailWind Layout Default Settings
The default system and design settings (Options, Colors, Rules, Layer stackup, Vias, CAM, and 
Attributes) are preset by the default.asc  and decaledt.asc  files. The file default.asc  contains design mode 
settings, and the file decaledt.asc  contains decal editor mode settings.

You can create your own start-up file to customize the software launch defaults. For more information, see 
“Creating Start-up Files”.
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Software Interface Customization
You can customize the software interface to suit your work style and design work. You can determine 
which toolbars to display, add items to toolbars and menus, and create custom toolbars, menus and 
shortcut keys.

Your customizations are saved with your current workspace so that all of the changes you make to 
toolbars, menus, and shortcut keys are present when you work in that workspace again.

Toolbar Customization
Command and Menu Customization
Toolbar and Menu Content
Shortcut Key Customization
Screen Appearance
Setting the Interface Language
Resizing the Layers List
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Toolbar Customization
Click the Tools  > Customize  > Toolbars and Menus  tab to create custom toolbars and shortcut menus.

For related information, see “Moving or Copying Menu Commands”.

Tip
To create a custom main menu, use the Commands  tab on the Customize dialog box.

See the following subtopics for more information:

Creating a Custom Toolbar
Showing or Hiding a Toolbar
Deleting a Custom Toolbar
Renaming a Custom Toolbar
Resetting Toolbars to Defaults

Creating a Custom Toolbar
Create a new empty toolbar and add items (commands) to it.

Procedure
1. On the Tools menu, click Customize. The Customize dialog box opens.

2. Create a new Toolbar:

a. In the Toolbars and Menus tab  on page 1220, in the Toolbars box, click the New  button .

b. Type the name for the toolbar and click OK.

• The new (empty) toolbar appears on the software interface.

• The Toolbars and Menus  tab lists the new toolbar, showing it as selected and enabled for 
display (the check box to the left of its name is selected).

c. Drag the toolbar to where you want it on the software interface.

3. Add items (commands) to your new toolbar:

a. Click the Commands  tab.

b. In the Categories list, select a menu or toolbar name to display commands specific to that 
menu or toolbar, or select All Commands. If you are working in a special mode in SailWind 
Layout (for example, the Decal Editor), some categories of commands are not available for 
customization.

c. In the Commands list, select the command you want and drag it to the toolbar.

4. When you have finished adding commands to the new toolbar, click Close.
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Showing or Hiding a Toolbar

Related Topics
Deleting a Custom Toolbar

Toolbars and Menu Item Removal

Renaming a Custom Toolbar

Showing or Hiding a Toolbar
Increase space in the software interface by displaying the toolbars you need to use and hiding others that 
you do not use. You can also remove toolbars that contain tools that you do not use in favor of displaying 
custom toolbars containing those you use.

Procedure
1. Click the Tools  > Customize  menu item. The Customize dialog box opens.

2. In the Toolbars and Menus tab  on page 1220, in the Toolbars list, select the toolbar.

3. To display the toolbar in the interface, select the check box to the left of its name. Clear the check 
box to hide the toolbar.

4. Click the Close  button.

Tip
For information on other ways you can customize the appearance of toolbars and menus, 
see “Screen Appearance”.

Deleting a Custom Toolbar
You can remove or delete any toolbar that you customize. You cannot, however, delete a system toolbar.

Procedure
1. Click the Tools  > Customize  menu item. The Customize dialog box opens.

2. In the Toolbars and Menus tab  on page 1220, in the Toolbars list, select the toolbar.

3. Click the Delete  button.

Related Topics
Adding Items to Toolbars and Menus

Toolbars and Menu Item Removal

Showing or Hiding a Toolbar

Renaming a Custom Toolbar
You can change the name of any toolbar that you create (customize). You cannot, however, rename a 
system toolbar.
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Procedure
1. Click the Tools  > Customize  menu item. The Customize dialog box opens.

2. In the Toolbars and Menus tab  on page 1220, in the Toolbars list, select a custom toolbar.

3. Click the Edit  button .

4. In the Toolbar Name dialog box, type the new name and click the OK  button.

Related Topics
Showing or Hiding a Toolbar

Deleting a Custom Toolbar

Resetting Toolbars to Defaults
You can reset one or all system toolbars so that they display their default buttons.

Procedure
1. Click the Tools  > Customize  menu item. The Customize dialog box opens.

2. Click the Toolbars and Menus tab  on page 1220.

3. Reset one of the following:

• A single toolbar:

i. In the toolbars list, select the toolbar.

ii. Click the Reset  button.

• All system toolbars: In the Toolbars area, click the Reset All  button.
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Command and Menu Customization
You can customize commands and then add the commands to menus or as buttons on toolbars. You can 
also customize Menus.

See the following subtopics for more information:

Creating a Custom Command
Editing a Custom Command
Deleting a Custom Command
Creating a Custom Menu

Creating a Custom Command
You can create a custom command from a command that already exists as a menu item or toolbar button. 
To create this kind of command, select an existing command on which to base your new command then 
define the new command properties.

You can also create a custom command from a macro command file. For instructions, see “Adding 
Macros to Toolbars and Menus” in the SailWind Layout Command Reference.

Procedure
1. Click the Tools  > Customize  menu item. The Customize dialog box opens.

2. In the Commands tab  on page 1213, in the Categories list, click a menu or toolbar name to display 
items (commands) specific to that menu or toolbar, or click the “All Commands” list item.

If you made macro commands (on the Macro Files  tab) available as commands, the Categories 
list includes the Macro category and the Commands list includes the macros. For more information, 
see “Adding Macros to Toolbars and Menus” in the SailWind Layout Command Reference.

3. In the Commands list, select the command on which you want to base your custom command. 
Then, click the New  button.

4. In the Add command  on page 1050 dialog box, specify the properties of your new command:

a. In the Command name box, type the name of the command.

b. In the Description box, type a description of the custom command.

c. If an image was associated with the original command, click Use Default Image to use that 
same image with your custom command. Click Select User-Defined Image to use a different 
image, edit an image, or create a new image.

d. Click the OK  button to close the “Add command” dialog box and return to the Customize dialog 
box.

5. If you are finished with all customizations, click the Close  button.

Tip
To add the command to a toolbar or menu, click the command and drag it from the 
Commands list to the toolbar or menu.
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Related Topics
Adding Items to Toolbars and Menus

Adding Macros to Toolbars and Menus [SailWind Layout Command Reference Manual]

Resetting Toolbars to Defaults

Editing a Custom Command
SailWind Layout provides you with the ability to edit the commands you create (custom commands). You 
cannot edit system commands, however.

Procedure
1. On the Tools  menu, click Customize. The Customize dialog box opens.

2. In the Commands tab  on page 1213, in the Categories list, click a menu or toolbar name to display 
items (commands) specific to that menu or toolbar, or click All Commands.

3. In the Commands list, select your custom command and click the Edit  button .

4. In the Edit Command dialog box  on page 1050, change the properties of your custom command:

a. In the Command name box, type the name of the command.

b. In the Description box, type a description of the custom command.

c. If an image was associated with the original command, select Use Default Image to use that 
same image with your custom command. Click “Select User-defined Image” to use a different 
image, edit an image, or create a new image.

d. Click OK  to close the Edit commands dialog box and return to the Customize dialog box.

5. When you are finished with all customizations, click Close.

Deleting a Custom Command
You can remove or delete any command you create (custom commands). However, you cannot delete 
system commands.

Procedure
1. On the Tools  menu, click Customize. The Customize dialog box opens.

2. In the Commands tab  on page 1213, in the Categories list, click a menu or toolbar name to display 
items (commands) specific to that menu or toolbar, or click All Commands.

3. In the Commands list, select your custom command and click the Delete  button.

4. Click Close.

Creating a Custom Menu
You can create a new empty menu and then add items (commands) to it to create a custom menu.
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Creating a Custom Menu

Procedure
1. Click the Tools  > Customize  menu item. The Customize dialog box opens.

2. In the Commands tab  on page 1213, in the Categories list, click New Menu.

3. In the Commands list, select New Menu and drag it to the location you want.

• To create a top-level menu, drag the new menu to the Menu Bar.

• To create a submenu, drag it over an existing menu name.

4. In the interface, right-click over your new menu and click the Button Appearance  popup menu 
item.

5. In the Button Appearance Dialog Box, in the Button text field, type the name for the menu and click 
the OK  button. Leave the Customize dialog box open.

6. To add items (commands) to your new menu, click the Commands tab.

7. In the Categories list, select a menu or toolbar name to display commands specific to that menu or 
toolbar, or select All Commands.

If you are working in a special mode in SailWind Layout or SailWind Logic (for example, the Decal 
Editor in SailWind Layout), some categories of commands are not available for customization.

8. In the Commands list, select the command you want and drag it to the menu.

9. When you have finished adding commands, click the Close  button.
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Toolbar and Menu Content
You can modify the items on toolbars and menus.

See the following subtopics for more information:

Adding Items to Toolbars and Menus
Customizing the Appearance of New Toolbar and Menu Items
Moving or Copying Buttons Using the Customize Dialog Box
Moving or Copying Buttons Without the Customize Dialog Box
Moving or Copying Menu Commands
Toolbars and Menu Item Removal

Adding Items to Toolbars and Menus
You can customize toolbars by adding new buttons and you can customize menus by adding new 
commands.

Procedure
1. Click the Tools  > Customize  menu item. The Customize dialog box opens.

2. In the Commands tab  on page 1213, in the Categories list, select a toolbar or menu name to 
display commands specific to that menu or toolbar, or select All Commands.

If you are working in a special mode in SailWind Layout or SailWind Logic (for example, the Decal 
Editor in SailWind Layout), some categories of commands are not available for customization.

3. In the Commands list, select the command you want and drag it to the toolbar or menu.

To remove an item from a toolbar or menu (while the Customize dialog box is open), click the item 
and drag it outside the toolbar or menu.

4. When you have finished adding commands, click the Close  button.

5. For instructions to customize the text or image of the toolbar or menu item, see “Customizing the 
Appearance of New Toolbar and Menu Items”.

Related Topics
Creating a Custom Command

Adding Macros to Toolbars and Menus [SailWind Layout Command Reference Manual]

Toolbars and Menu Item Removal

Moving or Copying Menu Commands

Customizing the Appearance of New Toolbar and Menu 
Items
You can customize the text and image of new toolbar and menu items.
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Moving or Copying Buttons Using the Customize Dialog Box

Procedure
1. Click the Tools  > Customize  menu item. The Customize dialog box opens.

2. In the interface, right-click over your new menu item or toolbar button and click the Button 
Appearance  popup menu item.

3. In the Button Appearance Dialog Box, make changes to the appearance of the item.

4. When you have finished customizations in the Button Appearance dialog box, click OK.

5. In the Customize dialog box, click Close.

Moving or Copying Buttons Using the Customize Dialog 
Box
Use the Customize dialog box to rearrange toolbar buttons to meet your preferences.

Procedure
1. Click the Tools  > Customize  menu item. The Customize dialog box must remain open to allow 

these changes.

2. Move or copy the toolbar button:

• To move the button: Click the toolbar button and drag it to a new place on the same toolbar or 
to a different toolbar.

• To copy the button: Click the toolbar button. Press and hold the Ctrl key while dragging the 
button to place the copy on the same toolbar or to a different toolbar.

3. Close the Customize dialog box.

Moving or Copying Buttons Without the Customize Dialog 
Box
If desired, you can move a toolbar button by pressing the ALT key and dragging it. You can also copy a 
toolbar button by pressing the ALT + CTRL keys while dragging the item you want to copy. Using these 
key combinations allows you to arrange custom toolbars without using the Customize dialog box.

Procedure
1. Press and hold the Alt key.

2. Move or copy the toolbar button.

• To move the button: Drag the toolbar button to a new place on the same toolbar or to a different 
toolbar.

• To copy the button: Drag the toolbar button and then press and hold the Ctrl key instead of the 
Alt key to create a copy of the button to place on the same toolbar or to a different toolbar.
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Moving or Copying Menu Commands
You can customize the arrangement of command on a menu using the Customize dialog box.

Procedure
1. Click the Tools  > Customize  menu item.

2. In the main window, click the menu to expand it and display the contents. The Customize dialog 
box must remain open to allow these changes.

3. Move or copy the menu command:

• To move the command: Drag the menu item to its new location on the same menu or to a 
different menu.

• To copy the command: Press and hold the Ctrl key while dragging the item to create a copy to 
place on the same menu or on a different menu.

4. Close the Customize dialog box.

Related Topics
Command and Menu Customization

Adding Items to Toolbars and Menus

Resetting Toolbars to Defaults

Toolbars and Menu Item Removal
You can customize a toolbar or menu by removing items and buttons. The method to use depends on 
whether the Customize dialog box is open.

Use one of the following methods:

• If the Customize dialog box is open, drag the item outside the toolbar or menu. Then close the 
Customize dialog box.

• If the Customize dialog box is closed, press and hold the Alt key. Then drag the item outside the 
toolbar or menu.

Tip
You can reset a toolbar or shortcut menu back to its default list of items. See “Resetting 
Toolbars to Defaults”.

Related Topics
Adding Items to Toolbars and Menus
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Shortcut Key Customization
You can create and customize shortcut keys by using the Keyboard and Mouse  tab of the Customize 
dialog box.

To assign a shortcut key to a macro, see “Assigning Shortcut Keys to Macros” in the SailWind Layout 
Command Reference.

See the following subtopics for more information:

Creating a Shortcut Key
Rules and Restrictions for Key Sequences
Listing Available Shortcut Keys
Deleting a Shortcut Key
Resetting to Default Shortcut Keys

Creating a Shortcut Key
You can create shortcuts that apply in a specific mode. The same shortcut key may have different 
functionality depending on the mode in which you are working.

Procedure
1. Click the Tools  > Customize  menu item. The Customize dialog box opens.

2. In the Keyboard and Mouse tab  on page 1214, in the Mode box, select the mode to which you 
want to apply the shortcut. The available commands for that mode appear in the Commands box.

3. In the Commands box, select the command for which you want to create a new shortcut. If a 
shortcut already exists, it appears in the Current shortcuts box.

To replace an existing shortcut, click Delete  to remove the existing shortcut, and create a new 
shortcut for the command.

4. Above the Current shortcuts box, click the New  button  to open the “Assign Shortcut Dialog 
Box”  on page 1106.

5. Create one of the following shortcut types:

• Shortcut key  — Click “Press new shortcut key(s)” and press the keyboard keys that you want 
to use. For detailed information about rules and restrictions for creating shortcut keys, see 
“Rules and Restrictions for Key Sequences”. As you enter the new shortcut, similar shortcuts 
appear in the “Similar shortcuts assigned to other commands” box. This helps to avoid the 
creation of a new shortcut that conflicts with an existing shortcut.

• Mouse action  — Click “or select a pointer event”, and then select a combination of list box 
options, mouse button events, and modifier keys.

6. Click OK  to close the Assign shortcut dialog box. The new shortcut appears in the Current 
shortcuts box on the Customize dialog box.
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Rules and Restrictions for Key Sequences
SailWind Layout has certain restrictions when using key sequences to make a shortcut.

The first character may consist of the following, including Alt, Ctrl, or Shift modifiers:

• All printable characters including Space and Tab

• All function keys

• Extended keys: Up, Down, Left, Right, Insert, Delete, Home, PageUp, PageDown, End

• Numerical keypad keys (when Num Lock is off): Up, Down, Left, Right, Insert, Home, PageUp, 
PageDown, Del, End, /, *, +, -

• Mouse pointer events: Click, Double-click, RotateForward, RotateBackward. Mouse pointer 
events cannot be combined with key sequences, although the Ctrl, Alt, and Shift modifiers are 
allowed.

• Subsequent characters may consist of alphanumeric characters (a-z0-9).

Tip
Some combinations, like Alt+Tab, are intercepted by Windows and are not available.

Related Topics
Creating a Shortcut Key

Command and Menu Customization

Resetting to Default Shortcut Keys

Listing Available Shortcut Keys

Listing Available Shortcut Keys
You can generate a report in an HTML format displaying a table of commands and the shortcuts assigned 
to them.

Procedure
1. Click the Tools  > Customize  menu item. The Customize dialog box opens.

2. In the Keyboard and Mouse tab  on page 1214, click Report.

3. In the Save report dialog box, specify a file name and location, then click Save. A hyperlink to the 
file appears in the Output window, on the Status  tab.
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Deleting a Shortcut Key

Related Topics
Command and Menu Customization

Creating a Shortcut Key

Resetting to Default Shortcut Keys

Deleting a Shortcut Key
Delete or remove shortcuts you no longer want to use. You can also delete them as the first step to 
changing an existing shortcut.

Procedure
1. Click the Tools  > Customize  menu item. The Customize dialog box opens.

2. In the Keyboard and Mouse tab  on page 1214 in the Mode box, select the mode for the shortcut 
you want to delete. The available commands for that mode appear in the Commands box.

3. In the Commands list, select the command whose shortcut you want to delete.

4. In the Current shortcuts list, select the shortcut you want to delete.

5. Click the Delete  button.

6. When finished, close the Customize dialog box.

Related Topics
Creating a Shortcut Key

Resetting to Default Shortcut Keys

Resetting to Default Shortcut Keys
You can restore all shortcut keys to their default settings.

Procedure
1. Click the Tools  > Customize  menu item. The Customize dialog box opens.

2. In the Keyboard and Mouse tab  on page 1214, click Reset All.

3. On the confirmation dialog box, click Yes.

4. When finished, close the Customize dialog box.

Screen Appearance
You can customize the software interface by toggling the appearance of tooltips, changing the button 
icon size, enabling personalized menus (shortened menus based on usage), changing the menu 
display, changing the Microsoft visual style of the windows and dialog boxes, and changing the interface 
language.
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For more information, see the Options tab of the Customize dialog box  on page 1218.

Related Topics
Setting the Interface Language

Resizing the Layers List

Setting the Interface Language
You can change the language used in the text of the interface. SailWind Layout supports the following 
languages: English and Chinese Simplified.

Procedure
1. Click the Tools  > Customize  menu item. The Customize dialog box opens.

2. In the Options tab  on page 1218, in the Visual Style area, in the Interface language list, click the 
desired language.

3. In the prompt, “You must restart SailWind Layout for the change of language to take effect”, click 
OK.

4. Close the Customize dialog box.

5. Restart SailWind Layout.

Resizing the Layers List
You can change the width of the Layers list on the Standard toolbar if your layer names are longer than 
what is displayed by default. Although you can press the Alt key to move buttons on toolbars, you cannot 
use the Alt key to resize the Layers list.

Procedure
1. Click the Tools  > Customize  menu item. The Customize dialog box opens.

2. On the Standard Toolbar of the main Interface, select the Layers list box.

3. Use the resizing bar that appears on the cursor as you hover over the right side of the Layers list 
box. Resize as needed.

4. Close the Customize dialog box.
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Window Placement
You can customize the way windows (Output window, Project Explorer window, Markups window, Archive 
Navigator) appear in your workspace.

See the following subtopics for specific information:

Hiding Windows Automatically
Detaching Windows from the Current View
Attaching Windows to the Current View

Hiding Windows Automatically
You can also set a window to hide automatically so that it appears when you hover the pointer near it, and 
automatically minimizes when you move the pointer away from it.

Procedure
1. Move your pointer to the right side of the title bar in the window you want to hide.

2. Click the thumbtack  in the window title bar. The thumbtack picture changes to point sideways 
. A new bar appears on the side of the interface. The side on which the bar appears depends 

on the location of the window. For example, if the Project Explorer is located on the left side of the 
user interface, when you click the Auto Hide setting from the menu, the new bar appears on the left 
side of the interface. The new bar contains a tab that has the same name as the window.

3. Hover over the tab in the new bar. The window reappears, covering the application.

4. Move the pointer away from the window. The window minimizes to a tab.

Tip
To turn off the Auto Hide feature, hover over the tab in the new bar so the window 
reappears. Then repeat steps 1-2 in reverse.

Detaching Windows from the Current View
You can detach a window from the current view. This is called floating. A floating window does not attach 
to the current view; instead, it hovers, blocking the view to anything behind it.

Procedure
1. If the window is currently set to hide automatically, first turn off the Auto Hide feature.

2. Double-click the window title bar. The window detaches and you can move it to any part of the 
screen. To undo floating, see “Attaching Windows to the Current View”.
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Attaching Windows to the Current View
You can attach a window to the current view. This is called docking. A docked window does not block the 
view to anything behind it.

You can dock a window in its last docked location, or dock a window to a different location.

Docking to the Last Location
Docking to a New Location
Embedding Two Windows Within One Window Space
Creating Tabs Within Windows

Docking to the Last Location
You can dock a window to its previous docked location.

Procedure
1. Select the window to dock.

2. Double-click the window title bar. The window reattaches to the interface.

Docking to a New Location
Dock a window to a new location using the cursor.

Procedure
1. Using the title bar, drag the window. When you start dragging the window, additional graphics 

appear in the user interface. At the edges of the user interface, arrows containing graphics appear, 
as shown in Figure 2.

Figure 2. Window Dragging Graphic

A similar group of arrows appears in a group near the center of the screen. Ignore that group of 
arrows for this procedure.

2. While dragging the window, hover over one of the arrows on the edge of the user interface. For 
example, hover over the arrow on the left side of the user interface. A transparent colored block 
appears along the side of the user interface to which you are pointing. This block indicates where 
the window will be docked when you release the mouse button. For example, if you hover over the 
arrow on the left side of the user interface, a block appears along the left side of the screen, as 
shown in Figure 3.
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Embedding Two Windows Within One Window Space

Figure 3. Docking a Window

3. Release the mouse button while hovering over the arrow that indicates where you want to dock 
the window. The window docks to the user interface, and the other windows in the user interface 
resize.

Embedding Two Windows Within One Window Space
If desired, you can embed a window within another window space to improve the efficiency of the work 
area.
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Procedure
1. Using the title bar, drag a window into another window. When you start dragging a window, 

additional graphics appear in the user interface. A group of arrows containing graphics appears 
in the center of docked windows into which you are dragging, as shown below. Depending on the 
window in which you are dragging, the group of arrows may also have a tab graphic in the center.

Figure 4. Dragging a Window—Arrow Group

A similar group of arrows appears at the sides of the user interface. Ignore those arrows for this 
procedure.

2. While dragging the window, hover over one of the arrows. For example, hover over the left arrow. A 
transparent colored block appears along the side of the window you are dragging, as shown below. 
This block indicates where the window will be docked when you release the mouse button. For 
example, if you hover over the left arrow, a block appears along the left side of the Output Window.

Figure 5. Dragging and Docking a Window

3. Release the mouse button while hovering over the arrow that indicates where you want to dock 
the window. The window is embedded within another window, both sharing the space the original 
window occupied.

Tip
To maximize your workspace, try setting these embedded windows to hide automatically. 
Ctrl-click the thumbtack in one of the window title bars, and all of the windows within the 
original window frame hide automatically.
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Creating Tabs Within Windows
Create a tab of your window within the space occupied by another window.

Procedure
1. Using the title bar, drag a window into another window. When you start dragging a window, 

additional graphics appear in the user interface. A group of arrows containing graphics appears in 
the center of the window into which you are dragging, as shown below. Depending on the window 
into which you are dragging, the group of arrows may also have a tab graphic in the center.

Figure 6. Dragging and Docking a Window—Arrow Commands

A similar group of arrows appears at the sides of the user interface. Ignore those arrows for this 
procedure.

2. While dragging the window, hover over the tab graphic. A transparent colored block appears over 
the window you are dragging, as shown below. This block indicates where the window will be 
docked when you release the mouse button. For example, if you hover over the tab in the Project 
Explorer window, a block appears over the Project Explorer.

Figure 7. Dragging a Window—Transparent Block

3. Release the mouse button while hovering over the tab. The window is embedded as a tab within a 
window, as shown below. You can click each tab to access each window.
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Figure 8. Window Embedded as a Tab

4. To rearrange the tab, drag the tab to a new position within the row of tabs.

5. To move an embedded window, drag the tab out of the window in which it is embedded and the tab 
will convert back into a window that you can place where desired.

Tip
To maximize your workspace, try setting these embedded windows to hide automatically. 
Ctrl-click the thumbtack in one of the window title bars, and all of the windows within the 
original window frame hide automatically.

Transparent View Mode
Use Transparent Mode to view traces on several layers simultaneously. Transparent mode can show you 
hidden obstacles directly under the current active layer.

To toggle transparent view mode, use the Modeless Command  on page 83 T.

With Transparent mode you can view traces on several layers at once. Transparent mode can show 
obstacles that may be hidden directly under the current active layer. When Transparent mode is on, you 
see trace-over-trace, trace-over-part outline, copper-over-trace overlaps drawn in a third, lighter color. 
The overlap color is determined by the colors you assign to your traces. With Transparent mode off, 
overlaps do not appear.
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Outline View Mode

Figure 9. A Routed Board with Transparent Mode Off and On

You should use transparent mode for inspecting dense route areas or when routing in areas with layer-
specific obstructions.

Color Selection and Transparent Mode
The transparent effect is more visible if you use darker colors for traces. Bright colors like yellow and 
aqua wash out the effect.

Figure 10. A Thirty Two Color Grid with Transparent Mode Off and On

Tip
Items that you select may not clear normally and may remain highlighted until you click Redraw 
on the toolbar.

Outline View Mode
Use Outline mode to speed redraw time by displaying traces and pads as outline objects instead of filled 
objects. Traces appear as two parallel lines, separated by the established trace width. Pads appear as 
outlines of their shapes.

To toggle outline view mode, use the Modeless Command  on page 83 O.
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Resolution Options
With resolution options, modeless commands ‘OL’ and ‘OH’  on page 83, you can change the display 
resolution for faster redraw of very large designs. High resolution, which is the default, displays objects in 
their true shape. Low resolution displays pads as square or rectangular objects. The last resolution setting 
you used is saved, for example, if you set low resolution, selecting outline mode toggles between normal 
view and low resolution mode.

Related Topics
Viewing Protected Routes with Outline Mode

Bottom View
You can change the view of the design space to view your PCB design from behind. Enable this bottom 
view to help visualize the placement of components or the placement of reference designators on the 
bottom side of the board.

Use one of the following to toggle Bottom View:

• View  > Bottom View  menu item

• Standard Toolbar > Bottom View button

• Use the B modeless command  on page 83

• Press Alt-B

The entire design space is mirrored. Moving the cursor to the left results in a positive move on the x axis 
while in Bottom View.

If you have enabled the Active layer comes to front setting in the Global Options  on page 1531, the active 
layer remains at the front when you switch to Bottom View. If the Active layer comes to front setting is 
disabled when you switch to Bottom View, you will see the bottom layer at the front regardless of which 
layer is active.

Fonts
Text strings and labels in your designs can use stroke font and/or system fonts that are installed on your 
system.

• You can set fonts for each text string and label you create in your design, choosing stroke font or 
system fonts for each selection. You can also have a combination of stroke font and system fonts 
within the same design.

• You can search for fonts used for text strings or labels, and can then open the item Properties to 
apply a different font name and style to all objects that you select for modification.

• Designs to be output to printers and plotters can also use both stroke fonts and system fonts. 
When making font selections, consider the following:
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Fonts

◦ System font text is supported in RS-274X Gerber format when Fill mode is on and is 
output as a set of filled polygons. For more information see the settings in the Photo Plotter 
Advanced Setup Dialog Box.

◦ System fonts are not supported in the RS-274D CAM output format. If you attempt to use this 
output format with system fonts, the program displays a warning message. If you proceed, 
system fonts will not be output. Instead, you should use the RS-274X format with system 
fonts.

• If the design uses fonts or character sets that are not installed on your system, a font substitution 
process begins automatically when the file is loaded. During this process, you are asked to 
choose fonts to substitute for those that are missing from your system. For instructions, see 
“Replacing Missing Fonts”.

• For systems using languages that do not include stroke font, English stroke font is used.

• Non-ASCII symbols, such as +/-, ohm, and degrees are available on your system for the installed 
fonts you select. If the character sets you choose are not available, a blank space or blank text 
box appears where the symbols should be. In this case, choose character sets that are available 
on your system to enable the symbols to display in your design.

When you open an existing design that was created on a system without system font supported, you 
must choose whether to use stroke or system fonts for every text string or label in the design. To convert 
the existing text or label fonts to another font, use the Text  on page 1750 or Part Label Properties  on 
page 1603 dialog box. To find fonts easily, use the Find Dialog Box.
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Chapter 3
Modeless Commands and Shortcuts

Learning and using modeless commands and command shortcuts available in the function keys, keypad 
keys and keyboard key combination can make your use of the software more efficient.

Tip
Some commands are only accessible as a modeless command.

Modeless Commands
Function Keys
Keypad Keys
Keyboard Shortcuts

Modeless Commands
You can set or change some settings and functions at any time by typing a code letter for the command, 
entering the new value, and pressing the Enter key. This is called a Modeless Command.

Modeless Commands usually apply to values that you change frequently during design. Use the 
Modeless Command “G,” for example, to change the grid setting. Type “G”, the new setting, and press the 
Enter key.

To show this help topic at any time while SailWind Layout is running, type “?” and press the Enter key.

Modeless Command Formats

Tip
(X,Y) = coordinates; (s) = text; (n) = number

Table  6. Modeless Command and Shortcut Key Table Conventions

Convention Description

<value> A variable, or something you can type (modeless commands 
only).

{ } An optional command argument.

<Click> Click the left mouse button.

MButton+<Click> Click the middle mouse button or wheel.

RButton+<Click> Click the right mouse button.

<RotateBackward> Rotate the wheel backward, where the top of the wheel rotates 
toward your palm.

SailWind Layout Guide and Reference 83



Modeless Commands and Shortcuts
Modeless Commands  

Table  6. Modeless Command and Shortcut Key Table Conventions  (continued)

Convention Description

<RotateForward> Rotate the wheel forward, where the top of the wheel rotates 
away from your palm.

 

Tip
Spaces have significance in modeless commands and shortcut keys. For example, SS W1 and S 
SW1 have different meanings. SS W1 means to search for and select W1, while S SW1 means to 
search for SW1.

Modeless Command List

The following is a complete list of all of the modeless commands:

Table  7. Modeless Commands for Setting the Design Units

Name Command Description

Set Design Units to Inches UI Sets the Design Units to inches in the Global 
category > General  subcategory of the Options 
dialog.

Set Design Units to Mils UM Sets the Design Units to mils (thousands of 
an inch) in the Global  category > General 
subcategory of the Options dialog.

Set Design Units to Millimeters 
(metric)

UMM Sets the Design Units to metric (millimeters) in 
the Global  category > General  subcategory of 
the Options dialog.

Table  8. Modeless Commands for (Cartesian) Grid Settings

Name Command Description

Global Grid Setting G<x> {<y>} Sets the Design and Via grids simultaneously. 
The second parameter is optional. If you type 
one parameter, it applies the same value to 
both <x> and <y>. For example, G 25, G 8.3 or 
G 16-2/3, G 5 25.

Displayed (Dot) Grid Setting GD <x> {<y>} Sets the Displayed (Dot) grid. The second 
parameter is optional. If you type one 
parameter, it applies the same value to both 
<x> and <y>. For example, GD 8-1/3, GD 25 
25, or GD 100.

Design Grid Settings GR <x> {<y>} Sets the Design grid (placement and routing). 
The second parameter is optional. If you type 
one parameter, it applies the same value to 
both <x> and <y>. For example, GR 8-1/3, GR 
25 25, GR 25.
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Table  8. Modeless Commands for (Cartesian) Grid Settings  (continued)

Name Command Description

Via Grid Settings GV <x> {<y>} Sets the Via grid. The second parameter is 
optional. If you type one parameter, it uses the 
same value for both <x> and <y>. For example, 
GV 8-1/3, GV 25 25, or GV 100.

 

Table  9. Modeless Commands for (Polar) Grid Settings

Name Command Description

Polar Grid On/Off GP Polar grid on/off. Use the polar grid for Radial 
Move, circular component arrays, and to create 
radial drawings.

 Note:
Routing on the polar grid requires you to set 
the Angle Mode to Any Angle. See the AA 
modeless command for more info.

Move to a Point Specified by 
Polar Coordinates (radius 
angle)

GP r a Move to a point specified by polar coordinates 
(radius and angle).

Move to a Point Specified by 
the Angle, Using the Existing 
Radius

GPA a Move to a point specified by the angle, using 
the existing radius.

Move to a Point Specified by 
the Radius, Using the Existing 
Angle

GPR r Move to a point specified by the radius, using 
the existing angle.

Move to a Point Specified by 
the Current Angle (da) Value, 
Using the Existing Radius

GPRA da Move to a point specified by the current angle 
(da) value, using the existing radius.

Move to a Point Specified by 
the Current Radius (dr), Using 
the Existing Angle

GPRR dr Move to a point specified by the current radius 
(dr), using the existing angle

• - 8 = (eight); - 8-1/3 = (eight and a third); - 8.33 = (eight point 33)

• You can search for, and move the cursor to, a location regardless of the current grid, but the Snap to 
grid settings of the Grids Options restrict you to performing any design activity on the grid.

 

Table  10. Modeless Commands for Setting Origins

Name Command Description

Set the Origin Using Design 
Coordinates

SO Sets the origin using current design 
coordinates.
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Table  10. Modeless Commands for Setting Origins  (continued)

Name Command Description

If a component, pin, drafting corner, text, via, 
circle, or line intersection is selected, SO sets 
the board origin to the origin of the selected 
item. If nothing is selected, coordinates must be 
given. For example, SO 8.3 8.3 or SO 25 25.
See also: “Design Origin and Workspace”.

Set the Origin Using Absolute 
Coordinates of the Design 
Space

SOA Sets the origin using the absolute coordinates 
of the design space. Coordinates must be 
given. The design space measures 56 inches 
X 56 inches and with the design space origin 
at the center of this space, the coordinates 
measure from -28” to +28” on both the x 
and y axis. By displaying the design space 
coordinates, you can determine whether you 
will reach the limits of the design space based 
on the placement of your design origin and the 
size requirements of your board.
For example, SOA 8.3 8.3 or SOA 25 25.

Table  11. Modeless Commands for Line/Trace Angle Settings

Name Command Description

Any Angle AA Any angle mode. Sets the Line/trace angle 
setting in the Design options to Any angle (no 
angle restrictions).

Diagonal Angle AD Diagonal angle mode. Sets the Line/trace angle 
setting in the Design options to Diagonal (45 
degree angles only).

Orthogonal Angle AO Orthogonal angle mode. Sets the Line/trace 
angle setting in the Design options to 
Orthogonal (90 degree angles only - no dialog 
or 45-degree corners).

Table  12. Modeless Commands for Line/Trace Width Settings

Name Command Description

Reduce Display Width R <n> Sets the “Minimum display width” in the General 
options  on page 1531 to <n>, for example, R 
50. Any line widths that are less than this value 
are drawn as single pixel center lines. This 
feature is no longer needed to speed refresh 
times with the power of today’s video cards, 
but is still used to assist in the selection of very 
small line segments.

Change Current Width to <n> W <n> Changes the current trace or line width to the 
number <n> you enter, for example W 5.
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Table  13. Modeless Commands for Line Style Settings

Name Command Description

Line Style (status) LS Shows the current line style setting in the status 
bar.

Line Style Solid LSS Sets the default line style for new 2D line 
objects to Solid lines.

Line Style Dashed LSD Sets the default line style for new 2D line 
objects to Dashed lines.

Line Style Dotted LSO Sets the default line style for new 2D line 
objects to Dotted lines.

Line Style Dash Dotted LSA Sets the default line style for new 2D line 
objects to Dash Dotted lines.

Line Style Dash Double-Dotted LSB Sets the default line style for new 2D line 
objects to Dash Double-dotted lines.

Table  14. Modeless Commands for DRC Settings

Name Command Description

Turn Off DRC Mode DRO Turn off on-line DRC mode. Sets the on-line 
DRC setting in the Design options to Off.

Prevent DRP Prevent errors mode. Sets the on-line DRC 
setting in the Design options to Prevent errors.

Warn DRW Warn errors mode. Sets the on-line DRC setting 
in the Design options to Warn errors.

Ignore Clearance DRI Ignore clearance mode Sets the on-line 
DRC setting in the Design options to Ignore 
clearance.

 

Table  15. Modeless Commands for Searching

Name Command Description

Search Absolute S <x> <y> Search absolute. Moves the pointer to the 
specified X and Y coordinates, for example S 
1000 1000.

Search for Reference 
Designator/Pin

S <s> Search for reference designator/pin <s>, for 
example S U1.1 or S U1.

Search Relative SR <x> <y> Search relative. Moves the pointer by the 
specified X and Y offset, for example SR -100 
-50.
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Table  15. Modeless Commands for Searching  (continued)

Name Command Description

Search Relative X SRX <x> Search relative X at current Y. Moves pointer by 
the specified X offset, for example SRX 300.

Search Relative Y SRY <y> Search relative Y at current X. Moves pointer by 
the specified Y offset, for example SRY 400.

Search and Select SS <s> Search and Select components by reference 
designator, for example SS U10. You can also 
search and select more than one component by 
typing multiple entries, for example SS U10 U5 
R6.

 Tip
Spaces may be important in modeless 
commands. For example, SS W1 and S 
SW1 have different meanings. SS W1 tells 
SailWind Layout to search and select W1, 
while S SW1 tells it to search for SW1.

Search and Select Using 
Asterisk *

SS <s>* You can search and select using an asterisk, 
*. Type SS, a space, the character you want 
to search by, and an asterisk. For example, to 
search and select all components beginning 
with a C, type SS C*. All components with 
a reference designator starting with C are 
selected.

 Tip
This command is useful for placing parts. 
For example, you can select all resistors 
using SS R* and then choose Move 
Sequential from the pop-up menu to place 
the selected parts.

Absolute Move to <n>, Current 
Y

SX <x> Search absolute X at current Y. Moves the 
pointer to the specified X coordinate and the 
current Y coordinate, for example SX 300.

Absolute Move to <n>, Current 
X

SY <y> Search absolute Y at current X. Moves the 
pointer to the specified Y coordinate and the 
current X coordinate, for example SY 400.

Search for and Select Route 
Segments Using Pixels

XP Search for and select route segments using 
pixels instead of segment width, allowing you to 
adjust a trace whose corners are less than the 
width of the trace.

 

Table  16. Modeless Commands for Drafting Shape Control

Name Command Description

Circle shape draw mode. HC Sets drawing mode to circle shape.
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Table  16. Modeless Commands for Drafting Shape Control  (continued)

Name Command Description

Path shape draw mode. HH Sets drawing mode to path shape.

Polygon shape draw mode. HP Sets drawing mode to polygon shape.

Rectangle shape draw mode. HR Sets drawing mode to rectangle shape.

Table  17. Modeless Commands for Objects Snapping

Name Command Description

Object Snap Mode OS Toggles Snap to Objects mode on/off in the 
Object Snap options  on page 1540.

Object Snap Radius OSR <n> Sets the snapping radius to the specified value 
(in current design units) in the Object Snap 
options  on page 1540. If no value is given, 
OSR displays current value of snap radius in 
the status bar.

Object Snap Type OS <n> Sets the Snap to object types in the Object 
Snap options  on page 1540 and clears those 
not selected. You can use one or more of the 
following values:

• C  — center of a circle or an arc.

• E  — corner of a drafting shape or line end.

• I  — intersections; the cross point of two lines 
or arcs.

• M  — midpoint of a line or arc.

• O  — component origin.

• P  — a pin or via origin.

• Q  — quadrants; four orthogonal points on a 
circle or arc.

For example: If you want to only snap to 
midpoints, type OS M. Or if you want to snap to 
all objects, type OS CEIMOPQ.

Table  18. Modeless Commands for Object Visibility

Name Command Description

Bottom View B Mirrors the entire design space from below. 
Moving the cursor to the left results in a positive 
move on the x axis while in Bottom View.

Complementary Format C Type C and press the Enter key to change the 
display to a complementary format, which views 
thermals and antipads on plane layers. Type 
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Table  18. Modeless Commands for Object Visibility  (continued)

Name Command Description
C a second time and press the Enter key to 
restore the normal non complementary view.

Active Layer to Front On/Off D Toggles the active layer setting in the Global 
category > General  subcategory of the Options 
dialog.

Drill Outline On/Off DO Toggles the display of the drill outline. The 
display of the drill is disabled when you give a 
net a specific highlight color in View > Nets.

Pin Number Display On/Off PN Toggles the display of the pin numbers. This 
command also toggles the Pin Num. column 
check box in the Display Colors Setup Dialog 
Box. Sizing is controlled by the settings in the 
Display Options  on page 1525.

Transparent Mode On/Off T Toggles the display of objects as either 
transparent or opaque.
See also: “Transparent View Mode”.

Text Outline On/Off X Toggles the display of text outlines.

 

Table  19. Modeless Commands for Net Highlighting

Name Command Description

Highlight Nets One by One N <s> Highlights nets one by one. To place the 
highlighted net <s> at the top of the stack, 
repeat the command, for example, N GND.

 Tip
Highlighted nets take on the Highlight color 
specified in the Display Colors dialog box  on 
page 1318.

Unhighlight Each Highlighted 
Net in Reverse Order

N - Unhighlights each highlighted net in reverse 
order in which they were added using the N 
command.

Remove All Highlighting from 
the Nets

N Removes all highlighting from the nets.

 

Table  20. Modeless Commands for Net Name Visibility

Name Command Description

Toggle Visibility of Net Names NN Toggles the visibility of net names.
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Table  20. Modeless Commands for Net Name Visibility  (continued)

Name Command Description

This command toggles the Net Name check 
box (object type - column) in the Display Colors 
Setup Dialog Box.
When the Net Name column check box is 
enabled, net name visibility is still restricted 
by the color tiles on each layer and the Show 
net names on Traces, Vias, Pins check boxes. 
See also the NNP, NNT, and NNV modeless 
commands.
Sizing and frequency of the net name 
placement is controlled by the settings in the 
Display Options  on page 1525.

Toggle Display of Net Names 
on Pins

NNP Toggles the display of net names on pins.
This command toggles the Show net names 
on...Pins check box in the Display Colors Setup 
Dialog Box. Sizing is controlled by the settings 
in the Display Options  on page 1525.
The display of net names also depends on the 
Net Name check box and the presence of a 
non-background color tile on the layer in the 
Display Colors Setup Dialog Box.

Toggle Display of Net Names 
on Traces

NNT Toggles the display of net names on traces.
This command toggles the Net names 
on...Traces check box in the Display Colors 
Setup Dialog Box. Sizing and frequency of 
placement is controlled by the settings in the 
Display Options  on page 1525.
The display of net names also depends on the 
Net Name check box and the presence of a 
non-background color tile on the layer in the 
Display Colors Setup Dialog Box.

Toggle Display of Net Names 
on Vias

NNV Toggles the display of net names on vias.
This command toggles the Net names on...Vias 
check box in the Display Colors Setup Dialog 
Box. Sizing is controlled by the settings in the 
Display Options  on page 1525.
The display of net names also depends on the 
Net Name check box and the presence of a 
non-background color tile on the layer in the 
Display Colors Setup Dialog Box.
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Table  21. Modeless Commands for Layer Visibility (Quick Layer View)

Name Command Description

Quick Layer View Z Quick layer view. With no command arguments, 
Z displays the initial layer view.

Add or Remove Layer from 
Current Set of Displayed 
Layers

Z {+<layer>} 
{-<layer>}

Add or remove layer from the current set of 
displayed layers. Examples:

• Z +O makes the outside layers visible, but 
does not change visibility of other layers.

• Z -O makes the outside layers invisible, but 
does not change visibility of other layers.

• Z -2 +O makes invisible layer 2 and makes 
visible the outside layers.

View Only the Range of Layers 
You Type

Z <n-m> View only the range of layers you type. For 
example, Z 2-4 displays layers 2, 3, and 4. Do 
not enclose the range with square brackets.

View Only the Layers You Type Z <layer n> {<layer 
m> …}

View only the layers you type. For example, Z 2 
4 d displays layers 2, 4, and the documentation 
layer.

View All layers Z * View all layers.

 Restriction:
Z supports only the asterisk * regular 
expression.

Hide All layers Z -* Hide all layers.

 Restriction:
Z supports only the asterisk * regular 
expression.

View the Active Layer Z A View the active layer. If the active layer is 
changed, it has no effect on the display.

View the Assembly Drawing 
Bottom layer.

Z ADB View the Assembly Drawing Bottom layer.

View the Assembly Drawing 
Top layer.

Z ADT View the Assembly Drawing Top layer.

View Only the Bottom Layer Z B View only the bottom layer.

View Only the Current Layer Z C <-C> View only the current layer. If the active 
layer is changed, only the new current layer 
is displayed. Unlike Z A, it puts you in a 
continuous mode where all layers are hidden 
except the active layer. When you change 
layers, the new layer becomes visible and all 
other layers are hidden. Use Z -C to exit the 
mode.

View All Documentation Layers Z D View all documentation layers.
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Table  21. Modeless Commands for Layer Visibility (Quick Layer View)  (continued)

Name Command Description

View All Electrical Layers Z E View all electrical layers.

View All Internal Layers Z I View all internal layers.

View Only the Outside Layers 
(Top and Bottom Layers)

Z O View only the outside layers, that is, the top and 
bottom layers.

View the Paste Mask Bottom. Z PMB View the Paste Mask Bottom.

View Paste Mask Top Z PMT View the Paste Mask Top.

View Solder Mask Bottom Z SMB View the Solder Mask Bottom.

View Solder Mask Top Z SMT View the Solder Mask Top.

View Silkscreen Bottom Z SSB View the Silkscreen Bottom.

View Silkscreen Top Z SST View the Silkscreen Top.

View Only the Top Layer Z T View only the Top layer.

View Unrouted Connections 
(that are visible on all layers)

Z U Toggles the view of unrouted connections that 
are visible on all layers.

View All Layers Z Z View all layers.

Restore a Quick Layer View 
Configuration

ZR <name> Restore a quick layer view configuration. For 
example, ZR L23 restores the configuration 
stored as L23.

 Tip
Type ZR and press the Enter key to see a 
list of all layer configurations created by ZS 
in this session.

See also: ZS.

Save Current Set of Displayed 
Layers as a Quick Layer View 
Configuration

ZS <name> Saves the current set of displayed layers as a 
quick layer view configuration. For example, ZS 
L23 stores the current configuration as L23. The 
quick layer view configuration is available until 
you exit the program.
See also: ZR.

 

Table  22. Modeless Commands for Layers

Name Command Description

Change the Current Layer to 
<n>

L <n> Changes the current layer to <n>. <n> can be 
any number or name, for example (L 2) or (L 
top).
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Table  22. Modeless Commands for Layers  (continued)

Name Command Description

Layer Direction on the Current 
Layer

LD Toggles between horizontal and vertical routing 
layer direction on the current layer. Changes 
the Routing Direction setting for the active layer 
in the design.

Paired Layer Command PL <n1> <n2> Paired Layer command, where <n> can be 
layer numbers or layer names. (for example, PL 
1 2 or PL top bottom).
Sets the Layer pair setting in the Routing 
options  on page 1542.

 

Table  23. Modeless Commands for Managing the 3D View Point in SailWind 3D

Name Command Description

View from Top T View from top.

View from Bottom B View from bottom.

View from Left L View from left.

View from Right R View from right.

Table  24. Modeless Commands for Vias

Name Command Description

Toggle Between End Via 
Modes

E Cycles through the End Via modes:
• End No Via (where a trace ends in space)

• End Via (where a trace ends with a via)

• End Test Point (where a trace ends with a 
test point via

 Tip
See the Status bar to know what mode you 
have switched to.

Open Via Dialog V Opens the Vias Dialog Box.

Automatic Via Selection VA Sets the Via Mode to Automatic in the Vias 
Dialog Box. See the dialog box topic for more 
information.

Use Partial Via VP Sets the Via Mode to Partial in the Vias 
Dialog Box. See the dialog box topic for more 
information.

Use Through Hole Via VT <name> Sets the Via Mode to Through in the Vias 
Dialog Box. If multiple vias exist, you can also 
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Table  24. Modeless Commands for Vias  (continued)

Name Command Description
type the name of the via to use. See the dialog 
box topic for more information.

 

Table  25. Modeless Command for Pour and Hatch Outlines

Name Command Description

Pour Outline On/Off PO Toggles the pour outline on/off and toggles 
the Display mode of copper planes between 
Pour outline and Hatch outline in the “Copper 
Planes / Hatch and Flood”  on page 1511
options.

Table  26. Modeless Commands for Outline Mode Settings

Name Command Description

Outline Mode On/Off O Toggles outline mode on and off. The OH 
and OL modeless command determine the 
resolution mode of outline mode. Displays an 
outline of pads, traces and all lines. Traces are 
displayed at their true width to the limits of the 
Minimum Display Width setting in the Global / 
General Options  on page 1531.
See also: “Outline View Mode”.

Outline Mode in High 
Resolution

OH Toggles outline mode with High resolution. 
Displays all objects with their true shape.

Outline Mode in Low Resolution OL Toggles outline mode with Low resolution. 
Displays rounded objects with squared corners. 
Oval and rectangular pads look the same. 
Trace segments do not have arcs at the ends. 
As an exception, round pads are drawn as 
circles.

Table  27. Modeless Commands for General Mode Settings

Name Command Description

Toggle Make Like Reuse 
Operations

RV Toggles Make Like Reuse operations to 
compare or ignore value and tolerance 
attributes.
See also: “Design Elements Made Like a Reuse 
Definition”.

Toggles Shove Mode On/Off SH Toggles Shove mode on or off.
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Table  28. Modeless Commands for Measurement

Name Command Description

Quick Measure Q Quick Measure with a dynamic ruler. Place 
the cursor at the starting point then type the 
“q” modeless command. Drag the cursor to 
create a line between the start and end point 
of your measurement. Snaps to the design 
grid when Snap to grid  on page 1537is on. 
Measurements are gridless when Grid Snap 
is off. Dynamically reports delta x, delta y, and 
delta x,y in current design units  on page 1531. 
You can also measure precise Euclidean 
distances between polar grid nodes using this 
command.
Quick Measure mode also works with Object 
Snapping. But unless you are within the snap 
radius of an object type, you are not given the 
option to choose between snapping to the grid 
or an object for your starting point. Snapping to 
object types takes priority over snapping to the 
grid.
You can enable Snapping to Objects on the 
popup menu during the measure operation, in 
the Options dialog box  on page 1540, or by 
using the OS modeless commands.
See also: “Measurement”.

Quick Length QL Quick Length.
1. Area-select the route items you want to 

measure; such as trace segments, nets, or 
pin pairs.

2. Type QL and press the Enter key.

A report of the route item lengths for routed, 
unrouted, and total length appears in the default 
text editor.
See also: “Measurement”.

Table  29. Modeless Commands for Multiple Undo and Redo Operations

Name Command Description

Multiple Undo Command 
(1-100)

UN [<n>] Multiple undo command (1-100), <n> is 
optional. (Ex. UN 2) UN will undo 1 time.

Multiple Redo Command RE [<n>] Multiple redo command (1-100), <n> is optional. 
(Ex. RE 2) RE will redo 1 time.

 

96 SailWind Layout Guide and Reference



 
Modeless Commands and Shortcuts

Modeless Commands

Table  30. Miscellaneous Modeless Commands

Name Command Description

Enable Color by Net Y Toggles the application of custom color to 
net pads, pins, vias, and—optionally—traces, 
according to the settings in the View Nets 
Dialog Box.

Open File <name> F <name> Open file <name>, where <name> is the path 
and name of the file to open (for example, F 
demo.eco).

Show This Help Topic ? Show this help topic.

Database Integrity Test I Runs Database Integrity Test.

Table  31. Modeless Commands for the Basic Media Wizard/Log Test

Command Description

Basic Log Test BLT Basic Log Test. Opens the Log Test Dialog 
Box. BLT finds and runs BMW session playback 
media.
See also: BMW and BLT

Open Basic Media Wizard BMW Opens the Basic Media Wizard dialog box.
• BMW records session playback media for 

a problematic SailWind Logic, SailWind 
Layout or SailWind Router session. It can 
create playback media based on your last 
SailWind session or your current session. 
This playback media can be replayed using 
the BLT modeless command.

• BMW is also a command line option.

See also: BMW and BLT

Start BMW Session Logging BMW ON Starts BMW session logging.

Stop BMW Session Logging BMW OFF Stops BMW session logging.

 

Table  32. Modeless Command for the Unrouted

Name Command Description

Enable Visibility of the 
Unrouted in the Same Net as 
the Selected Object

VUS Show the unrouted in the same net as the 
selecetd object.

Disable Visibility of the 
Unrouted in the Same Net as 
the Selected Object

HUS Hide the unrouted in the same net as the 
selecetd object.
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Table  32. Modeless Command for the Unrouted  (continued)

Name Command Description

Show All the Unrouted VUA Show all the unrouted in the design, except 
those in the locked net(s).

Hide All the Unrouted HUA Hide all the unrouted in the design, except 
those in the locked net(s).

Function Keys
Use function keys in SailWind Layout to perform commonly used tasks.

The following table defines the function key command assignments.

Table  33. Function Key Command Assignments

Function Key Description

F1 Open Help (context sensitive)

F2 Add Route

F3 Dynamics Route

F4 Toggle Layer Pair

F5 Select Pin Pair

F6 Select Net

F7 Autoroute Selected

F8 Unassigned

F9 Unassigned

F10 Unassigned

F11 Unassigned

F12 Unassigned

Keypad Keys
Use the keypad to perform common layout tasks.

The following table defines the keypad key command assignments.
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Table  34. Keypad Key Command Assignments

Keypad Keys Description

(Number Keys) with NumLock On

Keypad (0) Center the view using the pointer location.

Keypad (1) Redraw.

Keypad (2) Pans the workspace down one-half the screen height.

Keypad (3) Zooms out at the pointer.

Keypad (4) Pans the workspace left one-half the screen width.

Keypad (5) Starts Zoom from center (Num Lock only).

Keypad (6) Pans the workspace right one-half the screen width.

Keypad (7) Zoom to the Board.

Keypad (8) Pans the workspace up one-half the screen height.

Keypad (9) Zoom in at the pointer location.

Keypad (.) Starts Zoom from corner (Zoom Mode only).

(Command Keys) with NumLock Off

<Insert> Centers the view using the pointer location.

<End> Redraw.

<Down Arrow> Moves the pointer down one design grid.

<Page Down> Zooms out at the pointer.

<Left Arrow> Moves the pointer left one design grid.

<Right Arrow> Moves the pointer right one design grid.

<Home> Zooms to the Board.

<Up Arrow> Moves the pointer up one design grid.

<Page Up> Zooms in at the pointer.

<Delete> Delete the selected object.
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Keyboard Shortcuts
SailWind Layout provides certain keyboard combinations (shortcuts) to access or perform some common 
layout tasks.

The following table provides a complete list of the keyboard shortcut commands.

Table  35. Keyboard Shortcuts for Panning, Zooming and Navigation

Name Shortcut Keys Description

<Home>Zoom to Board

Ctrl+B

Zooms to the board. Fits the 
board outline into the workspace.

Zoom Extents Ctrl+Alt+E Zooms to extents. Fits all objects 
in the design into the workspace.

Zoom Area In/Out (Zoom 
by Drag)

MButton+ <Start Drag> Zooms area in or out. Drag 
pointer up to zoom in. Drag 
pointer down to zoom out.

Start Zoom from Corner Shift+MButton+ <Start Drag> Starts Zoom from Corner.

Zoom to Selection Alt+Z Zooms to selection. Fits the 
selected objects into the 
workspace.

Zoom Mode On/Off Ctrl+W Toggles Zoom Mode On/Off.

MButton+<Click>Center View (Using 
Pointer Location)

<Insert>

Centers the view at the pointer.

LButton+<Click>Zoom In at Pointer 
(Zoom Mode)

<spacebar>

Zooms in at the pointer (zoom mo
de).

Zoom Out at Pointer 
(Zoom Mode)

RButton+<Click> Zooms out at the pointer (zoom 
mode).

<Page Up>Zoom In at Pointer

Ctrl+<Rotate Forward>

Zooms in at the pointer.

<Page Down>Zoom Out at Pointer

Ctrl+<Rotate Backward>

Zooms out at the pointer.

Move Pointer Down (One 
Design Grid)

<Down Arrow> Pointer moves down one design 
grid.

Move Pointer Up (One 
Design Grid)

<Up Arrow> Pointer moves up one design 
grid.
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Table  35. Keyboard Shortcuts for Panning, Zooming and Navigation  (continued)

Name Shortcut Keys Description

Move Pointer Left (One 
Design Grid)

<Left Arrow> Pointer moves left one design 
grid.

Move Pointer Right (One 
Design Grid)

<Right Arrow> Pointer moves right one design 
grid.

Dynamic Panning (Pan 
by Drag)

Alt+MButton+<Start Drag> Pans the sheet area below 
the pointer to the center of the 
workspace.

Pan Workspace Down 
(One Line)

<Rotate Backward> Pans workspace down one line.

Pan Workspace Up (One 
Line)

<Rotate Forward> Pans workspace up one line.

Pan Workspace Right 
(One Line)

Shift+<Rotate Backward> Pans workspace right one line.

Pan Workspace Left 
(One Line)

Shift+<Rotate Forward> Pans workspace left one line.

Pan Workspace Down 
(One Pixel)

Ctrl+Alt+<Rotate Backward> Pans workspace down one pixel.

Pan Workspace Up (One 
Pixel)

Ctrl+Alt+<Rotate Forward> Pans workspace up one pixel.

Pan Workspace Right 
(One Pixel)

Alt+Shift+ <Rotate Backward> Pans workspace right one pixel.

Pan Workspace Left 
(One Pixel)

Alt+Shift+<Rotate Forward> Pans workspace left one pixel.

 

Table  36. Keyboard Shortcuts for Selection

Name Shortcut Keys Description

Selection Filter Ctrl+Alt+F Displays the Selection Filter.

Select LButton+<Click> Selects an object.

Select <Spacebar> Selects an object.

Select All Board Objects Ctrl+A Selects all objects in the design 
based upon the selection filter 
choices.

Area Select LButton+<Start Drag> Starts an area selection.

Area Complete LButton+<End Drag> Completes an area selection.
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Table  36. Keyboard Shortcuts for Selection  (continued)

Name Shortcut Keys Description

Cancel Area Selection LButton+<Cancel Drag> Cancels an area selection.

Cycle Selection <Tab> Cycles the selection of adjacent 
objects within the pick radius.

Toggle Selection Ctrl+LButton+<Click> Toggles object selection.

Select Target (BGA 
Function)

Ctrl+Shift+Z Select target.

 

Table  37. Keyboard Shortcuts for File Operations

Name Shortcut 
Keys Description

Create New Design File (Blank) Ctrl+N Creates a new blank design file.

Open File (Design) Ctrl+O Opens a design file.

Save Ctrl+S Saves the design file

 

Table  38. Keyboard Shortcuts for Opening Menus and Dialog Boxes

Name Shortcut Keys Description

Open SailWind 3D 
window

3 Opens the SailWind 3D window 
if the cursor is active in the 
design area.

Open File Menu Alt+F Opens the File menu.

Open Edit Menu Alt+E Opens the Edit menu.

Open View Menu Alt+V Opens the View menu.

Open Setup Menu Alt+S Opens the Setup menu.

Open Tools Menu Alt+T Opens the Tools menu.

Open Help Menu Alt+H Opens the Help menu.

Open Shortcut Menu RButton+<Click> Opens the Shortcut menu.

Properties (Current 
Object)

LButton+<DoubleClick> Displays Properties for the 
currently selected object.

Properties (for Selected) Alt+<Enter> Opens Properties dialog box for 
selected object.
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Table  38. Keyboard Shortcuts for Opening Menus and Dialog Boxes  (continued)

Name Shortcut Keys Description

Ctrl+Q

Options Global Ctrl+<Enter> Opens the Options dialog box.

Display Colors Setup Ctrl+Alt+C Opens the Display Colors Setup 
dialog box.

Options > Design 
Category

Ctrl+Alt+D Opens the Design  category of 
the Options dialog box.

Options > Global  category 
> General  subcategory

Ctrl+Alt+G Opens the Global  category > 
General  subcategory of the 
Options dialog box.

Open Status Window Ctrl+Alt+S Opens the Status Window

Open View Nets Dialog Ctrl+Alt+N Opens the View Nets dialog box.

 

Table  39. Keyboard Shortcuts for Placement Operations

Name Shortcut Keys Description

Move Selected Object(s) Ctrl+E Moves the selected object(s).

Rotate Selected (90) 
(during move) (CCW)

<Tab> Rotates a component (during 
component move mode) 
(CCW).

Rotate Selected (90) 
(during move) (CW)

Shift+<Tab> Rotates the selected component 
(during component move mode) 
(CW).

Rotate Selected (90) 
(CCW)

Ctrl+R Rotates the selected 
components(90 degrees) 
(CCW).

Spins Selected Ctrl+I Spins the selected object.

Flip Side (Selected) Ctrl+F Flips an object to the opposite 
side of the board.

Align Component Ctrl+L Align Component.
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Table  40. Keyboard Shortcuts for Routing Operations

Name Shortcut Keys Description

LButton+<Click>Add Corner

<Spacebar>

Adds a corner (interactive 
routing).

Add Tack LButton+<Click> Add a tack.

Add Via Shift+LButton+<Click> Adds a via (interactive routing).

Add Jumper Ctrl+Alt+J Add a jumper (interactive 
routing).

Backup <Backspace> Removes the last routed corner 
on a trace or the last corner on 
a 2D line (in polygon or path 
drawing mode).

Stretch Shift+S Stretch (interactive routing 
mode).

Complete 
Route

<Enter> Complete route.

LButton+<Click>Complete

LButton+<DoubleClick>

Complete (interactive routing) 
when pointer is near a valid 
completion point.

End (routing) Ctrl+LButton+ <Click> End (interactive routing).

Length 
Minimization

Ctrl+M Runs length minimization.

Quick 
Measure/Reset 
DxDy

Crtl+<PageDown> Quick Measure
• Works the same as the Q 

modeless command.

• Resets the Delta X,Y 
values to zero and begins 
measuring from the current 
location. This command 
works in any mode, with 
Delta X,Y on the status bar 
instead of the grid display.

Show Route 
Length (Design 
View)

Ctrl+<PageUp> Shows the route length (Design 
View).

Create Union Ctrl+G Create a Union.

Route Loop Ctrl+J Route a Loop.

Create Cluster Ctrl+K Create a Cluster.
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Table  40. Keyboard Shortcuts for Routing Operations  (continued)

Name Shortcut Keys Description

Teardrop 
Properties

Ctrl+T Displays the Teardrop 
Properties

 

Table  41. Keyboard Shortcuts for Bus Routing Operations

Name Shortcut Keys Description

Bus Route Ctrl+Alt+B Bus Route

Add Corner to Guide 
(Bus Routing Only)

Alt+LButton+<Click> Add a corner to a guide (Bus 
Routing only).

Add Via to Guide (Bus 
Routing Only)

Alt+Shift+LButton+ < Click> Add a via to a guide (Bus 
Routing only).

Cycle Via Pattern (Bus 
Route Only)

Ctrl+<Tab> Cycle through the via patterns 
(Bus Routing only).

End Guide (Bus 
Routing Only)

Ctrl+Alt+LButton+<Click> End Guide (Bus Routing only).

Next Guide (Bus 
Route Only)

<Tab> Next Guide (Bus Route only)

Previous Guide (Bus 
Route Only)

Shift+<Tab> Previous Guide (Bus Route 
only).

 

Table  42. Keyboard Shortcuts for Editing

Name Shortcut Keys Description

Cut Ctrl+X Cut

Copy Ctrl+C Copy.

Paste Ctrl+V Paste.

<End>Redraw

Ctrl+D

Redraw.

Delete/Unroute <Delete> Unroute selected object.

Cancel Command <Escape> Cancels command.

Redo Ctrl+Y Redo.

Undo Ctrl+Z Undo.
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Table  42. Keyboard Shortcuts for Editing  (continued)

Name Shortcut Keys Description

Highlight Object Ctrl+H Highlights Object.

Unhighlight Ctrl+U Removes highlighting from current object.

 

Table  43. Keyboard Shortcuts for Viewing

Name Shortcut 
Keys Description

Bottom Alt+B Mirrors the view of the design in the workspace.

Next View Alt+N Displays the next view.

Previous View Alt+P Displays the previous view.

 

Table  44. Mouse Button Substitutions

Name Shortcut Keys Description

Activate Right Click Pop-up Menu 
(Right Mouse Button)

M Activates the shortcut menu 
for the current mode. Same as 
right-click.

Left Mouse Click <Spacebar> Activates a left mouse button 
click (to add corners, select 
items, complete, etc.) at the 
current pointer location.

 

Table  45. Keyboard Shortcuts for Panning, Zooming and Navigation in SailWind 3D

Name Shortcut Keys Description

<Home>Zoom to Board

Ctrl+B

Zooms to the board. Fits 
the board outline into the 
workspace.

Zoom Extents Ctrl+Alt+E Zooms to extents. Fits all objects 
in the design into the workspace.

Zoom Area In/Out 
(Zoom by Drag)

MButton+<Start Drag> Zooms area in or out. Drag 
pointer up to zoom in. Drag 
pointer down to zoom out.
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Table  45. Keyboard Shortcuts for Panning, 
Zooming and Navigation in SailWind 3D  (continued)

Name Shortcut Keys Description

Zoom to Selection Alt+Z Zooms to selection. Fits the 
selected objects into the 
workspace.

MButton+<Click>Center View (Using 
Pointer Location)

<Insert>

Centers the view at the pointer.

Zoom Out <Page Down> Zoom out at the pointer.

Zoom In <Page Up> Zoom in at the pointer.

Zoom Out at Pointer Ctrl+<Rotate Backward> Zoom out at the pointer.

Zoom In at Pointer Ctrl+<Rotate Forward> Zoom in at the pointer.

Pan by Drag Alt+MButton+<StartDrag> Board moves in direction 
opposite to dragging direction.

 

Table  46. Keyboard Shortcuts for Managing the 3D View Point in SailWind 3D

Name Shortcut Keys Description

View from Top Shift+T View from top.

View from Bottom Shift+B View from bottom.

View from Left Shift+L View from left.

View from Right Shift+R View from right.

Rotate View Around Y-axis Shift+MButton+<Drag> Rotate view around Y-axis.

Rotate View Around Z-axis Ctrl+MButton+<Drag> Rotate view around Z-axis.

 

Table  47. Keyboard Shortcuts for File Operations in SailWind 3D

Name Shortcut Keys Description

Create New Design File 
(Blank)

Ctrl+N Creates a new design file.

Open File (Design) Ctrl+O Opens a design file.

Save Ctrl+S Saves a design file.

 

SailWind Layout Guide and Reference 107



Modeless Commands and Shortcuts
Keyboard Shortcuts  

Table  48. Keyboard Shortcuts for Opening Menus and Dialog Boxes in SailWind 3D

Name Shortcut Keys Description

Properties (for Selected) Ctrl+Q Displays Properties for the currently 
selected object.

Options > Design Category Ctrl+Alt+D Opens the Design  category of the 
Options dialog box.

 

Table  49. Keyboard Shortcuts for Placement Operations in SailWind 3D

Name Shortcut Keys Description

Move Ctrl+E Moves the selected object(s).

Rotate Selected (90) (during 
move) (CCW)

<Tab> Rotates a component (during 
component move mode) (90 
degrees) (CCW).

Rotate Selected (90) (CCW) Ctrl+R Rotates the selected 
components (90 degrees) 
(CCW).

Rotate Selected (90) (during 
move) (CW)

Shift+<Tab> Rotates the selected 
components (during component 
move mode (90 degrees) (CW).

Spin Selected Ctrl+I Spins the selected object.

Flip Side (Selected) Ctrl+F Flips an object to the opposite 
side of the board.

Align Component Ctrl+L Opens Align dialog box.

Delete Component <Delete> Delete component(s). (ECO 
mode must be turned ON.)

LButton+<Click>Complete Move

<Space>

Complete move.

Cancel Move <Esc> Cancel move.

 

Table  50. Keyboard Shortcuts for Editing in SailWind 3D

Name Shortcut Keys Description

Cut Ctrl+X Cut (ECO mode must be turned ON).

Copy Ctrl+C Copy.
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Table  50. Keyboard Shortcuts for Editing in SailWind 3D  (continued)

Name Shortcut Keys Description

Paste Ctrl+V Paste (ECO mode must be turned ON).

<End>Redraw

Ctrl+D

Refreshes silkscreen, soldermask, plane 
data in SailWind 3D window.

Cancel Command <Escape> Cancels command.

Redo Ctrl+Y Redo.

Undo Ctrl+Z Undo.

Reload 3D Ctrl+<F5> Reload 3D data and refresh SailWind 3D 
window.
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Chapter 4
Design and Editing Basics

Read the topics that follow to learn the basics of design and editing in SailWind Layout.

Database Limits
The Selection Filter
Object Selection
Cycle Picking
Selecting Objects by Selected List
Selecting Stitching Vias in a Shape
Isolated Stitching Via Selection
Running the Selection Report
Object Finding
Highlighting Objects
Measurement
Cut, Copy, and Paste Commands
Delete Command
Copying a Bitmap
Object Snap

Database Limits
As of PowerPCB 4.0, the database limits increased.

The following table shows the old and new database limits:

Tip
If your design uses these new limits, you may not be able to export it into a PADS-format ASCII 
file compatible with a previous version of the program. For more information, see “ASCII Format” 
in the SailWind Layout Command Reference.

Table  51. Database Limits

Description PowerPCB version 2 and 3 PowerPCB version 4 
and SailWind Layout

Drawing items per design 16,777,216 Same

Drawing pieces per design 16,777,216 Same

Corners per design 16,777,216 Same

Arcs per design 16,777,216 Same

Text strings per design 32,768 Same
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Table  51. Database Limits  (continued)

Description PowerPCB version 2 and 3 PowerPCB version 4 
and SailWind Layout

Text length per design 16,777,216 Same

Pieces per drawing 32,768 Same

Corners per drawing 16,777,216 Same

Arcs per drawing 16,777,216 Same

Text strings per drawing 32,768 Same

Text length per drawing 16,777,216 Same

Corners per piece 32,768 Same

Arcs per piece 32,768 Same

Drawings per PCB decal 32,768 Same

Reference designator characters 15 Same

Components per design 32,768 16,777,216

Terminals, via types, and jumper types 
per design

32,768 16,777,216

Gates per part type 100 702

Gates per design 32,768 16,777,216

Pin pairs per design 32,768 16,777,216

Nets per design 32,768 16,777,216

Alphanumeric pin numbers per design 32,768 16,777,216

Alphanumeric pin number length 4 7

Number of layers 30 250

Number of electrical layers 30 64

Number of pins per component 2000 32,768

Decal name length 40 Same

Part type name length Same

Net name length 47 Same

Layer name length 31 Same
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Table  51. Database Limits  (continued)

Description PowerPCB version 2 and 3 PowerPCB version 4 
and SailWind Layout

Component rotation precision 0.001× Same

Pad rotation precision 0.01× Same

Generic polylines angle precision 0.1× Same

ASCII file line length 2307 Same

Attribute name length 256 Same

Attribute value length 2048 Same

Tip
Consider all limits of 32,768 and 16,777,216 as formal. Actual limits may be smaller due to 
memory limitations.
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The Selection Filter
The layout of a printed circuit board displays overlapping layers of objects and dense areas of design 
objects on each layer, making it difficult to select the object you want. Use the Selection Filter to help 
solve this problem.

Use the Selection Filter to specify the type of object and even the layer on which to select objects. The 
Selection Filter has two tabs, the Object and the Layer. As a shortcut, you can also use preset Selection 
Filter setups available on the shortcut menu.

There are three ways to use the Selection Filter. For more information, see the topics in this section.

Filtering Selection Using the Selection Filter Shortcuts
Filtering Selection by Object Type in the Selection Filter
Filtering Selection by Layer in the Selection Filter

Filtering Selection Using the Selection Filter 
Shortcuts
Use the Selection Filter shortcuts to quickly set the Selection Filter to select items in the design.

Procedure
1. Ensure nothing is currently selected in the design. If something is already selected, the shortcut 

menu will not display the Selection Filter presets. To clear selection in the design, do one of the 
following.

• Right-click and click the Cancel  popup menu item.

• Click in an empty area of the design space - outside the board area if possible, since you could 
accidentally select a transparent object within the board area.

2. Right-click and click one of the selection filter presets.

Results
In the Selection Filter dialog box, check boxes are selected according to the preset that you chose.

Filtering Selection by Object Type in the Selection 
Filter
Use the Object  tab of the selection filter to specify which type of objects you would like to be able to 
select in the design.

Procedure
1. Click the Edit  > Filter  menu item.

2. In the Selection Filter dialog box, on the Object tab  on page 1710, select the design and drafting 
items by selecting the appropriate object type check box(es).
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Tip
You can use the Anything  or Nothing  buttons to quickly select all or clear all check boxes.

3. Click Close.

4. Select your items in the design.

Filtering Selection by Layer in the Selection Filter
Use the Layer  tab of the selection filter to specify on which layer would like to be able to select objects in 
the design.

Procedure
1. Click the Edit  > Filter  menu item.

2. In the Selection Filter dialog box, on the Layer tab  on page 1708, select the layers from the layer 
list by selecting the appropriate layer check box(es).

Tip
You can use the Anything  or Nothing  buttons to quickly select all or clear all check boxes.

3. Click Close.

4. Select your items in the design.

CAUTION:
Unlike the check boxes on the Object  tab, those on the Layer  tab are not altered by 
changing any of the Selection Filter presets on the shortcut menu. You must return to the 
Layer  tab to re-enable selection of objects on the layer(s) you disabled. Disabling a layer 
for selection will prevent you from routing to the layer or placing objects on the layer.

Object Selection
Most design work involves adding, modifying, and deleting items. SailWind Layout provides many ways to 
select items and two ways to edit items.

You can first select the object  on page 1842 to edit and then select the command, select mode; or you 
can first select the command and then select the object to edit, verb mode.

Verb mode attaches a command to the pointer and performs that command on any items subsequently 
selected. The advantage of using verb mode is that it automatically sets the selection filter to items that 
respond to the active command.

There are several ways to select objects:

• One at a time

• Several objects at once
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• All objects within an area

• All objects of the same type

Single Object Selection
To select a single object, point to the object and click. The object becomes selected and highlighted. Any 
previously selected objects are no longer selected. If you click over empty design space, all previously 
selected objects are no longer selected.

But since you may click on a transparent design object and select it, right-click and click the Cancel 
popup menu item to de-select any selected items.

Multiple Object Selection

To select multiple objects, press and hold the Ctrl key while you click over each item in sequence. 
Alternatively, you can drag a selection area around many objects and everything in the selection area will 
be selected according to your settings in the Selection Filter  on page 114.

Start at one corner of the area and drag to the diagonally opposite corner. When you release the button, 
all objects contained within the rectangle are selected. If an object was not previously selected, it is added 
to the set of selected objects. If an object was previously selected, it is removed from the set of selected 
objects.

You can add additional objects to the selection or remove objects from the selection by pressing the Ctrl 
key while you click.

Selection Tips

If you try to select an object in a dense or crowded area, use the Selection Filter to disable other items for 
selection or use the Cycle command. For instructions, see “Cycle Picking”. Alternatively, you can make 
area selection, and then right-click to choose the Selected List  menu item. For details, see "Selecting 
Objects by Selected List".

You can click the Edit  > Find  menu item to search for and select objects in the design. For more 
information, see “Object Finding”.

The Project Explorer also enables you to select design objects. For instructions, see “Selecting Design 
Objects Using the Project Explorer”.

Tip
The Drag Moves area in the Global > General  tab of the Options dialog box can affect your ability 
to area select in dense designs. If a selected object starts to move when you area select, click 
Cancel  from the shortcut menu and try starting in a different area. To disable drag moves, set the 
Drag Moves setting to No Drag Moves.

The following table shows how to use Shift or function key combinations to automatically select multiple 
items.

Table  52. Selecting Using Shift and Function Keys

Item to select Key combination

Pin Pair (traces, connection, and both pins) Shift+click trace or connection.

Whole Net (traces, connections, and pins) F6+click a trace, pin, or connection.
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Table  52. Selecting Using Shift and Function Keys  (continued)

Item to select Key combination

Whole Net (pins only) Shift+click a pin.

Multiple Trace Segments Click the first segment, then Shift+click the last 
segment. All segments in between are selected.

Whole Drawing Shape Shift+select an edge.

The following table shows how to extend the selection of currently selected objects.

Table  53. Extending the Selection of Selected Objects

Additional items to select Command

Select Pin Pairs from selected pins Right-click and click the Select Pin Pairs, 
popup menu item or press the F5 key.

Select Pin Pairs from selected traces Right-click and click the Select Pin Pairs  popup 
menu item, or press the F5 key.

Select Nets from selected pins Right-click and click the Select Nets  popup 
menu item, or press the F6 key.

Select Nets from selected pin pairs Right-click and click the Select Nets  popup 
menu item, or press the F6 key.

Select Nets from selected traces Right-click and click the Select Nets  popup 
menu item, or press the F6 key.

Select Electrical Nets from selected nets Right-click and click the Select Electrical Net 
popup menu item.

For instructions to select items in the two modes, see the following topics:

• Selecting Using Select Mode

• Selecting Using Verb Mode

Selecting Using Select Mode

Selecting Using Verb Mode

Selecting Using Select Mode
You can apply various commands to an object when you select it first. This is also called Object Mode.

Procedure
1. Point to the object and click. The selected item highlights.

2. Use one of the following:
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• Right-click to open a popup menu of commands that are appropriate for the selected item.

• Click a toolbar button to start a command.

• Click a menu command.

Selecting Using Verb Mode
When you select a command first, you are restricted to select only those design objects to which the 
command applies.

Procedure
1. Open one of the toolbars by clicking one of the following buttons on the Standard Toolbar. Each 

toolbar provides a specific set of additional buttons.

Figure 11. Toolbar Buttons

2. Press the Esc key before you click a button to make sure nothing is selected. If something is 
selected when you click a button, the command acts on the already selected item.

3. Click one of the buttons on the newly opened toolbar. The command attaches to the pointer and 
the Status Bar displays the command name. Now you can apply the command to objects that you 
select. When you move the pointer into the workspace, a small V appears on the pointer to show 
that the selected command is active - the pointer is in verb mode.

4. Select an object on which to perform the active command. An object is one discreet item in the 
design, such as a route segment or part. Click the Select  button to cancel the command. Some 
commands work with area selection (multiple items). For example, the Move command or the Bus 
Route command.

Examples
On the Design Toolbar, click the Spin  button. The small V attaches to the pointer within the workspace. 
Select a component. The component is in Spin Mode. Indicate a new orientation or press the Esc key to 
cancel the spin.

Cycle Picking
When you cannot easily select the object you want because several objects occupy the same location 
use cycle picking.

Procedure
1. Move the pointer over the object to select, and click.

2. If you did not select the correct object press the Tab key. Alternatively, you can click the Cycle 
button on the Standard Toolbar, or click Cycle  on the Edit  menu, or right-click and click the Cycle 
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popup menu item. Any of these actions deselects the currently selected object and selects a new 
object at the same location within the pick radius.

3. You can continue to click the Cycle  button to cycle the current selection through all objects at the 
pointer location.

Selecting Objects by Selected List
Selected List displays what currently selected graphically, from which to choose the target object(s) you 
want. It is a more efficient choice for you to select object(s) in a dense or crowded area.

Procedure
1. Make area/multiple selection in dense areas of the design to include your target object(s).

2. Right-click, and click the Selected List  popup menu item.

3. The Selected List Dialog Box  opens and lists all the objects currently selected in the workspace.

4. Select target object(s) in the list by checking the entry check box, which will be highlighted in the 
workspace simultaneously. You can also:

• Add additional design objects to the list: Press and hold the Ctrl key while you click.

• Remove the selected item(s) from the list by clicking Remove.

Note:
To clear the list, you can also click in an empty area of the workspace.

• Filter objects by name: Type a wildcard or expression  in the Name box, and press the Enter key 
or click Filter. If you do not want to restrict the results with a filter, you can display all items by 
typing * (asterisk).

• Fits the selected objects into the workspace by clicking Fit to View.

• Exports what currently in the list to a local CSV file by clicking Export.

For specific parameter description, see Table 200.

5. Close the dialog box.

Selecting Stitching Vias in a Shape
When you are working with vias in a design, you may want to select all of the stitching vias in a shape in 
order to modify them. You can select all stitching vias inside copper or a copper plane outline.

Procedure
1. Select the copper or copper plane outline.

2. Right-click and click the Select Stitching Vias  popup menu item.
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Isolated Stitching Via Selection
An isolated stitching via is not connected to any hatch outline or copper area. You can locate such vias by 
selecting them. You can select all isolated stitching vias in the entire design or just those associated with 
a specific net.

The search for isolated stitching vias ignores connections to CAM plane layers.

• To select all isolated stitching vias in the design  — With no object selected, right-click in the 
design area and click the Select Isolated Stitching Vias  popup menu item.

• To select isolated stitching vias associated with a net  — Select a net then right-click and click 
the Select Isolated Stitching Vias  popup menu item.

Tip
When you verify your design, you can find isolated stitching vias by performing a 
Connectivity Check; however, you first need to set up that check. For information, see 
“Setting Up Checking for Isolated Stitching Vias.”

Running the Selection Report
The selection report is a quick way to determine everything you have selected in your design. This report 
is a great way to ensure that you are moving and editing exactly what you want.

Restrictions and Limitations
The Selection Report is available only when at least two objects of different types are selected in your 
design.

Procedure
1. Select more than one type of object.

2. Right-click and click the Selection Report  popup menu item, or click the View  > Selection Report 
menu item.

Results
The report.rep  file opens in your default text editor and displays everything you have selected in your 
design at this moment.
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Object Finding
Use the Find dialog box to find and select single or multiple objects by reference designator, part type, 
line width, or other aspect.

Find works two ways, depending on your selection mode  on page 115:

• Select mode  — Find ignores the Selection Filter  on page 114 settings and selects whatever you 
ask it to.

• Verb mode  — Find only looks for items that are logical for verb mode.

A few of the Find By commands present more complex commands for finding.

Finding By Attribute
Finding By Keepout
Finding Fonts
Finding By Physical Design Reuse
Finding By Test Point Types
Finding by Thermal Attributes
Finding by Hatch Outline
Finding by Isolated Hatch Outline

Finding By Attribute
You can find objects by attribute name or attribute value.

Procedure
1. Click the Edit  > Find  menu item. The Find Dialog Box  opens.

2. In the “Find By” list, click Attribute. A list of attributes in the design appears in the Attribute list box.

3. To filter the attributes, select an attribute in the Attribute list or type a wildcard or expression  in the 
Value box and click Apply. When you click an attribute, attribute values appear in the list box on 
the right. You can select more than one attribute.

4. You can select one or more values from the Attribute Value box.

5. Click OK  to apply the action as selected in the Action list.

Finding By Keepout
You can sort keepouts by restriction type when finding them.
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Procedure
1. Click the Edit  > Find  menu item. The Find Dialog Box  opens.

2. In the “Find By” list, click Keepouts. A list of restriction types in the design appears in the 
Restrictions box on the left.

3. To filter the keepouts, type a wildcard or expression  in the Value box and click Apply. You can 
select one or more restrictions. If you select a Component Height restriction, a list of available 
heights appears in the list box on the right.

4. Click OK  to apply the action as selected in the Action list. The action is applied to all keepouts that 
have the selected restriction.

Finding Fonts
Use the Find dialog box to find fonts in labels or text strings in your design. When you use it in conjunction 
with the Select action, you can then use the Properties dialog box to set up new fonts or font styles.

Procedure
1. Click the Edit  > Find  menu item. The Find Dialog Box  opens.

2. In the “Find By” list, click Label Fonts or Text Fonts.

3. In the Text Fonts box, click one or more fonts to find. The list includes all fonts in the design. Once 
you select a text font, the Styles area is populated with the list of font styles used in the design.

4. In the Styles area, click one or more styles to find. The list includes all font styles in the design.

5. Click OK  to apply the action as selected in the Action list.

Finding By Physical Design Reuse
You can use the Find dialog box to find reuse objects by reuse type or by reuse name.

Procedure
1. Click the Edit  > Find  menu item. The Find Dialog Box  opens.

2. In the “Find By” list, click Reuse Type. A list of reuse types in the design appears in the list box on 
the left.

3. To filter the reuse, type a wildcard or expression  in the Value box and click Apply  or click a reuse 
type. A list of reuse names (names for each instance of the type) appears in the list box on the 
right.

4. Click OK  to apply the action as selected in the Action list.

Finding By Test Point Types
Use the Find dialog box to find the test point types in your design.
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Procedure
1. Click the Edit  > Find  menu item. The Find Dialog Box  opens.

2. In the “Find By” list, click Test Point Types.

3. In the Test Point Types box, click to search by Via, Component pin, or Net. The contents of the list 
box at the right of the dialog box changes depending on what you select. The table below shows 
what the List Box displays for each of the available selections

Table  54. Test Point Types List

Selection List Box Contents

Via Lists and sorts, in order, all types for test points on vias.

Component pin Lists and sorts, in order, all nets containing test points on component 
pins. Jumper pins are treated as component pins by Find.
If the design has at least one unused component pin with a test point 
attribute, the name Unused Pins appears at the bottom of the list box. 
All unused pins with the test point attribute are also searched for test 
points.

Nets Lists all nets with test points, either on component pins or vias.
If the design has at least one unused component pin with a test point 
attribute, the name Unused Pins appears at the bottom of the list box.

4. To filter the test points, type a wildcard or expression  in the Value box and click Apply.

5. Click OK  to apply the action as selected in the Action list.

Results
The search result differs depending on which box has the current selection, the Test Point Types box or 
the one to the right of it. If you have selected a category, all objects of that category are found, but if a 
specific item is selected in the box to the right of the category, only that item(s) is found.

Finding by Thermal Attributes
Find thermals sorted by their inner pad size.

Procedure
1. Click the Edit  > Find  menu item. The Find Dialog Box  opens.

2. In the “Find By” list, click Thermal Attributes.

3. To filter the attributes, type a wildcard or expression  in the Value box and click Apply.

4. In the Inner Size box, select an inner pad size. The list on the right lists a breakdown of thermals 
using the following format: outer/number of spokes/spoke width/rotation format.

5. Click OK  to apply the action as selected in the Action list.
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Finding by Hatch Outline
Find small copper plane hatch outlines that you want to delete.

Procedure
1. Click the Edit  > Find  menu item. The Find Dialog Box  opens.

2. In the “Find By” list, click Hatch outline.

3. Type the area size of the copper plane in squared current design units in the Value field. All copper 
planes of equal size or less are selected. For example, your current design units are mils. To select 
all copper plane areas smaller than two square mils, type 4 in the value box.

4. Click OK.

5. Press the Delete key.

Finding by Isolated Hatch Outline
Locate areas of copper plane that have been isolated from the main plane area, but are still part of the 
same netname. Cleared obstacles that are too close to the edge of the copper plane outline usually cause 
isolated copper planes.

Procedure
1. Click the Edit  > Find  menu item. The Find Dialog Box  opens.

2. In the “Find By” list, click Isolated hatch outline. Copper plane areas not assigned a netname are 
not considered isolated; they are excluded from this operation.

3. Click OK.
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4. Press the Delete key.

Figure 12. Isolated Hatch Outline

Highlighting Objects
You can highlight an object without performing an operation on it.

Procedure
1. Select the objects to highlight.

2. Click the Edit  > Highlight  menu item to show the object as highlighted.

The highlight color from the Display Colors Setup Dialog Box  is applied to highlighted objects.

If you selected the object afterwards, it loses its highlighting.

3. To remove the highlighting from the object, select the object and click the Edit  > Unhighlight  menu 
item.
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Measurement
You can measure clearance distances or objects in your design using two modeless commands.

Using Quick Measure
Using Quick Length

Using Quick Measure
Use the Q modeless command to measure using a dynamic ruler or measuring stick.

Procedure
1. Locate your pointer at the starting location of your measurement. Without further movement of the 

pointer, type the Q Modeless Command  on page 83 and then type Enter.

2. Move the pointer in any direction and a line is drawn indicating the span of your measurement. 
Three measurement values are displayed as you move the mouse pointer.

• dx  — Displays the delta measurement along the x axis.

• dy  — Displays the delta measurement along the y axis.

• d  — Displays the delta of the euclidean measurement between the start and end point.

3. When finished, press the Esc key to exit the Quick Measure mode.

Using Quick Length
Use the QL modeless command to measure routed objects you have selected in the design.

Procedure
1. Select a net, pin pair, or one or more routed segments in the design.

2. Type the QL Modeless Command  on page 83 and then press the Enter key. The measurement of 
the selected route objects is given in a Layout.err  report file which opens.

Cut, Copy, and Paste Commands
Use the Cut, Copy, and Paste commands just as you would in any other Windows software. You can 
paste the same copy repeatedly; it remains on the clipboard until you overwrite it with a new copy or cut 
action. You can also paste into a different design.

While the cut, copy, and paste commands function as you would expect in the Windows OS, these 
commands also perform uniquely in specific situations:
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• Cut, Copy, and Paste support attributes  — When you cut, copy, or paste objects their 
attributes are cut, copied, and pasted with them. Attribute labels are also cut, copied, and pasted 
with the objects to which they are assigned.

• Cut, Copy, and Paste also support physical design reuses  — You can copy only one physical 
design reuse at a time. When you copy a physical design reuse and paste it into a different 
design, the reuse file is compared against the current design to detect possible reference 
designator, layer, decal, and net-name conflicts. This comparison will also detect other errors and 
warnings, as described in “Process of an Added Physical Design Reuse”.

• Cut, Copy, and Paste a group  — When you paste a group, an error may appear in one of the 
Trace Copy dialog boxes. For more information, see the “Trace Copy Dialog Box” topic. The 
Group editing options  on page 1503 also affect this.

• Pasting  — You can only paste items in DRC Off mode.

• Copy Traces, Traces and Vias, or Routed Pin Pairs Only  — When you select and copy a trace 
or a trace and via combination, you start a specialized operation that immediately attaches a 
copy of the selected routing to the pointer and lets you repeatedly paste with a mouse click. This 
function bypasses the paste command and automatically adds the design object to the pointer 
and allows you to paste with design rule checking enabled.

• Capture an Area as a Bitmap Image  — You can use the Edit  > Copy as Bitmap  menu item to 
define a rectangular area from which to copy graphics information to the Clipboard as a bitmap 
image, which you can use in other files and documents. For instructions, see “Copying a Bitmap”.

• Copying and Pasting in ECO mode  — Any addition to the design that would force updating the 
netlist or part list must take place in ECO mode. Use the ECO Options Dialog Box  to target and 
direct the .eco  file. If something is in the buffer that is not in the current part list or netlist, and you 
try to paste outside of ECO mode, SailWind Layout prompts you to enter ECO mode to complete 
pasting.

• Copy Multiple Selections  — You can copy and paste multiple or mixed selections, or different 
item types on different layers using a selection rectangle. You can also build extended selections. 
For example, you can use a selection rectangle to copy an SMD part, its via fanouts, and an 
associated dimensioning item that was assigned to a documentation layer. You can only select 
items that appear on screen. You can copy the selected items to the Clipboard, retaining their 
layers and relative positions.

• Paste Multiple Selections  — When the Clipboard holds multiple selections comprised of some 
ECO and some non-ECO registered items, Paste operates differently depending on whether you 
are in ECO mode. If you paste in ECO mode, all items can be pasted. Part reference designators 
are added sequentially. If you are not in ECO mode, you can paste only non-ECO registered 
items.

Delete Command
Like the Copy and Paste operations, the Delete command is sensitive to whether you are in ECO mode. 
When the ECO Toolbar is not open, you can press the Delete key to unroute selected segments, pin 
pairs, or nets, leaving the connections intact.
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Restriction:
You cannot delete physical design reuses that contain glued components or protected routes.

When the ECO Toolbar is open, you can use Delete to completely remove parts or nets from the design. 
You can remove any non-ECO items like copper, lines, or text normally. You can also unroute routed 
traces normally. If you delete a group of ECO and non-ECO items, or combined ECO items (parts and pin 
pairs or nets), confirmation prompts, one for each item, will appear sequentially.

Copying a Bitmap
Define a rectangular area to copy graphics information as a bitmap image. Then you can switch to 
another application, Microsoft Word for example, and use the Paste command to insert the bitmap into a 
document.

Procedure
1. Click the Edit  > Copy as Bitmap  menu item.

2. Area select  on page 118 the area to copy. All visible items in the rectangle including the 
background, dot grid, and color, are copied.

3. Open the application in which you want to place the bitmap and paste to place the image.

Tip
You can also insert the picture with the Paste Special  menu item in products that support 
this feature.

Object Snap
You can snap to specified types of objects instead of snapping to the grid when you use the Q (Quick 
Measure) modeless command, perform any drafting modification, or perform any component placement 
command.

This includes:

• Add new drafting shape (of any type)

• Modify existing drafting shape (moving a corner or edge)

• Add a new corner to an existing drafting shape

• Split the edge of an existing drafting shape

• Move an entire drafting shape or group of shapes

• Add a new component
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• Add a new stitching via

• Move a component or via

• Add a terminal in the Decal Editor

• Move a terminal in the Decal Editor

During all these procedures, the Snap to Objects  menu item and the Snap to  sub-menu of object 
types can be found on the popup menu. You can also control object snapping using the OS Modeless 
Commands, or the Object Snap options  on page 1540.

You can enable the display of markers to indicate the different types of snapping points in the Object 
Snap options  on page 1540.

The snapping to objects takes precedence over snapping to the grid if Snap to grid is enabled for the 
Design grid when the pointer is within the Snap radius.

If there is more than one object type in the vicinity of the Snap radius, the object type with the highest 
precedence is selected. The order of precedence is the order in which the object types appear in the 
Object Snap options  on page 1540. You can always filter out the types of objects to snap to if there are 
conflicts.

You can snap to points on the following design objects as long as they are visible in the design:

• drafting items (2D lines, coppers, keepouts, board outline, dimensioning lines)

• pins

• vias

• components
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Chapter 5
Setting Colors

You can set and apply colors in SailWind Layout in one of four ways: to all design objects globally, to 
individual nets, to design objects set up in the Decal Editor, and to design objects in the CAM document 
output.

• Design  — Use the Display Colors Setup Dialog Box  to set colors to objects on each layer.

• Nets  — Use the View Nets Dialog Box  to set colors to individual nets.

• Decal  — Use the Display Colors Setup Dialog Box  within the Decal Editor. Once you bring the 
decal into a design, the decal assumes the design colors. You can change colors in the Decal 
Editor; however, the colors remain for the duration of your editing session with the decal only. 
When you change the decal, it reverts back to the defaults.

• CAM  — Use the Select Items Dialog Box  to set colors to objects in CAM before printing the CAM 
document. You must have a color printer for the colors to be available in the Select Items dialog 
box.

The following topics cover the Design color settings.

Setting Colors for the Design
Changing the Color Palette
Making All Objects Visible
Hiding Design Objects
Hiding Layers
Making Pin Numbers and Net names Visible or Invisible
Pin Number and Net Name Display Options
Saving Color Assignments to a File
Make Permanent Changes to the Display Colors

Setting Colors for the Design
As you work on a layout design, you can customize display colors to make it easier to see objects as you 
place them.

Using the Display Colors Setup dialog box, you can:

• Set and change the color of objects on a per layer or per object type basis.

• Make objects visible or invisible in the display (also on a per layer or per object type basis).

• Customize the palette of color selections.

• Save your customizations in a configuration file.
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Procedure
1. Click the Setup  > Display Colors  menu item.

Tip
You can clear the Display Colors Setup dialog box of the preset color assignments in the 
Layers/Object Types. Click Assign All  and in the Assign Color to All Layers dialog box, 
click Assign Background Color to All Objects and then click OK.

2. In the Display Colors Setup Dialog Box, set the color(s) for design objects:

a. To set the color for one object, in the Selected Color area, click a color tile. Then in the Layers/
Object Types table, click the color tile for the object type in the correct layer row.

Tip
To change the palette of colors from which you can select, see “Changing the Color 
Palette”.

b. To make all objects on a layer the same color, click the layer number to select the entire row, 
and then click the color tile in the Selected Color area.

c. To make an object the same color on all layers, click the object name to select the entire 
column, and then click the color tile in the Selected Color area.

d. To make an object type invisible, set its tile to the background color. You can make multiple 
objects invisible (for example, all objects on the same layer). For more information, see “Hiding 
Design Objects”.

Tip
To automatically make an object type the same color on all layers, use the Assign 
Color to All Layers dialog box.  on page 1094

3. Click OK. The display reflects your color settings.

Results
When you save the design, SailWind Layout stores the settings with design data.

You can save display color settings you commonly use as you work on a design. See “Saving Color 
Assignments to a File”.

You can use modeless commands to make pin numbers and net names visible or invisible. See “Making 
Pin Numbers and Net names Visible or Invisible”.

Color configurations saved in PowerPCB versions 2.1 and lower cannot be used in PowerPCB versions 
3.0 and higher.

Changing the Color Palette
You can change the color tiles that appear in the color palette. Changing the color tiles allows you to 
quickly choose custom colors.
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Procedure
1. Click the Setup  > Display Colors  menu item.

2. In the Display Colors Setup dialog box  on page 1318, in the Selected Color area, click the color 
tile that you want to change.

3. Click Palette.

4. In the Color dialog box, click the color value you want to use. You can also create a custom color. 
Refer to the Windows Help for more information on changing the Windows color palette.

5. Click OK  to return to the Display Colors Setup dialog box. You may need to click the selected color 
tile again to see the color change. The new color appears in the tile you selected.

6. Click OK  to close the Display Colors Setup dialog box.

Results
You can bring back the original color palette by clicking Default Palette.

Making All Objects Visible
The Assign Colors to All Layers dialog box contains several shortcuts for quickly assigning colors to all 
layers, including the background color.

Procedure
1. Click the Setup  > Display Colors  menu item.

2. In the Display Colors Setup dialog box  on page 1318, click Assign All.

3. In the Assign Color to All Layers Dialog Box, click Automatically Make Objects Visible.

4. In the Color Preference list, select one of the following:

• One Color Per Object Type  — Assigns one color for a certain object type on all layers. For 
example, assign the color which is currently set to the background color, on all layers,

• One Color for a Layer  — Assigns color for all objects, which are currently set to the 
background color, on the same layer.

• Selected Color  — Assigns a color you select from the Display Colors Setup dialog box color 
matrix to all objects, which are currently assigned the background color, on all layers.

5. Click OK  to return to the Display Colors Setup dialog box.

6. Click OK  to close the Display Colors Setup dialog box.

Results
You can also use the same dialog box to make objects invisible. See “Hiding Design Objects”.
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Hiding Design Objects
When you are placing or routing components in a layout design, it can be helpful to make certain objects 
visible in the display and others invisible. For example, you might want to make objects on the power, 
ground, and bottom layers invisible when you are routing on the top layer.

You can also hide individual net connections or traces using the View Nets Dialog Box.

When you are working in the design, you can make pin numbers or net names invisible (or visible again) 
using modeless commands. See “Making Pin Numbers and Net names Visible or Invisible”.

Procedure
1. Click the Setup  > Display Colors  menu item.

Tip
Save your current color configuration  on page 135 to revert to the design colors you were 
using.

2. In the Display Colors Setup Dialog Box, use the method that matches what you want to do:

• Make one object type invisible  — Set its tile to the background color.

• Make all objects on a layer invisible  — Clear the check box to the right of the layer name. For 
specific information on hiding layers including shortcuts, see “Hiding Layers”.

• Make an object type invisible on all layers  — Clear the check box above the column for that 
object type.

• Make all objects invisible  — Change their colors on all layers to the background color. Click 
Assign All. In the Assign Color to All Layers Dialog Box, click Assign Background Color to 
All Objects. You might use this option as a quick way to clear the display of objects except for 
board outline and connections, whose colors are set in the Other area.

3. Click OK.

Hiding Layers
Hide layers in the design to reduce clutter in the display. The invisible layers are still listed in dialogs and 
the layer list, but are invisible in the design.

Tip
A wide array of shortcuts for hiding layers is available as modeless commands. See the 
“Modeless Commands for Layer Visibility (Quick Layer View)  on page 83” table.
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Making Pin Numbers and Net names Visible or Invisible

Procedure
1. Click the Setup  > Display Colors  menu item.

2. In the Display Colors Setup Dialog Box, clear the check box to the right of the layer name that you 
want to hide. As an alternative, you could use the Z modeless command to hide a specific layer. 
For example, type Z -2 to hide layer 2 from view.

Results
The layer is hidden without affecting the color tiles of the objects on that layer. You could achieve the 
same effect by assigning the background color to all the objects on the layer but then you would have to 
reassign colors to the layer objects to make them visible again.

Making Pin Numbers and Net names Visible or 
Invisible
While working in a layout design, you can use modeless commands to turn display of net names and pin 
numbers on or off.

• See the PN modeless command in the “Modeless Commands for Object Visibility table”  on 
page 83.

• See NN, NNP, NNT, and NNV modeless commands in the “Modeless Commands for Net Name 
Visibility table  on page 83”.

Pin Number and Net Name Display Options
You can set the text size of displayed net names and pin numbers, and the maximum allowable gap 
between net names on traces.

Use the Display category of the Options dialog box  on page 1525.

Saving Color Assignments to a File
You can save color assignments you have specified in the Display Colors Setup dialog box to a file.

Procedure
1. Click the Setup  > Display Colors  menu item.

2. In the Display Colors Setup Dialog Box, set the color assignments you want.

3. Click Save  in the Configuration area.

4. In the Save Configuration dialog box that appears, type the configuration name.
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• You are not prompted if you overwrite an existing color configuration.

• To save the current color settings under an existing configuration, select the configuration name 
from the configuration list and click Save. Name the new configuration with the old file name. 
The file is overwritten.

Results
The current color settings are saved under the new name. Configurations are saved in the C:
\<install_folder>\<version>\Settings  folder as the saved name with a .ccf  extension. To change the default 
display colors setup, name the color configuration default.ccf.

To use a previously saved configuration, select the configuration name from the Configuration list.

To delete a configuration, select the configuration in the list and click Delete.

Make Permanent Changes to the Display 
Colors
The Display Colors of the Design Editor and the PCB Decal Editor only change for the current Design 
or Decal. To make permanent changes to the colors, you must create a new default start-up file for the 
Design Editor or the PCB Decal Editor.

For the Design Editor, see “SailWind Layout Default Settings”.

For the PCB Decal Editor, see “Creating a New Default Decal Editing Environment”.
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Chapter 6
Managing Libraries and Library Data

Read the following topics to learn more about the creation, modification, and management of libraries, 
including information on library search order, import/export of library data, and the generation of library 
reports.

SailWind Libraries
Conversion of Older PADS Libraries to the Current Format
Creating a New Library
Displaying Items in a Library
Modification of Library Data
Library Availability and Search Options
Library Attribute Management
Import and Export of Libraries
Library Report Creation
Wildcards and Expressions

SailWind Libraries
The parts, decals, and other items you use to lay out a design in SailWind reside in one or more SailWind 
libraries.

Libraries store decal and part type attributes and attribute labels, but they do not store attribute values. 
The following table shows the four kinds of items that can exist in a library.

Table  55. Library Items

Item Description

Decal The graphical representation of the part when it is drawn. This is often 
referred to as the footprint.

Part Data about a part, including logic family, attributes, pins, and gates. For 
example, as a 74LS02.

Lines Graphical data you can store in the library to use in any design file. For 
example, a company logo.

CAE Decal The graphical representation of a schematic part, such as a NOR gate. 
These items are read-only. Use SailWind Logic to create and modify CAE 
decals.

A single SailWind library consists of 4 files, each containing items of a specific type identified by the file’s 
extension, as follows:
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Table  56. SailWind Library Files

File Extension File Contents

.pt Part Types

.pd PCB Decals

.ld CAE Decals

.ln Line graphics

For information on creating CAE decals, see “Creating a New CAE Decal” in the SailWind Logic Guide. 
For information on creating line graphics, see “Adding Drafting Items from a Library” in this manual.

Conversion of Older PADS Libraries to the 
Current Format
To support new functionality, the library structure for SailWind Layout and SailWind Logic updates from 
time to time. When you convert earlier versions to the latest version libraries, they change so they 
become compliant with the latest software. The conversion changes the file name extension.

For steps detailing how to convert libraries, see the Library Converter  Help.

Tip
If you have libraries from PowerPCB versions 1 or 2 you need to use the library converter in 
PowerPCB 3.x.

A report file is created listing which libraries converted along with their conversion status (fully converted, 
converted with n failures, or no conversion possible). For each library the report will list the items that 
converted with their status (converted OK or failed to convert).

For information on how to convert older PADS libraries to the current SailWind format, see the SailWind 
Library Converter User’s Guide.

Creating a New Library
When you create a new library, you actually create a blank container for library content and add it to the 
Library List. After you create this new library, you can then fill it with content.

Tip
You can also add an existing library - for more information, see “Adding Libraries to the Library 
List”.

Procedure
1. Click the File  > Library  menu item.

2. Click Create New Lib.
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Displaying Items in a Library

3. In the New Library dialog box, specify the folder and library file name, and then click Save.

4. Click Close.

Results
Your library is added to the bottom of the Library list which is also the last library in the search order 
on page 145. To move your library up in the library list and search order, see “Setting the Library List 
Order”.

Displaying Items in a Library
Use the Library Manager dialog box to display the items contained in a library.

Procedure
1. Click the File  > Library  menu item.

2. In the Library Manager Dialog Box, select a library in the Library list or select the (All Libraries) item 
at the top of the list.

3. Click one of these buttons to display categories of items in the library:

• Decals  — PCB decals (component footprints)

• Parts  — The electrical information that joins with the PCB decal

• Lines  — Drafting objects

• Logic  — CAE decals (schematic symbols) (Use SailWind Logic to edit CAE decals.)

4. An empty filter box yields no results. To filter the list, type wildcards or expressions  on page 155
in the Filter box. If you do not want to restrict the results with a filter, you can display all items by 
typing * (asterisk) in the Filter box.

5. Click Apply.

Results
Library item names are displayed in the PCB Decals, Part Types, Line Items, or CAE Decals list. (The 
list name changes based on the Filter you have selected.) The preview window displays a graphic of the 
library object.

Since library Parts have no visual representation, the preview window displays the first PCB decal 
associated with the part.
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Modification of Library Data
SailWind Layout provides a wide range of options for modifying your library data to meet your design 
requirements.

Adding Items to a Library
Deleting Items from a Library
Copying a Library Item
Editing Items in a Library
Deleting All Items in a Library
Transferring Library Data

Adding Items to a Library
You can add new items to a library using the Library Manager dialog box.

Procedure
1. Click the File  > Library  menu item.

2. In the Library Manager Dialog Box, select a library in the Library list. If you select (All Libraries), the 
New  button is unavailable.

3. Click one of these buttons to display categories of items in the library:

• Decals  — PCB decals (component footprints)

• Parts  — The electrical information that joins with the PCB decal

• Lines  — Drafting objects

• Logic  — CAE decals (schematic symbols) (Use SailWind Logic to edit CAE decals.)

4. Click New

◦ Decals  — Opens the PCB Decal Editor with the default configuration required to create a 
new decal. For more information, see “Creation of a New Decal”.

◦ Parts  — Opens the Part Information Dialog Box with the default configuration required to 
create a Part Type. For more information, see “Creation of a New Part Type”.

◦ Lines  — New and Edit are unavailable. There is no special library lines editor. Use 
drafting tools to create or edit lines and save them to the library. For more information, see 
“Creating a Drafting Object” and “Saving a Drafting Item to a Library”.

◦ Logic  — New and Edit are unavailable. Use SailWind Logic to create CAE decals. For 
more information, see ““Creating a New CAE Decal””.
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Deleting Items from a Library
You can remove or delete one or more selected items from a library.

Procedure
1. Click the File  > Library  menu item.

2. In the Library Manager Dialog Box, select a library in the Library list. If you select (All Libraries), the 
Delete  button is unavailable.

3. Click one of these buttons to display categories of items in the library:

• Decals  — PCB decals (component footprints)

• Parts  — The electrical information that joins with the PCB decal

• Lines  — Drafting objects

• Logic  — CAE decals (schematic symbols)

4. An empty filter box yields no results. To filter the list, type wildcards or expressions  on page 155
in the Filter box. If you do not want to restrict the results with a filter, you can display all items by 
typing * (asterisk) in the Filter box.

5. Click Apply.

6. Select one or more items in the PCB Decals, Part Types, Line Items, or CAE Decals list. (The list 
name changes based on the Filter you have selected.)

Use Ctrl+click to select multiple non-sequential items. Use Shift+click or drag the cursor to select a 
range of items.

7. Click Delete.

Copying a Library Item
You can copy a selected item to another name or another library.

Procedure
1. Click the File  > Library  menu item.

2. In the Library Manager Dialog Box, select a library in the Library list.

If you select (All Libraries), the Copy  button is unavailable.

3. Click one of these buttons to display categories of items in the library:

• Decals  — PCB decals (component footprints)

• Parts  — The electrical information that joins with the PCB decal
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• Lines  — Drafting objects

• Logic  — CAE decals (schematic symbols)

4. An empty filter box yields no results. To filter the list, type wildcards or expressions  on page 155
in the Filter box. If you do not want to restrict the results with a filter, you can display all items by 
typing * (asterisk) in the Filter box.

5. Click Apply.

6. Click Copy.

7. In the dialog box that opens, select another library to receive the item, and/or type a new item 
name, and then click OK.

◦ Decals  — Opens the Save PCB Decal to Library Dialog Box

◦ Parts  — Opens the Save Part Type to Library Dialog Box

◦ Lines  — Opens the Save Drafting Item to Library Dialog Box

◦ Logic  — Opens the Save CAE Decal to Library Dialog Box

Editing Items in a Library
You can use the Library Manager to edit items in a library.

Procedure
1. Click the File  > Library  menu item.

2. In the Library Manager Dialog Box, select a library in the Library list.

If you select (All Libraries), the Edit button is unavailable.

3. Click one of these buttons to display categories of items in the library:

• Decals  — PCB decals (component footprints)

• Parts  — The electrical information that joins with the PCB decal

• Lines  — Drafting objects

• Logic  — CAE decals (schematic symbols)

4. An empty filter box yields no results. To filter the list, type wildcards or expressions  on page 155
in the Filter box. If you do not want to restrict the results with a filter, you can display all items by 
typing * (asterisk) in the Filter box.

5. Click Apply.

6. Click Edit.
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◦ Decals  — Opens the PCB Decal Editor with the selected decal. For more information, see 
“Editing a Library Decal”.

◦ Parts  — Opens the Part Information dialog box on a selected part. For more information, 
see “Creating and Modifying Part Types”.

◦ Lines  — Unavailable. There is no special library lines editor. Use drafting tools to create 
or edit lines and save them to the library. For more information, see Creating a Drafting 
Object  and “Saving a Drafting Item to a Library”.

◦ Logic  — Unavailable. Use SailWind Logic to create CAE decals. For more information, 
see “Creating a New CAE Decal”.

Deleting All Items in a Library
You can delete all library items by replacing an existing library with a new empty one of the same name. 
Doing so ensures that there are no items left inadvertently when you delete a library.

Restrictions and Limitations

• You cannot delete the contents of a read-only library.

Procedure
1. Click the File  > Library  menu item.

2. Click Create New Lib. The New Library dialog box appears.

3. Select the library file whose contents you want to delete.

4. Click Save, and then click Yes  when prompted.

5. Click Close.

Transferring Library Data
You can transfer library objects from one library to another.

Tip
To copy over single items, see “Copying a Library Item”.

Procedure
1. Follow the steps to export library data from the library  on page 151.

2. Then follow the steps to import the library data to another library  on page 151.
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Library Availability and Search Options
Use the Library List dialog box to specify search-related options such as the library search order and 
which libraries are available to the design. Operations in this dialog box affect the contents of the Library 
list in the Library Manager dialog box.

Adding Libraries to the Library List
Removing Libraries from the Library List
Library Content and the Search Order
Setting the Library List Order
Sharing a Library Across a Network
Controlling Library Search Access
Protecting Library Files
Synchronizing with SailWind Logic

Adding Libraries to the Library List
If you want to make a library’s contents available, add the library to the library list. The library must be 
listed in the Library Manager in order to search it and use its parts, decals, or line items in your design.

Procedure
1. Click the File  > Library  menu item, and then click Manage Lib. List.

2. In the Library List Dialog Box, click Add.

3. In the Add Library dialog box, specify the folder and file name of the library to add, and then click 
Open.

Results
The library is added beneath the currently selected library in the Library list.

Removing Libraries from the Library List
If you want to prevent a library’s contents from being used in a design, remove the library from the library 
list.

Procedure
1. Click the File  > Library  menu item, and then click Manage Lib. List.

2. In the Library List Dialog Box, in the Library list, select one or more libraries, and then click 
Remove.

Tip
The library files are not deleted from the computer.
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Library Content and the Search Order
Parts and decals you create do not have to be located in the same library together. When your part refers 
to a decal in a different library, SailWind Layout automatically picks up the decal when needed.

If you have multiple library items of one type and with the same name, the first occurrence of the item is 
chosen when the library is searched.

For example, during import of a schematic netlist, the libraries are searched for an 0603 decal. But there 
are two, each in a different library. The libraries are searched from the first library in the list, to the last 
library in the list. The first occurrence found will be selected for use to represent the part in the design.

When you have multiple libraries available, they are processed in their order in the library list whenever 
the libraries are searched. The libraries are searched during the following procedures:

• Searching for library items using various dialogs

• Importing a netlist from the schematic

• Updating your design from the library

• Annotating your design with new components from the schematic

You can change the search order of libraries using the Library List Dialog Box.

Setting the Library List Order
You can specify the order in which libraries are searched.

Procedure
1. Click the File  > Library  menu item, and then click the Manage Lib. List  button.

2. In the Library List Dialog Box, in the Library list, select the library, and then click Up  or Down  as 
needed.

With each click, the library moves up or down one place in the library list. The libraries are 
searched top to bottom.

Sharing a Library Across a Network
You can share a library across a networked environment to allow more than one user to access the library 
simultaneously.

Procedure
1. Click the File  > Library  menu item, and then click the Manage Lib. List  button.

2. In the Library List dialog box, in the Library list, select the library. You can select multiple libraries 
using the Shift and Ctrl keys.

3. Select the Shared check box.
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Results
More than one user can access the library file at the same time.

Controlling Library Search Access
You can enable or disable the searching of a particular library when performing operations that involve 
libraries, such as adding parts.

Procedure
1. Click the File  > Library  menu item, and then click the Manage Lib. List  button.

2. In the Library List dialog box, in the Library list, select the library. You can select multiple libraries 
using the Shift and Ctrl keys.

3. Select the Allow Search check box.

Protecting Library Files
The Read Only check box is only a status indicator; it is always shaded and unavailable for editing. You 
can set library read-only status only in the Microsoft Windows File Manager. To ensure file protection, the 
system administrator who owns the files is the only one who can set or clear the read-only status.

Procedure
1. In Windows Explorer, locate your library files. By default, libraries installed with the software are 

located at C:\<install_folder>\<version>\Libraries.

2. Select all four library files, right-click and click the Properties  popup menu item.

3. In the Properties dialog box, on the General  tab, select the Read-only check box.

4. Click OK.

Results
The library Read-Only check box in the Library List Dialog Box  will not update until you reopen the dialog 
box.

Synchronizing with SailWind Logic
You can enable or disable the synchronizing of library settings between SailWind Logic and SailWind 
Layout. When you select the “Synchronize with SailWind Logic” check box in SailWind Layout, all library 
changes you make within SailWind Layout copy also to SailWind Logic.

Tip
To ensure a round-trip synchronization, select the same check box in SailWind Logic.
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Procedure
1. Click the File  > Library  menu item, and then click the Manage Lib. List  button.

2. In the Library List Dialog Box, select the Synchronize with SailWind Logic check box.
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Library Attribute Management
Use the Manage Library Attributes dialog box to manage attributes on a library-by-library basis. You can 
add, delete, and rename attributes for all parts or decals in an individual library or in all libraries. You can 
also display all the attributes in a library, whether the attributes apply to all items or to individual items.

Tip
The Manage Library Attributes dialog box does not manage attributes in the design. Use the 
Attribute Dictionary  to manage attributes in the design.

Adding an Attribute to Multiple Library Items
Deleting Attributes from Library Items
Renaming Attributes of Library Items

Adding an Attribute to Multiple Library Items
You can add an attribute to all parts and decals, or just to parts or decals individually, in one or all 
libraries.

Restrictions and Limitations

• This process will yield no result or warning if the library you are working with is read-only. Check 
the status of the library in the Library List Dialog Box.

Procedure
1. Click the File  > Library  menu item.

2. In the Library Manager dialog box, click Attr Manager.

3. In the Manage Library Attributes Dialog Box, in the Select Library list, select an individual library or 
the (All Libraries) item at the top of the list.

4. In the Item Types list, choose whether to apply the new attribute to All Items, or only either Part 
Types or PCB Decals.

5. Click Add Attr. The Add New Attribute to Library Dialog Box  appears.

6. For the Attribute Name, do one of the following:

• Type an attribute name into the box

• Click Browse Lib. Attr  to search all libraries for an existing attribute name

7. If desired, you can type a value in the Attribute Value box.

8. Click OK. The Attribute Name appears in the Attributes in Library list.

9. Click Close.

148 SailWind Layout Guide and Reference



 
Managing Libraries and Library Data

Deleting Attributes from Library Items

Results
Your new attribute is added. Check for the new attribute in the Decal Attributes Dialog Box  (for PCB 
decals) or on the Attributes tab of the Part Information dialog box  on page 1584 (for Part Types).

Deleting Attributes from Library Items
You can delete one or more attributes from all parts and decals, or just from parts or decals individually, in 
one or all libraries.

Restrictions and Limitations

Note:
This process will yield no result or warning if the library you are working with is read-only. Check 
the status of the library in the Library List Dialog Box.

Procedure
1. Click the File  > Library  menu item.

2. In the Library Manager dialog box, click Attr Manager.

3. In the Manage Library Attributes Dialog Box, in the Select Library list, select an individual library or 
the (All Libraries) item at the top of the list.

4. In the Item Types list, choose whether to delete the attribute(s) from All Items, or from either Part 
Types or PCB Decals.

5. In the Attributes in Library list, select one or more attributes to delete, and then click Delete Attrs.

6. In the prompt that appears, click OK.

7. Click Close.

Results
Your attribute(s) is deleted. Check for the deleted attribute in the Decal Attributes Dialog Box  (for PCB 
decals) or on the Attributes tab of the Part Information dialog box  on page 1584 (for Part Types).

Renaming Attributes of Library Items
You can rename an attribute of all parts and decals, or just of parts or decals individually, in one or all 
libraries.

Restrictions and Limitations

Note:
This process will yield no result or warning if the library you are working with is read-only. Check 
the status of the library in the Library List Dialog Box.
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Procedure
1. Click the File  > Library  menu item.

2. In the Library Manager dialog box, click Attr Manager.

3. In the Manage Library Attributes Dialog Box, in the Select Library list, select an individual library or 
(All Libraries).

4. In the Item Types list, choose whether to rename the attribute(s) from All Items, or from either Part 
Types or PCB Decals.

5. In the Attributes in Library list, select one or more attributes to rename, and then click Add>>.

6. Double-click in the New Name cell. Type the new name that you want to specify for the attribute or 
to display all existing attributes in the library, click Browse Lib. Attr. If you would like to assign one 
of these existing names, select it and click OK. to close the Browse Library Attributes dialog box. 
This will load the name into the New Name cell.

Tip
You can specify the name of an existing attribute. No error message appears when you 
do this. The only time this may have an adverse effect is if both attributes are assigned 
to a single item, in which case the error is reported in the error file and the rename is not 
performed for those items where there are conflicts.

7. When you have finished with specifying the New Name, click Rename Attrs.

8. Click Close.

Results
Your attribute is renamed. Check for the renamed attribute in the Decal Attributes Dialog Box  (for PCB 
decals) or on the Attributes tab of the Part Information dialog box  on page 1584 (for Part Types).
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Import and Export of Libraries
Use the Library Manager dialog box to import or export library data in ASCII format.

Importing Library Data
Exporting Library Data

Importing Library Data
You can import library data from a previously-exported library ASCII file.

Tip
Beginning with PADS 9.0, die parts and flip chips are no longer identified by their family 
designations (DIE or FLP), but instead by the Special Purpose settings in the General tab of the 
Part Information dialog box  on page 1590. When you import an ASCII file created by a previous 
PADS version, these Special Purpose settings are automatically set for parts having the logic 
family DIE or FLP. The part’s family designation remains the same.

Procedure
1. Click the File > Library  menu item.

2. In the Library Manager Dialog Box, in the Library list, select the library to receive the library data.

3. To import one of the four file types, you must select the matching filter:

• If the file type is .c, select the Logic filter. This ASCII file contains CAE decals (logic symbols).

• If the file type is .l, select the Lines filter. This ASCII file contains drafting objects.

• If the file type is .d, select the Decals filter. This ASCII file contains PCB decals (component 
footprints).

• If the file type is .p, select the Parts filter. This ASCII file contains part types.

4. Click Import.

Note:
Import fails if the library to receive imported items is read-only.

5. In the Library Import File dialog box, specify the folder and the file name, and then click Open.

Exporting Library Data
You can export library data into an ASCII file for importing into another library.
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Procedure
1. Click the File  > Library  menu item.

2. In the Library Manager Dialog Box, in the Library list, select the library whose data you want to 
export.

3. Click any of the following:

• Decals  — Exports PCB decals (component footprints)

• Parts  — Exports Components

• Lines  — Exports drafting objects

• Logic  — Exports CAE decals (schematic symbols)

4. An empty filter box yields no results. To filter the list, type wildcards or expressions  on page 155
in the Filter box. If you do not want to restrict the results with a filter, you can display all items by 
typing * (asterisk) in the Filter box.

5. Click Apply.

6. Select one or more items in the list, and then click Export.

7. In the Library Export File dialog box, specify the folder, type the file name, and then click Save.

Results

• The Special Purpose settings of any die parts and flip chips are cleared.

• Die parts and flip chips having a family designation other than DIE and FLP lose their die part or 
flip chip special purpose and become normal parts.

• Any normal parts that have the DIE or FLP family designation are treated as die parts or flip chips 
in the previous PADS version.

152 SailWind Layout Guide and Reference



 
Managing Libraries and Library Data

Library Report Creation

Library Report Creation
You can create reports from the Library Manager to list any number of library objects. You can configure 
the Parts report to also list the values of attributes that you choose to include in the report.

Creating a Report of the Parts in a Library
Creating a Report of Decals, Lines or Logic Symbols in a Library

Creating a Report of the Parts in a Library
From the Library Manager, you can generate a report about the parts in a single library or all libraries. The 
report (an ASCII file) lists each part and its associated attributes. You can specify the attributes you want 
reported.

Examples of parts reports are shown below.

Procedure
1. Click the File  > Library  menu item.

2. In the Library manager dialog box, select a library from the Library list, or select (All Libraries).

3. In the Filter area, click Parts. A list of parts in the library (or in all libraries) appears in the Part 
Types area.

Tip
To refine the list, use the filter field. Type a part name in the field or use wildcards (*) to 
specify a group of parts. Then click Apply.

4. When you have the list of parts you want to report on, click List to File.

5. In the Report Manager dialog box, specify the part attributes you want to include in the report. 
In the Available attributes list, click an attribute to select it, then click Include>>. The attributes 
appear in the Selected attributes list.

To remove attributes from the Selected attributes list, select them and click Exclude>>.

6. Optionally, you can refine the list of parts to include in the report. In the Part Filter field, type a part 
name in the field or use wildcards (*) to specify a group of parts. Then click Apply.

7. Click Run.

8. In the Library List File dialog box, select a folder and file format for the report. You can select either 
of two formats:

• Library List format (lst): Information is formatted in columns for viewing or printing. (See Parts 
Report in .lst Format below.)

• Comma-separated values format (csv): format recognized by MS Excel. (See Parts Report 
in .csv Format below.)
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9. Click Save.

10. In the Report Manager dialog box, click Close.

Results
The Report Manager generates the report and displays a link to it in the Output window. To view or print 
the report, click the link. Notepad opens and displays the report.

Figure 13. Parts Report in .lst Format

Figure 14. Parts Report in .csv Format

Creating a Report of Decals, Lines or Logic 
Symbols in a Library
From the Library Manager, you can generate a report listing the decals, lines, or logic symbols in a single 
library. The report is an ASCII file listing each item’s name along with the date and time the item was 
modified.

For more information, see “Creating a Report of the Parts in a Library”.

Procedure
1. Click the File  > Library  menu item.

2. In the Library Manager dialog box, select a library from the Library list. The List to File button is 
unavailable for Decals, Lines, and Logic Symbols if you select All Libraries.

3. In the Filter area, click the filter you want. A list of parts in the library appears in the Part Types 
area.
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Tip
To select one or more specific item, use the filter field. Type an item name in the field or 
use wildcards (*) to specify a group of items. Then click Apply.

4. When you have the list you want to report on, click List to File.

5. In the Library List File dialog box, specify a folder and file name for the report and click Save.

Results
Notepad appears, displaying a list of the item names and the date and time when each was last modified. 
You can print the list from Notepad.

Wildcards and Expressions
You can use wildcards and expressions to filter the information that displays.

Table  57. Wildcards and Expressions

Expression: Use to:

* Match any number of characters.

? Match any one character.

[set] Match any character in the specified set.

 Tip
A set is composed of characters or a range of characters; for example, A-Z 
or 0-9 or a-z.

[!set] or [^set] Match any character not in the specified set.

\ Match a special syntactic character exactly, suppressing the special character's 
syntactic significance.

 Tip
The following characters need the \ before them: `[]*?!^-\'

Table  58. Usage Examples of Wildcards and Expressions

Expression: Results in all items that:

74* start with 74: 7404, 74LS04, 74622.

74?? start with 74 followed by any two characters: 7404, 74T2, 74TP.

74??08 start with 74, followed by any two characters, and end with 08: 74LS08, 
74HC08, 744608.

*08 start with any number of characters and end with 08: 2146108, 5408, 
54HCT08, 744608.
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Table  58. Usage Examples of Wildcards and Expressions  (continued)

Expression: Results in all items that:

*08* start with any number of characters, followed by 08, and end with any 
number of characters: 5408, 5408BE, 54HCT08AE, 74ABT08CE2, 
941M70839.

[57]* start with 5 or 7 with any number of characters after: 54HCT244, 
5968BAE4, 74ACT44.

[5-7]* start with 5 or 6 or 7 followed by any number of characters: 54LS08, 
6225BE, 69TF77, 74ALS02.

[57]4HCT?? start with 5 or 7, followed by 4HCT, and end with any two characters: 
54HCT04, 54HCT74, 74HCT27, 74HCT84.

74A[CH]* start with 74A, followed by C or H, and end with any number of characters: 
74AC244, 74AHCT27.

74A[!C-H]* start with 74A, followed by any character except the letters C through H, 
and end with any number of characters: 74ABT44, 74ALS244, 74ABF365.

[\\]*08 start with the character \, followed by any number of characters, and end 
with 08: \LS08, \HCT08, \ABT08.

156 SailWind Layout Guide and Reference



 

 

 

Chapter 7
Creating and Editing PCB Decals

A PCB decal is a software representation of the outline, terminals, and attributes of an electrical 
component. SailWind Layout uses PCB decals in the placement and routing of components during the 
design layout process.

The following topics present a detailed description of how to create and edit PCB Decals using the PCB 
Decal Editor. They also discuss the setup of the PCB Decal Editor as well as the process of updating a 
design from the library after you have edited the decals.

Setting Up the PCB Decal Editor
Creating a New Default Decal Editing Environment
Setting Colors of Objects in the Decal Editor
Creation of a New Decal
Library and Component Decal Edits
Decal Editing Tasks
Solder and Paste Masks
Updating a Design from the Library
Undo an Update From Library
Prevention of Update From Library Undo Buffer Overruns
The Compare/Update Process
How to Read the Update Report

Setting Up the PCB Decal Editor
You use the PCB Decal Editor to create new decals or to modify existing ones. You can modify the Decal 
Editor’s layers, colors, rules, editor options, and Decal Wizard options.

Procedure
1. Click the Setup  > Layer Definition  menu item to change the layer stackup in the Layers Setup 

on page 1441dialog box. If you need to add objects to specific layers, use the Layers Definition 
settings to configure the design to your requirements.

2. Click the Setup  > Display Colors  menu item to change the colors of objects or layers in the 
Display Colors Setup  on page 1318 dialog box. As you work on a decal, you may find it useful to 
apply different colors to objects or layers to visually differentiate them.

You can modify the colors of objects and layers in the Decal Editor, but when the decal is used by a 
component in the design, it uses the colors set for the design.

3. Click the Tools  > Options  menu item to change the options in the Options dialog box  on 
page 1531.
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4. Click the Setup  > Decal Rules  menu item to change the decal rules in the Decal Rules  on 
page 1231dialog box.

Note:
Rules set at this level of the rules hierarchy are used only by SailWind Router.

Related Topics
Creating a New Default Decal Editing Environment

Creating a New Default Decal Editing 
Environment
SailWind Layout provides a default (start-up) decal editing environment that opens when you start the 
Decal Editor from the Tools menu. This decal editing environment has its own layers, colors, rules, and 
editor options settings. These settings are very generic in the out-of-the-box default environment.

If you have personal preferences or your company has specific design standards for decal creation, you 
can modify and save the default environment’s settings to create a new default that will support those 
preferences. This can help you to improve productivity by loading your preferred setting each time the 
Decal Editor is opened.

Procedure
1. Click the Tools  > PCB Decal Editor  menu item. The Decal Editor opens with the default 

configuration.

2. Set options and settings to reflect your personal preferences or company design standards. For 
more information, see “Setting Up the PCB Decal Editor”.

3. Click the File  > Save as Start-up File  menu item.

4. In the Start-up File Output dialog box, select the appropriate check boxes in the Sections area, and 
clickOK.

When you immediately click the File  > New  menu item, you will see the new default settings.

Setting Colors of Objects in the Decal Editor
As you work on a decal, you can customize display colors to make it easier to see objects as you place 
them.

Using the Display Colors Setup dialog box, you can:

• Set and change the color of objects on a per layer or per object type basis

• Make objects visible or invisible in the display (also on a per layer or per object type basis)
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• Customize the palette of color selections

• Save your customizations in a configuration file

Procedure
1. Click the Tools  > PCB Decal Editor  menu item to start the Decal Editor.

2. Click the Setup  > Display Colors  menu item.

3. In the Display Colors Setup Dialog Box  on page 1322, set the color(s) you want:

a. To set the color for one object, in the Selected Color area, click a color tile. Then in the Layers/
Object Types table, click the tile for the object type in the correct layer row. To change the 
palette of colors from which you can select, click Palette. For more information, see “Changing 
the Color Palette”.

b. To make all objects on a layer the same color, click the layer number to select the entire row, 
and then click the color tile in the Selected Color area.

c. To make an object the same color on all layers, click the object name to select the entire 
column, and then click the color tile in the Selected Color area.

d. To make an object type invisible, set its tile to the background color. You can make multiple 
objects invisible (for example, all objects on the same layer). For more information, see “Hiding 
Design Objects”.

To make an object type the same color on all layers, click the Assign All  button and use the 
Assign Color to All Layers dialog box.  on page 1094

4. Click Apply.

If you modify the display color settings, you can save the new configuration to a file for reuse in 
future design sessions. For more information, see “Saving Color Assignments to a File”.

Tip
Color configurations saved in PowerPCB versions 2.1 and lower cannot be used in 
PowerPCB versions 3.0 and higher.

Related Topics
Creating a New Default Decal Editing Environment
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Creation of a New Decal
In the PCB Decal Editor, you can use the Decal Wizard to create some footprints automatically, or use the 
Drafting Toolbar commands to manually create a decal.

Creating a Basic Decal Automatically
The Decal Wizard Options Configuration File
Creating a Decal Manually

Creating a Basic Decal Automatically
Use the Decal Wizard to automatically create common decal types based on settings you provide in the 
Decal Wizard dialog box.

In order to create a decal, you need to begin with the package dimensions and enlarge the decal to the 
appropriate material condition  on page 1838.

Procedure
1. Click the Tools  > PCB Decal Editor  menu item to start the Decal Editor.

2. On the Standard Toolbar, click the Drafting Toolbar  button to open the Drafting Toolbar, and then 
click the Wizard  button.

3. Choose one of these methods to calculate the required dimensions and create a new PCB decal:

• Manually Calculate the Required Decal Dimensions  — You manually calculate the decal 
dimensions required for the package and enter the dimensions into the Decal Wizard to create 
the new decal.

• Use the Decal Calculator to Generate the Required Dimensions  — You enter the package 
dimensions into the Decal Calculator area of the dialog box (if the feature is available for the 
specific component family) and let the Decal Calculator generate the decal according to preset 
standards of material conditions.

4. After you create the basic decal, you can edit it to add other items, such as labels, attributes, 
keepouts, solder mask relief, height values, and hard breakouts/fanouts. For more information, see 
“Decal Editing Tasks”.

Related Topics
The Decal Wizard Options Configuration File

The Decal Wizard Options Configuration File
You cannot modify or delete the Default configuration of the Decal Wizard Options but you can save a 
new configuration file.

This configuration file is saved in the UserDir  folder. The UserDir  environment variable is set in the 
\Settings\SailWindpcb.ini  file, and by default is set to the \Settings\  folder. The file has an extension of 
.dwc. These files are in text format and can be opened with your default text editor.
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Custom Package Types and Pitch Ranges
You can use your default text editor to further customize the configuration file you saved from the Decal 
Wizard Options dialog box. You can edit the existing package types or add new package types.

If you edit the text of your .dwc  file, you must consider the following requirements:

• Only pre-defined component families can be used, and all the required parameters for the 
component family must exist (for example, Toe).

• The component_type section numbers must not skip a number; however they do not need to 
be in consecutive order in the file. For example, if numbers 4 and 6 exist, there must also be a 
number 5 somewhere in the file.

• Pitch ranges cannot overlap and, all together, must cover all values from 0 to infinity.

• The DecalName parameters are restricted to <Pitch>, <LeadSpan>, <LeadSpan1>, 
<LeadSpan2>, <Height>, <BodyWidth>, <BodyLength>, and <PinCount>.

If these requirements are not met and you attempt to use the configuration in the Decal Wizard Options 
dialog box, a warning appears to explain the problem and you cannot use the configuration file.

Creating a Decal Manually
If you cannot create a decal using the decal wizard, you can create it manually using the Decal Editor 
Drafting Toolbar buttons.

Procedure
1. Click the Tools  > PCB Decal Editor  menu item to start the Decal Editor with the default decal 

editing environment.

You do not have to start with the default decal when creating a new decal. If the new decal you 
want to create will be similar to an existing decal, you can edit that decal and save it under a new 
name to create the new decal.

2. Set the decal origin  on page 170.

3. Add and place the terminals  on page 172.

4. Create any copper shapes  on page 179, such as copper associated with terminal pads.

5. Define the terminal pad stacks  on page 185.

6. Create the Assembly  on page 195, Silkscreen  on page 196 and Placement  on page 197 part 
outlines.

7. Add other items, such as labels, attributes, keepouts, solder mask relief, height values, and hard 
breakouts/fanouts. For more information, see “Decal Editing Tasks”.
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• You cannot edit the default “Name” and “Type” labels that appear when you create a new decal; 
these “placeholder” labels are automatically populated with the correct reference designator 
and part type name, respectively, when a part using the decal is added to a design.

• You can add other “placeholder” labels to a decal. For more information, see “Creating 
Placeholder Attribute Labels”.

8. Click the File  > Save Decal As  menu item, name the new decal and save it to a library.

Related Topics
Library Content and the Search Order
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Library and Component Decal Edits
You can edit a library decal or the decal assigned to a component in a design.

Modifications to Components
Editing a Library Decal
Checking for Errors Between Part Types and Assigned PCB Decals
Fixing Logical Errors
Fixing Mismatched Pins Errors
Editing the Decal Assigned to a Component in the Design

Modifications to Components
When you add a component from the library to a design, the component is copied from the library into the 
design as a separate instance.

There are then two versions of the component - the library version and the design version. You can 
modify either or both of these; but which one you modify makes a difference:

• If you want the changes to apply only to the Library version of the component, use the PCB Decal 
Editor to make the changes. If you modify the Library version of a component, only that version 
is changed; instances of the component existing in the design are not changed. (If you want to 
change the design components to match the Library version, you can click the Tools  > Update 
from Library  menu item.)

• If you want the changes you make to apply only to the component(s) in the current design, use 
the Layout Editor to make the changes. If you modify the design version of a component, the 
change affects only the selected component(s) in the current design (or all instances of that 
component in the design); the Library definition of the component is not changed (unless you 
specifically change it by right-clicking and clicking the Save to Library  popup menu item with the 
component selected in the design).

Most of the items that make up a component definition can be edited only in the Layout editor, or only in 
the PCB Decal Editor, not in both places. But the following items can be edited in either editor, and you 
must decide which editor to use:

• In the component part type:

◦ Attributes

• In the component’s decals:

◦ Attributes

◦ Labels

◦ Silkscreen

◦ Keepouts
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◦ Copper

◦ Solder mask

◦ Paste mask

◦ Part outline width

◦ Decal rules

◦ Pad stack

Editing a Library Decal
You can use the Decal Editor to modify PCB Decals in a library. The changes you make apply at the 
library level but do not apply automatically to instances within the design.

Procedure
1. Click the Tools  > PCB Decal Editor  menu item to start the Decal Editor.

2. Click the Open  button. The Get PCB Decal From Library Dialog Box  opens.

3. From the Library list in the Filter area, select the library that contains the decal.

4. If you want to filter the PCB Decals list, type a wildcard or expression  on page 155 in the Items box 
and click Apply.

The Items box must contain at least the asterisk (*) to get any search results. An asterisk displays 
all parts in the list.

5. Select the decal from the PCB Decals list. The preview area displays a graphic of the decal.

6. Click OK.

Tip
If the decal is assigned to any part types in the SailWind libraries, the Part Type List 
for Decal <name> dialog box opens. Review the information and close the dialog box. 
For more information, see “Checking for Errors Between Part Types and Assigned PCB 
Decals”.

7. Edit the decal. For information on how to edit a PCB decal, see “Decal Editing Tasks”.

8. Save the decal.
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Checking for Errors Between Part Types and 
Assigned PCB Decals
If you open a decal for editing in the Decal Editor, and you have already assigned it to part types in the 
SailWind Libraries, the “Part Type List for Decal <name>” dialog box opens.

From this dialog box, you can check to ensure that the pins match the pins listed in the Part Type Pins 
tab table, or when pin mapping exists - on the Part Type Pin Mapping  tab.

Procedure
1. Click the Tools  > PCB Decal Editor  menu item to start the Decal Editor.

2. Click the Open  button. The Get PCB Decal From Library Dialog Box  opens.

3. From the Library list in the Filter area, select the library that contains the decal.

4. If you want to filter the PCB Decals list, type a wildcard or expression  on page 155 in the Items box 
and click Apply.

The Items box must contain at least the asterisk (*) to get any search results. An asterisk displays 
all parts in the list.

5. Select the decal from the PCB Decals list. The preview area displays a graphic of the decal.

6. Click OK.

7. If the decal is assigned to any part types in the SailWind libraries, the Part Type List for Decal 
<name> dialog box  on page 1606 opens. To open the dialog manually, click the Tools  > Part 
Types  menu item. You can sort the table by a given column by clicking the column header.

8. On the Part Type List for Decal <name> dialog box, click Edit Part.

9. The Part Information for Part <name> dialog box opens. From this dialog box, you can check to 
ensure that the pins match the pins listed in the Pins  tab table, or when pin mapping exists - on the 
Pin Mapping  tab.

10. When you have finished reviewing the information, click OK  to close the Part Information for Part 
<name> dialog box.

11. Click Close  to close the Part Type List for Decal <name> dialog box.

12. Edit the decal. For information on how to edit a PCB decal, see “Decal Editing Tasks”.

13. Save the decal.

14. Click the File  > Exit Decal Editor  menu item to return to your design.

Fixing Logical Errors
You can correct any logical errors that appear in the Error Status column of the “Part Type List for Decal” 
dialog box.
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Procedure
1. On the Tools  menu, click PCB Decal Editor  to open the Decal Editor.

2. Click the Open  button. The Get PCB Decal From Library Dialog Box  opens.

3. From the Library list in the Filter area, select the library that contains the decal.

4. If you want to filter the PCB Decals list, type a wildcard or expression  on page 155 in the Items box 
and click Apply.

The Items box must contain at least the asterisk (*) to get any search results. An asterisk displays 
all parts in the list.

5. Select the decal from the PCB Decals list. The preview area displays a graphic of the decal.

6. Click OK.

7. If the decal is assigned to any part types in the SailWind libraries, the Part Type List for Decal 
<name> dialog box  on page 1606 opens. To open the dialog manually, click the Tools  > Part 
Types  menu item. You can sort the table by a given column by clicking the column header.

8. On the Part Type List for Decal <name> dialog box, select a line item with a logical error.

9. Click Show Errors  to create and open a report with details of the errors.

10. Click Edit Part  to open the Part Type.

11. In the part type, fix the errors and then click OK.

12. The Part Type List for Decal dialog box will update the Error Status.

Fixing Mismatched Pins Errors
You can correct any mismatched pins errors that appear in the Error Status column of the “Part Type List 
for Decal” dialog box.

Procedure
1. Click the Tools  > PCB Decal Editor  menu item to start the Decal Editor.

2. Click Open. The Get PCB Decal From Library Dialog Box  opens.

3. From the Library list in the Filter area, select the library that contains the decal.

4. If you want to filter the PCB Decals list, type a wildcard or expression  on page 155 in the Items box 
and click Apply.

The Items box must contain at least the asterisk (*) to get any search results. An asterisk displays 
all parts in the list.

5. Select the decal from the PCB Decals list. The preview area displays a graphic of the decal.

6. Click OK.

7. If the decal is assigned to any part types in the SailWind libraries, the Part Type List for Decal 
<name> dialog box  on page 1606 opens. To open the dialog manually, click the Tools  > Part 
types  menu item. You can sort the table by a given column by clicking the column header.
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8. On the Part Type List for Decal <name> dialog box, select a line item with a mismatched pin error.

9. Click Show Errors  to create and open a report with details of the errors.

10. In the PCB Decal Editor, correct the error.

11. In the Part Type List for Decal dialog box, click Refresh, to update the dialog box.

Tip
You can click Check Decal to check the decal against all associated part types to show all 
mismatched pin number errors.

Related Topics
Part Information Dialog Box, Pins Tab

Part Information Dialog Box, Pin Mapping Tab

Editing the Decal Assigned to a Component in the 
Design
You can edit the decal that one or more selected components in the design are using and apply the 
changes to those components alone, or to all the components in the design using the decal.

You can also save the changes to the existing decal in the library, or create a new decal.

Procedure
1. Select the component(s). The selected components must all use the same decal.

2. Right-click and click the Edit Decal  popup menu item to open the PCB Decal Editor.

3. Edit the decal. For information on how to edit a PCB decal, see “Decal Editing Tasks.”

Restriction:
If your design is in default layer mode and you edit a design decal and attempt to change it 
to increased layer mode, the message “You will not be able to apply decal changes to the 
design. Continue?” appears. Either click Cancel  to return to the Layers Setup Dialog box 
without changing the decal to increased layer mode, or click OK  to proceed to the Increase 
Maximum Layer Number dialog box, where you can save the decal changes to the library; 
then exit the PCB Decal Editor without applying changes. After you have completed the 
edits to the decal in the library, you can then switch the current design to increased layer 
mode and update the decal.

4. If you want to save changes to the library:
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a. Click the File  > Save Decal As  menu item.

b. In the Save PCB Decal to Library dialog box, set the Library and Name of PCB Decal fields to 
save the changes to a new decal. If you want to save the changes to the existing decal, leave 
the fields as they are.

c. Click OK.

5. Click the File  > Exit Decal Editor  menu item.

6. In the Apply Decal Changes dialog box, Click Selected  to apply the changes to the selected 
components only, or All  to apply the changes to all components using that decal in the design.
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Decal Editing Tasks
You can use the Decal Editor to perform editing tasks, including editing properties, locating the decal 
origin, adding, deleting and modifying terminals, creating and associating copper shapes, creating and 
modifying custom pad stacks, working with labels and attributes, and a multitude of other editing tasks.

SailWind Layout combines decals and part types to create components. Use the PCB Decal Editor to 
create and edit the decal associated with a part type in the parts library. Many PCB Decal Editor drafting 
operations are identical to Layout Editor drafting operations.

When the PCB Decal Editor starts, your current design is stored and PCB Decal Editor takes over. The 
colors used in the PCB Decal Editor come from the Layout Editor. When you exit the PCB Decal Editor, 
use File commands to save information, and exit as you would a stand-alone program. You will return to 
the current design in SailWind Layout.

When editing decals, note the following:

• SailWind Layout supports 16 alternate decals per part type.

• You can use Dimensioning within the PCB Decal Editor; however, dimensions are converted to 
2D lines and text when you save the decal. For more information, see the Dimensioning Process 
topic.

PCB Decal Editor drafting works with the objects that make up a decal:

• Decal name

• Terminals

• 2D lines

• Text

• Copper

• Copper voids

Editing the Properties of a Decal Item
Location of the Decal Origin
Setting the Decal Origin with Set Origin
Setting the Decal Origin Using a Modeless Command
Terminals
Moving a Decal Name
Creating Copper in the Decal
Surface Mount Device Pads
Creation of Custom Pad Shapes
Associating Copper with Terminals
Unassociating Copper from Terminals
Pad Sizes and Pad Stacks
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Drill Size
Customizing Pad Stacks of Decal Pins
Creation of Thermals in the Pad Stacks
Creation of Antipads in the Pad Stacks
Editing Pad Stacks
Editing a Pad Stack in the PCB Decal Editor
Saving Pad Stack Changes to the Decal Library
Pad Stack Report
Slotted Holes
Creating Assembly Drawing Decal Objects
Creating Silkscreen Decal Objects
Creating a Placement (Nudge) Decal Outline
Importing RF Shapes in DXF Format
Attributes in the PCB Decal Editor
Creating Attributes in the PCB Decal Editor
Modifying an Attribute
Creating Attribute Labels in the PCB Decal Editor
Creating Placeholder Attribute Labels
Modifying Decal Label Properties
Non-Decal Attributes
Creating Keepout Areas in a Decal
Modifying Decal-level Keepouts
Layers for Decal-level Keepouts
Generating Drafting Shapes from Terminals
Step and Repeat

Editing the Properties of a Decal Item
You can edit the properties of decal items, including terminals, labels, text, and 2D items.

Procedure
1. In the Decal Editor, select an item then right-click and click the Properties  popup menu item. You 

can also Double-click on the item, or select the item and click the Properties  button on the Decal 
Editor Toolbar.

2. In the displayed dialog box, edit the decal name properties.

3. Click OK.

Location of the Decal Origin
The location of a decal’s origin affects how decals attach to the cursor when you move a component 
in the Move by Origin mode. It also affects how pick and place machines populate the board with 
components.

Typically, through-hole devices have their origin at Pin 1, and surface-mount devices at the geometric 
center of the component; other devices may have other origin requirements.
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When you are creating a new decal, you can define the origin whenever it is most convenient. For 
example, if you are creating a through-hole device decal:

• You could create Pin 1 on the default origin, and then build the remainder of the decal relative to 
that origin.

• You could build the entire decal anywhere within the workspace, and then move the origin to Pin 
1.

Setting the Decal Origin with Set Origin
You can set a decal’s origin while you are editing it in the Decal Editor.

Procedure
1. Click the Setup  > Origin  menu item.

2. Click where you want the new origin to be.

Setting the Decal Origin Using a Modeless 
Command
You can set a decal’s origin by using a modeless command and specifying the x and y location 
coordinates.

Procedure
1. Select the decal.

2. Type the modeless command SO <x> <y>.

Tip
Type SO for relative coordinates, SOA for absolute coordinates.

SailWind Layout Guide and Reference 171



Creating and Editing PCB Decals
Terminals  

Terminals
Terminals define the physical connection points on the PCB decals. The terminal Properties establish the 
connectivity relationship between the schematic symbol and the PCB decal.

Adding Terminals
Using Step and Repeat to Add an Array of Terminals
Assigning JEDEC Pinning
Modifying Terminal Properties
Modifying Terminal Number Properties
Moving a Terminal
Moving a Terminal Number
Swapping Terminal Numbers
Terminal Renumbering
Renumbering by Clicking Terminals
Renumber Using the Pin Numbers Dialog Box
Editing Individual Pin Numbers
Copying and Pasting Pin Numbers
Deleting a Terminal

Adding Terminals
Terminals are the pads or lands of a decal.

Procedure
1. Click the Tools  > PCB Decal Editor  menu item to start the Decal Editor.

2. Click the Drafting  button to open the Drafting Toolbar, and then click the Terminal  button.

3. In the “Add Terminals Dialog Box”  on page 1073, in the Start pin number area, choose a pin type 
and then type values in the Prefix and/or Suffix boxes for the pin numbering. A preview of pin 
numbers based on your input is displayed below the boxes.

• Alphabetic and numeric values can be used in either box. For example, A1 or 1A

• For a single numeric, use either Prefix or Suffix box, and void the other box.

4. In the Increment options area, choose what to increment by clicking either the Increment prefix or 
Increment suffix option.

5. In the Step value box, type a positive or negative number by which to increase or decrease the pin 
numbers with consecutive or stepped values.

6. If using alphanumerics, you can select the Verify valid JEDEC pin numbering check box to ensure 
that legal alphanumeric values are used. This option only ensures that valid alpha and numeric 
combinations are used. To arrange rows and columns according to JEDEC, use the Tools  > 
Assign JEDEC Pinning  menu item.
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7. Click to indicate a position for the new terminal. Repeat as necessary.

Tip
You can also add terminals by replicating one or more existing terminals. See “Using Step 
and Repeat to Add an Array of Terminals”  on page 173.

Related Topics
Creating Copper in the Decal

Associating Copper with Terminals

Using Step and Repeat to Add an Array of Terminals
You can add an array of terminals using the step and repeat function.

Procedure
1. Select one or more terminals, right click and click the Step and Repeat  menu item.

2. In the Step and Repeat dialog box  on page 1734, click the tab of the type of array to create: 
Linear, Polar, or Radial, and set the options for the array.

3. If the object selection contains text or a terminal, you can also automatically increment the text or 
pin number.

4. Click OK  to create the array.

• Terminals are replicated with associated coppers.

• Settings in the Step and Repeat tabs are saved when you close the dialog box and when you 
exit the Decal Editor.

Assigning JEDEC Pinning
You can assign pin numbers to rows and columns of terminals according to the JEDEC standard.

Procedure
1. Click the Tools  > PCB Decal Editor  menu item to start the Decal Editor.

2. Click the File  > Open Decal  menu item.

3. To filter the decals, in the Filter area, type a wildcard or expression  on page 155 in the Items box 
and click Apply.

4. Click to indicate the decal to which you want to assign JEDEC pinning and click OK.

5. Click the Tools  > Assign JEDEC Array Pinning  menu item. The JEDEC Array Pinning Dialog Box 
appears.

6. Choose the Decal Type by selecting either the Component or Substrate option.
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7. Click OK.

8. Save the Decal.

Modifying Terminal Properties
You can modify the various properties assigned to terminals such as the x,y locations, pin numbers, pad 
stacks and copper associations.

Procedure
1. With a decal open in the PCB Decal Editor, select a terminal, right-click and then click the 

Properties  popup menu item.

2. Modify any of the following information:

• Terminal x,y coordinates.

• Terminal pin number. You can change the pin number of the selected terminal.

3. Click Pad Stacks  to open the Pad Stack Properties dialog box  on page 1574. Use this dialog box 
to modify one or more selected pad stacks.

4. In the Terminal Properties dialog box, you can clear the Associated Copper check box to 
disassociate copper from the terminal.

5. Click Apply  to apply your modifications or Cancel  to cancel the changes.

6. If you select another terminal while the dialog box is open, the information is updated for the 
selected terminal.

Tip
You can use any alphanumeric characters except brackets { }, asterisks *, commas (,), 
question marks (?), or spaces.

Related Topics
Aligning Objects

Customizing Pad Stacks of Decal Pins

Modifying Terminal Number Properties
You can modify the properties of an individual terminal to change its location or pin number.

Procedure
1. With a decal open in the PCB Decal Editor, select a terminal number, right-click, and then click the 

Properties  popup menu item.

2. Modify any of the following information:
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• Coordinates  — You can also move the terminal number using coordinates.

• Pin Number  — You can change the pin number.

If you select another terminal number while the dialog box is open the information is updated for 
the selected terminal number.

Moving a Terminal
You can move one or more terminals to change their location within the decal.

Procedure
1. In the PCB Decal Editor, select the terminal to move. You can select more than one at a time.

2. Drag the terminal. The terminal remains attached to the pointer.

3. Click to complete the move.

You can also use the arrow keys to control movement: each press of an arrow key moves the 
selected terminal to the next point on the grid. Using the Terminal Properties dialog box, you can 
type a new X,Y location.

Related Topics
Moving Design Objects Radially

Moving a Terminal Number
You can move one or more terminal numbers to change their location within the decal.

Procedure
1. In the PCB Decal Editor, select the terminal number to move. You can select more than one at a 

time.

2. Drag the terminal number and release the mouse button. The terminal number dynamically 
attaches to the pointer.

3. Click to indicate a new location to complete the move.

4. You can also use the arrow keys: each press of the arrow key moves the selected terminal number 
to the next point on the grid. Using the Terminal Number Properties dialog box, you can type a new 
X,Y location.

Swapping Terminal Numbers
You can swap numbers between two terminals to reorder them.
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Procedure
1. In the PCB Decal Editor, select the terminals you want to swap.

2. Right-click and click the Swap  popup menu item.

The terminal numbers switch.
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Terminal Renumbering
When constructing PCB decals, you may need to renumber the terminals. There are two methods to 
renumber terminals.

Renumbering by Clicking Terminals
In the Decal Editor, you can renumber terminals in ascending order by selecting the starting terminal and 
clicking consecutive terminals.

Procedure
1. With a decal open in the PCB Decal Editor, select a starting terminal, right-click, and then click the 

Renumber Terminals  popup menu item.

Renumber Terminals is not available if more than one terminal is selected.

2. In the Start pin number area, type values in the Prefix and/or Suffix boxes. A preview of pin 
numbers based on your input is displayed below the boxes.

• Alphabetic and numeric values can be used in either box. For example, A1 or 1A.

• For a single numeric, use either Prefix or Suffix box, and clear the other box.

3. In the Increment options area, choose what to increment by clicking either the Increment prefix or 
Increment suffix option.

4. In the Step value box, type a positive or negative number by which to increase or decrease the pin 
numbers with consecutive or stepped values.

5. If using alphanumerics, you can select the Use JEDEC pin numbering check box to ensure that 
legal alphanumeric values are used.

This option only ensures that legal alphanumeric combinations are used. To arrange rows and 
columns according to JEDEC, use the Tools  > Assign JEDEC Pinning  menu item.

6. Click OK.

• The terminal is highlighted, and the pointer changes to a small cross. The pointer dynamically 
attaches to the renumbered terminal. The message “Renumbering… Next New Number: #” also 
attaches to the pointer.

• If you have duplicate numbers during the renumbering process, the duplicate numbers appear 
with a tilde (~) next to them.

7. Select another terminal to assign the next available number.

Tip
If you have renamed all available pins, the message “Renumbering... New Numbers 
Exhausted!” appears. In other words, the message appears if you renumber all eight 
terminals on a decal with eight pins.
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8. You can back up in the numbering process. Right-click and click the Back  popup menu item or 
press the Backspace key to restore the original number. If you selected a group of terminals to 
renumber, Back will undo the renumbering one terminal at a time. To undo completed terminal 
renumbering click Undo from the Edit menu.

9. To cancel the terminal renumbering process at any time, right-click and click the Cancel  popup 
menu item. SailWind Layout restores the original terminal numbering.

Tip
To renumber multiple terminals, click and hold the left mouse button, then drag the pointer 
across the terminals while pressing the Shift key. When you release the mouse button, all 
of the selected terminal numbers update, excluding terminals that are already renumbered.

10. Right-click and click the Complete  popup menu item when you finish reassigning terminal 
numbers.

Renumber Using the Pin Numbers Dialog Box
You can use the Pin Numbers dialog box to interactively renumber the terminals in the design area. 
Selecting pin numbers in the dialog box selects the matching pins in the design area and selecting pins in 
the design area selects the matching pins in the dialog box.

The Pin Numbers dialog box can be accessed from the Setup  > Pin Numbers  menu item.

You can modify the pin numbers listed in the dialog box, by editing individual cells, by copying and 
pasting, or by using the Renumber Pins dialog box.

Tip
Pin number changes on the decal will not be updated until you click Apply  or OK.

Editing Individual Pin Numbers
You can use the Renumber Pins dialog box to edit individual pin numbers on a decal.

Procedure
1. Click the Setup  > Pin Numbers  menu item.

2. Double click a Number cell, or select a number cell and click Edit.

3. Type a new pin number.

Copying and Pasting Pin Numbers
You can copy table data you select from the Pin Numbers dialog or from Microsoft Excel and paste it into 
the Numbers list. The cell you select in the table is the paste origin. Pasted data appears below the paste 
origin.
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Procedure
1. In Excel, select data and use the Excel Copy command in Excel. Or in the Pin Numbers dialog, 

select data and click Copy  in the Pin Numbers dialog box.

2. Select the cells into which you want to paste the data. Data will only paste into selected cells.

3. Click Paste  to paste the data into the table starting at the paste origin.

Deleting a Terminal
You can delete unwanted pins directly from within the PCB Decal Editor.

Procedure
1. In the PCB Decal Editor, select the terminal to delete. You can select more than one at a time.

2. Press the Delete key. The remaining terminals are automatically renumbered. The alphanumeric 
labels remain unchanged.

Moving a Decal Name
You can drag a decal name with the mouse to move it from one location to another.

Procedure
1. In the PCB Decal Editor, select the decal name to move.

2. Drag the decal and release the mouse button. The decal name dynamically attaches to the pointer.

3. Click to indicate a new location to complete the move. You can also use the arrow keys to control 
movement -each press of an arrow key moves the decal to the next point on the grid.

Related Topics
Rotating an Object

Creating Copper in the Decal
You can create copper in the decal and associate it with a pin to create a custom pad shape or heat sink. 
You can also create unassociated copper heat sink or shielding shapes that move with the decal in the 
design.

Prerequisites
You must select a layer for placement of the copper. You cannot create a copper shape on all layers 
(layer number zero). If you need the same copper shape on multiple layers, copy the shape to the other 
layers.

Procedure
1. Click the Drafting Toolbar  button.

2. On the Drafting Toolbar, click the Copper  button.
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3. Select a layer on which to place the copper.

4. Right-click and click a command to change the values of the drafting object. For more information, 
see “Set Values Before Creating a Drafting Object”.

5. Create the shape using one of the following:

• Creating a Circle Drafting Object

• Creating a Polygon or Path Drafting Object

• Creating a Rectangle Drafting Object

6. Once you complete the shape, it becomes a filled shape.

Results
Examine the resulting copper shape and look for any of these conditions:

• If the shape edges are not correct, see “Edge Precision of Drafting Shapes  on page 615”.

• If the shape is on the wrong layer or needs to be modified, see “Drafting Object Properties”.

• If you want to start over, see “Deleting a Drafting Segment or Object”.

Related Topics
Associating Copper with Terminals

Creating a Copper Cut Out

Generating Drafting Shapes from Terminals

Surface Mount Device Pads
Surface Mount Device (SMD) pads are usually rectangular, although you can assign any shape. When 
defining an SMD pad, set the pad stack for all other layers to a round shape, size 0 pad, drill size 0, and 
clear Plating. The drill oversize parameter does not apply. If you use associated copper to define the SMD 
pad, set the pad stack for that layer to a square shape, size 0.

Use the Via under SMD routing command to place vias directly under SMD pads. For more information, 
see “Adding Vias in Pads”. You can undersize the SMD pads for the paste mask photoplot during the 
CAM process.

Plane Connections
Pins that are supposed to connect to the plane are usually plotted for manufacturing using spoked 
thermal relief pads.

Creation of Custom Pad Shapes
You can create odd shaped (irregular shaped) pads by drawing a copper shape and associating it to the 
pad while editing the decal.

180 SailWind Layout Guide and Reference



 
Creating and Editing PCB Decals

Associating Copper with Terminals

For more information, see “Associating Copper with Terminals”.

Associating Copper with Terminals
You can associate a drawn copper shape with a terminal/pad. This assigns the copper shape the same 
net connection as the terminal/pad. Use associated copper to create custom pad shapes or to create hard 
breakouts in decals.

CAM interprets pads and other objects differently when they are associated with copper in the PCB Decal 
Editor. Interpretation is as follows:

• Terminals are interpreted as vias

• Closed copper shapes are interpreted as pads

• Open copper (a path drawn with copper) is interpreted as a trace

Tip
Using the Vias, Pads, and Traces check boxes along with those in the Pins with Associated 
Copper area will give you total control over what appears in your CAM document.

Restrictions and Limitations
Routing is only completed to the center of the pad and any thermal connections are made to the pad only 
and not the associated copper shape.

Procedure
1. Draw the copper shape. For more information, see “Creating Copper in the Decal”.

You can create multiple copper shapes.

2. With a decal open in the PCB Decal Editor, select a terminal, right-click and then click the 
Associate  popup menu item.

3. Select the copper item to associate with the terminal. This electrically connects the copper item 
with the terminal. You may want to physically connect the terminal and copper item by overlaying 
part or all of the terminal.

4. If you are using the associated copper to create an odd shaped pad, maximize the pad shape 
inside the overlapping associated-copper shape. The underlying pad is still the routing target 
on page 1854 and also the connection point for thermals if this pad will ever be connected to a 
copper plane. If associated copper surrounds the terminal pin by a large amount it could prevent 
thermal spokes from being generated.

Note:
When routing to a decal pad with associated copper in the design editor, the trace is 
flagged as a partial connection if you route only to the associated copper, and not to the 
center of the decal pad itself. Note, however, that though the connection is flagged as 
partial, it will result in a functional connection on the finished board.
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Results
CAM interprets terminals differently when associated with copper. For more information, see Associated 
Copper and CAM.

Unassociating Copper from Terminals
You can remove the association between a copper item and a terminal.

Procedure
1. In the Decal Editor, select the copper item.

2. Right-click and click the Unassociate  popup menu item.

Tip
As an alternative, in the Terminal Properties, you can clear the Associated Copper check 
box to unassociate copper from the terminal.
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Pad Sizes and Pad Stacks
A pad  is a small area of copper that acts as a conductor for component pins and vias. The pad ensures 
connectivity between the trace entering the drill hole and the copper plating that lines the inside of the 
hole.

Pads are classified as two types:

• Through hole pads  — Are used for components that mount with pins that go through the board. 
When through hole pads are drilled and plated, a small ring of copper remains and ensures 
connectivity between the trace entering the drill hole, the copper plating that lines the inside of the 
hole, and the pad on the opposite side of the board. Vias are considered through hole pads, but 
may be created to go through only certain layers.

• Surface mount pads  — Are used for components that have pins, which are glued to an outside 
layer of the board. Routing to vias provides connectivity to other layers.

Pad Stacks
Pad Stack Default Layers
Pad Stacks and Antipad Definitions
Pad Stacks and Associated Copper

Pad Stacks
On a two-layer board, a component pin or via drill hole has a separate pad on the top layer and the 
bottom layer. You can set different shape, size, and diameter values for each pad. If you add any inner 
routing layers to the design, you can define pads on those layers. The resulting two or more pads for the 
pin or via is called the pad stack.

Pad stacks are classified into two categories:

• Component pad stacks  — Component pad stacks are used for component pins and are either 
surface mount, with no drill diameter, or through hole. Pad stack information for a component is 
stored with its part decal information.

• Via pad stacks  — Via pad stacks are used for feed-throughs and can be through hole or partial. 
Partial vias begin or end on an outer or inner layer. Partial vias are used on multilayer boards 
and are created by drilling laminate layers separately for layer-dedicated vias, then pressing 
them together and drilling the through holes. If a via connects an outer layer and an inner layer, 
it is called a blind via. If a via connects two inner layers, it is called a buried via. The via type 
determines whether a via is through hole or partial. The via description is the combination of type, 
plating, and pad stack information.

You can edit pad stacks by layer, so you can set component or via pads to zero, turning them off, on 
layers where they are not needed to create more routing real estate around a drill hole. You can assign 
different shapes to them for different routing or photoplot applications. The resulting configuration of 
size, shape, diameter, and layer description for a pad stack is called its pad stack information. For more 
information, see the Editing Pad Stacks  topic.

For information on installing vias, see the Via Setup  on page 327 topics.
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Pad Stack Default Layers
The default layer list features a special generic layer list. It lists Mounted Side, Inner Layers, and Opposite 
Side. Such a setup allows quick customization of the electrical layers and adds flexibility if you choose to 
mount the component on the bottom side or add extra inner layers.

Mounted/Opposite Side
If you customize the Mounted Side or Opposite Side, your customized pad will flip with the component 
if you choose to mount the component on the bottom side of the board. However, if you choose to 
customize the specific layer of your top or bottom side of the board, that customized pad will remain on 
that layer even though you flip the component.

Inner Layers
If you customize the Inner Layers, you can add layers to your design and your pad customizations will 
propagate to any added. However, if you choose to customize each specific layer, and you increase the 
layers of your design, your customized pads will remain only on those specific internal layers.

Pad Stacks and Antipad Definitions
Setting an antipad definition for the inner layer modifies the photoplot output for CAM planes and split/
mixed planes. If you want a unique antipad on split/mixed plane layers, add a new layer for the split/mixed 
plane before defining the antipad.

Related Topics
Setting Up an Inner Layer

Pad Stacks and Associated Copper
When defining associated copper for a terminal, define a zero size, square-shaped pad in the terminal 
pad stack on the layer of the associated copper. Routing commands interpret the zero size, square-
shaped pad to be the routing target for the associated pad copper on that layer.

Drill Size
During manufacturing, the interior surfaces of drill holes are coated with metal plating. For vias, the plating 
enables connectivity when the layers are pressed together. Plating reduces the diameter of drilled holes. 
The size difference does not affect vias as much as component holes, where a smaller diameter can 
hinder part insertion.

The drill size you define for a pad stack is assumed to be the finished hole size, after plating. 
Manufacturing should use a larger drill bit than the specified drill size specified so that once the plating 
is added, the resulting inner diameter is at, or close to, the original finished specification. So that you 
can use the actual drill bit size in clearance checking, there is a universal “Drill oversize” setting on the 
Design  tab of the Options dialog box, which adds a fixed amount of diameter to all drill size definitions. 
The combination of the pad stack drill size and the drill oversize setting is the diameter used by the batch 
design rule checks. This is also the drill hole size that displays on a pin or via.

In most cases, manufacturers use drill sizes equal to the pad stack drill size plus twice the thickness of 
the plating. To determine what value to enter, know how your board manufacturer chooses drill diameters.
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Customizing Pad Stacks of Decal Pins
You can customize the pad stacks of the pins in your decal. You can choose to customize one pin, or 
multiple pins simultaneously.

Restrictions and Limitations
When customizing pad stacks of decal pins, the following restrictions apply

• If you are working in the PCB Decal Editor, you must have a decal open in the editor. The 
terminals (pins) must exist in your decal before you can modify their default pad stacks.

• If you are working in the Design Editor, the decal you want to edit must exist in the design.

Procedure
1. Click the Setup  > Pad Stacks  menu item.

2. In the “Pad Stacks Properties Dialog Box”  on page 1566, ensure that your decal is selected in the 
Decal name list.

3. Under the “Pin: Plated:” list, select the pin to customize. If you do not want to customize all the pins 
simultaneously, you can add one or more specific pin numbers to the list using the Add Pin Dialog 
Box.  on page 1066

4. Under the “Sh: Sz: Layer:” list, select one or more layers of the pad stack you want to customize.

For more information, see:

• Pad Stack Default Layers  on page 184

• Control of Solder Mask and Paste Mask

5. In the Parameters area, specify the settings for all three Pad, Thermal, and Antipad  pad styles if 
needed. The style of pad used is selected automatically in the design depending on the situation. 
The thermal and antipad styles are used when the pin is located within a plane.

For more information, see:

• “Design Rule Versus Pad Stack - Thermals and Antipads”  on page 797

• Creation of Thermals in the Pad Stacks

• Creation of Antipads in the Pad Stacks

• Customizing Design Rule Thermals.

6. Below the Parameters area, set the options that apply to the pads on all layers for the selected 
pin(s).

7. If you need to customize other pins in the decal, return to step 3.

8. Click OK  to save all the pad stack customizations.
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Results
Verify that your custom thermals are showing up in CAM plane plots. For custom thermals to be visible, 
you must select the Use Custom Thermal Settings check box in the Plot Options Dialog Box  and ensure 
that the photo plotter format is RS-274-X. Custom thermals for CAM planes are not supported by RS-274-
D.

Related Topics
Assigning Copper Plane Thermal Attributes

Creation of Thermals in the Pad Stacks
You can set up thermals wherever you can create or modify pad stacks. Create thermals on split/mixed 
plane layers and CAM negative planes (for RS-274-X output).

Restrictions and Limitations
When creating thermals in pad stacks, the following restrictions apply:

• In the PCB Decal Editor, thermals cannot be created in the Pad Stack Properties for Pin dialog 
box. Instead, click the Setup  > Pad Stacks  menu item to use the Pad Stacks Properties dialog 
box.

Tip
The Sh: Sz: Layer: area of these dialog boxes contains one global listing for inner layers, 
listed as <Inner Layers>. Setting a thermal definition for this inner layer modifies the 
photoplot output for CAM plane and split/mixed plane layers. If you want a unique thermal 
on a particular layer, add the new layer and define the specific thermal setting.

Procedure
1. Select one or more layers.

2. In the Parameters area, click the Thermal  tab.

3. Click the appropriate pad shape to enable the size and shape controls for thermals.

Tip
The pad stack thermal settings use oval and rectangular shapes for slotted holes as well 
as for oval and rectangular pads.

4. Change the default thermal values in the fields provided. No pad stack thermal will be used if 
the “Use design rules for thermals and antipads” check box is selected in the Options dialog box 
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Creation of Antipads in the Pad Stacks
> Copper Planes  category > Thermals subcategory  on page 1514. For more information, see 
““Customizing Design Rule Thermals”  on page 669”.

Note:
CAM planes are negative images compared to other layers. When you set thermals for 
CAM plane layers, you must select the Use Custom Thermal Settings check box in the Plot 
Options  on page 1641 dialog box. Make sure you are also using RS-274-X output format 
in the Photo Plotter Advanced Setup  on page 1619 dialog box.

Related Topics
Customizing Pad Stacks of Decal Pins

Creation of Antipads in the Pad Stacks
Antipads are set up wherever pad stacks can be created or modified. Create antipads on split/mixed 
plane layers and CAM negative planes (for RS-274-X output).

Restrictions and Limitations
In the PCB Decal Editor, antipads cannot be created in the Pad Stack Properties for Pin dialog box. 
Instead, click the Setup  > Pad Stacks  menu item to use the Pad Stacks Properties dialog box.

Procedure
1. Select one or more layers.

The Sh: Sz: Layer: area of these dialog boxes contains one global listing for inner layers, listed as 
<Inner Layers>. Setting an antipad definition for this inner layer modifies the photoplot output for 
CAM plane and split/mixed plane layers. If you want a unique antipad on a particular layer, add the 
new layer, and define the specific antipad setting.

Antipads are not found when using the generic Mounted Side and Opposite side layers. If you want 
a custom antipad for the top and bottom layers, you need to add the specific layer.

2. In the Parameters area, click the Antipad  tab.

3. Click the appropriate pad shape to enable the size and shape controls for antipads. The pad 
stack antipad settings use oval and rectangular shapes for slotted holes as well as for oval and 
rectangular pads.

4. Change the default antipad value in the field provided. No pad stack antipad will be used if the 
“Use design rules for thermals and antipads” check box is selected in the Options dialog box > 
Copper Planes  category > Thermals subcategory  on page 1514. For more information, see 
“Customizing Design Rule Antipads”  on page 670.

Note:
CAM planes are negative images compared to other layers. When you set antipads for 
CAM plane layers, you must select the “Use Custom Thermal Settings” check box in the 
Plot Options  on page 1641 dialog box. Make sure you are also using RS-274-X output 
format in the Photo Plotter Advanced Setup  on page 1619 dialog box.
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Related Topics
Customizing Pad Stacks of Decal Pins

Editing Pad Stacks
Pad information for the selected decal is listed by pin number to the right of the Setup/Pad Stack form. A 
typical decal uses one pad stack description for all its pins. This practice has some common exceptions. 
For example, a square pad usually designates pin 1 of through-hole components.

Procedure
1. Click the Setup  > Pad Stacks  menu item.

2. Set the pad stack type to Decal or Via.

3. Click the decal or via name from the Decal Name list.

4. Make your changes and then click OK.

5. When you are prompted to save changes to all or the selected parts click the appropriate button:

• All  — Use this choice to assign the decal name to the part type and for all part types in the 
design using this decal to assume the new pad stack definition.

• Selected  — Use this choice to rename the individual component's decal using a suffix letter; for 
example a DIP16 with a local pad stack edit becomes DIP16A. This decal name becomes the 
only decal listing, primary or alternate, for this particular reference designator.

Related Topics
Customizing Pad Stacks of Decal Pins

Editing a Pad Stack in the PCB Decal Editor
Edit a pad stack in the PCB Decal Editor to change the pad stack of a single pin or to make pad stack 
changes and save them to the library before adding parts to the design.

Procedure
1. Click the Tools  > PCB Decal Editor  menu item to open the Decal Editor.

2. Open a decal.

3. Select the pin or pins for which you want to change the pad stack. Alternatively, click the Setup  > 
Pad Stacks  menu item and select or add the specific pad stack that needs to be edited.

4. Right-click and click the Pad Stacks  popup menu item. The Pad Stack Properties for Pin Dialog 
Box  appears.

5. In the “Pin No. Plated”: area, click the pin you want to change, then in the “Sh: Sz: Layer:” area, 
click a layer on which you want to change the pad stack information. If you opened the Pad Stacks 
properties dialog box from the Setup menu, you can edit multiple pad stack layers at once.
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Saving Pad Stack Changes to the Decal Library

6. Make the pad stack modifications.

7. Click the “Assign to all selected pins” check box to apply the modifications to all of the selected 
pins. Selected pins appear in the Pin Name list.

8. Click OK. The pad stack changes are applied to every selected pin. To save the changes, you 
must also save the decal.

Note:
To work with pad stacks on library parts before they are added to the design, enter the 
PCB Decal Editor through the Library Manager. This lets you include decal names in the 
part's alternate decals, ensuring smoother operation if you refresh a part type in the design 
with a definition from the library.

Related Topics
Part Information Dialog Box, PCB Decals Tab

Saving Pad Stack Changes to the Decal Library
Changing the pad stack definition for a single part or for all parts does not change the decal in the part's 
library definition. Use the Library Manager to include any new decal names in the part's alternate decals. 
This ensures a smoother operation if you ever refresh the part type in the design with a new definition 
from the library. You can save pad stack changes to the parts library.

Procedure
1. Select the part.

2. Right-click and click the Save to Library  popup menu item. The Save Part Types and Decals 
dialog box shows the selected part type and all of its alternate decals as of the last time it was read 
or refreshed.

If you created a new suffixed decal, meaning you changed the pad stack for one component only, 
the new decal also appears.

3. Highlight either the decal you changed or the new decal and the library where you keep the decals.

Pad Stack Report
You can create a text format, pad stack report file for a selected component or via or all components and 
vias.

A sample file output appears below.

PAD STACK LISTING
Finger Format — Size Shape Orientation Length Offset Drill
Pad Format —— Size Shape Drill
Shape=[OF]OvalFinger,[RF]RectFinger,[R]Round,[S]Square,[A]Annular,[O]Odd
Pad stack for Via: STANDARDVIA
START(1)  55 C 37
INNER  70 C 20 (inner layers not otherwise described)
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END(2)   55 C
Pad stacks for Part Decal: DIP14
Used by Part Types: 7400
PIN 0 (All pins not otherwise described) (Plated)
TOP(1)   60 C  37
INNER  80 C  (inner layers not otherwise described)
BOTTOM(2)  60 C
PIN 1 (Plated)
TOP(1)   60 S 37
INNER  80 C (inner layers not otherwise described)
BOTTOM(2)  60 C
Pad stacks for Part Decal: DIP14\SO
Used by Part Types: 7400
PIN 0 (All pins not otherwise described) (Plated)
TOP(1)   24 R 90 60 0 0
INNER  0 C (inner layers not otherwise described)
BOTTOM(2)  0 C
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Slotted Holes
You can create slotted holes using the Pad Stacks Properties dialog box or the Pad Stacks Properties for 
Pins dialog box. Slotted holes have orientation and offset properties, but have the same unit and range 
as the associated pad's orientation and offset. You can use slotted holes with only round, square, oval, or 
rectangular pad shapes.

Therefore, you can only define slotted holes for component pins. All pads in the pad stack should be oval 
or rectangular; the pad shape is checked on the mounted side. You can also create a thermal or antipad 
definition for slotted holes.

For custom antipads, the default antipad shape around the slotted hole is always oval. For custom 
thermals, the default pad shape around the slotted hole depends on the pad shape on the specific layer.

For custom thermals, settings on the Pad Stacks Properties Dialog Box  control spoke angle and width. 
The Clearance Rules dialog box  on page 1167 pad to copper clearance controls the calculation of the 
outer width.

Note:
A custom thermal or antipad for a slotted hole has the same orientation and offset as the slot.

Other information on slotted holes includes:

• Slotted holes are displayed in the same color as drills.

• The Drill Oversize option in the Options dialog box Design  tab applies to plated slotted holes.

• Drill-to-drill clearance checking checks slotted holes.

• You can use slotted holes as test points.

Tip
Control the line width for slotted holes using Line Width in the Drill Drawing Options dialog 
box.

Slotted Hole Geometry
Slotted Hole Offset Versus Pad Offset
CAM Output and Slotted Holes
Slotted Holes in CAM350
Creating Slotted Holes in Decals
Creating Slotted Holes in Pins

Slotted Hole Geometry
The valid range of values for slotted hole length, orientation, and offset parameters are the same as those 
for a pad. They are expressed in the design units selected in the associated Pad Stacks Properties dialog 
box.

Length Value Range: >= 0 and <= 1000 mils (25.4 mm)
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Orientation Value Range: >= 0.000 and <= 179.999 degrees

Offset Value Range: >= -500 (-17.2 mm) and <= 500 mils 17.2 (mm)

Slotted Hole Offset Versus Pad Offset
You can change the offset of oval pad shapes to move the electrical center of the pin (as well as the 
center of the drill). Since standard conventions consider slotted holes to be drills, such conventions also 
consider the electrical center to be the center of the slotted hole.

If you moved the pad offset to the far end of the pad, you would quickly move the slotted hole outside the 
pad boundary. Instead of moving a pad offset, you can use a slotted hole offset to move the slotted hole.

Slotted hole offset moves the center of the slotted hole relative to the electrical center of the pin–always in 
the opposite direction of the pad offset. For example, if you want to move the electrical center of a 200x60 
mil pad 70 mils to the left, set a pad offset of 70. To center the slotted hole, set a slotted hole offset of 70. 
See the graphic below for more information. The maximum amount of offset you can set is one half the 
length.

Figure 15. Pad Offset Versus Slot Offset

CAM Output and Slotted Holes
The CAM output type determines how slotted holes are defined and represented.

Drill Drawings
Slotted holes are shown on drill drawing as 2 drill symbols, one at each end of the centerline of the slotted 
hole. The true outline (edge-to-edge representation) of the slotted hole is then drawn around the two drill 
symbols.
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Figure 16. Drill Drawing of a DIP14 with 30x120 Mil plated Slotted Holes at Each End

Slotted holes are shown in the drill chart as a value in the Size column. The size is the edge-to-edge size 
of the slotted hole, meaning that the width of the slotted hole is also the drill size. The Quantity column 
shows the number of slots.

The table below shows a sample Drill chart of a DIP14 with a 30x120 mil plated slotted holes at each end

Table  59. Sample Drill Chart

SIZE QTY SYM PLTD

35 14 + PLTD

30x132 2 X PLTD

NC Drill

Two drill symbols for each end of a slotted hole are created in the NC drill data. Slotted holes are output 
according to pin type output (plated/nonplated). Slotted hole test points are output according to test point 
output. For example, if you output plated pins and test points, slotted holes that are plated and/or test 
points will also be output.

Gerber Output

Slotted holes are represented two ways in Gerber data. The first is as a centerline with endpoints that 
are one half the drill size from the ends of the slotted hole. The second ways is as a closed, unfilled oval, 
showing the outer edge of the slotted hole. The centerline of this oval is the outer edge of the slotted hole. 
Both are drawn with the smallest round aperture available.

Figure 17. Gerber Output of Slotted Holes
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Slotted Holes in CAM350
The method of fabrication determines the hole representation you use in CAM350.

• To create slotted holes with a series of drills, use the centerline format and the Gerber to Drill 
feature in CAM350.

• To mill slotted holes, use the outer edge format and Gerber to Mill in CAM350.

Related Topics
Slotted Holes

Creating Slotted Holes in Decals

Creating Slotted Holes in Pins

Customizing Pad Stacks of Decal Pins

Pad Stack Properties for Pin Dialog Box

Drill Drawing Options

Creating Slotted Holes in Decals
You can add slotted holes to a decal in the Decal Editor.

Procedure
1. Click the Tools  > PCB Decal Editor  menu item to open the Decal Editor.

2. Click the Setup  > Pad Stacks  menu item.

3. In the Pad Stacks Properties Dialog Box, set any pad stack options you want, such as plated, size, 
shape, and layer.

4. Select the Slotted check box to add a slotted hole to the decal.

5. Set the length, orientation, and offset of the slotted hole.

6. Click OK.

7. Choose whether to keep existing attributes on the pin (Keep Attributes), and then choose whether 
to apply the pad stack changes to all decal types (All) or to just the selected component (Selected). 
You can also to cancel the slotted hole creation (Cancel).

Creating Slotted Holes in Pins
You can select individual pins on a decal and add slotted holes.

Procedure
1. Select a pin, right-click, and then click the Properties  popup menu item.

2. Click Pad Stack.
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3. In the Pad Stacks Properties Dialog Box, select the Slotted check box to add a slotted hole.

4. Set the length, orientation, and offset of the slotted hole.

5. Click OK.

6. Choose whether to keep existing attributes on the pin (Keep Attributes), and then choose whether 
to apply the pad stack changes to all decal types (All) or to just the selected component (Selected). 
You can also choose to cancel the slotted hole creation (Cancel).

Creating Assembly Drawing Decal Objects
SailWind Layout uses the assembly outline and assembly refdes on the assembly drawing to define the 
exact outline and identify the body of the part. The assembly outline shows where the part is to be placed 
during the board assembly process.

Procedure
1. Click the Tools  > PCB Decal Editor  menu item to open the Decal Editor.

2. Click the Drafting Toolbar  button then click the 2D line  button and then on the Assembly Drawing 
Top layer, draw the outline. For more information on drawing 2D shapes, see Creating a Drafting 
Object.

Tip
If you flip a part to the other side of the board, the assembly outline flips with it. Even 
though you create the outline on the Assembly Top layer, it automatically flips to the 
Assembly Bottom layer when you flip the component from the mounted side to the opposite 
side.

3. Add a second reference designator label on the Assembly Outline Top layer. The reference 
designator label should be large and located inside the outline. For more comprehensive 
procedures than what is listed below, see Creating Attribute Labels in the PCB Decal Editor.

a. Click Add New Label .

b. In the Add New Decal Label  on page 1060 dialog box, in the Attribute list, select the Ref.Des. 
attribute.

c. In the Layer list, select the assembly drawing top layer.

d. Click OK. The label appears with the value “Name”.

e. Right-click and click the Move  popup menu item.

f. Position the new label.

Tip
To create assembly layer reference designators globally in the design editor, see 
Generating a Second Set of Reference Designators for Assembly Drawings.
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Results
If a 2D item does not appear after you draw it, the color set for Lines on the layer is probably the same as 
the background color. Set a different color for Lines in the Display Colors Setup dialog box.  on page 1318

Creating Silkscreen Decal Objects
The silkscreen outline prints on the board and remains visible on the board after the part has been 
placed. This outline—along with its reference designator, pin number and polarity labels—identifies the 
part and its pins to anyone assembling, testing, or servicing the board. The silkscreen also serves as a 
nudge outline if no actual nudge outline exists on Layer 20.

Procedure
1. Click the Tools  > PCB Decal Editor  menu item to open the Decal Editor.

2. Click the Drafting Toolbar  button then click the 2D line  button and then on the Silkscreen Top 
layer, draw the outline. For more information on drawing 2D shapes, see Creating a Drafting 
Object.

Tip
If you flip a part to the other side of the board, the silkscreen outline flips with it. Even 
though you create the outline on the Silkscreen Top layer, it automatically flips to the 
Silkscreen Bottom layer when you flip the component from the mounted side to the 
opposite side.

3. Move the silkscreen refdes to the Silkscreen Top layer. The silkscreen refdes label is automatically 
added at the creation of the new decal. But by default it is added to the Top (Mounted) layer.

a. Double-click the “Name” label in the decal.

b. In the Decal Label Properties Dialog Box, in the Layer list, select the silkscreen top layer.

c. Click OK.

4. Add pin number, and polarity labels if needed. The labels should be located outside the outline, 
where they can be seen after the part is placed. For more comprehensive procedures than what is 
listed below, see “Creating Attribute Labels in the PCB Decal Editor”.

5. Silkscreens for large components with many pins often have miniature dots or pin numbers visible 
next to selected pins to make it easier locate a pin on the board during testing or troubleshooting 
sessions. If you use text in the decal for these, they will not be movable when the component 
is placed in the design. Use labels instead; labels can be moved or deleted in the design if 
necessary.

a. Click Add New Label.

b. In the Add New Decal Label  on page 1060 dialog box, in the Attribute box, type a name for the 
new attribute. The value can only be assigned once the decal is used in the design.

c. In the Layer list, select the silkscreen top layer.

d. Click OK. The label appears with the attribute name you typed.
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e. Right-click and click the Move. popup menu item.

f. Position the new placeholder.

Results
If an item does not appear after you add it, the color set for the item is probably the same as the 
background color. Set a different color in the Display Colors Setup dialog box.  on page 1318

The refdes (Name label) is controlled by the Pin Num column and the part type (Type label) is controlled 
by the Type column.

Creating a Placement (Nudge) Decal Outline
Some parts need additional spacing to allow for machine-placement or rework on the physical board. The 
placement (or nudge) outline defines these spacings.

The placement (nudge) outline (sometimes called a “courtyard”) defines the boundary where nudging  on 
page 499 of the part initiates when another part is moved against it.

You can use a larger outline on layer 20 to ensure that your design placement is correct even though you 
apply the same “Body to body” clearance for all components.

Procedure
1. Click the Tools  > PCB Decal Editor  menu item to open the Decal Editor.

2. Click the Drafting Toolbar  button then click the 2D line  button and then on layer 20 (120 in max 
layers mode), draw the 2D line item(s) defining the nudge outline. For more information on drawing 
2D shapes, see Creating a Drafting Object.

Tip
The outline does not have to be a contiguous shape enclosing the part. It can be made up 
of multiple 2D items—any object placed on Layer 20 (the Placement layer) is considered 
part of the “outline”.

Results
The placement outline is considered by the software as part of the component body. Whenever it is 
encountered, the “Body to body” clearance rule is invoked.

If a 2D item does not appear after you draw it, the color for Lines on layer 20 is probably the same as the 
background color. Set a different color for Lines in the Display Colors Setup dialog box.  on page 1318

Importing RF Shapes in DXF Format
You can import specialized shapes of DXF format into your decal or into the design using the AutoCAD 
2004 DXF format.

Restrictions and Limitations
DXF import only supports the following geometries: POINT, LINE, ARC, CIRCLE, ELLIPS, TRACE, 
SOLID, 3DFACE, POLYLINE, LWPOLYLINE (AutoCAD R14), and BLOCKS with hierarchy.
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Procedure
1. Click the Drafting Toolbar  button.

2. On the Drafting Toolbar, click the Import DXF File  button.

Tip
The DXF import functionality of the Import DXF File button is optimized for importing RF 
shapes as 2D lines or copper. For more DXF import functionality use the File > Import 
method  on page 297.

3. In the File Import dialog box, browse for the DXF file and then click Open.

4. In the DXF Import Dialog Box, in the DXF-File Unit list, select the units used in the DXF file.

5. For each layer you want to include in the import:

a. Select the Add check box.

b. In the PCB Layer column, double-click a layer box and select the PCB layer to use for the 
items of that DXF Layer.

c. In the Type column, double-click a type box and select either 2D Line or Copper for the DXF 
items of that layer.

Note:
A PCB layer set to <All Layers> cannot be imported as copper. You cannot have 
copper items on <All Layers> in a PCB decal.

6. Click OK.

Results
The geometries are added to the design or the decal in the PCB Decal Editor. If you need your imported 
geometries to be single objects, but they have been imported as multiple line items, see Join and Close 
2D Lines and Copper Shapes.

Related Topics
Importing DXF Files

DXF Format

Attributes in the PCB Decal Editor
You can add attributes automatically to the Attribute Dictionary when returning from the PCB Decal Editor.

You can use attributes in the PCB Decal Editor, but they differ in concept from attributes in the Layout 
Editor: The only attributes you can create in the PCB Decal Editor are decal attributes, which are 
associated with the physical decal.
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The Attribute Dictionary does not exist in the PCB Decal Editor; therefore, attributes in the PCB Decal 
Editor are text strings only. They do not have properties, types, hierarchies, and other settings that 
attributes in the Attribute Dictionary have.

When you use Edit Decal to enter the PCB Decal Editor (to edit a design decal), upon exit, you are asked 
whether to apply the changes you made. If you apply the changes when you return to the Layout Editor, 
any attributes you added in the PCB Decal Editor are added to the Attribute Dictionary. The attributes are 
added at the Decal level of the attribute hierarchy and assigned to the appropriate objects.

Restriction:
When you enter PCB Decal Editor using the Tools menu item (to edit a library decal), any 
attributes you create in the PCB Decal Editor are not added to the Attribute Dictionary.

If you created an attribute in the PCB Decal Editor that exists in the Attribute Dictionary, the existing 
attribute in the dictionary is maintained. The attribute is assigned to the part that uses the decal. If a label 
for the attribute exists, it is associated with the attribute in the Attribute Dictionary.

If you created an attribute in the PCB Decal Editor that does not exist in the Attribute Dictionary, a non 
ECO-Registered attribute is created with the Free Text type. The attribute is then assigned to the part that 
uses the decal. If a label for the attribute exists, it is associated with the attribute created in the Attribute 
Dictionary.

Creating Attributes in the PCB Decal Editor
You can define attributes for a decal by typing in the desired name or selecting an attribute name from a 
pre-defined list.

Procedure
1. Click the Tools  > PCB Decal Editor  menu item to open the Decal Editor.

2. Click the Edit  > Attribute Manager  menu item.

3. In the Decal Attributes Dialog Box, click Add.

4. Do one of the following:

• Type an attribute name in the new Attribute cell, and press the Enter key. Attribute names are 
not checked in the PCB Decal Editor.

• Select the new Value cell and click Edit.

• Type an attribute value, and press the Enter key. You can also type units for the value. If you do 
not specify units, the decal units are used.

5. Click Close.

Tip
You can also add attributes using the Browse Lib. Attr.  button.
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Related Topics
Attributes in the PCB Decal Editor

Control of Solder Mask and Paste Mask

Modifying an Attribute
You can use the Attribute Manager to modify an attribute.

Procedure
1. Click the Tools  > PCB Decal Editor  menu item to open the Decal Editor.

2. Click the Edit  > Attribute Manager  menu item.

3. In the Decal Attributes Dialog Box, Select the Attribute cell or the Value cell for the attribute.

4. Click Edit.

5. Type a new name or value, and press the Enter key.

6. Click Close.

Creating Attribute Labels in the PCB Decal Editor
Labels in the PCB Decal Editor offer you greater flexibility than labels in the Layout Editor; you can 
display either decal attributes or an attribute from an object that uses the decal.

Other than the enhanced flexibility, you use attribute labels in the PCB Decal Editor exactly as you use 
labels in the Layout Editor  on page 581.

For example, you can create a label for the part attribute Cost. Since Cost is not a decal attribute, you 
create the attribute in the Attribute Dictionary in the Layout Editor, and assign a placeholder label in the 
PCB Decal Editor. For more information, see “Creating Placeholder Attribute Labels”  on page 201

When you create labels, they may not be visible. Turn on the visibility of labels using the Display Colors 
Setup Dialog Box. Here, you can set the color for reference designators, part type, and attribute labels.

Tip
Pre-version 3.0 labels for part names, reference designators, and terminal numbers are converted 
to labels for version 3.0 and higher when you open the part in the Decal Editor.

Procedure
1. Click the Tools  > PCB Decal Editor  menu item to open the Decal Editor.

2. With a decal open, click the Drafting Toolbar  button to display the Drafting Toolbar.

3. Click the Add New Label  button.

4. In the Add New Decal Label Dialog Box, in the Attribute list, select the attribute you want, or if the 
attribute you desire is not shown in the list, in the Attribute list click <Browse Lib. Attr.> to pick from 
the list of all library attributes. If you are creating labels for jumpers, Reference Designator is the 
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only available attribute. Also, hidden attributes do not appear in the Attribute list unless the attribute 
was selected for the label before it was set as a hidden attribute.

5. In the Browse Library Attributes Dialog Box  click the attribute and click OK. The dialog box closes 
and the attribute name appears in the Attribute list in the Add New Decal Label dialog box.

6. The Value box lists the value of the selected attribute. Accept this value, or type a new one. This 
box is unavailable if you selected Reference Designator or Part Type from the Attribute list, if the 
attribute is read-only, or if you open the Properties dialog box for labels of different attribute types. 
However, if the labels you select belong to attributes of the same type, you can edit this box. If the 
attributes have different values, the box is blank. You can type a new value in the box to apply it to 
all of the selected attribute labels and their parent objects. Additionally, be aware that Value is also 
unavailable if the attribute is ECO-registered and SailWind Layout is not in ECO mode.

7. In the Show list, select the value you want to control the visibility of the label. You can choose 
to turn the label off, to display only the label name, to display only the label value, to display the 
name and value, or to display the full name and value (when labeling a structured attribute  on 
page 1862). Labels are invisible regardless of this setting unless you use the Display Colors Setup 
dialog box to change the color of labels to a color different from that of the background.

8. Complete the label configuration by specifying the desired font, the layer for the label, position, X,Y 
location, rotation, size, stroke width, mirroring, justification and right reading selections. For more 
information on the details of these settings, see Add New Decal Label Dialog Box.

9. Click OK.

Related Topics
Creating Placeholder Attribute Labels

Creating Placeholder Attribute Labels
A placeholder label  is a label for an attribute that does not exist.

Placeholder labels have two practical uses:

• To predefine label positions in the decal and use them in the Layout Editor. This method also lets 
you create labels for non-decal attributes.

• To create a label for an attribute that will be created in the Layout Editor, but does not exist yet.

Procedure
1. When you create a label  on page 200 in the PCB Decal Editor, in the Add New Decal Label 

Dialog Box, in the Attribute list, click “New user attr”. UserAttribN appears in the Attributes list, 
where N is 1, 2, 3, or the next available number.

2. Type the name of an attribute for which you want to create a label.

3. Continue to define the label.

4. Once you create a placeholder label, you can easily associate it with an existing attribute in the 
Attribute Dictionary when you return to the Layout Editor.
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Modifying Decal Label Properties
Use the Decal Label Properties dialog box to modify a decal label or to change the attribute that the label 
displays.

Procedure
1. Click the Tools  > PCB Decal Editor  menu item to open the Decal Editor.

2. Select a decal label  on page 589, right-click, and then click the Properties  popup menu item. If 
you select multiple labels, settings in this dialog box apply to all selected labels.

3. In the Decal Label Properties Dialog Box, in the Attribute list, select the attribute you want.

If you are creating or modifying labels for jumpers, Reference Designator is the only available 
attribute.

Hidden attributes do not appear in the Attribute list unless the attribute was selected for the label 
before it was set as a hidden attribute.

4. The Value box lists the value of the selected attribute. Accept this value, or type a new one. This 
box is unavailable if you clicked Reference Designator or Part Type from the Attribute list, if the 
attribute is read-only, or if you open the Properties dialog box for labels of different attribute types. 
However, if the labels you select belong to attributes of the same type, you can edit this box. If the 
attributes have different values, the box is blank. You can type a new value in the box to apply it to 
all of the selected attribute labels and their parent objects. Additionally, be aware that Value is also 
unavailable if the attribute is ECO-registered and SailWind Layout is not in ECO mode.

5. In the Show list, click the value you want to control the visibility of the label. You can choose to turn 
the label off, to display only the label name, to display only the label value, to display the name and 
value, or to display the full name and value (when labeling a structured attribute  on page 1862). 
Labels are invisible regardless of this setting unless you use the Display Colors Setup dialog box to 
change the color of labels to a color different from that of the background.

6. Complete the label configuration by specifying the desired font, the layer for the label, position, X,Y 
location, rotation, size, stroke width, mirroring, justification and right reading selections. For more 
information on the details of these settings, see Decal Label Properties Dialog Box.

7. Click OK.

Related Topics
Creating Attribute Labels in the PCB Decal Editor

Non-Decal Attributes
A decal label always associates with an attribute name. At any time, that attribute may or may not be a 
decal attribute.

For example, you may create a decal attribute called My Attribute and then create a label for it. If you 
delete the decal attribute, the label remains, but it is now associated with a non-decal attribute with the 
name My Attribute.

The reverse is also true. You can create a label and associate it with an attribute that is not a decal 
attribute (by choosing an attribute from the Library Attribute Manager or by typing an attribute name in the 
Add New Decal Label dialog box). The label is now associated with a non-decal attribute.
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Creating Keepout Areas in a Decal
You can create keepouts in the PCB Decal Editor. Decal-level keepouts appear similar to other keepouts. 
When you create a decal-level keepout, any part using the decal in the Layout Editor uses the specified 
keepout restrictions.

You can create a decal-level keepout that restricts Trace and Copper, Copper Plane, Via and Jumper, 
and Test Points. You cannot create keepouts for placement, component height, or component drills. You 
create a keepout in the PCB Decal Editor the same way you create one in the Layout Editor.

You can create keepout areas using closed polygons (with or without arcs), circles, or rectangles. The 
current angle mode and design grid settings determine the placement of the lines.

You cannot move a decal-level keepout independently of the part to which it belongs. Once you create a 
decal-level keepout, you must enter the PCB Decal Editor to modify any properties of the keepout. You 
modify keepouts in the PCB Decal Editor exactly as you would in the Layout Editor. User interaction is the 
same for either; the only difference is the type of objects you can restrict.

For more information on creating and modifying keepouts, see the Keepouts  on page 465topic.

Procedure
1. With a decal open in the Decal Editor, click the Drafting Toolbar  button to open the Drafting 

Toolbar, and then click the Keepout  button.

2. Right-click and click a draw mode from the popup menu for the type of shape you want to create.

3. Create a closed shape to define the keepout area. The Drafting Properties dialog box automatically 
appears when you close the shape.

4. In the Add Drafting Dialog Box, select restrictions. If you select the Placement restriction, it 
prevents placement of other components. Components bodies are repelled from one another 
on mounted layers using the clearance distance specified in the Body to Body design rule  on 
page 1167. In addition, you can create a larger nudge outline  on page 197 or courtyard that 
also applies only to the mounted layer. But a component keepout can be placed on any layer. For 
example, you create a placement keepout on the opposite side of the board in order to keep the 
area below free of components. Since the keepout is added to the library decal, it moves with the 
component in the design.

5. Click the layer on which to place the keepout. When you choose layer assignments, restrictions not 
available for that layer are unavailable. When defining keepouts in the PCB Decal Editor, you can 
also assign keepouts to the variable <Opposite Side> layer. You cannot do this in the Layout Editor 
- keepouts are assigned to a specific layer.

6. Click OK. The keepout is created. If you create other keepouts, they use the restrictions you set 
here as the default.

Results
If you export your design in ASCII format to an older version of the software where Placement keepouts 
are not valid, you will receive a warning message. If the Placement restriction is the only restriction, the 
keepout will not be exported. If the Placement restriction was not the only restriction, the keepout will be 
exported without the Placement restriction.
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Modifying Decal-level Keepouts
After you create a decal-level keepout, you must use the PCB Decal Editor to modify any of its properties. 
You can change the size of a keepout just as you would any other drafting object: move an edge or 
corner, or change the diameter of a circle. You can also copy a keepout to another location and change its 
restrictions or layer assignments.

Procedure
1. Select an edge, right-click, and then click the Select Shape  popup menu item.

2. Right-click and click the Properties  popup menu item.

3. Turn restrictions on or off and modify the layer settings. For more information, see Drafting Object 
Properties.

4. Click OK.

Restriction:
You cannot modify a keepout that is part of a physical design reuse. If you try to, the 
message “Reuse elements cannot be modified. Break the reuse first” appears. Click OK  to 
cancel the operation.

Layers for Decal-level Keepouts
To create keepouts assigned to Inner Layers (any layer other than top or bottom), you must increase the 
number of layers to three.

Decal-level keepouts use the same layer assignments as keepouts created in the Layout Editor, plus 
an additional option for Opposite Layer. Opposite Layer assigns restrictions to the side opposite the one 
on which you place the component. For example, while editing a decal, create a Copper Plane keepout 
and choose Opposite Side from the Layer list. In the Layout Editor, and with the component mounted on 
the top side, the keepout prevents copper planes in that area on the bottom layer. If you click Flip Side 
to place the component on the bottom layer, the keepout prevents copper planes in that area on the top 
layer.

Generating Drafting Shapes from Terminals
You can use the outline of a terminal as the basis to create new drafting shapes.

Procedure
1. Select one or more terminals.

2. Right-click and click the Generate Drafting Shape  popup menu item.

3. In the Generate Drafting Shape Dialog Box, select the type of drafting item from the Type list. The 
valid drafting types are 2D Line, Copper, Copper Cut Out, and Keepout.

4. In the Layer list, select the Layer on which to place the new drafting shape.

5. In the Width box, type a line width for the new shape.
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6. In the Oversize/Undersize value box, do one of the following:

• To create a new drafting shape larger than the terminal outline by the typed value, type a 
positive number.

• To create a new drafting shape equal in size to the terminal, type 0 (zero).

• To create a new drafting shape smaller than the terminal outline by the typed value, type a 
negative number.

7. Click Complete  to close the dialog box and create a new shape or click Create  to keep the dialog 
box open for creating more shapes.

Step and Repeat
The Step and Repeat tool found in the PCB Decal Editor defines complex, repetitive array patterns so 
that the fanout of traces from a component on a Device Under Test PCB is consistent. Such consistency 
ensures device simulation and testing takes place under exacting conditions.

Step and Repeat arranges terminal, drawing, copper, cutout, or text items in a planar or polar array 
pattern. You can replicate single or multiple items.

Step and Repeat also automatically increments repeated terminals and text suffixes.

Linear Step and Repeat
Use the Step and Repeat dialog box to create linear arrays.

Figure 18. Initial Setup for a Linear Step and Repeat
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Figure 19. Results after Performing a Linear Step and Repeat

Polar Step and Repeat

Use the Polar tab in the Step and Repeat dialog box to create angular, or circular arrays.

Figure 20. Initial Setup for a Polar Step and Repeat
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Figure 21. Results after Performing a Polar Step and Repeat

Radial Step and Repeat

Use the Radial tab in the Step and Repeat dialog box to create radial arrays.

Figure 22. Initial Step for a Radial Step and Repeat with Associated Copper
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Figure 23. Results after Performing a Radial Step and Repeat with Associated Coppers
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Solder and Paste Masks
You can create custom openings in the top and bottom solder mask and paste mask layers for individual 
pad stacks, for decals, or for components. You do this in the Decal Editor, or in the pad stack.

Control of Solder Mask and Paste Mask
Solder Mask Openings in the Decal Editor
Creating Solder Mask Openings in the Pad Stack
Paste Mask Openings in the Decal Editor
Creating Paste Mask Openings in the Pad Stack

Control of Solder Mask and Paste Mask
You can use several methods to control solder or paste mask openings in the gerber outputs. You can 
add physical shapes as openings on the mask layers and you can also generate the openings when 
creating the gerber outputs. Since different areas can have multiple values, the precedence of these 
values follow a hierarchical rule. You can use any combination of such methods.

Physical Shapes in the Work Area
When you create a physical shape (opening) on the mask layer using the following methods, you can 
view it in the Decal Editor and the Design Editor.

In the Pad Stacks

You can add the solder and/or paste mask layer to a pad stack and create the shape and size of the 
opening. And since you can create all of a component’s pins at the same time, you can potentially add 
mask openings to all the pins of a component at once. This method limits you to the pad shapes that are 
available to pad stacks.

You can do this at the design level to make it design specific, or at the library level to make it available for 
each new design that uses the decal.

In the Decal Editor

When you edit the decal in the Decal Editor, you can add a copper shape to a solder mask or paste mask 
layer and that shape becomes the opening in the mask. There are two ways to create the shape:

• You can draw the shape freehand using copper. There is no limit to the shape like in the pad 
stacks.

Tip
Use this method to create gang solder mask relief by drawing a copper rectangle over a 
whole row of pads.

• You can use the Generate Drafting Shape command to generate a copper shape based on the 
shape of a terminal that you can add to the solder or paste mask layer. This has the same effect 
as adding the shape to the pad stack.
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Generated Shapes in the CAM Output
When you generate these shapes in the CAM Output you cannot view them in either the Decal Editor or 
the Design Editor. They are only visible in the CAM Preview.

In the CAM Output

When you create the solder or paste mask output, you can add the pads (from the component layer) and 
the pad shapes become the mask openings. You can globally oversize or undersize the pad shapes with 
a setting in the Plot Options.

In an Attribute

You can apply a unique over or under size setting to special components using an attribute. You can 
assign an oversize or undersize by adding the “CAM.Solder mask.Adjust” or “CAM.Paste mask.Adjust” 
attribute to a decal. The attribute value applies to all pads of the component.

Mask Hierarchy
There is a hierarchical order to the solder mask and paste mask values when there are conflicts. When 
multiple values exist at different hierarchy levels, the highest priority value is used; the others are ignored.

The following table content is true only while the CAM.Apply Oversize To All Pads attribute  on page 960
is set to Yes (the default setting on all new designs in PADS 2007.1 and later versions).

Table  60. Solder & Paste Mask Size Priorities

Hierarchy Level Description

1
(Highest Level - 
overrides all others)

• Pad sizes on the top and bottom solder and paste mask layers in the pad 
stack. If a pad size is defined on both the component level and the decal 
level, the priority order is:
a.  Component instance level value

b.  Library decal level value For more information, see Customizing Pad 
Stacks of Decal Pins

• Component level over/undersize values of the CAM.Solder mask.adjust, 
and CAM.Paste mask.adjust attributes. This applies to Components and 
Vias.

 Tip
The CAM.Solder mask.adjust and CAM.Paste mask.adjust attributes 
are combined not only with pad shapes on the Solder mask or Paste 
mask layers, but in the absence of those pad shapes they can also 
be combined with top and bottom layer component pads when added 
to the configuration of the solder and paste mask layers during the 
creation of the CAM document. For more information, see Design 
Object Attributes

 CAUTION:
Because these two items are of equal priority, when they are both defined, 
they are combined to generate the mask shape.
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Table  60. Solder & Paste Mask Size Priorities  (continued)

Hierarchy Level Description

2 • Library decal level over/undersize values of the CAM.Solder mask.adjust, 
and CAM.Paste mask.adjust attributes.

 Tip
The CAM.Solder mask.adjust and CAM.Paste mask.adjust attributes 
are combined with top and bottom layer component pads when added 
to the configuration of the solder and paste mask layers during the 
creation of the CAM document. For more information, see Creating 
Attributes in the PCB Decal Editor

3 • PCB level over/undersize values of the CAM.Solder mask.adjust, and 
CAM.Paste mask.adjust attributes. For more information, see Adding an 
Attribute to All Objects in the Design

4
(Lowest level - is 
overriden by all 
others)

• Over/undersize value of the global CAM, Plot Options > Over(Under)size 
Pads By value in combination with the CAM.Apply Oversize To All Pads 
attribute. For more information, see Plot Options Dialog Box

Related Topics
Creating a Solder Mask Gerber-format File

Creating a Paste Mask Gerber-format File

Tented Vias With Solder Mask
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Solder Mask Openings in the Decal Editor
Using the Decal Editor, you can create custom solder mask openings for the solder mask layers.

Creating a Solder Mask Opening by Copying a Pad Shape
Creating a Solder Mask Opening by Drawing the Opening Shape

Creating a Solder Mask Opening by Copying a Pad Shape
You can create a solder mask opening by copying a pad shape, over- or undersizing it, and saving it as 
copper on the Top or Bottom solder mask layer.

Procedure
1. Open the decal from the library or the design.

2. With nothing selected, right-click, and click the Select Terminals  popup menu item.

3. Select the terminal you want to copy, right click, and click the Generate Drafting Shape  popup 
menu item.

4. In the Generate Drafting Shape Dialog Box, from the Type list, select Copper.

5. From the Layer list, select Solder Mask Top or Solder Mask Bottom.

6. Set Width and “Oversize/Undersize value” as desired.

7. Click Create.

8. Click Close.

To see the new opening shape(s), you will need to open the Display Colors Setup Dialog Box, 
assign a color to the Top or Bottom solder mask layer, and make the layer active by selecting it 
from the Layer List.

Creating a Solder Mask Opening by Drawing the Opening 
Shape
You can create a solder mask opening by drawing the mask opening shape in copper on the Top or 
Bottom solder mask layer.

Tip
You can also use this procedure to create gang relief of solder mask.

Procedure
1. Open the decal from the library or the design.

2. Select the Solder Mask Top or Solder Mask Bottom layer.

3. Click the Drafting Toolbar  button.
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4. Click the Copper  button.

5. Create the new opening shape  on page 613.

To see the new opening shape(s), you will need to open the Display Colors Setup Dialog Box, 
assign a color to the Top or Bottom solder mask layer, and make the layer active by selecting it 
from the Layer List.

Related Topics
Control of Solder Mask and Paste Mask

Creating Solder Mask Openings in the Pad Stack
You can create custom solder mask openings for individual pins or components in the pad stack.

Tip
Solder Mask openings in the pad stack have priority over all other solder mask opening values. 
see “Control of Solder Mask and Paste Mask.”

Procedure
1. With nothing selected, right-click, and then click the Select Components  popup menu item.

2. Select the component that has the pin(s) for which you want to create solder mask openings.

3. Right-click, and then click the Properties  menu item.

4. In the Component Properties Dialog Box, select thePad Stack  button.

5. In the Pad Stacks Properties Dialog Box, if you want to create an opening for only a single pin, 
click the Add  button under the Pin: Plated: list, and select the pin. If not, go to Step 6.

6. Click the Add  button under the Sh; Sz: Layer: list, and add the Solder Mask Top or Solder Mask 
Bottom layer.

7. Select the appropriate pad shape, and set the Width;, Length: and Orientation values for the new 
solder mask opening.

8. Click OK.

To see the new opening shape(s), you will need to open the Display Colors Setup Dialog Box, 
assign a color to the Top or Bottom solder mask layer, and make the layer active by selecting it 
from the Layer List.

Related Topics
Control of Solder Mask and Paste Mask
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Paste Mask Openings in the Decal Editor
Read the sections that follow to learn how to use the Decal Editor to create custom paste mask openings 
for the paste mask layers.

Creating a Paste Mask Opening by Copying a Pad Shape
Creating a Paste Mask Opening by Drawing the Opening Shape

Creating a Paste Mask Opening by Copying a Pad Shape
You can create a paste mask opening by copying a pad shape, over- or undersizing it, and saving it as 
copper on the Top or Bottom paste mask layer.

Procedure
1. Open the decal from the library or the design.

2. With nothing selected, right-click, and then click the Select Terminals  popup menu item.

3. Select the terminal you want to copy, right-click, and then click the Generate Drafting Shape 
popup menu item.

4. In the Generate Drafting Shape Dialog Box, in the Type list, click Copper.

5. In the Layer list, select Paste Mask Top or Paste Mask Bottom.

6. Set Width and Oversize as desired.

7. Click Create.

8. Click Close.

To see the new opening shape(s), you will need to open the Display Colors Setup Dialog Box, 
assign a color to the Top or Bottom paste mask layer, and make the layer active by selecting it from 
the Layer List.

Creating a Paste Mask Opening by Drawing the Opening 
Shape
You can create a paste mask opening by drawing the mask opening shape in copper on the Top or 
Bottom paste mask layer.

Procedure
1. Open the decal from the library or the design.

2. Select the Paste Mask Top or Paste Mask Bottom layer.

3. Click the Drafting Toolbar  button.

4. Click the Copper  button.
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5. Create the new opening shape  on page 613.

To see the new opening shape(s), you will need to open the Display Colors Setup Dialog Box, 
assign a color to the Top or Bottom paste mask layer, and make the layer active by selecting it from 
the Layer List.

Related Topics
Control of Solder Mask and Paste Mask

Creating Paste Mask Openings in the Pad Stack
You can create custom paste mask openings for individual pins or components in the pad stack.

Tip
Paste Mask openings in the pad stack have priority over all other paste mask opening values. see 
“Control of Solder Mask and Paste Mask”.

Procedure
1. With nothing selected, right-click, and then click the Select Components  menu item.

2. Select the component whose pin(s) you want to create paste mask openings for.

3. Right-click, and then click the Properties  menu item.

4. In the Component Properties Dialog Box, click the Pad Stack  button.

5. In the Pad Stacks Properties Dialog Box, if you want to create an opening for only a single pin, 
click the Add  button under the Pin: Plated: list, and select the pin. If not, go to Step 6.

6. Click the Add  button under the Sh; Sz: Layer: list, and add the Paste Mask Top or Paste Mask 
Bottom layer.

7. Select the appropriate pad shape, and set the Width, Length and Orientation values for the new 
paste mask opening.

8. Click OK.

To see the new opening shape(s), you will need to open the Display Colors Setup Dialog Box, 
assign a color to the Top or Bottom paste mask layer, and make the layer active by selecting it from 
the Layer List.

Related Topics
Control of Solder Mask and Paste Mask

Updating a Design from the Library
When you import a netlist into a design, SailWind Layout writes a copy of the library content for the parts 
into the design. Over time, however, as you make updates to the library, the parts in the design fall out of 
synchronization with newer versions in the library.
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Use Update from Library (UFL) to create a report of any part differences between the current design and 
the library, and to update the design to reflect the current state of the library. You can compare or update:

• Part types

• PCB decals and decal rules

• Attributes and labels

Restrictions and Limitations
When updating a design from the Library, these restrictions will apply:

• Since each item in your design is linked to its library counterpart by name only, unconsidered 
updating can have unforeseen and unintended consequences. Before you update any design, 
you should always ascertain how updating will affect it. Either generate a comparison report 
and determine what differences exist between the design and library (and thus what changes 
will occur during the update,) or make a copy of the design and check/test the updated copy for 
unwanted changes or behavior.

• To find differences between the library and design in the comparison report, search for “different”.

• Design changes resulting from updating can cause existing electrical nets to be truncated, split, 
or deleted altogether. It can also cause existing electrical nets to be extended, or new electrical 
nets to be created if the refdes prefixes of updated components are specified in the Electrical 
Nets dialog box. For more information, see “Electrical Nets”  on page 337.

Procedure
1. Verify that the library order is correct. Updating from the library searches libraries for part types 

using the library order shown in the “Library List dialog box”  on page 1448.

2. If you want to compare/update only specific components, select them. Otherwise, the update from 
library process selects all components in the design by default.

3. Click the Tools  > Update from Library  menu item.

4. Modify the settings in the Update from Library Dialog Box.

5. Click OK.

When the comparison or update operation is completed, the update report is opened for viewing, 
and a link to the report file is written to the Output Window.

Related Topics
Undo an Update From Library

Prevention of Update From Library Undo Buffer Overruns
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Undo an Update From Library
If an update operation updates at least one item, the update process creates an undo checkpoint so that 
you can undo any changes made to the design. You can revert to the last-saved checkpoint using the 
Edit  > Undo  menu item.

Tip
If nothing updates, the update from library process does not create a new undo checkpoint and 
preserves undo data and undo checkpoints created by previous commands.

Prevention of Update From Library Undo 
Buffer Overruns
SailWind Layout stores the data required to undo an update in the undo buffer.

To prevent overflows of this buffer when updating very large designs, UFL estimates the amount of undo 
data being generated, and if there is risk of a buffer overflow, displays this prompt:

“Too much data to fit into the Undo buffer. The Undo buffer will be cleared. Continue?”

Respond with one of the following actions:

• Click OK  to clear the undo buffer and disable undo creation for this update. The update operation 
will continue, and you will be unable to undo the updates.

• Click Cancel  to cancel the update and return to the UFL dialog. Undo data and undo checkpoints 
created by previous commands are preserved.

Related Topics
The Compare/Update Process

Update from Library Dialog Box

How to Read the Update Report

The Compare/Update Process
The update process begins by comparing the design content with the library content. If it finds the design 
content to be different from the library content, it updates the design content according to the options set 
in the Update From Library dialog box, and documents the results in the report file. The compare process 
is the same, except that the design is not updated.

General Rules
During Compare/Update, the system will enforce a number of general rules to assure proper execution of 
the process.
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In comparing and updating, the following general rules apply for all items:

• Matching items  — For each part type and decal listed in the Design items area of the Update 
from Library dialog box, all available libraries are searched to find a matching named entry, and 
the first matching entry found is used. Libraries are searched in the order shown in the Library 
List dialog box (File  > Library  > Manage Lib. List  button). You can use this dialog box to change 
the search order. Libraries that have the Allow Search property turned off are ignored. If no match 
is found, comparison of the item is skipped, and a “not found” entry is made in the report file.

• Timestamps  — Each part type and decal in the design and library has a timestamp. Depending 
on the options chosen in the Update from Library dialog box, comparison of the timestamps can 
determine what is compared/updated. See Update from Library Dialog Box. Designs created with 
SailWind Layout versions prior to 9.1 do not have timestamps. See Older Designs  for information 
on how to handle these designs.

What is Compared
During the Compare/Update process, a number of parameters related to the Part Types and the PCB 
Decal constructions are compared.

The following tables list the content compared and reported for each item selected for comparison or 
update.

Table  61. Compared and Reported Part Type Structures

Item or Element What is Compared & Reported

Part Type Timestamp, Logic Family, ECO Registered (y n), Special Purpose flag, 
gates count, gate pins count, signal pins count, connector pins count, 
attributes count, pin mappings count, decals count, associated decals list

For each gate Pin count, gate swap ID

For each gate pin Pin number, pin name, pin type, pin swap ID

For each signal pin Pin number, name

For each connector pin Pin number

For each attribute Attribute value

For each pin mapping Pin number value

.

Table  62. Compared and Reported PCB Decal Structures

Item or Element What is Compared & Reported

PCB Decal Timestamp, terminals count, padstacks count, attributes count, body 
outline pieces count, free coppers count, keepouts count, text items 
count, labels count, dimensions count, associated coppers count, decal 
rule set count

For each terminal Terminal number, associated padstack, location (x y), associated copper 
list
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Table  62. Compared and Reported PCB Decal Structures  (continued)

Item or Element What is Compared & Reported

For each padstack Drill diameter, drill plated (y n), drill slotted (y n), drill length, drill offset, 
drill orientation, pad count, plus:

• For each normal pad: Layer, pad shape and size, corner style, offset, 
orientation

• For each thermal pad: Layer, thermal shape and size, spoke count, 
spoke width, spoke angle

• For each antipad: Layer, antipad shape and size

For each attribute Attribute value

For each decal rule Rule value

For each body outline piece Layer, shape (OPEN, CLOSED, or CIRCLE), origin (First Corner 
location) (x y), line width, plus:

• If shape is OPEN or CLOSED: geometry corner count, geometry arc 
count, plus:

• For each corner: location (x y)

• For each arc: arc center and radius

• If shape is CIRCLE: circle radius

For each free copper Layer, shape (OPEN, CLOSED, or CIRCLE), origin (First Corner 
location) (x y), line width, associated cutout count, plus:

• If shape is OPEN or CLOSED: geometry corner count, geometry arc 
count, plus:

• For each corner: location (x y)

• For each arc: arc center and radius

• If shape is CIRCLE: circle radius

• For each associated cutout: shape (OPEN, CLOSED, or CIRCLE), 
origin (First Corner position) (x y), line width, plus:

• If shape is OPEN or CLOSED: geometry corner count, geometry 
arc count, plus:

• For each corner: location (x y)

• For each arc: arc center and radius

• If shape is CIRCLE: circle radius

For each keepout Shape (OPEN, CLOSED, or CIRCLE), origin (First Corner location) (x y), 
line width, restrictions, plus:

• If shape is OPEN or CLOSED: geometry corner count, geometry arc 
count, plus:

• For each corner: location (x y)

• For each arc: arc center and radius

• If shape is CIRCLE: circle radius
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Table  62. Compared and Reported PCB Decal Structures  (continued)

Item or Element What is Compared & Reported

For each text item Layer, text string, font, text height, line width, mirror (y n), location (x y), 
rotation, justification (horizontal vertical).

For each label Associated attribute, layer, font, text height, line width, mirror (y n), 
location (x y), rotation, justification (horizontal vertical), right reading, 
visibility

For each associated copper Terminal ID, Layer, shape (OPEN, CLOSED, or CIRCLE), origin (First 
Corner position) (x y), line width, associated cutout count, plus:

• If shape is OPEN or CLOSED: geometry corner count, geometry arc 
count, plus:

• For each corner: location (x y)

• For each arc: arc center and radius

• If shape is CIRCLE: circle radius

• For each associated cutout: shape (OPEN, CLOSED, or CIRCLE), 
origin (First Corner location) (x y), line width, plus:

• If shape is OPEN or CLOSED: geometry corner count, geometry 
arc count, plus:

• For each corner: location (x y)

• For each arc: arc center and radius

• If shape is CIRCLE: circle radius

For each dimension Type, layer, origin (x y), text font, text, piece count, plus:
• For the text: Layer, font, text height, line width, mirror, location (x y), 

rotation, justification (horizontal vertical)

• For each piece: piece type, geometry corner count, geometry arc 
count, plus:

• For each arc: arc center and radius

Older Designs
Designs created with PADS Layout versions prior to 9.1 do not have timestamps. This is important to 
consider when working with older designs.

When one of these designs is opened, the timestamps on all part types and decals in the design are 
set to “Jan 01 00:00:00 1970” (UTC). To find out whether the content of the part types and decals in the 
design is in sync with the library, compare the design and library with the Hide identical results check box 
selected.

Related Topics
Updating a Design from the Library

Update from Library Dialog Box

How to Read the Update Report

220 SailWind Layout Guide and Reference



 
Creating and Editing PCB Decals
How to Read the Update Report

How to Read the Update Report
Every time you update a design from the library or generate a comparison report, SailWind Layout writes 
the results of the operation to a new UpdateFromLibrary_Layout_Report.txt  file in C:\SailWind Projects.

The Update Report gives you information about the items selected for comparison or update, including:

• Whether the timestamp of an item in the design is older, newer, or the same as the item’s 
timestamp in the library.

• Whether the content of an item in the design is the same as or different from the item’s content in 
the library.

• The differences between the compared items.

Update Report Examples
The Update Report is divided into a header and six sections: Report Options, Results Summary, Part 
Types Summary, PCB Decals Summary, Part Type Comparison Details, and PCB Decal Comparison 
Details.

Examples of each section are given in the following figures:

• Report Options section  — Lists the options selected for this operation in the Update from 
Library dialog box. Example:  
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• Results Summary section  — Gives a statistical summary of comparison and update results. 
Example: 

• Part Types Summary section  — Lists all the selected part types and decals, and gives 
comparison/update information about each. Example:  

• PCB Decals Summary section  — Lists all the PCB Decals associated with the selected part 
types and gives comparison/update information about each. Example:  

• Part Type Comparison Details section  — Lists compared part types, showing detailed 
comparison results. Example:  
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• PCB Decal Comparison Details section  — Lists compared decals, showing detailed 
comparison results. Example:

Update Report Messages

The following tables list and describe the messages returned for compared/updated items in the Update 
Report.
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Table  63. Part Type and PCB Decal Summary Messages

Appears in Column: Message Explanation

older than in library Design version is older than 
Library version.

identical Design and library versions 
have identical timestamps.

newer than in library Design version is newer 
than Library version.

Design Timestamp

not checked Timestamps were not 
compared because the item 
was not found in the library.

same Compared item content in 
the design and library are 
the same. (Does not apply 
to any item content that is 
not compared because the 
comparison is turned off 
in the Update from Library 
dialog box.)

different Compared item content in 
the design and library are 
different.

Compared Content

not checked Content was not compared 
because the item was not 
found in the library.

updated Design item has been 
updated with content from 
the library.

not touched Design item (part 
type/decal) was not 
updated because:

• UFL was run in 
Compare mode, or

• The item was not found 
in the library.

Update Status

update failed The item could not be 
updated. Some possible 
causes are:

• Lost connection to 
library file

• Mismatch of pin counts 
between design and 
library items
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Table  63. Part Type and PCB Decal Summary Messages  (continued)

Appears in Column: Message Explanation

• The library part type has 
no decal assigned.

• Decal not found in 
library when updating 
part type and decal

skipped Items are skipped if:
• They do not qualify for 

Compare/Update (for 
example, items with 
identical timestamps), or

• The item was not found 
in the library.

.

Table  64. Part Type and PCB Decals Comparison Details Messages

Appears in Column: Message Explanation

same Item content in the design 
and library are the same. 
(Order can be different.)

different Item content in the design 
and library are different.

 Tip
A design that has been 
exported to ASCII and 
reimported may show 
differences in graphical 
data resulting from 
optimizations made 
during ASCII export.

not found in library Item does not exist in the 
library.

Comparison

not found in design Item does not exist in the 
design.

none Item has no Special 
Purpose flag.

< no value > Attribute exists but has no 
value assigned.

Library
Design

< no attribute > Attribute not found.
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Related Topics
Updating a Design from the Library

Update from Library Dialog Box

The Compare/Update Process
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Chapter 8
Creating and Modifying Part Types

Read the topics that follow to learn more about the processes used to create, modify, and save part types 
to the libraries, as well as the structures involved in assigning pin numbers and gates to part types.

Part Types
Creation of a New Part Type
Creating a Part Type with Identical Schematic and Layout Pin Numbering
Creating a Part Type with Different Schematic and Layout Pin Numbering
Creating a Non-ECO-Registered Part Type
Creating a Non-Electrical Part Type
Creating a Connector Part Type
Modification of Part Types
Saving Modified Decals and Parts to Libraries

Part Types
You cannot add a part to a SailWind Layout design, or import the part as a component of a netlist, unless 
the library has an available part type and a PCB decal for the part.

• The PCB decal represents the “footprint” of the part (including pad and drill sizes) on the board, 
and is required both to place the part on the board and to route the nets connecting to the part’s 
pins.

• The part type represents the electrical configuration of the part, including its logic family, 
pins, gates and gate pins, and mapping of gate pins to the part’s pins. It also includes other 
information, such as part attributes and the list of PCB decals assigned to the part. When you add 
a part to a design, it is added as an instance of the part type.

You create a new SailWind part type  on page 230, or modify an existing part type  on page 235, by 
specifying the properties of the part in the tabs of the Part Information dialog box, as follows:

• General —  on page 1590Part statistics, logic family, pin number mapping status, connector 
status, ECO-registered status, list of reference designator prefixes to define the set of parts to 
which these properties apply, define part as special purpose (connector, die part, or flip chip).

• PCB Decals —  on page 1593List of assigned PCB Decals. You must assign a decal to the part 
before specifying gate information, signal pin names, and alphanumeric pin names.

• Gates —  on page 1588Default and alternative gates, gate swapping eligibility, gate properties, 
gate pin-swapping eligibility.

• Pins —  on page 1596Signal names for pins, such as power and ground pins.

• Attributes —  on page 1584Attributes of the part.
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• Connectors —  on page 1586Default and alternative CAE decals used as connectors in SailWind 
Logic. This tab is unavailable when the Connector check box on the General tab is cleared, or 
when a gate has been assigned to the part on the Gates tab.

• Pin Mapping —  on page 1600Optional pin mapping of logical to physical pin numbers This tab is 
unavailable when you select the Define Mapping Of Part Type Pin Numbers To PCB Decal check 
box on the General tab, and assign one or more decals containing alphanumeric pin numbers. 
The decal determines the number of pins in the part.

Creation of a New Part Type
You can create new part types for a large selection of component types.

There are five different component types that require specific instructions to create the part type:

• The component is an electrical part, and the logical and physical pin numbering is the same--both 
numeric, or both alphanumeric. For detailed instructions, see “Creating a Part Type with Identical 
Schematic and Layout Pin Numbering”.

• The component is an electrical part, and the logical and physical pin numbering is different--the 
logical is alphanumeric and the physical is numeric. For detailed instructions, see “Creating a Part 
Type with Different Schematic and Layout Pin Numbering”.

• The component is a connector. For detailed instructions, see “Creating a Connector Part Type”.

• The component will not be ECO registered. For detailed instructions, see “Creating a Non-ECO-
Registered Part Type”.

• The component is a non-electrical part, such as a mounting screw or locating post, that is not 
connected to any net. For detailed instructions, see “Creating a Non-Electrical Part Type”.

Creating a Part Type with Identical Schematic 
and Layout Pin Numbering
You can create a part type that uses the same logical and physical pin numbering. You can choose either 
alphanumeric-to-alphanumeric or numeric-to-numeric for the schematic-to-layout pin numbering.

Restrictions and Limitations

• Your PCB decal(s) must exist to use this procedure. For more information, see “Creation of a 
New Decal”.

Procedure
1. Click the File  > Library  menu item.

2. In the Library Manager Dialog Box, select a library for the new part.

3. Click the Parts  button, and then click the New  button.
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4. On the General tab  on page 1590 of the Part Information dialog box, select the logic family; this 
sets the refdes prefix.

5. Select the ECO Registered Part check box.

6. On the PCB Decals tab  on page 1593, assign one or more decals to the part.

Note:
If your logic symbol uses alphanumeric pin numbering and the PCB decal uses numeric 
pin numbering, you must use the Pin Mapping  tab to map the alphanumeric symbol pins 
to the numeric decal pins. For instructions, see Mapping Alphanumeric Pin Numbers to 
Numeric Decals.

7. On the Gates  tab, add at least one gate. (Add multiple gates if you want to be able to swap them.) 
For instructions, see “Assigning CAE Decals to Gates”.

8. On the Pins tab  on page 1596, you must fill out the Pin Group and Name columns; the other 
columns are optional. For instructions, see “Editing Pins Table Data”.

9. On the Attributes tab  on page 1584, add attributes as necessary. For instructions, see “Adding 
Attributes to a Part Type”  on page 243.

10. Click OK. For instructions, see “Part Type Error Checking”.

11. In the Save Part Type to Library dialog box, type a name for the new part, and click OK.

Related Topics
Creation of a New Part Type

Creating a Part Type with Different Schematic 
and Layout Pin Numbering
You can create a part type that uses alphanumeric numbering for the logical pins and numeric numbering 
for the physical pins. Use the Pin Mapping  tab to map the alphanumeric symbol pins to the numeric 
decal pins.

Restrictions and Limitations

• Your PCB decal(s) must exist. For more information, see “Creation of a New Decal”.

Procedure
1. Click the File  > Library  menu item.

2. In the Library Manager Dialog Box, select a library for the new part.

3. Click the Parts  button, and then click the New  button.

4. On the General tab  on page 1590 of the Part Information dialog box, select the logic family; this 
sets the refdes prefix.
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5. Select the “Define mapping of Part Type pin numbers to PCB Decal” check box.

6. Select the “ECO Registered Part” check box.

7. On the PCB Decals tab  on page 1593, assign one or more numeric decals to the part. For 
instructions, see “Mapping Alphanumeric Pin Numbers to Numeric Decals”.

8. On the Gates tab  on page 1588, add at least one gate. (Add multiple gates if you want to be able 
to swap them.) For instructions, see “Assigning CAE Decals to Gates”.

9. On the Pins tab  on page 1596:

a. The pin numbering in the part type needs to match the pin numbering style used in the logical 
schematic symbol, so change the pin numbers to alphanumerics to match the schematic 
alphanumerics. For instructions, see “Renumbering Pins in the Pins Table”.

b. Fill out the Pin Group and Name columns; the other columns are optional. For instructions, see 
“Editing Pins Table Data”.

10. On the Attributes tab  on page 1584, add attributes as necessary. For instructions, see “Adding 
Attributes to a Part Type”  on page 243.

11. On the Pin Mapping tab  on page 1600, map the unmapped logical pins (alphanumeric) to the 
physical decal pins (numeric). For instructions, see “Mapping Alphanumeric Pin Numbers to 
Numeric Decals”.

12. Click OK. For more information, see “Part Type Error Checking”.

13. In the “Save Part Type to Library” dialog box, type a name for the new part, and click OK.

Related Topics
Creation of a New Part Type

Creating a Non-ECO-Registered Part Type
You can create a non-ECO-registered part type. A non-ECO-registered part is a part—such as a 
mounting-hole—that does not transfer during forward or backward annotation.

Procedure
1. Click the File  > Library  menu item.

2. In the Library Manager Dialog Box, select a library for the new part.

3. Click the Parts  button, and then click the New  button.

4. On the General tab  on page 1590 of the Part Information dialog box, select the logic family; this 
sets the refdes prefix.

5. Clear the ECO Registered Part check box.

6. On the PCB Decals tab  on page 1593, assign one or more decals to the part. For instructions, see 
“Mapping Alphanumeric Pin Numbers to Numeric Decals”.

7. On the Gates tab  on page 1588, add at least one gate. (Add multiple gates if you want to be able 
to swap them.) For instructions, see “Assigning CAE Decals to Gates”.
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8. On the Pins tab  on page 1596, you must fill out the Pin Group and Name columns; the other 
columns are optional. For instructions, see “Editing Pins Table Data”.

9. On the Attributes tab  on page 1584, add attributes as necessary. For instructions, see “Adding 
Attributes to a Part Type”  on page 243.

10. Click OK. For more information, see “Part Type Error Checking”.

11. In the Save Part Type to Library dialog box, type a name for the new part, and click OK.

Related Topics
Creation of a New Part Type

Creating a Non-Electrical Part Type
You can create a non-electrical part type such as a mounting screw or locating post and add it to a parts 
list.

Restrictions and Limitations

• Your PCB decal(s) must exist to use this procedure. For more information, see “Creation of a 
New Decal”.

Procedure
1. Click the File  > Library  menu item.

2. In the Library Manager Dialog Box, select a library for the new part.

3. Click the Parts  button, and then click the New  button.

4. On the General tab  on page 1590 of the Part Information dialog box, select the logic family; this 
sets the refdes prefix.

5. Clear the ECO Registered Part check box.

6. On the PCB Decals tab  on page 1593, assign a non-electrical (no pin terminals) decal to the part. 
For instructions, see “Mapping Alphanumeric Pin Numbers to Numeric Decals”.

7. On the Attributes tab  on page 1584, add attributes as necessary. For instructions, see “Adding 
Attributes to a Part Type”  on page 243.

8. Click OK. For more information, see “Part Type Error Checking.”

9. In the Save Part Type to Library dialog box, type a name for the new part, and click OK.

Related Topics
Creation of a New Part Type
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Creating a Connector Part Type
You can create a connector part type that enables a feature in SailWind Logic to split a connector into 
multiple pin decals, making each pin its own gate.

Restrictions and Limitations

• Your PCB decal(s) must exist to use this procedure. For more information, see “Creation of a 
New Decal”.

Procedure
1. Click the File  > Library  menu item.

2. In the Library Manager Dialog Box, select a library for the new part.

3. Click the Parts  button, and then click the New  button.

4. On the General tab  on page 1590of the Part Information dialog box, select the logic family; this 
sets refdes prefix.

5. Select the ECO Registered Part check box.

6. Select the Special Purpose check box, and click Connector.

7. On the PCB Decals tab  on page 1593, assign one or more decals to the part. For instructions, see 
“Mapping Alphanumeric Pin Numbers to Numeric Decals”.

8. On the Pins tab  on page 1596, you must fill out the Pin Group and Name columns; the other 
columns are optional. For instructions, see “Editing Pins Table Data”.

9. On the Attributes tab  on page 1584, add attributes as necessary. For instructions, see “Adding 
Attributes to a Part Type”  on page 243.

10. On the Connector tab  on page 1586, add pin decals to be used in the schematic. For instructions, 
see “Assigning Special Symbols to a Connector”.

11. Click OK. For more information, see “Part Type Error Checking”.

12. In the Save Part Type to Library dialog box, type a name for the new part, and click OK.

Related Topics
Creation of a New Part Type
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Modification of Part Types
Read the sections that follow to learn more about the processes used to modify part types and to check 
them for errors, as well as how to add and modify part type attributes.

Modifying a Part Type
Assigning PCB Decals to Part Types
Assigning CAE Decals to Gates
Modification of Gates in Parts in the Library
Modifying the Pins Table Information
Part Type Error Checking
Adding and Modifying Part Type Attributes
Assigning Special Symbols to a Connector
Mapping Alphanumeric Pin Numbers to Numeric Decals

Modifying a Part Type
You can modify part types to accurately represent the requirements of your designs.

Procedure
1. Click the File  > Library  menu item.

2. Select a Library, and then click the Parts  button.

3. Select a part, and then click the Edit  button.

4. When you have finished modifying the properties, click OK  to save the changes.

Assigning PCB Decals to Part Types
Filter your library search for decals and assign a decal and then alternates if desired.

Procedure
1. Click the File  > Library  menu item.

2. In the Library Manager Dialog Box, select a Library, and then click the Parts  button.

3. Select a part, and then click the Edit  button.

4. On the PCB Decals tab  on page 1593, to filter the contents of the Unassigned Decals list, use any 
of the following:

a. In the Library list, select an individual library (or select “All Libraries”).

b. In the Filter box type wildcards  on page 155. Type asterisk (*) in the Filter box to display all 
decals.
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c. Type a number in the Pin Count box, and then click Apply.

d. Click the “Show only Decals with pin numbers matching Part Type” check box to filter out 
decals that do not have pin numbers matching existing gate and signal pins on the Pins  tab, or 
the physical pin numbers on the Pin Mapping  tab.

5. To assign one or more decals:

• Select a decal in the Unassigned Decals list and click Assign. Assigned PCB decals can have 
a different number of pins.

• To assign a decal that does not exist in a library, click Assign New. In the the Assign New PCB 
Decal dialog box, type the name and then click OK.

You can only assign up to 16 PCB decals to a part. You must assign a decal with enough 
pins for all the defined gate pins and signal pins on the Pins  tab. Only decals with sequential 
numerical pin numbers can be used with pin mapping.

6. To change the order of decals in the Assigned Decals list, select the decal, and then click Up  or 
Down.

Tip
The decal at the top of the list is the default decal and is used when you add the part to the 
design.

7. When you have finished modifying the properties, click OK  to save the changes.

Related Topics
Creation of a New Part Type

Library Content and the Search Order

Assigning CAE Decals to Gates
Type the name of a CAE Decal or use the Assign Decal to Gate dialog box to assign default and 
alternative CAE decals to gates.

Procedure
1. Click the File  > Library  menu item.

2. In the Library Manager Dialog Box, select a Library, and then click the Parts  button.

3. Select a part, and then click the Edit  button.

4. In the Part Information for Part dialog box, select the Gates tab  on page 1588.

5. Select the cell under CAE Decal 1 and click the Edit  button or double-click the cell under CAE 
Decal 1.

6. Type a decal name in the CAE Decal box or click the  (browse) button to search for a decal 
from a library.
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7. The Browse  button opens the Assign Decal to Gate Dialog Box. To filter the contents of the 
Unassigned Decals list, use any of the following:

a. In the Library list, select an individual library or select (All Libraries).

b. In the Filter box, type wildcards  on page 155. Type asterisk * in the Filter box to display all 
decals.

c. Type a number in the Pin Count box, and then click Apply. This box is read-only after a decal 
is assigned.

8. To assign one or more decals:

• Select a decal in the Unassigned decals list and click Assign, or to assign a decal that does not 
exist in a library, click Assign New. In the Assign New Gate Decal dialog box, type the name 
and then click OK.

• You can assign up to four CAE decals to a part. Assigned decals must have the same number 
of pins.

9. To change the order of decals in the Assigned Decals list, select the decal, and then click Up  or 
Down.

Tip
The decal at the top of the list is the default decal and is used when you add the part to the 
schematic.

10. Assign Gate pins on the Pins tab  on page 1596.

11. When you have finished modifying the properties, click OK  to save the changes.

Related Topics
Creation of a New Part Type

Modification of Gates in Parts in the Library

Modification of Gates in Parts in the Library
You can modify parts in the library using the Library Manager. Information you can modify includes 
location, decal, connector, gates, alphanumerics, signal pins, and attributes.

For each gate, you can type the CAE Decal name; the name of the logic symbol that is used to display 
the part in the schematic. Alternate decal assignments must have the same number of pins. You can 
define one primary and three alternate decals for each gate.

When at least one decal is assigned to a part, you can type or modify its gate information. This includes 
swap enabling or disabling for gates within a part or between similar parts. This information lets SailWind 
Layout know which gates it can substitute for connection length minimization after placement.

You can also swap pins within gates to uncross connections and facilitate routing. In both gate and pin 
swapping, you assign a number to the gate or pin in the Gates tab. Pins with like numbers can swap 
within a gate. Gates with like numbers can swap within the part, or to other similar parts. A one (1) 
indicates the gate is swappable with gates of the same part type in the PCB design database. If a part 

SailWind Layout Guide and Reference 237



Creating and Modifying Part Types
Modification of Gates in Parts in the Library  
contains more than one type of swappable gate, then identify the second type with the number 2, the third 
type with 3, and so on. Zero (0) indicates that no swapping can occur.

For more information, see the Creating and Modifying Part Types  on page 229topic.
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Modifying the Pins Table Information
The Pins table contains the mapping of the pins data and allows you to add, edit, and renumber the pins.

Adding a Series of Pins to the Pins Table
Editing Pins Table Data
Renumbering Pins in the Pins Table

Adding a Series of Pins to the Pins Table
You can use the Add Pins dialog box to add a series of pins to the Pins table instead of adding one pin at 
a time.

Procedure
1. Click the File  > Library  menu item.

2. In the Library Manager dialog box  on page 1449, select a Library, and then click the Parts  button.

3. Select a part, and then click the Edit  button.

4. In the Part Information for Part dialog box, select the Pins tab  on page 1596.

5. Click the Add Pins  button.

6. In the Add Pins Dialog Box, type the number of pins to add in the Number of pins box. Total pins 
for the part can not exceed 32,767 pins.

7. In the Start pin number area, type values in the Prefix and/or Suffix boxes. A preview of pin 
numbers based on your input is displayed below the boxes. Alphabetic and numeric values can 
be used in either box. For example, A1 or 1A. For a single numeric, use either Prefix or Suffix box, 
and void the other box.

Note:
If you type alphanumerics and the decal uses numerics, you must use the Pin Mapping 
tab to map the alphanumerics onto the decal.

8. In the Increment options area, choose what to increment by clicking either the Increment prefix or 
Increment suffix option.

9. In the Step value box, type a positive or negative number by which to increase or decrease the pin 
numbers with consecutive or stepped values.

10. If using alphanumerics, you can select the Use JEDEC pin numbering check box to ensure that 
legal alphanumeric values are used.

11. When you have finished modifying the properties, click OK  to save the changes.

12. Click OK  to close the Part Information for Part dialog box.
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Related Topics
Creation of a New Part Type

Editing Pins Table Data
You can click a cell in the row of the pin you are editing to edit the cell contents, or select one or more 
cells of the same column and click the Edit  button.

Procedure
1. Click the File  > Library  menu item.

2. In the Library Manager dialog box  on page 1449, select a Library, and then click the Parts  button.

3. Select a part, and then click the Edit  button.

4. In the Part Information for Part dialog box, select the Pins tab  on page 1596.

5. Click the Pin Group cell and in the list, choose from gate, signal pin, or unused pin. Gates listed 
in the Pin Group cell list are added using the Gates  tab. Signal pins require a signal name in the 
Name cell.

6. Click the Number cell and type a pin number for the pin. Typically, the pin number should match 
those used in the PCB decal. For example, alphanumeric to alphanumeric. Pin numbers can be 
either numeric or alphanumeric.

Note:
Prior to PADS2007, alphanumeric pin numbers were not legal on the PCB decal but 
overlaid the numeric decal numbers, and were stored within the Part Type. If your logical 
schematic symbol uses alphanumeric pin numbering, you can continue to keep numeric 
PCB decals and use the Pin Mapping  tab to overlay different alphanumeric pin numbers 
onto the numeric PCB decal pin numbers.

7. Click the Name cell and type a pin signal or function name. For example, “Clock” or “CLK.” A pin 
name is not required. The Name column is not used for unused pins.

Note:
Gate pin names can contain up to 40 characters, while signal pin names can contain up to 
47. All alphanumeric characters are accepted. You cannot use special characters such as 
question marks ?, curly braces { }, asterisks *, periods ., commas , , or spaces.

8. Click the Type cell and in the list, choose a pin type. The type column is only used with gate pins.

9. Click the Swap cell and type a swap number, or use the up/down arrows. You swap pins within 
gates to uncross connections and facilitate routing. Pins with like numbers can swap within a gate. 
Type 0 to disable swapping.

10. Click the Sequence (Seq.) cell and type the gate sequence number. The sequence number 
determines the mapping of CAE gate pins to PCB decal pins. The sequence is automatically 
shared with alternate CAE decals. For example, it shows how pin numbers appear on the CAE 
gate decal; therefore, in Gate A, sequence number 1 could be pin 1, but in Gate B, sequence 
number 1 would be pin 4.
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Note:
When editing pin data for connectors, only the Pin Group and Number columns are 
relevant. Data entered in other columns is rejected. Connectors do not have gates, so the 
Pin Group column just indicates whether a pin is a connector pin or an unused pin.

11. When you have finished modifying the properties, click OK  to save the changes.

Related Topics
Creation of a New Part Type

Renumbering Pins in the Pins Table
You can change the numbering of pins in the Pin  tab table.

Procedure
1. Click the File  > Library  menu item.

2. In the Library Manager dialog box  on page 1449, select a Library, and then click the Parts  button.

3. Select a part, and then click the Edit  button.

4. In the Part Information for Part dialog box, select the Pins tab  on page 1596.

5. Select one or more cells in the Number column.

6. Click the Renumber  button. In the Renumber Pins Dialog Box, the Number of pins box displays 
the number of pins selected for renumbering.

7. In the Start pin number area, type values in the Prefix and/or Suffix boxes. A preview of pin 
numbers based on your input is displayed below the boxes. Alphabetic and numeric values can 
be used in either box. For example, A1 or 1A. For a single numeric, use either Prefix or Suffix box, 
and void the other box.

8. In the Increment options area, choose what to increment by clicking either the Increment prefix or 
Increment suffix option.

9. In the Step value box, type a positive or negative number by which to increase or decrease the pin 
numbers with consecutive or stepped values.

10. If using alphanumerics, you can select the “Use JEDEC pin numbering” check box to ensure that 
legal alphanumeric values are used.

11. When you have finished modifying the properties, click OK  to save the changes.

Related Topics
Creation of a New Part Type

Part Type Error Checking
Validation takes place when you click Check Part, OK, Save As, or when you click a different tab.

SailWind Layout Guide and Reference 241



Creating and Modifying Part Types
Part Type Error Checking  

The validation process checks for the following error conditions:

• Empty pin numbers or pin numbers with embedded spaces or illegal characters. Duplicated Pin 
numbers

• Empty, duplicated, or non-sequential sequence numbers within a single gate

• Non-empty Type cells for signal pins or unused pins, or empty Type cells for gate pins

• Pin names with illegal characters for gate pins, net names with illegal characters for signal pins, 
non-empty name for unused pins, empty name for signal pins. Blank pin names are permitted for 
gate pins.

• Empty pin swap for gate pins, non-empty pin swap for signal and unused pins. Pin swap values 
for gate pins outside of the range 0 to 100.

Related Topics
Creation of a New Part Type
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Adding and Modifying Part Type Attributes
You can add part type attributes to part types. You can also modify existing part type attributes to 
accommodate changes and additions to your design data.

Adding Attributes to a Part Type
Adding Height Information to Library Parts
Defining Default Attributes for New Parts

Adding Attributes to a Part Type
You can add part information (attributes) to a part type such as manufacturer, part number, and so forth.

Procedure
1. Click the File  > Library  menu item.

2. In the Library Manager dialog box  on page 1449, select a Library, and then click the Parts  button.

3. Select a part, and then click the Edit  button.

4. In the Part Information for Part dialog box, click the Attributes tab  on page 1584.

5. Click Add  to add a new attribute row.

6. Type the new attribute name and value. Alternatively, you can click the Browse Lib Attr  button to 
select an existing attribute from a list.

7. Repeat Steps 2 and 3 to add additional attributes.

8. When you have finished modifying the properties, click OK  to save the changes.

Adding Height Information to Library Parts
You can add height information to part types. SailWind Layout uses height information to prevent layout 
designers from placing components in height-constrained areas. SailWind Layout also uses the height 
information when exporting a design to a 3-dimensional modeling application.

Procedure
1. Click the File  > Library  menu item.

2. In the Library Manager dialog box  on page 1449, select a Library, and then click the Parts  button.

3. Select a part, and then click the Edit  button.

4. In the Part Information for Part dialog box, click the Attributes tab  on page 1584.

5. Click Add  to add a new attribute row.

6. For the new attribute name type Geometry.Height. Alternatively, you can click the Browse Lib Attr 
button to select Geometry.Height from a list.
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7. Type the value in current design units.

8. When you have finished modifying the properties, click OK  to save the changes.

Related Topics
Adding Height Information to Design Components and Jumpers

Restricting Heights on Component Layers

Restricting Heights in Areas of Component Layers

Defining Default Attributes for New Parts
You can save a default set of attributes for use with each new part.

Note:
Attribute names but not values are saved in the default attribute list.

Procedure
1. Click the File  > Library  menu item.

2. In the Library Manager dialog box  on page 1449, select a Library, and then click the Parts  button.

3. Select a part, and then click the Edit  button.

4. In the Part Information for Part dialog box, click the Attributes tab  on page 1584.

5. Once the list of attributes is correct, click Save As Default.

6. When you have finished modifying the properties, click OK  to save the changes.

Results
The default attribute list is saved to C:\<install_folder>\<version>\Settings\defaultattribute.txt, which is 
shared between SailWind Logic and SailWind Layout.

Related Topics
Library Attribute Management

Creation of a New Part Type

Assigning Special Symbols to a Connector
Use the Browse for Special Symbols dialog box to assign one or more pin decals, or Special Symbols, to 
a connector. Doing so allows you to use any of the special symbols as alternate pins of the connector.

Instead of displaying it as a single symbol, SailWind Layout breaks up the connector into individual pin 
symbols in the schematic. You can place the pins all together, or wherever you like, on a single page or 
even across multiple pages.
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Mapping Alphanumeric Pin Numbers to Numeric Decals

Procedure
1. Click the File  > Library  menu item.

2. In the Library Manager dialog box  on page 1449, select a Library, and then click the Parts  button.

3. Select a part, and then click the Edit  button.

4. In the Part Information for Part dialog box, click the Connector tab  on page 1586.

5. To filter the Gate Decals list, select a library in the Library list, type wildcards  on page 155 in the 
Filter box, and then click Apply. To display all items, type asterisk * and click Apply.

6. Select the item in the list.

7. Click OK.

8. When you have finished modifying the properties, click OK  to save the changes.

Related Topics
Creating a Connector Part Type

Creation of a New Part Type

Mapping Alphanumeric Pin Numbers to Numeric 
Decals
You can complete the pin mapping in one of several ways.

Procedure
1. Click the File  > Library  menu item.

2. In the Library Manager dialog box  on page 1449, select a Library, and then click the Parts  button.

3. Select a part, and then click the Edit  button.

4. In the Part Information for Part dialog box, select the Pin Mapping tab  on page 1600.

5. In the decal list above the preview window, select the assigned decal to which you want to map 
alphanumeric pins.

6. Map the pins using one of the following methods

• Using the Unmapped Pins list  — In the Unmapped Pins list, select one or more 
alphanumerics. Select one or the starting row in the Part Type column if you have a consecutive 
list to map. Click Map.

CAUTION:
If there are any errors in the pin numbering, correct them by editing the table on the Pins 
tab. Do not attempt to renumber pins in the table on the Pin Mapping  tab.
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• Using the Part Type column  — Select a cell in the Part Type column and click the Edit  button, 
or simply double-click the cell. Then type a pin number. The pin number is removed from the 
Unmapped pins list.

• Using the Preview Window  — Select an alphanumeric in the Unmapped Pins list and double 
click the pin in the decal preview window to map the alphanumeric to the pin. The next row in 
the Unmapped Pins list becomes the next selected alphanumeric for mapping.

Tip
In the preview window, you can click and drag to define a zoom box, or use Shift+click 
or Shift+right-click to zoom in or out by a factor of two. You can zoom in up to 16X the 
original scale. The preview window will only zoom out to fit the decal entirely in the view.

• Using a Spreadsheet Application  — Click Copy Map  to copy both columns of the mapping 
table. Paste the mapping table into Excel. Make mass edits. Copy the data from Excel and click 
Paste Map  on the Pin Mapping  tab.

Note:
Copy Map  and Paste Map  only work with the whole pin mapping table and not selective 
rows.

7. Repeat as necessary.

8. When you have finished modifying the properties, click OK  to save the changes.

Related Topics
Creating a Part Type with Different Schematic and Layout Pin Numbering

Creation of a New Part Type

Saving Modified Decals and Parts to Libraries
Use the Save Part Types and Decals to Library dialog box to save modified decals or parts to libraries.

Procedure
1. Modify the decal or part in the PCB Decal Editor, and then return to the Layout Editor.

2. Select the components, right-click, and then click the Save to Library  popup menu item.

3. In the Save Part Types and Decals to Library Dialog Box, select items in the Part Types and 
Decals lists.

Tip
If you created a new suffixed decal, meaning you changed the pad stack for one 
component only and the decal name has a unique suffix, the new decal also appears in the 
Decals list.
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4. Select libraries to receive the information in the Part Type Library and Decal Library lists.

5. Click OK.

Related Topics
Creating a Basic Decal Automatically

Creating a New Library

Import and Export of Libraries
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Chapter 9
Starting a New Design

Typically, you start a new design by creating a new design file, and then importing a netlist created by a 
schematic tool such as SailWind Logic. But if the design you are planning is simple and does not require 
a schematic, you can create the design all within SailWind Layout itself. Designs you create in this way 
are referred to as “layout-driven” designs.

Creating a New Design File
Import of a Schematic Design Netlist
Cross-Probing
Creating a New PCB Design from an OrCAD Netlist
Layout-Driven Designs

Creating a New Design File
Use the New command to create a new design file.

Procedure
1. Open SailWind Layout and click New. (If you already have a design open in SailWind Layout, click 

the File  > New  menu item).

2. In the Set Start-up File Dialog Box, select the start-up file. A start-up file contains global settings 
such as layer definitions, grids, clearance rules, the attribute dictionary, and so on.

3. If you want to use this start-up for all new design files, select the Don't Display Again check box.

4. Click OK.

Related Topics
Start-up Files

Import of a Schematic Design Netlist
The process of laying out a design in SailWind Layout typically begins with importing a netlist file 
containing all the schematic information for the design, including a list of all the parts and their decals.

During the netlist file import process, all the parts are sourced from the library, and their decals are 
stacked at the origin, ready for placement.

CAUTION:
For a netlist import to succeed, all parts and decals listed in the netlist must exist in your library. 
If any are missing, the import operation writes an ascii.err  file listing the missing parts/decals. To 
import the netlist successfully, you must add these components to your library, either by adding a 
library which contains the missing components to your library list, or by creating the missing part 
types and missing decals in an existing library.
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The procedure you use to import a netlist depends on which schematic tool you are using. For product-
specific instructions, see one of the following topics:

• “Creating a New PCB Design by Manually Importing the SailWind Logic Netlist”  on page 271

• Creating a New PCB Design from an OrCAD Netlist

Cross-Probing
You can cross-probe with SailWind Logic to simplify importing the netlist and placing the parts.

The procedure you use to cross-probe  on page 1819 depends on which schematic tool you are using. 
For product-specific instructions, see Cross-Probe Between SailWind Products  in the SailWind Logic 
Guide.

Creating a New PCB Design from an OrCAD 
Netlist
When you lay out a new PCB design, you typically start by importing a netlist created in a schematic 
capture application. This includes the ability to import a netlist created in ORCAD.

Procedure
1. Change the filename extension of the OrCAD netlist from .net  to .asc. SailWind Layout only 

imports netlist files with .asc  extensions.

2. Open the netlist file in a text editor.

3. In SailWind Layout, click the File  > Reports  menu item.

4. In the Reports Dialog Box, select “PowerPCB V3.0 Format Netlist”, and click OK.

5. In the report that is displayed, copy the header line, which will look something like this:

!PADS-POWERPCB-V3.0-MILS! DESIGN DATABASE ASCII FILE 2.0

6. Paste the header line in the OrCAD netlist, replacing the original header, which will look something 
like this:

*PADS-PCB*

7. Replace the software version number (V3.0) in the new header with the number of the software 
version you are running.

8. Save and close the netlist file.

9. In SailWind Layout, click the File  > Import  menu item.

10. In the File Import dialog box, browse for and select the OrCAD netlist .asc  file, and then click 
Open.

11. If an ascii.err  file is produced, perform the following steps:
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a. Close the design into which you just imported the netlist. Click No  when you are prompted to 
save the design.

b. Add any missing components listed in the ascii.err  file to your library, either by adding a library 
which contains the missing components to your library list, or by creating the missing part 
types and decals in an existing library. (See “Adding Libraries to the Library List”, “Creating 
and Modifying Part Types”, and Creating and Editing PCB Decals” for information on how to do 
these tasks.)

c. Resolve any other errors found in the ascii.err  file. Error messages of the type “*Bad *PART* 
ascii data line format” may indicate that an invalid character has been found in the part name. 
The characters invalid in part names are:

.  ,  :  ^  [  ]  $  *  {  }  (  )  @  ?  =  \   <space> 

d. When all the errors have been resolved, repeat this procedure.

Results
The import process sources all the part types and decals from the library and stacks the decals at the 
origin. You can then use the Tools  > Disperse Components  menu item to spread out the components.

Layout-Driven Designs
Most PCB designs are schematic-driven, meaning designers create them in schematic software and 
the components, connections, and constraints then pass to SailWind Layout. After they are in SailWind 
Layout, according to those constraints, layout designers place components, making their connections 
permanent with copper traces.

But if the design is simple, and you are able to skip creating the schematic(s), you can add components, 
create connections, and create constraints from the ECO toolbar in SailWind Layout. The ECO toolbar 
contains all the tools that are design-altering.

If your design is schematic-driven, it must remain synchronized/in parallel between the schematic and 
layout tool. You can record design modifications made by tools on the ECO toolbar in an ECO file that you 
can use to synchronize the schematic design with the layout design.

But if you create a layout-driven design, and you have no schematic to synchronize with, there is no 
need to maintain a .eco  file. When you open the ECO Toolbar and are prompted with the ECO Options 
dialog box, you can safely clear the “Write ECO file” check box and then ignore all the settings of the ECO 
Options dialog box.

Using the tools on the ECO Toolbar, you can:

• Add and delete components

• Add and name connections/nets

• Rename and delete nets

• Rename component reference designators

• Change components
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• Swap pins and gates

• Assign constraints/design rules

For more information on the ECO Toolbar, see “ECO Mode Operations (Layout-Driven Design Tools)”.
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Chapter 10
File Operations

Read the topics that follow to learn more about various file operations.

Start-up Files
Creating Start-up Files
Specifying the Start-up File
Opening Files
File Open Conversions
Replacing Missing Fonts
Archiving Your Design

Start-up Files
Use start-up files to save color settings, the attribute dictionary, and other universal parameters and then 
apply them to every new .pcb  file. To set and apply default settings use the System Default (default.asc) 
start-up file.

For information on creating start-up files, see the Specifying the Start-up File  on page 255 and Creating 
Start-up Files  topics.

The provided start-up files listed in the table below show typical values for different technologies, and do 
not represent any specific technology.

Table  65. Start-up Files

File Item
System Default
Startup File

Chip on Board
Startup File

Low Temp 
Co-fired Ceramic
Startup File

MCM-L
Startup File

Filename default.asc cob-startup.stp ltcc-startup.stp mcml-startup.
stp

Units mils mils mils metric (mm)

Design grid 100x100 5x5 1x1 0.005

Via grid 25x25 5x5 1x1 0.005

Layers 2 2 13 2

Trace Width 12 3 4 0.05

Vias (top/inner/bottom)

Standard 55/55/55 30/30/30 55/55/55 0.2/0.2/0.2

Micro None None 6/4/6 None
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Table  65. Start-up Files  (continued)

File Item
System Default
Startup File

Chip on Board
Startup File

Low Temp 
Co-fired Ceramic
Startup File

MCM-L
Startup File

Clearances

Trace-Trace 6 3 5 0.35

Trace-Via 6 3 4 0.35

Via-Via 6 3 4 0.35

Unsupported Start-up Files
The start-up file is an ASCII file with an .stp file extension.

CAUTION:
This method of creating a start-up file is unsupported.

By design, items you can include in the start-up file are restricted by the Start-up File Output Dialog Box. 
Nevertheless, it is possible to export an unrestricted ASCII file using the ASCII Output dialog box. Then 
you could rename the extension from .asc  to .stp  and place the file in the C:\<install_folder>\<version>
\Settings folder where it would be found and used as a start-up file. For example, if you repeatedly design 
products using the same board outline, you could use this method to export your board outline into the 
start-up file. Then you would start with your board outline when beginning a new design.

Related Topics
Creating Start-up Files

Specifying the Start-up File

Creating Start-up Files
You use the Start-up File Output dialog box to create a start-up file that contains global settings such as 
layer definitions, grids, clearance rules, the attribute dictionary, and so on. You can create different start-
up files and specify which one to use when creating a new design file. This capability enables you to save 
setup time when creating a new design by reusing global settings saved in a start-up file.

Procedure
1. In the current design, specify the options and preferences you want to include in the start-up file.

2. Click the File  > Save As Start-up File  menu item.

3. In the Save As dialog box, specify the start-up file name and click Save. The Start-up File Output 
Dialog Box  appears.

4. In the Sections area, select the check box for any of the following settings you want to include in 
the start-up file. If you want to select all the check boxes, click Select All.
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• PCB Parameters  — Global information, such as colors, layer definitions, and grids

• Vias  — Via information, such as default via type, jumpers, padstack definitions and locations

• Layer Data  — Layer information specified in the Layers Setup dialog box, such as number of 
layers, layer names, routing direction for the layer, electrical type, and associations

• Rules  — Rules information, such as clearance, routing, and high-speed

• CAM  — CAM information related to the plot file configurations

• Attributes  — Attribute information, such as the attribute dictionary, all attributes assigned 
to objects in the design, and attribute status (read only, system, ECO registered, or hidden). 
Values in the attribute hierarchy are not saved.

For related information, see “Modifying the Default Attribute Dictionary”.

5. In the Units list, select the units you want to use in the start-up file. Current units provide more 
information than Basic units, such as grid positions.

6. In the Start-up File Description box, type a brief description of the global settings you are saving. 
The description appears when you select the start-up file in the Set Start-up File dialog box, and 
should help remind you of the settings in the start-up file.

7. Click OK.

Results
The start-up file is written to the C:\<install_folder>\<version>\Settings  folder. Start-up files have an .stp 
file extension.

Related Topics
Specifying the Start-up File

Start-up Files

Specifying the Start-up File
You use the Set Start-up File dialog box to select the start-up file to use for new design files. A start-up file 
contains global settings such as layer definitions, grids, clearance rules, the attribute dictionary, and so 
on.

Use start-up files only when creating new designs; specifying a new start-up file does not affect existing 
designs.

Procedure
1. Click the File  > Set Start-up File  menu item.

2. In the Set Start-up File Dialog Box, select the start-up file and click OK. If you plan to use the 
selected start-up file for all new design files, select the Don't Display Again check box.
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Related Topics
Creating Start-up Files

Start-up Files

Opening Files
You can open current or older design versions and reuse files. In some circumstances, when you open 
a file, SailWind Layout might convert the data to current formats. If another user has the file open, it is 
locked to any edits.

These file types can be opened:

• Design files, *.pcb — PADS Layout binary format

• Reuse files, *.reu — A physical design reuse type, known as the reuse definition  on page 1854

• Old binary files, *.job — PADS Perform V6 and PADS Work V7 format .job  files

When you open a file in SailWind Layout, one or more conversions may take place to update your data to 
current data format. For more information, see File Open Conversions.

Tip
Improvements in thermal relief definition in PADS 9.2 may cause changes in thermal pad 
appearance, flooding results, and CAM output (for CAM Plane layers) when a design from a 
previous version is opened in PADS 9.2 or later. If incompatibilities are found when such a file is 
opened, a warning prompt is displayed and the incompatibilities are written to the Powerpcb.Rep 
file.

Procedure
1. Click the File  > Open  menu item.

2. In the File Open dialog box, select the file and click Open.

Related Topics
File Open Conversions

File Open Conversions
When you open a file, some data conversions may take place to update your data to current data format.

Copper Moved
In some previous versions of PADS Layout you could create copper that appeared on all layers (Layer 
0). SailWind Layout now requires you to create copper on a specific layer. If you open a file containing 
copper created for all layers, the copper is placed on Layer 1 and a message appears indicating which 
items were moved.
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Attributes Converted
When you open a design, the Attribute Dictionary is loaded. You can change the default attributes that are 
imported by changing the default attribute dictionary.

For more information, see Default and Other Attribute Properties and Usage.

If you open a design created with a version prior to PowerPCB version 3.0 any part type attributes found 
are converted to new attributes, which are added to the Attribute Dictionary (if necessary), and applied 
to the items on which they were found. For example, if you assigned value and tolerance in your existing 
design, they are converted to Value and Tolerance attributes and then added to the appropriate objects.

Table  66. Items Converted to Attributes in Version 3

Attribute Name Created When

Value A value is found appended to a part type name.

Tolerance A tolerance is found appended to a part type name.

ASSEMBLY_OPTIONS Assembly Variants exist in the design.

DFT.Nail Count Per Net The nail count per net is greater than one, the default.
The nail count may be greater than one if the Insert Multiple 
Test Points Per Net check box is selected in the Audit Rules 
tab of the DFT Audit dialog box.

Labels Converted
If you open a design created with a version prior to PowerPCB version 3.0, the reference designators and 
part types are converted to current labels. The location, orientation, and color of the labels are preserved 
if they were on the Top or Bottom layers. The default height and width are used, mirroring is turned off, 
and labels are placed on the Top layer. Also, visibility is set to Value.

For information on changing these settings see Modifying Part Label Properties.

Differential Pair Trace Width and Gap Converted
Width and gap for differential pair traces can be set for all layers or per layer. When you open a design, 
the width is set for all layers and is the larger of the recommended widths for each member of the 
differential pair. The gap assigned to the differential pair is set for all layers.

For information on setting the width and gap per layer, see Creating Differential Pair Design Rules.

Replacing Missing Fonts
Text and labels in your designs use stroke font or the system fonts installed on your system. When you 
open a design that uses fonts or characters that are not installed on your system, the Font Replacement 
dialog box—in which you can specify how the missing fonts should be replaced—opens automatically.

You can replace missing fonts automatically or manually, or you can skip the replacement process 
for fonts you identify. When you choose to replace fonts manually, you are asked to confirm your font 
selections before the replacement process initiates. If you choose to skip font replacement, you do not 
confirm your selections to start the replacement process, or if you cancel the replacement, the loading of 
the design for display on your system is cancelled, and the original design file is preserved.
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Restrictions and Limitations
Type 1 fonts are not supported.

Procedure
1. In the Font Replacement Dialog Box, set the replacement mode and font for each missing font, as 

follows:

a. To accept the replacement font named in the Replace with font field, select Automatic from the 
Mode drop-down list.

b. To choose a different replacement font, select Manual from the Mode drop-down list, then 
select the replacement font from the Replace with font drop-down list.

c. To keep the existing font setting, select Skip from the Mode drop-down list. Clearances for text 
strings will be preserved, and objects using the missing font will appear in the display as empty 
boxes.

2. When you have made the desired settings for all the missing fonts, click OK.

Related Topics
Finding Fonts

Archiving Your Design
You can create a folder, a PDF, and/or a zip file that contains all of your design files and supporting files. 
This includes the .pcb  design file, a schematic file, libraries, and any additional files or folders you want. 
You choose what to archive; all fields are optional.

Procedure
1. Open the design you want to archive.

2. Click the File  > Archive  menu item.

3. Select the files and folders you want in the Archiver Dialog Box.

4. Click OK.

Results
An archive folder that contains the design and/or schematic files, the libraries, and any additional files and 
folders you have indicated is created.

If you chose to compress the files using the zip format, the archive folder contains only the .zip  file, which 
has a filename of the following format:

<project_name>YYYYMMDDHHMMSS.zip

Where YYYY is the year, MM is the month, DD is the day, HH is the hour in military (24-hour) time, MM is 
the minute, and SS is the second of the exact time you created the file.
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If you chose to create a PDF, the file is created using the design name and placed in the archive folder.
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Chapter 11
Setting up the Design Environment

Read the following topics to learn more about the procedures for setting up some initial non-electrical 
portions of the design.

Creating a Board Outline
Creating a Board Cut Out
Importing a Board Outline and Cut Out from AutoCAD
Board Outline Reuse
Moving a Board Cut Out
Creating and Adding Board Fiducials
Creating and Adding Board Mounting Holes

Creating a Board Outline
Use the Board Outline and Cut Out  button on the Drafting Toolbar to create a board outline.

Restrictions and Limitations
You can create only one board outline per design.

Procedure
1. On the Drafting Toolbar, click the Board Outline and Cut Out  button.

2. Right-click and click the shape of your board outline.

3. Draw your outline. For specific shape instructions, see “Creating a Rectangle Drafting Object” 
on page 624, “Creating a Circle Drafting Object”  on page 624, “Creating a Polygon or Path 
Drafting Object”.  on page 623

4. To change the color of the board outline, click the Setup  > Display Colors  menu item. In the Other 
area, set the color of the Board Outline tile. Any board cut outs you create will be the same color.

Related Topics
Importing a Board Outline and Cut Out from AutoCAD

Board Outline Reuse

Creating a Board Cut Out

Creating a Board Cut Out
Use the Board Outline and Cut Out  button on the Drafting Toolbar to create a board cut out. You can 
create only one board outline per design, so use the same command and creation process for creating 
cut outs.
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Restrictions and Limitations
You cannot create a notch using a board cut out. To create a notch, edit the board outline instead.

Prerequisites
The board outline  on page 261 must exist before you can create a cut out.

Procedure
1. On the Drafting Toolbar, click the Board Outline and Cut Out  button. Since a board outline 

already exists, the message “Board Outline exists. Would you like to create a Board Cut Out?” 
appears. Click Yes  to continue.

2. Right-click and click the shape of your board cut out.

3. Draw your cut out. For specific shape instructions, see“Creating a Rectangle Drafting Object”  on 
page 624, “Creating a Circle Drafting Object”, “Creating a Polygon or Path Drafting Object”.  on 
page 623

4. To change the color of the board cut out, click the Setup  > Display Colors  menu item. In the Other 
area, set the color of the Board Outline tile.

Results
A board cut out cannot intersect another cut out or the board outline. If intersections occur, the message 
“Selected point is outside the board area” appears in the Status Bar. If you move a cut out and it 
intersects another cut out or the board outline, the message “Board cut out intersects the board outline” 
appears.

Importing a Board Outline and Cut Out from 
AutoCAD
You can import a board outline from a DXF file created in AutoCAD provided you meet certain preliminary 
requirements in the AutoCAD setup.

Procedure
1. Create a layer within AutoCAD entitled BOARD_OUTLINE_00.

2. Draw your board outline using the Polyline  button in AutoCAD. Make sure you close the Polyline 
shape, and assign a real width to the closed polyline.

Only one polyline object can be used for the board outline since SailWind Layout only allows a 
single board outline shape.

If you did not create the board outline shape on the new layer, you can select the board outline, 
and within the Properties of AutoCAD, assign the shape to the BOARD_OUTLINE_00 layer.

3. If you do not require a cut out, simply save the file as a DXF format file and import into a blank 
SailWind Layout design file. If you have a cut out(s), proceed with the next steps.

4. Create a layer within AutoCAD entitled BOARD_CUTOUT_00.

5. Draw your cut out(s) using a closed Polyline for each cutout.
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If you did not create the board cutout shape on the new layer, you can select the cut out(s), and 
within the Properties of AutoCAD, assign the cut out(s) to the BOARD_CUTOUT_00 layer.

6. Select the board outline and cut out(s), and make a Block out of them. In the Block Definition 
dialog box, name the block BOARD_1.

7. Save the file in AutoCAD as a DXF format file and import into a blank SailWind Layout design file.

Results

• Did the board outline or cutout import as a 2D line? If so, it was not assigned to the correct layer. 
In AutoCAD, go into the object’s properties and assign it to the correct layer.You can determine 
if the object imported as a board outline or a 2D line by its color. Check the color of the object 
against the color set for the Board Outline in the Display Colors Setup Dialog Box. (The color set 
for the Board Outline must be different than the color set for Lines.)

• If the import of the board and cutout does not proceed correctly, explode the block in AutoCAD, 
recreate it and save a new DXF file.

• Are you getting an error about a polyline that is not closed? In AutoCAD, edit the polyline and 
close it.

Related Topics
Creating a Board Outline

Creating a Board Cut Out

Board Outline Reuse
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Board Outline Reuse
If you need to create more than one board with the same outline, there are several ways to reuse the 
board outline in a new design depending on the situation.

Copying and Pasting the Board Outline
Adding the Board Outline to the Library
Exporting the Board Outline into an ASCII File
Adding the Board Outline to an Unsupported Start-up File

Copying and Pasting the Board Outline
If desired, you can copy and paste the outline from one design into the next.

Procedure
1. Open the design with the Board Outline that you want to copy.

2. With nothing selected, right-click and click the Select Board Outline  popup menu item.

3. Shift-click the board outline.

4. Click the Edit  > Copy  menu item.

5. Open the new design.

6. Click the Edit  > Paste  menu item. The board outline is attached to the pointer.

7. Position the Board Outline with the pointer and click to place it.

Related Topics
Board Outline Reuse

Adding the Board Outline to the Library
You can save the board outline to the library and later add it to other designs.

Procedure
1. Open the design with the Board Outline that you want to copy.

2. With nothing selected, right-click and click the Select Board Outline  popup menu item.

3. Shift-click the board outline.

4. Right-click and click the Save to Library  popup menu item.

5. In the Save Drafting Item to Library dialog box  on page 1393, choose a library and then type the 
name of the item.

6. Click OK.
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7. Reuse the board in a future design.

a. Open the next design.

b. On the Drafting Toolbar, click the From Library  button.

c. In the Get Drafting Item from Library dialog box  on page 1393, locate the board outline you 
save to a library in a previous step and select it in the Drafting Items list.

d. Click OK. The board outline is attached to the pointer.

e. Position the Board Outline with the pointer and click to place it.

Related Topics
Board Outline Reuse

Exporting the Board Outline into an ASCII File
You can share your board outline with another user who does not share your libraries. You can export the 
board outline into an ASCII file for import by the other user.

Procedure
1. Create  on page 261 a board outline. If you have a design with a board outline, you can use this 

design; remove any extra line items so they are not included in the export in the next step.

2. Export  on page 291 to an ASCII file. In the ASCII Output Dialog Box, select the Lines check box 
only.

3. Import  on page 290 the saved ASCII file into a new design.

Related Topics
Board Outline Reuse

Adding the Board Outline to an Unsupported 
Start-up File
If you are consistently using the same board outline for your designs, add the board outline to a startup 
file and when you start a new design, the board outline is there by default. Export the board outline in 
an ASCII file along with other startup features, rename the file extension to .stp, and place the file in the 
start-up file directory for use as a start-up file.

For more information, see Unsupported Start-up Files in “Start-up Files”.

Procedure
1. First, read the “Creating Start-up Files  on page 254” topic.

2. Follow the steps in “Exporting the Board Outline into an ASCII File” to create an ASCII file with 
the board outline and any other line items, stackup, rules, or other defaults you might want in your 
start-up file.
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3. Rename the .asc  file extension to .stp  and place the file in the C:\<install_folder>\<version>
\Settings  folder.

4. Follow the instructions in “Specifying the Start-up File” to use the start-up file for future designs.

Related Topics
Board Outline Reuse

Moving a Board Cut Out
When you move a board cut out, avoid using the “Move by Origin” move preference.

Procedure
1. Check the Move Preference:

a. Click the Tools  > Options  menu item.

b. In the Options dialog box, click the Design category  on page 1503.

c. In the Move preference area, select either “Move by cursor location” or “Move by midpoint”. 
If the move preference is set to “Move by origin”, the cut out may snap off screen since the 
pointer snaps to the origin of the board outline and not the cut out.

d. Click OK.

2. With nothing selected, right-click and click the Select Board Outline  popup menu item.

3. Shift-click the cut out to select the whole shape.

4. Right-click and click the Move  popup menu item.

Results
The cut out attaches to the pointer so you can place it where you want.

If you move a cut out and it intersects another cut out or the board outline, the message “Board cut out 
intersects the board outline” appears.

Related Topics
Creating a Board Cut Out

Creating and Adding Board Fiducials
Board fiducials  are pads on the outer layers of the board surrounded by adequate soldermask clearances 
to allow for better visual contrast and increased recognition. Various steps of the board fabrication and 
assembly processes use board fiducials for positioning and alignment, most importantly during the 
automated placement of components. Automated vision systems on specialized processing equipment 
use fiducials as visual targets to align and calibrate the machines.
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Procedure
1. Create a new decal  on page 160 of a single pad stack  on page 185 for the fiducial:

a. Define a pad on the top (mounted) layer and no pad on the inner or bottom (opposite) layers.

b. Add to this a soldermask opening two or three times the size of the pad on the top soldermask 
layer.

c. Next, add a pad the same size as the fiducial to the top assembly layer to help viewers of the 
assembly drawing orient the location of the components.

d. You can create a keepout around the fiducial to assure no other design objects on adjacent 
layers will interfere with the visual recognition of the fiducial by the automated systems.

2. Create a non-ECO Registered Part  on page 232 for this new decal.

3. Add the new part using the Add Component button on the ECO Toolbar  on page 821.

4. Place the fiducials around the edge of the board inside the board outline.

Examples

Fiducial
This example will provide the information needed to create a fiducial.

1. Create a new decal of a single pad stack for the fiducial using these suggested dimensions:

Table  67. Usage Example - Fiducial

Layer Shape Size Description

Top (Mounted) Round 40 mils Top pad

Solder Mask Top Round 80 mils Solder mask to void

Assembly Top Round 40 mils Assembly ref. image top

All Layers (Keepout) Round 80 mils Component/via/routing

Layer 20 Circle 80 mils Courtyard outline

1. Create a non-ECO Registered Part for this decal and name it FIDUCIAL40 or some other 
descriptive name of your choice.

2. Add the new part using the Add Component  button on the ECO Toolbar.

3. Place two fiducials at the extremities of the board in diagonally opposed corners 1/4 inch inside 
the board edges
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Creating and Adding Board Mounting Holes
Board mounting holes typically provided places to secure and support the printed circuit board in the 
device enclosure. Mounting holes usually fit with ANSI and ISO standard mounting hardware. Depending 
upon the specific requirements of the design, mounting holes may be plated or non-plated.

Procedure
1. Create a new decal  on page 232 of a single pad stack  on page 185 for the mounting hole:

a. Define a pad on the top (mounted) layer and the bottom (opposite) layer.

b. Define a pad on the inner (signal) layer and add a plane anti-pad definition to the pad.

c. Add soldermask openings for the pads on the top and bottom soldermask layers.

d. Next, add pads to the top and bottom assembly layer to help viewers of the assembly drawing 
find the location of the mounting holes.

e. You can create a keepout around the mounting hole to assure that there is adequate clearance 
for the fastener and any required tools.

f. Specify the drill size of the through hole.

g. If the mounting hole is to be plated, check the plated check box; if the mounting hole is to be 
unplated, leave the plated check box unchecked.

2. Create a non-ECO Registered Part  on page 232 for this new decal.

3. Add the new part using the  on page 821Add Component  button on the ECO Toolbar.

4. Place the mounting holes at the required locations within the board outline.

Examples

Mounting Hole (Plated)
This example will provide the information needed to create a plated mounting hole for a #6-32 ANSI 
screw (.157” hole).

1. Create a new decal of a single pad stack for the mounting hole using these suggested 
dimensions:

Table  68. Usage Example - Mounting Hole (Plated)

Layer Shape Size Description

Top (Mounted) Round 280 mils Top pad

Bottom (Opposite) Round 280 mils Bottom pad

Round 208 mils Inner padInner (Signal)

Round 208 mils Inner anti-pad (clearance)
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Table  68. Usage Example - Mounting Hole (Plated)  (continued)

Layer Shape Size Description

Solder Mask Top Round 280 mils Solder mask top void

Solder Mask Bottom Round 280 mils Solder mask bottom void

Assembly Top Round 280 mils Assembly ref. image top

Assembly Bottom Round 280 mils Assembly ref. image bottom

Layer 20 Circle 300 mils Courtyard outline

All Layers (Drill hole) Round 157 mils Plated hole

All Layers (Keepout) Round 354 mils Component/via/routing

1. Create a non-ECO Registered Part for this decal and name it MTGP-6 or some other descriptive 
name of your choice.

2. Add the new part using the Add Component  button on the ECO Toolbar.

3. Place the mounting holes at the required locations within the board outline.

Mounting Hole (Non-Plated)
This example will provide the information needed to create a non-plated mounting hole for a #6-32 ANSI 
screw (.157” hole)

1. Create a new decal of a single pad stack for the mounting hole using these suggested 
dimensions:

Table  69. Usage Example - Mounting Hole (Non-Plated)

Layer Shape Size Description

Top (Mounted) Round 40 mils Top pad (visual ref.)

Bottom (Opposite) Round 40 mils Bottom pad (visual ref.)

Round 40 mils Inner pad (visual ref.)Inner (Signal)

Round 205 mils Inner anti-pad (clearance)

Solder Mask Top Round 157 mils Solder mask top void

Solder Mask Bottom Round 157 mils Solder mask bottom void

Assembly Top Round 157 mils Assembly ref. image top

Assembly Bottom Round 157 mils Assembly ref. image bottom
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Table  69. Usage Example - Mounting Hole (Non-Plated)  (continued)

Layer Shape Size Description

Layer 20 Circle 300 mils Courtyard outline

All Layers (Drill hole) Round 157 mils Non-Plated hole

All Layers (Keepout) Round 354 mils Component/via/routing

1. Create a non-ECO Registered Part for this decal and name it MTGNP-6 or some other 
descriptive name of your choice.

2. Add the new part using the Add Component  button on the ECO Toolbar.

3. Place the mounting holes at the required locations within the board outline.
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Chapter 12
Working with SailWind Logic

Read the topics that follow to learn more about creating a PCB layout from a SailWind Logic schematic, 
cross-probing, and forward- and backward-annotation of design changes.

Creating a New PCB Design by Manually Importing the SailWind Logic Netlist
Troubleshooting the Netlist Process
Dispersing Components by Schematic Sheet
Cross Probe with SailWind Logic
Forward-Annotation of Design Changes from SailWind Logic
Backward Annotation from SailWind Layout to SailWind Logic

Creating a New PCB Design by Manually 
Importing the SailWind Logic Netlist
Use this method if you do not have both SailWind Logic and SailWind Layout on your computer. This 
manual method requires you to manually export the netlist from SailWind Logic and then import it into 
SailWind Layout.

Alternatively, if you have both SailWind Logic and SailWind Layout on your computer, use the SailWind 
Layout Link within SailWind Logic for a simpler method. For more information, see Creating a New PCB 
Design Using the Automated SailWind Layout Link  in the SailWind Logic Guide.

CAUTION:
Forward annotation of changes to an existing design requires a different process. See “Forward-
Annotation of Design Changes from SailWind Logic”.

Prerequisites
This is a continuation of a process started in SailWind Logic. You must have the netlist (*.asc) file. For 
more information, see “Manual Netlist Process Between SailWind Logic and SailWind Layout” in the 
SailWind Logic Guide.

Procedure
1. In SailWind Layout, click the File  > Import  menu item.

2. Select “ASCII Files (*.asc)” in the file type list.

3. Navigate to the location of the netlist file created from the SailWind Logic design, select it, and click 
Open.

Results
The import process sources all the part types and decals from the library and stacks the decals at the 
origin. You can then click the Tools  > Disperse Components  menu item to spread out the components. 
Alternatively, you can arrange parts based on the schematic sheet.
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If an errors report file (ascii.err) is generated and errors are found in the netlist, see “Troubleshooting the 
Netlist Process” for more information.

Troubleshooting the Netlist Process
If SailWind Layout finds errors in the netlist import process, it generates an errors report file (ascii.err) and 
displays the error report file in a Notepad window. SailWind Layout does not generate an errors file if it 
does not find any errors.

The following are errors that are reported and steps to perform in fixing those errors:

• Library issues

• Single or zero pin nets

• Totally floating connections or subnets

• Unnamed dangling connections (one end floating)

• Power and Ground symbols used on nets whose name is different from the default name on the 
symbol

• Multiple subnet nets where one or more subnets is missing an off-page symbol

• Single subnet nets with an off-page symbol (lonely subnet warning)

• User named subnets that have no visible net name label

Procedure
1. In SailWind Layout, click the File  > New  menu item.

2. Click No  when you are prompted to save the design.

3. Add any missing components listed in the ascii.err  file to your library, either by adding a library 
which contains the missing components to your library list, or by creating the missing part types 
and decals. (For instructions, see “Adding Libraries to the Library List”  on page 144, “Creating and 
Modifying Part Types”, and “Creating and Editing PCB Decals”.)

4. Resolve any other errors found in the ascii.err  file.

5. When all the errors have been resolved, repeat the procedure you used to pass the netlist from 
SailWind Logic to SailWind Layout.

Related Topics
Creating a New PCB Design by Manually Importing the SailWind Logic Netlist

272 SailWind Layout Guide and Reference



 
Working with SailWind Logic

Dispersing Components by Schematic Sheet

Dispersing Components by Schematic Sheet
After receiving netlist from SailWind Logic, you can use the "Disperse by Logic" feature to disperse 
components while retaining their relative positions almost as indicated in the schematic sheet. You can 
also specify what action to take and perform on the components to disperse.

Prerequisites

• You must have the netlist (*.asc) file passed from SailWind Logic to SailWind Layout, and all the 
errors in the ascii.err  file resolved.

• Netlists to use with this feature must be generated by SailWind Logic in versions later than 
V3.0.34.

Procedure
1. With nothing selected, right-click and click the Disperse by Logic  popup menu item.

2. In the “Disperse by Logic” dialog box, specify the dispersing strategy, with details described below.

Field Description

Min Space Specifies the minimum allowable spacing between parts to disperse 
in mils.

Union/Cluster area Specifies what action to take and perform on the parts to disperse 
by clicking Disperse All/Disperse, with options below:

• Nothing (default): Nothing else

• Create Union: Use the parts to create a union.

• Create Cluster: Use the parts to create a cluster.

Sheets/Parts area • Sheets list on the left: Lists all the schematic sheets.

• Parts table on the right: Displays information of parts in the 
selected schematic sheet, including reference designator, PCB 
decal, and value. Changes depending on the selection made in 
the Sheets list.

Disperse All Disperses parts in all the schematic sheets, except those glued or in 
unions/clusters.

Disperse Disperses parts in the selected schematic sheet, except those glued 
or in unions/clusters.

 Note:
If no space is available for placement, the parts attach to the 
pointer for manual placement in the design.
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Cross Probe with SailWind Logic
You can control cross probing with SailWind Logic by using the SailWind Layout Link within SailWind 
Logic.

For instructions, see “Cross-Probe Between SailWind Products” in the SailWind Logic Guide.
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Forward-Annotation of Design Changes from 
SailWind Logic
You can import design changes from SailWind Logic into SailWind Layout. Create the ECO file containing 
the design changes by comparing the schematic and the layout design. You can then bring forward 
design changes from the SailWind Logic design using one of three methods.

Tip
If you are creating a new PCB by importing a netlist for the first time, see “Creating a New PCB 
Design by Manually Importing the SailWind Logic Netlist”  on page 271.

CAUTION:
Design changes resulting from forward-annotating can cause existing “electrical nets” to be 
truncated, split, or deleted altogether. It can also cause existing electrical nets to be extended or 
new electrical nets to be created if the refdes prefixes of updated components are specified in the 
Electrical Nets dialog box. For more information, see “Electrical Nets”  on page 337.

If you have both SailWind Logic and SailWind Layout on your computer, use the “SailWind Layout Link” 
in SailWind Logic for the simplest and fastest automated process. For more information, see Forward 
Annotating Using the Automated SailWind Layout Link  in the SailWind Logic Guide.

If you do not have SailWind Logic on your computer, you must compare the schematic and layout designs 
in either SailWind Logic or SailWind Layout to generate an .eco  file to apply to the layout design. Using 
the Compare/ECO tool in SailWind Layout requires less steps since it can also automatically import the 
differences of the generated .eco  file.

Forward Annotating Using an ECO File Generated by SailWind Layout
Forward Annotating by Importing an ECO File from SailWind Logic

Forward Annotating Using an ECO File Generated 
by SailWind Layout
SailWind Logic provides you with updated netlist file that you can compare the current PCB layout to 
generate an .eco  file. You can then import the file to update the PCB layout.

This procedure is a continuation of the procedure Method 2 — Generate the ECO File in SailWind Layout 
in the SailWind Logic Guide.

CAUTION:
Design changes resulting from forward-annotating can cause existing electrical nets to be 
truncated, split, or deleted altogether. It can also cause existing electrical nets to be extended or 
new electrical nets to be created if the refdes prefixes of updated components are specified in the 
Electrical Nets dialog box. For more information, see “Electrical Nets”  on page 337.

SailWind Layout Guide and Reference 275



Working with SailWind Logic
Forward Annotating Using an ECO File Generated by SailWind Layout  

Restrictions and Limitations

• During design comparison, a reuse definition is ignored and actual elements in the physical 
design reuse are used in the comparison.

• Transferring non-ECO-registered parts and non-electrical parts is constrained. See the override 
settings in the Design category  of the SailWind Logic, Options dialog box.

Prerequisites
You must have an updated schematic netlist (.asc) file, and have the PCB design open in SailWind 
Layout.

Procedure
1. There is no undo after an .eco  file import. If you think you might want to revert to the state of the 

design before the import, you should save a copy of the PCB layout.

2. In SailWind Layout click the Tools  > Compare/ECO  menu item.

3. In the Compare/ECO dialog box, click the Documents tab  on page 1185.

4. In the “Original Design to Compare and Update” area, select the “Use Current PCB Design” check 
box. If the check box is unavailable, clear the check box of the same name in the “New Design with 
Changes” area.

5. In the New Design with Changes area, browse for the updated schematic netlist (.asc) file. You will 
need to change the file type to “ASCII Files (*.asc)”.

6. Click the Comparison tab  on page 1181, and select the options you want to use for design 
comparison.

Tip
To avoid unexpected changes during forward annotation, consider comparing data before 
you forward-annotate. Select only the Generate Differences Report check box in the 
Documents  tab, and click Run. The netlist and PCB files are compared and differences 
written to Layout.rep  in the \SailWind Projects  folder. To see the differences, click Show 
Report  in the Process Status dialog box.

7. On the Documents  tab, select the Generate ECO File check box, and verify the ECO Filename. 
Give the file a unique name to avoid overwriting any existing ECO files.

8. Click the Update tab  on page 1187, and select the Update Original Design check box. This saves 
you from manually importing the generated ECO file.

9. Set the other options for updating.

10. Click Run. The Process Status Dialog Box  opens. Output files are written to the \SailWind Projects 
folder. Messages or errors that occur during comparison are also written to Layout_Session.log 
and Layout.err  in the \SailWind Projects  folder.

Results
The files generated are:
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• <pcb_name>mine.eco  — The ECO file. Contains ECO commands that describe the changes 
needed to update the original design to match the new design. Generated when you select the 
Generate ECO File check box in the Compare/ECO Tools dialog box, Documents  tab. For more 
information, see “ECO File Commands” in the SailWind Layout Command Reference.

• Layout.rep  — The Differences Report file. Describes the differences between the “old” and 
the “new” compared files. Generated when you select the Generate Differences Report check 
box from the Compare/ECO Tools dialog box, Documents  tab. For more information, see 
“Differences Report”  on page 848.

• ecogtmp0.asc  — Temporary copy of the “old” netlist

• ecogtmp1.asc  — Temporary copy of the “new” netlist

• ecogtmp[ 0|1 ].err  — Generated only if errors are found in the netlist. A link to this file is displayed 
in the Output Window.

Forward Annotating by Importing an ECO File from 
SailWind Logic
You import the .eco  file of design changes into SailWind Layout.

For more information, see Method 3 — Generate the ECO File in SailWind Logic  in the SailWind Logic 
Guide.

CAUTION:
Design changes resulting from forward-annotating can cause existing electrical nets to be 
truncated, split, or deleted altogether. It can also cause existing electrical nets to be extended or 
new electrical nets to be created if the refdes prefixes of updated components are specified in the 
Electrical Nets dialog box. For more information, see “Electrical Nets”  on page 337.

Restrictions and Limitations

• During design comparison, a reuse definition is ignored and actual elements in the physical 
design reuse are used in the comparison.

• Transferring non-ECO-registered parts and non-electrical parts is constrained. See the override 
settings in the Design category  of the SailWind Logic, Options dialog box.

Tip
As long as the PCB design has not undergone engineering changes, the last .asc  file from 
SailWind Logic can be compared to the current design in SailWind Logic to generate the 
.eco  file of the engineering changes in the design. If the last exported .asc  file is lost, you 
can export an  on page 291 .asc  file from SailWind Layout to compare against the current 
schematic to generate the .eco  file that gets imported into SailWind Layout to update the 
PCB layout. The same effect is created using “Forward Annotating Using an ECO File 
Generated by SailWind Layout” but with that method, the process is semi-automated by 
automatically importing the .eco  file.
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Prerequisites
You must acquire an .eco  file, and have the PCB design open in SailWind Layout.

Procedure
1. There is no undo after an .eco  file import. If you think you might want to revert to the state of the 

design before the import, you should save a copy of the PCB layout.

2. Click the File  > Import  menu item.

3. On the File Import dialog box, select the “ECO Files (*.eco)” file type.

4. Browse to the file to import and click Open.

Results
If there are errors during the import, an eco.err  file opens in your default text editor. No changes are made 
to the PCB layout until the .eco  file is imported without errors. A link to the ECO Import errors file is also 
written to the Output window.
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Backward Annotation from SailWind Layout to 
SailWind Logic
Using the process called backward annotation, you can export your PCB layout changes “back” to the 
schematic. You can send part, gate, pin, net, and attribute changes.

CAUTION:
While there are three methods to backward annotate design changes, only one method is 
recommended — Back Annotating Using an ECO File from SailWind Layout. The other methods 
generate an .eco  file by design comparison - a less accurate process. The recommended method 
records the .eco  file in SailWind Layout while making ECO changes and manually imports it into 
SailWind Logic for the best results. For more information, see “Recording Versus Generating an 
ECO File”  on page 814.

Back Annotating Using the Automated SailWind Layout Link
Back Annotating Using an ECO File from SailWind Layout
Back Annotating Using an ECO File Created in SailWind Logic
Backward Annotation Results

Back Annotating Using the Automated SailWind 
Layout Link
If SailWind Logic and SailWind Layout reside on the same computer, you can use the SailWind Layout 
Link dialog box to compare a newer PCB design with an older schematic, and update the older schematic 
from the newer PCB design. You can also create a differences report.

Restrictions and Limitations
Transferring non-ECO-registered parts and non-electrical parts is constrained. See Options Dialog Box, 
Design Category  for details.

During design comparison, a reuse definition is ignored and actual elements in the physical design reuse 
are used in the comparison.

CAUTION:
This method generates a new .eco  file and does not use a recorded .eco  file. Recording the exact 
changes in an .eco  file gives the best back annotation results. Use Back Annotating Using an 
ECO File from SailWind Layout  for the best results. For more information, see “Recording Versus 
Generating an ECO File”  on page 814.

Prerequisites
You must have the older schematic open in SailWind Logic, and the newer PCB design open in SailWind 
Layout.
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Procedure
1. In SailWind Logic, click the Tools  > SailWind Layout  menu item.

2. If SailWind Layout is not already open with the design, the Connect to SailWind Layout dialog box 
appears. 

a. Click Open  to open the PCB design you want to annotate from in SailWind Layout.

b. In the File Open dialog box, select the .pcb  file and click Open.

3. In the SailWind Layout Link dialog box, click the Design tab.

Tip
To avoid unexpected changes during backward annotation, consider comparing data 
before you back-annotate. If you want to check the design differences before updating, 
click the Compare PCB  button. The two versions are compared and differences written to 
Logic.rep  in the \SailWind Projects  folder. To see the report, click the logic.rep  link in the 
Output Window.

4. On the Preferences tab, set the appropriate options.

5. On the ECO Names tab, set the appropriate options.

6. On the Design tab:

a. If needed, select the “Compare Design Rules” and “Show Net List errors report” check boxes.

b. Click the ECO From PCB  button.

Results
If you receive a message that the schematic net list may have errors, you should not continue, but select 
the Show Net List errors report check box and run ECO From PCB again to investigate and fix the errors 
before you proceed.

Related Topics
Cross-Probe Between SailWind Products [SailWind Logic User's Guide]

Back Annotating Using an ECO File from SailWind 
Layout
Create the .eco  file of design changes using SailWind Layout and then import it into the SailWind Logic 
design.

Recording engineering changes to your design is the preferred means of generating the .eco  file since 
it creates a perfect “before-and-after” record of changes. You can generate an .eco  file by comparing 
designs; however, it does not create a perfect before-and-after record of components that are exactly 
identical in their part types and connections. For more information, see“Recording Versus Generating an 
ECO File”  on page 814.
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Restrictions and Limitations

• Transferring non-ECO-registered parts and non-electrical parts is constrained. see “Options 
Dialog Box, Design Category” for details.

• During design comparison, a reuse definition is ignored and actual elements in the physical 
design reuse are used in the comparison.

Prerequisites
If you neglected to record the .eco  changes and you must generate the .eco  file by comparing two 
designs, see “Comparing Two Versions of a Design”.

Procedure
1. Record the engineering/netlist changes in an .eco  file. For more details, see“Recording ECO 

Changes  on page 814”.

2. In SailWind Logic, click the Tools  > Options  menu item. In the Options Dialog box, click the 
Design  category.

3. Set the “Allow overwriting of attribute values in design with blank values from library” check box 
appropriately to allow or prevent overwriting of non-blank attribute values with blank (“placeholder”) 
values from the library.

4. Click OK.

5. In SailWind Logic, with your design open, click the File  > Import  menu item.

6. In the File Import dialog box, in the file type list, select “ECO Files (*.eco)”.

7. Browse for and select the ECO file to import.

8. Click Open.

Results
If no errors occur, the schematic is updated. If errors occur, the schematic is not updated, and the errors, 
along with a link to the ECO Import errors file (eco.err), are written to the Output window.

Back Annotating Using an ECO File Created in 
SailWind Logic
You can acquire the layout design in an .asc  file format and compare it to the schematic design with the 
SailWind Logic Compare/ECO tools. You can then import .eco  file of design changes into the SailWind 
Logic schematic design.

SailWind Layout Guide and Reference 281



Working with SailWind Logic
Back Annotating Using an ECO File Created in SailWind Logic  

Restrictions and Limitations

• Transferring non-ECO-registered parts and non-electrical parts is constrained. see “Options 
Dialog Box, Design Category” for details.

• During design comparison, a reuse definition is ignored and actual elements in the physical 
design reuse are used in the comparison.

CAUTION:
This method generates a new .eco  file and does not use a recorded .eco  file. Recording 
the exact changes in an .eco  file gives the best back annotation results. Use “Back 
Annotating Using an ECO File from SailWind Layout” for the best results. For more 
information, see “Recording Versus Generating an ECO File”  on page 814.

Prerequisites
You must have an .asc  file exported from SailWind Layout. For more details, see “Exporting an ASCII File 
on page 291”.

Procedure
1. In SailWind Logic, click the Tools  > Options  menu item. In the Options dialog box, click the 

Design  category.

2. Set the “Allow overwriting of attribute values in design with blank values from library” check box 
appropriately to allow or prevent overwriting of non-blank attribute values with blank (“placeholder”) 
values from the library.

3. Click OK.

4. In SailWind Logic, click the Tools  > Compare/ECO  menu item.

5. In the Compare/ECO dialog box, click the Documents Tab.

6. In the Original Design to Compare and Update area, select the Use Current Schematic Design 
check box. If it is unavailable, you will first need to clear the check box of the same name in the 
New Schematic Design with Changes area.

7. In the New Schematic Design with Changes area, browse for the new .asc  file exported from 
SailWind Layout. In the New Design File Name dialog box, change the file type to “ASCII Files 
(*.asc)” to locate your file.

8. Click the Comparison Tab, and select the options you want to use for design comparison.

9. Optionally, if you want to check the design differences before creating the ECO file:

a. Select the Generate Differences Report check box in the Documents  tab.

b. Clear the Generate ECO File check box.

c. ClickRun. The netlist and PCB files are compared and differences written to Logic.rep  in the 
\SailWind Projects  folder. Click Show Report  in the Process Status dialog box to view the 
differences.
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10. Select the Generate ECO File check box, and verify the ECO Filename. Give the file a unique 
name to avoid overwriting any existing ECO files.

11. Click Run. Output files are written to the \SailWind Projects  folder. Messages or errors that occur 
during comparison are also written to Logic_Session.log  and Logic.err  in the \SailWind Projects 
folder.

12. In SailWind Logic, click the File  > Import  menu item.

13. In the File Import dialog box, in the file type list, click “ECO Files (*.eco)”.

14. Browse for and select the ECO file to import.

15. Click Open.

Results
If no errors occur, the schematic is updated. If errors occur, the schematic is not updated, and the errors, 
along with a link to the ECO Import errors file (eco.err), are written to the Output window. You must correct 
the errors before you can import the file.

Related Topics
Backward Annotation Results

Backward Annotation Results
The backward annotation process handles various layout changes differently while back-annotating to the 
schematic.

Attribute Level Backward Annotation
You can backward annotate new attributes and deleted attributes.

New Attributes

• A new attribute in a part updates all parts of the same type. If the attribute name does not exist, it 
is added with the assigned value.

• An error is created if the part does not exist.

• Unsupported attribute types, such as net or net class, are ignored.

Deleted Attributes

• Deleting an attribute for a part-type deletes the attribute on all parts of that type in the design.

• An error message is generated if the part or attribute name does not exist.

• If the attribute command specifies an object type not supported for general attributes, such as net 
or net class, the attribute command is ignored.
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Part Level Backward Annotation
You can backward annotate added parts, changed parts, deleted parts, and the reference designator 
name.

Added Parts

• A new sheet is created and all new parts are added to the sheet. Parts are placed on a grid so 
that parts of a medium size do not overlap. No attempt is made to avoid overlapping of larger 
parts.

• An error message is generated if the reference designator of the newly added part already exists 
or if the part does not exist in the Library.

• The part is not added to the schematic if the reference designator already exists.

• If the part contains Signal Pins, these pins are included in the add pin function. Backward 
annotation does not currently support signal pins so an error message is created.

Changed Parts

• If the changed part is a multi-gate part, all gates are updated to the new part type.

• An error message is generated if the new part does not exist in the design or in the Library, or if 
the gate or pin count is incompatible.

Deleted Parts

• If the deleted part is a multi-gate part, all gates are deleted.

• An error message is generated if the part is still connected to a net or the part does not exist.

Reference Designator Name

• If the part being renamed is a multi-gate part, all gates are updated. An error message is 
generated if the old reference designator does not exist.

Gate Level Backward Annotation
You can backward annotate swapped gates.

• SailWind Logic creates an offpage symbol at each swapped gate. An error message is created if 
the gate does not exist.

Net Level Backward Annotation
You can backward annotate joined nets, nets created by splitting an existing net, and renamed nets.

Joined Nets

• The first net is renamed to be the same name as the second net.

Nets Created by Splitting an Existing Net
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• A Delete Pin from Net operation is performed to remove them from the existing net, followed by 
an Add Pin to Net operation to add the pin to the new net.

Renamed Nets

• All subnets of the old net on all sheets are renamed. If any of the subnets contain Power or 
Ground symbols without netnames, netnames are added to these symbols.

• An error message is created if the new net already exists.

Pin Level Backward Annotation
You can backward annotate swapped pins, pins added to a net, and pins disconnected from a net.

Swapped Pins

• SailWind Logic creates an offpage symbol at each swapped pin.

Pins Added to a Net

• A pin can be added only if it is not already connected to another net. If the pin is a gate pin (a 
visible terminal pin on the gate symbol), an offpage symbol is created.

• An error is created if pin is already connected or the pin is a signal pin already assigned to a net.

Pins Disconnected from a Net

• If the pin is a gate pin, the connection is deleted if it connects to a tie-dot or offpage symbol. If the 
connection goes to another gate pin, the connection is broken and, an offpage symbol is added.

• This command generates an error message if the pin is not connected to the net in question.
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Chapter 13
Importing and Exporting

Read the topics that follow to learn more about the import and export of various file types.

File Import Formats
File Export Formats
Importing an ASCII File
Exporting an ASCII File
Exporting OLE Files
Importing an OLE File
DXF Format
Importing DXF Files
Exporting DXF Files
Specifying DXF Drill Sizes and Symbols
Importing IDF Files
Exporting IDF Files
Defining IDF-Specific Part Outlines for IDF Export
Adding IDF-Specific Drill Hole Information for IDF Export
Setting IDF-Specific Part Height Information for IDF Export
Importing Protel 99SE Design Database Files
Importing Protel PCB98 Design Files
Importing Protel DXP / Altium Designer Design Files
Importing P-CAD Design Files
Importing CADSTAR PCB Design Files
Importing CADSTAR Archives
Importing OrCAD Board Files
Importing Eagle Design Files
Importing PADS Maker Design Files
Exporting ODB++ Files
Exporting CCE Files
The IPC-D-356 Netlist
Exporting an IPC-D-356 Netlist

File Import Formats
The File  > Import  menu item imports design data from another file into a .pcb  design.

The supported file formats are listed in Table 70.
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Table  70. Import Data Formats

Format Extension Description

ASCII  on page 290 .asc PADS-ASCII format text
Exception: SailWind Layout no longer 
imports Perform 6 ASCII format files.

Data eXchange Format, or 
DXF  on page 297

.dxf A graphical information format used by 
AutoCAD and other CAD systems.

Engineering Change Order .eco Contains forward annotation or backward 
annotation information generated in a 
schematic capture package, concerned with 
logic changes to the design.
For more information, see “Working with 
SailWind Logic”.

Intermediate Data Format, or 
IDF  on page 300

.emn Data in IDF 2.0 or 3.0 format.
You must have the IDF Interface option in 
SailWind Layout to import IDF files.
For more information, see “Intermediate Data 
Format”.

OLE  on page 293 .ole You can use the Edit  > Insert New Object 
menu item to embed files from other 
applications as OLE objects in your design. 
If you then export all these objects to an 
OLE file, you can embed them as a set into 
another design using the File  > Import  menu 
item.
For more information, see “Inserting OLE 
Objects in SailWind Layout”.

Collaboration .clb, .cle Design markups in the collaboration file 
(.clb) and encrypted collaboration file (.cle) 
formats.
For more information, see “Importing 
Markups Using the Markups Dialog Box”, 
and “Importing Markups Using File > Import”.

Protel 99SE design database 
on page 303

.ddb Protel 99 design files in the binary format or 
ASCII format.

Protel 99SE design  on 
page 304

.pcb Protel 98 design files in the binary format or 
ASCII format.

Protel DXP / Altium Designer 
design  on page 304

.pcbdoc Altium DXP/2004/2006/Altium Designer 
design files in the binary format or ASCII 
format.

P-CAD design  on page 305 .pcb P-CAD design files in binary and ASCII 
formats generated in P-CAD 2001, 2002, 
2004, or 2006.
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Table  70. Import Data Formats  (continued)

Format Extension Description

CADSTAR PCB design  on 
page 305

.pcb CADSTAR design files in binary format 
generated in CADSTAR 5.0, 6.0, 7.0, or 8.0.

CADSTAR PCB archives  on 
page 306

.cpa CADSTAR files in ASCII format generated in 
CADSTAR 5.0, 6.0, 7.0, or 8.0.

OrCAD Board  on page 306 .max OrCAD Layout design files in binary 
generated in OrCAD Layout 9.X, 10.X.

Eagle Board .brd Eagle design files

PADS Maker .pcb PADS Maker (PCB design software from 
Digi-Key®, based on Siemens Digital 
Industries Sofware)

File Export Formats
Exporting selectively extracts data from the current .pcb  file and saves to a file in another format.

The supported formats are listed in the table below.

Table  71. SailWind Layout Export Data Formats

Format Extension Description

ASCII Export  on page 291 .asc PADS-ASCII format text

 Restriction:
SailWind Layout does not export Perform 6 
ASCII format files.

If you are exporting to the format of a release 
earlier than PADS 9.5, virtual pins in the design 
are exported as vias.

Data eXchange Format, or 
DXF  on page 298

.dxf A graphical information format used by 
AutoCAD and other CAD systems.

Intermediate Data Format, or 
IDF  on page 301

.emn  and .emp Export data to IDF 2.0 and 3.0 formats.
You must have the IDF Interface option in 
SailWind Layout to export IDF files.
Virtual pins in the design are exported as vias.
For more infomation, see “Intermediate Data 
Format”.

OLE  on page 293 .ole You can use the Edit  > Insert New Object 
menu item to embed files from other 
applications as OLE objects in your design. 
If you then export all these objects to an OLE 
file, you can embed them as a set into another 
design using the File  > Import  menu item.
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Table  71. SailWind Layout Export Data Formats  (continued)

Format Extension Description

For more information, see “Inserting OLE 
Objects in SailWind Layout”.

PADS HyperLynx HYP  on 
page 

.hyp You can use the File  > Export  menu item to 
export the design to a .hyp  file.
Virtual pins in the design are exported as vias.

IPC-D-356 or IPC-D-356a  on 
page 310

.ipc Export your data to IPC-D-356 or IPC-D-356 
revision A formats.
Virtual pins in the design are exported as vias.

ODB++  on page 308 .tgz Export your data to an ASCII open format. This 
format is self-contained and can be transferred 
between computers without any loss of data.
Virtual pins in the design are exported as vias.

Collaboration Files .cle Export markups in the encrypted collaboration 
file format for use in collaboration software.
For more information, see “Exporting Markups 
Using the Markups Dialog Box”, and “Exporting 
Markups Using File > Export”.

CCE Files  on page 309 .cce Export the design in compressed (.cce) format 
for use in design review and collaboration 
software, such as CAMCAD, or visECAD.
Virtual pins in the design are exported as vias.

CAM350 File  on page 876 .cam Launch the CAM350 link to export the CAM350 
data and/or open the file in CAM350.
Virtual pins in the design are exported as vias.

SPECCTRA  on page 1001 .do Launch the Specctra Translator to create the 
.do  file for the Specctra autorouter.
Virtual pins in the design are exported as vias.

Importing an ASCII File
You can import an ASCII file created with previous versions of SailWind Layout.

If your data requires format or other changes, such as the addition of an attribute dictionary, to update 
your data to the current SailWind release, SailWind Layout makes the updates at the time of import. If the 
ASCII file contains test points, SailWind Layout removes the test points that are not accessible and lists 
them in the report file. SailWind Layout preserves physical design reuses when you import an ASCII file.
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Restrictions and Limitations

• You cannot import the ASCII file if any of the following conditions is true:

◦ The design is in default layer mode and the ASCII file is in increased layer mode. Use the 
Layers Setup dialog box to change the design to increased layer mode.

◦ The ASCII file that has fewer electrical layers than the current design. Use the Layers Setup 
dialog box to increase the electrical layer count in the design to match the number in the 
imported ASCII file.

◦ Perform 6 ASCII created the ASCII file.

• Improvements in thermal relief definition introduced in PADS 9.2 might cause changes in thermal 
pad appearance, flooding results and CAM output (for CAM Plane layers) when an ASCII file from 
a previous version is imported into PADS 9.2 or later. If incompatibilities are found when such a 
file is imported, a warning prompt is displayed and the incompatibilities are written to the ascii.err 
file.

• Beginning with PADS 9.0, die parts and flip chips are no longer identified by their family 
designations (DIE or FLP), but instead by the Special Purpose settings in the General tab of the 
Part Information dialog box  on page 1590. When you import an ASCII file created by a PADS 
version previous to 9.0, these Special Purpose settings are automatically set for parts having the 
logic family DIE or FLP. The part’s family designation remains the same.

Procedure
1. Click the File  > Import  menu item.

2. In the File Import dialog box, select the ASCII Files (*.asc) file type.

3. Browse to the file to import and click Open.

Results
The file is imported, and import process information is written to ascii.err  in the ...\SailWind Projects  folder.

Related Topics
Exporting an ASCII File

Exporting an ASCII File
You can use ASCII files to exchange design data between SailWind Layout and external translators or 
previous versions of SailWind Layout.
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Restrictions and Limitations

• SailWind Layout does not export to PADS-Perform 6 ASCII format.

• Exporting to older formats will result in the loss of any newer software features not supported by 
older formats.

• Improvements in thermal relief definition introduced in PADS 9.2 may cause changes in thermal 
pad appearance, flooding results and CAM output (for CAM Plane layers) when an design is 
exported from PADS 9.2 or later to a previous version. If incompatibilities are found when the 
design is exported, a warning prompt is displayed and the incompatibilities are written to the 
Powerpcb.Rep  file.

• Beginning with PADS 9.0, die parts and flip chips are no longer identified by their family 
designations (DIE or FLP), but instead by the Special Purpose settings in the General tab of the 
Part Information dialog box  on page 1590. With this change, the following changes occur in a 
design when you export it to an ASCII file of a PADS version previous to 9.0:

◦ The Special Purpose settings of any die parts and flip chips are cleared.

◦ Die parts and flip chips having a family designation other than DIE and FLP lose their die part 
or flip chip special purpose and become normal parts.

◦ Any normal parts that have the DIE or FLP family designation are treated as die parts or flip 
chips in the previous PADS version.

• If you are exporting to the format of a release earlier than PADS 9.5, virtual pins in the design are 
exported as vias.

Procedure
1. Click the File  > Export  menu item.

2. On the File Export dialog box, select the ASCII Files (*.asc) file type.

3. Specify the filename to export to and click Save.

4. In the ASCII Output Dialog Box, check the appropriate check boxes to specify the design sections 
that you want to write to the ASCII file, or click Select All.

5. In the Format list, select the format version. (If you want to export to PowerBGA V3.0, use the 
PowerPCB V3.0 format.)

6. In the Units list, select the units to export. If you plan to use the ASCII file for an external translator 
or another ASCII-reading program, select Current. If you plan to re-import the ASCII file and save 
it as a .pcb  database, select Basic. Basic units represent how values are stored in the software. 
They do not use standard units of measure, but they record precise positioning values for database 
items.

7. If you want to export attributes assumed from higher levels in the attribute hierarchy, select the 
Parts and Nets check boxes as appropriate.

8. Click OK.
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Results
The .asc  file is created. An export status log file— ascii.err—and an export report file—Powerpcb.Rep—
are created in the \SailWind Projects  folder. Existing physical design reuse information is retained.

Related Topics
Importing an ASCII File

Exporting OLE Files
You can export all the OLE objects in your design to an OLE file, which you can then import into another 
design.

Procedure
1. Click the File  > Export  menu item.

2. On the File Export dialog box, select the OLE Files (*.ole) file type.

3. Specify the filename to export to and click Save.

Results
The .ole  file containing all OLE objects in your design is created.

Related Topics
Inserting OLE Objects in SailWind Layout

Importing an OLE File

Importing an OLE File
You can import an OLE file (such as a screenshot) into your design.

Restrictions and Limitations

• When you import an OLE file into your design, all OLE objects currently in the design are deleted.

Procedure
1. Click the File  > Import  menu item.

2. On the File Import dialog box, select the OLE Files (*.ole) file type.

3. Browse to the file to import and click Open.

4. Click Yes in the two prompts that appear.
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Results
Any existing OLE objects in the design are removed, and the OLE objects in the selected OLE file are 
imported into the design.

Related Topics
Inserting OLE Objects in SailWind Layout

Exporting OLE Files

DXF Format
The DXF format handles database objects differently than ASCII files. DXF does not support physical 
design reuses. DXF also does not support route protection information; therefore, when you import or 
export a DXF file, the process removes all route protection information. DXF does, however, store slotted 
hole information for both import and export. Because jumpers, although not part of the part list, are 
considered vias, you can export them to DXF.

SailWind Layout does not import DXF files from PowerPCB 1.3 and earlier. Versions before PowerPCB 
3.0 do not read the DXF files created by PowerPCB 4.0.

If you import a DXF file that contains an ellipse, or a scaled arc with a radius that is too big for the 
database, a dialog box appears asking you to enter an approximation error. The approximation error 
determines how the ellipse/arc will be broken into line segments.

For information on creating objects that properly translate to copper polygons and to avoid creating self-
intersecting polygons, see Defining Copper Objects in AutoCAD.

DXF Messages
The following are possible DXF messages:

• Warning: Found a self-intersecting copper piece while importing hatched solid. File line: XXXX. 
Continue process?

The DXF file contains a self-intersecting polygon. File line: XXXX refers to the line where the error 
occurs. Correct the polygons in the AutoCAD application. For information on creating objects 
that properly translate to copper polygons and avoiding creating self-intersecting polygons, see 
Defining Copper Objects in AutoCAD.

• Warning: Board cutout containing point <x,y> intersects existing board cutout containing <x,y>. 
New cutout not imported from DXF file.

The Overlapping board cutouts are reported as warnings when importing a DXF file. Click OK  to 
continue importing or click Cancel  to cancel.

• Warning: Board cutout containing point <x,y> intersects the board outline. Cutout not imported 
from DXF file.

The cutouts that overlap the board outline are reported as warnings. Click OK  to continue 
importing or click Cancel  to cancel.
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Defining Copper Objects in AutoCAD
To define an object in AutoCAD that properly translates to a copper polygon, create a closed polyline that 
does not self-intersect and assign a solid hatch type. If you create a polygon in this way, it converts to 
a copper polygon in SailWind Layout (Figure 24). In addition, the copper polygon is created in SailWind 
Layout so that the outside edges of the polygon are aligned with the edges of the shape in AutoCAD, 
ensuring the entire shape is dimensioned and checked correctly. The following graphic demonstrates this 
conversion.

Figure 24. Copper Object with Closed Polygon (Solid Hatch Type)

If you create a polygon without hatching in AutoCAD, the polygon converts to a 2D line in SailWind 
Layout (Figure 25). In this case the centerlines of the 2D line are aligned with the edges of the shape in 
AutoCAD. The following graphic demonstrates this conversion.

Figure 25. Copper Object with Closed Polygon (No Hatching)

DXF Export of Filled Polygons
Filled copper polygons export as polylines with a solid hatch.

Legacy Layer Mapping
The following is a cross-reference of the DXF layer names used in the various releases of PADS 
products. We don’t recommend you try to bring an old DXF file into a new release of SailWind Layout.

Table  72. PADS Legacy Layer Mapping

PADS 
Perform PowerPCB v1.1 - v1.3 PowerPCB v1.5 - current

TXTnn TEXTnn TEXT_nn

LINnn 2D_LINEnn 2D_LINE_nn

COPnn COPPERnn COPPER_nn
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Table  72. PADS Legacy Layer Mapping  (continued)

PADS 
Perform PowerPCB v1.1 - v1.3 PowerPCB v1.5 - current

CCOnn COPPER_CUTOUTnn COPPER_CUTOUT_nn

CPRnn POUR_UNFLOOD POUR_VOID_nn

CPOnn POUR_FLOOD POUR_HEADER_nn

HOLnn HATCH_OUTLINEnn POUR_OULINE_nn

HVOnn HATCH_VOIDnn POUR_VOID_nn

THVnn VIA_THERMALnn POUR_VIATHERM_nn

THRnn PAD_THERMALnn POUR_PADTHERM_nn

BRD00 BOARD_OUTLINE BOARD_OUTLINE_00

CONnn CONNECTIONnn LINK_00

PADXnn PADS_INNER PADS_INNER

PADXBnn PADS_BOTTOMnn PADS_BOT

PADSTnn PADS_TOPnn PADS_TOP

PNM00 PART_NAME_TOP and 
PART_NAME_BOTTOM

PART_NAME_TOP and 
PART_NAME_BOT

CMB00 PART_TOP PART_TYPE_TOP

COM01 PART_BOTTOM PART_TYPE_BOT

BDYnn BODYnn

DRLTPnn DRIL_PLTE_THRUnn DRIL_PLTE_THRU_nn

DRLTN DRIL_NO_PLTE_THRUnn DRIL_NPLTE_THRU_nn

DRLNP DRIL_PLTE_PRTLnn-nn DRIL_PLTE_PRTL_nn

DRLNN DRIL_NPLTE_PRTLnn-nn DRIL_NPLTE_PRTL_nn

TRKnn TRACKSnn TRACE_nn

VIAi VIAi VIA

PKGnn PARTINFO PART_INFO

PCB30 PADS_PARAMETERS PCB_PARAMS

KEY00 DRILL_SYMBOL DRIL_SYMBOL
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Table  72. PADS Legacy Layer Mapping  (continued)

PADS 
Perform PowerPCB v1.1 - v1.3 PowerPCB v1.5 - current

CTBnn COMPONENT_TEXTnn PART_TOP_TEXT_nn and 
PART_BOT_TEXT_nn

Importing DXF Files
You can import DXF files of the AutoCAD 2004 DXF format.

There are two interfaces to import DXF files. This procedure uses an interface designed for advanced 
import of any and all design objects. It imports the design objects from specially named block and layers 
names in AutoCAD. This mapping is hard-coded and cannot be changed.

If you need to simply import RF shapes into the decal or into the design, use the procedure given in 
Importing RF Shapes in DXF Format.

Restrictions and Limitations

• You cannot import a DXF file to a design if the design is in default layer mode and the DXF file 
is in increased layer mode. Use the Layers Setup dialog box to change the design to increased 
layer mode.

Procedure
1. Click the File  > Import  menu item.

2. In the File Import dialog box, in the file type list, select DXF Files (*.dxf).

3. Browse to the file to import and click Open.

4. In the DXF Import Dialog Box, in the Layer Selection area, select layers from which to import 
information.

To add individual layers, select the layer names in the Available list and click the Add  button. To 
remove individual layers, select the layer names in the Selected list and click the Remove  button.

5. In the Select Input Items area, check the appropriate check boxes to specify the items that you 
want to import, or click Select All.

6. In the DXF-File Unit list, select the units to use in the DXF file. This list is unavailable if it is not 
necessary to set the units.

7. In the Mode Area, click an import mode.

8. Click OK.

Results
The .dxf  file is imported and opened in SailWind Layout.

Line styles imported in the DXF file are matched with the five SailWind Layout line styles. When a line 
style does not resemble any of the SailWind Layout line styles, a solid line is created.
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If your imported geometries have been imported as multiple line items, and you want to convert them to 
single objects, use the procedures listed in Join and Close 2D Lines and Copper Shapes  to do this.

CAUTION:
Nets bridged with copper are not supported in the .dxf  file format. If you are importing a file 
previously exported with bridged coppers, they will be imported as regular copper shapes.

Related Topics
Importing a Board Outline and Cut Out from AutoCAD

DXF Format

Exporting DXF Files
You export DXF files to transfer design elements to AutoCAD. For example, you can export component 
height information with the design in order to create a 3D model.

Restrictions and Limitations

• The .dxf  file version exported is in version 12 format.

• Nets bridged with copper are not supported in the .dxf  file format and are exported as regular 
copper shapes.

• Although 2D lines are drawn with a round pen in SailWind Layout, they are squared (not rounded) 
in DXF.

• Also, many DXF software tools display patterns of styled lines as hollow and not filled.

Procedure
1. On the File  menu click Export.

2. In the File Export dialog box, in the Save as type list, select “DXF Files (*.dxf)”.

3. Browse to overwrite a file, or type a new file name. Click Save.

4. On the “DXF Export dialog box”  on page 1338, in the Export Type area, choose between standard 
and flat output.

If you select flat output, setup of DXF drill sizes and symbols is unavailable, and 2D Line styles 
(dash, dotted, dash-dotted, dash-double-dotted) are converted to solid lines.

5. In the Layer Selection area, move the layers you want to export information from to the Selected 
list.

6. In the Select Input Items area, check the items that you want to export, or click All Items.

7. In the DXF-File Unit list, select the units to use in the DXF file. The list is unavailable if it is not 
necessary to set the units.
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8. If you are exporting a standard file, perform the following steps if you want to define DXF drill sizes 
and symbols:

a. Click Setup.

b. In the Setup DXF Drill Size and Symbols dialog box, to specify a drill size for a 2D line library 
item, click Add, type a value into the Drill Size box, and then type the library item name into the 
Library Equivalent box.

If you do not associate a drill size to a 2D line library item, the default drill symbol is exported 
for that item.

c. To remove a drill size for a 2D line library item, select the item in the Drill Size and Library 
Equivalent area, and then click Delete.

d. If you want to change symbol units, select the units from the System Units list.

e. If you want to change the appearance of the default drill symbol, which appears in the DXF file 
as a plus sign +, type the length/width of the plus sign in the Symbol Size box, and then type 
the plus sign line width in the Line Width box.

f. Click OK.

9. Click OK.

Results
The .dxf  file is created.

Related Topics
DXF Format

Specifying DXF Drill Sizes and Symbols
Use the “Setup DXF Drill Size and Symbols” dialog box to specify drill sizes for 2D line library items that 
you export to DXF.

Procedure
1. Click the File  > Export  menu item. Save as DXF type and in the Export dialog box click Setup.

2. If you want to specify a drill size for a 2D line library item, click Add, type a value into the Drill Size 
box, and then type the library item name into the Library Equivalent box.

If no drill size is associated to a 2D line library item, the default drill symbol is exported for that 
item.

3. If you want to remove a drill size for a 2D line library item, select the item in the Drill Size and 
Library Equivalent area, and then click Delete.

4. If you want to change symbol units, select the units from the System Units list.
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5. If you want to change the appearance of the default drill symbol, which appears in the DXF file as 
a plus sign +, type the length/width of the plus sign into the Symbol Size box, and then type the line 
width of the plus sign into the Line Width box.

6. Click OK.

Related Topics
Setup DXF Drill Size and Symbols Dialog Box

DXF Export Dialog Box

Importing IDF Files
You can import board outlines, keepouts, components, and holes into your SailWind Layout design by 
importing an IDF .emn  file exported from a mechanical design system.

Restrictions and Limitations

• SailWind Layout cannot import the information in the .emp  library file.

• Some of the components you import are mechanical objects that are not ECO registered, such as 
board mounting holes and card guides.

Procedure
1. Click the File  > Import  menu item.

2. On the File Import dialog box, select the IDF Files (*.emn) file type. You can import IDF 2.0 or 3.0 
.emn  files.

3. Browse to the file to import and click Open.

4. In the IDF Import Dialog Box, in the Select Import Items area, check the check boxes of the items 
that you want to import, or click All Items  to import everything.

5. Click OK.

Results
The .emn  board file is imported and opened in SailWind Layout. A status log file is written to C:\SailWind 
Projects\idfimport.sts.

Related Topics
Adding Components During Importing [SailWind Layout Command Reference Manual]

Importing Holes [SailWind Layout Command Reference Manual]

Exporting IDF Files
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Exporting IDF Files
You can create IDF files to export board outlines, keepouts, components, and holes to a mechanical 
design system.

Tip
For a more accurate IDF export, set any IDF-specific part height, drilled hole, and part outline 
information before exporting. For more information, see”Setting IDF-Specific Part Height 
Information for IDF Export”, “Adding IDF-Specific Drill Hole Information for IDF Export”, and 
“Defining IDF-Specific Part Outlines for IDF Export”.

Procedure
1. Click the File  > Export  menu item.

2. On the File Export dialog box, select the IDF Files (*.emn, *.emp) file type.

3. Specify the file to export and click Save.

4. On the IDF Export Dialog Box, in the Shape Layer list, select the layer containing the outline 
information  on page 302 for the decals in your design that you want to send to the mechanical 
design system.

5. In the Format list, select the IDF version to use.

6. In the Select Export Items area, check the items that you want to export, or click All Items.

7. Specify the minimum height of components you want to export by typing the minimum part heights 
in the Top and Bottom boxes. Components less than these heights are not exported. If a part is not 
exported because of a minimum height value, a message is written to the status log file.

8. If the Geometry.Height attribute for any exported part type and decal pairs does not exist or is 
set to zero, the Missing Height dialog box appears for each pair. If you want to specify height 
information prior to exporting the part type and decal pair, type the height into the Height box.

If you do not specify the height (or specify it as zero), the mechanical design system may prompt 
you to enter a height when importing the IDF files.

Tip
If you want to apply the height for all part type and decal pairs, select the For All Parts 
check box.

9. Click OK.

Results
The .emn  (board and placement) and .emp  (part library) files are created. A status log file is written to C:
\SailWind Projects\idfexport.sts.
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Related Topics
Setting IDF-Specific Part Height Information for IDF Export

Missing Height Dialog Box

Importing IDF Files

Defining IDF-Specific Part Outlines for IDF 
Export
For a more accurate IDF export, create any IDF-specific part outlines before you export to IDF. The IDF 
library file requires part outline information for all parts.

Procedure
1. Click the Tools  > PCB Decal Editor  menu item.

2. Open the decal for which you want to define an outline.

3. Click the layer on which to define the outline. For IDF, you must use the same layer in each decal 
to define all part outlines.

4. Define the part outline. The outline must be a single, special kind of closed curve that is either a 
circle or a sequence of non-self-intersecting arcs and contiguous line segments.

5. Save the decal.

Related Topics
Part Outline Information [SailWind Layout Command Reference Manual]

Adding IDF-Specific Drill Hole Information for 
IDF Export
For a more accurate IDF export, use the HOLE part attribute to set any IDF-specific drill hole information 
for single-pin parts before you export to IDF. (Vias and multiple-pin parts, even though they appear as 
drilled holes in the mechanical design system, do not use the HOLE attribute.)

Mechanical design systems interpret drill holes as board drills.

Procedure
1. Click the File  > Library  menu item.

2. In the Library Manager dialog box, click the Parts  button.

3. From the Part Types list, select the single-pin part for which you want to add drill hole information, 
and click Edit. (Even if you use the same part type with different decals for holes and nonholes, set 
the HOLE attribute in the part type nevertheless.)
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4. In the Attributes  tab of the Part Information dialog box, add the HOLE part attribute.

5. Click OK.

Setting IDF-Specific Part Height Information 
for IDF Export
For a more accurate IDF export, set any IDF-specific part height information before you export to IDF. You 
do this by assigning the Geometry.Height attribute at the Decal or Part Type hierarchy level.

For information on how to do this, see “Assigning Attributes to Design Objects With the Object Attributes 
Dialog”.

Related Topics
Design Object Attributes

Attribute Manager

Part Height Information [SailWind Layout Command Reference Manual]

Importing Protel 99SE Design Database Files
You can import a Protel .ddb  file directly into SailWind Layout.

Tip
Run the standalone translator to control additional aspects of the translation, including file 
placement and attribute mapping. See the SailWind Layout Translator User’s Guide  for more 
information. The SailWind Layout Translator can be found on the Start menu under the SailWind 
folder for the version you have installed and on Windows 7 within the Translators folder.

Procedure
1. Click the File  > Import  menu item.

2. On the File Import dialog box, select the “Protel 99SE design database (*.ddb)” file type.

3. Browse to the file to import and click Open.

Results
The .ddb  file is imported and opened in SailWind Layout. The resulting SailWind Layout file is saved 
in the same folder as the original file with the suffix _pads. For example, if the original file name is 
ProtelTest.ddb, the new filename will be ProtelTest_pads.pcb.

If a file with the new name already exists in the folder, a sequential number is added to the file name. For 
example, ProtelTest_pads_1.pcb, ProtelTest_pads_2.pcb, and so on.

A log file, with the same name as the resulting .pcb  file, is saved in the \SailWind Projects  folder by 
default.
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Importing Protel PCB98 Design Files
You can import a Protel .pcb  file directly into SailWind Layout.

Tip
Run the standalone translator to control additional aspects of the translation, including file 
placement and attribute mapping. See the SailWind Layout Translator User’s Guide  for more 
information. The SailWind Layout Translator can be found on the Start menu under the SailWind 
folder for the version you have installed and on Windows 7 within the Translators folder.

Procedure
1. Click the File  > Import  menu item.

2. On the File Import dialog box, select the “Protel PCB98 Design (*.pcb)” file type.

3. Browse to the file to import and click Open.

Results
The .pcb  file is imported and opened in SailWind Layout. The resulting SailWind Layout file is saved 
in the same folder as the original file with the suffix _pads. For example, if the original file name is 
ProtelTest.pcb, the new filename will be ProtelTest_pads.pcb.

If a file with the new name already exists in the folder, a sequential number is added to the file name. For 
example, ProtelTest_pads_1.pcb, ProtelTest_pads_2.pcb, and so on.

A log file, with the same name as the resulting .pcb file, is saved in the \SailWind Projects  folder by 
default.

Importing Protel DXP / Altium Designer Design 
Files
You can import a.pcbdoc  file directly into SailWind Layout.

Tip
Run the standalone translator to control additional aspects of the translation, including file 
placement and attribute mapping. See the SailWind Layout Translator User’s Guide  for more 
information. The SailWind Layout Translator can be found on the Start menu under the SailWind 
folder for the version you have installed and on Windows 7 within the Translators folder.

Procedure
1. Click the File  > Import  menu item.

2. On the File Import dialog box, select the “Protel DXP / Altium Designer design (*.pcbdoc)” file type.

3. Browse to the file to import and click Open.
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Results
The .pcbdoc  file is imported and opened in SailWind Layout. The resulting SailWind Layout file is saved 
in the same folder as the original file with the suffix _pads. For example, if the original file name is 
ProtelTest.pcbdoc, the new filename will be ProtelTest_pads.pcb.

If a file with the new name already exists in the folder, a sequential number is added to the file name. For 
example, ProtelTest_pads_1.pcb, ProtelTest_pads_2.pcb, and so on.

A log file, with the same name as the resulting .pcb  file, is saved in the \SailWind Projects  folder by 
default.

Importing P-CAD Design Files
You can import a .pcb  file directly into SailWind Layout.

Tip
Run the standalone translator to control additional aspects of the translation, including file 
placement and attribute mapping. See the SailWind Layout Translator User’s Guide  for more 
information. The SailWind Layout Translator can be found on the Start menu under the SailWind 
folder for the version you have installed and on Windows 7 within the Translators folder.

Procedure
1. Click the File  > Import  menu item.

2. On the File Import dialog box, select the “P-CAD design files (*.pcb)” file type.

3. Browse to the file to import and click Open.

Results
The.pcb  file is imported and opened in SailWind Layout. The resulting SailWind Layout file is saved 
in the same folder as the original file with the suffix _pads. For example, if the original filename is 
PCADTest.pcb, the new filename will be PCADTest_pads.pcb.

If a file with the new name already exists in the folder, a sequential number is added to the file name. For 
example, PCADTest_pads_1.pcb, PCADTest_pads_2.pcb, and so on.

A log file, with the same name as the resulting .pcb file, is saved in the \SailWind Projects  folder by 
default.

Importing CADSTAR PCB Design Files
You can import a .pcb  file directly into SailWind Layout.

Tip
Run the standalone translator to control additional aspects of the translation, including file 
placement and attribute mapping. See the SailWind Layout Translator User’s Guide  for more 
information. The SailWind Layout Translator can be found on the Start menu under the SailWind 
folder for the version you have installed and on Windows 7 within the Translators folder.
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Procedure
1. Click the File  > Import  menu item.

2. On the File Import dialog box, select the “CADSTAR PCB design files (*.pcb)” file type.

3. Browse to the file to import and click Open.

Results
The .pcb file is imported and opened in SailWind Layout. The resulting SailWind Layout file is saved 
in the same folder as the original file with the suffix _pads. For example, if the original file name is 
CADSTARTest.pcb, the new filename will be CADSTARTest_pads.pcb.

If a file with the new name already exists in the folder, a sequential number is added to the file name. For 
example, CADSTARTest_pads_1.pcb, CADSTARTest_pads_2.pcb, and so on.

A log file, with the same name as the resulting .pcb  file, is saved in the \SailWind Projects  folder by 
default.

Importing CADSTAR Archives
You can import a .cpa  file directly into SailWind Layout.

Procedure
1. Click the File  > Import  menu item.

2. On the File Import dialog box, select the “CADSTAR archive (*.cpa)” file type.

3. Browse to the file to import and click Open.

Results
The .cpa  file is imported and opened in SailWind Layout. The resulting SailWind Layout file is saved 
in the same folder as the original file with the suffix _pads. For example, if the original file name is 
CADSTARTest.cpa, the new filename will be CADSTARTest_pads.pcb.

If a file with the new name already exists in the folder, a sequential number is added to the file name. For 
example, CADSTARTest_pads_1.pcb, CADSTARTest_pads_2.pcb, and so on.

A log file, with the same name as the resulting .pcb  file, is saved in the \SailWind Projects  folder by 
default.

Importing OrCAD Board Files
You can import a .max  file directly into SailWind Layout.

Tip
Run the standalone translator to control additional aspects of the translation, including file 
placement and attribute mapping. See the SailWind Layout Translator User’s Guide  for more 
information. The SailWind Layout Translator can be found on the Start menu under the SailWind 
folder for the version you have installed and on Windows 7 within the Translators folder.
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Importing Eagle Design Files

Procedure
1. Click the File  > Import  menu item.

2. On the File Import dialog box, select the “OrCAD Board files (*.max)” file type.

3. Browse to the file to import and click Open.

Results
The .max  file is imported and opened in SailWind Layout. The resulting SailWind Layout file is saved 
in the same folder as the original file with the suffix _pads. For example, if the original file name is 
OrCADTest.max, the new filename will be OrCADTest_pads.pcb.

If a file with the new name already exists in the folder, a sequential number is added to the file name. For 
example, OrCADTest_pads_1.pcb, OrCADTest_pads_2.pcb, and so on.

A log file, with the same name as the resulting .pcb  file, is saved in the \SailWind Projects  folder by 
default.

Importing Eagle Design Files
You can import a .brd  file directly into SailWind Layout.

Tip
Run the standalone translator to control additional aspects of the translation, including file 
placement and attribute mapping. See the SailWind Layout Translator User’s Guide  for more 
information. The SailWind Layout Translator can be found on the Start menu under the SailWind 
folder for the version you have installed and on Windows 7 within the Translators folder.

Procedure
1. Click the File  > Import  menu item.

2. On the File Import dialog box, select the “Eagle Board files (*.brd)” file type.

3. Browse to the file to import and click Open.

Results
The .brd  file is imported and opened in SailWind Layout. The resulting SailWind Layout file is saved 
in the same folder as the original file with the suffix _pads. For example, if the original filename is 
EagleTest.pcb, the new filename will be EagleTest_pads.pcb.

If a file with the new name already exists in the folder, a sequential number is added to the file name. For 
example, EagleTest_pads_1.pcb, EagleTest_pads_2.pcb, and so on.

A log file, with the same name as the resulting .pcb file, is saved in the \SailWind Projects  folder by 
default.

Importing PADS Maker Design Files
You can import a .pcb  file directly into SailWind Layout.
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Procedure
1. Click the File  > Import  menu item.

2. On the File Import dialog box, select the PADS Maker Layout files (*.pcb) file type.

3. Browse to the file to import and click Open.

Results
The .pcb  file is imported and opened in SailWind Layout. The resulting SailWind Layout file is saved in 
the same folder as the original file with the suffix _pads. For example, if the original filename is PADS 
MakerTest.pcb, the new filename will be PADSMakerTest_pads.pcb.

If a file with the new name already exists in the folder, a sequential number is added to the file name. For 
example, PADSMakerTest_pads_1.pcb, PADSMakerTest_pads_2.pcb, and so on.

A log file, with the same name as the resulting .pcb file, is saved in the \SailWind Projects  folder by 
default.

Exporting ODB++ Files
You can export an entire design to an ODB++ job, which you transfer from computer to computer without 
any loss of data.

CAUTION:
ODB++ export is based on the CAM documents generated from your design.
• If you have not generated CAM documents and proceed without them, the software generates 

a set of CAM documents using default configurations and uses them for the ODB++ export. The 
resulting auto-generated CAM documents may be different than what you would create.

• A warning appears if you inadvertently duplicate one or more layers during the process of 
creating CAM documents.

Tip
Virtual pins in the design are exported as vias.

Procedure
1. Click the File  > Export  menu item.

2. In the File Export dialog box, select the location for the job from the Save in list.

3. In the Save as type list, select ODB++ (*.tgz).

If you have copper planes that are not flooded, they are flooded automatically when the CAM 
documents are being generated.

If you have not created all the required CAM documents for your design you are prompted with a 
list of missing documents. You can cancel the operation and create those documents, or you can 
continue and use CAM documents created using default settings.

If you have not created any of the required CAM documents for your design you are prompted to 
generate the default documents.
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Exporting CCE Files

4. Make appropriate setting changes in the ODB++ Export Dialog Box.

5. Click Save.

Results
The ODB++ job, consisting of a .tgz  file and associated report file (_odbppExport.rep), is created and 
placed in the location indicated in step 2. For example, if your file is preview.pcb, the resulting files will be 
preview.tgz  and previewodbpp_Export.rep  in the same directory.

Exporting CCE Files
You can export design elements in CCE (formerly CC/CCZ) files for import to CAMCAD, and visECAD.

Procedure
1. Click the File  > Export  menu item.

2. In the File Export dialog box, in the Save as type list, select CCE Files (*.cce).

3. Browse to select a file to overwrite, or type a new file name. The file name will default to the 
existing design name.

4. Click Save.

5. In the CCE Export Dialog Box, specify the Solder Mask, Paste Mask, and Component Outline 
Layer options.

6. Click OK.

Related Topics
CCE Export Dialog Box

The IPC-D-356 Netlist
The IPC-D-356 netlist format describes the netlist in terms of X, Y locations, which is the format required 
for testing bare boards.

The IPC-D-356 format is an ASCII format in machine readable form which contains the X,Y locations of 
points of connectivity of nets, ensuring that the resulting printed circuit board is not only manufactured 
correctly, but is correct to the original design.

Prior to the IPC-D-356 netlist, ASCII file output was the only file output. This output described connectivity 
between pins by their reference designators. However, machines require coordinates and CAM outputs 
consisted of artwork files only. Connectivity could be discovered based on the layer stackup of the 
artwork, but it could never be checked against the original design.

The IPC-D-356 netlist includes net names, reference designators, and pin numbers. This is not required 
to test connectivity between coordinates, but it produces results which are easier to understand.

You can also use the updated IPC-D-356A format, which is an updated revision to the D-356 netlist 
format. The revision A format has more features and is an improvement on the original D-356 format.
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Exporting an IPC-D-356 Netlist
You can export either an IPC-D-356 netlist or an IPC-D-356 Revision A netlist.

Warning:
Nets bridged with copper are combined when you export the design into the .ipc  (IPC356) file 
format.

Procedure
1. Click the File  > Export  menu item.

2. In the File Export dialog box, in the Save as type list, select IPC356 Files (*.ipc).

3. Browse to overwrite a file or type a new file name. Click Save.

4. In the IPC Export Dialog Box, select one of the two netlist formats.

5. Click OK. The .ipc  file is created.

Related Topics
The IPC-D-356 Netlist
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Chapter 14
Layers

Read the topics that follow to learn more about layer stackup and procedures for setting up the layers of 
your design.

Layer Modes
Special Functionality of Layers 20 and 25
Choosing Between Split/Mixed and CAM Layers
Association of Component and Documentation Layers
Setting Up Layers
Increasing the Maximum Number of Available Layers
Designating a Board as Single-sided
Modifying the Number of Electrical PCB Layers
Setting Up an Outer Layer
Setting Up an Inner Layer
Setting Up a Documentation Layer
Hiding or Displaying Non-electrical Layers in Layer Lists
Setting Layer Parameters
Unassigning a Netname from a Plane Layer
Reassigning Electrical Layers

Layer Modes
SailWind Layout supports two layer modes.

Supported layer modes are as follows:

• Default layer mode (up to 30 layers)  — can consist of up to a maximum of 30 electrical layers 
or a combination of electrical and nonelectrical layers. In default layer mode, you can only import, 
add, or load other default layer mode items, such as files or library items, to your design. You 
cannot load increased layer mode objects into the default layer mode design.

• Increased layer mode (up to 250 layers)  — can consist of up to a maximum 64 electrical layers 
and 186 nonelectrical layers. The total number of layers includes associated layers such as 
mask, silkscreen, drill drawing, and assembly layers

In increased layer mode, you can load both default and increased layer mode objects into your 
design. Changing from default layer mode to increased layer mode increases all nonelectrical 
layer numbers by 100. In default layer mode, layer number 20 is used for placement outlines. In 
increased layer mode, layer 120 is used for placement outlines. Layer 25 in default layer mode, or 
125 in increased layer mode, was historically used for oversizing thermals and antipads for CAM 
planes prior to the CAM Plot Options for CAM Plane Layers  on page 1641.

You do not have to convert existing default layer mode libraries, reuse files, or archived designs 
to increased layer mode. You can use existing library decals, drawings, and reuses that are 
saved in default layer mode for both default and increased layer mode designs. You can cut from 
a design in default layer mode and paste into a design in increased layer mode. If you make sure 
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that you have consistent layer definition in libraries, reuses, and designs, no problems with layer 
matching will occur.

Restriction:
Once you change the design to increased layer mode, you cannot return to default layer 
mode.

Note:
You cannot export a design with more than 30 electrical layers to a SailWind Layout PADS-
format ASCII file prior to version 4.0.

Either default or increased layer mode is specified in each design or design fragment such as .pcb, .asc, 
.stp, .dxf, .reu, and high speed .edp files, library decals and drawing items, copy/paste buffer, and external 
CAM documents.

Related Topics
Increasing the Maximum Number of Available Layers

Special Functionality of Layers 20 and 25
During the evolution of the SailWind design environment, certain layers within the standard layer setup 
have been adopted for specific uses. These uses include special functionality assigned to Layer_20 and 
Layer_25.

Layer 20 - Placement Outlines
When components are placed on a board, it is desired to keep them separated by a specific clearance in 
order to prevent them from overlapping and creating potential unwanted connections between the copper 
features of the components. Since some component leads extend beyond the body of the components, a 
specific outline that includes the desired clearance can be added on Layer 20 to represent the maximum 
boundary of the component

This placement outline is:

• Commonly referred to as the placement (or nudge) outline - sometimes called a component 
courtyard.

• Used to specify additional clearances around a component to accommodate specific 
requirements for specialized placement and rework equipment.

• Used by on-line DRC and Verify Design to check for placement outline spacing violations.This is 
in addition to the standard “Body to body” design rule clearance check.
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Tip
To check the outlines, in the Verify Design, Clearance Checking Setup dialog box, enable 
the Placement outline check box.

Note:
Though only one layer is specified to contain the placement outlines, SailWind Layout 
uses the component placement layer assignment (top or bottom) of each component to 
determine how to interpret and check outline clearances during design verification.

For more information, see “Creating a Placement (Nudge) Decal Outline”  on page 197.

Layer 25 - 3D Body Outlines
Historically, when using CAM planes (negative planes), positive images of anti-pads would be created 
in the pad stack on Layer 25. The plane outline would also be added as copper or a 2D line on Layer 25 
around the board outline to create a gap from the plane to the board edge. This data would be merged 
with the CAM layer when the output files were generated for the photo plotter (Gerber files). Over time, 
the software evolved and “custom thermals and anti-pads” functionality was extended to CAM planes 
thereby making the use of anti-pads on Layer 25 obsolete.

Layer 25 is currently used for 3D body outlines. If you would like to view your design in the 3D Viewer, 
and you do not have a 3D model available for the component, the system will attempt to extrude a 
3D representation of the component from the data available in the pcb decal. The 3D Viewer will 
automatically look for a 3D body outline on Layer 25 to use for extruding the shape.

Tip
If no 3D body outline is present on Layer 25, the system will attempt to use the silkscreen image 
of the component as the basis for the shape extrusion.

By default, the Land Pattern Creator uses Layer 25 for 3D body outlines when generating PCB decals.

For more information, see “Choosing Between Split/Mixed and CAM Layers”.

Choosing Between Split/Mixed and CAM 
Layers
Solid planes can be represented in two ways—positive and negative.

A positive plane is created by using solid polygons on a Split/Mixed layer to represent the area that you 
want filled with copper. Pads, vias, thermals, anti-pads and other design objects are subtracted from the 
solid area. This method most accurately represents how the actual plane will look at fabrication. When the 
image is sent to a photo plotter, a positive representation of the plane is created on the film.

In the past, the photo plotter would use a very small aperture to “paint” the solid areas. This typically 
required the photo plotter to create tens of thousands of line segments to represent the plane. The file 
size could become quite large and took a lot of time to process, both by SailWind Layout and the photo 
plotter.

A negative plane on a CAM layer is created by using the absence of data to represent the area that 
you want filled with copper and you then create positive images of the design elements (pads, vias, 
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thermals, anti-pads) that you want to remove from the copper. When the image is sent to a photo plotter, 
only the positive images of the design elements to be removed are created on the film. The film is then 
photographically reversed to create the positive image used to fabricate the board. Using this process, the 
photo plotter only has to “paint” the areas where copper will be removed resulting in a much smaller file 
size and a substantial reduction in processing time.

Historically, when designs were sent to a photo plotter service bureau using very slow dial-up modems, 
file size was extremely important. Therefore, it was much more desirable to represent planes using 
the much smaller file sizes produced by negative (CAM) planes. In order to utilize this method, a CAM 
plane layer would be specified in SailWind to represent the plane, and then the positive images of anti-
pads would be created as pads on Layer 25. This data would be merged with the CAM layer when the 
output files were generated for the photo plotter (Gerber files). The resulting files were compact, more 
economical to transfer and quicker to process. Unfortunately, these negative CAM planes had certain 
design restrictions that created potential risks in their use.

Though these negative image planes were quick to generate, they were designed for single net 
assignment and no routing. The framework for CAM planes was rudimentary and did not allow for custom 
thermals or anti-pads. Verification of CAM planes was severely limited and required a lot of manual 
checking to verify plane connectivity. Also, considering that the plane was represented by a negative 
image, the plane outline could not be drawn and a positive image object had to be added to layer 25 
around the board outline to create the gap from the plane outline to the board edge.

Although “custom thermals and anti-pads” functionality has since been extended to CAM planes and the 
CAM plane functionality remains, it is outmoded by the advanced features available for planes on Split/
Mixed plane layers. Split/Mixed planes are quick to generate and process using today's computing power 
and modern laser photo plotters. Split/Mixed planes allow you to split the layer into multiple planes. They 
allow a mixed use of planes and routing with custom thermals, automatic back-off from traces and control 
of the shape of planes.

For more information about Split/Mixed plane features, see the features attributed to the Plane area in 
“Differences Between Copper Shapes and Copper Planes”.

Association of Component and 
Documentation Layers
Layer association outputs text, line, or shape items on manufacturing plots for the component layers, top 
or bottom.

When you associate a documentation layer  on page 1189dedicated to a manufacturing plot type with 
a component layer, the CAM output Document Type selections automatically include the associated 
documentation layer items with the plot type. You can associate the following layer types with a 
component layer: Paste Mask, Solder Mask, Silkscreen, and Assembly.

TrueLayer and Layer Association
When you define the pad stacks of a decal, the default layers for the pad stack are universal - Mounted, 
Inner, Opposite. They can be used universally on either side of the board. The mounted side can be the 
top or bottom of the board and the opposite side is always opposite the mounted side. If you were to 
instead create a pad stack that used specific layers, when you flipped the component to the other side of 
the board, the pad stacks would not flip.

Although you might add a specific Solder Mask, Paste Mask, Silkscreen or Assembly layer to the pad 
stacks of a decal, the TrueLayer feature flips the layer information when a component is flipped to the 
bottom side of the board. For example, if you have a surface mounted device with only a pad stack 
definition on the Solder Mask Top layer, when you flip the device to the bottom layer, the definition from 
the Solder Mask Top layer gets moved to the Solder Mask Bottom layer. You do not need to define a pad 
stack definition for the Solder Mask Bottom layer in case the component gets flipped.
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To disable the TrueLayer feature, see the “Software Launch Options” topic for instructions on command 
line options.

Setting Up Layers
Set up your layers by first defining them in the Layer Setup dialog box.

Procedure
1. Click the Setup  > Layer Definition  menu item. The Layers Setup Dialog Box  appears.

2. Set the number of layers for the design and if needed:

• Increase the total number of layers  on page 315available to the design database.

• Designate that this is a single-sided board  on page 316.

• Increase the number of electrical layers  on page 316.

3. Set up the outer  on page 317 layers.

4. Set up the inner  on page 318 layers.

5. Determine the visibility of non-electrical layers  on page 319.

6. Definelayer and substrate thickness  on page 320.

Increasing the Maximum Number of Available 
Layers
SailWind Layout features two layer modes—default layer mode and increased layer mode. Should you 
choose to switch to the increased layer mode, you can raise the number of available layers.

For more information regarding the two modes, see “Layer Modes”.

Restrictions and Limitations
When you switch a design to increased layer mode, you cannot return the design to default layer mode.

Procedure
1. Click the Setup  > Layer Definition  menu item. The Layers Setup Dialog Box  appears.

2. Click Max Layers. The Increase Maximum Layer Number Dialog Box  opens.

3. Click OK  to switch to increased layer mode.

Results
All documentation layer numbers from the 30 layer database are increased by 100. For example, if you 
started with a 12 electrical-layer design, the first documentation layer, layer 13, becomes layer 113.
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Designating a Board as Single-sided
You can only designate a board to be single-sided provided it has no more than two electrical layers.

Procedure
1. Click the Setup  > Layer Definition  menu item. The Layers Setup Dialog Box  appears.

2. Select the Single-sided board support check box.

3. Click OK.

Results

• Connectivity checking no longer reports connectivity errors for component pins with non-plated 
drill holes. Components and jumpers placed on the top layer are considered as connected to 
pads on the bottom layer with solder joints.

• In CAM output, all through-hole pins and vias are treated as non-plated regardless of the 
definition in pad stacks.

Modifying the Number of Electrical PCB 
Layers
You can change the number of electrical layers in a design in either default-layer (30 layer database) 
mode or increased-layer (250 layer database) mode.

For more information, see “Layer Modes”.

Restrictions and Limitations
You can't modify the layer definition for electrical layers if a physical design reuse exists on the board.

Prerequisites
Before changing the number of electrical layers, delete all partial vias and their definitions from your 
design.

Procedure
1. In the Layers Setup Dialog Box, click Modify. The Modify Electrical Layer Count Dialog Box  opens.

2. In the Modify Electrical Layer Count dialog box, type the new number of electrical layers within the 
specified range.

3. Click OK. The Reassign Electrical Layers Dialog Box  opens.

4. If necessary, reassign the electrical information on any existing electrical layer to a new layer. 
The new electrical layers are created in the database with default parameter values. For more 
information, see “Reassigning Electrical Layers”.
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5. Click OK  to return to the Layers Setup dialog box.

Tip
If you increase your electrical layer count, and intend to use partial vias, you should also 
update your drill pairs layer settings  on page 1337.

Setting Up an Outer Layer
The outer layers of your design are the Top and Bottom layers. You can designate an outer layer as a 
component layer or non-component layer.

Procedure
1. In the Layers Setup Dialog Box, select an outer layer. For example, select Top.

2. In the Name box, type the name of the layer. By default, the outer layer names are assigned as 
Top and Bottom. Rename the layer to something that lets you know what the layer is. For example, 
Top Component Layer 1.

3. In the Electrical Layer Type area, click Component if you want to allow components on the layer; 
otherwise click Routing. If you select Component, you can change the layer associations:

a. Click the Associations button.

b. In the Component Layer Associations Dialog Box, set the associations for each documentation 
layer type.

When a top or bottom layer is set as a component layer, you can associate, or otherwise map, 
which documentation layers go with the selected layer. Whatever layer associations are made 
here are used by CAM routines for output. For example, when you output a silkscreen for the 
top, any items on the documentation layer you associated for silkscreen are automatically 
added to the CAM document.

c. Click OK.

4. In the Layers Setup dialog box, click a Plane Type setting. If you select CAM or Split/Mixed Plane, 
you must assign the plane net(s) to the layer:

a. Click the Assign Nets  button. The Plane Layer Nets Dialog Box  appears.

b. Click a net from the All Nets list.

c. Click Add  to move the net to the Assigned Nets list. You can also assign a net to other layers 
as required. For example, if you have multiple ground plane layers, you can assign your 
ground net to those multiple layers.

d. If the layer is a Split Mixed Plane type, you can associate additional nets to the layer.

e. Click OK.

5. In the Layers Setup dialog box, click a Routing Direction setting. You must assign a primary routing 
direction to all electrical layers. Nonelectrical layers are not assigned a routing direction. The 
routing direction affects the manual and autorouting performance. For example, if you select 
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Horizontal but most of the traces on the layer need to be vertical, route editing performance is slow. 
Also, selecting Any can adversely affect route editing performance.

6. Click OK.

Related Topics
Setting Up an Inner Layer

Setting Up a Documentation Layer

Association of Component and Documentation Layers

Choosing Between Split/Mixed and CAM Layers

Setting Up an Inner Layer
The inner layers of your design are always electrical layers.

Procedure
1. In the Layers Setup Dialog Box, select an inner layer. For example, select Ground Plane.

2. In the Name box, type the name of the layer. By default, SailWind Layout assigns the layer number 
as its name; for example, Inner Layer 2. Rename the layer to something that lets you know what 
the layer is; for example, Inner Signal Layer 2.

3. Click a Plane Type setting. If you select CAM or Split/Mixed Plane, you must assign the plane 
net(s) to the layer:

a. Click the Assign Nets  button. The Plane Layer Nets Dialog Box  appears.

b. Click a net from the All Nets list.

c. Click Add  to move the net to the Assigned Nets list. You can also assign a net to other layers 
as required. For example, if you have multiple ground plane layers, you can assign your 
ground net to those multiple layers.

d. If the layer is a Split Mixed Plane type, you can associate additional nets to the layer.

e. Click OK  to close the Plane Layer Nets dialog box.

4. In the Layers Setup dialog box, click a Routing Direction setting. You must assign a primary routing 
direction to all electrical layers. Nonelectrical layers are not assigned a routing direction. The 
routing direction affects the manual and autorouting performance. For example, if you select 
Horizontal but most of the traces on the layer need to be vertical, route editing performance is slow. 
Also, selecting Any can adversely affect route editing performance.

5. Click OK.

Related Topics
Setting Up an Outer Layer

Setting Up a Documentation Layer

Choosing Between Split/Mixed and CAM Layers
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Setting Up a Documentation Layer
SailWind Layout assigns layers 21 to 30 (in default layer mode) as default documentation layers for 
manufacturing plot types, including two for silkscreen (top and bottom).

Procedure
1. In the Layers Setup Dialog Box, select a documentation layer. Documentation layers are listed 

after all electrical layers. A quick way to tell if a layer is a documentation layer is the absence of a 
letter in the Direction (dir) column.

2. In the Name box, type the name of the layer. By default, SailWind Layout assigns the layer number 
as its name; for example, Layer_3. Rename the layer to something that lets you know what the 
layer is; for example, Gold Mask.

3. Click a Fab. Assembly and Documentation Layer Type setting. If you click SilkScreen, Paste Mask, 
Solder Mask, or Assembly, this layer is available for association with component layers.

4. Click OK.

Related Topics
Association of Component and Documentation Layers

Setting Up an Inner Layer

Setting Up an Outer Layer

Component Layer Associations Dialog Box

Hiding or Displaying Non-electrical Layers in 
Layer Lists
Default SailWind Layout designs come with many available layers and these layers all appear in the layer 
list of certain dialogs. If your design only uses a few layers, the result is a large number of unused layers 
appearing in the layer list. You can hide those unused layers from view to shorten the layer list wherever it 
displays—for example, the Layer list of the Standard Toolbar, the Layers Setup and Display Colors dialog 
boxes.

Tip
For instructions on hiding layers in the PCB design, see “Hiding Layers”.

Restrictions and Limitations
You can hide only non-electrical layers from layer lists.

Procedure
1. In the Layers Setup Dialog Box, click Enable/Disable.

2. Select the appropriate check box in the Enabled column to either enable or disable a layer.
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Tip
While the Enabled column is the only editable column, you can sort the displayed layers by 
any column. Click a column heading to sort by that column's values. Click the same column 
heading again to re-sort in the reverse order.

3. Click OK  to return to the Layers Setup dialog box.

Setting Layer Parameters
Layer parameters are provided to confirm design compliance and calculate impedance. For example, 
when you verify your design, the electrodynamic check uses such information to confirm design 
compliance as electrical layer and dielectric material layer thickness and dielectric constant information 
defined in the Layer Parameter Setup dialog box. Besides, more layer parameters are provided for 
impedance calculation.

Traces on high-speed printed circuit boards can act like transmission lines that “broadcast” interference 
to adjacent conductors. With the high-speed rules module, you can use Rules to set clearances on a net 
class, net, or pin-to-pin connection basis; then use high-speed checking to report on properties such as 
impedance, delay, track length, daisy chaining, and parallel routing. These issues cause interference and 
create costly problems in prototyping. You can run checks against the entire board or against specific 
nets.

Prerequisites
You must specify your plane layers in the Layers Setup dialog box before you run an electrodynamic 
check. For a two-layer board, temporarily identify one of the layers as a plane layer.

Procedure
1. In the Layers Setup Dialog Box, click the Advanced  button. The Layer Parameter Setup dialog box 

opens.

2. Set layer parameters as needed.

• For each dielectric material layer, double-click the Type cell to select whether the “layer” is a 
Prepreg or Substrate layer.

• For dielectric material and coating layers, fields Dk and Df are editable. For electrical layers, 
you can set such parameters as Drum SR, Matte SR, Ref.Plane, SE Width, DIFF Width, and 
DIFF Spacing.

For detailed parameter description, refer to the table below.
Table  73.  Layer parameter description

Field Description

# Displays the electrical layer number, which corresponds to Lev.  in 
the Layers Setup Dialog Box.

Name Displays the name of the layer, which corresponds to that defined 
in the Layers Setup Dialog Box.
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Field Description

Type Specifies the type of layer. The only layers available for edit are 
dielectric. You have the choice of Substrate or Prepeg in this list.

Material Specifies the material of each layer. You can choose one from the 
drop-down list.

Thickness Specifies the thickness of the layer.
The input range varies from the material type and current design 
units:

• For dielectric material, its thickness must be within 5.08 
mm/200 mil/0.2 inch.

• For copper, its thickness must be within 0.25 mm/10 mil/0.2 
inch.

Tip:  If no coating is required, set thickness to zero.

Dk Specifies the dielectric constant value.

Df Specifies the dielectric loss tangent.
Range: 0—1

Drum SR Specifies the roughness of the drum side.
The input range varies from the current design units:

• Mils: 0—1

• Metric: 0—0.02540

• Inches: 0—0.001

Matte SR Specifies the roughness of the matte side.
The input range is silmilar to that of the drum side.

Ref. Plane Specifies the electrical layer as reference layer or not.
Note:  Plane layers specified in the Layers Setup Dialog Box  are 
set to reference layers by default.

SE Width Specifies the single-ended trace width.
The input range varies from the current design units as follows and 
the same rule applies to that of DIFF Width as well as DIFF Space.

• Mils: 0—100

• Metric: 0—2.54

• Inches: 0—0.001

SE Z0 (ohm) Displays the single-ended impedance calculated by clicking 
Calculate Impedance.

DIFF Width Specifies the trace width of differential pairs.

DIFF Space Specifies the spacing between differential pairs.
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Field Description

DIFF Z0 (ohm) Displays the differential impedance calculated by clicking 
Calculate Impedance.

Edit Makes the selected cell available for editing.
Exception:  Cells that are grayed out or blank are unavailable for 
editing.

Weight (oz) Specifies to view and edit copper thicknesses by ounces per 
square foot.

Design (") Specifies to view and edit copper thicknesses in the same unit of 
measure as the current database.

Board Thickness The total value of material and layer thicknesses in the current 
design units.

Calculate Impedance Clicks to start impedance calculation.

Import Clicks to import a XML file.

Export Clicks to export a XML file.

3. To view and edit copper thicknesses by ounces per square foot, click “Weight (oz)”. Otherwise, 
click Design to view and edit in the same unit of measure as the current database

Related Topics
Verify the Design

Setup of High Speed (Electrodynamic) Checking

Setup of EDC Parameters

Unassigning a Netname from a Plane Layer
You can remove a netname from its assignment to a plane layer.

Procedure
1. In the Layers Setup Dialog Box, select a layer defined as a CAM Plane or a Mixed Plane.

2. Click Assign Nets. The Plane Layer Nets Dialog Box  opens.

3. Click the netname in the Assigned Nets list.

4. Click Remove. The netname is moved back to the All Nets list.

5. Click OK.
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Reassigning Electrical Layers

Reassigning Electrical Layers
When you alter the number of electrical layers, you must reassign the old layers to locations in the new 
layer setup.

Restrictions and Limitations

• When reassigning layers, component keepouts are ignored. They remain on the layer on which 
you created them.

• You cannot modify the layer definition for electrical layers when a physical design reuse exists on 
the board.

• If a route is attached to a pad that is not available on the new layer, such as a surface mount 
pin or a partial via, the program places a zero-length unroute from the end of the trace to the 
component pin.

Procedure
1. In the Layers Setup Dialog Box, click Reassign. The Reassign Electrical Layers Dialog Box  opens.

2. Click the number of the layer you want to reassign from the Old list.

3. Type the layer number you want to assign it to in the “New Layer #” box. You cannot merge items 
from an old to a new layer, but you can swap layers. Additionally, the target layer must be empty.

4. The following information moves from the old layer to the new layer:

• Traces and vias

• Drafting objects

• Layer name, layer type, routing direction, and component/plane layer parameters

5. If you decrease the number of layers and the selected layer has no data, you can remove the layer. 
To remove it, click Delete.

6. Click OK. You return to the Layers Setup dialog box.

Results
The following layer properties are changed during layer reassignment:

• Name

• Plane status

• Layer (routing) direction

• Dielectric constant and thickness (associated with upper copper layer)
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• Associated nonelectrical layers (for top and bottom)

• List of assigned nets

• Colors, including outline colors

Tip
Because both layer names and colors are reassigned, an object remains in the same color 
after reassignment.

The following objects have an assigned layer and are reassigned during layer reassignment:

• Traces

• 2D lines, free and in decal (part outlines)

• Copper, open and closed, free and in decals, but not pin-associated copper

• Keepouts, free and in decals

• Copper cutouts, free, associated, and in decals

• Texts, free, combined with 2D lines, and in decals

• Attribute labels

• Pour outlines and plane areas

• Pour or plane area hatch outlines and hatch voids

• Conditional clearance rules

• Layer mask in routing rules

The following objects have an assigned layer and are not reassigned during layer reassignment:

Tip
Before deleting an electrical layer, make sure that you first delete all of the following objects from, 
and any references to, the layer.

• Pad definitions on absolute layers in pad stacks (for decals and vias)

• Pin-associated copper in decals
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Reassigning Electrical Layers

• Start and end layers for partial vias

• Drill pairs
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Chapter 15
Via Setup

Read the following topics to learn more about the setup of vias.

For information about adding virtual pins to nets in your design, see Virtual Pins.

Defining Drill Pairs
Creation of Vias
Editing a Via Type
Deleting a Via Type
Tented Vias With Solder Mask
Troubleshooting Via Usage

Defining Drill Pairs
A drill pair  is a pair of layer numbers specifying the starting layer and ending layer of a drilled hole. If you 
want to use one or more partial vias in your design, you must define a drill pair for each layer change 
specified in a via type.

Define drill pairs before you define partial via types or begin routing; after you define your drill pairs, 
SailWind Layout prevents you from performing actions (such as defining a via type, or making a layer 
change during routing) that do not conform to a defined drill pair.

If you are using both through-hole and partial vias in your design, you must also create an “all-layers” drill 
pair for the through-hole default via type; after any partial via type has been created, SailWind Layout 
requires that a drill pair be defined for all via types, including the through-hole default.

Procedure
1. Click the Setup  > Drill Pairs  menu item.

2. In the Drill Pairs Setup Dialog Box, click Add  to add a line to the Drill Pairs list.

3. Select the starting layer from the Starting Layer list. The layer number is automatically indicated to 
the left of the list.

4. Select the ending layer from the Ending Layer list. The layer number is automatically indicated to 
the left of the list.

5. Repeat Steps 2 through 4 to add any additional drill pairs. You can change the starting or ending 
layer of a drill pair, or delete drill pairs.

6. Click OK  to save the drill pairs.

Tip
You can use up to 30 electrical layers when adding a partial via in default layer mode. You 
can use up to 64 electrical layers when adding a partial via in increased layer mode.

SailWind Layout Guide and Reference 327



Via Setup
Defining Drill Pairs  

Related Topics
Creating a Partial Via Type

Creating a Through-hole Via Type

Drill Pairs Setup Dialog Box

Creating a Non-Drilled Single-Layer Via Type for Virtual Pins
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Creation of Vias

Creation of Vias
You can create three basic via types: Through-hole, Partial, and Non-drilled Single-Layer (the Partial via 
type includes both blind and buried vias).

Creating a Through-hole Via Type
Creating a Partial Via Type
Creating a Non-Drilled Single-Layer Via Type for Virtual Pins

Creating a Through-hole Via Type
You can create a through-hole via type to use for vias and/or virtual pins.

Prerequisites
If any partial drill pairs exist in your design, an “all-layers” drill pair must also exist before you perform this 
procedure. See “Defining Drill Pairs”.

Procedure
1. Click the Setup  > Pad Stacks  menu item.

2. In the Pad Stacks Properties Dialog Box, in the Pad Stack Type area, click Via.

3. Click Add Via  to add a line to the Decal name list. A list of all previously defined via types appears 
in the Decal Name list.

4. In the Vias area, in the Name box, type the name of the new via.

5. Click Through to indicate that this is a Through-hole via type.

6. If needed, customize the pads for individual layers, as follows:

a. Select the layer from the “Sh: Sz: Layer: list”. For more information, see “Pad Stack Default 
Layers” and “Control of Solder Mask and Paste Mask  on page 209”.

b. In the Parameters area, specify the settings on all three Pad, Thermal, and Antipad  tabs. 
The style of pad used is selected automatically in the design depending on the situation. 
The thermal and antipad styles are used when the pad is located within a plane. For more 
informations, see “Design Rule Versus Pad Stack - Thermals and Antipads”  on page 797.

c. Repeat Steps a and b for other layers, as needed.

7. Click OK  to save the new via type.

Related Topics
Pad Sizes and Pad Stacks

Creating a Partial Via Type

Editing a Via Type

Creating a Non-Drilled Single-Layer Via Type for Virtual Pins
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Defining Drill Pairs

Pad Stacks Properties Dialog Box

Creating a Partial Via Type
You can create a partial via type to use for vias and/or virtual pins.

Partial vias can be either a blind via  or buried via.

For more information, see “Creating a Through-hole Via Type” and “Creating a Non-Drilled Single-Layer 
Via Type for Virtual Pins”.

Prerequisites
A drill pair specifying the starting and ending layers for the new partial via type must exist. For more 
information, see “Defining Drill Pairs”.

Procedure
1. Click the Setup  > Pad Stacks  menu item.

2. In the Pad Stacks Properties Dialog Box, in the Pad Stack Type area, click Via.

3. Click Add Via  to add a line to the Decal name list. A list of all previously defined via types appears 
in the Decal Name list.

4. In the Vias area, type the name of the via type in the Name box.

5. Click Partial to indicate that this is a blind or buried via type.

6. Select the starting and ending layers from the Start Layer and End Layer lists.

7. If necessary, customize the pads for individual layers, as follows:

a. Select the layer from the “Sh: Sz: Layer:” list. For more information, see “Pad Stack Default 
Layers” and “Control of Solder Mask and Paste Mask”.

b. In the Parameters area, specify the settings on all three Pad, Thermal, and Antipad  tabs. 
The style of pad used is selected automatically in the design depending on the situation. 
The thermal and antipad styles are used when the pad is located within a plane. For more 
information, see “Design Rule Versus Pad Stack - Thermals and Antipads”  on page 797.

c. Repeat Steps a and b for other layers, as needed.

8. If the partial via will be laser drilled, you can select the Laser check box to use the “Laser drill 
oversize” value in the Options Dialog Box, Design Category, for verifying spacing.

9. Click OK  to save the new via type.

Results
If you are unable to use the new partial via type, check the following in the Default Routing Rules:

• Is your new via type in the Selected vias list and available for use in the design?

• Are both the from and to layers listed in the Selected layers list and available for routing?
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Creating a Non-Drilled Single-Layer Via Type for Virtual Pins

Related Topics
Editing Pad Stacks

Creating a Through-hole Via Type

Editing a Via Type

Creating a Non-Drilled Single-Layer Via Type for Virtual Pins

Defining Drill Pairs

Pad Stacks Properties Dialog Box

Creating a Non-Drilled Single-Layer Via Type for 
Virtual Pins
You can create a non-drilled (single-layer) pad via type to be used by virtual pins. You must create one of 
these for each layer on which you will use virtual pins. Use the Through via setting to create a single pad 
non-drilled via type.

Procedure
1. Click the Setup  > Pad Stacks  menu item.

2. In the Pad Stacks Properties Dialog Box, in the Pad Stack Type area, click Via.

3. Click Add Via to add a line to the Decal name list. A list of all previously defined via types appears 
in the Decal Name list.

4. In the Vias area, in the Name box, type the name of the new via type.

5. Click Through. You must use this setting to create a non-drilled via type.

6. From the “Sh: Sz: Layer:” list, select the layer on which virtual pins using this via type will be 
installed. For more information, see “Pad Stack Default Layers”.

7. In the Parameters area, specify only the settings on the Pad tab. (The thermal and antipad styles 
are used only when the pad is located within a plane, and virtual pins are not allowed in plane 
nets.) For more information, see “Design Rule Versus Pad Stack - Thermals and Antipads”  on 
page 797.

8. In the Drill size box, type 0 (zero).

9. For all other layers of the pad stack, in the Size box, type 0 (zero).

10. Click OK  to save the new via type.

Related Topics
Creating a Through-hole Via Type

Creating a Partial Via Type

Adding a Virtual Pin to a Net
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Editing a Via Type
You can make changes to a via type and apply the changes to all objects that use that via type.

Procedure
1. Select a via or virtual pin.

2. Right-click and click the Properties  popup menu item.

3. In the Via Properties  on page 1779 or Virtual Pin Properties  on page 1789 dialog box, click the 
Pad Stack  button.

4. In the Pad Stacks Properties Dialog Box, click the via type to edit in the Decal Name list.

5. Change via settings as needed. Use the Parameters and Drill Size areas to reset the size and 
shape options.

6. When you finish making changes, click OK.

7. Click Yes  to change all vias of the selected type.

8. Click OK  to close the Via or Virtual Pin properties dialog box.

Related Topics
Editing Pad Stacks

Creating a Through-hole Via Type

Creating a Partial Via Type

Creating a Non-Drilled Single-Layer Via Type for Virtual Pins

Defining Drill Pairs

Pad Stacks Properties Dialog Box

Deleting a Via Type
Delete via types by deleting a via definition in the pad stacks.

Procedure
1. Click the Setup  > Pad Stacks  menu item.

2. In the Pad Stacks Properties Dialog Box, in the Pad Stack Type area click Via.

3. Click a via type name in the Decal Name list.

4. Click Delete Via.

5. Click OK.
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Deleting a Via Type

Related Topics
Editing Pad Stacks

Creating a Through-hole Via Type

Creating a Partial Via Type

Creating a Non-Drilled Single-Layer Via Type for Virtual Pins

Pad Stacks Properties Dialog Box
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Tented Vias With Solder Mask
You can cover vias with solder mask (a process known as “tenting” the via.)

While using an attribute to control soldermask openings is a quick method, you are unable to see the 
shapes in the design since they are generated when creating the gerber files. Adding custom solder mask 
shapes to pad stacks is more labor intensive but also allows the most control and customization of each 
pad stack. See the topics below for more information.

Tenting Vias By Adding a Custom Solder Mask Shape
Tenting Vias By Adding an Attribute
Verifying Via Tenting Results

Tenting Vias By Adding a Custom Solder Mask 
Shape
Use the Pad Stacks dialog box to add a custom solder mask shape to one or both solder mask layers. 
Adding solder mask shapes to all pad stacks allows you to see solder mask openings in the design and 
also see when there are no openings in the solder mask. The Solder Mask layer also displays drill hole 
locations.

Procedure
1. On the Setup  menu, click Pad Stacks.

2. In the Pad Stacks Properties Dialog Box, in the Pad Stack Type area, click Via.

3. Add a solder mask layer to the via type you want to be tented, as follows:

a. In the Decal name list click the name of the via type.

b. In the Vias area Name box, append “_OPEN” to the via type name.

c. In the Sh: Sz: Layer area, click Add, and from the Add Layer dialog box select either Solder 
Mask Top or Solder Mask Bottom, and click OK.

d. With the new Solder Mask layer selected, set the pad diameter to the oversize required for the 
via.

e. If you need to add the other solder mask layer, repeat steps c and d.

4. Create a duplicate of the via type you just edited, as follows:

a. With the <VIA_NAME>_ OPEN via type selected, click the Add Via  button, and click Yes  when 
prompted to apply pad stacks information and to change all vias of type <VIA_NAME>_ OPEN.

b. In the Vias area, type “<ORIGINAL_VIA_NAME>_TENTED”.

c. In the Sh: Sz: Layer area, select a Solder Mask layer.

d. With the Solder Mask layer selected, set the pad diameter to zero.
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Tenting Vias By Adding an Attribute

e. If you need to add the other solder mask layer, repeat steps c and d.

f. Click OK  to save the settings and close the dialog box.

5. Tent the vias in the design, as follows:

a. In the design, select the vias you want to be tented.

b. Right-click and click the Properties  popup menu item.

c. In the Via Properties Dialog Box, in the Via Name list, select the name of the new tented via 
type.

d. Click OK.

Results
To verify your results, perform the procedure in Verifying Via Tenting Results.

Tenting Vias By Adding an Attribute
Use the Object Attributes dialog box to add an attribute that controls the solder mask openings. This is 
the quickest method, but you will be unable to see the shapes in the design — you have to create a CAM 
document to see them.

CAUTION:
If a solder mask shape exists in a solder mask layer of the via type pad stack, and the via type 
also has an assigned “CAM.Solder mask.Adjust” value, and you apply both values when creating 
the CAM document, the values are combined. See “Mask Hierarchy  on page 209”.

Procedure
1. In the design, select the vias you want to be tented.

2. Right-click and click the Attribute  popup menu item.

3. In the Object Attributes Dialog Box, click the Add  button.

4. From the drop-down list in the Attribute column, select CAM.Solder mask.Adjust.

5. Double-click in the edit box under the Value header, type a negative value that represents the via 
pad size, and press the Enter key. For example, enter -20 to tent a 20 mil via pad.

6. Click Close.

Results
To verify your results, perform the procedure in Verifying Via Tenting Results.

Verifying Via Tenting Results
You can verify the results of via tenting operations by previewing the solder mask area.
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Procedure
1. Click the File  > CAM  menu item.

2. In the Define CAM Documents Dialog Box, click the Add button.

3. In the Add/Edit Document Dialog Box, from the Document Type list, select Solder Mask.

4. In the Layer Association dialog box, select the top/bottom layer.

5. In the Customize Document area, click the Layers  button.

6. In the Select Items Dialog Box  Selected list, select Solder Mask Top.

7. In the Items on Primary area, select the Vias check box.

8. Click the Preview  button. The output will show openings for the “open” vias, but the “tented” vias 
will not appear.

Troubleshooting Via Usage
Keep certain tips in mind when you try to place a via, and it fails, or you receive the message, “Via usage 
for this net is restricted.”

• When partial vias  on page 330 are used, you must set up a drill pair  on page 327 for all partial 
and through hole vias  on page 329 in the design.

• In the Routing Rules Dialog Box, you can specify the vias that are to be used at all levels of the 
design rules hierarchy  on page 404. This can, for example, prevent you from using the wrong 
via on a specific net or pin pair.
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Chapter 16
Electrical Nets

Read the topics that follow to learn how to create and manage electrical nets.

Electrical Net Creation
Deletion of Electrical Nets
Excluding Nets from Electrical Net Creation
Excluding Components from Electrical Net Creation
Canceling Electrical Net Creation by Nets
Canceling Electrical Net Creation by Components
Selecting Electrical Nets
Creating a Matched Length Group of Electrical Nets
Creating a Differential Pair of Electrical Nets
Creating or Modifying Electrical Net Design Rules
Clearing Electrical Net Rules
Conditions Governing Electrical Net Creation
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Electrical Net Creation
You can associate an array of nets joined by discrete components, creating an electrical net to which you 
can apply length, differential pair and matched length rules as you would to a single net. The length of an 
electrical net is the combined lengths of the nets and discrete components of which it is composed.

The figure below shows a simple example of an electrical net.

Figure 26. Electrical Net Components and Nets

There are three methods you can use to create and modify electrical nets.

By default these methods are independent of each other (that is, you can use any of the methods by 
itself), because the commands/properties by which they interact are defaulted to allow you to choose one 
method to use, and ignore the others. Choosing one method and sticking with it is the simplest course. 
If you mix methods in your design, you will need to understand how the methods interact, described in 
“Conditions Governing Electrical Net Creation”  on page 348.

Creating Electrical Nets by Selecting the Nets
Creating Electrical Nets by Selecting the Components
Creating Electrical Nets by Component Refdes Prefix

Creating Electrical Nets by Selecting the Nets
You can create electrical nets by selecting nets and associating them.

Restrictions and Limitations

• Plane nets cannot be part of an electrical net.

• Components through which an electrical net passes must be either discrete two-pin components, 
or multiple pin components if all the pins connect to a gate and each gate has exactly two pins.

338 SailWind Layout Guide and Reference



 
Electrical Nets

Creating Electrical Nets by Selecting the Components

Procedure
1. Click the Setup  > Electrical Nets  menu item.

2. In the Electrical Nets  on page 1361 dialog box, set the “Maximum net count per electrical net” and 
“Maximum non-plane-net pin count” values for your design.

3. In the workspace, select the nets you want make into electrical nets.

4. Right-click and click the Electrical Nets  popup menu item. As an alternative, in the Net Properties 
dialog box  on page 1487, select the “Create electrical net” check box. The selected nets are made 
into electrical nets, and the Net Properties “Create electrical net” check box is selected for all the 
selected nets.

5. Whenever electrical nets are created, deleted or changed, all electrical nets in the design are 
regenerated. Verify that the results of an electrical nets action are what you expected by reading 
the messages in the Output Window.

Results
Are the results different from what you expected?:

• An expected electrical net might have been split or truncated, or not created at all, if it surpassed 
one of the maximum thresholds set in the Electrical Nets  on page 1361 dialog box.

• Some nets cannot be made into electrical nets; for example, two selected nets from opposite 
sides of the board will have the Create electrical net check box selected, but no electrical net will 
be created.

• Mixed-method restriction — if a component to which one of the selected nets is attached has 
been excluded from electrical net creation, no electrical net can go through it. (A component or 
net is excluded from electrical net creation if its “Create electrical nets” and “Allow electrical net 
creation...” check boxes are both cleared.) For more information, see ““Conditions Governing 
Electrical Net Creation”  on page 348”.

Related Topics
Canceling Electrical Net Creation by Nets

Excluding Nets from Electrical Net Creation

Creating Electrical Nets by Selecting the 
Components
To base the creation of electrical nets on the selected components, use the connected physical nets on 
the components to create your electrical nets.

Restrictions and Limitations

• Plane nets cannot be part of an electrical net.

• Components through which an electrical net passes must be either discrete two-pin components, 
or multiple pin components if all the pins connect to a gate and each gate has exactly two pins.
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Procedure
1. Click the Setup  > Electrical Nets  menu item.

2. In the Electrical Nets  on page 1361 dialog box, set the “Maximum net count per electrical net” and 
“Maximum non-plane-net pin count” values for your design.

3. In the workspace, select the components whose nets you want to make into an electrical net.

4. Right-click and click the Electrical Nets  popup menu item. As an alternative, in the Component 
Properties Dialog Box, select the “Create electrical net” check box. The nets attached to the 
selected components are made into an electrical net, and the Component Properties “Create 
electrical net” property is set for all the selected components.

5. Whenever electrical nets are created, deleted or changed, all electrical nets in the design are 
regenerated. Verify that the results of an electrical nets action are what you expected by reading 
the messages in the Output Window.

Results
Are the results different from what you expected?

• An expected electrical net might have been split or truncated, or not created at all, if it surpassed 
one of the maximum thresholds set in the Electrical Nets  on page 1361 dialog box.

• Mixed-method restriction — if a net attached to a selected component is excluded from electrical 
net creation, it cannot be included in an electrical net. (A component or net is excluded from 
electrical net creation if its “Create electrical net” and “Allow electrical net creation...” check boxes 
are both cleared.) For more information, see “Conditions Governing Electrical Net Creation”  on 
page 348.

Related Topics
Excluding Components from Electrical Net Creation

Canceling Electrical Net Creation by Components

Creating Electrical Nets by Component Refdes 
Prefix
You can create electrical nets automatically by specifying the refdes prefixes of the components through 
which the nets pass in the Electrical Nets dialog box.

For more information, see Electrical Nets Dialog Box.

Restrictions and Limitations

• Plane nets cannot be part of an electrical net.

• Components through which an electrical net passes must be either discrete two-pin components, 
or multiple pin components if all the pins connect to a gate and each gate has exactly two pins.
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Creating Electrical Nets by Component Refdes Prefix

Procedure
1. Click the Setup  > Electrical Nets  menu item.

2. In the Electrical Nets  on page 1361 dialog box, set the “Maximum net count per electrical net” and 
“Maximum non-plane-net pin count” values for your design.

3. In the “Discrete component prefixes” area, enter the refdes prefixes of the components that should 
create electrical nets. This creates electrical nets for all components that have the specified refdes 
prefixes. In order to constrain the number of electrical nets that are created, you could assign 
unique reference designators to those components that should create electrical nets, or simply 
create electrical nets by selecting the components in the design  on page 339.

4. Click OK. Electrical nets are regenerated based on the new or changed set of specified refdes 
prefixes.

5. Whenever electrical nets are created, deleted or changed, all electrical nets in the design are 
regenerated. Verify that the results of an electrical nets action are what you expected by reading 
the messages in the Output Window.

Rules (min/max length, matched length groups, differential pairs) for electrical nets that are 
unchanged in the regeneration are kept. Electrical nets that are changed (including changes to the 
set of components they pass through), or deleted:

• Lose their rules

• Are removed from matched length groups, and

• Diff pairs containing them are removed.

Results
Are the results different from what you expected?

• An expected electrical net might have been split or truncated, or not created at all, if it surpassed 
one of the maximum thresholds set in the Electrical Nets  on page 1361 dialog box.

• Mixed-method restriction — if any of the selected components, or any net attached to a selected 
component, has been excluded from electrical net creation, it cannot be included in an electrical 
net. (A component or net is excluded from electrical net creation if its “Create electrical net” and 
“Allow electrical net creation...” check boxes are both cleared.)

For more information, see the “Conditions Governing Electrical Net Creation”  on page 348.

Related Topics
Deletion of Electrical Nets

Excluding Nets from Electrical Net Creation

Excluding Components from Electrical Net Creation
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Deletion of Electrical Nets
You can delete electrical nets manually—or automatically, if Ref. Des. Prefix assignment in the Electrical 
Nets dialog box created them.

Deleting Electrical Nets Manually
Deleting Electrical Nets Automatically

Deleting Electrical Nets Manually
Select electrical nets in the design to delete them.

Procedure
1. In the workspace, select the electrical nets  on page 345you want to delete.

2. Right-click and click the Delete Electrical Net  popup menu item. Deleting an electrical net does 
not delete the physical nets.

Results
The Create electrical net check box is cleared for all the nets of the selected electrical nets. If any 
electrical nets were created by component (including by refdes prefix), for those nets the “Allow electrical 
net creation by component” check box is cleared as well.

Related Topics
Canceling Electrical Net Creation by Nets

Excluding Nets from Electrical Net Creation

Deleting Electrical Nets Automatically
You can “automatically” delete a group of electrical nets that the refdes prefix method created 
automatically.

Procedure
1. Click the Setup  > Electrical Nets  menu item.

2. In the Electrical Nets  on page 1361 dialog box, delete the refdes prefixes of the associating 
components.

3. Click OK.

4. Whenever electrical nets are created, deleted or changed, all electrical nets in the design are 
regenerated. Verify that the results of an electrical nets operation are what you expected by 
reading the messages in the Output Window.
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Results
The electrical nets created by components having the specified refdes prefix are deleted, split or 
truncated.

Are the results different from what you expected? Mixed-method restrictions:

• If a component having the deleted refdes prefix has the “Create electrical net” check box 
selected, the physical nets will remain in an electrical net.

• If a component having the deleted refdes prefix has the “Allow electrical net creation by refdes 
prefix and by net” check box selected, and both nets attached to a two-pin component (or to a 
single gate of a multiple-pin component) have the “Create electrical net” check box selected, 
those nets will remain in an electrical net.

For more information, see ““Conditions Governing Electrical Net Creation”  on page 348”.

Related Topics
Excluding Components from Electrical Net Creation

Excluding Nets from Electrical Net Creation
You can exclude individual nets from inclusion in any electrical net.

Clear both the Net Properties “Create electrical net” check box and the “Allow electrical net creation 
by component” check box, removing the selected nets from any current electrical net, and preventing 
electrical net creation by component (including by refdes prefix). For more information, see “Conditions 
Governing Electrical Net Creation”  on page 348.

Procedure
1. In the workspace, select the net(s) you want to exclude from electrical net creation.

2. Right-click and click the Disable Electrical Net Creation  popup menu item. As an alternative, 
in the Net Properties dialog box, clear both the “Create electrical net” and “Allow electrical net 
creation by components” check boxes.

3. Whenever electrical nets are created, deleted or changed, all electrical nets in the design are 
regenerated. Verify that the results of an electrical nets operation are what you expected by 
reading the messages in the Output Window.

Results
The selected nets are removed from existing electrical nets, and the Net Properties “Create electrical net” 
and “Allow electrical net creation by components” check boxes are cleared for all the selected nets.

Related Topics
Excluding Components from Electrical Net Creation

Canceling Electrical Net Creation by Nets
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Excluding Components from Electrical Net 
Creation
You can prevent an individual component (a component through which an electrical net passes) from 
creating electrical nets.

If you exclude a component that is not already part of an electrical net, it cannot become part of an 
electrical net created by net or by refdes prefix. In addition, if the component is already part of an 
electrical net, it is removed from the electrical net.

Clear both the Component Properties “Create electrical net” and “Allow electrical net creation...” check 
boxes, preventing the selected components from creating electrical nets. For more information, see 
“Conditions Governing Electrical Net Creation”  on page 348.

Procedure
1. In the workspace, select the components you want to exclude from electrical nets.

2. Right-click and click the Disable Electrical Net Creation  popup menu item. As an alternative, in 
the Component Properties Dialog Box, clear both the “Create electrical net” and “Allow electrical 
net creation by refdes prefix or by net” check boxes.

3. The selected components are excluded from electrical net creation. If a component is part of an 
existing electrical net, it is removed, that is, the electrical net no longer goes through it. Removing a 
component from an electrical net splits, truncates, or deletes the electrical net, depending upon its 
configuration and the position of the removed component.

4. Whenever electrical nets are created, deleted or changed, all electrical nets in the design are 
regenerated. Verify that the results of an electrical nets operation are what you expected by 
reading the messages in the Output Window.

Results
Are the results different from what you expected? Nets attached to the excluded component may still be 
part of an electrical net through other components.

Related Topics
Excluding Nets from Electrical Net Creation

Canceling Electrical Net Creation by Nets
You can cancel or prevent participating nets from creating an electrical net.

Procedure
1. In the workspace or Project Explorer, select the nets you want to remove from electrical nets.

2. Right-click and click the Properties  popup menu item.

3. In the Net Properties dialog box  on page 1487, in the Electrical Nets area, clear the Create 
electrical net check box. The selected nets are removed from existing electrical nets.
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Canceling Electrical Net Creation by Components

Tip
If you want to exclude the nets from electrical nets altogether, also clear the “Allow 
electrical net creation by components” check box.

4. Whenever electrical nets are created, deleted or changed, all electrical nets in the design are 
regenerated. Verify that the results of an electrical nets operation are what you expected by 
reading the messages in the Output Window.

Results
Are the results different from what you expected? Mixed-method restriction — nets that are also part of an 
electrical net by the component and/or the refdes prefix method remain part of an electrical net.

Related Topics
Conditions Governing Electrical Net Creation

Canceling Electrical Net Creation by 
Components
You can cancel or prevent components from creating an electrical net that passes through them.

Procedure
1. In the workspace or Project Explorer, select the components whose electrical net creation you want 

to cancel.

2. Right-click and click the Properties  popup menu item.

3. In the Component Properties Dialog Box, in the Electrical Nets area, clear the Create electrical net 
check box. Electrical net creation by the selected component is canceled.

Tip
If you want to exclude the components from electrical nets any method, also clear the 
“Allow electrical net creation by refdes prefix and nets” check box.

4. Whenever electrical nets are created, deleted or changed, all electrical nets in the design are 
regenerated. So you should always verify that the results of an electrical nets operation are what 
you expected by reading the messages in the Output Window.

Results
Are the results different from what you expected? Mixed-method restriction — nets that are attached 
to selected components, and are also part of electrical nets by the net and/or the refdes prefix method 
remain in the electrical net through the selected components.

Selecting Electrical Nets
Use the shortcut menu to select an electrical net.
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Procedure
1. In the workspace, select one of the nets in the electrical net you want to select.

2. Right-click and click the Select Electrical Net  popup menu item.

Creating a Matched Length Group of Electrical 
Nets
Gather electrical nets into a matched length group and apply rules to the group.

Procedure
1. Click the Setup  > Design Rules  menu item.

2. In the Rules Dialog Box, click Electrical Nets.

3. In the Electrical Net Rules Dialog Box, select the electrical nets you want to include in the matched 
length group, and click the HiSpeed  button.

4. Make appropriate settings in the HiSpeed Rules Dialog Box, and click OK.

Creating a Differential Pair of Electrical Nets
Add electrical nets into a differential pair and apply rules to the pair.

Procedure
1. Click the Setup  > Design Rules  menu item.

2. In the Rules Dialog Box, click Differential Pairs.

3. In the Differential Pairs Dialog Box, select the Electrical nets  tab.

4. Select the electrical nets to make up the diff pair:

a. Select the first electrical net from the Available list, and click the top Select  button.

b. Select the second electrical net from the Available list, and click the bottom Select  button.

5. Click Add.

6. Set the properties of the diff pair as appropriate, and click OK.

Creating or Modifying Electrical Net Design 
Rules
Set or modify electrical net design rules. By default, electrical nets have no rules.
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Clearing Electrical Net Rules

Procedure
1. You can assign rules to one or more electrical nets at a time. There are two ways to select the 

electrical net(s) before accessing the rule categories.

• Select electrical nets in the design:

i. In the design area, select one of the nets in the electrical net to which you want to apply 
rules. You can also use the Find dialog box to find nets and use wildcards in the Value field 
to filter the selection.

ii. Right-click and click the Select Electrical Net  popup menu item.

iii. Right-click and click the Show Rules  popup menu item.

• Select electrical nets from the list in the Electrical Net Rules dialog box:

i. Click the Setup  > Design Rules  menu item.

ii. In the Rules Dialog Box, click Electrical Nets.

iii. In the Electrical Net Rules Dialog Box, in the Electrical Nets box, click one or more electrical 
nets. To display all electrical nets, clear the Show Electrical Nets with Rules check box.

2. Click the HiSpeed  button.

3. In the HiSpeed Rules dialog box for electrical nets  on page 1405, specify Length and/or Matching 
rules for the selected electrical net(s).

Results
After you define rules, the HiSpeed Rules indicator (H) appears beside the selected electrical nets in the 
Electrical Nets list.

Clearing Electrical Net Rules
Select an electrical net and return its rules setup to the default. By default, electrical nets have no rules.

Procedure
1. Click the Setup  > Design Rules  menu item.

2. In the Rules Dialog Box, click Electrical Nets.

3. In the Electrical Net Rules Dialog Box, select one or more electrical nets in the Electrical Nets list, 
click Default, and then click Yes. The Default button is unavailable if the selected electrical net has 
no rules assigned to it. You know you have successfully reset the net rules if the HiSpeed Rules 
indicator (H) is removed, and the Default button is no longer available.

4. Close all rules dialog boxes to return to the design.
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Conditions Governing Electrical Net Creation
You can create electrical nets using one of three methods. To correctly maintain settings, avoid using a 
mixture of methods.

Settings That Control Electrical Net Creation
The following Net Properties dialog box  on page 1487 settings control the creation of electrical nets:

• Create electrical net check box  — creates electrical nets and is cleared by default for all nets.

• Allow electrical net creation by components check box  — allows the selected net to be 
added to an electrical net by other methods, and is selected by default for all nets. So by default, 
you can create an electrical net by any of the three methods.

The following Component Properties dialog box  on page 1191 settings control the creation of electrical 
nets:

• Create electrical net check box  — creates electrical nets, and is cleared by default for all 
components.

• Allow electrical net creation by refdes prefix and nets check box  — allows the selected 
component to be added to an electrical net by other methods, and is selected by default for 
components. So by default, you can create an electrical net by any of the three methods.

The following “Electrical Nets Dialog Box”  on page 1361 Refdes prefixes and settings control the creation 
of electrical nets:

• Maximum net count per electrical net value  — default value is 5.

• Maximum non-plane-net pin count value  — default value is 25. Virtual pins are not included in 
a net’s pin count.

Conditions Required for Electrical Net Creation
A discrete component and its attached nets become part of an electrical net only if the following 
conditions 1 and 2 are true:

1. The component and net properties are set so as to meet one of the following conditions:

◦ Component Properties “Create electrical net” check box is selected and neither attached net 
is excluded from electrical net creation. (A component or net is excluded from electrical net 
creation if its “Create electrical net” and “Allow electrical net creation...” check boxes are both 
cleared.)

◦ Net Properties “Create electrical net” check box is selected for both nets and the component 
is not excluded from electrical net creation (A component or net is excluded from electrical net 
creation if its “Create electrical net” and “Allow electrical net creation ...” check boxes are both 
cleared.)
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◦ Component “Allow electrical net creation...” check box is selected and no attached net is 
excluded from electrical net creation and the component’s refdes prefix is specified in the 
Electrical Nets dialog box. (A component or net is excluded from electrical net creation if its 
“Create electrical net” and “Allow electrical net creation...” check boxes are both cleared.)

2. The component, its nets, and the potential electrical net it will be a part of, conform to the 
“Maximum net count per electrical net” and “Maximum non-plane-net pin count” settings in the 
“Electrical Nets Dialog Box”  on page 1361.
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Chapter 17
Setting Options

Read the topics that follow to learn more about multi-step procedures for setting options in SailWind 
Layout.

Creating a Backup File
Setting the Display Grid
Setting the Design Grid
Setting Up a Polar Grid
DRC and the Via Stitching and Shielding Operations

Creating a Backup File
SailWind Layout automatically backs up your files based on the settings you choose.

Procedure
1. Click the Tools  > Options  menu item > Global  category > Backups subcategory  on page 1527.

2. In the Interval box, type the time in minutes between backups.

3. In the Number of Backups box, type the quantity (1-9) of different backup files to create. Backup 
files are named <design_name>#.pcb, where # is a sequential number. For example, Layout1.pcb, 
Layout2.pcb, and so on.

4. If you want to change the folder or name of the backup file, click Backup File. The Backup File 
dialog box appears. Browse to the folder, type the file name, and then click Save.

5. Select the “Use design name in backup file name” check box to use the design name instead of the 
product name as the file name. For example, preview_Layout1.pcb, preview_Layout2.pcb  instead 
of layout1.pcb, layout2.pcb.

6. Select the “Create backup files in design directory” check box to place all of your backup files in the 
same directory as the design. Clear the check box if you want your backup files in one, common 
backup directory.

Results
Table  74. Backup File Creation

If this is selected: The Backup File is Saved

Create backup files 
in design directory

Use design Name 
in backup file name

in one common directory without the design name.

X X in the design directory using the design name.

X in the design directory without the design name.
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Table  74. Backup File Creation  (continued)

If this is selected: The Backup File is Saved

X in one common directory using the design name.

Setting the Display Grid
You can set a visible dot grid in the design area to aid in component placement.

Procedure
1. Click the Tools  > Options  menu item > Grids and Snap category > Grids subcategory  on 

page 1537.

2. In the Display grid area, type a value for the X and Y values. You can set this grid to the same 
setting as the design grid or give it a different set of values like a multiple of the design grid. For 
example if your design grid is 5,5 mils, set the grid to 20,20. You will see the grid when using a 
higher magnification and can easily perceive the invisible grid locations between the dot grid.

Tip
The fastest and most convenient way to change this grid is to use the Modeless Command 
on page 83 instead of using the Options dialog box; type GD <x> <y> and press the Enter 
key. For example, GD 100 100.

Setting the Design Grid
Set the design grid for placement of components, traces and drafting objects.

Procedure
1. Click the Tools  > Optionsmenu item > Grids and Snap category > Grids subcategory  on 

page 1537.

2. In the Design grid area, type a value for the X and Y values. To improve routing, set the design grid 
to the minimum trace width + minimum trace to trace spacing or a multiple of this value.

Tip
The fastest and most convenient way to change this grid is to use the Modeless Command 
on page 83 instead of using the Options dialog box; type GR <x> <y> and press the Enter 
key. For example, GR 100 100. To set the design and via grid to the same setting, type G 
<x> <y> and press the Enter key.

Setting Up a Polar Grid
Before using Radial Move, set up a polar grid and the move options.
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DRC and the Via Stitching and Shielding Operations

Procedure
1. Click the Tools  > Options  menu item > Grids and Snap category > Grids subcategory  on 

page 1537.

2. Click Radial Move Setup.

3. In the Radial Move Setup Dialog Box,  on page 1652set up options and click OK. You can now 
use Radial Move.

Tip
Use the modeless command GP to make the polar grid visible in the design. You can click 
the Setup  > Set Origin  menu item to change the location of the polar grid origin, but you 
must Redraw to see the change.

Related Topics
Component Arrays

Moving Design Objects Radially

DRC and the Via Stitching and Shielding 
Operations
The Design Rule Checking setting determines how the Via Stitch and Add Via Shield operations can add 
vias.

The Design Rule Checking (On-line DRC  on page 1503) setting works with these operations in the 
following ways:

• Even when the DRC setting is Off, the Via Stitch and Add Via Shield operations do not add vias 
that violate clearance rules for pins, coppers, keepouts, texts, and board outline. However, the 
operations may create violations with traces if the DRC setting is Off.

• If the DRC setting is Prevent Errors, DRC prevents the via stitching and shielding operations from 
placing any via that violates design rules, including traces.

• If the DRC setting is Warn Errors, when the stitching and shielding operations place vias that 
violate design rules, DRC displays the warning “Clearance violations detected. Permit?”
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Chapter 18
Controlling Attributes

Read the topics that follow to learn more about creating, modifying, managing and using attributes in 
SailWind Layout.

Attributes
Attributes Workflow
Attribute Hierarchy
Passing Attributes
Attribute Dictionary
Creating Attributes for the Design
Modifying Design Attribute Properties
Deleting Design Attributes
Attribute Manager
Design Object Attributes

Attributes
You can use attributes  to associate information with an object in the design. Attributes are made of two 
parts: an attribute name and its corresponding value.

For example, you can create an IsSMD attribute to keep track of which parts are SMD and which are not.

You can assign attributes to the following objects:

• PCB (the board)

• Part Type

• Decal

• Part (component; instance of a part in the design)

• Net Class

• Net

• Pin, including jumper pin

• Via

Every attribute you add to a design is added to the Attribute Dictionary. Attributes are assigned for the 
entire design. Once you name an attribute and set its properties, that name and those properties apply 
throughout the design.
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Attributes Workflow
Create and manage attributes using a structured workflow.

This is the general process for adding attributes to a design:

1. Create attributes. You can create attributes using the Attribute Dictionary. You can also create 
attributes and assign them to objects using the Object Attributes Dialog Box; however, you cannot 
modify the properties of the attribute with this dialog box. Therefore, it is easier to create all your 
attributes in the Attribute Dictionary. Define the attribute properties. You must set the kind of value 
the attribute should have, the design objects to which you want to assign the attribute, and the 
hierarchy for the attribute. For more information, see the Creating Attributes for the Design  topic.

2. Assign attributes to objects in the design. For more information, see the Design Object Attributes 
topic.

3. You can assign attributes to multiple objects of multiple types. For more information, see the 
Attribute Manager  on page 392 topic.

4. When it is necessary to change the attributes assigned to objects use the Properties dialog 
boxes.

Attribute Hierarchy
The attribute hierarchy is the search order in which SailWind Layout searches the database to find an 
attribute value. You can assign attributes using the default hierarchy or you can change the hierarchy, 
creating your own search order. The lowest level to which you can assign an attribute is the PCB. An 
attribute applied to the PCB applies to every object on the board, unless you set an attribute at a higher 
hierarchy level. When you set an attribute at a higher level in the hierarchy, it overrides the PCB level.

The levels in the attribute hierarchy are object dependent, that is, each object has a different hierarchy. 
You can modify the hierarchy for every attribute using the Objects tab  on page 1111 on the Attribute 
Properties dialog box. The following table shows the attribute default hierarchy for each object type.

Table  75. Attribute Hierarchy

For Object Default Hierarchy is

PCB None. This is the lowest level. Attributes assigned at other levels in 
this hierarchy override attributes assigned at this level.

Part Type Part Type, PCB

Decal Decal, PCB

Part (Component) Part, Decal, Part Type, PCB

Net Class Net Class, PCB

Net Net, Net Class, PCB

Via Via, Net, Net Class, PCB
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Table  75. Attribute Hierarchy  (continued)

For Object Default Hierarchy is

Pin Pin, Net, Net Class, Part, Decal, Part Type, PCB

If you assign attributes to multiple levels and then delete an attribute, the attribute from the next level in 
the hierarchy is assumed. For example, if you assign an attribute at the Part Type level and at the PCB 
level, and you delete the attribute at the Part Type level, the attribute at the PCB level is then applied to 
the component.

Passing Attributes
You can pass attributes between SailWind Layout and other programs. SailWind Layout provides a 
default set of units (and unit prefixes) acceptable for input and for output among programs.

For more information, see Default Units.

Table  76. Passing Attributes to Other Programs

Program Attribute Passing

SailWind Logic You can pass the Value and Tolerance part type attributes in SailWind 
Logic forward to SailWind Layout as part of a netlist. SailWind Layout 
can accept the attributes from the netlist.

IDF The default attribute Geometry.Height is automatically exported 
to IDF. This attribute replaces the ZHEIGHT functionality used in 
previous versions of SailWind Layout.
For more information, see “Exporting IDF Files”.

BoardSim You can pass the default attributes Value, Tolerance, Voltage, and 
PowerGround to BoardSim.
For more information, see “Creating PADS HyperLynx BoardSim - 
HYP Files  on page  ”.
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Attribute Dictionary
Although you can add new attributes to design objects using the Object Attributes dialog box (select 
an object > right-click > Attribute  popup menu item), you must use the Attribute Dictionary to set the 
properties for attribute values.

It is recommended that you use the Attribute Dictionary to create new attributes for, or to edit and delete 
attributes in, your design. You can also use the Attribute Dictionary to assign attributes for the design, or 
remove attributes from objects.

Use the Attribute Dictionary to create attributes in a design. SailWind Layout provides default attributes 
that are applied to every new design. Although the attributes are provided, they are not assigned to any 
objects.

You can automatically load attributes for part types and decals from the current libraries into PCB designs 
using the Attribute Dictionary dialog box. You can load attributes when you open files or you can load the 
attributes after you open a file. When you load attributes, the following actions occur:

• The Attribute Dictionary is updated with new attributes

• Each new attribute uses the default hierarchy

• Attributes are added to the current part types and decals, as appropriate, in the open design

• ECO registration is turned on for all new attributes

• ECO commands are not stored in the ECO journal file for these updates

For more information, see the “Attribute Dictionary Dialog Box” topic.

Default and Other Attribute Properties and Usage
Modifying the Default Attribute Dictionary
Assignment of Attributes
Attribute Values
Attribute Types

Default and Other Attribute Properties and Usage
SailWind Layout provides default attributes that are available to every design. You can change the default 
attribute dictionary to match library attributes or to suit other design needs.

For more information, see the “Modifying Design Attribute Properties”  on page 389 and “Modifying the 
Default Attribute Dictionary”  on page 371 topics.

SailWind Layout also provides a default set of units (and unit prefixes) that are accepted as input and 
used as output. For more information, see Default Units.

CAUTION:
Do not edit the ASSEMBLY_OPTIONS attribute. SailWind Layout automatically maintains this 
attribute.
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Default Attribute Properties
Default attribute properties are defined and maintained in the design database.

In the following table column titles:

• S  — System

• H  — Hidden

• RO  — Read-only

Table  77. Default Attribute Properties

Attribute Type Objects ECO Hierarchy S H RO

Value Free Text* Part, Part 
Type

Yes Part, Part Type Yes No No

Tolerance Free Text* Part, Part 
Type

Yes Part, Part Type Yes No No

HyperLynx.Model Free Text* Part, Part 
Type

Yes Part, Part Type Yes No No

HyperLynx.Model 
File

Free Text* Part, Part 
Type

Yes Part, Part Type Yes No No

HyperLynx.Function Not supported by PADS HyperLynx. Values were: SIM_OUTSIM_BOTH and 
SIM_IN.

HyperLynx.Freque
ncy

Not supported by PADS HyperLynx

HyperLynx.Duty 
Cycle

Not supported by PADS HyperLynx

HyperLynx.Type Not supported by PADS HyperLynx. Values were: Clock, Strobe, Data Address, 
Power Supply, Analog High Speed, Analog Low Speed, Do Not Analyze.

HyperLynx.Default 
IC.Model

Not supported by PADS HyperLynx

HyperLynx.Default 
IC.Model File

Not supported by PADS HyperLynx

HyperLynx.Default 
IC.Model Pin

Not supported by PADS HyperLynx

Part Number Free Text* Part, Part 
Type

Yes Part, Part Type No No No

Description Free Text* Part, Part 
Type

Yes Part, Part Type No No No
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Table  77. Default Attribute Properties  (continued)

Attribute Type Objects ECO Hierarchy S H RO

Cost Free Text* Part, Part 
Type

Yes Part, Part Type No No No

Manufacturer #1 Free Text* Part, Part 
Type

Yes Part, Part Type No No No

Manufacturer #2 Free Text* Part, Part 
Type

Yes Part, Part Type No No No

DIE.xxx Free Text* Decal No Decal Yes Yes Yes

ASSEMBLY_OPTI
ONS

Free Text* PCB, Part Yes PCB Yes Yes Yes

PowerGround Yes/No Net, Net 
Class, PCB

Yes Net, Net Class Yes No No

Voltage Measure Net, Net 
Class

Yes Net, Net Class Yes No No

Geometry.Height Size/Dim. 
(Measure)

PCB, Part, 
Decal,Part 
Type

No Part, Decal Yes No No

• *  — Free Text attributes are not case-sensitive

Other Attribute Properties
An extensive list of other attribute properties are defined and maintained in the design database. In the 
following table column titles:.

• S  — System

• H  — Hidden

• RO  — Read-only

Table  78. Other Attribute Properties

Attribute Type Objects ECO Hierarchy S H RO

AutoDimensioning.Line_
Layer

Number PCB No PCB Yes No No

AutoDimensioning.Text_
Layer

Number PCB No PCB Yes No No

AutoDimensioning.Arc_
RadiusMode

Yes/No PCB No PCB Yes No No
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Table  78. Other Attribute Properties  (continued)

Attribute Type Objects ECO Hierarchy S H RO

AutoDimensioning.Mark
er_Shape

Yes/No
(each)

PCB No PCB Yes No No

AutoDimensioning.Mark
er_Size

Measure PCB No PCB Yes No No

AutoDimensioning.Mark
er_Width

Measure PCB No PCB Yes No No

AutoDimensioning.Arrow
_Shape

Number PCB No PCB Yes No No

AutoDimensioning.Arrow
_Length

Measure PCB No PCB Yes No No

AutoDimensioning.Arrow
_Size

Measure PCB No PCB Yes No No

AutoDimensioning.Arrow
_LineWidth

Measure PCB No PCB Yes No No

AutoDimensioning.Arrow
_TailLength

Measure PCB No PCB Yes No No

AutoDimensioning.Arrow
_TextGap

Measure PCB No PCB Yes No No

AutoDimensioning.Text_
Height

Measure PCB No PCB Yes No No

AutoDimensioning.Text_
Width

Measure PCB No PCB Yes No No

AutoDimensioning.Text_
Suffix

Free Text† PCB No PCB Yes No No

AutoDimensioning.Text_
NumberPrecision

Measure* PCB No PCB Yes No No

AutoDimensioning.Text_
AngularPrecision

Measure* PCB No PCB Yes No No

AutoDimensioning.Text_
DisplacementCase

Number PCB No PCB Yes No No

AutoDimensioning.Text_
DisplacementValue

Number PCB No PCB Yes No No

AutoDimensioning.Text_
DefaultOrientation

Number PCB No PCB Yes No No

AutoDimensioning.Text_
DefaultPosition

Number PCB No PCB Yes No No
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Table  78. Other Attribute Properties  (continued)

Attribute Type Objects ECO Hierarchy S H RO

AutoDimensioning.Text_
ManualMove

Yes/No PCB No PCB Yes No No

AutoDimensioning.Text_
NoGenerate

Yes/No PCB No PCB Yes No No

AutoDimensioning.Exten
sion_Draw1

Yes/No PCB No PCB Yes No No

AutoDimensioning.Exten
sion_Draw2

Yes/No PCB No PCB Yes No No

AutoDimensioning.Exten
sion_Width

Measure PCB No PCB Yes No No

AutoDimensioning.Exten
sion_PickPointGap

Measure PCB No PCB Yes No No

AutoDimensioning.Exten
sion_LineGap

Measure PCB No PCB Yes No No

AutoDimensioning.Previ
ew_Type

Number PCB No PCB Yes No No

DFT.Nail Count Per Net Number Net, Net 
Class, PCB

Yes Net, Net Class Yes No No

DFT.Nail Diameter Free Text† Pin, Via No Pin, Via Yes No No

DFT.Nail Number Free Text† Pin, Via No Pin, Via Yes No No

DFT.Generate Test 
Points

Yes/No PCB No PCB Yes Yes Yes

DFT.Probe to Trace 
Clearance

Size/Dim.(Me
asure)**

PCB No PCB Yes Yes Yes

DFT.Probe to Pad 
Clearance

Size/Dim.(Me
asure)**

PCB No PCB Yes Yes Yes

DFT.Allow Stubs Yes/No PCB No PCB Yes Yes Yes

DFT.Stub Length Size/Dim.(Me
asure)***

PCB No PCB Yes Yes Yes

DFT.Use Via Grid Yes/No PCB No PCB Yes Yes Yes

DFT.Grid X-Coordinate Size/Dim.(Me
asure)***

PCB No PCB Yes Yes Yes

DFT.Grid Y-Coordinate Size/Dim.(Me
asure)***

PCB No PCB Yes Yes Yes
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Table  78. Other Attribute Properties  (continued)

Attribute Type Objects ECO Hierarchy S H RO

Strategy.SplitPairs.Pass List**** PCB No PCB Yes Yes Yes

Strategy.SplitPairs.Prot
ect

Yes/No PCB No PCB Yes Yes Yes

Strategy.SplitPairs.Pa
use

Yes/No PCB No PCB Yes Yes Yes

Strategy.SplitPairs.Prior
ity

Number PCB No Net, Net Class, 
Part, PCB

Yes Yes Yes

Strategy.SplitPairs.Inten
sity

List***** PCB No PCB Yes Yes Yes

Strategy.Fanout.PlanePr
iority

Number PCB No PCB Yes Yes Yes

Strategy.Fanout.Pass List**** PCB No PCB Yes Yes Yes

Strategy.Fanout.Protect Yes/No PCB No PCB Yes Yes Yes

Strategy.Fanout.Pause Yes/No PCB No PCB Yes Yes Yes

Strategy.Fanout.Priority Number PCB No Net, Net Class, 
Part, PCB

Yes Yes Yes

Strategy.Fanout.Intens
ity

List***** PCB No PCB Yes Yes Yes

Strategy.Fanout.PlanePr
iority

Number PCB No PCB Yes Yes Yes

Strategy.Patterns.Pass List**** PCB No PCB Yes Yes Yes

Strategy.Patterns.Prot
ect

Yes/No PCB No PCB Yes Yes Yes

Strategy.Patterns.Pause Yes/No PCB No PCB Yes Yes Yes

Strategy.Patterns.Prior
ity

Number PCB No Net, Net Class, 
Part, PCB

Yes Yes Yes

Strategy.Patterns.Intens
ity

List***** PCB No PCB Yes Yes Yes

Strategy.Patterns.Plane
Priority

Number PCB No PCB Yes Yes Yes

Strategy.Route.Pass List**** PCB No PCB Yes Yes Yes

Strategy.Route.Protect Yes/No PCB No PCB Yes Yes Yes

Strategy.Route.Pause Yes/No PCB No PCB Yes Yes Yes
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Table  78. Other Attribute Properties  (continued)

Attribute Type Objects ECO Hierarchy S H RO

Strategy.Route.Priority Number PCB No Net, Net Class, 
Part, PCB

Yes Yes Yes

Strategy.Route.Intensity List***** PCB No PCB Yes Yes Yes

Strategy.Route.PlanePri
ority

Number PCB No PCB Yes Yes Yes

Strategy.Optimize.Pass List**** PCB No PCB Yes Yes Yes

Strategy.Optimize.Prot
ect

Yes/No PCB No PCB Yes Yes Yes

Strategy.Optimize.Pause Yes/No PCB No PCB Yes Yes Yes

Strategy.Optimize.Prior
ity

Number PCB No Net, Net Class, 
Part, PCB

Yes Yes Yes

Strategy.Optimize.Intens
ity

List***** PCB No PCB Yes Yes Yes

Strategy.Optimize.Plane
Priority

Number PCB No PCB Yes Yes Yes

Strategy.Miters.Pass List**** PCB No PCB Yes Yes Yes

Strategy.Miters.Protect Yes/No PCB No PCB Yes Yes Yes

Strategy.Miters.Pause Yes/No PCB No PCB Yes Yes Yes

Strategy.Miters.Priority Number PCB No Net, Net Class, 
Part, PCB

Yes Yes Yes

Strategy.Miters.Intensity List***** PCB No PCB Yes Yes Yes

Strategy.Miters.PlanePri
ority

Number PCB No PCB Yes Yes Yes

Strategy.TestPoint.Pass List**** PCB No PCB Yes Yes Yes

Strategy.TestPoint.Prot
ect

Yes/No PCB No PCB Yes Yes Yes

Strategy.TestPoint.Pa
use

Yes/No PCB No PCB Yes Yes Yes

Strategy.TestPoint.Prior
ity

Number PCB No Net, Net Class, 
Part, PCB

Yes Yes Yes

Strategy.TestPoint.Inten
sity

List***** PCB No PCB Yes Yes Yes
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Table  78. Other Attribute Properties  (continued)

Attribute Type Objects ECO Hierarchy S H RO

Strategy.TestPoint.Plane
Priority

Number PCB No PCB Yes Yes Yes

• †  — Free Text attributes are not case-sensitive

• *  — Dimensioning text number and text angular precision values range from 0 to 8.

• **  — DFT.Probe to trace and probe to pad clearance values range from 1 to 1000

• ***  — DFT.Stub length, grid x-coordinate, and grid y-coordinate values

• ****  — Strategy.XXX.Pass values shown in the following table are available for all 
Strategy.XXX.Pass attributes, where XXX is the name of the pass type for SailWind Router to 
perform: Split Pairs, Fanout, Patterns, Route, Optimize, Miters, and Test Point.

Table  79. Values for Strategy XXX Pas Attributes

Status Represents

Done Indicates SailWind Router completed this pass.

Yes Indicates SailWind Router should perform this pass.

No Indicates SailWind Router should not perform this pass.

• *****  — Strategy.XXX.Intensity values where XXX is the name of the pass type for SailWind 
Router to perform: Split Pairs, Fanout, Patterns, Route, Optimize, Miters, and Test Point.

Default Attribute Usage
Default attributes are used according to specific rules.

Table  80. Default Attribute Usage

Attribute Used For

Value Replaces the value attribute that is usually assigned to the 
part name on the schematic level. When you bring parts into a 
design, value is converted to the new attribute format.

Tolerance Replaces the tolerance attribute that is usually assigned to the 
part name on the schematic level. When you bring parts into a 
design, tolerance is converted to the new attribute format.

HyperLynx.Model In the .ref file that lists reference designators and 
corresponding model information, this attribute provides 
the model name. Used for PADS HyperLynx BoardSim 
simulations. When an IBIS model file (.ibs)  contains multiple 
component models, this attribute is necessary to specify 
which should be used.
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Table  80. Default Attribute Usage  (continued)

Attribute Used For

HyperLynx.Model File In the .ref file that lists reference designators and 
corresponding model information, this attribute provides the 
name of the IBIS model file (.ibs). Used for PADS HyperLynx 
BoardSim simulations.

HyperLynx.Function Not supported by PADS HyperLynx.

HyperLynx.Frequency Not supported by PADS HyperLynx.

HyperLynx.Duty Cycle Not supported by PADS HyperLynx.

HyperLynx.Type Not supported by PADS HyperLynx.

HyperLynx.Default IC.Model Not supported by PADS HyperLynx.

HyperLynx.Default IC.Model File Not supported by PADS HyperLynx.

HyperLynx.Default IC.Model Pin Not supported by PADS HyperLynx.

HyperLynx.Sim Direction Not supported by PADS HyperLynx.

Part Number Used for part ordering, accounting, and so on.

Description Describes the purpose of the part.

Cost Specifies the cost of the part.

Manufacturer #1 Specifies the primary manufacturer of the part.

Manufacturer #2 Specifies a secondary manufacturer of the part.

ASSEMBLY_OPTIONS Indicates whether the part is part of an assembly variant. 
Existing assembly variants are converted.

PowerGround Identifies nets as ground and power nets.

Voltage Describes the voltage of the net.

Geometry.Height Describes the part height (height above the PCB).

Other Attribute Usage
Other attributes are also used according to specific rules.

Table  81. Other Attribute Usage

Attribute Used For

AutoDimensioning.Line_Layer Indicates the layer on which the 
dimensioning lines appear.
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Table  81. Other Attribute Usage  (continued)

Attribute Used For

AutoDimensioning.Text_Layer Indicates the layer on which the 
dimensioning text appears.

AutoDimensioning.Arc_RadiusMode Indicates whether to measure a radius or 
a diameter when you dimension a circle.

AutoDimensioning.Marker_Shape Indicates the shapes of the alignment tool, 
horizontal, vertical, or diagonal crosshairs, 
and a square or circular bull's-eye.

AutoDimensioning.Marker_Size Indicates the size of the alignment tool.

AutoDimensioning.Marker_Width Indicates the line width of the alignment 
tool.

AutoDimensioning.Arrow_Shape Indicates whether to draw open arrows, 
closed arrows, or datum lines.

AutoDimensioning.Arrow_Length Indicates the length of the arrow.

AutoDimensioning.Arrow_Size Indicates the width (height) of the arrow.

AutoDimensioning.Arrow_LineWidth Indicates the line width of the tail and 
arrow lines.

AutoDimensioning.Arrow_TailLength Indicates the minimum length of the arrow 
tail.

AutoDimensioning.Arrow_TextGap Indicates the spacing between the tail and 
the measurement text.

AutoDimensioning.Text_Height Indicates the height of dimensioning text.

AutoDimensioning.Text_Width Indicates the width of one character in 
dimensioning text.

AutoDimensioning.Text_Suffix Indicates the suffix to appear after the 
dimensioning measurement.

AutoDimensioning.Text_NumberPrecision Indicates the number of decimal places, in 
mils, for linear measurements.

AutoDimensioning.Text_AngularPrecision Indicates the number of decimal places, in 
degrees, for angular measurements.

AutoDimensioning.Text_DisplacementCase Indicates the position of the dimensioning 
text.

AutoDimensioning.Text_DisplacementValue Indicates the custom position of the 
dimensioning text.

AutoDimensioning.Text_DefaultOrientation Indicates the orientation of the 
dimensioning text.
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Table  81. Other Attribute Usage  (continued)

Attribute Used For

AutoDimensioning.Text_DefaultPosition Indicates the position of the dimensioning 
text.

AutoDimensioning.Text_ManualMove Attaches the dimensioning text to the 
pointer when you add dimensions.

AutoDimensioning.Text_NoGenerate Creates only extension lines and arrows 
when you add dimensions.

AutoDimensioning.Extension_Draw1 Draws an extension line for the first point 
you select.

AutoDimensioning.Extension_Draw2 Draws an extension line for the second 
point you select.

AutoDimensioning.Extension_Width Indicates the width of the extension line.

AutoDimensioning.Extension_PickPointGap Indicates the gap between the selection 
point and the end of the extension line.

AutoDimensioning.Extension_LineGap Indicates the overhang of the line beyond 
the arrow.

AutoDimensioning.Preview_Type Indicates the contents of the preview 
window at various orientations depending 
on the current preference settings.

DFT.Nail Count Per Net Indicates the maximum number of test 
points on a net.

DFT.Nail Diameter Indicates the probe, or nail diameter, size 
for a test point.

DFT.Nail Number Indicates the ID of the probe in the test 
fixture.

DFT.Generate Test Points Indicates whether test points should be 
created.

DFT.Probe to Trace Clearance Indicates the minimum probe-to-trace 
clearance.

DFT.Probe to Pad Clearance Indicates the minimum probe-to-pad 
clearance.

DFT.Allow Stubs Indicates whether stubs should be 
created.

DFT.Stub Length Indicates the maximum stub length.

DFT.Use Via Grid Indicates whether to use the via grid when 
adding and placing test points.
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Table  81. Other Attribute Usage  (continued)

Attribute Used For

DFT.Grid X-Coordinate Indicates the via grid size along the X 
axis.

DFT.Grid Y-Coordinate Indicates the via grid size along the Y 
axis.

Strategy.SplitPairs.Pass Indicates whether SailWind Router should 
perform the split pairs pass and whether it 
is complete.

Strategy.SplitPairs.Protect Indicates whether SailWind Router should 
protect traces routed during the split pairs 
pass.

Strategy.SplitPairs.Pause Indicates whether SailWind Router should 
pause routing after completing the split 
pairs pass.

Strategy.SplitPairs.Priority Indicates the routing order of nets for the 
split pairs pass.

Strategy.SplitPairs.Intensity Indicates the intensity, or level of effort, for 
SailWind Router to use when performing 
the split pairs pass.

Strategy.Fanout.Pass Indicates whether SailWind Router should 
perform the fanout pass and whether it is 
complete.

Strategy.Fanout.Protect Indicates whether SailWind Router should 
protect traces routed during the fanout 
pass.

Strategy.Fanout.Pause Indicates whether SailWind Router should 
pause routing after completing the fanout 
pass.

Strategy.Fanout.Priority Indicates the routing order of nets for the 
fanout pass.

Strategy.Fanout.Intensity Indicates the intensity for SailWind Router 
to use when performing the fanout pass.

Strategy.Fanout.PlanePriority Indicates the routing order for plane nets 
for the fanout pass.

Strategy.Patterns.Pass Indicates whether SailWind Router should 
perform the patterns pass and whether it 
is complete.

Strategy.Patterns.Protect Indicates whether SailWind Router should 
protect traces routed during the patterns 
pass.
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Table  81. Other Attribute Usage  (continued)

Attribute Used For

Strategy.Patterns.Pause Indicates whether SailWind Router 
should pause routing after completing the 
patterns pass.

Strategy.Patterns.Priority Indicates the routing order of nets for the 
patterns pass.

Strategy.Patterns.Intensity Indicates the intensity for SailWind Router 
to use when performing the patterns pass.

Strategy.Patterns.PlanePriority Indicates the routing order for plane nets 
for the patterns pass.

Strategy.Route.Pass Indicates whether SailWind Router should 
perform the route pass and whether it is 
complete.

Strategy.Route.Protect Indicates whether SailWind Router should 
protect traces routed during the route 
pass.

Strategy.Route.Pause Indicates whether SailWind Router should 
pause routing after completing the route 
pass.

Strategy.Route.Priority Indicates the routing order of nets for the 
route pass.

Strategy.Route.Intensity Indicates the intensity for SailWind Router 
to use when performing the route pass.

Strategy.Route.PlanePriority Indicates the routing order for plane nets 
for the route pass.

Strategy.Optimize.Pass Indicates whether SailWind Router should 
perform the optimize pass and whether it 
is complete.

Strategy.Optimize.Protect Indicates whether SailWind Router should 
protect traces routed during the optimize 
pass.

Strategy.Optimize.Pause Indicates whether SailWind Router 
should pause routing after completing the 
optimize pass.

Strategy.Optimize.Priority Indicates the routing order of nets for the 
optimize pass.

Strategy.Optimize.Intensity Indicates the intensity for SailWind Router 
to use when performing the optimize pass.

Strategy.Optimize.PlanePriority Indicates the routing order for plane nets 
for the optimize pass.
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Table  81. Other Attribute Usage  (continued)

Attribute Used For

Strategy.Miters.Pass Indicates whether SailWind Router should 
perform the miters pass and whether it is 
complete.

Strategy.Miters.Protect Indicates whether SailWind Router should 
protect traces routed during the miters 
pass.

Strategy.Miters.Pause Indicates whether SailWind Router should 
pause routing after completing the miters 
pass.

Strategy.Miters.Priority Indicates the routing order of nets for the 
miters pass.

Strategy.Miters.Intensity Indicates the intensity for SailWind Router 
to use when performing the miters pass.

Strategy.Miters.PlanePriority Indicates the routing order for plane nets 
for the miters pass.

Strategy.TestPoint.Pass Indicates whether SailWind Router should 
perform the test point pass and whether it 
is complete.

Strategy.TestPoint.Protect Indicates whether SailWind Router should 
protect traces routed during the test point 
pass.

Strategy.TestPoint.Pause Indicates whether SailWind Router should 
pause routing after completing the test 
point pass.

Strategy.TestPoint.Priority Indicates the routing order of nets for the 
test point pass.

Strategy.TestPoint.Intensity Indicates the intensity for SailWind Router 
to use when performing the Test Point 
pass.

Strategy.TestPoint.PlanePriority Indicates the routing order for plane nets 
for the test point pass.

Modifying the Default Attribute Dictionary
You can edit the default attribute dictionary. You may want to change the default dictionary so it matches 
your library attributes.

The list of default attributes is stored in two ASCII files, both stored in the C:\<install_folder>\<version>
\Settings  folder.
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• Default.asc  — Used for new designs.

• DefaultAttributeDictionary.asc  — Used for older (pre-version 3.0) designs. If this file is not 
found, an attribute dictionary is not loaded with older designs.

The appropriate ASCII file automatically imports when you create a new file or import an older file. For 
more information, see “File Open Conversions” and “Attribute Dictionary Dialog Box”.

Prerequisites
Back up your Default.asc or DefaultAttributeDictionary.asc before you overwrite it.

Procedure
1. Click the File  > New  menu item.

2. If you want to edit the default attributes to use with older files, click the File  > Import  menu item 
and import the file DefaultAttributeDictionary.asc.

3. Click the Edit  > Attribute Dictionary  menu item.

4. Modify the existing attributes or add attributes as needed. For more information, see “Modifying 
Design Attribute Properties”.

5. Click OK  to close the dialog box.

6. To overwrite the existing file, click the File  > Export  menu item. Do this to change the default.asc 
or the DefaultAttributeDictionary.asc  files. If you want to create a new start-up file to use with only 
new files, go to Step 10.

7. Click ASCII  as the file type and click Save. The ASCII Output dialog box appears.

8. In the Sections list, select the Attributes check box.

9. Click OK. The default attribute dictionary is replaced.

10. To create a new start-up file, follow the steps described in Creating Start-up Files. Make sure you 
select the Attributes check box in the Start-up File Output dialog box. A new start-up file is created. 
You can use this start-up file with all new designs.

Assignment of Attributes
If you cannot select the object to which you want to assign an attribute, select the related object.

The following table defines the relationship of the objects. For more information, see “Applying an 
Attribute Value to All Other Objects”  on page 395 for assigning to the same object types and Attribute 
Manager  on page 392 topics to assign to multiple object types.

Table  82. Assignment of Attributes

Object What to Select

PCB Any object

Part Type A design component
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Table  82. Assignment of Attributes  (continued)

Object What to Select

Decal A design component

Part A design component

Jumper A Jumper

Pin A Pin

Net Class A net that is a member of the class

Net A Net

Via A Via
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Attribute Values
Attribute values can be 2047 characters long. You can use any printable character, including spaces, in 
an attribute value. You cannot, however, use a space as the first or last character in the value.

When you enter an attribute value, the exact value you type (in dialog boxes, ASCII files, or the library) is 
stored. This means that capitalization, leading and trailing zeros, embedded spaces, specific unit prefixes, 
and the presentation of the Yes/No value are all stored exactly as you type them. Leading and trailing 
spaces are not saved. Invalid values are not saved.

Exact values are saved for the following attribute types:

• Number

• Decimal umber

• Yes/No

• Measure

Exact values are not saved in the Attribute Dictionary entry for the List attribute type or when you set 
Limits for Number, Decimal Number, and Measure attribute types. For the Number attribute type, leading 
zeros are removed. For Decimal Number and Measure attribute types, leading zeros are removed, 
trailing zeros after the decimal point are removed, and numbers greater than 14 characters are rounded. 
Numbers with more than 14 zeros may be converted to scientific notation.

When using attribute values:

• Automation does not pass the exact attribute value for Yes/No, Number, or Decimal Number 
attribute types. Automation does, however, pass the exact attribute value for the Measure 
attribute type.

• Automation ignores whether an attribute is read only, system, or hidden. Therefore, Automation 
can change all attributes (properties, Attribute Dictionary entry, and value), regardless of their 
state.

Special Attribute Measurements
Number/Decimal Number Attribute Values and ECO
Exact Attribute Value Examples
List Exception
Measure, Geometry.Height (Size/Dimension) Attribute Exceptions
Default Units
Customizing Units for Attributes
.ini File Format for Units

Special Attribute Measurements
You can enter complex units like ounces/sq. foot for copper thickness; however, SailWind Layout does not 
input, process, or output prefixes for complex units.
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• Size/Dimension. SailWind Layout accepts as input, processes, and outputs Size/Dimension units 
using the values shown in the table below.

Table  83. Size and Dimension Measurements

Unit set on Global Tab 
(Options) Output Example Comment

Mils 12 mil 1 mil = 25.4*10-6 m

Metric 3 mm 1 mm = 1*10-3 m

Inches 2" 1" = 25.4*10-3 m

• Percentages. SailWind Layout accepts as input, processes, and outputs a percentage, like 10%, 
if you use the percent symbol (%).

Number/Decimal Number Attribute Values and ECO
SailWind Layout automatically converts attribute values for the Number, Decimal Number, or Measure 
type properties during the ECO process.

For example, a frequency value, if entered as 100 at the schematic or library, is converted to .1 kHz 
by default. Also, leading and trailing zeroes are truncated. For example, the decimal number 123.400 
becomes 123.4.

Although these conversions are correct, Compare Netlist and the ECO process, detect and report these 
conversions as differences. Therefore, a design populated with attributes could have thousands of 
warnings. To avoid this, do one of the following:

• Define attributes as Free Text type in the Attribute Dictionary. When you want to take advantage 
of the math functions in the Attribute Manager dialog box, go to the Attribute Dictionary and 
change the type to Number, Decimal Number, or Measure. Then, before performing a comparison 
or beginning an ECO, set the type back to Free Text.

• Use the Number, Decimal Number, or Measure types. Make sure the attributes are ECO-
registered and then perform a backward annotation. The values are converted in the design and 
backward annotated to the schematic. The schematic and PCB layout will now be synchronized.

Exact Attribute Value Examples
The exact value required for an attribute varies depending on the type of attribute, such as number, 
decimal, or measurement.

The following tables provide some specific examples of exact attribute values.

Table  84. Yes/No Examples

You Type V 3.5 and Higher Import 
and Export V 3.0 Imports and Exports

y Y Yes
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Table  84. Yes/No Examples  (continued)

You Type V 3.5 and Higher Import 
and Export V 3.0 Imports and Exports

NO NO No

true True Yes

1 1 Yes

Table  85. Number Examples

You Type V 3.5 and Higher Import 
and Export V 3.0 Imports and Exports

0001 0001 1

Table  86. Decimal Number Examples

You Type V 3.5 and Higher Import 
and Export V 3.0 Imports and Exports

0001.5 0001.5 1.5

0.123456789 0.123456789 0.123457

0.000001 0.000001 1E-006

1d3 1d3 1000

12.3e7 12.3e7 1.23E+008

121. 121. 121

1.230000 1.230000 1.23

Table  87. Measure Examples

You Type V 3.5 and Higher Import 
and Export V 3.0 Imports and Exports

10 10 10V

1000V 1000V 1kV

1e-5V 1e-5V 10uV

12 volt 12 volt 12V

7 MILLIVOLT 7 MILLIVOLT 7mV
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List Exception
Although SailWind Layout does not save exact List type values, it does change list entries to match the 
Attribute Dictionary entry.

For example, if the Attribute Dictionary entry for a list type attribute has Intel, IBM, and AMD as list 
choices, and you enter intel as a value, SailWind Layout changes the entry to Intel. The lowercase i is 
changed to uppercase. The following table lists exceptions for voltage measures.

Table  88. Measure, Voltage Attribute Exceptions

You Type
V 3.5 and higher 
Import and 
Export

V 3.0 Imports 
and Exports Comment

" 10V" "10V" "10V" Spaces before 10V are removed 
in both 3.0 and 3.5

 Note:
Quotation marks used only to 
show spaces

"10V " "10V" "10V" Spaces after 10V are removed in 
both version 3.0 and 3.5

 Note:
Quotation marks used only to 
show spaces

ten volt Invalid string. Input is ignored 
and no value is attached to the 
attribute.

Measure, Geometry.Height (Size/Dimension) Attribute 
Exceptions
If you do not specify a unit of measure for a Size/Dimension Measure type attribute, SailWind Layout 
does not save the exact value.

The value is not saved because a number in the attribute value without a unit creates confusion if you 
change the current units.

Table  89. Measure, Geometry Height Attribute Exceptions

V 4.0 and higher Input V 4.0 and higher Output for Current Units

String Current Units Mils Inches Metric (mm)

10 mils 10mil 0.01" 0.254mm

0.1 inches 100mil 0.1" 2.54mm

10 metric 39.37mil 0.3937" 10mm
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Tip
Using a non-standard format for your value might cause SailWind Layout to change the value 
even if you do not change the current units. For example entering a value of 0001.2000mil, 
causes SailWind Layout to change the value to 1.2mil.

Default Units
You can include a unit with an attribute value. SailWind Layout provides a default set of units (and unit 
prefixes) acceptable for input and for output.

SailWind Layout uses Systeme Internationale units, or SI units. Units are exported with attributes and are 
converted appropriately. User-defined units (dollar, yen, feet, pound, ounces/sq. foot, and so on) are not 
converted. Also, you cannot use prefixes with user-defined units.

The following units are supported, but are either enabled or disabled for actual use within SailWind 
Layout. To change the units that appear in this list, see Customizing Units for Attributes.

Tip
An extra comma (,) means that you can enter the abbreviation for the unit without a prefix. For 
example, you can enter O for Ohm in an attribute value; it is a valid value. You cannot, however, 
add F for Farad in an attribute value; it is not a valid value. You must use Farad with a prefix.

Supported Units
The following table lists units that are supported in SailWind Layout.

Table  90. Supported Units

Abbreviation Unit Enabled Allowed Prefixes Quantity

O Ohm Yes u,m,,k,M,G Resistance

F Farad Yes p,n,u,m Capacitance

H Henry Yes n,u,m Inductance

Hz Hertz Yes ,k,M,G Frequency

A Ampere Yes u,m,,k Electric current

V Volt Yes n,u,m,,k Voltage

W Watt Yes p,u,m,,k,M,G Power

s Second Yes p,n,u,m Time

g Gram No u,m,,k Mass

Wb Weber No p,n,u,m Magnetic flux
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Table  90. Supported Units  (continued)

Abbreviation Unit Enabled Allowed Prefixes Quantity

T Tesla No p,n,u,m,,k Magnetic flux 
density

C Coulomb No p,n,u,m Charge

S Siemens No n,u,m Electric conductance

J Joule No p,n,u,m,,k,M,G Energy

N Newton No u,m,,k Force

Pa Pascal No ,k,M Pressure

K Kelvin No u,m, Temperature

rad Radian No u,m, Plane angle

sr Steradian No u,m, Solid angle

cd Candela No u,m,,k Luminous intensity

lx Lux No u,m,,k Illumination

lm Lumen No u,m,,k Luminous flux

mol Mole No u,m,,k Amount of 
substance

Gy Gray No U,m,,k Absorbed dose

Bq Becquerel No U,m,,k Activity

Sv Sievert No U,m,,k Dose equivalent

m Meter No P,n,u,m,,k Distance

l Liter No U,m, Liquid

Unit Prefixes
As shown below, each prefix has a symbol and is a power of ten. You cannot use prefixes with user-
defined units, such as dollar, yen, feet, pound, and so on.

Tip
SailWind Layout never exports the prefixes h, da, d, and c.
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Table  91. Unit Prefixes

Symbol Prefix Power of Ten

Y Yotta +24

Z Zetta +21

E Exa +18

P Peta +15

T Tera +12

G Giga +9

M Mega +6

k kilo +3

h hecto +2

da deca +1

d deci -1

c centi -2

m milli -3

u micro -6

n nano -9

p pico -12

f fempto -15

a atto -18

z zepto -21

y yocto -24

Customizing Units for Attributes
In addition to the standard attributes, you can add and modify custom attributes to a design to meet your 
own specialized requirements.

Procedure
1. Navigate to the C:\<install_folder>\<version>\Programs  folder.

2. Open the SailWindpcb.ini  file in a text editor, such as Notepad.
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.ini File Format for Units

3. Add a new attribute unit section by typing the header [SI Units].

4. Make modifications as required:

a. To Enable Units:

i. To enable units, delete the “ignore;” variable from the line. For example, the line for the 
Gram unit reads:

Gram=ignore;u,m,,k

ii. Modify the line so it reads:

Gram=u,m,,k

b. To Disable Units:

i. To disable units, add the “ignore;” variable to the line. For example, the line for the Farad 
unit reads:

Farad=p,n,u,m

ii. Modify the line so it reads:

Farad=ignore;p,n,u,m

iii. It is recommended that you leave the unit prefixes intact even when disabling the unit. This 
makes it easier to enable the unit later because you will not have to specify prefixes again.

5. Save the SailWindpcb.ini  file.

Related Topics
.ini File Format for Units

.ini File Format for Units
Specify units in the [SI Units] section of the .ini  file.

Use the following format:

<full unit name>=[ignore;][input:<prefix list>;][output:<prefix list>]

Table  92. where:

<full unit name> Specifies the name of the unit.

[ignore;] Specifies whether to ignore the unit. If this variable is included, 
the unit is ignored. To enable the unit remove this variable.
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Table  92. where:  (continued)

[input:<prefix list>;] Specifies that you are creating a list of prefixes that are valid 
for input into SailWind Layout.

[output:<prefix list>] Specifies that you are creating a list of prefixes that are valid 
for output from SailWind Layout.

Tip
You can list the valid prefixes after the equal sign (=) and those prefixes are used for both input 
and output.

382 SailWind Layout Guide and Reference



 
Controlling Attributes

Attribute Types

Attribute Types
You can assign many types of attributes to the objects in your designs, including the free-text type, the 
yes/no type, and the list type.

The Free Text Attribute Type
The Yes/No Attribute Type
The List Attribute Type
The Measure Attribute Type
Creating a Number or Decimal Number Type Attribute

The Free Text Attribute Type
You can select the Free Text attribute type to use any text as the attribute value. This is the default. Free 
text is not “intelligent,” meaning you can type the name of the net as an attribute, but renaming the net 
does not update the attribute.

With the Free Text type you can select the Case-sensitive parameter to preserve the letter case of Free 
Text entries. This setting affects sorting and matching in the Find Dialog Box  and the Attribute Manager 
Dialog Box.

The Yes/No Attribute Type
You can select the Yes/No attribute type to create a list where you can select “Yes” or “No” as the attribute 
value.
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The List Attribute Type
The List attribute type allows you to create a list from which to choose the value.

Creating a List Type Attribute
Deletion of List Entries

Creating a List Type Attribute
You can create a list of entries as options for the attribute value. For example, you can create a list of all 
of your part manufacturers that is used every time you assign the attribute.

Procedure
1. Click the Edit  > Attribute Dictionary  menu item.

2. In the Attribute Dictionary Dialog Box, click New.

3. In the Attribute Properties dialog box  on page 1115, type the name of the new attribute to create in 
the Attribute text box.

Tip
Attribute names can be 255 characters long. You can use any printable character, including 
spaces, in an attribute name. A space, however, cannot be the first or last character, or the 
character after a dot in the attribute name (for example, xxx. xxx is illegal). Attribute names 
are not case sensitive, and they are defined for the entire design, not per object.

4. On the Types  tab, select the List Type.

5. Type an attribute value in the List box and click Set  to add the item to the list. Repeat as 
necessary.

6. You can select the Case-sensitive check box to preserve the letter case of List entries. This setting 
affects sorting and matching in the Find Dialog Box  and the Attribute Manager Dialog Box.

7. On the Objects tab  on page 1111, assign settings and hierarchy to the objects to which you want 
to apply the attribute.

8. Click OK  to close the Attribute Properties dialog box.

9. Click Close  to close the Attribute Dictionary dialog box.

Results
The List box contains the items you entered as possible values for attributes. The items in the list appear 
as a list from which you can click a value in the Object Attributes or Attribute Manager dialog boxes.

Deletion of List Entries
Click Clear  or Clear All  to delete an attribute item or items from a list.
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Deletion of List Entries

Procedure
1. Click the Edit  > Attribute Dictionary  menu item.

2. In the Attribute Dictionary Dialog Box, select an attribute that contains a List item that you would 
like to delete.

3. Click the Properties  button.

4. On the Types  tab, select the item(s) that you wish to delete from the list box.

5. Click the Clear  or Clear All  button to delete the item(s) from the list.

6. Click OK  to close the Attribute Properties dialog box and return to the Attributes Dictionary dialog 
box.

7. Click Close  to close the Attribute Dictionary dialog box.
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The Measure Attribute Type
A Measure attribute type  is a physical value associated with units. It allows you to determine a 
measurement for the attribute value.

Creating a Measure Type Attribute
Deleting a Set of Units

Creating a Measure Type Attribute
You can select the Measure attribute type to set measurement parameters for the attribute value. It is a 
physical value associated with units.

You can set up the unit of measurement and set a minimum and maximum for the value. You can click 
a unit of measure from the predefined list or you can add a new unit to the list. You can also customize 
units  on page 380. You can either use an existing measurement unit or add a new measurement unit to 
the design.

Attribute values for the Measure type properties are automatically converted during the ECO process.

Procedure
1. Click the Edit  > Attribute Dictionary  menu item.

2. In the Attribute Dictionary Dialog Box, click New.

3. In the Attribute Properties dialog box  on page 1115, type the name of the new attribute to create in 
the Attribute text box.

Tip
Attribute names can be 255 characters long. You can use any printable character, including 
spaces, in an attribute name. A space, however, cannot be the first or last character, or the 
character after a dot in the attribute name (for example, xxx. xxx is illegal). Attribute names 
are not case sensitive, and they are defined for the entire design, not per object.

4. On the Types  tab, select the Measure type and perform one of the following:

• In the Measure list, select an existing measurement unit. The abbreviation appears in the Abbr 
box, the unit in the Unit box, and the measure or quantity in the Quantity box.

• Enter the details for a new measurement unit.

i. In the Abbr box, type the abbreviation to use for the unit.

ii. In the Unit box, type the name of the unit.

Note:
If you use the unit Mil, assign the attribute at the board level. Otherwise the unit will 
not change when you change units for the design (using the Options dialog box > 
Global  category > General subcategory  on page 1531.
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Deleting a Set of Units

iii. In the Quantity box, type the quantity, or what it measures.

iv. Click Set  to add the item to the list.

v. In the Limits area, type a minimum value in the Min box and/or a maximum value in the Max 
box. SailWind Layout checks against the Limits area values. If an attribute has the Number, 
Decimal Number, or Measure type property, SailWind Layout checks the attribute value 
against this property. Leading zeros are removed, trailing zeros after the decimal point are 
removed, and numbers greater than 6 characters are rounded.

5. On the Objects tab  on page 1111, assign settings and hierarchy to the objects to which you want 
to apply the attribute.

6. Click OK  to close the Attribute Properties dialog box.

The new Attribute is added to the Attribute Dictionary with the measurement values that you 
assigned.

Deleting a Set of Units
You can delete a set of measurement units from an attribute.

Procedure
1. Click the Edit  > Attribute Dictionary  menu item.

2. In the Attribute Dictionary Dialog Box, select an attribute that contains a measurement item that 
you would like to delete.

3. Click the Properties  button.

4. On the Types  tab, the currently assigned measurement unit will be selected.

Tip
You can clear the measurement unit or assign a new set of values in the Abbr:, Unit: and 
Quantity: boxes.

5. Click Clearor Clear User  to delete an item or all user items from the list. Clear User  deletes only 
user-defined units from the list.

6. The default units remain in the list.

7. Select a new measurement unit from the list or type in a new measurement unit in the Abbr:, Unit: 
and Quantity: boxes.

Tip
You must specify a measurement for the attribute in order to save it and close the Attribute 
Properties dialog.
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8. Click OK  to close the Attribute Properties dialog box and return to the Attributes Dictionary dialog 
box.

9. Click Close  to close the Attribute Dictionary dialog box.

Related Topics
Default Units

Customizing Units for Attributes

Creating a Number or Decimal Number Type Attribute
You can type an integer number (Number) or a number with decimal or floating point numbers (Decimal 
Number) for the attribute value. SailWind Layout automatically converts attribute values for the Number or 
Decimal Number type properties during the ECO process.

Restrictions and Limitations
These are the valid ranges that are recognized:

• Number  — You can type any number between -232 and 232 -1. Leading zeros are removed. 
Numbers with more than 6 zeros may be converted to scientific notation.

• Decimal Number  — You can type any number between 1.7E +/- 308. Leading zeros are 
removed, trailing zeros after the decimal point are removed, and numbers greater than 6 
characters are rounded.

Procedure
1. Click the Edit  > Attribute Dictionary  menu item.

2. In the Attribute Dictionary Dialog Box, click New.

3. In the Attribute Properties dialog box  on page 1115, type the name of the new attribute to create in 
the Attribute text box.

Tip
Attribute names can be 255 characters long. You can use any printable character, including 
spaces, in an attribute name. A space, however, cannot be the first or last character, or the 
character after a dot in the attribute name (for example, xxx. xxx is illegal). Attribute names 
are not case sensitive, and they are defined for the entire design, not per object.

4. Click the Properties  button.

5. On the Types  tab, select the Number or Decimal number type.

6. Type a minimum value in the Min box and/or a maximum value in the Max box.

7. SailWind Layout checks against the Limits area values. If an attribute has the Number, Decimal 
Number, or Measure type property, SailWind Layout checks the attribute value against this 
property.
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Creating Attributes for the Design

8. On the Objects tab  on page 1111, assign settings and hierarchy to the objects to which you want 
to apply the attribute.

9. Click OK  to accept the limits and close the Attribute Properties dialog box.

10. Click Close  to close the Attribute Dictionary dialog box.

11. For more information, see “Number/Decimal Number Attribute Values and ECO”.

Creating Attributes for the Design
SailWind Layout provides default attributes to apply to every new design you create. Although SailWind 
Layout provides attributes, it does not assign them to any objects.

For more information, see “Default and Other Attribute Properties and Usage”.

Procedure
1. Click the Edit  > Attribute Dictionary  menu item.

2. In the Attribute Dictionary Dialog Box, click New.

3. In the Attribute Properties dialog box  on page 1115, type the name of the new attribute to create in 
the Attribute text box.

Tip
Attribute names can be 255 characters long. You can use any printable character, including 
spaces, in an attribute name. A space, however, cannot be the first or last character, or the 
character after a dot in the attribute name (for example, xxx. xxx is illegal). Attribute names 
are not case sensitive, and they are defined for the entire design, not per object.

4. On the Types  tab, assign a type to the attribute and assign settings to the type if applicable. The 
default type is Free Text.

5. On the Objects tab  on page 1111, assign settings and hierarchy to the objects to which you want 
to apply the attribute.

6. When you finish setting attribute properties, click OK  to return to the Attribute Dictionary dialog 
box.

7. Click Close.

Modifying Design Attribute Properties
Use the Attribute Dictionary to modify design attribute properties.

Prerequisites
If an attribute is ECO-Registered, you must be in ECO mode to modify the attribute.
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Procedure
1. Click the Edit  > Attribute Dictionary  menu item.

2. In the Attribute Dictionary Dialog Box, click the attribute to modify from the list. Default attributes 
and the design attributes are listed. You can select an attribute group  on page 1811 from the 
Group list to filter the view and display only a select group of attributes. Attributes are grouped if 
they are structured attributes  on page 1862.

Tip
If you select the Show Hidden check box, you can view attribute groups that have no 
visible attributes. You set whether an attribute is hidden on the Objects  tab of the Attribute 
Properties dialog box.

CAUTION:
You can modify the default attributes; however, it is not recommended.

3. Click Properties.

4. In the Attribute Properties dialog box,  on page 1115 click the Types  tab, and click the type for the 
attribute.

CAUTION:
If you use the design unit Mil, assign the attribute at the board level, otherwise the unit will 
not change when you change units for the design (using the Options dialog box > Global 
category > General subcategory  on page 1531).

5. Click the Objects tab  on page 1111, and click the objects you want to restrict. You cannot 
assign the attribute to a restricted object. For example, if you are defining the properties for a 
Manufacturer attribute, you may want to restrict nets so they cannot have this attribute. Therefore, 
you would disable the Net object for the Manufacturer attribute.

6. To use the default hierarchy, click the Use Default Hierarchy check box. If you choose not to 
use the default hierarchy, you can modify it. Modifying the hierarchy is considered an advanced 
procedure.

7. If you want to enable ECO Registration  on page 1824 of the attribute, click the ECO Registered 
check box. If you enable ECO Registration, changes made to the attributes are recorded in the 
ECO file. Enabling ECO Registration also restricts you to modifying attributes while the ECO 
Toolbar is active (ECO mode).

8. Click OK  when you finish setting attribute properties to return to the Attribute Dictionary dialog box.

9. Click Close.

Deleting Design Attributes
Use the Attribute Dictionary to delete attributes in your design. If you delete a decal attribute, any labels 
associated with it now associate with non-decal attributes.
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Deleting Design Attributes

Procedure
1. Click the Edit  > Attribute Dictionary  menu item.

2. In the Attribute Dictionary dialog box,  on page 1107click the attribute to delete from the list. You 
can select an attribute group  on page 1811 from the Group list to filter the view and display only 
a select group of attributes. Attributes are grouped if they are structured attributes  on page 1862. 
Clear the Show Hidden check box to filter the list to show only attribute groups that contain at least 
one visible attribute.

CAUTION:
You can delete the default attributes; however, it is not recommended. Because the default 
attributes are only provided for your design and not assigned to objects, you do not need to 
delete these attributes.

3. Click Delete. If you select a hidden attribute, this button is unavailable. The message “Are you sure 
you want to delete attribute type XXX?” appears.

4. Click Yes  to delete the attribute.
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Attribute Manager
Use the Attribute Manager to view a spreadsheet of all of the attributes on all objects in the design.

You can use the Attribute Manager to add, edit, and delete attribute values on multiple object types. You 
can also create value summaries of an attribute that is based on every value of the attribute assigned to 
objects of the same type. In other words, summaries are applied per attribute and apply to all objects on 
the same tab.

CAUTION:
Hidden attributes are not available to the Attribute Manager and are not listed in the Show 
Attributes dialog box.

Note:
Rows in the multi-column list are unavailable if the attribute is read-only  on page 1853. Rows are 
also unavailable if the attribute is ECO-registered  on page 1824 and SailWind Layout is not in 
ECO mode  on page 1824. Hidden attributes do not appear in the list. All objects appear in the 
multi-column list, regardless of whether they have attributes assigned to them. Objects that do not 
have attributes assigned to them have <none> in the cell under the attribute name. Objects that 
have attributes assigned to them, but not values, have blank cells under the attribute name.

Tip
You can avoid DRC violations or shorts by placing attributes on Documentation layers if used 
in the design. If an attribute is displayed in the design, and placed on an Electrical layer it will 
show up as copper in the manufacturing documents. Place free text and attribute values on the 
Silkscreen Top layer or another documentation layer.

Listing Design Objects
Selecting Attributes to List in the Attribute Manager
Adding Attribute Values to Design Objects With the Attribute Manager
Modifying Attribute Values Using the Attribute Manager
Deleting Attribute Values
Applying an Attribute Value to All Other Objects
Creating a Summary

Listing Design Objects
The multi-column list of the Attribute Manager catalogs design objects and the attributes assigned to 
them. Objects appear in the left column and their attribute names appear in the column headers.

Procedure
1. Click the Edit  > Attribute Manager  menu item.

2. In the Attribute Manager Dialog Box  in the View area, click a view option:
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Selecting Attributes to List in the Attribute Manager

• Selected  — Lists attributes from the objects selected in the design. If you select objects in the 
design and then open the Attribute Manager, selected objects appear on their appropriate tab. If 
you do not select objects of a certain type, the tab is unavailable. To view other objects, use the 
Filter.

• Filter  — Lists attributes from all of the objects in your design. This view option allows you to 
view attributes assigned to non-selectable objects, such as Decals and Part Types. When using 
the filter, type the first characters of the objects to view, type an asterisk (*) after the character, 
and then click Apply Filter. The objects appear on the appropriate tab in the multi-column list.

Selecting Attributes to List in the Attribute Manager
Use the Show Attributes dialog box to select attributes to list in the multi-column list of the Attribute 
Manager.

Procedure
1. Click the Edit  > Attribute Manager  menu item.

2. In the Attribute Manager Dialog Box, click Show.

3. In the “Show Attributes Dialog Box”  on page 1720, select an attribute group in the Group list or 
<all> for all attributes. Use the Group list to filter the Attributes list. You can choose an attribute 
group  on page 1811 to view.

4. In the Attributes list, select the check box next to the attribute name to view the attribute in the 
Attribute Manager dialog box.

Tip
You can use the Select All  or Unselect All  buttons to select all or clear all check boxes.

Adding Attribute Values to Design Objects With the 
Attribute Manager
In the Attribute Manager, you can add an attribute and value to one or more objects that do not already 
have the attribute assigned to it. You can add values to cells with “<none>” in it, which means the attribute 
is available to the design but you have not already assigned it to an object.

You can add attribute values to a design object only for attributes that are available to the design. To 
create a new attribute for use with design objects, see “Creating Attributes for the Design”. You can 
include a unit with the value. SailWind Layout also provides a default set of units (and unit prefixes) that 
are accepted as input and used as output. For more information, see “Default Units”.

Restrictions and Limitations
You cannot add a hidden attribute, read-only attribute  on page 1853, or ECO-registered attribute  on 
page 1824 while not in ECO mode  on page 1824.
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Procedure
1. Click the Edit  > Attribute Manager  menu item.

2. In the Attribute Manager Dialog Box, select a cell with <none> in it.

3. Click Add.

4. Type a value in the cell and press the Enter key.

Tip
You can only add attribute values to a design object for attributes that are available to the 
design. To create a new attribute for use with design objects, see “Creating Attributes for 
the Design”. You can include a unit with the value. SailWind Layout also provides a default 
set of units (and unit prefixes) that are accepted as input and used as output. For more 
information, see “Default Units”.

Modifying Attribute Values Using the Attribute 
Manager
In the Attribute Manager, you can edit blank attribute value cells or cells with a value. If a cell is blank, it 
means that the assigned attribute has no value.

Restrictions and Limitations
You cannot edit a read-only attribute  on page 1853, or an ECO-registered attribute  on page 1824 while 
not in ECO mode  on page 1824.

Procedure
1. Click the Edit  > Attribute Manager  menu item.

2. In the Attribute Manager Dialog Box, select a blank cell or a cell with a value.

3. Click Edit.

4. Type a value in the cell and press the Enter key.

Tip
You can include a unit with the value. SailWind Layout also provides a default set of units 
(and unit prefixes) that are accepted as input and used as output. For more information, 
see “Default Units”.

Deleting Attribute Values
In the Attribute Manager, you can delete an attribute and value from a design object.
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Applying an Attribute Value to All Other Objects

CAUTION:
You cannot delete a read-only attribute  on page 1853, or an ECO-registered attribute  on 
page 1824 while not in ECO mode  on page 1824.

Procedure
1. Click the Edit  > Attribute Manager  menu item.

2. In the Attribute Manager Dialog Box, select a cell with a value.

3. Click Delete. The message “Are you sure you want to delete attribute value <attribute name>: 
<attribute value>?” appears.

4. Click Yes  to delete the value.

The attribute and value are removed from the object and the cell value is <none>.

Applying an Attribute Value to All Other Objects
In the Attribute Manager, you can apply an attribute value from one object to all other objects of the same 
type. In other words, you can set the same attribute value for all objects of the same type. Any existing 
values remain unchanged.

Procedure
1. Click the Edit  > Attribute Manager  menu item.

2. In the Attribute Manager Dialog Box, click the cell whose attribute value you want to apply to the 
other objects on the tab.

3. Click Fill Column. The “Are you sure you want to fill <name of attribute> for all objects by 
<selected value>?” message appears.

4. Click Yes  to apply the value. The attribute and its value are applied to the other cells in that 
column, except for Summary cells.

Creating a Summary
Create and modify attribute summaries that are based on every value of the attribute assigned to objects 
of the same type. In other words, summaries apply per attribute and are summed up from all objects in 
the same tab of the multi-column list. You can also change the summary type. The summaries appear at 
the bottom of attribute columns.

Restrictions and Limitations

• Summaries are only available for Number, Decimal Number, and Measure attribute types. The 
type is an attribute property. For more information, see “Attribute Types”.

• Hidden attributes are not available to the Attribute Manager and are not listed in the Show 
Attributes dialog box.
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Procedure
1. Click the Edit  > Attribute Manager  menu item.

2. In the Attribute Manager Dialog Box, click Show.

Note:
An attribute must be selected for viewing in the Attribute Manager. See “Selecting 
Attributes to List in the Attribute Manager” for more information.

3. In the “Show Attributes Dialog Box”  on page 1720 select an attribute in the Attributes list.

4. Select the check boxes for the summary types you want to create for each attribute type.

5. Click OK  to return to the Attribute Manager dialog box. The summary you created appears in the 
last two rows of the multi-column list. If you enabled more than one summary, the second summary 
appears in the two rows following the first summary.

6. You can create summaries or edit the summary types for other attribute columns without going into 
the Show Attributes dialog box. In another qualified attribute column (Number, Decimal Number, 
and Measure attribute types), double-click in the cell of the first summary row (used for the title of 
the summary type).

7. Choose a summary from the list, and press the Enter key. The new summary information appears.
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Design Object Attributes

Design Object Attributes
Use the resizable Object Attributes dialog box to add, modify, or remove attributes of single objects or 
multiple objects of the same type.

CAUTION:
Rows in the multicolumn list are unavailable if the attribute is read-only  on page 1853. Rows are 
also unavailable if the attribute is ECO-registered  on page 1824 and SailWind Layout is not in 
ECO mode.

Note:
You can avoid DRC violations or shorts by placing attributes on Documentation layers if used 
in the design. If an attribute is displayed in the design, and placed on an Electrical layer it will 
show up as copper in the manufacturing documents. Place free text and attribute values on the 
Silkscreen Top layer or another documentation layer.

Assigning Attributes to Design Objects With the Object Attributes Dialog
Modifying Attribute Values
Removing Attributes
Removing Attribute Values
Adding Height Information to Design Components and Jumpers
Adding an Attribute to All Objects in the Design

Assigning Attributes to Design Objects With the 
Object Attributes Dialog
You can assign attributes to an object or objects of the same type using the Object Attributes dialog box.

For example, you can select multiple parts and assign attributes, but you cannot select parts and vias 
and assign attributes. The Object Attribute dialog box only shows attributes that apply to the objects you 
select.

Procedure
1. Select the object(s) to which you want to assign an attribute. You can only select objects of the 

same type.

2. Right-click and click the Attribute  popup menu item. The “Object Attributes Dialog Box”  on 
page 1496 opens. For more information, see “Assigning Attributes to Design Objects With the 
Object Attributes Dialog”.

3. From the Groups list click an attribute group  on page 1811 to view. If you assign multiple attributes 
and some of those are structured attributes  on page 1862, this list acts as a filter and allows you to 
choose the attribute group to view.

4. From the Attributes For list, select the attribute hierarchy level for which you want to assign an 
attribute. The hierarchy levels change, depending on the object you selected in step 1. For more 
information, see “Attribute Hierarchy”.
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Note:
You cannot select a hierarchy level if you have multiple objects selected. The attribute 
is assigned at the current level; for example, if you select multiple parts, attributes are 
assigned at the Component level.

5. Click Add. A new, blank attribute line appears in the Attribute list. The pointer appears in the blank 
cell in the Attribute column. This cell is also a list that contains the attributes that apply to the 
object type you selected in step 1. This list is based on entries in the Attribute Dictionary. For more 
information, see “Attribute Dictionary”.

6. Click an attribute from the Attribute list, or type the name of a new attribute in the blank cell. You 
cannot add a hidden or read-only  on page 1853 attribute. Lists the name of the attribute. Attributes 
names can be 255 characters long. You can use any printable character, including spaces, in 
an attribute name. A space, however, cannot be the first or last character in the attribute name. 
Attribute names are not case sensitive, and they are defined for the entire design, not per object.

Tip
When you add a new attribute to the design, it is also added to the Attribute Dictionary.

7. Double-click in the blank cell in the Value column (next to the attribute you just added). Assign 
the value for the attribute. You can include a unit with the value. SailWind Layout also provides a 
default set of units (and unit prefixes) that are accepted as input and used as output. The Level 
column lists the hierarchy level where the attribute is assigned. In other words, the attribute is 
inherited from the level that appears in this column. It takes its value from the Attributes For list. 
For more information, see “Default Units”.

Tip
If you use the design unit Mil, assign the attribute at the board level. Otherwise the unit 
will not change when you change units for the design (using the Global  tab of the Options 
dialog box).

8. Click Close  to close the Object Attributes dialog box.

Tip
You can add the same attribute multiple times, as long as you add it to different levels of 
the attribute hierarchy.

Related Topics
Creating Attributes for the Design

Control of Solder Mask and Paste Mask

Modifying Attribute Values
You can modify the attribute values of an object or objects of the same type using the Object Attributes 
dialog box. When you select multiple objects to modify attributes, the Attributes list displays the union of 
all attribute names.
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Modifying Attribute Values

In other words, the Attributes list displays the attributes that belong to all of the selected objects. When 
you add an attribute, you add it to all selected objects, and when you delete a value, you delete it from 
all objects with that attribute. You can edit the value of a selected attribute if the current level defines the 
attribute.

For example, if the text in the “Level” column matches the text in the “Attribute For” list, you can edit the 
value. If the current level does not define the attribute (the text in the Level column does not match the 
text in the Attributes For list), SailWind Layout adds a new attribute for the current level that matches the 
attribute you want to edit. You can then edit the value in the new attribute. You cannot edit the name of an 
attribute. You can either delete the attribute entirely, using the Attribute Dictionary  on page 355, or add a 
new attribute with the correct attribute name.

Procedure
1. If the attribute is ECO-registered  on page 1824, enter ECO mode. To enter ECO mode, click the 

ECO Toolbar button. If you do not enter ECO mode first, a message appears, informing you that 
you need to enter ECO mode.

Restriction:
You cannot modify read-only attributes  on page 1853.

For more information, see “ECO Options Dialog Box”.

2. Select the object(s) to modify.

3. Right-click and click the Attribute  popup menu item. Attribute information about the selected 
object(s) appears in spreadsheet form in the “Object Attributes Dialog Box”  on page 1496.

4. From the Groups list click an attribute group  on page 1811 to view. If you assign multiple attributes 
and some of those are structured attributes  on page 1862, this list acts as a filter and allows you to 
choose the attribute group to view.

5. From the Attributes For list, click the attribute hierarchy level for which you want to assign an 
attribute. The hierarchy levels change, depending on the object you selected in step 1. For more 
information, see “Attribute Hierarchy”.

Note:
You cannot click a hierarchy level if you have multiple objects selected. The attribute 
is assigned at the current level; for example, if you select multiple parts, attributes are 
assigned at the Component level.

6. Click the cell (in the Value column) of the attribute value to modify. If a cell is blank, it means that 
the attribute is assigned to the object, but has no value. It can also mean that the values differ for 
the selected objects.

7. Click Edit.

8. Type or click the new attribute value and press the Enter key. The new value is added to the 
objects. For more information, see “Attribute Values”.
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You can include a unit with the value. SailWind Layout provides a default set of units (and unit 
prefixes) that are accepted as input and used as output. For more information, see “Default Units”.

Tip
If attribute values are not the same, the value for that attribute is blank. If you modify that 
value, the new value applies to all objects with that attribute. You can also remove values 
from attributes (assign the attribute with no value).

Related Topics
Removing Attribute Values

Removing Attributes
You can remove an attribute of an object or objects of the same type using the Object Attributes dialog 
box. You can only delete attributes on the current level. If you delete an attribute and a value appears for 
the attribute at a higher level in the hierarchy, it applies to the current level.

To delete the attribute entirely from the design, use the Attribute Dictionary  on page 355.

Procedure
1. If the attribute is ECO-registered  on page 1824, enter ECO mode. To enter ECO mode, click the 

ECO Toolbar  button. The ECO Options Dialog Box  appears. If you do not enter ECO mode first, a 
message appears, informing you that you must enter ECO mode.

Tip
You cannot edit read-only attributes  on page 1853.

2. Select the object(s) to edit.

3. Right-click and click the Attribute  popup menu item. The “Object Attributes Dialog Box”  on 
page 1496 appears. Attribute information about the selected objects appears in spreadsheet form 
in the list.

4. From the Groups list click an attribute group  on page 1811 to view. If you assign multiple attributes 
and some of those are structured attributes  on page 1862, this list acts as a filter and allows you to 
choose the attribute group to view.

5. Click the cell whose attribute value you want to delete.

6. Click Delete.

The attribute is removed from the objects.

Removing Attribute Values
You can remove an attribute value of an object or objects of the same type using the Object Attributes 
dialog box.
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Adding Height Information to Design Components and Jumpers

Procedure
1. If the attribute is ECO-registered  on page 1824, enter ECO mode. To enter ECO mode, click the 

ECO Toolbar  button. The ECO Options Dialog Box  appears. If you do not enter ECO mode first, a 
message appears, informing you that you must enter ECO mode.

Tip
You cannot edit read-only attributes  on page 1853.

2. Select the object(s) to edit.

3. Right-click and click the Attribute  popup menu item. The “Object Attributes Dialog Box”  on 
page 1496 appears. Attribute information about the selected objects appears in spreadsheet form 
in the list.

4. From the Groups list click an attribute group  on page 1811 to view. If you assign multiple attributes 
and some of those are structured attributes  on page 1862, this list acts as a filter and allows you to 
choose the attribute group to view.

5. Click the cell from which you want to remove values.

6. Click Edit.

7. Press the Spacebar key and the press the Enter key. The attribute is still assigned to the objects, 
but it has no value.

Adding Height Information to Design Components 
and Jumpers
Height information prevents components from being placed in height-constrained areas. Height 
information is also important when exporting a design to a 3-dimensional modeling application.

Tip
To quickly add height information to multiple objects, use the procedure in “Adding Attribute 
Values to Design Objects With the Attribute Manager”.

Procedure
1. Select the object in the design.

2. Right-click, then click the Attribute  popup menu item.

3. In the Object Attributes Dialog Box, click the Add  button.

Note:
Some attributes require you to be in ECO Mode.

4. Type Geometry.Height, or select it from the list.
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5. Enter a value.

6. Click the Close  button.

Related Topics
Adding Height Information to Library Parts

Restricting Heights on Component Layers

Restricting Heights in Areas of Component Layers

Adding an Attribute to All Objects in the Design
Add an attribute at the PCB level of the attribute hierarchy to apply the attribute to all objects in the 
design.

Tip
Attributes at this level have the lowest priority in the attribute hierarchy. For more information, see 
“Attribute Hierarchy.”

Procedure
1. In the design, select an object (for example, a component, component pad, net, or via), right-click 

and click the Attribute  popup menu item.

2. In the Attributes for list, click PCB. Attributes of the PCB at the PCB level of the attribute hierarchy 
are displayed.

3. Click the Add  button to add a new attribute.

4. In the new row, type a new attribute, or use the list to select a predefined attribute.

5. Type a value.

6. Click Close.

402 SailWind Layout Guide and Reference



 

 

 

Chapter 19
Setting Rules and Using Keepouts

Read the topics that follow to learn more about setting up design rules for your design. You can also 
import rules from the schematic.

Design Rules
Design Rules Transfer
Import and Export of Design Rules
Creation of Rules for Your Design
Design Rules Setup
Creating a Report of the Design Rules
Turning on Design Rule Checking
Check Design Rules
Restricting Heights on Component Layers
Restricting Heights in Areas of Component Layers
Keepouts
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Design Rules
Design rules represent constraints, such as clearances and available routing layers, that support 
manufacturing, signal integrity, and other design requirements. SailWind Layout can perform design rule 
checking as you interactively place and route the design (called on-line design rule checking or just DRC), 
or after you complete design operations.

Most rules that you set up are used by On-line Design Rule Checking and can actively prevent you from 
making design errors. Some rules are only checked as a post-process using the Verify Design utility. 
Lastly, some rules are only used by the advanced capabilities of SailWind Router.

Setup Strategy
Design Rule Hierarchy
Design Rule Categories
Non-Default Rules Indicators
Advanced Rules Option
Design Rule Checking

Setup Strategy
The first step in your strategy for setting up the rules of your design is to create a set of default rules.

The default rules are a set of rules that apply to all the objects in your design that will not have any other 
rules assigned. Objects with hierarchical rules take precedence over the default rules. For example, a pin 
pair rule with a Trace Width of 10 will override the default rule with a Trace Width of 5.

Note:
Larger clearance rules always have precedence despite the order of the hierarchy. For example, 
if you use a Default clearance rule of 50 mils, but a higher Net clearance rule of 10 mils, the more 
restrictive default clearance rule of 50 mils has precedence and is applied to the net even though 
a hierarchical Net clearance was created. Clearance rules should be less restrictive at lower 
levels of the hierarchy. They should be a minimum clearance value.

After the Default rule set has been created, create hierarchical rules based on the requirements of your 
design. Any hierarchical rules that are created are based on the Default set.

Design Rule Hierarchy
The design rule hierarchy enables you to specify a default set of rules for the entire design and additional 
rules for individual objects or collections of objects.

For example, you might specify in the default design rules a small trace width that would be adequate for 
signal nets, and then specify a large trace width for a class  on page 1816 composed of power nets.

Because objects can be subject to multiple design rules, the design rule hierarchy specifies the priority of 
the rule types, so you can predict which design rule is applied to an object.

Basic Object Hierarchy
The objects in the design are defined using a basic object or relational hierarchy.
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Design Rule Hierarchy

The design hierarchy can be easily visualized in the Rules Dialog Box.

The lowest level of the hierarchy begins with the Default level. Once you set the Default rules, they apply 
to all design objects, unless you customize the rules at a higher level of the hierarchy. In the figure below, 
each object to the right of the Default rules takes precedence over the object before it. For example, the 
Net level has a higher priority than the Class level, which has only a higher priority than the Default level. 
The Component level of the hierarchy has the highest priority in the hierarchy.

Figure 27. Basic Object Hierarchy

Table  93. Hierarchy Descriptions

Hierarchy level Description

Default Rules that apply to an object if there are no other individually defined rules.

Class Rules for a collection of nets, called a class, that need identical rules.

Net Rules for a specific net.

Group Rules for a collection of pin pairs, called a group, that need identical rules.

Pin Pair Rules for a specific pin pair.
Usage example: A net needs different trace widths for certain pin-to-pin 
connections within it. You can apply rules to only those selected pin-to-pin 
connections.

Decal Rules for all components using a specific decal.

Component Rules for a specific component.

Complete Hierarchy
The complete hierarchy is not limited to the seven buttons in the Rules dialog box.

Conditional Rules add many levels in between and are used extensively in the complete design rule 
hierarchy. Conditional design rules are rules that come into effect when an object is adjacent to another 
object named in the conditional rule and/or on a layer named in the conditional rule. For example: Change 
a trace at any point in its length depending on the layer on which it resides. Net A may be assigned a 
default clearance of 12, but may need to reduce to 8 when it enters layer 4. In this case, you can assign 
12 as the default for net A and make a conditional rule which applies an 8 mil clearance to net A against 
layer 4.

Although the hierarchy is more extensive than the basic object hierarchy as seen in the Rules dialog box, 
the relationships that are found in the basic object hierarchy are still maintained by the conditional rules. 
For example, Net rules have a priority over Class rules in the basic hierarchy. So, a net to net conditional 
rule also has priority over a class to class rule.
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The following list is the complete hierarchy when all possible design rules are involved. This lists the 
priority for all rules from lowest to highest. Default rules, at level 1, have the lowest priority and represent 
the lowest level of the rules hierarchy. Component rules, at level 32, have the highest priority and 
represent the highest level of the rules hierarchy.

Note:
Electrical net rules are not part of the rules hierarchy.

1. Default rules  on page 416

2. Default clearance rules on a specific layer (Conditional)  on page 416

3. Class rules  on page 418

4. Class clearance rules on a specific layer (Conditional)  on page 422

5. Net rules  on page 423

6. Net clearance rules on a specific layer (Conditional)  on page 424

7. Group rules  on page 426

8. Group clearance rules on a specific layer (Conditional)  on page 430

9. Pin Pair rules  on page 431

10. Pin Pair clearance rules on a specific layer (Conditional)  on page 432

11. Class against Class rules (Conditional)  on page 433

12. Class against Class rules on a specific layer (Conditional)  on page 433

13. Net against Class rules (Conditional)  on page 435

14. Net against Class rules on a specific layer (Conditional)  on page 435

15. Net against Net rules (Conditional)  on page 437

16. Net against Net rules on a specific layer (Conditional)  on page 437

17. Group against Class rules (Conditional)  on page 439

18. Group against Class rules on a specific layer (Conditional)  on page 439

19. Group against Net rules (Conditional)  on page 441

20. Group against Net rules on a specific layer (Conditional)  on page 441
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Design Rule Categories

21. Group against Group rules (Conditional)  on page 443

22. Group against Group rules on a specific layer (Conditional)  on page 443

23. Pin Pair against Class rules (Conditional)  on page 445

24. Pin Pair against Class rules on a specific layer (Conditional)  on page 445

25. Pin Pair against Net rules (Conditional)  on page 447

26. Pin Pair against Net rules on a specific layer (Conditional)  on page 447

27. Pin Pair against Group rules (Conditional)  on page 449

28. Pin Pair against Group rules on a specific layer (Conditional)  on page 449

29. Pin Pair against Pin Pair rules (Conditional)  on page 451

30. Pin Pair against Pin Pair rules on a specific layer (Conditional)  on page 451

31. Decal rules  on page 453

Restriction:
Decal rules are not used in SailWind Layout.

32. Component rules  on page 455

Restriction:
Component rules are not used in SailWind Layout.

33. Differential pair rules

Restriction:
Only the gap value applies to the hierarchy; it is considered as the equivalent of the trace 
to trace clearance.

Design Rule Categories
SailWind Layout provides five possible categories of design rules. Not all categories are available at all 
levels of the basic hierarchy.

For example, the Fanout and Pad Entry categories are only available at the Default, Decal, and 
Component levels.
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Figure 28. Rule Category Icons

Table  94. Design Rule Category Descriptions

Rule Category Description

Clearance rules  on 
page 1167

Set the minimum allowable air gap between various object types in the 
design, such as trace to trace and via to trace.

 Tip
You can also define conditional clearance rules that apply when 
an object is adjacent to a specified object, or when an object is 
on a specified layer. For example, you can use conditional rules 
to specify different clearance rules for a net when it is routed on 
different layers.

Routing rules  on 
page 1666

Topology  on page 1867 type, assign and prohibit via types, layers 
available for routing, specify maximum number of vias per net, specify 
topology types, and allow or prohibit autorouting.

High Speed rules  on 
page 1402

Parallelism  on page 1845, shielding  on page 1859, geometric and 
electrical constraints, and length matching.  on page 1837 Set the 
minimum and maximum parameters for advanced design rules, such 
as parallelism, delay, and capacitance. You can pass these rules from 
the schematic or assign them in SailWind Layout. You can also pass 
clearance and routing rules to autorouters. The router must be able to 
interpret the passed rules.

 Tip
You can also define conditional high-speed rules that apply when 
an object is adjacent to a specified object, or when an object is 
on a specified layer. For example, you can use conditional rules 
to specify different high-speed rules for a net when it is routed on 
different layers.

Fanout rules  on 
page 1375

Adding copper shapes automatically to SMD  on page 1860 pads to 
make routing easier and to ensure that connections are made.

 Restriction:
These rules are only used by SailWind Router

Pad Entry  on page 1564 Location and angles for pad-to-trace intersections, and rules for 
placing vias on SMD  on page 1860 pads.

 Tip
These rules are only used by SailWind Router

Non-Default Rules Indicators
When you change rules in the hierarchy from the default rules, two types of indicators appear.
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Non-Default Rules Indicators

The indicators visually show that rules have been customized from the default rules.

• The categories of rules customized at the current rule level are displayed parenthetically beside 
the class, net, group, or pin pair name in the list.

Figure 29. Non-Default Parenthetical Indicators

C = Clearance rules

R = Routing rules

H = High speed rules

Example: A net listing followed by (RH) has non-default routing and high speed rules definitions.

• The icon that appears below each rule category button indicates whether the rules are 
customized at the current rule level or if it is only customized at another rule level.

Figure 30. Non-Default Icon Indicators

The meaning of the icon corresponds to the button in the Hierarchy area of the Rules dialog box.

Example: If a green polygon appears below the Clearance button, then the default values apply at 
the current level of the hierarchy for the object you’ve selected.
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Advanced Rules Option
The Advanced Rules option is a license-enabled modular add-on that extends the restricted rule set to 
allow use of the full rule set.

The full set of constraints allow for control of more complex designs. Without the Advanced Rules option, 
you only have access to the Default, and Net design rules. With the Advanced Rules options, your license 
enables the Class, Group, Pin Pairs, Decal, Component, Conditional Rules, and Differential Pairs Rules.

When you use Advanced Rules, the Hierarchical dialog boxes on the Design Rules dialog box are 
available. You can read in hierarchically assigned rules from a netlist and edit and save rule changes 
using the hierarchy.

If you do not have the Advanced Rules option, the Hierarchical dialog boxes on the Design Rules dialog 
box are not available. However, schematic-applied hierarchical rules reside in the netlist, and they can be 
passed to any autorouter that can interpret them.

Design Rule Checking
On-line Design Rule Checking (DRC) provides continuous rule checking during routing and placement.

On-line DRC does not check clearance for text, open associated copper, or free copper belonging to a 
decal. The following table shows the four DRC modes.

Table  95. Design Rule Checking Modes

Mode Purpose

Prevent Errors Prevents you from completing any operation that will create errors. 
You cannot paste items from the paste buffer. You cannot create 
or change (move, split, or miter, for example) the following items: 
board outlines, board cutouts, text, copper, and keepouts. To 
edit the Properties of these items, turn off On-line DRC using the 
modeless command, DRO. You can also right-click and click the 
Ignore Clearance  popup menu item to temporarily override DRC 
and complete an operation. When you are done, On-line DRC 
automatically resets to Prevent mode.

Warn Errors Warns that a design rule violation has occurred by highlighting the 
rule obstacles.

Ign Clrn Ignores clearance checking.

Off DRC is completely deactivated. When On-line DRC is off, program 
performance is enhanced. However, you are limited to the Route 
command for trace editing. When you turn On-line DRC on again, 
SailWind Layout pauses to map the board. The undo buffer is cleared 
when you turn On-line DRC off, but is still available for further edits.

To turn On-line DRC on use the Design  category in the Options dialog box or the modeless command, 
DRP or DRW. After activating On-line DRC, you can change the setting using the dialog box, or the 
modeless commands.

When On-line DRC is activated, an octagon shaped guard band appears at the end of the route to 
indicate any clearance violation. You can hide the guard band using the Show Guard Band option in the 
Options dialog box > Routing  category > General  subcategory.
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Design Rules Transfer

On-line Design Rule Checking is available on most SailWind Layout configurations. For Advanced Design 
Rules package users, all hierarchical rules, except High Speed EDC settings, are monitored.

Clearance Checking Against Text
For clearance checking against text, a rectangle referred to as an extent box is drawn around the text 
string, calculated as a smallest rectangle that will contain the text string. If a text string is rotated, the 
extent box is also rotated.

Text strings included in clearance checking are those that exist on the same level as other checked 
objects, or created to appear and on all layers.

CAUTION:
Text belonging to a decal is not checked for clearance by On-line DRC.

Clearance Checking Against Copper
Clearance checking against copper includes closed or open copper that is not part of the current net 
being routed and exists on the same layer as other checked objects. Closed copper in a decal that is 
associated with a terminal is checked for clearance by On-line DRC.

CAUTION:
On-line DRC does not check the clearance of open associated copper and free copper belonging 
to a decal.

Design Rules Transfer
Schematic and design files store the design rules you create. Design rules set up in SailWind Logic 
transfer automatically when you import the netlist into SailWind Layout. Design rules you set up in 
SailWind Layout become available automatically when you open the design in SailWind Router.

Note:
SailWind Logic supports only default, class, and net rules.

Import and Export of Design Rules
You can export and import design rules for the purpose of reusing them in future designs that require the 
same constraints.

• To export design rules, follow the instructions to export an ASCII file  on page 291, but in the 
ASCII Output dialog box, select only the Rules check box.

• To import the design rules, follow the instructions to import an ASCII file  on page 290.

Related Topics
Check Design Rules
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Creation of Rules for Your Design
SailWind Layout provides many levels of rules in the rules hierarchy. You can create rules at each level of 
the hierarchy.

Restriction:
The links below are in hierarchical order from lowest to highest priority. For more information, see 
“Design Rule Hierarchy”.

Links to Procedures for Creating all Rule Types
Default Rules

• Creating Default Rules

• Creating Default Clearance-Rules for a Specific Layer  (Conditional Rule)

Class Rules

• Class Design Rules

• Creating Class Clearance Rules for a Specific Layer  (Conditional Rule)

Net Rules

• Net Design Rules

• Creating Net Clearance Rules for a Specific Layer  (Conditional Rule)

Group Rules

• Group Design Rules

• Creating Group Clearance Rules for a Specific Layer  (Conditional Rule)

Pin Pair Rules

• Pin Pair Design Rules

• Creating Pin Pair Clearance Rules for a Specific Layer  (Conditional Rule)

Class Against... Rules

• Creating a Class Against Class Design Rule  (Conditional Rule)

• Creating a Class Against Class Design Rule for a Specific Layer  (Conditional Rule)

Net Against... Rules
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• Creating a Net Against Class Design Rule  (Conditional Rule)

• Creating a Net Against Class Design Rule for a Specific Layer  (Conditional Rule)

• Creating a Net Against Net Design Rule  (Conditional Rule)

• Creating a Net Against Net Design Rule for a Specific Layer  (Conditional Rule)

Group Against... Rules

• Creating a Group Against Class Design Rule  (Conditional Rule)

• Creating a Group Against Class Design Rule for a Specific Layer  (Conditional Rule)

• Creating a Group Against Net Design Rule  (Conditional Rule)

• Creating a Group Against Net Design Rule for a Specific Layer  (Conditional Rule)

• Creating a Group Against Group Design Rule  (Conditional Rule)

• Creating a Group Against Group Design Rule for a Specific Layer  (Conditional Rule)

Pin Pair Against... Rules

• Creating a Pin Pair Against Class Design Rule  (Conditional Rule)

• Creating a Pin Pair Against Class Design Rule for a Specific Layer  (Conditional Rule)

• Creating a Pin Pair Against Net Design Rule  (Conditional Rule)

• Creating a Pin Pair Against Net Design Rule for a Specific Layer  (Conditional Rule)

• Creating a Pin Pair Against Group Design Rule  (Conditional Rule)

• Creating a Pin Pair Against Group Design Rule for a Specific Layer  (Conditional Rule)

• Creating a Pin Pair Against Pin Pair Design Rule  (Conditional Rule)

• Creating a Pin Pair Against Pin Pair Design Rule for a Specific Layer  (Conditional Rule)

Decal Rules

• Creating Decal Design Rules

Component Rules

• Creating Component Design Rules

Differential Pair Rules
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• Creating Differential Pair Design Rules

414 SailWind Layout Guide and Reference



 
Setting Rules and Using Keepouts

Design Rules Setup

Design Rules Setup
Read the sections that follow to learn how to set up each of the different design rules types in SailWind 
Layout.

Default Design Rules
Class Design Rules
Net Design Rules
Group Design Rules
Pin Pair Design Rules
Class Against Class Design Rules
Net Against Class Design Rules
Net Against Net Design Rules
Group Against Class Design Rules
Group Against Net Design Rules
Group Against Group Design Rules
Pin Pair Against Class Design Rules
Pin Pair Against Net Design Rules
Pin Pair Against Group Design Rules
Pin Pair Against Pin Pair Design Rules
Decal Design Rules
Component Design Rules
Deletion or Modification of Conditional Design Rules
Differential Pair Design Rules
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Default Design Rules
When it comes to creating default design rules, you can create default rules and apply them to all layers 
of a design or you can create default design rules and apply them to specific layers.

Creating Default Rules
Creating Default Clearance-Rules for a Specific Layer

Creating Default Rules
Each new design already has a default set of rules or constraints. The default set either comes from the 
SailWind Layout default.asc  template file or imports from the schematic design.

Customize the default rules to the requirements of your design. You can also create default clearance 
rules for a specific layer  on page 416.

Procedure
1. Click the Setup  > Design Rules  menu item.

2. In the Rules Dialog Box, click Default.

3. In the Default Rules Dialog Box, click any of the five rule category  on page 407 buttons (Clearance, 
Routing, HiSpeed, Fanout, Pad Entry) to customize the rules from their default values and settings.

4. After you have customized the rule categories, close all Rules dialog boxes.

Related Topics
Design Rule Hierarchy

Creating Default Clearance-Rules for a Specific Layer
You can create a unique set of default rules on a specific layer that take precedence over the default rules 
that apply to all layers.

Procedure
1. Click the Setup  > Design Rules  menu item, and then click the Conditional Rules  button.

2. In the Conditional Rule Setup  on page 1199 dialog box, in the Source rule object area, click “All”.

3. In the Against rule object area, with “Layer” already selected, select the layer from the list.

4. In the Current rule set area, click Clearance.

5. Click Create.

6. In the Existing rule sets list, if not already selected, select the newly created rule set.
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Creating Default Clearance-Rules for a Specific Layer

7. In the Object to object box, type a value to apply to all objects or click Matrix  to enter the 
Clearance Rules Dialog Box  to apply different values between objects. You must click OK  in the 
Clearance Rules dialog box to accept the changes.

8. When finished, close any open Rules dialog boxes.

Related Topics
Design Rule Hierarchy
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Class Design Rules
Read the sections that follow to learn more about the setup and application of the class design rules.

Creating Class Design Rules
Deleting a Design Rule Class
Adding Nets to an Existing Design Rule Class
Removing Nets from a Design Rule Class
Modifying Class Design Rules
Renaming a Design Rule Class
Resetting Class Rules to Default Rules
Displaying the Nets of a Class Design Rule
Creating Class Clearance Rules for a Specific Layer

Creating Class Design Rules
A class  is a collection of nets to which you can assign a common set of design rules. You must first create 
a class and assign nets to the class before you can assign rules to the class.

You create the class either by selecting nets in the design, or by selecting them from a list in the Class 
Rules dialog box, but you can only use the Class Rules dialog box to define its design rules.

Procedure
1. Create a new class using one of the following two methods:

• Select nets in the design:

i. In the design area, select the nets you want to add to the class.

Tip
You can also use the Find dialog box to find nets and use wildcards in the Value field 
to filter the selection.

ii. Right-click and click the Make Class  popup menu item.

iii. In the Add Net to Class  on page 1058 dialog box, click Create New Class, type the class 
name in the Add to Class box, and then click OK.

• Select nets from the list in the Class Rules  on page 1162 dialog box:

i. Click the Setup  > Design Rules  menu item, and then click Class.

ii. In the Class name box, type the class name, and then click Add. The maximum class 
name length is 15 characters. You can use any alphanumeric characters except brackets {}, 
asterisks *, or spaces.
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iii. In the Nets area, in the Available list, double-click to quickly add the net to the class, 
or select multiple nets and click Add>>. Nets cannot exist in more than one class. The 
Available list in the Class Rules dialog box displays only nets that have not been assigned 
to a class.

2. In the Class Rules Dialog Box  (Setup  > Design Rules  menu item then Class), select the class in 
the Class box.

3. Click any of the three rule category  on page 407 buttons (Clearance, Routing, HiSpeed) to 
customize the rules from their default values and settings.

4. After you have customized the rule categories, click OK  to accept the changes and close the Class 
Rules dialog box.

Results
After you customize a rule category for the class, Non-Default Rules Indicators  appear in the dialog box.

Related Topics
Creating Net Design Rules

Adding Nets to an Existing Design Rule Class

Design Rule Hierarchy

Deleting a Design Rule Class
Use the Class Rules dialog box to delete classes.

Procedure
1. Click the Setup  > Design Rules  menu item and then click Class.

2. In the Class Rules Dialog Box, in the Class box, select one or more classes, and then click Delete. 
To display all classes in the Class box, clear the Show Classes with Rules check box.

3. Click OK  to accept the changes and close the Class Rules dialog box.

4. Click Close  in the Rules dialog box.

Adding Nets to an Existing Design Rule Class
If you have already defined a class design rule, you can add nets to it as required.
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Procedure
1. Add nets to an existing class using one of the following two methods:

• Select nets in the design:

i. In the design area, select the nets you want to add to the class.

Tip
You can also use the Find dialog box to find nets and use wildcards in the Value field 
to filter the selection.

ii. Right-click and click the Make Class  popup menu item.

iii. In the Add Net to Class  on page 1058 dialog box, click the Add to Existing Class option, 
and select the class in the Existing Classes list.

iv. Click OK.

• Select nets from the list in the Class Rules dialog box:

i. Click the Setup  > Design Rules  menu item, then click Class.

ii. In the Class Rules  on page 1162 dialog box, in the Class box, select the class to which 
you want to add a net. To display all classes in the Class box, clear the Show Classes with 
Rules check box.

iii. In the Nets area, in the Available list, double-click to quickly add the net to the class, 
or select multiple nets and click Add>>. Nets cannot exist in more than one class. The 
Available list in the Class Rules dialog box displays only nets that have not been assigned 
to a class.

2. Click OK  to accept the changes and close the Class Rules dialog box.

Removing Nets from a Design Rule Class
Use the Class Rules dialog box to remove nets from a class.

Procedure
1. Click the Setup  > Design Rules  menu item, then click the Class  button.

2. In the Class Rules Dialog Box, in the Class box, select the class. To display all classes in the Class 
list, clear the Show Classes with Rules check box.

3. Select the nets for removal in the Selected list, and then click <<Remove.

4. Click OK  to accept the changes and close the Class Rules dialog box.

5. Click Close  in the Rules dialog box.
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Modifying Class Design Rules
If desired, you can change or modify the rules of a class of nets.

Procedure
1. Click the Setup  > Design Rules  menu item, then click the Class  button.

2. In the Class Rules Dialog Box, in the Class box, select the class.

3. Click any of the three rule category  on page 407 buttons (Clearance, Routing, HiSpeed) to modify 
the values and settings.

4. After you have customized the rule categories, click OK  to accept the changes and close the Class 
Rules dialog box.

5. Click Close  in the Rules dialog box.

Renaming a Design Rule Class
Use the Class Rules dialog box to change the name of a class.

Procedure
1. Click the Setup  > Design Rules  menu item, then click the Class  button.

2. In the Class Rules Dialog Box, in the Class box, select a class. To display all classes in the Class 
list, clear the Show Classes with Rules check box.

3. In the Class name box, type the new class name.

4. Click Rename.

5. Click OK  to accept the changes and close the Class Rules dialog box.

6. Click Close  in the Rules dialog box.

Resetting Class Rules to Default Rules
If desired, you can reset the class rules to the same as the default rules.

Procedure
1. Click the Setup  > Design Rules  menu item, then click the Class  button.

2. In the Class Rules Dialog Box, select one or more classes in the Class list, click Default, and then 
click Yes. The Default  button is unavailable if the class already has only default rules assigned to 
it. You know you have successfully reset the class rules if all the icons below the rule categories  on 
page 407 (Clearance, Routing, HiSpeed) return to the Default icon, and the Default  button is no 
longer available.

3. Click OK  to accept the changes and close the Class Rules dialog box.

4. Click Close  in the Rules dialog box.
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Displaying the Nets of a Class Design Rule
If you want to know what nets are assigned to a class, you can view them in the Class Rules dialog box.

Procedure
1. Click the Setup  > Design Rules  menu item, then click the Class  button.

2. In the Class Rules Dialog Box, in the Class list, click the name of the class. Nets in the class 
appear in the Selected list.

3. After you have viewed the nets, click Cancel  to close the Class Rules dialog box without saving 
any changes.

4. Click Close  in the Rules dialog box.

Creating Class Clearance Rules for a Specific Layer
You can create a unique set of class rules for a specific layer that take precedence over the class rules 
that apply to all layers.

Prerequisites
The Class of nets must already exist. For more information, see “Class Design Rules”.

Procedure
1. Click the Setup  > Design Rules  menu item, then click Conditional Rules.

2. In the Conditional Rule Setup  on page 1199 dialog box, in the Source rule object area, click the 
Classes option and then select a class in the list.

3. In the Current rule set area, choose the Clearance option.

4. In the Against rule object area, choose the Layer option and then select a layer from the list.

5. Click Create.

6. In the Existing rule sets list, if not already selected, select the newly created rule set.

7. In the Object to object box, type a value to apply to all objects or click Matrix  to enter the 
Clearance Rules Dialog Box  to apply different values between objects. You must click OK  in the 
Clearance Rules dialog box to accept the changes.

8. When finished, close any open Rules dialog boxes.

Related Topics
Design Rule Hierarchy
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Net Design Rules
Read the topics that follow to learn more about the setup and application of net design rules.

Creating Net Design Rules
Modification of Net Design Rules
Resetting Net Rules to Default Rules
Creating Net Clearance Rules for a Specific Layer

Creating Net Design Rules
Use the Net Rules dialog box to customize the design rules that apply to nets. Unless you customize the 
design rules for a net, it assumes the Default design rule values and settings.

Procedure
1. You can assign rules to one or more nets at a time. There are two ways to select the net(s) before 

accessing the rule categories.

• Select nets in the design:

i. In the design area, select the net or nets to which you want to apply rules.

Tip
You can also use the Find dialog box to find nets and use wildcards in the Value field 
to filter the selection.

ii. Right-click and click the Show Rules  popup menu item.

• Select nets from the list in the Net Rules dialog box:

i. Click the Setup  > Design Rules  menu item, then click the Net  button.

ii. In the Net Rules Dialog Box, in the Nets box, click one or more nets. To display all nets, 
clear the Show Nets with Rules check box.

2. Click any of the three rule category  on page 407 buttons (Clearance, Routing, HiSpeed) to 
customize the rules from their default values and settings.

3. After you have customized the rule categories, close all rules dialog boxes to return to the design.

Results
After you customize a rule category for the net(s), Non-Default Rules Indicators  appear in the dialog box.

Related Topics
Design Rule Hierarchy
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Modification of Net Design Rules
You can modify net design rules to meet your design requirements.

Procedure
1. Click the Setup  > Design Rules  menu item, then click the Net  button.

2. In the Net Rules Dialog Box, in the Nets box, click one or more nets with rules assigned.

3. Click any of the three rule category  on page 407 buttons (Clearance, Routing, HiSpeed) to modify 
the values and settings.

4. If other nets have the same rules, you may be prompted with a dialog box to include the other nets 
in the changes you are making. Click one of the following:

◦ Yes  — the dialog goes away and the other nets are selected in the Nets list. You must 
click the rule cateory button again to proceed.

◦ No  — the rule category dialog opens for editing.

5. After you have customized the rule categories, click OK  to accept the changes and close the Net 
Rules dialog box.

6. Click Close  in the Rules dialog box.

Resetting Net Rules to Default Rules
You can reset the net rules to the same as the default rules.

Procedure
1. Click the Setup  > Design Rules  menu item, then click the Net  button.

2. In the Net Rules Dialog Box, select one or more nets in the Nets list, click Default, and then click 
Yes. The Default  button is unavailable if the net has only default rules assigned to it.

You know you have successfully reset the net rules if all the icons below the rule categories 
(Clearance, Routing, HiSpeed) return to the Default icon, and the Default  button is no longer 
available.

3. Close all rules dialog boxes to return to the design.

Creating Net Clearance Rules for a Specific Layer
You can create a unique set of net rules on a specific layer that take precedence over net rules which 
apply to all layers.

Procedure
1. Click the Setup  > Design Rules  menu item and then click the Conditional Rules  button.

2. In the Conditional Rule Setup  on page 1199 dialog box, in the Source rule object area, click Nets 
and then select a net in the list.
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3. In the Current rule set area, choose the Clearance option.

4. In the Against rule object area, choose the Layer option and then select a layer from the list.

5. Click Create.

6. In the Existing rule sets list, if not already selected, select the newly created rule set.

7. In the Object to object box, type a value to apply to all objects or click the Matrix  button to enter 
the Clearance Rules Dialog Box  to apply different values between objects. You must click OK  in 
the Clearance Rules dialog box to accept the changes.

8. When finished, close any open Rules dialog boxes.

Related Topics
Design Rule Hierarchy
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Group Design Rules
The following topics describe the setup and application of the group design rules.

Creating Group Design Rules
Deleting a Design Rule Group
Adding Pin Pairs to an Existing Design Rule Group
Removing Pin Pairs from a Design Rule Group
Modifying Group Design Rules
Renaming a Design Rule Group
Resetting Group Rules to Default Rules
Displaying the Pin Pairs of a Design Rule Group
Creating Group Clearance Rules for a Specific Layer

Creating Group Design Rules
A group  is a collection of pin pairs to which you can assign a common set of design rules. You must first 
create a group and assign pin pairs to the group before you can assign rules to the group.

You create the group either by selecting pin pairs in the design, or by selecting them from a list in the 
Group Rules dialog box, but you can only use the Group Rules dialog box to define its design rules.

Procedure
1. Create a new group using one of the following two methods:

• Select pin pairs in the design:

i. In the design area, select the pin pairs you want to add to the group.

Tip
You can also use the Find dialog box to find pin pairs and use wildcards in the Value 
field to filter the selection.

ii. Right-click and click the Make Group  popup menu item.

iii. In the Add Pin Pairs to Group  on page 1068 dialog box, choose the Create New Group 
option, type the group name in the Add to Group box, and then click OK.

• Select pin pairs from the list in the Group Rules dialog box:

i. Click the Setup  > Design Rules  menu item and then click the Group  button.

ii. In the Group Rules dialog box,  on page 1399 in the Group name box, type the group name, 
and then click Add. The maximum group name length is 15 characters. You can use any 
alphanumeric characters except brackets {}, asterisks *, or spaces. These characters are 
automatically replaced with an underscore.
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iii. In the Connections area, in the Available list, double-click to quickly add the pin pair to 
the group, or select multiple pin pairs and click Add>>. You can also filter the display of 
Available pin pairs to a single net by selecting the net in the From net list. Pin pairs cannot 
exist in more than one group. The Available list in the Group Rules dialog box displays only 
pin pairs that have not been assigned to a group.

2. In the Group Rules Dialog Box  (Setup  > Design Rules  menu item and then click Group and select 
the group in the Group box.

3. Click any of the three rule category  on page 407 buttons (Clearance, Routing, HiSpeed) to 
customize the rules from their default values and settings.

4. After you have customized the rule categories, click OK  to accept the changes and close the 
Group Rules dialog box.

Results
After you customize a rule category for the group, Non-Default Rules Indicators  appear in the dialog box.

Related Topics
Creating Pin Pair Design Rules

Adding Pin Pairs to an Existing Design Rule Group

Design Rule Hierarchy

Deleting a Design Rule Group
Use the Group Rules dialog box to delete a group in SailWind Layout, such as a group of pin pairs.

Procedure
1. Click the Setup  > Design Rules  menu item and then click the Group  button.

2. In the Group Rules Dialog Box, in the Group box, select one or more groups, and then click 
Delete. The group name is deleted from the Group box. To display all groups in the Group box, 
clear the Show groups with rules check box.

3. Click OK  to accept the changes and close the Group Rules dialog box.

4. Click Close  in the Rules dialog box.

Adding Pin Pairs to an Existing Design Rule Group
SailWind Layout allows you to group pin pairs together and apply design rules. You can create a new 
group or you can add pin pairs to an existing group design rule.
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Procedure
1. Add pin pairs to an existing group using one of the following two methods:

• Select pin pairs in the design:

i. In the design area, select the pin pairs you want to add to the group.

Tip
You can also use the Find dialog box to find pin pairs and use wildcards in the Value 
field to filter the selection.

ii. Right-click and click the Make Group  popup menu item.

iii. In the Add Pin Pairs to Group  on page 1068 dialog box, choose the Add to Existing Group 
option, and select the group in the Existing Groups list.

iv. Click OK.

• Select pin pairs from the list in the Group Rules dialog box:

i. Click the Setup  > Design Rules  menu item and then click the Group  button.

ii. In the Group Rules Dialog Box, in the Group box, select the group to which you want to add 
a pin pair. To display all groups in the Group box, clear the Show groups with rules check 
box.

iii. In the Connections area, in the Available list, double-click to quickly add the pin pair to 
the group, or select multiple pin pairs and click Add>>. You can also filter the display of 
Available pin pairs to a single net by selecting the net in the From net list. Pin Pairs cannot 
exist in more than one group. The Available list in the Group Rules dialog box displays only 
pin pairs that have not been assigned to a group.

2. Click OK  to accept the changes and close the Group Rules dialog box.

Removing Pin Pairs from a Design Rule Group
If necessary, you can remove a set of pin pairs from a group if you do not want to apply the group design 
rules to it. Use the Group Rules dialog box to remove pin pairs from a group.

Procedure
1. Click the Setup  > Design Rules  menu item and then click the Group  button.

2. In the Group Rules Dialog Box, in the Group box, select the group. To display all groups in the 
Group list, clear the Show groups with rules check box.

3. Select the pin pairs for removal in the Selected list, and then click <<Remove.
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4. Click OK  to accept the changes and close the Group Rules dialog box.

5. Click Close  in the Rules dialog box.

Modifying Group Design Rules
You can change or edit group design rules and apply them to all objects in the group.

Procedure
1. Click the Setup  > Design Rules  menu item and then click the Group  button.

2. In the Group Rules Dialog Box, in the Group box, select the group.

3. Click any of the three rule category  on page 407 buttons (Clearance, Routing, HiSpeed) to modify 
the values and settings.

4. After you have customized the rule categories, click OK  to accept the changes and close the 
Group Rules dialog box.

5. Click Close  in the Rules dialog box.

Renaming a Design Rule Group
You can change the name of a design rules group by using the Group Rules dialog box.

Procedure
1. Click the Setup  > Design Rules  menu item and then click the Group  button.

2. In the Group Rules Dialog Box, in the Group box, select a group. To display all groups in the Group 
list, clear the Show groups with rules check box.

3. In the Group name box, type the new group name.

4. Click Rename.

5. Click OK  to accept the changes and close the Group Rules dialog box.

6. Click Close  in the Rules dialog box.

Resetting Group Rules to Default Rules
You can set a group’s design rules back to their default rule settings.

Procedure
1. Click the Setup  > Design Rules  menu item and then click the Group  button.

2. In the Group Rules Dialog Box, select one or more groups in the Group list, click Default, and then 
click Yes. The Default  button is unavailable if the class already has only default rules assigned to 
it.

You know you have successfully reset the group rules if all the icons below the rule categories  on 
page 407 (Clearance, Routing, HiSpeed) return to the Default  icon, and the Default button is no 
longer available.
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3. Click OK  to accept the changes and close the Group Rules dialog box.

4. Click Close  in the Rules dialog box.

Displaying the Pin Pairs of a Design Rule Group
If you want to know what pin pairs are assigned to a group, you can view them in the Group Rules dialog 
box.

Procedure
1. Click the Setup  > Design Rules  menu item and then click the Group  button.

2. In the Group Rules Dialog Box, in the Group list, click the name of the group. Pin pairs in the group 
appear in the Selected list.

3. After you have viewed the pin pairs, click Cancel  to close the Group Rules dialog box without 
saving any changes.

4. Click Close  in the Rules dialog box.

Creating Group Clearance Rules for a Specific Layer
You can create a unique set of group rules on a specific layer that take precedence over the group rules 
which apply to all layers.

Prerequisites
The Group of pin pairs must already exist. For more information, see “Group Design Rules”.

Procedure
1. Click the Setup  > Design Rules  menu item and then click the Conditional Rules  button.

2. In the Conditional Rule Setup  on page 1199 dialog box, in the Source rule object area, choose the 
Groups option and then select a group in the list.

3. In the Current rule set area, click Clearance.

4. In the Against rule object area, choose the Layer option and then select a layer from the list.

5. Click Create.

6. In the Existing rule sets list, if not already selected, select the newly created rule set.

7. In the Object to object box, type a value to apply to all objects or click the Matrix  button to enter 
the Clearance Rules Dialog Box  to apply different values between objects. You must click OK  in 
the Clearance Rules dialog box to accept the changes.

8. When finished, close any open Rules dialog boxes.

Related Topics
Design Rule Hierarchy
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Pin Pair Design Rules
Read the topics that follow to learn more about the setup and application of the pin pair design rules.

Creating Pin Pair Design Rules
Modification of Pin Pair Design Rules
Resetting Pin Pair Rules to Default Rules
Creating Pin Pair Clearance Rules for a Specific Layer

Creating Pin Pair Design Rules
Use the Pin Pair Rules dialog box to create design rules for one or more pin pairs.

Procedure
1. You can assign rules to one or more pin pairs at a time. There are two ways to select the pin pair(s) 

before accessing the rule categories.

• Select pin pairs in the design:

i. In the design area, select the pin pair(s) to which you want to apply rules.

Tip
You can also use the Find dialog box to find pin pairs and use wildcards in the Value 
field to filter the selection.

ii. Right-click and click the Show Rules  popup menu item.

• Select nets from the list in the Pin Pair Rules dialog box:

i. Click the Setup  > Design Rules  menu item and then click the Pin Pairs  button. If you want 
to display all pin pairs, clear the Show pin pairs with rules check box.

ii. In the Pin Pair Rules Dialog Box, in the Connections box, click one or more pin pairs. To 
display pin pairs for a specific net, select the net in the From Net list.

2. Click any of the three rule category  on page 407 buttons (Clearance, Routing, HiSpeed) to 
customize the rules from their default values and settings.

3. After you have customized the rule categories, close any rules dialog boxes to return to the design.

Results
After you customize a rule category for the pin pair(s), Non-Default Rules Indicators  appear in the dialog 
box.

Related Topics
Design Rule Hierarchy
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Modification of Pin Pair Design Rules
If necessary, you can edit pin pair design rules to support your specific design requirements.

Follow the procedure in the topic “Creating Pin Pair Design Rules”  on page 431.

Resetting Pin Pair Rules to Default Rules
If desired, you can reset the pin pair design rules to back to their default settings.

Procedure
1. Click the Setup  > Design Rules  menu item and then click the Pin Pairs  button.

2. In the Pin Pair Rules Dialog Box, select one or more pin pairs in the Connections list, click Default, 
and then click Yes. The Default  button is unavailable if the pin pair has only default rules assigned 
to it.

You know you have successfully reset the pin pair rules if all the icons below the rule categories  on 
page 407 (Clearance, Routing, HiSpeed) return to the Default icon, and the Default  button is no 
longer available.

3. Close any rules dialog boxes to return to the design.

Creating Pin Pair Clearance Rules for a Specific Layer
You can create a unique set of pin pair rules on a specific layer that take precedence over pin pair rules 
that apply to all layers.

Procedure
1. Click the Setup  > Design Rules  menu item and then click the Conditional Rules  button.

2. In the Conditional Rule Setup  on page 1199 dialog box, in the Source rule object area, choose the 
Pin pairs option and then select a pin pair in the list.

3. In the Current rule set area, choose the Clearance option.

4. In the Against rule object area, choose the Layer option and then select a layer from the list.

5. Click Create.

6. In the Existing rule sets list, if not already selected, select the newly created rule set.

7. In the Object to object box, type a value to apply to all objects or click the Matrix  button to enter 
the Clearance Rules Dialog Box  to apply different values between objects. You must click OK  in 
the Clearance Rules dialog box to accept the changes.

8. When finished, close any open Rules dialog boxes.

Related Topics
Design Rule Hierarchy
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Class Against Class Design Rules
Read the topics that follow to learn more about the setup and application of the class against class design 
rules.

Creating a Class Against Class Design Rule
Creating a Class Against Class Design Rule for a Specific Layer

Creating a Class Against Class Design Rule
You can create clearance or high speed rules that apply between the same class or two different classes 
of nets.

Prerequisites
Both Classes of nets must already exist. For more information, see “Class Design Rules”.

Procedure
1. Click the Setup  > Design Rules  menu item and then click the Conditional Rules  button.

2. In the Conditional Rule Setup  on page 1199 dialog box, in the Source rule object area, choose the 
Classes option and then select a class in the list.

3. In the Current rule set area, choose the Clearance or the High Speed option.

4. In the Against rule object area, choose the Classes option and then select a class from the list.

5. Click Create.

6. In the Existing rule sets list, if not already selected, select the newly created rule set.

7. Set the required Clearance or High Speed values.

8. When finished, close any open Rules dialog boxes.

Related Topics
Design Rule Hierarchy

Creating a Class Against Class Design Rule for a Specific 
Layer
You can create clearance rules that apply between the same class or two different classes of nets on a 
specific layer. Such a clearance rule takes precedence over class against class clearance rules that apply 
to all layers.

Prerequisites
Both Classes of nets must already exist. For more information, see “Class Design Rules”.
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Procedure
1. Click the Setup  > Design Rules  menu item and then click the Conditional Rules  button.

2. In the Conditional Rule Setup  on page 1199 dialog box, in the Source rule object area, choose the 
Classes option and then select a class in the list.

3. In the Current rule set area, choose the Clearance option.

4. In the Against rule object area, choose the Classes option and then select a class from the list.

5. In the Apply to layer list, select a specific layer.

6. Click Create.

7. In the Existing rule sets list, if not already selected, select the newly created rule set.

8. Set the required Clearance values.

9. When finished, close any open Rules dialog boxes.

Related Topics
Design Rule Hierarchy
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Net Against Class Design Rules
Read the topics that follow to learn more about the setup and application of the net against class design 
rules.

Creating a Net Against Class Design Rule
Creating a Net Against Class Design Rule for a Specific Layer

Creating a Net Against Class Design Rule
You can create clearance or high speed rules that apply between a net and a class of nets.

Prerequisites
The Class of nets must already exist. For more information, see “Class Design Rules”.

Procedure
1. Click the Setup  > Design Rules  menu item and then click the Conditional Rules  button.

2. In the Conditional Rule Setup  on page 1199 dialog box, in the Source rule object area, choose the 
Nets option and then select a net in the list.

3. In the Current rule set area, choose the Clearance or the High Speed option.

4. In the Against rule object area, choose the Classes option and then select a class from the list.

5. Click Create.

6. In the Existing rule sets list, if not already selected, select the newly created rule set.

7. Set the required Clearance or High Speed values.

8. When finished, close any open Rules dialog boxes.

Related Topics
Design Rule Hierarchy

Creating a Net Against Class Design Rule for a Specific 
Layer
You can create clearance rules that apply between a net and a class of nets on a specific layer. Such 
clearance rules take precedence over net against class clearance rules that apply to all layers.

Prerequisites
The Class of nets must already exist. For more information, see “Class Design Rules”.
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Procedure
1. Click the Setup  > Design Rules  menu item and then click the Conditional Rules  button.

2. In the Conditional Rule Setup  on page 1199 dialog box, in the Source rule object area, choose the 
Nets option and then select a net in the list.

3. In the Current rule set area, choose the Clearance option.

4. In the Against rule object area, choose the Classes option and then select a class from the list.

5. In the Apply to layer list, select a specific layer.

6. Click Create.

7. In the Existing rule sets list, if not already selected, select the newly created rule set.

8. Set the required Clearance values.

9. When finished, close any open Rules dialog boxes.

Related Topics
Design Rule Hierarchy
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Net Against Net Design Rules
Read the topics that follow to learn more about the setup and application of the net against net design 
rules.

Creating a Net Against Net Design Rule
Creating a Net Against Net Design Rule for a Specific Layer

Creating a Net Against Net Design Rule
You can create clearance or high speed rules that apply between the same net or two different nets.

Procedure
1. Click the Setup  > Design Rules  menu item and then click the Conditional Rules  button.

2. In the Conditional Rule Setup  on page 1199 dialog box, in the Source rule object area, choose the 
Nets option and then select a net in the list.

3. In the Current rule set area, choose the Clearance or the High Speed option.

4. In the Against rule object area, choose the Nets option and then select a net from the list.

5. Click Create.

6. In the Existing rule sets list, if not already selected, select the newly created rule set.

7. Set the required Clearance or High Speed values.

8. When finished, close any open Rules dialog boxes.

Related Topics
Design Rule Hierarchy

Creating a Net Against Net Design Rule for a Specific 
Layer
You can create clearance rules that apply between the same net or two different nets on a specific layer. 
Such design rules take precedence over net against net clearance rules that apply to all layers.

Procedure
1. Click the Setup  > Design Rules  menu item and then click the Conditional Rules  button.

2. In the Conditional Rule Setup  on page 1199 dialog box, in the Source rule object area, choose the 
Nets option and then select a net in the list.

3. In the Current rule set area, choose the Clearance option.

4. In the Against rule object area, choose the Nets options and then select a net from the list.

5. In the Apply to layer list, select a specific layer.
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6. Click Create.

7. In the Existing rule sets list, if not already selected, select the newly created rule set.

8. Set the required Clearance values.

9. When finished, close any open Rules dialog boxes.

Related Topics
Design Rule Hierarchy
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Group Against Class Design Rules
Read the topics that follow to learn more about the setup and application of the group against class 
design rules.

Creating a Group Against Class Design Rule
Creating a Group Against Class Design Rule for a Specific Layer

Creating a Group Against Class Design Rule
You can create clearance or high speed rules that apply between a group of pin pairs and a class of nets.

Prerequisites
The Group of pin pairs and the Class of nets must already exist. For more information, see “Group Design 
Rules” and “Class Design Rules”.

Procedure
1. Click the Setup  > Design Rules  menu item and then click the Conditional Rules  button.

2. In the Conditional Rule Setup  on page 1199 dialog box, in the Source rule object area, choose the 
Groups option and then select a group in the list.

3. In the Current rule set area, choose the Clearance or the High Speed option.

4. In the Against rule object area, choose the Classes option and then select a class from the list.

5. Click Create.

6. In the Existing rule sets list, if not already selected, select the newly created rule set.

7. Set the required Clearance or High Speed values.

8. When finished, close any open Rules dialog boxes.

Related Topics
Design Rule Hierarchy

Creating a Group Against Class Design Rule for a 
Specific Layer
You can create clearance rules that apply between a group of pin pairs and a class of nets on a specific 
layer. Such clearance rules take precedence over group against class clearance rules that apply to all 
layers.

Prerequisites
The Group of pin pairs and the Class of nets must already exist. For more information, see “Group Design 
Rules” and “Class Design Rules”.
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Procedure
1. Click the Setup  > Design Rules  menu item and then click the Conditional Rules  button.

2. In the Conditional Rule Setup  on page 1199 dialog box, in the Source rule object area, choose the 
Groups option and then select a group in the list.

3. In the Current rule set area, choose the Clearance option.

4. In the Against rule object area, choose the Classes option and then select a class from the list.

5. In the Apply to layer list, select a specific layer.

6. Click Create.

7. In the Existing rule sets list, if not already selected, select the newly created rule set.

8. Set the required Clearance values.

9. When finished, close any open Rules dialog boxes.

Related Topics
Design Rule Hierarchy
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Group Against Net Design Rules
Read the topics that follow to learn more about the setup and application of the group against net design 
rules.

Creating a Group Against Net Design Rule
Creating a Group Against Net Design Rule for a Specific Layer

Creating a Group Against Net Design Rule
You can create clearance or high speed rules that apply between a group of pin pairs and a net.

Prerequisites
The Group of pin pairs must already exist. For more information, see “Group Design Rules”.

Procedure
1. Click the Setup  > Design Rules  menu item and then click the Conditional Rules  button.

2. In the Conditional Rule Setup  on page 1199 dialog box, in the Source rule object area, choose the 
Groups option and then select a group in the list.

3. In the Current rule set area, choose the Clearance or the High Speed option.

4. In the Against rule object area, choose the Nets option and then select a net from the list.

5. Click Create.

6. In the Existing rule sets list, if not already selected, select the newly created rule set.

7. Set the required Clearance or High Speed values.

8. When finished, close any open Rules dialog boxes.

Related Topics
Design Rule Hierarchy

Creating a Group Against Net Design Rule for a Specific 
Layer
You can create clearance rules that apply between a group of pin pairs and a net on a specific layer. Such 
clearance rules take precedence over group against net clearance rules that apply to all layers.

Prerequisites
The Group of pin pairs must already exist. For more information, see “Group Design Rules”.

SailWind Layout Guide and Reference 441



Setting Rules and Using Keepouts
Creating a Group Against Net Design Rule for a Specific Layer  

Procedure
1. Click the Setup  > Design Rules  menu item and then click the Conditional Rules  button.

2. In the Conditional Rule Setup  on page 1199 dialog box, in the Source rule object area, choose the 
Groups option and then select a group in the list.

3. In the Current rule set area, choose the Clearance option.

4. In the Against rule object area, choose the Nets option and then select a net from the list.

5. In the Apply to layer list, select a specific layer.

6. Click Create.

7. In the Existing rule sets list, if not already selected, select the newly created rule set.

8. Set the required Clearance values.

9. When finished, close any open Rules dialog boxes.

Related Topics
Design Rule Hierarchy
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Group Against Group Design Rules
Read the topics that follow to learn more about the setup and application of the group against group 
design rules.

Creating a Group Against Group Design Rule
Creating a Group Against Group Design Rule for a Specific Layer

Creating a Group Against Group Design Rule
You can create clearance or high speed rules that apply between the same group of pin pairs or two 
different groups of pin pairs.

Prerequisites
The Group(s) of pin pairs must already exist. For more information, see “Group Design Rules”.

Procedure
1. Click the Setup  > Design Rules  menu item and then click the Conditional Rules  button.

2. In the Conditional Rule Setup  on page 1199 dialog box, in the Source rule object area, choose the 
Groups option and then select a group in the list.

3. In the Current rule set area, choose the Clearance or the High Speed option.

4. In the Against rule object area, choose the Groups option and then select a group from the list.

5. Click Create.

6. In the Existing rule sets list, if not already selected, select the newly created rule set.

7. Set the required Clearance or High Speed values.

8. When finished, close any open Rules dialog boxes.

Related Topics
Design Rule Hierarchy

Creating a Group Against Group Design Rule for a 
Specific Layer
You can create clearance rules that apply between the same group of pin pairs or two different groups of 
pin pairs on a specific layer. Such rules take precedence over group against group clearance rules that 
apply to all layers.

Prerequisites
The Group(s) of pin pairs must already exist. For more information, see “Group Design Rules”.
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Procedure
1. Click the Setup  > Design Rules  menu item and then click the Conditional Rules  button.

2. In the Conditional Rule Setup  on page 1199 dialog box, in the Source rule object area, choose the 
Groups option and then select a group in the list.

3. In the Current rule set area, choose the Clearance option.

4. In the Against rule object area, choose the Groups option and then select a group from the list.

5. In the Apply to layer list, select a specific layer.

6. Click Create.

7. In the Existing rule sets list, if not already selected, select the newly created rule set.

8. Set the required Clearance values.

9. When finished, close any open Rules dialog boxes.

Related Topics
Design Rule Hierarchy
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Pin Pair Against Class Design Rules
Read the topics that follow to learn more about the setup and application of the pin pair against class 
design rules.

Creating a Pin Pair Against Class Design Rule
Creating a Pin Pair Against Class Design Rule for a Specific Layer

Creating a Pin Pair Against Class Design Rule
You can create clearance or high speed rules that apply between a pin pair and a class of nets.

Prerequisites
The Class of nets must already exist. For more information, see “Class Design Rules”.

Procedure
1. Click the Setup  > Design Rules  menu item and then click the Conditional Rules  button.

2. In the Conditional Rule Setup  on page 1199 dialog box, in the Source rule object area, choose 
the Pin Pairs option and then select a pin pair in the list. You can also filter the list of pin pairs to a 
single net by selecting the net in the From net list.

3. In the Current rule set area, choose the Clearance or the High Speed option.

4. In the Against rule object area, choose the Classes option and then select a class from the list.

5. Click Create.

6. In the Existing rule sets list, if not already selected, select the newly created rule set.

7. Set the required Clearance or High Speed values.

8. When finished, close any open Rules dialog boxes.

Related Topics
Design Rule Hierarchy

Creating a Pin Pair Against Class Design Rule for a 
Specific Layer
You can create clearance rules that apply between a pin pair and a class of nets on a specific layer. Such 
rules take precedence over pin pair against class clearance rules that apply to all layers.

Prerequisites
The Class of nets must already exist. For more information, see “Class Design Rules”.
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Procedure
1. Click the Setup  > Design Rules  menu item and then click the Conditional Rules  button.

2. In the Conditional Rule Setup  on page 1199 dialog box, in the Source rule object area, choose 
the Pin Pairs option and then select a pin pair in the list. You can also filter the list of pin pairs to a 
single net by selecting the net in the From net list.

3. In the Current rule set area, choose the Clearance option.

4. In the Against rule object area, choose the Classes option and then select a class from the list.

5. In the Apply to layer list, select a specific layer.

6. Click Create.

7. In the Existing rule sets list, if not already selected, select the newly created rule set.

8. Set the required Clearance.

9. When finished, close any open Rules dialog boxes.

Related Topics
Design Rule Hierarchy
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Pin Pair Against Net Design Rules
Read the topics that follow to learn more about the setup and application of the pin pair against net design 
rules.

Creating a Pin Pair Against Net Design Rule
Creating a Pin Pair Against Net Design Rule for a Specific Layer

Creating a Pin Pair Against Net Design Rule
You can create clearance or high speed rules that apply between a pin pair and a net.

Procedure
1. Click the Setup  > Design Rules  menu item and then click the Conditional Rules  button.

2. In the Conditional Rule Setup  on page 1199 dialog box, in the Source rule object area, choose 
the Pin Pairs option and then select a pin pair in the list. You can also filter the list of pin pairs to a 
single net by selecting the net in the From net list.

3. In the Current rule set area, choose the Clearance or the High Speed option.

4. In the Against rule object area, choose the Nets option and then select a net from the list.

5. Click Create.

6. In the Existing rule sets list, if not already selected, select the newly created rule set.

7. Set the required Clearance or High Speed values.

8. When finished, close any open Rules dialog boxes.

Related Topics
Design Rule Hierarchy

Creating a Pin Pair Against Net Design Rule for a Specific 
Layer
You can create clearance rules that apply between a pin pair and a net on a specific layer. Such rules 
take precedence over pin pair against net clearance rules that apply to all layers.

Procedure
1. Click the Setup  > Design Rules  menu item and then click the Conditional Rules  button.

2. In the Conditional Rule Setup  on page 1199 dialog box, in the Source rule object area, choose 
the Pin Pairs option and then select a pin pair in the list. You can also filter the list of pin pairs to a 
single net by selecting the net in the From net list.

3. In the Current rule set area, choose the Clearance option.

4. In the Against rule object area, choose the Nets option and then select a net from the list.
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5. In the Apply to layer list, select a specific layer.

6. Click Create.

7. In the Existing rule sets list, if not already selected, select the newly created rule set.

8. Set the required Clearance values.

9. When finished, close any open Rules dialog boxes.

Related Topics
Design Rule Hierarchy
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Pin Pair Against Group Design Rules
Read the topics that follow to learn more about the setup and application of the pin pair against group 
design rules.

Creating a Pin Pair Against Group Design Rule
Creating a Pin Pair Against Group Design Rule for a Specific Layer

Creating a Pin Pair Against Group Design Rule
You can create clearance or high speed rules that apply between a pin pair and a group of pin pairs.

Prerequisites
The Group of pin pairs must already exist. For more information, see “Group Design Rules”.

Procedure
1. Click the Setup  > Design Rules  menu item and then click the Conditional Rules  button.

2. In the Conditional Rule Setup  on page 1199 dialog box, in the Source rule object area, choose 
the Pin Pairs option and then select a pin pair in the list. You can also filter the list of pin pairs to a 
single net by selecting the net in the From net list.

3. In the Current rule set area, choose the Clearance or the High Speed option.

4. In the Against rule object area, choose the Groups option and then select a group from the list.

5. Click Create.

6. In the Existing rule sets list, if not already selected, select the newly created rule set.

7. Set the required Clearance or High Speed values.

8. When finished, close any open Rules dialog boxes.

Related Topics
Design Rule Hierarchy

Creating a Pin Pair Against Group Design Rule for a 
Specific Layer
You can create clearance rules that apply between a pin pair and a group of pin pairs on a specific layer. 
These rules take precedence over pin pair against group clearance rules that apply to all layers.

Prerequisites
The Group of pin pairs must already exist. For more information, see “Group Design Rules”.
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Procedure
1. Click the Setup  > Design Rules  menu item and then click the Conditional Rules  button.

2. In the Conditional Rule Setup  on page 1199 dialog box, in the Source rule object area, choose 
the Pin Pairs option and then select a pin pair in the list. You can also filter the list of pin pairs to a 
single net by selecting the net in the From net list.

3. In the Current rule set area, choose the Clearance option.

4. In the Against rule object area, choose the Groups option and then select a group from the list.

5. In the Apply to layer list, select a specific layer.

6. Click Create.

7. In the Existing rule sets list, if not already selected, select the newly created rule set.

8. Set the required Clearance values.

9. When finished, close any open Rules dialog boxes.

Related Topics
Design Rule Hierarchy
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Pin Pair Against Pin Pair Design Rules
Read the topics that follow to learn more about the setup and application of the pin pair against pin pair 
design rules.

Creating a Pin Pair Against Pin Pair Design Rule
Creating a Pin Pair Against Pin Pair Design Rule for a Specific Layer

Creating a Pin Pair Against Pin Pair Design Rule
You can create clearance or high speed rules that apply between the same pin pair or two different pin 
pairs.

Procedure
1. Click the Setup  > Design Rules  menu item and then click the Conditional Rules  button.

2. In the Conditional Rule Setup  on page 1199 dialog box, in the Source rule object area, choose 
the Pin Pairs option and then select a pin pair in the list. You can also filter the list of pin pairs to a 
single net by selecting the net in the From net list.

3. In the Current rule set area, choose the Clearance or the High Speed option.

4. In the Against rule object area, choose the Pin Pairs option and then select a pin pair from the list. 
You can also filter the list of pin pairs to a single net by selecting the net in the From net list.

5. Click Create.

6. In the Existing rule sets list, if not already selected, select the newly created rule set.

7. Set the required Clearance or High Speed values.

8. When finished, close any open Rules dialog boxes.

Related Topics
Design Rule Hierarchy

Creating a Pin Pair Against Pin Pair Design Rule for a 
Specific Layer
You can create clearance rules that apply between the same pin pair or two different pin pairs on a 
specific layer. These rules take precedence over pin pair against pin pair clearance rules that apply to all 
layers.

Procedure
1. Click the Setup  > Design Rules  menu item and then click the Conditional Rules  button.

2. In the Conditional Rule Setup  on page 1199 dialog box, in the Source rule object area, choose 
the Pin Pairs option and then select a pin pair in the list. You can also filter the list of pin pairs to a 
single net by selecting the net in the From net list.
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3. In the Current rule set area, choose the Clearance option.

4. In the Against rule object area, choose the Pin Pairs option and then select a pin pair from the list. 
You can also filter the list of pin pairs to a single net by selecting the net in the From net list.

5. In the Apply to layer list, select a specific layer.

6. Click Create.

7. In the Existing rule sets list, if not already selected, select the newly created rule set.

8. Set the required Clearance values.

9. When finished, close any open Rules dialog boxes.

Related Topics
Design Rule Hierarchy
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Decal Design Rules
Read the topics that follow to learn more about the setup and application of the decal design rules.

Creating Decal Design Rules
Modification of Decal Design Rules
Resetting Decal Rules to Default Rules
Creating Decal Design Rules in the PCB Decal Editor

Creating Decal Design Rules
Use the Decal Rules dialog box to define design rules that apply to all instances of a decal within the 
design. You can assign rules to one or more decals at a time.

Restrictions and Limitations

• You can define Decal Rules in SailWind Layout; however, these rules are used in SailWind 
Router only.

Procedure
1. Click the Setup  > Design Rules  menu item and then click the Decal  button.

2. In the Decal Rules Dialog Box, in the Decals box, click one or more decals. To display all decals, 
clear the Show decals with rules check box.

3. Click any of the four rule category  on page 407 buttons (Clearance, Routing, Fanout, Pad Entry) to 
customize the rules from their default values and settings.

4. After you have customized the rule categories, close any rules dialog boxes to return to the design.

Results
After you customize a rule category for the class, Non-Default Rules Indicators  appear in the dialog box.

Related Topics
Design Rule Hierarchy

Modification of Decal Design Rules
If necessary, you can edit or change decal design rules to support your specific design requirements.

Follow the procedure in the topic “Creating Decal Design Rules”.

Resetting Decal Rules to Default Rules
If desired, you can reset the decal rules back to their default settings.
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Procedure
1. Click the Setup  > Design Rules  menu item and then click the Decal  button.

2. In the Decal Rules Dialog Box, select one or more decals in the Decals list, click Default, and then 
click Yes. The Default  button is unavailable if the decal has only default rules assigned to it.

You know you have successfully reset the decal rules if all the icons below the rule categories 
on page 407 (Clearance, Routing, Fanout, Pad Entry) return to the Default icon, and the Default 
button is no longer available.

3. Close any rules dialog boxes to return to the design.

Creating Decal Design Rules in the PCB Decal Editor
Use the Decal Rules dialog box to define design rules for the decal. SailWind Layout saves the design 
rules with the decal in the library. The design rules become active whenever you use the decal in a 
design.

Restrictions and Limitations
You can define Decal Rules in SailWind Layout; however, these rules are used in SailWind Router only.

Procedure
1. In the PCB Decal Editor, click the Setup  > Decal Rules  menu item.

2. In the Decal Rules dialog box  on page 1231, click any of the four rule category  on page 407
buttons (Clearance, Routing, Fanout, Pad Entry) to customize the rules from their default values 
and settings.

3. Close any rules dialog boxes to return to the design.

Results
After you customize a rule category for the decal(s), Non-Default Rules Indicators  appear in the dialog 
box.

Related Topics
Design Rule Hierarchy
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Component Design Rules
Read the topics that follow to learn more about the setup and application of the component design rules.

Creating Component Design Rules
Modification of Component Design Rules
Resetting Component Rules to Default Rules
Creating Via Routing Rules in the Decal Editor

Creating Component Design Rules
Use the Component Rules dialog box to create design rules for one or more components.

Restrictions and Limitations

• You can define Component Rules in SailWind Layout; however, these rules are used in SailWind 
Router only.

Procedure
1. You can assign rules to one or more components at a time. There are two ways to select the 

component(s) before accessing the rule categories.

• Select components in the design:

i. In the design area, select the component(s) to which you want to apply rules.

Tip
You can also use the Find dialog box to find components and use wildcards in the 
Value field to filter the selection.

ii. Right-click and click the Show Rules  popup menu item.

• Select components from the list in the Component Rules dialog box:

i. Click the Setup  > Design Rules  menu item and then click the Component  button.

ii. In the Component Rules Dialog Box, in the Components box, select one or more 
components. To display all components in the list, clear the Show components with rules 
check box. To display components using a specific decal, select the decal in the “Using 
decal” list.

2. Click any of the four rule category  on page 407 buttons (Clearance, Routing, Fanout, Pad Entry) 
to customize the rules from their default values and settings.

3. Close any rules dialog boxes to return to the design.
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Results
After you customize a rule category for the pin pair(s), Non-Default Rules Indicators  appear in the dialog 
box.

Related Topics
Design Rule Hierarchy

Modification of Component Design Rules
You can edit or change component design rules as necessary to support the specific requirements of your 
design.

Follow the procedure in the topic “Creating Component Design Rules”.

Resetting Component Rules to Default Rules
If necessary, you can set the component rules back to their default settings.

Procedure
1. Click the Setup  > Design Rules  menu item and then click the Component button.

2. Select one or more components in the Components list, click Default, and then click Yes. The 
Default  button is unavailable if the component has only default rules assigned to it.

You know you have successfully reset the component rules if all the icons below the rule 
categories  on page 407 (Clearance, Routing, Fanout, Pad Entry) return to the Default icon, and the 
Default  button is no longer available.

3. Close any rules dialog boxes to return to the design.

Creating Via Routing Rules in the Decal Editor
Use the Routing Rules dialog box to specify which vias may be used with the decal.

Restrictions and Limitations

• When you open the Routing Rules dialog box from the Decal Editor, only options in the Vias area 
are available.

Procedure
1. In the PCB Decal Editor, click the Setup  > Design Rules  menu item and then click the Routing 

button.

2. In the Routing Rules Dialog Box, in the Vias area, click the Via definition  button.

3. In the Setup Via Dialog Box, specify vias to use for routing rules in the Decal Editor:
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Creating Via Routing Rules in the Decal Editor

a. To add a via, type the via name into the box, and then click Add.

b. Click OK.

Tip
The Setup Via dialog box does not know about via padstacks in the design. Use this 
dialog box to set up only via names, not the internal structure of the pad stacks. These 
via names should reference the real vias in your design, where the internal padstack 
structure is defined.

4. In the Routing Rules dialog box, do any of the following:

• To make vias available to the Decal Editor, select the vias and click Add.

• To make vias unavailable to the Decal Editor, select the vias and click Remove.

Related Topics
Routing Rules Dialog Box

Design Rule Hierarchy

Creating and Editing PCB Decals
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Deletion or Modification of Conditional Design 
Rules
Read the topics that follow to learn more about deleting or modifying conditional design rules.

Deleting a Conditional Rule
Modifying a Conditional Rule

Deleting a Conditional Rule
If necessary, use the Conditional Rule Setup dialog box to delete conditional rules that you have created.

Procedure
1. Click the Setup  > Design Rules  menu item and then click the Conditional Rules  button.

2. In the Conditional Rule Setup  on page 1199 dialog box, in the Existing rule sets list, select one or 
more rules to delete.

3. Click the Delete  button.

Modifying a Conditional Rule
You can make changes to an existing conditional rule.

Procedure
1. Click the Setup  > Design Rules  menu item and then click the Conditional Rules  button.

2. In the Conditional Rule Setup  on page 1199 dialog box, in the Existing rule sets list, select the rule 
to modify. In the Current rule set area, the rule set type enables either the clearance or high-speed 
value options.

3. Modify the Clearance or High speed rule values.

Note:
For reporting purposes, nets and pin pairs in the Source rule object list are identified as 
aggressors  on page 1808. If a class is in the Source rule object list, all nets in the class 
are identified as aggressors.

CAUTION:
Rules specified in this dialog box override high-speed rules specified in the HiSpeed Rules 
dialog box.

4. Close all open rules dialog boxes.

458 SailWind Layout Guide and Reference



 
Setting Rules and Using Keepouts

Modifying a Conditional Rule

Related Topics
Design Rule Hierarchy
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Differential Pair Design Rules
Read the topics that follow to learn more about the setup and application of the differential pair design 
rules.

Creating Differential Pair Design Rules
Deleting a Differential Pair Design Rule

Creating Differential Pair Design Rules
You can define differential pair rules for nets, pin pairs, or electrical nets that behave electrically as 
differential pairs.

Restrictions and Limitations

• You can define differential pair rules in SailWind Layout or SailWind Router; however, these rules 
are used in SailWind Router only. To verify differential pairs in the design, you must check them in 
Latium checking  on page 883.

Procedure
1. Click the Setup  > Design Rules  menu item and then click the Differential Pairs  button.

2. In the Differential Pairs Dialog Box, choose the Net, Pin pairs, or Elecrical Nets  tab.

3. In the Available list, double-click the first net, and then double-click the second net. Double-clicking 
is a shortcut instead of clicking the Select>>  button.

Note:
Nets, pin pairs, and electrical nets cannot exist in more than one differential pair. The 
Available list displays only items that have not been assigned to a differential pair.

4. Click Add.

5. Set the Properties of the pair.

6. Click OK.

7. Close the Rules dialog box.

Deleting a Differential Pair Design Rule
Use the Differential Rules dialog box to delete a differential pair rule.

Procedure
1. Click the Setup  > Design Rules  menu item and then click the Differential Pairs  button.

2. In the Differential Pairs Dialog Box, choose the Net  or Pin pairs  tab.

3. Select the differential pair in the Pairs list, and then click <<Remove.
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Creating a Report of the Design Rules

4. Click OK.

5. Close the Rules dialog box.

Creating a Report of the Design Rules
Use the Rules Report dialog box to create a report of some or all design rules. You can then print the 
report of the design rules.

Procedure
1. Click the Setup  > Design Rules  menu item and then click the Report  button.

2. In the Rules Report dialog box,  on page 1677 in the Rule Types area, enable any of the rule types.

3. In the Pin pairs, Groups, Components, Nets, Classes, and Decals areas, do one of the following:

• Select the check box to report all objects.

• Select one or more items in the list to report only specific objects.

Tip
In the Pin pairs area, you can filter the contents of the Pin pair list by selecting a net in 
the Net list.

4. If you want to report the default rules for each enabled rule type in the Rules Types area, select the 
Default Rules check box.

5. In the Output area, click one of the following options:

• Rule Sets  — Report all rules that are different from the default rules

• Rule Values  — Report the values of all rules, even if they match the default rules values

6. Click OK.

Results
The report is written to C:\SailWind Projects\rules.rep  and displayed by the default text editor.

Turning on Design Rule Checking
With Online DRC, you can enable live design rule checking as you work on your design. Online DRC 
prevents or reports design rule violations during interactive placement or routing.

Use Online DRC to constrain actions and avoid making design errors. You can run the Verify Design  on 
page 1775 tool to search for and locate errors at any time.
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Restrictions and Limitations

• There are many design rules that are not checked by Online DRC. Some are only checked by 
SailWind Router (for example, Maximum number of vias) and others can only be checked as a 
post process by the Verify Design tool (for example, net Capacitance). Check the documentation 
and test the rule to ensure it works with Online DRC.

• Online DRC does not prevent you from moving objects in a flooded area. If you don’t re-flood 
the area, Verify Design reports errors. If objects within a flooded area were moved, or thermal 
settings were changed since the original flooding, you need to flood the area again.

Procedure
1. Click the Tools  > Options  menu item > Design category  on page 1503.

2. In the Online DRC area, select a setting.

Tip
You can also initiate design rule checking using one of the Design Rule Checking 
modeless commands (drp, drw, dri, or dro).  on page 1479

Check Design Rules
You can perform a design rules check during interactive place and route operations, or after place and 
route operations are complete.

For more information, see “Turning on Design Rule Checking”.

Use Verify Design to check for design rule violations after placement or routing, and report any violations 
in the work area and in a text file. For more information, see “Verify the Design”.

Restricting Heights on Component Layers
You can create a board height restriction to limit the height of components placed on the board.

Restriction:
You cannot use a height restriction of 0 (zero) to prevent placement on a layer. A height restriction 
of 0 specifies no restriction. To prevent placement of all components on a layer, make the layer a 
Routing layer instead of a Component layer in the Layers Setup Dialog Box.

Tip
If you want to have a visual cue that a board has a height restriction, use the procedure in 
“Restricting Heights in Areas of Component Layers” to create a keepout area over the entire layer.
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Restricting Heights in Areas of Component Layers

Restrictions and Limitations

• A board height restriction does not prevent placement of a decal that has no geometry.height 
attribute.

• No warning is given if you create a restriction after a component that is taller than the height 
restriction has been placed. The violation will be caught, however, when you run a clearance 
check in Verify Design.

Procedure
1. Click the Tools  > Options  menu item, then click the Text and Lines  tab.

2. In the Board component height restriction area, enter the height restriction for the Top and/or 
Bottom layer.

3. Click OK.

Results
You will be unable to place components whose geometry.height attribute value is greater than the 
specified height restriction.

Related Topics
Adding Height Information to Design Components and Jumpers

Adding Height Information to Library Parts

Restricting Heights in Areas of Component Layers

Restricting Heights in Areas of Component 
Layers
You can create a board height restriction to limit the height of components placed in an area of the board.

Restrictions and Limitations

• A board height restriction does not prevent placement of a decal that has no geometry.height 
attribute.

• No warning is given if you put a keepout over an already-placed component that is taller than the 
height restriction. The violation will be caught, however, when you run a clearance check in Verify 
Design.

Procedure
1. In the Layer list of the Standard Toolbar, select a component layer.

2. Create a keepout  on page 465 in the area of the board where you want to restrict component 
height.
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3. In the Add Drafting dialog box, in the Restrictions area, select the Placement and the Component 
height check boxes.

4. Type the height restriction in the box.

5. Click OK.

Results
You will be unable to place components whose geometry.height attribute value is greater than the 
specified height restriction.

Related Topics
Adding Height Information to Design Components and Jumpers

Adding Height Information to Library Parts

Restricting Heights on Component Layers
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Keepouts

Keepouts
Keepouts  prevent the placement of design items within a specified area. Keepouts appear as one pixel-
width lines during interactive placement, cluster placement, routing, and other operations. The outer edge 
of design objects and board outlines/cutouts appear for use in clearance calculations against keepouts. 
Both the Online Design Rule Checking and Verify Design tools recognize keepouts as obstacles.

You can create keepouts in both the Layout Editor and the PCB Decal Editor. User interaction is the same 
for either; the only difference is the type of objects you can restrict.

CAUTION:
The three component type keepouts can only be created in the Layout Editor.

Creating Keepout Areas
Modifying a Keepout

Creating Keepout Areas
Create a keepout to define areas where design objects cannot be placed. You can create keepout areas 
using closed polygons (with or without arcs), circles, or rectangles. The current angle mode and design 
grid settings determine the placement of the lines.

Note:
When defining keepouts in the PCB Decal Editor, you can also assign keepouts to an <Opposite 
Side>. You cannot do this in the Layout Editor. Placement, Component Height, and Component 
Drill check boxes are unavailable in the PCB Decal Editor.

Procedure
1. On the Drafting Toolbar, then click the Keepout  button.

2. Right-click and click a draw mode for the type of shape to create.

3. Create a closed shape to define the keepout area.

4. In the Add Drafting dialog box  on page 1054that appears, select restrictions.

5. Click the layer on which to place the keepout.

Tip
When you choose layer assignments, restrictions not available for that layer are 
unavailable. For example, if you choose a non-placement layer, the Placement check box 
will not be available.

6. Click OK. The keepout is created. If you create other keepouts, they use the restrictions you set 
here as the default.
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Results
The keepout is displayed with a widely spaced hatch filling the area. If the fill you are using for Copper or 
Copper Planes is similar and you find it difficult to distinguish them, you can change the direction of the 
keepouts to be the reverse in the “Hatch and Flood”  on page 1511 options.

Related Topics
Creating Keepout Areas in a Decal

Modifying a Keepout
You can change the size of a keepout just as you would any other drafting object: move an edge or 
corner, or change the diameter of a circle. You can also copy a keepout to another location and change its 
restrictions or layer assignments.

Procedure
1. Select the edge of a keepout, right-click and click the Select Shape  popup menu item.

2. Right-click and click the Properties  popup menu item.

3. In the Drafting Properties dialog box, turn restrictions on or off and modify the layer settings. For 
more information, see “Drafting Object Properties.”

4. Click OK.

Tip
You cannot modify a keepout that is part of a physical design reuse. If you try to, the 
message “Reuse elements cannot be modified. Break the reuse first” appears. Click OK  to 
cancel the operation.

Related Topics
Restricting Heights on Component Layers

Attribute Dictionary
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Chapter 20
AI-Powered Advanced Functionality

Read the topics that follow to learn more about the procedures for executing algorithmn-driven layout.

Layout Area Assessment
Intelligent Layout
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Layout Area Assessment
Use this feature to automatically place components within the board outline, adhering to the layout rules 
while minimizing the occupied space. It can be triggered by the following two methods:

Triggered by Menu Bar
Prerequisites
There are unglued components outside the board outline.

Procedure
1. Click the AI  > Layout Area Assessment  menu item.

2. Configure layout rules, including:

• One-sided Layout  — Select this option to enable the single-sided layout.

By default, this option is unchecked for double-sided layout.

• Allow 45 Degrees  — Select to allow rotating components by 45 degrees.

• Border Spacing  — Specify the minimum clearance from the component body to the board 
outline.

• Max Iteration Number  — Specify the number of algorithm iterations, with an upper limit of 100.

3. Add classes to include decals and define spacing rules between classes.

a. Add classes: In the Class Decal Name box, type the name of the class, and then click Add  to 
add the class name to the Class list.

Select a class name in the Class list, you can also:

• Click Rename  to rename the class selected in the list with the text in the Class Decal Name 
box.

• Click Delete  to delete the selected item.

b. Include PCB decal types to the class: Select a class in the list, and then choose decals from 
the Usable list to add to the Selected list.

• Use Ctrl/Shift for multiple selections.

• Click Remove  to move the class from the Selected list to the Usable list.
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Triggered by Right-Click Menu

c. Define spacing rules between classes: In the Spacing Rule of the Same Surface Element area, 
define the clearance rule between classes by double-clicking the table cell.

Tip
To set the same value for an entire column or the table, click on a column heading or 
All.

4. Click Run  to perform the layout operation. A hyperlink to the report file appears in the Output 
window, on the Status  tab.

During runtime, you can:

• Check both the current and maximum iteration count, as well as area utilization rate in the 
Status Bar.

• Click the Cancel  button or close the dialog box to terminate the process, placing components 
based on the current operating state.

5. (Optional) Click the Save  button to save all settings for the next run.

Triggered by Right-Click Menu
Prerequisites
There are unglued components outside the board outline.

Procedure
1. Select components for layout. Use Ctrl+click to select multiple non-sequential items, or drag the 

cursor to select a range of items.

2. Right-click and select the Layout Area Assessment  popup menu.

3. Click the board outline or 2D line item to define the layout area outline as prompted.

The selected component is placed based on the options configured in the Layout Area Assessment 
Dialog Box, except for the maximum iteration number (1 for this case).

Intelligent Layout
Use the Layout Area Assessment feature for minimal layout area.

Prerequisites

• The AI layout reference data  option is enabled when sending a SailWind Logic netlist using the 
SailWind Layout Link.

• A board outline must be defined in the design.
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Procedure
1. Click the AI  > Intelligent Layout  menu item.

2. In the Intelligent Layout dialog box, a table lists the intelligent identified component groups along 
with their layout state and rule set correspondingly.

Note:
Rule set is not currently supported.

3. (Optional) Click the Rule Setup  button to configure layout options on demand, including:

• Allow rotation  — Select to allow rotating components by 90 degrees.

• Layout style  — Select the layout style from the drop-down list.

• One-sided Layout  — Select this option to enable the single-sided layout.

By default, this option is unchecked for double-sided layout.

• Key part safety spacing  — Specify the minimum clearance from the intelligently identified key 
component within a group.

Tip
TSkip this step t set.

4. Click the Module Analysis  button to initiate the module analysis.

5. Click the Module Layout  button to initiate the layout process.

When the process is completed, the Layout State changes to "Layout completion".

6. Click the Cluster Create  button to create clusters from the component groups.

7. Click the Cluster Layout  button to open the Cluster Placement Dialog Box.
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Chapter 21
Part Placement

Read the topics that follow to learn more about the multiple methods and strategies available for part 
placement operations. You can also learn more about the operations of the part placement commands, 
as well as information on changing or modifying your placement, dispersion, and the use of unions and 
clusters.

Placement Strategy
Placement Guidelines
Component Placement Process
Setting the Origin of an Object
Placement and Length Minimization
Controlling Length Minimization
Minimizing Unrouted Connection Length
Placement Related ECOs
Use of the Find Dialog Box During Placement
Component Spacing
Moving Components
Moving Items With Move by Origin
Moving Items With Stretch Traces During Component Move
Moving Design Objects Radially
The Radial Move Shortcut Menu
Sequential Component Placement
Modify the Board-Side Location of Components
Component Arrays
Aligning Objects
Rotating an Object
Spinning an Object
Swapping Parts
Interactive Placement Tools
Changing the Part Outline Width
Modifying Component Properties
Creating a Label
Editing a Label
Cluster and Union Placement
Unions
Cluster Placement

Placement Strategy
Parts placement depends on multiple factors. In addition to connection length and spacing tolerances, 
manufacturing considerations such as accessibility for pick-and-place machines and solder treatment 
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also affect placement. After you determine your manufacturing strategy and import your netlist, use the 
interactive placement tools to optimize your placement scheme.

Tools to aid in parts placement include:

• Find function that locates and selects parts by reference designator or location

• Separate grid settings for x and y coordinates, set by a modeless command

• Interactive part alignment function

• Nudge interactive parts shoving, with DRC enabled

• Net length minimization

• Connection length minimization

• Automatic and interactive part, pin, and gate swapping

• Automatic part renumbering

Remember to backward annotate engineering change order (ECO) changes to the schematic.

Placement Guidelines
A number of guidelines will aid you in the development of your component placement design.

A good placement scheme:

• Observes all the restrictions placed on component location and trace routing.

• Provides the easiest routing solutions.

Follow this general order for placement:

1. Place all components that have a fixed location, such as connectors, ICs that require a specific 
location, and mounting holes.

2. Because of their typically heavy connectivity pattern, connectors need sufficient room between 
other connectors and the first row of ICs to exit the connector. Allow at least 0.5 mils between the 
connector and the nearest row of ICs.

3. Place components that have engineering restrictions, such as parts that must be a certain 
distance from each other, parts that cannot be located next to each other, and parts that must be 
near the connector.

4. Place components with no overriding placement requirements. Follow these general guidelines:
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Component Placement Process

◦ A part's pads should fall on the grid used during autorouting. Some standard increments are 
100, 50, 25, 20, 16.67, 12.5, or 10 mils. Set up the design grid before placing components.

◦ The flow of connections should be vertical and horizontal. Minimize diagonal connections.

◦ Component pads should line up vertically and horizontally so they do not block routing 
channels. If two ICs are side by side with their pads staggered 50 mils, the pads of one IC 
block the routing channels of the other.

◦ For manufacturing reasons, it is better to have all of the ICs on the board oriented in the same 
direction, rather than some vertical and some horizontal.

Component Placement Process
SailWind Layout initially overlays all parts at the origin on the top layer. Before placing components, 
create a board outline, set up the layers of the design, set the grid values, and set up the clearance 
design rules—specifically those that apply to component placement.

Many commands are available to place your components. You can:

• Switch to SailWind Router and use it to do all of your placements.

Restriction:
You cannot use unions, clusters, or reuse items in SailWind Router to assist with 
placement.

• Click the Tools  > Disperse Components  menu item to disperse all the components around the 
board outline.

Tip
Click the View  > Extents  menu item after you disperse components to bring all design 
objects into view.

• Move components in the design. For more information, see “Moving Components”.

• Orient parts radially on a polar grid. For more information, see “Setting Up a Polar Grid”.

• Move multiple components sequentially. For more information, see “Sequential Component 
Placement”.

• Flip components to the bottom layer. For more information, see “Modify the Board-Side Location 
of Components, Bottom View”.

• Array components. For more information, see “Creating a Component Array”.

• Align edges or centerlines of multiple components. For more information, see “Aligning Objects”.
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• Rotate objects in 90 degree increments or at any angle. For more information, see “Rotating an 
Object, Spinning an Object”.

• Swap the locations of two parts. For more information, see “Swapping Parts”.

• Automatically nudge overlapping components into positions that agree with the clearance rules. 
If you disable design rule checking, you can place parts into positions that disagree with your 
design rule clearances. For more information, see “Nudge Overlapping Parts”.

Setting the Origin of an Object
Set the origin of an object to move it or place it. You can set the origin of a board outline, 2-D line, decal 
shape (in the PCB Decal Editor), copper shape, keepout shape, and dimension shape.

You can set the origin of an object using the popup menus when creating a Dimensioning Shape or 
Drafting Shape.

Procedure
1. Select the whole shape.

Tip
Right-click and click the Select Shape, Select Documentation, or Select Board Outline 
popup menu selection shortcuts to select the whole shape. As an alternative, you can 
press the Shift key and select a segment - this selects the shape rather than a segment or 
corner.

2. Right-click and click the Set Origin  popup menu item.

3. Click to set the new origin point. A message appears to confirm the origin point.

4. Click Yes  to change the origin point or click No  to use the previous origin point.

5. To exit Set Origin mode, press the Esc key.

Placement and Length Minimization
Before you begin placement, set the topology types you want to use for nets, net classes, or the Default 
level of the rules hierarchy. Topology  is the pattern of the trace and the order in which to connect pins in a 
net. The Length Minimization tool reorders pin connections in a net to support the topology you set.

Length minimization does not change the netlist, it just finds better places to make connections required 
by the netlist. For example, if you specify the “minimized” topology for a net, length minimization finds the 
pin order that produces the shortest pin-to-pin connections.

When you move a part around the layout, length minimization happens on the fly. If the topology type 
is set to something other than “protected,” you can see ratsnest connections linking and unlinking pins 
on the moved part to the nearest viable terminals on other parts. Also, as you move the part, a running 
measurement called New Length/Old Length appears on the message line. 100 equals 100 percent of 
all nets connected to the part when you picked it up. If the percentage becomes less than 100, the length 
is getting better. If the percentage becomes more than 100, the length is getting worse. When you have 
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Controlling Length Minimization
a placement you think will work, you can also run length minimization for the entire board by using the 
Length Minimization command.

Generally, placement that minimizes connection length should be your primary consideration. However, 
using minimum connection length to determine part location can result in dense areas of connections, 
usually in the center of the board. These connections can outnumber the routing channels available in the 
area. Consequently, after you minimize the connection length, study the board to see whether there are 
critical dense areas. Do not hesitate to make local adjustments to the component locations to spread the 
connections away from the dense areas.

Part swapping also depends on topology type. No ECO file is required or generated for length 
minimization or part swapping. On the other hand, gate swapping, pin swapping, and ECL terminator 
swapping, are all recorded in an ECO file for backward annotation. There may be, however, some high-
speed or critical nets in your design for which you want to set to the “protected” topology type before you 
begin placement.

Controlling Length Minimization
You can control length minimization by using different methods, each having a distinct effect on the your 
design environment.

There are two levels of control for length minimization.

• The Length minimize setting in the Design category of the Options dialog box that determines if 
and when length minimization occurs when moving a component - during a move, or after a move 
which consumes less display memory.

• The more detailed controls are configured at the Default or a hierarchical rules level, in 
the Routing Rules dialog box. For more information, see the Routing Rules Dialog Box  on 
page 1666topic.

Minimizing Unrouted Connection Length
Before you begin placement, consider setting the topology types you want to use. Running a length 
minimization does not change the netlist; it just finds better places to make the same connections the 
netlist specifies, based on the topology types you set.

Procedure
Click the Tools  > Length Minimization  menu item.

The nets are reordered to minimize the length between connection points.

Related Topics
Placement and Length Minimization

Routing Rules Dialog Box

Placement Related ECOs
An engineering change order (ECO) is a change in design that either comes to the board from the 
schematic or occurs in the layout and effects the schematic.

SailWind Layout Guide and Reference 475



Part Placement
Use of the Find Dialog Box During Placement  

Because ordinary length minimization and part swapping do not change the netlist, you do not need to 
backward annotate them to the schematic. You must, however, record in an .eco  file length minimization 
and placement optimization tools like gate and pin swapping and reference designator renumbering. For 
this reason, these commands are located on the ECO Toolbar. When you access the ECO Toolbar you 
are automatically prompted to make this file.

Use of the Find Dialog Box During Placement
If you imported parts using the .asc  format, the placement process usually begins with design parts 
overlaying at the design origin.

You can use the Find Dialog Box  to break out and select certain parts, or groups of a package type. The 
dialog box can also attach parts to your pointer for individual placement.

Component Spacing
SailWind Layout provides automated rules checking to ensure adequate spacing between components.

Spacing Basics
The software places components using the units of the Design grid when you enable the snap to grid 
setting of the Design grid.

The software prevents components from overlapping if you have set up a Body to body Clearance  on 
page 1167 rule and the Online DRC  on page 1503 (design rule checking) is in Prevent errors mode.

The preceding illustration shows examples of how some of the design clearance rules are interpreted by 
DRC in various design situations.
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Component Spacing

During placement operations (with Online DRC enabled), the system examines the design rules for the 
component being placed and compares them against other design objects including other components, 
the board outline and board cutouts.

All of the design rules are equally and separately enforced. If values are specified for each of the design 
clearance rules, then they are individually checked. During placement operations (with Online DRC 
enabled), the system does not allow a part to be placed if any design clearance rule is in violation of its 
specified value.

Typically, when a component is moved into the proximity of another component, the system will check the 
following design rules (if values are assigned):

• Body/Layer 20 (placement) outline against other body/Layer 20 (placement) outlines

• Body/Layer 20 (placement) outline against board outline or board cutout(s)

• Pad/SMD to Pad/Via/SMD/Trace/Copper/Text/Board/Drill clearances (with full rules hierarchy 
support)

• Pad and SMD Same Net clearances (with full rules hierarchy support)

The component body is considered to be the furthest extent of any 2D line object on the following layers:

• Component layer (top or bottom)

• Associated silkscreen layer for component layer (silkscreen top or bottom)

• All Layers/Layer 0 (zero).

There is only one “Body to body” clearance value that must apply to all components.

Body-to-Body Checking Rules

The “Body to body” check has specific rules associated with it during placement operations with DRC 
enabled:

• If the body outline encounters another body outline, and no other clearance violations exist, then 
the “Body to body” rule is applied.

• SailWind Layout does not have a “Body to Pad/SMD” design rule, therefore, in a situation where 
a component body/Layer 20 (placement) outline is in proximity to the TH or SMD pads of another 
component, the “Body to body” clearance value is used during checking as the minimum target 
clearance value between the TH/SMD pads and the component body/Layer 20 (placement) 
outline.

• If the TH or SMD pads of a component are in proximity to the TH or SMD pads of another 
component, and the component body/Layer 20 (placement) outlines of the components do not 
violate the “Body to body” clearance value, then the system enforces the corresponding Pad/SMD 
to Pad/Via/SMD/Trace/Copper/Text/Board/Drill clearances (with full rules hierarchy support).

DRC checks the “Body to body” spacing between:
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• Component body outline to component body outline

• Layer 20 outline to Layer 20 outline

• Component body outline to Layer 20 outline

The software references the “Body to body” measurement from the edges of the 2D lines that define the 
body of the components.

Advanced Spacing

While a single “Body to body” clearance may suit many of your components, you may have many parts 
that require extra spacing, for the pick and place process, or for rework.

You can create a custom clearance outline in the decal on Layer 20. The software uses this larger 
placement outline, called a “component courtyard” or “nudge outline”, during the placement process to 
create more spacing around components. The software considers the Layer 20 (placement) outline as 
part of the component body. Whenever it is encountered, the “Body to body” clearance rule is invoked.

Tip
In extended layers mode  on page 315, Layer 20 becomes Layer 120.

Collision Prevention

If you set the Nudge option to “automatic” or “prompt”, when you attempt to overlap parts, the component 
either nudges automatically or you are prompted for the direction to move the component away from the 
one you are placing.

If you disable Nudge and turn off the Online DRC during placement, as a post-process, you can nudge all 
offending components with the Tools  menu > Nudge Components  command, but you have no control 
over the offending components and where they move.

You can create arrays of parts that automatically space rows and columns of components by values that 
you supply using the Create Array Dialog Box.

Spacing Verification
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Moving Components

If you are unsure if components have been placed outside of the design rules that you have set up, you 
can run a clearance check (click the Verify Design  > Clearance  menu item). Be sure that all aspects 
of your components, including the outline color for Layer 20 are visible since the clearance check only 
verifies objects that are visible and within view during its checking routine.

In the Clearance Checking Setup  on page 1164, select the check box for the following:

• Body to body to check for the “Body to body” clearance value between component bodies.

• Placement Outline to check for the “Body to body” clearance value between the Layer 20 outlines

Note:
If you select both the Body to body and the Placement outline checks, the system also checks 
for clearance violations between the component body outlines and the Placement (Layer 20) 
outlines.

Moving Components
You can move components as required to optimize part placement.

Procedure
1. Attach the component(s) to your pointer using one of the following methods:

• On the Standard Toolbar, click the Design Toolbar  button to display the Design Toolbar. On 
the Design Toolbar, click the Move, and then select a component. You can only move one 
component at a time.

• With nothing selected, right-click and click the Select Components  popup menu item, then 
select one or more components to move and drag the component(s) to the desired location. 
The Drag moves option  on page 1531 must be set to Drag and attach or Drag and drop. For 
more information, see “Drag Moves area of the Global > General options  on page 1531”.

• With nothing selected, right-click and click the Select Components  popup menu item, then 
select one or more components to move, right-click and click Move.

• With nothing selected, right-click and click the Select Components  popup menu item, then 
select one or more components to move and on the Design Toolbar, click the Move  button.

If you move a component with a pin that is a locked test point, a Warning appears. For more 
information, see “Troubleshooting”.

When you move a group, an error may appear in a Trace Copy Dialog Box.

If you try to move a component that is part of a physical design reuse, the message “Reuse 
elements cannot be modified. Break the reuse first” appears. Click OK  to cancel the move.

2. The component attaches to your pointer according to the Move preference option  on page 1503.
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Tip
While the component is attached to the cursor, you can right-click and click commands like 
Rotate 90, Spin, Flip Side, change the Move preference, activate Snapping to objects  on 
page 1540, or set the On-line DRC  on page 1503 to ignore clearance rules. Use Bottom 
View  for a more realistic view when placing components on the bottom side of the board.

3. To place the component, use one of the following methods:

• Move the pointer to the new location and click to place the component.

• Use one of the S Modeless Commands  to proceed to a specific coordinate. Press the Spacebar 
key to place the component. This substitutes a mouse click that could move the pointer off the 
coordinate that you specified.

Moving Items With Move by Origin
When you select several objects at once, you can use different origins for the move.

If you select Move by Origin in the Design category of the Options dialog box, the pointer snaps to the 
center of the group, calculated from the extents of the group, and uses it as the origin for the move.

Moving Items With Stretch Traces During 
Component Move
When you select a component with partial traces connected to the pins of the component, the traces 
stretch to remain connected to the pins as long as you have “Stretch traces during component move” 
selected in the Design category of the Options.

Each trace connected to a pin of the moving component connects to the new pin position. If DRC is 
off, straight-line segments are added. If DRC is on, traces are rerouted with smoothed patterns using 
AutoRoute. When “Stretch traces during component move” is not selected, unroutes are created between 
the tacks of the trace connections.

Moving Design Objects Radially
Use Radial Move to adjust the orientation of objects. This command supports creation of circular decals 
and circular boards. You can also use Radial Move with text and reference designators.

Restrictions and Limitations

• You must set up a Polar Grid  on page 352.

• In the PCB Decal Editor, you can only use Radial Move with terminals.
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Procedure
1. Select single or multiple components or unions. In the PCB Decal Editor, select single or multiple 

terminals.

2. On the Standard Toolbar, click the Design Toolbar  button to display the Design Toolbar.

3. On the Design Toolbar, click the Radial Move  button. The status bar displays the current polar 
radius and polar angle position in addition to the angular and radial increments.

Tip
You can alternately move design objects radially using verb mode. First, on the Design 
Toolbar, click the Radial Move  button and then select the desired design object(s) to 
move. This method will keep the Radial Move command active and allow you to repeat the 
operation again after you have finished moving you first selection(s).

4. If you did not previously set up the polar grid to match your design requirements, click the Tools  > 
Options  menu item, select the Grids  category, then click Radial Move Setup. The Radial Move 
Setup dialog box appears. For more information, see “Radial Move Setup Dialog Box”.

Set up the polar grid and move options and click OK. SailWind Layout saves these settings to 
apply to any future use of Radial Move in the current session.

The polar grid appears and the selected objects attach to the pointer.

5. Move the selected objects to an eligible site.

6. Click to indicate a location on the polar grid for the selected objects.

Tip
When you exit Radial Move, the polar grid is turned off. Use the GP modeless command 
on page 83 to turn the polar grid on and off independently of Radial Move.

Examples
Placing or moving parts on a radial grid utilizes a slightly different approach than that of the standard x/y 
grid. Examples will illustrate the behavior of the placement and move commands when using the polar 
grid.

The following graphic shows an example polar grid definition.
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Figure 31. An Example Polar Grid Definition

The following table shows the Radial Move settings used to create the polar grid in the figure above.

Table  96. Radial Move Settings

Option Setting

Polar Grid Origin X=1000, Y=1000

Inner Radius 100 (mils)

Delta Radius 100 (mils)

Start Angle 30.000 (degrees)

Angle Range 360.000 (degrees)

Delta Angle 20.000 (degrees)

Sites Per Ring 18

Direction Clockwise

Auto Rotate On

Disperse On

Use Discrete Radius On

Use Discrete Angle On

Polar Orientation Let Me Specify, 0.000 (degrees)

482 SailWind Layout Guide and Reference



 
Part Placement

The Radial Move Shortcut Menu

The Radial Move Shortcut Menu
The Radial Move shortcut menus provides a specific selection of commands for use during radial move 
operations, such as rotating or flipping an object or specifying where to grab the object during movement.

Right-click to open the Radial Move shortcut menu (Table 97).

Table  97. Radial Move Shortcut Menu Items

Command Description

Properties Queries the component or union.
For more information, see “Modifying Component Properties”.

Rotate 90 Rotates the part while calculating the orientation of the part relative 
to the radial direction, from the grid origin to the current position of 
the part's move origin. Each part or union rotates using its individual 
origin point.
For more information, see “Rotating an Object”.

Flip Side Flips each object individually around its radial direction.
For more information, see “Flipping a Component”.

Move by Cursor Location Moves objects according to the relationship between the cursor 
location and the origin of the moved object.
The default move preference is found in the Options Dialog Box, 
Design Category.

Move by Origin Moves objects by the origin of the object.
The default move preference is found in the Options Dialog Box, 
Design Category.

Move by Midpoint Moves objects by the midpoint of an object or a group of objects. 
Snaps to the current pointer position.
The default move preference is found in the Options Dialog Box, 
Design Category.

Ignore Clearance Temporarily ignores clearances for design rules.
The default On-line DRC setting is found in the Options Dialog Box, 
Design Category.
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Sequential Component Placement
After selecting a predetermined set of components, you can use the “Move Sequential” command to 
sequentially place components on your pointer for placement in the design.

Placing Components Sequentially Using the Find Dialog Box
Placing Components Sequentially in the Workspace

Placing Components Sequentially Using the Find 
Dialog Box
Use the Find dialog box to choose components by selecting them from a list. This method places the 
components on your cursor in alphanumeric order.

Procedure
1. Click the Edit  > Find  menu item.

2. In the Find Dialog Box, set Find by to Ref. Designator, Part Type, Decals, Unions or Clusters.

Tip
Select multiple Ref. Des. prefixes, part types or decals in order to expand the list of 
available components.

3. From the resulting list, select all the parts you want to move. Drag or use Shift-click for a range of 
components, and/or Ctrl+click for multiple components.

4. In the Action list, choose Move Sequential.

The Move by ascending Ref Des order has no function when used with the Find dialog box. 
Components are always added to the pointer in ascending Ref Des order. This feature is only used 
by the Placing Components Sequentially in the Workspace  method.

5. Click OK.

6. In the dialog box, “Proceed with next object? <value>” click:

• Yes  — to attach parts to the cursor successively, but prompt after every placement to allow you 
to skip over components if desired

• Yes to All  — if the alphanumeric order of the selection is okay and you do not intend to skip 
over components.

• No  — to skip this part, and go to the next.

The first part is attached to the pointer for placement. Parts are attached to the pointer in 
ascending Ref Des order.

With a part attached to the pointer, you can right-click to access the Rotate 90, Spin mode, Flip, 
move preferences, and Snap to features and commands. You can also use modeless commands.
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If a part selected for Move Sequential has a pin that is a locked test point, a Warning dialog box 
appears informing you of changes you are making to the test point. Test points are locked in the 
Routing options  on page 1542.

7. Click to place each component, union, or cluster.

Placing Components Sequentially in the 
Workspace
You select components by either using the Project Explorer or by right-clicking directly in the working 
area to apply the Move Sequential command. This method places the components on your cursor in the 
reverse order of your selection order - last component selected is attached to the cursor first.

Procedure
1. Use one or both of the following methods to select the components:

• In the Project Explorer with Allow Selection  on page 53 enabled, use Ctrl+click to select 
multiple components.

• In the working area, with nothing selected, right-click and click the Select Components, Select 
Unions/Components, or Select Clusters  popup menu item. Using Ctrl+click, select multiple 
components, unions or clusters.

The parts are attached to the pointer in the order in which they are selected. The first component 
selected is the first one attached to the pointer. You can override this in a later step.

2. In the working area, right-click and click the Move Sequential  popup menu item.

Note:
The Move by ascending Ref Des order can override the order in which you selected the 
components and place the components on your pointer in ascending Ref Des order.

3. In the dialog box, “Proceed with next object? <value>” click:

• Yes  — to attach parts to the cursor successively, but prompt after every placement to allow you 
to skip over components if desired

• Yes to All  — if the alphanumeric order of the selection is okay and you do not intend to skip 
over components.

• No  — to skip this part, and go to the next.

The first part is attached to the pointer for placement. With a part attached to the pointer, you can 
right-click to access the Rotate 90, Spin mode, Flip, move preferences, and Snap to features and 
commands. You can also use modeless commands.

You can set the Move preference to select a part by its Origin or Midpoint in the Design options  on 
page 1503.

Placement uses the current design grid. To place components with a Radial Move, turn on the 
polar grid on using the GP modeless command  on page 83.
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If a part selected for Move Sequential has a pin that is a locked test point, a Warning dialog box 
appears informing you of changes you are making to the test point. Test points are locked in the 
Routing options  on page 1542. For more information, see “Troubleshooting”.

4. Click to place the component.

Related Topics
Creating a Component Array

Automatic Placement

Use of the Find Dialog Box During Placement
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Modify the Board-Side Location of 
Components
Use Flip Side to move a part or parts to the opposite side of the board. The flipped part moves to the 
opposite side in a hinging motion, pivoting on a vertical axis through the part origin.

Text is mirrored so it always appears in the proper orientation. Use Flip Group  on page 488 to flip a 
component or components around an origin point you specify.

When you flip a component to the opposite side, layer associations change with the component. To turn 
off moving layer associations with components, set the /NTL switch  on page 488 before using Flip Side 
or Flip Group.

CAUTION:
Use associated copper rather than free copper in decals in the solder or paste mask. Results are 
unexpected when TrueLayer is on and you use free copper.

Flipping a Component
Flipping a Group
Use of the /NTL Switch

Flipping a Component
You can move a component to the opposite side of the board using its origin as the mirror point.

Procedure
1. Select one or more components to move to the opposite side.

2. Use one of the following:

• Right-click and click the Flip Side  popup menu item.

• Right-click and click the Properties  popup menu item. In the Component Properties Dialog 
Box, select the opposite layer in the Layer list.

Results
If DRC is on and the system encounters a clearance violation, the flip is canceled. Test points flip with the 
flipped component.

Tip
Use Bottom View  for a more realistic view when placing components on the bottom side of the 
board.
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Flipping a Group
You can move a group of components to the opposite side of the board by specifying the mirrored 
location.

Procedure
1. Select the components, right-click, then click the Flip Group  popup menu item.

2. Click to indicate the mirror location.

Use of the /NTL Switch
Layer associations automatically switch with a component when you flip it to another side.

Typically you would want to layer associations to move with the component. For example, you move a 
surface mounted component to the bottom of the board. The assembly drawing, silkscreen, solder mask 
and paste mask layer information moves from the top side to the bottom side documentation layers.

If for some special reason, you do not want this to occur, set the /NTL switch before starting SailWind 
Layout to turn TrueLayer associations off. For more information, see “Software Launch Options”.
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Component Arrays
You can arrange parts by creating arrays. A component array is a union with members placed on sites of 
a user-defined matrix.

Component Array Examples
Creating a Component Array
Modifying a Component Array

Component Array Examples
You can create either planar arrays or circular arrays.

Polar Grid or Circular Array
A number of specific values are utilized in the configuration of a polar grid or circular array.

The figure below shows the different values that you set to create a polar grid or a circular array. In a 
circular array, components are placed equal distances from each other on one or several rings. By turning 
on the polar grid and Snap to Grid, you can create drafting items with corners located at the nodes of the 
polar grid.

Figure 32. Polar Grid Array

Planar Array

A planar array is a union of components that are placed on the intersections of equidistant parallel lines.

The figure below shows the different values that you set to create a planar array. The parallel lines can 
exist in both the X and Y directions.
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Figure 33. Planar Array

Component Array Examples

Examples will illustrate different methods that can be utilized to setup component arrays.

The figure below represents an original PCB design with eight components selected to create an array.

Figure 34. PCB Design with an Array

The following examples represent the same eight components using different grid and array settings.

Example 1

The figure below shows a planar array of the original eight components with a minimum body-to-body 
clearance of 6 mils and 45-degree rotated components:
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Figure 35. An Example Planar Array (Minimum Body-to-Body Clearance of 6 mils)

The table below shows the settings used on the Planar Array tab to create the planar grid in the figure 
above.

Table  98. Planar Array Settings (6 mils)

Option Setting

Row to Row 193.7 (mils)

Column to Column 140.24 (mils)

Number of Columns 4

Place by Columns On

Rotate On

Orientation 45 (degrees)

Align by Origin

Example 2
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The figure below shows the example planar array of the original eight components with a minimum body-
to-body clearance of 200 mils.

Figure 36. An Example Planar Array (Minimum Body-to-Body Clearance of 200 mils):

The table below shows the settings on the Planar Array tab used to create the planar grid in the figure 
above.

Table  99. Planar Array 
Settings (200 mils)

Option Setting

Row to Row 430.15 (mils)

Column to Column 293.4 (mils)

Number of Columns 4

Place by Columns On

Rotate On

Orientation 0.000 (degrees)

Align by Origin
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Example 3

The figure below shows an example circular array of the original eight components with a minimum body-
to-body clearance of 200 mils:

Figure 37. An Example Circular Array

The table below shows the settings on the Planar Array tab used to create the circular array in the figure 
above.

Table  100. Circular Array Settings

Option Setting

Inner Radius 576.68 (mils)

Delta Radius 0 (mils)

Start Angle 5 (degrees)

Angle Range 360 (degrees), Locked

Delta Range 45.000

Sites per Ring 8

Direction Counterclockwise
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Table  100. Circular Array Settings  (continued)

Option Setting

Rotate On

Orientation 0.000

Align by Origin

Creating a Component Array
You can arrange parts by creating either circular or planar arrays.

Procedure
1. Select the components you want, right-click, then click the Create Array  popup menu item.

2. Click the tab that represents the array you want to create: Planar Array or Circular Array.

3. Set the options for the array and click OK. A dialog box appears asking you for an array or union 
name. For more information, see “Component Arrays”.

4. Type a name for the array or accept the default name and click OK. By default, arrays are 
sequentially named with an ARR_ prefix; for example, the first array in your design is named 
ARR_1, the second array is named ARR_2, and so on.

The array is created and attaches to your pointer.

You can use Move shortcut menu commands, such as Flip, Spin, and Rotate, while placing the 
array.

If you move a component with a pin that is a locked test point, a warning appears. For more 
information, see “Troubleshooting.”

If you try to move a component that is part of a physical design reuse, the message “Reuse 
elements cannot be modified. Break the reuse first” appears. Click OK  to cancel the move.

5. Click to indicate a location for the array.

Modifying a Component Array
Using Modify Array, you can rearrange the components in an array after placing it, or you can modify a 
union.

Restrictions and Limitations
When modifying a component array:

• You must select Unions in the Selection Filter to select arrays and unions.

• You can only modify one array or union at a time.
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Procedure
1. Select an array or union, right-click, then click the Modify Array  popup menu item.

• If you are modifying an array, the Modify Array dialog box appears with the tab displayed and 
the options used to create the array.

• If you are creating an array from a union, a dialog box appears asking whether to dissolve the 
union to create an array. Click Yes  to create the array from the Union. The Create Array dialog 
box appears.

2. Modify array options as necessary.

Modify Array does not enter Move mode as Create Array does.

Modify Array does not warn against nor prevent placement violations unless On-line DRC is in 
Prevent errors or Warn errors mode.

If you modify the location of an array that contains a component with a pin that is a locked test 
point, a warning appears. For more information, see “Troubleshooting.”

3. Click OK. The array is modified or created from the union.

4. If On-line DRC is in Prevent errors or Warn errors mode, click to indicate a new position for the 
modified array.

Aligning Objects
Alignment snaps selected parts to an imaginary line coming from a side or center of a guide component. 
After placing objects roughly in position, you can select several objects and automatically align them. The 
alignment command aligns all selected objects with the last one selected.

You can use Align with: pins (and align components by those pins), reference designators, unions in the 
Layout Editor, and terminals and terminal numbers in the PCB Decal Editor.

Procedure
1. Using Ctrl+click, select the objects you want to include in the alignment ensuring that you select 

the master object last.

2. Right-click and click the Align  popup menu item.

Restriction:
You cannot align elements in a physical design reuse. Align becomes unavailable when 
you select physical design reuse elements.

3. In the Align dialog box  on page 1080, click the alignment scheme you want to use. The objects are 
automatically aligned according to the position of the last one selected.

Automatic alignment does not guarantee minimum spacing if on-line DRC is not enabled, but you 
can use Nudge to accomplish this interactively. If On-line DRC is set to Prevent or Warn, Align 
does not perform the alignment if it causes a violation. Violations are reported in the status bar.
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Rotating an Object
You can rotate objects in 90 degree increments.

Procedure
1. Select the object to rotate. You can select more than one object at a time.

2. Right-click and click the Rotate 90  popup menu item. The selected object rotates 90 degrees 
counterclockwise.

If you rotate a component with a pin that is a locked test point, a warning appears. For more 
information, see “Troubleshooting.”

When you rotate a group, an error may appear in one of the Trace Copy dialog boxes. For more 
information, see “Trace Copy Dialog Box.”

If you try to rotate a component that is part of a physical design reuse, the message “Reuse 
elements cannot be modified. Break the reuse first” appears. Click OK  to cancel the operation.

Tip
To use Rotate 90 in Verb Mode, click the Rotate  button on the Design Toolbar and then 
select the part to rotate.

3. Repeat step 2 to continue rotating the objects.

Spinning an Object
You can spin an object on its axis during part placement.

Procedure
1. Select the object to spin.

2. Right-click and click Spin. The part attaches to the pointer. As you move the pointer, the part 
follows, changing the rotation angle.

You can multiple-select and rotate a group of parts in the same way; each turns on its own axis.

To view the angle of rotation as you spin the part, right-click and click Properties. The current 
angle appears in the Rotation box.

If you spin a component with a pin that is a locked test point, a warning appears. For more 
information, see “Troubleshooting”.

If you try to spin a component that is part of a physical design reuse, the message “Reuse 
elements cannot be modified. Break the reuse first” appears. Click OK  to cancel the operation.

3. Click to indicate a new angle.

4. To use Spin in Verb Mode, click the Spin  button on the Design Toolbar, and then select the part to 
spin. click to indicate a new angle.
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Swapping Parts
Sometimes simply switching neighboring parts' positions can improve connection length. You can swap 
the position of two parts anywhere on the board using the “Swap Part” command. When Online DRC is 
selected, the swap is examined for placement violations.

Procedure
1. To begin, use one of the following methods:

• For a single swap  — Select a part > Design Toolbar button > Swap Part  button.

• For multiple swaps  — Design Toolbar  button > Swap Part  button > select the first part to 
switch.

2. Select the second part to switch.

3. You are prompted to allow the swap and at the same time, the X + Y connection lengths before 
and after the swap appear in the status bar so you can see whether the lengths improve.

4. Click Yes  to complete the swap. Parts are swapped origin-to-origin.

If you chose the multiple swap method and you are still in Swap Part mode, you can continue to 
choose parts to swap.
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Interactive Placement Tools
You can place parts to exact tolerances using the alignment and nudge tools.

When placing parts interactively, note the following effects of alignment and nudge:

• Alignment snaps selected parts along an imaginary line coming from a side or center of a guide 
component.

• Nudge eliminates overlaps and clearance violations by pushing parts aside to make room for a 
crowded component.

Tip
For nudging, all component elements are considered glued. Align and Nudge are 
unavailable when you select physical design reuse elements.

Nudging Parts
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Nudging Parts
When parts are close enough to violate either pad-to-pad or body-to-body clearance rules, they are 
considered overlapping.

Nudge and Design Rule Checking (DRC)
Nudge Overlapping Parts
Nudging All Components
Nudging Single Parts

Nudge and Design Rule Checking (DRC)
When DRC is set to Prevent, SailWind Layout actively prevents overlapping by canceling the completion 
of an illegal move and returning the selected component to Move mode.

This automatic checking can be further refined using Nudge. Nudge is a shove function for parts; it 
resolves overlapping by moving surrounding parts away from the part you are trying to place. Nudge has 
three operational modes that you set on the Design  category of the Options dialog box. As shown in the 
table below, Nudge operation is dependent on the current DRC setting:

Table  101. DRC Setting and Nudge Modes

DRC Setting Prevent Warn Off or Ign Clrn

Auto Overlapping parts are automatically moved and unhighlighted. If relocation is 
not possible due to available space, a message appears.

Warn The Nudge dialog box appears for user interaction.

Off No Nudge operations 
occur. The selected 
part remains attached 
to the cursor.

The Clearance Violation 
dialog box appears. The 
choices are:
Ignore  — Places part 
without adjusting overlapping 
parts.
Explain  — Lists the 
intersecting parts.
Cancel  — Cancels the 
command; the part remains 
attached to the cursor.

The part is placed 
without moving 
overlapping parts.

When you use Nudge for placement, SailWind Layout approximates the component size. For example, 
if you placed an L-shaped component, SailWind Layout approximates that part area as a square, not as 
an L. Nudge then uses the greater of the pad-to-pad or body-to-body clearances defined in Design Rules 
setup to determine the distance that must exist between two components.

In many cases, several parts are adjusted to accommodate the moved part. Nudge does not move glued 
parts or parts outside the board outline. Nudge treats test points as glued objects. Nudge does not move 
parts inside the board outline outside the outline. When an overlap exists, the Nudge Parts and Unions 
dialog box appears.

Nudge does adhere to the current grid setting, so be sure you set the grid fine enough for the command 
place within the restrictions of your routing strategy.
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Nudge Overlapping Parts
Use Nudge to move overlapping parts. The manner in which Nudge operates is dependent on the current 
DRC setting.

For more information, see Nudging Parts.

Nudging All Components
You can move all overlapping parts at once using the Nudge Components command. Nudge eliminates 
overlaps and clearance violations by pushing parts aside to make room for a crowded component.

Procedure
Click the Tools  > Nudge Components  menu command.

All components are automatically nudged according to the design rules.

Nudging Single Parts
Nudge eliminates overlaps and clearance violations by pushing parts aside to make room for a crowded 
component. You can use Nudge to move an individual part that overlaps another part.

Procedure
1. Select a part.

2. Right-click and click the Nudge  popup menu item. For more information, see

Nudge does not move glued parts or parts outside the board outline. Parts inside the board outline 
are not nudged outside the outline.

Nudge considers test points to be glued objects.

You cannot nudge elements in a physical design reuse. All component elements are considered 
glued. Nudge is unavailable when you select physical design reuse elements.

3. In the Nudge Parts and Unions Dialog Box  on page 1495, click the nudge direction and the 
direction to move overlapping parts.

4. Click Run  to perform the nudge.

5. Often, several parts are adjusted to accommodate the moved part. Nudge identifies these parts, 
and allows for further adjustments, by displaying them in a specific color:

• Select color  — All parts affected by the Nudge routine.

• Highlight color  — The part to move in the next pass of Nudge.

Changing the Part Outline Width
You use this procedure to change the width of the 2D lines that indicate the part outline on Silkscreen Top/
Bottom layers.
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Restrictions and Limitations

• This procedure does not apply to placement (nudge) outlines created on Layer 20.

Procedure
1. Select a component, right-click, and then click the Properties  popup menu item.

2. Type a width (between 0 and 250) in the Part Outline Width box.

3. Click OK.

This change is reflected in the design only; the library is not updated.

Alternate decals in use are modified; alternate decals not in use are not modified.

Online DRC “Body to body” checking and Verify the Design  look at the part outline when checking.

CAUTION:
In SailWind Layout, the “Body to body” clearance checks are performed between the 
edges of the lines used to define the component body outlines. Increasing the widths of 
these lines may impact the spacing between existing components in the design and require 
you to perform a Verify Design Clearance check to assure that all of the “Body to body” 
clearances are maintained.

4. To update all parts that have the same decals as the selected parts with the new part outline width, 
click Continue.

Modifying Component Properties
You can edit or change component properties to reflect changes in the design.

Procedure
1. Select a component.

2. Right-click and click the Properties  popup menu item. The Component Properties Dialog Box 
appears.

Restriction:
Several of the options on the dialog box are unavailable when the component is part of a 
physical design reuse.

3. Make any necessary changes and click OK.

Creating a Label
You can create labels using the Labels  tab in the Component Properties dialog box.
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Procedure
1. Select a component.

2. Right-click and click the Properties  popup menu item. The Component Properties Dialog Box 
appears.

3. On the Labels  tab, in the Label list, click <new> and click the Label  button. For more information, 
see Adding a New Part Label.

4. From the Attribute list, click the attribute for which you want to create a label. When you click an 
attribute, the value for the attribute appears in the Value box.

Restriction:
The only attribute available for jumpers is the reference designator.

5. Accept the current value or type a new value. If you click Reference Designator or Part Type from 
the Attribute list, you cannot change the value.

This box is unavailable if the attribute is read-only  on page 1853. This box is also unavailable if the 
attribute is ECO-registered  on page 1824 and SailWind Layout is not in ECO mode.

6. Set the visibility status and the placement information for the label.

7. Set the justification, right-readability, height, and width of the label.

8. Click the layer on which to place the label, and then click OK  to create the label.

Tip
If you do not set visibility information (such as in steps 4, 5, and 6), default positions are 
used. For more information, see Label Defaults.

Note:
Labels are not checked for clearance violations. If you want to output labels from CAM as 
metal or copper, such as on a Routing layer, check your label placement carefully.

Editing a Label
The Label List contains existing labels for reference designators, part types, and attributes.

Procedure
1. Select a component.

2. Right-click and click the Properties  popup menu item. The Component Properties Dialog Box 
appears.

3. On the Labels  tab, click a label in the list and click the Label  button in this tab.
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4. A label is selected instead of the component, and the corresponding Part Label Properties dialog 
box  on page 590 appears where you can modify the label.

Restriction:
When modifying the Properties of a jumper name, Reference Designator is the only 
available label.

Related Topics
Component Properties Dialog Box

Cluster and Union Placement
Use cluster placement features to create associations or groupings of connected parts.

Two object types are used:

• Unions  — are user-created part associations that have a strict relationship with each other. 
An example of this is associating a filter capacitor to reside on top of an IC. When you move 
or place a selected union, the physical relationship between the parts, or union members, 
remains unchanged. Unions are not created using the Cluster Placement routines, but they are 
considered during cluster creation and automatic placement operations. For information, see the 
Unions  topic.

• Clusters  — are collections of individual parts, unions, and other clusters, based on connectivity. 
A series of ICs and associated discrete components that make up a memory array could make 
up a cluster. Clusters differ from unions because the parts that belong to the cluster, or cluster 
members, are rearranged within the cluster to improve placement.

Clusters are useful in very large designs or in designs where areas of the board are separated 
into different functions. You can create or modify clusters manually or automatically. You can also 
automatically place individual parts using this feature. For more information, see the Placing Parts 
Automatically  and Moving Clusters Interactively  topics.

Any operation that creates, displays, or modifies clusters (except the Cluster Manager) 
automatically places you in Cluster View mode. For more information, see the Cluster View Mode 
topic.

Cluster Display Settings
The circle that represents a cluster is assigned in the Display Colors Setup dialog box as a 2D Lines 
property on the Top layer. The text representing the cluster name is assigned as a Text property on layer 
20.

The connection lines originating from the center of the cluster (the same as in the normal view) are 
assigned with the Connection setting in the Display Colors Setup dialog box.
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Unions
Unions  are user-created part associations that have a strict relationship with each other, such as distance, 
rotation angle, top, or bottom side.

A common example is placing a filter capacitor to reside on top of an IC. When a selected union is moved 
or placed, the physical relationship between the parts, or union members, remains unchanged.

Creating a New Union
Creating Like Unions
Selection of Unions
Adding a Part to a Union
Modifying Unions
Delete a Union or Union Members
Remove a Part from a Union
Remove an Entire Union

Creating a New Union
You can create a union consisting of two or more parts.

Procedure
1. Select and position the parts that you want to make a union in a specific pattern. Leave the parts 

selected.

2. Right-click and click the Create Union  popup menu item. The Union Name Definition dialog box 
appears with a default name.

3. Use the default name or type a new name for the union, and click OK.

Creating Like Unions
You can use a union as an example to automatically create other unions of the same configuration.

Procedure
1. Select a union, right-click, and then click Create Like Unions.

A dialog box appears to “Confirm Creating Like Unions”.

2. Click Yes to continue.

3. In the dialog box that appears prompting “OK to Disperse new unions?” do one of the following:

• Click Yes  to disperse the newly created unions around the board outline.

• Click No  to disperse parts, and the message “Keep Base?” appears. This message asks 
whether to position the members of the new unions to match the union used for creation.
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• Click Yes to reposition the new unions exactly like the base part

• Click No  to leave the new unions in their current position.

Tip
Create Like Unions ignores parts with test points.
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Selection of Unions
You can select unions either manually or automatically.

Select a Union From a Union Member
Automatically Select a Union When One of Its Members is Selected

Select a Union From a Union Member
Select the first item in a union and then find the related objects.

Procedure
1. Select a member of a union.

2. Right-click and click the Select Union  popup menu item.

Automatically Select a Union When One of Its Members is 
Selected
Automatically select all members of a union when you select the first object.

Procedure
1. Click Edit  > Filter.

2. Click both the Parts and Unions options. For more information, see Refined Object Selection

Adding a Part to a Union
If desired, you can add parts to an existing union.

Procedure
1. Set the filter to select the entire union when you select a member. For more information, see 

Refined Object Selection

2. Use multiple selection, Ctrl+click, to select the parts to add.

3. Right-click and click the Create Union  popup menu item. The message “Break union and include 
its parts in new?” appears.

4. Click Yes  to add the new parts.

5. Click Yes  to use the same union name.

Modifying Unions
The Union Modification Flag setting that prevents you from modifying unions sets automatically when you 
start SailWind Layout. You can alter this setting.
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Procedure
1. Select a member of any union.

2. Right-click and click the Modify Union Member  popup menu item. This option remains active for 
the entire SailWind Layout session. Click the option again to return it to the default state.

Delete a Union or Union Members
You can remove a part from the union or remove the entire union.

You can choose the method that meets your design requirement:

• Remove a Part from a Union  — Use this method to remove an individual part from a union.

• Remove an Entire Union  — Use this method to remove the entire union from the design.

Remove a Part from a Union
If desired, you can break a part out from a union.

Procedure
1. Select the part to remove.

2. Right-click and click the Break From Union  popup menu item.

Remove an Entire Union
If desired, you can break apart a union.

Procedure
1. Select the union.

2. Right-click and click the Break  popup menu item.

Tip
Use the Break Like Unions and Break All Unions options to remove all like unions or 
remove all unions.

Related Topics
Union Properties Dialog Box
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Cluster Placement
With Cluster Placement you can create associations, or groupings, of connected parts.

Cluster Placement works with the following two object types:

• Unions  — User-created part associations that have a strict relationship with each other.

• Clusters  — Collections of individual parts, unions, and other clusters, based on connectivity.

Creating New Clusters
Modifying Existing Clusters
Cluster View Mode
Display Parts in Cluster View Mode
Moving Clusters Interactively
Delete a Cluster
Collapse Clusters
Collapsing All Clusters
Collapsing Cluster Members
Automatic Placement
Cluster Management

Creating New Clusters
You can manually create new clusters.

Procedure
1. Select the parts, unions, and other clusters to include in the cluster.

2. Right-click and click the Create Cluster  popup menu item. The cluster parts are erased and 
replaced by a circle with all connections originating from its center. This circle represents the 
cluster.

Modifying Existing Clusters
You can add parts and clusters to another cluster manually, semi-automatically, or automatically. You can 
only remove parts from existing cluster manually.

Procedure
1. Select the clusters to change.

2. Right-click and click the following popup menu items:
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• Edit Manual  — Click Add to Cluster to add to the selected cluster. The item appears in the 
current Highlight color. Click Remove from Cluster  to remove a highlighted item from the 
cluster. Click Complete  from the shortcut menu to finish modifying the cluster.

• Grow Incremental  — Opens the Cluster Grow Incremental dialog box  on page 1177 which 
contains information on the highlighted cluster plus the following buttons:

• Accept  — Adds the highlighted item to the selected cluster.

• Skip  — Skips this item and highlights the next.

• Stop  — Adds the items identified through the Accept button and completes the operation.

• Cancel  — Cancels the operation without modifying the selected cluster.

• Grow Automatic  — Opens the Cluster Size Limit Definition dialog box  on page 1177 which 
displays the current size of the cluster, or the number of cluster members, plus a text window 
containing the recommended number of cluster members. Click OK  to accept the new value, or 
type a higher value to add additional parts to the cluster.

Tip
Use the Cluster Manager  on page 1171 to modify existing clusters using a dialog box.

Cluster View Mode
SailWind Layout automatically switches to Cluster View Mode any time you create or modify clusters, 
unless you are using Cluster Manager. Click View  > Clusters  to switch between Cluster View and normal 
view.

In Cluster View Mode, several commands and options are unavailable or limited.

Display Parts in Cluster View Mode
You can display parts belonging to a cluster while in Cluster View Mode.

Procedure
1. Click Edit  > Filter.

2. Click Clusters.

3. Select the cluster.

4. Right-click and click the Show Contents  popup menu item. The parts appear in the current 
Highlight color.

5. To return the cluster to cluster view mode right-click and click Cancel.
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Moving Clusters Interactively
If necessary, you can reposition a cluster.

Procedure
1. Select a cluster, right-click, and then click the Move  popup menu item.

2. Move the cluster to a new location and click. The cluster moves to the new location and the 
members of the cluster collapse  on page 1816. You can set SailWind Layout so that clusters do 
not collapse after moving. For more information see Collapse Clusters.

Tip
Autoplacement features ignore components that are part of a physical design reuse.
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Delete a Cluster
You can remove an individual cluster or all clusters.

Remove a Single Cluster
Remove All Clusters

Remove a Single Cluster
You can remove a single cluster in a design.

Procedure
1. Select the cluster. You can make multiple selections.

2. Right-click and click the Break  popup menu item.

Remove All Clusters
If desired, you can remove all clusters in the design at once.

Procedure
1. Select any cluster.

2. Right-click and click the Break All Clusters  popup menu item.

Collapse Clusters
The “Collapse” command relocates the cluster members to the center of the cluster. The Place Parts 
process of Cluster Placement eliminates overlaps created when you collapse a cluster.

You can also move each part manually. Collapse operations ignore glued objects or unions containing 
glued objects.

Tip
To switch between viewing parts and viewing clusters click the View  > Clusters  menu item.

Collapsing All Clusters
You can collapse all clusters in the design at one time.

Procedure
1. With nothing selected, right-click and click the Select Clusters  popup menu item.

2. Right-click and click the Select All  popup menu item.

3. Right-click and click the Collapse Members  popup menu item.
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Collapsing Cluster Members
Be default, clusters in SailWind Layout collapse after moving them. However, you can change this setting.

Procedure
1. While moving a cluster, right-click and click the Collapse Cluster Members  popup menu item.

2. The cluster is collapsed.

Tip
Collapse Cluster Members is set to on each time you start SailWind Layout.

Related Topics
Cluster and Union Placement

Cluster Information Properties Dialog Box

Cluster Properties Dialog Box

Build Clusters Setup Dialog Box

Cluster Manager Dialog Box

Cluster Placement Dialog Box

Place Clusters Setup Dialog Box

Place Parts Setup Dialog Box
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Automatic Placement
Use the Cluster Placement dialog box to build new clusters, place clusters within the board outline, and 
place parts within the board outline.

Preparing for Automatic Placement
Placing Parts Automatically

Preparing for Automatic Placement
After you create a board outline and import a netlist, SailWind Layout locates all parts at the board origin. 
You can then prepare your design for automatic placement and begin the automatic placement process.

Procedure
1. Set the Design Grid to accommodate the parts you want to place. In English units a common grid 

is 100 or 50 mils for ICs and 50 mils for discrete parts. Start with a grid that is the most common 
denominator for your ICs.

2. Place all parts that should be in a fixed location, such as connectors, mounting holes, and so on. 
Select these parts.

3. Click the Properties  button.

4. Select the Glued check box in the Properties dialog box to prevent Automatic Placement from 
moving the parts.

5. Click the Tools  > Disperse Components  menu item to move all unglued components outside and 
around the board outline. Disperse arranges parts around the board outline based on height and 
length.

Tip
Disperse ignores components that are part of a physical design reuse.

6. On the Drafting Toolbar, click the Component Keepout  button to create areas where parts should 
not be placed during automatic placement.

7. Use the Rotate  and Flip  buttons to arrange parts that should be placed at an angle or reside on 
the bottom side of the design.

Placing Parts Automatically
As a time-saving option, you can choose to place parts on your PCB design automatically.
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Procedure
1. Click the Tools  > Cluster Placement  menu item.

2. Click the Place Parts  button. To modify the automatic placement options, click the Setup  button 
(below the Place Parts button). For more information see Place Parts Setup Dialog Box.

3. Click Run. A status dialog box appears to show placement progress. For more information see 
“Automatic Placement”.
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Cluster Management
Use Cluster Manager to display and manage cluster members and unions. You can move cluster 
members and unions from one cluster to another and break, or delete, clusters.

Cluster Manager works similarly to the Microsoft Windows Explorer; with it you can view items at the top 
level or at any level of the hierarchy.

The main elements of the Cluster Manager dialog box are two list boxes showing all clusters, unions, and 
components that exist in the design.

Adding a Component to a Cluster
Making Members of One Cluster Part of Another

Adding a Component to a Cluster
If desired, you can add additional components to an existing cluster.

Procedure
1. Click the Tools  > Cluster Manager  menu item.

2. In one list box, view the hierarchy of the cluster you want to add to.

3. In the other list box, select the components you want to add to the cluster.

4. Click the Move Arrow  button.

Making Members of One Cluster Part of Another
If desired, you can merge members of one cluster into another.

Procedure
1. Click the Tools  > Cluster Manager  menu item.

2. View the hierarchy of the cluster to add to in either list.

3. In the other list, view the hierarchy of the cluster containing the members to merge.

4. Highlight the members you want to move.

5. Click the Move Arrow  button.

Results
Removing all members from a cluster empties the cluster, but does not delete the cluster name until you 
click OK  to end the session. Before clicking OK, you can add members to this empty cluster by double-
clicking it and repeating the above steps for the members to add.
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Chapter 22
SailWind 3D

As an alternative to standard two dimensional board layout, SailWind Layout provides a three 
dimensional, graphical representation of your project in the SailWind 3D window. In addition to allowing 
interactive component placement, the SailWind 3D window also renders your board layout in a realistic 
three dimensional view, thereby letting you preview your design, perform physical measurements from 
one component to the next, and check clearances with imported mechanical designs, such as mounting 
brackets.

SailWind 3D Overview
SailWind 3D Object Manipulation
3D Model Mapping
Assigning a 3D Model to a Component
Reusing 3D Models with Other Components in a Design
Holes in SailWind 3D
Changing a 3D Model Assignment
Importing and Aligning 3D Mechanical Models
Positioning 3D Mechanical Models Using Mating Commands
Creating a Board Outline From an Imported Mechanical Model
Creation of 2.5D Models
Compare 3D and 2.5D Models
Comparing 2D Components with 3D Models
Saving 3D Models for Re-use in Other Designs
Component Placement in the SailWind 3D Window
Synchronizing the Design and SailWind 3D Viewing Areas
Defining 3D Clearance Constraints
Viewing DRC Violations in SailWind 3D
Running Batch 3D Clearance Checking
Changing the Appearance of Components and Models in 3D
Measuring In 3D with Measure Distance
Measuring In 3D with Measure Minimum Distance
Viewing Internal Layers in SailWind 3D
Creating 3D Cross Sections
Checking the Status of the 3D Design
Exporting the 3D Image to a 3D PDF File
Exporting the 3D Image to a Graphics File Type
Exporting the 3D Image as a Mechanical Model

SailWind 3D Overview
The SailWind 3D window provides a three-dimensional rendering of your PCB layout, including electronic 
components and mechanical assemblies (such as mounting brackets or connectors). This three-
dimensional representation allows you to examine the PCB construction, move and align components, 
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and check clearances between components on your PCB and adjacent assemblies (such as EMI shields, 
heat sinks, and covers). The SailWind 3D window also provides tools for aiding in the design collaboration 
process with mechanical (MCAD) designers.

Part Placement in SailWind 3D
One of the primary purposes of the SailWind 3D window is to allow you to view a three-dimensional 
representation of your design to check clearances between components and surrounding assemblies or 
mechanical parts in the X, Y, and Z direction.

Figure 38. Checking PCB Component Clearance with an Enclosure

However, if desired, you can synchronize the SailWind 3D window with the two-dimensional layout design 
view, meaning selecting and moving a part in one view updates the part’s position in the other view. 
This synchronization feature becomes helpful if you choose to place parts in your PCB design using the 
SailWind 3D window instead of the standard two-dimensional layout design view.

Using the SailWind 3D window, you can assign or “map” 3D models to your parts, thereby giving them an 
accurate three-dimensional representation (see Assigning a 3D Model to a Component). You then have 
the option of saving the 3D model mapping for re-use with other designs by saving it to the Reuse folder 
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location for a netlist project — see 3D Model Mapping. Alternatively, you can keep it mapped to part in the 
PCB design only.

For 3D model alignment, the SailWind 3D window appears adjacent to the Decal Editor along with the 
Align 3D Models dialog box (see Align 3D Models Dialog Box). The Align 3D Models dialog box provides 
you with the ability to align the pads of a 3D model with the pads of a part decal, as displayed in the 
SailWind 3D window.

Clearance Checking Features
For checking clearances, the SailWind 3D window provides options:

• Manually check distances between a component and a point on the PCB or an assembly using 
the “Measure Distance” and “Measure Minimum Distance” features. This option is especially 
useful when aligning a 3D model with decal pads.

• Perform automatic design rule checking across the entire design through the use of 3D 
clearances Design Rule Checks (DRC).

Note:
Use the 3D Clearances dialog in the SailWind 3D window for defining your 3D clearances.

MCAD Collaboration
To aid in the collaboration effort with mechanical designers, the SailWind 3D window features the MCAD 
Collaborator, a tool for tracking and annotating design change proposals. With the MCAD Collaborator, 
you can establish an initial or “baseline” design with the mechanical designers. When you make a change 
from the baseline layout design (for instance, you move a part), the MCAD Collaborator lists the affected 
part as a change proposal and allows you to exchange the proposal with the mechanical design team as 
an .idx  file. Upon acceptance from the mechanical designers, the proposal becomes the new baseline.

Related Topics
Assigning a 3D Model to a Component

SailWind 3D Object Manipulation
You can rotate the viewing angle of your PCB design in the SailWind 3D window along three axes. 
You can also zoom in or out to change the magnification of the rendered PCB design. Use the viewing 
controls in tandem with the SailWind 3D window display options to view various features of your PCB 
design.

Rotating the View
Choose the View > SailWind 3D  menu item to open the SailWind 3D window. The window displays next 
to the SailWind Layout design window.
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Figure 39. The SailWind 3D Window

You can resize the SailWind 3D window as necessary by dragging its border with the mouse.

The SailWind 3D window features a 3D view “cube” control for rotating, zooming, and panning the three-
dimensional PCB. Rotate the PCB in the SailWind 3D window to a fixed or orthogonal view (such as front 
view, top view, left-hand view, and so forth) by either clicking a corresponding surface of the cube, or by 
clicking a rotational arrow to rotate the PCB view in 90° increments.

Note:
Clicking a cube surface also changes the view to the default magnification.

Click the “home” icon at the corner of the cube for an isometric view of the PCB.

Alternatively, you can rotate the PCB dynamically by clicking any surface of the cube control and rotating 
it in the desired direction. The PCB moves as you rotate the cube.
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Figure 40. Rotating the PCB with the 3D View Control

Zooming and Panning
Use the 3D view control to zoom in on the PCB or pan across to view certain details as described in the 
following table:

Table  102. Manipulations with the 3D View Control

If you want to... Do the following...

Zoom in or out of the current view. Press the Ctrl key and drag the 3D view controller 
up or down.

Pan across the current view. Press the Shift key and drag the 3D view controller 
in any direction.

Using the Middle Mouse Button
Alternatively, if you want to rotate the board along a single axis or manipulate the 3D view from anywhere 
on the display using the middle mouse button, do so as follows:

Table  103. Manipulations with the Middle Mouse Button

If you want to... Do the following...

Zoom in or out of the current view. Press the Ctrl key and rotate the middle mouse 
wheel up or down.
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Table  103. Manipulations with the Middle Mouse Button  (continued)

If you want to... Do the following...

Rotate the current view around the 
X or Y axis.

Press the Shift key and press and hold the middle 
mouse button as you drag the cursor up and down 
for X axis rotation or sideways for Y axis rotation.

Rotate the current view around the 
Z axis.

Press the Ctrl key and press and hold the middle 
mouse button as you drag the cursor in a circular 
motion.

Pan across the current view. Press the Alt key and press and hold the middle 
mouse button as you drag the cursor up and down 
or sideways.

The SailWind 3D window supports most zooming functions available in the 2D workspace. For more 
information, see Zooming Overview.

Tip
Rotation with this method is limited to one axis at a time. To rotate the PCB in a dynamic direction, 
use the 3D view control instead.

Preset Views
The SailWind 3D window provides preset views (View Top, View Bottom, View Front, View Back, View 
Left, and View Right) for rapid access to standard views. Access these preset views by clicking the 

associated buttons in the 3D window toolbar.

While these preset views do not adjust the image magnification, they are useful for returning the view to 
an established angle, such as the top or front view.

3D Model Mapping
The SailWind 3D window allows you to assign a 3D model to a PCB component and align it with the decal 
pads. This alignment and assignment information is known as model mapping.

Mapping 3D models begins with assigning a 3D model to a component in the SailWind 3D window—see 
Assigning a 3D Model to a Component. After assigning and aligning the 3D model, you have the option of 
saving the mapping information to the Reuses folder location (for a netlist project).

When you map a 3D model to a component, and you choose to save the model mapping to the Reuse 
folder location (using the Update Library Dialog Box), SailWind Layout associates the 3D model 
assignment with the part type. It also associates the 3D model alignment information to the decal.
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Figure 41. SailWind 3D Model Mapping

The mapping function allows you to re-use the 3D model with any other design that has the same part 
type and decal combination. For more information, see Reusing 3D Models with Other Components in a 
Design.

Related Topics
Saving 3D Models for Re-use in Other Designs

Update Library Dialog Box

Assigning a 3D Model to a Component
Assign or “map” 3D models to component decals and align them so the SailWind 3D window accurately 
represents them in the rendered image. Import a new 3D model from an external source and map it to a 
decal then align the 3D model so that it is placed correctly on the PCB.

You can map 3D models in one of two ways: directly within the 3D window or within the Decal Editor.

Within the 3D window:

• You can perform mapping more quickly than editing in the Decal Editor and reloading the design 
in the 3D window after returning

• Changes do not modify the decal
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• Changes apply to all components with the same part type-decal pairing

• You can make alignment changes in delta offset values only

Within the Decal Editor:

• You can apply a model mapping to multiple Part Types

• Changes modify the decal, possibly making it appear in the list in the Update from Library Dialog 
Box

• You can make alignment changes in absolute or delta offset values

• When exiting, you can choose to apply mapping to the selected component or to all components 
using the same part type-decal pairing

Procedure
1. Select a component in the SailWind 3D window.

If you select an ECO-registered component, ensure the it meets “certain requirements”  on 
page 531 so that it displays correctly in the SailWind 3D window.

2. Click the Import Part Model  button on the 3D window toolbar. .

Alternatively, if you want to use the Decal Editor, perform the following steps:

a. Right-click on a component and click the Edit decal  popup menu item.

Restriction:
If your software license does not enable this feature, click in the standard two-
dimensional layout design view to access the Edit decal  command.

The Decal Editor opens and displays the default two-dimensional decal of the component and 
a corresponding representation in the SailWind 3D window adjacent to it. The Align 3D Models 
Dialog Box  also opens.
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b. In the Align 3D Models dialog box, select the part name (or names, if you want to map the 
same 3D model to more than one part) in the “Parts mapped to selected model” list and click 
Import.

3. In the Import Part Model dialog box, select the correct model definition file you want to import and 
click Import.

If you are assigning a 3D model through the Decal Editor, the new model appears in the Model 
Name list of the Align 3D Models dialog box as the model mapped to the decal.

4. Rotate or reposition the imported 3D model as necessary so it aligns correctly with the decal pads 
as follows:

a. Rotate the model so it is oriented correctly over the pads (its pins do not need to be aligned yet
—you will align them in the next sub-step).

b. Click the Align Pin-Pad Center  button. The decal pads hide temporarily to simplify alignment.

c. Select a face on a model pin to use for alignment, adjusting the 3D view as necessary for 
access. For example, if you are aligning a SO-14 package, select the bottom surface of pin 1 
that you expect to make contact with the pad.

The decal pads return to view after you select an alignment face.

d. Click the corresponding decal pad to which you want to align the center of the selected pin 
face. The model moves so the center of the pin face is aligned with the center of the pad.

e. In some cases—such as when you are mapping a through-hole component—you may also 
need to define which model face you want to make “seat” against the pad.
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Figure 42. Selecting a Model Face

i. Click Define Seating Plane.

ii. Rotate the 3D view as required to access the model face you want to seat against the pad.

iii. Click the face to select it. The model adjusts to seat the face against the pad.

Note:
If you close the 3D Window before exiting the Decal Editor, the Decal Editor prompts you 
to save your data. Click Yes  at the prompt to save the 3D model mapping and apply the 3D 
model to all parts in the design that have the decal. Otherwise, click No  to abandon your 
changes.

5. Click OK  when finished aligning and centering the model with the decal pads.

In the 3D window, you can save changes to the library using the Update Library Dialog Box. You 
can also use the Manage Mappings Dialog Box  to apply mappings to other components in the 
design.

After updating the library with your changes, you can later “change the 3D model”  on page 532
associated with the component but you can no longer delete all model associations.
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6. (Decal Editor only) Choose the File  > Exit Decal Editor  menu item when you are finished aligning 
the imported model.

In the Apply Decal Changes prompt, click All  to apply the 3D model to all parts using the decal in 
the design or Selected  to apply the model to the selected component only.

Tip
Click All  if you change only the model alignment.

Results
The SailWind 3D window displays changes in the three-dimensional representation of your design and its 
components.

Related Topics
SailWind 3D Object Manipulation

Align 3D Models Dialog Box

Saving 3D Models for Re-use in Other Designs

Reusing 3D Models with Other Components in 
a Design
As a time-saving measure, you can reuse or reassign 3D models to components on the rendered PCB 
design that share a common physical footprint. For example, you can assign the 3D model from a surface 
mount resistor to a surface mount capacitor if the two components appear physically identical.

Restrictions and Limitations
You cannot use the Manage Mappings dialog box to reassign a 3D model to a part if the part is already 
saved in the library with a 3D model.

Prerequisites
You have already mapped the 3D model you want to reuse to at least one component.

Procedure

1. In the SailWind 3D window, click the Manage Mappings  button. 

2. Select the “Enable cross probing” check box in the Manage Mappings Dialog Box.

3. Click a component in the 3D window that has the 3D model you want to reuse and make note of 
the corresponding entry indicated in the “Parts mapped to models list” of the Manage Mappings 
dialog box.
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Figure 43. Selected Model Entry in the Manage Mappings Dialog Box

Alternatively, you can click the model entry directly in the list to select it.

4. In the “Parts without model” list of the Manage Mappings dialog box, select the check box of the 
component or components that will reuse the 3D model.

5. Click the left arrow to map the selected component in the “Parts without model” list to the 3D 
model.

6. If a message appears cautioning about differences in alignment data between decals (“cells”), 
click No  to retain the current alignment of the 3D model you are reusing or click Yes  and choose 
another alignment as follows:

a. Click in the “Use alignment” box in the Choose Alignments Dialog Box.

b. Select an existing decal alignment from the list or click None  to “align the 3D model”  on 
page 524 manually.

7. Click OK  to map the component to the model.

8. If you need to re-align the 3D model, right-click it and click the Edit Decal  popup menu item to 
open the Decal Editor. See Assigning a 3D Model to a Component  for more information about 
aligning 3D models.

Related Topics
Saving 3D Models for Re-use in Other Designs

Update Library Dialog Box

Update Models Dialog Box
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Holes in SailWind 3D
In some cases, you must add certain attributes to components if you want the holes to display properly in 
SailWind 3D.

Holes Displayed in the 3D Window
Assigning a 3D Model to a Non-ECO Mounting Hole
Rendering Mounting Holes on ECO-Registered Parts as Voids
Setting Multi-Pin Components to Display Holes for Some Pins

Holes Displayed in the 3D Window
Pin holes, mounting holes, and other component holes do not always render as voids in SailWind 3D. 
The display of holes depends on several factors, such as whether or not the component is an ECO-
registered part or a non-ECO registered part, the number of pins, and whether or not it has a pin with a 
drill specification.

Generally, the pin holes of a component (such as a through-hole capacitor) always appear filled 
in SailWind 3D. For all other components, you must assign either the “HOLE” attribute or the 
“MountingHolePins” attribute for holes to display as voids.

The following sections summarize how holes render in SailWind 3D under various conditions.

ECO-Registered Parts

• Pin holes display as filled by default, even for through-hole components and components with 
only a single pin.

• Components with multiple pins that have mounting holes still render as filled.

• You can make the voids visible in SailWind 3D by applying either the “"HOLE" attribute”  on 
page 531 or the “"MountingHolePins" attribute”  on page 532.

Non-ECO Registered Parts

• Pin holes display as filled by default UNLESS the component has a single pin with a non-zero drill 
specification, in which case it converts automatically into a mounting hole and displays as such.

• SailWind 3D automatically renders a non-ECO component with a single pin as a mounting hole 
if the pin has a non-zero drill specification. This automatic rendering prevents you from selecting 
the mounting hole in the 3D window (to assign a 3D model to it, for example).

Note:
A mounting hole generally displays as a hole in the board, nothing else.

• You can assign a 3D model, such as a standoff, to a non-ECO component if you first “apply the 
MountingHolePins attribute”  on page 530. Assigning this attribute enables you to select the 
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component in the 3D window. Assigning the attribute also effectively converts the component 
from a mounting hole to a mechanical component with one mounting hole inside it.

Note:
SailWind 3D renders any non-ECO registered part with the “MountingHolePins” attribute 
as a mechanical component if the part has only a single pin (such as is the case for a 
mounting hole or fiducial). Be aware that turning off the display of mechanical models 
in the SailWind 3D settings hides such parts. Also be aware that these parts export as 
mechanical parts when exporting the design to MCAD software.

Assigning a 3D Model to a Non-ECO Mounting Hole
In some cases, you may want to assign a 3D model, such as a standoff, to one or more board mounting 
holes. You can assign a 3D model after first applying the “MountingHolePins” attribute.

Procedure
1. In the 2D workspace, right-click the mounting hole then click the Attribute  popup menu item.

2. In the “Object Attributes dialog box”  on page 1496, select the component level from the “Attributes 
for” list.

3. Click Add.

4. In the new Attribute box, type, “MountingHolePins” and press the Enter key.

5. (Optional) If you want the hole to continue to display as a void, type the pin number in the Value 
box.

6. Close the Object Attributes dialog box.

7. In the 3D window, select the corresponding mounting hole (note that it now displays as filled unless 
you specified the pin number in the Value box). Apply and “assign a new part model”  on page 523.

Figure 44. 3D Mounting Hole Before and After Applying the Attribute
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Rendering Mounting Holes on ECO-Registered 
Parts as Voids
In some cases, ECO-registered parts may not appear correctly in the SailWind 3D window; specifically, 
if a part is a single pin part, you must add certain attributes to the part decal to ensure a correct 
appearance.

Procedure
1. Right-click the component in either the 2D workspace or the 3D window, then click the Attribute 

popup menu item.

2. In the “Object Attributes dialog box”  on page 1496, click Add.

3. Type one of the following attributes:
Table  104. Required Attributes

Pin Type Attribute

Through-hole HOLE

SMD FIDUCIAL

For a single-pin, through-hole part, adding the “HOLE” attribute displays the hole as a void in the 
SailWind 3D window. For SMD single-pin parts, add the “FIDUCIAL” attribute in cases where you 
want the part treated as a fiducial.

Figure 45. ECO-Registered Mounting Hole Before and After Applying the HOLE Attribute
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Setting Multi-Pin Components to Display Holes for 
Some Pins
You can set attributes on an ECO-registered part so that the holes associated with one or more selected 
pins render in SailWind 3D as voids.

Procedure
1. Right-click the component in either the 2D workspace or the 3D window, then click the Attribute 

popup menu item.

2. In the “Object Attributes dialog box”  on page 1496, click Add.

3. Type “MountingHolePins” as the new attribute name and press the Enter key. In the Value box, 
type the pin number for each pin in the component where you want the corresponding hole to 
display as a void. Ensure you separate each pin number with either a comma or a space (for 
example, “P001,P003,P005,” and so on).

Note:
Keep the following in mind
• Ensure you specify the pin number of the part, NOT the decal pin number
• If you specify all pin numbers for an ECO-registered part, SailWind 3D renders the part 

as a mechanical model. Be aware that these parts export as mechanical parts when 
exporting the design to MCAD software.

• The software takes longer to render the 3D image of your PCB the more pin numbers 
you specify for hole rendering.

Figure 46. Mounting Pin Holes Before and After Applying the Attribute

Changing a 3D Model Assignment
You can change or assign a different 3D model to a component decal.
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Restrictions and Limitations

• Mapping through the Decal Editor allows you to choose to apply changes to only a component 
instance, if desired. Mapping in the 3D window applies changes to all instances of a component.

• If you have already updated the library with a 3D model assignment, you can change the 
assigned 3D model but you cannot remove all 3D model associations from the component.

• Be aware that any mapping changes made in the Decal Editor—including assignment and 
alignment of 3D models—affect the decal timestamp, which may affect the schematic during 
backward annotation.

• In the 3D window, you can use the Manage Mappings Dialog Box  to apply mappings to other 
components in the design.

Procedure
1. Select the part to which you want to assign a different 3D model.

2. Click the Import Part Model  button on the 3D window toolbar. .

Alternatively, if you want to use the Decal Editor, perform the following steps:

a. Right-click on a component and click the Edit decal  popup menu item.

The Decal Editor opens and displays the component decal and its currently mapped 3D model.

b. In the Align 3D Models Dialog Box, select the part or parts in the “Parts mapped to selected 
model list” that you want to reassign then click Import.

3. In the Import Part Model dialog box, browse to and select the correct model definition file you want 
to import and click Import.

If a dialog box appears with a caution about rewriting a file, click Yes  to overwrite the model 
currently in the local design library, No  to import the file as a new model, or Cancel  to exit without 
making changes.

4. “Rotate or reposition”  on page 525 the imported 3D model as necessary so it aligns correctly with 
the decal pads; then click OK.

5. (Decal Editor only) Choose the File  > Exit Decal Editor  menu item when you are finished aligning 
the imported model.

In the Apply Decal Changes prompt, click All  to apply the 3D model to all parts using the decal in 
the design or Selected  to apply the model to the selected part only.

The new 3D model appears in the Model Name list of the Align 3D models dialog box as the model 
mapped to the decal.

6. In the “Apply Decal Changes” dialog box, click All  to apply the 3D model to all parts using the 
decal in the design.

7. If you previously saved the model mapping to the Reuses file location, you can update the 
mapping:
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a. Click the Update Library  button in the SailWind 3D window toolbar.

b. In the Update Library Dialog Box, select the check box of the part with the new mapping.

c. In the Overwrite policy list, choose “Overwrite all in Library.”

Importing and Aligning 3D Mechanical Models
Add mechanical designs such as mounting brackets to your PCB design in the SailWind 3D window to 
examine clearances and construction with the rest of the PCB. Adding 3D mechanical designs helps to 
ensure the PCB parts fit with the mounting hardware or enclosures in the final, packaged PCB assembly.

You can import mechanical designs in a wide variety of file formats, including .asat, .iges, .sat, .step  (.stp), 
and .xtda.

Prerequisites

• You have opened a design in SailWind Layout and you have also opened the SailWind 3D 
window.

Procedure

1. In the SailWind 3D window, click the Mechanical Model Properties  button .

2. In the Mechanical Model Properties Dialog Box, click the Add  button ; then browse to and 
select the mechanical model file and click Open.

Tip
You can also import a mechanical model from the SailWind 3D window by clicking the 

Import Mechanical Model  button .You can then modify its properties by selecting the 
model and clicking the Mechanical Model Properties  button.

The imported mechanical model appears in the SailWind 3D window and a temporary instance 
name appears in the Instance  dropdown list.

3. Rename the mechanical model by typing a more descriptive name in the Instance  dropdown list.

4. Select a model type to determine which 3D clearance rules to apply and where to display the 
model in the 3D Display Control settings (see 3D Display Control Window).

5. Rotate and align the 3D mechanical model to its proper position in relation to the PCB design 
using the Rotate and Offset controls. Alternatively, select the Allow interactive mechanical model 
movement check box to reposition the mechanical model by dragging it with the mouse. Rotate the 
PCB angle as required to align the mechanical model in the X, Y, and Z direction. See SailWind 3D 
Object Manipulation.

6. Select or clear the check boxes for your save options.

7. Close the dialog box and save the PCB design when you are through adding the mechanical 
model.
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Results
You have added and aligned a mechanical model to your 3D PCB layout. If necessary, you can use 
the commands on the mating toolbar to ensure an accurate fit between mechanical models. For more 
information, see Positioning 3D Mechanical Models Using Mating Commands.

Positioning 3D Mechanical Models Using 
Mating Commands
You can use the mating commands (on the 3D window Toolbar) to accurately mate the surface of an 
imported 3D mechanical model with another surface. Two mated surfaces connect physically and remain 
in contact. Attempts to manipulate movement of one mated model is thus limited to permit only movement 
that keeps the mated surfaces in contact.

Note:
The mating commands apply to mechanical models only. To move or manipulate components, 
use the Decal Editor.

Prerequisites
You have already imported a 3D mechanical model and rotated or aligned it roughly in the position where 
you want to place it.

Procedure
1. In the SailWind 3D window, click to choose the mechanical model that you want to mate.

2. On the 3D window toolbar, click the Mate Selected Models  button. 

3. On the mechanical model, click the surface, edge, or other feature (such as a hole) that you want 
to mate to another surface.

To aid in choosing the feature, right-click and click a popup menu item to limit feature selection to 
the type of feature you want to align:

• Snap to Closest  — Enables you to click any mechanical feature of the model, whether it is an 
axis, edge, or face.

• Snap to Axes  — Enables you to click the discernible X, Y, or Z axis of a feature on the model, 
such as a hole, cutout, or corner.

• Snap to Edges  — Enables you to click any edge of the mechanical model.

• Snap to Faces  — Enables you to click one of the non-edge surfaces of the mechanical model.

SailWind Layout highlights the chosen feature after you click it.

4. Click a corresponding surface or mechanical feature on the other model where you want the 
mechanical model to mate. For example, if you choose a standoff on the mechanical model, and 
you want to mate it to a mounting hole on the PCB, click the desired mounting hole on the PCB.
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The mechanical model moves or snaps to the selected mechanical feature. In addition, in the 
Mechanical Model Properties Dialog Box, the alignment and movement features become disabled. 
SailWind Layout permits only movements that allow the two mated surfaces to remain in contact.

5. To disassociate or “unmate” the two surfaces at any time, click the mechanical model again to 
choose it and click the UnMate selected models  button. 

If you want to unmate all models at one time (without having to choose them all first), click the 
UnMate all models  button. 

Creating a Board Outline From an Imported 
Mechanical Model
You can import a mechanical model into the SailWind 3D window for use as a physical board outline in 
your design. If you want to use any of the holes already in the mechanical model, you must map them to 
their proper type, such as cutouts or mounting holes, to ensure proper import.

Note:
If you re-create a board outline using the same mechanical model, SailWind Layout discards your 
previous hole mappings.

Prerequisites
You have imported the mechanical model that you want to use for your board outline.

Procedure

1. In the SailWind 3D window toolbar, click the Create Board Outline  button. 

2. Select the surface of the imported mechanical model that you want to use for the board outline.

3. Click the location on the mechanical model that you want to use as the origin of the board outline.

4. A list of holes already in the imported mechanical model appears in the Map Hole Features 
Dialog Box. Select each hole that you want to use for the board by clicking the Hole Type box and 
choosing the corresponding hole type from the dropdown list:

• <Discard> — The default setting. The software ignores holes set to “Discard” when it generates 
the board outline.

• Contour — Indicates the hole is a cutout.

• MountingHole — Indicates the hole as a board mounting hole. Choose this option only if you 
want to map a hole in the mechanical model to an existing hole in your PCB design. If you 
choose this hole type, click the Hole Attribute box and select the corresponding mounting hole 
attribute from the dropdown list.

You can clear the Highlight check box for each hole individually to make identification easier. The 
SailWind 3D window centers a hole on the display if you select its check box again. Alternatively, 
you can click any hole on the mechanical assembly to cross probe with the holes in the dialog box.
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5. Click OK. The Map Hole Features dialog box closes and the design updates with the new board 
outline.

The updated board outline appears in both the SailWind 3D window and the layout design view.

Creation of 2.5D Models
SailWind Layout creates a “2.5D” model automatically by combining a component’s outline (such as that 
used for silkscreen) with its Geometry.Height attribute. When you open the SailWind 3D window, any part 
that does not already have a 3D model assigned is represented by a 2.5D outline. The component outline 
must meet certain requirements to ensure proper generation of the 2.5D model.

Component Outline Hierarchy
SailWind Layout locates component outlines using a layer hierarchy:

1. Layer defined in the SailWindpcb.ini  file

2. Layer 25 (125)

3. Top associated assembly layer

4. Top layer

5. <All Layers>

6. Layer 20 (120)

To define a component outline layer in the SailWindpcb.ini file, open the file (at <drive>\<install_folder>
\<release>\Settings\SailWindpcb.ini) with a text editor and add the following line:

3D_Shape_Layer = <layer number>

Where <layer number> is the component outline layer.

Component Outline Requirements
Component outlines must be closed in order for SailWind Layout to generate a 2.5D model. If you place 
any open component outlines on a layer defined in the SailWindpcb.ini  file, for example, SailWind Layout 
disregards the open outlines and selects only those that are closed.

To ensure SailWind Layout generates 2.5D models for all components, create closed component 
outlines and place them on Layer 25. SailWind Layout locates the closed component outlines as it 
searches through the component outline hierarchy. For example, if you have open silkscreen outlines 
for a component on the top layer—and the top layer is defined as the component outline layer in the 
SailWindpcb.ini  file—ensure you add corresponding closed outlines of the component to Layer 25.
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Figure 47. Open and Closed Component Outlines

Related Topics
Compare 3D and 2.5D Models

Compare 3D and 2.5D Models
As an additional aid for laying out parts on your PCB, you can view the “2.5D” models in tandem with 
3D parts in the SailWind 3D window. Enabling the 2.5D view allows you to check the alignment and 
positioning of a 3D model in relation to the original 2D layout to verify you have mapped the correct 
model.

The “2.5D” model is an extrusion of the decal’s silkscreen outline and the Geometry.Height attribute. 
When you open the SailWind 3D window, any part that does not already have a 3D model assigned is 
represented by a 2.5D outline of its decal. Any 3D model you assign to a part replaces the 2.5D model.
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Figure 48. A 2.5D Model Replaced by a 3D Model

As a layout verification, you can turn on the 2.5D model after assigning a 3D model by selecting the 
Overlay 3D Models with 2.5D check box in the 3D Display Control Window. The correctly aligned 3D 
model overlays the 2.5D outline.
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Figure 49. The Original 2.5D Model Overlaying the 3D Model

Reposition or realign the 3D model as necessary to reconcile any significant placement differences 
between the 2.5D and 3D models. If the models are not the same shape, ensure you have mapped the 
correct 3D model to the part.

See “Comparing 2D Components with 3D Models”  on page 541 for instructions.

Related Topics
Assigning a 3D Model to a Component

Decal Attributes Dialog Box

Creation of 2.5D Models
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Comparing 2D Components with 3D Models
Overlay an extruded 2D outline on a 3D model to verify the correct alignment and positioning of the 3D 
model.

Procedure
1. In the 3D Display Control Window, Options section, select the Overlay 3D models with 2.5D check 

box.

In the SailWind 3D window, the 2.5D outlines are shown as blue rectangular solids. 
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2. Examine the design and identify any components that may have alignment or positioning 

problems. 

Tip
To better evaluate the alignments, rotate the 3D image or change the view settings as 
needed. If necessary, clear the Perspective check box in the 3D Display Control dialog box 
so you can see the alignments and positions more clearly.

3. Correct any problems by adjusting the alignment of the 3D models so they are positioned correctly 
relative to the 2D components and land patterns.

Saving 3D Models for Re-use in Other Designs
You can save 3D (“map”) model-to-decal alignments from one PCB design and re-use them in an existing 
design wherever the part types and decal names are the same. For example, if you have two PCB 
designs that share a specific IC with an SO-16 decal, mapping a 3D model to the IC in one PCB design 
allows you to use the same 3D model with the IC/decal combination in the other PCB design. SailWind 
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Layout saves your 3D model mappings to the Reuses file location specified in the Tools  > Options  > 
Global  > File Locations  tab.

Prerequisites

• You are viewing a PCB design in the SailWind 3D window.

• You have mapped at least one 3D model to a decal in the PCB design.

Procedure

1. In the SailWind 3D window, click the Update Library button. 

2. In the Update Library Dialog Box, select the 3D model mappings that you want to save. Mappings 
are listed in the dialog box according to the part and decals to which they are mapped.

Select the Enable cross probing check box if you want the ability to click on a part in the design to 
interactively locate its corresponding mapping in the list.

3. Select an overwrite policy from the Overwrite policy list.

4. Click Apply  to save the 3D model mapping or mappings to the Reuse file location.

5. Click OK  to close the message prompt.

6. Click Cancel  to close the dialog box.

Results
You have mapped 3D models to part types in the Reuse file location and you have saved the 3D model 
alignment information with the part decals. The 3D models automatically appear in other designs 
wherever the part and decal combination is the same. If changes occur to any of the mapped 3D models 
externally to the PCB design, you can import the changes by clicking the Update Models  button in the 
SailWind 3D window. 

Related Topics
Reusing 3D Models with Other Components in a Design

3D Model Mapping

Component Placement in the SailWind 3D 
Window
As an additional tool for PCB layout, you can use the SailWind 3D window for component placement. 
Using the SailWind 3D window allows you to check the component placement in three dimensions.

After you import a design, SailWind Layout initially places all the design components on the PCB origin. 
With the SailWind 3D window, you can disperse the components and place them around the PCB as 
you would in the standard two-dimensional design view. The SailWind 3D window supports many of the 
standard component placement functions through use of a context menu.

For example, you can spin, rotate, nudge, disperse, and move components to the PCB flip side from 
withing the SailWind 3D window by right-clicking on a component and selecting an option from the popup 
menu. For more information about component placement, see “Part Placement”  on page 471.
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Restriction:
Use the standard two-dimensional design view to route and connect your components; the 
SailWind 3D window does not support component routing.

As with the two-dimensional design view, you can use on-line Design Rule Checking (DRC) to alert you 
to clearance warnings or violations while placing components in the SailWind 3D window. See “Viewing 
DRC Violations in SailWind 3D”  on page 545 for instructions.

Synchronizing the Design and SailWind 3D 
Viewing Areas
Set options to enable the views in the Design space and the SailWind 3D window to mirror one another in 
zoom level and pan area.

Procedure
1. In the SailWind 3D window with nothing selected, right-click and click the 3D Display Control 

popup menu item, or on the 3D General toolbar, click the 3D Display Control  button.

2. In the “3D Display Control Window”  on page 1034, in the Options section:

• Select the Drive 2D View check box to send synchronization commands to the Design view. 
Zoom levels and pan moves made in SailWind 3D will be matched in the Design space.

• Select the Follow 2D View check box to receive synchronization commands from the Design 
view. Zoom levels and pan moves made in the Design space will be matched in SailWind 3D.

3. Click OK.

Defining 3D Clearance Constraints
Define 3D clearance X,Y, and Z axis constraints for the objects in SailWind 3D. You can define generic, 
mechanical model type, and component specific constraints.

Restrictions and Limitations

• 3D clearance constraints affect only models in SailWind 3D and do not conflict with or override 
design constraints.

Procedure

1. In the SailWind 3D window, on the 3D General toolbar, click the Clearances  button .

2. In the 3D Clearances Dialog Box, to add a new row, click the Add  button .

3. In the new row, click the From and To fields to choose objects from the lists.
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4. Type values where needed in the Minimum XY, Minimum Z, Optimal XY, and Optimal Z boxes. 
If there are blank values the clearance is not checked. For example, this allows you to omit the 
XY clearance for a connector sticking out past the board edge. Specify a blank XY value for the 
specific component to board edge constraint.

5. Repeat as necessary.

6. Click OK.

7. For the next step, see either “Running Batch 3D Clearance Checking”  on page 546 to check 
all design objects or “Viewing DRC Violations in SailWind 3D”  on page 545 to view clearance 
violations as you move objects.

Viewing DRC Violations in SailWind 3D
Enabling standard on-line Design Rule Checking (DRC) in the Tools  > Options  menu also allows you to 
view 3D clearance violations in the SailWind 3D window while you position components on the PCB.

You can define your 3D clearances using the 3D Clearances Dialog Box.

Restrictions and Limitations
DRC in the SailWind 3D window checks only the 3D clearances; they do not conflict with or override 
design constraints.

Prerequisites
You have already defined one or more 3D clearances for your project (see “Defining 3D Clearance 
Constraints”  on page 544).

Procedure
1. Enable on-line DRC in either the “Prevent Errors” or “Warn Errors” mode—see “Design Rule 

Checking”  on page 410.

2. Position your PCB components as required. While positioning your a component, the component 
changes color (you may have to hold to component with the cursor at a position and allow it to 
“hover” a moment) to indicate 3D clearance violations as follows:
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• Optimal XY or Optimal Z violations  — Affected components or surfaces highlight in yellow 
when placement exceeds any “optimal” clearance.

• Minimum XY or Minimum Z violations — Affected components or surfaces highlight in red 
when placement exceeds any minimum clearance.

Figure 50. 3D Optimal and Minimum Violation Examples

3. Reposition the affected component as required until the highlight disappears, indicating the 3D 
clearance is no longer exceeded.

Running Batch 3D Clearance Checking
Check all 3D objects against the 3D Clearances constraints.

Prerequisites

• 3D Clearances must be defined. For more information, see “Defining 3D Clearance Constraints” 
on page 544.

Procedure
1. In the SailWind 3D window, on the 3D General toolbar, click the 3D Design Rule Check  button 

. A Processing dialog box opens displaying the elapsed time for the process. Then a window 
opens displaying the number of hazards found and showing a path to the log file.

2. In the Output Window, click the link to view the contents of the log file.
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Changing the Appearance of Components and Models in 3D

Changing the Appearance of Components and 
Models in 3D
You can alter the appearance of components and assemblies in the SailWind 3D window to make 
it quicker to identify key groups or components. For example, you can color code all 3D models of 
high frequency parts to make grouping them easier prior to routing. You can also make components 
transparent to view details beneath them.

Procedure
1. Open the 3D Display Control Window.

2. Select a component or mechanical model using one of the following methods:

• Click on a component or mechanical model on the PCB in the SailWind 3D window; then in the 
appropriate Components, Assemblies, Mechanicals, or PCBs area of the 3D Display Control 
dialog, click Add selected  to add it to the list.

• If the component does not appear in the list, click Add  and select it.

3. Locate the component in the appropriate list (Assemblies, Components, Mechanicals, or PCBs) of 
the 3D Display Control dialog box and select its corresponding Appearance checkbox. Ensure the 
Appearance check box is selected for the component or assembly and make the following changes 
are desired:

• Assign a color from the Color palette and set the transparency to the desired level.

• Clear the corresponding Visibility check box to hide a component or assembly.

4. Click Apply  after making your changes.

5. Click OK  to close the dialog box when you are done.

Measuring In 3D with Measure Distance
Measure distances between features of the 3D models when working in the SailWind 3D window.

Note:
The units of measure are the design units you define in the Design units area of the Tools  > 
Options  > Global/General  tab in SailWind Layout.
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Prerequisites

• Open the Display Control dialog box by clicking the 3D Display Control  button  on the 3D 
General Toolbar and enable the correct display settings so the objects you want to measure are 
visible.

• Use the 3D rotate, pan, and zoom controls to orient the design in the SailWind 3D window so the 
objects you want to measure are contained within the view.

Procedure

1. On the 3D General Toolbar, click the Measure Distance  button .

2. Choose one of the following options from the popup menu:

If you want to... Choose...

Measure between any two features Snap to Closest
(Default)

 Note:
Snap to Closest automatically 
determines and highlights the 
nearest axis, edge, face or point 
on the features.

Measure between the central axes of two circular features Snap to Axes

Measure between the edges of two rectangular features Snap to Edges

Measure between the flat surfaces of two rectangular features Snap to Faces

Measure between the points (corners) of two rectangular 
features

Snap to Points

3. Click on a feature to mark the starting point of the measurement.

The mode you select determines the appropriate feature automatically and highlights it. The 
distance from the starting point appears dynamically in a small readout attached to the cursor as 
you drag the cursor.

4. Hover over another feature to mark the ending point of the measurement.

Note:
Before selecting the second feature, (optionally) you can use the RMB menu to change the 
selection options.

The second feature highlights. The final measured distance between the two features appears 
when you hover over the ending point.
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Measuring In 3D with Measure Minimum Distance

5. You can sequentially select additional features and the status bar will display accumulative results 
of the measurement including the x, y and z offsets.

6. Press the Esc key once to release the currently selected feature so you can make additional 
measurements. Press the Esc key a second time to exit the Measure command.

Tip
You can right-click and click the Cancel  popup menu item to release the current feature. 
Choose Cancel  a second time to exit the Measure command.

Related Topics
SailWind 3D Object Manipulation

Assigning a 3D Model to a Component

3D Display Control Window

Measuring In 3D with Measure Minimum 
Distance
Measure the minimum distance between features of the 3D models when working in the SailWind 3D 
window.
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Note:
The units of measure are the design units you define in the Design units area of the Tools  > 
Options  menu item, Global/General  tab.

Prerequisites

• Open the Display Control dialog box by clicking the 3D Display Control  button  on the 3D 
General Toolbar and enable the correct display settings so the objects you want to measure are 
visible.

• Use the 3D rotate, pan, and zoom controls to orient the design in the SailWind 3D window so the 
objects you want to measure are contained within the view.

Procedure

1. Click the Measure Minimum Distance  button  to quickly measure the minimum distance 
between the closest features of two selected objects.

Tip
Choose either Mechanical Model Selection  or Board Selection  from the popup menu to 
limit your selections to one of those design levels.

2. Click on a feature to mark the starting point of the measurement.

The mode you select determines the appropriate feature automatically and highlights it. The 
distance from the starting point appears dynamically in a small readout attached to the cursor as 
you drag the cursor.

3. Hover over another feature to mark the ending point of the measurement.

The second feature highlights. The final measured distance between the two features appears 
when you hover over the ending point.
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Viewing Internal Layers in SailWind 3D

4. Press the Esc key once to release the currently selected feature so you can make additional 
measurements. Press the Esc key a second time to exit the Measure Minimum Distance 
command.

Tip
You can right-click and click the Cancel  popup menu item to release the current feature. 
Choose Cancel  a second time to exit the Measure Minimum Distance command.

Related Topics
SailWind 3D Object Manipulation

Assigning a 3D Model to a Component

3D Display Control Window

Viewing Internal Layers in SailWind 3D
The SailWind 3D window provides a virtual preview of the final manufactured PCB, allowing you to see 
into the layer stackup and inspect internal routing, via connections, and other design factors not visible in 
the 2D view.

Use the SailWind 3D window to analyze how blind and buried vias are connected through the layer 
stackup on a routed design. By scaling the design and zooming into areas of dense routing, you can 
verify that via connections on internal layers meet design specifications. Manipulating or rotating the 
design in the SailWind 3D window may also help you identify regions in high density designs where you 
can improve the placement or routing (see “SailWind 3D Object Manipulation”  on page 519).

Procedure
1. In the SailWind 3D window, open the 3D Display Control Window.

2. Select the “Include Internal Layers” check box to view the traces and pads on the internal layers.
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3. In the Options section, select the “Z-Axis Scaling” check box and choose 
a value for the Scale Factor from the dropdown list. (The larger the scaling 
value, the wider or “thicker” the gap between layers becomes in the Z-

axis.)

Tip
Selecting the Z-Axis Scaling check box also displays via barrels in the inner layers that are 
not otherwise visible when selecting the “Include Internal Layers” check box alone.

4. Use the 3D view controls to orient the design in the SailWind 3D window and focus on a specific 
area you want to analyze.

5. Visually examine the critical traces and vias to determine if the inner layer structures meet the 
design requirements. Note that the SailWind 3D window measuring tools (Measure Distance and 
Measure Minimum Distance) continue to report true material measurements regardless of z-axis 
scaling.

If necessary, you can select the Copper Planes check box (in the Objects area) to view internal 
layer copper planes. Ensure you click Refresh  after selecting the Copper Planes check box to 
ensure the copper planes are visible.

Creating 3D Cross Sections
Create cross-sectional “cutaway” views in the SailWind 3D window to view details such as the fit between 
the PCB components and mechanical assemblies or enclosures.
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Creating 3D Cross Sections

Figure 51. Using a Cut Plane to Create a Cutaway View

Creating a cross sectional view allows you to access components, vias, traces, and other details hidden 
by enclosures or other objects.

Procedure
1. In the SailWind 3D window, click the X Cut Plane, Y Cut Plane, or Z Cut Plane  button, depending 

upon which direction you want to “cut.”

You can click one, two, or all three cut plane buttons and have more than one active cut plane at 
one time (though only one cut per plane type).
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2. When the cut plane appears, drag the cut plane to the location where you want it and rotate it as 
necessary to achieve the desired cutaway view. The 3D cut plane removes all 3D material to one 

side from view. 

3. Click the cut plane button again to remove the cut plane.

The cut plane returns to its original pre-defined starting location the next time you click its 
corresponding button.

Checking the Status of the 3D Design
As you make changes in the SailWind 3D window, you may lose track of the parameters you have set and 
how the design is currently configured. You can generate a report of the 3D statistics and verify that the 
3D design is acceptable.

Procedure

1. Click the Design Status  button  on the 3D General Toolbar.

A 3D Design Status Report file appears.
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Checking the Status of the 3D Design

2. Review the contents of the report file to verify the 3D parameters.

Status Parameter Description

Design Z Extents Shows the maximum range in the Z-axis of all models in 
the design.
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Status Parameter Description

 Note:
The beginning value of the range shows a negative 
number if models are mounted on the rear of the 
PCB.

The Design Z Extents range tells you the overall 
thickness so you can verify that you have not exceeded 
the overall thickness (height) restriction for the 
assembled PCB.

Parts Models Found Lists the 3D model assignments for each part in the 
design.
Review this list to verify that you have the correct model 
assignment for each part.

Parts Models Not Found Lists all parts that do not have a 3D model assignment. 
By default, these parts are represented by 2D extruded 
models.
To assure the greatest accuracy possible in the 3D View, 
assign 3D models to all of the parts in this list when 
possible.

Assemblies Lists the mechanical assemblies that you have imported 
into the design.
Review this list to verify that you have imported all of the 
correct assemblies in the design.

3. (Optional) Make any changes necessary. For example, change model assignments, assign 
3D models to parts that do not have model assignments, or change the Z-axis clearances to 
accommodate height restrictions for the design. After making the changes, generate a new 3D 
Design Status Report and review it again.

Related Topics
Assigning a 3D Model to a Component

Defining 3D Clearance Constraints

SailWind 3D Overview

Exporting the 3D Image to a 3D PDF File
Capture the current SailWind 3D window and export it as a 3D PDF file that allows the recipient to view, 
rotate, and query the objects in the design in 3D.
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Exporting the 3D Image to a Graphics File Type

Procedure
1. In the Display Control dialog box, use the display options in the Components area to highlight 

specific parts or toggle their visibility if necessary.

Tip
Use the 3D rotate, pan, and zoom controls to orient the design in the SailWind 3D window 
the way you want it to appear in the exported image.

2. On the 3D General Toolbar, click the Export   button.

3. In the Export dialog box, choose the directory path, enter the file name, and in the “Save as type:” 
dropdown list, choose 3D PDF (.pdf) as the file type.

4. Click Save.

Related Topics
SailWind 3D Object Manipulation

Creating 3D Cross Sections

3D Display Control Window

Exporting the 3D Image to a Graphics File 
Type
Capture the current SailWind 3D window and export it as an graphics image file for use in assembly 
drawings and other manufacturing or test documentation.

Procedure
1. In the Display Control dialog box, use the display options in the Components area of the to 

highlight specific parts or toggle their visibility if necessary.

Tip
Use the 3D rotate, pan, and zoom controls to orient the design in the SailWind 3D window 
the way you want it to appear in the exported image.

2. On the 3D General Toolbar, click the Export   button.

3. In the Export dialog box, choose the directory path, enter the file name, and in the “Save as type:” 
dropdown list, choose the desired graphics image format (.bmp, .gif, .jpg, .png or .tif) for the 
exported file.

4. Click Save.
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Related Topics
SailWind 3D Object Manipulation

Creating 3D Cross Sections

3D Display Control Window

Exporting the 3D Image as a Mechanical Model
Capture the content of the SailWind 3D window and export it as a mechanical model for use in other PCB 
designs or in 3D mechanical design applications. You can choose to export all mechanical models in the 
design or just selected models.

Note:
You can also choose to export the design as a PDF or image file but your export options are 
limited in such a case.

Procedure
1. In the Display Control dialog box, use the display options in the Components area of the to 

highlight specific parts or toggle their visibility if necessary.

Tip
Use the 3D rotate, pan, and zoom controls to orient the design in the SailWind 3D window 
the way you want it to appear in the exported image.

2. On the 3D General Toolbar, click the Export   button.

3. In the Export dialog box, choose the directory path, type the file name, and in the “Type” dropdown 
list, choose SAT (.sat) or STEP (.step) as the file type.

4. In the “Mechanical Model Options” area, determine the type of design objects you want to export 
by selecting either “All mechanical models” (any mechanical models you have added plus the 
board with the components) or “Include with board export items only” (just the models with the 
“Include with board export” check box selected in the Properties dialog box).

5. Select the check box for each element type you want to export.

• The Silkscreen and Soldermask check boxes apply to STEP file export only.

• You can choose to export element types in separate files by selecting the “Export as Sheets” 
check box. For more information, see Export Dialog Box.

6. Click Save.

Results
SailWind Layout saves the specified mechanical models as one or more files, depending on your export 
selections. Note that if you export certain mechanical model elements as individual sheets (files), and 
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Exporting the 3D Image as a Mechanical Model
later you clear one or more of the element type check boxes in the Export dialog box, SailWind Layout 
deletes the corresponding SAT or STEP file.

Related Topics
SailWind 3D Object Manipulation

Creating 3D Cross Sections

3D Display Control Window
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Chapter 23
Exchanging Data with Mechanical Designers
Use MCAD Collaborator in SailWind Layout to transfer, record, manage, and preview change requests 
between the PCB design team and the mechanical design team.

Supported Design Objects for Data Exchange
Collaboration Workflow Diagram
Launching the Collaboration Tool
Setting Up a Collaboration Session
Sending a Baseline Request
Receiving a Baseline Request
Creating and Sending a Change Request
Reviewing and Applying a Change Request
Controlling the Display of Different States
Reviewing the Change History
Managing the Change Files

Supported Design Objects for Data Exchange
MCAD Collaborator supports the processing and exchange of design objects using IDX Schema 2.0 or 
3.0 formats.

The following tables list various design objects and whether or not they are supported for collaboration in 
IDX Schema 2.0 or IDX Schema 3.0.

Restriction:
You cannot collaborate by applying an IDX Schema 3.0 baseline file and then export an IDX 
Schema 2.0 proposal from that baseline.

Table  105. Objects Supported in IDX Schema 2.0

Design Object IDX 2.0

Single Boards

Cutouts yes

Traces

Export external layers data through baseline yes

Pads

Export external layers data through baseline yes

Vias
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Table  105. Objects Supported in IDX Schema 2.0  (continued)

Design Object IDX 2.0

Export thru-vias through baseline yes

Component Pins/Pin Holes/Mounting Holes

Export one location of component pin through baseline yes

For IDX 3.0, objects are supported for different collaboration processes:

• Export  — means you can export this data in IDX 3.0 format and save it as a baseline file.

• Collaborate  — means you can import and export these objects. The Collaborator tracks them so 
you can send and receive updates (additions, deletions, changes) on the objects.

Table  106. Objects Supported in IDX Schema 3.0

IDX 3.0
Design Object

Export Collaborate

Board Objects

Board Outline yes yes

Board Thickness yes no

Board Stackup yes no

Through Mounting Holes yes yes

Cutouts (Contours) yes yes

Cavities yes yes

Copper

Traces yes yes

Planes (Area Fills) yes yes

Via Pads yes no

Via Holes yes no

Blind/Buried Vias yes no

Fiducials yes no

Component Features

Electrical Components yes yes
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Collaboration Workflow Diagram

Table  106. Objects Supported in IDX Schema 3.0  (continued)

IDX 3.0
Design Object

Export Collaborate

Mechanical Components yes yes

Component Pads yes no

Component Pin Holes yes no

Primary Pin yes no

Keepouts

Placement Keepouts yes yes

Plane Keepouts yes yes

Trace Keepouts yes yes

Via Keepouts yes yes

Guidelines for Using Data Exchange Objects
Board Outlines/Board Thickness:

• MCAD Collaborator shows a different board thickness than the stackup thickness. The 
Collaborator does not include soldermask in the thickness calculation so it represents proper part 
mounting (parts actually mount on the copper). The stackup thickness, minus the thicknesses of 
the soldermask, should equal the board thickness shown in MCAD Collaborator.

Component Pins/Pin Holes/Mounting Holes:

• The IDX format contains information on the location of Pin One for a component.

The Pin One coordinates are shown in the Properties section. The report of the coordinate 
location of Pin One is relative to the part origin, not the board origin. This is used to assist in 
aligning models.

Collaboration Workflow Diagram
The typical collaboration workflow involves setting up a collaboration session, establishing a common 
design baseline, and then exchanging mechanical change requests.

You start the exchange process by opening a collaboration session and submitting a baseline data file 
to the mechanical design team (or they start the process by submitting their baseline file to you). The 
baseline and change data files are in IDX format. The baseline file updates the design with the changes; 
you do not have the option of rejecting the proposed changes in a baseline file. The side receiving a 
proposal has the option of either accepting or rejecting the proposed changes. Either side can then create 
and submit additional proposals by sharing new change data files.

You exchange the data files either by email or by storing them in a common directory accessible by 
both teams. Either team can initiate a change, and the change request is approved or rejected by the 
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other team. MCAD Collaborator saves and tracks the status of each change request so you have a 
continuous record of what was done. Once a change request has been sent and received, you can close 
the collaboration session.

Figure 52. Typical Collaboration Workflow Diagram

Related Topics
Launching the Collaboration Tool
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Launching the Collaboration Tool

Launching the Collaboration Tool
Launch the collaboration tool from the SailWind 3D window within SailWind Layout.

Procedure
1. From within a design in SailWind Layout, open SailWind 3D (View > SailWind 3D).

SailWind 3D opens and displays the 3D General toolbar.

2. Open the MCAD Collaborator by clicking on the MCAD Collaborator  button  on the toolbar.

Results
You are ready to set up a collaboration session.

Related Topics
Setting Up a Collaboration Session

Setting Up a Collaboration Session
Before you transmit changes, set up a collaboration session and define how you want to exchange data 
with the mechanical design team.

Restrictions and Limitations

• You must name (or rename) all components and part names so they do not contain spaces or 
non-alphanumeric characters. If you send a data file to the mechanical design team that has a 
space or a non-alphanumeric character in a name, those characters are automatically replaced 
with underscores. These automatic changes in the names are then marked as modifications even 
though no design change has actually occurred.

Procedure
1. In MCAD Collaborator, expand the Communication section.

2. In the Write Options section, choose the desired output and Email notification options from the 
dropdown lists.

3. Choose one of the following from the Data Transfer dropdown list to define how you want to 
exchange the baseline and change request files:

If you want to... Do the following...

Exchange data files by 
storing them in a shared 
directory

1. Choose File from the dropdown list.

2. In the Data Path text box, enter the path name for the 
directory where you want to store the data exchange 
files (or browse to locate the directory).

SailWind Layout Guide and Reference 565



Exchanging Data with Mechanical Designers
Setting Up a Collaboration Session  

If you want to... Do the following...

Exchange data files as email 
attachments

1. Choose Email from the dropdown list.

2. Choose either Outlook or SMTP from the Email 
Server dropdown list.

3. Enter the appropriate contact information in the 
Receiver Info and Sender Info text boxes.

4. Click Filter objects   to open the Object Filter dialog box.

5. In the Component Options section, do the following to specify how to generate component data:

• Check “Write Mounting Holes”  to generate mounting hole data as part of the decal.

• Check “Write Pin Holes”  to generate pin hole data as part of the decal.

• Under Replace 0 Height Components With, check “Top or Bottom Copper Thickness”  or enter a 
custom height.

Note:
The collaboration exchange may not transmit zero height values correctly. By defining a 
default height for zero height components, you avoid potential errors that may appear on 
the mechanical design side of the exchange.

6. In the Board Options section, check Write Cutouts (Contours and Cavities) to include cutouts.

7. In the Collaboration Objects Filter list, filter what is displayed in the Collaboration Data list by 
checking the desired object types. (Unchecked object types will not appear in the Collaboration 
Data list.)

8. Click OK  to save the Object Filter settings and close the dialog box.

Note:
If you made changes to the Collaboration Objects Filter list, the Update Tree Data  button 
in MCAD Collaborator turns yellow. Click Update Tree Data  to update the Collaboration 
Data list.

9. (Optional) In the Scheme section, click Save  and enter a scheme name to save the settings you 
define so you can reuse them later in other designs.

The Communication and Object Filter settings are saved as a scheme in the directory you specify.

Results
The Collaboration Data list displays the design objects you checked in the Objects Filter list.

The collaboration settings are stored with your design project.

You are ready to send a baseline request.
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Sending a Baseline Request

Related Topics
Launching the Collaboration Tool

Sending a Baseline Request

Receiving a Baseline Request

Creating and Sending a Change Request

Reviewing and Applying a Change Request

Sending a Baseline Request
Start a collaboration session by creating and sending a baseline request to the mechanical design team.

The baseline request establishes a common database that is shared between the PCB design team 
and the mechanical design team so that both are synchronized. Future change requests are referenced 
against the baseline data.

Prerequisites

• A collaboration session has been set up that defines how the request information is exchanged. 
See “Setting Up a Collaboration Session”  on page 565.

Procedure
1. In MCAD Collaborator, choose Baseline from the File Type Selector dropdown list.

2. Click Object Filter  to open the Object Filter dialog box.

a. Check the Component Options you want to apply.

a. In the Collaboration Objects Filter list, filter what is displayed in the Collaboration Data list by 
checking the desired object types. (Unchecked object types will not appear in the Collaboration 
Data list.)

a. (Optional) In the Board Options section, uncheck “Write Cutouts (Contours and Cavities)”  to 
send only the Board Outline without cutout and contour data.

a. Click OK  to apply the settings and close the Object Filter dialog box.

Note:
If you made changes to the Collaboration Objects Filter list, the Update Tree Data  button 
in MCAD Collaborator turns yellow. Click Update Tree Data  to update the Collaboration 
Data list with the objects you checked in the Object Filter dialog box.

The Properties section for the main design item shows the File type as “Baseline” and the Status 
as “To be sent”.

The status bar reads “Ready” and is green.

3. In the Collaboration Data list, check the objects you want to include in the baseline; uncheck the 
objects you want to exclude.
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4. Click Send.

MCAD Collaborator generates the specified PCB data.

Results
The baseline request file is saved and appears in the History section.

The status bar reads “Baseline sent...Ready to send or receive more changes” and is green.

If you enabled email notification, the mechanical design team receives your baseline request.

Related Topics
Receiving a Baseline Request

Creating and Sending a Change Request

Receiving a Baseline Request
If you receive a baseline request from the mechanical design team, you must accept the entire baseline 
database as it is submitted to you so you can proceed with the collaboration session.

The baseline establishes a common database that is shared between the PCB design team and the 
mechanical design team so that both are synchronized. Future change requests are referenced against 
the baseline data.

Note:
The MCAD Collaborator monitors the shared directory where the baseline files are stored 
and updates the Files section automatically whenever a new change request file (baseline or 
proposal) is placed in the directory.

Procedure
1. In the Files section of MCAD Collaborator, select the baseline file.

The Collaboration Data section shows a list of the design objects contained in the baseline file.

2. (Optional) For detailed information about a design object, select it and review the properties for that 
object in the Properties section.

3. Click Apply.

Note:
If a baseline has a DRC error, a warning message appears. You can proceed and apply 
items that partially succeed instead of failing the entire transaction. If you proceed, the 
MCAD and ECAD baseline files become out-of-sync.

Results
Your design database is updated with all of the changes contained in the baseline file. Error messages 
and processing reports appear in the Message Window.

The baseline file moves to the History section.
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Creating and Sending a Change Request

The status bar reads: “Baseline applied. Ready to send or receive more changes”  and is green.

Related Topics
Sending a Baseline Request

Creating and Sending a Change Request

Reviewing and Applying a Change Request

Reviewing the Change History

Creating and Sending a Change Request
You can make changes to the placement and objects in your design then send a change request to the 
mechanical design team that describes the proposed changes.

Prerequisites

• A baseline file has been exchanged and accepted.

Procedure
1. In MCAD Collaborator, choose Proposal from the Proposal Type dropdown list.

2. Click Update tree data   .

Note:
Any time you make a change in the PCB design, the Update tree data  button turns yellow 
to indicate that the data in MCAD Collaborator is out-of-sync and needs to be udpated.

MCAD Collaborator generates the revised PCB data with any changes you have made and shows 
the changes in the Collaboration Data list.

The Properties section shows the File type as “Proposal”, the Status as “To be sent”, and the File 
Name as “proposal_nn”.

3. (Optional) Do the following to limit the Collaboration Data list to only the types of objects you want 
to display:

a. Click Filter objects   to open the Object Filter dialog box.

b. In the Collaboration Objects Filter list, check only the types of objects you want to display in the 
Collaboration Data list, then click OK.

The Update tree data  button turns yellow to indicate that the list needs updating.

c. Click Update tree data   to update the Collaboration Data list and show only the object 
types you selected in the Collaboration Objects Filter list.

4. In the Collaboration Data list, check the objects you want to include in the proposal; uncheck the 
objects you want to exclude.
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5. Click Send.

Tip
If you want to abandon the proposal after sending it, click Abandon. This cancels the 
proposal file and changes its Status to “Abandoned”  in the History section.

Results
The proposal file is submitted to the mechanical design team for their approval or rejection. Error 
messages and processing reports appear in the Message Window.

The proposal file appears in the History section.

The status bar shows: “Proposal sent. Awaiting response”  and is yellow.

You can continue to make additional design changes or process other change requests sent to you 
from the mechanical design team. (You cannot send a new proposal until you have processed previous 
proposals and any responses you receive from the mechanical design team.)

Related Topics
Reviewing and Applying a Change Request

Sending a Baseline Request

Reviewing and Applying a Change Request
After you receive a change request (proposal) from the mechanical design team, preview the proposed 
changes and determine whether to accept or reject them.

The 3D View shows what has been added, modified, or deleted by highlighting the proposed changes.

Prerequisites

• A baseline file has been exchanged and accepted.

Procedure
1. In the Files section of MCAD Collaborator, select the proposal file you want to preview and 

validate.

The Collaboration Data section shows a list of the design objects contained in the proposal.

2. Click Highlight/Unhighlight   to activate highlighting and enable animation of the selected 
changes.

3. In the Collaboration Data list, select the object you want to preview.

The 3D View shows an animated playback of the change you select.

570 SailWind Layout Guide and Reference



 
Exchanging Data with Mechanical Designers

Controlling the Display of Different States

Tip
For more detailed information about the selected object, review the properties for that 
object in the Properties section. This shows a “From” / “To” comparison of the changes 
made to the object.

4. Based on what you see in the 3D View, determine if the change you previewed is acceptable.

If you want to... Do the following...

Accept the change Check the change item.

Reject the change Uncheck the change item.

5. Repeat Steps 3 - 4 for each object in the Collaboration Data list.

6. Click Apply.

Your design database is updated and the items you checked are changed in your design.

Note:
If a change creates a DRC error, you are notified and the change is not applied. For 
example, the change would create an "unresolvable metal error". In this case, you would 
need to send a "Reject" response.

The proposal file moves to the History section.

The status bar shows: “Proposal Applied. Ready to send a response”  and is green.

7. (Optional) Repeat Step 3, as needed, to review the changes that have been made and verify that 
the design has been updated correctly.

8. Click Send.

A response_nn.idx  file is sent.

Results
If you are collaborating by means of email notification, the mechanical design team receives a response 
telling them that you have processed the proposal. The email contains a file (response_nn.idx) that the 
mechanical team loads to their design environment to see the changes.

The status bar shows: “Transaction complete. Ready to send or receive more changes”  and is green.

Related Topics
Controlling the Display of Different States

Controlling the Display of Different States
Display different change items in a proposal based on their states to quickly determine the items to 
accept.
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You can control which objects appear in the Collaboration Data list of MCAD Collaborator according to 
their status within a proposal file. You can also highlight a selected object in the SailWind 3D window to 
locate it and analyze its impact.

For example, you can choose to view only those objects in a change request that are added, and not view 
objects that are deleted or changed. This helps you evaluate a proposed change request more efficiently 
by focusing on only one state at a time.

Procedure
1. In the Files section of MCAD Collaborator, select the proposal file you want to review.

The Collaboration Data section shows a list of the objects contained in the proposal file.

Tip
You can manage the files in the Files section in the following ways:
• Select a file and choose Clear  from the popup menu to remove it from the Files list.
• Choose Clear All  from the popup menu to remove all of the files from the Files list.
• Choose Refresh  from the popup menu to update the Files list.

2. In the display toolbar, click the appropriate buttons to toggle the display of objects in the 
Collaboration Data list:

If you want to... Do the following...

Show (or hide) all of the objects that have been added.
Click .

Show (or hide) all of the objects that have been deleted.
Click .

Show (or hide) all of the objects that have been modified.
Click .

3. (Optional) Click , then select an object in the Collaboration Data list that you want to preview in 
the 3D View.

The selected object is highlighted in the 3D View to help you locate it more quickly in the design.

Related Topics
Reviewing the Change History

Reviewing and Applying a Change Request

Sending a Baseline Request

Reviewing the Change History
You can review the history of change requests for the current collaboration session and look at previous 
proposals to recall what has been changed.
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Managing the Change Files

Procedure
1. In the History section of MCAD Collaborator, select the proposal you want to review.

The Collaboration Data section updates to show a list of the objects contained in the selected 
proposal.

2. In the Collaboration Data list, select the object you want to review.

The 3D View shows an animated playback of the change you select.

3. Continue to review other individual change items in the proposal, as needed, or select a different 
proposal and review those changes.

4. (Optional) Click Clear  in the History section to clear the entire change history and reset the current 
collaboration session.

The change request files are moved to the Files section and the History section becomes empty. 
The collaboration state is cleared as if no exchange of data has occurred.

CAUTION:
You cannot undo this action.

Related Topics
Reviewing and Applying a Change Request

Controlling the Display of Different States

Managing the Change Files
You can manage the list of files to work more efficiently with large lists of baseline and change request 
files.

Procedure
1. In the Files area of the MCAD Collaborator, select a file.

Tip
To make sure the Files area is updated and current, choose Refresh  from the popup 
menu.

2. Do any of the following:
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If you want to... Choose the following from the popup menu...

Remove a single file. Clear

Remove all of the files. Clear All
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Chapter 24
Virtual Pins

Read the topics that follow to learn more about the setup and management of virtual pins.

The Virtual Pin
Virtual Pin Setup
Adding a Virtual Pin to a Net
Moving a Virtual Pin
Deleting a Virtual Pin
Converting a Virtual Pin to a Via
Gluing a Virtual Pin
Changing a Virtual Pin’s Via Type
Support for Export to Other Formats
ECO Import Support
Reuses Support

The Virtual Pin
A virtual pin is like a component pin that you can add to a net. It becomes a start point and/or end point of 
one or more new pin pairs. This gives you increased (sub-pin-pair) control over the net. For example, you 
could use a virtual pin to create distinct matched length pin pairs out of the net’s branches.

Tip
You can also add virtual pins in SailWind Router.

A virtual pin uses the pad stack of a via. The pad stack can be through-hole or partial, or it can be a 
single-layer pad. Virtual pins are added to nets. When you add a virtual pin to a net, the total number of 
pin pairs in the net increases by 1, as shown in this example:
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You can assign rules to pin pairs ending on virtual pins in the same way as to pin pairs ending on 
component pins.

In the display, virtual pins are identified with a marker that uses the color of the board outline.

Figure 53. Virtual Pin Marker
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Virtual Pin Setup

To work with virtual pins, you need the Advanced Rules license.

Virtual Pin Setup
Virtual pins use via types defined in the Pad Stacks Properties dialog box.

If you want to create unique via types to use for virtual pins in your design (a non-drilled single-layer pad, 
for instance) follow the procedures in “Via Setup”.

Adding a Virtual Pin to a Net
You can add a virtual pin to any net—unrouted, partially-routed, or wholly routed.

When you add a virtual pin to a net, it is added as follows:

• If the virtual pin you are adding is the first virtual pin in the net, and the net has no pin pair rules 
and no routing, and has Minimized topology, pin pairs are created between the new virtual pin 
and each component pin in the net in a “starburst” pattern, with the virtual pin in the center. This is 
the only case in which a starburst pattern is created.

Note that if a virtual pin has been previously added to the net and deleted, the net topology will 
have been set to Protected; so the virtual pin you are adding, even though it appears to be the 
first virtual pin in the net, will be connected only to the nearest component pin, not in a starburst 
pattern. You must reset the net topology to Minimized to create the starburst pattern with a central 
virtual pin.

• If the virtual pin you are adding is the first virtual pin in the net, and the net has pin pair rules, 
or routing, or a topology other than Minimized, the new virtual pin is connected to the nearest 
component pin only. No starburst pattern is created.

• If the virtual pin you are adding is not the first virtual pin in the net, it is connected to the nearest 
virtual pin only. No starburst pattern is created.

Restriction:
You cannot create a starburst pattern by placing a virtual pin on a trace of a routed net.

Restrictions and Limitations
You cannot add a virtual pin to a plane net.

Procedure
1. In the design area, select a net.

2. Right-click and click the Add Virtual Pin  popup menu item. The new virtual pin appears on the 
pointer.

3. Position the virtual pin, and click to place it. To stop adding virtual pins, right-click and click the 
Cancel  popup menu item.
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Results

• If you have created a starburst pattern, the new pin pairs are created, and the net topology is 
set to Protected. If you set your filter to Select Pin Pairs, you can select each connection. The 
status bar displays the connection to the virtual pin. Instead of a component and pin number (for 
example U2.8), it displays the instance of the virtual pin (for example VP2). The same format 
(VP<number>) is used in pin pair names, for example VP7—U2.1.

For information on setting design rules for the new pin pairs, see “Pin Pair Design Rules.”

• If you have created a non-starburst configuration, or if you have created a starburst configuration 
and want to reconfigure your pin pairs, you will need to reschedule the net in SailWind Router. 
See “Rescheduling Nets” in the SailWind Router Guide  for instructions.

Moving a Virtual Pin
Move virtual pins just as you would move a via.

Restrictions and Limitations
You cannot move more than one virtual pin at a time.

Procedure
1. In the design area with nothing selected, right-click and click the Select Virtual Pins  popup menu 

item.

2. Select a virtual pin to move, right-click and click the Move  popup menu item.

3. Move the virtual pin to a new position. Virtual pins adhere to the via grid for initial placement but 
adhere to the design grid when moving them.

Deleting a Virtual Pin
You can remove or delete a virtual pin from a routed or unrouted connection.

Procedure
1. In the design area with nothing selected, right-click and click the Select Virtual Pins  popup menu 

item.

2. Select the virtual pin, right-click, and click the Delete  popup menu item.

Results

• If the deleted virtual pin has only one connection (routed or unrouted), the virtual pin and its 
connection are deleted.

• If the deleted virtual pin has two or more connections, all unrouted, the virtual pin is deleted, and 
new connections are made between the component pins and virtual pins it was connected to.
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Converting a Virtual Pin to a Via

• If the deleted virtual pin has two or more connections, some or all of which are routed:

◦ The virtual pin and all its attached pin pairs are deleted.

◦ Routing (traces and vias) of the deleted pin pairs remains, and is assigned new pin pairs.

◦ If traces from different layers were attached to the deleted virtual pin, one or more zero-length 
unroutes will be created between junctions on different layers.

◦ Unroutes might be connected to junctions that replace the virtual pin.

Converting a Virtual Pin to a Via
Select a virtual pin in the design and right-click to convert it to a via.

Procedure
1. In the design area with nothing selected, right-click and click the Select Virtual Pins  popup menu 

item.

2. Select the virtual pin, right-click and click the Convert to Via  popup menu item.

Results
The virtual pin is converted to a via, traces and unroutes attached to the converted virtual pin remain 
attached to the new via, and new pin pairs passing through the new via are assigned.

Gluing a Virtual Pin
Select a virtual pin in the design and enable the Glued property.

Procedure
1. In the design area with nothing selected, right-click and click the Select Virtual Pins  popup menu 

item.

2. Select the virtual pin, right-click and click the Properties  popup menu item.

3. In the Virtual Pin Properties Dialog Box, select the Glued check box.

4. Click OK.

Changing a Virtual Pin’s Via Type
If desired, you can change the via type that a virtual pin uses by right-clicking on it.
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Procedure
1. Select the virtual pin, right-click and click the Properties  popup menu item.

2. In the Virtual Pin Properties Dialog Box, select the new via type from the Via Name list.

3. Click OK.

Support for Export to Other Formats
Virtual pins are recognized and exported when a design is exported to the PADS-ASCII format (of PADS 
9.5 or later), or to a DXF file. When a design is exported to any other format, including PADS-ASCII 
formats of releases earlier than PADS 9.5, the export process converts virtual pins to vias.

For more information, see “File Export Formats”.

ECO Import Support
ECO ignores operations on virtual pins, but in cases of removal of components or connections from nets 
containing virtual pins, importing the ECO file affects the nets.

Nets are affected as follows when you import the ECO file:

• If, after applying all ECO commands that remove components, connections, or nets, a net is left 
with less than two component pins, the net and all its virtual pins are deleted.

• If a net with virtual pins is left with two or more component pins, its virtual pins remain, and new 
pin pairs are created.

• If a net is split at a connection that has a virtual pin, the virtual pin remains connected to one of 
the new nets.

Reuses Support
Physical design reuses do not support virtual pins.
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Chapter 25
Working With Labels

Read the topics that follow to learn more about the methods used to create, modify, and control the 
visibility of labels. These sections include a selection of graphical examples to guide you in setting up 
your label properties.

Labels
Adding a New Part Label
Selecting a Label
Deleting a Label
Justifying a Label
Modifying Part Label Properties
Modifying Labels using the Component Properties Dialog Box
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Labels
You can create attribute, reference designator, and part type labels for components and jumpers. You can 
control the visibility of, justification, right-readability, and alignment of labels.

When you create labels, they may not be visible. Turn on the visibility of labels using the Display Colors 
Setup dialog box, where you can set the color for reference designators, part type, and attribute labels.

Unlike free text, when you add a label, there is no invisible bounding rectangle  on page 1813 around the 
label itself.

Label Defaults
Justification Examples
Right Reading Examples
Managing Reference Designators
Labels in the PCB Decal Editor

Label Defaults
If you create a label, but do not provide display information in the decal or in the component, SailWind 
Layout uses default visibility properties.

The default position for the first label is at the decal origin with no orientation, and it uses the default 
height and width. If a label already exists in the first position, the second position is used. The default 
position for the second label is under the first label position.

The figure below shows how a new height attribute label is placed in the second default position. Note 
that the second position is based on the first position, not where other labels are placed.

Figure 54. New Height Attribute Label (Second Default Position)

The figure below shows how a new height attribute label is placed in the third default position because the 
first and second positions are already filled.

Figure 55. New Height Attribute Label (Third Default Position)
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Justification Examples

Related Topics
Labels

Creating Attribute Labels in the PCB Decal Editor

Justification Examples
You can justify free text and attribute, reference designator, and part type labels. You can set justification 
options when you create the label or text.

For more information, see Justifying a Label.

In the figure below, a label appears within a part outline. The label uses the default justification, which is 
Left, Down; meaning that the label was placed by its lower left corner.

Figure 56. Label Within a Part Outline

The figure below shows what happens when you change the Height and Width of the label. The label now 
overlaps the part outline.

Figure 57. Label After Changing the Height and Width (with Overlap)

The figure below shows how you can change the Height and Width of the label and prevent the label from 
overlapping outlines. By changing the justification to Top, Right you change the location by which the label 
is placed, preventing overlap.

Figure 58. Label After Changing the Height and Width (no Overlap)
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Related Topics
Labels

Creating Attribute Labels in the PCB Decal Editor

Right Reading Examples
You can set the left or right reading status for free text and attribute, reference designator, and part type 
labels using the Label Properties dialog box. You can also use the Properties dialog box for any of the 
objects.

For more information, see Adding a New Part Label  or the appropriate Properties object topic.

The figures below show different reading orientations.

Figure 59. Normal Rotation
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Right Reading Examples

Figure 60. Mirrored

Figure 61. Right Reading - Orthogonal
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Figure 62. Right Reading - Orthogonal, Mirrored

Figure 63. Right Reading - Angled
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Managing Reference Designators

Figure 64. Right Reading - Angled, Mirrored

Related Topics
Labels

Creating Attribute Labels in the PCB Decal Editor

Managing Reference Designators
SailWind Layout handles reference designators in the same manner as it handles attribute labels, 
providing flexibility in visibility and placement.

You have many options when creating and using reference designators in your design:

• Create a reference designator label and set it up for silkscreen layers. For more information, see 
the Moving Reference Designators to the Silkscreen Layer  on page 810topic.

• Create a second reference designator label and set it up for assembly drawing layers. For more 
information, see the Generating a Second Set of Reference Designators for Assembly Drawings 
on page 808 topic.

• Hide reference designators. For more information, see the Disabling Reference Designators of 
Selected Components  topic.

Related Topics
Labels

Creating Attribute Labels in the PCB Decal Editor
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Labels in the PCB Decal Editor
Work with labels in the PCB Decal Editor exactly as you do in the Layout Editor. Labels in the PCB Decal 
Editor offer you greater flexibility; you can display either decal attributes or an attribute from an object that 
uses the decal. You can, for example, create a label for the part attribute Cost. Since Cost is not a decal 
attribute, you create the attribute in the Attribute Dictionary in the Layout Editor, and assign a placeholder 
label in the PCB Decal Editor.

For more information, see the Creating Placeholder Attribute Labels  topic.

When you create labels, they may not be visible. Turn on label visibility in the Display Colors Setup dialog 
box. On the Display Colors Setup dialog box, you can set the color for reference designators, part type, 
and attribute labels.

If you created a placeholder label for an attribute that exists in the Attribute Dictionary, the label is 
associated with the existing attribute, but it is not visible. The attribute is not, however, assigned to the 
part using the decal. You must manually assign it.

Related Topics
Labels

Creating Attribute Labels in the PCB Decal Editor

Adding a New Part Label
Add labels of attributes from components or jumpers.

Restrictions and Limitations
When working with labels, some restrictions apply:

• Reference designator is the only label available for use when you are creating labels for jumpers.

• If you do not set visibility information, default positions are used. For more information, see “Label 
Defaults.”

• Unlike free text, when you add a label, there is no invisible bounding rectangle  on page 1813
around the label itself.

Procedure
1. Select a component or jumper, right-click, and then click the Add New Label  popup menu item.

2. In the Add New Part Label Dialog Box, in the Attribute list, select the attribute you want.

Restriction:
If you are creating labels for jumpers, Reference Designator is the only available attribute. 
Hidden attributes do not appear in the Attribute list unless the attribute was selected for the 
label before it was set as a hidden attribute.
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Selecting a Label

3. The Value for Component or Value for Jumper box lists the value of the selected attribute. Accept 
this value, or type a new one.

Restriction:
This box is unavailable if you clicked Reference Designator or Part Type from the Attribute 
list, if the attribute is read-only, or if you open the Properties dialog box for different 
attribute types. However, if the labels you select belong to attributes of the same type, you 
can edit this box.

Tip
If the attributes have different values, the box is blank. You can type a new value in the 
box to apply it to all of the selected attribute labels and their parent objects.Value is also 
unavailable if the attribute is ECO-registered and SailWind Layout is not in ECO mode.

4. In the Show list, click the value you want to control the visibility of the label. You can choose to turn 
the label off, to display only the label name, to display only the label value, to display the name and 
value, or to display the full name and value (when labeling a structured attribute).

Tip
Labels are invisible regardless of this setting unless you use the Display Colors Setup 
dialog box to change the color of labels to a color different from that of the background.

5. Make any additional settings required for the label.

6. Click OK.

Selecting a Label
Set the selection filter and select a label.

Procedure
1. Use one of the following methods to set the Selection Filter:

• With nothing selected, right-click, and then click the Select Documentation  popup menu item.

• Click the Edit  > Filter  menu item. In the Selection Filter dialog box  on page 114, on the Object 
tab, select the Labels check box. Click Close.

2. Select the label.

Deleting a Label
If desired, you can delete or remove a label from your design.
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Procedure
1. Select the label to delete. Use the selection filter if you need help selecting the label.

2. Press the Delete key, or click the Edit  > Delete  menu item.

Justifying a Label
You can justify free text and attribute, reference designator, or part type labels. You can set justification 
options when you create a label. You can also justify text and labels after you create them.

Procedure
1. Select the label or free text.

2. Choose one of one of these methods to justify the label:

• Right-click and click the Justify Horiz  popup menu item. Then click Left, Center, or Right  to 
set the horizontal Justification. Right-click again and click the Justify Vert  popup menu item. 
Then click Up, Center, or Down  to set the vertical justification.

• Right-click and click the Properties  popup menu item to open the Properties dialog box for the 
object and set the appropriate justification setting.

Note:
You can also set justification options when you spin or move labels and text. For more 
information, see “Moving Text and Labels  and Rotating an Object.”

Related Topics
Adding a New Part Label

Component Properties Dialog Box

Labels in the PCB Decal Editor

Modifying Part Label Properties
Use the Part Label properties dialog box to modify a label and to change the attribute the label displays.

Tip
If you select multiple labels, settings in this dialog box apply to all the selected labels.

Procedure
1. Select a part label, right-click, and then click the Properties  popup menu item.

2. In the Part Label Properties Dialog Box, in the Attribute list, select the attribute you want.
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Modifying Labels using the Component Properties Dialog Box

Restriction:
If you are creating or modifying labels for jumpers, Reference Designator is the only 
available attribute. Hidden attributes do not appear in the Attribute list unless the attribute 
was selected for the label before it was set as a hidden attribute.

3. The Value box lists the value of the selected attribute. Accept this value, or type a new one.

Restriction:
This box is unavailable if you clicked Reference Designator or Part Type from the Attribute 
list, if the attribute is read-only, or if you open the Properties dialog box for labels of 
different attribute types. However, if the labels you select belong to attributes of the same 
type, you can edit this box.

Tip
If the attributes have different values, the box is blank. You can type a new value in the 
box to apply it to all of the selected attribute labels and their parent objects.Value is also 
unavailable if the attribute is ECO-registered and SailWind Layout is not in ECO mode.

4. In the Show list, click the value you want to control the visibility of the label.

You can choose to turn the label off, to display only the label name, to display only the label value, 
to display the name and value, or to display the full name and value (when labeling a structured 
attribute).

Tip
Labels are invisible regardless of this setting unless you use the Display Colors Setup 
dialog box to change the color of labels to a color different from that of the background.

5. Make additional edits to text settings as necessary.

6. Click OK.

Modifying Labels using the Component 
Properties Dialog Box
You can modify labels from the Component Properties dialog box.

Procedure
1. Select a component, right-click, and then click the Properties  popup menu item.

2. Click the Labels  tab.
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3. Click the label to modify from the Label list and click the Label  button. The Part Label Properties 
dialog box appears.

4. For information on deleting labels, see “Deleting a Label.”
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Chapter 26
Reusing Designs or Parts of Designs

Read the topics that follow to learn more about the creation and management of physical design reuses.

Physical Design Reuse
Elements in a Physical Design Reuse
Process of an Added Physical Design Reuse
Creating a Physical Design Reuse
Selecting a Reuse in the Design
Moving a Reuse
Saving a Reuse
Design Elements Made Like a Reuse Definition
Using Make Like Reuse in Object Mode
Using Make Like Reuse in Verb Mode
Reuse Blocks Added in ECO Mode
Editing a Physical Design Reuse Definition
Modifying Reuse Properties in the Design
Resetting the Origin of a Reuse
Breaking a Reuse
Deleting a Reuse
Creating a Reuse Report

Physical Design Reuse
The most common use of the reuse feature is to clone the placement and layout of multi-channel design 
elements. To describe the feature more generally, if you have portions of your design that have a strict 
relationship with each other, you can group those elements of your design to lock them together to re-
use them, or to clone them. The physical design reuse includes properties and attributes of these objects, 
such as test point status. You can create a reuse of any design elements except for the board outline and 
board cutouts.

Reuse a circuit in other designs to effectively reuse proven and tested elements and shorten the design 
cycle of new designs.

A design may have a common circuit that you want to repeat a number of times in the same design. Place 
the components and interconnect traces for the common circuit, save that as a physical design reuse, and 
then clone it using other existing design elements.

Each time you create a physical design reuse, it is assigned a reuse type, a unique name that describes 
it. The reuse type is similar to the library part type. Each physical design reuse also has an origin. The 
origin is visible only when you reset the origin of the reuse. You cannot display the reuse name and reuse 
type in the design.

Here are the three ways a reuse can be used:
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• Like a union  on page 504, the elements of a reuse are glued together and are moved as a group. 
For example, if you have not finalized placement, but want to start routing, you could route 
associated elements and then move them later if needed.

• Save the reuse to a file, and in any design, use the reuse as a template to create a clone of the 
layout using existing design elements. For example, if you have a redundant or multi-channel 
area in your design, you could place and route the interconnects of one channel, and then use 
it as a template to automatically place and route the other identical channels. This accelerates 
placement and routing of the design.

• Save the reuse to a file, and in ECO mode, add the reuse elements to your design. For example, 
if you have no schematic to supply the parts and netlist, you can add the reuse into the design.

Elements in a Physical Design Reuse
You can include certain elements in a physical design reuse. The physical design reuse includes 
properties and attributes of these elements, such as test point status. Each element is assigned a unique 
ID in the reuse. You must completely select an item to include it in a reuse. SailWind Layout does not 
include partially selected items in a reuse.

Physical design reuse elements include:

• Component Elements

• Routing Objects

• Drafting Objects

• Unions and Arrays

• Net-Based Design Rules

The physical design reuse opens as a new design. The start-up file information and design rules 
saved with the physical design reuse load as well. When you load a physical design reuse, single pin 
components are added to the ends of the single pin nets to preserve the net objects. These components 
have no drill size, pad size, outline, and so on. They are glued by default, non-ECO registered, and 
located at the 0,0 origin. The component name includes the entire netname, or reasonable portions of it, 
to easily identify the component to net associations.

Component Elements
The table below shows component elements eligible for inclusion in a physical design reuse.

Table  107. Component Elements Used in Physical Design Reuse

Eligible Element Description

Reference Designator Includes the reference designator of a component.

Part Type Definition Includes all details of the part type definitions assigned to 
components.
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Table  107. Component Elements Used in Physical Design Reuse  (continued)

Eligible Element Description

Location Includes the location of component elements relative to the origin 
of the physical design reuse; including X,Y coordinates, rotation, 
and the side of the design on which the component is mounted.

Reference Designator and 
Type Label Properties

Includes each component element's reference designator and part 
type labels.

PCB Decal and Alternates Includes the PCB decal and alternates assigned to each 
component element.

Component Attributes Includes all attributes associated with each component element 
as well as their labels.

Other Properties Includes other details of the component and its pins, including the 
test point status, whether the test point is Top Access, thermal 
eligibility, and thermal and antipad pad stack for each pin.

Routing Objects
The path of route segments, or the route pattern, is stored with width, layer, and netname information. For 
a physical design reuse, it is assumed that a net consists of one or more pin pairs. Nets are not included 
directly in a reuse. Instead, the physical properties of the net such as traces, vias, jumpers, coppers, and 
signal names are included, so the net is preserved.

Tip
Because only net properties are included in a physical design reuse, unrouted pin pairs are not 
included. The signal name of a pin pair, however, is included and is assigned to pins of the pin 
pair.

The table below shows route elements you can include in a physical design reuse.

Table  108. Route Elements Used in Physical Design Reuse

Route Element Description

Complete Routes and Route 
Paths

Contiguous routed or unrouted segments of a pin pair between 
two component pins. This includes all trace segments, vias, and 
jumpers.

Partial Routes Incomplete, but contiguous, route segments of a pin pair that start 
or terminate on one component pin. The unrouted segments are 
also saved in the physical design reuse.

Floating Segments Segments of a pin pair that neither start nor end on a component 
pin. The path of the segments is stored in the physical design 
reuse with width, layer, and netname attributes. This may require 
generating new pin pairs when the physical design reuse is added 
to the design.

Multiple Pins of a Net Complete or partial route of the same net, with more than 
one component pin of the net included in the selection. When 
included in the physical design reuse, pin pairs may be created 
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Table  108. Route Elements Used in Physical Design Reuse  (continued)

Route Element Description
between the pins included in the physical design reuse in order to 
associate and preserve the route paths.

Single Pin of a Net Partial route of the same net with only one component pin of 
the net included in the selection. When included in the physical 
design reuse, a pin pair is created. If you cannot create the pin 
pair, the route is not included in the physical design reuse.

Vias Including any via in the route with the via name as an attribute.

Via Definitions Including the via definition (pad stack) in the physical design 
reuse for each element added to the physical design reuse.

Via Attributes Including test point status, Top Access status for test point, 
thermal status, and user-defined attributes.

Teardrop Settings Including teardrop status of route end points at vias and pads. 
Teardrop display is maintained according to the Tools  > Options 
menu item, Routing  tab, Generate Teardrops setting.

Jumper Component and Pins Including a jumper component with its reference designator, 
reference designator labels, pad stack definition of its vias (pins), 
and attributes.

Figure 65. Route Elements

Drafting Objects
The definition of the path of the line item, or shape, with width, layer, and netname stored in the physical 
design reuse. This includes both open and closed shapes.

The table below shows line elements eligible for inclusion in a physical design reuse.

Table  109. Line Elements Used in Physical Design Reuse

Line Element Description

2D Lines Including the shapes of all drawing pieces, layer for all drawing 
pieces, and a list of all text items associated with the 2D line.

Dimensions Including the X,Y location, layer, and individual dimension 
element settings, like text and arrow extensions.
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Table  109. Line Elements Used in Physical Design Reuse  (continued)

Line Element Description

Text Items Including the text string, X,Y location, orientation, layer, height 
and width, mirror flag, and justification settings.

Complete Copper Polygons Size and shape of polygons, stored with line width and netname.

Complete Copper Plane 
Polygons

Shape of copper plane polygons, stored as corner coordinates 
with attributes for polyline width and netname. Hatch outlines 
are not included in a physical design reuse but pour outlines are 
included. Editing to hatch outline is lost when you add a physical 
design reuse to a design.

Cutouts and Keepouts Any completely selected keepout, copper plane cutout, and 
copper cutout. Board cutouts are not stored in a physical design 
reuse.

Restriction:
Board outlines, board cutouts, hatch outlines, hatch voids, via thermals, and pad thermals are not 
included in the physical design reuse.

Unions and Arrays
Any completely selected union or component array is stored in a physical design reuse. Clusters are not 
included in a physical design reuse.

Net-Based Design Rules
Design rules for nets and net classes, default rules, and net-based pin pair and group rules are included 
in the physical design reuse. No other design rules, including pin pair-based rules, are included. Design 
rules are not added to a design from the reuse, but are used for comparison purposes.

Process of an Added Physical Design Reuse
When you add a physical design reuse to a design, SailWind Layout compares the design and the 
physical design reuse and records the results in the report file.

Information is processed in the following order:

• Layer Definitions Compared

• Part Types Compared

• PCB Decals Compared

• Components Added

• Pin Pairs Added
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• Routes and Design Rules Added

• Polygon and Text Items Added

When you add a second instance of a physical design reuse to the same design, the checking that occurs 
(described below) is skipped. However, if you copy a physical design reuse and paste it into a different 
design, the checking is performed.

A report file is created logging any errors or warnings. The report file is named Layout.err  and located in 
..\SailWind Projects. If an error is encountered, the add reuse process cancels. If you receive warnings, 
you can choose whether to cancel the process or add the reuse.

Layer Definitions Compared
The layer arrangements in both the physical design reuse and the design are compared. If both are 
identical, the physical design reuse is added.

Errors include:

• Layer counts not matching.

• Layer types not matching. Documentation layer type differences are not treated as errors. The 
layer type in the reuse is ignored in this case.

Warnings include:

• Layer names not matching. The layer name in the reuse is ignored. The report file details the 
layer name change.

• Other Layer Definition Data. Layer thickness, layer associations, and so on, are stored in the 
reuse, but the design settings are always used. This includes netnames associated with plane 
layers.

Part Types Compared
The part type names in the physical design reuse and the design are compared. If both are the same, the 
two part type definitions are compared. The definitions must match exactly, or the process cancels. Any 
differences found are recorded as errors in the report file for each part type.

PCB Decals Compared
If the PCB decals share the same name in the physical design reuse and in the design, the two 
decal definitions are compared. The definitions must match, or the add reuse process cancels. Slight 
differences in the decal definitions are tolerated. The location and orientation of the reference designator, 
part type, and attribute labels do not have to be identical. The attribute name and value, however, must 
match. Also, if the decal definitions differ, but the pin counts match, the decal definition in the physical 
design reuse is added to the design with a new name (its original name with an “A” suffix).

When the reuse is added, the PCB decal definition in the design is used.

When the decal pin counts do not match, errors are recorded in the report file. When PCB decals are 
renamed, warnings are recorded in the report file.
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Components Added
After the Reuse Properties dialog box settings are accounted for, component elements are added. If a 
part cannot be added, the add reuse process cancels.

Warnings include:

• Start at, Increment by, or Suffix/Prefix assigns a used reference designator. If a current setting in 
the Reuse Properties Dialog Box  creates a reference designator conflict, a message immediately 
appears and you can return to the Reuse Properties dialog box to choose different settings.

• Start at or Increment by assigns a new reference designator. If a reference designator is renamed 
(for example with a prefix), a message is recorded in the report file.

• Same or Next Highest assigns a new reference designator. If a reference designator is renamed, 
a message is recorded in the report file.

• Assign Prefix assigns a new reference designator. If a reference designator is renamed, a 
message is recorded in the report file.

• Assign Suffix assigns a new reference designator. If a reference designator is renamed, a 
message is recorded in the report file.

Pin Pairs Added
Pin pairs are added to the design. Pin pairs are also added to the design to merge reuse nets with 
existing nets in the design. If all pin pairs can be added to the design without conflict, the Add Reuse 
process continues. If a pin pair cannot be added, the Add Reuse process continues but the net is not 
added to the design.

When a net is renamed, a message is recorded in the report file.

Routes and Design Rules Added
Route elements are added based on the same rules and checking procedures for the route copy 
command. If any portion of the route patterns in the physical design reuse cannot be added to the design, 
the Add Reuse process continues and a message is recorded in the report file.

Nets added to the design assume the design rules for the net with which they merge. Otherwise, nets 
assume the default net rules. Rules saved with the physical design reuse are not used.

Jumpers are added to the design similarly to components and vias. The pad stacks and components are 
added as defined in the reuse definition, including any settings for thermal status, test point status, and so 
on.

Warnings include:

• Single pin nets not added without an existing net. Single pin nets are only added to the design 
when a net of the same name already exists in the design. Otherwise, single pin nets are not 
added. If single pin nets are removed, a warning is recorded in the report file.

• Via definitions not matching. If via definitions are the same in the physical design reuse and the 
design, the two via definitions are compared. The definitions must match or the via is added to 
the design with a new name (its original name with an “A” suffix). When the reuse is added, the 
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via definition in the design is used. If a new via definition is created, a message is recorded in the 
report file.

• Add route fails. If any portion of the route cannot be added, a message is recorded in the report 
file describing the failure.

• Add jumper fails. If a jumper cannot be added, a message is recorded in the report file describing 
the failure.

Polygon and Text Items Added
Polygon and text items are added to the design. There are no restrictions on adding polygons to a design, 
since adding a reuse must be performed with DRC off.

Tip
Pour cutouts are saved in the physical design reuse; however, board cutouts are not.

Creating a Physical Design Reuse
Select design items and add them to a reuse.

Procedure
1. Select the objects you want to include in the physical design reuse. You must select the entire 

object - partial selections are not included.

Tip
Copper planes must be in Pour Outline mode to be included in the Reuse. The copper 
plane cannot be flooded or in Hatch Outline mode when the Reuse is created.

2. Right-click and click the Make Reuse  popup menu item. Ineligible items are removed from the 
selection. Among them, selected tacks and trace corners are replaced with appropriate trace 
segments. Selected pin pairs are replaced with trace segments, vias, and jumpers (if pin pair is 
fully or partially routed). Unrouted pin pairs are removed from the selection.

Tip
If one of the items you selected is not a valid physical design reuse element, the message 
“Selection does not include items valid for inclusion into a reuse. Retry your selection.” 
appears. Click Report  to open a deselection report, in the default text editor, that lists 
items not valid for inclusion in a reuse. When you close the report, you return to the error 
message. Click OK  and repeat Step 1.

3. In the Make Reuse Dialog Box, in the Reuse Type box, type a description for the reuse.

4. Optionally, in the Reuse Name box, type a different reuse name if the default name based on the 
Reuse Type is not acceptable.

5. If you want to save the reuse to a file to use it as a template for cloning or to use it in other designs, 
select the Save to File check box.
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6. Optionally, click to view the Selection Report or Deselection Report, to ensure that all expected 
elements are in the reuse. The report file report.rep  is created in the C:\<install_folder>\<version>
\Settings  folder and opens in the default text editor. The deselection report and the selection report 
are created using the same file name. If you want to save this file, do so in the default text editor 
using a different file name.

7. Click OK.

• If the reuse type is already assigned to another physical design reuse in the design, the 
message “A reuse type in the design already exists with the name XXX. Reuse type names 
cannot be duplicated in the design” appears. Click OK  and specify another reuse type.

• If the reuse name is already assigned to another physical design reuse in the design, the 
message “Reuse name <name> already exists. Reuse names cannot be duplicated in the 
design” appears. Click OK  and specify another reuse name.

8. If you selected the Save to File check box, the Reuse Save As dialog box appears.

a. Type a physical design reuse file name and specify a location in which to save the file. The 
default physical design reuse file name is the reuse type name with a .reu  file extension. The 
default folder is \SailWind Projects\Reuse.

b. Click Save. If you specified a reuse file name that is different from the reuse name used in the 
design, the message “Do you want to change reuse type name to XXX?” appears.

c. Click Yes  to change the reuse type in the design to match the file name you specified, click No 
to ignore the change, or click Cancel  to cancel the Save to File process.

Results
Now you can:

• Move the reuse  on page 602.

• Create clones of the reuse  on page 603.

• Add the reuse to a design  on page 606.

Selecting a Reuse in the Design
Click on a reuse in the design to modify it or to view its properties.

Procedure
1. Select any element in the physical design reuse except for component pins.

2. Right-click and click the Select Reuse  popup menu item. The physical design reuse is selected.

Tip
Alternatively, to select physical design reuse blocks you can set the Selection Filter  on 
page 114 to Reuse or the Find Dialog Box  to Reuse type.

SailWind Layout Guide and Reference 601



Reusing Designs or Parts of Designs
Moving a Reuse  

Results
Now you can:

• Modify the properties of the reuse  on page 609

• Move the reuse  on page 602

• Rotate the reuse

• Create clones of the reuse  on page 603

• Break the reuse  on page 610

• Set the origin of the reuse  on page 610

• Save it to a file  on page 602 for use in other designs or to add a reuse to the design in ECO 
mode

• Report on the contents of the reuse  on page 611

Moving a Reuse
When you move a physical design reuse, traces routed to elements outside the reuse stretch, similarly to 
moving a group.

Procedure
1. Type the DRO modeless command  on page 83 and press the Enter key to turn off Design Rule 

Checking. DRC must be off to move a reuse.

2. Select the physical design reuse.  on page 601

3. Right-click and click the Move  popup menu item.

4. Click to indicate a new location for the physical design reuse. You can right-click and click the 
Cancel  popup menu item to cancel the move.

Saving a Reuse
You can save a physical design reuse to a file at any time. The saved version of the physical design reuse 
becomes known as the reuse definition.

Procedure
1. Select a reuse  on page 601.

2. Right-click and click the Save to File  popup menu item.

3. Optionally, you can type a new name for the reuse type from what it was named within the design.
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4. Browse for a location in which to save the selected physical design reuse. The default file name is 
the reuse type name with a .reu  file extension. The default folder is \SailWind Projects\Reuse.

5. Click Save.

• If you changed the reuse file name, the message “Do you want to change reuse type name to 
XXX?” appears. Click Yes  to change the reuse type file name, click No  to ignore the change, or 
click Cancel  to abort the Save to File process.

• If the name in the Reuse Type box is already assigned to another physical design reuse in the 
reuse folder, the message “XXX.reu already exists. Do you want to replace it?” appears. Click 
Yes  to overwrite the reuse file or click No  to specify another type.

Results
Now you can:

• Use the reuse as a template to create clones in another design.  on page 603

• Add the reuse to any design in ECO mode.  on page 606

Design Elements Made Like a Reuse Definition
The Make Like Reuse command uses existing design components with their logical interconnects to 
create a clone of a reuse definition. SailWind Layout automatically creates all other physical design reuse 
elements not yet present in the design—for example, traces, vias, coppers, 2D lines, and text.

The Make Like Reuse process maps components and interconnects of the physical design reuse circuit 
and searches for a match among the subcircuits within the design. Components are filtered based on 
the part type, the number of connections, the decal type, and the value/tolerance attributes. Nets are 
filtered based on the number of connections. Successive passes filter components and nets based on 
neighboring net and neighboring component characteristics, including terminal types and connection 
count. Parallel circuits are handled, and the filtering is independent of reference designators and 
netnames.

Default reuse properties are assigned to the new physical design reuse, including the reuse name. The 
Designator enumeration and Net Preferences are ignored since the elements already exist in the design.

Make Like Reuse skips glued components, components that are union or cluster members, component 
elements in another physical design reuse, and components with attached traces.

You can add a physical design reuse in either of these ways:

• Using Make Like Reuse in Object Mode  — Use this method to allow the software to find any 
compatible elements to use in the reuse clone.

• Using Make Like Reuse in Verb Mode  — Use this method to specify which design elements are 
used in each reuse clone. By choosing the components based on their schematic relationship, 
you can maintain the expected placement of the components.

Using Make Like Reuse in Object Mode
Select a reuse within the design and create a clone of it using design elements that the software selects.
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Restrictions and Limitations
You cannot add a physical design reuse if the design is in default layer mode and the reuse to add is in 
increased layer mode. Use the Layers Setup Dialog Box  to change the design to increased layer mode.

Procedure
1. Type the modeless command DRO  and press the Enter key to turn off Design Rule Checking. You 

must turn DRC off to make a like reuse. If DRC is not turned off, a prompt appears that allows you 
to turn DRC off.

2. Select an existing physical design reuse in the design as described in “Selecting a Reuse in the 
Design.”

3. To use the Reference Designator positions and style of the reuse, click the Tools  > Options  menu 
item and then click the Design  category, and select the Apply reuse Ref Des placement check box.

4. In the Matching Result Dialog Box, see whether a match to the selected reuse is found.

• If yes, each part has an equivalent one in the Equivalent Ref. Des. list, and the new physical 
design reuse dynamically attaches to the pointer after clicking OK.

• If not, some parts have no match. In this case, you can clear the Value check box to have 
another try.

For more parameter description, see Table 189.

5. Click OK  to close the dialog box. If a match is found in Step 4, with the like reuse on the pointer, 
click to place it.

Results
If you have bridge copper in your reuse block, you should ensure that it has retained its bridge status and 
assigned nets.

Using Make Like Reuse in Verb Mode
Unlike other buttons, the Make Like Reuse button is not “sticky” in verb mode, but instead it allows you to 
pre-select the components to use in the reuse before applying the Make Like Reuse command.

Restrictions and Limitations
You cannot add a physical design reuse if the design is in default layer mode and the reuse to add is in 
increased layer mode. Use the Layers Setup Dialog Box  to change the design to increased layer mode.

Procedure
1. Type the modeless command DRO  and press the Enter key to turn off Design Rule Checking. You 

must turn DRC off to make a like reuse. If DRC is not turned off, a prompt appears that allows you 
to turn DRC off.

2. Optionally, select the group of components you want to include in the new reuse.
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Tip
If you do not select a specific group of components to use in the reuse, any available 
components that match the reuse are used. This can group components that are not 
grouped together in the schematic. Skip this step if it does not concern you.

• If you want to pre-select a particular group of components to use in the reuse, you must save 
your reuse definition  before making a like reuse.

• Use cross-probing with the schematic software to select components that are grouped in the 
schematic.

• The group of components you select can be larger than required for the reuse; any useless 
components are ignored. You cannot select both the reuse and the group of components.

3. To use the Reference Designator positions and style of the reuse, click the Tools  > Options  menu 
item and then click the Design  category, and select the Apply reuse Ref Des placement check box.

4. Click the Design Toolbar  button and then click the Make Like Reuse  button on the Design 
Toolbar. The Open Reuse File dialog box appears.

5. Select a reuse in the Select Reuse Module Dialog Box.

6. In the Matching Result Dialog Box, see whether a match to the selected reuse is found.

• If yes, each part has an equivalent one in the Equivalent Ref. Des. list, and the new physical 
design reuse dynamically attaches to the pointer after clicking OK.

• If not, some parts have no match. In this case, you can clear the Value check box to have 
another try.

For more parameter description, see Table 189.

7. Click OK  to close the dialog box. If a match is found in Step 6, with the like reuse on the pointer, 
click to place it.

Results
If you have bridge copper in your reuse block, you should ensure that it has retained its bridge status and 
assigned nets.
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Reuse Blocks Added in ECO Mode
You can add reuse blocks to your design. Since adding reuse blocks will add new netlist elements, it must 
be done in ECO mode.

When the elements already exist in the schematic, use the Make Like Reuse command  instead.

The methods, to adding a reuse in ECO mode, are different depending if it is the first instance of the 
reuse or if you are adding an existing reuse.

Adding the First Instance of Design Reuse
Adding an Existing Reuse

Adding the First Instance of Design Reuse
After you create a physical design reuse and save it to a reuse definition file, you can add the elements of 
the reuse as new design elements in ECO mode.

Restrictions and Limitations
You cannot add a reuse to a design if the design is in default layer mode and the reuse to add is in 
increased layer mode. Use the Layers Setup Dialog Box  to change the design to increased layer mode.

Procedure
1. Click the ECO Toolbar  button. To add or copy a reuse, you must be in ECO mode; therefore, 

all components, pin pairs, and nets added to the design can be recorded in the .eco  file using 
standard ECO commands.

2. Type the DRO modeless command  on page 83and press the Enter key to turn off Design Rules 
Checking. You must turn DRC off to add or copy a reuse. If DRC is not turned off, a prompt 
appears that allows you to turn DRC off.

3. Click the Add Reuse  button on the ECO Toolbar. The Add Reuse dialog box appears.

4. Select the reuse file to add and click Open. The Reuse Properties Dialog Box  appears.

If the reuse file you select to add already exists in the design, the message “Reuse type XXX 
already exists in the design. OK to make a copy of this reuse type?” appears. Click OK  to add a 
copy of the selected physical design reuse from the design or click Cancel.

5. Set the reuse name and (Reference) Designator Preferences.

6. Click Net Properties. The Net Properties dialog box  on page 1491 appears.

7. Resolve net conflicts, if any, and click OK.

8. In the Reuse Properties dialog box, click OK. The reuse file is compared against the current design 
to detect possible reference designator, layer, decal, and netname conflicts, and to detect other 
errors and warnings.

For more information, see “Process of an Added Physical Design Reuse”.

The results of this comparison are recorded in the Layout.err  report file in the C:\<install_folder>
\<version>\Programs  folder.
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• If errors are found, the message “Adding this reuse to the design resulted in xxx errors and xxx 
warnings. The Add Reuse command was aborted. Show report file?” appears. Click Yes  to view 
the report file in the default text editor; otherwise click No  and return to step 3.

• If errors are not found, but warnings are, the message “Adding this reuse to the design resulted 
in 0 errors and xxx warnings. Show report file?” appears. Click Yes  to view the report file in the 
default text editor; otherwise click No  and proceed.

• If no errors or warnings are found, the message “Reuse added without warnings or errors. 
Show report file?” appears. Click Yes  to view the report file in the default text editor; otherwise 
click No  and proceed.

9. When all physical design reuse elements are successfully added to the design, the physical design 
reuse dynamically attaches to the pointer. With the Reuse on the pointer, click to place it.

Results
If you have bridge copper in your reuse block, you should ensure that it has retained its bridge status and 
assigned nets.

Related Topics
Adding an Existing Reuse

Process of an Added Physical Design Reuse

Adding an Existing Reuse
Add a copy of an existing physical design reuse to your design in any of three ways.

Procedure
1. Click the ECO Toolbar  button. To add or copy a reuse, you must be in ECO mode; therefore, 

all components, pin pairs, and nets added to the design can be recorded in the .eco  file using 
standard ECO commands.

Tip
You can copy and paste a reuse outside of ECO mode if the reuse contains only drafting 
items and no netlist items.

2. Type the DRO modeless command  on page 83and press the Enter key to turn off Design Rules 
Checking. You must turn DRC off to add or copy a reuse. If DRC is not turned off, a prompt 
appears that allows you to turn DRC off.

3. Select the reuse using one of the following methods:
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• Copy and Paste  — select the reuse in the design:

i. Select an existing physical design reuse in the design as described in “Selecting a Reuse in 
the Design”. You can only copy one reuse at a time.

ii. Click the Edit  > Copy  menu item.

iii. Click the Edit  > Paste  menu item.

• Add Reuse button in Object mode  — select the reuse in the design:

i. Select an existing physical design reuse in the design as described in “Selecting a Reuse in 
the Design”.

ii. Click the Add Reuse  button on the ECO Toolbar.

• Add Reuse button in Verb mode  — select the reuse definition file:

i. Click the Add Reuse  button from the ECO Toolbar. The Add Reuse dialog box appears.

ii. Click the reuse file you want to add and click Open. Since the reuse type already exists 
in the current design, the message “Reuse Type XXX already exists in the design. OK to 
make a copy of this reuse type?” appears.

iii. Click OK.

4. In the Reuse Properties Dialog Box  that appears, modify the physical design reuse properties as 
needed.

5. Click OK.

6. With the Reuse on the pointer, click to place it.

Results
If you have bridge copper in your reuse block, you should ensure that it has retained its bridge status and 
assigned nets.

When you copy a physical design reuse and paste it into a different design, the reuse file is compared 
against the current design to detect possible reference designator, layer, decal, and netname conflicts.

Related Topics
Process of an Added Physical Design Reuse

Editing a Physical Design Reuse Definition
You can edit a reuse definition and update the reuse file (.reu), modifying it like a PCB design.
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Modifying Reuse Properties in the Design

The reuse definition  on page 1854 is the master copy of the physical design reuse that saves to a 
file. The saved version of the physical design reuse is the version you should use in other designs. All 
resulting instances of the physical design reuse are based on this file.

Procedure
1. Open the physical design reuse file:

a. Click the File  > Open  menu item.

b. Click SailWind Layout Reuse Files (*.reu) as the file type.

c. Navigate to the appropriate folder and click the reuse file to open.

d. Click Open. The reuse is selected after you open it.

2. Select the physical design reuse.  on page 601

3. Right-click and click the Break Reuse  popup menu item to break the reuse  on page 610.

4. Edit the reuse, as necessary.

• Change the layer stackup  on page 315.

• Change the design rules  on page 412.

• Modify the reuse elements.

5. When finished changes to the reuse, recreate the physical design reuse:

a. Select all of the reuse elements.

b. Right-click and click the Make Reuse  popup menu item. The Make Reuse Dialog Box  appears.

c. Select the Save to File check box.

d. Type the Reuse Type and Reuse Name or if you do not remember it, you can type any name 
and select the correct file name in the next step.

e. In the Reuse Save As dialog box, click the name of the reuse file you just modified and click 
Save. The message “xxx.reu already exists. Do you want to replace it?” appears.

f. Click Yes  to overwrite the existing file. The physical design reuse definition is updated.

Modifying Reuse Properties in the Design
You can modify a physical design reuse, but you cannot modify the elements within the physical design 
reuse.

More modification options are available to you in ECO mode. When in ECO mode, any component or 
netnames you modify in the Reuse Properties Dialog Box  record in the .eco  file using standard ECO 
commands.
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Procedure
1. Select a physical design reuse.  on page 601

2. Right-click and click the Properties  popup menu item.

3. Modify the location, rotation, glued status, and reuse name, if necessary.

4. In ECO mode  on page 1824, you can modify the reference designator preferences or net 
properties, if necessary.

5. Click OK.

Results
If you changed the reference designator preferences or net properties, the component elements and 
private nets are renamed.

Resetting the Origin of a Reuse
Every physical design reuse has an origin. The default origin is the component pin with the lowest X and 
Y values. The origin marker is square, rather than round, to differentiate it from the design and component 
origin markers. The physical design reuse origin marker is visible only when you reset the origin.

Procedure
1. Select a physical design reuse  on page 601 whose origin you want to reset.

2. Right-click and click the Reset Origin  popup menu item. The reuse origin marker appears.

3. Click to indicate the new position of the origin. A message appears indicating the coordinates of 
the new origin and asks if you want to use this as the origin.

4. Click Yes  to use the new origin. Click No  to choose another origin.

Breaking a Reuse
You must break a physical design reuse before you can edit the elements within it. The Break Reuse 
command disassembles the physical design reuse and returns its elements to normal design data. When 
you break a physical design reuse, elements return to their pre-reuse state; SailWind Layout maintains 
route protection and other settings. You do not need to be in ECO mode to break a physical design reuse.

Procedure
1. Select a physical design reuse  on page 601

2. Right-click and click the Break Reuse  popup menu item. The message “OK to Break Reuse(s)?” 
appears.

3. Click Yes  to break the physical design reuse.

Note:
Reuses are automatically broken when you import an .eco  file.
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Deleting a Reuse

Deleting a Reuse
You can delete a reuse in ECO mode. Doing so removes all components and nets in the reuse.

If you want to simply break the reuse, see “Breaking a Reuse”.

Restrictions and Limitations
You cannot delete physical design reuses that contain glued components or protected routes.

Procedure
1. Click the ECO Toolbar  button. To delete a reuse, you must be in ECO mode; therefore, all 

components, pin pairs, and nets deleted from the design can be recorded in the .eco  file using 
standard ECO commands.

2. Select the physical design reuse  on page 601 you want to delete.

3. Click the Edit  > Delete  menu item, or press the Delete key.

4. In the confirmation message that appears, clear the Delete Routes check box if you want to 
preserve routes connected to the physical design reuse. It is not always possible to maintain traces 
connected to physical design reuse components. Delete Routes is selected by default, meaning 
routes are deleted with the physical design reuse.

5. Click OK  to delete the physical design reuse.

Creating a Reuse Report
You can create a report that contains the name, type, and elements of the selected physical design reuse.

Procedure
1. Select the physical design reuse  on page 601.

2. Right-click and click the Report Contents  popup menu item.

Results
The report is written to C:\SailWind Projects\rules.rep  and is displayed by the default text editor.
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Chapter 27
Drafting Operations

Read the topics that follow to learn more about the drafting commands that are available on the Drafting 
Toolbar. Use drafting commands to create and edit drafting objects, including the board outline, copper 
areas, keepout areas, simple line shapes, text, and all other items not generally associated with part 
placement or routing.

Creating a Drafting Object
Set Values Before Creating a Drafting Object
Edge Precision of Drafting Shapes
The Fill of Copper, and Copper Planes
Migration to Copper Planes
Plane and Net Connectivity
Creating a Polygon or Path Drafting Object
Creating a Circle Drafting Object
Creating a Rectangle Drafting Object
Self-Intersecting Polygons
Text
Modifying Copper Chamfered Paths Properties
Scaling 2D Line Objects and Dimensions
Modification of Drafting Objects
Combine Drafting Objects
Join and Close 2D Lines and Copper Shapes
Saving a Drafting Item to a Library
Adding Drafting Items from a Library
Modifying Objects in a 2D Lines Library
Change the Width of a Trace or Drafting Object
Pasting Items by the Pointer Location
Selection of Drafting Objects

Creating a Drafting Object
The methods for creating all drafting objects apply in the same manner. These instructions apply to 
creating 2D lines, copper, copper cutouts, board outlines, board outline cutouts, keepouts, copper planes, 
and copper plane cut outs.

Procedure
1. After you click a button on the Drafting Toolbar, right-click to set any values before creating the 

drafting object  on page 614.

2. Right-click and choose any of the following shapes to draw from the popup menu.
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• Circle  on page 624

• Polygon or Path  on page 623

• Rectangle  on page 624

• Chamfered path  on page 656 (copper only)

Set Values Before Creating a Drafting Object
Use the Drafting Toolbar to add drafting objects, such as copper shapes, keepouts, and non-electrical 
drawn items generally not associated with placement and routing. You can set various values after you 
click the button for the type of item to add, but before you place the drafting object.

Set Line Width
Choose one of the following methods to set the width of the lines in the drafting object you are creating:

• Type W<nn>, where <nn> is the width value

• Right-click and click the Width  popup menu item and type a value.

• Set the Default width value in the Text and Lines options  on page 1553.

Set Line Style
For 2D lines only, choose one of the following methods to set the line style:

• Right-click and click the Line Style  popup menu item, then choose a line style from the list.

• Type one of the LS Modeless Commands  to set the line style.

Set Layer Placement
Choose one of the following methods to select the layer for the placement of your drafting object:

• Type L<n>, where <n> is a layer number

• Right-click and click the Layer  popup menu item to specify the layer where you want to place the 
Drafting object.

• Specify the layer using the Layer list on the Standard Toolbar.

Set Auto Mitering of Corners
Choose one of the following methods to auto miter corners (diagonal miter or arc):
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Edge Precision of Drafting Shapes

• Right-click and click the Auto Miter  popup menu item to miter all added corners. Define the miter 
type and size in the Design options  on page 1503.

• In the Design options  on page 1503 in the Miters area, select the Auto miter check box.

Set Snap to Objects
You can snap to existing objects instead of to locations on the design grid. You can begin drawing from an 
object snap point or draw to an object snap point. You can enable snapping to objects in the Object Snap 
Options  on page 1540 or on the popup menu while drawing drafting objects. You can also use the OS 
Modeless Commands.

• Right-click and click the Snap to Objects  popup menu item.

Note:
To filter the objects you can snap to, right-click, choose the Snap to  popup menu item and 
then click to add or remove the check mark beside the types of objects you want to snap 
to.

Set Corner Angle
Choose one of the following methods to select a corner angle.

• Right-click and click the Orthogonal, Diagonal, or Any Angle  popup menu item.

• In the Design options  on page 1503, in the Line/trace angle area, choose a setting.

Related Topics
Creating a Circle Drafting Object

Creating a Polygon or Path Drafting Object

Creating a Rectangle Drafting Object

Deleting a Drafting Segment or Object

Edge Precision of Drafting Shapes
You often need to precisely control the edge of drafting shapes, as many factors contribute to that edge.

Line Width
The precision of edges is controlled by the line width used to create the shape. The default line width 
is set on the Text and Lines  category of the Options dialog box. However, you can change the line 
width prior to, or after creating your shape. Use a very narrow outline width to achieve a sharp corner or 
increase the value for more blunt corners. All corners are rounded with a radius equal to one half of the 
outline width.
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Figure 66. Narrow Versus Wide Outline Width

Design and Hatch Grids

Lines are used to create the outline of the shape and are also used to create the fill inside electrical 
drafting items. Lines or outlines are placed on the design grid. Then shapes are filled using horizontal 
lines placed on the Hatch Grid.

Figure 67. Hatch Grid

Clearance Rules

If you are creating a copper plane and your drafting shape is near another object, the resulting poured 
outline could be displaced by the clearance rules of that object.
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The Fill of Copper, and Copper Planes

Figure 68. Clearance Rule Effect on the Hatch Outline

The Fill of Copper, and Copper Planes
SailWind Layout generates the fill of copper and copper plane shapes using drafting lines drawn on the 
copper hatch grid. If you create the shape using a line width value less than the copper hatch grid value, 
it results in a hatch pattern. If you use a line width value equal to, or greater than the copper grid value, it 
results in a solid copper shape.

Figure 69. Example of Solid and Hatch Pattern

Shapes can be flooded with copper in varying degrees of hatch through to a solid pattern. The pattern 
used by default when you flood a shape is determined by the relative values of two settings in the Options 
dialog box:
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• The Default width value on the Drafting / Text and Lines options category  on page 1553

• The Copper hatch grid value on the Grids options category  on page 1537

You can set line width and grid settings before or after creating the object. After you’ve drawn the shape, 
you can change the settings in the Drafting Properties  on page 1328. If you need to customize the 
copper hatch grid for a copper plane shape, you can set the grid value in the Flood  on page 1381.

For more information on creating shapes with the desired flood pattern, see Creating a Copper Shape 
and “Creating a Copper Plane Manually”  on page 667.

Migration to Copper Planes
Prior to the VX.2.4 release, SailWind Layout used copper pours on “No Plane” layers and plane areas on 
“Split/mixed” layers. For all later releases, the software unifies copper pours and plane areas into “copper 
planes.” If you open a design saved in an earlier version, PADS migrates or converts all copper pours and 
plane areas to copper planes and applies design rules accordingly. Certain clearance and connectivity 
changes in your design may result.

The following changes take place during the migration to copper planes:

• The “Remove unused pads” setting, found in the “Thermals Options”  on page 1514, is extended 
to “No Plane” layers. With this setting enabled, all pads are removed on all internal “No Plane” 
and “Split/Mixed” layers unless the pin is connected to a trace or a copper plane on that layer. 
Prior to the PADS VX.2.4 release, unused pads were removed only from “Split/Mixed” layers.

• Copper pours converted to copper planes are affected by the Plane Thermal check box (in the 
Pin, or Via Properties dialog boxes)  on page 797. Prior to PADS VX.2.4, the setting applied only 
to plane areas on “Split/Mixed” layers. This means, for example, if you have disabled thermal 
connections for a pad or via by clearing the “Plane Thermal” check box, the software removes the 
thermal connection to copper planes (old copper pours) on “No Plane” layers when you import the 
design into a newer release.

• You can apply custom thermals and custom antipads to copper planes on “No Plane” layers in 
addition to “Split/Mixed” layers. Prior to PADS VX.2.4, the custom thermals and antipads applied 
only to plane areas on “Split/Mixed” layers.

• Prior to PADS VX.2.4, a pin could receive a thermal connection to a plane area on a “Split/Mixed” 
layer even though a trace was connected to it. With later releases, any component pin with an 
attached trace does not receive a thermal connection if the “Add thermals to routed component 
pads” setting is disabled in the “Thermals Options”  on page 1514. This was already the case 
for copper pours beginning with the PADS VX.2.3 release, and has been extended to copper 
planes on “Split/Mixed” layers in subsequent releases. Prior to PADS VX.2.3, a pin could receive 
a thermal connection to a copper pour even though a trace was connected and the “Add thermals 
to routed component pads” setting was disabled if an additional unrouted pin pair connection 
existed on the pin. Via pads will still receive thermal connections to copper planes regardless of 
the setting.

• The plane indicators, previously only shown on “Split/Mixed” layers and “CAM Plane” layers are 
extended to pins and vias surrounded by a copper plane on “No Plane” layers. The Show general 
copper plane indicators setting is found in the “Thermals Options”  on page 1514.
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Migration to Copper Planes

• One smoothing radius setting in the “Hatch and Flood Options”  on page 1511 applies to all 
copper planes, regardless of the layer on which they reside. Previous releases had separate 
smoothing radius settings for copper pours and plane areas. The value from the Hatch and Flood 
of an existing design is retained in VX.2.4 and later releases. It may be necessary to adjust the 
smoothing radius value if you experience connectivity errors in a later release that were not 
present in the prior version.

• The setting “Remove violating thermal spokes” is removed. All violating thermals spokes are 
removed by default. This is a hard-coded setting that cannot be modified.

• The modeless command “PO” toggles copper planes between pour outline and the flooded hatch 
display. The “SPO”, “SPI”, and “SPD” commands are no longer used.

• The “Create cutouts around embedded planes” setting in the “Hatch and Flood Options”  on 
page 1511 works for “No Plane” layers in addition to “Split/Mixed” layers. Previously, that setting 
worked for only “Split/Mixed” layers.

• Starting with VX.2.3, copper floods to the inner edge of completed cut out outlines instead of 
the centerline. Prior to VX.2.3, the cut out would grow by half the line width since copper would 
flood to its centerline rather than the inner edge which was the intended boundary. For more 
information, see “Creating a Copper Plane Cut Out”  on page 686.

Figure 70. Cut Out Pour Boundary Changes

• Beginning with PADS VX.2.6, the origin of the copper plane hatch grid is calculated from the 
lower left corner (if one exists or calculated if one does not exist) of the pre-flooded shape. If you 
used a hatched fill instead of a solid fill in a pre-VX.2.6 design, the hatch grid might not have the 
same origin and placement of the lines of the hatch grid. As a result, pins or vias that touched and 
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connected to the hatch grid might not be connected. Other pins that did not touch or connect to 
the hatch grid might be in a position to connect.

The origin of the hatch grid pattern is defined by an imaginary box surrounding the extents of 
the copper plane shape. The extents box is reduced by ½ the line width of the copper plane 
shape and the hatch grid origin is placed in the lower left corner of the extents box. For a simple 
rectangular copper plane shape the hatch grid origin will be in the lower left corner of the shape. 
For more complex shapes, the lower left corner of the extents may be a point outside of the 
copper plane shape. This is not the origin of the copper plane shape, only the origin of the hatch 
pattern for the copper plane.
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Migration to Copper Planes

Figure 71. Real Lower-Left Hatch Origin
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Figure 72. Calculated Lower-Left Hatch Origin

Plane and Net Connectivity
A plane  is a large copper area that provides access to universally necessary nets, like power or ground. 
One design may use several plane areas.

Most PCB designs locate planes on inner layers that are dedicated to the plane only, although you can 
place them on outer layers. The plane area can occupy all or only part of the layer.

Copper planes may have insulated traces and vias passing across the plane area, as long as the traces 
do not divide the plane to break connectivity.

Pins that are supposed to connect to the plane are usually plotted for manufacturing using spoked 
thermal relief pads. Pins that do not connect to the plane are referred to as unused pads, and are typically 
removed from inner layer planes and replaced with antipads.

Establishing a plane area and connecting the appropriate nets to it is usually one of the first routing tasks 
in the design process. The following two methods establish plane areas:

• Define a Layer as a Split/Mixed type and draw a Copper Plane

• Draw a Copper Plane on a No Plane layer
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Creating a Polygon or Path Drafting Object

Displaying Connectivity with General Plane Indicators
Use the “Show general copper plane indicators” setting in the Copper Planes  category > Thermals 
subcategory of the Options dialog box to see which pins have thermals. The “Plane thermal” Pin 
Properties setting determines whether the thermal is generated for the pin.

Set the Plane Thermal option using the Properties dialog boxes for pins, vias, and jumper pins.

Tip
Copper Planes on a No Plane or Split/Mixed layer are functionally equivalent. Using a Split/Mixed 
layer provides the “Show plane nets only” check box in the Drafting Properties and use of the 
Plane check in Verify Design. Some other software tools may make use of a layer specifically set 
as Split/Mixed to utilize certain functions.

Creating a Polygon or Path Drafting Object
Use the Drafting Toolbar to add drafting objects such as copper shapes, keepouts, and non-electrical 
drawn items generally not associated with placement and routing.

Procedure
1. Click the button for the type of item to add: 2D Line, Copper, Copper Cut Out, Keepout, Copper 

Plane, Copper Plane Cut Out  or Board Outline and Cut Out. The add command for that object 
type attaches to your pointer.

2. Right-click and set your drafting values  on page 614.

3. To start the drafting object and finish each segment or place each corner, use one of the following:

• Locate each coordinate with the pointer, and click to start and indicate consecutive corners.

• Type S<x>, <y>, where <x> and <y> are the coordinate values for the starting point and 
consecutive corners.

• Type SR<x>, <y> if you want to specify relative coordinate values for each point and corner.

Tip
Right-click and click the Add Arc  popup menu item to add an arc instead of a straight-
line segment.

Note:
You can press the BackSpace key to remove the last corner entered. You can also press 
the Esc key to cancel the operation.

4. Double-click or right-click and click the Complete  popup menu item to end the shape. Polygons 
are automatically closed; paths are terminated at the last-defined corner.

SailWind Layout Guide and Reference 623



Drafting Operations
Creating a Circle Drafting Object  

Related Topics
Creating a Circle Drafting Object

Creating a Rectangle Drafting Object

Deleting a Drafting Segment or Object

Set Values Before Creating a Drafting Object

Creating a Circle Drafting Object
Use the Drafting Toolbar to add drafting objects such as copper shapes, keepouts, and non-electrical 
drawn items generally not associated with placement and routing.

Procedure
1. Click the button for the type of item to add: 2D Line, Copper, Copper Cut Out, Keepout, Copper 

Plane, Copper Plane Cut Out  or Board Outline and Cut Out. The add command for that object 
type attaches to your pointer.

2. Right-click and set your drafting values  on page 614.

3. Click to indicate the location of the circle's center. Instead of using the pointer, you can type the 
coordinates using the following methods.

• Type S<x>, <y>, where <x> and <y> are the coordinate values for the starting and ending point.

• Type SR<x>, <y> if you want to specify relative coordinate values for the starting and ending 
point.

Tip
Press the Esc key to cancel the operation.

4. Click to indicate the circle's radius to complete the circle definition.

Related Topics
Creating a Polygon or Path Drafting Object

Creating a Rectangle Drafting Object

Set Values Before Creating a Drafting Object

Creating a Rectangle Drafting Object
Use the Drafting Toolbar to add drafting objects such as copper shapes, keepouts, and non-electrical 
drawn items generally not associated with placement and routing.
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Procedure
1. Click the button for the type of item to add: 2D Line, Copper, Copper Cut Out, Keepout, Copper 

Plane, Copper Plane Cut Out  or Board Outline and Cut Out. The add command for that object 
type attaches to your pointer.

2. Right-click and set your drafting values  on page 614.

3. Click to indicate one corner of the rectangle. Instead of using the pointer, you can type the 
coordinates using the following methods.

• Type S<x>, <y>, where <x> and <y> are the coordinate values for the starting and ending point.

• Type SR<x>, <y> if you want to specify relative coordinate values for the starting and ending 
point.

Tip
Press the Esc key to cancel the operation.

4. Click to indicate the location of the diagonally opposite corner.

Related Topics
Creating a Circle Drafting Object

Creating a Polygon or Path Drafting Object

Deleting a Drafting Segment or Object

Set Values Before Creating a Drafting Object

Self-Intersecting Polygons
A self-intersecting polygon  occurs whenever a portion of a shape outline overlaps with another portion 
of the same shape. In some cases, creating a polygon with too large a line width for the outline can also 
cause overlapping of some portions.

When drafting copper planes and shapes using polygons, you can set the outline line width in the Drafting 
Properties Dialog Box. Choosing a narrow line width enables you to create shapes with greater accuracy 
in detailed areas, as shown below.
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Figure 73. Close up of Shape Detail

You can set the line width as required for your design; however, as the width increases, the shape 
resolution decreases. Referring to the example in the preceding figure, as the outline line width of a 
copper shape increases, the outer edge of the lines remain in place and the inner edges expand inward. 
The result appears in the figure below.
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Self-Intersecting Polygons

Figure 74. Shape Detail with Increased Line Width

If you set the outline line width too wide, the centerlines of two edge segments may overlap one another, 
resulting in a self-intersection polygon.
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Figure 75. Overlapping Centerlines

Note:
The overlap is most visible when you turn on copper flooding.

Keep in mind that a self-intersecting polygon can occur with planes created from the board outline shape 
when the plane area shrinks by the clearance value. Similarly, a self-intersecting polygon can also occur 
when using the auto separate functionality because of the auto separate gap.
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Text

Text
Use free text to add text information to your design. Free text is not associated to a particular design 
object; you can use it to add descriptions such as board identification nomenclature.

Adding Free Text
Modifying Text Properties
Mirroring Text
Moving Text and Labels

Adding Free Text
You can add single lines of free text (text not belonging to an object) to a design.

When you add text, there is an invisible bounding rectangle  on page 1813 or outline box around the text 
itself. Type the X modeless command to toggle the outline box on or off.

Tip
To add multiple lines of text to a design, see “Embedded Text Documents  on page 986”.

Procedure
1. Click the Drafting Toolbar  button to open the Drafting Toolbar, and then click the Text  button.

2. In the Add Free Text Dialog Box, type the text string you want to use in the Text box. There is a 
maximum of 128 characters per text string.

3. In the Font list, select the font you want to use. The default font name and style appear in the Font 
box when the dialog box opens. Select a stroke font or a system font.

Tip
For system fonts, you can also click a font style button or any combination of buttons: B  for 
bold, I  for italic, or U  for underlined.

4. In the Layer list, select the layer on which you want the text.

5. In the X,Y location boxes, type values to move the text string to a specified location. If not 
specified, the text string attaches to your pointer for placement.

6. The Rotation box shows the current orientation of the text string. Type a new value to change the 
degree of rotation.

7. The Size box shows the current size used for display or CAM output of the text string. Type a new 
value to change the size.

8. For stroke font, type a line width.

9. Select the Mirrored check box if you want to flip the text. When Mirrored is checked, text is 
considered readable from the bottom side of the board.
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10. In the Justification area, set the horizontal and vertical justification of the text to ensure proper 
positioning between objects when text, attribute values, size, or width change.

• For vertical justification, click Left, Center, or Right.

• For horizontal justification, choose Up, Center, or Down.

Tip
You can set justification in the design after closing the Add Free Text dialog box. Select 
the text, then right-click and click Justify Horizontally, and then click the Left, Center, or 
Right  popup menu item; and right-click and click Justify Vertically,  and then click the Up, 
Center, or Down  popup menu item.

11. Click OK  to close the dialog box. If you did not type coordinates to place the text, the text 
dynamically attaches to the pointer. Click to indicate the location for the text. After you place the 
text, the Add Free Text dialog box reappears so you can create additional strings.

Tip
Place free text and attribute values on the Silkscreen Top layer to avoid DRC violations or 
shorts.

Related Topics
Modifying Text Properties

Combining Line and Text Objects

Mirroring Text

Moving Text and Labels

Modifying Text Properties
Use the Text Properties dialog box to modify free text. You can change the font, font style, layer 
assignment, orientation, rotation, size, line width, if it is mirrored, and justification. You can also access 
the parent object if the text string is combined with a drafting object.

Procedure
1. Select a text string, right-click, and then click the Properties  popup menu item.

2. The Text Properties dialog box displays the selected text string. Modify the existing text string, or 
type a new text string.

Restriction:
Several options in this dialog box are unavailable if the text is part of a physical design 
reuse.

3. In the Font area, select the font you want to use. Select stroke font or a system font.
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Mirroring Text

Tip
For system fonts, you can also click a font style button or any combination of buttons: B  for 
bold, I  for italic, or U  for underlined.

4. In the Layer area, select the layer on which you want the text.

5. In the X,Y location boxes, type new values to move the text string to a specified location.

6. The Rotation box shows the current orientation of the text string. Type a new value to change the 
degree of rotation.

7. The Size box shows the current size used for display or CAM output of the text string is shown. 
Type a new value to change the size.

8. For stroke font, type a line width.

9. Select the Mirrored check box if you want to flip the text. When Mirrored is checked, text is 
considered readable from the bottom side of the board.

10. In the Justification area, set the horizontal and vertical justification of the text to ensure proper 
positioning between objects when text, attribute values, size, or width change.

• For vertical justification, click Left, Center, or Right.

• For horizontal justification, choose Up, Center, or Down.

Tip
You can set justification in the design after closing the Add Free Text dialog box. Select 
the text, then right-click and click Justify Horizontally, and then click the Left, Center, or 
Right  popup menu item; and right-click and click Justify Vertically,  and then click the Up, 
Center, or Down  popup menu item.

11. Click OK. If you select another text object before closing the dialog box, the text information is 
updated.

Related Topics
Text

Mirroring Text

Moving Text and Labels

Mirroring Text
You can mirror text objects in your design.

Procedure
1. Select the object.

2. Right-click and click the Mirror  popup menu item.
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Related Topics
Text

Modifying Text Properties

Combining Line and Text Objects

Moving Text and Labels

Moving Text and Labels
You can move text and labels around in your design.

Procedure
1. Select a text or label, right-click, and then click the Move  popup menu item.

The object attaches to the pointer. If you move a text object that is combined  on page 642 with 
other drafting objects, all the combined objects move. You can also move text and labels with 
drag and drop operations or using the Move button in the Design Toolbar. You still have the same 
editing abilities while moving the text or label. You can use the arrow keys while moving reference 
designators.

2. You can open the Properties dialog box, rotate, spin, mirror, or justify the selected text or label 
while it is attached to your pointer.

3. Click to complete the move.

Related Topics
Text

Modifying Text Properties

Combining Line and Text Objects

Mirroring Text

Modifying Copper Chamfered Paths Properties
You can select the copper chamfered paths of a net to change its properties.

Procedure
1. Select a net in the design.

2. Right-click and click the Select Chamfered Paths  popup menu item.

Alternatively, you can click  under the RF Toolbar.

3. Right-click and click the Properties  popup menu item.
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Scaling 2D Line Objects and Dimensions

Related Topics
Drafting Object Properties

Scaling 2D Line Objects and Dimensions
Use Scale in the 2D line or Dimension object Properties to change the size of objects.

An arc is too large if its radius is greater than 14 inches or its center is outside the database coordinate 
area. The database coordinate area is (-28, -28) to (28, 28) inches. Arcs are approximated with multiple 
straight segments.

When you scale text or dimensions, combine them with other line objects. Line widths are not scaled.

When combined text or dimension text is scaled, the maximum text height is 1000 mils and the maximum 
text width is 50 mils.

Location of Scaled Objects
If the scale model contains multiple objects and you want to maintain their relative positions, combine the 
objects before using Scale.

In the following figure, the two noncombined objects are scaled. The objects have individual origins, as 
shown on the left. These different origins are used when scaling, creating overlapping objects, as shown 
on the right.

Figure 76. Noncombined Objects

In the following figure, the two combined objects are scaled. The objects have a single origin, as shown 
on the left. This origin is used when scaling, creating a larger copy of the original objects, as shown on the 
right.

Figure 77. Combined Objects
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Modification of Drafting Objects
After adding drafting objects to a design, you can move, edit, or delete them as your design needs 
change.

Moving a Drafting Object
Modifying Drafting Edge Properties
Modifying Drafting Corner Properties
Drafting Object Properties
Moving a Miter
Pulling an Arc from a Drafting Segment/Corner
Deleting a Drafting Segment or Object
Deleting an Item

Moving a Drafting Object
You can move a whole drafting object while maintaining its shape.

Procedure
1. Select the drafting object to move using one of the following methods:

• With nothing selected, right-click, then click the Select Shapes  popup menu item, and click on 
a segment of the object. The Select Shapes selection filter setting is the best filter for selecting 
Drafting Objects even if it is an open shape like a single line.

• Select a segment of the object, right-click, and then click the Select Shape  popup menu item.

• Shift-click a segment of the object

2. Right-click and click the Move  popup menu item.

Alternatively, you can drag the selected object, if allowed by your Drag moves setting  on 
page 1531.

3. The shape attaches to the cursor by the Move preference setting  on page 1503.

Tip
If you move a drafting object that is combined with other drafting objects, all the combined 
objects move.

4. If you need to make additional changes to the component before you move it, you can right-click 
and activate the rotate, spin, or mirror commands, or manage the Object snapping settings  on 
page 1540.
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Modifying Drafting Edge Properties

Restriction:
You cannot modify, move, or delete a polygon of any type (2D line, copper, or pour) that 
is part of a physical design reuse. If you try to otherwise modify a polygon, the message 
“Reuse elements cannot be modified. Break the reuse first” appears. Click OK  to cancel 
the operation.

5. Move the drafting object to its new location and click to place it.

Modifying Drafting Edge Properties
You can edit or change the properties of drafting edges.

Procedure
1. To select an edge, click on it once.

2. Right-click and click the Properties  popup menu item. The Drafting Edge Properties Dialog Box 
opens; showing you what type of drafting object the item is and rules information.

Tip
Several of the options in this dialog box are unavailable if the edge is part of a physical 
design reuse.

Modifying Drafting Corner Properties
You can edit or change the properties of drafting corners, such as location.

Procedure
1. Select a drafting corner, right-click, and then click the Properties  popup menu item.

2. In the X and Y boxes, type the X and Y location of the drafting corner.

3. Click Net  to modify settings for the net to which the drafting corner belongs.

4. Click Parent  to modify drafting object to which the corner belongs.

Tip
Several of the options in this dialog box are unavailable if the corner is part of a physical 
design reuse.

Related Topics
Modifying Net Properties

Drafting Object Properties
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Deleting a Corner

Moving a Corner
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Drafting Object Properties

Drafting Object Properties
You can select and edit drafting shapes in pieces or as whole items. The properties you can modify 
depend on whether you select a corner of the drafting object, an edge of the drafting object, or the whole, 
or parent object of a 2D line, copper, or text.

Note:
Several of the options in this dialog box are unavailable if the object is part of a physical design 
reuse.

Converting Drafting Shapes
Changing Line Widths
Scaling
Filling a Shape with Solid Copper
Changing Layers

Converting Drafting Shapes
You can convert a closed drafting object to another shape. In the Layout Editor, you can convert any 
closed drafting object to a 2D line, board outline, board cut out, copper, copper cut out, keepout, or 
copper plane. In the PCB Decal Editor, you can convert any closed drafting object to a 2D line, copper, 
copper cut out, or keepout.

Restrictions and Limitations
When converting shapes, the following restrictions apply:

• If there is no board outline in the design, the Board Cut Out type does not appear in the Drafting 
Properties dialog box Type list. You must first have a board outline before you can create a board 
cut out.

• If there is already a board outline in the design, the Board Outline option does not appear in the 
dialog box because you cannot have two board outlines.

Procedure
1. Select a drafting item, right-click, and then click the Properties  popup menu item.

2. In the Type list, select a new shape type.

Tip
The Copper Cut Out type is also used for cut outs in Copper Planes.

Changing Line Widths
You can modify the line width of drafting object outlines and fill lines as applicable.
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Procedure
1. Select a drafting item, right-click, and then click the Properties  popup menu item.

2. In the Drafting Properties Dialog Box, in the Width box, type a value.

Restriction:
Some drafting object line widths cannot be changed.

Note:
Like any other line width, the chamfered path does not appear as the correct width if the 
Minimum display width option for the design is larger than the Polygon outline width of the 
path. The path appears more narrow by the value of the Polygon outline width.

Scaling
Resize a drafting object.

Procedure
1. Select a drafting item.

2. The object will scale up or down from the origin of the shape. If necessary, right-click and click the 
Set Origin  on page 474 popup menu item to set the origin of the scale model.

3. Right-click, and click the Properties  popup menu item.

4. In the Drafting Properties Dialog Box, set scale options.

Enter a floating-point number greater than 0. Fractions are not supported. Values greater than 1 
will increase the size while values less than 1 will shrink the object. A scale value of 2 will double 
the shape's size, a scale value of 0.5 will halve the shape's size. The line width does not scale.

5. Click OK.

Results

• If scaling changes a dimension, select the dimension, right-click, and click the Reset 
Measurement  popup menu item to update the dimension measurement.

Filling a Shape with Solid Copper
SailWind Layout fills copper using the settings of the Copper Hatch Grid and the Drafting Default width. 
If desired, you can ignore these settings and fill a shape with solid copper. When you create chamfered 
paths, they appear as solid copper.
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Changing Layers

Procedure
1. Select a copper drafting object, right-click and then click the Properties  popup menu item

2. In the Drafting Properties dialog box  on page 1328, select the Solid Copper  check box.

Tip
The Solid Copper check box forces copper to use trace clearance rules.

Changing Layers
You can change the layer on which the drafting object exists.

Procedure
1. Select a drafting item, right-click, and then click the Properties  popup menu item.

2. Drafting Properties Dialog Box, in the Layer list, select the new layer.

Tip
Moving assigned copper to a nonelectrical layer removes the connection from the copper 
shape. Place the copper back on an electrical layer to reassign the connections.

Moving a Miter
You can expand or contract a miter or arc on a drafting segment with the Move Miter command.

Procedure
1. Select a miter segment or arc, right-click, and then click the Move Miter  popup menu item. The 

object dynamically attaches to your pointer.

2. Move the pointer to expand or contract the object.

3. Click to indicate the new miter position to finish. Indicate a location outside the point of intersection 
of the two lines to convert the arc or miter back to a corner.

4. Use the Stretch Command  to modify an arc or miter on a route.

Restriction:
You cannot modify, move, or delete a polygon of any type (2D line, copper, or copper 
plane) that is part of a physical design reuse. If you try to otherwise modify a polygon, the 
message “Reuse elements cannot be modified. Break the reuse first” appears. Click OK  to 
cancel the operation.

Related Topics
Pulling an Arc from a Drafting Segment/Corner
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Pulling an Arc from a Drafting Segment/Corner
Use the Pull Arc command to convert a drafting segment or corner into an arc. The starting points of the 
drafting segment become the start and stop angle for the new arc.

Procedure
1. Select a segment or corner, right-click, and then click the Pull Arc  popup menu item.

2. The segment or corner attaches to your pointer and changes to an arc.

3. Click to indicate the new position for the arc.

4. Use the Move Miter  on page 639 command to modify the radius of a created arc or miter.

Restriction:
You cannot modify, move, or delete a polygon of any type (2D line, copper, or copper 
plane) that is part of a physical design reuse. If you try to otherwise modify a polygon, the 
message “Reuse elements cannot be modified. Break the reuse first” appears. Click OK  to 
cancel the operation.

Related Topics
Creating Arc Miters

Creating Arcs

Deleting a Drafting Segment or Object
If desired, you can delete drafting segments or objects from your design.

Procedure
1. Select the segment or object. See “Selection of Drafting Objects”.

2. Press the Delete key or click the Edit  > Delete  menu item.

Restriction:
You cannot modify, move, or delete a polygon of any type (2D line, copper, or copper 
plane) that is part of a physical design reuse. If you try to otherwise modify a polygon, the 
message “Reuse elements cannot be modified. Break the reuse first” appears. Click OK  to 
cancel the operation.

Related Topics
Creating a Circle Drafting Object

Creating a Polygon or Path Drafting Object
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Deleting an Item

Creating a Rectangle Drafting Object

Set Values Before Creating a Drafting Object

Deleting an Item
Use the Delete command to remove a selected item from the design.

Procedure
1. Select the item you want to delete.

2. Click the Edit  > Delete  menu item. The item is removed from the design.
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Combine Drafting Objects
You can combine drafting objects so that they can be moved as a group. If the design changes, you can 
explode or un-combine the groups of drafting objects.

Combining Line and Text Objects
Exploding Combined Objects
Uncombining Drafting Objects
Removing a Text Object From a Combination

Combining Line and Text Objects
You can combine text objects and line objects to form one group. When you combine objects, you can 
select and move them as one item and save it to the library. When you move an object that is combined 
with other objects, all the combined objects move. You can use the Combine command in both the Layout 
Editor and in the Decal Editor.

Procedure
1. Use Shift-click to select the entire drafting shape that you want to combine.

2. When the shape is highlighted, use Ctrl+click to select the text to combine.

3. Right-click and click the Combine  popup menu item. You cannot combine text objects without 
including a drafting object.

Results
Once you combine objects, selection characteristics change for each object. When you Shift-click a 
shape, the whole shape and the text are selected for action. You can reposition the combined objects or 
save them to the library  on page 647 as one unit. If you select the text, however, only text is highlighted 
for editing or repositioning.

You can remove an object from the combination using Uncombine  from the shortcut menu. You can 
uncombine the entire combination using Explode  from the shortcut menu.

Related Topics
Exploding Combined Objects

Uncombining Drafting Objects

Exploding Combined Objects
Use Explode to remove all items from a combined object. Combined objects are made of multiple drafting 
and text objects that were combined using the Combine command. You can use Explode in the Layout 
Editor and in the PCB Decal Editor.
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Uncombining Drafting Objects

Procedure
1. Select the combination.

Tip
To select a combination, select any part of the combination, right-click, and click the Select 
Shape  popup menu item.

2. Right-click and click the Explode  popup menu item.

Related Topics
Combining Line and Text Objects

Uncombining Drafting Objects

Uncombining Drafting Objects
Use the Uncombine command—accessed in the Decal Editor—to remove a single item from a combined 
object. Combined objects are made of multiple drafting and text objects that you have combined using the 
Combine command.

Procedure
1. Select the combination.

Tip
To select a combination, select any part of the combination, right-click, and click the Select 
Shape  popup menu item.

2. Right-click and click the Uncombine  popup menu item.

3. Select the object.

Removing a Text Object From a Combination
If necessary, you can remove a text object by uncombining a combination.

Procedure
1. Select the text object.

2. Right-click and click the Uncombine  popup menu item.

Related Topics
Combining Line and Text Objects

Exploding Combined Objects
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Join and Close 2D Lines and Copper Shapes
You can join and close 2D lines and copper shapes so that changes applied to one object apply to all of 
the joined objects.

Use Join and Close to Connect 2D Lines and Copper Shapes
Joining 2D Lines and Copper Shapes
Closing 2D Lines and Copper Shapes
Breaking an Object

Use Join and Close to Connect 2D Lines and 
Copper Shapes
Use Join and Close commands to connect 2D lines and copper shapes to create single objects for the 
purpose of changing their properties. For example, you can create a closed 2D line and then change its 
properties to “copper.”

Tip
These commands are especially useful for after you have imported a .dxf  file.

You can use Join and Close when the line ends are “near enough”: meaning: touching, crossing slightly, 
or perfectly matched. If the lines are not touching or crossed too far, Join and Close will not work.

Examples of Near Enough
Join and Close will work on any of the following examples:

Examples of Not Near Enough
Join and Close will NOT work on either of the following examples:
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Joining 2D Lines and Copper Shapes

Limitations
You cannot join or close when the selection includes:

• Objects that are not 2D lines (for example, a keepout)

• 2D Line shapes on different layers

• 2D Lines that are part of a reuse

• 2D Lines that are closed or a circle

• More than one connection available with the same distance

Note:
The connection is available if both ends are not already connected with a smaller distance.

• Shapes that cannot be joined or closed into single shape. For example, you cannot do a multiple 
Join or Close.

Joining 2D Lines and Copper Shapes
Use the Join command to connect any 2D lines or copper shapes that are “near enough.”

For more information, see “Join and Close 2D Lines and Copper Shapes”.

Procedure
1. Select the two 2D lines or copper shapes you want to join. The objects must be near enough.

2. Right-click and click the Join  popup menu item.
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• If two segments cross near enough to their ends, the two segments are shortened and the 
cross point is the point where they are joined

• If the segments do not cross, an additional segment is added

Results
If the command worked, you should see “2D Line” in the Status bar. You can now select the entire joined 
object.

If the command did not work, you should see the error message: “Join command aborted” in the Output 
Window.

Closing 2D Lines and Copper Shapes
Use the Close command to create a closed (and joined) shape that has contiguous lines. The objects 
must be “near enough” for the command to be effective.

For more information, see “Join and Close 2D Lines and Copper Shapes.”

Procedure
1. Select the 2D lines or copper shapes you want to close. The objects must be near enough.

2. Right-click and click the Close  popup menu item.

Results
If the command worked, you should see “2D Line” in the Status bar. You can now select the entire closed 
object.

If the command did not work, you should see the error message: “Close command aborted” in the Output 
Window.

Breaking an Object
You can break any 2D Line or copper shape that is not a single straight line or a single arc into multiple 
2D Lines. The Break command creates a “break point” at every corner of the shape.

Restrictions and Limitations
You cannot break a circle or elements that belong to a reuse.

Procedure
1. Select the object you want to break.

2. Right-click and click the Break  popup menu item.

Results
If the command worked, you should see “Multiple Selection” in the Status bar. You can now select each 
segment separately.
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Saving a Drafting Item to a Library

Saving a Drafting Item to a Library
Add drafting items to your library so you can reuse them in a current design or any other design. SailWind 
Layout stores all of the objects with the Lines filter in the Library.

Procedure
1. Press the Shift key and select the item to select the whole shape rather than a segment or corner 

of the shape.

You can select a board outline, 2-D lines, copper objects, keepout objects, and dimension objects. 
You cannot save text alone to the library. Text must be combined  on page 642 with a 2D line in 
order to save it to the library.

2. Right-click and click the Save to Library  popup menu item.

3. In the Save to Library dialog box, select the library you want, and type the name of the item.

4. Click OK.

The drafting item is in the Library. Use the Lines filter in the Library Manager to find the item for 
future use.

Related Topics
Adding Drafting Items from a Library

Adding Drafting Items from a Library
You can select a drafting item from a library and add it to your design.

Prerequisites
You can place a board outline, copper object, or keepout object from a library only while on-line DRC is 
off.

Procedure
1. On the Standard Toolbar, click the Drafting Toolbar  button.

2. On the Drafting Toolbar, click the From Library  button.

3. In the Get Drafting Item from Library Dialog Box, select an item from a library.

Use the Library list to view drafting items in all libraries or in a specific library. Use wildcards  on 
page 155in the Filter to limit the objects that appear in the Drafting Items list.

4. Click OK. The item attaches to your pointer.
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5. Move the item to where you want and click to place the item.

Restriction:
You cannot add a drafting object to a design if the design is in default layer mode and the 
object is in increased layer mode. Use the Layers Setup Dialog Box  to change the design 
to increased layer mode.

Related Topics
Saving a Drafting Item to a Library

Modifying Objects in a 2D Lines Library
In order to edit an object that is stored in a 2D Lines library, you must first bring that object into the design 
workspace, make the desired edits and then save it back into the library.

Procedure
1. In the SailWind Layout workspace, on the Drafting Toolbar, click the From Library  button.

2. In the Get Drafting item from Library dialog box, select the desired object from the Drafting Items 
list and click OK. The item will attach to the cursor.

3. In the design workspace, click a location to place the item.

4. Make the desired edits using the commands available on the Drafting Toolbar and the right mouse 
button menus.

Tip
To save multiple objects that include lines and text, you must first select all the items, 
choose Combine  from the right mouse menu, and then choose Save to Library  from the 
right mouse button menu.

5. Once you have completed the desired edits, select the objects that make up the drawing item, right 
click and choose Save to Library.

6. You can choose to either overwrite the item or save it as a new item. Click OK  to save the 2D line 
object back into the 2D Lines library.
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Change the Width of a Trace or Drafting Object

Change the Width of a Trace or Drafting Object
During a design session, you can change the width of drafting object or a trace using one of two available 
methods.

Use one of the following methods changing the current width of traces or drafting objects:

Changing the Width of a Segment, Pair or Net Once It Is Routed
Finding All Traces of a Similar Width
Drawn Line Width

Changing the Width of a Segment, Pair or Net Once 
It Is Routed
If necessary, you can change the width of a segment, pin pair, or net after routing it by changing its 
properties.

Procedure
1. Select the item, right-click and select the Properties  popup menu item.

2. In the Drafting Properties dialog box  on page 1328, in the Width box, type a new value.

Finding All Traces of a Similar Width
You can locate and change objects all traces of a similar width.

Procedure
1. Click the Edit  > Find  menu item.

2. In the Find  on page 1378 dialog box, in the Find by list, select Line Width.

3. In the Line Type box, select Trace.

4. In the Line Width box, select the width and click OK.

Drawn Line Width
The drawn line width  is the width applied when you begin to draw a shape.

You set the default width of drawn lines differently from that of route widths. Use the Drafting / Text and 
Lines category  on page 1553in the Options dialog box to set the default width for drawn lines. To change 
the width of an existing shape, select the shape and right-click and click the Properties  popup menu item. 
Use the Find dialog box to search for and change all lines of a similar width.
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Pasting Items by the Pointer Location
The default origin for pasting contents is the lower left corner of the area that encompasses all information 
in the buffer (clipboard). You can paste design items using the location of the pointer when the item is 
copied or cut.

Procedure
1. Click the Tools  > Options  menu item, and then select the Design category  on page 1503.

2. In the “Move preference” area, click “Move by cursor location” and then click OK.

3. In the design, select the design item(s) to cut or copy.

4. Place the pointer at the new origin location and press Ctrl+X (for Cut) or Ctrl+C (for Copy).

5. Press Ctrl+V. The item appears on the cursor.

6. Find the new location and click to place the object.
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Selection of Drafting Objects

Selection of Drafting Objects
Drafting objects are made up of the line segment outlines and sometimes fill. At times, you want to select 
a segment, and at other times, you need to select the whole outline with the fill included.

Selecting Drafting Object Outlines
Selecting Whole Drafting Objects

Selecting Drafting Object Outlines
Select the outlines of a drafting object to move the outline and change the shape of the object.

Procedure
1. Right-click and click the Select Anything  popup menu item.

2. Click the outline of the shape.

3. Right-click and click a command to alter the segment as needed.

Selecting Whole Drafting Objects
Select the outlines and fill of a drafting object to move the object or change the properties of the whole 
object.

Procedure
Use one of the following methods:

• With nothing selected, right-click and click the Select Shapes  popup menu item and then click the 
object.

• With nothing selected, right-click and click the Select Anything  popup menu item and then shift-click 
along the outline of the object.

• With nothing selected, right-click and click the Select Anything  popup menu item and then drag a 
selection box over an outline segment.
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Chapter 28
Clearances and Spacing

Read the topics that follow to learn more about the procedures for using the View  > Clearance  menu item 
to check distances between objects.

Viewing the Clearance Between Nets
Viewing the Clearance Between Items and Annotating Dimensions
Viewing the Clearance Between a Net and an Item

Viewing the Clearance Between Nets
Use Net-to-Net Clearance to detect the location of the smallest spacing between two specified nets.

Procedure
1. Click the View  > Clearance  menu item.

2. In the View Clearance Dialog Box, click Net to Net.

3. To center the minimum clearance marker in the workspace, select the “Pan to Minimum Clearance 
Marker” check box.

4. Select two nets.

A minimum clearance marker displays the minimum clearance location between the nets in the 
design using the Selections color from the Display Colors dialog box.

Related Topics
Viewing the Clearance Between Items and Annotating Dimensions

Viewing the Clearance Between Items and 
Annotating Dimensions
Use Item-to-Item clearance to measure the spacing between items and annotate a PCB layout design 
with dimensioning that indicates critical or problem clearances.

Procedure
1. Go to the layer on which the items are placed. If you are not on the correct layer, you will not get a 

true clearance.

2. Click the View  > Clearance  menu item.

3. In the View Clearance Dialog Box, click Item to Item.

4. If you intend to annotate the design with the dimensions of the spacing between your two items, 
click Options  to set the placement layer and style of the dimensions.
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5. Select the two items.

Supported item types are pads, vias, jumpers, traces, 2D lines, copper, and component outlines. 
Information about the items appears in the Selected Items area of the View Clearance dialog box. 
Line extensions and arrows appear on the design showing the location and size of the minimum 
clearance.

Clearances are measured on the current layer. When one or both selected items are not on the 
current layer, the clearance is measured to the centerline of the item that is not on the current 
layer.

6. To place the dimensions in the design move the pointer to where you want the dimensions and 
click. If you do not want the dimensions in the design, click Cancel.

Dimensions are added to the layers for dimensioning 2D Lines and Text as set in the Options.

Viewing the Clearance Between a Net and an 
Item
Use Net-to-Item Clearance to detect the location of the smallest spacing between the net and all objects.

Procedure
1. Click the View  > Clearance  menu item.

2. In the View Clearance Dialog Box, click Net to Item.

3. To center the minimum clearance marker in the workspace, select the “Pan to Minimum Clearance 
Marker” check box.

4. Select a net.

A minimum clearance marker displays the minimum clearance location using the Selections color 
from the Display Colors dialog box.

Related Topics
Viewing the Clearance Between Items and Annotating Dimensions
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Chapter 29
Copper Operations

Read the topics that follow to learn more about the methods used to add copper shapes to your design, 
including how to assign names to copper objects and how to create cutouts within the copper shapes.

Creating a Copper Shape
Creating Copper Chamfered Paths
Setting Chamfered Path Parameters
Bridging Nets with Copper
Assigning a Unique Netname to Copper or Copper Planes
Creating a Copper Cut Out
Cut Outs Absorbed by Copper
Creating Nested Copper

Creating a Copper Shape
Copper is used to create heat sinks, shielding, and net bridges. You can assign nets to copper shapes.

Prerequisites

• Ensure you select a layer for placement of the copper. You cannot create a copper shape on all 
layers (layer number zero). If you need the same copper shape on many layers, copy the shape 
to other layers.

• Copper must be created with On-Line Design Rule Checking in the Off mode since copper 
objects cover any and all other electrical objects. If you need a copper shape that avoids 
objects other than the net to which it is assigned, use a copper plane. For more information, see 
“Creating a Copper Plane Manually”  on page 667.

Procedure
1. On the Drafting Toolbar, click the Copper button.

2. Right-click and click a command to change the values of the drafting object. For more information, 
see “Set Values Before Creating a Drafting Object”  on page 614.

3. Create the shape using one of the following:

• Creating a Circle Drafting Object

• Creating a Polygon or Path Drafting Object

• Creating a Rectangle Drafting Object

4. Once you complete the shape, it becomes a filled shape, and the Add Drafting Properties dialog 
box appears.
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Tip
If you do not want the Add Drafting dialog box to appear when completing the copper, clear 
the “Prompt for Net Name at Completion of Copper” check box in the Options dialog box > 
Text and Lines  category.

5. In the Add Drafting properties dialog box  on page 1328, you can make changes to the copper 
properties.

For example, in the Net Assignment area, you can assign a net by selecting the net name in the 
Net list or you can click the Assign Net by Click  button and click a design object attached to the 
net. For more information, see “Drafting Object Properties”  on page 637.

Is the resulting shape what you expected?

• If the fill is not correct, see “The Fill of Copper, and Copper Planes”  on page 617.

• If the shape edges are not correct, see “Edge Precision of Drafting Shapes  on page 615”.

• If the shape needs to be modified, see “Drafting Object Properties”.

• If you want to start over, see “Deleting a Drafting Segment or Object”.

Related Topics
Creating a Copper Cut Out

Assigning a Net to Existing Copper or Copper Planes

Routing To a Copper Shape

Routing From a Copper Shape

Creating Copper in the Decal

Bridging Nets with Copper

Cut Outs Absorbed by Copper

Creating Copper Chamfered Paths
Because some designs (such as RF designs) require specialized trace corner geometries, you can add 
chamfered copper as an alternative for regular traces. Using Chamfered Path, SailWind Layout squares 
or chamfers orthogonal corners. SailWind Layout also chamfers wide angle corners and acute corners.

As copper is created with an outline and a fill, you can specify a very narrow outline width to achieve very 
sharp corners. SailWind Layout creates all Chamfered Paths with a Solid Copper fill.

Prerequisites
This feature requires the Advanced Editing/RF license option  on page  .
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Creating Copper Chamfered Paths

Procedure
1. On the Drafting Toolbar, click the Copper  button.

If you have Online Design Rule Checking  on page 461 enabled, in the prompt that appears, click 
OK  to switch off Design Rule Checking.

2. Right-click and click the Chamfered Path  popup menu item.

3. In the Add Chamfered Path dialog box, set the Chamfered Path Parameters  on page 658 and 
then click OK.

4. Click to start the copper.

5. Move the pointer, then do one of the following:

• Click to place a corner.

• Type S<x>, <y>, where <x> and <y> are the coordinate values for the next corner.

• Type SR<x>, <y> if you want to specify relative coordinate values.

Tip
Right-click and click Add Arc  to add an arc instead of a straight-line segment.

6. Continue adding copper and corners as necessary.

Note:
To back up and remove the last corner, press the Backspace key.

7. To end the copper, either double-click or right-click and click the Complete  popup menu item.

8. In the Properties dialog box, you can assign a net and modify other settings.

Results
If you create a chamfered path pin pair, unroutes will update when you add the copper in the same way 
as a trace is placed between pads - from and to the center (or Pin Position) of the pads and when you 
assign the net to the copper. You can also convert traces to chamfered copper paths which automatically 
assigns the net and unroutes would also update with the original trace connection. see “Converting a 
Trace to a Copper Chamfered Path”.

Restriction:
The chamfered path does not appear as the correct width if the “Minimum display width” option for 
the design is larger than the Polygon outline width of the path. The path appears more narrow by 
the value of the Polygon outline width.
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Related Topics
Setting Chamfered Path Parameters

Restoring Traces After Conversion to Copper Chamfered Paths

Setting Chamfered Path Parameters
The Add Chamfered Path dialog box opens when you select Chamfered Path - copper shape. Set the 
Chamfered Path parameters before you add the copper to the design.

Procedure
1. On the Drafting Toolbar, click the Copper  button.

If you have Online Design Rule Checking  on page 461 enabled, in the prompt that appears, click 
OK  to switch off Design Rule Checking.

2. Right-click and click the Chamfered Path  popup menu item.

3. In the Polygon outline width box, type a width value for the copper outline.

Tip
Since copper is created with an outline and a fill, you can specify a very narrow outline 
width to achieve very sharp corners. Decrease the value for sharper corners and increase 
the value for more blunt corners. All corners are rounded with a radius equal to one half of 
the outline width.

4. In the “Chamfered path width” box, type a width value for the overall width of the copper path.

5. In the “Corner chamfer width ratio” box, type a value specifying the ratio of the chamfered corner 
width to the chamfered path width.

If the ratio is 1.0, the width of the chamfered corner is the same as the chamfered path. Reduce 
the ratio for a more narrow chamfered corner.

6. Clear the “Chamfer corners with angles less than or equal to” check box to chamfer only angles 
less than 90 degrees or select the “Chamfer corners with angles less than or equal to” check box 
to specify an angle between 90 and 180 degrees as the upper limit beneath which all angles are 
chamfered.

Outside corners less than 90 degrees are always chamfered.

7. Click OK.

Bridging Nets with Copper
You can create a physical connection between objects of two different nets with design rule checking 
enabled.
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Bridging Nets with Copper

Restrictions and Limitations

• You can not create bridge copper in the decal.

• Bridge copper saved to the library loses its bridge status.

Procedure
1. Use one the following methods.

• If the copper already exists, select the copper shape, and then right-click and click the 
Properties  popup menu item.

• If the copper does not already exist, Create the copper shape.  on page 655

2. In the Add Drafting or Drafting Properties dialog box  on page 1328, select the “Bridge” check box.

3. Click the Nets to bridge  button.

4. In the Net Association dialog box  on page 1486, add two or more nets to bridge from the 
“Available nets” list.

5. Click OK  in the Net Associations dialog box.

6. Click OK  in the Add Drafting dialog box.

Results
You can use this copper to bridge objects of the assigned nets without getting an online design rule 
checking error. The following exceptions will apply:

• When you run a connectivity check, it will only report an error if no physical connection exists 
between the bridge copper and a net associated to it.

• When you run a clearance check, it will only report an error if you use any non bridge-copper 
object to bridge the nets. This is also prevented by online DRC.

You can use the Find Dialog Box  to search for Nets with bridges. Results display the nets and list the 
bridge coppers associated with them.

You can copy bridge coppers and they retain their bridge status, but their net associations are removed. 
For more information, see “Copied Bridge Copper in ECO Mode”  on page 840.

CAUTION:
Bridged nets are combined when you export the design into the .hyp  (PADS HyperLynx), .ipc 
(IPC356), and .tgz  (ODB++) file formats.
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Assigning a Unique Netname to Copper or 
Copper Planes
You can assign a unique netname to copper or copper planes, enabling you to assign rules and properties 
to the copper shape independent of the netlist.

Tip
To assign an existing netname to a selected copper shape, use the Drafting Properties Dialog 
Box.

Procedure
1. Select a shape, right-click, and then click the Add Net  popup menu item.

2. In the Define Name of New Net Dialog Box, do one of the following:

• To specify a custom netname, choose the Typed New Name option and type the netname in 
the Name of New Net box. The maximum netname length is 47 characters. You can use any 
alphanumeric characters except braces { }, asterisks *, spaces, question marks, or commas.

• Choose the Autogenerated New Name option to use the default netname.

Results
The new name is added to the netlist, and you can access the net in the rules dialogs to add constraints 
to the new net. Because this action does not affect the schematic logic, the new netname is not recorded 
as an ECO operation.

Related Topics
Finding by Hatch Outline

Finding by Isolated Hatch Outline

Assigning a Net to a Copper Shape or Copper Plane

Creating a Copper Cut Out
Use copper cut outs to create voids inside copper shapes. Creating a cut out involves combining the fixed 
copper shape with the copper cut out.

Restrictions and Limitations
A cut out does not create a void in the outline of the copper shape. Create the copper as a polygon shape 
to create features in the outline.

Prerequisites
You must put the cut out on the same layer as the copper.
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Cut Outs Absorbed by Copper

Procedure
1. On the Drafting Toolbar, click the Copper Cut Out  button.

2. Create one or more cut out areas for the copper.

See “Creating a Drafting Object” for more information. You can create the cut out before the copper 
or the copper before the cut out.

3. Right-click and click the Select Shapes  popup menu item.

Tip
If you cannot see a cut out within the copper shape, use the Drafting  tab in the Options 
dialog box to set the hatch view to No Hatch. See the Hatch options in the Options dialog 
box > Copper Planes  category > “Hatch and Flood subcategory”  on page 1511.

4. Drag a box to group-select the copper and cut out(s).

Note:
Some circumstances do not allow for dragging a group selection box. Instead, click to 
select the cut out. Typically, the copper is selected first. Click the Cycle button to cycle to 
selecting the cut out. If you have multiple cut outs, use Ctrl+click to select the copper then 
click the Cycle  button to select another cut out. As you select additional cut outs, previous 
cut outs do not retain the selection color but remain selected. Finally, Ctrl+click to select 
the copper.

5. Right-click and click the Combine  popup menu item. Copper inside the cut out area is 
automatically removed.

Results
Is the result what you expected?

• Do you need to move or edit a cut out? You will need to uncombine it first. see “Uncombining 
Drafting Objects”.

• Do you need to move or edit the copper? Any modifications you make to the copper shape 
(move, rotate, miter, etc.,) also affect the combined cut out(s).

Related Topics
Cut Outs Absorbed by Copper

Cut Outs Absorbed by Copper
When you combine coppers and copper cut outs in SailWind Layout and take the design into SailWind 
Router, if any cut outs cross the copper outline, they are no longer cut outs. Instead, the software absorbs 
them into the copper shape.

In some cases, copper cut outs are completely enclosed within the confines of a copper shape. If the 
copper cut out extends beyond the boundaries of the copper shape, however, and you merge the cut 
out with the copper shape in SailWind Layout (by right-clicking and clicking the Combine  popup menu 
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item), when you move the design over to SailWind Router, the software “absorbs” it into the outline of the 
copper shape.

Figure 78. Absorbed Copper Cut Out

If the cut out completely divides a copper shape, two or more separate copper shapes may result in 
SailWind Router.

Figure 79. Subtracted Copper Cut Outs in SailWind Router

Certain other changes take place:
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Creating Nested Copper

• If you completely cover a copper shape with a cut out then combine the two, taking the design 
into SailWind Router deletes the copper shape in its entirety.

• SailWind Router removes any copper cut outs that lie outside the boundary of a copper shape.

• If a copper shape has two or more overlapping cut outs within its boundaries, the copper cut outs 
merge into one shape when you move the design to SailWind Router.

The software generates a report automatically when you open the design, detailing any instances where 
the software absorbs one or more shapes during the subtraction process.

Note:
If SailWind Router is running in the foreground, the link to the report displays in the SailWind 
Router Output Window. If SailWind Router is running in the background (for example, during 
an autoroute routine or during Latium Design Verification), the link to the report displays in the 
SailWind Layout Output Window.

Creating Nested Copper
You can create a copper shape within another “outer” copper shape. You can do so by creating a copper 
cut out inside the outer shape, combining it with the outer shape, and then creating the new nested 
copper shape inside the copper cutout.

Procedure
1. In the outer copper shape, Create a copper cut out  on page 660 of appropriate size and shape, 

and combine it with the outer shape.

2. Create the new nested copper shape  on page 655 within the copper cut out.

Results
The new nested copper shape displays inside the cut out of the outer shape.
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Chapter 30
Assigning a Net to a Copper Shape or 

Copper Plane
You can assign any net in the design to copper or copper planes so that the net maintains proper 
connectivity as it transitions across many design objects.

Assigning a Net to Existing Copper or Copper Planes
Creating Copper or Copper Planes Based on the Net of an Object

Assigning a Net to Existing Copper or Copper 
Planes
You can assign a net to copper or a copper plane by selecting a design object with the net already 
assigned, thus assigning the copper to the net.

Procedure
1. Select the copper shape or copper plane.

2. Assign the net using one of the following methods:

• Right-click and click the Properties  popup menu item. In the Drafting Properties dialog box, in 
the Net Assignment area, choose a net from the list of nets in the design.

• Right-click, and then click the Assign Net By Click  popup menu item. Click a design object, 
such as a pin, via, trace, net, copper, or unroute, with the netname you want to assign to the 
copper.

Restriction:
If a net has already been assigned to the copper or copper plane, Assign Net By Click 
is unavailable on the popup menu. You must right-click and click the Properties  popup 
menu item, and in the Drafting Properties dialog box, click the Assign Net By Click 
button.

Results
The status bar displays the netname assigned to the copper or copper plane.

Creating Copper or Copper Planes Based on 
the Net of an Object
If desired, you can assign a net to a new copper shape or pour area before you start drafting it.
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Procedure
1. Select a single design object, such as a pin, via, trace, net, copper, or unroute, on the net you want 

to assign to the copper.

2. Right-click,and click the Add Copper Area  or Add Copper Plane  popup menu item.

Restriction:
If you select multiple design objects, the Add Copper Area  and Add Copper Plane  popup 
menu items are unavailable.

3. Create the copper or copper plane.

Results
The copper inherits the netname from the selected object.
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Chapter 31
Copper Plane Operations

A copper plane  is a closed, non-self-intersecting polygon that provides access to universally necessary 
nets, like power and ground. One design may use several copper planes. Most PCB designs locate 
planes on inner layers that are dedicated to the plane only, although you can place them on outer layers. 
The plane area can occupy all or part of the layer it is on. Two or more partial planes can occupy one 
layer, each servicing a different net. Such a configuration is called a split plane.

Copper planes may have insulated traces and vias passing across the plane area, as long as the traces 
do not divide the plane to break connectivity.

You can create plane areas manually  on page 667 using the drafting tools or automatically  on 
page 668 using Create Copper Plane, using the board outline as a guide. After identifying a layer as a 
split/mixed plane layer and assigning nets to the layer, you can add plane areas.

For more information, see “Differences Between Copper Shapes and Copper Planes”  on page 779, and 
“Split/Mixed Plane Layers”  on page 683.

The following topics describe the methods used to create copper planes and how to assign nets to 
them. They also provide detailed information related to copper plane filling, splitting plane areas, thermal 
connectivity and troubleshooting.

Creating a Copper Plane Manually
Creating a Copper Plane Automatically
Customizing Design Rule Thermals
Customizing Design Rule Antipads
Associating a Net to a Copper Plane
Assigning Nets to Split/Mixed Plane Layers
Control the Display of Thermals in Copper Planes
System-prompted Copper Plane Filling
Troubleshooting Copper Plane Fills
Troubleshooting Thermal Results
Clearances Between Copper Planes and the Board Outline
Split/Mixed Plane Layers
Creation of Split Planes
Separating Copper Planes Automatically
Embedded Copper Planes
Creating a Copper Plane Cut Out
Assigning Copper Plane Thermal Attributes
Discarding Copper Plane Data on Save
Display of Connections for Pads Connected to a Copper Plane

Creating a Copper Plane Manually
Use a copper plane to create a copper area that avoids objects not connected to its associated net while 
simultaneously making thermal connections to objects that are connected to its associated net.
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Flooded copper planes create automatic clearance to traces, pins, and other objects that do not share the 
same net assignment.

For more information, see “Differences Between Copper Shapes and Copper Planes”  on page 779.

Procedure
1. On the Drafting Toolbar, click the Copper Plane  button.

2. Right-click and click a command to change the values of the drafting object. For more information, 
see “Set Values Before Creating a Drafting Object”.

3. Create the shape using one of the following:

• Creating a Circle Drafting Object

• Creating a Polygon or Path Drafting Object

• Creating a Rectangle Drafting Object

4. In the Add Drafting properties dialog box  on page 1328that displays:

a. Assign a net by selecting the net name in the Net list; or you can click the Assign Net by Click 
button and click a design object attached to the net.

When you create a copper plane on a split/mixed layer, you can select the “Show plane nets 
only” check box to limit the nets to only those assigned to the split/mixed plane layer in the 
Layers Setup.

b. Make any other appropriate changes to the copper plane properties.

5. Click OK.

6. View the resulting shape.

• If the gap between the pad and the copper for thermals or antipads is incorrect, see 
“Customizing Design Rule Thermals”  on page 669 or “Customizing Design Rule Antipads”  on 
page 670.

• If the shape edges are not correct, see “Edge Precision of Drafting Shapes  on page 615”.

• If the shape needs to be modified, see “Drafting Object Properties”.

• If you want to start over, see “Deleting a Drafting Segment or Object”.

Related Topics
Flooding Copper Planes

Creating a Copper Plane Automatically
You can create a copper plane by copying the shape of the board outline. A shape is generated 
proportionally smaller than the outline and includes miters or small notches existing in the board outline.
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Customizing Design Rule Thermals

Procedure
1. On the Standard Toolbar, set the active layer to either a non plane layer or a Split/Mixed plane 

layer in the Layer list.

2. Select the board outline.

3. Right-click and click the Create Copper Plane  popup menu item.

4. In the Add Drafting dialog box, in the Net assignment area, assign a net to the copper plane using 
either the net dropdown list or the Assign Net by Click  button.

You can use the Show plane nets only check box to reduce the list of nets to only those assigned 
to the layer in the Layers Setup. You can also choose “None” from the dropdown list and associate 
a net later. If only None appears in the list, the net has not been assigned to the Split/Mixed plane 
layer in the Layers Setup. When you assign the net to the copper plane, pads associated with 
these nets will get thermal indicators if they are inside the appropriate polygons.

Tip
When you use Create Copper Plane, you may receive an error message indicating a 
self-intersecting polygon  on page 625. This occurs because the generated plane area is 
proportionally smaller than the board outline and the software cannot create small miters 
and/or notches in the board outline using the specified line width. Correct this error by 
reducing the distance between the board outline and the plane. In the Tools > Options 
(menu item, Copper Planes  category, Hatch and Flood  subcategory, type a smaller value 
for the Auto Separate Gap setting. Alternatively, you can use a smaller line width for the 
copper plane (if you choose this method, you also need to reduce the copper hatch grid 
to match in order to maintain a solid fill for the copper plane. Generating more fill lines 
consumes more memory and could slow operations if the line width is greatly reduced).

Related Topics
Flooding Copper Planes

Customizing Design Rule Thermals
You can customize the default thermals on pins, virtual pins, and vias within copper planes. The default 
thermals depend upon the Thermals options for spoke settings and the Copper-to-Pad or Copper-to-Via 
clearance rule value for the clearance between the pin pad or via pad and the copper.

Procedure
1. Choose the Tools  > Options  menu item and then select the Copper Planes  category, then 

Thermals  subcategory to view the Thermals options  on page 1514.

There are separate settings for Drilled (Through-hole) and SMT (surface mount) pads.

2. Set the width of the spokes in the Spoke width box.

3. Set the minimum allowed number of spokes in the Spoke minimum box.

4. For each pad shape, set the orientation of the spokes.
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Tip
If you only want to flood over vias, you can enable an option in the properties of the copper 
plane. see “Flood and Hatch Options Dialog Box” for the “Flood over vias” check box.

5. If you want to allow routed pads to also have thermal connections, select the “Add thermals to 
routed component pads” check box.

6. Open the Design Rules  on page 1674. In any applicable level of the hierarchy of the design rules, 
in the Clearance  on page 1167 rules, set the Copper-to-Pad and Copper-to-Via value according to 
the needs of your design.

Results

• After you fill the copper plane, atherm.err  report generates if any pads receive fewer spokes than 
the Min. spoke value. For example, if the pad intersects the boundary of a copper plane, it may 
not be possible to create all four spokes.

• After filling a copper plane, if any pad fails to receive a thermal, use the Selection Filter to check 
for trace stubs at the pad. Small leftover trace segments attached to a pad prevent the pad from 
receiving thermals if the “Add thermals to routed component pads” check box is selected (in the 
Options dialog box, Copper Planes  category, Thermals  subcategory). Set the Selection Filter to 
Traces, Corners, and Tacks to select and remove trace segments attached to the pad.

Customizing Design Rule Antipads
You can customize the default antipads that appear around pins, vias, or drill holes within copper planes. 
Default antipads depend upon the Copper-to-Pad, Copper-to-Via, or Copper-to-Drill clearance rule value 
for the clearance between the pin pad, via pad, or drill hole and the copper. You can apply the clearance 
value to either the net of the copper plane or the net of the pad/via.

Procedure
1. Click the Setup  > Design Rules  menu item.

2. In the Design Rules  on page 1674 dialog box, in any applicable level of the hierarchy of the design 
rules, in the Clearance  on page 1167 rules, set the Copper-to-Pad, Copper-to-Via, and Copper-to-
Drill values according to the needs of your design.

Tip
By applying the clearance to the net of the copper plane rather than the pads, you can 
affect all pads, vias, and drills within the copper plane. But by applying the clearance to 
the net of pads and vias rather than the copper plane, you can achieve different antipad 
spacings. Or you can use a combination - apply a general minimum clearance to the net of 
the copper plane and apply a larger clearance to nets of objects that need larger antipads.
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Associating a Net to a Copper Plane

Results

• When you are dealing with antipads, there are two nets involved. If you are not getting the results 
you expect, ensure that the clearance values of the other net involved are not conflicting with the 
values you have already changed. Larger clearance values always have precedence.

• With through hole pins and vias, the copper-to-drill value applies if the “Use design rules for 
thermals and antipads” check box is selected.

• The Tools > Options  (menu item), Copper Planes  (category), Thermals  (subcategory) option 
“Remove unused pads” and “Use design rules for thermals and antipads” both affect the 
clearance of the antipad.

Related Topics
Customizing Design Rule Thermals

Associating a Net to a Copper Plane
You can associate a net with a copper plane at any point in the design process. This allows you the 
flexibility to assign a net to a copper plane at the time of creation, or to create the copper plane and then 
go back at some future time and associate a particular net with the copper plane.

Procedure
1. Select the copper plane outline.

2. Right-click and click the Properties  popup menu item.

3. Click a net from the Net  list.

4. Click OK.

Examples
Use the Drafting Properties dialog box to associate a net to a copper plane if:

• You created a copper plane before you assigned nets to the copper plane in the Layer Setup 
dialog box.

• You chose None from the Assign Net to Selected Polygon dialog box when you split a copper 
plane.

• You want to associate a different net to a copper plane.

Assigning Nets to Split/Mixed Plane Layers
After defining your plane layers, you can assign the appropriate net(s) to those layers to establish the 
desired connectivity in the design.

Use Assign Nets in the Layers Setup Dialog Box  to assign one or more nets to the split/mixed plane layer.
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Procedure
1. Click the Setup  > Layer Definition  menu item.

2. Select a split/mixed plane layer and click the Assign Nets  button.

3. Select a net from the All Nets list.

Note:
You can assign a net to as many layers as required.

4. Click Add  to move the net to the Assigned Nets list box.

5. Repeat the steps above to associate additional nets.

6. Click OK  to close the Plane Layer Nets dialog box.

7. Click OK  to close the Layer Setup dialog box.

Related Topics
Creating a Copper Plane Manually

Creating a Copper Plane Automatically

Creation of Split Planes

Control the Display of Thermals in Copper 
Planes
Use the Options dialog box > Copper Planes  category > Thermals  subcategory to control the display of 
thermal information.

For more information, see “Assigning Copper Plane Thermal Attributes.”

Use the “Active Layer Comes to Front” check box in the Tools > Options  (menu item), Global  (category), 
General  on page 1531 subcategory to view more detail for the thermal and antipad clearances. When 
this check box is selected, a small outline in the shape of the pad or via is visible when the current layer is 
a split/mixed plane layer. If the thermal display properties are correctly set, thermal graphics appear at all 
pins and vias belonging to the copper plane net.
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System-prompted Copper Plane Filling

Figure 80. Active Layer Setting Disabled (Top) and Enabled (Bottom)

System-prompted Copper Plane Filling
When you use certain command operations, you are prompted to fill a copper plane. The fill prompts 
appear when you verify your design or run CAM generation commands.

Verify Design
When you use the Tools  > Verify Design  menu item, and you perform a Copper Plane check (and also 
select the “Check clearance and connectivity” option in the Setup), the software checks for proper setup, 
creates the copper plane (if only one net is assigned), if necessary. The software then prompts you to fill 
the copper plane automatically. For more information, see “Verify the Design.”
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Run CAM
When you run CAM on a split/mixed plane layer, the software checks for proper setup and creates the 
copper plane if necessary. The software then prompts you to fill the copper plane automatically. For more 
information, see “Creating All Outputs.”

Troubleshooting Copper Plane Fills
Copper plane fills require special attention to assure that the connectivity matches the design intent.

Solution
The following situations can prevent a copper plane from filling.

No pads of the net are located within the copper plane
Ensure that at least one pad of the net assigned to the copper plane is within the shape.

No drilled pads are located within the copper plane
Typically, the default for non-drilled pads is to not have the Plane Thermal property enabled. Enable the 
Plane Thermal property for non-drilled pads to allow them to connect to the copper plane with thermals. 
Select the pad(s), right-click and click the Properties  popup menu item. In the Pin Properties Dialog Box, 
select the Plane Thermal check box. This causes the system to re-check which pins should get plane 
thermals based on the layers and nets.

No pads or vias located within the copper plane have the Plane Thermal 
property enabled
Enable the Plane Thermal property for pads and vias to allow them to connect to the copper plane with 
thermals. Select the pad(s), right-click and click the Properties  popup menu item. In the Pin Properties 
Dialog Box, select the Plane Thermal check box. This causes the system to re-check which pins and vias 
should get plane thermals based on the layers and nets. Repeat the process for the via(s).

No copper plane is defined
Ensure you can see the outline of the copper plane.

Multiple copper planes are intersecting or defined on top of each other
One of the copper planes must take priority and you must create a cutout of the other plane. You might 
benefit from enabling the “Create cutouts around embedded copper planes” option found by choosing the 
Tools > Options  menu item, Copper Planes (category), “Hatch and Flood”  on page 1511 subcategory. 
For information about giving a copper plane a flood priority, see the Flood Priority setting in the “Flood and 
Hatch Options Dialog Box”. The Flood Priority numbers should be lowest for inner nested copper planes 
and greatest for the outer copper planes.

You have modified the copper plane outline while the copper plane area is 
filled
Return the plane area to the basic plane outline using the modeless command PO before modifying the 
shape of the outline.
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You have embedded/nested copper planes
You must create the largest copper plane first, then the smaller inner copper plane(s) next. (As long 
as you select the Tools  > Options  menu item, then Copper Planes  (category), Hatch and Flood 
(subcategory), then “Create cutouts around embedded copper planes” check box, this automatically 
assigns the correct flood priority and creates the required copper plane cutout within the larger split 
plane.)

If you neglected to select the “Create cutouts around embedded copper planes” option or you simply 
created the inner copper plane area first, the copper plane areas have conflicting flood priority values 
and are unable to fill. You must decide the order in which the copper planes should be filled and adjust 
their flood priorities accordingly. For information about giving a copper plane a flood priority, see the Flood 
Priority setting in the “Flood and Hatch Options dialog  on page 1381” box. If you have only one inner 
copper plane, there is a quicker way to give it the higher flood priority. Use the PO modeless command 
to return the plane to outline mode. Select the plane area shape, right-click and click the Bring to Front 
popup menu item. The system recognizes the new flood priority and fills the copper plane.

Traces or pins block the fill from connecting with any pads of the same net
You must free up space for the fill at the current width and grid setting to flow and contact at least one pad 
of the same net with thermals.

Your minimum hatch area setting is too large
In the Tools > Options  (menu item), Copper Planes  (category), “Hatch and Flood”  on page 1511
subcategory, check the “Min. Hatch Area” and ensure the value entered is not larger than the copper 
plane size.

Your keepout is restricting the copper plane
Assign a color to Keepouts for all layers and ensure they do not restrict copper planes for the location and 
layer.

You have hidden the fill
Ensure the fill is visible. Tools > Options  (menu item), Copper Planes  (category), “Hatch and Flood”  on 
page 1511 subcategory, in the Hatch View area, click Normal instead of No Hatch.

You have set Thermal options to no connect
Ensure that drilled and non-drilled pads have orthogonal, diagonal, or flood over settings in the Thermals 
Options  on page 1514.

You have already routed to all available pads of the same net located within 
the plane area
If nets of the same name as the pour or plane are already routed, ensure that the Add thermals to routed 
component pads check box is selected in the Thermals Options  on page 1514.

Troubleshooting Thermal Results
When you fill (flood/pour) a copper plane, a Thermal Relief Errors Report (therm.err) might appear 
in your default text editor. This file appears when pads within the copper plane do not receive the 
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minimum number of spokes according to your settings in the Tools  > Options  menu item, Copper Planes 
(category), Thermals (subcategory).

The Thermal Relief Errors Report
Report sections state whether there is less than 100% or even 50% thermal extensions. Below each 
section there is a listing of the reference designator with pin number (if a component pad), pad coordinate 
location and the actual number of thermal spokes that were generated.

For example:

Drilled pads with
less than 50% thermal extensions
 
Report of Thermal Spokes Generator
 
On Primary Component Side:
 
J1.5 (455, 650) # = 2

This indicates that pin 5 of reference designator J1, at coordinates 455, 650 has only 2 thermal spokes 
that were generated. The required thermal spokes for this would be 4 or more. There could be a variety 
of reasons why the number of thermal spokes is reduced such as a clearance issue where as a trace is 
too close to a pad, or the copper plane outline width and hatch grid are too large for the copper to flood 
between the component pins, etc.

Interpreting Thermal Results
You can interpret the thermal results to detect problematic thermal issues in your design.

If results are not as expected, consider the following:

• If a large number of pads and/or vias have zero thermal spokes being generated, there may be a 
copper plane that is not filling. For more information, see “Troubleshooting Copper Plane Fills”.

• If there are only a few pads or vias that have zero thermal spokes and yet there is no obvious 
obstruction to their creation, you might have a situation where those pads or vias do not have the 
Plane Thermal property enabled. Enable the Plane Thermal property for those pads and vias to 
allow them to connect to the copper plane with thermals. Select the pad(s), right-click and click 
the Properties  popup menu item. In the Pin Properties dialog box, select the Plane Thermal 
check box. This causes the system to re-check which pins and vias should get plane thermals 
based on the layers and nets. Repeat the process for the via(s).

Clearances Between Copper Planes and the 
Board Outline
A number of factors can influence the way you construct copper planes and how they relate to other 
objects in a design.

Plane Edge Setback
For any plane area, it is desirable for the edge of the flooded plane to be set back slightly from the edge 
of the board. This prevents the edge of the plane from being exposed during the board trimming process 
and eliminates the potential of the plane being accidentally shorted to another design or packaging object.
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There are two important measurements that you must consider when auto-generating a plane area:

• The distance between the board outline and the plane area outline

• The distance between the board outline and the copper within the plane area after flooding (hatch 
outline)

Board Outline
A drawn 2D line represents the board outline. The Default Width setting on the Text and Lines  category 
of the Options dialog box determines the width of the line at the time of generation. You can change the 
board outline width by selecting the board outline and changing the width in the Drafting Properties dialog 
box.

The line used to represent the board outline is intended to be a visual reference that indicates the 
perimeter of the board in the design workspace as well as on the CAM plots. Changing the width of this 
line does not change the dimensions of the board as the actual board edge is at the centerline of this 2D 
line.

Plane Area Pour Outline
You can create a plane area by defining its pour outline. When you create the plane area pour outline, you 
specify the width of the line that represents the visible boundaries of the shape. The outer edge of this 
outline represents the maximum extents of the copper when the shape is flooded. The Board to Copper 
clearance rule influences how the design references the edges of this shape and can modify the extents 
of the copper flooding when required.

For more information on how plane area pour outlines are created, see Edge Precision of Drafting 
Shapes  on page 615.

Auto Separate Gap
You can split a single plane area shape into two or more shapes. When you divide the plane area, you 
can control the desired spacing between these multiple plane area shapes by specifying a value for the 
Auto Separate Gap (choose the Tools > Options  menu item and click the Copper Planes  category > 
Hatch and Flood  subcategory to access this setting).

The lines used to create the plane area pour outlines are Drafting objects and have width. If you have 
specified a value for the Auto Separate Gap, this value is used to compute the distance between the 
edges of these lines. Therefore, if you specify a 25 mil value for the Auto Separate Gap, the plane area 
pour outlines will be separated from one another by a distance of 25 mils. This distance is measured 
between the outer edges of the lines used to draw the plane area shapes.
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Figure 81. Auto Separate Gap

CAUTION:
When multiple plane areas exist on the same layer, the flood priority assignments determine the 
final separation gap (see Flood Priority Settings).

When auto-generating plane areas using the board outline shape, the Auto Separate Gap is considered 
during the calculations used to determine the distance that a plane area will be set back from the edge of 
the board.

Restriction:
If a value of 0 is specified for the Auto Separate Gap, a non-editable system default value of 10 
mils is used in this calculation.

For additional information on how split planes are created, see “Split/Mixed Plane Layers”  on page 683.

Plane Area Pour Outline Setback from the Board Outline
The line that draws the board outline is a Drafting object and thus it has a width, so any plane areas 
sharing a boundary with the board outline use the Auto Separate Gap value to determine the minimum 
distance that they must pull back from the board edge.

This setback distance is measured from the inside edge of the line used to draw the board outline. Since 
the board edge is at the center of the line defining the board outline, half of this line width is inside the 
edge of the board, so the resulting plane area pour outline setback distance is the sum of the value 
specified in the Auto Separate Gap plus one half of the line width used to draw the board outline.

Example:  If the board outline width is 10 mils and the Auto Separate Gap is set to 25 mils, then the 
resulting plane area pour outline setback distance would be the Auto Separate Gap value (25 mils) plus 
half of the line width value (5 mils) for a total distance of 30 mils from the board edge.
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Figure 82. Plane Area Pour Outline Setback from the Board Outline

Exception Example:  If no value is specified for the Auto Separate Gap, the system uses the system 
default value and places the plane area pour outline 10 mils from the inside edge of the line used to draw 
the board outline, so the resulting plane area pour outline setback distance would be the system default 
value (10 mils) plus half of the line width value (5 mils) for a total distance of 15 mils from the board edge.

Figure 83. Plane Area Pour Outline Setback from the Board Outline Exception

Plane Flood Hatch Outline Setback From the Board Outline
When plane areas are in proximity to the board edge, the Board to Copper clearance value in the design 
rules normally controls the plane flood hatch outline setback. However, if the results of the calculation that 
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determines the plane area pour outline setback has a value larger than the Board to Copper design rule, it 
takes precedence.

Plane areas are flooded based upon the following conditions:

1. If the Board to Copper value is larger than the Auto Separate Gap + half the board outline width, 
then the plane flooding boundary (hatch outline) is pulled back and the copper flood is set back 
from the board edge to a distance equal to the Board to Copper Clearance value.

2. If the value set in the Board to Copper Clearance is equal to or smaller than the Auto Separate 
Gap + half the board outline line width, then the plane flooding boundary is not reduced and the 
area is flooded to the existing plane shape edge.

For additional information related to how the plane flood hatch outlines are filled, see “The Fill of Copper, 
and Copper Planes”  on page 617

Examples of Plane Flooding Setback from the Board Outline
SailWind Layout calculates plane flooding setback distances based upon various design conditions. The 
following table provides examples of how plane flooding setback distance is calculated.

Table  110. Example Data for Determining Plane Flooding Setback Distance

Parameter Example A Example B Example C Example D

Board Outline Width 10 mils 10 mils 10 mils 10 mils

Auto Separate Gap 25 mils 0 25 mils 0

Board to Copper 50 mils 50 mils 0 0

Results

Distance to Pour Outline 30 mils 15 mils 30 mils 15 mils

Distance to Hatch Outline 50 mils 50 mils 30 mils 15 mils

Example A
The Board to Copper value is greater than the calculated plane area pour outline setback, so the Board to 
Copper value is used for the hatch outline setback.
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Figure 84. Plane Setback Example A

Example B

The Board to Copper value is greater than the calculated plane area pour outline setback (using the Auto-
Separate Gap default value), so the Board to Copper value is used for the hatch outline setback.

Figure 85. Plane Setback Example B

Example C

The Board to Copper value is equal to or smaller than the calculated plane area pour outline setback, so 
the plane area pour outline setback value is used for the hatch outline setback (coincident with the pour 
outline).
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Figure 86. Plane Setback Example C

Example D

The Board to Copper value is greater than the calculated plane area pour outline setback (using the Auto-
Separate Gap default value), so the Board to Copper value is used is used for the hatch outline setback.

Figure 87. Plane Setback Example D

CAUTION:
As the flooding operation can reduce the actual flooded area, always check plane connectivity 
after the flooding operation to be sure there are no discontinuities or starved thermals.
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Split/Mixed Plane Layers
SailWind Layout supports the creation of split and mixed plane layers. A split plane layer is a plane layer 
with one or more isolated areas of copper that have different net assignments. A mixed plane layer is a 
plane layer with one or more copper planes and any number of signal routes.

In many designs it is common to require large copper areas for voltage and ground nets. To do this, 
create an internal layer dedicated to a single net (typically power or ground nets). Although it is common 
to have one plane layer dedicated to a single net, designs with multiple voltage requirements require you 
to separate, or split, the plane layer into isolated areas. When designing very dense designs, you can use 
split/mixed plane layers for normal signal routing.

Setup  > Layer Definition  menu item includes an option for identifying split/mixed plane layers and the 
2-D drafting commands contain options for creating closed shapes to define copper planes and voids 
(areas with no copper). When you route on a layer identified as a split/mixed plane layer, clearances are 
automatically created around the trace and pin pair: the traces are actually plowed through the copper 
plane.

Copper plane operations also take full advantage of design rule-driven spacing and thermal relief 
generation. When you create copper planes with embedded traces, their spacing can be based on 
custom thermal clearances, design rule clearances or global clearances.

If you use split/mixed planes and you also route using SPECCTRA, see “SPECCTRA and Split/Mixed 
Planes”.

Creation of Split Planes
You can create more than one copper plane on a split/mixed plane layer.

There are three recommended methods to split a plane layer:

• Creating Multiple Copper Planes  — For more information, see “Creating a Copper Plane 
Manually”  on page 667, and “Creating a Copper Plane Automatically”  on page 668.

• Separating Copper Planes Automatically  — Use the Auto Plane Separate tool to split a copper 
plane that covers the whole layer or a large area into two or more copper planes. For more 
information, see “Separating Copper Planes Automatically”  on page 683.

• Creating an Embedded Copper Plane  — Embed a copper plane within another copper plane. 
For more information, see “Embedded Copper Planes”  on page 685.

Separating Copper Planes Automatically
Use the Auto Separate  button to divide a copper plane into two new copper planes. Using Auto 
Separate, you draw a path from one side of a copper plane to another side of the same plane. This path 
defines the center of the separation between the two new copper planes and divides the copper plane 
into two distinct shapes.

Restrictions and Limitations

• You must start and end the separation on the same copper plane polygon.
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Procedure
1. On the Standard Toolbar, in the Layer list, click the split/mixed plane layer.

2. Use one of the following:

• For object mode, right-click and click the Select Anything  popup menu item. Click the starting 
point of the split on a segment of the copper plane. Right-click and click Auto Separate.

• For verb mode, on the Standard Toolbar, click the Drafting Toolbar  button. On the Drafting 
toolbar, click the Auto Copper Plane Separate  button. Click to indicate a starting location 
somewhere on the perimeter of the copper plane polygon.

3. Double-click at the ending point on the copper plane outline to complete the Auto Separate 
command.

The Assign Net to Selected Polygon dialog box displays and automatically selects one of the new 
copper planes. The netnames that appear in the dialog are those that were assigned to the Split/
Mixed layer in the Layers Setup.

4. From the Choose Existing Net area, click a net to assign to the selected copper plane.

This assigns the net, deselects the copper plane, and selects the other copper plane.

Tip
No segments of the auto-separate path may be outside of the polygon or the message “All 
segments must be within the copper plane polygon” appears.

5. Click a net for the other copper plane. This assigns the net, deselects the copper plane and closes 
the dialog box.

Tip
Use the Tools  > Options  (menu item), Copper Planes (category), Hatch and Flood  on 
page 1511 (subcategory), Auto Separate Gap option to define the distance between the 
two copper planes.

6. If the message “Can't shrink polygon #1” or “Can't shrink polygon #2” appears, reduce each of the 
new polygons by one-half of the line width. An error occurred during this operation (probably self-
intersection).
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Embedded Copper Planes
Embedded copper planes enable you to create multiple copper planes on a specific layer and control how 
their constructions interact with each other.

You can embed copper planes (create a copper plane within another copper plane) using one of the 
following methods:

Creating an Embedded Copper Plane from the Outermost to the Innermost Area
Creating an Embedded Copper Plane by Prioritizing, Adding Cut Outs and Combining

Creating an Embedded Copper Plane from the 
Outermost to the Innermost Area
When creating an embedded copper plane, work from the outermost area to the innermost area to ensure 
that all areas flood as expected.

Procedure
1. Create the outermost copper plane by drawing a copper plane as described in “Creating a Copper 

Plane Manually,” and “Creating a Copper Plane Automatically.”

2. Create the inner copper plane using the Copper Plane  button on the Drafting Toolbar.

3. Continue nesting copper planes until you define all the embedded copper planes for the layer.

Tip
The embedded copper planes are automatically brought to the front so they are flooded 
correctly. To assign different flood priorities, see the “Flood and Hatch Options Dialog Box.

Creating an Embedded Copper Plane by 
Prioritizing, Adding Cut Outs and Combining
You cannot ensure correct flooding if you draw the innermost copper planes before the outermost copper 
planes. To ensure proper flooding of embedded copper planes, you can perform one of two methods: You 
can change the flooding priority of the embedded copper plane, or you can create a copper plane cut out 
around the perimeter of an embedded copper planes and then combine it with the outer copper plane.

Procedure
Choose one of the following:

• Select the embedded copper plane, right-click and click the Bring to front  popup menu item. This 
sets the embedded copper plane to a lower “Flood priority”, ensuring it floods before the outer copper 
plane.

• Alternatively, perform the following steps:
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i. Create a copper plane cut out on the outside perimeter of all embedded copper planes. (For more 
information, see Creating a Copper Plane Cut Out.)

ii. Select the copper plane cut out polygon shape.

iii. Press the Ctrl key and select the next outer copper plane.

iv. Right-click and click the Combine  popup menu item.

Creating a Copper Plane Cut Out
A copper plane cut out is a closed, non-self-intersecting polygon that defines a void within a copper plane. 
Creating a cut out involves combining the copper plane shape with the copper plane cut out shape.

Tip
You can create the cut out before the copper plane or the copper plane before the cut out.

Restrictions and Limitations

• Although it appears to create a void in the edge or outline of a copper plane when in hatch outline 
mode, a copper plane cut out does not actually alter the copper plane outline. Create the copper 
plane outline as a polygon shape to create features in the outline.

• You must put the copper plane cut out on the same layer as the copper plane.

Procedure
1. On the Drafting Toolbar, click the Copper Plane Cut Out  button.

2. Create one or more cut out areas for the copper plane.

See “Creating a Drafting Object” for more information.

3. Right-click and click Select Shapes.

Tip
If you cannot see a cut out within the copper plane shape because the shape is flooded, 
type the modeless command PO  to return the copper plane to pour outline display mode. 
You will need to re-flood the copper plane once you have combined the cut out with the 
copper plane.

4. Drag a box to group-select the copper plane and cut out(s).

Note:
Some circumstances do not allow for dragging a group selection box. Instead, use Ctrl
+click to select the copper plane and the cut out.
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5. Right-click and click the Combine  popup menu item.

6. “Flood the copper plane”  on page 780.

The copper plane area inside the cut out area is automatically removed. If you need to move 
or edit the copper plane or the cut out, be aware that any modifications you make to the copper 
plane shape (move, rotate, miter, and so on,) also affect the combined cut out(s). You may need to 
uncombine it first. For instructions, see “Uncombining Drafting Objects”  on page 643.

Results

CAUTION:
Starting with VX.2.3, copper floods to the inner edge of completed cut out outlines instead of the 
centerline. Prior to VX.2.3, the cut out would grow by half the line width since copper would flood 
to its centerline rather than the inner edge which was the intended boundary.

As you draw the cut out shape, the drawn geometry appears in a single screen pixel line.

Figure 88. Cut Out Outline While Drawing the Shape

Once completed, the outline uses a real line width but is positioned completely outside the perimeter of 
the drawn geometry to help visualize the cut out prior to flooding.
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Figure 89. Composite of Drawn and Display Outlines

Once the copper is poured, it pours to the perimeter of the drawn geometry - the inside edge of the cut 
out display outline.

Figure 90. Pour Surrounding Cut Out Geometry

Assigning Copper Plane Thermal Attributes
A thermal setting is assigned to all pad stacks in the design automatically.
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Use the Plane Thermal check box in the Pin Properties  on page 1632, Via Properties  on page 1779, 
and Jumper Pin Properties  on page 1422 dialog boxes to determine whether the pad stack is an eligible 
thermal candidate. Turn the Plane Thermal check box off if you do not want any type of thermal relief on 
any layer of the pad stack.

For more information, see “Generating Thermals”.

Related Topics
Control the Display of Thermals in Copper Planes

Discarding Copper Plane Data on Save
If desired, you can discard copper plane data and save only the plane polygons when you save the 
design file.

Procedure
1. Click the Tools  > Options  menu item, Copper Planes  (category), Hatch and Flood 

(subcategory).

2. In the Save to PCB File area, select the “Copper Plane polygon outlines” option and click OK.

3. Click the Tools  > Copper Plane Manager  menu item to flood the copper plane  on page 780.

4. Save the design.

The “Discarding Copper Plane Data Dialog Box”  on page 1314 appears.

5. Click Proceed  to save only the copper plane polygons. Click Save All  to save all copper plane 
data and change the option for future saves.

Display of Connections for Pads Connected to 
a Copper Plane
You can hide the connection lines (ratsnest or unroute connections) of nets assigned to a copper plane. 
Plane nets are typically power or ground nets; hiding them can help to clear the design space and reduce 
the connections to those that require more difficult routing.

Plane net connections can be made by through-hole pins connecting directly to the copper plane, or 
through fanout (short trace ending with a via) connections. These nets do not usually require long traces 
and are often not important in the strategic placement of the part - unless the copper plane to which they 
are attached is only in a certain area of the board. You can use the View Nets dialog box to hide the 
unroute connections of any or all nets in the design.

For more information, see “View Nets Dialog Box”.
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Chapter 32
Routing The Design

Read the topics that follow to learn more about routing connections in the design.

Routing Setup Considerations
Route and Unroute Protection
Selecting Routing Objects
Routing Tools
Design Routing Visibility Options
Routing To a Copper Shape
Routing From a Copper Shape
End a Trace on a Different Net
Vias
Teardrops
Tacks
Jumpers
Operations While Routing
Refined Object Selection
Operations After Routing
High Speed and RF Routing Features
Properties of Routing Objects
Troubleshooting Constraints While Routing
Clearance and Checking After Routing

Routing Setup Considerations
Consider certain SailWind Layout setup options before you begin routing your design.

• Angle Modes

• Starting Layer for Routing

• Via Types

• Via Modes

• Trace Width

• Length Minimization

• Routing Colors
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• Display of Trace Width

• Route and Unroute Protection

Angle Modes
Angle modes constrain the trace angle as you route the design and also impact the entry into pads. All 
routing modes are subject to the angle constraints for pad entry that you set in the Line/Trace area in 
the Design category of the Options dialog box  on page 1503. As shown in the table below, the routing 
modes are Orthogonal, Diagonal, and Any Angle. The modes determine how a trace follows the cursor 
from corner to corner and enters a pad on completion. To set these modes quickly type the AO, AD, or 
AA modeless commands  on page 83. All angle modes are constrained by the grid size if “Snap to grid” is 
enabled for the “Design grid” in the Grids options  on page 1537. The Status dialog box  on page 1733 is 
a useful tool for easy access to toggling the Snap to grid feature.

Table  111. Angle Modes

Mode Description

Orthogonal (AO) Prevents you from entering diagonal lines and 45-degree corners.

Diagonal (AD) Limits you to 45- and 90-degree angles on the grid.

Any Angle (AA) Allows placing routes at any angle.

Starting Layer for Routing
To set the current routing layer before you start routing, select the layer from the Layer list on the 
Standard Toolbar. A layer's current Routing Direction setting appears next to its entry in the Layer list. 
When you select a connection and select a routing mode, the route begins on that layer.

When you end a route on a layer different from where you began it, the layer you ended on becomes the 
active layer and appears in the Layer list. The next connection you select starts on this active layer. You 
can set a different active layer by using the list or by using the L modeless command  on page 83: type L; 
type the Layer number, and press the Enter key.

Via Types
A via is a drilled and plated hole used to connect copper objects on different layers of a printed circuit 
board.

In general, there are two types of vias:

• Through-hole vias  — Vias that are drilled through every layer of the board.

• Partial vias  — Vias drilled through a select number of layers. Partial vias include:

◦ Blind vias  — Vias that pass through an outer layer and connect to an inner layer.

◦ Buried vias  — A partial via that passes through only the inner layers.

Vias have a variety of uses in a layout design:
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• In Routing  — The most common use for vias is in routing traces, to continue the connectivity 
of traces to other layers. When you add a via during routing, SailWind Layout connects it to the 
trace and considers it a routing via.

• In stitching and shielding  — Vias used aside from routing are sometimes called free vias 
because they can be added anywhere in the design.

Free vias are more often called stitching vias because when added to a design, they may 
resemble a row or pattern of stitches. In addition, they are often used to “stitch together” copper 
to a plane. For example, you might add vias to a small copper area to give it more numerous 
connections to a ground plane, insuring a solid connection.

When you add these vias, the Stitching property is enabled, which distinguishes them from 
routing vias.

There are several methods you can use to place stitching vias in a layout design:

◦ Add single vias repetitively. Vias appear on your cursor, ready to be placed. For instructions, 
see “Adding Stitching Vias”.

◦ Surround a net, pin-pair, or copper area with vias to act as a via shield (Add Via Shield 
command). For example, you might place a via shield around a pin-pair to create an RF 
trough. For instructions, see “Adding a Via Shield”.

◦ Stitch a copper or copper hatch shape with a pattern of vias (Via Stitch  command). There are 
two modes for stitching the patterns:

• You can fill the shape with vias. For instructions, see “Filling a Shape with a Pattern of 
Vias”.

• You can also add vias inside the perimeter of the shape. For instructions, see “Placing 
Vias Inside the Perimeter of a Shape”.

Via Modes
Use the Vias Dialog Box  to determine what kind of via to install when you change levels while routing. 
Use the V modeless command  on page 83 to open the dialog box.

The table below lists the via routing modes. To set the via type quickly, use the VA, VP, or VT modeless 
commands  on page 83.

Table  112. Via Routing Modes

Mode Description

Automatic (VA) SailWind Layout chooses from all vias, through or partial, that can 
handle the particular layer change. If SailWind Layout finds partial vias 
dedicated to the layer change, it chooses from them even if the via is 
not one that is specifically selected in the Vias dialog box. If SailWind 
Layout cannot find a dedicated partial via, it selects any through vias 
for a through or partial layer change. It then checks the Routing Rules 
Dialog Box  for vias that are allowed for the net you are routing. If more 
than one via still passes, SailWind Layout installs the one with the 
smallest drill diameter or smallest pad size. Automatic allows only vias 
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Table  112. Via Routing Modes  (continued)

Mode Description
that begin and end on the “Layer pair” setting in the Options dialog box 
> Routing  category > General subcategory  on page 1542.
To use automatic via mode, the layer pair for routing and the layer pair 
for the partial via definition must match. For example, if you have a 
partial via set up for layers 1 through 4, and the layer pair for routing is 
set for layers 1 through 8, automatic mode will not insert a via.

Partial (VP) The automatic via selection still occurs, but it is limited to the partial 
vias only.

Through (VT) The automatic via selection still occurs, but it is limited to the through 
hole vias only.

In any case, the via must not create a clearance violation according to the default clearance rules or the 
clearance rules attached to the net you are routing, whichever rule takes precedence. If On-line DRC is 
set to Prevent Errors, the layer will not change if the trace or via creates a clearance problem.

You can change an installed via to another type using the Via Properties Dialog Box. For more 
information, see the “Modifying Via Properties” topic. You can also change the via type during routing. For 
more information, see the “Changing the Via Type While Routing” topic.

Allow Vias by Net

Use the Routing Rules Dialog Box  to control which vias are eligible for which nets. This is one of the main 
criteria for the automatic via selection.

Trace Width
You can pass a value for trace width with the netname from the schematic. You can also enter or edit 
the width as a line in the schematic ASCII file for nets. If widths are assigned to nets when the netlist is 
read in, the connections automatically assume those widths when routing. If no widths are associated, 
SailWind Layout provides a default width of 12 mils for all nets. You can change the default trace width 
at any time by changing the Recommended Trace Width. For more information, see the Clearance Rules 
Dialog Box.

The recommended width is in effect unless you override it locally. For example, a net may have a width 
of 12 assigned to it, but you need a certain pin pair within the net to have a width of 10. Use the Pin Pair 
Properties Dialog Box  to assign a local trace width to the pin pair in the Trace Width box.

You can see a connection's assigned width when you select it. The width appears on the Status Dialog 
Box  on page 1733prefixed with “W:” between the pin pair and the trace-to-trace clearance.

If you have the Advanced Rules license option, you can assign different widths within a net by making the 
width assignments on the net class, pin pair, or group of pin pairs level.

Length Minimization
When you start interactive routing, the flightline to the terminating pin may jump from the pin to which it is 
connected to another pin. This on-the-fly length minimization shows that the pin indicated by the flightline 
is part of the same net and is closer to the cursor than the original terminating pin.

You can disable length minimization by setting the topology type to “protected.” In this case, the flightline 
appears but maintains its original connection. You can set this property for Net, Class, or  the Default level 
of the rules hierarchy. For more information, see the Routing Rules Dialog Box.
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Routing Colors
Use the Display Colors Setup Dialog Box  to set different colors for routed traces on different layers. You 
can also set different colors for copper and for pads on pins or vias per level. If “Active layer comes to 
front” is selected on the Global category > General subcategory of the Options dialog box  on page 1531, 
when you start a routing command on that layer, all the traces drawn in the color for the current layer 
come forward and overlap traces on other layers.

To selectively hide or display traces or connections or to display nets with specific colors, use the View 
Nets Dialog Box. For more information, see “Assigning Colors to Nets”.

Display of Trace Width
To speed scrolling, panning, and screen regeneration, you can set a minimum displayed width for all lines. 
Any line widths under this width value appear as 1-pixel centerlines.

You can set the “Minimum display width” in the Global category> General subcategory of the Options 
dialog box  on page 1531 or use the R modeless command  on page 83. Set the value to your narrowest 
line width or less to see the design's true widths.
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Route and Unroute Protection
You can set options that prevent the modification of fully routed connections or the routed portion of partial 
routes, and also unroutes at the pin pair or net level. Protection of routed traces passes bidirectionally to 
and from SailWind Router to protect critically placed routes during interactive routing, and batch routing.

The protection setting is maintained when a reuse is created or broken apart. For more information, see 
the Breaking a Reuse  topic.

Tip
In the Routing category > General subcateory  on page 1542 of the Options dialog box, select the 
Show Protection check box to display traces with an outline pattern opposite that of other traces. 
In other words, if normal traces are solid, protected traces are outlined. If in Outline View Mode, 
protected traces are solid.

Protecting Pin Pair Trace Segments
Protecting Entire Nets
Protecting Unroutes in a Pin Pair
Protecting Unroutes in a Net

Protecting Pin Pair Trace Segments
You can protect or prevent modification of fully routed connections or the routed portion of pin pairs.

Procedure
1. Select a trace segment or unroute.

2. Right-click and click the Select Pin Pair  popup menu item.

3. Right-click and click the Properties  popup menu item.

4. In the Pin Pair Properties Dialog Box, select the Protect Routes check box.

5. Click OK.

Protecting Entire Nets
You can protect or prevent the modification of fully routed connections or the routed portion of nets.

Procedure
1. Select a trace segment or unroute.

2. Right-click and click the Select Net  popup menu item

3. Right-click and click the Properties  popup menu item.
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Protecting Unroutes in a Pin Pair

4. In the Net Properties dialog box  on page 1487, select the Protect Routes check box.

5. Click OK.

Protecting Unroutes in a Pin Pair
You can protect or prevent the modification of fully unrouted connections and the unrouted portion 
of partial routes of pin pairs. Protecting unroutes between pin pairs prevents routing of the protected 
connections.

Restrictions and Limitations
You cannot protect the unrouted portion of a partial route unless you first protect the routed portion.

Procedure
1. Select an unroute.

2. Right-click and click the Properties  popup menu item. The Pin Pair Properties Dialog Box  opens.

3. To protect a fully unrouted pin pair, select the Protect Unroutes check box. If the pin pair contains 
partial routes, this option is unavailable. To protect the unrouted portion of a partially routed pin 
pair, select the Protect Routes check box and then you can select the Protect Unroutes check box.

4. Click OK.

Protecting Unroutes in a Net
You can protect or prevent the modification of fully unrouted connections and the unrouted portion of 
partial routes in nets. Protecting unroutes in a net prevents routing of the protected connections.

Restrictions and Limitations
You cannot protect the unrouted portion of a partial route  on page 1846 unless you first protect the routed 
portion.

Procedure
1. Select an unroute.

2. Right-click and click the Select Net  popup menu item.

3. Right-click and click the Properties  popup menu item. The Net Properties dialog box  on 
page 1487 opens.

4. To protect a fully unrouted net, select the Protect Unroutes check box. If the net contains partial 
routes, this option is unavailable. To protect the unrouted portion of a partially routed net, select the 
Protect Routes check box and then you can select the Protect Unroutes check box.

5. Click OK.
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Selecting Routing Objects
Select one of several route objects before you begin routing. You can confirm what you have selected in 
the design.

Procedure
1. With nothing selected, right-click and either choose one of the selection presets or click the Filter 

popup menu item and then select specific routing objects for selection. For more information, see 
“The Selection Filter.”

2. Click one of the following objects:

• Connections  — if there is a color assigned to Connections in the Display Colors dialog box, 
you can toggle the display of unrouted connections using the Z U modeless command  on 
page 83. When you select a connection, right-click and click the Select Net  popup menu item to 
select the entire net.

• Pins  — for rectangular and oval pins, or pads, click in the center of the object or use area 
select. The trace begins on the active layer.

• Traces  — a tack appears at the starting point of routing.

• Vias  — the trace begins on the active layer.

• Tacks  — if SailWind Layout placed the tack, the tack is attached to the trace and you must 
select the trace. The layer on which the trace with the tack exists is the active layer.

Results
To confirm basic information for a selected object, you can open the status window by pressing Ctrl
+Alt+S. For more complete information about a specific object, select it and then right-click and click 
Properties.

Use Transparent Mode (T modeless command  on page 83) to view obstacles that may lie under traces on 
the current active layer.

For a visual aid set your dot grid to the same spacing as your routing grid. Use the GD modeless 
command and the grid value to do this. You can route on the polar grid as well.

Related Topics
Typing Modeless Commands
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Routing Tools
SailWind Layout provides multiple routing tools that each have their own special uses.

Tip
As an alternative, you can use the more powerful interactive and auto-routing capabilities of 
SailWind Router to route your design. Set up a routing strategy and options; indicate whether 
to autoroute with SailWind Router in the background or foreground. For more information, see 
Autoroute using SailWind Router  on page 776.

Table  113. Routing Tools

Topic Description

Routing Manually With the Add Route button on the Design Toolbar, click to indicate each 
corner in the trace. This type of routing works in any DRC mode.

Routing Dynamically The Dynamic Route tool is an interactive autorouter that follows the 
direction of your pointer as you move it, seeking optimal paths and 
installing corners as the trace progresses. Dynamic Routing is available 
only in “Prevent errors” On-line DRC mode.

Routing with the Single Layer 
Pin-to-Pin Autorouter

The Auto Route tools is a single layer, pin-to-pin autorouter that 
automatically adds traces to a selected connection or pin pair. Existing 
impeding traces are shoved when possible. Auto Routing is available 
only in “Prevent errors” On-line DRC mode.

Bus Router The bus router is a dynamic routing tool that creates buses. Use the bus 
router to quickly route data lines, memory arrays, or similar connections 
where several routes need to flow together from one part to another or 
to a set of parts.

Routing Buses The Bus Route tool is a dynamic router that creates data lines, memory 
arrays, or similar connections where several routes need to flow 
together from one set of parts to another. Bus Routing is available only 
in “Prevent errors” On-line DRC mode.

Routing Manually
With the Add Route  button on the Design Toolbar, click to indicate each corner in the trace. This type of 
routing works in any DRC mode.

You can add arcs, miters, and vias while a trace is in progress or after it is completed.

Prerequisites

• Set the routing direction  on page 1441 for all layers.

• Set your grids  on page 1537: design, via, and display.

• Set your design rules  on page 412 and enable DRC  on page 461.
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Procedure
1. On the Design Toolbar, click the Add Route  button.

Tip
You can set the Add Route command to start automatically when you double-click an 
unrouted path (connection). In the Options dialog box, Routing category > General 
subcategory  on page 1542, in the Unrouted path double click area, select the Add Route 
check box.

2. Select an object  on page 698 to route. The trace begins on the layer on which the object resides. 
If the object is on multiple layers, for example, a through-hole pin or via, the trace begins on the 
“active layer”  on page 1808. When you start routing from a trace, a tack  on page 1864 appears at 
the selection point.

3. Use the pointer to move the end of the trace you are drawing from grid point to grid point. The 
trace can move in one of the three Angle Modes: Orthogonal, Diagonal, or Any Angle. See the 
Line/Trace Angle setting in the “Options Dialog Box, Design Category.”

Tip
As you route, the “guard band”  on page 1832 appears whenever the head of the trace 
meets a clearance obstacle that it cannot shove. With design rules in prevent mode, you 
cannot complete the trace without changing the clearance rules or removing the obstacle.

4. Click to indicate a corner. To remove unwanted corners, press the Backspace key to remove the 
last corner and make the previous segment active.

5. Right-click and click the Add via  popup menu item to change layers. For more information, see 
“Adding a Via While Routing.”

Tip
Use Transparent Mode, T modeless command  on page 83, to view obstacles that may lie 
under traces on the active layer.

6. Proceed to your destination until you see the target  on page 1854 shape over a pad, trace, or via.

7. Click to complete the trace.

Results
If you disabled on-link design rule checking at any time when routing with the Add Route command, you 
should check the design for clearance violations. For instructions, see “Running a Design Check.”

Routing Dynamically
The Dynamic Route tool is an interactive autorouter that follows the direction of your pointer as you move 
it, seeking optimal paths and installing corners as the trace progresses. Dynamic Routing is available only 
in “Prevent errors” On-line DRC mode.

The Dynamic Route tool is a gridless, shape-based router. If the routing grid is set at less than clearance 
values, the Dynamic Route tool uses the clearance settings to decide the path.
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Because corners install automatically, you quickly route a selected connection by pulling the head of the 
trace through obstacles with the cursor, guiding the path you want to use. Although you can, you do not 
have to manually install corners. Established traces move out of the way to make room for a path you are 
routing, providing there is room to move without creating clearance violations.

Prerequisites

• Set your design rules  on page 412

• Set the routing direction  on page 1441 for all layers. Each layer has a preferred Routing 
Direction. Route on a layer that is set in the direction you need. For more information see “Layers 
Setup Dialog Box.”

• Set your grids  on page 1537: design, via, and display.

Procedure
1. Type the drp modeless command  on page 83 and press the Enter key to enable the online design 

rule checking Prevent mode and the Dynamic Route  button. For more information, see “Turning 
on Design Rule Checking”  on page 461 and “Design Rule Checking.”

2. On the Design Toolbar, click the Dynamic Route  button.

Tip
You can set Dynamic Route to start automatically when you double-click an unrouted 
path (connection). In the Routing Options > General subcategory  on page 1542, in the 
“Unrouted path double click” area, select the Dynamic Route check box.

3. Select an object  on page 698 to route. The trace begins on the layer on which the object resides. 
If the object is on multiple layers, for example, a through-hole pin or via, the trace begins on the 
“active layer”  on page 1808. When you start routing from a trace, a tack  on page 1864 appears at 
the selection point.

4. Guide the pointer through the items you want to bypass without creating corners. To remove 
unwanted corners, slowly move the pointer back over the unwanted traces. The trace can move 
in one of the three Angle Modes: Orthogonal, Diagonal, or Any Angle. See the Line/Trace Angle 
setting in the Options dialog box Design category  on page 1503.

Tip
As you route, the guard band  on page 1832 appears whenever the head of the trace 
meets a clearance obstacle that it cannot shove. With design rules in prevent mode, you 
cannot complete the trace without changing the clearance rules or removing the obstacle.

5. Click to indicate a corner; these act as tacked corners to prevent preceding segments from moving. 
To remove unwanted corners that were placed by clicking, press the Backspace key to remove the 
last corner and make the previous segment active.

6. Right-click and click the Add via  popup menu item to change layers. For more information, see 
“Adding a Via While Routing.”
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Tip
Use Transparent Mode, T modeless command  on page 83, to view obstacles that may lie 
under traces on the active layer.

7. Proceed to your destination until you see the target  on page 1854 shape over a pad, trace, or via.

8. Click to complete the trace.

Related Topics
Rerouting with Sketch Route

Routing with the Single Layer Pin-to-Pin Autorouter
The Auto Route tools is a single layer, pin-to-pin autorouter that automatically adds traces to a selected 
connection or pin pair. Existing impeding traces are shoved when possible. Auto Routing is available only 
in “Prevent errors” On-line DRC mode.

Restrictions and Limitations

• The auto router operates on one layer only; it will not add vias.

• The auto router follows only the current design grid.

• Each layer has a preferred routing direction, the auto router works only in the preferred routing 
direction. For more information, see “Layers Setup Dialog Box”.

Prerequisites
Set your grids  on page 1537: design and display.

Procedure
1. Type the drp modeless command  on page 83 and press the Enter key to enable the online design 

rule checking Prevent mode and the Auto Route  button. For more information, see “Turning on 
Design Rule Checking” and “Design Rule Checking”.

2. To improve route completion results, click the Tools  > Length Minimization  menu item. The Auto 
Route tool follows the unrouted connections to add traces. If you run Length Minimization, you can 
provide shorter and more direct paths for the Auto Route tool to follow.

3. On the Design Toolbar, click Auto Route.

4. Select an object  on page 698 to route.

Results
The router makes three attempts to find a path, shoving existing traces in the process to create new 
channels for the route. If the router can't complete the route, the routine aborts and it leaves the unrouted 
connection.
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Bus Router
The bus router is a dynamic routing tool that creates buses. Use the bus router to quickly route data 
lines, memory arrays, or similar connections where several routes need to flow together from one part to 
another or to a set of parts.

Tip
You need the Dynamic Route Editing (DRE) license option to use the bus router.

To use the bus router, identify multiple pin pairs to route and then place one route. This route acts as a 
guide route. The other routes, called follow routes, are based on the established path of the guide route. 
The bus router creates the guide route using the same automatic corner creation and trace shoving as the 
Dynamic Route tool.

To take full advantage of the bus router’s automatic routing features, make sure selected pin pairs are 
adjacent to each other at both ends of the connection and that connections do not cross. Selecting pins 
with connections that cross each other invokes a manual bus route mode where you dynamically route 
each connection in sequence. For more information, see the Routing Buses  topic.

Selection Criteria for Bus Routing
The bus router creates routes from selected pins, vias, and tacks. You can set the Selection Filter to 
select only these objects. You can also right-click and click the Select Pins/Vias/Tacks popup menu item 
when nothing in the work area is selected. The bus router does not work if you select connections or 
traces.

While selected pins are the most commonly used objects for bus routing, adding selected vias and tacks 
lets you route a portion of a bus, end it, and then begin routing again.

Selection Rules

The following rules govern selection for bus routing:

• Select at least two objects. This can be a combination of pins, vias, and tacks.

• Selected pins can have through-hole or surface mount pads. Selected surface mount pads must 
exist on the same layer.

• Selected pins must all belong to the same part.

• Selected objects must have assigned nets.

• Nets to which the selected objects are assigned cannot be assigned to a plane layer.

• Selected vias or tacks must be attached to a dangling route.

Object Filtering

When you start the bus router, the following are automatically cleared:
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• Pin selections on multiple parts. The part with the most selected pins remains selected and pins 
belonging to other parts are deselected.

• If two or more parts have the same number of selected pins, the part added to the design is 
chosen.

• Pins assigned to a plane net.

• One of two objects if they belong to the same net.

Bus Route and the Active Layer Setting
When you select surface mount pads or tacks at the ends of a trace, the layer on which these objects 
exist is detected and the layer is automatically set as the active routing layer.

Tip
If a selected pin has a layer restriction on the active layer, it is deselected.

Bus Route Tips for Adding Corners
While bus routing, you can cycle through all of the connections in the bus to use a different connection for 
the guide route.

• Keep guide routes as short as possible — Long guide routes can be difficult for the bus router to 
resolve, so indicate corners for bus turns as often as possible. If a Bus Route failure message 
appears on the status bar, press the Backspace key to undo the bus to the last indicated position. 
Then insert the corner at a different location.

• Switch the guide properly — Proper control of the guide route is necessary for successful bus 
routing. The guide route should be internal when you indicate a corner. If you use an external 
guide route to create a corner, the internal follow routes shrink to make a turn, as long as there is 
sufficient space.

Via Pattern Mode
You can choose from five via patterns when you add vias to a bus. The chosen via pattern is used until 
you choose a different pattern or exit the program. The available via patterns are:

Parallel

Vias are added in a column, parallel to the direction in which the bus is traveling. Parallel is the default via 
pattern (Figure 91). If the guide route is one of the middle routes, the remaining routes adjust on either 
side of the pattern (Figure 92).
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Figure 91. Routing when Via Pattern is Parallel to Bus Direction

Figure 92. Parallel Vias from Middle Guide Route

Perpendicular

Vias are added in a row, perpendicular to the direction in which the bus is traveling. When the guide route 
is one of the middle routes, the remaining routes adjust on either side of the pattern (Figure 93).

Figure 93. Routing when Via Pattern is Perpendicular to Bus Direction

Staggered

Vias are added in staggered rows to minimize space requirements. If the guide route is one of the middle 
routes, the remaining routes adjust on either side of the pattern (Figure 94).
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Figure 94. Routing when Via Pattern is Staggered

Minus 45 Degrees

Vias are added in a diagonal, at a negative 45-degree angle to the direction in which the bus is traveling. 
If the guide route is one of the middle routes, the remaining routes adjust on either side of the pattern 
(Figure 95).

Figure 95. Routing when Via Pattern is Minus 45 Degrees

Plus 45 Degrees

Vias are added in a diagonal, at a positive 45-degree angle to the direction in which the bus is traveling 
(Figure 96).

Figure 96. Routing when Via Pattern is Plus 45 Degrees

Related Topics
Routing Buses
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Routing Buses
The Bus Route tool is a dynamic router that creates data lines, memory arrays, or similar connections 
where several routes need to flow together from one set of parts to another. Bus Routing is available only 
in “Prevent errors” On-line DRC mode.

Prerequisites

• Set your grids  on page 1537: design, via, and display.

• Set the routing direction  on page 1441 for all layers. Each layer has a preferred routing direction, 
be sure to route on a layer that is set in the direction you need. For more information, see “Layers 
Setup Dialog Box”.

• Set your design rules  on page 412.

Procedure
1. Type the drp modeless command  on page 83 and press the Enter key to enable the online design 

rule checking Prevent mode and the Bus Route  button. For more information, see “Turning on 
Design Rule Checking” and “Design Rule Checking”  on page 410.

CAUTION:
If the Smooth bus route traces option  on page 1542 is enabled, the Smooth  on page 1860
command is applied to all Bus Route traces once they are complete.

2. Design Toolbar  button > Bus Route  button.

You can also activate the bus route mode from the shortcut menu or the toolbar after you have 
selected the objects for routing in the design.

3. Select multiple objects to route by holding the mouse button down and dragging a selection 
rectangle around them.

For example, draw a selection rectangle around a group of pins whose connections terminate 
on the same component. A route segment for the first connection, or guide route  on page 1832, 
attaches to the pointer (and follows pointer movement).

4. To use a different connection for the guide route, right-click and click the Next Guide  (or Previous 
Guide) popup menu item to cycle through all of the connections.

Tip
For a list of all Bus Routing keyboard shortcuts see the “Keyboard Shortcuts for Routing 
Operations  on page 100” table.

5. As you move the pointer, you route in a dynamic route mode where corners are added 
automatically. The trace can move in one of the three Angle Modes: Orthogonal, Diagonal, or Any 
Angle. For more information, see the Line/Trace Angle setting in the Options dialog box > Design 
subcategory  on page 1503.
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Tip
For best results, click to lock down a corner and use the inside connection as the guide 
since the guide does not take into account space required by the follow routes to turn 
around obstacles. After you indicate a corner, the guide route is reattached to the pointer.

6. To add a corner to the guide route only, right-click and click Add Corner to Guide  (or Alt+Click).

The follow routes follow the guide route after you indicate the next corner. The other bus 
connections, or follow routes  on page 1829, are routed following the guide route's path only 
after you add a corner or a via, end a trace, or complete the connection. If the bus router cannot 
create follow routes automatically, it switches to a manual bus route mode where you create each 
corner interactively. The bus router analyzes the new route and routes the other connections if 
possible, or it returns to manual mode. In manual mode, entering corners is the same as when 
you route dynamically  on page 700. When you complete a connection in manual mode, the next 
connection becomes the new guide route.

The follow routes pattern is based on the direction of the last segment added for the guide route. 
For example, if the last guide route segment is horizontal, then all follow routes are added as 
horizontal with a vertical set of end points.

Tip
The spacing of the routes is constrained by trace to trace clearances and snaps to the 
Design grid regardless of the snap to grid setting. You can vary the results of the bus 
routes by changing the grid spacing. For example, set the x and y coordinates of the grid to 
zero and then try 10.

7. To change layers for all connections at once:

a. Right-click, point to the Via Pattern Mode  popup menu item, then click the pattern you want.

b. Move the pointer to where you want to add the via pattern.

c. Right-click and click the Add Vias  popup menu item.

If DRC violations are detected, the message “Bus Router failed. Add vias for the current 
connection manually” appears on the Status Bar. Try Add Vias again allowing more room for 
the via placement using the current pattern. Otherwise, proceed to the next step to add the vias 
one at a time.

The spacing between vias is based on the via size, the via grid, and the widths and clearances 
of the traces.

d. If the via pattern you just added is not quite right, you can right-click and click Cycle Via 
Pattern  to see if a different pattern will improve placement of the vias.

Patterns that do not fit into the current area are skipped and next pattern is used. The Cycle 
Via Pattern menu item is only available if Add Vias or Add Via to Guide was the last command 
used. For more information, see “Via Pattern Mode  on page 703.”

8. If Add Vias failed, change the layers one connection at a time:
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a. Move the pointer to where you want to add the via.

b. Right-click and click the Add Via to Guide  popup menu item. A via is added to the current 
guide route and the next connection becomes the new guide route.

The spacing between vias is based on the via size, the via grid, and the widths and clearances 
of the traces. For more information, see “Adding a Via While Routing.”

9. To end the trace short of the target (leaving a dangling connection, or ending at a via or testpoint):

a. Right-click, point to the End Via Mode  popup menu item, and then click an End mode. For 
more information, see “End Via Mode.”

b. Move the pointer to where you want to add the tack or via.

c. Right-click and click the End  popup menu item.

If DRC violations are detected, the message “Bus Router failed. End bus manually” appears 
on the Status Bar. Try ending the bus again allowing more room. Otherwise right-click and click 
the End Guide  popup menu item to end the routes individually.

The spacing between vias is based on the via size, the via grid, and the widths and clearances 
of the traces.

10. To complete the bus route, proceed to the final destination and do one of the following:

• Right-click and click the Complete  popup menu item (or double-click).

• To incrementally complete each connection in the bus, move the guide route to its final 
connection point and click. The pointer changes to a target  on page 1854 shape at the correct 
connection point. The next connection in the bus becomes the new guide route. Repeat this 
process until you route all connections.

Examples
Listed below are examples of basic bus router operations:

• Moving the pointer before indicating a corner: only the guide route appears.

• Indicating a corner point for the bus: the other bus connections or follow routes, are routed 
following the guide route's path. After you indicate a corner, the guide route is attached to the 
pointer. Continue indicating corners for the bus.
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• Bus routing in progress. For best results when adding corners, use the inside connection as the 
guide.

Related Topics
Bus Router

Via Types
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Design Routing Visibility Options
SailWind Layout provides several visibility options to make routing your connections easier. By assigning 
specific colors to nets or unrouted connections, for example, you can quickly distinguish the net in the 
design. Similarly, by hiding unrouted connections that you do not need to see, you can make the design 
less cluttered.

Assigning Colors to Nets
Highlighting a Net
Changing the Visibility of All Unrouted Connections
Changing the Visibility of Selective Unrouted Connections
Viewing Protected Routes with Outline Mode

Assigning Colors to Nets
You can assign colors to pads, vias, and unrouted connections of a specific net. By default, pads, vias 
and unrouted connections assume the color given to them in the Display Colors dialog box. For example, 
assign a color to a plane net after placement. With all plane net pads appearing in a specific color, you 
can locate them quicker for fanning out to the plane layer.

There are many options available for net color assignment. See the table below for instructions.

Table  114. Available options for net color assignments

# Option Operation

1 Use the View Nets Dialog Box 1. Click the View  > Nets  menu item.

2. In the View Nets Dialog Box, scroll through the Net List 
on the left and add one or more nets to which you want to 
assign color to the View List.

3. In the View List, select one or more nets.

You cannot assign a color to Default.

4. Select the Enable Color by Net  check box.

5. In the Color by Net area, select a color for the net.

This color palette comes from the Display Colors Setup 
Dialog Box. If you select the “None” option, however, the 
net does not have a color assignment and it appears as it 
normally does. All nets are assigned None by default.

6. Click OK.

The color change takes place.

2 Use the Assign Color to Net 
Dialog Box

It works in both Verb Mode and Object Mode. Here takes 
operations in Verb Mode as example.
1. With nothing selected, right click, and click the Assign 

Color to Net  popup menu item.

2. In the View Nets Dialog Box, select a color you want from 
the color palette.
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Table  114. Available options for net color assignments  (continued)

# Option Operation

If you select the “None” option, however, the net does 
not have a color assignment and it appears as it normally 
does.

3. Select a net you want to color in the workspace.

To check if the color change takes place, click at the blank 
space.

 Tip
Colors of those nets locked in the View Nets Dialog 
Box  remain unchanged.

4. Optionally:
• Repeat Steps 2-3 for other nets that require individual 

colors.

• Click Default All  to return net colors to their default 
assignments (as defined in the Display Colors Setup 
Dialog Box), except those nets locked in the View Nets 
Dialog Box.

• Click More  to open the Assign Color to Netlist Dialog 
Box, where you can assign color for nets in a batch.

3 Use the Assign Color to 
Netlist Dialog Box

1. In the Assign Color to Netlist Dialog Box, add net(s) for 
which you want to assign color from the Net List to the 
Selected list.

You can use wildcards or expressions  for filter, and 
Ctrl/Shit for multiple selections.

2. In the color palette, select a color for all nets in the 
Selected list.

3. Click Apply  to make the color assignment effective.
 Tip
Colors of those nets locked in the View Nets Dialog 
Box  remain unchanged.

4. (Optional) To assign individual colors for other nets, you 
can:

• Click Remove all  to clear the Selected list, and then 
repeat Steps 1-3.

• Click Return  to use the Assign Color to Net Dialog Box 
for color assignment.

Highlighting a Net
Highlight a net to quickly locate it on a dense board.
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Changing the Visibility of All Unrouted Connections

Tip
To search for and select several nets, use the Find dialog box  on page 1378. Finding by nets 
finds and either highlights or selects nets.

Procedure
Type the N modeless command  on page 83, type a space after the N modeless command, type the 
netname and press the Enter key. As an alternative, you can select a net in the design by clicking on an 
unrouted connection, or pad and then click the Edit  > Highlight  menu item.

Results
The net appears in the Highlight color that is specified in the Display Colors  on page 1318. The net is not 
selected: you have to select a segment if you intend to route it. The highlighting turns off when you select 
the net or a pin pair and click the Edit  > Unhighlight  menu item.

Changing the Visibility of All Unrouted Connections
You can turn the display of all the unrouted connections (also called the “ratsnest”) on and off by display 
color or commands.

By color:

1. Click the Setup  > Display Colors  menu item.

2. In the Display Colors Setup Dialog Box, set the Connection  color tile:

◦ To the background color to make the connections invisible.

◦ To a specific color from the color palette to distinguish it in the design.

By commands:

Available options are shown as below, which take no effect on nets that are locked in the View Nets 
Dialog Box.

Table  115.  Available options for ratsnest visibility control

Option Operation

Function buttons Click the following buttons on the Standard Toolbar:

• : Show All Connection

• : Hide All Connection

Modeless commands Use modeless commands: VUA  for Show All Connection; HUA  for Hide 
All Connection.

Shortcuts Use the shortcuts for Show All Connection  and Hide All Connection 
as defined in the Customize Dialog Box, Keyboard and Mouse Tab, 
where these two commands are under the list item "Standard Toolbar".
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Changing the Visibility of Selective Unrouted 
Connections
You can also turn the display of selective unrouted connections on and off by display color or commands.

Table  116.  Available options

Option Operation

By display color 1. Click the View  > Nets  menu item.

2. In the View Nets  dialog box, select a net and move it to the View List to 
change its visibility.

Use this dialog box to hide or show ratsnest connections by netname. You 
can also select nets by net class, nets with rules, and plane net status. 
For example, it is often convenient to hide the unrouted connections of the 
ground net or other plane nets.

3. With the net or nets selected in the View List:
• To hide the net’s unrouted connections, in the View Unroutes Details 

area, click None.
 CAUTION:
When View Nets hides unrouted connections, neither Verify Design 
nor Find can see them. Be sure View Nets does not disable nets or 
traces you want to search for or select.

• To give the net’s unrouted connections a custom color, select a color in 
the palette. Pads, vias and unrouted connections take on the custom 
color.

By commands 1. Select one or more design items with net property from the workspace or the 
Project Explorer.

2. Apply commands to the selected objects by one of the following means:
 Note:
These comamnds are only available for design items with net property.

• Right-click menu: Right click, and click the Show Connection  or Hide 
Connection  popup menu item.

 Note:
To apply commands to multiple objects selected in the Project 
Explorer, you must right click at the blank space. Otherwise, it only 
works on the object at the cursor position on click.

• Use modeless commands: VUS  for Show Connection; HUS  for Hide 
Connection.

• Use the shortcuts for commands Show Connection  and Hide 
Connection  as defined in the Customize Dialog Box, Keyboard and 
Mouse Tab, where these two commands are under the list item "View".
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Viewing Protected Routes with Outline Mode
If your design contains protected routes, you can set them to display with the opposite outline pattern of 
other routes. In other words, if normal routes appear solid, protected routes have outlines, and so forth.

For more information, see “Route and Unroute Protection”  on page 696.

Procedure
1. Click the Tools  > Options  menu item.

2. In the Options dialog box, click the Routing category > General subcategory  on page 1542.

3. Select the Show Protection check box.

4. Click OK.

Routing To a Copper Shape
Unlike routing to a pad where you must route to the center of the pad to complete the connection, you 
only need to route to the edge of the copper.

Restrictions and Limitations
While in ECO - Add Route mode, you cannot terminate a newly created connection on copper. The 
connection must go between two component pins.

Prerequisites

• You must assign a net to the copper shape before you can route to it. For more information, see 
“Assigning a Net to a Copper Shape or Copper Plane”  on page 665.

• The net you are routing must be the same as the net assigned to the copper.

• If you are routing to pin copper, the copper must be associated to the pin in the decal in order to 
router to it. For more information, see “Associating Copper with Terminals”.

Procedure
1. As you are routing a net, guide the trace to the copper.

2. Choose an end point inside the perimeter of the copper. A target  on page 1854-like shape 
indicates that you have connected with the copper.

If you are routing on another layer, you can end the trace with a via into the copper. For more 
information, see “End Via Mode”.

3. Click to finish.

Related Topics
Routing From a Copper Shape
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Routing From a Copper Shape
There are limitations when routing from the copper. You must always select an area where a connection 
(unroute) emanates from the copper to start the routing process.

Because of this limitation, the recommended practice is to route to the copper  on page 715 whenever 
possible for more flexible connection points.

Prerequisites

• You must assign a net to the copper shape before you can route to it. For more information, see 
“Assigning a Net to a Copper Shape or Copper Plane”  on page 665.

• The net you are routing must be the same as the net assigned to the copper.

• If you are routing to pin copper, the copper must be associated to the pin in the decal in order to 
router to it. For more information, see “Associating Copper with Terminals”.

Procedure
1. While in a routing mode, locate the point where a connection (unroute) is exiting the copper.

2. Click to begin the trace.

Tip
You can route and add a via within the copper if you need to immediately change layers.

3. Route your trace.

Results
After routing, the ratsnest connection continues to exist in the design between the copper and other 
unrouted objects of that net. The connection disappears after all objects associated with that net are 
connected.

Related Topics
Routing To a Copper Shape

End a Trace on a Different Net
You can end a trace on a segment with a different netname, but you must use the Add Route button on 
the ECO Toolbar.

For more information, see the “Adding a Route in ECO Mode” topic.
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Vias
Read the topics that follow to learn more about using vias when routing.

For topics covering the design of vias, see “Via Setup”.

You can find more information about using vias to change layers in “Layer Changes While Routing”.

Via Types
Adding Vias in Pads
End Via Mode
The Layer Pair

Via Types
If you have different types of vias available to a net, you can switch between via modes to help select 
which via to use when routing.

You can use the V, VA, VP, VT modeless commands  on page 83 as shortcuts to specify the Via Mode in 
the Vias dialog box  on page 1782when you add a via or a virtual pin. When you choose a via type, it is 
used with the Add Via, Add Via to Guide, and Add Virtual Pin commands. For procedures, see “Changing 
the Via Type While Routing”.

The via must not create a clearance violation according to the default clearance rules or the clearance 
rules attached to the net you are routing, whichever takes precedence. If you set DRC to Prevent Errors, 
a layer change will not complete if the trace, via or virtual pin creates a clearance problem.

After you install a via or virtual pin, you can change it to another via type using the Via Properties Dialog 
Box  or Virtual Pin Properties Dialog Box.

Adding Vias in Pads
You can add vias to SMD pads to avoid fanouts when there is no room for a regular fanout in the design.

Procedure
1. In the Clearance Rules Dialog Box, in the Same Net area, the SMD to Via clearance must be 0 

(zero) at the required level of the rules hierarchy to enable the via to be placed in the pad.

Tip
Also consider other via rules, such that the via cannot create a clearance violation. It must 
be allowed for the net and in drill pairs.

2. Select one or more SMD pads, right-click and click the Add Via at SMD  popup menu item.

The via is added to the center of the SMD. Component pads always overlay vias and it may be 
difficult to determine if the via is actually inside the pad. Enable “Transparent mode” with the T 
modeless command  on page 83 to see vias in pads.
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Related Topics
Connecting SMD Pads to Planes

End Via Mode
To end a trace with vias, tacks, or test points, use the commands on the End Via Mode  submenu in the 
shortcut menu.

The available modes are listed below. The selected mode is on until you select a different one or exit 
SailWind Layout.

Table  117. End Via Modes

Mode Description

End No Via Ends the connection with a tack. End No Via is the default setting.

End Via Ends the connection with a via.

End Test Point Adds a test point via. For related information, see “Placing Test 
Points”, and “Setting Test Point Properties”.

Tip
If you try to add a test point to an area defined as a test point keepout area when DRC mode is 
set to Prevent Errors, the message “Test point keepout violation” appears and the test point is not 
added.

Related Topics
Routing Buses

The Layer Pair
If you're working extensively between two layers, set them as the default layer pair, and while routing, 
right-click and click the Layer Toggle  popup menu item, or shift-click to install a via and change to the 
other layer.

Set the layer pair in the Routing category > General subcategory  on page 1542 of the Options dialog box 
or as a shortcut, use the modeless command  on page 83 PL. Separate the modeless command and each 
layer number with a space.

To change layers outside the layer pair, use the L modeless command or right-click and click the Layer 
popup menu item to specify the layer number.

Related Topics
Layer Changes While Routing
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Teardrops
A teardrop  (also referred to as a pad fillet) is typically a v-shaped copper reinforcement that you add to 
the junction where a trace enters a pad. Most PCB designs use teardrops primarily on pads that have a 
drilled hole, though there are circumstances where they may be beneficial on surface mount technology 
(SMT) pads.

When you choose to generate teardrops, they are created automatically on all traces leading into pads 
and vias. If pads and vias are not yet routed, the teardrop is added once the trace into the pad or via is 
completed. You do not add teardrops selectively, but you can remove teardrops selectively.

In the Options dialog box, use the Routing  category > General  subcategory to generate teardrops. Use 
the Teardrops  category to set options only for teardrops on new traces that you route. These settings are 
saved with the design.

Figure 97. Pads with Teardrops

Benefits of Using Teardrops
Generating Teardrops
Removing All Teardrops
Disable the Display of Teardrops
Selectively Disabling Teardrops
Teardrops in CAM
Modifying Teardrop Properties
Checking Teardrops for Errors

Benefits of Using Teardrops
Teardrops provide solutions for a number of design issues, such as improving yield, preventing acid traps, 
and reducing flex circuit stress.
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Yield Improvement
Teardrops can improve yield during the board manufacturing process when stacks of boards are drilled 
simultaneously.

A typical printed circuit board design can contain hundreds (and in some cases thousands) of drilled 
holes. If a manufacturer can drill a stack of 3 or 4 (or more) boards at the same time, they can improve 
throughput, and therefore reduce the overall cost of the board run. Unfortunately, as the height of the 
board stack increases, the potential for the drill to “wander” off of its centerline also increases. The farther 
the drill has to travel, the more potential there is for it to veer off its intended path, and produce a hole that 
is off-center on the pads of the lower board(s) in the stack. Though the variance is typically only a few 
thousandths of an inch, this small movement can cause the drill hole to become tangent to the edge of 
the pad, and if it occurs at the location where a trace connects to the pad, it can result in breakout or an 
open circuit.

Figure 98. Drilling a Stack of Boards

Adding a teardrop to the pad increases the target area around the trace-to-pad connection and can 
compensate for some amount of the drill drift. This allows the connection to be made even if the drill is 
tangent to the pad edge and encroaches on the connection area.

This technique is effective on both round and square through-hole pads.
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Figure 99. Pads with Breakouts

Acid Trap Prevention
Teardrops can reduce the potential of acid traps at the trace-to-pad junction.

The location where the trace enters the pad poses a potential for the etching solution (acid) to build up in 
the sharp corners and over-etch the junction. This can result in a slight narrowing of the trace as it enters 
the pad and potentially creating a connection that is more prone to fracturing. This over-etching can also 
slightly reduce the current handling capacity of the trace at the junction creating a potential failure point.

Adding a teardrop to the connection point eliminates the potential problem. It does not matter if the drill is 
centered or offset in the pad.

Figure 100. Acid Trap Reduction
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Stress Failure Reduction
Teardrops can reduce the potential for stress failures on flex circuits.

The location where the trace enters the pad can be subject to constant stress on a flex circuit. As the 
flex circuit is bent, it stresses this connection, and if the movement is repeated enough times, it could 
eventually cause the junction to fracture and fail.

Adding a teardrop to the connection point adds additional surface area to this potential stress point and 
greatly improves the ability of the board to withstand the effects of the repeated stress. It does not matter 
if the drill is centered or offset in the pad.

Figure 101. Stress Failure Reduction

Teardrops on SMT Pads
The same design benefits of acid trap reduction and stress fracture reduction obtained from using 
teardrops on through-hole pads can also be applied to surface mount design objects.
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Generating Teardrops

Figure 102. Teardrops on SMT Pads

Related Topics
Teardrops

Generating Teardrops
You can create teardrops on trace connections to pads and vias. If desired, you can also enable 
connections not yet routed to automatically create teardrops after they are routed.

Restrictions and Limitations

• You cannot place default-shaped teardrops on square pads.

• You cannot place teardrops on traces when a trace corner is inside the pad or via or if the 
segment is too short. Use the additional teardrop option Auto Adjust to solve this. This option is in 
the Routing  category > Teardrops  subcategory of the Options dialog box. Use Auto Adjust to set 
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a custom length and width ratio. With Auto Adjust selected, SailWind Layout attempts to adjust 
the length of the teardrop on traces where the trace corner is inside the pad or via or the segment 
is too short to contain the specified length ratio.

Procedure
1. Click the Tools  > Options  menu item.

2. In the Options dialog box, on the Routing category > General subcategory  on page 1542, select 
the Generate Teardrops check box.

3. Click OK.

Teardrops are automatically added to existing trace segments that enter or leave a pad or via or 
whenever you route that connection. Teardrops may not appear on all existing pads if the traces 
going in to the pads are not centered. Re-route the traces from the pads to the first corners to fix 
these exceptions.

Tip
If you do not want a teardrop on a specific trace you are routing, after you begin routing 
the trace, right-click and click the Ignore Teardrop  popup menu item to turn on the Ignore 
Teardrop mode. A teardrop will not appear on traces that you route until you right-click and 
click the Ignore Teardrop  popup menu item again, to turn off Ignore Teardrop mode. A 
check appears beside the command on the menu to indicate that the mode is turned on.

Results
If you have not changed the teardrop options in a previous SailWind Layout session, the Default teardrop 
shape is used for all newly routed trace connections to pads and vias. You can set more specific options 
for teardrops if you have the additional teardrop functionality using the Routing  category > Teardrops  on 
page 1546 subcategory in the Options dialog box.

Removing All Teardrops
You can delete or remove teardrops from a design by reversing the process for creating them.

Procedure
1. Click the Tools  > Options  menu item.

2. In the Options dialog box, on the Routing  category > General subcategory  on page 1542, clear 
the Generate Teardrops check box.

Disable the Display of Teardrops
You can also temporarily disable the display of teardrops without removing them from the design.

Procedure
1. Click the Tools  > Options  menu item.

2. In the Options dialog box, on the Routing  category > General subcategory  on page 1542, in the 
Parameters area, clear the Display Teardrops check box.
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Selectively Disabling Teardrops
You can turn teardrops off selectively at the pin level.

Procedure
1. Select one or more pins. To clear multiple pins, set the Selection Filter  on page 1710 to “Pins 

only”, and draw a selection rectangle to select multiple pins. As long as all the selected pins are 
teardrop-enabled, you can open the Properties dialog box to disable teardrops.

2. Right-click and click the Properties  popup menu item.

3. In the Pin Properties Dialog Box, clear the Teardrops check box.

Teardrops in CAM
When you plot teardrops, the line width you use is the same as the track width. If the teardrop is on an 
annular-shaped pad, SailWind Layout uses the difference between the outer pad radius and the inner pad 
radius as the line width if that amount is less than the track width.

Related Topics
Modifying Teardrop Properties

Teardrop Properties on Traces Dialog Box

Modifying Teardrop Properties
You can modify the teardrop shape, length ratio, and width ratio for any selected teardrop. You can 
modify teardrops individually, teardrops on all layers, or all teardrops at one time. You can also remove an 
individual teardrop from a design.

Procedure
1. Select one or more traces to which teardrops are attached. If you select in the middle of a trace 

with teardrops at each end, both teardrops are edited. Select the trace near the teardrop you want 
to modify to edit only one teardrop.

2. Right-click and click the Teardrop Properties  popup menu item.

The Teardrop Properties on Traces Dialog Box  appears.

3. Make changes and then click OK.

Results

• If you selected multiple traces and modify teardrops on those traces or apply teardrop property 
changes to multiple teardrops, only existing teardrops are modified. Newly created teardrops 
always use the settings in the Routing  category > Teardrops subcategory  on page 1546 of the 
Options dialog box.
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• If you selected Layer or All from the Apply To area, Auto Adjust changes to a third state, neither 
on nor off. This occurs because Auto Adjust reads the Auto Adjust setting for more than one trace 
and they can vary. You can still change Auto Adjust.

• You cannot preview teardrops when you select Layer or All.

Checking Teardrops for Errors
You can run a check on teardrops—using a similar method to the Verify Design dialog box—to check for 
and view teardrop errors. SailWind Layout gives the error location, layer, and a short explanation of the 
error. Start the teardrop checking process through the Routing  category > Teardrops  subcategory of the 
Options dialog box instead of the Verify Design dialog box.

Procedure
1. Click the Tools  > Options  menu item. The Options dialog box opens. You must enable teardrops 

before you can check them. On the Routing  category > General subcategory  on page 1542, 
select the Generate Teardrops check box.

2. In the Options dialog box, click the Routing  category > Teardrops subcategory  on page 1546.

3. Click the Check  button.

4. In the Check Teardrop Dialog Box, click Start  to run the check. Error results are listed in the 
Location box. Listed errors contain their (X,Y) location, layer, and error type.

5. Select an error from the list.

• In the Explanation box, view the detailed information about the error selected in the Location 
list. The explanation includes information about any conflicting object. The current error list 
remains whether the dialog box is open or closed.

• The design window pans to the area of the error (unless the Disable Panning check box is 
selected). This is more obvious if you are zoomed into your design and the marker is set to 
show up in the design. The error markers remain until you click Clear Errors, which clears the 
error markers, but does not fix the errors.

Tip
Colors must be assigned properly in the Display Colors Setup Dialog Box  in order to see 
error markers. Errors in the design area appear in the color of the Errors check boxes per 
layer of the Display Colors dialog box. When an error is selected in the Location box, the 
error in the design area appears in the “Highlight” color.

Results
You can view the current error results in your default text editor. To view the most recently run report 
results in the default text editor, click View Report. You can print or save the results from your default text 
editor.

To change the default teardrop report file name, click Report File. This opens the Save As dialog box 
where you can change the name of the report. The changed name remains the default until you change it 
again.
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Tacks
SailWind Layout generates tacks, which most commonly occur at corners where traces are routed against 
the layer direction.

You can also add Tacks  on page 1864 manually. They can even be deleted in some cases, but it is not 
recommended since it will typically remove the corner at the same time and change the path of the routed 
trace.

You can add tacks manually to lock a corner or prevent rerouting when using the dynamic route or bus 
route tool. While routing click to lock down a corner with a tack. When there are no tacks, traces can be 
shoved to allow room for another trace to be routed.

When the tack is not required for a route direction change, pressing Delete removes the corner beneath 
the tack and moves the tack to the next “U” point in the route. The Selection Filter  on page 1710 contains 
an option for tacks so you can set the filter to select only tacks. To delete a manually added tack select it 
and press the Delete key.

SailWind Layout Guide and Reference 727



Routing The Design
Jumpers  

Jumpers
Read the topics that follow to learn more about creating, adding, and modifying jumpers.

Setting Up Jumpers
Setting Up Jumper Pad Stacks
Adding Jumpers
Creating Jumper List Reports
Modifying Jumper Properties
Modifying Jumper Name Properties
Modifying Jumper Pin Properties

Setting Up Jumpers
When you add a jumper to the design, SailWind Layout uses the Default jumper. You can change the 
Default jumper settings or change the settings for a specific jumper in the design. The attributes of the 
default jumper save to the SailWindpcb.ini  file. Open the pin properties to change the setting of a specific 
pin in the design.

Use the Jumpers dialog box to set up and modify jumpers and jumper pad stacks. You can create and 
modify SMD jumpers (single layer jumpers) on the top or bottom mounting layer.

Procedure
1. Click the Setup  > Jumpers  menu item.

2. In the Jumpers Dialog Box, in the Apply to area click:

• Default  — to change the settings of the Default jumper - any new jumper added to the design. 
The settings are saved in the SailWindpcb.ini  file.

• Design  — and then select a jumper name in the Reference Name list—to change the settings 
of an existing jumper in the design.

3. Modify the jumper size settings. To modify the jumper size settings of Design Jumpers, use the 
Jumper Properties  on page 1425. In the Jumper Sizes area:

a. In the Min. Length and Max. Length boxes, type the minimum and maximum length of the 
jumper.

b. In the Jumper Sizes area, in the Increment box, type the increment, at which you can stretch 
the jumper between the minimum and maximum lengths.

4. Set up the pad stacks  on page 729.

5. In the Drill Size box type the drill size if the jumper is a through hole jumper. Type a drill size of 
zero if you want a surface mount jumper with round pads.

6. Select the Display Silk check box to display the silkscreen outline for the jumper. The outline for 
jumpers is set at 10 mils; you cannot modify this setting. To modify the Display Silk settings of 
Design Jumpers, use the Jumper Properties  on page 1425. For CAM output, you must enable 
Component Outlines for the layer on which the jumper resides before jumper outlines will plot.
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Setting Up Jumper Pad Stacks
You can set up pad stack information for jumpers or individual jumper pins.

Procedure
1. Click the Setup  > Jumpers  menu item.

2. In the Jumpers Dialog Box, in the Apply to area click:

• Default  — to change the settings of the Default jumper - any new jumper added to the design. 
The settings are saved in the SailWindpcb.ini  file.

• Design  — and then select a jumper name in the Reference Name list—to change the settings 
of an existing jumper in the design.

3. In the Pin list, select both jumper pin (All) or a pin to change. You can add individual pins of the 
jumper to the list for customizing. Use the Add  or Delete  button to maintain the Pin list.

4. In the Shape/Size/Layer list select a layer on which to make jumper pad stack changes. When 
modifying Design jumpers, you can add individual layers of the design to the list for customizing 
the design jumper. Use the Add  or Delete  button to maintain the Shape/Size/Layer list.

5. In the Parameters area, select the type of pad from the Pad Style list.

Choose from (normal) pad, thermal (pad), or antipad. You cannot create antipads on outer 
layers. When you select an outer layer (<Start> or <End>) in the Size/Shape/Layer list, Antipad 
is unavailable. You can click Use Global Defaults  to set the Thermal and Antipad shapes, of a 
layer and pin, to the default shapes specified by the design rules and the design Options > Copper 
Planes category > Thermals subcategory  on page 1514. The Use Global Defaults  button is only 
available when the Pad Style list is set to Thermal or Antipad.

Thermal and Antipad display configuration controls the size and shape of thermals and antipads 
used on split/mixed layers and CAM negative planes (for RS-274X output).

6. Select a Pad Shape.

Choose from: Round, Square, Annular, or Odd. Annular and Odd shapes are only available for the 
normal pad style. You can select the Pad Size Relative to Drill Size check box to display inner and 
outer pad values relative to the drill size.

7. In the Diameter box, type the diameter for the pad style.

Thermals require additional settings. Read “Design Rule Versus Pad Stack - Thermals and 
Antipads”  on page 797for details.

8. Square pads only: Select the Corner type and enter the Radius.

Results
You can view the effect of your pad settings in the Pad Preview display.
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Related Topics
Modifying Jumper Properties

Modifying Jumper Name Properties

Modifying Jumper Pin Properties

Adding Jumpers
You can place jumpers in a trace either while routing or after you finish routing. SailWind Layout considers 
jumper pins as vias. The space between the jumper pins does not have electrical properties. Jumper pins 
are checked for Design Rule clearances as vias.

Tip
SailWind Router can load and autoroute jumpers  on page 1835.

Restrictions and Limitations

• Jumpers do not follow the Body to Body, Default Design Rule in batch and On-line DRC.

• Jumper silkscreens are not user configurable.

• You cannot use Find to search for jumpers.

• Cluster Place ignores jumpers.

• For CAM output, you must enable Component Outlines for the layer on which the jumper resides 
before jumper silkscreen outlines will plot. The outline for jumpers is set at 10 mils; you cannot 
modify this setting.

Procedure
1. Unless you want to use the default jumper, set up a jumper:

a. Click the Setup  > Jumpers  menu item.

b. In the Jumpers Dialog Box, change the stackup of the jumper pins and the jumper size 
settings. For more information, see “Setting Up Jumpers”.

2. Start the jumper in one of the following ways:

• While routing — locate the pointer at the point where you want the first pin of the jumper to 
appear.

• On an existing trace — select the trace at the point where you want the first pin of the jumper to 
appear. As an alternative, on the Design Toolbar click Add Jumper  and then click a point on a 
trace where you want the first pin of the jumper to appear.

3. Right-click and click the Add Jumper  popup menu item. The first pin of the jumper appears.
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Creating Jumper List Reports

4. Move the mouse to stretch the jumper. You can stretch between Minimum Length and Maximum 
Length jumper settings at a preset increment. The angle mode also applies.

5. Click to complete the jumper.

• If you are adding a jumper to an existing trace, you must enter the second pin on a trace in the 
same net.

• If you added a trace while routing, regular routing continues.

Creating Jumper List Reports
You can use the Reports dialog box to create a report containing information about all jumpers in the 
design.

Procedure
1. Click the File  > Reports  menu item.

2. In the Reports Dialog Box, in the Select Report Files for Output list, select “Jumper List”.

3. Click OK. The report is written to C:\SailWind Projects\report.rep  and displayed in the default text 
editor.

Related Topics
Reports

Modifying Jumper Properties
Open the Jumper Properties to view information, change coordinates, change jumper size settings, 
control the display of the jumper outline, glue the jumper in place, or modify the pad stack and reference 
designator of the jumper.

Procedure
1. Use one of the following methods to access the Jumper Properties:

• Select a jumper pin, right-click and click the Properties  popup menu item. In the Jumper Pin 
Properties Dialog Box, click the Jumpers  button. The Jumper Properties Dialog Box  appears.

• Select the outline of a jumper, right-click and click the Properties  popup menu item.

• Click in the middle of the jumper to select it. Both jumper pins and the jumper name appears in 
the Selections color. Right-click and click the Properties  popup menu item.

• Select the jumper name and then right-click and click Properties. In the Jumper Name 
Properties Dialog Box, click the Jumper  button.

2. In the Jumper Properties Dialog Box, view properties or make changes.

3. Click OK.
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Related Topics
Modifying Jumper Name Properties

Modifying Jumper Pin Properties

Modifying Jumper Name Properties
Open the Jumper Name Properties to change the value or properties of the reference designator.

Procedure
1. Use one of the following methods to access the Jumper Name Properties:

• Select a jumper reference designator. Right-click and click the Properties  popup menu item.

• Select the jumper. Right-click and click the Properties  popup menu item. The Jumper 
Properties Dialog Box  appears. Select the name to modify from the Label list. Click the Label 
button.

2. In the Jumper Name Properties Dialog Box, view properties or make edits.

3. Click OK.

Related Topics
Modifying Jumper Pin Properties

Modifying Jumper Properties

Modifying Jumper Pin Properties
In the Jumper Pin Properties, you display jumper pin information, change the coordinates of a jumper pin, 
and activate the pin as a test point.

Procedure
1. Select the jumper pin.

2. Right-click and click the Properties  popup menu item. The Jumper Pin Properties Dialog Box 
appears.

3. View Jumper Pin properties or make changes.

4. Click OK.

Results
If you change the pad stack of a jumper pin that is a locked test point, the Warning: Test Point Locked 
dialog box  on page 995 appears.
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Modifying Jumper Pin Properties

Related Topics
Modifying Jumper Name Properties

Modifying Jumper Properties
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Operations While Routing
You can access certain operations or features while routing in SailWind Layout.

Trace Length Monitor
Activating the Trace Length Monitor
Routing Direction
Layer Selection for Starting a Trace
Adding a Via While Routing
Creating Arcs
Layer Changes While Routing
Changing the Via Type While Routing
Changing the Trace Width While Routing
Troubleshooting Routing on Another Layer
Traces Ended on Different Nets

Trace Length Monitor
The trace length monitor calculates and shows the trace length (on the status bar and near the pointer) as 
you route. When design rules for the net specify a length, then red or green text in the monitor indicates 
whether the length is within the specified rules.

• Red text indicates violations of the rule.

• Green text indicates trace lengths within the rule.

The status bar shows detailed length information.

The trace length monitor shows the routed length and the estimated total length of the net. For more 
information, see “Trace Length Monitor”.

Figure 103. The Trace Length Monitor
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Color Customization for the Trace Length Monitor
You can set the colors of the text in the monitor that indicate whether the length is within the specified 
rules. Set the colors in the SailWindpcb.ini  file. In the .ini  file, look for the [monitor] section that resembles 
the following:

[monitor]

normal = 10

norules = 15

error = 12

The numbers represent colors from the [Colormap] section of the .ini  file. To change the colors used in the 
monitor, change the numbers in the [monitor] section to a color from the [Colormap] section. Values may 
be 0-31.

Effects of Reroute and Smooth on Trace Length
During reroute operations, the trace length monitor may show a length greater that the actual final length. 
In addition, for dynamic routing, smoothing operations and pad entry corrections may be performed on 
traces after you finish routing (depending on your Options dialog box > Routing  category > General 
subcategory  on page 1542 settings). These operations may change trace length slightly.

Trace Length Monitor Reports
As mentioned, the trace length monitor shows the net length rules, the current routed length, and the 
estimated total length. The rules that are reported are net length rules. As shown in Table 118, the trace 
length monitor reports different information depending on the length rule.

Table  118. Trace Length Monitor Reports

Length Rule Information in Report

Minimum/Maximum Length 
Rules

Shows the current routed length, the total length, the minimum 
net length rule, and whether it's applied at the net or pin pair 
level of the rules hierarchy.

Matched Length Rules Shows the current routed length, the total length, and the 
matching net length rule.

Differential Pair Rules Shows the current routed length, the total estimated length, the 
minimum length rule, the maximum length rule, the gap rule, 
and whether it's a net or pin pair rule.

No Length Rules Shows the current routed length and the total estimated length.
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Activating the Trace Length Monitor
The trace length monitor calculates and shows trace length as you route. As you move the pointer and 
route traces, the routed and unrouted length of nets or pin pairs and associated rules are shown near the 
pointer and on the status bar.

The trace length monitor is available for the following commands:

• Route/Add Route

• Dynamic Route

• Move Segment

• Move Corner

• Move Via

Procedure
1. Click the Tools  > Options  menu item.

2. In the Options dialog box, on the Routing  category > General subcategory  on page 1542, select 
the Show Trace Length check box.

3. Click OK.

This turns the display of the trace length monitor on or off at the pointer only. The trace length 
always displays on the status bar.

Tip
You can also use the shortcut  on page 100 Ctrl+PageUp to turn the trace length monitor on 
or off. Turning the trace length monitor on or off does not end the current routing command; 
you can continue to route.

Related Topics
Trace Length Monitor

Routing Direction
When you start routing, SailWind Layout automatically chooses the end from which you start. If you want 
to start from the opposite end of the connection, right-click and click the Swap End  popup menu item. 
Also, at any point while you are routing, click (add a corner) to preserve what you have already routed 
and switch to the opposite end of the connection to route from the opposite direction.

Swap End is available only in Add Route  on page 699 and Dynamic Route  on page 700 modes.
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Layer Selection for Starting a Trace
When you start routing a trace, it assumes the layer of the object from which it began the connection, 
such as a pad, via, or copper area. If it starts routing from a through-hole pad or a via, you can set the 
current routing layer before you start routing.

Choose one of the following methods to set the layer before routing:

• On the Standard Toolbar, in the Layer list, choose the layer.

• Change the current layer by typing the L modeless command  on page 83, typing the layer 
number, and pressing the Enter key.

A layer's current direction setting appears next to its entry in the Layer list. You can change the layer's 
current direction setting by typing the LD modeless command.

When you select a connection and select a routing mode, the route begins on that layer. When you end a 
route on a different layer than where you began it, the layer you ended on becomes the active layer and 
appears in the Layer list box. The next connection you select starts on this active layer.

Adding a Via While Routing
You can add a via during routing to either continue routing on another layer or to connect to a plane area.

Prerequisites

• You must have created a via type for use with your design. For more information, see “Creating a 
Through-hole Via Type” and “Creating a Partial Via Type”.

• The via must be available for use, and both source and destination layers must be available for 
routing according to the applicable Routing Rules  on page 1666.

Procedure
1. While routing, use one of the following methods to add a via:

• Right-click and click the Add Via  popup menu item to continue routing on another layer.

• Click to place a tack and then change to the desired new layer  on page 738 to continue 
routing. The via is added automatically in the location of the tack.

If the via is a restricted via, ensure the requirements to this procedure are in place.

If a violation is detected, the via grid or a clearance rule could be preventing the placement of the 
via. Also, the layer you are routing to could be unavailable for routing. Ensure the requirements to 
this procedure are in place.
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Tip
Instead on continuing routing after you add a via, you can end the trace with a via. You 
would use this method to fan out a plane net to the plane layer. While routing, right-click, 
point to the End Via Mode  popup menu item, and then click the End Via  popup submenu 
item to set the mode. Right-click and click the End  popup menu item to end the trace with 
a via. The trace ends with a Via. If there is a plane area on the path of the via, it will either 
connect with a thermal connection if necessary or add an antipad if it should not connect.

2. Continue routing on the new layer.

Related Topics
Troubleshooting Routing on Another Layer

Via Types

End Via Mode

The Layer Pair

Creating Arcs
While routing, you can create arcs instead of corners.

Procedure
1. While routing, right-click and click the Add Arc  popup menu item. The segment extending from the 

last corner is converted to an arc.

2. Move the pointer to adjust and indicate the radius.

3. Click to complete the arc. Routing continues from this point.

Related Topics
Stretching an Arc or Miter

Layer Changes While Routing
To change layers while routing, use the L modeless command while the trace is active. The “L” command 
installs a via at the last corner and moves the segment of your trace (stretching from the via to the 
pointer) onto the specified layer. The Via Type dialog box settings control the type of via you place. The 
trace color changes accordingly and the new layer appears in the Layer list on the Standard Toolbar.

If the layer change is allowed, a via is installed at the last corner when you change layers either while 
routing or after entering the trace. You can use the design rules to use a specific via by default. Since 
partial vias undergo a checking process, you cannot set them this way by default; they are chosen 
automatically depending on the circumstances of layer change.

Conditions for Changing Layers
Operations for changing layers in interactive routing are the same for the Route command and Dynamic 
Route Editor.
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Changing the Via Type While Routing

When you change layers, you must meet several requirements before you can place a via. First, the 
layer change must be a legal drill pair, the start and finish layer numbers. This check affects multiple 
layer boards. Establish pairs by clicking the Setup  > Drill Pairs  menu item, according to your projected 
manufacturing plan. Once you enter drill pairs, you are warned if you are joining two layers that do not 
match your manufacturing scheme.

For more information on setting up through hole vs. partial vias, see Via Setup.

Layer Change Methods
There are several ways to install a via and change layers while routing:

• If you are working extensively between two layers, set them as the default “Layer Pair” in the 
Options dialog box > Routing  category > General subcategory  on page 1542. You can also use 
the PL modeless command  on page 83. While routing, right-click and click the Layer Toggle 
popup menu item or press the F4 key.

• Type the L modeless command  on page 83, the new layer number, and press the Enter key.

• Right-click and click the Layer  popup menu item. This opens the Modeless Command window 
with the L command already typed for you. After the L command, type the new layer number and 
then press the Enter key.

• On the Standard Toolbar, in the Layer list, select the new layer.

The type of via placed is determined by the Vias Dialog Box  settings. You can also use the V modeless 
commands  on page 83.

Related Topics
Adding a Via While Routing

Changing the Via Type While Routing
While routing, you can change the type of via that SailWind Layout uses for via additions.

Procedure
1. While routing, right-click and click the Via Type  popup menu item.

The Vias Dialog Box  appears. You can leave the Vias dialog box open to quickly change from one 
via type to another.

2. In the Via Mode area click a via type.

3. If the via is a through hole, click the via type to use in the Via List list.

If you click automatic, SailWind Layout selects a via type based on which via types are allowed 
for the net in the Routing Rules  on page 1666 dialog box and which via types are legal for the 
layer change according to the Drill Pairs Setup  on page 1337 dialog box. If more than one via type 
qualifies on both counts, the product uses the smaller drill diameter and/or smaller pad size.

4. Click OK. The new via type is used until you change it.
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Changing the Trace Width While Routing
When you change the trace width, the current routing width changes from the last corner, leaving 
segments before the last corner at their original width. All subsequent segments draw at the new width, 
until you reach the next pin in the net. The width stays associated with the connection until you change it.

The “Recommended” trace width setting  on page 1167 for the net stays unchanged. If you end with a 
partial route and use it later, the width you set separately is still in effect.

Procedure
1. While routing, type the W modeless command  on page 83. This changes the “Default width” setting 

in the Options dialog box > Drafting  category > Text and Lines subcategory  on page 1553. You 
can also change the width in the Grid/Width dialog box  on page 1398.

2. Type the new width and then press the Enter key. The line width area on the status bar changes 
accordingly.

Related Topics
Changing the Width of an Existing Trace

Troubleshooting Routing on Another Layer
You can use a via to switch to another layer while routing but many rules or settings can prevent you from 
routing on another layer.

If you have trouble, here is a list of things to check:

• Is the via type in the Selected layers list? In the Routing rules  on page 1666 at each level of the 
hierarchy, you can disable a via for routing by keeping it out of the Selected vias list.

• Is the layer in the Selected layers list in the Layer biasing? In the Routing rules  on page 1666
at each level of the Rules hierarchy, you can disable a layer for routing by keeping it out of the 
Selected Layers list in the Layer biasing area.

• Is the layer check box cleared in the Selection Filter? In the Selection Filter, on the Layer tab  on 
page 1708, you can clear the check box of a layer. Nothing on that layer is selectable - including 
the pad of the via from which you are trying to route.

• Is the active layer not coming to the front? In the Options dialog box > Global category > General 
subcategory  on page 1531, you can select the “Active layer comes to front” check box to bring 
the layer forward. Then you can select items on that layer more easily.

• Is there a conditional rule which prevents this net from routing on this layer, or near these 
components?
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Traces Ended on Different Nets
To end a trace on a segment with a different netname, use the ECO Toolbar routing command. SailWind 
Layout assumes you are intentionally joining two nets to make one, and considers it an engineering 
change. SailWind Layout records it in the database as such.

You must assign a new netname: either use one of the names from the nets you just combined or use a 
third name. For instructions, see “Adding a Route in ECO Mode”.
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Refined Object Selection
You can use additional selection filter shortcuts after selecting a design object. Right-click and click a 
selection shortcut.

Selecting Nets From an Electrical Object
Selecting Pin Pairs From an Object
Selecting Classes from Nets
Selecting Groups from Pin Pairs
Selecting Drafting Objects from Segments/Corners

Selecting Nets From an Electrical Object
You can select an assigned net of an electrical object quickly. Electrical objects include trace objects, 
pins, copper objects, planes, and unroutes.

Procedure
1. Select an object.

2. Right-click and click the Select Net  popup menu item, or press the F6 key. The entire net is 
selected, including routes, connections, and pins.

Selecting Pin Pairs From an Object
You can select all pin pairs attached to a pin, trace segment, corner, tack, or via.

Procedure
1. Select an object.

2. Right-click and click the Select Pin Pairs  popup menu item, or press the F5 key.

Selecting Classes from Nets
A class  is a collection of nets with a common set of design rules. You can define classes graphically or by 
using the Class Rules dialog box.

For more information about classes, see “Design Rule Hierarchy.”

If you have created net classes, you can quickly select all items such as pins, traces, and unrouted pin 
pairs within them, or determine the class of a net.

Procedure
1. Select a net.

2. Right-click and click the Select Class  popup menu item.
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Selecting Groups from Pin Pairs
A group is a collection of pin pairs with a common set of design rules. You can define groups using the 
Group Rules dialog box.

For more information about groups, see “Design Rule Hierarchy”.

Procedure
1. Select a pin pair of a group.

2. Right-click and click the Select Group  popup menu item. All pin pairs of the group are selected.

Selecting Drafting Objects from Segments/Corners
You can use the Select Shape command to select an entire drafting object from one of its segments or 
corners.

Procedure
1. Select the drafting segment or corner.

2. Right-click and click the Select Shape  popup menu item.
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Operations After Routing
SailWind Layout offers detail tools to help you clean up or modify routed trace patterns, perform a 
completely reroute, or protect routes from further modifications.

Tip
If you try to modify route objects in a physical design reuse, the message “Reuse objects cannot 
be modified. Break the reuse first” appears. Click OK  to cancel the editing operation. You can, 
however, copy trace patterns from a physical design reuse.

To view obstacles that may lie under traces on the current active layer use Transparent View Mode, 
modeless command  on page 83 T.

Moving a Trace Segment to Another Layer
Rerouting with Route or Dynamic Route
Rerouting with Sketch Route
Smoothing Trace Segments
Changing the Pad Entry Angle
Copying and Pasting Trace Patterns
Creating Route Loops
Moving a Trace Segment
Trace Shove During a Move
Deleting a Trace Segment
Unrouting All Segments Attached to the Pads of a Component
Changing the Width of an Existing Trace
Creating Arc Miters
Converting a Trace Corner to an Arc
Stretch Command
Moving a Corner
Moving a Via or Tack
Deleting Dangling Routes
Splitting a Trace
Adding a Corner to a Trace Segment
Adding Vias to an Existing Trace
Stitching Vias
Adding a Test Point to an Existing Trace
Deleting a Corner
Deleting a Via
Gluing a Via
Deleting Miters
Deleting a Route from a Pin Pair
Connecting SMD Pads to Planes
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Moving a Trace Segment to Another Layer

Moving a Trace Segment to Another Layer
Instead of rerouting an entire trace, you can move a trace segment to another layer and allow SailWind 
Layout to add vias automatically at the opposite ends of the trace segment.

Procedure
1. Select one or more continuous trace segments.

2. Right-click and click the Properties  popup menu item.

3. In the Trace Properties Dialog Box, select the layer you want from the Layer list.

4. Click OK.

Results
The trace segment moves to the selected layer and vias are automatically placed at the segment end 
points.

If nothing happens, design rules may have been violated. For example, there may not be enough room for 
a via or traces may not be permitted on the layer you have chosen.

Rerouting with Route or Dynamic Route
You can reroute traces by starting and ending a new replacement trace anywhere along the existing trace. 
You can start and end reroutes on segments, pins, and vias.

Prerequisites

• The existing and new traces must have the same netname.

• The net must be enabled for copper sharing. To enable copper sharing, use the Routing Rules  on 
page 1666 dialog box for the net and select Copper Sharing. To enable sharing for all nets, in the 
Rules dialog box,  on page 1674 click Default  and select Copper Sharing in the Routing area.

Procedure
1. Select a trace segment at the point where you want to start the reroute.

Tip
Use Transparent View Mode, modeless command  on page 83 T, to view obstacles that 
may lie under traces on the current active layer.

2. Right-click and click the Route  or Dynamic Route  popup menu item. The new trace begins at the 
selection point.
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• If you reroute a segment that has a via or jumper pin that is a locked test point, the locked test 
point is not deleted. The test point remains connected by an unroute.

• If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK  to cancel the editing operation.

3. Route the new trace segment. You can end on a trace when the pointer changes to a bull's-eye 
as you move the route in progress over the segment into which you want to T-connect. If you 
have created a connection loop, the “Delete Loop?” message appears. Click OK  to delete the 
highlighted segment or click Next  to cycle through the other segments in the loop. Click OK  to 
delete the highlighted segment.

4. To complete the route, double-click or right-click and click the Complete  popup menu item.

Rerouting with Sketch Route
Use Sketch Route to reroute a set of trace segments between two pins. A pin in this case may be a 
component pin, via, or tack.

Restrictions and Limitations
Sketch Route cannot move a tack, so most traces that travel in the wrong direction, or have tacks for any 
other reason, are ineligible for Sketch Rerouting.

Procedure
1. Type the drp modeless command  on page 83 and press the Enter key to enable the online design 

rule checking Prevent mode and the Sketch Route  button.

For more information, see “Turning on Design Rule Checking,” and “Design Rule Checking.”

2. Activate the Sketch Route command using one of the following:

• Object mode — select the first segment of the series you want to edit, then right-click and click 
the Sketch Route  popup menu item.

• Verb mode — on the Design Toolbar, click the Sketch Route  button and then click on a trace 
segment at the point where you want to change the trace pattern.

Restriction:
If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK  to cancel the editing 
operation.

3. A thin dotted line appears that moves with the pointer. Use this line to mark the general location of 
the new trace. You do not have to enter any corners.

4. Click to indicate the end of the sketched route. This completes the trace, routing through the 
defined path.
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Smoothing Trace Segments

Smoothing Trace Segments
Smoothing removes unnecessary segments from a trace and converts ninety-degree corners to forty-five 
degree corners whenever possible. This option is only available with the Dynamic Route Editing licensing 
option.

Procedure
1. Type the drp modeless command  on page 83 and press the Enter key to enable the online design 

rule checking Prevent mode.

For more information, see “Turning on Design Rule Checking,” and “Design Rule Checking.”

2. Select a trace segment.

3. Right-click and click the Smooth  popup menu item.

Restriction:
If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK  to cancel the editing 
operation.

Changing the Pad Entry Angle
After you complete routing a connection from pin to pin, you can change the pad entry angle into the pin.

The Trace/Line Angle setting in the Options dialog box > Design subcategory  on page 1503 determines 
the angle of pad entry when you complete a trace. You can also use Trace/Line Angle in the Status Dialog 
Box.

Procedure
1. Select the segment.

2. Right-click and click the Pad Entry  popup menu item.

The final segment changes its orientation and adjusts the attached segments accordingly if 
possible. If the new pad entry causes a clearance error, the process is canceled.

Restriction:
If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK  to cancel the editing 
operation.

Copying and Pasting Trace Patterns
You can reproduce repetitive routing patterns by making one example of a segment pattern, copying it, 
and pasting it on any similar connections. The selection includes layer changes and vias in the path.
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Memory patterns or SMD fanouts are ideal applications for copied routes. When you select and copy a 
trace or a trace and via combination, you start a specialized operation that immediately attaches a copy of 
the selected routing to the pointer and lets you repeatedly paste with a mouse click.

Procedure
1. Select anything from a single trace segment up to a pin pair in length.

Your selection can include vias. The copy feature does not work on trace patterns longer that a 
single pin pair. Select multiple items by Ctrl+click. Selections can include vias.

2. Click the Edit  > Copy  menu item, or press Ctrl+C.

All included segments and vias are copied and attached to your pointer in Move mode.

3. If needed, right-click and use the shortcut menu commands to rotate or flip the copy.

4. Position the pointer over the location of the pins to which you want to paste.

A copy is pasted and another copy remains attached to the pointer so you can paste it again. A 
copied trace only pastes to a valid electrical connection: you cannot paste to empty space. If the 
copied traces are shorter than the target pin pair, a connection is created from the end of the copy 
to the other pin of the pair.

The pointer then snaps automatically to a point the same distance from and in the same direction 
as the last placement. This makes it easy to install repetitive route patterns.

5. Press the Esc key to cancel further copies.

Related Topics
Copying and Pasting Routes in BGAs

Cut, Copy, and Paste Commands

Creating Route Loops
You can reroute from point to point along the same net without deleting the previous path. This causes the 
new route to branch off the existing route, creating a loop.

Procedure
1. Indicate the location on the route segment where you want the branch to occur.

2. Right-click and click the Route Loop  popup menu item.

A new route starts at the selection point. You can also start Route Loop using the Ctrl+J shortcut 
keys.

Restriction:
If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK  to cancel the editing 
operation.
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Moving a Trace Segment

3. Indicate the location for each corner of the new route.

4. Indicate the location where the loop branches back into the existing route.

Moving a Trace Segment
You can move traces if you need to make room for other routing objects.

Procedure
1. Select the trace segment.

2. Use one of these methods to start the move.

• Right-click and click the Move  popup menu item.

• Press Ctrl+E.

• Select the trace segment and drag. Use the Options dialog box > Global category > General 
subcategory  on page 1531 to click a drag and drop method, or to prohibit pointer-drag moves.

The selection attaches to the pointer.

3. Click to indicate the new route location.

Related Topics
Stretching an Arc or Miter

Trace Shove During a Move
You can use the shortcut menu to enable or disable trace shoving, or moving, when you move traces. If 
you want to move traces aside, when the trace is in Move mode, right-click and click the Shove  popup 
menu item to enable the shove feature.

This feature requires that you have the Dynamic Route Editing installed option.

The following restrictions apply:

• If you set DRC to Prevent or Warn, you cannot create a clearance violation when you relocate the 
trace.

• If you move a trace that is attached to a via or pin that is a locked test point, a Warning dialog box 
appears informing you of changes to the test point and giving you options. For more information, 
see “Modifying a Route Attached to a Locked Test Point.”
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• If you try to modify route objects in a physical design reuse, the message “Reuse objects cannot 
be modified. Break the reuse first” appears. Click OK  to cancel the editing operation.

Tip
Use Transparent View Mode, the modeless command  on page 83 T, to view obstacles that 
may lie under traces on the current active layer.

Deleting a Trace Segment
You can delete trace segments to restore the unroute connection.

Procedure
1. Select the segment.

2. Press the Delete key, or click the Edit  > Delete  menu item. When you delete a trace segment, an 
unroute connection line is restored.

If you delete a trace that is attached to a via that is a test point, the via is automatically deleted 
with the trace unless the test point is locked. If the test point is locked, it remains connected by an 
unroute.

If you try to delete a segment that is part of a physical design reuse, the message “The command 
cannot be applied to reuse elements” appears in the status bar.

Unrouting All Segments Attached to the Pads of a 
Component
You can unroute the first segment attached to each pin of a component. Use the “Unroute Attached 
Segments” command to reroute each connection that terminates at the part, or when replacing a 
component in the design. When you unroute a segment, tacks appear at the end of the connection where 
it meets the route. If the unrouted segment ends at a via, SailWind Layout creates a connection between 
the via and the unrouted pin.

Procedure
1. Select the component from which you want to unroute attached segments.

2. Right-click and click the Unroute Attached Segments  popup menu item.

The first segments are unrouted and tacks appear at the end of the routes.

Restriction:
If you try unroute segments that are part of a physical design reuse, the message “The 
command cannot be applied to reuse elements” appears on the status bar.
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Changing the Width of an Existing Trace

Results
When you unroute all final segments into a component, in some cases it may appear as though a trace is 
still connected to a pad. This occurs when the final two segments end within the bounds of the pad. See 
the example in the graphic below.

Changing the Width of an Existing Trace
You can change the width of routed traces at the segment, pin pair, or net level.

Tip
You can also use the Edit  > Find  menu item to find all traces of a similar width, select them, and 
change them to a new width.

Procedure
1. Select a segment, pin pair, or net.

2. Right-click and click the Properties  popup menu item.

3. In the Trace Properties  on page 1757, Pin Pair Properties  on page 1627, or Net Properties dialog 
box  on page 1487, in the Width or Trace Width box, type the new width and click OK.

Restriction:
If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK  to cancel the editing 
operation.

Creating Arc Miters
You can create a small, smooth arc effect by mitering a routed 90 degree corner. Such an ability is useful 
if you need to automatically add arcs to many corners in the design.

If you want to manually add an arc, see “Converting a Trace Corner to an Arc”.
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Procedure
1. Click the Tools  > Options  menu item. The Options dialog box opens.

2. On the Design category  on page 1503, in the Miters area, click Arc.

3. Set the Ratio.

Ratio is the ratio of the arc radius to the trace width; for example, for a 12-mil trace, a ratio of 1 
produces a radius of 12; a ratio of 2 produces a radius of 24.

4. To apply the miter, select the corner, right-click, and click the Add Miter  popup menu item.

Trace segments that are too short for the specified ratio are not mitered. You can also select one or 
more pin pairs, right-click and click Add Miter.

Restriction:
If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK  to cancel the editing 
operation.

Converting a Trace Corner to an Arc
Use the “Convert to Arc” command to create an arc from two intersecting route segments. You can 
manually pull the arc to the radius that you need.

If you need to automatically add arcs to many corners in the design, see “Creating Arc Miters”.

Procedure
1. Click the Tools  > Options  menu item. The Options dialog box appears.

2. On the Design category  on page 1503, in the Miters area, use the Angle value to control which 
trace corners will be converted to arcs.

For example, if the Angle box is set to 90 degrees, then only trace corners that form angles less 
than or equal to 90 degrees can be converted to arcs.

3. Select the corner of a trace.

4. Right-click and click the Convert to Arc  popup menu item.

Note:
If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK  to cancel the editing 
operation.

5. Move the pointer to adjust the radius of the new arc and click to finish.

Results
If you need to adjust the radius of a created arc or to convert the arc back to a corner, select the arc 
segment, right-click and click Stretch  on page 753.

752 SailWind Layout Guide and Reference



 
Routing The Design

Stretch Command

Stretch Command
Use the Stretch command to stretch arcs or miters and to move route segments.

Stretching an Arc or Miter
Using Stretch to Move a Route Segment

Stretching an Arc or Miter
Use Stretch to expand or contract a miter or arc on a trace segment.

Procedure
1. Select the miter segment or arc.

2. Right-click and click the Stretch  popup menu item. The object attaches to your pointer.

If you move or stretch a route that is attached to a via or pin that is a locked test point, a Warning 
dialog box appears informing you of changes to the test point and giving you options. For more 
information, see “Modifying a Route Attached to a Locked Test Point.”

Restriction:
If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK  to cancel the editing 
operation.

3. Move the pointer to expand or contract the object. Click outside the point of intersection of the two 
lines to return the arc or miter to a corner.

4. Click to finish.

Using Stretch to Move a Route Segment
Use Stretch to move a straight route segment that has corners at the end points.

Tip
To modify arcs and miters of drafting objects, use the Pull Arc  on page 640 and Move Miter  on 
page 639 commands.

Restrictions and Limitations
You cannot use Stretch to move a straight route segment with an arc at its end point.

Procedure
1. Select the trace segment.

2. Right-click and click the Stretch  popup menu item. The segment attaches to your pointer.
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If you move or segment that is attached to a via or pin that is a locked test point, a Warning 
dialog box appears informing you of changes to the test point and giving you options. For more 
information, see “Modifying a Route Attached to a Locked Test Point.”

Restriction:
If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK  to cancel the editing 
operation.

3. Move the pointer to move the segment. The corner angles are maintained and the length of 
the segment is adjusted during the stretch. If you stretch a segment so that it reaches another 
segment’s corner, corner angles may change.

4. Click to finish.

Related Topics
Creating Arcs

Creating Arc Miters

Moving a Corner
You can move any corner on a trace or drafting object.

Procedure
1. Select the corner to move.

2. Right-click and click the Move  popup menu item.

When moving a corner of a drafting object, you can also use the Move button on the Design 
Toolbar. Click to select the corner and it attaches to your pointer.

Restriction:
If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK  to cancel the editing 
operation.

3. Optionally, you can right-click and apply any of the following:

• Convert To Arc  — To convert the corner to an arc. The corner becomes an arc and remains 
attached to your pointer. Move the arc to the desired position, and click to complete.

• Shove  — To shove other routes as you move the selected corner.

• Orthogonal, Diagonal  or Any Angle — To select an angle setting.

• Ignore Clearance  — To ignore clearance rules regardless of the On-line DRC setting  on 
page 1503 in the Options dialog box > Design  category.
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Moving a Via or Tack

4. Move the corner with the pointer.

5. Click to place the corner at the new location.

Related Topics
Deleting a Corner

Modifying Drafting Corner Properties

Moving a Via or Tack
You can use the pointer to move a via or tack in your design.

Procedure
1. Select the via or tack.

2. Right-click and click the Move  popup menu item.

If you move a via that is a locked test point, a Warning dialog box appears informing you of 
changes you are making to the test point and giving you options. For more information, see 
“Modification of a Via or Virtual Pin That is a Locked Test Point” or “Modifying a Route Attached to 
a Locked Test Point.”

Restriction:
If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK  to cancel the editing 
operation.

3. Optionally, you can right-click and apply any of the following:

• Shove — To shove other routes as you move the selected tack or via.

• Orthogonal, Diagonal, or Any Angle — To select an angle setting.

• Ignore Clearance  — To ignore clearance rules regardless of the On-line DRC setting  on 
page 1503 in the Options dialog box > Design  category.

4. Move the pointer to reposition the via or tack. If you move a via that is a test point into an area 
defined as a test point keepout area, and DRC mode is ON, a message appears and the test point 
is cleared.

Deleting Dangling Routes
Dangling routes  are stubs or spurs off of traces that are not tied to any pin by a ratsnest. By contrast, 
partial routes are uncompleted routes where the ratsnest flightline is still visible.

In SailWind Layout you can end the route on a via by choosing End With Via from the Route shortcut 
menu. This creates a dangling via and dangling route.
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Procedure
1. Select one or more nets in the design.

2. Right-click and click the Select Dangling Routes  popup menu item.

3. Press the Delete key or right-click and click the Unroute  popup menu item.

Restriction:
If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK  to cancel the modifying 
operation.

Splitting a Trace
The Split command divides a selected line segment into two segments and makes one of the segments 
move dynamically with the pointer by adding a third segment at the location of the split.

Procedure
1. Begin the split using one of the following methods:

• Object mode — select a trace segment, right-click and click the Split  popup menu item.

• Verb mode — on the Design Toolbar click the Split  button and then select a trace segment.

The segment dynamically attaches to the pointer. The current Angle Mode setting effects the 
movement of the attached segments.

Restriction:
If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK  to cancel the editing 
operation.

2. Optionally, while splitting a trace, you can switch the trace side that is attached to the pointer. 
Before completing the split, right-click and click the Swap  popup menu item. The pointer attaches 
to the other end of the segment.

3. Click to indicate where to split the segment. One of the two segments is divided into two segments.

4. If you selected Verb mode, add a split to another trace segment or press the Esc key to cancel the 
Split mode.

Adding a Corner to a Trace Segment
Add Corner divides the selected line segment into two segments and makes both line segments move 
dynamically with the pointer to create the new corner.
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Adding Vias to an Existing Trace

Procedure
1. Begin the corner using one of the following methods:

• Object mode — select a trace segment, right-click and click the Add Corner  popup menu iem.

• Verb mode — on the Design Toolbar click the Add Corner  button and then select a trace 
segment.

The segments dynamically attach to the pointer with the corner at the position of the pointer. The 
current Angle Mode setting effects movement of the attached segments.

Restriction:
If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK  to cancel the editing 
operation.

2. Click to indicate the location for the new corner.

When On-line DRC is set to Prevent Errors and errors occur, (guard band  on page 1832 appears), 
the corner is added at the closest legal position to the indicated point.

Adding Vias to an Existing Trace
Add a feed-through via to the selected trace at the selection point location. This action does not change 
the current layer setting.

Procedure
1. Select a trace segment, trace corner, or trace end point at the location of the via you want to place.

2. Right-click and click the Add Via  popup menu item.

The via is added at the point where you selected the trace object. The via is a plain via. The 
Stitching or Glued settings are not enabled for the via. To add traces to unrouted connections, pin 
pairs or nets, see “Adding Stitching Vias”.

Note:
If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK  to cancel the modifying 
operation.
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Stitching Vias
Use stitching vias to interconnect copper areas of nets including copper planes or CAM planes.

Note:
SailWind Layout does not consider stitching vias to be orphaned vias and does not delete them 
during routing optimization. If you use the Select Dangling Routes command, it will select stitching 
vias. Glue stitching vias to keep them from being deleted if you select dangling routes and delete 
them as part of your design process.

Adding Stitching Vias
Selecting Stitching Vias
Changing Stitching Via Types
Deleting Stitching Vias
Converting Routing Vias into Stitching Vias

Adding Stitching Vias
You must associate stitching vias with a net. You can add them to the design through the net selection of 
an object in the design.

Stitching vias interact with many commands in SailWind Layout:

• The All Except Connected Plane Nets option in the View Nets dialog box disables unroute display 
to stitching vias that are embedded in copper planes, or CAM planes. Also, Length Minimization 
calculates both the pads and drills of the stitching via to determine the unroute visibility to a 
stitching via.

• When you copy trace patterns, stitching vias are also copied. Copied stitching vias snap to the via 
grid when pasted.

Procedure
1. Select a net (you can click trace segments, vias, pins, unroutes, copper, and copper planes), pin 

pair, or unroute in the design.

2. Right-click and click the Add Via  popup menu item to attach the new via to the pointer.

3. Click to place the stitching via.

Another stitching via attaches to the pointer. You can place vias repeatedly. If unroutes are visible 
for the selected net, a new unroute will connect to the stitching via.

4. Right-click and click the Cancel  popup menu item to stop adding stitching vias.

Results
When you add a via to an unroute, pin pair or net, the result is a via with a Stitching setting enabled. By 
default, stitching vias added to the design are always given the Stitching setting as they are added. Vias 
added to traces are not. When you add a via to a trace segment or trace corner, the result is a plain via 
(unglued). For more information, see “Adding Vias to an Existing Trace”.
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Selecting Stitching Vias

You can prevent the deletion of stitching vias during ECO operations such as Delete Component, Delete 
Connection, and Delete Pin, as well as during a Change Part or an Unroute operation. To preserve 
stitching vias select the Keep Stitching Vias check box in the Group Editing area on the Options dialog 
box > Design category  on page 1503.

Related Topics
DRC and the Via Stitching and Shielding Operations

Selecting Stitching Vias
You must enable the selection of stitching vias before you can select a stitching via.

Procedure
1. With nothing selected, right-click and click the Filter  popup menu item.

2. In the Selection Filter, on the Object  tab, select the Stitching vias check box. Clear the check 
boxes of other object types for easier selection of the Stitching vias.

3. Click Close.

4. Select a stitching via.

Changing Stitching Via Types
You can use any via type, including SMD, through-hole, or partial as a stitching via. If the default via is not 
the correct via, you can modify the via type.

Procedure
1. Select one or multiple stitching vias.

2. Right-click and click the Properties  popup menu item.

3. In the Via Name list, select the correct via.

Tip
You can use the Pad Stacks dialog box to create new vias.

Deleting Stitching Vias
Delete stitching vias by pressing the Delete button on the keyboard.

Procedure
1. Select one or more stitching vias  on page 1862 to delete.

2. Press the Delete key. A dialog opens with the message, “Delete all orphaned vias?”. Click Yes  to 
delete the stitching via.
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Converting Routing Vias into Stitching Vias
Vias that you add to a trace segment, corner, or end point, are not considered stitching vias but routing 
vias. Like stitching vias, you can use these routing vias to interconnect areas of a net, but SailWind 
Layout does not consider them plain vias. Enable the Stitching setting to make a routing via into a 
stitching via.

Procedure
1. Select one or multiple vias.

2. Right-click and click the Properties  popup menu item.

3. Select the Stitching check box.

4. Click OK.

Related Topics
Gluing a Via

Stitching Vias

Adding a Test Point to an Existing Trace
You can manually add a test point along an existing segment or trace of a route. Test points, by default, 
do not glue in a design. You can access them from the bottom.

Tip
You can also make an existing via, pin or virtual pin a test point. See the Test Point check box 
in the following object Properties dialog boxes: Via Properties Dialog Box, Pin Properties Dialog 
Box, Jumper Pin Properties  on page 1422

Procedure
1. Unless the via used in the design can also be used for test points, create a via  on page 329 to use 

as a test point.

2. If there is more than one via available to the design, you must specify the via that should be used 
for test points.

a. Click the Tools  > DFT Audit  menu item.

b. In the DFT Audit dialog box  on page 1273, select the Add Test Points to Existing Traces check 
box. This check box must be selected to choose a test point in the Use Test Point Via list, but is 
not required to be active to add test points to traces in SailWind Layout.

3. Use one of the following methods to add a test point:
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Deleting a Corner

• Object mode — Select a trace segment or corner. You cannot use multiple selection when 
adding test points to a route. Right-click and click the Add Test Point  popup menu item.

• Verb mode — On the Design Toolbar, click the Add Test Point button. Select any trace 
segment or corner to which you want to add a test point. Repeat or right-click and click Cancel 
to exit Add Test Point mode.

4. A test point is added to the route.

If you try to add a test point in an area defined as a test point keepout area and DRC mode is set 
to Prevent Errors, the message “Test point keepout violation” appears and the test point is not 
added.

Restriction:
If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK  to cancel the editing 
operation.

Results
When the via or pin is flagged as a test point, and the Show Test Points check box is selected on the 
Options dialog box > Routing  category > General subcategory  on page 1542, an arrow marker overlays 
the via:

Related Topics
Performing a Test Point Audit

Deleting a Corner
You can delete corners of traces or drafting objects.

Procedure
1. Select the corner.

2. Press the Delete key. The two segments joined at the corner become one segment.

Restriction:
If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK  to cancel the editing 
operation.
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Related Topics
Moving a Corner

Modifying Drafting Corner Properties

Deleting a Via
You can remove a via by selecting it and pressing the Delete key.

Procedure
1. Select the via.

2. Press the Delete key. The via is deleted and the layers of the attached segments are changed if 
necessary.

Note:
If you try to modify route objects in a physical design reuse, the message “Reuse objects 
cannot be modified. Break the reuse first” appears. Click OK  to cancel the editing 
operation.

Gluing a Via
Glue a via to prevent it from being moved for any reason.

You can fix a via's location to establish it as a test point on the fabricated board. The points of a bed 
of nails test apparatus are matched to the test point locations. So if you redesign and remanufacture 
the board, the glued test points prevent the vias from moving in the new design, thus preventing costly 
retooling of the test equipment.

Procedure
1. Select a via, right-click and click the Properties  popup menu item.

2. Select the Glued check box.

3. Click OK.

Results
If you also select the Test Point check box, you include the via's location in a report file in a Test Point 
section. The Test Point check box also indicates if the via was automatically installed and glued as a test 
point by an autorouter. Installing test points this way returns test points from the router with checked Glue 
and Test Point check boxes.

Deleting Miters
A miter is a diagonal segment or arc that replaces a corner. You can delete all miters from one or more 
routed pin pairs, drafting paths, or polygons.
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Deleting a Route from a Pin Pair

Procedure
1. Select the routed pin pairs, drafting paths, or polygons.

2. Right-click and click the Delete Miters  popup menu item. All miters in the selected path are 
deleted and replaced by a 90-degree corner.

Deleting a Route from a Pin Pair
You can delete all traces and vias in a routed pin pair.

Procedure
1. Select the pin pair.

2. Press the Delete key. A ratsnest line between the two pins replaces the routed pin pair.

Connecting SMD Pads to Planes
Routing an SMD pad to a plane involves placing a via to the plane under or somewhere near the pad.

Vias you add to plane nets receive a thermal relief pad for the plane layer based on the either the 
design rules or the pad stack. For more information, see “Design Rule Versus Pad Stack - Thermals and 
Antipads”  on page 797.

Prerequisites

• You must have created a via type for use with your design. For more information, see “Creating a 
Through-hole Via Type”, and “Creating a Partial Via Type”.

• The via must be available for use, and both source and destination layers must be available for 
routing according to the applicable Routing Rules  on page 1666.

Procedure
1. Optionally, if you are fanning out power and ground connections, you can hide all unrouted 

connections except the power and ground nets and give the pads of those nets unique colors to 
quickly identify them in the design:

a. Click the View  > Nets  menu item.

b. Select “Default” in the View List list.

c. Select the “Traces Plus the Following Unroutes” check box, if necessary, and in the View 
Unroutes Details area, click None.

d. In the Select By list, click Plane Nets. Locate your plane nets in the Net List and add them to 
the View List.

e. Select the plane nets and in the View Unroutes Details area, click “All Except Connected Plane 
Nets”. This shows full pin-to-pin connections and partially routed copper traces, but not partial 
connections.

f. Select each plane net individually and in the Color by Net area, give each net a unique color.
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g. Click OK.

All the unrouted connections from the display except for the plane net connections are visible 
and the pads of those nets have unique colors. These turn off as you link them to the plane 
with vias.

2. Add a via using one of the following methods:

• Fanout via:

i. Route a small trace segment out from the pad.

ii. While routing, right-click, point to End Via Mode, and then click the End Via  popup menu 
item to set the mode.

iii. Right-click and click the End  popup menu item to end the trace with a via. The trace ends 
with a Via. If there is a plane area on the path of the via, it will either connect with a thermal 
connection if necessary or add an antipad if it should not connect.

• Via in pad:

i. In the Clearance Rules Dialog Box, in the Same Net area, the SMD to Via clearance must 
be 0 (zero) at the required level of the rules hierarchy to enable the via to be placed in the 
pad.

ii. Select the pad, right-click and click the Add Via at SMD  popup menu item. The via is added 
to the center of the SMD. Component pads always overlay vias and it may be difficult 
to determine if the via is actually inside the pad. Enable Transparent mode with the T 
modeless command  on page 83 to see vias in pads.

Results
When you install the via, either under the pad or a short distance away, the connection for that pin-to-pin 
unroute connection disappears if you route the connection to the plane layer. For more information, see 
“Check the Plane Connection for Continuity.”
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High Speed and RF Routing Features
Read the topics that follow to learn more about RF features for use when routing.

Converting a Trace to a Copper Chamfered Path
Restoring Traces After Conversion to Copper Chamfered Paths
Adding a Via Shield

Converting a Trace to a Copper Chamfered Path
Converting traces to a copper chamfered path has two advantages over simply creating a copper 
chamfered path. You can use the more powerful interactive router to initially route the trace, and when 
you convert the trace to a chamfered path, SailWind Layout assigns the net automatically.

Procedure
1. Select a pin pair, multiple pin pairs, or a net.

Unrouted or partially routed pin pairs, or pin pairs belonging to reuse blocks, are excluded from 
selection.

2. Right-click and click the Convert to Chamfered Paths  popup menu item.

Alternatively, you can click  under the RF Toolbar.

3. In the Convert Pin Pairs to Chamfered Paths dialog box, select the pins pairs desired using Ctrl
+click, Shift+click, or the Select All  and Unselect All  buttons as shortcuts.

Only the pins pairs selected in the design appear in the Selected pin pairs list.

4. In the Conversion parameters area, in the Polygon outline width box, type a width value for the 
width of the copper outline.

Since copper is created with an outline and a fill, you can specify a very narrow outline width to 
achieve very sharp corners. Decrease the value for sharper corners and increase the value for 
more blunt corners. All corners are rounded with a radius equal to one half of the outline width.

5. Specify a trace width using one of the following:

• Select the “Use trace width” check box to use the trace width as the width of the chamfered 
path. Where multiple trace widths exist, the actual trace widths are used. The Selected trace 
widths value at the top of the Conversion parameters area displays the range of trace widths of 
the items in the Selected pin pairs list.

• Clear the “Use trace width” check box and enter a value in the Converted path width box.

6. In the Corner chamfer width ratio box type a value specifying the ratio of the chamfered corner 
width to the chamfered path width.

For example, if the ratio is 1.0, the width of the chamfered corner is the same as the chamfered 
path. Reduce the radio for a more narrow chamfered corner.

7. Specify the degree of corners to chamfer using one of the following:
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• Clear the “Chamfer corners with angles less than or equal to” check box to chamfer only angles 
less than 90 degrees (acute angles).

• Select the “Chamfer corner with angles less than or equal to” check box to specify an angle 
between 90 and 180 degrees as the upper limit beneath which all angles are chamfered. 
Outside corners less than 90 degrees are always chamfered.

8. Click OK. The trace is converted to a chamfered path and original trace segments are unrouted. 
Existing vias are retained and are glued.

Related Topics
Creating Copper Chamfered Paths

Restoring Traces After Conversion to Copper Chamfered Paths

Drafting Object Properties

Restoring Traces After Conversion to Copper 
Chamfered Paths
Converting original traces to copper unroutes the traces. You must re-route traces to replace chamfered 
paths.

Procedure
1. Use the Select Nets selection filter to select the net.

2. Right-click and click the Select Chamfered Paths  popup menu item.

Alternatively, you can click  under the RF Toolbar.

3. Press the Delete key.

Vias in the chamfered path are not deleted since they are glued during conversion from trace to 
chamfered path.

4. Re-route the pin pair, pin pairs, or net.

Adding a Via Shield
A via shield is a collection of stitching vias that surround a routed net, pin-pair or copper area. You might 
use a via shield, for example, to surround a net in order to limit noise susceptibility.

For example:
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Procedure
1. If you have not done so, set the options for shielding on the Options dialog box > Via Patterns 

category  on page 1556.

If you need to create a new via type for shielding, see “Via Setup”. Your Via Pattern settings are 
stored for future operations. You need to perform this step only if you want to change the settings 
you selected previously.

2. Select a net, pin-pair or copper area.

To add a via shield around a differential pair, first set the filter mode to either Net or Pin-Pair. Then 
select the two nets or two pin-pairs that make up the differential pair and add a via shield around 
them. For example:

The shielding operation applies a shield to each net; therefore, unwanted vias may appear 
between differential pair traces. If this result happens, you would need to delete those vias.

3. Right-click and click the Add Via Shield  popup menu item.

Alternatively, you can click  under the RF Toolbar.

Results
Vias are placed around the selected net, pin-pair, or copper. If there is adequate room for the vias, but no 
vias appear, your View > Nets menu item, View Details setting  on page 1786 could be set to not show 
Traces Plus the Following Unroutes.
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If the Design Rule Checking setting is Prevent Errors, the Add Via Shield operation does not add any via 
that violates design rules.

When you edit traces, SailWind Layout does not update the pattern of vias in the via shield. After editing 
traces, you may need to add the via shield again. If that is the case, delete the old via shield before 
adding the new one.

Related Topics
DRC and the Via Stitching and Shielding Operations
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Properties of Routing Objects
Use the Properties dialog boxes to make selective modifications to any routing objects.

Modifying Net Properties
Modifying Pin Properties
Modifying Pin Pair Properties
Modifying Trace Corner or Tack Properties
Modifying Via Properties
Modifying Trace Segment Properties

Modifying Net Properties
In the Net Properties dialog box, view net information, control the protection of the net and unroutes, 
control the trace width, and electrical net status.

Procedure
1. Select a net, right-click and click the Properties  popup menu item.

2. In the Net Properties dialog box  on page 1487, modify settings if necessary.

Several of the options in this dialog box are unavailable if the net is part of a physical design reuse.

3. Click OK.

Related Topics
View Nets Dialog Box

Modifying Pin Properties
In the Pin Properties dialog box, view pin information, and control teardrop, plane thermal, and test point 
status.

Procedure
1. Select a pin, right-click and click the Properties  popup menu item.

2. In the Pin Properties Dialog Box  modify settings if necessary.

Several of the options in this dialog box are unavailable if the pin pair is part of a physical design 
reuse. If you modify a pin that is a locked test point, a Warning dialog box may appear informing 
you of changes you are making to the test point and giving you options. For more information, see 
“Modification of a Via or Virtual Pin That is a Locked Test Point”.

3. Click OK.
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Modifying Pin Pair Properties
In the Pin Pair Properties dialog box, view pin pair information, control protection of traces and unroutes, 
and control trace width.

Procedure
1. Select a pin pair, right-click and click the Properties  popup menu item.

2. In Pin Pair Properties Dialog Box, modify the settings, if necessary.

3. Click OK.

Modifying Trace Corner or Tack Properties
In the Trace Corner or Tack Properties dialog boxes, view the trace corner or tack information, and modify 
coordinates.

Procedure
1. Select a trace corner, right-click and click the Properties  popup menu item.

2. In the Tack Properties or Trace Corner Properties dialog boxes  on page 1744, modify the settings, 
if necessary.

Several of the options in this dialog box are unavailable if the corner is part of a physical design 
reuse. If you select another trace corner while the dialog box is open, the selected corner updates 
with the information.

3. Click OK.

Related Topics
Design Rule Hierarchy

Modifying Via Properties
In the Via Properties dialog box, view via information, modify coordinates, change via types, set the glued, 
stitching, plane thermal, and test point status.

Procedure
1. Select a via, right-click and click the Properties  popup menu item.

2. In the Via Properties Dialog Box, modify the settings, if necessary.

Several of the options in this dialog box are unavailable if the via is part of a physical design reuse. 
If you select another via while the dialog box is open, the information updates for the selected 
via. If you modify a via that is a locked test point, a Warning dialog box may appear informing you 
of changes you are making to the test point and giving you options. For more information, see 
“Modification of a Via or Virtual Pin That is a Locked Test Point”.

3. Click OK.
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Modifying Trace Segment Properties
In the Trace Properties dialog box, view trace segment information, modify the coordinates, specify the 
trace width, or change the layer on which the segment resides.

Procedure
1. Select the trace segment, right-click and click the Properties  popup menu item.

2. In the Trace Properties Dialog Box, modify the settings, if necessary.

If you change the layer, vias are automatically added at the segment endpoints. If you select 
another trace segment while the dialog box is open, the information is updated for the selected 
segment. Several of the options in this dialog box are unavailable if the trace is part of a physical 
design reuse.

3. Click OK.

Troubleshooting Constraints While Routing
When you are routing and the design rules constrain you, you can view the rule hierarchy to which the 
object is subjected and access the rules for a design object (class, net, group, pin pair, component, or 
unroute). You can do so by selecting the object in the design and displaying its rules.

For example, if there are specific rules defined for the pin pair associated with the unrouted connection, 
the Pin Pair Rules dialog box appears.

Procedure
1. Select the object whose rules you want to display.

2. Unless you are already selecting a pin pair or net, right-click and click the Select Pin Pair  popup 
menu item.

3. Right-click and click the Properties  popup menu item.

4. In the Pin Pair Properties Dialog Box, in the Rules Data area, view the level from which the Pin 
Pair is getting the design rules.

5. Click the Rules  button to access the Pin Pair level of design rules.

If you need to access a different level of the hierarchy, close all open dialog boxes and click the 
Tools  > Rules  menu item.

Clearance and Checking After Routing
Trace Clearance  is the distance allowed between a trace edge and the edge of another conducting item. 
You can run a verification check to find clearance violations.

Assign clearance values in the Clearance Rules Dialog Box. If you have the Advanced Rules Installed 
Option  on page  , you can assign non-default clearances on the pin pair, pin pair group, net class, 
and all 25 levels of the conditional rules.
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Use the Tools  > Verify Design  menu item menu to search the design for clearance violations. Verify 
Design marks each violation and enables you to center the view on each violation. Verify Design only 
checks for clearance violations on what you choose to display in the design. If you want to check the 
entire design for clearance violations, make sure colors are applied to all object and that nothing is 
invisible in the design. Also bring all design items into view by zooming out to the point where all items are 
in view.

Setting up clearances for traces, as well as pads and vias, is described in “Design Rules  on page 1821”. 
Checking for errors (spacing errors, airgap errors, and high-speed problems) is discussed in “Verify the 
Design”.

Related Topics
Design Rule Hierarchy
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Chapter 33
SailWind Router

This section discusses using SailWind Router in your design process. You can connect to SailWind 
Router from within the SailWind Layout environment. Once connected, you can launch a SailWind Router 
autorouting session or you can initiate Synchronization Mode where you can work interactively and 
simultaneously in SailWind Layout and SailWind Router.

Synchronization Mode
Enabling Synchronization Mode
Sending a Design to SailWind Router in Synchronization Mode
Autorouting Your Design Using SailWind Router
Setting up a Routing Strategy

Synchronization Mode
Synchronization Mode links SailWind Layout and SailWind Router such that as you work in one program, 
you see the changes reflected in the other. For example, if SailWind Layout is the “active” program, 
changes made there are reflected in SailWind Router but you are restricted in what you can do in 
SailWind Router since it is the “inactive” application. When you are in Synchronization Mode, you can 
instantly switch between the two programs.

If an unsupported command is performed or an unsupported option is changed, the inactive program will 
become out of sync.

Note:
You must enable Synchronization mode  on page 774 and then restart SailWind Layout before 
Synchronization mode takes effect.

Despite the synchronization, you must actively switch back to SailWind Layout in order to work on your 
design in SailWind Layout.

Automation can still be used; however, most Automation methods will not return any valuable results and 
will not make any changes in the database.

There are a few commands and options that are not supported in Synchronization mode. If you perform 
one of these commands, or change one of the options, SailWind Layout and SailWind Router become out 
of sync.

To re-synchronize the two programs, click the Layout button on the main toolbar in SailWind Router if 
SailWind Router is active; or click the Route button on the main toolbar in SailWind Layout if SailWind 
Layout is active.

Unsupported commands

• Changing a drafting object: copper, copper planes, text, 2D lines, keepouts, labels, board 
outlines, dimensioning. However, when drafting objects are attached to a component and the 
component is moved, it will not cause the programs to become out of sync.

• Changing rules
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• Changing padstacks or layer definitions

• Importing ASCII files (or any other import)

• Verifying the design

• Changing reuses and clusters

• ECO or BGA operations

• Updating from the library

• Using the Decal Editor

• Inserting an OLE object

• Any operation that clears the Undo buffer; including Autorouting and large group moves

Unsupported option changes

• DFF

• DFT

• Verify Design

• Drafting

• Hatch and Flood

• Thermals

• ECO Options

• Via Patterns

Related Topics
Cut Outs Absorbed by Copper

Enabling Synchronization Mode
Synchronization Mode links SailWind Layout and SailWind Router so that you see the design in both 
programs and can work in either tool without moving the design back and forth.
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Sending a Design to SailWind Router in Synchronization Mode

Procedure
1. Click the Tools  > Options  menu item.

2. In the Options Dialog Box, click the Synchronization category  on page 1535.

3. In the Layout and Router Synchronization area, click Enable.

4. Switching to SailWind Router automatically places your design in SailWind Layout in DRC Off 
mode; the DRC mode in SailWind Router is not affected.

To restore the DRC mode when you switch back to SailWind Layout (to the setting that existed 
before switching to SailWind Router) click Restore DRC Mode on return. Depending on the size of 
your design, restoring the DRC mode may take a few minutes.

5. To receive a warning that your design is being placed into DRC Off mode when you switch to 
Synchronization Mode, click Warn about switching to DRC Off mode.

6. Click OK.

7. Restart SailWind Layout.

Related Topics
Sending a Design to SailWind Router in Synchronization Mode

Sending a Design to SailWind Router in 
Synchronization Mode
Use Synchronization Mode to quickly transfer your design to SailWind Router, but still keep your design 
open in SailWind Layout.

Procedure
1. Enable Synchronization Mode  on page 774.

2. Switch to SailWind Router using one of the following:

• On the Standard Toolbar, click the Route  button.

• Click the Tools  > Router  menu item, and in the SailWind Router Link dialog box select an 
Action and click Proceed.

Note:
To exit Synchronization mode, close one of the programs. Since in Synchronization 
Mode the Layout button (on the SailWind Router Standard Toolbar) does not send 
your design to SailWind Layout and then close SailWind Router, you must close the 
application manually. However, if one of the programs is out of sync, make sure you save 
your changes if you want to keep them. For example, if you want to continue working 
in SailWind Layout, but no longer want to be in Synchronization Mode, close SailWind 
Router. When prompted, save your design.
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Results
SailWind Router opens and your design is loaded. SailWind Layout is switched to DRC Off mode and is 
now the inactive program. Most menu items and commands are disabled or are read-only for the inactive 
program. As you work in SailWind Router, you will see the changes reflected in SailWind Layout. You can 
quickly switch between the two programs and continue to be in Synchronization Mode. Look at the status 
bar to quickly determine which mode the program is in: Active, Inactive, or Out of sync.

If an unsupported command is performed or an unsupported option is changed, the inactive program will 
become out of sync. To re-synchronize the two programs, if SailWind Router is active, click the Layout 
button on the main toolbar in SailWind Router; or if SailWind Layout is active, click the Route button on 
the main toolbar in SailWind Layout.

To turn off the display of licensing warnings when switching between SailWind Layout and SailWind 
Router, type the following text in the Blazerouter.ini  file:

[Security]

DisplayWarnings=0

(You do not need to restart SailWind Router.)

Related Topics
Enabling Synchronization Mode

Cut Outs Absorbed by Copper

Autorouting Your Design Using SailWind 
Router
Using the link you can either run SailWind Router and automatically open the current design file in the 
foreground, so you can view the autorouter's progress, or you can run SailWind Router in the background.

Procedure
1. Click the Tools  > Router  menu item.

2. In the SailWind Router Link Dialog Box, in the Action area, select the action you want to perform:

Autoroute in Background — Opens SailWind Router and SailWind Router Monitor, but runs 
SailWind Router in the background. Layout commands are disabled and a wait cursor shown until 
autorouting is completed or the Stop button is selected in the Router Monitor.

Autoroute in Foreground — Opens SailWind Router and SailWind Router Monitor, and runs 
SailWind Router in the foreground making it the active program.

3. In the Routing Strategy area, click Setup  to set the autorouting strategy  on page 777.

4. Set any required settings before autorouting:
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Setting up a Routing Strategy

a. In the Options area, click one of the selections to specify which settings you want to configure 
and then click Setup.

b. Repeat for other selections as required.

5. Click Proceed.

Results
If you clicked Run in Background, the SailWind Router Monitor  on page   appears, but SailWind 
Router does not appear on your desktop.

If you clicked Run in Foreground, the SailWind Router Monitor  on page   appears. SailWind Router 
also opens and automatically autoroutes the current SailWind Layout design.

Related Topics
Cut Outs Absorbed by Copper

Setting up a Routing Strategy
Use the Routing Strategy dialog box to define a strategy for autorouting a design. A routing strategy is a 
detailed set of instructions that SailWind Router uses to complete the autorouting of your design. You can 
create very detailed sets of instructions that can precisely control the routing order of specific nets, net 
classes, layers and components.

The strategy defines the sequential operations to perform during autorouting, including:

• Passes that the autorouter should run, including the routing intensity, whether or not to protect the 
generated traces, and whether to pause after a pass completes.

• Order in which to autoroute nets, net classes, differential pairs, and matched length groups and 
components.

Procedure
1. Click the Tools  > SailWind Router  menu item.

2. In the SailWind Router Link Dialog Box, in the Routing Strategy area, click Setup.

3. In the Routing Strategy Dialog Box, in the Pass column, select the check box for each pass type 
you want to run. You can run any combination of passes.

4. In the Protect column, select those passes after which to protect the generated traces. This 
protects traces and glues vias that are completed during the corresponding pass type.

5. In the Pause column, select the pass after which you want to pause routing.

Tip
To continue after a paused pass when autorouting in the foreground, click the Resume 
Autorouting button on the Routing Toolbar in SailWind Router (or press the F10 key).
To continue after a paused pass when autorouting in the background, click the Stop button 
in the SailWind Router Monitor dialog box.
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6. In the Intensity column, select the appropriate intensity. Intensity determines the effort and time the 
router can spend on a pass. You cannot set an intensity for the Center pass.

7. Set the routing order for the passes:

a. In the Routing Order column, click the field for the Pass Type you want to set.

b. At the bottom left of the dialog box in the Available list, select items to add to the Routing 
Order. The list is filtered between Components and different types of Nets using the “Select by” 
list above it. For example:

i. For the Fanout pass, click Clear, and then click the Plane Nets  button to fanout only those 
nets.

ii. For the Patterns pass, click Clear. Set the “Select by” list to Nets and in the Available list 
choose any known bus nets in your design and then click the Selected  button.

iii. For the Route pass, set the “Select by” list to Components and choose the most dense 
components in your design and then click the Selected  button. In the Routing Order area, 
make sure the All Nets item is at the bottom of the routing order. If needed, use the down 
arrow to move it down in the order.

c. Use the Routing Order area buttons to delete and re-order the items.

8. Click OK.

Results
When you autoroute the design using SailWind Router  on page 776, the autorouter follows the routing 
order when routing your design.

Related Topics
Autorouting Pass Types [SailWind Router User's Guide]
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Chapter 34
Filling Copper, and Copper Planes

This section describes the methods used to fill coppers, and copper planes. It describes their differences, 
how connectivity is established, and how vias interact with the flooding operations.

Differences Between Copper Shapes and Copper Planes
Flooding Copper Planes
Hatching Copper Planes
Copper Plane Flood Priorities
Setting Flooding Order of Overlapping Copper Planes
Plane Thermal Indicators
Understanding How to Manipulate Copper Plane Thermals and Antipads
Generating Thermals
Thermals on CAM Planes
Thermals on Copper Plane Areas
Flood Over Pads in a Copper Plane
Flood Over Vias in a Copper Plane
Filling a Shape with a Pattern of Vias
Placing Vias Inside the Perimeter of a Shape
Surrounding a Void with Vias

Differences Between Copper Shapes and 
Copper Planes
There are many differences between copper shapes and copper planes. This topic presents a feature 
comparison table that explains the differences for understanding when to use one instead of the other.

Table  119. Feature Comparison of Copper Shapes and Copper Planes

Feature Copper 
Shape

Copper 
Plane

Can be filled without assigning a net X X

Is filled automatically X

Can be created in the PCB Decal Editor X

Can be created on non-electrical layers X X

Can have thermals on routed pads X

Must encompass an electrical object of the net to which it’s assigned 
when using the “Remove isolated copper” option

X
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Table  119. Feature Comparison of Copper Shapes and Copper Planes  (continued)

Feature Copper 
Shape

Copper 
Plane

Avoids objects of any net to which it is not assigned X

Has thermal spokes based on the Thermal Options X

Can generate thermals and antipads from the design rules* X**

Is not filled automatically, but must be poured X

Can generate custom thermals and antipads from pad stack settings* X

Can automatically create cutouts around embedded copper planes* X

Can remove unused pads on inner layers* X

Can be automatically generated based on the shape of the board 
outline

X

Can be split into two areas using the Auto Plane Separate tool X

Can save hatch outlines with the design X

*These features are controlled by settings.

**If you use the “Use design rules for thermals and antipads” setting in the Options dialog box > Copper 
Plane  category > Thermals  subcategory, antipads use the Copper-to-Drill clearance rule rather than the 
Copper-to-Pad clearance.

Flooding Copper Planes
Flooding recalculates the copper plane and recreates all clearances for the current obstacles within the 
plane outline, observing clearance rules. Use Flood if you change clearance rules, or make changes to—
or within—a copper plane that might create clearance violations.

Flooding fills the copper plane with copper in a hatched or solid pattern  on page 617, creating isolation 
areas around copper, traces, and pads that are inside the copper plane but are not part of the same net. It 
also creates thermal relief connections around pins that belong to the same net.

The flood operation uses the Options dialog box settings in the Copper Planes category > “Hatch and 
Flood subcategory”  on page 1511 and Thermals subcategory  on page 1514, and Grids  on page 1537
category, as well as the flood and hatch options  on page 1381.

Tip
If you have overlapping outlines on the same layer having the same flood priority, the software 
cannot determine which one is the obstacle and which one is the standoff around the obstacle. To 
avoid conflicts, the overlapping or common section is drawn as a non-hatch area.

780 SailWind Layout Guide and Reference



 
Filling Copper, and Copper Planes

Flooding Copper Planes

Procedure
1. Use one of the following methods:

• Flooding a copper plane using select and flood — Use this method to select the copper plane 
and then apply flooding.

i. Select the copper plane.

ii. Right-click and click the Flood  popup menu item.

• Flooding a copper plane using the Flood button in verb mode — Use this method if you have 
more than one copper plane to flood. You first activate the Flood button in verb mode and then 
you can sequentially click copper planes and apply flooding.

i. On the Drafting Toolbar, click the Flood  button. 

ii. Select a copper plane to flood.

iii. Click and flood other copper planes as needed.

• Flooding a copper plane using the Copper Plane Manager — Use this method to apply flooding 
to all copper planes in the design.

i. Click the Tools  > Copper Plane Manager  menu item.

ii. In the Copper Plane Manager Dialog Box, click Flood.

iii. Select one or more layers having copper planes to flood.

iv. Click Start  to start the flood process.

• Flooding all copper planes in the design by clicking the Flood All  button on the main toolbar. 

Tip
To see the plane data in a negative mode, use the C modeless command.

2. Inspect the resulting shape:

• If the copper plane did not fill, see “Troubleshooting Copper Plane Fills”  on page 674.

• If the copper plane filled, but opened a Thermal Relief Errors Report (therm.err), see 
“Troubleshooting Thermal Results”  on page 675.

• If the gap between the pad and the copper for thermals or antipads is incorrect, see 
“Customizing Design Rule Thermals” or “Customizing Design Rule Antipads”.
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• If the fill is not correct, see “The Fill of Copper, and Copper Planes”  on page 617.

• If the shape edges are not correct, see “Edge Precision of Drafting Shapes  on page 615”.

• If the shape needs to be modified, see “Drafting Object Properties”.

• If you want to start over, see “Deleting a Drafting Segment or Object”.

For more information, see “Split/Mixed Plane Layers”  on page 683.

Note:
Online DRC does not prevent you from moving objects in a flooded area. If you do not re-
flood the area, Verify Design reports errors. If objects within a flooded area were moved, 
or thermal settings were changed since the original flooding, you need to flood the area 
again.

Related Topics
Setting Flooding Order of Overlapping Copper Planes

Assigning a Net to a Copper Shape or Copper Plane

Hatching Copper Planes

Hatching Copper Planes
Hatching refills (with hatch lines) existing poured copper planes for the current session; it does not 
recalculate the copper plane area.

Each time you open a design file, you must hatch the design; the fill is not saved (you can set the file 
to hatch automatically each time you open it, however, using the “Autohatch on file load” option in the 
Tools  > Options  menu item, Copper Planes  category > Hatch and Flood  subcategory. Use Flood if 
you change clearance rules, or make changes to—or within—a copper plane that might create clearance 
violations.

Restrictions and Limitations

• You can only hatch a copper plane that has already been flooded. This converts the pour outline 
to a hatch outline.

Procedure
1. Use one of the following methods:

• Hatching a copper plane using select and hatch — Use this method to select the copper plane 
and then apply hatching.

i. Select the copper plane.

ii. Right-click and click the Hatch  popup menu item.
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Copper Plane Flood Priorities

• Hatching a copper plane using the Hatch button in verb mode — Use this method if you have 
more than one copper plane to hatch. You first activate the Hatch button in verb mode and then 
you can sequentially click copper planes and apply hatching.

i. On the Drafting Toolbar, click the Hatch  button.

ii. Select a copper plane to hatch.

iii. Click and hatch other copper planes as needed.

• Hatching a copper plane using the Copper Plane Manager — Use this method to apply 
hatching to all copper planes in the design.

i. Click the Tools  > Copper Plane Manager  menu item.

ii. In the Copper Plane Manager Dialog Box, click Hatch.

iii. Click Start  to start the hatch process.

2. Inspect the resulting shape:

• If the gap between the pad and the copper for thermals or antipads is incorrect, see 
“Customizing Design Rule Thermals” or “Customizing Design Rule Antipads”.

• If the fill is not correct, see “The Fill of Copper, and Copper Planes”  on page 617.

• If the shape edges are not correct, see “Edge Precision of Drafting Shapes  on page 615”.

• If the shape needs to be modified, see “Drafting Object Properties”.

• If you want to start over, see “Deleting a Drafting Segment or Object”.

Note:
Online DRC does not prevent you from moving objects in a flooded area. If you do not re-
flood the area, Verify Design reports errors. If objects within a flooded area were moved, 
or thermal settings were changed since the original flooding, you need to flood the area 
again.

Related Topics
Flooding Copper Planes

Copper Plane Flood Priorities
To determine which shape should be flooded first, you must set a flood priority to each shape. A shape 
with a lower priority number will be flooded before an object with a higher priority number. Copper planes 
on different layers are processed independently.
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Scenario 1
You have adjacent shapes with a 25mil copper-to-copper clearance rule value.

Figure 104. Scenario 1 with Same and Different Flood Priorities
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Copper Plane Flood Priorities

Scenario 2

You have an embedded shape within a copper plane.

Figure 105. Scenario 2 with Same and Different Flood Priorities

Scenario 3
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You have multiple overlapping shapes.
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Copper Plane Flood Priorities

Figure 106. Scenario 3 with Wrong and Correct Flood Priorities
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Related Topics
Setting Flooding Order of Overlapping Copper Planes

Flooding Copper Planes

Setting Flooding Order of Overlapping Copper 
Planes
The order in which copper planes are flooded will determine how they will appear in the design. You must 
set a flood order, (called the “priority”) for each object to define which copper plane should be flooded first. 
An object with a lower priority number will be flooded before an object with a higher one. Copper planes 
on different layers are processed independently.

Procedure
1. Right-click and click the Select Shapes  popup menu item.

2. Select the copper plane.

Restriction:
The area you select cannot be a “plane hatch outline”  on page 1849.

Tip
To quickly give the area the highest priority, bring it to the front (right-click and click the 
Bring to front  popup menu item); to give it the lowest priority, send it to the back (right-
click and click the Send to back  popup menu item).

3. Right-click, then click the Properties  popup menu item.

4. In the Drafting Properties Dialog Box, click the Options  button. If the button does not appear, you 
have selected a hatch outline.

5. In the Flood and Hatch Options Dialog Box, set the flood priority. 0 (zero) is the highest priority 
(that is, it is flooded first and cannot be flooded over), and 250 the lowest.

Tip
You can also see the flood priority number in the status bar as P:<number>, when you 
select the area.

6. Click OK  to close all open dialog boxes.

Related Topics
Copper Plane Flood Priorities

Keepouts

788 SailWind Layout Guide and Reference



 
Filling Copper, and Copper Planes

Plane Thermal Indicators

Plane Thermal Indicators
Plane thermal indicators are graphic images that show the thermal attribute status of pads.

There are two types of plane thermal indicators, general and specific. Sometimes during editing, thermal 
markers are covered; redraw the screen to view all of the markers.

Table  120. Plane Thermal Indicators

Indicator Description

General Plane Thermal General plane thermal indicators show that a connection to 
a CAM or split/mixed plane exists somewhere within a pad 
stack. This indicator shows as a small "x" in the center of the 
pad:

Specific Plane Thermal Specific plane thermal indicators show that a specific pad 
on a specific layer is connected to a plane. These indicators 
appear in the color assigned to the board outline in the 
Display Colors Setup dialog box.
There is a different specific plane indicator for CAM planes 
and split/mixed planes:
CAM Plane Indicator:

Split/Mixed Plane Indicator:

Plane Antipad Pads that do not belong to a CAM or split/mixed plane net and 
are present on one of these layer types appear with a circle to 
represent the antipad. These pads use the color specified for 
that layer in the Display Colors Setup dialog box.
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Understanding How to Manipulate Copper 
Plane Thermals and Antipads
This section presents conceptual information that applies to the creation of copper planes and the use of 
custom thermals.

For procedures to create copper planes, see “Creating a Copper Plane Manually”  on page 667 and for 
custom thermals, see “Creation of Thermals in the Pad Stacks”  on page 186.

Common Copper Plane Thermal and Antipad Clearance Scenarios
Common Thermal Style Scenarios
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Common Copper Plane Thermal and Antipad Clearance Scenarios

Common Copper Plane Thermal and Antipad 
Clearance Scenarios
This section discusses the four most common setting-combinations that affect a design’s thermal and 
antipad clearances. Understanding these settings enables you to predictably create the thermal and 
antipad clearances that you desire.

Default Thermals and Antipads
Design Rules for Thermals and Antipads
Custom Thermals and Antipads
Hierarchy Between Custom Thermals and Antipads and the Use of Design Rules for Thermals and 
Antipads

Default Thermals and Antipads
There are a number of common settings for the default thermals and antipads. Once familiar with these 
settings, you can determine which ones you should use to accomplish your design goals.

Setup required:

1. Remove Unused Pads  on page 1514 check box selected (enabled)

2. Use Design Rules for Thermals and Antipads  on page 1514 check box cleared (disabled)

3. No custom thermals defined in Pad Stacks Properties  on page 1566

4. No custom antipads defined in Pad Stacks Properties  on page 1566

The Remove Unused Pads setting removes the pad from any component pin or via on an inner layer if 
that pin or via is not thermally tied to the copper plane or there are no routes coming off that pin or via on 
the plane layer.

Default thermals and antipads use the following basic formulas for calculating the clearance to the drill for 
antipads and the clearance to the pad for thermals:

• Default component through-hole antipad diameter = (2 x Copper-to-Pad clearance value) + pad 
size

• Default via antipad diameter = (2 x Copper-to-Via clearance value) + via pad size

Example:  +5V via in a +12V copper plane with 35 mil pad, 20 mil drill, and 8 mil copper-to-via clearance 
value would result in a 51 mil diameter antipad, (2 x 8) + 35 = 51. Default copper to pad or copper to via 
clearance on thermals is simply controlled by the copper-to-pad or copper-to-via values.

Note:
The drill-to-copper clearance is used when the drill size is larger than the pad size, as defined in 
the pad stack setup.
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The rules hierarchy  on page 404 influences the default antipad and thermal clearance sizes. A Net 
rule with a higher copper-to-pad value than the default rule will create larger antipad sizes and greater 
clearance on thermals for the pins of that net. A net rule created for the plane net will not affect the 
antipad clearance size, but will affect the copper clearance on thermals. Net rules for the opposing nets 
will affect antipad size.

Conditional rules have some special behaviors. A Conditional rule in which a net is set against a layer will 
utilize the default antipad calculation. However, a Conditional rule in which one net is set against another 
net will not affect the antipad size unless the “Use Design Rules for Thermals and Antipads” setting is 
enabled - see “Design Rules for Thermals and Antipads”.

Design Rules for Thermals and Antipads
These are a number of common settings for Design Rules for thermals and antipads. Once familiar with 
these settings, you can determine which ones you should use to accomplish your design goals.

Setup required:

1. Remove Unused Pads  on page 1514 check box selected (enabled)

2. Use Design Rules for Thermals and Antipads  on page 1514 check box selected (enabled)

3. No custom thermals defined in Pad Stacks Properties  on page 1566

4. No custom antipads defined in Pad Stacks Properties  on page 1566

The thermals and antipads are now independently controlled by the Design Rules. This method enables 
you to create large antipad sizes without affecting the clearance on pads with thermals. The antipad size 
created affects both vias and component pads.

• Antipad Diameter for component pads and vias = (2 x Copper-to-drill) + Drill size

Thermal clearance is controlled by design rules copper-to-pad and copper-to-via settings. The rules 
hierarchy influences the default antipad and thermal clearance sizes. A net rule for the plane net affects 
the antipad size of any opposing net if you adjust the drill-to-copper value.

Example:  A copper plane is defined for +12v, a net rule for +12v with an increased drill-to-copper value 
will cause the antipad size to increase for all non-connected pins or vias within the +12v copper plane.

Conditional rules have some special behaviors. A Conditional rule in which a net is set against a layer will 
utilize the default antipad calculation - see “Default Thermals and Antipads.” However, a Conditional rule 
in which one net is set against another net will not affect the antipad size unless the “Use Design Rules 
for Thermals and Antipads” setting is enabled.

Custom Thermals and Antipads
Custom thermals and antipads both have some common settings. Familiarize yourself with these settings 
to determine best which ones to use for accomplishing your design goals.

Setup required:

1. Remove Unused Pads  on page 1514 check box selected (enabled)

2. Use Design Rules for Thermals and Antipads  on page 1514 check box cleared (disabled)
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3. You have custom thermals defined in Pad Stacks Properties  on page 1566

4. You have custom antipads defined in Pad Stacks Properties  on page 1566

Design rule settings do not affect the custom antipad size you define for the decal(s). The custom pad 
stack settings determine thermal or antipad clearances as well as any clearance checks.

Note:
You must select the Remove Unused Pads check box to enable custom antipad creation.

Hierarchy Between Custom Thermals and Antipads and 
the Use of Design Rules for Thermals and Antipads
There are a number of common settings for establishing the hierarchy between custom thermals and 
antipads and the use of Design Rules for thermals and antipads. Once familiar with these settings, you 
can determine which ones you should use to accomplish your design goals.

Setup required:

1. Remove Unused Pads  on page 1514 check box selected (enabled)

2. Use Design Rules for Thermals and Antipads  on page 1514 check box selected (enabled)

3. You have custom thermals defined in Pad Stacks Properties  on page 1566

4. You have custom antipads defined in Pad Stacks Properties  on page 1566

All custom antipad settings are ignored on pins and vias. The antipad size are determined by the copper-
to-drill value in design rules.

• Antipad Diameter for component pads and vias = (2 x Copper-to-drill clearance value) + Drill size

A custom thermal’s inner diameter is still used (the actual pad size), however the copper-to-pad clearance 
is used for component pins and the copper-to-via clearance is used for vias. The outer diameter value 
from a custom thermal is ignored in favor of the design rules.
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Common Thermal Style Scenarios
This section discusses the three most common situations that affect thermal styles such as orthogonal, 
diagonal, flood over and no connect. Understanding these situations enables you to predictably create the 
thermal styles that you desire.

Thermal Style Changes in the Thermals Options
Hierarchy between Custom Thermals and Thermal Style Changes in the Thermals Options
Hierarchy Between Custom Thermals, Style Changes in the Thermals Options and Flood-over Vias in 
Copper Planes

Thermal Style Changes in the Thermals Options
There are a number of common settings for changing thermal styles in the Thermals options. Once 
familiar with these settings, you can determine which ones you should use to accomplish your design 
goals.

Setup required:

1. You have made thermal style changes in the Copper Planes  category > Thermals  on page 1514
subcategory.

2. No custom thermals are defined in Pad Stacks Properties  on page 1566

3. The “Flood over vias” check box is unchecked (disabled) in the Flood  on page 1381.

The thermal style you choose affects all component pins and all vias for all layers and for all copper 
planes. You can set different thermal styles for each of the four pad shapes: round, square, oval, and 
rectangle. You can also differentiate between through-hole and surface mount components.

For example:  It is possible to have a through-hole round pad with orthogonal spokes and a through-hole 
oval pad with a flood-over. You could also set up a through-hole round pad to be diagonal while an SMD 
round pad is set to no-connect.

Hierarchy between Custom Thermals and Thermal Style 
Changes in the Thermals Options
There are a number of common settings for establishing the hierarchy between custom thermals and 
thermal style changes in the Thermals options. After you become familiar with them, you can determine 
which settings you should use to accomplish your design goals.

Setup required:

1. You have made thermal style changes in the Copper Planes  category > Thermals  on page 1514
subcategory.

2. You have custom thermals defined in Pad Stacks Properties  on page 1566

3. The Flood over vias check box is cleared (disabled) in the Flood and Hatch Options  on 
page 1381.
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Settings adhere to those components with custom thermals defined. All other components and/or vias 
will follow the thermal styles defined in the Tools  > Options  menu item > Copper Planes  category > 
Thermals  subcategory. You can create a flood-over of specific pins or vias by creating a custom thermal 
and reducing the outer diameter size to be equal to the inner diameter size. You may find this very 
helpful if, for instance, you only want the two mounting hole pins of your component to flood-over when 
connecting to GND.

Hierarchy Between Custom Thermals, Style Changes 
in the Thermals Options and Flood-over Vias in Copper 
Planes
There are a number of common settings for establishing the hierarchy between custom thermals, style 
changes in the Thermals options and flood-over vias in the copper planes. Once familiar with these 
settings, you can determine which ones you should use to accomplish your design goals.

Setup required:

1. You have made thermal style changes in the Tools  > Options  menu item, Copper 
Planescategory > Copper Planes / Thermals  on page 1514 subcategory.

2. No custom thermals are defined in Pad Stacks Properties  on page 1566

3. The Flood over vias check box is selected (enabled) in the Flood and Hatch Options  on 
page 1381

Settings adhere to those components with custom thermals defined. For those vias that are within the 
copper plane in which you specified for “Flood Over Vias,” they all flood over, no custom thermals adhere 
within that copper plane polygon. To set Flood Over Vias, select the copper plane in pour outline mode, 
right-click and click the Properties  popup menu item, click on the Flood & Hatch Options  button, and in 
the Flood & Hatch Options dialog box, select the “Flood over vias” check box. The thermal styles defined 
in the Options dialog box > Copper Planes  category > Thermals  subcategory are adhered to by all 
remaining components and vias.

Generating Thermals
Component pins and vias automatically receive thermals if they are associated with a plane net and if 
they have pads on the associated CAM plane layer. For component pins and vias that receive thermals, 
the Plane Thermal option is automatically turned on in the Pin Properties dialog box.

• When you unassign a plane net from a plane layer, the thermals are removed for all of the pins in 
the net. The Plane Thermal option is automatically cleared in the Pin Properties dialog box.

• If during routing you add a via to a plane net, the via automatically receives a plane thermal. The 
Plane Thermal option is automatically selected in the Via Properties dialog box.

For information on how thermals translate to and from SPECCTRA, see the SPECCTRA Translator Help.

Check the Flood Priorities by selecting the shape, opening the Properties and clicking on the Options 
button. The Flood Priority numbers should be lowest for inner nested planes and greatest for the outer 
planes.
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Symptoms of Poor Thermal Results
Poor thermal connectivity can cause signal integrity problems in your design.

If the following symptoms occur, see “Troubleshooting Copper Plane Fills”  on page 674:

• Copper plane will not flood

• Problems with split/mixed planes

Thermals on CAM Planes
When you generate thermals for CAM plane plots, SailWind Layout looks for plane netnames associated 
with CAM plane layers. SailWind Layout also checks that pins or vias with pads on the CAM plane layer 
have the Plane Thermal option selected in the Pin Properties and Via Properties dialog boxes. Use the 
“Show General Copper Plane Indicators” option in the Tools  > Options  menu item, Copper Planes 
category > Thermals  subcategory to display CAM plane thermals.

When a pin exists in a net that is associated with a CAM plane layer and Plane Thermal is selected for 
the pin, a thermal appears on the pin. The ratsnest connections still appear. Use plane check in Verify 
Design to verify thermal generation for CAM plane plots.

CAM Plane Thermals
CAM plane thermals are displayed in the work area and the CAM preview area.

These calculations are also used for output during printing, pen plotting, and photo plotting operations:

• The outer diameter of the thermal matches the width of the aperture set in the Photo Plotter 
Setup Dialog Box.

• The inner diameter is 75% of the outer diameter.

• The number of spokes is always four, arranged diagonally.

• The spoke width is 1/6 of the outer diameter.

Tip
The inner width for custom CAM plane thermals is set as the pad size defined in the Pad Stacks 
Properties dialog box. The outer width is set as the default same-net pad to corner rule.

Viewing Plane Layer Connectivity
For CAM plane layers, the Plane Thermal option determines whether the thermal is generated for the pin. 
The Plane Thermal option signals CAM output to assign a D-code for a thermal relief aperture around the 
pins. Set the Plane Thermal option using the Properties dialog boxes for pins, vias, and jumper pins.

If you set up a plane connection successfully, a D-Code number is assigned for a thermal relief pad in 
your photoplotter aperture table, one that matches each pad size required. For more information, see the 
Results section of “Creating a CAM Plane Gerber-format File”.
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Thermals on Copper Plane Areas
SailWind Layout follows certain procedures for thermals appearing in copper planes.

SailWind Layout looks for the same net name for objects to connect with a copper plane thermal:

• A component pin receives a thermal connection to a copper plane if there is no trace connected 
to it and the net name of the pin matches the net name of the copper plane.

• A component pin with a trace connected to it may receive a thermal connection if the “Add 
thermals to routed component pads” check box is selected in the Tools  > Options  menu item > 
Copper Planes  category > Thermals  subcategory.

• During copper plane flooding, vias always get copper plane thermals if the netname of the via 
matches the netname of the surrounding copper plane, whether they show unroutes or not.

Ratsnets connections still appear after the software pours the copper plane and installs the copper plane 
thermals. Click the View  > Nets  menu item to open the View Nets dialog box and assign the net to the 
View list. In the View Details area, select the “Traces Plus the Following Unroutes” check box and set the 
corresponding option to “All Except Connected Plane Nets. Choose the Tools  > Verify Design  menu item 
to check connectivity for copper planes.

Setting Pins and Vias as Thermals
Jumper pins, pins, and vias can all have thermals. For these objects to be eligible for a thermal, the Plane 
Thermal check box in the Jumper Pin Properties, Pin Properties, and Via Properties dialog boxes must be 
enabled.

If you select more than one pin or via where both plane nets and non plane nets are included, and not 
all pins and vias are marked as eligible for indicators, the Plane Thermal check box is neither selected 
or cleared but shows is a solid square showing a mixed state. If you click to select Plane Thermal, the 
selected plane net pins or vias are updated.

Design Rule Versus Pad Stack - Thermals and Antipads
There are two ways to apply thermal and antipad settings. One is design-based, and uses the design rule 
hierarchy to apply the settings. The second is component-based, and uses the pad stacks to customize 
the thermals and antipads of component pins and vias. You can use a combination of design rule and pad 
stack thermal and antipad settings.

Design Rule Thermals and Antipads

Design rule thermals are defined by the settings of the Thermals Options and the Copper-to-Pad or 
Copper-to-Via clearance rules. In the Thermals Options you define the spokes, and using the clearance 
rules, you define the gap between the pad and the copper.

Design rule antipads are defined by the Pad to Copper and Via to Copper clearance rules. You can use 
the hierarchy of the design rules to create different gaps between the drill and copper of antipads. For 
example, using the Net level of the Rule hierarchy, you could apply a larger gap to any pad connected to 
a particular net. Antipads can be defined by the Drill to Copper clearance rule when you select the “Use 
design rules for thermals and antipad” check box in the Options dialog box > Copper Planes  category > 
Thermals  subcategory.

You can only apply separate spoke settings to drilled and non-drilled thermals. The spoke settings 
globally apply to all pads of either type. If you need to customize the spoke settings of individual pads, 
you should use the pad stack thermal and antipad settings.
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Pad Stack Thermals and Antipads

The pad stack thermals and antipads offer full control over all aspects of thermals and antipads. Unlike 
the design rule thermals and antipads, you can control the spokes of individual pads.

If you apply pad stack thermals and antipads to decals in the library, those settings may not apply to 
different PCB designs. You may want to only apply the pad stack settings to instances of the decal in the 
design rather than the decal in the library.

Priority

Although you can use a combination of design rule and pad stack thermal and antipad settings, the pad 
stack settings take priority over the more global design rule settings.
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Flood Over Pads in a Copper Plane
You can flood over pads in a copper plane. There are two methods that you can use to flood over pads.

To flood over vias, see “Flood Over Vias in a Copper Plane.”

Flooding Over Pads Using the Thermals Options
Flooding Over Pads Using a Custom Thermal in the Pad Stack

Related Topics
Flood Over Vias in a Copper Plane

Flooding Over Pads Using the Thermals Options
You can use the Flood over option in the Thermals options to flood over all pads in a specific copper 
plane.

Restrictions and Limitations
These settings apply only when you are not using custom thermals.

Procedure
1. Click the Tools  > Options  menu item.

2. Click the Copper Planes  category > Thermals  on page 1514 subcategory.

3. For the pad shape, select the cell in the Drilled Thermals or SMT Thermals column to expand the 
list.

4. Click “Flood over”.

5. Repeat steps 2 and 3 for each pad shape you need to flood over.

6. Click OK.

7. Re-flood the area.

Results
The selected area is flooded with copper. All of the pad shapes you chose in Step 2 are flooded over.

Flooding Over Pads Using a Custom Thermal in the 
Pad Stack
You can create flood-over pads for component pads on any layers containing copper planes. Use this 
procedure if you do not want to flood over every object of a certain shape; you can flood over selected 
pad stacks.
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Procedure
1. Click the Setup  > Pad Stacks  menu item.

2. In the Pad Stacks Properties Dialog Box, in the Pad Stack Type area, select Decal.

3. Select a decal in the Decal Name list.

4. Select a pin from the “Pin: Plated:” list

5. Select a layer from the “Sh: Sz: Layer:” list.

6. In the “Pad style” area, click the Thermal  tab and click a pad shape from the buttons.

7. Select the “Flood Over” check box.

8. Repeat steps 5-7 for other layers of the decal pin that require thermal settings.

9. Click OK  then click Yes  to apply this update to the selected component or all components with this 
decal.

Note:
Clicking Selected  appends the decal name with a letter to differentiate the padstack 
settings for the selected component from those applied to all other components with the 
same decal.

10. Repeat steps 1-9 for other decals for which you want flood-over pads.

11. For via and jumpers pads, flood-over settings are stored per type. Create a new via type if required 
for flood-over definition, then follow steps 1-8 but select “Via” as the pad stack type in step 2.

Tip
You can flood-over vias in copper planes using the Flood and Hatch Options Dialog Box. 
You can also flood over all drilled or SMT pads of a particular shape by setting options in 
the Tools  > Options  menu item > Copper Planes  category > Thermals  subcategory.
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Flood Over Vias in a Copper Plane
You can flood over pads or vias in a copper plane. There are two methods that you can use to flood over 
vias.

• Flooding over vias by setting the drafting properties of the copper plane — Use this procedure to 
flood over vias in a copper plane area.

• Flooding over vias using a custom thermal in the pad stack — Use this procedure to flood over 
vias in a copper plane. Use this procedure if you do not want to flood over every object of a 
certain shape; you can flood over selected pad stacks.

To flood over pads, see “Flood Over Pads in a Copper Plane”.

Flooding Over Vias By Setting the Drafting Properties of the Area
Flooding Over Vias Using a Custom Thermal in the Pad Stack

Related Topics
Flood Over Pads in a Copper Plane

Flooding Over Vias By Setting the Drafting 
Properties of the Area
You can use the Drafting Properties of the area to flood over vias in a copper plane.

Procedure
1. Select the copper plane outline.

2. Right-click and click the Properties  popup menu item.

3. Click the Flood & Hatch Options  button.

4. In the Flood and Hatch Options Dialog Box, select the Flood over vias check box.

If the Flood & Hatch Options  button is unavailable, close the dialog box, use the modeless 
command “PO” to switch to the pour outline mode, and repeat steps 1-4.

5. Click OK  and then click Yes  to proceed with the flood.

Tip
Click No  to flood the area later on.

6. Close the Drafting Properties dialog box.

Results
The selected area floods over with copper. Any vias connected to the net also flood over, and there are no 
longer any thermal spokes on the vias.
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Flooding Over Vias Using a Custom Thermal in the 
Pad Stack
You can use the Thermal Pad style option in the Pad Stacks Properties dialog box to flood over vias in a 
copper plane. Use this procedure if you do not want to flood over every via of a certain shape; you can 
flood over selected via types.

Procedure
1. Click the Setup  > Pad Stacks  menu item.

2. In the Pad Stacks Properties Dialog Box, in the Pad Stack Type area, select Via.

3. Select the via name in the Decal name  list.

4. Choose the layer you want from the Sh: Sz: Layer  list.

5. In the Parameters area, select Thermal  from the Pad style  list.

6. Select the appropriate pad shape button.

7. Select the Flood over check box.

8. Click OK  and then click Yes  to apply the changes to all vias of that type.

The selected pads stacks are flooded over in the copper plane.

Filling a Shape with a Pattern of Vias
To fill a copper plane with a pattern of stitching vias, use the Via Stitch operation in Fill mode.

Figure 107. Shape Stitched with Vias
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Filling a Shape with a Pattern of Vias

Procedure
1. If you have not done so, set the options for stitching shapes in the Tools  > Options  menu item > 

Via Patterns  category. For information, see “Setting Options for Via Patterns  on page 1556”.

Set the Pattern setting to Fill on the Via Patterns  tab or set it after you select the object. (See Step 
3.)

Tip
Your Via Pattern settings are stored for future operations. You need to perform this step 
only if you want to change the settings

2. Select the shape you want to stitch with vias. The shape can be:

• Drawn copper

• A flooded copper plane

• A hatch outline for a copper plane

Restriction:
The copper or copper hatch outline must be associated with a net.

3. Right-click and click the Via Stitch  popup menu item.

Tip
To override the Pattern (Fill or Perimeter) setting in the Via Patterns Options, right-click and 
click the Via Stitch Mode popup menu item, then select the pattern.

Results
The selected copper or hatch outline is filled with the pattern of vias.

Note:
If the Design Rule Checking (DRC) setting is Prevent Errors, the Via Stitch operation does not 
add any via that violates design rules.

Related Topics
DRC and the Via Stitching and Shielding Operations

Vias

Placing Vias Inside the Perimeter of a Shape

SailWind Layout Guide and Reference 803



Filling Copper, and Copper Planes
Placing Vias Inside the Perimeter of a Shape  

Placing Vias Inside the Perimeter of a Shape
You place vias inside the perimeter of a copper plane or a hatch outline by using the Via Stitch command 
in Perimeter mode.

Figure 108. Vias Inside Perimeter

Procedure
1. If you have not done so, set the options for stitching shapes in the Via Patterns Options. For 

information, see “Setting Options for Via Patterns  on page 1556”.

Set the Pattern setting to Perimeter on the Tools  > Options  menu item > Via Patterns  category or 
set it after you select the object. (See Step 3.)

Tip
Your Via Pattern settings are saved for future operations. You need to perform this step 
only if you want to change the settings

2. Select the shape you want to stitch with vias. The shape can be:

• Drawn copper

• A flooded copper plane

• A hatch outline for a copper plane

3. Right-click and click the Via Stitch  popup menu item.
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Surrounding a Void with Vias

Tip
To override the Pattern (Fill or Perimeter) setting in the Via Patterns Options, select Via 
Stitch Mode, then select the pattern.

Note:
If the Design Rule Checking (DRC) setting is Prevent Errors, the Via Stitch operation does 
not add any via that violates design rules.

Related Topics
DRC and the Via Stitching and Shielding Operations

Filling a Shape with a Pattern of Vias

Surrounding a Void with Vias
When you use the Via Stitch operation to place vias inside the perimeter of a shape, by default the 
operation does not place vias around a void within that shape. You can change the default behavior for 
the Via Stitch operation.

CAUTION:
Exit SailWind Layout before you edit the SailWind.ini  file.

Procedure
1. In a text editor, open the SailWindpcb.ini  file. The file’s location is:

C:\<install_folder>\<version>\Settings

2. Change the VS_StitchVoids value to 1. For example:

[ViaShield]
VS_StitchVoids=1

3. Restart SailWind Layout.

Results
The Via Stitch operation not only places vias inside the perimeter of a shape but also surrounds voids 
within the shape.
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Figure 109. Vias Surrounding a Void
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Chapter 35
Reference Designators

Reference designators are used to identify individual design objects. This section describes the use of 
reference designators in the design.

Standard Reference Designators
Generating a Second Set of Reference Designators for Assembly Drawings
Moving a Reference Designator
Moving Reference Designators to the Silkscreen Layer
Disabling Reference Designators of Selected Components

Standard Reference Designators
In order to promote continuity across the industry, standardized reference designators have been created 
for each of the major component and design object types. This topic presents a table containing the 
standard reference designator definitions from the IPC-2612 standard for schematic symbol generation.

Table  121. Standard Reference Designators

Prefix Description Prefix Description

A separate assembly LS loudspeaker, buzzer

AR amplifier M meter

AT attenuator, isolator MG motor-generator

B blower, motor MH* mounting hole

BT battery MK microphone

C capacitor MP mechanical part

CB circuit breaker P connector, plug, male

CP connector adapter, coupling PS power supply

CN capacitor network Q transistor

D or CR diode R resistor

D or VR breakdown diode RN resistor network

DC directional coupler RT thermistor

DL delay line S switch

DS display, lamp T transformer
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Table  121. Standard Reference Designators  (continued)

Prefix Description Prefix Description

E terminal TB terminal board, terminal strip

F fuse TC thermocouple

FD fiducial TP** test point, in-circuit test points

FL filter TZ transzorb

G generator, oscillator U inseparable assembly, IC package

GN general network V electron tube

H hardware VR voltage regulator

HY circular, directional coupler W wire, cable, cable assembly

J connector, jack, female X fuse holder, lamp holder, socket

K contactor, relay Y crystal, magnetostriction oscillator

L coil, inductor, bead, ferrite bead Z miscellaneous

*These class letters would not appear in a parts list as they are part of a PCB and not an active electronic 
component.

**Not a class letter, but commonly used to designate test points for maintenance purposes.

Note:
Note: The above list is not exhaustive. See the standard list of class designation letters in ANSI 
Y32.2/IEEE Std 315, Section 22 and the Index.

Generating a Second Set of Reference 
Designators for Assembly Drawings
You can generate a second set of reference designators, from the components on your board, to place on 
the Assembly Drawing layers.

For assembly drawings, you typically place the reference designators in the center of the components. 
But for the silkscreen, you place the reference designators outside the component. Instead of moving the 
reference designators for the silkscreen gerber file, and the assembly drawings, you create a second set 
for the assembly drawings. While you can add two sets of reference designators when you create the 
decal, the following procedure assumes you only have one set of reference designators on the silkscreen 
layers, placed optimally for the silkscreen.

808 SailWind Layout Guide and Reference



 
Reference Designators

Moving a Reference Designator

Procedure
1. Select all components on either the top, or bottom layer.

For selection instructions, see “Object Selection.” You might need to hide the opposite mounted 
layer or set your selection filter to select only objects on the one layer.

Tip
Use the Z modeless command  on page 83 to hide and reveal specified layers.

2. Right-click and click the Add New Label  popup menu item.

3. In the Add New Part Label Dialog Box, ensure the Attribute list is set to “Ref.Des”.

4. In the Layer list, select either the Assembly Drawing Top or Assembly Drawing Bottom layer.

The layer to which you are moving the labels needs to be set as visible and a non-background 
color applied to reference designators on that layer in order for you to see the new labels on the 
layer. For more information, see “Setting Global Colors of Design Objects  on page 131.”

5. Use the Position and sizes area to move all reference designators to the origin of components.

This is a quick way to center reference designators of surface mount components and any other 
components whose origin is at the center and not pin 1.

a. In the Position and sizes area, select the Relative to Component check box.

b. In the X and Y boxes, type 0 (zero).

c. In the Justification area, for both Horizontal and Vertical lists, click Center.

6. Click OK.

7. You will need to manually center any components with origins not at the center of the component.

See “Moving a Reference Designator.”

Related Topics
Disabling Reference Designators of Selected Components

Moving Reference Designators to the Silkscreen Layer

Moving a Reference Designator
As you reposition objects in your design, reference designators may have to be moved so that they 
remain legible and avoid conflict with other design objects. You can move reference designators to 
optimize their location on the PCB.

SailWind Layout Guide and Reference 809



Reference Designators
Moving Reference Designators to the Silkscreen Layer  

Procedure
1. Use one of the following methods to begin moving the reference designator:

• Object mode — Select a reference designator then right-click and click the Move  popup menu 
item.

• Verb mode — On the Design Toolbar, click the Move Reference Designator  button, then select 
the reference designator that you want to move.

2. With the reference designator attached to the pointer, click to indicate a new location for the 
reference designator.

Moving Reference Designators to the 
Silkscreen Layer
If your components have been designed with reference designators included on layers other than the 
silkscreen layer(s) such as Layer Top or Layer Bottom, you can move them to the silkscreen layer(s) in 
the design.

Procedure
1. Select all components on either the top, or bottom layer.

For selection instructions, see “Object Selection.” You might need to hide the opposite mounted 
layer or set your selection filter to select only objects on the one layer.

Tip
Use the Z modeless command  on page 83 to hide and reveal specified layers.

2. Right-click and click the Properties  popup menu item.

3. In the Component Properties Dialog Box, click the Labels  tab.

4. In the Label list, select “Ref.Des”.

5. Click the button underneath the Label list.

6. In the Part Label Properties Dialog Box, in the Layer list, select the correct silkscreen layer for the 
components you have selected at the beginning of this procedure.

7. Click OK  to move the reference designator labels to the specified layer.

8. Repeat this procedure for labels on the opposite layer.
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Disabling Reference Designators of Selected Components

Related Topics
Generating a Second Set of Reference Designators for Assembly Drawings

Disabling Reference Designators of Selected Components

Object Selection

Disabling Reference Designators of Selected 
Components
You can disable the display of the reference designator label for a component. If you turn off the reference 
designator label, it is also not visible in the CAM outputs for manufacturing the PCB.

This feature could be used to disable the reference designators of mounting holes placed in the design 
from parts stored in the library. As parts, they have reference designators, but they do not need reference 
designators to show up in the silkscreen.

Tip
You can hide the display of all reference designators by layer using the Display Colors Setup 
Dialog Box.

Procedure
1. Select a reference designator.

2. Right-click and click the Properties  popup menu item.

3. In the Part Label Properties Dialog Box, in the Show list, click None.

4. Click OK  and the reference designators label is turned off.

Related Topics
Generating a Second Set of Reference Designators for Assembly Drawings

Moving Reference Designators to the Silkscreen Layer

Object Selection
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Chapter 36
ECO (Engineering Change Order)

As you develop new iterations of your design, you may need to create an ECO (Engineering Change 
Order) to capture the changes and forward or back annotate them between the schematic and the 
printed circuit board designs. This section discusses the purpose and use of Engineering Change Order 
operations.

Engineering Change Order Operations
ECO Toolbar
Recorded Versus Generated ECO Files
Recording ECO Changes
ECO-Registered Parts
ECO-Registered Attributes
ECO Mode Operations (Layout-Driven Design Tools)

Engineering Change Order Operations
ECO operations include any processes that modifies the connection list or parts list. These operations 
include deleting, adding, and changing various aspects of decals, parts, nets, pin pairs, pad stacks, 
attributes, or design rules.

You must be in ECO mode before you can make such edits. In ECO mode, SailWind Layout can record 
your changes in a text file called the ECO file. You can use the ECO file as a reference to update, or 
back-annotate, the schematic.

ECO Toolbar
The ECO Toolbar provides quick access to commands that allow you to create and update Engineering 
Change Orders associated with your design.

Use the ECO Toolbar to:

• Make engineering (netlist) changes to a schematic-driven design.

When laying out a schematic-driven design, you need to record any netlist changes you make 
in order to back-annotate them to the schematic. To do this, you work in ECO mode to record 
your changes, and use the ECO Toolbar tools to make the changes, which are saved in a text 
file called the ECO file (.eco). Then you use the ECO file to back-annotate the changes to the 
schematic.

You can also create an ECO file by using the Compare/ECO dialog box (Tools  menu > 
Compare/ECO  menu item).

• Create a layout-driven design.

In a layout-driven design (with no schematic), you use the tools in the ECO Toolbar to create the 
netlist (add parts and make connections). Since there is no schematic to back-annotate to, you do 
not need to save changes in an ECO file.
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Recorded Versus Generated ECO Files
It is always a best practice to record the engineering changes you make to your design. When you record 
the changes, an exact list is kept of the before and after change to objects.

For example, the .eco  file will list that capacitor C42 was renamed to C71. If instead, you generate a list 
of engineering changes by simply comparing two designs, there is no way for the software to determine 
the changes that were made to parts that are electrically identical. If there are four identical capacitors in 
the design with identical connections, it might report that C28 changed to C71 when that isn’t exactly what 
happened. Electrically, there’s nothing wrong with these arbitrary decisions since the capacitors have the 
same value and are attached to the same nets. But if you compared how those capacitors are placed in 
the layout relative to how they’re placed in the schematic, it might not make sense and it could lead you to 
be concerned that something terrible has occurred with the synchronization of the design.

So, depending on how you create the .eco  file, a renumbered back annotation can have different effects, 
one of which can be inconvenient to cross probing or double-checking the results of the renumbering - 
comparing the schematics to the layout. Using a recorded .eco  file is the best option and can be used 
in all three methods of back annotation including manual and automated methods. If you record the 
renumbering of the reference designators in the .eco  file while you use the autorenumber tool, you will 
have a perfect (was...is) before and after listing of the changed reference designators.

But if you generate the .eco  by comparing netlists, you will not have an exact (was...is) before and after 
list of the discretes in the schematic. Discretes that are identical components and have identical net 
connections are indistinguishable in the netlist. Electrically the changes will be correct. But since there is 
no placement information in netlists, an .eco  file generated by comparison won’t be able to determine the 
exact refdes exchange of these discretes.

Recording ECO Changes
If you are working on a schematic-driven design, you will need to back-annotate design changes to the 
schematic. You can record your netlist changes and then save them to an ECO file.

Procedure
1. On the Standard Toolbar click the ECO Toolbar  button.

If the ECO Options dialog box does not appear, click the ECO Options  button on the ECO Toolbar 
to open it.

2. In the ECO Options dialog box:

a. Select the “Write ECO file” check box.

b. Make sure that the pathname of the .eco  file in the “Filename” text box is correct. (If the file 
does not exist, it is created and recorded changes are written to it. Existing .eco  files are left 
untouched.)

c. If the .eco  file already exists, specify what to do with it:

• To append ECO changes you make in this session to the existing file, select the Append to 
file check box.

• To overwrite the existing file with the changes you make in this session, clear the Append to 
file check box.
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ECO-Registered Parts

d. Specify when ECO changes will be saved:

• To be able to save ECO changes incrementally during the session, so you can view them in 
the ECO file, select the Write ECO file after closing ECO toolbox check box.

• To save ECO changes only when you save the .pcb  file, open a new file, or exit SailWind 
Layout, clear the Write ECO file after closing ECO toolbox check box.

e. Set the other options as appropriate. See the “ECO Options Dialog Box” topic.

f. Click OK.

Results
Any netlist changes you make are recorded. If you have selected the Write ECO file after closing ECO 
toolbox check box, the changes are written to the ECO file when you close the ECO toolbox; otherwise 
they are saved when you save the design, open a new file, or exit the software.

If you clear the Write ECO file or the Write ECO file after closing ECO toolbox check box during a session, 
all recorded change data, both in memory and in the ECO file, are deleted.

Related Topics
Recorded Versus Generated ECO Files

Backward Annotation from SailWind Layout to SailWind Logic

ECO-Registered Parts
A part is ECO-registered when you edit the part with the Library Manager, select ECO Registered Part on 
the General tab of the Part Information dialog box, and then save the part to the library. Once a part has 
been assigned the ECO Registered status, it can be identified for inclusion or exclusion during the ECO 
update processes.

When updating a design with changes from a schematic or updating a schematic with changes from a 
design, you can exclude or include non-ECO-registered parts from ECO processing. In the ECO Options 
Dialog Box, do one of the following:

• If you want ECO processing to exclude non-ECO-registered parts, select the “Output Only ECO 
Registered Parts” check box.

• If you want ECO processing to include non-ECO-registered parts, which includes non-electrical 
parts, clear the “Output Only ECO Registered Parts” check box.

You must be in ECO mode to add, delete, rename, or alter a part regardless of whether it is registered or 
not.

Avoid connecting non-ECO-registered parts, such as mechanical hardware, to ECO-registered netlist 
items, such as GND. A conflict may occur when an ECO-registered item is connected to a non-ECO-
registered item.
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ECO-Registered Attributes
Both ECO-registered and non-ECO-registered attributes can be added, deleted, or changed in ECO 
mode.

To turn on ECO Registration for attributes, use the Objects tab of the Attribute Properties dialog box 
on page 1111. Also turn on ECO Registration for any attributes you want to backward annotate to the 
schematic. Via attributes are not registered attributes, therefore you can add, delete, or change them in 
ECO mode or non-ECO mode.

You can exclude non-ECO-registered attributes from ECO processing by clearing the “Compare Only 
ECO Registered Attributes” check box in the Comparison  tab of the Compare/ECO Tools dialog box  on 
page 1181.

When updating a design from a schematic, a report automatically appears indicating the ECO registration 
of imported attributes. When an attribute does not exist in the Attribute Dictionary, it is added with ECO 
registration turned off. If the attribute already exists in the dictionary, the existing attribute and ECO 
registration in the dictionary are used.
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ECO Mode Operations (Layout-Driven Design Tools)

ECO Mode Operations (Layout-Driven Design 
Tools)
This section describes specific operations that you can perform only in ECO mode.

CAUTION:
A protected route or physical design reuse element can prevent you from making ECO changes. 
You must unprotect the route or break the reuse to proceed. If you are recording changes to an 
ECO file, the action of removing the protection on traces or breaking out reuse elements is not 
saved.

Predefined Netnames
Added Connection
Adding a Connection in ECO Mode
Adding a Route in ECO Mode
Adding a Component in ECO Mode
AutoRenumber Sweeps
Changing the Reference Designators of Multiple Components in ECO Mode (Autorenumbering)
Changing a Component in ECO Mode
Updating a Part Type from the Library in ECO Mode
Copying a Part in ECO Mode
Deleting a Component in ECO Mode
Deleting a Connection in ECO Mode
Splitting a Net in ECO Mode
Deleting a Net in ECO Mode
Changing the Reference Designator of a Component in ECO Mode
Changing the Reference Designator Prefix of Multiple Components in ECO Mode
Renaming a Net in ECO Mode
Swapping ECL Terminators Automatically in ECO Mode
Swapping Gates
Swapping Pins
Copied Bridge Copper in ECO Mode
Illegal Characters in Netnames and Part Names

Predefined Netnames
When you add a net to the design using the Add Route, Add Connection, or Copy Route command, the 
Derive Net Name from Pin Function shortcut menu option controls how the added net is named. When 
this option is enabled, the pin's pin name determines the net name. If no pin name exists, or this option is 
disabled, the net name is automatically generated.

Use the Derive Net Name from Pin Function option when creating the design on the fly instead of creating 
the design from the netlist generated by the schematic tool. For example, in a typical BGA design you 
manually connect each die part's substrate bond pad to a BGA component pad using the Add Route or 
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Add Connection command. To give the added net a meaningful name, enable Derive Net Name from Pin 
Function to derive the net name from the die part pin name, for example, GND.

Added Connection
When adding connections, the command behavior is dependent upon the condition of the pins that are 
being connected such as pins not in a net, one pin in a net, one pin defined as an output or merging nets.

In example 1 shown in Figure 110, Pin 1 and Pin 2 are not in a net. A pin name (function) exists for one of 
the pins.

Connecting Pin 1 and Pin 2 opens the Define Name of Net dialog box.

Figure 110. Added Connection When Pins are Not in a Net

Clicking Add Pins to OUTPUT in the Define Name of Net dialog box adds Pin 1 and Pin 2 to netname 
OUTPUT (Figure 111).

Figure 111. Added Pin 1 and Pin 2 to Netname OUTPUT

In example 2 shown in Figure 112, one of the pins is in a net. One of the pins has a pin function defined.

Figure 112. Added Connection When One of the Pins is in a Net
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Adding a Connection in ECO Mode

When you connect Pin 1 and Pin 2, the Define Name of Net dialog box appears. Choose the name you 
want to assign to the merged nets. The nets are then merged as shown in Figure 113.

Figure 113. Merging Nets

Adding a Connection in ECO Mode
When you create a new pin pair in your design and it will change the current netlist. ECO Mode captures 
this change and preserves it for later back annotation to the schematic. While adding the new connection, 
you have a number of naming options available.

CAUTION:
When you modify or delete design objects, electrical nets are regenerated. This can cause 
existing electrical nets that include these objects to be truncated, split, or deleted altogether.

Procedure
1. Click the ECO Toolbar  > Add Connection  button0

If this is the first time in the current session you are using the ECO Toolbar, the ECO Options 
Dialog Box  appears. Set the options you want and click OK  to use the ECO tools.

2. Select the first pin in the connection.

While adding a connection:

• You can right-click and click the Rename Current Net  popup menu item to rename the net of 
the current pin. In the Rename Net prompt, type the new name and click OK. The maximum 
netname length is 47 characters. For more information, see “Illegal Characters in Netnames 
and Part Names”.

• You can rename the net of the current pin, as follows:

• To use the pin function as the net name, right-click and click the Derive Net Name from Pin 
Function  popup menu item. For more information, see “Predefined Netnames”.

• To type in a new name, right-click and click the Rename Current Net  popup menu item. 
In the Rename Net prompt type the new name, and click OK. The maximum netname 
length is 47 characters. For more information, see “Illegal Characters in Netnames and Part 
Names.”

• To use the pin function as the net name, right-click and click the Derive Net Name from Pin 
Function  popup menu item. For more information, see “Predefined Netnames.”
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• To type in a new name, right-click and click the Rename Current Net  popup menu item. 
In the Rename Net prompt, type the new name, and click OK. The maximum netname 
length is 47 characters. For more information, see “Illegal Characters in Netnames and Part 
Names.”

3. Select the second pin in the connection.

If you are connecting to a pin of a different net (merging two nets), the Define Name of Merged Net 
Dialog Box  appears. Choose or type a new netname. (Netnames are automatically generated for 
each newly created connection.) For more information, see “Predefined Netnames”  on page 817.

4. Click another pin to continue adding connections to this net, or right-click and click the Cancel 
popup menu item to stop.

Related Topics
Illegal Characters in Netnames and Part Names

Adding a Route in ECO Mode
You can create routes that add to or change the current netlist, or that end a route on a segment with a 
different netname.

CAUTION:
When you modify or delete design objects, electrical nets are regenerated. This can cause 
existing electrical nets that include these objects to be truncated, split, or deleted altogether.

Procedure
1. Click the ECO Toolbar  > Add Route  button.

If this is the first time in the current session you are using the ECO Toolbar, the ECO Options 
Dialog Box  appears. Set the options you want and click OK  to use the ECO tools.

2. Select the pin at which to start the trace.

3. Begin routing.

Add corners and vias as described in “Routing Manually”. You can also use the shortcut menu to 
control routing operations. While routing:

• You can rename the net of the current pin. Right-click and click the Rename Current Net 
popup menu item. In the Rename Net prompt type the new name, and click OK. The maximum 
netname length is 47 characters. For more information, see “Illegal Characters in Netnames 
and Part Names”.

As an alternative you can use the pin function as the net name. Right-click and click the Derive 
Net Name from Pin Function  popup menu item. For more information, see “Predefined 
Netnames”.

• Right-click and click the Cancel  popup menu item to exit Add Route mode.
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Adding a Component in ECO Mode

• With Online DRC disabled, the pointer changes to a bull's-eye when it is near any eligible 
completion point, regardless of the net.

• With On-line DRC in Prevent errors mode  on page 1503, when routing a trace between pins 
that are not part of the same net or that have no netlist, all items are considered obstacles. To 
connect to the pin, right-click and click the Select Target  popup menu item and select the pin at 
which you want to end the trace.

• If you are connecting to a pin of a different net (that is, merging two nets), the Define Name of 
Merged Net Dialog Box  appears. Choose or type a new netname. (Netnames are automatically 
generated for each new connection.) For more information, see “Predefined Netnames.”

4. Select the pin on which to end the trace.

Related Topics
Illegal Characters in Netnames and Part Names

Adding a Component in ECO Mode
You can add a new component to your design in ECO Mode and it will change the current netlist. ECO 
Mode captures this change and preserves it for later back annotation to the schematic.

CAUTION:
When you modify or delete design objects, electrical nets are regenerated. This can cause 
existing electrical nets that include these objects to be truncated, split, or deleted altogether.

Restrictions and Limitations

• You cannot add a decal to a design if the design is in default layer mode and the decal to be 
added is in increased layer mode. Use the Layers Setup Dialog Box  to change the design to 
increased layer mode.

• A part must be ECO-registered  on page 1824 to be included in the ECO file. You set the ECO 
registration for parts in the Part Information dialog box  on page 1590.

Procedure
1. Click the ECO Toolbar  > Add Component  button.

If this is the first time in the current session you are using the ECO Toolbar, the ECO Options 
Dialog Box  appears. Set the options you want and click OK  to use the ECO tools.

2. In the Get Part Type from Library Dialog Box, to filter the part types, in the filter area, type a 
wildcard or expression  on page 155 in the Items box and click Apply.

If the Filter Items box is blank, no items will be displayed. Add an asterisk (*) to see all items of the 
library or library partition in the Part Types list.

3. Select the part name in the Part Types list box and click Add  to attach the component to the 
pointer.
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• If the selected part type already exists in the design with the specified name, the message “Part 
Type <name> already exists in design. Loading from Library is skipped, design's Part Type will 
be used” appears. Click OK  to continue. Go to step 4.

• If the specified part type does not exist in the design, but the decal name does exist, the 
message “Decal(s) <name> already exists in design. Loading of decal(s) from Library is 
skipped, design's data will be used” appears. This message appears only if the number of 
terminals in the library part and the design part are the same. Click OK  to continue. Go to step 
4.

• If the specified part type does not exist, and the number of terminals in the new decal does not 
match the number of terminals in the existing decal, the message “Decal <name> already exists 
in design. Library decal has different number of terminals than decal in design. Aborting Get 
Part Type from Library” appears. The Add Part process cancels in this case.

• If the number of terminals does not match in the alternate decals, the message “Library Part 
Type <library name:part type name> has decals with different number of terminals. Aborting Get 
Part Type from Library” appears. The Add Part process cancels in this case.

4. Click Close  to close the dialog box.

5. Optional: Assign a reference designator.

Unless you assign a reference designator, the new part is automatically annotated with the next 
available reference designator. You can change the reference designator before placing the new 
component. Right-click and click the Rename Current Part  popup menu item. In the Rename Part 
prompt, type the new reference designator, and click OK.

6. Move the part to the appropriate location and click to place the part.

Related Topics
Updating a Design from the Library

AutoRenumber Sweeps
The AutoRenumber result depends on the matrix created by the cell size and the directional pattern of 
the renumbering sweep. The values used in the Cell Size area of the AutoRenumber dialog box allow 
you to create custom renumbering sweeps of the board. Here we provide two usage examples and then 
recommend a best practice.

You can select one of eight different directional numbering patterns. Choose the pattern that best suits the 
orientation and shape of your board.
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AutoRenumber Sweeps

Figure 114. AutoRenumber Patterns

Wide Sweep Example
In this example, you accept the default Cell Size settings of the AutoRenumber dialog box. The On x and 
On y values are set to encompass your entire board. This produces one long, wide sweep. The result of 
using a wide sweep frequently results in unexpected numbering of the reference designators.

Figure 115. Wide Sweep Results

Narrow Sweep Example
In this example, you type a small value for the On y value of the Cell Size. The On y value is something 
small like 10 mils and it catches even the smallest variations in the alignment of components. The result 
of using a sweep that is too narrow results in numbering of components that don’t appear to be offset.
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Figure 116. Narrow Sweep Results

Best Practice
Based on the examples shown, the best practice to follow with renumbering is to create cells that do span 
your entire board, but in narrow sweeps. You may need to adjust the width of your sweep to achieve the 
desired result. When renumbering, the sweep uses the bottom pin of components as the origin.

For example, your board measures 4000 mils wide and 2000 mils high. You are renumbering left to right, 
top to bottom. You want to set your cell size to On x=4000 and On y=10.

Tip
If the reference designator renumbering isn’t exactly perfect, you can always manually renumber 
a few components that weren’t renumbered according to what you expected.

Related Topics
Changing the Reference Designators of Multiple Components in ECO Mode (Autorenumbering)

Changing the Reference Designators of Multiple 
Components in ECO Mode (Autorenumbering)
After you complete the final placement of a design, you can renumber the parts to order the reference 
designators in a recognizable pattern, such as top to bottom, left to right. This makes it easier to find a 
component on a fabricated board.

Autorenumbering is an ECO operation, so you must start ECO mode before you can autorenumber parts. 
The resulting ECO file contains part name changes for backward annotation to the associated design file.

CAUTION:
If you are renumbering a schematic-driven design that will be back-annotated to the schematic, 
you must record the autorenumber operation by checking the Write ECO file check box in the 
ECO Options dialog box before you renumber. Recording the exact changes in an .eco  file gives 
the best back annotation results. For more information, see “Recorded Versus Generated ECO 
Files”.
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Changing the Reference Designators of Multiple Components in ECO Mode (Autorenumbering)

CAUTION:
When you modify or delete design objects, electrical nets are regenerated. This can cause 
existing electrical nets that include these objects to be truncated, split, or deleted altogether.

Restrictions and Limitations

• A protected route or physical design reuse element can prevent you from changing a reference 
designator. You must unprotect the route or break the reuse to proceed. If you are recording 
changes to an ECO file, the action of removing the protection on traces or breaking out reuse 
elements is not saved.

• Jumpers are excluded from autorenumbering.

Procedure
1. Click the ECO Toolbar  > Auto Renumber  button.

(If this is the first time in the current session you are using the ECO Toolbar, the ECO Options 
Dialog Box  appears. Set the options you want and click OK to use the ECO tools.)

2. In the AutoRenumber Dialog Box, make sure the reference designation prefixes you want to use 
are selected in Prefix List. You must select at least one prefix.

3. In the Cell Size area, type the matrix size for the renumbering sweep.

For information about selecting cell sizes and renumbering patterns, see “AutoRenumber Sweeps”.

4. Make your renumbering choices in the Precedence area:

• For designs with parts on both top and bottom, select the “Continuous numbering side to side” 
check box to number all parts sequentially. In “Start Renumbering From” click either Top or 
Bottom.

• For the Top and/or Bottom, select the Renumber check box and indicate the “Start at” value and 
the Increment value if applicable.

• Click a renumbering pattern button for one or both sides.

5. Click OK.

Results
Are the results not what you expected? Click Edit > Undo  to undo the renumbering and start over. (You 
many want to revisit the “AutoRenumber Sweeps”.)

Related Topics
Recorded Versus Generated ECO Files

Recording ECO Changes

Backward Annotation from SailWind Layout to SailWind Logic
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Changing a Component in ECO Mode
Use Change Component to change the part type of one or more components, or all part types of the 
same name, to the part type of another component in the design or to a part type in the library.

The updated part type may contain a different decal assignment which can affect routing in the design. 
You can also update the part type with a newer version from the library  on page 827.

CAUTION:
When you modify or delete design objects, electrical nets are regenerated. This can cause 
existing electrical nets that include these objects to be truncated, split, or deleted altogether.

Restrictions and Limitations

• A protected route or physical design reuse element can prevent you from changing a component 
in ECO mode. You must unprotect the route or break the reuse to proceed. If you are recording 
changes to an ECO file, the action of removing the protection on traces or breaking out reuse 
elements is not saved.

• You cannot add a decal to a design if the design is in default layer mode and the decal to add is 
in increased layer mode. Use the Layers Setup Dialog Box  to change the design to increased 
layer mode.

Procedure
1. Click the ECO Toolbar  > Change Component  button.

(If this is the first time in the current session you are using the ECO Toolbar, the ECO Options 
Dialog Box  appears. Set the options you want and click OK to use the ECO tools.)

2. Type DRO and press the Enter key to turn off On-line DRC (Design Rules Checking).

3. Select the component or components whose part type you want to change.

To select a single component, click the component in the design area. To select multiple 
components, right-click and click the Find  popup menu item to use the Find dialog box. For more 
information, see the “Find Objects dialog box  on page 1378” topic.

4. Change the component using one of the following:

a. To change the component to a different part type from the design, click the component whose 
part type you want to use as the replacement.

b. To change the component to a part type from the library, right-click and click the Library 
Browse  popup menu item. The Get Part Type from Library Dialog Box  appears. To filter the 
part types, in the filter area, type a wildcard or expression  on page 155 in the Items box and 
click Apply. Locate and select the item, and then click Replace.

• If the selected part type already exists in the design with the specified name, the message 
“Part Type <name> already exists in design. Loading from Library is skipped, design's Part 
Type will be used” appears. Click OK  to continue.
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Updating a Part Type from the Library in ECO Mode

5. In the Change Component Dialog Box, you are prompted to confirm the change. Select the Keep 
Attributes check box if you want to retain the attributes of the part in the design.

6. If the modified Part Type changes the PCB decal or contains different pin numbers, you must map 
the old decal pin numbers to the new decal pin numbers in the Assign Pin Numbers Dialog Box.  on 
page 1104

Results
Change Component retains test points if the pin position is the same and the new terminal still has pads 
on the testing side; otherwise the test point is removed.

Updating a Part Type from the Library in ECO Mode
You can update part type data from a new version in the library. The updated part type may contain a 
different decal assignment which can affect routing in the design.

You can also change a component  on page 826 to another part type in the design or in the library.

CAUTION:
When you modify or delete design objects, electrical nets are regenerated. This can cause 
existing electrical nets that include these objects to be truncated, split, or deleted altogether.

Restrictions and Limitations

• You cannot add a decal to a design if the design is in default layer mode and the decal to add is 
in increased layer mode. Use the Layers Setup Dialog Box  to change the design to increased 
layer mode.

• A protected route or physical design reuse element can prevent you from updating a part type 
in ECO mode. You must unprotect the route or break the reuse to proceed. If you are recording 
changes to an ECO file, the action of removing the protection on traces or breaking out reuse 
elements is not saved.

Procedure
1. Click the ECO Toolbar  > Change Component  button.

(If this is the first time in the current session you are using the ECO Toolbar, the ECO Options 
Dialog Box  appears. Set the options you want and click OK to use the ECO tools.)

2. Type DRO and press the Enter key to turn off On-line DRC (Design Rules Checking).

3. Select the component or components whose part type you want to update.

4. Right-click and click the Library Browse  popup menu item.

5. In the Get Part Type from Library Dialog Box, select the Update Part Type from Library check box 
to update the selected part type with a new library definition of the same name.

The search locates and automatically highlights the library definition for the selected part type.

6. Click Replace.
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7. If there are additional components with the selected part type that you did not select in the design, 
you are prompted with the message, “Part type <name> will be replaced with Library item for ALL 
parts of this type in the design”. Click OK. Note that you must update all components that use the 
same part type.

8. You are prompted to confirm the change. Select the Keep Attributes check box if you want to retain 
attributes.

9. If the modified Part Type changes the PCB decal or contains different pin numbers, you must map 
the old decal pin numbers to the new decal pin numbers in the Assign Pin Numbers Dialog Box.  on 
page 1104

Results
Change Component retains test points if the pin position is the same and the new terminal still has pads 
on the testing side; otherwise the test point is removed.

Related Topics
Assign Pin Numbers Dialog Box

Changing a Component in ECO Mode

Updating a Design from the Library

Copying a Part in ECO Mode
Creating a copy of an existing part changes the netlist, is considered an engineering change and requires 
ECO mode.

CAUTION:
When you modify or delete design objects, electrical nets are regenerated. This can cause 
existing electrical nets that include these objects to be truncated, split, or deleted altogether.

Procedure
1. In the design, select the part to copy.

2. Click the ECO Toolbar  > Add Component  button.

(If this is the first time in the current session you are using the ECO Toolbar, the ECO Options 
Dialog Box  appears. Set the options you want and click OK  to use the ECO tools.) As an 
alternative, click the Edit  > Copy  menu item, then Edit  > Paste  menu item.

The component attaches to the pointer.

3. Optional: Before placing the component, you can assign a reference designator. If you do not, the 
new part is automatically annotated with the next available reference designator.

Right-click and click the Rename Current Part  popup menu item. The Rename Part prompt 
appears asking for a new reference designator. Type the new reference designator, and click OK.

4. Move the part to the appropriate position and click to place it.
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Deleting a Component in ECO Mode

Deleting a Component in ECO Mode
Deleting a component from the board changes the netlist, is considered an engineering change and 
requires ECO mode.

CAUTION:
When you modify or delete design objects, electrical nets are regenerated. This can cause 
existing electrical nets that include these objects to be truncated, split, or deleted altogether.

Restrictions and Limitations
A protected route or physical design reuse element can prevent you from deleting a component in ECO 
mode. You must unprotect the route or break the reuse to proceed. If you are recording changes to an 
ECO file, the action of removing the protection on traces or breaking out reuse elements is not saved.

Procedure
1. Click the ECO Toolbar  > Delete Component  button.

(If this is the first time in the current session you are using the ECO Toolbar, the ECO Options 
Dialog Box  appears. Set the options you want and click OK  to use the ECO tools.)

2. Set the selection filter to Select Components.

3. Select one or multiple components to delete.

You can select multiple components by dragging a box around them.

4. In the Delete Part Dialog Box, you can optionally select the Delete Routes check box to delete 
routes that are connected to the component(s).

5. Click OK  to confirm the deletion.

Test points are deleted with the part.

6. If the deletion of the component(s) creates single-pin nets, a second Delete Part dialog box  on 
page 1267 appears and displays which nets will also be deleted. This is not an optional step. Click 
Close.

Deleting a Connection in ECO Mode
Use Delete Connection to delete a pin pair, disconnect a pin from a net, or split a net into two different 
nets. This also deletes test point vias belonging to the connection. Deleting a connection changes the 
netlist, is considered an engineering change and requires ECO mode.

CAUTION:
When you modify or delete design objects, electrical nets are regenerated. This can cause 
existing electrical nets that include these objects to be truncated, split, or deleted altogether.
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Restrictions and Limitations
A protected route or physical design reuse element can prevent you from deleting a connection in ECO 
mode. You must unprotect the route or break the reuse to proceed. If you are recording changes to an 
ECO file, the action of removing the protection on traces or breaking out reuse elements is not saved.

Procedure
1. Click the ECO Toolbar  > Delete Connection  button.

(If this is the first time in the current session you are using the ECO Toolbar, the ECO Options 
Dialog Box  appears. Set the options you want and click OK to use the ECO tools.)

2. Do one of the following:

• Delete a Pin Pair — Select the connection or trace between the pins of the pin pair to delete it. 
If the net contains only one pin pair, selecting either pin deletes the pin pair.

• Disconnect a Pin — Select the pin to disconnect. If a net contains more than one pin pair, the 
Disconnect Pin Dialog Box  appears with an option to delete the route segment(s) going to the 
pin.

• Split a Net — See “Splitting a Net in ECO Mode” for information on how to do this.

Splitting a Net in ECO Mode
You can split a net by deleting a pin pair in the middle of multi-pin pair net. Splitting a net changes the 
netlist, is considered an engineering change and requires ECO mode.

Warning:
If you split a net associated to bridge copper, the association is removed from the copper.

CAUTION:
When you modify or delete design objects, electrical nets are regenerated. This can cause 
existing electrical nets that include these objects to be truncated, split, or deleted altogether.

Restrictions and Limitations
A protected route or physical design reuse element can prevent you from splitting a net in ECO mode. 
You must unprotect the route or break the reuse to proceed. If you are recording changes to an ECO file, 
the action of removing the protection on traces or breaking out reuse elements is not saved.

Procedure
1. Click the ECO Toolbar  > Delete Connection  button.

(If this is the first time in the current session you are using the ECO Toolbar, the ECO Options 
Dialog Box  appears. Set the options you want and click OK to use the ECO tools.)

2. Select the connection between pin pairs where the net should be split.
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Deleting a Net in ECO Mode

You are prompted with a message like this:

Click Yes.

3. In the Define Name of New Net Dialog Box, name the new net or let SailWind Layout automatically 
generate the new netname.

Netnames:

• Have a maximum length of 47 characters.

• Can contain any alphanumeric characters except brackets { }, asterisks *, commas (,), spaces, 
and question marks.

Results

• If a Color by Net setting exists for a net that is split, the new net uses the same color setting. For 
more information, see “Assigning Colors to Nets”.

• Test points belonging to the connection are deleted.

Deleting a Net in ECO Mode
You can delete all pin pairs and remove all pin connections from a net. Deleting a net changes the netlist, 
is considered an engineering change and requires ECO mode.

CAUTION:
When you modify or delete design objects, electrical nets are regenerated. This can cause 
existing electrical nets that include these objects to be truncated, split, or deleted altogether.

Restrictions and Limitations
A protected route or physical design reuse element can prevent you from deleting a net in ECO mode. 
You must unprotect the route or break the reuse to proceed. If you are recording changes to an ECO file, 
the action of removing the protection on traces or breaking out reuse elements is not saved.

Procedure
1. Click the ECO Toolbar  > Delete Net  button.

(If this is the first time in the current session you are using the ECO Toolbar, the ECO Options 
Dialog Box  appears. Set the options you want and click OK to use the ECO tools.)

SailWind Layout Guide and Reference 831



ECO (Engineering Change Order)
Changing the Reference Designator of a Component in ECO Mode  

2. Select a pin, unrouted pin pair, trace, or via in the net to delete.

3. Click OK  to confirm the deletion.

Delete Net also deletes test point vias that belong to the net.

Changing the Reference Designator of a 
Component in ECO Mode
You can change a single component’s reference designator using the Rename Component ECO tool. 
Changing a reference designator changes the netlist, is considered an engineering change and requires 
ECO mode.

CAUTION:
When you modify or delete design objects, electrical nets are regenerated. This can cause 
existing electrical nets that include these objects to be truncated, split, or deleted altogether.

Restrictions and Limitations
A protected route or physical design reuse element can prevent you from changing a reference 
designator in ECO mode. You must unprotect the route or break the reuse to proceed. If you are 
recording changes to an ECO file, the action of removing the protection on traces or breaking out reuse 
elements is not saved.

Procedure
1. Click the ECO Toolbar  > Rename Component  button.

(If this is the first time in the current session you are using the ECO Toolbar, the ECO Options 
Dialog Box  appears. Set the options you want and click OK to use the ECO tools.)

2. Select a single component.

3. In the Rename Part prompt, in the New Name box, type the new reference designator.

4. Click OK.

Related Topics
Recorded Versus Generated ECO Files

Recording ECO Changes

Backward Annotation from SailWind Layout to SailWind Logic

Changing the Reference Designator Prefix of 
Multiple Components in ECO Mode
You can change the reference designator prefix of multiple design components using the Rename 
Component ECO tool. This changes the netlist, is considered an engineering change and requires ECO 
mode.
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Renaming a Net in ECO Mode

CAUTION:
When you modify or delete design objects, electrical nets are regenerated. This can cause 
existing electrical nets that include these objects to be truncated, split, or deleted altogether.

Restrictions and Limitations
A protected route or physical design reuse element can prevent you from changing a reference 
designator prefix in ECO mode. You must unprotect the route or break the reuse to proceed. If you are 
recording changes to an ECO file, the action of removing the protection on traces or breaking out reuse 
elements is not saved.

Procedure
1. Select multiple components whose reference designator prefix you want to change.

All selected components must currently have the same prefix.

2. Click the ECO Toolbar  > Rename Component  button.

(If this is the first time in the current session you are using the ECO Toolbar, the ECO Options 
Dialog Box  appears. Set the options you want and click OK to use the ECO tools.)

3. Choose one of the following:

• Add to the existing prefix — Type the new prefix and then the current prefix.

• Change the existing prefix — Type a new prefix.

4. Click OK.

Related Topics
Recorded Versus Generated ECO Files

Recording ECO Changes

Backward Annotation from SailWind Layout to SailWind Logic

Renaming a Net in ECO Mode
You can change the name of a net using the Rename Net ECO tool. This changes the netlist, is 
considered an engineering change and requires ECO mode.

Restrictions and Limitations
A protected route or physical design reuse element can prevent you from renaming a net in ECO mode. 
You must unprotect the route or break the reuse to proceed. If you are recording changes to an ECO file, 
the action of removing the protection on traces or breaking out reuse elements is not saved.
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Procedure
1. Click the ECO Toolbar  > Rename Net  button.

(If this is the first time in the current session you are using the ECO Toolbar, the ECO Options 
Dialog Box  appears. Set the options you want and click OK to use the ECO tools.)

2. Select a pin, unrouted pin pair, trace, or via in the net to rename.

3. In the Rename Net Dialog Box, type the new name, and click OK.

The maximum netname length is 47 characters. For more information, see “Illegal Characters in 
Netnames and Part Names”.

Swapping ECL Terminators Automatically in ECO 
Mode
You can automatically swap ECL terminator assignments, or swap netnames between ECL pins.

CAUTION:
When you modify or delete design objects, electrical nets are regenerated. This can cause 
existing electrical nets that include these objects to be truncated, split, or deleted altogether.

Restrictions and Limitations
This command ignores objects that are part of a physical design reuse. A protected route or physical 
design reuse element can prevent you from swapping ECL terminators in ECO mode. You must unprotect 
the route or break the reuse to proceed. If you are recording changes to an ECO file, the action of 
removing the protection on traces or breaking out reuse elements is not saved.

Procedure
1. Click the ECO Toolbar  > Terminator Assign  button.

(If this is the first time in the current session you are using the ECO Toolbar, the ECO Options 
Dialog Box  appears. Set the options you want and click OK to use the ECO tools.)

2. Click Yes  to the displayed prompt.
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Swapping Gates
This section describes the processes used to swap gates manually or automatically.

Swapping a Gate Manually in ECO Mode
Swapping All Gates Automatically in ECO Mode

Swapping a Gate Manually in ECO Mode
You can swap a gate with any equivalent gate to optimize routing and/or minimize trace lengths.

Gates are equivalent when:

• They share the same package.

• They have matching, nonzero Swap IDs.

• They have an equal pin count.

CAUTION:
When you modify or delete design objects, electrical nets are regenerated. This can 
cause existing electrical nets that include these objects to be truncated, split, or deleted 
altogether.

Restrictions and Limitations

• You cannot swap a gate that has any pins from a pin pair with rules.

• A protected route or physical design reuse element can prevent you from swapping gates in ECO 
mode. You must unprotect the route or break the reuse to proceed. If you are recording changes 
to an ECO file, the action of removing the protection on traces or breaking out reuse elements is 
not saved.

Procedure
1. Click the ECO Toolbar  > Swap Gate  button.

(If this is the first time in the current session you are using the ECO Toolbar, the ECO Options 
Dialog Box  appears. Set the options you want and click OK to use the ECO tools.)

2. Select a pin.

All candidates for swapping are highlighted. Candidates with a nonzero Swap ID that matches the 
selected pin's Swap ID are highlighted in the highlight color. Candidates with different or undefined 
Swap IDs are highlighted in a complementary color.

3. Select the highlighted pin to swap with.
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Results
If the Stretch Traces During Component Move check box is selected (on the Options dialog box > Design 
category  on page 1503), traces attached to pins of the swapped gates are rerouted. If Stretch Traces 
During Component Move is cleared, trace segments are unrouted before the swap is performed.

Tip
You can undo your last Swap Gate command immediately after performing the swap. Right-click 
and click the Undo Last Swap  popup menu item while still in Swap mode, or exit Swap mode and 
click the Undo  button on the Standard Toolbar.

Related Topics
Part Information Dialog Box, Gates Tab

Swapping All Gates Automatically in ECO Mode
You can swap all gates with any equivalent gates based on shortest total unrouted pin pair lengths.

Gates are equivalent when:

• They share the same package.

• They have matching, nonzero Swap IDs.

• They have an equal pin count.

CAUTION:
When you modify or delete design objects, electrical nets are regenerated. This can 
cause existing electrical nets that include these objects to be truncated, split, or deleted 
altogether.

Restrictions and Limitations

• You cannot swap a gate that has any pins from a pin pair with rules.

• Objects that are part of a physical design reuse are ignored.

• A protected route or physical design reuse element can prevent you from swapping gates in ECO 
mode. You must unprotect the route or break the reuse to proceed. If you are recording changes 
to an ECO file, the action of removing the protection on traces or breaking out reuse elements is 
not saved.

836 SailWind Layout Guide and Reference



 
ECO (Engineering Change Order)

Swapping All Gates Automatically in ECO Mode

Procedure
1. Click the ECO Toolbar  button.

(If this is the first time in the current session you are using the ECO Toolbar, the ECO Options 
Dialog Box  appears. Set the options you want and click OK to use the ECO tools.)

2. Click the Auto Swap Gate  button on the ECO Toolbar.

Results
If the Stretch Traces During Component Move check box is selected (on the Options dialog box > Design 
on page 1503), traces attached to pins of the swapped gates are rerouted. If Stretch Traces During 
Component Move is cleared, trace segments are unrouted before the swap is performed.

Tip
You can undo your last Auto Swap Gate command immediately after performing the swap. Just 
click the Undo  button on the Standard Toolbar.

Related Topics
Part Information Dialog Box, Gates Tab
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Swapping Pins
This section describes the processes used to swap pins manually or automatically.

Swapping a Pin Manually in ECO Mode
Swapping All Pins Automatically in ECO Mode

Swapping a Pin Manually in ECO Mode
You can swap a pin with any equivalent pin to optimize routing and/or minimize trace lengths. Pins are 
equivalent when they have matching, nonzero Swap IDs.

Restrictions and Limitations

• You cannot swap a pin that has any pins from a pin pair with rules.

• Connectors that are glued down are not included in the swap.

• A protected route or physical design reuse element can prevent you from swapping pins in ECO 
mode. You must unprotect the route or break the reuse to proceed. If you are recording changes 
to an ECO file, the action of removing the protection on traces or breaking out reuse elements is 
not saved.

Procedure
1. Click the ECO Toolbar  > Swap Pin  button.

(If this is the first time in the current session you are using the ECO Toolbar, the ECO Options 
Dialog Box  appears. Set the options you want and click OK  to use the ECO tools.)

2. Select a pin.

All candidates for swapping are highlighted. Candidates with a nonzero Swap ID that matches the 
selected pin's Swap ID are highlighted in the highlight color. Candidates with different or undefined 
Swap IDs are highlighted in a complementary color.

3. Select one of the highlighted pins with which to swap.

If you attempt to swap pins with undefined swap IDs or with different swap IDs, the Confirm Pin 
Swap Dialog Box  appears and you must confirm that the swap is legitimate. If these pins ought to 
be swappable, the correct process would be to give them identical swap IDs in the Pins tab of the 
Part Information dialog box  on page 1590.

4. Click OK.

Results
If the Stretch Traces During Component Move check box is selected (on the Options dialog box > Design 
category  on page 1503), traces attached to pins of the swapped gates are rerouted. If Stretch Traces 
During Component Move is cleared, trace segments are unrouted before the swap is performed.
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Swapping All Pins Automatically in ECO Mode

Tip
You can undo your last Swap Pin command immediately after performing the swap. Right-click 
and click the Undo Last Swap  popup menu item while still in Swap mode, or exit Swap mode and 
click the Undo  button on the Standard Toolbar.

Related Topics
Part Information Dialog Box, Pins Tab

Swapping All Pins Automatically in ECO Mode
You can swap all pins with equivalent pins automatically based on shortest total unrouted pin pair lengths. 
Pins are equivalent when they have matching, nonzero Swap IDs.

Restrictions and Limitations

• You cannot swap a pin that has any pins from a pin pair with rules.

• Connectors that are glued down are not included in the swap.

• Objects that are part of a physical design reuse are ignored.

• A protected route or physical design reuse element can prevent you from swapping pins in ECO 
mode. You must unprotect the route or break the reuse to proceed. If you are recording changes 
to an ECO file, the action of removing the protection on traces or breaking out reuse elements is 
not saved.

Procedure
1. Click the ECO Toolbar  button.

(If this is the first time in the current session you are using the ECO Toolbar, the ECO Options 
Dialog Box  appears. Set the options you want and click OK to use the ECO tools.)

2. Click the Auto Swap Pins  button on the ECO Toolbar.

Results
If the Stretch Traces During Component Move check box is selected (on the Options dialog box Design 
category  on page 1503), traces attached to pins of the swapped gates are rerouted. If Stretch Traces 
During Component Move is cleared, trace segments are unrouted before the swap is performed.

Tip
You can undo your last Auto Swap Pin command immediately after performing the swap. Just 
click the Undo  button on the Standard Toolbar.

Related Topics
Part Information Dialog Box, Pins Tab
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Copied Bridge Copper in ECO Mode
When you copy bridge copper in ECO mode and at least one assigned net trace with it, the pasted copy 
retains its bridge status and association to any attached trace(s). According to the circumstances of the 
pasted traces, their net names may be renamed or merged with existing net(s).

Illegal Characters in Netnames and Part Names
You can use any alphanumeric character for netnames and part names, with a few noted exceptions.

The following characters are illegal in netnames:

• SpacesCommas (,)

• Braces ( { } )

• Asterisks (*)

• Question marks (?)

The following characters are illegal in part names:

• SpacesCommas (,)

• Braces ( { } )

• Asterisks (*)

• Question marks (?)

• Periods ( . )

• Ampersands (&)
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Chapter 37
Comparing Designs

This section discusses how to compare two versions of a design. It explains how to generate a 
differences report and the files you can use to update the older design to match the newer one.

Design Comparison
Comparing Two Versions of a Design
Comparing Designs Using ECOGEN
Differences Report

Design Comparison
You can compare two versions of a design and create the files needed to update the original design to 
match the new design. Before comparing a schematic to a PCB layout, create a PADS-format ASCII 
netlist file (.asc) by generating a netlist in SailWind Logic or other schematic tool.

When you compare the updated schematic to the original PCB layout and then update the PCB layout to 
match the schematic, the process is called forward to layout or forward annotation. Similarly, when you 
compare the updated PCB layout to the original schematic and then update the schematic to match the 
PCB layout, the process is called backward from layout or backward annotation.

If SailWind Layout and the schematic tool are on the same computer, you can use more convenient 
automated tools to compare and update design versions. If SailWind Layout and the schematic tool are 
not on the same computer, you can use SailWind Layout to compare two versions of the design. See the 
following for more information:

• For SailWind Logic, see “Working with SailWind Logic”.

Design comparison can handle unused pins nets. An unused pins net contains all the component pins 
with no assigned net and groups them into one large net.

Design comparison does not do any of the following:

• Add pins removed from logic nets to the unused pins net.

• Use the reuse definition; the actual elements in the physical design reuse are used during 
comparison.

During comparison, it is assumed the new design contains the most current Attribute Dictionary. If an 
attribute is not ECO registered in the new design, the attribute is backward annotated only if you clear 
Compare only ECO Registered Parts check box on the Comparison tab of the Compare/ECO Tools 
dialog box  on page 1181. If an attribute is ECO registered in the new design, the attribute is backward 
annotated and the value in the old design is updated, but the ECO registration for the attribute in the old 
design is not updated.

Comparing Two Versions of a Design
To compare two versions of a design, generate a new .eco  file, a differences report, an ASCII file for 
back-annotating to a schematic, or all of them.
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Tip
As an alternative, you can use the ECOGEN  on page 844 command in SailWind Layout to do 
this.

You can compare two versions of a design in any of the following forms:

• The PCB design that is currently open in SailWind Layout

• A PADS-format ASCII netlist file (.asc) representing the schematic or the PCB layout

• A PCB layout file (.pcb)

If you are trying to forward or backward annotate design changes between SailWind Layout and SailWind 
Logic, you should record changes in an .eco  file as you make them. This gives the best back-annotation 
results. For more information, see “Recording ECO Changes  or ” Backward Annotation from SailWind 
Layout to SailWind Logic.

For more details on the differences of these methods, see “Recorded Versus Generated ECO Files.”

Tip
If SailWind Layout and the schematic tool are on the same computer, you can use SailWind 
Layout Link in SailWind Logic to both create the ECO file and forward or back-annotate the 
schematic. For more information, see “Working with SailWind Logic”.

Procedure
1. Click the Tools  > Compare/ECO  menu item.

2. In the Compare/ECO dialog box, on the Documents tab  on page 1185, select the designs to 
compare as follows:

• If the older design is in memory, and you want to compare it with a newer .asc  or .pcb  file, use 
these settings:

• If the newer design is in memory, and you want to compare it with an older .asc  or .pcb  file, use 
these settings:
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• If neither design is in memory, and you want to compare an older.asc  or .pcb  file with a newer 
.asc  or .pcb  file, use these settings:

3. In the Output Options area, select the files you want to generate.

4. Set the appropriate options on the Comparison  on page 1181and Update  on page 1187 tabs.

5. Click Run  to compare the designs and create the files you specified. (The Run  button becomes 
available when you select an option in the Output Options area.)

6. Click the Show Report  buttons in the Process Status dialog box to view the generated files.

7. Click the Close  button.

Results
Any messages or errors that occur during comparison are written to Layout.err, which is stored in the 
\SailWind Projects  folder.

If the original design is in memory and you selected Update Original Design on the Update  tab, the 
updates are automatically imported into the design when comparison is completed. To confirm that 
the updated design matches the new design, run the compare again, and select only the Generate 
Differences Report check box. If there are still differences, use the ECO Toolbar commands to correct the 
design.

If you did not select Update Original Design to automatically update the original design, click the File  > 
Export  menu item to import the .eco  file and update the design.
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After verification is complete, click the Tools  > Verify Design  menu item to check the design integrity.

Tip
If commands in the ECO file added any parts at the origin in the updated original design, 
remember to place these parts and route any newly unrouted pin pairs.

Related Topics
Design Comparison

Comparing Designs Using ECOGEN

Comparing Designs Using ECOGEN
After you make changes to a design, you can use the ECOGEN command to compare the new version 
of the design to the original, and create the files needed to update the original design to match the new 
design.

Tip
As an alternative, you can use the “Compare/ECO Tools dialog box”  on page 1185 in SailWind 
Layout to do this.

It is good practice to record changes in an .eco  file as you make them. This gives the best back-
annotation results. For more information, see “Recording ECO Changes”. For more information on the 
differences between these methods, see “Recorded Versus Generated ECO Files”.

If you want to compare the schematic to the PCB layout, export a PADS-format ASCII netlist file (.asc) 
from the schematic tool before comparing the designs.

Restrictions and Limitations

• ECOGEN always compares component and decal rules and Fanout and Pad entry rules, even if 
you do not specify the -l switch.

• ECOGEN does not generate change information for layers. For layer-dependent rules such as 
conditional rules, make sure the designs being compared have the same number of layers.

• ECOGEN ignores virtual pins.

• ECOGEN ignores the reuse definition  on page 1854 and uses the actual elements in the physical 
design reuse for comparisons.

Prerequisites
If you want to compare the schematic to the PCB layout, export a PADS-format ASCII netlist file (.asc) 
from the schematic tool before comparing the designs.
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Procedure
1. Open the Windows command prompt.

Click the Start  > Windows Accessories  > Windows System  > Command Prompt  menu item.

2. Change to the folder where the ecogen.exe  file resides, for example, C:\<install_folder>\<version>
\Programs.

3. Run ECOGEN in one of the following two ways:

• Enter the ecogen command using the following format:

ecogen <new_design> <original_design> [<eco_out>] 
 [-u<unused net name>] [-e<error file>] [-d<report 
 file>] [-r[a][p]] [-a<attr mask>] [-f] [-l <rules mask>] 
 [-n<new_design_title>][-o<original_design_title>] [-g] [-s] [-m] 
 [-q] [-i <output unit>]

For example:

ecogen \ePD\3.1\project\logic.asc C:\SailWind Projects\pcb.asc
 design.eco -lNET,CLR -uNOT_CONNECTED

In this example, ECOGEN:

• Compares the original design (before changes), logic.asc, with the new design, pcb.asc

• Creates an ECO file, design.eco, which can be used for updating the original design, 
logic.asc

• Compares Clearances Rules for nets

• Specifies that NOT_CONNECTED is an unused pins net as a result of SPECCTRA routing.

In the command line:

• You must enter the newDesign, originalDesign, and ecoFile arguments in the given order.

• If an argument contains spaces, enclose the argument with double-quotes " ".

• Type ECOGEN@<command_file>, where <command file> is a pathname to a file containing all 
the parameters on one line.

Examples
The following table contains the parameter usage. Square brackets [ ] enclose optional parameters.
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Table  122. Parameter Usage

Parameter Specifies

newDesign The design file containing the changes you want to place into the 
original design.

originalDesign The design file that you want to update so that it matches the new 
design.

[eco_out] The ECO command file containing ECO directives. You can import this 
file into the original design to update the original file.

[-aAttributeMask] Attribute comparison and the attributes to be compared (AttributeMask)
This mask selects the object types for which to compare attributes. The 
mask is a string of object types separated by commas without spaces. 
You can specify these object types:
PCB,PART,PARTTYPE,PARTDECAL,NET,NETCLASS,PIN
Specify the AttributeMask as a string of object types separated by 
commas without spaces. for example: -aPART,NET
If you want to ignore all attributes during comparison, do not specify the 
-a switch. If you do not use this switch, existing attributes are preserved 
and no ECO commands are generated for attribute modification.
To compare part and net attributes, for example, for a SailWind Logic 
schematic, use the -aPART,NET switch value.
To compare board, part, net, and pin attributes, for example, for a 
PADS Designer  schematic, use the -aPCB,PART,NET,PIN switch value
To compare the attributes for all object types, use the -a 
PCB,PART,PARTTYPE,PARTDECAL,NET,NETCLASS,PIN switch 
value.

-dReportFile The file containing the differences between the original design and the 
new design.

[-eErrorFile] The file containing ECOGEN status and error messages. ECOGEN 
automatically opens the default editor you chose during installation to 
display the error file.

[-f] Enables comparison of part decal assignment.

 Tip
• Do not use either the -g or -q switch if you want to compare 

net names and reference designator names, and rename as 
necessary.

• These switches are best used to minimize changes to routed 
traces. Selecting this option may result in the positional 
swapping of parts.

Use the -g switch to disable reference designator and net name 
comparison.
Use this switch to compare connectivity and topology (not names) and 
rename as necessary. Compare differences using pin names, part type 
names, and so on.

[-g], [-q]

Use the -q switch to suppress part renames.
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Table  122. Parameter Usage  (continued)

Parameter Specifies

Use this switch to compare net names and reference designators, but 
prefer adding or deleting parts to renaming parts. Compare differences 
using reference designators or net names on the basis that few 
reference designators have been renamed, but nets have not been 
renamed.

[-iOutputUnit] Specifies an output unit for dimensional values in the ECO and report 
files. (If you do not specify this switch, ECOGEN uses the output unit of 
the new design.)
You can specify an output unit of: BASIC, MILS, INCHES, or METRIC.
If you specify an output unit that ECOGEN does not recognize (for 
example, if you mistype the unit name), the command uses BASIC.

[-lRulesMask] Specifies rules comparison and the object types, rule types, and rule 
kinds to be compared (RulesMask).
For RulesMask, you can specify:

• Object types: PCB, NET, NETCLASS, PINPAIR, and GROUP. If 
you do not specify any object types, rules for all object types are 
compared.

• Rule types: Clearance, Routing and High Speed (CLR, RT, HS). If 
you do not specify any rule types, all three types are compared.

• Rule kinds: General, Conditional, and Differential Pairs (GEN, 
CON, DFP). If you do not specify any rule kinds, all three kinds are 
compared.

Specify the RulesMask as a string of object types separated by 
commas without spaces. For example:

-lNETCLASS,GROUP,CLR

If you do not specify a RulesMask, ECOGEN, compares rules of all 
types and kinds on all object types.

[-m] Enables comparison of part placement. When comparing the PCB 
layout to the schematic, this feature is available only for PADS Designer 
schematics containing placement information created by ePlanner.

[-nNewDesignTitle] The string used in the report header for the new design name.

[-oOldDesignTitle] The string used in the report header for the original design name.

[-r[a][p]] Enables comparison of only ECO registered [p]arts or [a]ttributes.
Use the -rap switch to compare only ECO registered parts and 
attributes.
Use the -ra switch to compare only ECO registered attributes. Via 
attributes are not ECO registered and cannot be added, deleted, or 
changed during the ECO process.
Use the -rp switch to compare only ECO registered parts.
Do not use the -r switch if you want ECOGEN to compare all parts and 
attributes.
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Table  122. Parameter Usage  (continued)

Parameter Specifies

Do not use the -rap or -rp switches if you want to compare mechanical 
or non-electrical parts on the designs.

[-uUnusedNetName] Indicates an unused pins net that contains pins that have no logical 
net association. This net is a result of SPECCTRA routing. Use the 
netname you used in SPECCTRA. The maximum netname length is 
47 characters. You can use any alphanumeric characters except curly 
braces { }, asterisks *, spaces, question marks, or commas.

Related Topics
Design Comparison

Comparing Two Versions of a Design

Differences Report
The Differences Report (Layout.rep) reports the results of a comparison of two design files. (You perform 
the comparison using the Tools  > Compare/ECO  menu item or the ecogen command in the Windows 
command prompt.) For example, you can compare a new design (one with changes) to the original 
design (before changes). The Differences Report lists the changes found in the new design as compared 
in the original design.

Part Differences
Lists part type information and part placement information in separate sub-sections.

The part type information sub-section lists the reference designator and the part type for both the old and 
new designs. Parts that exist only in the old design are listed under the New Design column as <none>. 
Parts that exist only in the new design are listed under the Old Design column as <none>. Parts that are 
renamed are listed on the same line. Parts that have new part types are listed on the same line. Parts that 
have new assigned decals are listed on the same line. Parts that are identical by reference designator 
and part type in both designs are not listed.

The part placement information sub-section lists the differences for each part's x/y coordinates, glue 
status, and mirror (flip) status. Part placement information is reported only for parts that exist in both the 
old design and the new design.

Net Differences
Lists names of the nets that do not exist. Lists the nets that match, but have different names, including 
nets in the old design that have been combined in the new design. A net split operation appears as pin 
differences. Nets are listed alphabetically under the Old Design column, except where multiple nets are 
combined, when they are listed in succession. Nets that do not exist in the old design are listed at the end 
of this section.

Swapped-Gate Differences
Lists any gates from the old design that are swapped with gates in the new design. The report lists 
reference designators for the parent components in the design followed by the pins in the gate.
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Swapped-Pin Differences
Lists any swapped pins in the old design that are swapped with pins in the new design. This list provides 
reference designators for the components in the design followed by the swapped pins.

Unmatched Net Pins in Old Design
Lists any connected pins in the old design that are missing or connected to other nets in the new design. 
These are the pins that are deleted from nets during the ECO process. This list provides net names in the 
old design followed by unmatched pins in the net. If the net does not exist in the new design, all pins in 
the net are listed.

Unmatched Net Pins in New Design
Lists any connected pins in the new design that are missing or connected to other nets in the old design. 
These are the pins that are added to nets during the ECO process. This list provides net names in the 
new design followed by unmatched pins in the net. If the net does not exist in the old design, all pins in 
the net are listed.

Attribute Differences
Lists each object under the following headings: Attribute Name, Old Value, and New Value. Attribute 
differences are included only for objects that exist in both the old design and the new design. If an 
attribute is missing in either design, the value is listed as <no attr>. If the attribute exists, but has no 
value, it is listed as <no value>.

Tip
To generate a report containing the mechanical (nonelectrical) parts in the design, clear the 
“Compare only ECO Registered Parts” check box on the Comparison tab  on page 1181 of the 
Compare/ECO Tools dialog box.

Unmatched Net Pin Pairs in Old Design
Lists any pin pairs in the old design that are missing, connected to other nets, or connected to the same 
scheduled net in a different place in the new design. These would be the pin pairs that would be deleted 
from nets during the ECO process.

The report lists net names in the old design followed by the unmatched pin pairs in the net. If the net is 
missing in the new design, then all the pin pairs in the net are listed.

Unmatched Net Pin Pairs in New Design
Lists any connected pin pairs in the new design that are missing, connected to other nets, or connected to 
the same scheduled net in a different place in the old design. These would be the pin pairs that would be 
added to nets during the ECO process.

The report lists net names in the new design followed by the unmatched pin pairs in the net. If the net is 
missing in the old design, then all the pin pairs in the net are listed.

Rules Differences
This section reports differences in design rules between two designs. This section lists each object that 
has rules differences as a subheading. The subheading has three columns: Rule Name, Old Value, and 
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new Value. (The Rules Differences section heading shows the units in which the values for rules are 
displayed.)

The subheading for each object type includes:

• The object type

• The object name in the original design

• The object name in the new design (if the name is different)

• The rule type

For example:

RULES DIFFERENCES (Values in mils)
          Old Object Name -> New Object Name -> Rule Type
          Rule Name           Old Value         New Value
          NETCLS              CLASS1 -> MYCLS   ROUTING
          PIN_SHARE           ON                OFF
          VALID_LAYERS        Top               Bottom

This example shows a routing rule set change for the CLASS1 class. The change renamed CLASS1 
to MYCLS and included changed in the pin share and valid layers rules. No other routing rules were 
changed.

Differences in Net Classes

This section lists names of net classes that:

• Do not exist in one design or another. (Classes that do not exist in the original design appear at 
the end of the section.)

• Match but have different names

For example:

NET CLASS DIFFERENCES
Old Design      New Design
CLASS1          MYCLASS
CLASS2          <none>
<none>          NEWCLS

This example shows that in the new design:

• The CLASS1 net class was renamed to MYCLASS.

• The CLASS2 net class was removed.

• The NEWCLS net class was added.

Class Nets That Were Removed

850 SailWind Layout Guide and Reference



 
Comparing Designs
Differences Report

This section reports nets that are in the original design but were removed from the new design. (The 
net class in the original design has nets either not included in the new design or included in different net 
classes in the new design.)

This section lists:

• Each net class in the original design from which nets were removed and the names of those 
removed nets

• All of the nets in the net class if the net class does not exist in the new design

For example:

REMOVED CLASS NETS
 
CLASS1        $$$1879    $$$1906    $$$1928
              $$$1920
CLSMESH       GNC        VCC

This example shows:

• Nets $$$1879, $$$1906, $$$1928, and $$$1920 in the CLASS1 net class of the original design 
are missing from that net class in the new design.

• Nets GND and VCC in the CLSMESH class of the original design are missing from that net class 
in the new design.

If you use the ECO operation to update the original design, the operation deletes the nets from net 
classes in the original design.

Class Nets That Were Added

This section reports nets that are not in the original design and are added in the new design. (The net 
class in the new design has nets either not included in the original design or included in different net 
classes in the original design.)

This section lists:

• Each net class that has added nets in the new design and the names of added nets

• All of the nets in the net class if the net class is new (does not exist in the original design)

For example:

ADDED CLASS NETS
 
CLASS1         ANDROID    BAJOR    SPOT
               DATA00     DATA01
CLSMESH        ZORG       GND2

This example shows that in the new design:
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• ANDROID, BAJOR, SPOT, DATA00, and DATA01 nets were added to CLASS1.

• ZORG and GND2 nets were added to the CLSMESH class.

Differences in Pin-Pair Groups

This section lists pin-pair groups that:

• Do not exist in one design or the other. Pin-pair groups that do not exist in the original design 
appear at the end of the section.

• Match but have different names.

For example:

PIN-PAIR GROUP DIFFERENCES
Old Design       New Design
GROUP1           <none>
GROUP2           GROUPB
<none>           NEWGRP

This example shows that in the new (changed) design:

• The GROUP1 pin-pair group was removed.

• The GROUP2 pin-pair group was renamed to GROUPB.

• The NEWGRP pin-pair group was added.

Pin Pairs That Were Removed From Groups

This section reports pin-pairs that were in the original design but removed from the new design. (The pin-
pair group in the original design has pin-pairs either not included in the new design or included in different 
groups in the new design.)

This section lists:

• Each group in the original design from which pin-pairs were removed and the names of removed 
pin-pairs

• All of the pin-pairs in the group if the group does not exist in the new design

For example:

REMOVED GROUP PIN-PAIRS
 
GROUP1        U2.2-U1.2 U3.3-U2.2 U3.2-U4.2
              U1.5-U2.5 U4.5-U1.5
GLMESH        R102.1-C2.2

This example shows that in the new (changed) design:
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• Five pin-pairs were removed from GROUP1.

• The pin-pair R102.1-C2.2 was removed from the GLMESH group.

Pin-Pairs That Were Added to Groups

This section reports pin-pairs in the new design that are not in the original design. (The pin-pair group in 
the new design has pin-pairs either not included in the original design or included in different groups in the 
original design.) An ECO operation adds these pin-pairs.

This section lists:

• Each group with added pin-pairs in the new design and the names of added pin-pairs.

• All of the pin-pairs in the group if the group is new (does not exist in the original design).

For example:

UNMATCHED GROUP PIN-PAIRS
 
G        U2.2-U1.2 U3.2-U2.2
DASL     R29.2-U23.17

This example shows that in the new (changed) design:

• Two pin-pairs were added to the G group.

• The pin-pair R29.2-U23.17 was added to the DASL group.
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Chapter 38
Reports

You can generate reports for the currently loaded design. Several report formats are provided, plus you 
can create reports formatted to match existing design standards. Each report pass creates a file called 
report.rep, which is stored in the \SailWind Projects  folder.

Report Types
Running a Report
Running a Report Using an Assembly Variant
Adding or Removing Report Formats
Creating Custom Reports Using the Report Wizard

Report Types
SailWind Layout includes two types of reports; predefined reports and customizable reports. The 
predefined reports provide useful statistical information about your design. The customizable reports allow 
you to create and configure a report that contains design-specific information that you desire for checking 
and testing your design.

• Predefined Reports

• Customizable Reports

Predefined Reports
The following table lists the predefined report types, which cannot be deleted.

Table  123. Predefined Reports

Report Description

Unused Provides a listing of all unused pins for each package in a design.

Statistics Provides a variety of statistical information in a design such as number of 
layers, drill locations, and routed connections.

Limits Provides maximum numbers of the various design items, based on your 
program’s package limits.

Customizable Reports
SailWind Layout includes report format files that you can customize to fit specific output requirements. 
These files are located in C:\<install_folder>\<version>\Settings  and were created using the Report 
Generation Language  (RGL). The file name extension used for these files is .fmt.

To help you select the proper report, report files are listed in the Reports dialog box by description of 
output, instead of by file name. Table 124  lists the formats, file names, and their descriptions.
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Table  124. Customizable Reports

Report Format File Report Description

Net List w/o pin info netlist.fmt Signals by netname without pin 
information

Net List w/pin info netlistp.fmt Signals by netname with pin information

Parts List 1 parts1.fmt Parts by reference designator

Parts List 2 parts2.fmt Reference designator by part type

Test points report testpnts.fmt Test point locations and netname

Jumper List jumpers.fmt Jumper locations and netnames

SailWind Format Netlist padsnet.fmt Netlist in current SailWind Layout format

PADS Format Netlist padsnetV2.fmt Netlist in PowerPCB 2.0 format

DFT Extended Test Point testpoint.fmt Test points by nets, nets without test 
points, and number of test points per net

 Note:
You must have the DFT Audit licensing 
option to select DFT Extended Test 
Point.

Jumper List Report
You can create a Jumper List Report that lists all jumpers and their characteristics. Table 125  shows a 
sample report file.

JUMPER LIST REPORT -- a b c d e f g h i j.pcb

TOTAL = 3 jumper(s)

Table  125. Jumper List Report

Ref.Nm Angle Length X1 Y1 X2 Y2 Signal

JMP1 90.000000 350 1825 3200 1825 3550 GND

JMP2 0.000000 250 2600 3275 2850 3275 GND

JMP3 90.000000 525 2725 2400 2725 2925 DA01

Running a Report
You can choose to run any of the 12 pre-configured reports. Two of the reports produce old format 
netlists.

856 SailWind Layout Guide and Reference



 
Reports

Running a Report Using an Assembly Variant

Procedure
1. Click the File  > Reports  menu item to open the Reports Dialog Box.

2. In the Select Report Files for Output list, select one or more report formats.

If the report format you want is not available, you can create a custom format, see “Adding or 
Removing Report Formats” or “Creating Custom Reports Using the Report Wizard”.

3. Click OK.

Results
The report is written to C:\SailWind Projects\report.rep  and displayed in the default text editor. If you 
selected more than one report format, report.rep  contains all the reports.

Running a Report Using an Assembly Variant
If your design uses assembly variants, you can create a report based on an assembly variant instead of 
the base design.

Procedure
1. Click the File  > Reports  menu item to open the Reports Dialog Box.

2. In the Select Report Files for Output list, select one or more report formats.

3. Select the Use Assembly Variant check box, and then select a variant from the Name list.

Uninstalled parts are listed as <<Not Installed>> and substituted parts are listed with the correct 
part type. Some data may not reflect the substituted parts data, for example, the Unused report 
reflects the gate assignments for the Default part type, but not the gate assignments for the 
Substituted part. If the Use Assembly Option check box is cleared, raw database  on page 1853
data is reported.

4. Click OK.

Results
The report is written to C:\SailWind Projects\report.rep  and displayed in the default text editor. If you 
selected more than one report format, report.rep  contains all the selected reports.

Adding or Removing Report Formats
You can add or remove report formats from Reports dialog box. If you want to add a report format, you 
first create the format file using Report Generation Language.

For more information, see Customizable Reports.

Procedure
1. Click the File  > Reports  menu item to open the Reports Dialog Box.

2. Modify the list of report formats:
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• Add to the list a custom report format, or import a report format file:

i. Click Add.

ii. In the Report Format File dialog box, browse to the format file and click Open. The format is 
added to the list and copied to the C:\<install_folder>\<version>\Settings  folder.

• Remove a report format from the list:

i. Select the format.

ii. Click Delete. You cannot delete the Unused, Statistics, and Limits report types. The format 
is removed from the list and the file name extension is changed from .fmt  to .del.

3. Click OK.

Related Topics
Creating Jumper List Reports

Creating Custom Reports Using the Report 
Wizard
In a maximum of 8 steps, the Script Wizard prompts you to choose information and once complete, it 
creates a reusable script of the report format, runs the script against the current design, and generates 
your report in Plain text, RTF, Excel, and HTML formats. This method is easier than manually writing the 
report formats in Report Generation Language for the Reports dialog box.

Procedure
1. Click the Tools  > Basic Scripts  > Basic Scripts  menu item.

2. In the Basic Scripts Dialog Box, scroll through the list of scripts and select SailWind Layout Script 
Wizard.

3. Click Run.

4. Proceed through the screens of the Wizard and on the final screen, either click Finish to create the 
script of the report or click Finish & Run Report Now to see the report also.

The basic script that generates the report appears in the Basic Scripts dialog box for reuse and the 
report opens in the chosen format. You can delete the basic script of the report if you do not intend 
to use it again.

Examples
Create and run a component height report listing the height of each part in the design.
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Creating Custom Reports Using the Report Wizard

1. Click the Tools  > Basic Scripts  > Basic Scripts  menu item..

2. In the Basic Scripts Dialog Box, scroll through the list of scripts and select SailWind Layout Script 
Wizard.

3. Click Run.

4. On the Introduction screen, click Next.

5. On the Format screen, click Microsoft Excel and then click Next.

6. On the Report Type screen, click PCB-Based Reports and then click Next.

7. On the Database Object screen, click Parts and then click Next.

8. On the Data Type screen, click General Part properties in table format and then click Next.

9. On the Object Properties screen, in the Attribute (Select existing or type any valid name) list click 
Geometry.Height and then click Add.

10. On the Report Options screen, click Next.

11. On the Output Files screen, in the “Enter the name of the resulting VB script (without BAS 
extension)” box type a name for the report to be listed in the Basic Scripts dialog box.

12. Click Finish & Run Report Now.

13. An Excel report is generated for the current design reporting on the value of the Geometry.Height 
attribute of each part. When you need to generate the report again, select it in Basic Scripts 
dialog box and click Run.
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Chapter 39
Checking a Design for Errors

This section describes the methods for checking a design for errors. It covers the Verify Design process 
as well as the interactions presented by Design For Test (DFT), Design For Fabrication (DFF), CAM, 
Thermal Analysis and the 3D PCB Viewer.

Design for Test
DFF, Design For Fabrication
Exporting to CAM350
Working with Markups
Verify the Design
Fabrication Checking
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Design for Test
To support In Circuit Testing (ICT) procedures, SailWind Layout’s DFT Audit can help you manage 
in-circuit test points. Using parameters that you set, DFT Audit can analyze all nets in the design, 
automatically assign test point attributes to the appropriate vias and component pins on accessible 
(adaptable) nets, add test points to adaptable nets that are already routed, and report inaccessible (non-
adaptable) nets.

For non-adaptable nets, DFT Audit can add test point vias and place them outside the board outline. 
These capabilities help you consider ICT early in the design process, improving your productivity by 
reducing potential iterations of a manual DFT Audit.

To manually assign a component pin or via as a test point, you add a test point setting to the object. A test 
point can be one pin of a multiple pin component, the only pin of a single test point component, or a via.

DFT Audit assigns vias and component pins as test points rather than adding several single pin 
components. Therefore, you avoid backward annotation of test point information to the schematic. For 
more information, see “Test Point Definition”.

When you run DFT Audit, SailWind Layout automatically transfers the design to SailWind Router. Using 
parameters that you set in SailWind Layout, SailWind Router analyzes all nets for adaptability and adds 
test points to routed adaptable nets. Note that SailWind Router may reroute nets during DFT Audit. When 
SailWind Router is done, it transfers the design back to SailWind Layout. For nets that SailWind Router 
determines to be non-adaptable, SailWind Layout can optionally add test points, which are placed outside 
the board edge. When DFT Audit finishes, the DFT Audit Board Report appears.

To access the DFT Audit, click DFT Audit on the Tools menu. For information about running DFT Audit, 
see the Performing a Test Point Audit  topic.

Restriction:
DFT Audit tolerates slotted holes, but does not test them for adaptability.

While you can run DFT Audit in either SailWind Layout or SailWind Router, the dialog box used to set a 
DFT Audit option depends on the program you are running. For more information, see “Mapping SailWind 
Layout DFT Audit Settings to SailWind Router”.

Test Point Definition
DFT-Related Options
Compare Test Points
Creating a Test Point ASCII File
Performing a Test Point Audit
Placing Test Points
Setting Test Point Properties
Setting Test Point Assignment Eligibility
Probing the PCB Top Side Only
Modifying a Jumper Pin that is a Locked Test Point
Modifying a Pin that is a Locked Test Point
Modifying a Route Attached to a Locked Test Point
Modification of a Via or Virtual Pin That is a Locked Test Point
Moving a Via or Virtual Pin That Is a Locked Test Point
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Test Point Definition

Move Sequential to Move Components, Unions, or Clusters with a Locked Test Point
Moving, Dispersing, or Aligning a Component, Cluster, or Union with a Locked Test Point

Test Point Definition
Specific test point terminology is used to describe the various parameters used in setting up your test 
points in the design.

Figure 117  show the different parts of a test point, while Table 126  describes the parts.

Figure 117. Different Parts of a Test Point

Table  126. Parts of a Test Point

Part of Test Point Description

Test Probe Also known as the probe, nail, nail pin, or tester pin. This object 
accesses the test point through the test fixture and makes contact 
between the test point on the PCB and the test equipment.

Test Fixture A thick metallic plate attached to the ICT equipment that is 
customized for each PCB. The test fixture accurately positions test 
probes to their respective test points on the PCB. Test fixtures can be 
designed for a single side of the PCB, typically the bottom side, or for 
both sides of the board, which is called a clam fixture.

Test Point The point on the net you are accessing, typically a via or component 
pin.

Head Type The type of head style or contact point on the test probe. The head 
is the part of the probe that makes contact with the test point. You 
cannot set the Head Type in SailWind Layout.

Nail Diameter An ASCII string assigned to a test point via or pin that equals the 
probe diameter.

Nail Number A unique label assigned to a probe.

DFT-Related Options
In addition to adding more test point capabilities through DFT Audit, SailWind Layout contains additional 
features available within other functionality to support test points.
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This test point information is discussed with the specific SailWind Layout topic and context-sensitive help 
is available from any dialog boxes you may encounter when working with test points. The table below 
shows impacted functionality.

Table  127. DFT-Related Options

Option Impact

Add a test point Manually adds a test point attribute to an existing via, jumper 
pin, or component pin.

ASCII I/O Exports and imports test points.

Cluster Placement and Cluster 
options

Prompt you when you move, disperse, or collapse clusters with 
a locked test point.

CAM Select Items dialog box displays test points. NC Drill Options 
dialog box plots test point locations.

Compare Test Points Compares test point locations in two files.

ECO Delete Connection, Delete Net, Delete Part, and Change Part 
handle test points differently.

End Test Point Manually ends a route with a test point via on a dangling route.

Find Finds by test points.

Modifying Prompts you if you modify an object with a test point attribute; 
for example, changing the pad stack of a component pin that 
is a test point or changing the via type. See the Modifying 
Via Properties, Customizing Pad Stacks of Decal Pins, and 
Modifying Pin Properties  topics.

Moving Prompts you if you move a locked test point. This includes 
all moving commands for via, pin, cluster, union, or reroute, 
including spinning, rotating, and flipping objects. See the Moving 
Components, Moving, Dispersing, or Aligning a Component, 
Cluster, or Union with a Locked Test Point  on page 873, 
Cluster Placement, and Moving a Trace Segment  topics.

Reports Extended reports for test points, including more keywords.

Routing tab Displaying test points and locking test point locations.

SPECCTRA Translator The SPECCTRA Translator supports via keepouts and a net of 
unused pins.

Verify Design Checks for test point probe violations on the entire design.

Compare Test Points
Use Compare Test Points to compare test point settings in ASCII format, between the current file and 
another file.
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Creating a Test Point ASCII File

Procedure
1. You need an ASCII file of test points from an older version of the design file.

For more information, see “Creating a Test Point ASCII File”.

2. Click the Tools  > Compare Test Points  menu item to open the Compare Test Points dialog box.

3. Locate or type the name of the ASCII test point file to compare against.

You do not need to type the .asc  extension.

4. Click OK. SailWind Layout creates an internal ASCII test point list of the open file and compares it 
to the one you specified.

If the ASCII file you compare against is a version earlier than PowerPCB 2.x, or if a test point 
section is not present in the ASCII file, an error message appears. Create another file to compare 
against.

When differences exist, the output error file tpasc.lst  opens listing the differences.

Creating a Test Point ASCII File
You can create an ASCII test point list in an older design format.

Procedure
1. Open the .pcb  file in SailWind Layout.

2. Click the File  > Export  menu item to open the File Export dialog box.

3. Type a name in the File name box.

4. Click Save  and the ASCII Output dialog box appears.

5. Click the PowerPCB V3.0 Format from the list.

6. Click Current from the Units list.

7. Click Select All  to select all check boxes.

8. Click OK.

Performing a Test Point Audit
Use DFT (Design For Test) Audit to manage test points used to support In Circuit Testing (ICT) 
procedures. Test points help you meet your ICT requirements early in the design process and can 
improve your productivity by reducing design iterations.

When you run DFT Audit, SailWind Layout automatically transfers the design to SailWind Router. Using 
options you set in SailWind Layout, SailWind Router analyzes all nets for accessibility and adds test 
points to routed accessible nets. Note that SailWind Router may reroute nets during DFT Audit. When 
SailWind Router is done, it transfers the design back to SailWind Layout. For nets that SailWind Router 
determines to be inaccessible, SailWind Layout can optionally add test points, which are placed outside 
the board edge. When DFT Audit finishes, the DFT Audit Board Report appears.
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Prerequisites

• SailWind Router must be installed and licensed for you to run DFT Audit in SailWind Layout. You 
can run DFT Audit regardless of the layer limits in the SailWind Router license.

• If you are using BGAs, fan out the BGAs before running DFT Audit.

Procedure
1. Click the Tools  > DFT Audit  menu item.

2. On the DFT Audit dialog box, click the tab for which you want to modify the test point placement 
options and properties:

• Options  on page 866

• Properties  on page 867

• Assignment  on page 868

3. Modify the properties on the tab as required.

4. Click Run. The automatic audit process starts.

Tip
DFT Audit honors any test point keepouts defined in the design.

Related Topics
Design for Test

Automatic Test Point Placement [SailWind Router User's Guide]

Placing Test Points
Several options for placing test points are available to you on the Options  tab of the DFT Audit dialog 
box. Choose the options that best fit the requirements of your current design.

Tip
To reduce design iterations, consult with your automated test engineers when setting DFT Audit 
options.

Procedure
1. Click the Tools  > DFT Audit  menu item, then select the Options  tab.

2. Define how test points are created using options in the Create test points area.

You can preserve existing via properties and add test point vias to routed, accessible nets.
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3. Set probe via test point properties using options in the Probe through area.

4. Place via test points on a grid using options in the Place via points using area.

5. Specify test point nail diameters using options in the Available Nail Diameters area.

6. Set minimum pad areas using options in the Minimum Pad Probing Sizes area.

Set minimum pad probing sizes for both vias and component pins to ensure that there is sufficient 
pad area for probe contact.

Tip
In DFT, virtual pins are treated as component pins.

Related Topics
Performing a Test Point Audit

Setting Test Point Properties
Several test point properties are available to you on the Properties  tab of the DFT Audit dialog box that 
allow you to specify many of the physical characteristics of test points.

Tip
To reduce design iterations, consult with your automated test engineers when setting DFT Audit 
options.

Procedure
1. Click the Tools  > DFT Audit  menu item, then select the Properties  tab.

2. Specify the minimum distances between the probe and other design objects using options in the 
Probe Minimum Distances area.

Tip
The clearances needed between a probe and another design object are mostly based on 
the physical constraints of the Automated Test Equipment (ATE) used by In Circuit Testing 
(ICT) procedures. The probes extending out of the ATE fixture must make contact with 
the PCB without interference from any obstacles. This means that test points must keep 
a fixed distance from component bodies, pads, mounting holes, and the board edge, and 
must also have the minimum spacing between them.

3. Specify the maximum length of trace stubs required to make a net accessible to a test probe by 
typing the length into the Stub Length box.

4. Specify zero or more than one nail pins on a net using options in the Multiple Test Point Nets area.

By default, all nets are set to receive one probe, or nail pin. If you do not want any nail pins on a 
net, double-click the Nail Pins cell for the net and type zero (0). If you want to change the number 
of nail pins for a net to receive, in the Multiple Test Point Nets area, type the new value in the Nail 
Pins cell for the net.
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To display only nets with no nail pin or with more than one nail pin, select the Show Only Nets with 
Nail Pins Not Equal to One check box.

To sort the list by a different column, click the column header at the top of the list.

Related Topics
Performing a Test Point Audit

Setting Test Point Assignment Eligibility
Use the Assignment  tab to prevent or favor assigning test points to components or to via types. By 
default, all pins on a net are available for test pin assignment and are evenly weighted as test point 
candidates.

Tip
To reduce design iterations, consult with your automated test engineers when setting DFT Audit 
options.

Procedure
1. Click the Tools  > DFT Audit  menu item, then select the Assignment  tab.

2. To prevent use as a test point, select the Exclude check box.

3. To favor use as a test point, select the Prefer check box.

4. To apply even weighting, clear the Exclude and Prefer check boxes.

To change the check box value for multiple rows, select the rows and then click a check box.

To sort the spreadsheet by a specific column, click that column's header.

Related Topics
Performing a Test Point Audit

Probing the PCB Top Side Only
You can restrict test point probing to the PCB top side only. This is useful for preparing a test setup when 
physical restrictions exist that will not let you access the bottom of the board during testing.

Procedure
1. Create a test point keepout  on page 465 on the bottom side of the board.

2. Click the Tools  > DFT Audit  menu item to open the DFT Audit dialog box.

3. Click the Options  on page 866 tab.

4. In the Probe through area, select the Probe Top Side check box.

5. Click Run.
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Modifying a Jumper Pin that is a Locked Test Point

Results
DFT Audit ignores the bottom side because it has a test point keepout defined. Only the top side of the 
PCB is probed.

Modifying a Jumper Pin that is a Locked Test Point
When modifying or moving a jumper pin that is a locked test point, a message is presented indicating that 
the object is locked and you will be required to confirm your design intent.

Procedure
You will be modifying a locked test point in one of the following ways:

• If you are modifying the pad stack of a jumper pin that is a locked test point, the “One of the jumper 
pins is locked as a test point. Do you want to apply the changes to jumper?” message appears. Click 
one of the following:

• Yes  — Applies the change and maintains the locked test point status.

• No  — Cancels the change.

• If you move a jumper pin that is a locked test point, the “Via marked as Test Point. Proceed Anyway?” 
message appears. Click one of the following:

• Disable Lock Test Points  — Turns the Lock Test Points check box off in the Options dialog box > 
Routing  category > General subcategory  on page 1542.

• OK  — Allows you to move the jumper pin and maintain the test point status; the jumper pin is 
locked in its new position.

• Cancel  — Cancels the move.

Modifying a Pin that is a Locked Test Point
When modifying a pin that is a locked test point, a message will presented indicating that the object is 
locked and you will be required to confirm your design intent.

Procedure
You will be modifying a pin that is a locked test point in one of the following ways:
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• If you are modifying the pad stack of a component pin, the “Do you want to apply the changes to all 
components with decal type xxx or just the selected components?” message appears. Click one of the 
following:

• All — Applies the change to all decal types.

• Selected — Applies the change to the selected decal.

• Cancel — Cancels the change.

• If the component pin is a locked test point, the “Include locked test points in Pad Stack update?” 
message appears when you click All or Selected. Click one of the following:

• Yes  — Applies the change and maintains the locked test point status.

• No  — Cancels the change.

Modifying a Route Attached to a Locked Test Point
When modifying a route that is attached to a locked test point, a message will presented indicating that 
the object is locked and you will be required to confirm your design intent.

Procedure
If you attempt to move or modify a route that is attached to a via that is a locked test point, the “Command 
causes the move of Via(s) marked as Test Point(s). Continue command ignoring Test Points or keep them 
locked during modification of route?” message appears. Click one of the following:

• Disable Lock Test Points  — Turns the Lock Test Points check box off in the Options dialog box > 
Routing  category > General subcategory  on page 1542.

• OK  — Performs the modification and moves the via along with the route, ignoring the locked test point 
setting. The test point will be locked again in its new position.

• Keep Locked  — Performs the modification but does not move the via; the locked test point location is 
maintained. You can modify the route, but the test point via does not move.

• Cancel  — Cancels the modification.
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Modification of a Via or Virtual Pin That is a Locked Test Point

Modification of a Via or Virtual Pin That is a Locked 
Test Point
When modifying a via or a virtual pin that is a locked test point, you can choose to modify the pad stack, 
or assign a different via type.

Modifying the Pad Stack of a Via or Virtual Pin That Is a Locked Test Point
Assigning a Different Via Type To a Via That Is a Locked Test Point
Assigning a Different Via Type To a Virtual Pin That Is a Locked Test Point

Modifying the Pad Stack of a Via or Virtual Pin That Is a 
Locked Test Point
When modifying the pad stack of a via or virtual pin that is a locked test point, a message will presented 
indicating that the object is locked and you will be required to confirm your design intent.

Procedure
You are modifying the pad stack of a locked test point in one of the following ways:

• If you modify the pad stack of a via or virtual pin in the Pad Stacks Properties dialog box, the “Are you 
sure you want to change all vias of type xxx?” message appears. Click one of the following:

• Yes  — applies the change.

• No  — cancels the change.

• If the via/virtual pin is a locked test point, the “Include locked test points in Pad Stack update?” 
message appears. Click one of the following:

• Yes  — Applies the change and maintains the locked test point status.

• No  — For vias, cancels the change. For virtual pins, the change is made (that is, as though Yes 
had been selected).

Results
If you do not include test points in the update, then the pad stacks for the test points are preserved by 
renaming them with a TP_ prefix; for example, changing the pad stacks for STANDARDVIA, the test point 
pad stack is renamed TP_STANDARDVIA.

Assigning a Different Via Type To a Via That Is a Locked 
Test Point
When assigning a different via type to a via that is a locked test point, a message will presented indicating 
that the object is locked and you will be required to confirm your design intent.

SailWind Layout Guide and Reference 871



Checking a Design for Errors
Assigning a Different Via Type To a Virtual Pin That Is a Locked Test Point  

Procedure
If you assign a different via type to a via that is a locked test point, by selecting a new Via Name in the Via 
Properties dialog box, the “Command causes change of via type for Via(s) marked as Test Point. Proceed 
Anyway?” message appears. Click one of the following:

• Disable Lock Test Points  — Turns the Lock Test Points check box off in the Options dialog box > 
Routing  category > General subcategory  on page 1542.

• OK  — Applies the change and maintains the test point status.

• Cancel  — Cancels the change.

Assigning a Different Via Type To a Virtual Pin That Is a 
Locked Test Point
If you assign a different via type to a virtual pin that is a locked test point, by selecting a new Via Name in 
the Virtual Pin Properties dialog box, no message appears, and the change is made.

Procedure
Assign a different via type to a virtual pin that is a locked test point, by selecting a new Via Name in the 
Virtual Pin Properties dialog box.

Moving a Via or Virtual Pin That Is a Locked Test 
Point
When moving a via or virtual pin that is a locked test point, a message will presented indicating that the 
object is locked and you will be required to confirm your design intent.

Procedure
If you move a via or virtual pin that is a locked test point, the “Via marked as Test Point. Proceed 
Anyway?” message appears. Click one of the following:

• Disable Lock Test Points  — Turns the Lock Test Points check box off in the Options dialog box > 
Routing category > General subcategory  on page 1542.

• OK  — Allows you to move the via and maintain the test point status; the via is locked in its new 
position.

• Cancel  — Cancels the move.
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Move Sequential to Move Components, Unions, or 
Clusters with a Locked Test Point
When using Move Sequential to move a components, union or cluster that contains a pin that is a locked 
test point, a message will presented indicating that the object is locked and you will be required to confirm 
your design intent.

Procedure
When using Move Sequential with a locked test point, one of the following occurs:

• If a part or union selected for Move Sequential contains a pin that is a locked test point, the 
“Component/Union xxx have pins marked as Test Points. Continue?” message appears. Click one of 
the following:

• Yes  — Moves the part although it is a test point. The test point is locked in its new position.

• No  — Skips the component or union.

• Cancel  — Cancels the move sequence.

• If a cluster selected for Move Sequential contains a pin that is a locked test point and Collapse Mode 
is on, the “Cluster xxx has members with pins marked as Test Points. Continue?” message appears. 
Click one of the following:

• Yes  — Moves the cluster even though it is a test point. The test point is locked in its new position.

• No  — Skips the cluster.

• Cancel  — Cancels the move sequence.

Moving, Dispersing, or Aligning a Component, 
Cluster, or Union with a Locked Test Point
When moving, dispersing, or aligning a components, union or cluster that contains a pin that is a locked 
test point, a message will presented indicating that the object is locked and you will be required to confirm 
your design intent.

Note:
This applies to Rotate 90, Spin, Flip Side, Radial Move, Group Rotate 90, and Flip Group. This 
also applies to Automatic Cluster Placement operations, such as Collapse Cluster, and changing 
the decal of a component.

Procedure
If you attempt to move a component with a pin that is a locked test point, the “Component pin(s) marked 
as Test Point. Proceed Anyway?” message appears. Click one of the following:
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• Disable Lock Test Points  — Turns the Lock Test Points check box off in the Options dialog box > 
Routing  category > General subcategory  on page 1542.

• OK  — Performs the modification and moves the component, ignoring the locked test point setting. The 
test point will be locked again in its new position.

• Cancel  — Cancels the modification.
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DFF, Design For Fabrication
To support fabrication design rules, SailWind Layout provides fabrication checks with Verify Design. 
This functionality, called DFF Audit (Design For Fabrication) , lets you either check for fabrication errors 
within SailWind Layout or backward annotate errors from the CAM product, CAM350. DFF Audit detects 
potential errors in a design, so that you can identify these problems prior to board fabrication.

The checking within SailWind Layout uses the CAM document definitions to determine if fabrication errors 
exist. The CAM documents determine the photoplotter output and include layer composites, oversize, 
suppression, and other masking preferences. All electrical layers are analyzed to check acid traps and 
copper sliver fabrication. To check mask sliver and solder mask bridge fabrication, the solder mask layers 
are analyzed. To check silkscreen over pads, silkscreen layers are compared to solder mask layers.

Design for Fabrication Workflow
Process Flow for Using DFF Audit
DFF Audit Process Flow using CAM350 Link

Design for Fabrication Workflow
Design For Fabrication is best accomplished using a structured workflow to define the various steps of the 
process.

The table below shows the basic workflow for auditing your design for fabrication.

Figure 118. Design for Fabrication Workflow

Process Flow for Using DFF Audit
You can use DFF Audit to detect and resolve any fabrication errors. The audit process analyzes, verifies 
and displays any errors in the design related to the specific checks that you specify.

Prerequisites
You need the CAM350 Link license option to use this.
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Procedure
1. Lay out the design using SailWind Layout  on page 253 and SailWind Router  on page 776.

2. Create CAM documents  on page 934.

3. Set up Verify Design preferences for fabrication checks  on page 894.

4. Run Verify the Design.

5. Use the layout editor in conjunction with the Verify Design dialog box to view and correct 
fabrication errors.

6. Repeat steps 3 through 5 until fabrication errors are resolved.

DFF Audit Process Flow using CAM350 Link
If you use CAM350 in your design process, you can use DFF Audit to detect and resolve any fabrication 
errors. The audit process analyzes, verifies and displays any errors in the design related to the specific 
checks that you specify.

Prerequisites
You need the CAM350 Link license option to use this.

Procedure
1. Lay out the design using SailWind Layout  on page 253 and SailWind Router  on page 776.

2. Create CAM documents  on page 934.

3. Output the CAM documents to CAM350.

4. Set up Verify Design preferences for fabrication checks  on page 894.

5. Run Verify the Design.

6. Use the layout editor in conjunction with the Verify Design dialog box to view and correct 
fabrication errors.

7. Use CAM350  on page 876 to view errors. Use SailWind Layout to correct fabrication errors.

8. Repeat steps 3 through 7 until fabrication errors are resolved.

Exporting to CAM350
You can translate a SailWind Layout design using CAM350 Link. This allows you to perform additional 
design analysis on your design in the CAM350 environment.

Prerequisites
You need the CAM350 Link license option to use this.
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Exporting to CAM350

Procedure
1. Create a SailWind Layout design.

2. Click the File  > Export  menu item, and in the Save as type list, click CAM350 and then click Save. 
The CAM350 dialog box appears.

3. Choose a mode - to either create the CAM350 .cam  file only, or create the file and automatically 
launch CAM350.

4. In the Layer Options area, select an option for the amount of PADS design detail to translate to the 
CAM350 database.

5. Arcs in polygon shapes, such as copper planes, are approximated using straight edges. In the Arc 
Approximation Tolerance box, type the minimum allowable distance between the actual arc path 
and the approximated straight-line segments. This appears in the appropriate design units, which 
you set on the Options dialog box > Global  category > General  subcategory.

6. In the CAM350 File Name box, type a .cam  path and file name or click Browse to navigate to a 
location.

The default file name and path are the same name as the current design file name and path.

7. Click OK.

8. Run your manufacturing process in CAM350.

Results
Once the design file is in CAM350, you can perform DFM analysis on the design. If DFM errors exist, 
you can back-annotate  on page 889 the errors to SailWind Layout to identify and correct them. 
Subsequently, you can generate a new CAM350 database and verify that all DFM errors have been 
corrected. You can then create CAM outputs in either SailWind Layout or CAM350.

The processing routines that translate SailWind Layout data into CAM350 .cam  files detect errors and 
warnings and report them to the standard SailWind Layout error file (Layout.err).
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Working with Markups
You can use markups to define and document specific issues related to your design. This lets you notate 
design concerns and easily share them with associates or downstream process personnel.

Adding Markups
Exporting Markups Using the Markups Dialog Box
Exporting Markups Using File > Export
Importing Markups Using the Markups Dialog Box
Importing Markups Using File > Import
Linking Design Objects to Markup Issues
Unlinking Design Objects from Markup Issues

Adding Markups
Use the Markups dialog box to log issues concerning the design. You can add 2D line markups to issues 
in order to outline or highlight their location. You can also link design objects to markups.

Prerequisites
You must create at least one topic section to begin adding issues and 2D line markups.

Procedure
1. Click the Edit  > Markups  menu item.

2. Click the Add Topic  button to add a topic.

For example, as you review the design for another designer, you spot several silkscreen placement 
issues. You could name the markup topic - Silkscreen.

3. Click the Add Issue  button to add an issue.

For example, your first issue could be the placement of a reference designator beneath a 
component. You could name the markup issue - Placement of R54 refdes.

4. Click the Add Markup  button.

5. Right-click and choose your options before adding the 2D line.

Restriction:
Line widths or the layer location of your 2D line markers are not maintained when exporting 
and re-importing.

6. Draw a 2D line to highlight the area of concern.

For example, you could draw a rectangle around the offending refdes.

7. You can also link design items  on page 881 to the markup.

8. Save the markups by choosing one of the following:
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Exporting Markups Using the Markups Dialog Box

• Click the Export  button in the Markups dialog box to export the markups into a .cle  encrypted 
collaboration file.

• Click the File  > Save as  menu item to generate a snapshot of the design and create a .cle  file 
to match it.

Note:
The markups are not saved when you click the File  > Save  menu item (or the Save 
button on the dialog box, or Ctrl+S).

Results

• Issues are logged against the design and ready to be shared.

• Markups take the color of 2D lines on any given layer.

Related Topics
Importing Markups Using the Markups Dialog Box

Importing Markups Using File > Import

Exporting Markups Using the Markups Dialog Box
You can use the Markups Dialog Box to export markups for use in another software tool like CAMCAD 
and visECAD. The markup is exported into a simple .cle  file which contains only the markup information.

Alternatively, you can export a .CCE  file which includes most design elements along with the markups. 
See “Exporting Markups Using File > Export”.

Procedure
1. Click the Edit  > Markups  menu item.

2. In the Markups dialog box, click the Export  button.

3. In the Collaboration Data Save As dialog box, type a name for the .cle  file.

4. Click Save.

Exporting Markups Using File > Export
You can use the File > Export command to export markups for use in another software tool like CAMCAD 
and visECAD. The markup is exported in a .CCE  file which includes most design elements along with the 
markups.

Alternatively, you can export a simple .cle  file which contains only the markup information. See “Exporting 
Markups Using the Markups Dialog Box”.

SailWind Layout Guide and Reference 879



Checking a Design for Errors
Importing Markups Using the Markups Dialog Box  

Procedure
1. Click the File  > Export  menu item.

2. In the File Export dialog box, in the Save as type list, click either Collaboration Files (*.cle), or CCE 
Files (*.cce).

3. Type a name for the .cle  file or the .cce  file.

4. Click Save.

Results
Markups are exported into the file. If you placed markup lines on different layers in the design, this 
information is ignored and all markups are exported into a single layer in the .cle file.

Related Topics
Exporting CCE Files

Importing Markups Using the Markups Dialog Box
You can use the Markups Dialog Box to import markups created in another software tool, like CAMCAD or 
visECAD.

Restrictions and Limitations
Any markups that exist in the Markups dialog box will be deleted before the new data is imported.

Procedure
1. Click the Edit  > Markups  menu item.

2. In the Markups dialog box, click the Import  button.

3. In the Collaboration Data Import dialog box, browse for and select the .clb  or .cle  file to import.

4. Click Open.

Related Topics
Importing Markups Using File > Import

Importing Markups Using File > Import
You can use the File  > Import  menu item to import markups created in another software tool, like 
CAMCAD or visECAD.

Restrictions and Limitations
Any markups that exist in the Markups dialog box will be deleted before the new data is imported.
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Linking Design Objects to Markup Issues

Procedure
1. Click the File  > Import  menu item.

2. In the File Import dialog box, in the Files of type list, click Collaboration Files (*.clb, *.cle).

3. Browse for and select the .clb  or .cle  file to import.

4. Click Open.

Results

• The Markups dialog box is populated with the imported collaboration data.

• Some shapes imported from other software have no equivalent in SailWind Layout (for example, 
sticky notes). They are represented as accurately as possible with 2D lines in SailWind Layout.

• The text that accompanies any imported shapes is not located in the design, but appears in the 
Text box in the Markups dialog box.

Related Topics
Importing Markups Using the Markups Dialog Box

Linking Design Objects to Markup Issues
You can link design objects to markups of issues. You can link components, nets, vias and drawings 
(board outline, 2D lines, keepouts).

Procedure
1. In the design, select one or more design objects.

2. In the Markups dialog box, right-click over the markup and click the Link Selected  popup menu 
item.

Results
The design items are listed under each element type in the elements tree of the Markups dialog box.

Related Topics
Unlinking Design Objects from Markup Issues

Adding Markups

Unlinking Design Objects from Markup Issues
You can unlink items from being linked to markups and listed in the elements tree of the Markups dialog 
box.

SailWind Layout Guide and Reference 881



Checking a Design for Errors
Unlinking Design Objects from Markup Issues  

Procedure
In the Markups dialog box, in the elements tree, right-click over an item and click the Unlink  popup menu 
item.

Related Topics
Linking Design Objects to Markup Issues
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Verify the Design

Verify the Design
You can check for individual or all design errors using the Verify Design dialog box. Check for the 
following types of errors: clearance, connectivity, high speed, number of vias, plane connection, test point, 
fabrication, wire bond. It does not check reference designator, part type, or attribute labels for clearance 
violations.

Running a Design Check
Review of the Design Error Results
Troubleshoot Design Verify Errors
Saving and Printing Error Results
Setting Default Report File Names
Previewing Fabrication Errors in CAM files
Back-annotating CAM350 Files
Adding Nets or Classes for Specific High-Speed Checks
Setting Up Clearance Checking
Setting Up Checking for Isolated Stitching Vias
Setting Up Latium Checking

Running a Design Check
You can check for individual or all design errors using the Verify Design dialog box:

Procedure
1. Click the Tools  > Verify Design  menu item.

2. In the Check area of the Verify Design dialog box, choose a checking option.

3. If the Setup  button is available (unavailable for Maximum via count and Test Points checks):

a. Click Setup  to specify additional settings for the check.

b. Specify settings in the Setup dialog box and then click OK.

4. Click Start  to run the check.

5. After the check process completes, a message window might open with the number of errors 
found. Click OK.

Results
Error markers appear in the design at error locations and error details populate the Verify Design dialog 
box. For more information, see “Interpreting Error Markers”.
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Review of the Design Error Results
Use Verify Design to examine error markers and view the descriptions of each error.

Reading Error Details
Viewing Errors in the Design
Interpreting Error Markers

Reading Error Details
Error results for a type of check are listed in the Location box. Listed errors, contain their (X,Y) location, 
layer, and error type.

Procedure
1. Click the Tools  > Verify Design  menu item.

2. Select an error from the list.

The explanation for the error appears in the Explanation box.

3. View the more specific, detailed information about the error selected in the Location list including 
information about any conflicting object.

4. Click Close  when you are finished with the Verify Design dialog box.

The current error list remains whether the dialog box is open or closed. The error markers remain 
until you click Clear Errors, which clears the markers, not the errors.

Viewing Errors in the Design
You can view error markers in the design. Error markers in the workspace indicate the error type.

Prerequisites
Colors must be assigned properly in the Display Colors dialog box in order to see error markers. Errors in 
the design area appear in the color of the Errors check boxes per layer of the Display Colors dialog box. 
When an error is selected in the Location box, the error in the design area appears in the Highlight color.

Procedure
1. You open the Verify Design database to perform a design check and generate a list of any errors 

occurring in your design.

See “Running a Design Check”  on page 883 for instructions.

2. With the “Verify Design dialog box”  on page 1775 still open, select an error from the Location list.

3. The design window pans to the area of the error (unless you select Disable Panning first).

The pan to the area of the area is more obvious if you are zoomed into your design.
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Interpreting Error Markers

Tip
You can prevent the design area from panning to errors when you select them if you select 
the Disable Panning check box in the Verify Design dialog box.

The generated error list remains whether the dialog box is open or closed. If you close the dialog 
box, you can view the list in the error report file. You can access the report file by clicking the link 
that appears in the Output window.

Note:
Error markers are not erased from the design until you click Clear Errors  which clears the 
error markers, not the actual errors. You must correct the error in the design.

Interpreting Error Markers
After verifying the design, error markers are inserted in a SailWind Layout database as database objects. 
Error objects present in a SailWind Layout database transfer into SailWind Router and are converted into 
SailWind Router error objects during file load.

Tip
Within SailWind Router you can assign an error as ignored. An ignored error status makes the 
error marker invisible but leaves the error in the database. SailWind Layout supports storage of 
the ignored status on errors; however, ignored status can only be assigned or unassigned within 
SailWind Router. In SailWind Layout, ignored errors are not invisible. Ignored errors invisible 
in SailWind Router saved to a SailWind Layout file will be visible when the file is loaded into 
SailWind Layout. But ignored errors remain as ignored after a file is saved in SailWind Layout and 
loaded SailWind Router.

Most error objects in SailWind Layout are converted to an identical SailWind Router error object. The 
exceptions to these conversions are listed in the Notes column of the table below.

Table  128. SailWind Layout/Router Error Objects

Marker Error Notes

Testability and 
Connectivity

High-speed

Fabrication
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Table  128. SailWind Layout/Router Error Objects  (continued)

Marker Error Notes

Minimum/Maximum 
Length

Assembly (Latium Only) Component height errors become assembly errors 
in SailWind Router. Consequently, SailWind Router 
assembly errors in SailWind Router are converted to 
SailWind Layout keepout errors in SailWind Layout when 
the file is saved.

Drill to Drill Drill to Drill errors in SailWind Layout become fabrication 
errors in SailWind Router. Consequently, drill to drill 
errors in SailWind Router are converted to drill to drill 
errors in SailWind Layout when the file is saved.
Drill to Drill errors are reported for only one layer in a drill 
pair.

Clearance “Body to body” errors are clearance errors in SailWind 
Layout. “Body to body” checking is not performed in 
SailWind Router, only placement outline checking is 
performed as an assembly check. Therefore, “Body 
to body” errors cannot exist in SailWind Router. 
SailWind Layout “Body to body” errors are converted to 
placement outline errors in SailWind Router - identified 
by Assembly error markers. Consequently, SailWind 
Router Placement Outline errors in SailWind Router are 
converted to SailWind Layout placement outline errors in 
SailWind Layout when the file is saved.

 Tip
“Body to body” errors are not returned from SailWind 
Router.
 CAUTION:
When a design is loaded into SailWind Router, 
the SailWind Layout “Body to body” clearance 
rule value is converted to the SailWind Router 
“Minimum spacing between components” value. In 
SailWind Layout, the spacing between component 
outlines is performed between the edges of the 
lines used to define the component body outlines. 
In SailWind Router, the Placement outline checking 
is done using the centerline of the lines used to 
create the Placement outlines. Due to these subtle 
differences, components that meet the DRC spacing 
requirements in SailWind Router may have to be 
re-checked when the design returns to SailWind 
Layout.

Keepout Component height errors become assembly errors 
in SailWind Router. Consequently, SailWind Router 
assembly errors in SailWind Router are converted to 
SailWind Layout keepout errors in SailWind Layout when 
the file is saved.
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Troubleshoot Design Verify Errors

Table  128. SailWind Layout/Router Error Objects  (continued)

Marker Error Notes

Board Outline

Maximum Angle

Maximum Via Number One marker is added for every net with too many vias.

Latium Check The Latium error marker indicates that you have Latium 
rules  on page 1835 in your design. You can only check 
these rules by using the Latium Design Verification 
check in the Verify Design dialog box. Therefore, to 
be sure you do not have Latium errors, run the Latium 
check.

Troubleshoot Design Verify Errors
There are different types of errors such as clearance errors, subnet errors and untied plane pin errors. 
Interpreting them correctly will help you clear them from the design quickly.

Clearance Errors
Clearance errors can report a Same net clearance error with an error explanation of Distance between 
pads too small.

Although there is no specific SMD-to-SMD and SMD-to-Pad clearances, the SMD-to-Via clearance rule is 
used.

Subnet Errors
Connectivity checks often report a subnet error.

There are several causes of subnet errors:

• An unassigned net  — the net is not assigned to the plane area. Open the properties of the plane 
area shape  on page 1328 and ensure that a net is assigned to the shape. You can only assign a 
net while the shape is in outline mode.

• A small unroute  — turn off all layers in the Display Colors Setup Dialog Box. Assign a bright 
color to Connections and search the design for unroutes.
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Tip
You might find a connection to a pin that is not fully routed to the center of the pad. It's also 
easier to spot these if you assign a different color between pads and traces and enable the 
transparent mode to see the trace “underneath” the pad.

• An unplated component pin  — check the pad stacks properties  on page 1566 of the 
component pin and ensure the Plated check box is selected.

• A via or pad without a plane thermal  — open the Via Properties  on page 1779 or Pin 
Properties  on page 1632 dialog box and ensure the Plane Thermal check box is selected.

A Full Plane Check with Same Layer Connectivity Check will also display a subnet error which is caused 
only by isolated planes. For more information, see “Plane Checking Setup”.

Untied Plane Pin Errors
Plane checks sometimes report untied plane pin errors.

There are a few causes of untied plane pin errors:

• An unplated pin or via

• A pin with a pad size on a plane layer that is greater than the drill size plus the drill oversize

• A pin without the thermal attribute set

Saving and Printing Error Results
You can print error results, or alternatively, view the current error results in your default text editor.

Procedure
1. Click the Tools  > Verify Design  menu item.

2. To view the most recently run report results in the default text editor, click View Report. You can 
print or save the results from your default text editor.

Related Topics
Setting Default Report File Names

Setting Default Report File Names
When you run a Verify Design check, a report file is created with a unique name for each check type.

Procedure
1. Click the Tools  > Verify Design  menu item.

2. To specify the default file name of each report type click Report File.
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Previewing Fabrication Errors in CAM files

This opens the Save As dialog box where you can name the report that you will run, if you do not 
want to use the default reference name for the report type.

If you do not give the report a unique name, it is always saved to the default file name.

Tip
If you assign it a name, that name is the default for the report type until you change it 
again.

Previewing Fabrication Errors in CAM files
After you run a Fabrication check that reports errors, you can preview the CAM layer document 
associated with the error. The Preview button is available only when fabrication checking is enabled and 
lists errors.

Prerequisites
You need the CAM350 Link license option to use this.

Procedure
1. Click the Tools  > Verify Design  menu item.

2. Select an error in the Location box.

3. Click Preview.

Results
The CAM Preview Dialog Box  opens.

Tip
Since error markers are not added to the CAM document, it helps to zoom into the design area 
before you click Preview. If the CAM Preview does not open zoomed into the same area, you can 
click the Workspace button in the Cam Preview window to match the workspace view.

Note:
In the CAM Preview window, click Setup  to change the preview settings of the specified 
document in the preview area.

Back-annotating CAM350 Files
Backward annotation begins by parsing the specified CAM350 file for DFM errors. For each error listed in 
the file an error marker is added to the SailWind Layout database, at the error location.
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Prerequisites

• You need the CAM350 Link license option to use this.

• Existing DFM error markers in the SailWind Layout database are cleared before the CAM350 file 
is parsed.

Procedure
1. Perform DFM error analysis in CAM350 and save the file.

2. Open the design file in SailWind Layout.

3. Click the Tools  > Verify Design  menu item.

4. In the Verify Design Dialog Box, in the Check area, choose the Fabrication option.

5. Click Setup.

6. In the Fabrication Checking Setup Dialog Box  choose the Annotate DFF Errors option.

7. Type the name or browse for the CAM350 file in which DFM errors were saved.

8. Click Start  in the Verify Design dialog box. DFM error markers  on page 885 appear wherever 
errors exist in the design. They also appear in the Location list with their location.

9. Correct existing errors and regenerate the CAM350 database.

Adding Nets or Classes for Specific High-Speed 
Checks
You can run specific electrodynamic checks on nets or classes.

Procedure
1. Click the Tools  > Verify Design  menu item.

2. In the Verify Design Dialog Box, in the Check area, select the High Speed option.

3. Click Setup, then click Add Nets  or Add Classes.

4. Select a net or class and then click OK.

Tip
You can select more than one item using Ctrl+click. You can select a range using Shift
+click or by dragging the cursor.

Related Topics
Setup of High Speed (Electrodynamic) Checking

Setup of EDC Parameters
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Setting Up Clearance Checking

Setting Up Clearance Checking
Use the Clearance Checking Setup dialog box to specify which clearances to check during a Clearance 
verification.

CAUTION:
Clearance checks are only applied to design objects that are visible in the workspace view at 
your current zoom level and only those design objects with their colors are turned on. If you are 
zoomed in or have objects turned off, they are ignored by the clearance check.

Restrictions and Limitations

• Clearance checking only checks the visible area of the design.

• Reference designator, part type, and attribute labels are not checked for clearance violations.

• Clearance checking does not check against 2D lines.

• Clearance checking is not performed on CAM Planes.

Procedure
1. Click the Tools  > Verify Design  menu item.

2. In the Verify Design Dialog Box, in the Check area, select the Clearance option, and then click 
Setup.

3. Select the check box beside any types of clearance checks you want to enable and then click OK.

Tip
Acute angles create solder bridging between conductive objects during board 
manufacturing.

Related Topics
Verify the Design

Design Rule Hierarchy

Setting Up Checking for Isolated Stitching Vias
During design verification, you can use the Connectivity Check to report isolated routing vias and isolated 
stitching vias.

(An isolated stitching via is a stitching via that is not connected to any hatch outline or copper area.) 
However, to have the check report isolated stitching vias, you must first set it up to ignore connections to 
CAM planes.
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Procedure
1. Click the Tools  > Verify Design  menu item.

2. In the Verify Design Dialog Box, in the Check area, select the Connectivity option and then click 
Setup.

3. In the Connectivity Checking Setup dialog box, select the Ignore CAM plane connection for 
isolated stitching vias check box and click OK.

Results
When you verify the design, the checking operation reports isolated stitching vias as errors and marks 
them in the design, along with the other errors found during checking.

Setting Up Latium Checking
Latium checking performs advanced design checking using the Latium technology contained with 
SailWind Router.

Procedure
1. Click the Tools  > Verify Design  menu item.

2. In the Verify Design Dialog Box, in the Check area, select the Latium Design Verification option, 
and then click Setup.

3. Select the “Net to All” check box to check clearance rules on each net or hierarchical level against 
any other obstacle type.

4. Select the Board Outline check box to check clearance rules for the board outline and board cut 
outs.

5. Select the Off Board Text check box to check for off-board text and to flag all instances of off-board 
text as clearance errors.

6. Select the Keepout check box to check for keepout restriction violations.

7. Select the Same Net check box to check clearances between objects along the same net, as 
specified in the Clearance Rules dialog box.

For more information, see “Design Rule Hierarchy”.

8. Select the Drill to Drill check box to check clearances between all drill holes. Pad stack drill size 
plus the drill oversize value calculate the diameter for plated holes.

Tip
Drill to drill errors are reported for only one layer in a drill pair.

9. Select the Trace Width check box to check traces in excess of minimum and maximum widths, 
specified in the Clearance Rules dialog box.

For more information, see “Design Rule Hierarchy”.

10. Select the Placement Outline check box to check outline against outline with the following 
considerations:
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• In default layer mode, check outline against outline on layer 20, not on electrical layers.

• In increased layer mode, check outline against outline on layer 120.

Tip
You can create outlines on layer 20 (or 120) that do not exactly match the actual 
component outline. By setting a larger outline on this layer, you can leave an area near a 
component open for other purposes. This check ensures this area is left open.

11. Select the Via at SMD check box to check for via at SMD restriction violations.

For more information, see “Pad Entry Rules Dialog Box”.

12. Select the Differential Pairs check box to check for differential pair restriction violations.

For more information, see “Creating Differential Pair Design Rules”.

13. Select the Trace Length check box to check for length restriction violations.

For more information, see “HiSpeed Rules Dialog Box”.

14. Select the Test Point check box to check test points on the design.

Test Points checks for probe clearances, minimum via/pad sizes for probing, SMD pin probing, 
test points on component pin on the component side, test point count per net settings and nail 
diameter settings, and compares the settings against the setting in the DFT Audit program. For 
more information, see “Performing a Test Point Audit”.

Results
Latium design checks are performed with the following restrictions:

• Reference designator, part type, and attribute labels are not checked for clearance violations.

• Latium design verification performs clearance checking on only the visible area of the design. 
When clearance checking against the board outline, the edge of the object is checked against the 
centerline of the board outline.

• Drill to Drill errors are reported for only one layer in a drill pair.

• Test point checking is the same whether you enable the checking on the Latium Checking Setup 
dialog box or on the Verify Design dialog box. If you plan to perform Latium design verification, 
you can eliminate an extra design transfer between SailWind Layout and SailWind Router by 
running test point checking with the other Latium checks.

Related Topics
Verify the Design
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Fabrication Checking
Use the Fabrication Checking Setup dialog box to enable fabrication checks, or to load DFF errors from a 
pre-existing CAM350 database and annotate into the design.

Note:
You need the CAM350 Link license option to use this.

Fabrication Checks Definition
Fabrication Check Types
Setup of High Speed (Electrodynamic) Checking
Setup of EDC Parameters
Plane Checking Setup
Setting Up Wire Bond Checking
Check the Plane Connection for Continuity
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Fabrication Checks Definition
This section describes the DFF Audit options in the Fabrication Checking Setup dialog box.

Acid Traps
Slivers
Solder Bridges
Starved Thermals
Annular Ring
Silkscreen Over Pads
Trace Width/Pad Size

Acid Traps
An acid trap is a location where, due to the surface tension of the etching, acid gets trapped in an area. 
This acid causes over-etching, which hurts yield. The acid trap runs on all visible electrical layers as 
defined by CAM documents.

Acid Trap Maximum Size indicates the maximum size of the acid traps to flag. The area of pools that are 
flagged will be less than this value (Figure 119).

Figure 119. Acid Trap Maximum Size

Acid Trap Maximum Angle is an angle from 1 to 89 degrees. Any copper items (traces, pads, or any other 
objects that exist on the layer) that form an angle smaller than this are flagged as an acid trap (Figure 
120).

Figure 120. Acid Trap Maximum Angle

Slivers
Copper slivers are areas in the copper that are so narrow they may flake off. This check detects potential 
slivers on the electrical and composite layers in the design.

Copper slivers (Figure 121) should be eliminated whenever possible to prevent defect from occurring 
during the etching process.
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Minimum Copper indicates the maximum size of the copper slivers to flag. This flags slivers of a width 
less than this value. This check runs on all visible electrical layers as defined by CAM documents.

Figure 121. Sliver

Mask slivers in the solder mask layer are areas where the solder mask is so narrow they may flake off. 
These flakes float around and may drop into an area that needs to be soldered later, resulting in a bad 
board.

Minimum Mask (Figure 122) indicates the maximum size of the slivers to flag. This flags slivers of a width 
less than this value. This check runs top and bottom solder mask layers, if visible as defined by CAM 
documents.

Figure 122. Minimum Mask Size

Solder Bridges
When a mask layer is created, openings for pads may be oversized too much and expose an adjacent 
trace or other conductive object. Therefore, during fabrication, the copper for that pad may become too 
close and create a bridge to the adjacent object. Solder bridges are usually caused by problems during 
mask data creation.

The CAD system used may be unable to validate that what was created is going to work.

The Minimum Gap (Figure 123) is the maximum distance the solder can bridge and cause a connection to 
an adjacent object within the same mask opening. If the adjacent object is farther from the pad than this 
distance, even if the mask layer exposes it, it will not be identified as a bridge.

Figure 123. Minimum Gap
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Starved Thermals
Many designs are plagued by thermal pad problems for negative CAM planes because the CAD system 
did not verify whether the thermals were going to make good connections to the copper plane.

The Starved Thermals fabrication check verifies whether each thermal connection to the negative CAM 
plane is valid, or if it has been constricted by adjacent data that is too close or overlapping – effectively 
starving out the ties. This check runs on all visible CAM negative plane layers as defined by CAM 
documents.

Starved Thermal Minimum Clearance is the percentage of the area next to the spoke of the thermal that 
must not be blocked by another object. Any smaller opening is considered starved.

Figure 124. Starved Thermals

Starved Thermal Minimum Spokes is the number of thermal spokes that cannot be blocked by another 
object. Any less will be considered starved. The number of spokes is specified as EVERY, meaning all 
spokes must not be blocked, or as an integer from 1 to 4.

Annular Ring
The Annular Ring area lets you set up annular ring checks by comparing data on different layers. This test 
checks both the size and the offset between the two layers.

The checks (described in the table below) assure that proper clearances are observed to alleviate 
manufacturing problems in the board fabrication processes. Layers to be tested are derived from CAM 
documents and pad stack data. This area provides selections for pad, mask, and drill checks. When drill 
sizes are analyzed for annular rings, the drill oversize setting on the Tools > Options > Design tab is not 
considered.

Table  129. Annular Ring Checks

Annular Ring Check Type Checks

Annular Ring–Pad to Mask The clearance between a pad and its solder mask opening. 
The offset and the annular ring are checked against the 
specified clearance value. This check is run on top and 
bottom electrical layers against their associated solder mask 
layers.
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Table  129. Annular Ring Checks  (continued)

Annular Ring Check Type Checks

Annular Ring–Drill to Mask The clearance between a drill and its solder mask opening. 
The offset and the annular ring are checked against the 
specified clearance value. This check is run on the top and 
bottom drill layers against their corresponding solder mask 
layers.

Annular Ring–Drill to Pad The clearance between a drill and its associated pad 
calculated as <pad size - drill size>.The offset and the 
annular ring are checked against the specified clearance 
value. This check can be run on any specified electrical 
layer.

Silkscreen Over Pads
The Silkscreen Over Pads check lets you set up the clearance for comparing data on silkscreen layers 
against top and bottom electrical layers. This check analyzes both the size and the offset between the two 
layers.

Layers to be tested are derived from CAM documents and pad stack data. This check is run for top and 
bottom electrical layers against their associated silkscreen layers.

Figure 125. Comparing Data on Silkscreen Layers

Trace Width/Pad Size
The Trace Width/Pad Size check runs minimum trace width and minimum pad size checks for electrical 
layers.

The Trace Width check detects small electrical traces on the electrical layers in the design. Minimum 
Trace indicates the maximum size of the traces to flag. Traces with a width less than this value will be 
flagged. This check runs on all visible electrical layers as defined by CAM documents.

The Pad Size check detects small pads on the electrical layers in the design before the board is 
manufactured. Minimum Pad indicates the maximum size of the pads to flag. Pads with a diameter 
less than this value will be flagged. This check runs on all visible electrical layers as defined by CAM 
documents.
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Fabrication Check Types
Fabrication checks are used to verify that a design is manufacturable and that typical fabrication issues 
have been eliminated from the design.

Running Fabrication Checks
Checking Acid Traps
Checking Slivers
Checking Starved Thermals
Checking Trace Width/Pad Size
Checking Silkscreen Over Pads
Checking Annular Ring
Pad to Mask
Drill to Mask
Drill to Pad
Checking Solder Bridges
Annotating DFF Errors

Running Fabrication Checks
Fabrication checks are used to analyze a design and report potential fabrication issues that might 
create defects during the manufacturing process. Use the results of the fabrication checks to verify the 
manufacturing integrity of your design.

Prerequisites
Fabrication checks require certain CAM documents, which are listed below. You may consider creating 
these files before running the Fabrication check.

• To check Acid Traps, all electrical layer CAM documents are required.

• To check Copper Slivers, all electrical layer CAM documents are required.

• To check Solder Mask Slivers, the top and bottom Solder Mask layer CAM documents are 
required.

• To check Solder Mask Bridges, the top and bottom electrical and solder mask CAM documents 
are required.

• To check Starved Thermals, all negative CAM Plane layer CAMD documents are required.

• To check Minimum Annular Rings, all electrical layer and solder mask layer CAM documents are 
required.

• To check Silkscreen Over Pads, the top and bottom solder mask and silkscreen CAM documents 
are required.
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Procedure
1. Click the Tools  > Verify Design  menu item.

2. In the Verify Design Dialog Box, in the Check area, select the Fabrication option, and then click 
Setup.

3. Choose the type of check that you want to run and set the required parameters.

Checking Acid Traps
Use this check to flag small areas where acid will pool up. The check is run on all visible electrical layers 
as defined in the CAM documents.

Procedure
1. Click the Tools  > Verify Design  menu item.

2. In the Verify Design Dialog Box, in the Check area, select the Fabrication option, and then click 
Setup.

3. Select the Acid Trap check box.

4. In the Maximum Size box, type a maximum value of the acid traps to detect.

The areas of the “pools” that are flagged will be less than this value.

5. In the Maximum Angle box, type a maximum angle for traces, pads, or any other data that exists 
on the layer.

Any items that form an angle smaller than this will be flagged as an acid trap.

Checking Slivers
Use this check to flag copper sliver and solder mask sliver areas. This compares the top solder mask 
layer against the top electrical layer and the bottom solder mask layer against the bottom electrical layer 
as defined in the CAM documents.

Procedure
1. Click the Tools  > Verify Design  menu item.

2. In the Verify Design Dialog Box, in the Check area, select the Fabrication option, and then click 
Setup.

3. Select the Slivers check box.

4. In the Minimum Copper box, type a minimum value for copper slivers.

This flags slivers with less area than this value.

5. In the Minimum Mask box, type a minimum value for solder mask slivers.

This flags the slivers with a width less than this value, checking the top and bottom solder mask 
layers if they are visible.
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Checking Starved Thermals
Use this check to flag invalid thermals where adjacent data overlaps the thermal spokes.

Restriction:
Starved Thermals are only checked on (negative) CAM planes.

Procedure
1. Click the Tools  > Verify Design  menu item.

2. In the Verify Design Dialog Box, in the Check area, select the Fabrication option, and then click 
Setup.

3. Select the Starved Thermals check box.

4. In the Minimum Clearance box type the percentage of the thermal's spoke that can be unblocked 
by another object.

Any less of an opening will be considered “starved.”

5. In the Minimum Spokes list, select the minimum allowable number of the thermal's spokes that 
cannot be blocked by another object.

Any less will be considered “starved.”

Checking Trace Width/Pad Size
Use this check to flag traces and pads that are too small. Checks all electrical layers as defined in the 
CAM documents.

Procedure
1. Click the Tools  > Verify Design  menu item.

2. In the Verify Design Dialog Box, in the Check area, select the Fabrication option, and then click 
Setup.

3. Select the Trace Width/Pad Size check box.

4. In the Minimum Trace box, type a minimum trace width value. This flags traces with a width less 
than this value.

This check runs on all visible electrical layers.

5. In the Minimum Pad box, type a minimum pad size. This flags pads with a diameter of less than 
this value.

This check runs on all visible electrical layers.

Checking Silkscreen Over Pads
Use this check to flag silkscreen over pads on top and bottom layers as defined in the CAM documents.
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Procedure
1. Click the Tools  > Verify Design  menu item.

2. In the Verify Design Dialog Box, in the Check area, select the Fabrication option, and then click 
Setup.

3. Select the Silkscreen Over Pads check box.

4. In the Minimum Gap box, type the minimum allowable distance between silkscreen features and a 
region exposed by solder mask.

Checking Annular Ring
Use this series of checks to flag minimum annular rings on top and bottom layers, comparing electrical, 
drill, and mask layers.

Procedure
1. Click the Tools  > Verify Design  menu item.

2. In the Verify Design Dialog Box, in the Check area, select the Fabrication option, and then click 
Setup.

3. Select the Annular Ring check box to enable the Pad to Mask, Drill to Mask and Drill to Pad 
checks.

4. The series of pad checking options are enabled for further definition.

Pad to Mask
Use the Pad to Mask check to flag minimum clearance distances between a pad and its solder mask 
opening. The offset and annular ring is checked against the specified clearance value. This compares 
the top electrical layer against the top solder mask layer or the bottom electrical layer against the bottom 
solder mask layer.

Procedure
1. Click the Tools  > Verify Design  menu item.

2. In the Verify Design Dialog Box, in the Check area, select the Fabrication option, and then click 
Setup.

3. Select the Pad to Mask check box.

4. In the box, type the minimum clearance value.

5. In the Layers list, select the layer to use for checking.

Drill to Mask
Use the Drill to Mask check to flag minimum clearance distances between a drill and its solder mask 
opening. The offset and annular ring is checked against the specified clearance value. This compares the 
top drill layer against the top solder mask layer or the bottom drill layer against the bottom solder mask 
layer.
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Drill to Pad

Procedure
1. Click the Tools  > Verify Design  menu item.

2. In the Verify Design Dialog Box, in the Check area, select the Fabrication  option, and then click 
Setup.

3. Select the Drill to Mask check box.

4. In the box, type the minimum clearance value.

5. In the Layers  list, select the layer to use for checking.

Drill to Pad
Use the Drill to Pad check to flag minimum clearance distances between a drill and its associated pad. 
The offset and annular ring is checked against the specified clearance value. This check is run on each 
specified layer.

Procedure
1. Click the Tools  > Verify Design  menu item.

2. In the Verify Design Dialog Box, in the Check area, select the Fabrication option, and then click 
Setup.

3. Select the Drill to Pad check box.

4. In the box, type the minimum clearance value.

5. In the Layers list, select the layer to use for checking.

Checking Solder Bridges
Use this check to flag solder mask bridging. Solder can bridge and cause a connection to an adjacent 
object within the same mask opening. If the adjacent object is farther from the pad than this distance, 
even if it is exposed by the mask layer, it will not be identified as a bridge.

This compares the top solder mask layer against the top electrical layer or the bottom solder mask layer 
against the bottom electrical layer as defined in the CAM documents.

Procedure
1. Click the Tools  > Verify Design  menu item.

2. In the Verify Design Dialog Box, in the Check area, select the Fabrication option, and then click 
Setup.

3. Select the Solder Bridges check box.

4. In the Minimum Gap box, type the minimum clearance value.

5. In the Layers  list, select the layer to use for checking.
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Annotating DFF Errors
If you use CAM350 for checking fabrication errors, you can load DFF errors from a CAM350 file.

Procedure
1. Click the Tools  > Verify Design  menu item.

2. In the Verify Design Dialog Box, in the Check area, select the Fabrication option, and then click 
Setup.

3. If not already selected, click the Annotate DFF Errors option.

4. In the CAM350 File Name box, type a .cam  path and file name or click Browse  to navigate to the 
location of a file to back-annotate DFF errors into SailWind Layout for design verification.

The file will be generated when the checks are run.

Related Topics
Fabrication Checks Definition

Verify the Design
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Setup of High Speed (Electrodynamic) Checking
Use the Electrodynamic Check dialog box to enable high-speed checks for individual nets and classes or 
for the whole design.

Note:
You must have specified your plane layers in the Layers Setup Dialog Box  before you run an 
electrodynamic check. For a two-layer board, temporarily identify one of the layers as a plane 
layer.

Enabling High Speed Checks
Deleting Tasks
Setting Electrodynamic Check Parameters
Setting Design Rules
Reusing Electrodynamic Check Settings

Enabling High Speed Checks
You can enable checks for the entire design or if you need to make specific checks of certain nets or 
classes, you can add them to the Task List. You can enable different checks for each item in the Task List.

Procedure
1. Click the Tools  > Verify Design  menu item.

2. In the Verify Design Dialog Box, in the Check area, select the High Speed option, and then click 
Setup.

3. If you need to add specific nets or classes to the Task List, click Add Nets  or Add Classes.

Tip
(N) is added to Task list items that are nets and (C) is added to items that are classes.

4. Select an item from the Task List to enable High Speed checks for that item.

5. Select the check boxes for the types of checks you want to enable.

To define checks for several nets or classes simultaneously, click more than one item in the list. If 
there are conflicting values between two selected items, the check boxes are dimmed but can be 
cleared and selected.

6. Repeat steps 2 and 3 for each remaining item.

Deleting Tasks
You can delete specific nets and classes from the Task List - deleting the custom checks.
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Procedure
1. Click the Tools  > Verify Design  menu item.

2. In the Verify Design Dialog Box, in the Check area, select the High Speed option, and then click 
Setup.

3. Select the task in the Task List and click Delete.

Setting Electrodynamic Check Parameters
You can set up Electrodynamic Check Parameters in addition to activating the Electrodynamic checks. 
Use the Parameters dialog box to enter physical properties of the PCB, to customize checks and to 
request report detail level.

Procedure
1. Click the Tools  > Verify Design  menu item.

2. In the Verify Design Dialog Box, in the Check area, select the High Speed option, and then click 
Setup.

3. Click Parameters.

Related Topics
Setup of EDC Parameters

Setting Design Rules
You can access the design rules from the Electrodynamic check dialog box. Use the Rules dialog box 
to enter high-speed rules such as minimum and maximum lengths, gaps for parallelism and tandem 
checking, and other limits like stub length and daisy chaining.

Procedure
1. Click the Tools  > Verify Design  menu item.

2. In the Verify Design Dialog Box, in the Check area, select the High Speed option, and then click 
Setup.

3. If you need to edit or assign rules for checking, click the Rules  button as a shortcut to the Rules 
dialog box.

Related Topics
Design Rule Hierarchy

Reusing Electrodynamic Check Settings
You can reuse your electrodynamic check settings. You can save the current electrodynamic check task, 
parameter and rules settings.
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Reusing Electrodynamic Check Settings

Procedure
1. Click the Tools  > Verify Design  menu item.

2. In the Verify Design Dialog Box, in the Check area, select the High Speed option, and then click 
Setup.

3. Click Save  or Save As  to store your settings to an .edp  file.

4. Click Open  to retrieve settings from an .edp  file.

Related Topics
Setup of EDC Parameters

Verify the Design
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Setup of EDC Parameters
Use the EDC Parameters dialog box to define global rules like layer thickness and copper thickness. You 
can also specify how detailed a design verification report you want.

Setting Up Layer Definitions
Setting Parallelism Check Details
Setting Daisy Chain Report Details
Setting Details for Other Checks
Including Segment Coordinates in Segments Reports
Listing Violations Only
Excluding Segments under/within Pads from Calculations

Setting Up Layer Definitions
You may have already set up your layer definitions in the Layers Setup dialog box, but this duplicate of 
the Layer Thickness table allows you to make modifications or to set definitions for the first time if needed. 
Set these definitions before you run an electrodynamic check.

Note:
Board Thickness is the total value of material and layer thicknesses in the current design units.

Procedure
1. Click the Tools  > Verify Design  menu item.

2. In the Verify Design Dialog Box, in the Check area, select the High Speed option, and then click 
Setup.

3. In the Electrodynamic Check dialog box, click the Parameters  button.

4. If the layers are not set up properly, use the Layers  button to gain easy access to the Layers Setup 
Dialog Box  where you can define layer properties, names, and functionality.

Note:
You must have specified your plane layers in the Layers Setup Dialog Box  before you run 
an electrodynamic check. For a two-layer board, temporarily identify one of the layers as a 
plane layer.

5. For each dielectric material layer, double-click the Type cell to select whether the “layer” is a 
Prepreg or Substrate layer.

Although it is a longer process, you can click a box and then click Edit instead of using the double-
click method.

6. For each layer, double-click the Thickness cell and type a value.

If no coating is required, set thickness to zero.

7. For dielectric material layers, double-click the Dielectric cell and type a dielectric constant value.
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Setting Parallelism Check Details

You can view and edit copper thicknesses by weight or design units. Click the copper thickness 
unit you want:

• Weight (oz) — Weight of copper in ounces, per square foot

• Design Units — Same unit of measure as the current database unit of measure

Setting Parallelism Check Details
You can select the extent of checking and reporting for Parallelism and Tandem checks.

Procedure
1. Click the Tools  > Verify Design  menu item.

2. In the Verify Design Dialog Box, in the Check area, select the High Speed option, and then click 
Setup.

3. In the Electrodynamic Check dialog box, click the Parameters  button.

4. In the Parallelism area, in the Check Against list, select the extent of checking. Select from:

• Nets/Pin Pairs — Checks the parallelism and tandem rules against the entire net or pin pair.

• Segments — Checks the parallelism and tandem rules against only individual segments.

5. In the Parallelism area, in the Report Detail list, select the extent of reporting. Select from:

• Net Names Only — Displays only net names and violations.

• Aggressors/Victims — Displays specific aggressor and victim nets.

• Segments — Displays segment coordinates and layers in addition to aggressor and victim nets.

Setting Daisy Chain Report Details
You can select the extent of reporting for the Stubs (Daisy Chain) check.

Procedure
1. Click the Tools  > Verify Design  menu item.

2. In the Verify Design Dialog Box, in the Check area, select the High Speed option, and then click 
Setup.

3. In the Electrodynamic Check dialog box, click the Parameters  button.

4. In the Daisy Chain area, in the Report Detail list, select the extent of reporting. Select from:
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• Net Names Only — Include the number of T points and whether the net is daisy chained.

• Stubs — Include the group of pins within each stub, the total stub length for each group, the 
number of T points, and whether or not the net is daisy chained.

• Pin Pairs — Include the pin to pin length of all pin pairs, the total pin pair length added together 
to form stubs, the number of T points, and whether the net is daisy chained.

• Segments — Include the coordinates and layer of all track corners, the pin to pin length of all 
pin pairs, the total pin pair length added together to form stubs, the number of T points, and the 
nets being daisy chained.

Setting Details for Other Checks
You can set various setting for other checks in the Design Verify process such as capacitance, 
impedance, delay, and length.

Procedure
1. Click the Tools  > Verify Design  menu item.

2. In the Verify Design Dialog Box, in the Check area, select the High Speed option, and then click 
Setup.

3. In the Electrodynamic Check dialog box, click the Parameters  button.

4. In the Other Checks area, in the Check Against list, select the extent of checking of Length and 
Delay rules. Select from:

Nets/Pin Pairs — Check the Length and Delay rules against the entire net or pin pair.

Segments — Check the Length and Delay rules against individual segments.

5. In the Other Checks area, in the Report Detail list, select the extent of reporting for capacitance, 
impedance, delay, and length. Select from:

Nets — Include the starting and ending pins of nets and net values for capacitance, impedance, 
delay, and length.

Pin Pairs — Include pin-to-pin points, pin pair values, and net values for capacitance, impedance, 
delay, and length.

Segments — Include individual segment coordinates and segment values for capacitance, 
impedance, delay, and length.

6. Select the Include Copper check box to include copper polygons with signal names in the 
capacitance calculations.

7. Select the Use FieldSolver for Calculations check box to calculate electric parameters of 
transmission lines such as: impedance, delay (per unit length), and capacitance (per unit length).

For more information, see the PADS HyperLynx SI/PI User’s Guide.
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Including Segment Coordinates in Segments Reports

Including Segment Coordinates in Segments Reports
You can include segment coordinates in reports where Segments has been selected in the Report Detail 
in any one of Parallelism, Daisy Chain, or Other Checks sections.

Procedure
1. Click the Tools  > Verify Design  menu item.

2. In the Verify Design Dialog Box, in the Check area, select the High Speed option, and then click 
Setup.

3. In the Electrodynamic Check dialog box, click the Parameters  button.

4. Select the Report Segment Coordinates check box.

Listing Violations Only
You can list only items that contain violations in the high-speed report.

Procedure
1. Click the Tools  > Verify Design  menu item.

2. In the Verify Design Dialog Box, in the Check area, select the High Speed option, and then click 
Setup.

3. In the Electrodynamic Check dialog box, click the Parameters  button.

4. Select the Report Violations Only check box.

Excluding Segments under/within Pads from Calculations
You can exclude trace segments under pads from calculations. When routing, traces are routed into the 
middle of pads. This final segment is excluded.

Procedure
1. Click the Tools  > Verify Design  menu item.

2. In the Verify Design Dialog Box, in the Check area, select the High Speed option, and then click 
Setup.

3. In the Electrodynamic Check dialog box, click the Parameters  button.

4. Select the Remove Segments under Pads check box.

Related Topics
Verify the Design
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Plane Checking Setup
Use the Mixed Plane Setup dialog box to set the type of Plane checking.

Checking Thermal Connectivity Only
Checking Clearance and Net Connectivity
Checking Same Layer Connectivity

Checking Thermal Connectivity Only
You can check your design for split/mixed or CAM plane thermal connectivity. Use this check to find pins 
or vias that do not have the thermal attribute set, or to find pins that are not within a plane area (thermals 
will not connect). You can set the thermal attribute in Jumper Pin, Pin, or Via Properties dialog boxes.

Procedure
1. Click the Tools  > Verify Design  menu item.

2. In the Verify Design Dialog Box, in the Check area, select the Plane option, and then click Setup.

3. Click “Check thermal connectivity only”.

4. Click OK.

5. Click Start  in the Verify Design dialog box to run the check.

Tip
Routed pins without the thermal attribute set are not marked as errors.

Related Topics
Assigning Copper Plane Thermal Attributes

Checking Clearance and Net Connectivity
You can check your design for split/mixed plane clearance and net connectivity errors. If the split/mixed 
plane is not connected in the design, the plane will be flooded before the check is run.

Prerequisites
Before you check for clearance and net connectivity, a plane area for each net assigned to the plane layer 
in the Layers Setup Dialog Box  must be present.

Procedure
1. Click the Tools  > Verify Design  menu item.

2. In the Verify Design Dialog Box, in the Check area, select the Plane option, and then click Setup.

3. Click Check clearance and connectivity.
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Checking Same Layer Connectivity

4. Click OK.

5. Click Start  in the Verify Design dialog box to run the check.

Tip
Pads on plane layers are checked for plating, a pad size on a plane layer that is greater 
than the drill size plus the drill oversize, or connection to a plane net.

Checking Same Layer Connectivity
Ensures that plane areas are continuous on the split/mixed plane layer. Plane areas of a particular net 
must have copper contact with each other without going to another layer.

Procedure
1. Click the Tools  > Verify Design  menu item.

2. In the Verify Design Dialog Box, in the Check area, select the Plane option, and then click Setup.

3. Click Check clearance and connectivity.

4. Select the Same Layer Connectivity check box.

5. Click OK.

6. Click Start  in the Verify Design dialog box to run the check.

Proper same layer continuity
The two planes are connected by 
thermal spokes and on the same layer.

Error condition
Two planes with the same net exist but 
are connected by a pad and a trace on 
a different layer.

Related Topics
Verify the Design

Troubleshoot Design Verify Errors
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Setting Up Wire Bond Checking
Use the Wire Bond Checking Setup dialog box to specify which wire bond rules to check during a Wire 
Bonds verification.

Procedure
1. Click the Tools  > Verify Design  menu item.

2. In the Verify Design Dialog Box, in the Check area, select the Wire Bonds option, and then click 
Setup.

3. Select the check box beside any types of checks you want to enable and then click OK.

Unchecked rules appear in the Wire Bond Report  as “Not Set.”

Restriction:
The rule is not checked unless you select it and enter a value.

Related Topics
Wire Bond Rules Dialog Box

Verify the Design

Check the Plane Connection for Continuity
When you run a continuity check in Verify Design, the net checks are connected if no errors are found.

Run the Plane check to see whether a pad exists in the connecting pad stack for the plane level, for 
example; is the pad size more than 0 or does the drill size exceed pad size? For links to SMD pads, it 
checks whether the pad-to-via connection connects to the plane.
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Chapter 40
Dimensions

This section describes the many dimensioning methods available and defines how the dimensioning 
objects interact with the design elements. It also discusses dimension styles, snap modes and how to 
delete or modify dimensions.

Dimensioning
Dimensioning Process
Creation of Dimensions
Selecting a Dimension Measurement Style
Setting an Edge Preference
Snap Mode for Dimension Points
Selecting the Parent Dimensioning Object
Moving Dimensions and Dimension Objects
Deleting Dimensions
Resetting Dimension Measurements

Dimensioning
Dimensioning measures distances or angles on points you select, creates a text string containing the 
measured value, and creates the associated extension lines and arrows. This information is considered 
mechanical documentation for PCB designs.

The following table shows the setup options that let you match existing drafting standards and control how 
to add new dimensions.

Table  130. Dimensioning Set Up Options

Option Description

Options Establishes the appearance of newly added dimensions. For more 
information, see the Options Dialog Box, Dimensioning Category, 
General Subcategory.

Snap Mode Controls how you select data items.

Edge Preference Sets whether to measure lines from edge or centerline.

Dimensioning also lets you create Baseline dimensions for annotating multiple items from the same 
starting point. Use Continue to create daisy-chained dimensions.

Tip
You can use Dimensioning within the PCB Decal Editor. However, saving the decal converts 
dimensions to 2-D lines and text.
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Dimensioning Modes
All of the various data items, routes, parts, and drafting items in SailWind Layout are referred to as 
objects. For dimensions, the extension lines, dimension lines, arrows, and text strings that make up 
dimensions are called dimension elements. Collectively, they create a dimension object.

Tip
When selecting and modifying, the software considers dimension lines as part of the arrows.

The following lists examples of how you can combine these separate elements to indicate dimensions:

• The standard, or default, dimension is comprised of lines extending from each point of 
measurement, a dimension line with arrows at each end running between the extension lines, and 
a text string identifying the length.

• Datum line dimensions are comprised of one extension line and one text string.

• Leader line dimensions consist of a dimension line with an arrow at one end and a text string at 
the other end. This category includes radius type dimensions.

You can combine dimension elements in various ways to create a dimension object. Many of the 
modification commands use these combinations, for example:

• You can select the entire dimension object from one of its selected elements using Select Parent.

• If you open the Properties of a selected dimension element, a Parent button appears in the 
subsequent dialog box. Click the Parent  button to consider the entire dimension object for 
modifications.

Dimensioning Process
The Dimensioning Toolbar provides quick access to tools for dimensioning your design. The 
Dimensioning Toolbar is also available in the PCB Decal Editor.

Procedure
1. On the Standard Toolbar, click the Dimensioning Toolbar  button to display the Dimensioning 

Toolbar.

2. Set your preferences for dimensions on the Options dialog box > Dimensioning  category.

Give specific attention to the Layers where the dimensioning objects are added. For more 
information, see “Dimensioning Options  on page 1520.”

CAUTION:
Text and lines added to electrical layers will be fabricated in copper! Select a 
documentation layer for documentation objects.

3. Before attempting to dimension a design object, set the selection filter to the type of object for 
dimensioning.
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Dimensioning Process

For more information, see “The Selection Filter.”

4. Based on the type of object to be dimensioned, select a dimensioning button.

For more information, see “Creation of Dimensions.”

5. If you are creating multiple linear dimensions, right-click and click one of the measurement styles.

For more information, see “Selecting a Dimension Measurement Style.”

6. Based on the dimension you are creating and line widths of extension lines and objects in the 
design, you may need to select a difference edge preference. Right-click and click one of the Edge 
Preferences.

For more information, see “Setting an Edge Preference.”

7. Unless you are dimensioning a single basic object, you may need to manually identify the points to 
dimension. Right-click and click one of the Snap Modes.

For more information, see “Snap Mode for Dimension Points.”

8. Select the object to dimension and then click to place the dimension.

9. When finished dimensioning, click the Select  button to end dimensioning operations.

Tip
You can also use the View Clearance dialog box (View  > Clearance  menu item) to add 
dimensions to your design.

Related Topics
View Clearance Dialog Box
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Creation of Dimensions
You can create dimensions automatically and manually with the dimensioning tools. If a design object is in 
a selected state when a dimensioning button is clicked, one item is dimensioned. After dimensioning the 
first item, you select the next data item, and then click the button again.

Note:
Dimensioning modes are sticky, allowing you to select and dimension additional data items. To 
exit a dimensioning mode, click the Select  button on the toolbar, or click View  > Toolbars  > 
Dimensioning Toolbar  menu item to close the toolbar.

Adding Dimensions with Auto Mode
Adding Horizontal Dimensions
Adding Vertical Dimensions
Adding Aligned Dimensions
Adding Rotated Dimensions
Adding Angular Dimensions
Adding Arc or Circle Dimensions
Adding Leader Line Dimensions

Adding Dimensions with Auto Mode
Auto mode automatically establishes the orientation of newly added dimensions. If you select a line 
segment with Auto active, the system measures the length of the line segment and adds a dimension 
line parallel to the selected line. Auto is similar in functionality to Aligned mode except that Auto does not 
allow the selection of individual points. Snap mode is unavailable while you use Auto.

Auto dimensions arcs and circles in the same manner; click Auto  and select the arc or circle to 
dimension. The advantage to using Auto mode is that you can create dimensions for line segments and/or 
arcs without having to switch modes.

Procedure
1. On the Standard Toolbar, click the Dimensioning Toolbar  button, then on the Dimensioning 

Toolbar, click the Auto  button.

2. Select the line segment or arc you want to dimension.

An image of the dimension is attached to and moves with the pointer to locate the dimension line.

3. Click to indicate the location for the dimension line.

Restriction:
Snap Mode is unavailable for Auto dimensioning since this option only works with selected 
line segments.
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Adding Horizontal Dimensions

Adding Horizontal Dimensions
Horizontal mode creates dimensions with the dimension line always being in a horizontal orientation, X 
direction.

Selected line segments that exist at an angle have their base distance measured. Line segments in a 
pure vertical orientation, Y direction, cause an error message to appear. The same orientation rules apply 
for points entered through the pointer.

Procedure
1. On the Standard Toolbar, click the Dimensioning Toolbar  button, then on the Dimensioning 

Toolbar click the Horizontal  button.

2. If needed, select a Snap Mode  on page 925 and Edge Preference  on page 923 popup menu 
item.

3. Select the line segment to dimension, or indicate two points and the dimension dynamically 
attaches to the pointer.

4. Click to indicate a location for the dimension line and then you can continue to dimension 
additional data items.

Adding Vertical Dimensions
Vertical mode creates dimensions with the dimension line always being in a vertical orientation, Y 
direction.

Selected line segments that exist at an angle have their height distance measured. Line segments in a 
pure horizontal orientation, X direction, cause an error message to appear. The same orientation rules 
apply for points entered through the pointer.

Procedure
1. On the Standard Toolbar, click the Dimensioning Toolbar  button and then on the Dimensioning 

Toolbar click the Vertical  button.

2. If needed, select a Snap Mode  on page 925 and Edge Preference  on page 923 popup menu 
item.

3. Select the line segment to dimension, or indicate two points and the dimension dynamically 
attaches to the pointer.

4. Click to indicate a location for the dimension line, and then you can dimension additional data 
items.

Adding Aligned Dimensions
Aligned creates dimensions with the dimension line at the same angle as the selected line or points. 
Aligned is similar to Auto, but in addition to dimensioning selected lines, Aligned allows you to indicate 
two points that identify the measurement locations.
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Procedure
1. On the Standard Toolbar, click the Dimensioning Toolbar  button, and then on the Dimensioning 

Toolbar click the Aligned  button.

2. If needed, select a Snap Mode  on page 925 and Edge Preference  on page 923 popup menu 
item.

3. Select the line segment to dimension, or indicate two points and the dimension dynamically 
attaches to the pointer.

4. Click to indicate a location for the dimension line and then you can dimension additional data 
items.

Adding Rotated Dimensions
Rotated mode creates dimensions similar to Aligned mode, but offers the additional flexibility of rotating 
the entire dimension object by a specified number of degrees. This feature is convenient when several 
dimensions exist in one location, because it allows you to offset some dimensions for easy viewing.

When dimensioning in Rotated mode, the system displays a prompt window specifying the current angle, 
with zero being in the positive Y axis (toward the top of the work area). You can type a different value to 
rotate and offset the entire dimension object. Positive values rotate counterclockwise; negative values 
rotate clockwise.

Procedure
1. On the Standard Toolbar, click the Dimensioning Toolbar  button, and then on the Dimensioning 

Toolbar click the Rotated  button.

2. If needed, select a Snap Mode  on page 925 and Edge Preference  on page 923 popup menu 
item.

3. Select the line segment to dimension, or indicate two points.

4. Type the rotation value you want to use and click OK  and the dimension dynamically attaches to 
the pointer.

5. Click to indicate a location for the dimension line and then you can dimension additional data 
items.

Adding Angular Dimensions
Angle mode measures and dimensions an angle in degrees. You can specify this angle by two line 
segments, a line segment and two points, or four points.

These settings are controlled by the available Snap modes  on page 925.

Procedure
1. On the Standard Toolbar, click the Dimensioning Toolbar  button, and then on the Dimensioning 

Toolbar click the Angular  button.

2. If needed, right-click and click a Snap Mode  on page 925 popup menu item.
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Adding Arc or Circle Dimensions

3. Select the lines to dimension, or indicate two points to define the angle and the angular dimension 
dynamically attaches to the pointer.

4. Click to indicate a location for the dimension line, and then you can dimension additional data 
items.

Adding Arc or Circle Dimensions
Arc creates dimensions that measure and document the size of arcs or circles, with the calculation being 
the radius or the diameter.

Procedure
1. On the Standard Toolbar, click the Dimensioning Toolbar  button, and then on the Dimensioning 

Toolbar click the Arc  button.

2. If needed, right-click and click an Edge Preference  on page 923 popup menu item.

3. Select the arc or circle to dimension and the radial dimension dynamically attaches to the pointer.

4. Click to indicate a location for the dimension line, and then you can dimension additional data 
items.

Tip
Arc mode works best when you select the “Manual position” check box in the Displacement 
area of the Options dialog box > Dimensioning category > Text subcategory  on page 1522. 
This lets you create a leader line effect for documented arcs and circles.

Adding Leader Line Dimensions
Leader creates a standard pointer to the selected information or point. It is simply a line with an arrow at 
one end and a user-specified text string at the other.

Procedure
1. On the Standard Toolbar, click the Dimensioning Toolbar  button, and then on the Dimensioning 

Toolbar click the Leader  button.

2. Right-click and click a Snap Mode  on page 925 popup menu item if you are creating the leader 
from a specific point, such as the midpoint of the selected line.

3. Select the line to dimension, or click to indicate a point for the arrow and a line with an orthogonal 
corner dynamically attaches to the pointer.

4. Click to add a vertex and anchor the leader line, and then double-click to complete the leader line.

5. Type a text string for the leader line and click OK.

Related Topics
Dimensioning Process

SailWind Layout Guide and Reference 921



Dimensions
Selecting a Dimension Measurement Style  

Selecting a Dimension Measurement Style
Dimensions can be created using a chained or baseline style. This section provides detailed descriptions 
of each method.

Creating Chained Dimensions
Creating Baseline Dimensions
Setting an Existing Extension Line as the Baseline

Creating Chained Dimensions
Continue type dimensioning creates dimensions in a daisy-chained fashion. With Continue on, the last 
entered point becomes the new first point of subsequent dimensions.

Procedure
1. On the Standard Toolbar, click the Dimensioning Toolbar  button to display the Dimensioning 

Toolbar.

2. Click the appropriate dimensioning button on the Dimensioning Toolbar, such as Horizontal, 
Vertical, or Aligned.

3. Right-click and click the Continue  popup menu item and a check mark appears next to Continue, 
indicating that it is active.

4. Click to indicate the location of the first dimension point and the prompt “Continue. Enter second 
point” appears.

5. Click to indicate the location of the next dimension point.

6. Move the pointer to position the dimension line and click to indicate the first dimension object.

7. Repeat steps 4 and 5 for all points.

8. To end dimensioning, right-click and click Continue again and the check mark next to Continue is 
removed.

Creating Baseline Dimensions
Baseline dimensioning defines several measurements from the same starting point.

Procedure
1. On the Standard Toolbar, click the Dimensioning Toolbar  button to display the Dimensioning 

Toolbar.

2. Click the appropriate dimensioning button on the Dimensioning Toolbar, such as Horizontal, 
Vertical, or Aligned.

3. Right-click and click the Baseline  popup menu item. A check mark appears next to Baseline, 
indicating that it is active.
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Setting an Existing Extension Line as the Baseline

4. Click to indicate the location of the baseline dimension point. The prompt “Baseline. Enter second 
point” appears on the Status Bar.

5. Click to indicate the location of the next dimension point.

6. Move the pointer to position the dimension line and click to indicate the first dimension object.

7. Repeat steps 4 and 5 for all points.

8. To end dimensioning, right-click and click the Baseline  popup menu item again. The check mark 
next to Baseline is removed.

Related Topics
Setting an Existing Extension Line as the Baseline

Setting an Existing Extension Line as the Baseline
You can set an existing extension line as the new baseline.

Procedure
1. On the Standard Toolbar, click the Dimensioning Toolbar  button, and then on the Dimensioning 

Toolbar, click the Select  button.

2. Select the extension line to act as the new baseline.

3. Right-click and click the Baseline  popup menu item and a check mark appears next to Baseline, 
indicating that it is active.

4. Click a dimension button on the Dimensioning Toolbar that matches the selected extension line 
orientation.

5. Click to indicate the location of the next dimension point.

6. Move the pointer to position the dimension line and click to indicate the first dimension object.

7. Repeat steps 4 and 5 for all points.

8. To end dimensioning, right-click and click the Baseline  popup menu item again and the check 
mark next to Baseline is removed.

Related Topics
Creating Baseline Dimensions

Dimensioning Process

Options Dialog Box, Dimensioning Category, Alignment and Arrows Subcategory

Setting an Edge Preference
The Edge Preference enables you to measure and dimension objects from the center of the drawn line 
or from either line edge. The default measures all lines from their physical centerline, regardless of the 
drawn line width. While this would be necessary for a part to part dimension, a dimension that documents 
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the design rule spacing between two adjacent routes would need the edge preference set to Use Inner 
Edge.

Procedure
1. On the Standard Toolbar, click the Dimensioning Toolbar  button, and on the Dimensioning 

Toolbar, click a dimensioning style button.

2. Right-click and click an Edge Preference popup menu item described in the table below.
Table  131. Edge Preference Choices

Edge Preference Description

Use Centerline Measures from the center of the object.

Use Inner Edge Measures from the edge closest to the other point.

Use Outer Edge Measures from the edge furthest from the other point.

This mode remains in effect until you select another. Also use the shortcut menu to set the snap 
mode  on page 925.

Tip
Line length measurements are also affected by the edge preference option. To ensure 
accuracy of standard dimensioning tasks, reset this option to Use Centerline, after using 
one of the alternate settings.

A check mark appears next to the selected popup menu item to indicate that it is in use.

Related Topics
Dimensioning Process

Dimensioning
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Snap Mode for Dimension Points

Snap Mode for Dimension Points
A Snap mode lets you precisely identify points to dimension from by forcing the pointer to snap to a 
specified part of an object, such as the corner or center.

Using a Snap Mode
Adjusting Snap While Dimensioning

Using a Snap Mode
The system defaults to auto-snap mode. In this mode, both endpoints of a selected line segment or an 
entire arc are selected to identify the dimension points. You can select a more manual snap mode.

Procedure
1. On the Standard Toolbar, click the Dimensioning Toolbar  button, and on the Dimensioning 

Toolbar, click a dimensioning style button.

2. To disable auto-snap, right-click and click one of the snap mode popup menu items and a check 
mark appears next to the selected mode.

This mode remains active until you select another one, or until you exit SailWind Layout.

3. To re-enable auto-snap, right-click and click the snap mode popup menu item to remove the check 
mark from the currently-selected mode.

Restriction:
Snap modes are unavailable for Auto and Arc type dimensioning styles. These styles only 
support the auto-snap mode because they apply to selected line segments and arcs, not 
selected points.

Adjusting Snap While Dimensioning
You can adjust snap mode while selecting dimensioning points. This capability can be important when 
dimensioning angles.

Procedure
1. On the Standard Toolbar, click the Dimensioning Toolbar  button, and on the Dimensioning 

Toolbar, click a dimensioning style button.

2. If needed, right-click and click a snap mode popup menu item.

The following table lists the snap modes and their descriptions.
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Table  132. Snap Modes

Snap to: Description

Corner Snaps to the endpoints of a line segment or arc. A corner is where a design 
object changes direction.

Midpoint Snaps to the center point of a line segment or arc. Circles are selected at the 
180-degree point, left side, since arcs are drawn with the starting point on 
the right.

Any Point Snaps to the closest point on a line segment, arc, or circle.

Center Snaps to the center of the closest circle, arc, or pad.

Circle/Arc Snaps to the radius point of an arc or circle.

Intersection Snaps to closest point where two or more objects intersect.

Quadrant Snaps to the closest orthogonal point, 0, 90, 180, or 270 degrees, on an arc 
or circle. Arcs must pass through an orthogonal point to be selected.

Do Not Snap Snaps to any grid point.

Restriction:
Snap mode is unavailable for Auto and Arc type dimensioning styles. These styles support 
the auto-snap mode only because they apply to selected line segments and arcs, not 
selected points.

3. Select the first dimensioning point.

4. If needed, right-click and click another snap mode and then select the second dimensioning point.

5. If you selected the Angular dimensioning style, repeat steps 4-5 as needed to select the other side 
of the angle.

Related Topics
Dimensioning Process

Selecting the Parent Dimensioning Object
You can select the parent dimension object from a selected dimension element.

Procedure
1. Select one of the items in the dimension object.

2. Right-click and click the Select Parent  popup menu item. The entire dimension is selected.

Related Topics
Dimensioning

926 SailWind Layout Guide and Reference



 
Dimensions

Moving Dimensions and Dimension Objects

Moving Dimensions and Dimension Objects
You can move Dimensions or Dimension Objects using the Move command or by dynamically dragging 
objects.

Moving an Entire Dimension
Moving a Dimension Object
Moving Text to Its Default Location
Dynamically Drag Objects
Changing Lengths

Moving an Entire Dimension
When required, you can move an entire dimension. This is useful when you need to create additional 
space for another dimension or callout.

Procedure
1. Select the dimension object through multiple selection, or by using the Select Parent  on page 926

button in the Properties dialog box.

Note:
To move dimension objects using keyboard entered coordinates, use the Dimension Object 
Properties dialog box  on page 1311.

2. Right-click and click the Move  popup menu item and the dimension object dynamically attaches to 
the pointer.

3. Click to indicate a location for the object.

The dimension object remains selected for additional moving, if required.

Moving a Dimension Object
You can move individual dimension objects, including: arrows (with their lines), text strings, extension 
lines, and leader segments.

Procedure
1. Select a dimension object.

2. Right-click and click the Move  popup menu item.

3. Click to indicate the new location for the dimension object.
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The new position of the text and the location of the arrows are determined by the current settings in 
the Options dialog box > Dimensioning  categories.

Tip
If you select and move an extension line, the dimension line and the dimension text are 
both automatically modified to reflect the new measurement. Stretching the extension line 
without changing the measurement is performed with the Change Length  on page 927
command. This command works in the same manner as moving arrows, but works with 
selected extension lines.

Moving Text to Its Default Location
If you have repositioned a text object, you can move the text to its default location.

Procedure
1. Click the dimensioning text to select it.

If you cannot select the text, check the selection filter settings.

2. Right-click and click the Default Location  popup menu item.

Tip
To add a new segment to an existing leader, right-click and click the Add Corner  and Split 
popup menu items.

Dynamically Drag Objects
Objects can be dynamically dragged to reposition them. This allows you to quickly and intuitively 
reposition objects.

Prerequisites
You must set the “Drag moves” setting to “Drag and drop” in Tools  > Options  menu item, Global 
category > General  subcatory.

Procedure
1. Select an object.

2. Place the pointer over the selected object, then click and hold the left mouse button to initiate Drag 
mode.

3. Move the mouse to the new location for the object and release the left mouse button.

Changing Lengths
With an extension line selected, the Change Length command adjusts the position of the dimension line 
and arrows without changing the actual measurement. When used, the dimension object is attached to, 
and moves along with, the pointer, such as when a new dimension is created.
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Deleting Dimensions

Procedure
1. Select the extension line for which you want to change the length.

2. Right-click and click the Change Length  popup menu item and the dimension object dynamically 
attaches to the pointer.

3. Click to indicate the new location for the dimension.

Related Topics
Dimensioning Process

Resetting Dimension Measurements

Selecting the Parent Dimensioning Object

Deleting Dimensions
When they are no longer needed, you can delete a dimension element.

Procedure
1. Select the dimension element to delete using one of the following methods:

• Select one of the dimension's elements and right-click and click the “Select Parent”  on 
page 926 popup menu item.

• Use multiple selection  on page 115 to sequentially select each element belonging to the 
dimension.

• Select the entire dimension with a selection rectangle.

2. Press the Delete key.

Resetting Dimension Measurements
If you need to edit a dimension, you can reset the measurement text.

Procedure
1. Click the dimensioning text to select it.

If you cannot select the text, check the selection filter settings.

2. Right-click and click the Reset Measurement  popup menu item.

3. Type the new measurement in the Text Value dialog box and click OK.

SailWind Layout Guide and Reference 929



Dimensions
Resetting Dimension Measurements  

930 SailWind Layout Guide and Reference



 

 

 

Chapter 41
CAM Output

The following topics describe setup, preview and output for a printer, plotter, photoplotter, NC drill device 
and output files that are compatible with a variety of automatic assembly and pick-and-place machines.

You use the CAM command on the File menu to produce laser copy, plots, Gerber files, drill drawings, 
and other manufacturing outputs.

CAM Documents
Associated Copper and CAM
RS-274-X Format
Creating CAM Outputs to Manufacture Your PCB
CAM Output Creation
Creating Reusable Fabrication Notes
Reporting Apertures of a Photo-Plot File(s)
TrueLayer Associations
Colors in CAM Documents
Applying the Over(Under)size Value to All Layers
Drill Drawing Options
Assembly Variants
CAM Preview
Printing
DFM Analysis of CAM Documents
CAM Plus Assembly Machine Interface
CAM350

CAM Documents
CAM is an acronym for Computer-Aided Manufacturing. Using the CAM tools, you can produce not only 
Gerber-formatted photoplot or manufacturing outputs, but printouts and plots as well.

A plot type, drill, silkscreen, or routing, together with an associated output device setup is called a CAM 
document.

There is no default set of output configurations when you start a new design - the Define CAM Documents 
dialog box is empty. Different types of designs require unique sets of output files. A design with 14 layers 
requires a larger set of output files than a design with only 2 layers. You must define your own list of 
output-document configurations which you require for each design. Your configurations can be saved 
within the .pcb  file, so each file has its own CAM Documents list. You can export and then import your 
document configurations to reuse with a similar design.

When you add a CAM document, you are adding a preset output configuration, like a script, which you 
run against your design to create the type of output document required. The preset (CAM document) 
contains the Document Type, visible objects, design positioning, and output device.

When you have a list of document configurations in the Define CAM Documents dialog box, you can 
quickly run the configurations against your current design and create the outputs, whether they are 
printouts or photo plots or both. You can print documents singly or in batch mode.
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You can use Import and Export to move a CAM documents list, including the aperture list and drill feed 
and speed table, between .pcb  files.

Note:
You can create a maximum of 250 CAM Document configurations.

Associated Copper and CAM
CAM interprets pads and other objects differently when they are associated with copper in the PCB Decal 
Editor.

For more information, see Associating Copper with Terminals. Associating copper shapes and open 
copper is one way to create hard breakouts in decals.

• Terminals are interpreted as vias.

• Closed copper shapes are interpreted as pads.

• Open copper (a path drawn with copper) is interpreted as a trace.

RS-274-X Format
The RS-274-X format is based on the Gerber Format Guide (Document Number: 0000-00-RM-000, Part 
Number: 414-100-002) by Gerber Systems Corporation. RS-274-X in SailWind Layout is a data format 
created in CAM for photoplotters.

Clicking the RS-274-X output format from the Photo Plotter Advanced Setup Dialog Box  creates a Gerber 
file with the information shown in Table 133.

Table  133. RS-274-X Fields

Field Description

AM Aperture macro

AD Aperture description

FS Format statement

MO Units mode

IN Image name

LN Layer name

LP Layer polarity

G36,G37 Fill area controls

932 SailWind Layout Guide and Reference



 
CAM Output

RS-274-X Format

These features are allowed for the 9500, 9800, 9900, GPC, and Insight/2020 photoplotters that also 
support the G74, G75 multiquadrant circular interpolation function codes. Some of these parameters 
appear in the Gerber file depending on photo plotter settings; however, the parameters in Table 134  are 
always present in the Gerber file.

Table  134. Gerber File Fields

Field Description

The name of the design %IN job name *% where job name is the name of the design.

The mode parameter Indicates the units, for example, %MOIN*% or %MOMM*%.

A format statement parameter Describes the format options selected in the Photo Plotter 
Advanced Setup Dialog Box, for example %FSLAX45Y45*%.

Aperture Table
All simple apertures; such as round, oval, or rectangular; are described in the output Gerber file as a 
%ADDxx*% parameter. The Photoplotter Aperture Report file is also created.

Aperture Macro
Copper areas associated with pins are output as unique aperture flashes.

Aperture support is as follows:

• Line-shaped polygonal copper with 50 vertexes or less and circular copper are supported.

• Line-shaped polygonal solid copper with 50 vertexes or less and circular solid copper are 
supported.

• Arc-shaped copper outlines are aperture macros in Gerber using polygonal approximation with up 
to 50 vertices. The %AM*% parameter limits the number of vertices to 50.

• Thermal reliefs for CAM planes are output as macro flash.

SailWind Layout does not support copper cutouts for coppers associated with component pins.

SailWind Layout does not support hatched coppers associated with component pins. All associated 
coppers appear and output in CAM as solid, regardless of the grid spacing and line width.

Fill Area
Solid, not hatched, copper and copper planes are output in fill area mode (G36,G37 brackets). Hatched 
areas are output in vector format. Circular copper areas, arc-shaped polygons, and circular and polygonal 
copper cutouts are all supported.

Verify Photoplots
Verify Photoplots Document Type supports the macros, aperture selection, and fill area commands of 
SailWind Layout Gerber outputs. Verify Photoplots can only process RS-274-X Gerber files created by 
SailWind Layout.
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Creating CAM Outputs to Manufacture Your 
PCB
There are typical gerber files, drill files, assembly coordinate files, and drawings you need to manufacture 
your PCB. Check with your manufacturer for a specific list of requirements.

Procedure
1. Generate the outputs for the top layer:

a. Create the Conductive Elements gerber-format file for the photo plotter. Choose between the 
following layer types:

• Routing/Split Plane (gerber-format file)  on page 948

• CAM Plane (gerber-format file)  on page 951

b. Create the Silkscreen gerber-format file for the photo plotter (gerber-format file)  on page 938

c. Create the Solder mask gerber-format file for the photo plotter (gerber-format file)  on 
page 941

d. Create the Paste mask gerber-format file for the photo plotter (gerber-format file)  on 
page 943

e. Create the Assembly Drawing (non-gerber)  on page 946

2. Generate the photo plotter Conductive Elements gerber-format file outputs for each internal layer. 
Choose between the following layer types:

• Routing/Split Plane (gerber-format file)  on page 948

• CAM Plane (gerber-format file)  on page 951

3. Generate the outputs for the bottom layer:

a. Create the Conductive Elements gerber-format file for the photo plotter. Choose between the 
following layer types:

• Routing/Split Plane (gerber-format file)  on page 948

• CAM Plane (gerber-format file)  on page 951

b. Create the Silkscreen gerber-format file for the photo plotter (gerber-format file)  on page 938

c. Create the Solder mask gerber-format file for a photo plotter (gerber-format file)  on page 941

d. Create the Paste mask gerber-format file for a photo plotter (gerber-format file)  on page 943

e. Create the Assembly Drawing (non-gerber)  on page 946

4. Generate the outputs for each drill pair:
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Creating CAM Outputs to Manufacture Your PCB

a. Create the Drill Drawing with Drill Table (non-gerber)  on page 954

b. Create the NC Drill file for the drilling machine (drill file)  on page 953

Related Topics
Verifying a Gerber File
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CAM Output Creation
The following output types can be created.

Creating a Custom CAM Output
Creating a Set of CAM Documents Using Auto Define
Creating a Silkscreen Gerber-format File
Creating a Solder Mask Gerber-format File
Creating a Paste Mask Gerber-format File
Creating an Assembly Drawing
Creating a Routing/Split Plane Gerber-format File
Creating a CAM Plane Gerber-format File
Creating an NC Drill File
Creating a Drill Drawing with Drill Table
Verifying a Gerber File
Creating All Outputs

Creating a Custom CAM Output
You can create a custom CAM output. This setting has no presets. You start with no default assigned 
layers or objects and choose which items to include in the output.

Tip
If you use the TrueLayer option, see “TrueLayer Associations” for information on how TrueLayer 
affects layers and CAM documents.

Procedure
1. Click the File  > CAM  menu item.

2. In the Define CAM Documents Dialog Box, click Add.

3. In the Add Document dialog box  on page 1044, type a Document Name.

It is beneficial to add a description of your custom output in the document name. Type a document 
name that describes the plot type and output device; for example, Silkscreen Top Layer - to Print. If 
you were outputting this document to a file, this is not the filename to which it would be saved; you 
define that in the Output File box in a later step.

4. In the Document Type list, click Custom.

When you select a specific document type, the program automatically generates a pre-configured 
set of layers and items to plot. You can use these or customize them. You can view a summary 
of the settings of the default document type in the Summary box. If during your selection of a 
Document Type you are prompted to select a Layer Association and the layer does not exist in the 
list, you may need to revisit your Layers Setup. Click Set Layers for a shortcut to the Layers Setup 
Dialog Box; otherwise you would need to close all CAM dialog boxes to access the Setup menu.

5. In the Output File box, type a name for the file you are creating.
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Creating a Set of CAM Documents Using Auto Define

An autogenerated name appears in the Output File box. This is the name of the file you might send 
to the manufacturer. Your manufacturer will find it helpful if this filename is related to its function 
and placement in the layer stackup.

6. In the Customize Document area, click the Layers  button.

7. In the Select Items Dialog Box, choose which layers and layer items should appear in your output 
and then click the Preview button to check what will be included in the output.

8. Click OK  to accept the changes and close the Select Items dialog box.

9. In the Customize Document area, click Options.

10. In the Plot Options Dialog Box, in the Positioning area, set the positioning options.

11. Click OK  to close the Plot Options dialog box.

12. In the Output Device area, choose the device and update the Device Setup as needed.

13. Click OK  to add the new file configuration to the Define CAM Documents Dialog Box.

Tip
While you can click Run  and create the output file from the Add Document dialog box, you 
probably want to add this configuration to the Define CAM Documents dialog box in case 
you need to generate the file again.

14. In the CAM Directory list, choose the folder where you want to save the output files.

You can skip this step if you are sending it to your printer.

15. Select the document(s) you want to output in the Document name list, and then click Run.

16. Click Save.

If you close the .pcb design without saving the design, you will lose any additions to the Define 
CAM Documents dialog box.

Results
Your file(s) appear in the C:\SailWind Projects\Cam  directory (or a subdirectory if you created one) if you 
are not sending the output to your printer.

Creating a Set of CAM Documents Using Auto 
Define
You can quickly generate a set of CAM documents for your design using Auto Define. This feature uses a 
predefined group of default parameters to generate a “starter” set of CAM documents that you can further 
refine to meet your specific design requirements.

After using Auto Define to create your baseline CAM documents, you can edit each individual CAM 
document configuration to change the filename and modify the design object selections to meet 
your manufacturing output requirements. After the edits are complete, you can save and export the 
configurations for use in other designs.
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Restrictions and Limitations

• Auto Define only creates photoplot (.pho) files. You must manually create any additional types of 
CAM documents required by your design flow for printing or pen plotting.

• Auto Define uses a generic naming convention to identify each of the different CAM document 
file types (solder mask, paste mask, routing/plane layers, assembly drawing, drill file, and others). 
You can rename the files to reflect your specific naming preferences or corporate standards.

• Auto Define analyzes the design and creates separate drill files for plated-through holes, non-
plated holes, and individual partial via drill pairs (if present in the design).

• Auto Define attempts to create a complete set of CAM documents based upon your specific 
design setup. It does not overwrite any existing CAM document configurations that you may have 
already created for the design. Auto Define detects and preserves any existing CAM document 
configurations and only appends the remaining missing files to the design.

• You cannot modify the default parameters used to auto-generate the CAM Document 
configurations; however, once created, you can edit and save your modified CAM document 
configurations, export them, and use them in other designs.

Procedure
1. Click the File  > CAM  menu item.

2. In the Define CAM Documents dialog box, click the Auto Define  button.

Results
The newly created CAM document configurations will appear in the CAM Documents area.

Note:
Auto Define always attempts to generate a full set of CAM document configurations based 
upon your specific design setup. If you want to use Auto Define to create a subset of the CAM 
document configurations, run Auto Define to create the full set of CAM document configurations 
and then manually delete any unwanted CAM document configurations.

Creating a Silkscreen Gerber-format File
You create the silkscreen gerber-format file for your manufacturer’s photo plotter to produce the 
silkscreen top or silkscreen bottom layer.

Procedure
1. Click the File  > CAM  menu item.

2. In the Define CAM Documents Dialog Box, click Add.

3. In the Add Document dialog box  on page 1044, type a Document Name such as Silkscreen Top, 
or Silkscreen Bottom.
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4. In the Document Type list, click Silkscreen and in the Layer Association Dialog Box  that appears, 
choose from the Top or Bottom side of the board.

Tip
The layers may not be named Top or Bottom, but will have the names you chose for the 
top and bottom layer of your design in the Layers Setup Dialog Box.

5. In the Output File box, type a name for the file you are creating.

Tip
An autogenerated name appears in the Output File box. This is the name of the file you will 
send to the manufacturer. Your manufacturer will find it helpful if this filename is related to 
its function. Name the file silkscreen_top.pho  or silkscreen_bottom.pho.

6. In the Customize Document area, click the Layers  button.

7. In the Select Items Dialog Box, choose which layers and layer items should appear in the 
silkscreen data:

• If all your silkscreen elements have been added to the Silkscreen layer, you can remove other 
layers in the Selected list.

• In a typical silkscreen, you want the Component outlines of the layer you are working on (Top 
Mounted or Bottom Mounted), as well as Ref. Des., and Outlines.

• For large components, it is common to add attributes that add dots at pin 1 and numbers 
around the component to lessen the time it takes to locate a pin during testing or 
troubleshooting. If you have added such attributes on the Silkscreen layer, you should choose 
to display the Attributes from the Silkscreen layer.

• Click the Preview button to check what will be included in the output.

8. Click OK  to accept the changes and close the Select Items dialog box.

9. In the Customize Document area, click Options.

10. In the Plot Options Dialog Box, in the Positioning area, set the positioning options.

Tip
It is important that each gerber-format file that you output for your design line up exactly 
with the others. You must use the same Positioning settings for each layer and you must 
ensure that objects on one layer are not offsetting the layer from the Justification setting. 
For example, you have chosen to justify the layers by the Top Left, and you have decided 
to include the board outline in all your outputs. The board outline will be justified at the top 
left of each output, but if you have a component that extends outside the board outline on 
the left side of the board, it is possible that your silkscreen layer will not be aligned to the 
other layers you have created, since the alignment is to the component outline on the left 
(and the board outline at the top).

11. In the Suppress area, you can suppress the display of some Reference Designators.
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Tip
For example, if you have a set of mounting holes that use the Ref Des prefix X, you can 
choose not to include those reference designators in the silkscreen.

12. Click OK  to close the Plot Options dialog box.

13. In the Output Device area, click the Photo  button if not already selected.

14. Click Device Setup  and in the Photo Plotter Setup Dialog Box, make any necessary changes to 
the settings.

15. Click the Advanced  button and in the Photo Plotter Advanced Setup Dialog Box, make any 
necessary changes to the settings.

Tip
You may want to use the RS-274X format.

16. Click OK  to close the Photo Plotter Advanced Setup dialog box.

17. Click OK  to close the Photo Plotter Setup dialog box.

18. Click OK  to add the new file configuration to the Define CAM Documents Dialog Box.

Tip
While you can click Run  and create the output file from the Add Document dialog box, you 
probably want to add this configuration to the Define CAM Documents dialog box in case 
you need to generate the file again.

19. Repeat these steps again to create the Silkscreen output for the opposite side of the board (if 
applicable).

20. In the CAM Directory list, choose the folder where you want to save the output files.

21. Select the document(s) you want to output in the Document name list, and then click Run.

22. Click Save.

Tip
If you close the design without saving the design, you will lose any additions to the Define 
CAM Documents dialog box.

Results
Your file(s) appear in the C:\SailWind Projects\Cam  directory or a subdirectory if you created one.

When looking at the Silkscreen preview, the black lines represent the silkscreen artwork. You should 
typically see component outlines of the layer you are working on (Top Mounted or Bottom Mounted), 
any board identification or version text, company logo, as well as Reference Designators outside the 
component outlines renumbered (from the original netlist import) into an easily search-able pattern.
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You can use two sets of reference designators, one set on the silkscreen layers for the silkscreen artwork 
positioned outside the components where they will not be hidden after the component are placed and 
soldered onto the board, and the other set on the assembly drawing layers centered on components for 
the assembly drawing. If you have not built this second assembly drawing set of reference designators 
into your library decals, you can quickly add them to your design. For more information, see “Generating a 
Second Set of Reference Designators for Assembly Drawings”.

Related Topics
Creating CAM Outputs to Manufacture Your PCB

Changing the Reference Designators of Multiple Components in ECO Mode (Autorenumbering)

Creating a Set of CAM Documents Using Auto Define

Creating a Solder Mask Gerber-format File
You create the solder mask gerber-format file for your manufacturer’s photo plotter to produce the solder 
mask top, or solder mask bottom layer.

Note:
Virtual pins in the design are output as vias.

Procedure
1. Click the File  > CAM  menu item.

2. In the Define CAM Documents Dialog Box, click Add.

3. In the Add Document dialog box  on page 1044, type a Document Name such as Solder Mask Top, 
or Solder Mask Bottom

4. In the Document Type list, click Solder Mask and in the Layer Association Dialog Box  that appears, 
choose from the Top or Bottom side of the board.

Tip
The layers may not be named Top or Bottom, but will have the names you chose for the 
top and bottom layer of your design in theLayers Setup Dialog Box.

5. In the Output File box, type a name for the file you are creating.

Tip
An auto-generated name appears in the Output File box. This is the name of the file you 
will send to the manufacturer. Your manufacturer will find it helpful if this filename is related 
to its function. Name the file soldermask_top.pho  or soldermask_bottom.pho.

6. In the Customize Document area, click the Layers  button.

7. In the Select Items Dialog Box, choose which layers and layer items should appear in the solder 
mask data:

SailWind Layout Guide and Reference 941



CAM Output
Creating a Solder Mask Gerber-format File  

• You need solder mask openings for each pad of each component and (optionally) each via.

• If you have added these openings in the pad stacks, and all your solder mask elements 
have been added to the Solder Mask layer, you can remove other layers in the Selected list.

• If you have not added these openings in the pad stacks, there is an easy way to get the 
openings that you need without editing all the pad stacks. You can add the top layer to the 
Selected list and select the Pads check box for that layer. This adds openings the exact size 
of the pads in the solder mask. You will only need to oversize the Pads in the Plot Options.

• Click the Preview button to check what will be included in the output. When looking at the 
preview, the white area will be the solder mask. Black areas are openings in the solder mask.

8. Click OK  to accept the changes and close the Select Items dialog box.

9. In the Customize Document area, click Options.

10. In the Plot Options Dialog Box, in the Positioning area, set the positioning options.

Tip
It is important that each gerber-format file that you output for your design line up exactly 
with the others. You must use the same Positioning settings for each layer and you must 
ensure that objects on one layer are not offsetting the layer from the Justification setting. 
For example, you have chosen to justify the layers by the Top Left, and you have decided 
to include the board outline in all your outputs. The board outline will be justified at the top 
left of each output, but if you have a component that extends outside the board outline on 
the left side of the board, it is possible that your silkscreen layer will not be aligned to the 
other layers you have created, since the alignment is to the component outline on the left 
(and the board outline at the top).

11. In the Over(Under)size Pads By box, type a value if you need to globally modify the pad size 
openings.

Tip
If you are using the pad shapes of an outer layer to create the solder mask openings of the 
solder mask layer, you will probably want to add a global oversize here.

12. Click OK  to close the Plot Options dialog box.

13. In the Output Device area, click the Photo  button if not already selected.

14. Click Device Setup. In the Photo Plotter Setup Dialog Box, make any necessary changes to the 
settings.

15. Click the Advanced  button. In the Photo Plotter Advanced Setup Dialog Box, make any necessary 
changes to the settings.

Tip
You may want to use the RS-274X format.

16. Click OK  to close the Photo Plotter Advanced Setup dialog box.
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17. Click OK  to close the Photo Plotter Setup dialog box.

18. Click OK  to add the new file configuration to the Define CAM Documents Dialog Box.

Tip
While you can click Run  and create the output file from the Add Document dialog box, you 
probably want to add this configuration to the Define CAM Documents dialog box in case 
you need to generate the file again.

19. Repeat these steps again to create the Solder Mask output for the opposite side of the board (if 
applicable).

20. In the CAM Directory list, choose the folder where you want to save the output files.

21. Select the document(s) you want to output in the Document name list, and then click Run.

22. Click Save.

Tip
If you close the design without saving the design, you will lose any additions to the Define 
CAM Documents dialog box.

Results
Your file(s) appear in the C:\SailWind Projects\Cam  directory or a subdirectory if you created one.

When looking at the Solder Mask preview, the white area will be the solder mask. Black areas are 
openings in the solder mask. You should typically see solder mask openings for each pad of each 
component and any vias that are not tented (masked).

Related Topics
Creating CAM Outputs to Manufacture Your PCB

Control of Solder Mask and Paste Mask

Creating a Set of CAM Documents Using Auto Define

Creating a Paste Mask Gerber-format File
You create the paste mask gerber-format file for your manufacturer’s photo plotter to produce the paste 
mask top, or paste mask bottom layer.

Procedure
1. Click the File  > CAM  menu item.

2. In the Define CAM Documents Dialog Box, click Add.

3. In the Add Document dialog box  on page 1044, type a Document Name such as Paste Mask Top, 
or Paste Mask Bottom
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4. In the Document Type list, click Paste Mask and in the Layer Association Dialog Box  that appears, 
choose from the Top or Bottom side of the board.

Tip
The layers may not be named Top or Bottom, but will have the names you chose for the 
top and bottom layer of your design in theLayers Setup Dialog Box.

5. In the Output File box, type a name for the file you are creating.

Tip
An auto-generated name appears in the Output File box. This is the name of the file you 
will send to the manufacturer. Your manufacturer will find it helpful if this filename is related 
to its function. Name the file pastemask_top.pho or pastemask_bottom.pho.

6. In the Customize Document area, click the Layers  button.

7. In the Select Items Dialog Box, choose which layers and layer items should appear in the paste 
mask data:

• You need paste mask openings for each pad of each surface mount component.

• If you have added these openings in the pad stacks, and all your paste mask elements 
have been added to the Paste Mask layer, you can remove other layers in the Selected list.

• If you have not added these openings in the pad stacks, there is an easy way to get the 
openings that you need without editing all the pad stacks. You can add the top layer to the 
Selected list and select the Pads check box for that layer. This adds openings the exact 
size of the pads in the paste mask. You can oversize or undersize the Pads (paste mask 
openings) in the Plot Options.

• If all your paste mask elements have been added to the Paste Mask Top layer, you can remove 
other layers in the Selected list.

• Click the Preview button to check what will be included in the output. When looking at the 
preview, the black areas are the paste mask openings which become the solder paste locations 
on the board.

8. Click OK  to accept the changes and close the Select Items dialog box.

9. In the Customize Document area, click Options.

10. In the Plot Options Dialog Box, in the Positioning area, set the positioning options.
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Tip
It is important that each gerber-format file that you output for your design line up exactly 
with the others. You must use the same Positioning settings for each layer and you must 
ensure that objects on one layer are not offsetting the layer from the Justification setting. 
For example, you have chosen to justify the layers by the Top Left, and you have decided 
to include the board outline in all your outputs. The board outline will be justified at the top 
left of each output, but if you have a component that extends outside the board outline on 
the left side of the board, it s possible that your silkscreen layer will not be aligned to the 
other layers you have created, since the alignment is to the component outline on the left 
(and the board outline at the top).

11. In the Suppress area, you can suppress the paste mask openings for components.

Tip
For example, if you have an edge connector, you do not want to add paste mask openings 
over its pads. If you are using the pad shapes of an outer layer to create the paste mask 
openings of the paste mask layer, you will want to add the reference designator of the edge 
connector to the Suppress box to prevent it from getting solder paste in the manufacturing 
process.

12. In the Over(Under)size Pads By box, type a value if you need to globally modify the pad size 
openings.

13. Click OK  to close the Plot Options dialog box.

14. In the Output Device area, click the Photo  button if not already selected.

15. Click Device Setup  and in the Photo Plotter Setup Dialog Box, make any necessary changes to 
the settings.

16. Click the Advanced  button and in the Photo Plotter Advanced Setup Dialog Box, make any 
necessary changes to the settings.

Tip
You may want to use the RS-274X format.

17. Click OK  to close the Photo Plotter Advanced Setup dialog box.

18. Click OK  to close the Photo Plotter Setup dialog box.

19. Click OK  to add the new file configuration to the Define CAM Documents Dialog Box.

Tip
While you can click Run  and create the output file from the Add Document dialog box, you 
probably want to add this configuration to the Define CAM Documents dialog box in case 
you need to generate the file again.

20. Repeat these steps again to create the Paste Mask output for the opposite side of the board (if 
applicable).

21. In the CAM Directory list, choose the folder where you want to save the output files.
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22. Select the document(s) you want to output in the Document name list, and then click Run.

23. Click Save.

Tip
If you close the design without saving the design, you will lose any additions to the Define 
CAM Documents dialog box.

Results
Your file(s) appear in the C:\SailWind Projects\Cam  directory or a subdirectory if you created one.

When looking at the Paste Mask preview keep in mind that, unlike solder mask, the paste mask is not an 
artwork layer - it is not a substance that is applied to the board. In this respect it is opposite to the solder 
mask layer. The black areas are in fact openings in the paste mask layer stencil and are the locations 
where the solder paste will be applied to the board. You should typically see paste mask openings (solder 
paste locations) for each pad of surface mounted components.

Related Topics
Creating CAM Outputs to Manufacture Your PCB

Control of Solder Mask and Paste Mask

Creating a Set of CAM Documents Using Auto Define

Creating an Assembly Drawing
You create the assembly drawing for your manufacturer to reference when assembling the components 
on the board.

Procedure
1. Click the File  > CAM  menu item.

2. In the Define CAM Documents Dialog Box, click Add.

3. In the Add Document dialog box  on page 1044, type a Document Name such as Assembly Top, or 
Assembly Bottom

4. In the Document Type list, click Assembly and in the Layer Association Dialog Box  that appears, 
choose from the Top or Bottom side of the board.

The layers may not be named Top or Bottom, but will have the names you chose for the top and 
bottom layer of your design in the Layers Setup Dialog Box.

5. In the Output File box, type a name for the file you are creating.

An auto-generated name appears in the Output File box. This is the name of the file you will send 
to the manufacturer. Your manufacturer will find it helpful if this filename is related to its function. 
Name the file assembly_top.pho  or assembly_bottom.pho.

6. If you need to create an assembly drawing of an assembly variant, do the following:
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a. In the Customize Document area, click Assembly.

b. In the Select Assembly Variant dialog box, click the Use Assembly Variant check box to use an 
assembly variant as your design input for the assembly drawing.

Tip
Clear the check box to use all parts in the database, known as the raw database  on 
page 1853.

c. In the Name list, select a variant and click OK.

7. In the Output Device area, choose the device and update the Device Setup as needed.

Typically, you would send the Assembly drawings to your printer, plotter or PDF file, and not output 
them to a gerber file. When you activate a printer or plotter as your output, you have the option 
to apply different colors to items in your output document. For example, you could include traces 
and pads in your assembly drawing using a lighter gray color while your component outlines and 
reference designators remained black. This could provide more context when manually assembling 
the board.

8. In the Customize Document area, click the Layers  button.

9. In the Select Items Dialog Box, choose which layers and layer items should appear in the paste 
mask data:

• You can add a set of reference designators to the assembly layers, and center those reference 
designators inside the component outline instead of using the silkscreen reference designators 
which will be scattered around the outside of components. This will make the assembly drawing 
easier to read. For the procedures, see “Generating a Second Set of Reference Designators for 
Assembly Drawings.”

• You may want to add the Part Types to the assembly drawing also.

• If you have added markers in attributes to mark pin 1, it might be beneficial to add these to your 
assembly drawing.

• If all your assembly elements have been added to the assembly layer, you can remove other 
layers in the Selected list.

• Click the Preview  button to check what will be included in the output.

10. Click OK  to accept the changes and close the Select Items dialog box.

11. In the Customize Document area, click Options.

12. In the Plot Options Dialog Box, in the Positioning area, set the positioning options.

13. In the Suppress area, you can suppress the display of some Reference Designators.

For example, if you have a set of mounting holes that use the Ref Des prefix X, you can choose 
not to include those reference designators in the assembly. They are not a true component and 
you do not need the assemblers to think it needs to be populated with a component.

14. For the assembly bottom drawing, you may want to select the Mirror Image check box to mirror the 
image.
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15. Click OK  to close the Plot Options dialog box.

16. Click OK  to add the new file configuration to the Define CAM Documents Dialog Box.

Tip
While you can click Run  and create the output file from the Add Document dialog box, you 
probably want to add this configuration to the Define CAM Documents dialog box in case 
you need to generate the file again.

17. Repeat these steps again to create the Assembly drawing for the opposite side of the board (if 
applicable).

18. In the CAM Directory list, choose the folder where you want to save the output files.

You can skip this step if you are sending it to your printer.

19. Select the document(s) you want to output in the Document name list, and then click Run.

20. Click Save.

If you close the .pcb  design without saving the design, you will lose any additions to the Define 
CAM Documents dialog box.

Results
Your file(s) appear in the C:\SailWind Projects\Cam  directory (or a subdirectory if you created one) if you 
are not sending the output to your printer.

When looking at the Assembly Drawing preview, you typically see component outlines of the layer you 
are working on (Top Mounted or Bottom Mounted), as well as Reference Designators centered inside the 
component outlines renumbered (from the original netlist import) into an easily searchable pattern.

You use two sets of reference designators, one set on the assembly drawing layers centered on 
components for the assembly drawing, and the other set on the silkscreen layers for the silkscreen 
positioned outside the components where they will not be hidden after the component placement. If you 
have not built this second assembly drawing set of reference designators into your library decals, you 
can quickly add them to your design. For more information, see “Generating a Second Set of Reference 
Designators for Assembly Drawings”  on page 808.

Related Topics
Creating CAM Outputs to Manufacture Your PCB

Changing the Reference Designators of Multiple Components in ECO Mode (Autorenumbering)

Creating a Set of CAM Documents Using Auto Define

Creating a Routing/Split Plane Gerber-format File
Conductive element layers are separated into two types of outputs. Your layers are either routing/
split plane layers, or CAM plane layers. You create the routing/split plane gerber-format file for your 
manufacturer’s photo plotter to produce the conductive layer of your PCB.
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Prerequisites

• Before you actually create the gerber-format file for this conductive layer, you must ensure that all 
copper planes are flooded and filled with copper.

• Virtual pins in the design are output as vias.

Procedure
1. Click the File  > CAM  menu item.

2. In the Define CAM Documents Dialog Box, click Add.

3. In the Add Document dialog box  on page 1044, type a Document Name.

It is beneficial to add not only the usage of the layer in the name, but also the placement of the 
layer in the board layer stackup. For example, Signal 2 - L6.

4. In the Document Type list, click Routing/Split Plane and in the Layer Association Dialog Box  that 
appears, choose your layer from the available layers.

5. In the Output File box, type a name for the file you are creating.

An autogenerated name appears in the Output File box. This is the name of the file you will send to 
the manufacturer. Your manufacturer will find it helpful if this filename is related to its function and 
placement in the layer stackup.

6. In the Customize Document area, click the Layers  button.

7. In the Select Items Dialog Box, choose which layers and layer items should appear in the 
silkscreen data:

• In a typical conductive elements output, you want all the conductive elements of one layer. You 
probably want Pads, Traces, Vias, Copper, and associated pin copper if it exists.

• If you add drafting elements to this layer, like lines or text, they will be manufactured as copper. 
You might want to move these items to the silkscreen layer.

• Click the Preview  button to check what will be included in the output.

8. Click OK  to accept the changes and close the Select Items dialog box.

9. In the Customize Document area, click Options.

10. In the Plot Options Dialog Box, in the Positioning area, set the positioning options.
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Tip
It is important that each gerber-format file that you output for your design lines up exactly 
with the others. You must use the same Positioning settings for each layer and you must 
ensure that objects on one layer are not offsetting the layer from the Justification setting. 
For example, you have chosen to justify the layers by the Top Left, and you have decided 
to include the board outline in all your outputs. The board outline will be justified at the top 
left of each output, but if you have a component that extends outside the board outline on 
the left side of the board, it is possible that your silkscreen layer will not be aligned to the 
other layers you have created, since the alignment is to the component outline on the left 
(and the board outline at the top).

11. Click OK  to close the Plot Options dialog box.

12. In the Output Device area, click the Photo  button if not already selected.

13. Click Device Setup  and in the Photo Plotter Setup Dialog Box, make any necessary changes to 
the settings.

14. Click the Advanced  button and in the Photo Plotter Advanced Setup Dialog Box, make any 
necessary changes to the settings.

Tip
You may want to use the RS-274X format.

15. Click OK  to close the Photo Plotter Advanced Setup dialog box.

16. Click OK  to close the Photo Plotter Setup dialog box.

17. Click OK  to add the new file configuration to the Define CAM Documents Dialog Box.

Tip
While you can click Run  and create the output file from the Add Document dialog box, you 
probably want to add this configuration to the Define CAM Documents dialog box in case 
you need to generate the file again.

18. In the CAM Directory list, choose the folder where you want to save the output files.

19. Select the document(s) you want to output in the Document name list, and then click Run.

CAUTION:
If your design has copper planes that are not filled with copper, you must fill the areas 
before creating the gerber-format outputs. You will be prompted to fill them in order to 
create the output file.

20. Click Save. If you close the .pcb  design without saving the design, you will lose any additions to 
the Define CAM Documents dialog box.

Results
Your file(s) appear in the C:\SailWind Projects\Cam  directory or a subdirectory if you created one.
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When looking at the Routing/Split Plane preview, you typically see in black - only the copper items located 
on the selected layer - all traces, vias, copper, copper planes. If this is a component layer, you will also 
see all the component pads and associated pin copper if it exists. The white areas are areas of no copper.

Related Topics
Creating CAM Outputs to Manufacture Your PCB

Creating a Set of CAM Documents Using Auto Define

Creating a CAM Plane Gerber-format File
Conductive element layers are separated into two types of outputs. Your layers are either routing/split 
plane layers, or CAM plane layers. You create the CAM plane gerber-format file for your manufacturer’s 
photo plotter to produce the conductive layer of your PCB.

Note:
Virtual pins in the design are output as vias.

Procedure
1. Click the File  > CAM  menu item.

2. In the Define CAM Documents Dialog Box, click Add.

3. In the Add Document dialog box  on page 1044, type a Document Name.

It is beneficial to add not only the usage of the layer in the name, but also the placement of the 
layer in the board layer stackup. For example, GND CAM Plane - L3.

4. In the Document Type list, click CAM Plane and in the Layer Association Dialog Box  that appears, 
choose your layer from the available layers.

5. In the Output File box, type a name for the file you are creating.

An autogenerated name appears in the Output File box. This is the name of the file you will send to 
the manufacturer. Your manufacturer will find it helpful if this filename is related to its function and 
placement in the layer stackup.

6. In the Customize Document area, click the Layers  button.

7. In the Select Items Dialog Box, choose which layers and layer items should appear in the 
silkscreen data:

• In a typical CAM plane output, you probably want Pads, Vias, and Copper. Since this is a 
negative image plane, copper objects will show up as a cutout in the CAM Plane.

• If you add drafting elements to this layer, like lines or text, they will be manufactured as copper. 
You might want to move these items to the silkscreen layer.
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• Click the Preview  button to check what will be included in the output.

Tip
CAM Planes are negative images in the work area and also in the CAM Preview. When 
viewing a routing/split plane layer document type the white areas are openings in the 
copper, but when viewing a CAM (negative) plane, the white area is copper.

8. Click OK  to accept the changes and close the Select Items dialog box.

9. In the Customize Document area, click Options.

10. In the Plot Options Dialog Box, in the Positioning area, set the positioning options.

Tip
It is important that each gerber-format file that you output for your design line up exactly 
with the others. You must use the same Positioning settings for each layer and you must 
ensure that objects on one layer are not offsetting the layer from the Justification setting. 
For example, you have chosen to justify the layers by the Top Left, and you have decided 
to include the board outline in all your outputs. The board outline will be justified at the top 
left of each output, but if you have a component that extends outside the board outline on 
the left side of the board, it is possible that your silkscreen layer will not be aligned to the 
other layers you have created, since the alignment is to the component outline on the left 
(and the board outline at the top).

11. In the CAM Plane Layers area, set the settings as necessary.

12. Click OK  to close the Plot Options dialog box.

13. In the Output Device area, click the Photo  button if not already selected.

14. Click Device Setup  and in the Photo Plotter Setup Dialog Box, make any necessary changes to 
the settings.

15. Click the Advanced  button and in the Photo Plotter Advanced Setup Dialog Box, make any 
necessary changes to the settings. You may want to use the RS-274X format.

16. Click OK  to close the Photo Plotter Advanced Setup dialog box.

17. Click OK  to close the Photo Plotter Setup dialog box.

18. Click OK  to add the new file configuration to the Define CAM Documents Dialog Box.

Tip
While you can click Run  and create the output file from the Add Document dialog box, you 
probably want to add this configuration to the Define CAM Documents dialog box in case 
you need to generate the file again.

19. In the CAM Directory list, choose the folder where you want to save the output files.
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20. Select the document(s) you want to output in the Document name list, and then click Run.

21. Click Save. If you close the .pcb  design without saving the design, you will lose any additions to 
the Define CAM Documents dialog box.

Results
Your file(s) appear in the C:\SailWind Projects\Cam directory or a subdirectory if you created one.

When looking at the CAM Plane preview, you see a negative image (opposite image) compared to the 
Routing/Split Plane layers. The white area is the copper and the black objects - typically only vias or 
through hole pin locations are areas of no copper. Since this is a negative image, you place copper on 
this layer to create a copper void (an area of no copper). You should see these voids if you have used 
them.

CAM plane thermals are displayed in the CAM Preview dialog box (and in the Layout editor). The 
following calculations are also used for resulting output during printing, pen plotting, and RS-274-X 
photoplotting operations:

• The outer diameter of the thermal matches the width of the aperture set in the Photo Plotter 
Setup Dialog Box.

• The inner diameter is 75% of the outer diameter.

• The number of spokes is always four, arranged diagonally.

• The spoke width is 1/6 of the outer diameter.

Tip
The inner width for custom CAM plane thermals is set as the pad size defined in the Pad Stacks 
Properties dialog box. The outer width is set as the default same-net pad to corner rule.

Related Topics
Creating CAM Outputs to Manufacture Your PCB

Creating a Set of CAM Documents Using Auto Define

Creating an NC Drill File
You can create an NC drill file for each drill pair in your design. This allows the board fabricator to use 
separate drilling operations for specific layer pairs during the board fabrication process.

Procedure
1. Click the File  > CAM  menu item.

2. In the Define CAM Documents Dialog Box, click Add.

3. In the Add Document dialog box  on page 1044, type a Document Name.

It is beneficial to add not only the usage of the file in the name, but also the drill pair if using partial 
vias. For example, NC Drill L1-3.
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4. In the Document Type list, click NC Drill.

5. In the Output File box, type a name for the file you are creating.

An autogenerated name appears in the Output File box. This is the name of the file you will send to 
the manufacturer. Your manufacturer will find it helpful if this filename is related to its function and 
the drill pair it represents.

6. In the Customize Document area, click Options.

7. In the NC Drill Options Dialog Box, set the options for your file.

Tip
If you are using partial vias, you can choose which drill pair this file represents by selecting 
the Partial Vias check box and selecting the Drill Pair.

8. Click OK  to close the NC Drill Options dialog box.

9. In the Output Device area with the Drill button automatically selected, click Device Setup.

10. In the NC Drill Setup Dialog Box, make any necessary changes to the settings.

11. Click OK  to close the NC Drill Setup dialog box.

12. Click OK  to add the new file configuration to the Define CAM Documents Dialog Box.

Tip
You can click Run  and create the output file from the Add Document dialog box; however, 
it is better instead to add this configuration to the Define CAM Documents dialog box by 
clicking OK  in the event you need to generate the file again.

13. In the CAM Directory list, choose the folder where you want to save the output files.

14. Select the document(s) you want to output in the Document name list, and then click Run.

15. Click Save. If you close the .pcb  design without saving the design, you will lose any additions to 
the Define CAM Documents dialog box.

Results
Your file(s) appear in the C:\SailWind Projects\Cam  directory or a subdirectory if you created one.

When looking at the NC Drill File preview, you see drill locations, but this file is not meant to be viewed 
like the other output files. To examine the drill symbols and their locations, view the Drill Drawing  on 
page 954 instead.

Related Topics
Creating a Set of CAM Documents Using Auto Define

Creating a Drill Drawing with Drill Table
You can create a drill drawing for one or more drill pairs.
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Restrictions and Limitations
The drill chart is only output in the drill drawing CAM document. It is not embedded in the design.

Procedure
1. Choose the File > CAM  menu item.

2. In the Define CAM Documents dialog box, click Drill Symbols  to open the “Global Drill Symbols 
dialog box”  on page 1387 to define your drill symbols.

3. If using partial vias, select the Unique Through/Partial column  check box to allow filtering of the 
drill holes.

Selecting this check box displays the Through/Partial column in the table to differentiate partial 
from through-hole drills.

4. If necessary, click Regenerate  to update the table data.

Populate data in the drill drawing table by manually adding entries or by gathering information from 
the design database by clicking Augment  or Regenerate. If you have not saved any new default 
settings and if no data previously existed in the table, clicking Augment  or Regenerate  populates 
the table in ascending order of size and then plated holes before non-plated holes.

5. Customize the settings of the Drill data as needed.

• Customize the text size.

• Modify the symbols used and Tolerance. For more information, see “Modifying Drill Table 
Entries”  on page 963.

• Sort the data in the drill drawing table by clicking the column header of drill size, quantity of the 
holes, or plating type. For more information, see “Sorting the Data in the Drill Drawing Table”  on 
page 962.

6. Click OK  to close the Global Drill Symbols dialog box.

7. In the Define CAM Documents dialog box, click Add.

8. In the Add Document dialog box  on page 1044, type a name in the Document Name box.

It is beneficial to add not only the usage of the file in the name, but also the drill pair if using partial 
vias. For example, Drill Drawing L1-3.

9. From the Document Type dropdown list, select “Drill Drawing” and then, in the “Layer Association 
dialog box”  on page 1437 that appears, choose one of the layers in your drill pair and click OK.

If you are only using through hole vias, any layer will do. If you want to display the drill holes of 
multiple drill pairs in the same drawing, select one of the layers in your drill pair. You will add 
additional layers in a later step.

10. In the Output File box, type a name for the file you are creating.

(An auto-generated name appears in the Output File box but you can overwrite it.) This is the 
name of the file you will send to the manufacturer. Your manufacturer will find it helpful if this 
filename is related to its function and the drill pair it represents.

11. In the Customize Document area, click the Layers  button.
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12. In the “Select Items dialog box”  on page 954, choose which layers to include, and check for 
these conditions:

CAUTION:
The objects that require drilling must be added to the drill drawing in order for the drill 
chart to be created. The chart only displays the drill data of items that are added to the 
drill drawing in the Select Items dialog box  on page 1699. For example, if no pads or vias 
are added from the electrical layers, the chart will not display drill information for those 
locations.

• If you have added dimensions to the Drill Drawing layer, you must enable Lines and Text.

• For designs that only use through holes, you only need to include one electrical layer. For 
designs that use partial vias, you need to add at least one layer that the partial via starts on, 
passes through, or ends on. Even though a layer of each drill pair appears in the list, you can 
use the Drill Drawing Options to restrict the drill holes that appear in the drawing.

• Click the Preview  button to see what will be included in the output.

13. Click OK  to accept the changes and close the Select Items dialog box.

14. In the Customize Document area, click Options.

15. In the “Plot Options dialog box”  on page 1641, in the Positioning area, set the positioning options.

16. In the Drill Chart area, type new coordinates for the Location of the chart if necessary.

In the Preview window, notice the position of the magenta-colored rectangle with respect to the 
position of your board outline. This is the current location of the drill chart in the drill drawing. 
Determine where to position the drill chart with reference to the design origin.

17. Click the Drill Symbols  button and in the “Drill Symbols dialog box”  on page 1334, select the 
“Use” check box for each drill symbol that you want to include in the drawing; then click OK.

18. Check your location of the Drill Chart in the Preview window and if needed, edit the location of the 
drill chart.

19. Click OK  to close the Plot Options dialog box.

20. In the Output Device area, choose the device and update the device setup as needed.

21. Click OK  to add the new file configuration to the “Define CAM Documents dialog box”  on 
page 1261.

Tip
Although you can click Run  and create the output file from the Add Document dialog 
box, the recommended course is to click OK  to add this configuration to the Define CAM 
Documents dialog box in the event you need to generate the file again.

22. In the CAM Directory list, choose the folder where you want to save the output files.

You can skip this step if you are sending it to your printer.
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23. Select the document(s) you want to output in the Document name list, and then click Run.

24. Click Save. If you close the design without saving the design, you will lose any additions to the 
Define CAM Documents dialog box.

Results
Your file(s) appear in the C:\SailWind Projects\Cam  directory (or a subdirectory if you created one) if you 
are not sending the output to your printer. In addition, the Drill Drawing preview displays drill locations with 
markers and a drill chart listing all the drill sizes, based on your assignments in the Global Drill Symbols 
dialog box and the set design unit options (mils, metric, or inches). Dimensioning measurements for the 
board may also display on the drawing.

Related Topics
Creating CAM Outputs to Manufacture Your PCB

Creating a Set of CAM Documents Using Auto Define

Verifying a Gerber File
Use Verify Photo to open .pho  (gerber) files for viewing.

The Verify Photo is more than just a Preview, it looks at the actual Gerber output for its data, rather 
than taking data from the PCB file before the actual photoplot is generated. This allows you to create a 
hardcopy paper printout of your Gerber files to perform visual inspections and keep records of your plot 
files.

Procedure
1. Click the File  > CAM  menu item.

2. In the Define CAM Documents Dialog Box, click Add.

3. In the Document Type list, click Verify Photo.

4. In the Photo plotter output file name dialog box, browse for the gerber file.

5. Select the gerber file and click Open. The path to the file appears in the Summary area.

6. Click the Preview Selections  button.

7. View your gerber file in the CAM Preview window.

Related Topics
Creating CAM Outputs to Manufacture Your PCB

Creating All Outputs
You can run multiple CAM document configurations against your current design.
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Procedure
1. Select a document configuration in the CAM Documents list.

You can also drag or Shift+click to select multiple adjacent documents. Select multiple non-
adjacent documents using Ctrl+click.

2. Click Run.

Results
A prompt window verifies the list of documents to be created. The generated CAM outputs are send to 
print or plot or are written to a file in the CAM Directory.

When you run CAM on a layer that is specified as a mixed plane in the Layers Setup Dialog Box, the 
message “Split/mixed plane detected. Perform flood and DRC checks?” appears. This message appears 
only once when running CAM on multiple split/mixed plane layers.

• Click Yes  to run the flood operation on the split/mixed plane, perform a Plane Check of Verify 
the Design, and generate split/mixed plane data for the layer. The Plane Check is run using the 
options of the Mixed Plane Setup Dialog Box.

• Click No  to cancel the process. You can run Plane Check from Verify Design manually for more 
information on the errors.

Note:
CAM interprets pads and other objects differently when they are associated with copper in 
the PCB Decal Editor. For more information, see the Pins with Associated Copper area of 
the “Select Items Dialog Box”.

Tip
For color print outputs, if text is combined with a 2D line or part of a dimension line, then 
a grayscale or preset color will be used for line items. Any free text on the board will use 
what is assigned for text in the Select Items dialog box.

Note:
Virtual pins in the design are output as vias.

Creating Reusable Fabrication Notes
You can save your fabrications notes to the library for reuse.

Procedure
1. Create the individual line items of text.

For more information, see “Adding Free Text”.

2. Since text alone cannot be saved to the library, add an underline to the heading of your fab notes 
using a 2D Line.
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For more information, see “Creating a Drafting Object”.

3. Combine all the text with the line item.

For more information, see “Combining Line and Text Objects”.

4. Save your notes to a library.

For more information, see “Saving a Drafting Item to a Library”.

Reporting Apertures of a Photo-Plot File(s)
You can produce a report of the apertures used in a CAM Document.

Prerequisites
To produce an aperture report, you must have run the CAM Document(s) photo plot configuration against 
your design. If the CAM Document is set to print, or pen output, it will not produce the report.

Procedure
1. Click the File  > CAM  menu item.

2. Select a CAM document in the CAM Documents list.

3. Click Aperture Report.

4. In the Aperture report file name dialog box, type a name for the report and then click Save.

Results
The aperture report opens in the default text editor.

TrueLayer Associations
By default, when you flip a component, the component attributes flip with it. For example, you flip a 
component from one side to the other in the design.

Although the reference designator attribute is visible and located on the top silkscreen layer, it 
automatically flips to the bottom silkscreen layer. You are using TrueLayer association. This feature 
also depends on you associating layers correctly in the Layer Setup. You can override the TrueLayer 
functionality by applying a command line switch to the software on startup.

For more information, see “Software Launch Options”.

Colors in CAM Documents
You can apply colors to CAM document objects if you are outputting to a printer or a pen plotter.
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Restriction:
The color palette only shows colors that the printer or plotter can output. If your device can 
only print grayscale, the palette will show grayscale. For monochrome output devices (printers/
plotters), the only color available is black.

Colors of Objects
You can assign a color to the object types for printing.

• In the Select Items Dialog Box, in the Selected Color area, click a color in the palette and click the 
box beside a design object. You must select the check box of a design object before the object 
color swatch appears.

Colors of Individual Nets
You can use the colors you have assigned to nets in the View Nets dialog box when you print.

• In the Select Items Dialog Box, select the Color By Net check box to use the View Nets colors in 
the output.

Applying the Over(Under)size Value to All 
Layers
You can extend the value of the Over(Under)Size value to non-electrical layers using an attribute applied 
to the PCB level of the attribute hierarchy.

In PADS2007.1 or later, the attribute is automatically added to all designs when opening the design or 
when importing an ASCII file. Opened designs, created with version PADS2007 have the attribute value 
set to No to only apply the Over(Under)size value to electrical layers.

Opened designs created with any other version have the attribute set to Yes to apply the Over(Under)size 
value to all layers.

Procedure
1. In the design, select an object (for example, a component, component pad, or net), right-click and 

click the Attribute  popup menu item.

2. In the “Attributes for” list, click PCB.

Tip
This displays any attribute of the PCB at the PCB level of the attribute hierarchy.

3. The “CAM.Apply Oversize To All Pads” attribute appears in the attribute list.

4. Use an attribute value of Yes to apply the Over(Under)size value to all layers or use No to accept 
the default of applying the value only to electrical layers.
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Results

• Is the Over(Under)size value not being applied correctly? There is a hierarchy of settings that 
apply to Solder Mask and Paste Mask layers, and the Over(Under)size value has the lowest 
priority. For more information, see “Control of Solder Mask and Paste Mask”.

• Is the attribute not listed when viewing the PCB attributes at the PCB level of the hierarchy? Add 
the attribute with the correct value.
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Drill Drawing Options
Use the Drill Drawing Options dialog box to set drill drawing legend and marker parameters.

Sorting the Data in the Drill Drawing Table
Modifying Drill Table Entries

Sorting the Data in the Drill Drawing Table
You can populate and then sort the data in the drill drawing table by drill size or quantity of the holes, and 
then by plating type.

Tip
Populate data in the drill drawing table by manually adding entries or by gathering information 
from the design database with Augment  or Regenerate. If you have not saved any new default 
settings and if no data previously existed in the table, Augment  or Regenerate  populates the 
table in ascending order of size and then plated holes before non-plated holes.

Procedure
1. Click on the appropriate column (Size, Quantity, or Plated) in the drill drawing table.

2. Click another column heading (Size, Quantity, or Plated) to also sort by that column.

Results
The final sorting order is determined by the order in which the columns are selected for sorting.

For example, clicking the Size column first determines whether the data appears in numerical ascending 
or descending order. If you then click the Plated column, the list is reordered with plated or non-plated 
holes first while maintaining the ascending or descending numerical sorting order that you previously 
selected. If you then click the Quantity column, the Quantity sorting order overrides the previous 
selections.

Examples
The sorting results are formatted to correspond with the filters you have chosen.

Table 135  shows the result of a sort by size (ascending order) and then by plated type.

Table  135. Example Sort Result

Symbol Size Quantity Plated Tolerance

+ 0.0135 35 Yes +0.000/0.0135

X 0.02 125 Yes +/-0.003

Rectangle 0.037 62 Yes +/-0.003

Diamond 0.048 X 1.020 44 Yes +/-0.003

962 SailWind Layout Guide and Reference



 
CAM Output

Modifying Drill Table Entries

Table  135. Example Sort Result  (continued)

Symbol Size Quantity Plated Tolerance

Rectangle + 0.056 8 Yes +/-0.003

Rectangle X 0.072 4 Yes +/-0.003

Diamond + 0.11 6 No +/-0.005

Circle + 0.156 4 No +0.005/-0.002

Modifying Drill Table Entries
You can modify the drill table entries shown in the Drill Data area.

Restrictions and Limitations

• Symbol usage is exclusive - you cannot save your changes if you create duplicate symbol 
assignments.

• You cannot edit data in the Size, Quantity, or Plated columns.

Procedure
1. To modify the symbol associated with a specific drill entry, double-click the target symbol entry in 

the Symbol column and select a symbol from the list of available drill symbols.

The next time you click on the entry, the symbol preview window in the Drill Symbol Markers area 
reflects the symbol change.

2. To specify or change the tolerance value for a specific drill entry, double-click the target tolerance 
entry in the Tolerance column and type a tolerance value.

Tip
The Tolerance column gives you the flexibility of entering a text string of up to 32 
characters, which enables you to add a fabrication note along with your tolerance value. 
 As a general rule, be careful to type suitable tolerance values. You can copy and paste 
tolerance data between text fields, but you cannot perform multiple cell copy functions.
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Assembly Variants
Assembly Variants allow you to create multiple versions of your assembly containing component 
substitutions and/or omissions. This allows one base design to support multiple product configurations at 
assembly time.

Substitute a Component for Assembly Variants
Creation of Assembly Variants
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Substitute a Component for Assembly Variants
The Variant/Substitute dialog box appears when you choose to substitute a component in an assembly 
variant. When you substitute a component, the substitution is referred to as the active component. The 
original component that you substituted is referred to as the default. The default component is what exists 
in the base option and the raw database.

Substituting Components
Component Status Interpretation
Displaying Substitution Differences
Previewing a Variant

Substituting Components
You can use Assembly Variants to substitute components in your assemblies.

Procedure
1. Click the Tools  > Assembly Variants  menu item.

2. Choose any of the following ways to begin substituting a component:

• Click an Assembly Variant in which you want to substitute the component from the Variant 
Name  list, select the component name to change, and click Substituted  in the Status area.

• Select a component in the multicolumn list, and click Substitute  in the Status area.

• Click Substitute  from the Verb Mode list, and select a component in the Layout Editor.

3. In the Variant/Substitute dialog box, in the multicolumn list, double-click a Part Type in the Active 
column.

The multicolumn list displays the attributes (Value) of the component you are substituting, its 
Default  on page 1820 value, and its Active  on page 1808 value (the substitution).

4. In the list, select a value you want to use for the substitution.

5. Click OK  to complete the substitution.

6. Click OK  to save and apply the substitutions to the Assembly Variant.

7. To choose a different part type from a library click Browse.

Restriction:
You cannot substitute the Family, Number of Pins, Number of Gates, or Signals Pins. This 
information is updated when you choose a different part type.

Component Status Interpretation
The Status area explains the status of the component.
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• Current  — The state before you click Substituted or Verb Mode.

• New  — The state after you click Substituted or Verb Mode.

For example, if a component is Installed and you want to Substitute it, Current displays Installed because 
the component was installed in the variant. New reads Substituted because you are creating a new 
substitution for the component.

Displaying Substitution Differences
You can display only the values of the Default and Active component which differ, in the multicolumn list. 
This includes items that you manually change and items that change because you select a different part 
type.

Procedure
Select the Show Difference check box and view the updated list with only the differences.

Previewing a Variant
You can preview your substitutions.

Procedure
Click the Preview  button and view the substitutions.

For more information, see “Previewing Assembly Variants”.
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Creation of Assembly Variants
Use the Assembly Variants dialog box to create a new variant, review or edit a variant, preview variants, 
delete variants, and create reports for variants.

Creating Assembly Variants
Installing, Uninstalling, or Substituting Variant Design Components
Modifying Assembly Variants
Modifying Assembly Variants by Component
Deleting Assembly Variants
Previewing Assembly Variants
Creating Assembly Variant Parts Lists
Creation of Assembly Variant Assembly Drawings

Creating Assembly Variants
You can create Assembly Variants to represent different variations of your final assembly.

Procedure
1. Click the Tools  > Assembly Variants  menu item.

2. In the New variant's name box, type the name of the new variant, up to 26 characters,

3. Click Create  and a new variant is created that contains all the items in the Base Option  on 
page  .

4. Use the Display  list to filter the items to view in the multicolumn list.

5. Uninstall, or substitute  on page 968 your design components.

6. When you finish defining the new Variant, click OK  or Apply  to save the changes to the new 
Variant.

The Base Option is also updated based on the new variant. You can continue to create new 
Variants.
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Installing, Uninstalling, or Substituting Variant Design 
Components
The following topics describe two different methods you can use to install, uninstall or substitute variant 
design components.

Using the Multicolumn List
Using the Design Area/Layout Editor

Using the Multicolumn List
You can modify the component status using the multicolumn list and the Status area.

Restrictions and Limitations
Since you cannot directly modify the Status of the Base Option  on page   which is based on the other 
variants, modifying the Status is unavailable when you view the Base Option in the multicolumn list.

Procedure
1. Select a variant in the Name list.

2. In the multicolumn list, select the items you want to uninstall from the new Variant and click Not 
Installed.

Tip
Click the column header to sort the multicolumn list.

3. In the multicolumn list, select the items you want to substitute and click Substituted.

The Variant/Substitute dialog box  on page 964 appears for each item.

4. Make any substitutions you want and click OK  to return to the Assembly Variants dialog box.

Using the Design Area/Layout Editor
You can also modify the component status using the Layout Editor. With Verb Mode you can decide what 
action to take and perform it on components in the Layout Editor (outside the dialog box).

Procedure
1. Select a variant in the Name list.

2. In the Manager area, select Install, Uninstall, or Substitute in the Verb Mode list.

3. Click outside the dialog box.

The dialog box remains open, but it is not active.

4. In the design area, select the components, one at a time, to which to perform the action.
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Tip
When using the Substitute Verb Mode, the Variant/Substitute dialog box  on page 964
appears after each component you select.

5. When you finish selecting components or want to change the Verb Mode, click inside the dialog 
box.

The multicolumn list in the dialog box updates to reflect the actions you performed on items.

Restriction:
You cannot modify the BaseOption  on page  .

Modifying Assembly Variants
By modifying an Assembly Variant, you can, for example, choose to uninstall or substitute a component 
that is Installed in the variant you click in the Name list.

Procedure
1. Click the Tools  > Assembly Variants  menu item.

2. In the Name  list, click the variant for which you want to view the status.

3. To view all components in the Assembly Variant click All in the Display list.

The multicolumn list reflects the status of components for that variant.

4. In the multicolumn list, click any components you want to install, uninstall, or substitute for the 
variant.

Tip
Click the column header to sort the multicolumn list.

5. Click Installed, Not Installed, or Substituted.

When you click Substituted, the Variant/Substitute dialog box  on page 964 appears for each variant 
that you select to substitute.

If you change the status of a component from Substituted to Installed, the variant uses the Default 
component  on page 1820.

If a component is already substituted in the variant and you want to change the substitution 
values, select the component in the multicolumn list and click Edit  in the Status area. The Variant/
Substitute dialog box appears.

6. Make any substitutions in the Variant/Substitute dialog box and click OK. You return to the 
Assembly Variants dialog box.

7. Click OK.
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Modifying Assembly Variants by Component
You can modify Assembly Variants when you click Components in the Type list. If the component selected 
in the Name list is Installed in Options, you can uninstall it from or substitute it in Options.

Procedure
1. Click the Tools  > Assembly Variants  menu item.

2. In the Type list, click Components.

3. In the Name list, click the component whose status you want to view.

4. In the Display list, click All  to view the status of the component in all variants.

5. In the multicolumn list, select the variants from which you want to install, uninstall, or substitute the 
component.

If a component is already substituted in the variant and you want to change the substitution, select 
the variant in the multicolumn list and click Edit  in the Status area. The Variant/Substitute dialog 
box appears.

Tip
Click the column header to sort the multicolumn list.

6. Click Installed, Not Installed, or Substituted.

When you click Substituted, the Variant/Substitute dialog box  on page 964 appears.

If you change the status of a component from Substituted to Installed, the variant uses the Default 
component  on page 1820.

7. Make any substitutions in the Variant/Substitute dialog box and click OK.

You return to the Assembly Variants dialog box.

8. Click OK  or Apply  to save the changes to the variant.

Substituted items are removed from the Base Option.

Deleting Assembly Variants
You can delete existing assembly variants in the Assembly Variants dialog box.

Procedure
1. Click the Tools  > Assembly Variants  menu item.

2. In the Name list, click the variant which you want to delete.

3. Click the Delete  button.
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Previewing Assembly Variants
You can display installed components in all of your assembly variants. You can choose to display, to not 
display, or to display components in a different color.

You can view statistics about assembly variants, such as where component location, how components 
relate spatially to other components in the assembly variant, and what components you have created 
substitutes for.

Procedure
1. Click the Tools  > Assembly Variants  menu item.

2. Select the variant to preview in the Name  list.

3. Click Preview  and the Preview for <variant> dialog box appears displaying an assembly drawing of 
the variant.

4. Click Variants  to open the Preview/Option dialog box.

Use the Preview/Option dialog box to change the appearance of your preview. The multicolumn list 
box indicates whether objects of a status are currently visible in the preview window for a variant.

5. Double-click in the cell of the component in the Assembly Variant for which you want to change 
visibility.

• Click No  to make the components invisible.

• Click Yes  to make the components visible.

• Click Color  to choose a display component color. The Colors dialog box appears. Click a color 
in which to display selected components and click OK. You return to the Preview/Option dialog 
box appears. The multicolumn list reflects a Yes status for the component. If it has a color, it is 
visible.

6. Click OK  to return to the Preview for Variant dialog box.

The preview area reflects the visibility status you set.

Creating Assembly Variant Parts Lists
You can create parts lists based on assembly variants using a feature of the Reports dialog box.

Procedure
Verify your assembly variant selections. and click the Report  button.

For more information, see “Running a Report Using an Assembly Variant”.

Creation of Assembly Variant Assembly Drawings
You can create assembly drawings from assembly variants.

For more information, see “Creating an Assembly Drawing”  on page 946.
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CAM Preview
During CAM document operations, use the CAM Preview dialog box to preview your output. It displays all 
items that will appear in the final CAM document and their position within the plot paper extents.

You can also use the CAM Preview dialog box after you use Verify the Design  to perform fabrication 
checking and you want to preview the CAM document associated with the layer for a selected error.

Use the CAM Preview Setup dialog box to invert, show plot orientation, or overlay multiple CAM 
Documents - you can change the preview attributes of all documents. You must have at least one CAM 
document defined to use preview setup.

For more information, see “CAM Preview Dialog Box”  on page 1150 and “CAM Preview Setup Dialog 
Box”  on page 1152
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Printing
The following topics describe how you can choose to print your CAM documents directly to a Windows 
printer, or to a PostScript file that you can then review or send to your fabricator.

Printing to a Windows Printer
Print PostScript to a File

Printing to a Windows Printer
One of the output choices for CAM documents is your printer.

Tip
Test the link between Windows and the printer by printing this help topic.

Procedure
1. Click the File  > CAM  menu item.

2. In the Define CAM Documents dialog box, select a document and click Edit.

3. In the Edit Document dialog box  on page 1044, under Output Device, click the Print  button.

This indicates the output device. All printing is controlled using the Windows printer properties.

4. Click Device Setup.

5. In the Print Setup dialog box set printer and document properties and click OK.

6. Under Document Name, type a meaningful name for the document and click OK.

Note:
A meaningful name is one that indicates the document type, the type of output, and the 
layer.

Your document is added to the CAM Documents list in the Define CAM Documents dialog box.

7. Click the Layers  button to display the Select Items dialog box.

8. Set the layers to output information on and click Add.

9. Establish any color changes: 

a. Click the color to use from the Selected Color area, and turn on the check boxes of the objects 
to assign to the color. The new color appears to the right of the object.

b. Continue to assign/redefine the colors by clicking the color and the check box of the objects.

10. When you finish setting options, click OK  to return to the Edit Document dialog box.
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11. To print, click Run. The message “Do you wish to generate the following outputs?” appears.

12. Click Yes  to print.

Related Topics
Print PostScript to a File
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Print PostScript to a File
SailWind Layout supports PostScript printing to a file through use of the Windows printer properties.

For information on setting up printers and defining printer properties, see the Microsoft Windows Help.

You must set up your printer to print to a file before you create a PostScript file.

Setting the Printer to Print to a File
Printing a CAM Document to a File

Setting the Printer to Print to a File
Configure your system to print to a file instead of directly to your printer.

Procedure
1. Locate printer information based on your platform:

• Using your Windows Start menu, locate Printers and Faxes using the Windows Control Panel.

• If you are having difficulty locating the printer setup controls, consult your Windows 
documentation.

2. Right-click the PostScript printer you want to use to print to a file and then click the Properties 
popup menu item.

3. In the Properties dialog box, click the Ports  tab.

4. Under Print to the Following Port, in the Port column, select the FILE: check box, which has the 
description Print to File.

Tip
This procedure works with local printers. If you are using network printers, you may not 
have access rights to select or change the port information.

5. Click OK. You can now print to a file.

Printing a CAM Document to a File
After setting up your system to print to a file, you can create your CAM documents as print files.

Procedure
1. Complete the steps above to set up the printer to print to a file.

2. Click the File  > CAM  menu item. The Define CAM Documents dialog box  on page 931 appears.

3. Select the default folder to which to output your CAM files from the CAM Directory box.
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If you click <Create>, you can create a new folder. The default folder is \SailWind Projects\Cam
\default.

4. Click Add  in the CAM Documents area. The appears.

5. In the Add Document dialog box  on page 1044 Document Type list click the document type you 
want to use.

6. From the Layer Association Dialog Box  that appears, select the layer you want to use and click 
OK.

All associated items, tracks, and vias are added to the Summary area.

7. Under Output Device, click the Print  button.

8. Click the Device Setup  button.

9. In the Print Setup dialog box choose a printer and set printer properties and then click OK.

For more information on this dialog box, see the Microsoft Windows Help.

10. Under Document Name, type a meaningful name for the document and click OK.

Once you are satisfied with your CAM document definitions and have finished setting printing 
options, you can print as you normally would. For more information, see “Printing”.

Tip
For best results, make sure that you have a design loaded before generating the output 
file.

11. In the Define CAM Documents dialog box, select your document and click Run.

The message “Do you wish to generate the following outputs?” appears.

12. Click Yes  to print to a file. The Print to File dialog box appears (as long as you have selected a 
printer that is defined to print to a file).

13. Use the dialog box to specify a name (and, optionally, a path) for the output file. The default path is 
\My Documents\SailWind Projects\Cam\default, but you may have changed this in step 3 above.

14. Click OK. The printer file is created.
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DFM Analysis of CAM Documents
Once you create your CAM documents, you can analyze them using DFM Analysis.

Setting up DFM Analysis
Running the DFM Analysis

Setting up DFM Analysis
If you have not previously set up your DFM Preferences, you can use Setup to specify the options you 
want to use while analyzing your CAM documents.

Procedure
1. Click the Tools  > DFM Analysis  > Setup  menu item.

2. Select the Preferences you want and then run the analysis.

Tip
To view help on DFM Analysis, press the F1 key with the dialog box open.

Related Topics
DFM Analyses User Guide

Running the DFM Analysis
If you have already created your DFM Preferences, you can proceed directly to running you analysis.

Procedure
1. Click the Tools  > DFM Analysis  > Start Analysis.

2. The analysis will run and generate a report.

Tip
To view help on DFM Analysis, press the F1 key with the dialog box open.
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CAM Plus Assembly Machine Interface
The CAM Plus command generates computer-aided manufacturing (CAM) output files that are compatible 
with a variety of automatic assembly and pick-and-place machines. Supported formats include Dynapert, 
Siemens, Universal, and Quad.

Batch Mode and Masked Mode
Running CAM Plus
CAM Plus Report File Names

Batch Mode and Masked Mode
CAM Plus uses the part.def  file differently depending on whether you click Masked in the Parts list in 
conjunction with Batch Part Definition File.

• With Masked selected and the Batch Part Def File check box selected, CAM Plus sorts parts to all 
machines as defined in the part.deffile, ignoring non-defined parts, Part D.

• With Masked selected, the Batch Part Def File check box cleared, and a specific machine 
selected, CAM Plus sorts only parts defined in part.def  as assigned to that machine.

• With something other than Masked selected and the Batch Part Def File check box selected, 
CAM Plus sorts parts assigned in part.def  to their respective machines, but includes undefined 
parts in files for all machines.

• With something other than Masked selected, the Batch Part Def File check box cleared, and a 
specific machine selected, CAM Plus sends all parts to the selected machine.

Running CAM Plus
You can set up CAM Plus to generate machine-specific output files.

Prerequisites
You must manually create a part.def  file in order to use the CAM Plus option. Every part that is used in the 
design must be listed in the part.def  file. This may require assistance from manufacturing engineering to 
determine which parts to insert by which machines, and to set standard bin assignments. Also, place all 
design components at their final locations before you start CAM Plus. By default, the part definition file is 
read from the \Libraries  folder. For more information, see Part Definition File Format.

Procedure
1. Click the File  > CAM Plus  menu item.

2. In the Part Definition Filename box, type part.def. The file is read from the \Libraries  folder by 
default.

3. In the Setup area:
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a. Select a side of the board from the Side list.

b. Select the type of parts to include in the report from the Parts list.

Choose from SMT, ThruPin, All, and Masked. Masked parts are those that are assigned to the 
machine selected format as an insert class.

c. Select the Read Part Definition check box to add the additional information contained in the 
Part Definition File, part.def, to the parts contained in a design.

This information defines the insertion class for all parts. Read Part Definition scans the Part 
Definition File for information about the parts in the database. When an exact match is found 
between a part type name in the database and a part type name in the definition file, the 
information combines to provide the manufacturing output.

d. Select the Read Value Definition check box to read the Value attributes for each part in the 
SailWind Layout design and append the Value attribute to the part type name when matching 
each part type in the Part Definitions file, part.def.

For example, an R1/4W part type with Value attribute 100K could have an entry in the Part 
Definitions file as follows: R1/4W{100K},ins=un6241,bodydiam=200,leaddiam=30,anvil=2

e. Select the Verify File check box to produce an ASCII verification file.

This ASCII file is stored in the \SailWind Projects\Cam\<board_file_name>  folder. This file 
contains 2D line data that describes the path for the inserted parts. The name of the file is 
the name of the interface program created, with the .asc  extension. You can read this file into 
SailWind Layout with the ASCII In command. It states the insertion path as 2D lines on layer 
19. If a Part_Num value for a part is not found, Part_Num is set to Missing.

f. Select the Batch Part Def. File check box to run all of the outputs with a single command.

For each program you run, an output file is produced with the name suffix bt or bb, for example 
dym318bt.smt  or 6241bb.put. If this file already exists, the message “Overwrite existing file 
(Y/N)?” appears. Click either Yes or No. If you click Yes, the file is overwritten and placed in 
the CAM subfolder. Each of the parts in the selected category is added to the file. A report 
calledinsert.lst  lists each part and the machine that inserts it. The Batch command does not 
create a Verify file.

4. In the Geometry area:

a. Type a value for the Board Offsets to define the offset of the machine’s location dowel with 
regard to the 0,0 system origin board.

These offset values convert the design coordinates to the machine origin. Allowable values are 
from 0 to 10 inches. Offset values are in inches; for example, 1250 is 1.25 inches. You may 
need to define a new Board offset for each machine.

b. Type values for the Step/Repeat values to define whether to treat the board as a single design 
when creating the output program file, or to insert a number of boards simultaneously.

When you insert a number of boards, you can define the number of steps in the X and Y 
direction and the step and repeat interval to use, as shown in the table below. CAM Plus uses 
current design units for the offset and step and repeat values. Each machine has its own units 
type to which the data is always converted regardless of the current design units. CAM Plus 
generates assembly program files for inserting parts on all boards.
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Table  136. X and Y Step and Count Options

Option Description

X Count Number of copies in X direction. The maximum is 20.

Y Count Number of copies in Y direction. The maximum is 20.

X Step The step distance in the X direction between the origin of each board. The 
maximum is 10 inches.

Y Step The step distance in the Y direction between the origin of each board. The 
maximum is 10 inches.

The default is no step and repeat, equivalent to a step of 1 in X and Y.

5. In the Output Format list, select the machine format.

Files are produced for all parts of a selected class: masked, through hole, SMT, top, bottom, 
and so on. All parts in the class are included in this output file, whether or not their insert class is 
defined as belonging to the specific machine.

6. In the Universal Tooling and Universal Axial Output lists select the desired settings if applicable.

Note:
Universal-specific instructions are available when you select Universal machine formats or 
check Batch Part Def. File.

7. Click Run.

8. Examine the Status Messages box for the current state of output.

9. Navigate to C:\PadsProjects\CAM\Newfolder(Design Name)\  to examine the output file. CAM Plus 
produces and prints error messages in the file padscim.err.

CAM Plus Report File Names
The file names created by CAM Plus for various insertion machines are formatted with a prefix name of 
the machine and a suffix of the components selected.

The prefix for each machine type is shown under the heading for each machine in the CAM Plus 
Supported Machine Formats. The last two characters in the output file name (shown as xx) are 
determined by the components selected.

Table 137  shows the first letter in the pair of ending characters.

Table  137. Output File Name Ending Characters (First Letter)

Letter Description

M If the output selected is mask

S If surface mount is selected
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Table  137. Output File Name Ending 
Characters (First Letter)  (continued)

Letter Description

T If through hole is selected

A If all parts are selected

Table 138  shows the second letter is the pair of ending characters.

Table  138. Output File Name Ending Characters (Second Letter)

Letter Description

T If components on the top layer are selected

B If components on the bottom layer are selected

CAM350
CAM350 is a pre-production CAM system that combines DFM analysis, DRC checking, test fixturing, 
planning, and tooling. The CAM350 products range from Gerber viewers to full-featured CAM editors that 
process PCB databases into usable fabrication and panel data.

CAM350 lets you analyze your design for manufacturing issues prior to fabrication, drastically reducing 
cycle time and cost. The tools are based on a fully-intelligent CAD database and can input and output 
virtually any Gerber format, IPC-D-350/IPC-D-356 data, CAD database, or netlist.

CAM350 Link
CAM350 Link is a SailWind Layout option that automatically translates a design database into a CAM350 
(version 6.0 and greater) database. You no longer need to generate an ASCII file for translation; CAM350 
Link uses the native SailWind Layout file format and adds a .cam  extension. In addition to converting 
designs for translation, you can launch CAM350 and load the current database directly from the CAM350 
dialog box.

CAM350 Link also supports backward annotation of Design For Manufacture (DFM) errors to a SailWind 
Layout database so that you can identify and correct DFM errors in SailWind Layout instead of making 
the corrections in CAM350.

See the “Creating CAM Outputs to Manufacture Your PCB” topic for information on outputting CAM 
documents from SailWind Layout. See the DFF Audit Process Flow using CAM350 Link  topic for 
information on CAM350 Link procedures.

CAM350 Link Non-Supported Objects
Some design objects are not passed from SailWind Layout to CAM350 during CAM350 Link translation 
when translating a CAM document with nets and when translating CAD layers to CAM layers.

These specific design objects are:
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• Associated pin copper is merged into a single layer custom aperture. Associated pin copper 
is always merged to the pad layer during translation to CAM350. The result is that associated 
copper is not handled on layers other than the pad layer. In addition, associated copper is not 
distinguished from pad flashes.

• Combined text is not output with owning lines in CAM documents. When combined text and 
lines are translated to CAM350, combined text visibility is controlled by text visibility in the CAM 
document itself, not by the line visibility in the CAM document settings.

• The pad oversize option in the CAM documents is not supported when translating to CAM350.

• Hatched copper is not supported for PADS-format ASCII import. Hatched copper is converted to 
solid fill copper rather than hatched copper when translating to CAM350.

• Decal lines and text on the Top or Bottom electrical layers are not distinguished from lines and 
text for Top or Bottom silkscreen layers. Decal lines and text from the Top and Bottom electrical 
layers are moved to silkscreen layers during CAM350 translation. Visibility control for Top and 
Bottom lines and text can not be distinguished from visibility control for silkscreen lines and text.

• Jumper reference designators and outlines are moved to silkscreen layer. Jumper reference 
designators are converted to free text and jumper outlines are converted to lines in CAM350. 
Jumper reference designators and outlines are also moved to the silkscreen layer during 
translation.

The CAM350 Analysis feature reports jumpers as net connectivity errors. CAM350 does not support CAM 
negative planes on outer mounting layers. CAM350 does not support a layer type of negative plane for 
outer mounting layers.

Test Points in CAM350
Test points in CAM350 are used for Bed of Nails testing or Flying Probe in-circuit testing. Test points in 
SailWind Layout are used for in-circuit testing using fixtures. Although the test configurations and rule 
data are similar, there is no direct mapping between SailWind Layout test point configuration data and 
CAM350 configuration data.

However, test point status is passed to CAM350 for information purposes. The test point status and the 
access side are translated from the ASCII file to the CAM350 database.

Test point configuration data and clearance rules are not passed to CAM350 from SailWind Layout.

Probe sizes are not passed to CAM350. Only the test point location and probe side are passed.

CAM350 Link Document Conversion
SailWind Layout CAM documents combine layer and data type specifications for output in a CAM 
photoplot file. A new layer is created in the CAM350 file for each SailWind Layout CAM document.

For more information on CAM documents see the “Creating CAM Outputs to Manufacture Your PCB” 
topic.

CAM documents can be arbitrarily named. These arbitrary names are used for layer names in the 
CAM350 database to hold the CAM document content. The CAM350 Link extracts the SailWind Layout 
data types from the PADS-format ASCII file for the layers specified in the MISC CAM section of the 
ASCII file. The resulting layers in the CAM350 database match the content of the Gerber photoplot file 
generated by SailWind Layout CAM operations.
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Tip
CAM document names are truncated to 16 characters due to the maximum file name length in 
CAM350.

Supported CAM documents for CAM350 Link include the following five types:

• Plane: ground plane (pads, vias, copper, lines, text)

• Routing: top (pads, vias, tracks, copper, lines, text)

• Silkscreen: (outline top)

◦ top: (ref. des., part type)

◦ silkscreen top: (lines, text, outlines)

• Paste mask:

◦ top: (pads)

◦ paste mask top: (copper, lines, text)

• Solder mask:

◦ top: (pads, test points)

◦ solder mask top: (copper, lines, text, test points)
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Chapter 42
Object Linking and Embedding

The following topics discuss the embedding of OLE objects in SailWind Layout, the characteristics of 
embedded objects, and the operations you can perform on them.

OLE in SailWind Layout
Inserting OLE Objects in SailWind Layout
Embedded Text Documents
OLE Object Selection
OLE Object Management
Editing OLE Links
Open an OLE Object for Viewing or Editing
Saving OLE Objects

OLE in SailWind Layout
With SailWind Layout object embedding capabilities you can insert other files or other applications as 
linked or embedded objects within a SailWind Layout design. Linked objects automatically update from 
the source each time you open the SailWind Layout database.

For example you can insert a Microsoft Word document containing manufacturing information or a 
Microsoft Excel spreadsheet containing a Bill of Materials. SailWind Layout does not need to understand 
the format of the inserted object; SailWind Layout communicates with the application that created the file 
and that source application tells SailWind Layout what information to display and how to display it.

Insertion of SailWind Logic, Layout or Router files as OLE objects in other files (including other PADS 
files) is not supported. Any SailWind Logic, Layout or Router file inserted in another file will not behave 
properly and cannot be edited within the “container” application.

Related Topics
Exporting OLE Files

Importing an OLE File

Inserting OLE Objects in SailWind Layout
You can insert a linked or embedded object into your design.

Note:
If you have multiple OLE objects in a SailWind Layout design, you can export them to an .ole file 
on page 293 and import them into other designs.
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Tip
If you insert an object whose source application is an OLE linking and embedding server, that 
application opens inside SailWind Layout, but runs in the background. The source application's 
toolbar takes over the SailWind Layout toolbar. You can then work with the source application 
in the same way as you would if you started it outside of SailWind Layout. This is called visual 
editing. When you click outside of the object, the SailWind Layout toolbar takes over again, and 
you can continue to design in SailWind Layout. Because the source application continues to run 
in the background you can click on the object and work in the source application at any time.

Restrictions and Limitations

• Insertion of SailWind Logic, Layout or Router files as OLE objects in other files (including other 
PADS files) is not supported.

• You cannot insert OLE linked or embedded objects in the PCB Decal Editor.

Procedure
1. Click the Edit  > Insert New Object  menu item. The Insert Object dialog box appears.

2. Click whether to Create New or Create from File. Create New inserts a new OLE object. Create 
from File inserts an existing file as an OLE object.

3. If you clicked Create New, click the type of OLE object you want to create. If you clicked Create 
from File, click the file you want to insert as an OLE object.

4. If you clicked Create from File, and you want to make the inserted object a link to the original file, 
select the Link check box. If you choose not to link the object, it is an embedded object.

5. If you want to display the object as an icon, select the Display as Icon check box.

6. Click OK  to insert the object in SailWind Layout.

Related Topics
Object Linking and Embedding

Embedded Text Documents
You can embed a multi-line text document in your design instead of using the Text tool on the Drafting 
Toolbar to add multiple single lines of text. After the file is embedded, you can resize the object 
appropriately.

For instructions, see “Inserting OLE Objects in SailWind Layout”.

For this purpose, embedding is recommended over linking since the embedded document will reside 
inside the .pcb  file and cannot get lost or accidentally deleted, as an external file can. You can see a 
sample of an embedded text file in the preview.pcb  sample design. See the Notes section below the 
board outline. Double-click the text to activate the Microsoft Word document.

Please note the following restrictions:
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OLE Object Selection

• OLE objects cannot be plotted by a pen or photo plotter. They can only be printed.

• Plot OLE objects must be enabled in the Plot Options Dialog Box  to appear in the printout, but 
they will never be visible when viewing the Print Preview.

• OLE objects can be printed only by using a zero plot orientation.

Related Topics
Adding Free Text

OLE Object Selection
Selection of OLE objects in SailWind Layout operates differently than selection of other objects such as 
pads, nets, components and so forth.

The differences are:

• You cannot select more than one OLE object at a time.

• You cannot use area select to select OLE objects.

• Commands apply to selected OLE objects only, even if you also select SailWind Layout objects. 
OLE objects have selection priority over SailWind Layout components.

• OLE objects are always on top; to select SailWind Layout items under an OLE object, you must 
move the OLE object.

When you click on an OLE object in SailWind Layout, it behaves like a nontext item in a Word file. that is, 
it becomes a rectangular area with sizing handles to indicate that it is selected. (Sizing handles are small, 
black squares that appear at the corners and along the sides of a rectangular area surrounding a selected 
object.)

Right-click a selected OLE object to access a shortcut menu that lists all commands that you can apply to 
the OLE object.
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OLE Object Management
Managing OLE objects is similar to managing SailWind Layout objects. You can cut, copy, and paste OLE 
objects using the Cut, Copy, and Paste commands from the Edit menu.

Undo and Redo do not affect OLE objects, so use care when managing them.

Cutting, Copying, and Pasting an OLE Object
Toggling the Background Color of an OLE Object
Toggling Display of OLE Objects
Toggling an OLE Object’s Display Type
Moving an OLE Object
Resizing an OLE Object
Converting an OLE Object
Specifying an OLE Object’s Activation Type
Deleting OLE Objects

Cutting, Copying, and Pasting an OLE Object
You can cut or copy a linked or embedded object, and paste it.

Procedure
1. Copy or cut the OLE object as follows:

a. Select the OLE object.

b. Click Edit menu  > Copy  or Edit menu  > Cut.

2. Click the Edit  > Paste  menu item.

3. Relocate the pasted object as necessary.

Toggling the Background Color of an OLE Object
You can toggle the background color of an OLE object between the design background color and white.

Procedure
1. Select the OLE object.

2. Right-click, and click the White Background  popup menu item.

Toggling Display of OLE Objects
If you have many linked or embedded objects in your design, you can increase redraw speed by turning 
off OLE object display.
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Toggling an OLE Object’s Display Type

Procedure
1. Click the Tools  > Options  menu item > .Global  category > General  subcategory.

2. In the OLE Document Server area, select the “Display OLE Objects” check box.

Toggling an OLE Object’s Display Type
You can toggle an object’s display type between display as icon and display as the actual object.

Procedure
1. Select the OLE object.

2. Right-click and click the (Object_Type) > Convert  popup menu item.

3. In the Convert Dialog Box, click the Display as Icon check box.

Moving an OLE Object
Move OLE objects just as you move non-text objects in a Word document.

Procedure
1. Click and hold the left mouse button on the object.

2. Drag the object to the new location, and release the mouse button.

Resizing an OLE Object
You can resize OLE objects by dragging any of the sizing handles.

Procedure
1. Select the object.

2. Click and drag one of the sizing handles to resize the object. Sizing handles are small, black 
squares that appear at the corners and along the sides of a rectangular area surrounding a 
selected object.

3. Release the mouse button when the object is sized correctly.

Converting an OLE Object
You can convert an embedded OLE object to another object type. The types of object you can convert the 
OLE object to depends on the object’s source application.

Tip
Tip: You can also specify that an object remain as it is, but be activated as an object of a different 
type. See Specifying an OLE Object’s Activation Type.
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Procedure
1. Select the object.

2. Right-click and click the (Object_Type) > Convert  popup menu item.

3. In the Convert Dialog Box, click Convert to, and select the type to convert to from the Object Type 
list.

4. Click OK.

Specifying an OLE Object’s Activation Type
You can specify that an embedded object remain as it is, but be activated as an object of a different type. 
The types of object you can activate the OLE object as depends on the object’s source application.

Tip
Tip: You can also convert an object to a different type. See Converting an OLE Object.

Procedure
1. Select the object.

2. Right-click and click the (Object_Type) > Convert  popup menu item.

3. In the Convert Dialog Box, click Activate as, and select the type to activate the object as from the 
Object Type list.

4. Click OK.

Deleting OLE Objects
You can delete a single OLE object with the Delete key, or all of them using a special menu item.

Restrictions and Limitations
Undo and Redo do not affect OLE objects, so use care when managing them.

Procedure
1. If you want to delete all OLE objects in the design, click the Edit  > Delete All OLE Objects  menu 

item.

2. Otherwise, select the single OLE object to delete.

3. Press the Delete key.

Editing OLE Links
You can edit the link of a linked OLE object. Editing the link allows you to update the link, open the 
original object source, change the original object source, or break the link with the object source to make 
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Editing OLE Links
an embedded OLE object. You can also choose to update the object automatically or using a manual 
command.

Procedure
1. Click the Edit  > Links  menu item. The Links dialog box appears.

2. Click the link you want to edit from the list.

3. Click the options you want to use or modify.

4. Click Close  to close the Links dialog box. You cannot cancel changes you make in the Links dialog 
box.
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Open an OLE Object for Viewing or Editing
You can edit an OLE object’s content within SailWind Layout (known as in-place editing), or in a separate 
window. In either case, you edit its contents as you normally would using all of the source application's 
commands and tools.

See the documentation for the source application for more information on displaying, selecting, deleting, 
and saving SailWind Layout objects in container applications.

Viewing or Editing In Place in SailWind Layout
Viewing or Editing in a Separate Window

Viewing or Editing In Place in SailWind Layout
You can use an OLE object’s source application within SailWind Layout to view or edit the object.

Restrictions and Limitations

• Linked objects cannot be edited in place: they open in a separate window for viewing or editing.

• If the source application does not support viewing/editing within SailWind Layout, the object 
opens in a separate window.

Procedure
1. Double-click on the object.

2. Make the appropriate edits.

3. When you are finished editing, click outside of the object to end the edit session.

Results
Updates are automatically reflected in the object.

Viewing or Editing in a Separate Window
You can edit an OLE object outside SailWind Layout, in the source application.

Procedure
1. Ensure that the Update on Redraw check box in the Global tab  on page 1531 of the Options 

dialog box is checked.

2. Ctrl+double-click on the object.

3. Make the appropriate edits in the source application window.

4. When you are finished editing, click File  > Close and Return to  <design_file_name>. (This is the 
form of the command in MS Word. In other applications the command may be slightly different.)
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Saving OLE Objects

Results
Updates are automatically reflected in the object.

Saving OLE Objects
OLE objects are automatically saved as part of your design when you save a SailWind Layout design.

If you want to save OLE objects separately, use Export  on page 293 to save all the OLE objects in an .ole 
file. You can then use Import  on page 287 to import them into other designs.

Procedure
1. Click the File  > Export  menu item.

2. Click OLE Files (*.ole) from the Save as Type list.

3. Browse to the location for the new OLE file.

4. Type a name for the file.

5. Click Save.
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Chapter 43
Troubleshooting

The following topic explain how to deal with fatal design errors, powerpcb.reg  problems, and locked test 
point difficulties.

Repairing a Design with Fatal Errors
Warning: Test Point Locked Dialog Box
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Repairing a Design with Fatal Errors
When SailWind Layout encounters an unrecoverable problem, a fatal error warning with an error code 
appears.

The topics below explain what to do when you encounter a fatal database error, and steps you can take to 
recover lost data.

For related information, see also “Error Detection, BMW and BLT, Scripting and Macros”.

Recovering from a Fatal Error During File Open
Recovering from a Fatal Error During Normal Operation
Database Integrity Check During Normal Use

Recovering from a Fatal Error During File Open
If SailWind Layout crashes or displays a fatal error when you open a design, the design file may be 
corrupted. Before opening a Support Center service request, try to repair the file using the SailWind 
Router database integrity checking.

Procedure
1. Immediately after the fatal error occurs, create a new folder named <design_name>_save, 

and copy the damaged design file and its backups (Layout.pcb, Layou1.pcb, Layou2.pcb  and 
Layou3.pcb) to the new folder. (You may need to include these files as part of a Service Request.)

2. Open a standalone SailWind Router session, and open the damaged file. If the file does not open, 
Customer Support will need to review the design; exit this procedure and open a new Support 
Center service request including the files you saved in <design_name>_save. If the file opens, 
continue with Step 3.

3. Click File  menu > Save As, and save the file under a different name, with the .pcb  extension.

4. Close SailWind Router.

5. Open the new .pcb file in SailWind Layout. If the file does not open, Customer Support will need 
to review the design; exit this procedure and open a new Support Center service request including 
the files you saved in <design_name>_save. If the file opens, continue with the following step.

6. Export and re-import the design in ASCII format, as follows:

a. Click File menu > Export.

b. In the File Export dialog box, browse to an appropriate folder, name the new .asc file 
<design_name>_ascii.asc, and click Save.

c. In the ASCII Output dialog box,

i. Click Select All.

ii. Leave Expand Attributes unchecked.
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iii. From the Units list, select Basic.

iv. Click OK.

d. When the ASCII file is saved, click File  > New. (If prompted, accept the default start-up file, 
and click No to the “Save old file” prompt.)

e. Click File  > Import.

f. Browse to the <design_name>_ascii.asc  file you just exported, select it, and click Open. If an 
ascii.err file is displayed Customer Support will need to review the design; open a new Support 
Center service request including the files you saved in <design_name>_save. If no ascii.errfile 
is displayed, continue with Step 7.

7. Use one of the procedures described in Forward-Annotation of Design Changes from SailWind 
Logic  to compare the netlists of this .pcb  design and its associated schematic, and if necessary, 
update the .pcb. This restores any lost part or net connections to the .pcb.

8. The design is fixed; save the file as <design_name>_fixed.pcb.

Recovering from a Fatal Error During Normal 
Operation
If SailWind Layout crashes or displays a fatal error during normal operation, the .pcb  file may be 
corrupted. Before opening a Support Center service request, create copies of all files and run through 
some simple methods that may repair the design database.

Restrictions and Limitations
You cannot use this procedure to repair a design that fails to open. In that case, try to recover the file 
using the procedure in Recovering from a Fatal Error During File Open.

Tip
Several files are created in the following procedure; the procedure specifies locations and names 
for these files in order to ensure that you work with the proper file in each step.

Procedure
1. Exit from the fatal error message. The design is saved to the backup file and closed.

2. Immediately create a new folder named <design_name>_save,  and copy the damaged design file 
and its backups (Layout.pcb, Layou1.pcb,Layou2.pcb  and Layou3.pcb) to the new folder. (You may 
need to include these files as part of a Service Request.)

3. Create another new folder named <design_name>_repair  for the repair process files, and copy the 
damaged design file to the new folder as <design_name>_bad.pcb.

4. Restart SailWind Layout, and try to open <design_name>_bad.pcb. (Depending on the error, you 
may be able to open the file and continue.) If the file does not open, exit this procedure and use the 
procedure in Recovering from a Fatal Error During File Open. If the file opens, continue with Step 
5.
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5. Type the modeless command I and press the Enter key to run a database integrity check as 
described in Database Integrity Check During Normal Use.

6. Repeat the action that caused the error. If no errors/warnings appear, skip to Step 13. If errors/
warnings do appear, continue with Step 7.

7. Export and re-import the design in ASCII format, as follows:

a. Click File menu > Export.

b. In the File Export dialog box, browse to the <design_name>_repair  folder, name the new .asc 
file ascii_1.asc, and click Save.

c. In the ASCII Output dialog box,

i. Click Select All.

ii. Leave Expand Attributes unchecked.

iii. From the Units list, select Basic.

iv. Click OK.

d. When the ASCII file is saved, click File  > New. (If prompted, accept the default start-up file, 
and click No to the “Save old file” prompt.)

e. Click File  > Import.

f. Browse to the ascii_1.asc  file you just exported, select it, and click Open. If an ascii.err  file is 
displayed, exit this procedure and open a new Support Center service request including the 
files you saved in <design_name>_save. If no ascii.err  file is displayed, continue with Step 8.

8. Repeat the action that caused the error. If no errors/warnings appear, skip to Step 14. Otherwise, 
continue with Step 9.

9. Save the design as <design_name>_1.pcb, and close SailWind Layout.

10. Open and save the design in SailWind Router, as follows:

a. Start a standalone SailWind Router session, and open <design_name>_1.pcb. If the file does 
not open, Customer Support will need to review the design; exit this procedure and open a new 
Support Center service request including the files you saved in <design_name>_save. If the 
file opens, continue with step 10b.

b. Click File menu > Save As, and save the file as <design_name>_2.pcb.

c. Close SailWind Router.

11. Open <design_name>_2.pcb  in SailWind Layout. If the file does not open, Customer Support will 
need to review the design; exit this procedure and open a new Support Center service request 
including the files you saved in <design_name>_save. If the file opens, continue with Step 12.

12. Repeat the action that caused the error. If errors/warnings still appear, Customer Support will need 
to review the design; exit this procedure and open a new Support Center service request including 
the files you saved in <design_name>_save. If no errors/warnings appear, continue with Step 13.

13. Export and re-import the design in ASCII format, as follows:
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a. Click File menu > Export.

b. In the File Export dialog box, browse to an appropriate folder, name the new .asc  file 
<design_name>_ascii.asc, and click Save.

c. In the ASCII Output dialog box,

i. Click Select All.

ii. Leave Expand Attributes unchecked.

iii. From the Units list, select Basic.

iv. Click OK.

d. When the ASCII file is saved, click File  > New. (If prompted, accept the default start-up file, 
and click No to the “Save old file” prompt.)

e. Click File  > Import.

f. Browse to the <design_name>_ascii.asc  file you just exported, select it, and click Open. 
If an ascii.err  file is displayed, Customer Support will need to review the design; exit this 
procedure and open a new Support Center service request including the files you saved in 
<design_name>_save. If no ascii.err  file is displayed, continue with Step 14.

14. Use one of the procedures described in “Forward-Annotation of Design Changes from SailWind 
Logic” to compare the netlists of this .pcb  design and its associated schematic, and if necessary, 
update the .pcb. This restores any lost part or net connections to the .pcb.

15. The design is fixed; save the file as <design_name>_fixed.pcb.

Database Integrity Check During Normal Use
When you run the database integrity check with the modeless command I, SailWind Layout verifies that 
the values in the design database are within an acceptable range. If problems are encountered, you are 
prompted to confirm an automatic database correction.

After you use the automatic correction routine to fix the errors, you should run a set of interactive checks 
on the new database. These interactive checks include, but are not limited to:

• Clearance checks

• Comparing netlists

• Continuity checks

• Tie plane check

For instructions on how to run these checks see “Verify the Design”.
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Warning: Test Point Locked Dialog Box
A Warning dialog box appears when you modify vias, pins, or jumper pins that are locked test points, 
or clusters that contain test points, or routes that are connected to locked test points. The functions this 
warning dialog box performs vary, depending on whether you are modifying vias, pins, or routes.

The following topics discuss your options for handling locked test points during each of the following 
circumstances:

Modifying a Jumper Pin that is a Locked Test Point

Modifying a Pin that is a Locked Test Point

Modifying a Route Attached to a Locked Test Point

Modification of a Via or Virtual Pin That is a Locked Test Point

Move Sequential to Move Components, Unions, or Clusters with a Locked Test Point

Moving, Dispersing, or Aligning a Component, Cluster, or Union with a Locked Test Point
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Chapter 44
SPECCTRA Link

The SPECCTRA Link sends PCB design file data to a SPECCTRA design file, and then imports the 
SPECCTRA results back to a PCB design file. The Link features an automatic DO File editor to edit 
existing or new DO files. Parameters are automatically saved between sessions.

SPECCTRA translates route protection status, physical design reuses, test point settings on both vias 
and component pins, decal keepouts, board keepouts, and board cutouts. Route protection status is 
passed to and from SPECCTRA for routed traces and vias using SPECCTRA's fix attribute for wires 
and route attribute for vias. Protection for unrouted traces is passed to SPECCTRA only for whole 
connections, such as routed links that start and end on component pins. For more information, see Route 
Protection Status to SPECCTRA.

Unused Pins Net
Data Passed to SPECCTRA
SailWind Layout to SPECCTRA Rules Conversion
SPECCTRA Output File Location and Router Settings
Loading In and Out of SPECCTRA Automatically
Loading In and Out of SPECCTRA Manually
Translating Design Data from SailWind Layout to SPECCTRA
Translating Design Data from SPECCTRA to SailWind Layout
Setting SPECCTRA Options
Setting the SPECCTRA Automatic Startup Information
Creating or Editing a .do File
Setting up SPECCTRA .do File Startup Options
SPECCTRA and Split/Mixed Planes
Defining Split Planes Before Routing in SPECCTRA
Defining Split Planes After Routing in SPECCTRA

Unused Pins Net
SailWind Layout passes unused pins, or pins that are not connected to a net, to SPECCTRA. These pins 
and their fanouts are added to a net of unused pins called +UNUSED_PINS+ in SPECCTRA (this was 
formerly called *UNUSED_PINS*). When you return the routed design to SailWind Layout, you can also 
pass the unused pins and fanout information. The +UNUSED_PINS+ net information is translated into the 
NOT_CONNECTED net in SailWind Layout. You can change the name of the NOT_CONNECTED net in 
the SPECCTRA Options dialog box, but the net should have a unique name.

The NOT_CONNECTED net is a normal net inside SailWind Layout that contains the fanout via, the 
trace, and the unused pin. Because this net is a normal net in SailWind Layout, pins in it are no longer 
treated as unused pins in subsequent SPECCTRA sessions. Use the existing DO file to protect this net 
from being routed as a normal net in subsequent sessions. To recreate this net in SPECCTRA, delete it in 
SailWind Layout before routing the design.
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Tip
SailWind Layout cannot define a connection for a single pin net; therefore, if the +UNUSED_PINS
+ net contains only a single component pin and fanout, SailWind Layout cannot interpret it.

The figure below demonstrates fanouts on unused pins in SPECCTRA. It also demonstrates how 
SailWind Layout interprets those fanouts and unused pins. Because SPECCTRA now translates test 
point attributes on component pins as well as on vias, the following figure demonstrates how SPECCTRA 
passes test points assigned to the fanouts of the unused pins.

Figure 126. Fanouts on Unused Pins

Data Passed to SPECCTRA
You can pass DFT audit settings and keepouts to SPECCTRA.

DFT Audit Settings to SPECCTRA
You can pass DFT Audit test point placement options to SPECCTRA for its test point placement routine. 
SPECCTRA generally uses these options when applicable. Options such as test point clearances are 
passed to SPECCTRA. But options such as nail diameters and fixture drill sizes are used only by DFT 
Audit. Because they do not affect SPECCTRA's test point insertion, this type of information is not passed.

SPECCTRA bases its clearance calculations on DFT Audit options. SPECCTRA's clearance options are 
set in the Setup Test Point Rule area of the SPECCTRA DO File dialog box. For more information about 
DFT Audit, see “Design for Test”.

Tip
SPECCTRA does not allow assigning multiple test points to net. This setting is not passed to 
SPECCTRA.

Keepouts to SPECCTRA
The SailWind Layout to SPECCTRA Link supports via keepouts and passing other types of keepouts (for 
wires, bends, components, and pins) to SPECCTRA. Copper shapes on any level are passed in this way. 
By manipulating this existing keepout functionality, you can pass other specific keepouts to SPECCTRA.

SailWind Layout supports keepouts in the Layout Editor.

Slotted Holes to SPECCTRA
Non plated slotted holes are converted to keepouts on all layers. Plated slotted holes use a circular drill at 
the electrical center.
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Route Protection Status to SPECCTRA
You can set options in SailWind Layout that prevent modifying routed traces and vias in SPECCTRA. 
This feature protects critically placed routes during interactive routing and in batch routing in automatic 
routers. Protection is passed to and from SPECCTRA. Components, vias, test points, and other design 
items associated with protected routes or unroutes are also protected.

Protected Traces and Vias to SPECCTRA
Routed traces with protected status are passed to SPECCTRA with a fix attribute. You cannot modify 
fixed traces, and the router cannot route to this trace.

Vias attached to at least one protected trace are passed to SPECCTRA with a route attribute. Although 
you cannot modify these vias, you can route to them to complete a connection.

Table 139  lists the rules used by the SPECCTRA Link to determine via attributes.

Table  139. SPECCTRA Link Rules

Via has protected 
traces

Locked test point 
status Glue status SPECCTRA via status

Yes Any Any Route

No Yes Any Route

No No Yes Protect

No No No Normal (by default)

Protected, Unrouted Traces to SPECCTRA
Route protection status is passed to SPECCTRA only for those SailWind Layout unrouted traces that 
are whole connections, which start and end on component pins. Unrouted connections are passed to 
SPECCTRA as a fromto with a fix attribute.

Protected Components with Routed Traces to SPECCTRA
A component is passed to SPECCTRA with lock status as long as the component has at least one pin 
attached to a trace with route protection.

Receiving Protection Status for Routed Traces from SPECCTRA

• SPECCTRA wires that have a fix attribute are returned to SailWind Layout as traces with route 
protection.

• Vias with a protect attribute in SPECCTRA are transformed to glued status in SailWind Layout.

• Vias that have a route attribute in SPECCTRA are not given special protection in SailWind 
Layout.

Table 140  through Table 142  provide lists of the passing and returning protection status for SailWind 
Layout traces, vias, and unroutes.

SailWind Layout Guide and Reference 1003



SPECCTRA Link
Data Passed to SPECCTRA  

Table  140. Protection Status for Traces

Status in 
SailWind Layout

Status passed to 
SPECCTRA

Protection in 
SPECCTRA

Status 
passed from 
SPECCTRA

Status returned 
to SailWind 
Layout

Regular trace Normal type wire --- Normal type Regular trace

Regular trace Normal type Protect Protect type Regular trace

Regular trace Normal type Fix Protect type Regular trace

Protected trace Fix type --- Fix type Protected trace

Protected trace Fix type Protect/Unprot
ect

Fix type Protected trace

Protected trace Fix type Fix/unfix Fix type Protected trace

Table  141. Protection Status for Vias

Status of trace in SailWind Layout

Has 
Protected 
Traces

Locked 
TP status

Glued 
Status

Status passed 
to SPECCTRA

Protection in 
SPECCTRA

Status 
passed from 
SPECCTRA

Status 
returned to 
SailWind 
Layout

Yes Any Any Route Any Route Normal*

No Yes Any Route Any Route Normal*

No No Yes Protect --- Protect Glued

No No Yes Protect Unprotect Normal Normal**

No No Yes Protect Unfix Protect Glued

No No Yes Protect Fix, protect Protect Glued

No No No Normal --- Normal Normal

No No No Normal Fix, protect Protect Glued

* If defined in the original SailWind Layout design, the glue status of the via is lost. The test point is 
preserved by SPECCTRA and is returned to the SailWind Layout design.

** You can delete the via in SPECCTRA if the route, edit, or clean commands are performed in 
SPECCTRA after the Unprotect command.

Table  142. Protection Status for Unroutes

Type of Unroute in SailWind 
Layout

Passed to SPECCTRA 
as Returned from SPECCTRA as

Not protected unroute No special handling No special handling
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Table  142. Protection Status for Unroutes  (continued)

Type of Unroute in SailWind 
Layout

Passed to SPECCTRA 
as Returned from SPECCTRA as

Protected totally unrouted 
connection

Fromto type, Fix No special handling—not protected 
in SailWind Layout

Protected unroutes of partially 
routed connections

No special handling No special handling

Physical Design Reuses to SPECCTRA
Routes that are elements of a physical design reuse are passed to SPECCTRA with a fix attribute. 
Therefore, you cannot modify or route them. SPECCTRA only connects to vias and coppers in a physical 
design reuse if they are passed with a route attribute. Table 143  provides a summary of Physical Design 
Reuse Processing.

Table  143. Physical Reuse Processing

Reuse Element Passed to SPECCTRA 
as Returned from SPECCTRA

Component lock_type fix No(Warning issued; whether it 
has changed, or not, the new 
placement is not returned to 
SailWind Layout.)

Via type route No

Trace type fix No

Jumper lock_type fix No

Copper with netname type route No

Jumpers to SPECCTRA
You can pass jumpers to SPECCTRA. SPECCTRA will not attempt to route SailWind Layout jumpers.

Tip
Do not use SPECCTRA jumpers; they are not backward compatible.

SailWind Layout to SPECCTRA Rules 
Conversion
Design Rules are converted into one of two types of SPECCTRA rules using the keywords RULE and 
CIRCUIT. The type used in the conversion is indicated for each SPECCTRA rule.
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Routing, High-Speed, and Clearance Rules
Routing, high-speed, and clearance rules are supported for classes, nets, groups, and pin pairs. 
Additionally, as Table 144  shows, SailWind Layout default rules are passed when possible.

Table  144. Routing Rules

SailWind Layout Routing Rules SPECCTRA Routing Rules

Copper Sharing (rule (tjunction on/off))

Priority (circuit (priority #))

Selected Layers* (circuit (use_layer # # #))

Selected Vias* (circuit (use_via a b c))

*Selected Layer and Selected Via rules require the Advanced Rules option in 
SPECCTRA.

The Link passes default routing rules to SPECCTRA. Copper Sharing is passed at the PCB rule level.

The Link also passes Priority, Selected Layers, and Selected Vias by creating an artificial class containing 
all nets you did not assign to a class. This artificial class is named CLASS_nnnnnnn, where nnnnnnn is a 
number from 0 to 9999999. The default routing rules are then passed to SPECCTRA in this artificial class, 
as shown in Table 145.

Table  145. High-Speed Rules

SailWind Layout High-Speed Rules SPECCTRA High-Speed Rules

Min/Max Length (circuit (length max min) (type actual))

Stub Length (rule (max_stub #))

Match Lengths (circuit (match_fromto_length on/off) (tolerance dist))

Shielding w/Gap (circuit (shield on (use_net net)))(rule (shield_gap 
dist))Net must be a power net or SPECCTRA will fail 
on input.

Parallelism Length and Gap (rule (parallel_segment (gap dist) (limit dist)

The Link passes the default high-speed rules to SPECCTRA. It passes Parallel Length, Tandem Length 
and Gap, Stub Length, and Min/Max Length by creating an artificial class containing all nets you did not 
assign to a class. This artificial class is named CLASS_nnnnnnn, where nnnnnnn is a number from 0 to 
9999999. The high-speed rules are then passed to SPECCTRA in this artificial class.

Clearance Rules
As shown in Table 146, SPECCTRA accepts only one trace width per rule so the recommended width is 
passed.
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Table  146. Clearance Rules

SailWind Layout SPECCTRA

(rule(width dist)

Trace to Trace spacing (clearance dist (type wire_wire))

Via to Trace spacing (clearance dist (type via_wire))

Via to Via spacing (clearance dist (type via_via))

Pad to Trace spacing (clearance dist (type pin_wire))

Pad to Via spacing (clearance dist (type pin_via))

Pad to Pad spacing (clearance dist (type pin_pin))

Smd to Trace spacing (clearance dist (type smd_wire))

Smd to Via spacing (clearance dist (type smd_via))

Smd to Pad spacing (clearance dist (type smd_pin))

Smd to SMD spacing (clearance dist (type smd_smd))

Board to Trace spacing (clearance dist (type area_wire))

Board to Via spacing (clearance dist (type area_via))

Board to Pad spacing (clearance dist (type area_pin))

Board to SMD spacing (clearance dist (type area_smd))

Smd to Via same net (clearance dist (type 
smd_via_same_net))

Smd to Crn same net (clearance dist (type 
smd_to_turn_gap))

Pad to Crn same net (clearance dist (type 
pad_to_turn_gap))

Via to Via same net (clearance dist (type 
via_to_via_same_net))

Drill to Drill spacing (clearance dist (type drill_gap))

Body to Body spacing Unsupported

The Link passes default clearance rules to SPECCTRA at the PCB rule level.
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Tip
Copper is translated to a SPECCTRA keepout. In addition, a board outline is translated as a 
boundary. Both keepouts and boundaries use the area clearance mentioned above.

Specctra Text Translation
Text translates as a keepout. During generation of the SPECCTRA keepout, the maximum text clearance 
defined in the following clearance rules is used to expand the SPECCTRA keepout area to allow for the 
required clearance:

• Text-to-Trace spacing

• Text-to-Via spacing

• Text-to-Drill spacing

• Text-to-SMD spacing

Differential Pairs
SPECCTRA does not support minimum/maximum length directly for differential pairs. However, you can 
add these restrictions using routing rules applied to the pair of nets.

The following SPECCTRA syntax supports net pairs:

(pair (nets nm1 nm2 (gap dist)))

Pin pairs use the syntax:

(pair (wires nm1 nm2 (gap dist)))

Conditional Rules
Conditional rules are separated into two categories: high-speed and clearance. SPECCTRA can accept 
conditional rules for layers. However, any other rules can only be conditional if they use net classes. A 
class can contain only nets, not pin pairs or groups. Therefore, any conditional rule that includes a group 
or pin pair, and is a high-speed rule, cannot be passed to SPECCTRA.

Nets in conditional rules are automatically placed in dummy SPECCTRA classes using the naming 
convention NEW_CLASS_# as follows:

(class NEW_CLASS1 $$$2016)

High-Speed Conditional Rules
A high-speed conditional rule is converted like a non conditional high-speed rule, except that it must be of 
the form class vs. class, as follows:

### PADS Layout Conditional Rule ###
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(class_class

(classes CLASS_0 CLASS_1)

(rule (parallel_segment (gap dist) (limit dist)))

(rule (tandem_segment (gap dist) (limit dist)))

)

###############################

Clearance Conditional Rules
Conditional clearance rules must be of the form object vs. layer, as follows:

###########################

### PADS Layout Group Rule ###

(group GROUP_0

(fromto U2-2 U1-2

)

(fromto U4-9 U1-9

)

(fromto U3-10 U4-10

)

(layer_rule 1

(rule

(width dist)

(clearance dist (type wire_wire))
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(clearance dist (type via_wire))

etc.

Tip
Conditional rules vs. text are ignored. SPECCTRA does not recognize text.

SPECCTRA Output File Location and Router 
Settings
Use the Setup SPECCTRA Finish dialog box to specify output file locations and to set instructions for the 
SPECCTRA router regarding actions performed when routing is completed, such as running the mitering 
pass, running re-cornering, and insertion of test points.

Procedure
1. Click the File  > Export  menu item.

2. In the File Export dialog box, in the Save as type list, click SPECCTRA Files (*.dsn).

3. Browse to overwrite a file or type a new file name. Click Save.

4. In the SPECCTRA Link dialog box, click DO File.

5. In the SPECCTRA Do File dialog box, click Finish.

6. To indicate the wires file, type or browse to the location in the Wires File box.

7. To indicate the routes file, type or browse to the location in the Routes File box.

8. To indicate the session file, type or browse to the location in the Session File box.

9. Select the options you want for test points installed by SPECCTRA in the Test Points area. (For 
more information, see “Data Passed to SPECCTRA”, and the “Testpoint” topic in the SPECCTRA 
Help.)

10. Select a miter conversion type from the Miter area.

11. Select a recornering option from the Recorner area.

12. To remove crossover and clearance violations, click Delete Conflicts.

13. To eliminate notches and remove extra bends, click Critic.

14. To add extra space if there is room, click Spread  and type the spread value in the Extra box.

15. Select the type of data you want to include in the report from the Reports area.

16. To indicate the report file, type or browse to the location in the Report File box.
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17. Click Apply. The appropriate lines are added to your .do  file at the last pointer location.

Tip
To remove a line, select it in the .do  file in the Editor area and press the Delete key on your 
keyboard.

Loading In and Out of SPECCTRA 
Automatically
When you start SPECCTRA from within SailWind Layout, the SPECCTRA Link dialog box enables you to 
load in and out of SPECCTRA automatically.

If you set up the maximum number of vias in SailWind Layout, the SPECCTRA Link automatically passes 
them to SPECCTRA.

CAUTION:
If the maximum number of vias rule is not supported by the set of licensed SPECCTRA options 
you have enabled, SPECCTRA may ignore this rule or even disable autorouting.

The SPECCTRA Link passes various types of keepouts in SailWind Layout—such as placement, trace, 
and via keepouts— to SPECCTRA automatically: placement keepout (as place_keepout), trace keepout 
(as wire_keepout), and via keepout (as via_keepout).

Tip
If you want to have finer control of SPECCTRA, use the Stand-alone SPECCTRA Link dialog box 
to load in and out of SPECCTRA manually  on page 1012.

Procedure
1. On the File menu, click Export.

2. In the File Export dialog box, in the Save as type list, click SPECCTRA Files (*.dsn).

3. Browse to overwrite a file or type a new file name. Click Save.

4. In the SPECCTRA Link dialog box, type or browse for the .DO  file you want to use.

5. To create or edit the .DO  file, click DO File. For more information, see “Creating or Editing a .do 
File”.

6. To set the SPECCTRA automatic startup information, click Setup. (For more information, see 
“SPECCTRA Setup Dialog Box”  on page 1729.)

7. To specify output files (routes file and session file), type in their locations on the Setup SPECCTRA 
Finish dialog box. To access it, click DO File on the SPECCTRA Link dialog box, then click Finish 
on the SPECCTRA Do File dialog box and enter the file locations. (For more information, see 
“SPECCTRA Output File Location and Router Settings”.)
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8. To set options for sending via keepout information, passing advanced rules, setting a trace arc 
translation mode, or returning unused pins net, click Options. (For more information, see “Setting 
SPECCTRA Options”.)

9. Click Continue. The design loads into SPECCTRA and the router runs in batch mode.

When translation completes, the modified design file appears on the screen, loaded into a new 
SailWind Layout session (unless “Launch SailWind Layout session” is cleared in the Setup dialog 
box). The Link starts a new session so it does not interrupt any current sessions. If you run the 
router overnight, you can close the SailWind Layout session to save memory.

Loading In and Out of SPECCTRA Manually
If you start SPECCTRA independently of SailWind Layout, you can manually control the SPECCTRA 
interface. This gives you more control over how to use SPECCTRA. You can import from and export to 
SPECCTRA, and you can set instructions for the SPECCTRA router regarding actions performed when 
routing is completed (for example, running the mitering pass, running re-cornering, and inserting test 
points).

Tip
If you want to start SPECCTRA from within SailWind Layout, you use the SPECCTRA Link dialog 
box to load in and out of SPECCTRA automatically  on page 1012.

Procedure
1. If you are in SailWind Layout, save the .pcb  file.

2. Use Windows Explorer to navigate to your C:\<install_folder>\SailWind<version>\Programs 
directory, and double-click pads2sp.exe.

3. In the SPECCTRA Link dialog box, to set up the SPECCTRA automatic startup information, click 
Setup. (For more information, see “Setting the SPECCTRA Automatic Startup Information”.)

4. To translate the .pcb  file to SPECCTRA format click To SPECCTRA. The To SPECCTRA dialog 
box appears. (For more information, see “Translating Design Data from SailWind Layout to 
SPECCTRA”.)

5. Start SPECCTRA.

Tip
You can also launch SPECCTRA by checking the Startup SPECCTRA check box on the To 
SPECCTRA dialog box.

6. Use the File operations in SPECCTRA to load the translated design (.dsn) file.

7. When you are finished with SPECCTRA, to run the Link again to translate the output back to a 
.pcb  design file, click From SPECCTRA. (For more information, see “Translating Design Data from 
SPECCTRA to SailWind Layout”.)

8. Load the new .pcb  file into SailWind Layout.
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Translating Design Data from SailWind Layout 
to SPECCTRA
Use the To SPECCTRA dialog box to translate a .pcb  design file into a SPECCTRA design file.

Procedure
1. Use Windows Explorer to navigate to your C:\<install_folder>\SailWind<version>\Programs 

directory, and double-click pads2sp.exe.

2. In the SPECCTRA Link dialog box, click To SPECCTRA.

3. To indicate the file to send to SPECCTRA, type or browse to the location in the PCB File box.

4. To indicate the design file (.dsn) that SPECCTRA inputs, type or browse to the location in the 
Design File box.

5. To indicate the .do  file to send to SPECCTRA, type or browse to the location in the DO File box. 
The .do  file is the script file that controls SPECCTRA operation.

6. To indicate the output file (.did) that SPECCTRA creates, type or browse to the location in the Did 
File box. This file serves as an input .do  file in a subsequent SPECCTRA session.

7. To start SPECCTRA after the batch conversion is complete, click Startup SPECCTRA.

8. To create or edit the .DO  file, click DO File. (For more information, see “Creating or Editing a .do 
File.)

9. To set options for sending via keepout information, passing advanced rules, setting a trace arc 
translation mode, or returning unused pins net, click Options. (For more information, see “Setting 
SPECCTRA Options”.)

Translating Design Data from SPECCTRA to 
SailWind Layout
Use the From SPECCTRA dialog box to translate design data modified by SPECCTRA back into a .pcb 
design file.

Procedure
1. Use Windows Explorer to navigate to your C:\<install_folder>\SailWind<version>\Programs 

directory, and double-click pads2sp.exe.

2. In the SPECCTRA Link dialog box, click From SPECCTRA.

3. To indicate the routing information file that is returned by SPECCTRA after processing, type or 
browse to the location in the SPECCTRA Routes box. Include the command to write this file after 
autorouting at the end of the .do  file.

4. To indicate the placement and routing information file, type or browse to the location in the Session 
File box. You do not need to supply this file name if you did not use any of the SPECCTRA 
placement capabilities.
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5. To indication the original (source) .pcb  file, type or browse to the location in the Original PCB File 
box.

6. To indicate the file to be created from the SPECCTRA file, type or browse to the location in the 
New PCB File box.

7. To set options for sending via keepout information, passing advanced rules, setting a trace arc 
translation mode, or returning unused pins net, click Options. (For more information, see “Setting 
SPECCTRA Options”.)

Setting SPECCTRA Options
The Options dialog box appears when you click the Options button on the SPECCTRA Link dialog box, 
the TO SPECCTRA dialog box (stand-alone), or the FROM SPECCTRA dialog box (stand-alone).

This dialog box controls options for sending via keepout information, passing advanced rules to 
SPECCTRA, setting a mode for trace arc translation, and returning the unused pins net from SPECCTRA. 
(For more information, see “Unused Pins Net”.)

Procedure
1. On the File menu, click Export.

2. In the File Export dialog box, in the Save as type list, click SPECCTRA Files (*.do).

3. Browse to overwrite a file or type a new file name. Click Save.

4. In the SPECCTRA Link dialog box, click Options.

5. To send via keepout areas from your decals to SPECCTRA, select the layer you want from the 
Layer Containing Via Keepout Shapes list.

Tip
SailWind Layout fully supports keepouts in the Layout Editor. The preferred method to 
create a via keepout is to define keepouts in your decals.

6. To pass default Selected Layer and Selected Via rules to SPECCTRA, click Pass  Default 
Advanced Rules. These rules require the Advanced Rules option in SPECCTRA. Turn this option 
on if you have this SPECCTRA option; otherwise, leave this option off. (For more information, see 
“SailWind Layout to SPECCTRA Rules Conversion”.)

7. Select from one of three modes to perform trace arc translation:

To Single Segment — Replaces each trace arc with a single segment. This is the default mode.

To Multiple Segments — Replaces a trace arc with multiple segments. The original trace arc is 
divided into smaller arcs (equal to approximately 5 degrees) and then each smaller arc is replaced 
by a single segment. The result is a polyline of multiple segments instead of the arc.

To Quarter Arcs (QARCs) — Breaks existing arcs into quarter arcs and other segments. (Quarter 
arcs are arcs whose start and end points are exactly 0–90, 90–180, 180–270, and 270–360 
degrees.) The quarter arcs are translated to the SPECCTRA QARC structure. The remaining parts 
of arcs are translated to polylines.
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8. To return unused pin and fanout information to SailWind Layout, click Return UNUSED_PINS 
routing to SailWind Layout. Type the name of the net in the SailWind Layout design that will 
contain the unused pins. Provide a new name if you do not want to use the default.

The maximum netname length in SailWind Layout is 47 characters. You can use any alphanumeric 
characters except for brackets{ }, asterisks *, or spaces.

Clear this option to ignore unused pin and fanout information when returning to SailWind Layout.

Tip
SPECCTRA names the unused pins net +UNUSED_PINS+ while previous versions named 
it *UNUSED_PINS*. The SPECCTRA Link interprets both names.

Setting the SPECCTRA Automatic Startup 
Information
Use the SPECCTRA Setup dialog box to set SPECCTRA automatic startup information.

Procedure
1. On the File menu, click Export.

2. In the File Export dialog box, in the Save as type list, click SPECCTRA Files (*.do).

3. Browse to overwrite a file or type a new file name. Click Save.

4. In the SPECCTRA Link dialog box, click the Setup  button.

5. To indicate the executable needed to run SPECCTRA, type or browse to the location in the 
Executable box.

6. To indicate the password file needed to run SPECCTRA, type or browse to the location in the 
Password/Server box.

Tip
For teal key node-locked or floating licensing, point to your license server in the standard 
port@host format. For example, 7508@myserver.

7. To indicate the SPECCTRA message output file, type or browse to the location in the Message 
Output box.

8. To indicate the SPECCTRA status file, type or browse to the location in the Status box.

9. To indicate the SPECCTRA color mapping file, type or browse to the location in the Color Mapping 
box.

10. To disable the SPECCTRA graphic display and make SPECCTRA run faster, click No Graphics.

11. To close SPECCTRA after it processes the .do  file commands, click Quit After Do.

12. To delete all prerouted traces before entering SPECCTRA, click No Preroutes.
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13. To ignore copper without net assignments, which have no net association in SPECCTRA, click 
Don't Strip Orphan Shapes.

14. To convert one-inch square, or smaller, polygons to simple rectangles, click Simplify Polygons.

15. Select the licensing type you want: Floating, Node-locked with Flexid Key, or Node-locked with SSI 
key.

16. To reload the routed design back into SailWind Layout after it processes the .do  file commands, 
click Launch SailWind Layout session.

Creating or Editing a .do File
The .do  file is an editable batch script file, which controls SPECCTRA operation. You can add or edit 
command lines in a .do  file. When you start the editor, the .do  file you specify in the SPECCTRA Link 
dialog box is read for editing.

Procedure
1. On the File menu, click Export.

2. In the File Export dialog box, in the Save as type list, click SPECCTRA Files (*.do).

3. Browse to overwrite a file or type a new file name. Click Save.

4. In the SPECCTRA Link dialog box, do one of the following:

• To create a new file, type the name of the new .do  file in the DO File Name box and click DO 
File.

• To edit an existing file, type or browse to the name of the .do  file in the DO File Name box and 
click DO File.

5. The contents of the Setup and All areas change according to the options you select in the Setup 
area. Select the options you want and then click Apply to Editor  to write the information to the .do 
file. The commands appear in the Editor area.

• Order -change the original net ordering and control whether nets are routed in daisy-chain or 
starburst fashion. (For more information, see “Order” and “Choosing Starburst or Daisy-Chain 
Wiring” topics in the SPECCTRA Help.)

• Action - control wire rerouting, net routing, and the availability of connections, vias, and layers 
for autorouting. (For more information, see the “Protect/Unprotect”,” “Fix/Unfix,” and “Select/
Unselect” topics in the SPECCTRA Help.)

• Cost - control routing costs and override the autorouter internal cost table. (For more 
information, see the “Cost,” “Limit,” “Tax,” and “Using Standard Autorouting Commands” topics 
in the SPECCTRA Help.)

If you click Cost in the Cost area and Layer in the All area, options in the Type area appear. 
(For more information, see the “Type,” “Length,” “Way (Cost),” and “Way (Limit)” topics in the 
SPECCTRA Help.)
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• Test Point Rule - control passing DFT Audit test point placement options to SPECCTRA for its 
test point placement routine. (For more information, see “Data Passed to SPECCTRA”, and the 
“Testpoint” and “Testpoint Antennas” topics in the SPECCTRA Help.)

Table  147. SPECCTRA Link Dialog Box Options

Option Function

Insert Test Points Allows insertion of test points and makes the 
options in the Test Points area available.

Allow Points at Pins Allows placement of test points on component pins.
There is no equivalent in DFT Audit; test points are 
always allowed on pins.

Allow Antennas Allows antennas. Set a length.
There is no equivalent in DFT Audit.

Max Length Sets the length restriction for antennas. The default 
maximum length is negative one (-1), no length 
restriction.

Center to Center The distance between the centers of test points. 

Center to Comp Edge The distance between the center of 
the test point and the component 

outline.

Image Outline Clearance The clearance between the component outline and 
the test point carrier (via or component pin). If the 
Image Outline Clearance is negative, a zero (0) is 

set. 

Test Side Searches the specified side for test point 
placement.

Use Via Uses vias as test points.

Grid X, Y The test point grid.
For more information, see “Grid Options  on 
page 1537”.
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• All area - Limits actions to certain selected objects. The content of this area changes depending 
on the options you select in the Setup area.

• Only area - Limits actions to certain selected objects.

6. Use the Routing area to set fanout rules: direction, pin type, and maximum length, and to set the 
Bus direction and enter the number of passes for each type.

7. To autoroute your design based on how your design is converging, click Smart Route. For more 
information see the SPECCTRA Help.

8. To write the commands to the .do  file click Apply to Editor. The command appears in the Editor 
area.

9. Click Startup  to set the startup information. (For more information, see “Setting the SPECCTRA 
Automatic Startup Information”.)

10. Click Finish  and set the parameters in the Setup SPECCTRA Finish dialog box. (For more 
information, see “SPECCTRA Output File Location and Router Settings”.)

11. Click Apply  to save the parameters.

12. Click Save As  to save the file and enter a name for the file. This is optional.

13. Click Continue  to start the conversion and loading process.

Setting up SPECCTRA .do File Startup Options
Use the Setup SPECCTRA Startup dialog box to include a line referencing previously entered routes, 
saved in Wires or Best Save files, in your .do  file. SPECCTRA refers to these files upon startup. You can 
also include the name of the status file and parameters for Via at SMD, Seed Via, and Seed Via minimum 
distance.

For details on these files and functions see the SPECCTRA Design Language Reference PDF file 
spdlr.pdf  in the SPECCTRA group.

Procedure
1. Click the File  > Export  menu item.

2. In the File Export dialog box, in the Save as type list, click SPECCTRA Files (*.do).

3. Browse to overwrite a file or type a new file name. Click Save.

4. In the SPECCTRA Link dialog box, click DO File.

5. In the SPECCTRA DO File dialog box, click Startup.

6. To indicate the wires file, type or browse to the location in the Wires File box.

7. To indicate the status file, type or browse to the location in the Status File box.

8. To indicate the Best Save file, type or browse to the location in the Best Save box.

9. To allow vias at SMD pads, select On in the Via at SMD area. To ensure that the via is on a grid 
point select On in the Grid area. To ensure that the via fits within the pad, select On in the Fit area.
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10. To break up two-pin connections that are larger than a certain length, click Seed Via and type the 
length value in the Distance box.

11. Click Apply.

SPECCTRA and Split/Mixed Planes
If you plan to use SPECCTRA to fanout or otherwise route your power nets to their associated plane area 
polygons, read this important information before you define your plane polygons in SailWind Layout.

During the development of the split/mixed plane features in SailWind Layout, certain operational details 
were discovered about the way that SPECCTRA routing commands respect plane polygons. To achieve 
proper attachment of power nets to plane polygons in SPECCTRA, use one of the following split plane 
definition procedures. Following these steps will ensure the highest possible quality routing results from 
SPECCTRA.

• If you typically define split planes after you route your designs in SPECCTRA, see the “Defining 
Split Planes After Routing in SPECCTRA” topic.

• If you typically define split planes before you route your designs in SPECCTRA, see the “Defining 
Split Planes Before Routing in SPECCTRA” topic.

SPECCTRA translates split/mixed plane layers without routing, named copper, or plane polygons as 
power layers. SPECCTRA does not consider power layers as routing layers and, therefore, cannot route 
on these layers. This minimizes the layer count passed to the router. For example, you can route a four-
layer design with two power layers in a SPECCTRA configuration licensed for two routing layers.

SPECCTRA regards the entire plane as the area in which to connect component pins to all plane nets. 
The SPECCTRA fanout and route commands connect SMD component pins by routing short traces from 
the pins to vias to satisfy a connection to the plane.

For best results:

• Perform a multipass fanout of power pins before you execute multiple route passes by inserting 
the number of fanout passes in the command. For example, change "fanout (pin_type power)" to 
"fanout 5 (pin_type power)".

• Select the proper fanout options as defined in Creating or Editing a .do File.

• Avoid assigning design rules to nets that are associated with split/mixed plane layers. If design 
rules are present the design will not open in SPECCTRA. The SPECCTRA Link automatically 
removes or ignores design rules associated with split/mixed plane layers.

Routed Traces on SailWind Layout Split/Mixed Plane Layers
With SailWind Layout you can route traces on split/mixed plane layers. This is also possible in 
SPECCTRA, but the file is automatically adjusted to achieve the proper results in SPECCTRA. These 
changes result in behavior modifications of the routing commands in SPECCTRA, possibly causing 
unexpected routing patterns.
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Adjustments to the Design
SPECCTRA translates SailWind Layout split/mixed plane layers with routing or named copper as mixed, 
rather than power layers. Therefore, SPECCTRA routes on these layers, if necessary, to complete the 
design.

Behavior Changes in SPECCTRA
Mixed layers are translated as routing layers, increasing the layer count passed to SPECCTRA. For 
example, a four-layer design with two routing layers, one power layer, and one mixed layer is considered 
a three routing layer design and cannot be opened in a SPECCTRA configuration that is licensed for only 
two routing layers.

SPECCTRA considers plane polygons on mixed layers as areas available for connecting component 
pins to the plane net, but does not consider them obstacles to routing. Therefore, the fanout and route 
commands can add routes that pass through the plane polygons on SPECCTRA mixed layers.

Isolated instances of routing failure may occur. Failures may include the failure of the fanout command 
to connect pins to the plane polygons, or when the route command moves a connected plane net pin 
outside the area defined by the plane polygon, thus isolating the pin from the plane net.

To avoid the behavior changes, use one of the following procedures in your design process:

• Split the planes after routing. For more information, see “SPECCTRA and Split/Mixed Planes”.

• Unroute the offending traces before proceeding. Prior to passing the design to SPECCTRA, 
unroute any traces in the split/mixed layers. Remove any named copper. After routing in 
SPECCTRA completes and the design returns to SailWind Layout, reroute the traces you 
previously unrouted and restore the named copper shapes to the proper split/mixed layer.

Related Topics
Creating or Editing a .do File

Defining Split Planes Before Routing in 
SPECCTRA
When you can define your split planes before routing, you can use the advanced functionality of SailWind 
Layout and SPECCTRA to quickly route your split plane designs.

Procedure
1. Assign layers as split/mixed layer type: Before you can add split plane nets and data to a layer, 

you must assign the layer as split/mixed. (For more information, see “Layers Setup dialog box and 
Plane Layer Nets Dialog Box  on page 1640”.)

For best results, limit the assignment of split/mixed to internal, embedded plane players. Assigning 
external routing layers as split/mixed layers may produce unexpected results.

2. Define the plane polygons: Create split plane polygons for each net assigned to the plane layer 
using the steps described in “Creating a Plane Area” and “Auto Separate.”

With SailWind Layout you can define overlapping plane polygons, but plane flooding detects 
overlaps and automatically adjusts the plane fill area to eliminate overlaps. SPECCTRA does not 
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offer features to automatically adjust overlapping polygons and may produce unexpected results 
when large numbers of overlapping polygons are translated.

For best results:

• Define your planes using the Auto Separate command only. This eliminates the possibility of 
overlapping plane areas or plane area cutouts.

• If you prefer to create planes as polygon rectangles and circles, create the smaller polygons 
first and then add polygons around them rather than creating a larger polygon and embedding a 
smaller polygon within it.

3. Route the design in SPECCTRA: Once you assign the proper layer and net data for the plane 
layer, you can transfer the design to SPECCTRA. (For more information, see “Loading In and Out 
of SPECCTRA Automatically”.)

4. Flood the split/mixed plane polygons: After routing is completed in SPECCTRA and the design 
returns to SailWind Layout, flood the plane polygons.

5. Verify plane net continuity: After flooding the planes, verify the continuity of the plane nets. This 
process scans the plane polygons and route data and reports portions of nets disconnected from 
the plane polygons. For information on how to do this, see “Verify the Design”, “Plane Checking 
Setup”, “Creating a Copper Plane Manually”, “Creating a Copper Plane Automatically” and “Plane 
Checking Setup.”

Defining Split Planes After Routing in 
SPECCTRA
When your design process involves splitting planes after you route the design in SPECCTRA, you do this 
in SailWind Layout.

Procedure
1. Assign layers as Split/Mixed Plane Layer Type: Before you can add split plane nets and data to a 

layer, you must assign the layer as split/mixed. (For more information, see “Layers Setup Dialog 
Box” and Plane Layer Nets Dialog Box”.)

For best results:

• Do not define a plane area polygon for the split/mixed layer prior to autorouting in SPECCTRA. 
SPECCTRA considers that the entire plane layer belongs to all nets and provides short fanout 
traces for SMD pins connected to the plane nets.

• Limit the assignment of split/mixed to internal, embedded plane layers. Assigning external 
routing layers as split/mixed layers may produce unexpected results.

2. Route the design in SPECCTRA: Once you assign the proper layer and net data for the plane 
layer, you can transfer the design to SPECCTRA. (For more information, see “Loading In and Out 
of SPECCTRA Automatically”.)

3. Define the plane polygons: Create split plane polygons for each net assigned to the plane layer 
using the steps described in “Creating a Plane Area” and “Auto Separate.”
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Tip
If you want to pass this design to SPECCTRA again after you define split/mixed planes, 
see the information below. Also see Routed Traces on SailWind Layout Split/Mixed Plane 
Layers.

With SailWind Layout you can define overlapping plane polygons, but plane flooding detects 
overlaps and automatically adjusts the plane fill area to eliminate overlaps. SPECCTRA, however, 
does not offer features to automatically adjust overlapping polygons. SPECCTRA may produce 
unexpected results when large numbers of overlapping polygons are translated.

For best results:

• Define planes using Auto Separate only. This eliminates the possibility of overlapping plane 
areas or plane area cutouts.

• If you prefer to create planes as polygon rectangles and circles, create the smaller polygons 
first and then add polygons around them rather than creating a larger polygon and embedding a 
smaller polygon within it.

4. Flood the split/mixed plane polygons: After routing is completed and the design returns to SailWind 
Layout, flood the plane polygons.

5. Verify the plane net continuity: After flooding the planes, verify the continuity of the plane nets. This 
process scans the plane polygons and route data and reports portions of nets disconnected from 
the plane polygons. For information on how to do this, see “Verify the Design”, “Plane Checking 
Setup”, “Creating a Copper Plane Manually”, “Creating a Copper Plane Automatically” and “Plane 
Checking Setup.”
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Chapter 45
Error Detection, BMW and BLT, Scripting 

and Macros
The following topics discuss crash detection and the use of the Basic Media Wizard and Basic Log Test 
tools.

Crash Detection
BMW and BLT
Session Log Files
Session Media Files
Replaying Session Playback Media with BLT
The /BMW Command Line Switch
Scripting and Macros

Crash Detection
If crash detection is enabled, the Error Detected dialog box opens at a crash and allows you to save a 
report of the SailWind environment as well as pertinent files in a compressed Dump File. You can then 
submit this file to our Support Center for troubleshooting. You can attach feedback to this report, and 
optionally, the BMW media and project files.

The Error Detected Dialog Box  is inaccessible unless the software crashes and crash detection is 
enabled in the software .ini  file.

Crash detection is controlled by the CrashDetection switch in the .ini  file; it is turned off by default.

• If no CrashDetection switch exists in the [General] section of the .ini  file, or if the switch exists 
with a value of 0 (zero), then crash detection is turned off. No report is created of the environment 
at the time of the crash.

• If the CrashDetection switch exists in the [General] section of the.ini  file, with a value of 1, then 
crashes are detected and the Crash Detection dialog box appears.

SailWind Layout Guide and Reference 1023



Error Detection, BMW and BLT, Scripting and Macros
BMW and BLT  

BMW and BLT
BMW (Basic Media Wizard) and BLT (Basic Log Test) are tools that you can use to record and play back 
SailWind Logic, SailWind Layout and SailWind Router sessions. They are particularly useful as a means 
of supplying information to Technical Support engineers trying to identify and resolve any problematical 
behavior you may encounter.

If you report problematical behavior for one of the SailWind tools to Technical Support, Tech Support 
engineers may ask you to use BMW to record session playback media documenting the actions that 
caused the problem. The tech support engineers can then replay the session with BLT to help them 
identify and resolve the problem.

Creation of Session Playback Media With BMW
Creating Session Playback Media For a Normal Session
Automatically Creating Session Playback Media for a Crashed Session
Manually Creating Session Playback Media For a Crashed Session

Creation of Session Playback Media With BMW
A choice table can help to choose which method to use to create the session playback media.

To create session playback media, BMW session logging must be enabled when the problem occurs. 
If session logging was not enabled when you encountered the problem, you must recreate the actions 
that caused the problem in a new session with session logging enabled. Also, depending on whether the 
problem you want to document caused the SailWind tool to crash, you can create session playback media 
based on either the current or the immediately previous SailWind tool session.

The following table specifies which of the procedures described below you must use to create session 
playback media.

Was logging
enabled?

Did the SailWind
tool crash?

Then use this procedure.

Yes No Creating Session Playback Media For a Normal Session

No No Creating Session Playback Media For a Normal Session

Yes Yes Automatically Creating Session Playback Media for a Crashed 
Session

No Yes Manually Creating Session Playback Media For a Crashed 
Session

Creating Session Playback Media For a Normal 
Session
You can record a SailWind Layout session even though the tool did not crash.
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Automatically Creating Session Playback Media for a Crashed Session

Procedure
1. Start the SailWind tool, but do not open the file in which you encountered the problematical 

behavior. (You must enable session logging before you open the file.)

2. Type the modeless command BMW ON and press the Enter key to enable session logging. 
Logging remains enabled for this and all future sessions until you disable it with the BMW OFF 
command.

3. Open the file in which you encountered the problematical behavior.

4. Perform the series of actions that produced the problematical behavior. The series of actions, as 
well as changes to the board or to the configuration, are stored in the Session Log Files  for the 
current session.

5. Type the BMW modeless command and press the Enter key.

6. In the Media Wizard dialog box, click Create Media from Current Session.

7. Type your initials in the User Initials text box. (They are included in the playback media filenames 
to identify the files as yours.)

8. To delete all entries in the session log file between the first Open and the last Save command, click 
Delete Actions Before Last Save. You can do this to eliminate any actions you may have performed 
before beginning the series of actions that produced the problematical behavior. This makes it 
easier for the Tech Support engineer to identify the problem.

9. Click OK  to create the Session Media Files.

Automatically Creating Session Playback Media for 
a Crashed Session
In certain conditions, you can automatically record a SailWind Layout session that caused the software to 
crash.

If you are affected by the restrictions listed below, see “Manually Creating Session Playback Media For a 
Crashed Session”  on page 1026.

Restrictions and Limitations

• This procedure works only if the previous (crashed) session started with BMW logging already 
enabled and logging remained enabled throughout the session.

• This procedure does not give useful results if any additional instance of the SailWind tool ran 
concurrently (for any period) with the previous (crashed) session.

Procedure
1. Start the SailWind tool, but do not open the file in which you encountered the problematical 

behavior. (You must enable session logging before you open the file.)

2. Type the modeless command BMW ON and press the Enter key to enable session logging. 
Logging remains enabled for this and all future sessions until you disable it with the BMW OFF 
command.
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3. Open the file in which you encountered the problematical behavior.

4. Perform the series of actions that produced the problematical behavior. The series of actions, as 
well as changes to the board or to the configuration, are stored in the Session Log Files  for the 
current session.

5. After the crash, restart the SailWind tool. A dialog box is displayed asking if you want to save 
media files for the crashed session. Click Yes  to create the Session Media Files.

Manually Creating Session Playback Media For a 
Crashed Session
You can manually create session playback media for a crashed session.

Use this procedure when the session you are recreating caused the SailWind tool to crash, and the 
automatic procedure described in “Automatically Creating Session Playback Media for a Crashed 
Session” cannot be used due to one of the listed restrictions.

Procedure
1. Start the SailWind tool, but do not open the file in which you encountered the problematical 

behavior. (You must enable session logging before you open the file.)

2. Type the modeless command BMW ON and press the Enter key to enable session logging. 
Logging remains enabled for this and all future sessions until you disable it with the BMW OFF 
command.

3. Open the file in which you encountered the problematical behavior.

4. Perform the series of actions that produced the problematical behavior. The series of actions, as 
well as changes to the board or to the configuration, are stored in the Session Log Files  for the 
current session.

5. After the crash, restart the SailWind tool.

6. Type the BMW  modeless command and press the Enter key.

7. In the Media Wizard dialog box, click Create Media from Previous Session.

8. Type your initials in the User Initials box to identify your session playback media files.

9. Click OK  to create the Session Media Files.

Session Log Files
Whenever BMW session logging is enabled, two sets of session log files are maintained in the \SailWind 
Projects  folder. These logs record actions performed in the current session, and in the immediately 
previous session.

BMW names these files as follows:

Current Session Log Files            Previous Session Log Files

<pads_tool>_Next.log           <pads_tool>_NextBak.log

<pads_tool>_Next.reg          <pads_tool>_NextBak.reg
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Session Media Files

<pads_tool>_Next.ini          <pads_tool>_NextBak.ini

These files are dynamic; each time you start a session, the current session log files are renamed as the 
previous session log files, and new current session log files are created. The contents of the old previous 
session log files are lost.

Whenever you elect to create session media files for a session, the appropriate set of these log files is 
saved in a permanent location, as described in Session Media Files.

Tip
You may see a log file named <pads_tool>_Session.log  listed in the \SailWind Projects  folder. 
This file is unrelated to the session playback media created by BMW.

Session Media Files
Each time you create session playback media, BMW creates a new session media folder in the \SailWind 
Projects  folder, and copies into it the .pcb file and the Session Log File for the session. BMW then 
renames these files based on the session media folder name.

The session media folder is named <month><day><initials><sequential letter>, where:

• <month><day> is the date.

• <initials> are letters you type in the Media Wizard dialog box to personalize the media files.

• <sequential letter> is a letter automatically assigned to sequence the directories created on a 
specific date.

Example:  \SailWind Projects\0530jsb  represents a session media folder created on May 30, using the 
initials js, and that was the second session media folder created on that day.

When creating the session playback media, the following files are written to the session media folder:

Related Topics
Session Log Files

Replaying Session Playback Media with BLT
You can use BLT to replay session playback media created by BMW.

Procedure
1. Type the BLT modeless command, and press the Enter key.

2. Select the session playback media from the Media Directories list and click OK.

Results
The session is replayed.
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Tip
To personalize the media folder and session playback media file names, select a media session 
from the Media Directories list, type the new name into the New name box, and then click 
Rename.

The /BMW Command Line Switch
You can use a command line switch in the startup options of the software if you want to automatically 
record every SailWind Layout session.

If you want BMW to automatically prompt you to create media from the previous session each time you 
start a SailWind tool, open the SailWind tool using the /BMW command line switch. Or use /BMW-xx 
(where xx represents your initials, which are used in folder and file names to identify them as yours).

When you use BMW as a command line option, it creates media of the previous session; use the BMW 
modeless command to create media of your current session.

Scripting and Macros
All scripting and macro documentation has been moved.

It can be found in the SailWind Layout Command Reference Manual.
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Chapter 46
GUI Reference Elements A

Read the sections that follow to learn more about dialog box elements in SailWind Layout.

3D Clearances Dialog Box
3D Display Control Window
3D Display Control Window in the Decal Editor
Add BGA Pin Labels Dialog Box
Add/Edit Document Dialog Box
Add Chamfered Path Dialog Box
Add Class Tasks Dialog Box
Add/Edit Command Dialog Box
Add Component Bond Pad Dialog Box
Add Die Parts Dialog Box
Add Drafting Dialog Box
Add Free Text Dialog Box
Add Net Tasks/Add Class Tasks Dialog Box
Add Net to Class Dialog Box
Add New Attribute to Library Dialog Box
Add New Decal Label Dialog Box
Add New Part Label Dialog Box
Add Pin Dialog Box
Add Pin Pairs to Group Dialog Box
Add Pins Dialog Box
Add Substrate Bond Pad Dialog Box
Add/Rename SBP Ring Dialog Box
Add Terminals Dialog Box
Align 3D Models Dialog Box
Align 3D Model Dialog Box
Align Parts Dialog Box
Archiver Dialog Box
Archiver - Additional Files Dialog Box
Archiver - Libraries Dialog Box
Arrow Properties Dialog Box
ASCII Output Dialog Box
Assembly Variants Dialog Box
Assign CBPs to Rings Dialog Box
Assign Color to All Layers Dialog Box
Assign Color to Net Dialog Box
Assign Color to Netlist Dialog Box
Assign Decal to Gate Dialog Box
Assign Net to Selected Polygon Dialog Box
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Assign New Gate Decal Dialog Box
Assign New PCB Decal Dialog Box
Assign Pin Numbers Dialog Box
Assign Shortcut Dialog Box
Attribute Dictionary Dialog Box
Attribute Manager Dialog Box
Attribute Properties Dialog Box, Objects Tab
Attribute Properties Dialog Box, Types Tab
Auto Placement Prompt
AutoRenumber Dialog Box
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3D Clearances Dialog Box
To access: Open the SailWind 3D window (View > SailWind 3D), then click the 3D clearances button 

.

Use the 3D Clearances dialog box to define additional clearances for the 3D models in your design. 
SailWind Layout performs a clearance check using the additional values when you click the SailWind 3D 
window Design Rule Check button.

Objects

Field Description

Specify clearances between objects 
table

Defines the optimal and minimum allowable clearances in the X, 
Y, and Z axes between two design objects in the 3D View.
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Field Description

Use the buttons to create  or delete  additional object 
clearance definitions.
You can add a new general rule to the 3D clearances dialog 
box; for instance, you can specify a 5 thousandths minimum 
clearance between all parts (components) and the board 
edge. Alternatively, you can specify a specific clearance for an 
individual part, board, mechanical component, or assembly to 
allow it to exceed a general clearance rule.
For example, if you have connector P2 that extends over 
the edge of the board (thereby violating a previously defined 
component-to-board-edge rule of 5 thousandths), select the 
connector in the SailWind 3D window. In the 3D Clearances 
dialog box, find the part listed as “Component: P2” in the 
From/To dropdown lists. You can then define a new 3D XY 
clearance of “0” (effectively removing the clearance constraint) to 
allow it to extend beyond the edge of the board.

From/To: Select the desired object from the dropdown lists to define the 
associated pairing clearance:

• Assembly  — The physical packaging or enclosure in which 
the active board (PCB) resides.

• Board  — Any part of the board surface, including the board 
edge.

• Board Edge  — Any edge of the board; includes the edge 
from the board outline as well as an edge formed by 
through-cutouts, contours, mounting holes, and cavities.

• Component  — Any imported mechanical model that is 
designated a “Component” type through the Mechanical 
Model Properties Dialog Box.

• Mechanical  — Any imported mechanical model that is 
designated a “Mechanical” type through the Mechanical 
Model Properites dialog box.

• PCB  — Any imported mechanical model that is designated a 
“PCB” type through the Mechanical Model Properties dialog 
box.

Minimum XY

 Note:
If online DRC is enabled, when 
the clearance of an object is less 
than the minimum, the object 
turns red.

Defines the minimum allowable clearance in both the X and Y 
direction (in thousandths) from one object to another.
This value cannot exceed the Optimal XY clearance value. If 
the Minimum XY value is set greater, the Optimal XY value 
automatically updates to match it.

Minimum Z

 Note:
If online DRC is enabled, when 
the clearance of an object is less 
than the minimum, the object 
turns red.

Defines the minimum allowable clearance in the Z direction (in 
thousandths) from one object to another.
This value cannot exceed the Optimal Z clearance value. 
If the Minimum Z value is set greater, the Optimal Z value 
automatically updates to match it.
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Field Description

Optimal XY

 Note:
If online DRC is enabled, when 
the clearance of an object is less 
than the optimal, the object turns 
yellow.

Defines the ideal clearance in both the X and Y direction (in 
thousandths) from one object to another.

Optimal Z

 Note:
If online DRC is enabled, when 
the clearance of an object is less 
than the optimal, the object turns 
yellow.

Defines the ideal clearance in the Z direction from one object to 
another.
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3D Display Control Window
To access: SailWind 3D window  > 3D General Toolbar  > 3D Display Control button

Manage the view options and change the color and transparency of component and mechanical models.
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3D Display Control Window

Objects

Area Field Description

Options

Discard Tiny Objects Hides small objects when zoomed out.

Dynamic Highlight Highlights components and mechanical models as the cursor hovers 
over top.

Drive 2D View Changing the view and zoom in the 3D view drives the 2D view also.

Follow 2D View The 3D view follows changes of the view and zoom in the 2D view.

Faster View Manipulation Temporarily hides small models and objects like vias and traces during 
movements (such as panning or zooming) to make the 3D manipulation 
faster.

Glued Markers A purple pyramid-shaped marker displays over glued components at all 
times. Letter indicators (G) also appear on each facet of the marker (the 
L is short for locked).

Force Opaque Overrides the transparency settings of everything to which a color is 
assigned.

Include Internal Layers Displays internal layers in the 3D view.

Mechanical Model 
Selection

Allows selection of mechanical models. For example, allows selection 
of a semi-transparent enclosure placed atop components on the PCB.

Origin Marker Displays the origin as a double cone shape - helps to locate the origin 
on the x,y, and z axes.

Overlay 3D Models with 
2.5D

Displays 3D step models and 2.5D (extruded models created from the 
placement outline and the Geometry.Height attribute). Provides a quick 
check if the 3D step model matches what’s expected.

Perspective Helps with depth perception by adding a vanishing point behind the 3D 
image. Close objects appear larger and farther objects appear smaller 
when you tilt away from Top view.

Photorealistic Shows a lifelike color of copper.

Shadow Adds a drop shadow.

Wireframe Displays everything with outlines, similar to outline mode in the 2D 
view.

Z-Axis Scaling Adds an exaggerated spacing between layers of the board stackup 
to review internal structures such as buried vias. Does not affect 
the measurement tools which report true values. Hides Assemblies, 
Mechanicals, and PCBs to prevent visual collisions of 3D structures for 
better viewing of the board. Lists of those objects in this dialog are also 
unavailable.
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Area Field Description

Scale Factor — Specifies the multiplication factor for visual extrusion of 
the board stackup.

 Note:
To view the barrels of your vias, you must also select the “Holes” 
and “Via Pads” check boxes.

Objects

Board Displays board outlines and cut outs. You can set the board color and 
transparency level by clicking the color tile next to the check box.

Component Pads Displays pads and drills of through hole pads.

Fiducials Displays global fiducials. Fiducials are defined as parts with a single 
surface mount pad (zero drill size) and one or more of the following is 
true:

• It is not an ECO registered part.

• It has an attribute named Fiducial with no value.

If opposite side fiducials are required, you will need to add a second 
fiducial on that other side of the board.

Holes Displays the holes in the PCB such as the holes in vias and holes in 
through-hole pins.

 Note:
To display the vias, you must also select the “Via Pads” check box.

Placement Keepouts Displays the Placement keepout as an obstruction with height to 
represent the keepout area. Takes into account any allowed height 
value underneath it. Placement keepouts set to <All Layers> are not 
displayed. If a keepout is both a Placement and “Routing” keepout, it 
takes priority as a placement keepout and is its visibility is controlled by 
the Placement Keepout check box.

Route Keepouts Displays Trace and Copper, Copper plane, Via and jumper, and Test 
point keepouts. Internal layer keepouts are not displayed. If a keepout 
is both a Placement and “Routing” keepout, it takes priority as a 
placement keepout and is its visibility is controlled by the Placement 
Keepout check box.

Traces Displays traces and copper.

Via Pads Displays via pads. (To display the holes in your via pads, you must also 
select the “Holes” check box.)

Copper Planes Displays copper planes. Changes to this setting do not appear 
automatically. You must use the adjacent Refresh button or the Refresh 
button on the 3D View toolbar.

Silkscreen Toggles the display of objects on the silkscreen layer. The objects 
shown for silkscreen in 3D are based on the settings in your silkscreen 
CAM documents. If you have not yet defined silkscreen CAM files, 
the default settings for silkscreen are used. Objects located outside 
the board outline are not shown in SailWind 3D unless they are 
partially inside the board outline. Changes to this setting do not appear 
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Area Field Description
automatically. You must use the adjacent Refresh button or the Refresh 
button on the 3D View toolbar.

Solder Mask Toggles the display of the solder mask layer. The objects shown for 
silkscreen in 3D are based on the settings in your silkscreen CAM 
documents. If you have not yet defined solder mask CAM files, the 
default settings for solder mask are used. Text on solder mask layers 
is shown as cut outs in the solder mask. Objects located outside 
the board outline are not shown in SailWind 3D unless they are 
partially inside the board outline Changes to this setting do not appear 
automatically. You must use the adjacent Refresh button or the Refresh 
button on the 3D View toolbar.

Components
Defines the appearance of design components added to the list. Select the Components check box to 
make all components visible (if you clear the check box, you cannot make components in the list visible 
individually).

Add Selected Adds the selected components to the list so you can customize their 
appearance. You can also use the Add button to choose from a list of 
design components.

Add Opens the Components dialog box where you can choose components 
to add from a list, by reference designator, instead of by selecting them 
in the view. Deletions can also be performed in this dialog.

Appearance • Color tile  — Click to assign a custom color, and/or transparency to 
the photo-realistic or custom color. A letter P appears in the color tile 
until you decide to override the photo-realistic color with a custom 
color.

• Check box  — Enables the custom appearance assigned in the 
adjacent color tile.

Visibility check box Displays the component in the 3D view.

Assemblies
Defines the appearance of assembly objects. After importing the model, you assign the model to this type in 
the Mechanical Model Properties. You must then add the model to the list. Right-click an item to remove it or 
remove all items from the list. This section is unavailable when the Z-Axis Scaling check box is selected.
Select the Assemblies check box to make all assemblies visible (if you clear the check box, you cannot make 
assemblies in the list visible individually).

Add Selected Adds the selected assembly type models to the list so you can 
customize their appearance. You can also use the Add button to choose 
from a list of imported models that are set to the Assembly type.

Add Opens the Assemblies dialog box where you can choose models to 
add from a list instead of by selecting them in the view. Deletion is also 
performed in this dialog.
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Area Field Description

Appearance • Color tile  — Click to assign a custom color, and/or transparency to 
the photo-realistic or custom color. A letter P appears in the color tile 
until you decide to override the photo-realistic color with a custom 
color.

• Check box  — Enables the custom appearance assigned in the 
adjacent color tile.

Visibility Displays the assembly in the 3D view.

Mechanicals
Defines the appearance of mechanical objects. After importing the model, you assign the model to this type 
in the Mechanical Model Properties. You must then add the model to the list. Right-click an item to remove it 
or remove all items from the list. This section is unavailable when the Z-Axis Scaling check box is selected.
Select the Mechanicals check box to make all mechanical objects visible (if you clear the check box, you 
cannot make mechanical objects in the list visible individually).

Add Selected Adds the selected mechanical type models to the list so you can 
customize their appearance. You can also use the Add button to choose 
from a list of imported models that are set to the Mechanical type.

Add Opens the Mechanicals dialog box where you can choose models to 
add from a list instead of by selecting them in the view. Deletion is also 
performed in this dialog.

Appearance • Color tile  — Click to assign a custom color, and/or transparency to 
the photo-realistic or custom color. A letter P appears in the color tile 
until you decide to override the photo-realistic color with a custom 
color.

• Check box  — Enables the custom appearance assigned in the 
adjacent color tile.

Visibility Displays the mechanical object in the 3D view.

PCBs
Defines the appearance of PCB models. After importing the model, you assign the model to this type in the 
Mechanical Model Properties. You must then add the model to the list. Right-click an item to remove it or 
remove all items from the list. This section is unavailable when the Z-Axis Scaling check box is selected.
Select the PCBs check box to make PCB models visible (if you clear the check box, you cannot make PCB 
models in the list visible individually).

Add Selected Adds the selected PCB type models to the list so you can customize 
their appearance. You can also use the Add button to choose from a list 
of imported models that are set to the PCB type.

Add Opens the PCBs dialog box where you can choose models to add from 
a list instead of by selecting them in the view. Deletions can also be 
performed in this dialog.
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Area Field Description

Appearance • Color tile  — Click to assign a custom color, and/or transparency to 
the photo-realistic or custom color. A letter P appears in the color tile 
until you decide to override the photo-realistic color with a custom 
color.

• Check box  — Enables the custom appearance assigned in the 
adjacent color tile.

Visibility Displays the PCB in the 3D view.

3D Display Configurations
You can save 3D display settings. Press the Save button at the bottom of the window and provide a name for 
the saved settings. The configuration is saved and the name is added to the list beside the Save button for 
recall when needed. All settings are saved except the design items listed under Components, Assemblies, 
Mechanicals, PCBs. Choose a configuration and click the Delete button to delete the configuration from the 
list.
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3D Display Control Window in the Decal Editor
To access: In the Decal Editor, SailWind 3D window  > 3D General Toolbar  > 3D Display Control 
button

Set various options to manage the view in the SailWind 3D window and control what it displays.

Objects

Object Description

Options • Dynamic Highlight  — Highlights components as the cursor hovers over 
top.

• Drive 2D View  — Changing the view and zoom in the 3D view drives the 
2D view also.

• Follow 2D View  — The 3D view follows changes of the view and zoom in 
the 2D view.

• Origin Marker  — Display the origin as a double cone shape. Helps to 
locate the origin on the x,y, and z axes.

• Overlay 3D Models with 2.5D  — Displays 3D step models and 
2.5D (extruded models created from the placement outline and the 
geometry.height attribute). Provides a quick check if the 3D step model 
matches what’s expected.

• Perspective  — Helps with depth perception by adding a vanishing point 
behind the 3D image. Close objects appear larger and farther objects 
appear smaller when you tilt away from Top view.
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Object Description

• Photorealistic  — Shows true color of copper.

• Wireframe  — Displays everything with outlines, like outline mode in the 
2D view.

Objects • Component Pads  — Enables the display of pads.

• Pin Numbers - 2D  — Enables the display and custom coloring of decal 
pin numbers.

• Pin Numbers - 3D  — Enables the display and custom coloring of 3D 
model pin numbers, if they exist.

3D Display 
Configurations

You can save 3D display settings. Press the Save button at the bottom of 
the window and provide a name for the saved settings. The configuration 
is saved and the name is added to the list beside the Save button for recall 
when needed. Choose a configuration and click the Delete button to delete 
the configuration from the list.
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Add BGA Pin Labels Dialog Box
To access: BGA Toolbar button > Wire Bond Diagram button > select a BGA pin

Use the Add BGA Pin Labels dialog box to label the die part's substrate bond pad. Usually, labels match 
the name of the BGA pin to which they are connected.

Description

• You can select the pads individually, by group, or by die part.

• Selecting a die part lists all pins in the Connection multicolumn list.

• The substrate bond pad of the selected die part is highlighted in the Die Pin# column. The BGA 
pin labels are listed in the BGA Pad column.

Objects

Field Description

Die Component Displays the component name.

BGA Component Lists the BGA components available.
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Field Description

Connection list • Die Pin #  — Displays the substrate bond pad of the selected die 
part.

• BGA Pad  — Lists the BGA pin labels.
 Tip
Double-click to edit the label.

Opens the Pads for Die Pin Dialog Box.

 Restriction:
Available only after double-clicking in the BGA Pad cell of the 
Connection list.

Show only pins connected to 
multiple BGA pads

Specifies to display only die pins that are connected to multiple BGA 
pin pads in the Connection  list.

Font The fonts available to you.

 Tip
• Select stroke font or a system font.
• For system fonts, you can also click a font style button, or any 

combination of styles: B for bold, I for italic, or U for underlined.

Layer The layers available to you on which to place the text.

Size Specifies the size of the font.
Size (pts):  This is font size in points and appears for system fonts
Size (mils):  This is font character height and appears for stroke fonts. 
The size refers to the height of the tallest characters.

Line Width Specifies the line width for stroke fonts only.

Related Topics
Adding BGA Pin Labels
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Add/Edit Document Dialog Box
To access:

• File  > CAM  menu item > Add

• File  > CAM  menu item > select a document name > Edit  button

Use the Add Document or the Edit Document dialog box to define a CAM document. The Add Document 
and Edit Document dialog boxes are identical except the Edit CAM Document dialog box opens populated 
with the information from the selected document, while the ADD CAM Document dialog box opens empty.

Objects

Field Description

Document Name The name of the CAM document.
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Field Description

Document Type When you add a CAM document, you must select the type of CAM 
document that you want to create. Each CAM document type has a 
specific set of options.

 Tip
The default settings of the CAM document types may not suit your 
decal layer usage. Always verify the document in the CAM Preview 
window to ensure that all necessary design elements are displayed 
for the type of document you are generating.

• Custom  — Create your own definition for a document. Use the 
Select Items Dialog Box  to specify which objects appear in the 
document.

• CAM Plane  — Document CAM Plane layers. CAM planes are 
always solid copper planes in SailWind Layout. To improve visibility 
in the work area, CAM planes are negative images and take on the 
background color of SailWind Layout. In the CAM Preview window 
options, you can invert the negative image of the CAM document. 
By default, conductive elements appear white in the CAM Preview 
window. Layer 25 (125 in extended layer mode) is frequently used 
for CAM plane objects where added copper is the opposite - not 
copper (negative layer). Layer 25 can also be used for defining the 
oversize of thermals and antipads (an old method), however, the 
CAM Plane custom thermal setting in the Plot Options Dialog Box  is 
a better method. Use the Select Items Dialog Box  to add layer 25 if 
needed.

• Routing/Split Plane  — Document layers that contain plane areas 
and/or routing. Use this type for Split/Mixed and No Plane layers. 
Conductive elements appear black in the CAM Preview window.

• Silkscreen  — Document top and bottom silkscreen layers. 
Layer 20 (120 in extended layer mode) is frequently used for 
placement/nudge outlines as an alternative to the silkscreen layer 
outline. Use the Select Items Dialog Box  to add layer 20 if needed. 
Silkscreen items appear black in the CAM Preview window.

• Paste Mask  — Document top and bottom paste mask layers. 
Black areas are paste locations. White is the paste mask. Paste 
is only used for surface mount components. Pads of through-hole 
components are not shown.

• Solder Mask  — Document top and bottom solder mask layers. 
Black areas are solder locations. White is the solder mask.

Document Type (con’t) • Assembly  — Document assembly drawings. Component outlines 
may have been created on the top layer, silkscreen layer, and/or 
layer 20. Use the Select Items Dialog Box  to add the layers you 
need. Assembly items appear black in the CAM Preview window.

• Drill Drawing  — Document drill locations. A drill table is added 
automatically and appears at a location specified in the Global Drill 
Symbols Dialog Box.

• NC Drill  — Generate an NC Drill file. This document is not intended 
for viewing. It contains the x and y location and drill size of each 
hole required in the design.

• Verify Photo  — View and verify any existing CAM document. The 
document to be viewed can be from a different design. Verify Photo 
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Field Description
supports the macros, aperture selection, and fill area commands 
of SailWind Layout Gerber outputs. Verify Photo plots can only 
process RS-274-X Gerber files created by SailWind Layout.

Output File Specifies the name of the CAM output file. Accept the default name, or 
type your preferred name for the output file.

Fabrication Layer The layer on which you will be using CAM350 for post processing.

 Tip
The Fabrication Layer is only used during conversion to the 
CAM350 database using CAM350 Link.

Summary Displays a summary of the selected CAM document.

Layers button Opens the Select Items Dialog Box.

Options button Opens a dialog box where you can set plot options depending on the 
plot type with which you are working:

• Plot Options  on page 1641 — Printer, Pen and photo plots

• Drill Drawing Options  on page 1387 — Drill drawings
 Restriction:
Available from the Plot Options Dialog Box  only when the Drill 
Drawing document type is selected.

• NC Drill Options  on page 1481 — NC drill output

Assembly button Opens the Select Assembly Variant Dialog Box.

Output Device You can print or plot your outputs on paper or you can send a photo 
plot file to manufacturing.

 Tip
Print the file to make sure it's okay before then send the file to the 
manufacturer.

• Print  — Send the document to a printer in your workplace when you 
click Run.

• Pen  — Send the document to a pen plotter in your workplace when 
you click Run.

• Photo  — Create a photo plotter file when you click Run. This gerber 
file is sent to manufacturing for use in a photo plotter to create your 
PCB.

• Drill  — Create an NC Drill file when you click Run. This is a file sent 
to manufacturing for input into a computerized drilling machine to 
drill all the vias.

Preview Selections button Opens the CAM Preview Dialog Box.

Device Setup button Opens a dialog box where you can set options associated with the 
selected device type, Printer Setup, Pen Plot Setup  on page 1617, 
Photo plot Setup  on page 1622, or NC Drill Setup  on page 1483.
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Field Description

Save As Defaults button Specifies to save your current settings as the defaults for this CAM 
document type and output device.
The layer selections are not saved as defaults. The location of the Drill 
Chart is not saved.

 Tip
This option is useful if you manually build your own drill table and 
want to use this drill table as the default drill table.

Run button Produces the document you just defined.

Set Layers button Opens the Layers Setup Dialog Box.

Related Topics
Creating CAM Outputs to Manufacture Your PCB
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Add Chamfered Path Dialog Box
To access: Drafting Toolbar > Copper  button > right-click > Chamfered Path  popup menu item

The Add Chamfered Path dialog box opens when you select the Chamfered Path - copper shape. You set 
Chamfered Path parameters before you add the copper to the design.

Tip
You may need to click OK  to switch off Design Rule Checking.

Objects

Field Description

Polygon outline width Specifies the width value for the copper outline.

 Tip
Since copper is created with an outline and a fill, you can specify a 
very narrow outline width to achieve very sharp corners. Decrease 
the value for sharper corners and increase the value for more blunt 
corners. All corners are rounded with a radius equal to one half of 
the outline width.

Chamfered path width Specifies the width value for the overall width of the copper path.

Corner chamfer width ratio Specifies the ratio of the chamfered corner width to the chamfered path 
width. If the ratio is 1.0, the width of the chamfered corner is the same 
as the chamfered path. Reduce the ratio for a more narrow chamfered 
corner.

Chamfer corners with angles 
less than or equal to

Specifies an angle between 90 and 180 degrees as the upper limit 
beneath which all angles are chamfered. Outside corners less than 90 
degrees are always chamfered.

 Tip
Click to clear the check box to only chamfer angles less than 90 
degrees.
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Related Topics
Creating Copper Chamfered Paths

Setting Chamfered Path Parameters

Add Class Tasks Dialog Box
For information about the Add Class Tasks dialog box, refer to the documentation for the Add Net Tasks 
dialog box.

See: Add Net Tasks/Add Class Tasks Dialog Box
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Add/Edit Command Dialog Box
To access: Tools  > Customize  menu item > Commands  tab > New  or Edit  button

Use the Add Command dialog box to create commands that you can then use as selections on menus or 
as buttons on toolbars.

Objects

Field Description

Command name The name of the new command.

 Tip
Type an ampersand (&) before the letter you want to use as the 
Alt keyboard shortcut.

Based on The command on which you want to base the new command.

Arguments Any arguments for the new command.

 Tip
Use a space to separate arguments. If an argument contains a 
space, enclose the argument in quotation marks (“).
 Restriction:
SailWind Router only.

Description Lists what the new command does.

Use Default Image Use the recommended image. This option is available only if an 
image was associated with the original command.

Select User-defined Image Select or create your own image to associate with the new 
command. This option is available only if an image was associated 
with the original command.
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Field Description

New Open the Edit Button Image Dialog Box.

Edit Open button in the Edit Button Image Dialog Box.

Related Topics
Creating a Custom Command

Creating a Custom Menu
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Add Component Bond Pad Dialog Box
To access: BGA Toolbar  > Wire Bond Editor  button > click the BGA > right-click > Add CBP  popup 
menu item

Use the Add Component Bond Pad dialog box to create new bond pads in your design.

Note:
This information applies only to the BGA toolkit.

Objects

Field Description

Pad # Assigns a number to the currently selected component bond pad. By 
default, it is the same number as the substrate bond pad to which it is 
connected.

Function Defines the function of the currently selected bond pad.

Shape list Assigns a shape to the currently selected bond pad. Select Rectangle 
or Oval.

Length Assigns a physical length, in current design units, for the currently 
selected bond pad.

Width Assigns a physical width, in current design units, for the currently 
selected bond pad.

Add button Dynamically attaches the substrate bond pad and wire bond to the 
cursor for placement.

Related Topics
Adding Component Bond Pads Manually to the Die
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Add Die Parts Dialog Box
To access: BGA Toolbar  > Add Die Parts  button

Use the Add Die Parts dialog box to import die parts from Library IQ into SailWind Layout.

Note:
This information applies only to the BGA toolkit.

Objects

Field Description

Preview Area Displays the Library IQ die part selected in the Die Part list.

File The die part filename.

Modified The last modification date.

Chip Bond Pads The number of chip bond pads in the die part.

Substrate Bond Pads The number of substrate bond pads in the die part.
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Field Description

Wire Bonds The number of wire bonds in the die part.

Flip Chip The Flip Chip identification for the die part.

Die Part list Lists all Library IQ die parts in the current folder.

Look in Displays the die part search folder.

 Tip
Click Browse  to search for the die part folder.

Apply  button Sets the die part search folder.

Add >>  button Adds the selected Library IQ die parts to the DIE Part Type table.

<< Remove  button Removes the selected DIE Part from the DIE Part Type table.

Die Part Type column The Library IQ die part to add.

Part Name column The reference designator that is automatically assigned to the die part 
type. To change the reference designator, double-click on the part 
name and type a new name.

Die Outline and Pads Sets the layer on which the die outline and pads appear. Select a layer 
from the list.

Wire Bonds Sets the layer on which the wire bonds appear. Select a layer from the 
list.

Create Nets from Die Pad 
Function Name

Automatically creates nets for pins with matching pin name when 
you add die parts to SailWind Layout. The net name matches the pin 
function.

Add Drafting Dialog Box
For information on the Add Drafting Dialog box, refer to the documentation for the Drafting Properties 
dialog box.

See the “Drafting Properties Dialog Box” topic.
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Add Free Text Dialog Box
To access: Drafting Toolbar  button > Text  button

Use the Add Free Text dialog box to add text that does not belong to another object (free text).

Description
When you add text, there is an invisible bounding rectangle  around the text itself.

Note:
Text can only be added one line at a time. See “Creating Reusable Fabrication Notes” for a tip on 
saving multiple lines of text to the library for reuse.

Objects

Field Description

Text The text string you want to use.

 Tip
There is a maximum of 128 characters per text string.

Font The fonts available to you. Select stroke font or a system font.
For system fonts, you can also click a font style button, or any 
combination of styles: B for bold, I for italic, or U for underlined.
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Field Description

Layer The layers available to you on which to place the text.

X,Y Places the decal label in a specified location.

Rotation Specifies the rotation angle of the label.

Size Specifies the size of the font.
Size (pts): This is font size in points and appears for system fonts.
Size (mils): This is font character height and appears for stroke fonts. 
The size refers to the height of the tallest characters.

Line Width Specifies the line width for stroke fonts only.

Mirrored Flips the label - text is considered readable from the bottom side of the 
board.

Horizontal, Vertical Sets the horizontal and vertical justification of the text to ensure proper 
positioning between objects when text, attribute values, size, or width 
change.
For vertical justification, click Left, Center, or Right. For horizontal 
justification, choose Up, Center, or Down.

 Tip
You can set justification for existing text by selecting the text, then 
right-clicking and clicking the Justify Horiz  or Justify Vert  popup 
menu item.

Defaults Restores the SailWind Layout default settings.

Clearance Specifies clearance values between the text and objects around it.

Related Topics
Adding Free Text
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Add Net Tasks/Add Class Tasks Dialog Box
To access:

• Tools  > Verify Design  menu item > High Speed check > Setup  button > Add Nets  button

or

• Tools  > Verify Design  menu item > High Speed check > Setup  button > Add Classes  button

Use to run specific electrodynamic checks on nets or classes.

Objects

Field Description

Nets/Classes list Lists the nets or classes available in the design.

Related Topics
Adding Nets or Classes for Specific High-Speed Checks
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Add Net to Class Dialog Box
To access: Select one or more nets > right-click > Make Class  popup menu item

Use the Add Net to Class dialog box to create a collection of nets to which you can assign a common set 
of design rules.

Objects

Field Description

Create New Class Specifies to make a new class for the selected nets.

Add to Existing Class Specifies to add the selected nets to an existing class.

Selected Nets Lists all nets selected in the design.

Add to Class: Specifies the name of the new class.

 Tip
This is unavailable if Add to Existing Class is selected.

Existing Classes: Lists the classes available in which to add the selected nets.

Related Topics
Creating Class Design Rules
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Add New Attribute to Library Dialog Box
To access: File  > Library  menu item > Library Manager dialog box > Attr Manager  button > Add Attr 
button

Use the Add New Attribute to Library dialog box to set name and value properties when adding new 
attributes to libraries.

Objects

Field Description

Browse Lib. Attr Opens the Browse Library Attributes Dialog Box.

Attribute Name The name of the new attribute.

Attribute Value The value of the new attribute.

Related Topics
Adding an Attribute to Multiple Library Items

Library Manager Dialog Box

Part Information Dialog Box, Attributes Tab
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Add New Decal Label Dialog Box
To access: Tools  > PCB Decal Editor  menu item > Drafting  button > Add New Label  button > select a 
decal

Use to create attribute labels for decals.

Objects

Field Description

Attribute The attributes available to you. If you are creating labels for 
jumpers, Reference Designator is the only available attribute.

 Tip
Hidden attributes do not appear in the Attribute list unless 
the attribute was selected for the label before it was set as a 
hidden attribute.

Value for The value of the selected attribute.
Unavailable if you selected Reference Designator or Part Type 
from the Attribute list, if the attribute is read-only, or if you open 
the Properties dialog box for labels of different attribute types. 
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Field Description
However, if the labels you select belong to attributes of the same 
type, you can edit this box.
If the attributes have different values, the box is blank. You 
can type a new value in the box to apply it to all of the selected 
attribute labels and their parent objects.
Value is also unavailable if the attribute is ECO-registered and 
SailWind Layout is not in ECO mode.

Show Controls the visibility of the label.
• None — Turns visibility off.

• Value — Displays only the label value.

• Name and Value — Displays the name and value.

• Full Name and Value — When labeling a structured attribute  on 
page 1862, displays the full structured name and value.

 Tip
Labels are invisible regardless of this setting unless you use 
the Display Colors Setup Dialog Box  to change the color of 
labels to a color different from that of the background.

Font The fonts available to you.
Select stroke font or a system font.
For system fonts, you can also click a font style button, or any 
combination of styles: B for bold, I for italic, or U for underlined.

Layer The layers available to you.

Relative to Places the label at the X and Y location relative to the component 
or the jumper. If you clear this check box, the label is placed at the 
X and Y location relative to the design origin.

X,Y Places the decal label in a specified location.

Rotation Specifies the rotation angle of the label.

Size Specifies the size of the font.
Size (pts): This is font size in points and appears for system fonts
Size (mils): This is font character height and appears for stroke 
fonts. The size refers to the height of the tallest characters.

Line Width Specifies the line width for stroke fonts only.
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Field Description

Mirrored Flips the label - text is considered readable from the bottom side of 
the board.

Horizontal, Vertical Sets the horizontal and vertical justification of the text to ensure 
proper positioning between objects when text, attribute values, 
size, or width change.
For vertical justification, click Left, Center, or Right. For horizontal 
justification, choose Up, Center, or Down.

 Tip
You can set justification for existing text by selecting the text, 
then right-clicking and clicking the Justify Horiz  or Justify 
Vert  popup menu item.

Right reading Controls whether labels are readable (from left to right, or from 
bottom to top if the label is rotated). Click the None, Orthogonal, 
or Angled  button to indicate the direction of reading you want.

Related Topics
Creating Attribute Labels in the PCB Decal Editor
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Add New Part Label Dialog Box
To access: Select a part > right-click > Add New Label  popup menu item

Use the Add New Part Label dialog box to create attribute labels, part type labels, and reference 
designator labels for components or jumpers.

Description

• Reference designator is the only label available for use when you are creating labels for jumpers.

• If you do not set visibility information, default positions are used. See also: “Label Defaults”.

• Unlike free text, when you add a label, there is no invisible bounding rectangle  on page 1813
around the label itself.

Objects

Field Description

Attribute The attributes available to you. If you are creating labels for 
jumpers, Reference Designator is the only available attribute.
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Field Description

 Tip
Hidden attributes do not appear in the Attribute list unless 
the attribute was selected for the label before it was set as a 
hidden attribute.

Value for The value of the selected attribute.
Unavailable if you selected Reference Designator or Part Type 
from the Attribute list, if the attribute is read-only, or if you open 
the Properties dialog box for labels of different attribute types. 
However, if the labels you select belong to attributes of the same 
type, you can edit this box.
If the attributes have different values, the box is blank. You 
can type a new value in the box to apply it to all of the selected 
attribute labels and their parent objects.
Value is also unavailable if the attribute is ECO-registered and 
SailWind Layout is not in ECO mode.

Show Controls the visibility of the label.
• None — Turns visibility off.

• Value — Displays only the label value.

• Name and Value — Displays the name and value.

• Full Name and Value — When labeling a structured attribute  on 
page 1862, displays the full structured name and value.

 Tip
Labels are invisible regardless of this setting unless you use 
the Display Colors Setup Dialog Box  to change the color of 
labels to a color different from that of the background.

Font The fonts available to you.
Select stroke font or a system font.
For system fonts, you can also click a font style button, or any 
combination of styles: B  for bold, I  for italic, or U  for underlined.

Layer The layers available to you.

Relative to Places the label at the X and Y location relative to the component 
or the jumper. If you clear this check box, the label is placed at the 
X and Y location relative to the design origin.

X,Y Places the decal label in a specified location.

Rotation Specifies the rotation angle of the label.

Size Specifies the size of the font.
Size (pts): This is font size in points and appears for system fonts
Size (mils): This is font character height and appears for stroke 
fonts. The size refers to the height of the tallest characters.
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Field Description

Line Width Specifies the line width for stroke fonts only.

Mirrored Flips the label - text is considered readable from the bottom side of 
the board.

Horizontal, Vertical Sets the horizontal and vertical justification of the text to ensure 
proper positioning between objects when text, attribute values, 
size, or width change.
For vertical justification, click Left, Center, or Right. For horizontal 
justification, choose Up, Center, or Down.

 Tip
You can set justification for existing text by selecting the text, 
then right-clicking and clicking the Justify Horiz  or Justify 
Vert  popup menu item.

Right reading Controls whether labels are readable (from left to right, or from 
bottom to top if the label is rotated). Click the None, Orthogonal, 
or Angled  button to indicate the direction of reading you want.

Related Topics
Adding a New Part Label
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Add Pin Dialog Box
To access: Setup  > Pad Stacks  menu item > select a Decal or Via > under the Pin: Plated: list, click the 
Add  button.

Use the Add Pin dialog box to select specific pins to add to the Pin: Plated: list in the Pad Stacks 
Properties dialog box.

Objects

Field Description

Pin list Select the specific pin(s) you want to add to the Pin: Plated: list 
in the Pad Stacks Properties Dialog Box. The pins will be listed 
individually and can be deselected once added to the Pin: Plated: 
list if you choose not to give them the all the same pad stacks.

• Ctrl+Click multiple items

• Shift+click for a range of items

• Click and drag for a range of items
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Field Description

Select odd/Select even You can use these buttons as a shortcut to select all the odd or 
even pins in the Pin List.
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Add Pin Pairs to Group Dialog Box
To access: Select pin pairs > right-click > Make Group  popup menu item

Use the Add Pin Pairs to Group dialog box to create a collection of pin pairs with a common set of design 
rules.

Objects

Field Description

Create New Group Specifies to make a new group for the selected pin pairs. This selection 
is unavailable if there are no other existing groups.

Add to Existing Group Specifies to add the selected pin pairs to an existing group. This 
selection is unavailable if there are no other existing groups.

Selected Pin Pairs Lists all pin pairs selected in the design.

Add to Group: Specifies the name of the new group.

 Tip
This is unavailable if Add to Existing Group is selected.

Existing Group: Lists the groups available in which to add the selected pin pairs.

Related Topics
Creating Group Design Rules
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Add Pins Dialog Box
To access:

• File  > Library  menu item > select a library > Parts  button > New  button > Pins  tab > Add Pins 
button

• File  > Library  > select a library > Parts  button > select a part > Edit  button > Pins  tab > Add 
Pins  button

Use to add pins to a part type.

Objects

Field Description

Number of pins Specifies the number of pins to add using the Add Pins dialog box.

Prefix The prefix you want for your pins.
Alphabetic and numeric values can be used. For example, A1 or 
1A.
For a single numeric, use either the Prefix or the Suffix box, and 
void the other box.

Suffix The suffix you want for your pins.
Alphabetic and numeric values can be used. For example, A1 or 
1A.
For a single numeric, use either the Prefix or the Suffix box, and 
void the other box.
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Field Description

Pin numbers A preview of pin numbers based on your input in the Prefix and 
Suffix boxes.

Increment prefix/Increment suffix Indicates whether you want the prefix or the suffix to increment.

Step value A positive or negative number by which to increase or decrease 
the pin numbers with consecutive or stepped values.

Verify valid JEDEC pin numbering Ensures that legal alphanumeric values are used.

Related Topics
Adding a Series of Pins to the Pins Table
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Add Substrate Bond Pad Dialog Box
To access: BGA Toolbar  > Wire Bond Editor  button > click the BGA > Right-click > Add SBP  popup 
menu item

Use the Add Substrate Bond Pad dialog box to create new bond pads in your design.

Note:
This information applies only to the BGA toolkit.

Objects

Field Description

Pin Name Assigns a pin name to the currently selected substrate bond pad.

Function Defines the function of the currently selected bond pad.

Layer list Lists all the electrical layers for creating SBPs, so you can create an 
SBP on a specific layer.

Length Assigns a physical length, in current design units, for the currently 
selected bond pad.

Width Assigns a physical width, in current design units, for the currently 
selected bond pad.

Add button Dynamically attaches the substrate bond pad and wire bond to the 
cursor for placement.

Related Topics
Adding Substrate Bond Pads
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Add/Rename SBP Ring Dialog Box
To access: Wire Bond Wizard Dialog Box > Add  button

Use the Add SBP Ring dialog box to add a ring for the substrate bond pads.

Objects

Field Description

Text box Enter the name of the ring as you want it to appear in the Wire Bond Wizard 
Dialog Box.
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Add Terminals Dialog Box
To access: Tools  > PCB Decal Editor  menu item > Drafting Toolbar  button > Terminals  button

Use the Add Terminals dialog box to set the type and numbering prior to adding terminals (pads or lands) 
of the decal.

Objects

Field Description

Pin Type Through Hole/Surface Mount  — Choose between placing 
a default through hole pin or surface mount pin. The default 
Through Hole pin is hard-coded as 60 mil round with 35 mil drill. 
The Surface Mount pin is hard-coded as 60 mil square. After 
placement, customize the shapes in the “Pad Stacks Properties 
Dialog Box”  on page 1566.

Start Pin Number Prefix/Suffix  — The prefix and suffix you want for your pins. For 
a single numeric, use either the Prefix or the Suffix box, and void 
the other box. Alphabetic and numeric values can be used. For 
example, A1 or 1A.
Pin numbers  — A preview of pin numbers based on your input in 
the Prefix and Suffix boxes.

Increment options Increment prefix/Increment suffix  — Indicates whether you want 
the prefix or the suffix to increment.
Step value  — A positive or negative number by which to increase 
or decrease the pin numbers with consecutive or stepped values.
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Field Description

Verify valid JEDEC pin numbering Ensures that legal alphanumeric values are used.

Related Topics
Adding Terminals
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Align 3D Models Dialog Box
To access: In the SailWind 3D window, select a component in the design then right-click and choose the 
Edit decal  popup menu item.

Use the Align 3D Models dialog box to assign and align a 3D model with the pads on the decal. The 
dialog box opens automatically whenever the Decal Editor opens for a component from the SailWind 3D 
window.
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Fields

Field Description

Model Name Displays the name of the selected model.

Approved Provides a means of documenting whether the 3D model 
mapping has been approved for record-keeping purposes. Select 
either “Approved” or “Not approved” from the list.
The selected annotation appears in the dialog box whenever 
Decal Editor is opened for the corresponding part from the 
SailWind 3D window.

Parts mapped to selected model Displays a list of parts that use the 3D model.
In most cases, only one part appears in the list. However, if 
more than one part in the PCB design shares the 3D model 
(for instance, you have the same 3D model represent both 
capacitors and resistors because the parts appear identical in 
3D), more than one part appears in the list.

Alignment mode Select one of the following:
• Absolute  — Moves the model in relation to the fixed XYZ 

origin.

• Delta  — Moves the model in relation to its currently displayed 
position.

Offset Type values in the X, Y, and Z boxes to move the 3D model.
Type positive or negative values to move the 3D model up or 
down, forward or backward.

 Tip
Use the Measure Distance tool in the SailWind 3D window to 
determine the distance to move the 3D model from its current 
position to the decal pad.

Rotate From the About list, select an axis (X, Y, or Z) and type an angle 
value (in degrees) to rotate the 3D model.
Click the “rotate left” or “rotate right” buttons to rotate the 3D 
model by 90 degrees around the selected axis.
Alternatively, you can click any of the green “directional” arrows 
located immediately above the model to rotate it in 90 degree 
increments.
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Field Description

Display rotation arrows Makes the rotational arrow controls appear.

Align Pin-Pad Center Aligns the center of a model pin that you choose with the center 
of a specific decal pin that you choose.
Clicking this button temporarily hides the pads from view. Click 
the pin surface that you want to center with the pad.
The pads become visible again after clicking the pin surface. 
Click the pad surface next to complete the pin-to-pad center 
alignment.
For more information, see Assigning a 3D Model to a 
Component.

Define Seating Plane Click to select the face of the model that you want to seat against 
the PCB pad.
For example, to ensure the pins of a DIP-14 package (or other 
through-hole component) seat properly in the pad holes, click 
this button then select the appropriate face on the model (such 
as the “flared” portion of a pin). The selected model face then 
seats against the pad.

Alignment: Indicates whether the 3D model has been aligned manually or 
automatically.

Import Click to map a 3D model to the part. Clicking this button opens 
the Browse dialog box to allow you to locate a 3D CAD file (such 
as a .sat  or .stp  file) for the desired 3D model.
This button is available only after selecting the part in the “Parts 
mapped to selected model” list.

Related Topics
Assigning a 3D Model to a Component

3D Model Mapping
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Align 3D Model Dialog Box
To access: In the SailWind 3D window, select a component in the design, then click the Import Part 
Model button.

Use the Align 3D Model dialog box to align a component’s 3D model with the pads on the decal. After 
importing a 3D model, this dialog opens automatically for aligning the model with the pads on the decal.

Fields

Field Description

Offset Type values in the X, Y, and Z boxes to move the 3D model. The 
values you type move the 3D model in relation to its currently 
displayed position.
Type positive or negative values to move the 3D model up or 
down, forward or backward.

 Tip
Use the Measure Distance tool in the SailWind 3D window to 
determine the distance to move the 3D model from its current 
position to the decal pad.

Rotate From the About list, select an axis (X, Y, or Z) from the About list 
and type an angle value (in degrees) to rotate the 3D model.
Click the “rotate left” or “rotate right” buttons to rotate the 3D 
model by 90 degrees around the selected axis.
Alternatively, you can click any of the green “directional” arrows 
located immediately above the model to rotate it in 90 degree 
increments.
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Field Description

Display rotation arrows Makes the rotational arrow controls appear.

Align Pin-Pad Center Aligns the center of a model pin that you choose with the center 
of a specific decal pad that you choose.
Clicking this button temporarily hides the pads from view. Click 
the pin surface that you want to align with the pad.
The pads become visible again after clicking the pin surface. 
Click the pad surface next to complete the pin-to-pad alignment.
For more information, see Assigning a 3D Model to a 
Component.

Define Seating Plane Click to select the face of the model that you want to seat against 
the PCB pad.
For example, to ensure the pins of a DIP-14 package (or other 
through-hole component) seat properly in the pad holes, click 
this button then select the appropriate face on the model (such 
as the “flared” portion of a pin). The selected model face then 
seats against the pad.
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Align Parts Dialog Box
To access: Select the parts you want to align > right-click > Align  popup menu item

Use the Align Parts dialog box to align selected objects along the left side, right side, vertical center, top, 
bottom, or horizontal center.

Objects

Field Description

Aligns selected items vertically along the left edge.

Aligns selected items vertically through the middle.

Aligns selected items vertically along the right edge.

Aligns selected items horizontally across the top.

Aligns selected items horizontally through the middle.

Aligns selected items horizontally across the bottom.

Related Topics
Aligning Objects
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Archiver Dialog Box
To access: File  > Archive  menu item

Use the Archiver dialog box to create archives of your designs, projects, files and folders, and libraries.

Objects

Field Description

PCB Design Specifies the location and name of the PCB design you want to 
archive. This is automatically populated with the information from the 
current design. To change the design, or if no design was opened, type 
the location or click the Browse  button.
Select the Create PDF check box to create a PDF file of the PCB 
design.
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Field Description

 Restriction:
This is unavailable if the file you chose is different from the current 
design.

Schematic Specifies the location and name of the schematic file you want to 
archive. To choose the file you want, type the location or click the 
Browse  button.
Select the Create PDF check box to create a PDF file of the schematic 
file.

 Restriction:
This is only available if you chose a PADS Designer file; it is 
unavailable if you chose a SailWind Logic file.

Add libraries Specifies that you want to include libraries in the archive.
• All — Add all of your libraries to the archive.

• Select — Add only the libraries you specify. Click the Browse 
button to open the Archiver - Libraries Dialog Box.

Additional files Specifies that you want to include other files and folders in your 
archive. Click the Browse  button to open the Archiver - Additional Files 
Dialog Box.

Target folder Specifies where you want the archive to be located. Type the path or 
click the Browse  button.

 Restriction:
If the Compress using zip format check box is unchecked, the 
target folder must be empty.

Compress using zip format Specifies to create a zip file. The filename will be in the following 
format:

<project_name>YYYYMMDDHHMMSS.zip

Where YYYY is the year, MM is the month, DD is the day, HH is the 
hour - in military time, MM is the minute, and SS is the second of the 
exact time you created the file.

Related Topics
Archiving Your Design
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Archiver - Additional Files Dialog Box
To access: File  > Archive  menu item > Additional Files check box > Browse  button

Use the Archiver: Additional dialog box to add files and folders to the design you want to archive.

Objects

Field Description

Additional files list Lists the files and folders you want to include in your archive.

Add File button Opens the Additional File dialog box where you can select individual 
files you want to add to the Additional files list.

Add folder button Opens the Browse for Folder dialog box where you can select an entire 
folder to add to the Additional files list.

Remove button Removes the selected file or folder from the Additional files list.

Remove All button Removes all of the files and folders from the Additional files list.

Related Topics
Archiving Your Design
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Archiver - Libraries Dialog Box
To access: File  > Archive  menu item > Add libraries check box > click Select > Browse  button

Use the Archiver: Libraries dialog box to add libraries to the design you want to archive.

Objects

Field Description

Available libraries Lists all of the libraries available for you to add to the archive.

 Restriction:
If your library is not listed in the Library Manager, it will not appear 
in this list.

Add >> button Moves the selected library from the Available libraries list to the 
Selected libraries list.

<< Remove button Moves the selected library from the Selected libraries list to the 
Available libraries list.

Add all >> button Moves all of the libraries from the Available libraries list to the Selected 
libraries list.

<< Remove all button Moves all of the libraries from the Selected libraries list to the Available 
libraries list.

Related Topics
Archiving Your Design
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Arrow Properties Dialog Box
To access: Select an arrow > right-click > Properties  popup menu item.

The Arrow Properties dialog box displays coordinate information for the selected arrow and provides 
several areas for modifications. The Arrow Properties dialog box remains open until you click OK  or 
Cancel. Selecting another arrow while the dialog box is open updates the information for the selected 
object.

Objects

Field Description

X and Y values Displays the X and Y coordinate locations of the selected object(s).

Parent button Opens the Dimension Properties Dialog Box  for the dimension object 
with which the selected object is associated.

Layer list Lists the current working layer. Select a new layer from the list to 
change it.

Tail Length Specifies the current minimum length of the arrow tail, which is the 
line extending beyond the arrow. Type a new value to change the tail 
length.

Indicates the current arrow type. Click an alternate button to modify.

Text Gap Specifies the current spacing between the tail and the measurement 
text. Type a new value to change the spacing.

Line Width Lists the current line width of the tail and arrow lines. Type a new value 
to change the line width.
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Field Description

Arrow Size Lists the current arrow width, which is the height of the arrow. Type a 
new value to change the width.

Arrow Length Lists the current arrow length, which is the measurement between the 
arrow tip and the end of the arrow. Type a new value to change the 
arrow length.

Related Topics
Moving Dimensions and Dimension Objects
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ASCII Output Dialog Box
To access: Choose the File > Export  menu item > choose ASCII Files (*.asc)  as the export file type > 
click Save

You can use ASCII files to exchange design data between SailWind Layout and external translators or 
previous versions of SailWind Layout.

Objects

Field Description

File The name of the file you are exporting.

Sections Specifies the sections of the ASCII file you want to export.
• PCB Parameters  — Global design information, such as units and colors

• Reuse  — Elements in, and the definition of, a physical design reuse

• Text  — Text

• Lines  — Two-dimensional (2D) lines

• Clusters  — Clusters and unions

• Vias  — Vias (including dangling vias), jumpers, and padstacks
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Field Description

• Decals  — Footprints

• Packages  — Electrical information

• Parts  — Component instances

• Jumpers  — Jumpers. If you plan to export to the PowerPCB V1.1 ASCII format, 
you cannot output complete jumper information. This is because SailWind Layout 
considers jumper pins as vias and jumpers are exported as vias when you select 
the Vias check box.

• Connections  — Unrouted pin pairs

• Routes  — Traces, including route loops

• Teardrops  — You must export routes to export teardrops.

• Miscellaneous  — Information not included in other items

• Rules  — Clearance, routing, and high-speed rules

• CAM  — Information related to plot file configurations generated using CAM

• Copper Planes  — Copper plane information (applies only to copper planes; does 
not include information on 2D lines, keepouts, or other shapes).

• Assembly Variants  — Assembly variants

• Test Points  — Test points and the test side (top, bottom, or both)

• Attributes  — Attribute Dictionary and all individual attributes and value 
assignments in the design. Status of attributes (read-only, system, ECO-registered, 
or hidden). Previous versions do not support all of the default attributes.

 Tip
Values through the attribute hierarchy are not exported.

Select All Selects all items in the Sections list.

Unselect All Unselects all items in the Sections list.

Format Specifies the format of the ASCII file. Use PowerPCB V3.0 to export to both 
PowerPCB and PowerBGA V3.0 ASCII formats.

Units Specifies the units to export.

 Tip
If you plan to use the ASCII file for an external translator or another ASCII-reading 
program, select Current. If you plan to re-import the ASCII file and save it as a 
.pcb  database, select Basic. Basic units represent how values are stored in the 
software. They do not use standard units of measure, but they record precise 
positioning values for database items.

Parts Specifies that you want to export attributes assumed from higher levels in the attribute 
hierarchy.

Nets Specifies that you want to export attributes assumed from higher levels in the attribute 
hierarchy.
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ASCII Output Dialog Box

Related Topics
Exporting an ASCII File
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Assembly Variants Dialog Box
To access: Tools  > Assembly Variants

Use the Assembly Variants dialog box to create a new variant, review or edit a variant, preview variants, 
delete variants, and create reports for variants.

Figure 127. Assembly Variants Dialog Box

Objects

Field Description

Type list Specifies what displays in the table: Assembly Variants or 
Components.

Display list Filters the Variant table based on your selection: All, Installed, Not 
Installed, Substituted.

Verb mode Specifies what action to take and perform on components in the Layout 
Editor (outside the dialog box): Install, Uninstall, Substitute, No.

Name Specifies the name of the Assembly Variant or the Component you 
want listed in the table. Changes depending on the selection made in 
the Type list.

New Variant’s name Specifies the name of the new variant, up to 26 characters.
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Field Description

Status area Specifies the status for the selected variant: Installed, Not installed, 
Substituted.

 Tip
If you click Substituted, the Variant Substitute Dialog Box  on 
page 1773 opens.

Edit button Opens the Variant/Substitute Dialog Box. Unavailable unless the 
component has already been substituted.

Preview button Opens the Preview for dialog box.

Create button Creates a new variant and adds it to the Name list.

Delete button Removes the selected variant from the Name list.

Reports button Opens the Reports Dialog Box.

Variant/Components table Lists the name and status of the variants or components selected in the 
Name list. Changes depending on the selection made in the Type list.

Related Topics
Assembly Variants
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Assign CBPs to Rings Dialog Box
To access: BGA Toolbar  > Wire Bond Wizard  > Assign CBPs  button

Use the Assign CBPs to Rings dialog box to specify which component bond pads to wire bond to which 
ring.

Description
You can preview this placement, see preview of CBP assignments.

Note:
This information applies only to the BGA toolkit.
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Assign CBPs to Rings Dialog Box

Objects

Field Description

View by Select an option for viewing the component bond pad data in the CBP 
list: CBP, CBP Function, SBP Function.

Show Only Unassigned CBPs Displays only the unassigned component bond pads in the CBP list.

Show Only CBPs for Selected 
Sides

Displays only component bond pads specified in the Generate Fanout 
for area of the Wire Bond Wizard Dialog Box. If you do not select this 
option, the list displays all component bond pads, no matter what the 
current settings are in the Generate Fanout for area.

CBP column Displays the CBP number. Displayed only when CBP is selected from 
the View by list.

CBP Function column Component bond pad function. Displayed only when CBP or CBP 
Function is selected from the View by list.

SBP Function column Substrate bond pad function. Displayed only when CBP or SBP 
Function is selected from the View by list.

CBP Count The component bond pad count for each bond pad function. Displayed 
only when CBP Function or SBP Function is selected from the View by 
list.

Select All  button Selects all component bond pads in the CBP list to assign to the 
currently selected rings.

Invert Selected  button Inverts all selections currently in the list. If one item is currently 
selected, this button will deselect that one item and select all other 
items instead.

Assign to area Use to select the ring or rings to which you want the selected 
component bond pad or pads assigned. You can select multiple rings at 
a time for component bond pad assignment.

Apply  button Applies your settings for assigning component bond pads to rings. Also 
clears the selections in the Assign to list. It does not close the Assign 
CBPs to Rings Dialog Box, so you can continue to make assignments.

Related Topics
Assigning CBPs to Rings
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Assign Color to All Layers Dialog Box
To access: Setup  > Display Colors  > Assign All  button

Use the Assign Color to All Layers dialog box to make objects visible or hide them in a design.

Description
For more information, see Making All Objects Visible, and Hiding Design Objects.

Objects

Field Description

Automatically Make Objects 
Visible

Specifies to automatically find objects on any layer that have the 
current background color and assigns a color based on the Color 
Preference list setting.

Color Preference Specifies the way you want to make objects visible in a design:
• One Color per Object Type  — Assigns color for a certain 

object type, when it is currently set to the background color, 
on all layers. The program assigns color according to the color 
set in the immediately adjacent tile, or, if no adjacent tile exists, 
according to color palette order.

• One Color for a Layer  — Assigns color for all objects, when 
they are currently set to the background color, on the same 
layer. The program assigns color according to the color set 
in the immediately adjacent tile, or, if no adjacent tile exists, 
according to color palette order.

• Selected Color  — Assigns the color you select from the 
Display Colors Setup Dialog Box  color palette to all objects, 
which are currently set to the background color, on all layers.

Update Visibility Check Boxes Specifies that the visibility check boxes surrounding the color 
matrix are selected if data exists on a layer, and clear if no data 
exists on a layer.

Update Enabled Status Specifies color assignment based on layer settings in the 
Enable/Disable Layer dialog box  on page 1365. When you select 
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Field Description
this option, nonelectrical layers that do not contain data are 
disabled.

Assign Background Color to All 
Objects

Specifies to make all objects on all layers invisible by changing the 
color of all objects, on all layers, to the current background color.

Related Topics
Setting Colors for the Design
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Assign Color to Net Dialog Box
To access: Select a net > right-click > Assign Color to Net  menu item

Use this dialog box to selectively assign display colors to individual nets.

Objects

Field Description

Color by Net area Sets a color to the net(s) in selection.

Default All  button Returns net colors to their default assignments (as defined in the 
Display Colors Setup Dialog Box), except those nets locked in the View 
Nets Dialog Box.

More  button Opens the Assign Color to Netlist Dialog Box.
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Assign Color to Netlist Dialog Box
To access: Click More  in the Assign Color to Net Dialog Box

Use this dialog box to selectively assign display colors to a batch of nets simultaneously.

Objects

Field Description

Net list Lists all of the nets available in the design.

Selected list Lists all of the nets for which you want to assign a display color.

Add/Remove buttons Add moves selected net names into the Selected list box where 
you can highlight net names and set display color for them. Use 
Ctrl/Shift for multiple selections. Click Remove  to move the net from 
the Selected list to the Net List.

Add all/Remove all buttons • Add all  moves all the nets from the Net Lsit to the Selected list

• Remove all  moves all the nets from the Selected list to the Net Lsit

Filter box Filters the Net List by net name.
• You can use wildcards or expressions  for filter.

• The search result will be displayed in real time.

Zooms to the selected object Fits the object(s) you select into the workspace, which takes effect on 
selections made in both the Net List and Selected list.
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Field Description

Color by Net area Sets a color to all nets in the Selected list.

Return  button Goes back to the Assign Color to Net Dialog Box.

Apply  button Makes the color assignment for the Selected list effective, except the 
nets locked in the View Nets Dialog Box.
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Assign Decal to Gate Dialog Box
To access: File  > Library  menu item > select a library > Parts  button > select part > New  or Edit  button > 
Gates  tab > double-click a CAE Decal cell > Browse  button

Use the Assign Decal to Gate dialog box to assign default and alternative CAE decals to gates.

Objects

Field Description

Library list Lists all libraries available to you.

Filter Narrows down your Unassigned decals list. You can use wildcards 
in this box.

Pin Count Lists the pin count for the selected gate.

Apply Executes the filter arguments.

Preview area Shows the selected decal.

Unassigned Decals list Lists all unassigned decals available to assign to the selected gate 
in the selected library.

Assign New Opens the Assign New Gate Decal Dialog Box, where you can 
enter the name of the new decal for the gate.

Assign >> Moves the selected decal from the Unassigned Decals list to the 
Assigned Decals list.
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Field Description

<< Unassign Moves the selected decal from the Assigned Decals list to the 
Unassigned Decals list.

Assigned Decals list Lists all assigned decals to the selected gate in the selected 
library.

Up/Down Moves the selected Decal up or down.

Related Topics
Assigning CAE Decals to Gates
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Assign Net to Selected Polygon Dialog Box
To access: Create a split plane on a Split/Mixed plane layer

Choose a net to assign to the split planes you create on a Split-Mixed plane.

Objects

Field Description

Choose Existing Net list Choose a net from the list to assign to the currently selected 
plane.
After making your selection, click OK  to assign a net to the 
next split plane.

Show Plane Nets Only check box Select the check box to limit the nets displayed in the list to 
only those set up as plane nets.
Use this check box when you have an extensive list of 
available nets to choose from and you want to select a plane 
net only.
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Assign New Gate Decal Dialog Box
To access: File  > Library  menu item > select a library > Parts  button > select part > New  or Edit  button > 
Gates  tab > double-click a CAE Decal cell > Browse  button > Assign New

Use the Assign New Gate dialog box to assign a new gate decal when it does not yet exist in the library.

Objects

Field Description

Text box Enter the name of the new gate decal you intend to add to the library.
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Assign New PCB Decal Dialog Box
To access: File  > Library  menu item > select a library > Parts  button > select part > New  or Edit  button > 
PCB Decals  tab > Assign New

Use the Assign New PCB Decal dialog box to assign a new PCB Decal when it does not yet exist in the 
library.

Objects

Field Description

Text box Enter the name of the new PCB decal you intend to add to the library.
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Assign Pin Numbers Dialog Box
To access: This dialog box opens when you perform a task that can change the number of pins, such as 
changing a component  on page 826 or updating a part type from the library  on page 827.

If you update a part type from the library and the pin numbers have changed, you must reassign 
connections to the new decal pin numbers. Use the Assign Pin Numbers dialog box to correctly map old 
decal connections to new decal connections.

Objects

Field Description

Net name column Displays the net connected to the existing decal pin numbers - listed in 
the Old column.

Old Displays the existing pin number connected to the net.

New Specifies the new pin number connected to the net. If a pin has a signal 
assigned to it in the part type, the signal is shown after the pin name, 
in brackets. New decal pin numbers are matched where possible. If no 
match exists, the cell in the New column is empty and/or a pin number 
is listed in the Unassigned Pins list.

Unassign Moves the selected new pin(s) to the Unassigned Pins list.
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Field Description

Assign Moves the selected unassigned pin(s) to the selected new pin cell(s). 
Assignment of pin numbers begins with the first selected cell in the 
New column.

Unassigned Pins list Lists all unassigned pins associated with this component. If a pin has 
a signal assigned to it in the part type, the signal is shown after the pin 
name, in brackets.

Use current pin map for other 
components

Specifies to use this pin mapping for all other components. If you 
clear this check box, you are prompted to change the pin mapping for 
other selected components in the design. You may not cancel without 
canceling the entire operation.

Related Topics
Updating a Part Type from the Library in ECO Mode

Changing a Component in ECO Mode
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Assign Shortcut Dialog Box
To access: Tools  > Customize  menu item > Keyboard and Mouse  tab > New  button

Create a new shortcut key or pointer event using the Assign Shortcut dialog box.

Objects

Field Description

Press new shortcut key Type the shortcut you want to use.

Select a pointer event Set a pointer event shortcut

Similar shortcuts list Lists the shortcut keys already assigned to other commands.
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Attribute Dictionary Dialog Box
To access: Edit  > Attribute Dictionary  menu item

Although you can add new attributes to design objects using the Object Attributes dialog box (select 
object > right-click > Attribute  popup menu item), you must use the Attribute Dictionary to set the 
properties for attribute values. It is recommended that you use the Attribute Dictionary to create new 
attributes for your design or to edit and delete its attributes. You can also use the Attribute Dictionary to 
assign attributes for the design, or remove attributes from objects.

Objects

Field Description

Attribute The name of the attribute selected in the Attribute list.

Group Filters the Attribute list by showing only the selected group.

Attribute list Lists all available attributes.

Show Hidden Specifies to show attribute groups that have no visible attributes.

 Tip
You set whether an attribute is hidden on the Objects  on 
page 1111 tab of the Attribute Properties dialog box.

New Opens the Attribute Properties dialog box  on page 1115.
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Field Description

Delete Removes the selected attribute.
You can delete the default attributes; however, it is not recommended. 
Because the default attributes are only provided for your design and 
not assigned to objects, you do not need to delete these attributes.

Properties Opens the Attribute Properties dialog box  on page 1115.
If an attribute is ECO-Registered, you must be in ECO mode to modify 
the attribute.

 Tip
You can modify the default attributes; however, it is not 
recommended.

Auto Load for pre-3.0 Designs Select this check box to automatically update attributes for part types 
and decals from the current libraries to the Attribute Dictionary as soon 
as the design is loaded. Then load a design.

 Restriction:
Designs created in PADS software before version 3.0 will not list 
any provided Default Attributes.

Load Now Automatically loads attributes for part types and decals from the current 
libraries to the Attribute Dictionary.

Related Topics
Controlling Attributes
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Attribute Manager Dialog Box
To access: Edit  > Attribute Manager  menu item

Use the Attribute Manager to view all of the attributes on all objects in the design. The Attribute Manager 
provides a spreadsheet view of all the attributes in the design. You can use the Attribute Manager to add, 
edit, and delete attribute values on multiple object types. You can also create a value summary of an 
attribute that is based on every value of the attribute assigned to objects of the same type.

CAUTION:
Hidden attributes are not available to the Attribute Manager and are not listed in the Show 
Attributes dialog box.

Objects

Field Description

View area Specifies what to show in the spreadsheet tabs.
• Selected  — Shows the attributes selected in the design.

• Filter  — Narrows down your unassigned decals list. You can use 
wildcards in this box.
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Field Description

 Tip
Attributes are shown in the spreadsheet only after you have 
selected the ones to show from the Show Attributes Dialog Box.

Apply Filter Executes the filter arguments.

Show Opens the Show Attributes Dialog Box  to select which attributes you 
want to view in the spreadsheet.

Hide Hides the selected column from the spreadsheet tabs.

Hierarchy level The order in which attribute values have priority. The object at the top 
of the list has the highest priority.

Spreadsheet tabs Lists attributes based on selections made in the View area, the attribute 
area, and which tab you are on: Components, Net Classes, Nets, 
Decals, Part Types, Pins, and Vias. Click on the column header (name 
of the attribute) to sort the column in ascending order. Click on it again 
to sort in descending order.

Add Adds an attribute to the selected cell.

Delete Removes the attribute from the selected cell.

Edit Makes the selected cell available for editing.

Fill Column Populates all cells in a column with what you have added to one cell in 
that column.

Related Topics
Attribute Manager
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Attribute Properties Dialog Box, Objects Tab
To access:

• Edit  > Attribute Dictionary  menu item > select attribute > Properties  button > Objects  tab

• Edit  > Attribute Dictionary  menu item > New  button > Objects  tab

Use the Objects  tab to assign the attribute to objects and set up the hierarchy for the attribute. If the 
attribute is a system attribute, SailWind Layout makes all of the options in this dialog box unavailable 
except the System attribute option (which you would use to turn off the system attribute flag).

Objects

Field Description

Attribute The name of the attribute.
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Field Description

Browse Lib Attr Opens the Browse Library Attributes Dialog Box.

Objects The list of objects you can make available to the attribute.
NetClass  — refers to a net class created in the Class Rules Dialog 
Box.
Part  — refers to a component in the design.
PCB  — refers to the design as a whole.
If you select the Via check box, the ECO Registered check box is 
unavailable.
See also: “Assigning Attributes to Design Objects With the Object 
Attributes Dialog”.

Hierarchy The order in which attribute values have priority. You must select an 
object in the Objects list to see the Hierarchy assigned to it. The object 
at the top of the list has the highest priority.
Clear the Use Default Hierarchy check box to change the default 
hierarchy of attribute values. You must select enough objects in the 
Objects list to activate a hierarchy. The order of the objects in the 
Objects list shows the default hierarchy.
For example, an attribute value can be assigned to a decal, part type, 
and to the part (component) in the design. A part-level value overrides 
a part-type value, which in turn, overrides a decal-level value. If you 
assign attributes to multiple levels and then delete an attribute, the 
attribute at the highest possible hierarchy level becomes the assumed 
attribute.

Up/Down Moves the object hierarchy up or down. The object at the top of the list 
has the highest priority.

Use Default Hierarchy Click to clear if you want to change the default hierarchy.
Hierarchy modification is restricted. SailWind Layout automatically sets 
a certain logical hierarchy. For example, you cannot place Net Class 
above Net in the hierarchy because a net cannot usually be derived 
from a Net Class. SailWind Layout automatically places Net above Net 
Class in the hierarchy.

ECO Registered Allows you to specify if the attribute is ECO registered  on page 1824. 
If so, changes to the attribute are registered in the ECO file. You can 
modify attributes only when the ECO Toolbar is open (ECO mode).
ECO registration of attributes is not forward or backward annotated. 
The value of an attribute is backward annotated only if the attribute is 
ECO registered; turn on ECO Registered for attributes to backward 
annotate. When forward annotating, a report automatically appears 
in your default text editor indicating the ECO Registration of imported 
attributes. If an attribute does not exist in the Attribute Dictionary 
on page 355, it is added with ECO Registered turned off. If the 
attribute already exists in the dictionary, the existing attribute and ECO 
Registered status in the dictionary are used.
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Field Description

 Restriction:
• If you click the Via object check box only, the ECO Registered 

check box is unavailable.
• Attributes modified using Automation are never registered in the 

ECO file, regardless of this setting.

System Shows whether the attribute is a system attribute. System attributes 
are used by SailWind Layout, an external program, or an Automation 
script (such as Sax Basic). The System check box prevents you from 
modifying an attribute that is internally set by, and critical to, SailWind 
Layout operation.

 Note:
Automation ignores this setting and can change a system attribute. 
This setting is also ignored in the PCB Decal Editor and the library. 
This setting does not effect opening .pcb  files, importing .asc 
files, importing .dxf  files, importing .eco  files, or interactive ECO 
operations (such as Add Part from Library, Update Part from 
Library, or Change Part).

The System check box is automatically selected if an attribute requires 
a specific type for processing. You can also turn on the System check 
box to prevent accidental modification of an Attribute Dictionary entry, 
which may be useful if external programs use the attribute.
You can modify the value of a system attribute. You cannot modify the 
Attribute Dictionary entry of a system attribute. For new attributes, the 
System check box is turned off by default.

 CAUTION:
Do not modify the properties or Attribute Dictionary entry of a 
system attribute. Severe program or script errors can occur.

Read-Only Shows whether the attribute value is read-only, which means it cannot 
be changed outside of the library. However, you can modify the 
attribute properties. If you want to modify the attribute value, do so in 
the library.
If you are responsible for setting attribute values, you may find the 
Read-Only status useful because it prevents other users from changing 
a value. The Read-Only check box can also protect part and decal 
library attribute data from modification.
For new attributes, this option is cleared by default. The Read-Only 
check box is unavailable if the Hidden check box is clicked because 
you cannot edit the value of a hidden attribute.

 Note:
Automation ignores this setting and can change a read-only 
attribute. This setting is also ignored in the PCB Decal Editor and 
the library. This setting does not effect opening .pcb  files, importing 
.asc  files, importing .dxf  files, importing .eco files, or interactive 
ECO operations (such as Add Part from Library, Update Part from 
Library, or Change Part).

Hidden Hides the attribute, so that it is not visible or editable. It will not appear 
in any dialog boxes.
Hidden attributes may be useful in the design, in a schematic program, 
or to an external program or script (such as Automation, ASCII, or 
ECO).
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Field Description

For more information, see “Attribute Hierarchy”.

 Note:
Automation ignores this setting and can change a hidden attribute. 
This setting is also ignored in the PCB Decal Editor and the library. 
This setting does not effect opening .pcb  files, importing .asc 
files, importing .dxf files, importing .eco  files, or interactive ECO 
operations (such as Add Part from Library, Update Part from 
Library, or Change Part).

Related Topics
Attribute Properties Dialog Box, Types Tab

Attribute Types
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Attribute Properties Dialog Box, Types Tab
To access:

• Edit  > Attribute Dictionary  menu item > select attribute > Properties  button

• Edit  > Attribute Dictionary  menu item > New  button

Use the Types  tab to set the attribute type.

Description
The Types  tab controls change depending on what you have selected. The major differences are as 
shown below:

Figure 128. Types Tab - Number
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Figure 129. Types Tab - Measure
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Attribute Properties Dialog Box, Types Tab

Figure 130. Types Tab - List

Objects

Field Description

Attribute The name of the attribute.

Browse Lib Attr Opens the Browse Library Attributes Dialog Box.

Free Text Allows you to type a text string as the attribute value.

Yes/No Creates a list box where you can select Yes or No as the attribute 
value.

Number Allows you to type a number as the attribute value.

Decimal number Allows you to type a decimal number for the attribute value.
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Field Description

Measure Allows you to determine a measurement for the attribute value. It is a 
physical value associated with units.

List Allows you to create a list from which you choose the value.

Case-sensitive Preserves the letter case of List entries.
This setting affects sorting and matching in the Find Dialog Box  and the 
Attribute Manager Dialog Box.

Limits Min/Max Specifies a range for the Measure attribute type. Type in the Min and 
Max boxes to set the range. SailWind Layout checks against the Limits 
area values.

Abbr Abbreviation to use for the unit.

Unit The name of the unit.

Quantity The quantity, or what it measures.

List list Specifies a user-defined list for the attribute.

Set Adds the item to the list.

Clear Removes the selected item from the list.

Clear All Removes all items from the list.

Clear User Removes all user-defined units from the list. All default units remain in 
the list.

Related Topics
Attribute Properties Dialog Box, Objects Tab

Attribute Types
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Auto Placement Prompt

Auto Placement Prompt
To access: Tools  > Cluster Placement  menu item > Place Clusters  button > Run  button > Interrupt 
button

Use the Auto Placement prompt to control the interruption of the cluster placement process.

Objects

Field Description

Abort Quits the Cluster Placement process. You are prompted to allow the adjusted 
placement where clicking No will undo any placement.

Proceed Continues with the original cluster placement process.

Resume You are prompted to allow the process to proceed based on the already adjusted 
placement.

Related Topics
Cluster Placement Status Dialog Box

Cluster Placement Dialog Box
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AutoRenumber Dialog Box
To access: On the ECO Toolbar, click Auto Renumber.

After you complete the placement of a design, you can renumber the parts to make the reference 
designators follow a specific pattern. This helps you find components on the fabricated board. 
AutoRenumbering reassigns the reference designators to one of the eight provided patterns.

Objects

Field or Button Description

Prefix List Lists the standard prefix for each part in the design. You can select 
individual prefixes to renumber associated parts. You can use the 
Shift+click, Ctrl+click, or click and drag shortcuts to select multiple 
items.

Select All The Select All button changes to Unselect All when prefixed are 
selected. You can renumber all parts by clicking the Select All 
button or clear all prefixes by clicking Unselect All.

Cell size Enter the cell size of the cell for the part-numbering sweep. 
Renumbering sorts and renumbers parts one cell at a time starting 
at the corner indicated by the Directional Pattern setting. For 
circular board outlines, an invisible bounding box determines 
the location of the first cell. The board outline width is taken into 
account when the reference point for positioning user-specified 
cells is calculated. Cells are counted from the outer edge of the 
board outline.
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AutoRenumber Dialog Box

Field or Button Description

See also: “AutoRenumber Sweeps”.

Continuous numbering side to 
side

Controls numbering between sides. Select this option to number all 
parts sequentially beginning with the Start Renumbering from layer 
and continuing to the opposite side. Clear the check box to if you 
want to specify a separate start at number and increment value for 
each side of the board.

Start Renumbering from Indicate the side on which to start renumbering the parts. 
Restriction: This feature is unavailable when parts are only on one 
side of the board or if the Continuous numbering side to side check 
box is cleared

Renumber (Top or Bottom) Select the check box to renumber the corresponding side of the 
board.
This feature is unavailable when parts are not on the layer.

Start at (Top or Bottom) Specify the starting number for renumbering for the corresponding 
side of the board. Renumbered parts maintain their alphabetic 
prefix and are assigned a numeric suffix beginning with this value.
This feature is unavailable when Continuous numbering side 
to side is enabled and it is not the selected layer of the Start 
Renumbering from setting.

Increment (Top or Bottom) Specify the value by which to increment the reference designators.
This feature is unavailable when Continuous numbering side 
to side is enabled and it is not the selected layer of the Start 
Renumbering from setting.

Directional patterns (Top or 
Bottom)

Select the button that shows the starting location and direction in 
which you want to renumber the board.
See also: “AutoRenumber Sweeps”.

Related Topics
Changing the Reference Designators of Multiple Components in ECO Mode (Autorenumbering)

AutoRenumber Sweeps
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Chapter 47
GUI Reference Elements B Through C

Read the sections that follow to learn more about the dialog box elements in SailWind Layout.

Basic Script Editor Dialog Box
Basic Scripts Dialog Box
BGA Route Wizard Dialog Box
Browse for Special Symbols Dialog Box
Browse Library Attributes Dialog Box
Build Clusters Setup Dialog Box
Button Appearance Dialog Box
CAM350 Link Dialog Box
CAM Plus Dialog Box
CAM Preview Dialog Box
CAM Preview Setup Dialog Box
CBP Properties Dialog Box
CCE Export Dialog Box
Change Component Dialog Box
Choose Alignments Dialog Box
Check for Updates Dialog Box
Check Teardrop Dialog Box
Class Rules Dialog Box
Clearance Checking Setup Dialog Box
Clearance Rules Dialog Box
Cluster Information Properties Dialog Box
Cluster Manager Dialog Box
Cluster Placement Dialog Box
Cluster Placement Status Dialog Box
Cluster Properties Dialog Box
Collaboration Data Import Dialog Box
Compare/ECO Tools Dialog Box, Comparison Tab
Compare/ECO Tools Dialog Box, Documents Tab
Compare/ECO Tools Dialog Box, Update Tab
Component Layer Associations Dialog Box
Component Properties Dialog Box
Component Rules Dialog Box
Conditional Rule Setup Dialog Box
Confirm Pin Swap Dialog Box
Connectivity Checking Setup Dialog Box
Convert Pin Pairs to Chamfered Paths Dialog Box
Copper Plane Manager Dialog Box
Create Array Dialog Box
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Create Die Dialog Box
Custom String Dialog Box
Customize Dialog Box, Commands Tab
Customize Dialog Box, Keyboard and Mouse Tab
Customize Dialog Box, Macro Files Tab
Customize Dialog Box, Options Tab
Customize Dialog Box, Toolbars and Menus Tab

Basic Script Editor Dialog Box
To access: Tools  > Basic Scripts  > Basic Script Editor  menu item

Basic is a simple scripting language. Like many Windows applications, such as Microsoft Word and 
Excel, PADS applications include Basic capabilities to allow users to customize their applications using a 
standard scripting language.

You can use the Basic Script Editor to create, edit, run, and troubleshoot Basic scripts from PADS 
applications.

Related Topics
Scripting and the Automation Server [SailWind Layout Command Reference Manual]

The Macro Language [SailWind Layout Command Reference Manual]

1124 SailWind Layout Guide and Reference

../../sailwindlayout_cmd_ref/topics/DISWChap_ScriptingAutomationServer_id9becda32.html
../../sailwindlayout_cmd_ref/topics/Contain_MacroLanguage_idbced4cde.html


 
GUI Reference Elements B Through C

Basic Scripts Dialog Box

Basic Scripts Dialog Box
To access: Scripts  > Script Manager

Use the Basic Scripts dialog box to access your scripts. In this dialog box, you can load and run your 
most commonly used scripts. You can also unload those scripts you do not use often. This dialog box 
runs only existing sample scripts.

Objects

Field Description

Script lists Lists the loaded scripts. The Script dropdown list and the Script list are 
synchronized

When you click the X button, the lower half of the dialog box 
“disappears”; leaving only the top left corner of the dialog box for 
interaction. When in reduced mode, click a script from the list and press 
the Enter key, or double-click on a script in the list.

In Menu Adds scripts to the Basic Scripting submenu from the Tools menu, 
where you can run often-used scripts directly from the menu without 
opening the Basic Scripts Dialog Box.

Run Runs the currently selected script.

Edit Opens the Sax Basic Engine dialog box where you can edit the 
selected script.

Load File Loads scripts into the list. You can load up to 32,767 scripts. Scripts are 
not compiled when they are loaded; they are compiled when you run 
them.
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Field Description

This list of scripts you load into this dialog box is saved in the 
VBScripts.ini  file, so these scripts load every time you open the Basic 
Scripts Dialog Box.

Unload File Unloads the selected script from the dialog box.

Related Topics
Basic Script Editor Dialog Box
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BGA Route Wizard Dialog Box

BGA Route Wizard Dialog Box
To access: BGA Toolbar  > Route Wizard  button

When you select the BGA Route Wizard button on the BGA Toolbar, the BGA Route Wizard dialog box 
appears. Use the BGA Route Wizard dialog box to generate connections only, or generate connections 
and routes. When you click either Run or OK, SailWind Layout stores in the design the selections you 
make in the BGA Route Wizard dialog box.

Note:
This information applies only to the BGA toolkit.

Description
The Die Wizard has 4 tabs:

• “Figure 132”  on page 1129

• “Figure 133”  on page 1129

• “Figure 134”  on page 1130

• “Figure 135”  on page 1130

The availability of tabs depends on whether you select Generate Connections or Generate Connections 
and Route from the Action area.

• If you select Generate Connections, the Routing  tab grays.

• If you select Generate Connections and Route, the Connections  tab grays.

• If you are creating a single-sided design, the BGA Fanouts  tab grays.
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Figure 131. BGA Route Wizard Dialog Box
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BGA Route Wizard Dialog Box

Figure 132. Connections tab

Figure 133. Routing tab
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Figure 134. Select Pads tab

Figure 135. BGA Fanouts tab
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BGA Route Wizard Dialog Box

Objects
Table  148. BGA Route Wizard Dialog Box Fields

Field Description

Die Ref Des list Displays the die reference designator when you open the BGA Route 
Wizard dialog box for the first time (per design), based on the logic 
families in the current design.
The BGA Route Wizard looks for parts having either a die part or flip 
chip special purpose setting. If more than one of these are found, 
one is randomly selected. If none is found, a component is randomly 
selected.

BGA Ref Des list Displays the BGA reference designator when you open the BGA Route 
Wizard dialog box for the first time (per design), based on the logic 
families in the current design.
The BGA Route Wizard looks for a BGA logic family. If no die with 
this logic family is found, a component is selected randomly. If more 
than one die has this logic family, one of the dies in that logic family is 
randomly selected.

Action area • Generate Connections  — Generates logical connections between 
die and BGA component pins. Connections are not routes; however, 
BGA fanouts  on page 1812 and SBP fanouts  on page 1857 are 
generated if specified in the Connections  tab.

• Generate Connections and Route  — Generates logical 
connections between component pins and creates trace patterns to 
route them. During processing, the following occurs:

• BGA fanouts are generated. This is performed on double-sided 
on page 1823 designs only.

• Serpentine routes  on page 1858 and plating tails  on page 1849
are generated.

• SBPs are logically assigned to the ends of serpentine traces 
and logical connections between die pins, and BGA pins are 
generated.

• SBP fanouts and any-angle coupling traces  on page 1809 are 
generated.

• The BGA Route Wizard generates route patterns on die and 
BGA layers only. The BGA layer contains only BGA fanouts. All 
other parts of route patterns (serpentine routes and plating tails, 
SBP fanouts and any-angle coupling traces) are created on the 
die layer.

tabs • Connections  on page 1127

• Routing  on page 1127

• Select Pads  on page 1127

• BGA Fanouts  on page 1127

Save Setup button Saves the selections you make in the BGA Route Wizard dialog box 
and stores them in a text file with a .brw  extension. This file is stored in 
the \SailWind Projects  folder.
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Table  148. BGA Route Wizard Dialog Box Fields  (continued)

Field Description

Load Setup  button Opens .brw  files that contain BGA Route Wizard settings.

Run  button Runs the routing process based on the selections made in the BGA 
Route Wizard dialog box.

Undo Last Run button Returns the design to its state prior to route processing. Undo Last 
Run  is unavailable until you run the routing process.

Table  149. Connections tab contents

Field Description

Existing Nets Controls predefined connections processing.
• When this option is selected, predefined connections are processed 

so BGA and SBP fanouts are generated for them.

• When this option is cleared, Die and BGA pins that already belong 
to signals are excluded from processing. BGA fanout and SBP 
fanout processing, if specified in the Connections  tab, are also not 
performed for existing connections.

The BGA Wizard interprets pins as obstacles and routes around them. 
If a new trace interferes with an existing trace, no shorts are placed and 
the new connection is unrouted. If a BGA or SBP pin has an existing 
fanout, it is used during processing.

 Tip
You can exclude some predefined connections using the Select 
Pads  tab.

Substrate Bond Pad Fanouts Creates SBP fanouts during connection generation. Specify the escape 
length and trace width in the SBP Fanout area.

BGA Fanouts Creates BGA fanouts during connection generation. This option is 
available only for double-sided packages.

Partitioning area Controls the pad partitioning displayed in the Select Pads  tab; creating 
sets of die pads and BGA pads to connect.:

• Side  — Die is partitioned by sides so that pad sets are: Right, Left, 
Top, and Bottom.

• Quadrant  — Die is partitioned into quadrants: Top Left, Top Right, 
Bottom Left, and Bottom Right.

See also: “Die Partitioning”.

Derive Net Name from Pin 
Function

Controls new net name generation. Select this option to use a pin's 
function as a basis for naming a new net.

Net Name Preferences area • Join Pads Having Same Net Name  — Combines die pads with the 
same function name into a single net.

• Iterate Net Name  — Generates separate nets for each die pad with 
the same name; for example, several GND die pads would have 
nets named GND1, GND2, and so on.
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BGA Route Wizard Dialog Box

Table  149. Connections tab contents  (continued)

Field Description

Net name preferences are shared between the Connections  tab and 
the Routing  tab. If you change net name preferences in one tab, the 
same changes occur in the other tab.

Trace Length Defines the SBP fanout trace length. The trace length is measured 
from the edge of the pad to the end of the trace.
If a value of zero is entered the trace is not created. The BGA 
Route Wizard also takes the SMD to Corner rule into account when 
generating this trace. This rule can make the BGA Route Wizard 
generate a longer trace than requested in the Trace Length box.

Trace Width Defines the SBP fanout trace width. The trace width must adhere to the 
minimum and maximum rule set in the Clearance Rules Dialog Box.
See also: “Design Rule Hierarchy”.

Table  150. Routing tab contents

Field Description

Coupling Routes and SBP 
Fanouts

Sets the trace width rules during route pattern creation for SBP fanouts 
on page 1857 and any-angle coupling routes  on page 1809.
Type a value into the Minimum and Recommended boxes. Values must 
be between the Minimum and Maximum trace width values defined in 
the Clearance Rules Dialog Box.
The BGA Route Wizard uses the Recommended value whenever 
possible, and uses the Minimum value only for connections that it 
cannot route using the Recommended value.

Serpentine Routes and 
Plating Tails

Sets the trace width rules during route pattern creation for serpentine 
patterns  on page 1858 and plating tails  on page 1849.
Type a value into the Minimum and Recommended boxes. Values must 
be between the Minimum and Maximum trace width values defined in 
the Clearance Rules Dialog Box.
See also: “Design Rule Hierarchy”.
The BGA Route Wizard uses the Recommended value whenever 
possible and uses the Minimum value only for connections that it 
cannot route using the Recommended value.

Rules button Opens the Default Rules Dialog Box.

Existing Nets Controls predefined connections processing.
• When this option is selected, predefined connections are processed 

so BGA and SBP fanouts are generated for them.

• When this option is cleared, Die and BGA pins that already belong 
to signals are excluded from processing. BGA fanout and SBP 
fanout processing, if specified in the Connections  tab, are also not 
performed for existing connections.

The BGA Wizard interprets pins as obstacles and routes around them. 
If a new trace interferes with an existing trace, no shorts are placed and 
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Table  150. Routing tab contents  (continued)

Field Description
the new connection is unrouted. If a BGA or SBP pin has an existing 
fanout, it is used during processing.

 Tip
You can exclude some predefined connections using the Select 
Pads  tab.

Plating Tails Specifies to create plating tails  on page 1849 for serpentine traces  on 
page 1858.

Derive Net Name from Pin 
Function

Controls new net name generation. Select this option to use a pin's 
function as a basis for naming a new net.

Net Name Preferences area • Join Pads Having Same Net Name  — Combines die pads with the 
same function name into a single net.

• Iterate Net Name  — Generates separate nets for each die pad with 
the same name; for example, several GND die pads would have 
nets named GND1, GND2, and so on.

Net name preferences are shared between the Connections  tab and 
the Routing  tab. If you change net name preferences in one tab, the 
same changes occur in the other tab.

Tail Length Defines the length of the plating tail wire  on page 1849 from the 
outside row of a BGA (single-sided package) or from a BGA fanout via 
(double-sided package) to the end point of the plating tail.
On single-sided packages the wire length is measured from the center 
of the BGA pad to the end of the plating tail, even if a test point via is 
added.
On double-sided packages the wire length is measured from the center 
of the BGA via to the end of the plating tail, even if a test point via is 
added.

 Tip
The BGA Route Wizard extends plating tails through the board 
outline, if necessary, without generating an error in the BGA 
Route Wizard Report that displays after you run the route 
wizard. However, Clearance Checking will produce errors in this 
circumstance.

End with Test Point Creates a test point at the end of each new plating tail.

 Tip
On the File menu, click Reports. Run the DFT Extended test point 
report to check that all traces have a plating tail.

Via Type list Defines the via type to use for the test point. The list contains the vias 
that are defined in the PCB Decal Editor for each part.
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BGA Route Wizard Dialog Box

Table  151. Select Pads tab contents

Name Description

Select Sides/Select 
Quadrants

The available partitioning type depends on whether the Generate 
Connections or Generate Connections and Route option is selected in 
the Action area.
Use the partition check boxes to select partition sets. The available 
Side partition sets are Right, Left, Top, and Bottom. The available 
Quadrant partition sets are Top Left, Top Right, Bottom Left, and 
Bottom Right.
Only the pins from selected sets appear in the Substrate Bond Pad and 
BGA Pins lists.

Select Graphically button Opens the Select Graphically Dialog Box.

Substrate Bond Pads area Lists the substrate bond pads to include in or exclude from processing.

 Tip
Die and BGA pads that already belong to signals are excluded 
from processing unless Existing Nets on the Connections  tab is 
selected.

BGS Pins list Lists the BGA pins to include in or exclude from processing.

 Tip
Die and BGA pads that already belong to signals are excluded 
from processing unless Existing Nets on the Connections  tab is 
selected.

Exclude button Removes selected pins from the Included list and adds them to the 
Excluded list.

Include button Removes selected pins from the Excluded list and adds them to the 
Included list.

Number of Included Pads Displays the number of pads currently listed in the Included list.

Table  152. BGA Fanout tab contents

Field Description

Fanout Style list Sets the fanout pattern. The available fanout styles depend on the grid 
array geometry. Herringbone and Diagonal are available for regular 
(non-staggered) arrays. Vortex and Double Vortex are available for 
staggered arrays.

Direction area • Out  — Turns BGA fanouts to the outside of the design.

• In  — Turns BGA fanouts to the inside of the design.

• Clockwise  — Turns BGA fanouts in a clockwise direction.

• Counterclockwise  — Turns BGA fanouts in a counterclockwise 
direction.

If either Orthogonal for Outside Row or Orthogonal for Inside Row 
is selected, the direction options only affect BGA fanouts within the 
central rows when more than two rows of BGA pads exist.
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Table  152. BGA Fanout tab contents  (continued)

Field Description

Orthogonal for Outside Row Turns BGA fanouts on the outside row outward at an orthogonal angle 
with respect to the die. If this option is selected, the Direction options 
have no effect on the outside row.

Orthogonal for Inside Row Turns BGA fanouts on the inside row inward at an orthogonal angle in 
respect to the die. If this option is selected, the Direction options have 
no affect on the inside row.

Trace Width Defines the trace width to use for BGA fanouts. The trace width must 
adhere to the minimum and maximum rule set in the Clearance Rules 
Dialog Box.
See also: “Design Rule Hierarchy”.

Via Type list Defines the via type to use for BGA fanouts. The list contains the vias 
that are defined for this design using Setup  > Pad Stacks.

Preview Window Shows the fanout pattern defined by the current settings on the BGA 
Fanouts  tab. In this window you can see that pads excluded from 
processing on the Select Pads  tab do not receive a fanout pattern.

 Tip
If Existing Nets on the Connections  tab or Routing  tab is selected, 
all pads, including pads that are not currently part of a predefined 
connection, are assigned a fanout pattern.

Related Topics
The BGA Route Wizard

Creating a Wire Bond Fanout
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Browse for Special Symbols Dialog Box

Browse for Special Symbols Dialog Box
To access:

• File  > Library  menu item > select a Library > Parts  button > New

• File  > Library  menu item > select a Library > Parts  button > select a connector Edit  button > 
Connector  tab > double-click Special Symbol cell > Browse  button

Use the Browse for Special Symbols dialog box to assign one or more CAE decals, or Special Symbols, 
to a pin type. Special Symbols indicate the function of the connector pin in SailWind Logic.

Figure 136. Browse for Special Symbols Dialog Box

Objects

Field Description

Preview area Shows the item selected in the Gate Decals list.

Gate Decals List of available Gate Decals.

Library list Lists all libraries available to you.

Items Narrows down your Gate Decals list. You can use wildcards in this 
box.

Apply Executes the filter arguments.
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Related Topics
Part Information Dialog Box, Connector Tab

Creating a Connector Part Type

Assigning Special Symbols to a Connector
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Browse Library Attributes Dialog Box

Browse Library Attributes Dialog Box
To access:

• File  > Library  menu item > Library Manager dialog box > Attr Manager  button > Browse Lib. 
Attr  button

• File  > Library  menu item > Library Manager dialog box > Attr Manager  button > Add Attr  button 
> Browse Lib. Attr  button

• Attribute Properties dialog box > Browse Lib. Attr.  button

Use the Browse Library Attributes dialog box to select an attribute from a list of all part and decal 
attributes available to the design.

Objects

Field Description

Attribute Displays the selected attribute.

Group Filters the attribute list. (Includes structured attributes  on 
page 1862.)

Refresh Manually updates the attribute list if you change the list of libraries 
in the Library Manager.

SailWind Layout Guide and Reference 1139



GUI Reference Elements B Through C
Browse Library Attributes Dialog Box  

Related Topics
Renaming Attributes of Library Items
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Build Clusters Setup Dialog Box

Build Clusters Setup Dialog Box
To access: Tools  > Cluster Placement  menu item > Build Clusters  button> Setup  button

Use the Build Clusters Setup dialog box to create new clusters from parts and unions. Creation is based 
on connectivity.

Objects

Field Description

Unlimited Specifies unrestricted parts per cluster.

Max. Parts Per Cluster box Sets the maximum number of parts allowed in one cluster.

Minimum Top Level Count Sets the minimum number of top-level clusters allowed. A top-level 
cluster is a cluster not contained within another cluster. If you set this 
to a low number and set Maximum Parts Per Cluster to Unlimited, all 
parts are grouped into one large cluster.

Create New Clusters Allows you to create new clusters. Clear the check box to modify only 
previously created clusters.

Unglued Parts Number box Displays current number of unglued parts in the design. The box 
remains unavailable for editing.

Build Mode area Clusters are identified as either open or closed:
Rebuild Open Clusters  — You can delete or replace an open cluster 
during automatic cluster creation. Automatically created clusters default 
to open.
Maintain Open Clusters  — You cannot delete or replace a closed 
cluster during automatic cluster creation. Manually created clusters 
default to closed.
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Related Topics
Automatic Placement
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Button Appearance Dialog Box
To access: Tools  > Customize  menu item. In the Customize dialog box, right-click on a menu or menu 
item in SailWind Layout and click the Button Appearance  popup menu item.

Use the Button Appearance dialog box to customize the appearance of menu items.

Objects

Field Description

Image only,
Text only,
Image and text

For menu items, choose what to display in the menu. Images appear 
in the gutter to the left of the command name. Applying images for 
menu items does not function for the menu name but only menu 
items.

Description This field is not available.

Use Default Image Use the recommended image.

Select User-defined Image Select or create your own image to associate with the new 
command.

New Open the Edit Button Image Dialog Box.

Edit Open button in the Edit Button Image Dialog Box.

Button Text Type the name for the menu item. Use the “&” character to the left 
of the letter you want to use with the Alt button to select menu items 
without the mouse and cursor.
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Related Topics
Customize Dialog Box, Commands Tab
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CAM350 Link Dialog Box

CAM350 Link Dialog Box
To access: File  > Export  menu item > select CAM350 Files > Save

Use the CAM350 dialog box to set options for, and to generate, a .cam  output file.

Objects

Field Description

Mode area Specifies the CAM350 mode you want:
• Create File Only to simply produce the .cam  file

• Create File and Launch CAM350 to start CAM 350 
and load the resulting .cam  file.

Layer Options 
area

Specifies the amount of SailWind design detail to 
translate to the CAM350 database.

• CAM Documents (includes Nets and Parts) 
— Translates CAM documents with part and net 
intelligence. Plot orientation, as specified in the CAM 
document, is not applied. This is useful for verifying 
net lists and DRCs in CAM350.
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Field Description

 Note:
Requirement:  Before using this option, flood all 
copper planes. Also, on the Tools  > Options 
menu item > Copper Planes  category > Hatch 
and Flood  subcategory, in the Save to PCB File 
area, click “All copper plane data”. This allows all 
pour data to be passed to CAM350.

• CAM Documents (Graphics only, Orientations 
applied)  — Translates CAM documents with plot 
orientation, including offset, rotation, mirroring, and 
scaling. This is useful for direct Gerber file translation 
to CAM350 where no component or net information 
is required. Requirement:  Before using this option, 
if your SailWind Layout photoplot output format is set 
to RS-274D, make sure your CAM350 default units 
(mils or inches) and CAM350 default precision are 
set to match the units for SailWind Layout and the 
precision for SailWind Layout File/CAM photoplot 
output, respectively. CAM350 Link uses the files 
pads3.arl (for English units) and pads3m.arl  (for 
Metric units) with this option and when Gerber files 
are in RS274-D format. The *.arl files determine how 
the aperture report file (*.rep) is generated by CAM in 
SailWind Layout will be interpreted by CAM350.

• CAD Layers -> CAM Layers (As-Is)  — Translates 
no CAM documents. Translates CAD layers as 
defined in the SailWind Layout database. This 
is useful for legacy CAM processes that take 
advantage of CAD layer translation using the 
PADS-ASCII format import operation in CAM350.

Requirement:  Before using this option, flood all 
copper planes. Also, on the Tools  > Options  menu 
item > Copper Planes  category > Hatch and Flood 
subcategory, in the Save to PCB File area, click “All 
copper plane data”. This allows all pour data to be 
passed to CAM350.

Arc 
Approximat
ion Tolerance

Specifies the minimum allowable distance between 
the actual arc path and the approximated straight-line 
segments.
Tip:  This is shown in the design units you set on the 
Global  tab.

CAM350 File 
Name

Specifies the path and name for the CAM350 file. The 
default file name and path are the same name as the 
current design file name and path.
Tip:  Click Browse to navigate to a location.

Related Topics
Exporting to CAM350

Annotating DFF Errors
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CAM Plus Dialog Box

CAM Plus Dialog Box
To access: File  > CAM Plus

The CAM Plus command generates computer-aided manufacturing (CAM) output files that are compatible 
with a variety of automatic assembly and pick-and-place machines. Before you use CAM Plus, prepare an 
information file called part.def.

Objects

Field Description

Part Definition Filename The name of the Part Definition file. The file part.def  is read from the 
\Libraries  folder by default.

Side The side of the board on which you want to report: Top or Bottom.

Parts The type of parts to include in the report: SMT, ThruPin, All, and 
Masked. For more information, see “Batch Mode and Masked Mode” 
on page 978.
Tip:  Masked parts are those that are assigned to the machine selected 
format as an insert class.
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Field Description

Read Part Definition Specifies to add the additional information contained in the Part 
Definition File, part.def, to the parts contained in a design.
This information defines the insertion class for all parts. Read Part 
Definition scans the Part Definition File for information about the parts 
in the database. When an exact match is found between a part type 
name in the database and a part type name in the definition file, the 
information combines to provide the manufacturing output.

Read Value Definition Specifies to read the Value attributes for each part in the SailWind 
Layout design and append the Value attribute to the part type name 
when matching each part type in the Part Definitions file, part.def.
Example:  An R1/4W part type with Value attribute 100K 
could have an entry in the Part Definitions file as follows: 
R1/4W{100K},ins=un6241,bodydiam=200,leaddiam=30,anvil=2

Verify File Specifies to produce an ASCII verification file.
This ASCII file is stored in the \SailWind 
Projects\Cam\<board_file_name> folder. This file contains 2D line data 
that describes the path for the inserted parts. The name of the file is 
the name of the interface program created, with the .asc  extension. You 
can read this file into SailWind Layout with the ASCII In command. It 
states the insertion path as 2D lines on layer 19. If a Part_Num value 
for a part is not found, Part_Num is set to Missing.

Batch Part Def. File Specifies to run all of the outputs with a single command. For more 
information, see “Batch Mode and Masked Mode”  on page 978.
For each program you run, an output file is produced with the name 
suffix bt or bb, for example dym318bt.smt  or un6241bb.put. If this file 
already exists, the message “Overwrite existing file (Y/N)?” appears. 
Click either Yes or No. If you click Yes, the file is overwritten and 
placed in the CAM subfolder. Each of the parts in the selected category 
is added to the file. A report called insert.lst  lists each part and the 
machine that inserts it. The Batch command does not create a Verify 
file.

X-/Y-Offset Defines the offset of the machine’s location dowel with regard to the 0,0 
system origin board.
These offset values convert the design coordinates to the machine 
origin. Allowable values are from 0 to 10 inches. Offset values are in 
inches; for example, 1250 is 1.25 inches. You may need to define a 
new Board offset for each machine.
The default is 0 offset, equivalent to treating the CAD system origin as 
the origin of the machine. Another way to think of this is that the X and 
Y offset are the distance from the location dowel of the machine to the 
SailWind Layout system origin. If the location dowel is in the lower left 
corner, this will be a positive value.

X-/Y-Count and X-/Y-Step define whether to treat the board as a single design when creating the 
output program file, or to insert a number of boards simultaneously.
When you insert a number of boards, you can define the number of 
steps in the X and Y direction and the step and repeat interval to use, 
as shown below. CAM Plus uses current design units for the offset and 
step and repeat values. Each machine has its own units type to which 
the data is always converted regardless of the current design units. 
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CAM Plus Dialog Box

Field Description
CAM Plus generates assembly program files for inserting parts on all 
boards.

• X-Count  — Number of copies in X direction. The maximum is 20.

• Y-Count  —Number of copies in Y direction. The maximum is 20.

• X-Step  —The step distance in the X direction between the origin of 
each board. The maximum is 10 inches.

• Y-Step  —The step distance in the Y direction between the origin of 
each board. The maximum is 10 inches.

The default is no step and repeat, equivalent to a step of 1 in X and Y.

Output Format Specifies the machine format.
Files are produced for all parts of a selected class: masked, through 
hole, SMT, top, bottom, and so on. All parts in the class are included in 
this output whether or not their insert class is defined as belonging to 
the specific machine.
When an output is performed, the resulting file or files are stored 
in a program-created folder under \SailWind Projects\cam. The 
subfolder matches the design's file name. For example, if the design 
loaded when CAM Plus is started is test.pcb, the results are stored in 
\SailWind Projects\cam\test.

Universal Tooling and
Universal Axial Output

Specifies the desired settings, if applicable.
Restriction:  Universal-specific instructions are available when you 
select Universal machine formats or check Batch Part Def. File.

Status Messages Displays the current state of output. Populated after you click Run.

Run Generates the output file.

Related Topics
CAM Plus Assembly Machine Interface
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CAM Preview Dialog Box
To access:

• File  > CAM  menu item > Preview  button

• File  > CAM  menu item > Add  button > Preview Selections

• File  > CAM  menu item > Add  button > Layers  > Preview  button

Use the CAM Preview dialog box to preview your CAM Documents.

Objects

Field Description

Document list Lists the available documents to preview.

Setup Opens the “CAM Preview Setup Dialog Box”  on page 1152.

Zoom area — In addition to the buttons of this area, you can zoom using the mouse.
• Right-click to zoom out by a factor of 2, centered on the pointer location.

• Click to zoom in by a factor of 2, centered on the pointer location.

• Click and drag to draw a zoom rectangle centered on the pointer location. Drag the pointer towards 
the top of the screen, diagonally from the indicated pointer locations to zoom in. Drag the pointer 
towards the bottom of the screen, diagonally from the indicated pointer locations to zoom out.
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CAM Preview Dialog Box

Field Description

Board Fits the contents of the selected document into the preview window.

Extents Fits the world, or the whole coordinate system, into the preview window.

Workspace Fits the current screen view into the preview window.

Refresh Refreshes the view from changes in the design or when you remove the 
application focus from the CAM Preview dialog box. For example, switch 
back to the preview window from another application and you will need to 
click Refresh.

Related Topics
Creating CAM Outputs to Manufacture Your PCB
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CAM Preview Setup Dialog Box
To access: File  > CAM  menu item > select a document > Preview  button > Setup  button

Use the CAM Preview Setup dialog box to invert, show plot orientation, or overlay multiple CAM 
Documents. If desired, you can change the preview attributes of all documents.

Tip
You must have at least one CAM document defined to use preview setup.

Objects

Field Description

Document Displays the document name.

Visible Specifies the documents you want to see; you can overlay multiple 
CAM documents. This requires that you have already set up other CAM 
documents.

Inverse Specifies to invert the view of a CAM document. You might want to 
invert the view of CAM Plane layers since they are negative layers and 
will appear different than all other layers.

Orient Specifies to scale and orient the preview data as defined by the CAM 
document plot options.

Related Topics
CAM Preview
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CBP Properties Dialog Box
To access: BGA Toolbar  button > Wire Bond Editor  button > Select a CBP > right-click > Properties 
popup menu item

The CBP Properties dialog box displays the pad number, function, position, and dimensions of the 
selected component bond pad. In the Wire Bond Editor, with one or more CBPs selected, right-click and 
click Properties to edit the CBP Properties.

Note:
This information applies only to the BGA toolkit.

Objects

Field Description

Pad # Assigns a number to the currently selected component bond pad. By 
default, it is the same number as the substrate bond pad to which it is 
connected.

Function Defines the function of the currently selected bond pad.

Fanout Side list Selects the side of the SBP Guide to which the CBP should be wire 
bonded. The possible values are left, top, right, and bottom.
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Field Description

Wirebond Displays the name of the substrate bond pad and the component bond 
pad that are connected by the wire bond.

X and Y Displays the X and Y coordinates of the bond pad. Type new values to 
move the bond pad.

Shape list Assigns a shape to the currently selected bond pad: Rectangle or Oval.

Length Assigns a physical length, in current design units, for the currently 
selected bond pad.

Width Assigns a physical width, in current design units, for the currently 
selected bond pad.

SBP button Opens the SBP Properties Dialog Box  for the component bond pad 
connected to the currently selected substrate bond pad. This button is 
unavailable if there is no connected component bond pad.

WB button Click WB to open the Wire Bond Properties Dialog Box  for the 
wire bond connected to the currently selected pad. This button is 
unavailable if there is no connected wire bond.

Related Topics
Editing Component Bond Pad Properties
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CCE Export Dialog Box
To access: File  > Export  menu item > select CCE Files > Save

Using the CCE Export dialog box, you can export design elements to CAMCAD, and visECAD.

Objects

Field Description

Solder Mask Options • Use unaltered solder mask layer data  — Select this option 
to use the solder mask data as it exists in the design. No 
additional pads are added and no oversizing or undersizing is 
applied.

• Use CAM-processed data  — Select this option to accept 
automatically-generated pads copied from the associated top or 
bottom layer, including any oversizing or undersizing.

You are not required to create solder mask shapes in each pad 
stack. During export, pads are copied from the outside layer to 
the solder mask layer for use as the solder mask shape.

• Over(Under)size pads by  — Type a value to apply a global 
oversize or undersize to all solder mask pads.

This global setting is the lowest of a hierarchy of possible 
values. For more information, see “Control of Solder Mask 
and Paste Mask”.
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Field Description

Paste Mask Options • Use unaltered paste mask layer data  — Select this option to 
use the paste mask data as it exists in the design. No additional 
pads are added and no oversizing or undersizing is applied.

• Use CAM-processed data  — Select this option to accept 
automatically-generated pads copied from the associated top or 
bottom layer, including any oversizing or undersizing.

You are not required to create paste mask shapes in each pad 
stack. During export, pads are copied from the outside layer to 
the paste mask layer for use as the paste mask shape.

• Over(Under)size pads by  — Type a value to apply a global 
oversize or undersize to all paste mask pads.

This global setting is the lowest of a hierarchy of possible 
values. For more information, see “Control of Solder Mask 
and Paste Mask”.

Component Outline Layer Choose a layer to use as the highest priority layer when searching 
for component outline shapes for each decal to export. Only layers 
marked as Enabled in the “Enable/Disable Layers Dialog Box”  on 
page 1365 are available. If you choose the Auto-detect item, the 
following search order is applied to locate a component outline:
1. Checks if the SailWindpcb.ini  option for the placement outline 

selection exists ([Graphics] 3D_Shape_Layer) and tries that 
layer.

2. Tries PADS layer 25 (recommended layer for 3D outline).

3. Tries PADS assembly top layer.

4. Tries PADS top layer.

5. Tries PADS layer 0 (“All Layers” layer setting).

6. Tries PADS layer 20 (recommended layer for placement 
outlines). If no closed shapes are found, goes to next search.

7. If no closed shapes are found, uses an artificial extents box 
around all component pins.

8. If no pins exist, uses an artificial extents box around all footprint 
elements (coppers, lines, and text).

9. If nothing is found, uses an artificial tiny box for empty 
footprints.

Found or generated outline shapes for a specific 
component are placed on PLACEMENT_OUTLINE_TOP or 
PLACEMENT_OUTLINE_BOTTOM (special layers in the CCE 
file) depending on the side of the board where the component is 
placed.
The CCE Export report file lists the layer used for each decal when 
using Auto-Detect. When a specific layer is selected on the export 
dialog, the report only lists decals and source layers that do not 
match the requested layer.

Related Topics
Exporting CCE Files
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Change Component Dialog Box
To access: select a component > ECO Toolbar > Change Component  button > right-click > Library 
Browse  popup menu item > select a part type > Replace

Use the Change Component dialog box to authorize changing a part type in the design and to control the 
retention of the attributes of the part in the design.

Objects

Field Description

Keep Attributes Select the check box to keep the attributes of the part in the design and 
apply them to the replacement part.

Yes Proceeds with the change of the part(s) in the design.

No Cancels the Replace command and returns you to the Get Part Type from 
Library Dialog Box.

Cancel Cancels the Change Component

Related Topics
Changing a Component in ECO Mode

Updating a Part Type from the Library in ECO Mode
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Choose Alignments Dialog Box
To access: From the Manage Mappings dialog box, select a part from the “Parts without model” list and 
assign it to a 3D model in the “Parts mapped to models” list; then click Yes  at the prompt.

Use the Choose Alignments dialog box to select an existing alignment pattern for a 3D model that you 
want to reuse with another part.

A part selected for a model assignment will initially align the 3D model in accordance with the alignment 
information in the part’s decal. You can use the Choose Alignments dialog box to accept or reject the pre-
established decal alignment.

Objects

Field Description

Cells to align Displays the name of the part decal that can reuse a 
model alignment.

Use alignment Displays a list of decal model alignments that can be 
reused.
For example, if you want to assign the 3D model for a 
capacitor to a resistor (because the 3D models appear 
the same), and the 3D model of the capacitor is currently 
used with decal CC0805, the decal name of “CC0805” 
appears in this field.
You can use the alignment of the current decal or select 
None  from the dropdown list to align the 3D model 
manually.
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Check for Updates Dialog Box
To access: Help  > Check for Updates  menu item

Use the Check for Updates dialog box to manually check for a new version of PADS, and to disable or 
enable automatic checks.

Objects

Field Description

Check for Updates button Manually checks for a new version of the SailWind software.

Disable “Check for Updates” 
functionality

Determines if SailWind automatically checks for a new version of the 
software.
Click to stop SailWind from automatically checking for a new version 
of the SailWind products; click to clear to have SailWind automatically 
check for a new version.

Related Topics
Check for (Software) Updates
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Check Teardrop Dialog Box
To access: Tools  > Options  menu item > Teardrops  tab > Check  button

Use the Check Teardrops dialog box to check for and view teardrop errors. SailWind Layout reports the 
error location, layer, and a short explanation of the error.

Description
You must enable teardrops before you can check them. Tools  > Options  menu item > Routing  tab > 
select Generate Teardrops check box > click OK.

Objects

Field Description

Location list The location of the teardrop error.
Click an error to pan to it in the design.

Errors Lists the total number of teardrop errors in the design

Explanation list The reason for the error selected in the Location list.

Disable Panning Specifies to not pan to the error selected in the Location list.

Clear Errors Clears only the error markers in the design. Does not fix the errors.

Start Runs the teardrop check.

View Report Lists the most recently run report results in your default text editor.

Report File Opens the Save As dialog box where you can specify the name of the 
error report and where to save it. This changes the default name of the 
report file until you change it.
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Check Teardrop Dialog Box

Related Topics
Modifying Net Properties
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Class Rules Dialog Box
To access: Setup  > Design Rules  menu item > Class  button

Use the Class Rules dialog box to create and manage classes of nets and to define design rules that 
apply to them.

Objects

Field Description

Class name Specifies the name of the class.

Class list Lists all class names.

Add Adds the class name to the Class list.

Delete Removes the selected class from the Class list.

Rename Renames the class selected in the Class list with the text in the Class 
Name box.

Show Classes with rules Specifies to show only classes that have rules.

Clearance Opens the Clearance Rules Dialog Box.
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Field Description

Routing Opens the Routing Rules Dialog Box.

HiSpeed Opens the HiSpeed Rules Dialog Box.

Report Opens the Rules Report Dialog Box.

Nets Available list Lists the nets available for this class.

 Tip
Nets cannot exist in more than one class. The Available list displays 
only nets that have not been assigned to a class.

Nets Selected list Lists the nets selected for this class.

Add >> Moves the net from the Available list to the Selected list.

<< Remove Moves the net from the Selected list to the Available list.

Picture below rule button The picture below each type of rule button identifies which rules 
hierarchy level is used for that rule type. The meaning of the picture 
corresponds to the button in the Hierarchy area of the Rules Dialog 
Box. For example, if you select a class in the Class list and a green 
polygon appears below the Clearance button, then the default values 
apply to the class.
See also: “Non-Default Rules Indicators”.

Default Removes non-default rules from the selected classes, so that only 
default rules apply.

Related Topics
Creating Class Design Rules

Deleting a Design Rule Class

Adding Nets to an Existing Design Rule Class

Removing Nets from a Design Rule Class

Modifying Class Design Rules

Renaming a Design Rule Class

Resetting Class Rules to Default Rules

Displaying the Nets of a Class Design Rule

Design Rule Hierarchy

SailWind Layout Guide and Reference 1163



GUI Reference Elements B Through C
Clearance Checking Setup Dialog Box  

Clearance Checking Setup Dialog Box
To access: Tools  > Verify Design  menu item > Clearance check > Setup  button

Use the Clearance Checking Setup dialog box to specify which clearances to check during a Clearance 
verification.

Objects

Field Description

Net to All Checks clearance rules from all levels of the Rules Hierarchy (all nets 
against all foreign obstacles).

Board Outline Checks clearance rules of net objects against the board outline and 
board cut outs (pins, vias, traces, and copper). When clearance 
checking against the board outline, the edge of the object is checked 
against the centerline of the board outline.

 Note:
Requirement:  You must also select the Body to body check box to 
check component outlines against the Board outline.

Off Board Text Checks for off board text and flags all instances of off board text as 
clearance errors.

Keepout Checks for keepout restriction violations.

Same Net Checks clearances between objects along the same net. Object to 
object checking includes the checks listed below:
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Field Description

• Pad edge to pad edge — 

• Pad edge to inside corner of trace — 

• SMD edge to pad edge — 

• SMD edge to inside corner of trace — 

• Acute angle between pad and trace — 

Drill to Drill Checks clearances between all drill holes. Pad stack drill size plus the 
drill oversize value calculate the diameter for plated holes.

 Restriction:
Drill to Drill errors are reported for only one layer in a drill pair.

Partial Via drills Checks for via configurations that can cause drilling problems during 
fabrication, specifically, configurations where two partial vias:

• Are at the same location,

• Have different drill sizes, and

• Share a layer (for example, VIA1-2, VIA2-4)

 Restriction:
This option is available only when Drill to Drill is selected.

Trace Width Checks traces in excess of minimum and maximum widths.

Body to body Checks component body outline against component body outline.

 CAUTION:
The Verify Design “Body to body” check does not check component 
outlines against TH or SMD pads.
 Tip
When used in combination with the Board Outline check, you can 
check component outlines against the board outline.

The component body outline is the furthest extent of any 2D line object 
on the following layers.
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Field Description

• Component layer (top or bottom)

• Associated silkscreen layer for component layer (silkscreen top or 
bottom)

• All Layers/Layer 0 (zero)

If you have a larger placement outline on Layer 20, see the Placement 
Outline check.

 Restriction:
This option is not available for Latium design checking.

Placement Outline In default layer mode, Placement Outline checks outline against outline 
on layer 20, not on electrical layers.

 Tip
Changing from default layer mode to increased layer mode 
increases all nonelectrical layer numbers by 100, so in increased 
layer mode, Placement Outline checks outline against outline on 
layer 120.

You can create outlines on layer 20 (or layer 120) that do not exactly 
match the actual silkscreen component outline. By setting a larger 
outline on this layer you can leave an area near a component open for 
other purposes. Using the Placement Outline check, you ensure that 
this area is left open.
See also: “Nudging Overlapping Parts  on page 500”.

Latium Error Markers Shows Latium error markers. A Latium error marker indicates that you 
have Latium rules in your design. You can only check these rules by 
using the Latium Design Verification option in the Verify the Design  on 
page 1775 dialog box.

Related Topics
Setting Up Clearance Checking
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Clearance Rules Dialog Box
To access: Setup  > Design Rules  menu item > choose a hierarchy level > Clearance  button

Use the Clearance Rules dialog box at any level of the rules hierarchy to define minimum edge-to-edge 
spacing between objects, and to define trace widths. Online DRC and design verifications check and 
report any clearance violations. SailWind Layout checks object types against other object types as well as 
against themselves (such as traces). Values display in current design units.

Objects

Area Description

Same net Specifies the space that must be maintained between items that are of the same 
net.

• SMD  — surface mount pad

• SMD-to-via  — value is also used for SMD-to-SMD and SMD-to-Pad rules

• Via-to-via  — value is also used for VIA-to-PAD and PAD-to-PAD

• Corner  — first trace bend point

• Pad  — through hole pad

• Trace-to-corner  — trace and the bend point of another trace. For example, a 
trace splits at a T-junction and one of the two traces has a bend point.

 Restriction:
Trace-to-Corner clearance is only used by SailWind Router. It is not used in 
Layout (either by Online DRC or checked by the Verify Design tool).

 Tip
To set the same value for an entire row, column or the table, click on a column 
heading (such as Corner, Via), row heading (such as Via, SMD), or All. Then 
type a value and click OK to apply the value.
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Area Description

Trace width Specifies the allowed range of trace widths.
• Minimum  — Minimum width for interactive routing

• Recommended  — Width to use when routing begins; except in SailWind 
Router where the width is automatically adjusted if the pin pitch is too small and 
using the recommended width would violate the trace to pad clearance.

• Maximum  — Maximum width for interactive routing

 Tip
Routing respects the minimum and maximum values when it varies trace width 
to achieve high-speed routing functions, for example, impedance matching.

Clearance Specifies the space that must be maintained between items of different nets.
• Trace to Trace  — The Gap value set in the Differential Pairs Dialog Box  has 

precedence over this value.

• SMD  — surface mount pad

• Corner  — first trace bend point

• Pad  — through hole pad

• Via  — also applies to jumper pins and virtual pins

• The Copper to Via, Pad, SMD or Drill values are also used to create the default 
thermals and anti-pads.

See also: “Design Rule Versus Pad Stack - Thermals and Antipads”  on 
page 797.

 Note:
• To set the same value for an entire row, column or the whole table/matrix, 

click on a column heading, row heading, or All. Then type a value and click 
OK to apply the value.

• Chamfered path copper uses the Solid Copper property which switches the 
copper to use trace clearances.

Other Specifies the clearances between additional design objects:
• Drill to drill  — Specifies the spacing required between drills

• Body to body  — Specifies the spacing required between the component body 
outlines.

 Note:
The spacing between component bodies is measured from the edges of the 
lines used to define the component body outlines.

Delete button Removes non-default clearance rules at the current level of the rules hierarchy.

 Restriction:
You cannot delete the Default clearance rules.

OK button  Restriction:
This button is unavailable if you are not licensed for the advanced rules but you 
have opened this dialog box to an advanced level of the rules hierarchy through 
the Properties of an object.

For example, with a pin pair selected, you right-click and click Properties. In the 
Trace Properties dialog box, you click the Rules button and in the Pin Pair Rules 
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Clearance Rules Dialog Box

Area Description
dialog box, you click Clearance. In the resulting Clearance Rules dialog box, the 
OK button is unavailable.

• Tips:

◦ You can set default clearance rules on a per-layer basis by creating All-to-Layer 
conditional rules. See also: “Conditional Rule Setup Dialog Box”.

◦ The BGA Route Wizard uses properties defined in this dialog box. See also: “BGA 
Route Wizard Dialog Box”.

Related Topics
Design Rule Hierarchy

SailWind Layout Guide and Reference 1169



GUI Reference Elements B Through C
Cluster Information Properties Dialog Box  

Cluster Information Properties Dialog Box
To access: Select a union within a cluster > right-click > Properties  popup menu item > Cluster Info 
button

The Cluster Information Properties dialog box modifies cluster attributes for the selected component or 
union that belongs to a cluster.

Objects

Field Description

Seed Identifies a cluster as a base, or top level cluster, during build and grow 
operations. SailWind Layout searches outward from seed clusters to 
identify other clusters that you can add to the seed cluster.

Skip while Building Cluster Ignores the union or cluster during Grow Incremental and Grow 
Automatic operations.

Related Topics
Union Properties Dialog Box
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Cluster Manager Dialog Box
To access: Tools  > Cluster Manager  menu item

Use Cluster Manager to display and manage cluster members and unions. You can move cluster 
members and unions from one cluster to another and break, or delete, clusters. Cluster Manager works 
similarly to the Microsoft Windows Explorer; with it you can view items at the top level or at any level of 
the hierarchy.

Objects

Field Description

Hierarchy Keeps track of the current cluster hierarchy. Top is the default level. 
Expanding a cluster causes the cluster, union, or member name to 
appear, separated by a forward slash (/).

Name Displays the name of the highlighted cluster or union. Rename a cluster 
or union by typing a new name and clicking Rename.

Rename Renames the selected cluster.

List Boxes Use either of the two list boxes for viewing all clusters, unions, and 
components in the design. The Top Level radio button marks the active 
list. Items within the lists are identified by the prefixes shown:
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Field Description

• Clusters — CLU

• Unions — UNI

• Components — com

Move area Moves members of a cluster from one list to another.

Expand Changes the contents of the list box to show only the objects in the 
cluster. The Top Level radio button changes to display the cluster 
name.

Collapse Returns to the top-level view, collapsing the hierarchy.

Break Deletes the selected cluster. You must click OK to remove the cluster 
from memory.

Find Opens the Find in hierarchy dialog box where you can find a specific 
cluster, union, or component name within the listed hierarchy. If a 
searched name is part of a cluster or union, it expands to show all 
members.

Related Topics
Automatic Placement

Cluster Placement
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Cluster Placement Dialog Box
To access: Tools  > Cluster Placement  menu item

Use the Cluster Placement dialog box to automatically build new clusters, place clusters within the board 
outline, and place parts within the board outline.

Objects

Field Description

Build Clusters Select to create new clusters outside the board outline. Created 
clusters default to open.
Click the Build Clusters Setup button to customize the clusters in the 
Build Clusters Setup Dialog Box. (Unavailable till you click the Build 
Clusters button.)

Place Clusters Select to position clusters within the board outline. Cluster members 
are also moved during this process, whose placement may differ as 
follows. You can see them if you use Disperse in Cluster View Mode or 
exit Cluster View Mode.

• If any cluster member is glued, the unglued is placed around the 
glued one, maintaining their relative layout. A random one will be 
selected if more than one glued object is in the cluster.

• If no glued component is in the cluster, all cluster members are 
placed where the cluster locates, maintaining their relative layout.

Click the Place Clusters Setup button to customize the placement of 
clusters in the Place Clusters Setup Dialog Box. (Unavailable till you 
click the Place Clusters button.)

Place Parts Select to perform automatic placement operations.
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Field Description

Click the Place Parts Setup button to customize placing parts in the 
Place Parts Setup Dialog Box.
(Unavailable till you click the Place Parts button.)

Run Click to initiate the operations for all selected function buttons; for 
example, you can select all three buttons to build clusters, place 
clusters, and place parts in one pass.
Also displays the Cluster Placement Status Dialog Box, in which you 
can interrupt the ongoing operations.
(This button is unavailable until you select at least one of the three 
function buttons.)

Ignore Invisible Nets Excludes any invisible nets from the build or placement strategy. To 
include invisible nets click to clear Ignore Invisible Nets.

Ignore Plane Nets Excludes plane layer nets in the build or placement strategy. To include 
plane nets click to clear this option.

Disperse Places unglued components outside the board outline to clear the 
board interior. Dispersion is based on part height and is sorted by 
length. Glued parts are not affected. Clusters are dispersed if you are 
in Cluster View Mode when you use Disperse.

Length Minimization Rearranges the pin pairs on the board. The pin pairs are calculated 
based on the minimum length criteria you set up using Routing Rules.

Nudge Runs a Nudge pass in automatic mode, automatically adjusting parts 
that fail Clearance Checking.

 Tip
• Nudge considers test points as glued objects.

• Nudge ignores components that are part of a physical design reuse.

Save Saves the current strategy for all three operations.

Load Opens a saved strategy file.

Related Topics
Automatic Placement

Cluster Placement
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Cluster Placement Status Dialog Box
To access: This dialog box is displayed when you use the Cluster Placement dialog box to automatically 
build new clusters, place clusters within the board outline, and place parts within the board outline.

The Cluster Placement Status dialog box displays the percentage of completion for each pass that you 
enable using Setup. The right side of this dialog box displays estimated and elapsed time for placement 
passes.

Description

Figure 137. Cluster Placement Status Dialog Box

After completion of placement operations, errors appear in the Placement Violations dialog box.

Figure 138. Placement Violations Dialog Box
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Double-click an item in the list for information.

Figure 139. Placement Violations Info Dialog Box

Objects
Table  153. Cluster Placement Status Dialog Box Fields

Field Description

Interrupt Pauses the placement process and opens the Auto Placement Prompt 
on page 1119.

Related Topics
Automatic Placement

Cluster Placement
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Cluster Properties Dialog Box
To access: Select a cluster > right-click > Properties

Use the Cluster Properties dialog box for information on a selected cluster and to make modifications.

Description

Figure 140. Cluster Properties Dialog Box

Press the Incremental button to open the Cluster Grow Incremental dialog box. Use it to cycle through 
other clusters in the design and select which ones to absorb into the current cluster.
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Figure 141. Cluster Grow Incremental Dialog Box

Press the Automatic button to open the Cluster Size Limit Definition dialog box. Use it to automatically 
add new members to the cluster based on a max number.

Figure 142. Cluster Size Limit Definition Dialog Box

Objects

Field Description

Name Name of the currently selected cluster. To rename the cluster, type a 
new name.

X/Y Coordinates Current coordinates of the cluster. To move the cluster to a new 
location, type new values.

Glued Prevents the cluster from moving through manual or automatic 
placement processes.

Top Area/Bottom Area The area the cluster encompasses based on the area of each cluster 
member.

Members Individual parts that are members of the selected cluster.

Delete Deletes the cluster and converts its members as individual parts.
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Field Description

Seed Toggle Selects parts from which you should start building clusters. Analysis 
for other parts to add to the cluster is based on these parts and on 
connectivity.

Incremental Opens the Cluster Grow Incremental dialog box  on page 1177 to 
incrementally add new members to the cluster.
See also: “Modifying Existing Clusters”.

Automatic Opens the Cluster Size Limit Definition dialog box  on page 1177 to 
automatically add new members to the cluster.
See also: “Modifying Existing Clusters”.

Seed Identifies a cluster as a base, or top level cluster, during build and grow 
operations. SailWind Layout searches outward from seed clusters to 
identify other clusters that you can add to the seed cluster.

Strong Places cluster members as close together as possible during 
placement operations. The minimum distance for placement is the 
same distance for part clearances in Design Rules.

Closed Prevents the cluster from being deleted during the Build Clusters pass 
of Cluster Placement.

Skip while Building Cluster Ignores the cluster during Grow Incremental and Grow Automatic 
operations.

Related Topics
Automatic Placement

Cluster Placement
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Collaboration Data Import Dialog Box
To access: In the Markups Dialog Box, click the Import  button, browse to and select a file, then click 
Open

Use the Collaboration Data Import dialog box to target any imported 2D lines to a specific documentation 
layer. Collaboration data often includes markups that are physically associated with the issues. The 
markups are imported as 2D lines to the documentation layer selected in the dialog box.

Objects

Field Description

Markups Layer Select a documentation layer from the list, as the location for any 
2D line markups that might be included in the collaboration data.

Change layer name to Select the check box to automatically change the name of the layer 
as listed in the Layers Setup. You can accept the default layer 
name or type a new one.
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Compare/ECO Tools Dialog Box, Comparison 
Tab
To access: Tools  > Compare/ECO Tools  menu item > Comparison  tab

Use the Comparison  tab on the Compare/ECO Tools dialog box to specify the elements to include in the 
design comparison.

Tip
During design comparison, SailWind Layout ignores the reuse definition  on page 1854 and uses 
the actual elements in the physical design reuse.
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Objects

Field Description

Comparison Options area  — if you are testing the effect of these options, you should save a copy of 
your design before you import an .eco  file since there is no undo of the .eco  import.

Compare only ECO 
Registered Parts

Comparison excludes non-ECO-registered parts  on page 1824. 
Non-ECO-registered parts may include mechanical or non-electrical 
parts present in the PCB design and not present in the schematic. 
To include all parts during comparison, clear Compare Only ECO 
Registered Parts.

Compare only ECO 
Registered Attributes

Comparison excludes non-ECO-registered attributes  on page 1824.

 Tip
Via attributes are not ECO registered and cannot be added, 
deleted, or changed during the ECO process.

Compare Part Decals Comparison includes part decals.

Compare Part Placement Comparison includes positional differences in component placement.

Compare Net Scheduling Comparison includes net scheduling differences. Net rescheduling 
is performed in SailWind Router. For more information, see 
“Rescheduling Nets” in the SailWind Router Help.

Name Comparison Options 
area

• Compare Net Names and Reference Designators. Rename as 
Necessary  — Compare differences using reference designators 
and net names.

Best used to minimize changes to routed traces. Selecting this 
option may result in the positional swapping of parts.

• Compare Net Names and Reference Designators. Prefer to Add 
or Delete Parts Instead of Renaming  — Compare differences 
using reference designators and net names on the basis that few 
reference designators have been renamed and nets have not been 
renamed. Best used to minimize the positional swapping of parts, 
and the design disruption that may result.

• Compare Connectivity and Topology (not names). Rename 
as Necessary  — Compare differences without using reference 
designators or net names. Compare differences using pin names, 
part type names, and so on.

Best used to compare designs when parts and nets have been 
renamed, and minimal interconnect changes have been performed.

Ignore the Unused Pins Net Specifies to exclude the unused pins net in the original design.
The unused pins net contains pins that have no logical net association. 
An unused pins net may be created when routing with SPECCTRA or 
with other tools in the PCB design process.
If you clear this option and you update the PCB layout from a 
schematic or previous PCB layout, the unused pins net may be 
deleted.
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Field Description

Net Name The name of the unused pins net. The maximum netname length is 
47 characters. You can use any alphanumeric characters except curly 
braces { }, asterisks *, spaces, questions marks, or commas.

Attribute and Design Rule 
Comparison Level area

See the Table 154  table.

Comparison Objects area Lists what you have selected in the Attribute and Design Rule 
Comparison Level area

Run Compares the designs.
Available when you select an option in the Output Options area on the 
Documents  tab.

Table  154.

Select With To Compare

SailWind Logic Object Types
Select this option to compare 
SailWind Logic netlists that have 
only parts defined.

Only part attributes (parts and nets)
Each part receives attributes from its 
corresponding Decal and Part Type, but 
modification is performed only at the part level.

PADS Designer  objects
Select this option to compare 
PADS Designer  netlists where 
board, part, net, and pin 
attributes are defined.

Board, parts, nets, and pin attributes
Each part receives attributes from its 
corresponding Decal and Part Type. Nets 
assume attributes from any net class to 
which they belong. Part and net differences 
are updated only at the part or net level 
respectively. There is no assumed hierarchy for 
pin attributes.

Compare 
Attributes

All Object Types
Select this option when you are 
comparing different versions of a 
SailWind Layout design.

All attributes (board, parts, nets, pins, net 
classes, part types, part decals).
No attribute hierarchy is assumed; all object 
types are compared and updated at their 
current level.

SailWind Logic Object Types Net and net class rules

PADS Designer  Object Types • Net and net class rules

• General rules

• Differential pairs rules

Compare Design 
Rules

All Object Types All design rules

Both Compare 
Attributes and 
Compare Design 
Rules

SailWind Logic Object Types • Part and net attributes

• Net and Net Class rules

• General and Conditional rules

• Differential Pairs rules

SailWind Layout Guide and Reference 1183



GUI Reference Elements B Through C
Compare/ECO Tools Dialog Box, Comparison Tab  

Table  154.  (continued)

Select With To Compare

PADS Designer  Object Types • Board, part, net, and pin attributes

• Net and Net Class rules

• General rules

• Differential pairs rules

All types of objects • Attributes of all object types

• All design rules

Related Topics
Comparing Designs

Working with SailWind Logic
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Compare/ECO Tools Dialog Box, Documents 
Tab
To access: Tools  > Compare/ECO  menu item

Use the Documents  tab on the Compare/ECO Tools dialog box to specify the designs to compare and 
the files to create.
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Objects

Field Description

Original Design to Compare 
and Update

• Use Current PCB Design  — Specifies to use the current design as 
the original to compare and update. Clear Use Current PCB Design 
to browse for another one.

• Original Design File  — Specifies to browse for another design to 
use as the original to compare and update.

New Design with Changes • Use Current PCB Design  — Specifies to use the current design 
as the new design with changes. Clear Use Current PCB Design to 
browse for another one.

• New Design File  — Specifies to browse for another design to use 
as the new design with changes.

Generate Differences Report Specifies to create a report file containing a description of the 
differences between the two design versions. This file is named 
Layout.rep  and is stored in the \SailWind Projects  folder.

Generate ECO File Specifies to create an ECO  on page 1824 file. Type or browse to the 
ECO file. The ECO file contains ECO commands that describe the 
changes needed to update the original design to match the new design.

Generate ASCII File for Back 
Annotation to Schematic

Specifies to create a file that contains information to send back to 
the schematic, click the Generate ASCII File for Back Annotation to 
Schematic box. You must also type the path and name of the file to 
create in the ASCII Filename box.

Run Compares the designs. Available when you select an option in the 
Output Options area.

Related Topics
Comparing Designs

Working with SailWind Logic
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Compare/ECO Tools Dialog Box, Update Tab
To access: Tools  > Compare/ECO  menu item > Update  tab

Use the Update  tab on the Compare/ECO Tools dialog box to specify the types of data to update in the 
original design and to specify whether to update library data.
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Objects

Field Description

Update Original Design Specifies to update the PCB layout in memory to match the new design 
by automatically importing into SailWind Layout the ECO file resulting 
from design comparison. This check box is unavailable unless both of 
the following options are selected:

• Use Current Design  in the Original Design to Compare and Update 
area on the Documents  tab.

• Generate ECO File on the Documents  tab.

Pause Before Updating 
Original Design

Specifies that you want to view the differences report or ECO file 
before automatically importing the ECO file into the original SailWind 
Layout design in memory.
Available only when Update Original Design is checked on the Update 
tab and Use Current PCB Design is checked in the Original Design to 
Compare and Update area on the Documents  tab.

Update Part Types in Library Specifies to update the SailWind Layout part type library by 
automatically importing the PADS-format ASCII part type file (.p) 
generated with ViewPCB in PADS Designer.

Party Type ASCII File Specifies the ASCII file to use. Type or browse for the file name.

Import to Library list Specifies the Library in which you want to import the updates.

New Library button Specifies that you want to create a new library in which to import the 
updates.

Import Mode for Library Parts 
area

Specifies how you want the changes to be imported:
• Do Not Overwrite Existing Parts

• Always Overwrite Existing Parts

• Prompt for Each Part to Overwrite

Run Compares the designs.
Available when you select an option in the Output Options area on the 
Documents  tab.

Related Topics
Comparing Designs

Working with SailWind Logic
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Component Layer Associations Dialog Box
To access: Setup  > Layer Definition  menu item > Associations  button

Use the Component Layer Associations dialog box to associate, or otherwise map, which documentation 
layers go with the selected layer when a top or bottom layer is set as a component layer.

Description
The layer associations made in this dialog box are used by CAM routines for output. For example, when 
you output a silkscreen for the top, any items on the documentation layer you associated for silkscreen 
are automatically added to the CAM document.

Objects

Field Description

Name The name of the layer selected in the Layers Setup Dialog Box. 
This is the layer you are associating with the components.

Silkscreen Specifies which Silkscreen layer you want to associate:
• None

• Silkscreen Bottom

• Silkscreen Top

Paste Mask Specifies which Paste Mask layer you want to associate:
• None

• Paste Mask Bottom

• Paste Mask Top

Solder Mask Specifies which Solder Mask layer you want to associate:
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Field Description

• None

• Solder Mask Bottom

• Solder Mask Top

Assembly Specifies which Assembly layer you want to associate:
• None

• Assembly Drawing Bottom

• Assembly Drawing Top

Related Topics
Setting Up an Outer Layer

1190 SailWind Layout Guide and Reference



 
GUI Reference Elements B Through C

Component Properties Dialog Box

Component Properties Dialog Box
To access:

• Select a component > right-click > Properties

• Select a component > Standard Toolbar > Properties  button

• Select a component > press the Ctrl-Q (or Alt-Enter) keys

Use the Component Properties dialog box to modify component placement, decal, cluster, label and 
electrical net information.

Description
There are three tabs that change the content displayed in the dialog box:

• Use the Part  tab in the Component Properties dialog box to view all information about the part. 
This is not editable.

• Use the Cluster  tab in the Component Properties dialog box to exclude clusters or set one as a 
base cluster.

• Use the Labels  tab in the Component Properties dialog box to specify the label you want to 
create or edit, and to open the Part Label Properties dialog box, where you can set the label 
properties.

Use the Electrical Nets area to make electrical nets settings.

Note:
This area only appears if you have the Advanced Rules license feature. For more information, see 
“Electrical Nets”  on page 337.
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Figure 143. Component Properties Dialog Box

Figure 144. Part Tab
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Figure 145. Cluster Tab

Figure 146. Labels Tab

Figure 147. Electrical Nets Area
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Objects
Table  155. Component Properties Dialog Box

Field Description

Ref. Des. The name of the reference designator of the selected part.

X,Y coordinates Displays the current coordinates of the queried part. Type new 
coordinates to move the part.

Rotation list Displays the current rotation angle of the part. Type a new rotation 
angle to change the rotation of the part.

Layer list Displays the layer on which the part is located. Click a new layer from 
the list to move the component to another layer.

Glued Sets whether the component is glued. Click to select the Glued check 
box to glue the component to the board and prevent component 
movement. Click to clear Glued to unglue a component.
If multiple parts are selected, and some of the parts are glued and 
others are not, the Glued check box appears gray (in an undefined 
state). You can click to select the Glued check box to glue all selected 
parts or click to clear the Glued check box to unglue all selected parts.

# of Connections Lists the number of connections attached to the part.

Decal list Lists the current part decal. Click a different decal from the list to 
change the decal.

 CAUTION:
You can assign decals using this dialog box outside of ECO mode 
on page 1824. This allows attribute changes even if the attribute 
is ECO-registered  on page 1824. For example, you can change 
the decal for U1 from a DIP 14 with a Geometry.Height attribute set 
at 200, to a SOIC 14 with a Geometry.Height attribute set at 100. 
Since you are not in ECO mode, the change is not recorded in the 
.eco  file.

Part Outline Width Displays the current width of component outlines. SailWind Layout only 
changes the part outline widths  on page 1846 of selected components' 
decals, not the widths of all decals in the design.
See also: “Changing the Part Outline Width”.

Pad Stack button Opens the component in the Pad Stack Properties dialog box  on 
page 1566.

Attributes button The Object Attributes Dialog Box  opens to assign attributes and values 
to any selected objects.

Rules button Opens the Component Rules Dialog Box  with the selected components 
highlighted in the Components list.
See also: “Design Rule Hierarchy”.
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Table  156. Cluster Tab Contents

Field Description

Skip While Building Cluster Excludes the component from cluster builds. Click to exclude the 
selected part from cluster build operations.

Seed Identifies a cluster as a base, or top level cluster, during build and grow 
operations. SailWind Layout searches outward from seed clusters to 
identify other clusters that you can add to the seed cluster.

Table  157. Labels Tab Contents

Field Description

Label list Specifies the label you want to create or edit.

Part Label Properties Opens the Part Label Properties Dialog Box.

Table  158. Electrical Nets Area Contents

Field Description

Electrical nets list Names of the electrical nets attached to or going through the 
component.
An electrical net name has a suffix of three caret symbols.

Create electrical net Select the check box to create an electrical net with the component’s 
nets. This check box is also selected by the Create Electrical Net 
command for selected components.

 Restriction:
• If a net of a selected component is excluded from electrical nets, it 

cannot be included in an electrical net.

(A component or net is excluded from electrical nets if its Create 
electrical net and Allow electrical net creation by components check 
boxes are both cleared.)

• If a selected component has more than two pins, the following 
conditions must apply, or the component cannot create an electrical 
net, that is, the electrical net cannot go through the component:

• All pins must connect to a gate.

• Each gate must have exactly two pins.

Clear the check box to remove the component from an electrical net, 
that is, to prevent an electrical net from going through it.
This check box is also cleared by the Disable Electrical Net Creation 
popup command for selected components.
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Table  158. Electrical Nets Area Contents  (continued)

Field Description

 Restriction:
If the Create electrical net check box in the Net Properties dialog 
box is selected for the component’s nets, you must also clear the 
Allow electrical net creation by refdes prefix and nets check box. 
Clear both check boxes to prevent the selected components from 
creating electrical nets (that is, to prevent any electrical net from 
going through them).

Allow electrical net creation 
by refdes prefix and nets

Select the check box to allow the component’s nets to be included 
in electrical nets automatically by specifying the component’s refdes 
prefix in the Electrical Nets dialog box, or by selecting the Create 
electrical net check box in the Net Properties dialog box.
Clear the check box to prevent electrical net creation of the selected 
components’ nets through those components by net or by refdes prefix. 
The nets can still be made into electrical nets by the other components 
they are attached to.
This check box is also cleared by the Disable Electrical Net Creation 
popup command for selected components.

 Restriction:
Components that have the Create electrical net check box selected 
are not prevented from being added to an electrical net by clearing 
this check box. Clear both check boxes to prevent the selected 
components from being added to an electrical net (that is, to 
prevent any electrical net from going through them).

Discrete length Enter the length to be used for this component when calculating pin 
pair and net lengths.
Half the Discrete length value is added to each connected pin pair, and 
net length measurement. You can add a value to represent the length 
of the component pin that will solder to the pad. For electrical nets, it 
gives a more accurate total length measurement where physical nets 
are chained together through discrete components. Without a Discrete 
length value, lengths of connected pin pairs and nets are measured 
only up to the origin of the pad. This may not be the geometric center of 
the pad in offset pads.

Related Topics
Modifying Component Properties
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Component Rules Dialog Box
To access:

• Setup  > Design Rules  menu item > Component  button

• Select a component > right-click > Show Rules

Use the Component Rules dialog box to define design rules that apply to components.

Tip
You can define Component Rules in SailWind Layout; however, these rules are used in SailWind 
Router only.

Objects

Field Description

Components list Lists all components in the design.

Show components with rules Specifies to show only components that have rules.

Using Decal Specifies to display components for a specific decal.
Select (All_decals) to display all decals.

SailWind Layout Guide and Reference 1197



GUI Reference Elements B Through C
Component Rules Dialog Box  

Field Description

Clearance Opens the Clearance Rules Dialog Box.

Routing Opens the Routing Rules Dialog Box.

Fanout Opens the Fanout Rules Dialog Box.

Pad Entry Opens the Pad Entry Rules Dialog Box.

Report Opens the Rules Report Dialog Box.

Picture below rule button The picture below each type of rule button identifies which rules 
hierarchy level is used for that rule type. The meaning of the picture 
corresponds to the button in the Hierarchy area of the Rules Dialog 
Box. For example, if you select a class in the Class list and a green 
polygon appears below the Clearance button, then the default values 
apply to the class.

Selected: Lists the components selected in the Components list.

Part type: Lists the part type(s) associated with the component(s) selected in the 
Components list.

Decal: Lists the decal(s) associated with the component(s) selected in the 
Components list.

Default Removes non-default rules from the selected components, so that only 
default rules apply.

Related Topics
Creating Component Design Rules

Resetting Component Rules to Default Rules

Design Rule Hierarchy
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Conditional Rule Setup Dialog Box
To access: Setup  > Design Rules  menu item > Conditional Rules  button

Use the Conditional Rule Setup dialog box to setup clearance and high-speed rules that come into 
effect only when objects named in the rule are adjacent or on a specific layer. For example, the default 
clearance between nets is X, but when net A is adjacent to net B, the clearance is Y.

Note:
The Advanced Rules option is required to setup conditional design rules.

Objects

Field Description

Source rule object Specifies the object for which to set the rule.

From net Specifies to display pin pairs for a specific net.
Select (All_nets) to display all pin pairs.
Available only if Pin pairs is selected in the Source rule object area.

Against rule object Specifies the object against which to set the rule.
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Field Description

For pin pair objects, you can display pin pairs for a net by selecting the 
net in the From net list.

From net Specifies to display pin pairs for a specific net.
Select (All_nets) to display all pin pairs.
Available only if Pin pairs is selected in the Against rule object area.

Apply to layer Specifies to apply the conditional rule to a specific layer.
Tip: Select (All layers) to apply it to all layers.
Restriction: Unavailable if Layer is selected in the Against rule object 
area.

Existing rule sets list Lists all rules previously created.

Clearance Specifies that this is a Clearance rule set. You can set the clearance 
for all objects in the Object to object box. But this box is unavailable if 
there are differing values within the Clearance Rules matrix, and you 
must click Matrix, and enter the values within the Clearance Rules 
dialog box.

Matrix button Opens the Clearance Rules Dialog Box.

High speed Specifies that this is a High Speed rule set. Set the parallel and tandem 
length and gap in the boxes.
For reporting purposes, nets and pin pairs in the Source rule object list 
are identified as aggressors  on page 1808. If a class is in the Source 
rule object list, all nets in the class are identified as aggressors.

Create Creates the rule and displays it in the Existing rule sets list.

Delete Removes the selected rule from the Existing rule sets list.

Related Topics
Deleting a Conditional Rule

Modifying a Conditional Rule

Design Rule Hierarchy

Creation of Rules for Your Design
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Confirm Pin Swap Dialog Box

Confirm Pin Swap Dialog Box
To access: ECO Toolbar  > Swap Pin  button > select pins without a swap ID or with different swap IDs

Use the Confirm Pin Swap dialog box to confirm and proceed with swapping pins that do not have swap 
IDs or have different swap IDs.

Objects

Field Description

Don’t display again Prevents this prompt from appearing the next time you swap pins 
with different or undefined swap IDs.
This setting is reset when you close and then return to the ECO 
Toolbar.

OK Proceeds with the swap of the pins.
If these pins are swappable, the correct process would be to give 
them identical swap IDs in the Pins tab of the Part Information 
dialog box  on page 1590.

Related Topics
Swapping a Pin Manually in ECO Mode
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Connectivity Checking Setup Dialog Box
To access: Tools  > Verify Design  menu item > Connectivity check > Setup  button

During design verification, you can use the Connectivity Check to report isolated routing vias and isolated 
stitching vias. (An isolated stitching via is a stitching via that is not connected to any hatch outline or 
copper area.) However, to have the check report isolated stitching vias, you must first set it up to ignore 
connections to CAM planes.

Objects

Field Description

Ignore CAM Plane 
Connection for isolated 
stitching vias

Specifies to report isolated stitching vias as errors and marks them in 
the design, along with the other errors found during checking.

Related Topics
Setting Up Checking for Isolated Stitching Vias
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Convert Pin Pairs to Chamfered Paths Dialog Box

Convert Pin Pairs to Chamfered Paths Dialog 
Box
To access: Select a pin pair, multiple pin pairs, or a net > right-click > Convert to Chamfered Paths 
popup menu item

Use the Convert Pin Pairs to Chamfered Paths dialog box to convert traces to chamfered copper. 
Converting traces to a copper chamfered path has two advantages over simply creating a copper 
chamfered path. You can also use the more powerful interactive router to initially route the trace. When 
you convert the trace to a chamfered path, SailWind Layout automatically makes the net assignment.

Tip
Unrouted or partially routed pin pairs, or pin pairs belonging to reuse blocks, are excluded from 
selection.

Objects

Field Description

Selected pin pairs list Lists the pin pairs you selected in the design.

Select All Selects all items listed in the Selected pin pairs list.
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Field Description

Unselect All Deselects all items listed in the Selected pin pairs list.

Selected trace widths Lists the range of widths for the selected traces.

Polygon outline width Specifies a width value for the width of the copper outline. Decrease 
the value for sharper corners and increase the value for more blunt 
corners. All corners are rounded with a radius equal to one half of the 
outline width.

 Tip
Since copper is created with an outline and a fill, you can specify a 
very narrow outline width to achieve very sharp corners.

Use trace width Specifies to use the trace width as the width of the chamfered path. 
Where multiple trace widths exist, the actual trace widths are used. The 
Selected trace widths value at the top of the Conversion parameters 
area displays the range of trace widths of the items in the Selected pin 
pairs list.
Click to clear this check box to enter a value in the Converted path 
width box.

Corner chamfer width ratio Specifies the ratio of the chamfered corner width to the chamfered path 
width. If the ratio is 1.0, the width of the chamfered corner is the same 
as the chamfered path. Reduce the radio for a more narrow chamfered 
corner.

Chamfer corners with angles 
less than or equal to

Clear the “Chamfer corners with angles less than or equal to” check 
box to chamfer only angles less than 90 degrees (acute angles).
or
Select the “Chamfer corners with angles less than or equal to” check 
box to specify an angle between 90 and 180 degrees as the upper limit 
beneath which all angles are chamfered. Outside corners less than 90 
degrees are always chamfered.

Related Topics
Converting a Trace to a Copper Chamfered Path
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Copper Plane Manager Dialog Box

Copper Plane Manager Dialog Box
To access: Choose the Tools > Copper Plane Manager  menu item

Flood copper plane outlines, and refill hatched copper plane areas.

Objects

Object Description

Hatch Fills in the hatch lines of previously flooded areas.
Unlike Flood, Hatch does not create new isolation areas or thermal connections. If 
objects within the flooded area were moved, or changed thermal settings since the 
original flooding, you need to change the hatch outline to a pour or plane outline 
and use Flood to generate the new hatch in the area.
Because the hatch lines are not stored, you should also perform hatch after 
opening a file, unless you have the “Autohatch on file load” setting enabled in the 
“Hatch and Flood”  on page 1511 options.

Flood Floods all copper planes on selected layers.
• Flooding creates isolation areas around traces and pads that are inside the 

copper plane outline but are not part of the same net. It also creates thermal 
relief connections around pins that belong to the same net (provided the “Plane 
Thermal” check box is selected for the pins in the Pin Properties Dialog Box), 
and performs the process on all copper planes on the selected layer or layers. 
To flood individual copper planes, select a copper plane shape in the design, 
right-click, and choose the Flood  popup menu item.

• It floods over instances where a drill size is larger than the pad to which it is 
assigned. By flooding over the drill and pads, the pad remains connected to the 
plane. So if you flood around pads (intending them to get a thermal relief), and 
these pads have a drill size that is larger than the pad size, the pad and drill are 
entirely flooded over, but can be detected with a Connectivity design verification 
check.
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Object Description

• Click Select All  to select all layers listed in the Layers list.

• Alternatively, you can flood copper planes on all layers at one time by clicking 
the Flood All button in the main toolbar. 

Options Provides quick access to related subcategories of the Tools menu > Options dialog 
box. Select the option type and click Setup.

• Thermals — Set the size and shape of default thermals.

• Hatch and Flood — Set hatching and flooding options.

Related Topics
Flooding Copper Planes

Hatching Copper Planes

Verify the Design
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Create Array Dialog Box

Create Array Dialog Box
To access: Select the components to include in the array > right-click > Create Array  popup menu item

Use the Create Array dialog box to set options for creating an array.

Description

Figure 148. Planar tab

Figure 149. Circular tab
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Figure 150. Create Array Dialog Box

Objects
Table  159. Create Array Dialog Box Fields

Field Description

Row To Row Sets the row-to-row distance in current design units.

Column To Column Sets the column-to-column distance in current design units.

Number of Rows Sets the number of rows in the array.
Type a value equal to or greater than 1. The Number of Columns is 
updated automatically based on this value.

Number of Columns Sets the number of columns in the array.
Type a value equal to or greater than 1. The Number of Rows is 
updated automatically based on this value.

Order by area • Rows — Determines the sequence in which components are 
placed in the planar array. When Order by Rows is selected, 
parts are sorted by selection and placed in array sites by rows, 
starting from the bottom row. Parts are placed in rows from left to 

right.

• Columns — Determines the sequence in which components are 
placed in the planar array. When Order by Columns is selected, 
parts are sorted by selection and placed in array sites by rows, 
starting from the bottom row. Parts are placed in rows from left to 

right.

Inner Radius Sets the radius of the inner ring of the polar grid or circular array in 
current design units. You cannot use zero or negative values.
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Create Array Dialog Box

Table  159. Create Array Dialog Box Fields  (continued)

Field Description

Delta Radius Sets the radial distance between neighboring rings of the polar grid or 
circular array in current design units.
For Circular Arrays you cannot use zero or negative values.

Start Angle Sets the polar angle, in degrees, of the first grid or circular array site. 
You can type a value between 0.000 and 359.999.

Angle Range Sets the range within which you want to place objects. 360 sets a full 
circle grid or array; smaller values set sector-shaped grids or arrays.

Delta Angle Sets the angular distance between neighboring sites within a ring.

Sites Per Ring Sets the number of sites for each ring of the grid or array. Type a value 
equal to or greater than 2. You cannot use zero or negative values.

Locked Controls the automatic adjustment of Angle Range, Delta Angle, and 
Sites Per Ring for Radial Move. Controls the automatic adjustment of 
Count, Angle, and Angle Range for Polar Step and Repeat.
The three settings above, Angle Range, Delta Angle, and Sites per 
Ring, are interdependent; each value depends on the values in the 
other two. Set one of the values and lock it. Set one of the unlocked 
values; the other unlocked value automatically updates. For example, 
if you set Angle Range to 360 and Sites Per Ring to 36, Delta Angle 
updates to 10.

Direction Sets how the sites are placed on the grid or circular array: Clockwise or 
Counterclockwise.

Rotate Sets whether to change the orientation of the selected components.
To change the orientation select this option and type a value, in 
degrees, in the Orientation box. Clear Rotate to maintain each 
component's current orientation.

Orientation Sets the orientation for the selected components.
Type in an orientation value, in degrees, for SailWind Layout to apply to 
each component in the array.

Sort by Reference Designator Sorts selected items by reference designator when creating or 
modifying an array or during a Radial Move.
When this option is cleared, items are sorted by the order in which they 
were selected.

Align by Determines how to align the components in the array.
• Origin — Snaps the origins of the components to the array sites.

• Midpoint — Snaps the midpoints of the components to the array 
sites.

Calculate Defines an array's parameters so that components are placed as 
closely to each other as possible without violating the Body-to-Body 
Clearance Design Rule. You can calculate the following:
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Table  159. Create Array Dialog Box Fields  (continued)

Field Description

• Everything — For planar arrays, calculates Instances, Number of 
Columns, and Number of Rows. For Circular arrays, calculates 
all options except Start Angle and Direction. Calculate always 
calculates options for a single ring array with an Angle Range of 360 
degrees.

• Distances — Calculates Row To Row and Column To Column 
values. Planar arrays only.

• Radius, Delta Radius — Calculates Inner Radius and Delta Radius 
based on all of the other values in the Circular  tab. Circular arrays 
only.

Related Topics
Setting Up a Polar Grid

Component Arrays
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Create Die Dialog Box

Create Die Dialog Box
To access: BGA Toolbar  > Die Wizard  button

Use the Create Die dialog box to select the method you want to use to create a new die.

Note:
This information applies only to the BGA toolkit.

Objects

Field Description

From Text File button Opens the Die Wizard - Create from Text File Dialog Box

Parametrically button Opens the Die Wizard - Create Parametrically Dialog Box

From GDSII File button Opens the Die Wizard - Create from GDSII File Dialog Box
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Custom String Dialog Box
To access: File  > Create PDF  menu item > in a header or footer position list, select Custom

Use the Custom String dialog box to create custom header or footer text for PDF outputs.

Objects

Name Description

text box Type your custom text for the selected header or footer position.

Related Topics
PDF Configuration Dialog Box

1212 SailWind Layout Guide and Reference



 
GUI Reference Elements B Through C

Customize Dialog Box, Commands Tab

Customize Dialog Box, Commands Tab
To access: Tools  > Customize  menu item > Commands  tab

Use the Commands  tab to add commands to menus or toolbars, or to create custom menus.

Objects

Field Description

Categories list Narrows down the list of commands.

Commands list List of commands available to add to a menu or toolbar.

Add a new command, delete a command you have added, or 
rename a command you have added.

Related Topics
Creating a Custom Command

Editing a Custom Command

Creating a Custom Menu

Adding Items to Toolbars and Menus

SailWind Layout Guide and Reference 1213



GUI Reference Elements B Through C
Customize Dialog Box, Keyboard and Mouse Tab  

Customize Dialog Box, Keyboard and Mouse 
Tab
To access: Tools  > Customize  menu item > Keyboard and Mouse  tab

Create and customize shortcut keys using the Keyboard and Mouse  tab of the Customize dialog box.

Objects

Field Description

Mode list Narrows down the list of commands.

Commands list The list of commands available for which to assign a shortcut.

Add a new command (opens the Add Command Dialog Box  on 
page 1050), delete a command you have added, or rename a 
command you have added (opens the Edit Command dialog box 
on page 1050).

Current shortcuts list The list of shortcuts assigned to the selected command.

Add a new shortcut (open the Assign Shortcut Dialog Box), or 
delete a shortcut you have added.

Description Lists what the selected command does.
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Customize Dialog Box, Keyboard and Mouse Tab

Field Description

Reset Sets the selected toolbar or shortcut menu to the default settings.

Report Saves a report of all current shortcut commands.

Related Topics
Shortcut Key Customization
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Customize Dialog Box, Macro Files Tab
To access: Tools  > Customize  menu item > Macro Files  tab

Create commands from macro files and add them to toolbars and menus using the Macro Files  tab.

Tip
To create a command from a macro command file, the macro command file (.mcr) must already 
exist. You can create a macro by recording it in a SailWind tool or scripting it in Macro language. 
For more information, see “Recording Design Work in Macro Files”.

Objects

Field Description

Macro Command Files list The list of macro files you have opened.

Add a macro to the list (opens the Open Macro dialog box), delete 
a macro from the list, or edit the location of a macro you have 
added.

Description Lists what the selected macro does.
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Customize Dialog Box, Macro Files Tab

Related Topics
Recording Design Work in Macro Files [SailWind Layout Command Reference Manual]

Screen Appearance

Creating a Custom Menu

Software Interface Customization
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Customize Dialog Box, Options Tab
To access: Tools  > Customize  > Options  tab

Customize the SailWind interface by changing the appearance of menus and toolbars using the Options 
tab of the Customize dialog box.

Objects

Field Description

Show ToolTips on toolbars Displays the button name over the toolbar button when you hover 
over it with your pointer.

Show shortcuts in ToolTips In addition to the name in the ToolTip, displays the shortcut for the 
button.

Large Icons Displays icons on the toolbar larger than the default size.

Menu animations list The type of animation for your menus: None, Unfold, Slide, or 
Fade.

Menu shadows Displays a shadow behind the menu.

Wait until <Enter> before 
executing long shortcuts

Delays the execution of shortcut keys until you press the Enter 
key.
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Customize Dialog Box, Options Tab

Field Description

Show recent commands first Displays your recent menu command selections at the top of the 
list.

Show full menus after delay Displays the full menu after a slight pause.

Reset my usage data Restores the default set of commands to the menus and toolbars.
This option does not undo any explicit customizations you made.

Visual Style Sets the look and feel of your toolbars and title bars.

Interface Language Specifies the language for all dialog boxes and messages 
displayed: English, Chinese Simplified.

Related Topics
Screen Appearance
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Customize Dialog Box, Toolbars and Menus 
Tab
To access: Tools  > Customize  menu item > Toolbars and Menus  tab

Use the Toolbars and Menus  tab on the Customize dialog box to create custom toolbars and shortcut 
menus.

Tip
To create a custom main menu, use the Commands  tab on the Customize dialog box. See 
“Creating a Custom Menu”.

Objects

Field Description

Toolbars list Specify which toolbars to display in the main window.

Add a new toolbar, delete a toolbar you have added, or rename a 
toolbar you have added.

Show text labels Shows the text label on the button in addition to the icon.

Select shortcut menus Specifies the shortcut menu you want to customize.
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Customize Dialog Box, Toolbars and Menus Tab

Field Description

 Restriction:
SailWind Router only.

Reset Sets the selected toolbar or shortcut menu to the default settings.

Reset All Sets all toolbars or shortcut menus back to their default settings.

Related Topics
Software Interface Customization
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Chapter 48
GUI Reference Elements D

Read the sections that follow to learn more about dialog box elements in SailWind Layout.

Decal Attributes Dialog Box
Decal Label Properties Dialog Box
Decal Rules Dialog Box
Decal Rules Dialog Box (Decal Editor)
Decal Wizard Dialog Box, BGA/PGA Tab
Decal Wizard Dialog Box, Dual Tab
Decal Wizard Dialog Box, Polar Tab
Decal Wizard Dialog Box, Quad Tab
Decal Wizard Options Dialog Box, Global Tab
Decal Wizard Options Dialog Box, Package Types Tab
Default Rules Dialog Box
Define CAM Documents Dialog Box
Define Name of Merged Net Dialog Box
Define Name of New Net Dialog Box
Delete Part Dialog Box
Derive SBP Function from Netlist Dialog Box
DFT Audit Dialog Box, Assignment Tab
DFT Audit Dialog Box, Options Tab
DFT Audit Dialog Box, Properties Tab
Die Flag Wizard Dialog Box
Die Wizard - Create from GDSII File Dialog Box
Die Wizard - Create from Text File Dialog Box
Die Wizard - Create Parametrically Dialog Box
Die Wizard Preview Colors Dialog Box
Differential Pairs Dialog Box
Dimension Properties Dialog Box
Dimension Text Properties Dialog Box
Discarding Copper Plane Data Dialog Box
Disconnect Pin Dialog Box
Disperse by Logic Dialog Box
Display Colors Setup Dialog Box
Display Colors Setup Dialog Box in the Decal Editor
Drafting Corner Properties
Drafting Edge Properties Dialog Box
Drafting Properties Dialog Box
Drill Symbols Dialog Box
Drill Pairs Setup Dialog Box
DXF Export Dialog Box
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DXF Import Dialog Box
DXF Import Dialog Box

1224 SailWind Layout Guide and Reference



 
GUI Reference Elements D
Decal Attributes Dialog Box

Decal Attributes Dialog Box
To access: Tools  > PCB Decal Editor  menu item > Edit  > Attribute Manager  menu item

Use this dialog box to assign decal attributes, such as Geometry.Height. The information travels with the 
decal.

Objects

Field Description

Attribute table • Attribute column — Lists the attributes assigned to the decal.

• Value column — Lists the value of the attributes assigned to the 
decal. You can specify the units for the value.

Add Adds a new row to the end of the Attribute table.

Delete Removes the selected row from the Attribute table.

Edit Makes the selected cell available for editing.

Browse Lib. Attr Opens the Browse Library Attributes Dialog Box.

SailWind Layout Guide and Reference 1225



GUI Reference Elements D
Decal Label Properties Dialog Box  

Decal Label Properties Dialog Box
To access: Select a decal label > right-click > Properties  popup menu item

Use this dialog box to modify a decal label or to change the attribute the label displays.

Tip
If you select multiple labels, settings in this dialog box apply to all selected labels.

Objects

Field Description

Attribute The attributes available to you. If you are creating labels for 
jumpers, Reference Designator is the only available attribute.
Hidden attributes do not appear in the Attribute list unless the 
attribute was selected for the label before it was set as a hidden 
attribute.

Value for The value of the selected attribute.
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Decal Label Properties Dialog Box

Field Description

 Tip
• Unavailable if you selected Reference Designator or Part Type 

from the Attribute list, if the attribute is read-only, or if you open 
the Properties dialog box for labels of different attribute types. 
However, if the labels you select belong to attributes of the 
same type, you can edit this box.

• If the attributes have different values, the box is blank. You 
can type a new value in the box to apply it to all of the selected 
attribute labels and their parent objects.

• Value is also unavailable if the attribute is ECO-registered and 
SailWind Layout is not in ECO mode.

Show Controls the visibility of the label.
• None — Turns visibility off.

• Value — Displays only the label value.

• Name and Value — Displays the name and value.

• Full Name and Value — When labeling a structured attribute  on 
page 1862, displays the full structured name and value.

 Tip
Labels are invisible regardless of this setting unless you use 
the Display Colors Setup Dialog Box  to change the color of 
labels to a color different from that of the background.

Font The fonts available to you.

 Tip
• Select stroke font or a system font.

• For system fonts, you can also click a font style button, or any 
combination of styles: B for bold, I for italic, or U for underlined.

Layer The layers available to you.

Relative to Places the label at the X and Y location relative to the component 
or the jumper. If you clear this check box, the label is placed at the 
X and Y location relative to the design origin.

X,Y Places the decal label in a specified location.

Rotation Specifies the rotation angle of the label.

Size Specifies the size of the font.
Size (pts): This is font size in points and appears for system fonts
Size (mils): This is font character height and appears for stroke 
fonts. The size refers to the height of the tallest characters.
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Field Description

Line Width Specifies the line width for stroke fonts only.

Mirrored Flips the label - text is considered readable from the bottom side of 
the board.

Horizontal, Vertical Sets the horizontal and vertical justification of the text to ensure 
proper positioning between objects when text, attribute values, 
size, or width change.

 Tip
• For vertical justification, click Left, Center, or Right. For 

horizontal justification, choose Up, Center, or Down.

• Optionally, set justification by selecting the text, then 
right-clicking and clicking Justify Horizontally, and then clicking 
Left, Center, or Right; and by right-clicking and clicking Justify 
Vertically, and then clicking Up, Center, or Down.

Right reading Controls whether labels are readable (from left to right, or from 
bottom to top if the label is rotated). Click None, Orthogonal, or 
Angled to indicate the direction of reading you want.

Related Topics
Modifying Decal Label Properties
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Decal Rules Dialog Box

Decal Rules Dialog Box
To access: Setup  > Design Rules  menu item > Decal  button

Use this dialog box to define design rules that apply to decals.

Tip
You can define Decal Rules in SailWind Layout; however, these rules are used in SailWind Router 
only.

Objects

Field Description

Decals list Lists all decals in the design.

Show decals with rules Specifies to show only decals that have rules.

Clearance Opens the Clearance Rules Dialog Box.

Routing Opens the Routing Rules Dialog Box.

Fanout Opens the Fanout Rules Dialog Box.
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Field Description

Pad Entry Opens the Pad Entry Rules Dialog Box.

Report Opens the Rules Report Dialog Box.

Picture below rule button The picture below each type of rule button identifies which rules 
hierarchy level is used for that rule type. The meaning of the picture 
corresponds to the button in the Hierarchy area of the Rules Dialog 
Box. For example, if you select a class in the Class list and a green 
polygon appears below the Clearance button, then the default values 
apply to the class.

Selected: Lists the decal(s) selected in the Decals list.

Components: Lists the component(s) associated with decal(s) selected in the 
Connections list.

Default Removes non-default rules from the selected decals, so that only 
default rules apply.

Related Topics
Creating Decal Design Rules

Resetting Decal Rules to Default Rules

Creating Decal Design Rules in the PCB Decal Editor

Design Rule Hierarchy
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Decal Rules Dialog Box (Decal Editor)

Decal Rules Dialog Box (Decal Editor)
To access: Tools  > PCB Decal Editor  menu item > Setup  > Decal Rules  menu item

Use this dialog box to define design rules that apply to decals in the Decal Editor.

Tip
You can define Decal Rules in SailWind Layout; however, these rules are used in SailWind Router 
only.

Objects

Field Description

Clearance Opens the Clearance Rules Dialog Box.

Routing Opens the Routing Rules Dialog Box.

Fanout Opens the Fanout Rules Dialog Box.

Pad Entry Opens the Pad Entry Rules Dialog Box.

Related Topics
Creating Decal Design Rules in the PCB Decal Editor
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Decal Wizard Dialog Box, BGA/PGA Tab
To access: Tools  > PCB Decal Editor  menu item > Drafting Toolbar  button > Wizard  button > BGA/
PGA  tab

Use the BGA/PGA wizard to create ball grid array and pin grid array decals. You can create decal 
patterns for full and depopulated matrix BGAs/PGAs, including staggered arrays.

Description
The BGA/PGA  tab controls change depending on your Device type selection. The two differences are 
shown in the figures below:

Figure 151. BGA/PGA Tab - Through hole Controls
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Decal Wizard Dialog Box, BGA/PGA Tab

Figure 152. BGA/PGA Tab - SMD Controls

Objects
Table  160. BGA/PGA Tab Contents

Field Description

Decal area

Device type Specifies whether the device will be a through hole or surface 
mount device. This setting is used to generate the correct type of 
pad stack for the device pins.

Decal type Specifies whether the decal is a component or substrate. This 
setting mirrors the column numbering. Column numbering is left to 
right for component type and right to left for substrate type.
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Table  160. BGA/PGA Tab Contents  (continued)

Field Description

Height(H) Specifies the height of the component. This value is added to the 
Geometry.Height attribute.

Origin Specifies the origin of the decal: the center of the decal or pin 1.

Pins area

Pin count Displays the number of pins in the decal. You cannot edit this 
value; it depends on row count, column count, and the stagger 
pitch value.

Diameter Sets the diameter of the pins in current units

Drill diameter Sets the drill hole diameter in current units.
This control is only available when the Device type is set to 
Through hole.

Plated Flags the through holes for plating.
This control is only available when the Device type is set to 
Through hole.

Staggered rows Enables staggering of pins. Stagger even rows or odd rows.

Assign JEDEC pinning Assigns an alphanumeric name to each pin in an array following 
the JEDEC standard.
Pin rows are lettered from top to bottom starting with A. The letters 
I, O, Q, S, X, and Z are not used. For arrays with more than 20 
rows, row 21 is designated AA. Subsequent rows are designated 
AB, AC, etc.
Pin columns are numbered starting with 1. Column numbering is 
left to right for component type and right to left for substrate type.

Row pitch Specifies the distance between rows of pins in current units

Row count Sets the number of pin rows in the decal

Void rows Specifies the number of rows in the decal that will be depopulated 
(void). Void rows are calculated from the center of the decal. When 
you set void rows, you must also set void columns.

 Tip
If the number of pin rows is an even number, the number of 
void rows should be an even number. If the number of pin rows 
is an odd number, the number of void rows should be an odd 
number.

Center rows Specifies the number of pin rows in the decal to center within 
void rows. When you set center rows, you must also set center 
columns.
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Table  160. BGA/PGA Tab Contents  (continued)

Field Description

 Tip
If the number of void rows is an even number, the number of 
center rows should be an even number. If the number of void 
rows is an odd number, the number of center rows should be 
an odd number.

Column pitch Specifies the distance between columns of pins in current units

Column count Sets the number of pin columns in the decal

Void columns Specifies the number of columns in the decal that will be 
depopulated (void). Void columns are calculated from the center 
of the decal. When you set void columns, you must also set void 
rows.

 Tip
If the number of pin columns is an even number, the number of 
void columns should be an even number. If the number of pin 
columns is an odd number, the number of void columns should 
be an odd number.

Center columns Specifies the number of pin columns in the decal to center within 
void columns. When you set center columns, you must also set 
center rows.

 Tip
If the number of void columns is an even number, the number 
of center columns should be an even number. If the number of 
void columns is an odd number, the number of center columns 
should be an odd number.

Default Sets all decal options to their default settings

Placement outline area

 Restriction:
This area is unavailable if you have chosen not to create the outline in the Decal Wizard Options  on 
page 1252.

Width Specifies the width of the placement outline. The placement outline 
options are set in the Decal Wizard Options  on page 1252.

Height Specifies the height of the placement outline. The placement 
outline options are set in the Decal Wizard Options  on page 1252.

Mask over(under)size area

Solder Specifies the oversize or undersize of the solder mask. The solder 
mask options are set in the Decal Wizard Options  on page 1252.
This area is unavailable if you have chosen not to create the solder 
mask outline in the Decal Wizard Options  on page 1252.

Paste Specifies the oversize or undersize of the paste mask. The paste 
mask options are set in the Decal Wizard Options  on page 1252.
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Table  160. BGA/PGA Tab Contents  (continued)

Field Description

 Restriction:
• This control is only available when the Device type is set to 

SMD.

• This area is unavailable if you have chosen not to create the 
paste mask outline in the Decal Wizard Options  on page 1252.

Preview area- displays a preview of the decal based on your current settings. The view displays what is 
inside the Placement outline.

View from bottom side Displays the decal from the bottom side in the Preview area.

Display Colors Click to open the Display Colors Setup Dialog Box  to change the 
colors of the preview window.

Active layer Specifies the active layer to display in the preview window.

Units Specifies whether the decal units are Mils, Metric, or Inches.

Wizard Options Opens the Decal Wizard Options Dialog Box  on page 1252.

Related Topics
Creating a Basic Decal Automatically
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Decal Wizard Dialog Box, Dual Tab
To access: Tools  > PCB Decal Editor  menu item > Drafting Toolbar  button > Wizard  button > Dual  tab

Use the Dual wizard to create both DIP and SMD decals.

Description
The Dual  tab controls change depending on your Device type selection. The differences are shown in the 
following two figures.

Figure 153. Dual Tab - Through hole Controls
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Figure 154. Dual Tab - SMD Controls

Objects
Table  161. Quad Tab Contents

Field Description

Decal area

Device type Specifies whether the device will be a through hole or surface 
mount device. This setting is used to generate the correct type of 
pad stack for the device pins.

Orientation Sets a vertical or horizontal orientation for the decal.

Height(H) Specifies the height of the component. This value is added to the 
Geometry.Height attribute.
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Table  161. Quad Tab Contents  (continued)

Field Description

Origin Specifies the origin of the decal: the center of the decal or pin 1.

Pins area

Pin Count Sets the number of pins in the decal.

Diameter Sets the diameter of the pins in current units.

 Restriction:
This control is only available when the Device type is set to 
Through hole.

Width Sets the width of each pin in current units.

 Restriction:
This control is only available when the Device type is set to 
SMD.

Pin Pitch Sets the center-to-center spacing between pins, in current units.

Row Pitch Sets the center-to-center spacing between rows of pins, in current 
units.

 Restriction:
This control is only available when the Device type is set to 
Through hole. The area, of the same name, that applies to 
SMD devices is documented below.

Numbering direction Specifies the direction in which to number pins: clockwise or 
counterclockwise (CCW).

Drill Diameter Sets the drill hole diameter in current units.

 Restriction:
This control is only available when the Device type is set to 
Through hole.

Plated Plates pins.

 Restriction:
This control is only available when the Device type is set to 
Through hole.

Length Sets the length of each pin in current units.

 Restriction:
This control is only available when the Device type is set to 
SMD.

Row pitch area

 Restriction:
This control is only available when the Device type is set to SMD.

List Specifies the locations used to measure the pitch.
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Table  161. Quad Tab Contents  (continued)

Field Description

• Center to Center — between centers of pins on opposite sides 
of the decal.

• Inner Edge to Edge — between inner edges of pins on opposite 
sides of the decal.

• Outer Edge to Edge — between outer edges of pins on 
opposite sides of the decal.

Value Specifies the value of the pitch or pin rows.

Pin 1 shape Specifies the shape of pin 1. Values change depending on whether 
the device type is through hole or SMD.

Pin shape Specifies the shape of all pins except for pin 1. Values change 
depending on whether the device type is through hole or SMD.

Square/Rectangular pins area

Corner type Specifies the corner type used when pin shapes are square or 
rectangular.

Radius Specifies the radius used for chamfered or rounded corners.

 Restriction:
This control is not available for 90 Degrees.

Default button Sets all decal options to their default settings.

Placement outline area

 Restriction:
This area is unavailable if you have chosen not to create the outline in the Decal Wizard Options  on 
page 1252.

Width Specifies the width of the placement outline. The placement outline 
options are set in the Decal Wizard Options  on page 1252.

Height Specifies the height of the placement outline. The placement 
outline options are set in the Decal Wizard Options  on page 1252.

Mask over(under)size area

 Tip
Half the oversize is added to either side of the pad.

Solder Specifies the oversize or undersize (use a negative value) of the 
solder mask. The solder mask options are set in the Decal Wizard 
Options  on page 1252.

 Restriction:
This area is unavailable if you have chosen not to create 
the solder mask outline in the Decal Wizard Options  on 
page 1252.
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Table  161. Quad Tab Contents  (continued)

Field Description

Paste Specifies the oversize or undersize (use a negative value) of the 
paste mask. The paste mask options are set in the Decal Wizard 
Options  on page 1252.

 Restriction:
• This control is only available when the Device type is set to 

SMD.

• This area is unavailable if you have chosen not to create the 
paste mask outline in the Decal Wizard Options  on page 1252.

Preview area  - displays a preview of the decal based on your current settings. The view displays what 
is inside the Placement outline.

View from bottom side Displays the decal from the bottom side in the Preview area.

Display Colors Click to open the Display Colors Setup Dialog Box  to change the 
colors of the preview window.

Active layer Specifies the active layer to display in the preview window.

Decal Calculator area  — generates the appropriate decal footprint based on the package dimensions. 
Uses the IPC-7351A standard and parameters that are set in the Decal Wizard Options -  on 
page 1257Package types  tab.

 Restriction:
The decal calculator is not available for through hole devices.

Package type Specifies the type of package and updates the package dimension 
diagram and variables on the parameter spreadsheet.

Package dimension diagram Displays the usage of the variables for the package type. You 
can find the variable parameters in the parameter spreadsheet 
and also in various locations in the dialog box. For example, the 
H variable (height) is not found in the spreadsheet because it is 
located at the top of the Decal Wizard dialog box. See the Show 
dimensions area for a useful feature to display only those settings 
in the dialog box that are used by the Decal Calculator.

Package parameter spreadsheet Specify the exact package dimensions and tolerances. Refer to 
the dimension diagram to the left of the spreadsheet to interpret 
the spreadsheet variables. Some variables are not found in the 
spreadsheet but are located in other parts of the dialog box. For 
example, the H variable (height) is not found in the spreadsheet 
because it is located at the top of the Decal Wizard dialog box.

Protrusion variation Specifies the amount that the decal pins should protrude from 
under the component leads to achieve different amounts of solder 
welding. Choose from the three land pattern material conditions  on 
page 1838: minimum, nominal, and maximum. See “Decal Wizard 
Options -  on page 1257Package types  tab” for settings of these 
material conditions.
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Table  161. Quad Tab Contents  (continued)

Field Description

Show dimensions Specify “All” to make all dialog box settings available or “Used 
in calculations” to gray out those settings not used by the Decal 
Calculator.

Calculate button Click to generate the decal according to the Decal Calculator 
parameters and settings.

 Tip
The orientation is set to vertical, the origin is set to center, pin 
numbering is set to CCW. And the width, length, row pitch, 
placement outline and Mask over(under)size are calculated.

Decal name Displays the generated name for the new decal in accordance with 
the IPC-7351A standard.

 Restriction:
If the decal name is generated and then you change any decal 
parameter that was used in the name generation, the decal 
name is cleared and you must click the Calculate button to 
regenerate the new, correct name.

Units Specifies whether the decal units are Mils, Metric, or Inches.

Wizard Options Opens the Decal Wizard Options Dialog Box  on page 1252.

Related Topics
Creating a Basic Decal Automatically

1242 SailWind Layout Guide and Reference



 
GUI Reference Elements D

Decal Wizard Dialog Box, Polar Tab

Decal Wizard Dialog Box, Polar Tab
To access: Tools  > PCB Decal Editor  menu item > Drafting Toolbar  button > Wizard  button > Polar  tab

Use the Polar decal wizard to create through-hole or SMD decals with pins evenly distributed on the array 
of the specified radius.

Description
The Polar  tab controls change depending on your Device type selection. The two differences are shown 
in the figures below:

Figure 155. Polar Tab - Through hole Controls
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Figure 156. Polar Tab - SMD Controls

Objects
Table  162. Polar Tab Contents

Field Description

Decal area

Device type Specifies whether the device will be a through hole or surface 
mount device. This setting is used to generate the correct type of 
pad stack for the device pins.

Height(H) Specifies the height of the component. This value is added to the 
Geometry.Height attribute.

Origin Specifies the origin of the decal: the center of the decal or pin 1.

1244 SailWind Layout Guide and Reference



 
GUI Reference Elements D

Decal Wizard Dialog Box, Polar Tab

Table  162. Polar Tab Contents  (continued)

Field Description

Pins area

Pin count Sets the number of pins in the decal.

Diameter Sets the diameter of the through hole pins.

 Restriction:
This control is only available when the Device type is set to 
Through hole.

Width Specifies the width of the surface mount pins.

 Restriction:
This control is only available when the Device type is set to 
SMD.

Start angle Sets the location, by angle, of the first pin on the circle.

Radius Sets the radius of the circle for the array in current units.

 Restriction:
This control is only available when the Device type is set to 
Through hole.

Numbering direction Specifies the direction in which to number pins: clockwise or 
counterclockwise (CCW).

Drill diameter Sets the drill hole diameter of the through hole pins.

 Restriction:
This control is only available when the Device type is set to 
Through hole.

Plated Marks the through holes for plating.

 Restriction:
This control is only available when the Device type is set to 
Through hole.

Length Specifies the length of the surface mount pins.

 Restriction:
This control is only available when the Device type is set to 
SMD.

Row pitch area

 Restriction:
This control is only available when the Device type is set to SMD.

List Specifies the locations used to measure the pitch.
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Table  162. Polar Tab Contents  (continued)

Field Description

• Center to Center — between centers of pins on opposite sides 
of the decal.

• Inner Edge to Edge — between inner edges of pins on opposite 
sides of the decal.

• Outer Edge to Edge — between outer edges of pins on 
opposite sides of the decal.

Value Specifies the value of the pitch or pin rows.

Pin 1 shape Specifies the shape of pin 1. Values change depending on whether 
the device type is through hole or SMD.

Pin shape Specifies the shape of all pins except for pin 1. Values change 
depending on whether the device type is through hole or SMD.

Square/Rectangular pins area

Corner type Specifies the corner type used when pin shapes are square or 
rectangular.

Radius Specifies the radius used for chamfered or rounded corners.

 Restriction:
This control is not available for 90 Degrees.

Default button Sets all decal options to their default settings.

Placement outline area

 Restriction:
This area is unavailable if you have chosen not to create the outline in the Decal Wizard Options  on 
page 1252.

Radius Specifies the radius of the placement outline. The placement 
outline options are set in the Decal Wizard Options  on page 1252.

Mask over(under)size area

Solder Specifies the oversize or undersize of the solder mask. The solder 
mask options are set in the Decal Wizard Options  on page 1252.

 Restriction:
This area is unavailable if you have chosen not to create 
the solder mask outline in the Decal Wizard Options  on 
page 1252.

Paste Specifies the oversize or undersize of the paste mask. The paste 
mask options are set in the Decal Wizard Options  on page 1252.

 Restriction:
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Table  162. Polar Tab Contents  (continued)

Field Description

• This control is only available when the Device type is set to 
SMD.

• This area is unavailable if you have chosen not to create the 
paste mask outline in the Decal Wizard Options  on page 1252.

Preview area  - displays a preview of the decal based on your current settings. The view displays what 
is inside the Placement outline.

View from bottom side Displays the decal from the bottom side in the Preview area.

Display Colors Click to open the Display Colors Setup Dialog Box  to change the 
colors of the preview window.

Active layer Specifies the active layer to display in the preview window.

Units Specifies whether the decal units are Mils, Metric, or Inches.

Wizard Options Opens the Decal Wizard Options Dialog Box  on page 1252.

Related Topics
Creating a Basic Decal Automatically
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Decal Wizard Dialog Box, Quad Tab
To access: Tools  > PCB Decal Editor  menu item > Drafting Toolbar  button > Wizard  button > Quad  tab

Use the QUAD wizard to create packages with leads extending from each of the four sides. For example, 
quad flat packs or plastic leaded chip carriers.

Objects
Table  163. Quad Tab Controls

Field Description

Decal area

Pin 1 location Specify the side and place to locate pin 1.
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Table  163. Quad Tab Controls  (continued)

Field Description

Height(H) Specifies the height of the component. This value is added to the 
Geometry.Height attribute.

Origin Specifies the origin of the decal: the center of the decal or pin 1.

Pins area

Horizontal pins Sets the number of horizontal pins in each of the two rows.

Vertical pins Sets the number of vertical pins in each of the two rows.

Width Sets the width of each pin in current units.

Pin Pitch(P) Sets the center-to-center spacing between pins, in current units.

Numbering direction Specifies the direction in which to number pins: clockwise or 
counterclockwise (CCW).

Length Sets the length of each pin in current units.

Length 2 Sets the length of pin 1, which is different from the other pins.

 Restriction:
This control is only available for the Quad Leadless Ceramic 
Chip Carrier (with longer pin 1).

Row pitch area

Measurement type Specifies the locations used to measure the pitch.
• Center to Center — between centers of pins on opposite sides 

of the decal.

• Inner Edge to Edge — between inner edges of pins on opposite 
sides of the decal.

• Outer Edge to Edge — between outer edges of pins on 
opposite sides of the decal.

Horizontal Specifies the pitch of horizontal pins.

Vertical Specifies the pitch of vertical pins.

Pin 1 shape area - Specifies the shape of pin 1.

Pin shape area - Specifies the shape of all pins except for pin 1.

Square/Rectangular pins area

Corner type Specifies the corner type used when pin shapes are square or 
rectangular.

Radius Specifies the radius used for chamfered or rounded corners.
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Table  163. Quad Tab Controls  (continued)

Field Description

 Restriction:
This control is not available for 90 Degrees.

Default button Sets all decal options to their default settings.

Placement outline area

 Restriction:
This area is unavailable if you have chosen not to create the outline in the Decal Wizard Options  on 
page 1252.

Width Specifies the width of the placement outline. The placement outline 
options are set in the Decal Wizard Options  on page 1252.

Height Specifies the height of the placement outline. The placement 
outline options are set in the Decal Wizard Options  on page 1252.

Mask over(under)size area

Solder Specifies the oversize or undersize of the solder mask. The solder 
mask options are set in the Decal Wizard Options  on page 1252.

 Restriction:
This area is unavailable if you have chosen not to create 
the solder mask outline in the Decal Wizard Options  on 
page 1252.

Paste Specifies the oversize or undersize of the paste mask. The paste 
mask options are set in the Decal Wizard Options  on page 1252.

 Restriction:
This area is unavailable if you have chosen not to create the 
paste mask outline in the Decal Wizard Options  on page 1252.

Preview area  - displays a preview of the decal based on your current settings. The view displays what 
is inside the Placement outline.

View from bottom side Displays the decal from the bottom side in the Preview area.

Display Colors Click to open the Display Colors Setup Dialog Box  to change the 
colors of the preview window.

Active layer Specifies the active layer to display in the preview window.

Decal Calculator area  — generates the appropriate decal footprint based on the package dimensions. 
Uses the IPC-7351A standard and parameters that are set in the Decal Wizard Options -  on 
page 1257Package types  tab.

Package type Specifies the type of package and updates the package dimension 
diagram and variables on the parameter spreadsheet.

Package dimension diagram Displays the usage of the variables for the package type. You 
can find the variable parameters in the parameter spreadsheet 
and also in various locations in the dialog box. For example, the 
H variable (height) is not found in the spreadsheet because it is 
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Table  163. Quad Tab Controls  (continued)

Field Description
located at the top of the Decal Wizard dialog box. See the Show 
dimensions area for a useful feature to display only those settings 
in the dialog box that are used by the Decal Calculator.

Package parameter spreadsheet Specify the exact package dimensions and tolerances. Refer to 
the dimension diagram to the left of the spreadsheet to interpret 
the spreadsheet variables. Some variables are not found in the 
spreadsheet but are located in other parts of the dialog box. For 
example, the H variable (height) is not found in the spreadsheet 
because it is located at the top of the Decal Wizard dialog box.

Protrusion variation Specifies the amount that the decal pins should protrude from 
under the component leads to achieve different amounts of solder 
welding. Choose from the three land pattern material conditions  on 
page 1838: minimum, nominal, and maximum. See “Decal Wizard 
Options -  on page 1257Package types  tab” for settings of these 
material conditions.

Show dimensions Specify “All” to make all dialog box settings available or “Used 
in calculations” to gray out those settings not used by the Decal 
Calculator.

Calculate button Click to generate the decal according to the Decal Calculator 
parameters and settings.

 Tip
The origin is set to center, pin numbering is set to CCW. And 
the width, length, row pitches, placement outline and Mask 
over(under)size are calculated.

Decal name Displays the generated name for the new decal in accordance with 
the IPC-7351A standard.

 Restriction:
If the decal name is generated and then you change any decal 
parameter that was used in the name generation, the decal 
name is cleared and you must click the Calculate button to 
regenerate the new, correct name.

Units Specifies whether the decal units are Mils, Metric, or Inches.

Wizard Options Opens the Decal Wizard Options Dialog Box  on page 1252.

Related Topics
Creating a Basic Decal Automatically
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Decal Wizard Options Dialog Box, Global Tab
To access:

• PCB Decal Editor > Tools  > Wizard Options  menu item > Wizard Options > Global  tab

• PCB Decal Editor > Drafting Toolbar  button > Wizard Options  button > Global  tab

• PCB Decal Editor > Drafting Toolbar  button > Wizard  button > Wizard Options > Global  tab

Use the Global  tab to enable or disable supplemental documentation layers and settings.

Objects

Field Description

Silkscreen outline area
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Field Description

Create Specifies to create the decal silkscreen.

Line width Specifies the width of the line used to draw the silkscreen.

Layer Specifies the layer on which to draw the silkscreen.

Minimum spacing from pin pads Specifies the gap between pad edges and the silkscreen outline 
edge.

Notch Specifies to create a notch in rectangular silkscreen shapes.

Polar tab Specifies to add a tab to polar (circular) silkscreen shapes.

Polar tab angle Specifies the location of the polar tab in degrees away from pin 1.

Assembly outline area

Create Specifies to create the assembly outline.

 Restriction:
• The assembly drawing is generated only if you use the Decal 

Calculator to generate the decal.

• The assembly drawing is generated only when you click the 
Calculate button in the Decal Wizard. If you change body width 
or length parameters after you click the Calculate button, the 
assembly drawing will not match the body of the component 
unless you click the Calculate button to generate a new 
assembly drawing with the new parameters.

Line width Specifies the width of the line used to draw the assembly outline.

Layer Specifies the layer on which to draw the assembly outline.

Notch Specifies to create a notch in the assembly outline shape.

Placement outline area
Tips:

• The placement outline dimensions are defined in this dialog, but the calculation of the dimensions 
happens in the Decal Calculator, which puts the resulting values into the corresponding dialog fields.

• The geometry of the placement outline is a rectangle surrounding the component with a clearance 
(the Courtyard excess value of the package type set in the Environment area of the Package types 
tab  on page 1257.) The clearance is calculated from the edges of pads or the component body, to 
the centerline of the placement outline.

Create Specifies to create the placement outline.
Clearing this checkbox makes the Placement outline area 
unavailable in the Decal Wizard.

Line width Specifies the width of the line used to draw the placement outline.

Layer Specifies the layer on which to draw the placement outline.
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Field Description

Crosshair at Origin Specifies to create a crosshair geometry at the origin of the decal.
The crosshair is created with the same Line width as the 
placement outline.

Crosshair size Specifies the size of the crosshair.
The width of the lines used in the crosshair are the same as the 
line width for the placement outline.

Solder mask area

Create Specifies to create the solder mask.
Clearing this checkbox makes the Solder field unavailable in the 
Mask over(under)size area of the Decal Wizard.

Top Layer Specifies the layer to use for top solder mask.

 Restriction:
Layers assigned to top and bottom solder mask and paste 
mask may not be the same.

Bottom Layer Specifies the layer to use for bottom solder mask.

 Restriction:
Layers assigned to top and bottom solder mask and paste 
mask may not be the same.

Gang mask area

Create when needed Specifies to create gang solder mask when the width of the 
solder mask web becomes less than the minimum web width 
val

ue.

 Tip
Gang mask is a copper shape associated with the component. 
The shape of the gang mask takes on the shape of the pins. 
If the pins are oval shaped, the corners of the gang shape will 
be rounded. If one pin is longer than others, the gang will only 
extend beyond the regular pin length for the one pin.
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Field Description

Minimum web width Specifies the minimum value of solder mask web allowed. Gang 
solder mask is created when the width of the web is less than this 
value and when you select the Create when needed check box.

Ask about gang mask Specifies to prompt you upon clicking OK in the Decal Wizard, 
when gang mask conditions exist. You can choose to accept 
the conditions or a gang mask will not be created. It will make 
individual (overlapping) solder mask pads.

Paste mask area

Create Specifies to create paste mask.
Clearing this check box makes the Paste field unavailable in the 
Mask over(under)size area of the Decal Wizard.

Layer Specifies the layer on which to create paste mask.

 Restriction:
Layers assigned to top and bottom solder mask and paste 
mask may not be the same.

Minimum pad to pad clearance Specifies the minimum spacing allowed between decal pads.
Pads are created regardless. But you are given a warning that the 
minimum spacing is violated.

Minimum standoff height to avoid 
pad trimming

Specifies the minimum standoff height - the gap between the 
component body and the board. When this value is greater than 
the Standoff height (H2) value of SOIC and QFP type packages, 
the pads will be trimmed to avoid coming in contact with the 
component body.

Default Resets all Global  tab settings to their default values.

Configuration name Specifies the saved configuration to use. When the settings of 
the dialog box are changed, you are prompted to save it to a 
configuration file. Configuration names can be a maximum of 30 
characters.

 Restriction:
The Default configuration cannot be changed.

For more information, see “The Decal Wizard Options 
Configuration File”.

Save As Allows you to save the current settings in a configuration for reuse. 
Opens the Save Configuration dialog box  on page 1684.

 Restriction:
Configuration names can be a maximum of 30 characters.

Configuration files are stored in the UserDir  folder as set in the 
SailWindpcb.ini  file and has the extension .dwc.
For more information, see “The Decal Wizard Options 
Configuration File”.

Units Specify whether the values are Mils, Metric, or Inches.
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Field Description

Reset All Resets both Global  and Package types  tabs (including all 
package types) settings to their default values.

Related Topics
Decal Wizard Options Dialog Box, Package Types Tab
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Decal Wizard Options Dialog Box, Package 
Types Tab
To access:

• PCB Decal Editor >Tools  > Wizard Options  menu item > Package types  tab

• PCB Decal Editor > Drafting Toolbar  button > Wizard Options  button > Package types tab

• PCB Decal Editor > Drafting Toolbar  button > Wizard  button > Wizard Options > Package types 
tab

Use this tab to set the defaults for each of the Package types used by the Decal Calculator.
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Objects

Field Description

Package type list Lists all the supported package types (and their pitch ranges) 
available to the Decal Calculator in the Decal Wizard. Select a 
package type from the list to view or modify the values used by 
the Decal Calculator to generate the decal.
If you open this dialog box from the Decal Wizard, this list item 
will correspond to the package type and the pitch value you have 
chosen in the Decal Wizard.

Fabrication tolerance Specifies the tolerance of the manufactured component and its 
land pattern.

 CAUTION:
If you add a tolerance to your decals, inform your 
manufacturer in case they also compensate by over-sizing the 
land area and unnecessarily duplicate the tolerance.

Placement tolerance Specifies the tolerance of the assembly process.

Round-off factor Specifies the factor used to round calculated values.

Solder mask over(under)size Specifies a positive value to oversize or a negative value to 
undersize the solder mask.

Paste mask over(under)size Specifies a positive value to oversize or a negative value to 
undersize the paste mask.

Environment area

 Tip
This area changes according to each different package type.

Courtyard excess Specifies the extra clearance to apply to the placement outline 
in excess of the rectangle surrounding the component. The 
clearance is added between the edges of pads and the centerline 
of the placement outline. Specify the values for all three material 
conditions.

Toe Specifies the extra protrusion of the pad beyond the toe of the 
lead. Specify the values for all three material conditions.

 Restriction:
This is replaced by the single Periphery parameter for two 
package types.

Heel Specifies the extra protrusion of the pad beyond the heel of the 
lead. Specify the values for all three material conditions.

 Restriction:
This is replaced by the single Periphery parameter for two 
package types.

Side Specifies the extra protrusion of the pad beyond the sides of the 
lead. Specify the values for all three material conditions.
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Field Description

 Restriction:
This is replaced by the single Periphery parameter for two 
package types.

Periphery Specifies one set of parameters instead of using Toe, Heel and 
Side parameters for both Pull-back Small Outline, No-Lead and 
Pull-back Quad Flat, No-Lead package types.

Default for this type Resets the values to the default for the current package type 
listed.

Configuration name Specifies the saved configuration to use. When the settings of 
the dialog box are changed, you are prompted to save it to a 
configuration file. Configuration names can be a maximum of 30 
characters.

 Restriction:
The Default configuration cannot be changed.

For more information, see “The Decal Wizard Options 
Configuration File”.

Save As Allows you to save the current settings in a configuration for 
reuse. Configuration names can be a maximum of 30 characters.
Tip: Configuration files are stored in the UserDir  folder as set in 
the SailWindpcb.ini  file and has the extension .dwc.
For more information, see “The Decal Wizard Options 
Configuration File”.

Units Specify whether the values are Mils, Metric, or Inches.

Reset All Resets both Global  and Package types  tab settings to their 
default values.

Related Topics
Decal Wizard Options Dialog Box, Global Tab
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Default Rules Dialog Box
To access: Setup  > Design Rules  menu item > Default  button

Use this dialog box to define design rules that apply to all objects in the design, except for objects to 
which you assigned rules with a higher priority.

Objects

Field Description

Clearance Opens the Clearance Rules Dialog Box.

Routing Opens the Routing Rules Dialog Box.

High Speed Opens the HiSpeed Rules Dialog Box.

Fanout Opens the Fanout Rules Dialog Box.

Pad Entry Opens the Pad Entry Rules Dialog Box.

Report Opens the Rules Report Dialog Box.

Related Topics
Creating Default Rules

Design Rule Categories

Design Rule Hierarchy
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Define CAM Documents Dialog Box
To access: Choose the File > CAM  menu item

Use this dialog box to define and store up to 250 CAM documents.

Tip
You must save the design file before the changes made to the CAM documents become part of 
the design file.

Objects

Field Description

Document Name The name of the CAM document.

Fabrication Layer The layer on which you will be using CAM350 for post processing.

Auto Define button Creates a complete set of CAM document definitions for the design 
using predefined default settings. Once created, the individual CAM 
document definitions can be edited or deleted as desired.
Any existing CAM document definitions will not be overwritten.

Drill Symbols button Opens the “Global Drill Symbols dialog box”  on page 1387, enabling 
you to define the drill symbols that you want to be available for use in 
drill drawings.
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Field Description

You enable each drill symbol you want to use in a specific drawing 
separately through the “Drill Symbols dialog box”  on page 1334.

Add button Opens the Add Document dialog box  on page 1044. Create a CAM 
Document configuration and return to the Define CAM Documents 
dialog box to save the configuration and Run the configuration against 
the design.

Edit button Opens the Edit Document dialog box  on page 1044 where you can edit 
the document settings.

Delete button Removes the selected CAM document.

Up button Moves the selected CAM document up one space for list organization.

Down button Moves the selected CAM document down one space for list 
organization.

Summary Displays a summary of the selected CAM document.

Run Runs the selected CAM document configurations against your current 
design.

Listing Opens the Listing file name dialog box where you can save a list of the 
CAM documents, which can also be printed and saved with your design 
documentation.

CAM Directory Specifies the location of the CAM output file.

 Tip
• The default location is \SailWind Projects\Cam\default  which is 

called from the CAMDir entry of the SailWindpcb.ini  file.

• To browse for the desired directory and create a new path that will 
be saved with the design, select <Create> in the CAM directory list.

Aperture Report Produces a report of the apertures used in a CAM Document.
To produce an aperture report, you must have run the CAM 
Document(s) photo plot configuration against your design. If the CAM 
Document is set to print, or pen output, it will not produce the report.

Save Saves the document configurations added to the CAM Documents 
list. Configurations are saved into the current software session but not 
yet saved into the .pcb  file. You must save the .pcb  design file for the 
changes made to the CAM documents to become part of the design 
file.

Import Opens the CAM import file name dialog box where you can recall an 
exported configuration to use as the CAM configuration for the .pcb  file.
You can reuse your CAM document configurations with other similar 
designs by exporting them and importing them into another design.

Export Saves the configuration to a separate file that you can later import to 
use for similar .pcb  files.
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Field Description

 Tip
If you name the file default.cam, it is used as the default CAM 
configuration for each .pcb  file.

You can reuse your CAM document configurations with other similar 
designs by exporting them and importing them into another design.

Preview Opens the CAM Preview Dialog Box  where you can see the results of a 
CAM Document configuration before you run the configuration against 
your design.

Related Topics
Creating CAM Outputs to Manufacture Your PCB
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Define Name of Merged Net Dialog Box
To access:

• ECO Toolbar  > Add Connection  button > click two pins with different netnames

• ECO Toolbar  button >Add Route  button > create a route between two pins with different 
netnames

• BGA Toolbar > Add Connection  and connect two BGA pins that have distinct nets

You use this dialog box to rename the net of two pins connected using the Add Connection or Add Route 
ECO tools.

Objects

Field Description

Mode of definition area This area allows you to choose the net name of the new merged 
net and provides you with four options. The first two options are 
the names of the two nets prior to their merging.
Autogenerate New Name — assigns a new $$$<number> name to 
the merged net.
Type New Name — allows you to type a new name in the Name of 
Net box.

Name of Net Displays the autogenerated new name of the net, or allows you to 
type the name of the merged net.

 Restriction:
This box is only available if you click Type New Name in the 
Mode of definition area.
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Define Name of Merged Net Dialog Box

Related Topics
Adding a Connection in ECO Mode

Adding a Route in ECO Mode

SailWind Layout Guide and Reference 1265



GUI Reference Elements D
Define Name of New Net Dialog Box  

Define Name of New Net Dialog Box
To access:

• ECO Toolbar  button >Delete Connection  button > click a connection bridging two pin pairs.

• In the Die Flag Wizard Dialog Box, click New Net.

You use this dialog box to name a new net created by the Delete Connection ECO tool or the Die Flag 
Wizard.

Tip
If you have deleted a connection bridging two pin pairs using the Delete Connection ECO tool, a 
prompt first appears and specifies which of the two pin pairs will be considered the new net. See 
“Deleting a Connection in ECO Mode” for more info.

Objects

Field Description

Mode of Definition area This area allows you to choose the net name of the new net.
Autogenerate New Name — assigns a new $$$<number> name to 
the merged net.
Type New Name — allows you to type a new name in the Name of 
Net box.

Name of New Net Displays the autogenerated new name of the net, or allows you to 
type the name of the new net.

 Restriction:
This box is only available if you click Type New Name in the 
Mode of definition area.
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Delete Part Dialog Box
To access:

• ECO Toolbar  button >Delete Component  button > select one or multiple components

• ECO Toolbar  button > select one or multiple components > press the Delete key

In ECO mode, use this dialog box to delete parts, resulting single-pin nets, and optionally any attached 
traces.

Description
Two Delete Part dialog boxes appear in succession. The first dialog confirms the deletion and allows 
you to delete traces that are connected to the component, and the second dialog box informs you of any 
single-pin nets that will be deleted as a result from the deletion of the component.

Figure 157. Delete Part Dialog Box 1

Figure 158. Delete Part Dialog Box 2

Objects
Table  164. Delete Part Dialog Box 1 Contents

Field Description

Delete Part/Selected Parts Prompts to confirm the deletion of the selected part(s). Specifies 
the reference designator of the part if you have only selected a 
single part.

Delete Routes Select the check box to also delete all traces routed to and from 
this component.
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Table  164. Delete Part Dialog Box 1 Contents  (continued)

Field Description

Exception:  Despite this setting, the traces of any single-pin nets 
that result from the deletion of the component will always be 
deleted.

 Tip
If you have routed to and from a pad (both traces sharing 
the pad), you will lose both connections. But if you keep the 
traces when the component is removed, the connection will be 
continuous and will show a tack in place of the pad.

Table  165. Delete Part Dialog Box 2 Contents

Field Description

Single-pin net list When the selected component is deleted, single-pin nets might 
result. These nets are always deleted, including both unrouted 
connections and traces.

Related Topics
Deleting a Component in ECO Mode
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Derive SBP Function from Netlist Dialog Box
To access: BGA Toolbar  button > Wire Bond Wizard  button > SBP Naming  button > Derive from 
Netlist  button > open a file

Use the Derive SBP Function from Netlist dialog box to import the SBP functions from a BGA, SailWind 
Layout, or SailWind Logic netlist ASCII file. SBP numbers are used as they are currently defined in the 
SBP Properties dialog box.

Note:
This information applies only to the BGA toolkit.

Description
See also: “Exporting ASCII Files  on page 291”.
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Objects

Field Description

Netlist File The name of the file you are using.

Select Component area Displays the reference designator and part type for all components in 
the net list from the imported ASCII file.
Select a die component from the list. After selecting the component, 
the names in the SBP Function column of the Preview SBP Function 
area are updated with the net names assigned to pins of the selected 
components in the imported file.

Preview SBP Function area This area contains a list with the columns SBP and SBP Function.
When you select a component in the Select Component area, Wire 
Bond Wizard updates the names in the SBP Function column. These 
names are updated to the net names assigned to the pins of the 
selected component in the imported ASCII file.

Related Topics
Importing the SBP Functions
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DFT Audit Dialog Box, Assignment Tab
To access: Tools  > DFT Audit  menu item > Assignment  tab

Use this tab to prevent or favor assigning test points to components or to via types. By default, all pins on 
a net are available for test pin assignment and are evenly weighted as test point candidates.

Tip
To reduce design iterations, consult with your automated test engineers when setting DFT Audit 
options.

Objects

Field Description

Components column Lists the components available to you.

Exclude column Specifies to prevent the use of the component as a test point.
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Field Description

To apply even weighting, clear the Exclude and Prefer check boxes.

Prefer column Specifies to favor the use of the component as a test point.
To apply even weighting, clear the Exclude and Prefer check boxes.

Via Type column Lists the vias available to you.

Exclude column Specifies to prevent the use of the via as a test point.
To apply even weighting, clear the Exclude and Prefer check boxes.

Prefer column Specifies to favor the use of the via as a test point.
To apply even weighting, clear the Exclude and Prefer check boxes.

Run button Starts the automatic audit process.

Related Topics
Setting Test Point Assignment Eligibility
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DFT Audit Dialog Box, Options Tab
To access: Tools  > DFT Audit  menu item > Options  tab

You have several options for placing test points on the Options  tab of the DFT Audit dialog box.

Tip
To reduce design iterations, consult with your automated test engineers when setting DFT Audit 
options.

Objects

Field Description

Create During Routing When using SailWind Router Link, select the check box to enable 
SailWind Router to create test points when routing nets.
When using SailWind Layout, this check box has no function.
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Field Description

Preserve Test Points Prevents existing vias and component pins assigned as test points 
from being reassigned, removed, deleted, shoved, or modified.

Add Test Points to Existing 
Traces

Adds test point vias to inaccessible nets that are already routed. The 
design is automatically passed to SailWind Router where it places test 
points and may, for example, plow other traces out of the way to make 
room for a new test point.
Specify the type of via to insert from the Use Test Point Via list.
You can also specify whether or not to allow short trace stubs when 
making nets accessible.

Add Off-board Test Points to 
Inaccessible Nets

Adds test point vias to nets that SailWind Router cannot make 
accessible. SailWind Layout places these test point vias outside the 
board outline and you can manually place them on the board.
Specify the type of via to insert from the Use Test Point Via list.

Use Test Point Via list Specifies the via type to use for test points. This list is enabled when 
you select any of the following check boxes:

• Add Test Points to Existing Traces

• Add Off-board Test Points to Inaccessible Nets

This setting also determines the via type used by the Add Test Point 
command and End Test Point command.

Allow Stubs Specifies to allow stubs.

Place Via Points Using area Specifies the grid type to use for via test point placement:
• Via Grid — uses the via grid that you set in the Grids options  on 

page 1537.

• Test Point Grid — specify the grid spacing in the X and Y boxes.

Probe Through area

PCB Top Side Specifies to probe the board from the top and bottom sides of the PCB.

 Tip
Pins are always available for probing from the bottom side, whether 
or not the PCB Top Side check box is selected. If you want to probe 
only the top side, see “Probing the PCB Top Side Only”.

Vias Specifies to use vias as test points.

 Tip
When the via is flagged as a test point, and the Show Test Points 
check box is selected in the Options dialog box > Routing  category 
> General subcategory  on page 1542, an arrow is drawn on it in 

the design:

Pins Specifies to use pins as test points.
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Field Description

 Tip
When the pin is flagged as a test point, and the Show Test Points 
check box is selected in the Options dialog box > Routing  category 
> General subcategory  on page 1542, an arrow is drawn on it in 

the design:

Unused Pins and Probe 
Unused Pins Net Name

Specifies to provide access to unused pins during automated testing, 
and then type the net name used for all the unused pins in the design.
If the unused pin is an SMD pad, DFT Audit attaches a test point via by 
adding one single pin net to each unused SMD pin. If the unused pin 
is a through hole component pin, DFT Audit assigns the unused pin as 
test point.

Available Nail Diameters table The nail diameters are listed in order of preference, where the first 
entry is the most preferred. You can only use a maximum of fifteen 
integer characters in the nail diameter name.

• Name — Specifies the probe size. The name is used to identify 
unique probe types. During the placement or assignment of test 
points, DFT Audit assigns values you specify in the Name cell as via 
or pin attributes. When you change these values, attributes for all 
vias and pins with these values are updated.

• Fixture Drill Size  — The diameter of the drilled hole in the fixture. 
Recommendation: Fixture drill size is used to calculate all rules 
relevant to the probe size, and its diameter should usually be 
slightly larger than the probe size.

• Enabled — Specifies whether or not to use the associated nail 
during automated testing.

• Add  — adds a row to the bottom of the table.

• Delete  — removes the selected row from the table.

• Up  and Down  — moves the selected row up or down.

Minimum Pad Probing Sizes Set minimum pad probing sizes for both vias and component pins to 
ensure that there is sufficient pad area for probe contact.

Run button Starts the automatic audit process.

Related Topics
Placing Test Points
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DFT Audit Dialog Box, Properties Tab
To access: Tools  > DFT Audit  menu item > Properties  tab

Several test point properties are available to you on the Properties  tab of the DFT Audit dialog box.

Tip
To reduce design iterations, consult with your automated test engineers when setting DFT Audit 
options.

Objects

Field Description

Probe Minimum Distances 
area

Specifies the minimum distances between the probe and other design 
objects using options in the Probe Minimum Distances area.
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Field Description

 Tip
The clearances needed between a probe and another design object 
are mostly based on the physical constraints of the Automated Test 
Equipment (ATE) used by In Circuit Testing (ICT) procedures. The 
probes extending out of the ATE fixture must make contact with the 
PCB without any obstacle. This means that test points must keep a 
fixed distance from component bodies, pads, mounting holes, and 
board edge, and must also have the minimum spacing between 
them.

Stub Length Specifies the maximum length of trace stubs required to make a net 
accessible to a test probe.

Multiple Test Point Nets table Displays the Net name, net pins, and net vias. Specifies the nail pins.

 Tip
• If you do not want any nail pins on a net, double-click the Nail Pins 

cell for the net and type zero (0).

• To sort the list by a different column, click the column header at the 
top of the list.

Show Only Nets With Pins 
Not Equal to One

Specifies to display only nets with no nail pin or with more than one nail 
pin in the table.

Run  button Starts the automatic audit process.

Related Topics
Setting Test Point Properties
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Die Flag Wizard Dialog Box
To access: BGA Toolbar  button > Die Flag Wizard  button > select die

Use the Die Flag Wizard dialog box to define the number of rings to create. Make selections that define 
the layers, shapes, dimensions, net connections, and other properties of the die flag and rings that you 
are creating.

Restriction:
This information applies only to the BGA toolkit.

Objects

Field Description

Die Flag and Rings list Lists all currently defined die flag shapes. Shapes have the predefined 
names Die Flag, Ring 1, Ring 2, and so on. These names appear only 
in the dialog box; they are not the names of the design copper shapes.
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Field Description

To view or modify settings for a shape, either the die flag or a ring, 
select the shape. Settings that you change in the dialog box apply only 
to the currently selected shape.
To create the selected shape, click the check box. If the shape's check 
box is cleared, Die Flag Wizard does not create that shape. It does, 
however, account for the shape's spacing while creating other shapes.

Add button Inserts a new ring around the selected shape (die flag or ring). The 
settings for this new ring are the same as for the selected shape. There 
is no limit to the number of rings you can add; however, only one die 
flag is allowed.

Delete button Deletes the currently selected ring from the list of shapes that Die Flag 
Wizard will create.
You cannot delete the die flag.

Layer list Lists all layers in the design. Specify a layer for the currently selected 
shape.

Shape list Specifies the shape of the die flag or ring:
• Rectangle

• Rounded rectangle

• Chamfered rectangle

• Arced

Spacing Specifies the distance between the inner edge of the die flag ring and 
the die outline. For other rings, this selection specifies the distance 
between the inner edge of the selected ring and the outer edge of the 
ring contained within it.
The value for the spacing can be positive, negative, or zero.

Width Assigns a width, in current design units, for the selected ring (including 
the die flag ring). Enter a width greater than zero.

Arc Height Assigns a height for the arced shape. Enter a value greater than or 
equal to zero.

Net list Lists net names. Select a net name to assign to the currently selected 
shape.

New Net button Opens the Define Name of New Net Dialog Box, where you can add 
the name of a new net to the list of available nets.

Create Solder Mask Shapes Creates a solder mask shape for the selected shape if the box is 
checked.

Solder Mask Layer Selects a layer upon which to create the solder mask.
The Layer list contains the names of the design layers associated with 
a solder mask.

Inside Compensation Defines the size of the overlap with or retraction of the solder mask 
shape from the inside of the conductive shape. To make the solder 
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Field Description
mask overlap the inside of the conductive shape, enter a positive value. 
To make the solder mask retract from the inside of the conductive 
shape, enter a negative value.

Outside Compensation Defines the size of the overlap with or retraction of the solder mask 
shape from the outside of the conductive shape. To make the solder 
mask overlap the outside of the conductive shape, enter a positive 
value. To make the solder mask retract from the outside of the 
conductive shape, enter a negative value.

Number Lists the number of spokes for the die flag. Available selections are: 4, 
8, 12, and 16.

Width Select the spoke width for the die flag.

Miter Size Select the size of the straight-line segments to miter acute angles 
where the die flag spokes connect to the rings or paddles.
The value must be greater than zero. It cannot exceed the distance 
between the outer edge of the center paddle and the inner edge of the 
die flag ring.

 Tip
To avoid acid traps, acute angles are not allowed.

Project from Corners Select whether to project the spoke configuration from the corner. 
When Project from corners is cleared, the spokes are offset from the 
corner.

Coverage Defines the size of the die flag's center paddle. It is the ratio of the area 
of the center paddle to the area of the entire die flag. The entire die flag 
encompasses the center paddle, spokes, and die flag ring.
Select a value between zero and 100. A value of zero means that the 
center paddle is not generated. A value of 100 means that the die 
flag is generated as one, solid shape without a defined center paddle, 
spoke, or ring.

Create button Creates all shapes that are checked in the list box, saves their settings, 
and closes the Die Flag Wizard Dialog Box.

Related Topics
Creating a Die Flag and Rings

The Die Flag Wizard
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Die Wizard - Create from GDSII File Dialog Box
To access: BGA Toolbar  button > Die Wizard  button > From GDSII File  button

Use this dialog box to add a new die to the current design or library based on an imported GDSII file.

Description
Use the dialog box to:

• Define a die outline from a GDSII file

• Define a set of CBPs from a GDSII file

• Define the numbering of CBPs

• Define the functions for pads from a GDSII file

• Define preferences for die component creation

Restriction:
This information applies only to the BGA toolkit.

The Die Wizard has 5 tabs:

• “Figure 160”  on page 1282

• “Figure 161”  on page 1283

• “Figure 162”  on page 1283

• “Figure 163”  on page 1284

• “Figure 164”  on page 1284
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Figure 159. Die Wizard - Create from GDSII File Dialog Box

Figure 160. From GDSII Die Size tab
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Figure 161. From GDSII CBP tab

Figure 162. From GDSII Pad # tab
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Figure 163. From GDSII Pad Functions tab

Figure 164. From GDSII Die Prefs tab

Objects
Table  166. Die Wizard - Create from GDSII File Dialog Box Fields

Field Description

File Displays the name of the text file you want to use to create the die.
Click Browse  to open the Open dialog box and chose the file you want.

The Size of GDS Units 
(microns)

Displays the size of the GDS file units in microns. Modify the value if 
necessary.
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Table  166. Die Wizard - Create from GDSII File Dialog Box Fields  (continued)

Field Description

Die Part Type The name of the type of die part you want to use to create the die.

Flip Chip Selects the IC die for facedown mounting. Flip chip components 
contain only pins (SBPs).

Mirror Shapes Mirrors, or flips, the shapes (die geometrical data) on the die display.

tabs • Die Size  on page 1281

• CBP  on page 1281

• Pad #  on page 1297

• Pad Functions  on page 1297

• Die Prefs  on page 1281

Die Data Status area Displays the die size, number of chip bond pads, and number of 
signals.

Units area Sets the global unit type to use to convert system units into one of 
these commonly used sets of measurements:

• Mils — Expressed in mils (1mil = 2.54*10^-5 m).

• Metric — Expressed in millimeters (1mm = 1.0*10^-3 m).

• Inches — Expressed in inches (1" = 2.54*10^-2 m).

All values are expressed on the die display in the units you choose.

 Restriction:
You cannot choose Microns to use as system units. Use Metric if 
the values in the imported file are expressed in microns.

Extent button Displays the design in the largest x and y area that is occupied by all 
items within the die definition.

Preview Colors button Opens the Preview Colors dialog box  on page 1305 so you can select 
colors that help you preview your design.

Show All check box When Show All is selected, the die display area contains both the 
shapes that represent the die items, such as the die outline and CBPs, 
and the rest of the shapes from the GDSII file.
When clear, the die display contains only the shapes selected as die 
items.

Preview window Displays the die design. Position the cursor and click to zoom in or 
right-click to zoom out.

Size of Preview Window 
display

Displays the size of the die display in the current unit measurement.

Cursor Position display Displays the position of the cursor in the die display.

SailWind Layout Guide and Reference 1285



GUI Reference Elements D
Die Wizard - Create from GDSII File Dialog Box  

Table  167. Die Size tab contents

Field Description

Set Size area — Select to set the die size and die outline position manually.

Length Type or select the length of the die, which corresponds to the X size.

Width Type or select the width of the die, which corresponds to the Y size.

Height Type or select the height of the die, which defines the thickness of the 
die.

Die Point list The die point (center, lower left, upper left, upper right, or lower right) 
for which you want to specify the coordinates for the base point, as 
expressed in X and Y.

X Type or select the die point along the x-axis you want as the base point 
for X.

Y Type or select the die point along the y-axis you want as the base point 
for Y.

Select from GDS Shape area — Select to choose a GDS shape for the die outline. You can modify the 
Height control, but you cannot modify the other parameters in the Set Size area.

GDS Layer Shows the layers defined in the GDSII file. Use to select the layer on 
which the die outline shape is located.

GDS Shape Shows the names of all the GDS shapes available for selection as the 
die outline shape. Only closed, filled shapes from the GDSII file that are 
also on the selected layer in the GDS Layer list appear.
The shapes appear in the die display area using the Shapes on 
Selected Layers color. The die display adjusts dynamically as you 
choose values, to help you select the proper shape.

Table  168. CBP contents

Field Description

Min Size Sets the minimum size you want to use to filter GDS shapes for CBPs, 
expressed in the current system units.

Max Size Sets the maximum size to use to filter GDS shapes for CBPs.

GDS Layer Use to select the layer on which the GDS shape for CBPs is located.

Shapes Inside Outline Includes only the shapes found inside the die outline in the filtering.

Pad Shape Defines the shape of the pads: rectangle or oval.
• Rectangle — CBP shapes are derived from GDS shapes as 

circumscribed rectangles.

• Oval — CBP shapes are derived from GDS shapes as 
circumscribed circles.
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Table  169. Pad # tab contents

Field Description

Numbering Mode • Circular — Circular numbering.

• JEDEC — JEDEC numbering.

Pin rows are lettered from top to bottom starting with A and pin 
columns are numbered from left to right starting with 1. The letters I, 
O, Q, S, X, and Z are not used. For arrays with more than 20 rows, 
row 21 is designated AA and subsequent rows are designated AB, 
AC, etc.

Direction area Specifies the numbering direction you want to use:
Clockwise — Numbering begins with pad 1 and continues in a 
clockwise direction.
CCW — Numbering begins with pad 1 and continues in a 
counterclockwise (CCW) direction.

Pad 1 Side area Specifies the side of the design to use for the position of pad 1:
Left — On the left side of the design.
Top — On the top of the design.
Right — On the right side of the design.
Bottom — On the bottom of the design.

Pad 1 Location area Specifies the location on the side of the design to use for the position of 
pad 1:
Center — Numbers the center pad of the specified side of the design 
as pad 1.
Left — Numbers the leftmost pad of the specified side of the design as 
pad 1.
Right — Numbers the rightmost pad of the specified side of the design 
as pad 1.
Specify — Numbers the pad you select on the specified side of the 
design as pad 1. Type or select the pad number you want to use for 
pad 1.

Table  170. Pad Functions tab contents

Field Description

Pad column Shows each component bond pad number. Click the Pad column 
header to sort by pad number in either ascending or descending order.

Function column Shows all function names that correspond to component bond pad 
numbers. Click the Function column header to sort by function name 
in either ascending or descending order. Double-click a function to 
change a function name.

Assign Functions area Specifies how you want to use to assign functions:
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Table  170. Pad Functions tab contents  (continued)

Field Description

• From Text File — After selecting the option, click Browse  to select 
the file you want to use to assign pad functions.

• From GDS Texts on Layer — Select the GDS layer you want to use 
to assign pad functions.

Assign button Assigns the new function names to all pads.

Table  171. Die Prefs tab contents

Field Description

Part Type Identifies the die part type to add to the design.

Part Creation Mode area Sets the layer on which the die outline and pads appear. Select a layer 
from the list.

• Add Part to Design — Adds the part to the currently open design. 
Indicate the reference designator that is automatically assigned 
to the new die component in the design in the Part Name box. To 
change the reference designator, click on the part name and enter a 
new name.

• Save to Library — Saves the part in a specified library. Select the 
library in which to save the part.

Die Outline and Pads • Sets the layer on which the die outline and pads appear. Select a 
layer from the list.

Related Topics
Creating a Die from a GDSII File
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Die Wizard - Create from Text File Dialog Box
To access: BGA Toolbar  button > Die Wizard  button > From Text File  button

Use this dialog box to add a new die to the current design or library based on an imported text file.

Description
Use the dialog box to:

• Define a die outline.

• Modify the shapes of CBPs from a text file.

• Define the numbering of CBPs from a text file.

• Modify the functions for pads from a text file.

• Define preferences for die component creation.

Restriction:
This information applies only to the BGA toolkit.

The Die Wizard has 5 tabs:

• “Figure 166”  on page 1290

• “Figure 167”  on page 1291

• “Figure 168”  on page 1291

• “Figure 169”  on page 1292

• “Figure 170”  on page 1292
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Figure 165. Die Wizard - Create from Text File Dialog Box

Figure 166. From Text File Die Size tab
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Figure 167. From Text File CBP tab

Figure 168. From Text File Pad # tab

SailWind Layout Guide and Reference 1291



GUI Reference Elements D
Die Wizard - Create from Text File Dialog Box  

Figure 169. From Text File Pad Functions tab

Figure 170. From Text File Die Prefs tab

Objects
Table  172. Die Wizard - Create from Text File Dialog Box Fields

Field Description

File Displays the name of the text file you want to use to create the die.
Click Browse  to open the Open dialog box and chose the file you want.

Imported File Units (Metric) Displays the size of the imported file units in microns. Modify the value 
if necessary.
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Table  172. Die Wizard - Create from Text File Dialog Box Fields  (continued)

Field Description

Die Part Type The name of the type of die part you want to use to create the die.

Flip Chip Selects the IC die for facedown mounting. Flip chip components 
contain only pins (SBPs).

Mirror Shapes Mirrors, or flips, the shapes (die geometrical data) on the die display.

tabs • Die Size  on page 1289

• CBP  on page 1289

• Pad #  on page 1289

• Pad Functions  on page 1289

• Die Prefs  on page 1289

Die Data Status area Displays the die size, number of chip bond pads, and number of 
signals.

Units area Sets the global unit type to use to convert system units into one of 
these commonly used sets of measurements:

• Mils — Expressed in mils (1mil = 2.54*10^-5 m).

• Metric — Expressed in millimeters (1mm = 1.0*10^-3 m).

• Inches — Expressed in inches (1" = 2.54*10^-2 m).

All values are expressed on the die display in the units you choose.

 Restriction:
You cannot choose Microns to use as system units. Use Metric if 
the values in the imported file are expressed in microns.

Extent button Displays the design in the largest x and y area that is occupied by all 
items within the die definition.

Preview Colors button Opens the Preview Colors dialog box  on page 1305 so you can select 
colors that help you preview your design.

Preview window Displays the die design. Position the cursor and click to zoom in or 
right-click to zoom out.

Size of Preview Window 
display

Displays the size of the die display in the current unit measurement.

Cursor Position display Displays the position of the cursor in the die display.

Table  173. Die Size tab contents

Field Description

Length Type or select the length of the die, which corresponds to the X size.

Width Type or select the width of the die, which corresponds to the Y size.
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Table  173. Die Size tab contents  (continued)

Field Description

Height Type or select the height of the die, which defines the thickness of the 
die.

Die Outline Base Point list Center, lower left, upper left, upper right, or lower right - for which you 
want to specify the coordinates for the base point, as expressed in X 
and Y.

X Type or select the die point along the x-axis you want as the base point 
for X.

Y Type or select the die point along the y-axis you want as the base point 
for Y.

Table  174. CBP tab contents

Field Description

Override pad shape Overrides the values from the file using the values you enter in Shape, 
Length, and Width to define the shape for all pads.

Shape Defines the shape of the pads: rectangle or oval.

Length Specifies the value for the pad length.

Width Specifies the value for the pad width.

Table  175. Pad # tab contents

Field Description

Override Pad numbers Overrides the values from the file using the values you enter to define 
the pad numbering.

Numbering Mode • Circular — Circular numbering.

• JEDEC — JEDEC numbering.

Pin rows are lettered from top to bottom starting with A and pin 
columns are numbered from left to right starting with 1. The letters I, 
O, Q, S, X, and Z are not used. For arrays with more than 20 rows, 
row 21 is designated AA and subsequent rows are designated AB, 
AC, etc.

Direction area Specifies the numbering direction you want to use:
Clockwise — Numbering begins with pad 1 and continues in a 
clockwise direction.
CCW — Numbering begins with pad 1 and continues in a 
counterclockwise (CCW) direction.

Pad 1 Side area Specifies the side of the design to use for the position of pad 1:
Left — On the left side of the design.
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Table  175. Pad # tab contents  (continued)

Field Description

Top — On the top of the design.
Right — On the right side of the design.
Bottom — On the bottom of the design.

Pad 1 Location area Specifies the location on the side of the design to use for the position of 
pad 1:
Center — Numbers the center pad of the specified side of the design 
as pad 1.
Left — Numbers the leftmost pad of the specified side of the design as 
pad 1.
Right — Numbers the rightmost pad of the specified side of the design 
as pad 1.
Specify — Numbers the pad you select on the specified side of the 
design as pad 1. Type or select the pad number you want to use for 
pad 1.

Table  176. Pad Functions tab contents

Field Description

Pad column Shows each component bond pad number. Click the Pad column 
header to sort by pad number in either ascending or descending order.

Function column Shows all function names that correspond to component bond pad 
numbers. Click the Function column header to sort by function name 
in either ascending or descending order. Double-click a function to 
change a function name.

Table  177. Die Prefs tab contents

Field Description

Part Type Identifies the die part type to add to the design.

Part Creation Mode area Sets the layer on which the die outline and pads appear. Select a layer 
from the list.

• Add Part to Design — Adds the part to the currently open design. 
Indicate the reference designator that is automatically assigned 
to the new die component in the design in the Part Name box. To 
change the reference designator, click on the part name and enter a 
new name.

• Save to Library — Saves the part in a specified library. Select the 
library in which to save the part.

Die Outline and Pads Specifies the layer on which you want to create the die data.
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Related Topics
Creating a Die from a Text File
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Die Wizard - Create Parametrically Dialog Box
To access: BGA Toolbar  button > Die Wizard  button > Parametrically  button

Use this dialog box to set up parameters for adding a new die to the current design or library.

Description
Use the dialog box to:

• Define a die outline.

• Define a set of CBPs.

• Define the numbering of CBPs.

• Define the functions for pads.

• Define preferences for die component creation.

• Add new die to the current design or to the part library.

On the CBP  tab, there are two ways to set up pad counts:

• Set up the total pad count for a die with automatic distribution of pad counts evenly along the 
sides, using Total, GND %, and PWR %.

• Set up a specific pad count for each side of a die, using Side, Total Pads, GND, and PWR.

• Define preferences for die component creation

Restriction:
This information applies only to the BGA toolkit.

The Die Wizard has 5 tabs:

• “Figure 172”  on page 1298

• “Figure 173”  on page 1299

• “Figure 174”  on page 1299

• “Figure 175”  on page 1300

• “Figure 176”  on page 1300
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Figure 171. Die Wizard - Create Parametrically Dialog Box

Figure 172. Die Size tab
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Figure 173. CBP tab

Figure 174. Pad # tab
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Figure 175. Pad Functions tab

Figure 176. Die Prefs tab

Objects
Table  178. Die Wizard - Create Parametrically Dialog Box Fields

Field Description

Die Part Type The name of the type of die part you want to use to create the die.

Flip Chip Selects the IC die for facedown mounting. Flip chip components 
contain only pins (SBPs).

Mirror Shapes Mirrors, or flips, the shapes (die geometrical data) on the die display.
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Table  178. Die Wizard - Create Parametrically Dialog Box Fields  (continued)

Field Description

tabs • Die Size  on page 1297

• CBP  on page 1297

• Pad #  on page 1297

• Pad Functions  on page 1297

• Die Prefs  on page 1297

Die Data Status area Displays the die size, number of chip bond pads, and number of 
signals.

Units area Sets the global unit type to use to convert system units into one of 
these commonly used sets of measurements:

• Mils — Expressed in mils (1mil = 2.54*10^-5 m).

• Metric — Expressed in millimeters (1mm = 1.0*10^-3 m).

• Inches — Expressed in inches (1" = 2.54*10^-2 m).

All values are expressed on the die display in the units you choose.

 Restriction:
You cannot choose Microns to use as system units. Use Metric if 
the values in the imported file are expressed in microns.

Extent button Displays the design in the largest x and y area that is occupied by all 
items within the die definition.

Preview Colors button Opens the Preview Colors dialog box  on page 1305 so you can select 
colors that help you preview your design.

Preview window Displays the die design. Position the cursor and click to zoom in or 
right-click to zoom out.

Size of Preview Window 
display

Displays the size of the die display in the current unit measurement.

Cursor Position display Displays the position of the cursor in the die display.

Table  179. Die Size tab contents

Field Description

Length Type or select the length of the die, which corresponds to the X size.

Width Type or select the width of the die, which corresponds to the Y size.

Height Type or select the height of the die, which defines the thickness of the 
die.

Die Point list (center, lower left, upper left, upper right, or lower right) for which you 
want to specify the coordinates for the base point, as expressed in X 
and Y.
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Table  179. Die Size tab contents  (continued)

Field Description

X Type or select the die point along the x-axis you want as the base point 
for X.

Y Type or select the die point along the y-axis you want as the base point 
for Y.

Table  180. CBP contents

Field Description

Total Type or select the total pad count for the die. If you modify the total pad 
count, the pads are evenly distributed along the four sides.

GND % Type or select the percentage of the total pin count to allocate as 
ground pads. If you modify the value, the ground pads for each side are 
derived from the Total count.

PWR % Type or select the percentage of the total pin count to allocate as 
power pads. If you modify the value, the power pads for each side are 
derived from the Total count.

Side column Lists the sides of the die.

Total Pads column View or double-click to change the total number of pads for each side 
of the die. If you modify a value, the values in Total, GND %, and PWR 
% adjust accordingly.

GND column View or double-click to change the total number of ground pads for 
each side of the die. If you modify a value, the values in Total, GND %, 
and PWR % adjust accordingly.

PWR column View or double-click to change the total number of power pads for each 
side of the die. If you modify a value, the values in Total, GND %, and 
PWR % adjust accordingly.

Pad Pitch Defines the distance between pads. The distance is measured from the 
left side of one pad to the left side of the next adjacent pad.

Row Pitch Defines the distance between rows to control creation of staggered row 
patterns. For a single row in a straight line around the sides of the die, 
enter 0. To create staggered row patterns, enter a specific positive or 
negative number.

Distance from Die Edge Defines the distance between the row of the pads and the die edge.

Pad Shape Sets the shape of the thermal relief  on page 1866: Round, Square, 
Rectangular, or Oval Pads.

Pad Length Type or select the value for the pad length.

Pad Width Type or select the value for the pad width.
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Table  181. Pad # tab contents

Field Description

Numbering Mode • Circular — Circular numbering.

• JEDEC — JEDEC numbering.

Pin rows are lettered from top to bottom starting with A and pin 
columns are numbered from left to right starting with 1. The letters I, 
O, Q, S, X, and Z are not used. For arrays with more than 20 rows, 
row 21 is designated AA and subsequent rows are designated AB, 
AC, etc.

Direction area Specifies the numbering direction you want to use:
Clockwise — Numbering begins with pad 1 and continues in a 
clockwise direction.
CCW — Numbering begins with pad 1 and continues in a 
counterclockwise (CCW) direction.

Pad 1 Side area Specifies the side of the design to use for the position of pad 1:
Left — On the left side of the design.
Top — On the top of the design.
Right — On the right side of the design.
Bottom — On the bottom of the design.

Pad 1 Location area Specifies the location on the side of the design to use for the position of 
pad 1:
Center — Numbers the center pad of the specified side of the design 
as pad 1.
Left — Numbers the leftmost pad of the specified side of the design as 
pad 1.
Right — Numbers the rightmost pad of the specified side of the design 
as pad 1.
Specify — Numbers the pad you select on the specified side of the 
design as pad 1. Type or select the pad number you want to use for 
pad 1.

Table  182. Pad Functions tab contents

Field Description

Pad column Shows each component bond pad number. Click the Pad column 
header to sort by pad number in either ascending or descending order.

Function column Shows all function names that correspond to component bond pad 
numbers. Click the Function column header to sort by function name 
in either ascending or descending order. Double-click a function to 
change a function name.

Signal Function Prefix Type or view the function prefix you want to use to derive the signal 
pad names.
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Table  182. Pad Functions tab contents  (continued)

Field Description

GND Pad Function Type or view the function name you want to use for the ground pads.

PWR Pad Function Type or view the function name you want to use for the power pads.

Assign button Assigns the new function names to all pads.

Table  183. Die Prefs tab contents

Field Description

Part Type Identifies the die part type to add to the design.

Part Creation Mode area Sets the layer on which the die outline and pads appear. Select a layer 
from the list.

• Add Part to Design — Adds the part to the currently open design. 
Indicate the reference designator that is automatically assigned 
to the new die component in the design in the Part Name box. To 
change the reference designator, click on the part name and enter a 
new name.

• Save to Library — Saves the part in a specified library. Select the 
library in which to save the part.

Die Outline and Pads Specifies the layer on which you want to create the die data.

Related Topics
Creating a Die Parametrically
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Die Wizard Preview Colors Dialog Box
To access: BGA Toolbar  button > Die Wizard  button > any button > Preview Colors  button

Use the Die Wizard Preview Colors dialog box to select colors for previewing your die design.

Restriction:
This information applies only to the BGA toolkit.

Description
Setting colors on this dialog box does not change the colors you set in the Display Colors Setup Dialog 
Box.

Objects

Field Description

Selected Color area Select the color you want to apply to one or more items on the dialog 
box.

Background Sets the background color in the die display area.

Highlight Sets the highlight color in the die display area.

Die Outline Sets the color of the die outline in the die display area.

CBP Sets the color of the CBPs in the die display area.

CBP # Sets the color of the CBP numbers in the die display area.
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Field Description

All Shapes Sets the color of all GDS shapes in the die display area. The GDSII 
shapes area of the dialog box is active only when you are creating a 
die from a GDSII file.

Shapes on Selected Layers Sets the color of the GDS shapes in the GDSII file that appear on the 
selected GSD Layer, in the die display area. The color appears only 
when the Die Size  tab or the Pad Functions  tab is active. The GDSII 
shapes area of the dialog box is active only when you are creating a 
die from a GDSII file.

Related Topics
Setting Die Preview Colors in the Die Wizard
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Differential Pairs Dialog Box
To access: Setup  > Design Rules  menu item > Differential Pairs  button

Use the Differential Pairs dialog box and its tabs to identify nets, electrical nets, or pin pairs that behave 
electrically as differential pairs, and to define differential pair design rules.

Description
You can set different properties for differential pairs, which affects how they are routed. Differential pair 
properties determine the gap between the traces in the controlled gap area  on page 1818, the minimum 
and maximum trace lengths and widths, and how to respond to obstacles  on page 1843 in the controlled 
gap area.

Tip
You can define Differential Pairs Rules in SailWind Layout, but these rules are used in SailWind 
Router only. Layout does, however, respect the diff pair gap as a trace to trace clearance.
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Objects

Field Description

Available list Lists the nets, pin pairs, or electrical nets available for differential pair 
creation.

 Tip
Nets, electrical nets, or pin pairs cannot be part of more than one 
differential pair. The Available list displays only items that have not 
been assigned to a differential pair.

Select>> Use the top and bottom Select buttons to move the first and second 
items making up a diff pair to a holding area, from which you can add 
them to the Pairs list.

1308 SailWind Layout Guide and Reference



 
GUI Reference Elements D

Differential Pairs Dialog Box

Field Description

<<Unselect Moves the first and second items back to the Available list.

Add>> Moves the selected items to the Pairs list.
This button is unavailable unless two items are selected and in the 
holding area.

<<Remove Moves the selected pair from the Pairs list back to the Available list.

Pairs list Lists the created differential pairs.

Trace length area Specifies the minimum and maximum length for a trace.

Restrict layer changes during 
autorouting check box

Forces the selected pair to be routed on a single layer.
This setting does not restrict layer changes when routing interactively.

Set trace width and gap for 
the pair by layer table

Specifies the width and gap per layer.
• Layer — The layer to set width and gap values.

 Tip
Setting the differential pair width and gap per layer enables you 
to better control impedance.

• Width — Specifies the width value for differential pairs on the 
specified layer.

• Gap — Specifies the gap value for differential pairs on the specified 
layer. Important: The Gap also specifies the trace to trace 
clearance. This clearance takes precedence over any other trace to 
trace clearance in the rules hierarchy  on page 404.

• Add  button — Adds a row to the bottom of the table to specify width 
and gap values for another layer.

• Delete button — Removes the selected row from the table.
 Restriction:
You cannot remove the <All Layers> row.

Obstacles • Allow pair to split around obstacles — Specifies to enable routing 
around an obstacle in the controlled gap area by temporarily 
exceeding the pair routing gap.

 Tip
This setting applies to autorouting and does not restrict splitting 
around obstacles when routing interactively.

• Maximum number of obstacles — Specifies the maximum number 
of obstacles to route around in the Maximum number of obstacles 
box. Obstacles in the start zone  on page 1862 or end zone  on 
page 1825 are not counted.

• Maximum obstacle size — Specifies the maximum spacing allowed 
between traces around obstacles in the Maximum obstacle size 
box. The size applies to the obstacle's longest horizontal or vertical 
dimension. Obstacle size in the start zone or end zone is not 
checked.
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Field Description

Preview area Shows the way in which the differential pairs will split around objects 
based on your selections.

Related Topics
Creating Differential Pair Design Rules

Deleting a Differential Pair Design Rule
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Dimension Properties Dialog Box
To access: Select a dimension > right-click > Properties  popup menu item.

The Dimension Properties dialog box reflects the type of dimension (Vertical, Horizontal, or Aligned), that 
you have currently selected.

Objects

Field Description

Type Displays the type of the selected dimension.

X/Y Specifies the x and y coordinates of the dimension object. The 
coordinates are calculated from the bottom of one of the extension 
lines or from the radius point of an arc. Type a new value to change the 
location.

Text Rotation Specifies the current rotation value. Positive values rotate entries 
in a counterclockwise direction. Negative values rotate entries in a 
clockwise direction. Type a new value to change the rotation.

Layer list Specifies the new layer to which to assign the entire dimension object, 
even if different layers were assigned for text and lines in the Options 
dialog box > Dimensioning  category > General subcategory  on 
page 1520of the Options dialog box.

Circle Dimension Allows modification of radial dimensions to indicate measurements 
from the radius point or diameter. Click one of these buttons to change 
the measurement type:

• Radius — Measures the circle dimension from the radius point.

• Diameter — Measures the circle dimension from the diameter.

Related Topics
Dimensioning Process
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Dimension Text Properties Dialog Box
To access: Select dimension text > right-click > Properties  popup menu item

The Dimension Text Properties dialog box displays information about the selected text string and provides 
several areas for modifying the string.

Description
It remains open until you click OK or Cancel. Selecting another text object while the dialog box is open 
updates the information for the selected object.

After a dimension object is created, you might need to change the location of the text string to 
accommodate existing dimensions. Use either Dynamic Drag or the Move command to move the object.

Objects

Field Description

Text Displays the current content of the selected string. Type in the box to 
modify the text string.

 Tip
Modifying the content of the text string does not adjust the 
extension line to accommodate the new text length. Use Change 
Length to modify the position of the extension line and update the 
text string.

Layer list Lists the current working layer. Select a new layer from the list.
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Dimension Text Properties Dialog Box

Field Description

X and Y boxes Lists the X and Y coordinate locations of the text, calculated from the 
lower left corner of the text string. Type new values to change the 
location of the text.

Size Specifies the size of the font.
Size (pts): This is font size in points and appears for system fonts
Size (mils): This is font character height and appears for stroke fonts. 
The size refers to the height of the tallest characters.

Line Width Specifies the line width for stroke fonts only.

Rotation Lists the current rotation value. Positive values rotate in a 
counterclockwise direction. Negative values rotate in a clockwise 
direction. Type a new value to change the rotation.

Mirrored Select to flip the text - text is considered readable from the bottom side 
of the board.

Parent Button Opens the Dimension Properties Dialog Box  for the dimension object 
with which the selected object is associated.

Related Topics
Dimensioning Process
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Discarding Copper Plane Data Dialog Box
To access: The Discarding Copper Plane Data dialog box appears automatically when you save a file 
in which you have copper plane data, and have set Prompt to discard copper plane data on the Options 
dialog box.

Use the Discarding Plane Data dialog box to control which plane data is saved.

Objects

Field Description

Don’t notify me next time Select the check box to suppress this message for subsequent file 
saves.

Proceed Saves only the plane polygons.

Save All Saves all copper plane data and changes the option for future 
saves.
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Disconnect Pin Dialog Box
To access: select a pin > ECO Toolbar > Delete Connection  button

Use the Disconnect Pin dialog box to confirm the disconnection of the pin from the net to which it is 
attached and to delete the route segment(s) that are attached to the pin.

CAUTION:
If you choose not to delete any routes that are attached to the pin, the routes will still appear as 
attached in the design and the gerber output files. Without deleting the routes, the pin is only 
disconnected in the netlist.

Objects

Field Description

Delete Routes Select to delete the route segment(s) that are connected to the pin. If you 
do not delete the routes, the pin will still appear as though it is attached.

 Tip
Only the routes of the pin pairs to/from the disconnected pin are 
deleted. All other segments belonging to the net are retained.

Related Topics
Deleting a Connection in ECO Mode
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Disperse by Logic Dialog Box
To access: With nothing selected, right-click and click the Disperse by Logic  popup menu item.

Use this dialog box to disperse parts while retaining their relative positions almost as indicated in the 
schematic sheet. You can also specify what action to take and perform on the parts to disperse.

Objects
Table  184. Parameter Description

Field Description

Min Space Specifies the minimum allowable spacing between parts to disperse in 
mils.

Union/Cluster area Specifies what action to take and perform on the parts to disperse by 
clicking Disperse All/Disperse  button, with options below:

• Nothing (default): Nothing else

• Create Union: Use the parts to create a union.

• Create Cluster: Use the parts to create a cluster.

Sheets/Parts area • Sheets list on the left: Lists all the schematic sheets.

• Parts table on the right: Displays information of parts in the selected 
schematic sheet, including reference designator, PCB decal, and 
value. Changes depending on the selection made in the Sheets list.

1316 SailWind Layout Guide and Reference



 
GUI Reference Elements D

Disperse by Logic Dialog Box

Table  184. Parameter Description  (continued)

Field Description

Disperse All Disperses parts in all schematic sheets, except those glued or in 
unions/clusters.

Disperse Disperses parts in the selected schematic sheet, except those glued or in 
unions/clusters.

 Note:
If no space is available for placement, the parts attach to the pointer 
for manual placement in the design.
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Display Colors Setup Dialog Box
To access: Setup  > Display Colors  menu item

Use the Display Colors Setup dialog box to Set display colors, save them, and restore them. Use this 
dialog to also change the color palette and make objects visible or invisible.

Tip
Changes you make to the color configuration in the Display Colors Setup dialog box do not apply 
to disabled layers.

1318 SailWind Layout Guide and Reference



 
GUI Reference Elements D

Display Colors Setup Dialog Box

Objects

Field Description

Selected Color area Select a color from the palette to assign to items on a layer. Once 
you select a color here, click the tile in the Color by Layer area of 
the item to which you want to assign the color.
See also: “Changing the Color Palette”.

Palette Opens the Color dialog box where you can choose to use new 
colors or customize colors you want to use.
See also: “Changing the Color Palette”.

Default Palette Reassigns all colors and settings to the default settings.

 Tip
You can change the default settings by saving a configuration 
and naming it default.

Assign All Opens the Assign Color to All Layers Dialog Box.

Layers/Object Types matrix  — Use this area to assign various colors to different objects on different 
layers. See also: “Setting Colors for the Design”.

Layers (rows) The rows of layers lists the layers as you have named them in the 
Layers Setup Dialog Box.

 Tip
• You can clear the check box of a row to make the layer 

invisible.

• To make all items on a layer one color, click the number of the 
row to select all row objects and then click a color tile in the 
Selected Color area. You can also select multiple rows using 
Shift+click for a range or Ctrl-click for a selection.

Object Types (columns) The columns list object types in the design.
• Pin Numbers and Net Names — Sizing is controlled by the 

settings in the Display Options  on page 1525.

• Top/Bottom Objects—Used to control the visibility of component 
body outlines and placement outlines. Tiles in these columns 
associated with the Top and Bottom Component Side or 
Top/Bottom Silkscreen layers control the visibility of component 
body outlines. Tiles in these columns associated with Layer 20 
control the visibility of Layer 20 (Placement) outline objects.

 Tip
• You can clear the check box of a column to make the objects 

invisible on all layers.

• To make all of one object type the same color on each layer, 
click the object name in the column header to select the object 
on all layers and then click a color tile in the Selected Color 
area. You can also select multiple columns using Shift+click for 
a range or Ctrl-click for a selection.
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Field Description

 Note:
Even if the Net Name column check box is selected and the 
tiles on layers are given a color, the display of net names is still 
restricted by the state of the Show net names on Traces, Vias, 
Pins check boxes.

Visible only Lists only visible layers. A layer is visible if at least one tile is 
assigned a non-background color.

Other area Globally assigns colors to other items. Click a color from the 
Selected Color area and click the tile of the item. You can globally 
control the colors for the following objects:

• Background — Setting other objects to this color makes them 
invisible.

• Selections — Objects that are selected for modifying.

• Highlight — Objects that are highlighted but not selected for edit 
operations.

• Board outline — Applies to the board outline and board cut 
outs.

• Connection — Unrouted pin pairs or the “ratsnest.”

Configuration list The list of saved configurations.

Save Opens the Save Configuration Dialog Box.

Delete Removes the selected configuration from the Configuration list.

Show net names on Traces, Vias, 
Pins

Select the check boxes to activate locations where net names 
should be visible.
Requirement:  To display net names on these objects, you must 
also select the check box for the Net Names column and give 
colors to color tiles in the column.

 Tip
• You can use the modeless commands NNT, NNV, and NNP to 

toggle these check boxes.

• The sizing and frequency of net name placement is controlled 
by the settings in the Display Options  on page 1525.

Apply immediately Specifies that any change in color or visibility made in this dialog 
box is immediately applied to the design; clicking the Apply button 
is not needed.

Related Topics
Hiding Layers

Display Colors Setup Dialog Box in the Decal Editor
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Display Colors Setup Dialog Box

Setting Colors for the Design

Saving Color Assignments to a File
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Display Colors Setup Dialog Box in the Decal 
Editor
To access: Tools  > PCB Decal Editor  menu item > Setup  > Display Colors  menu item

Use the Display Colors Setup dialog box to set display colors, save them, and restore them. Also use this 
dialog box to change the color palette and make objects visible and invisible.

Description

• Color changes are not permanently saved in the Decal Editor. To make permanent changes to the 
colors, see “Creating a New Default Decal Editing Environment”.

• Changes you make to the color configuration in the Display Colors Setup dialog box do not apply 
to disabled layers.
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Objects

Field Description

Selected Color area Select a color from the palette to assign to items on a layer. Once 
you select a color here, click the tile in the Color by Layer area of 
the item to which you want to assign the color.
See also: “Changing the Color Palette”.

Palette Opens the Color dialog box where you can choose to use new 
colors or customize colors you want to use.
See also: “Changing the Color Palette”.

Default Palette Reassigns all colors and settings to the default settings.

 Tip
You can change the default settings by saving a configuration 
and naming it default.

Assign All Opens the Assign Color to All Layers Dialog Box.

Layers/Object Types matrix  — Use this area to assign various colors to different objects on different 
layers.See also: “Setting Colors for the Design”.

Layers (rows) The rows of layers lists the layers as you have named them in the 
Layers Setup Dialog Box.

 Tip
• You can clear the check box of a row to make the layer 

invisible.

• To make all items on a layer one color, click the number of the 
row to select all row objects and then click a color tile in the 
Selected Color area.

Object Types (columns) The columns list object types in the design.

 Tip
• Although the Ref. Des. column is not visible as in the Layout 

Editor, it is part of the Pin Num. column.

• You can clear the check box of a column to make the objects 
invisible on all layers.

• To make all of one object type the same color on each layer, 
click the object name in the column header to select the object 
on all layers and then click a color tile in the Selected Color 
area.

Visible only Lists only visible layers. A layer is visible if at least one tile is 
assigned a non-background color.

Color by Layer matrix Use this area to assign various colors to different objects on 
different layers.
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Field Description

 Tip
The layer names that you assigned in the Layers Setup Dialog 
Box  appear along the left side of this area.

See also: “Setting Colors for the Design”.

Other area Globally assigns colors to other items. Click a color from the 
Selected Color area and click the tile of the item. You can globally 
control the colors for the following objects:

• Background — Setting other objects to this color makes them 
invisible.

• Selections — Objects that are selected for modifying.

• Highlight — Objects that are highlighted but not selected for edit 
operations.

Configuration list The list of saved configurations.

Save Opens the Save Configuration Dialog Box.

Delete Removes the selected configuration from the Configuration list.

Apply immediately Specifies that any change in color or visibility made in this dialog 
box is immediately applied to the design; clicking the Apply button 
is not needed.

Related Topics
Creating a New Default Decal Editing Environment

Setting Colors for the Design

Saving Color Assignments to a File
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Drafting Corner Properties
To access: Select a drafting edge > right-click > Properties  popup menu item

Use the Drafting Corner Properties to view an object type, layer assignment, trace clearance, or assigned 
net. You can move a corner by coordinates, access net information, and select the parent shape.

Objects

Field Description

Type Lists the object type.

X,Y Lists the current X,Y location of the corners. Type new values in the 
boxes to move the corner.

Layer Lists the layer on which the object is located.

Track Clearance Specifies clearance values between the corner and objects around it.

Net Lists the net associated with the corner.

Net button Opens the Net Properties dialog box  on page 1487.

Parent button Opens the Drafting Properties Dialog Box  for the drafting object to 
which the corner belongs.

Related Topics
Modifying Drafting Corner Properties
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Drafting Edge Properties Dialog Box
To access: Select a drafting edge > right-click > Properties  popup menu item

Use the Drafting Edge Properties dialog box to view and edit an object type, layer assignment, trace 
clearance, or assigned net.

Description
You can move an edge by coordinates or an arc by radius or start/end angle, access net information, and 
select the parent shape. The following are exceptions:

• For circles, you can change only Center Point and Radius.

• For arcs, use the X1,Y1 and X2,Y2 fields as the arc end points. To define an arc, you only need a 
subset of these fields. To redefine the arc, change only one field at a time. If you make a change 
that cannot be interpreted, the command is canceled.
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Drafting Edge Properties Dialog Box

Objects

Field Description

X1,Y1 / X2,Y2 boxes List the current X,Y location of the first and second corners of the edge. 
Type new values in the boxes to move one or both corners.

XC, and YC boxes The center coordinate of the arc or circle.

Radius box The radius for circles or arcs. Type a new value for the radius.

Start Angle box The starting angle of the arc. Zero (0) degrees is the positive X axis 
and positive angles are created counterclockwise.

Delta Angle box The number of degrees in the angle. Positive angles are created 
counterclockwise.

 Tip
• For circles, you can only change Center Point and Radius.

• For arcs, use the X1,Y1 and X2,Y2 fields as the arc end points. To 
define an arc, you only need a subset of these fields. To redefine 
the arc, only change one field at a time. If you make a change that 
cannot be interpreted, the command is canceled.

Width Lists the width of the edge.

Length Lists the length of the edge.

Layer Lists the layer on which the object is located.

Track Clearance Specifies clearance values between the corner and objects around it.

Net Lists the net associated with the edge.

Net button Opens the Net Properties dialog box  on page 1487.

Parent button Opens the Drafting Properties Dialog Box  for the drafting object to 
which the corner belongs.

Related Topics
Modifying Drafting Edge Properties
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Drafting Properties Dialog Box
To access: Choose a drafting shape, right-click and choose Properties

You can select and edit an entire drafting shape or a part of the shape. The properties you can edit 
depend on whether you select a corner of the drafting object, an edge of the drafting object, the entire 
drafting object, or the parent object.

Restriction:
Several of the options in this dialog box are unavailable if the object is part of a physical design 
reuse.

Description

Figure 177. Drafting Properties Dialog Box
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Drafting Properties Dialog Box

Figure 178. Showing the Nets to Bridge Button

Objects
Table  185. Drafting Properties Dialog Box Fields

Field Description

Type Converts the selected shape to a new one: Copper Plane (flooded), 2D 
Line, Board Outline, Board Cut Out, Copper Cut Out (also used for cut 
outs in Copper Planes), Keepout, or Copper.

 Tip
If your lines appear to be a closed polygon but you receive the 
error, “You cannot convert an open 2D Line into a close...”, with 
your shape selected, right-click and click the Close command. 
Unless there is a physical gap somewhere in your lines, your lines 
will be closed into a single polygon shape.
 Restriction:

• 2D lines that have been combined cannot be changed into other 
shapes. You must first explode the 2D line combination and then try 
to change it to another object.

• 2D lines that are continuous but are not a closed polygon can be 
changed only into a copper path.
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Table  185. Drafting Properties Dialog Box Fields  (continued)

Field Description

• If there is no board outline in the design, the Board Cut Out type 
does not appear in the Drafting Properties dialog box Type list.

• If there is a board outline in the design, the Board Outline option 
does not appear in the dialog box.

Line settings area

Width Specifies the width of the lines used for the outline and fill of the object 
if it applies.

Style Specifies the style of the 2D line object: Solid, Dash, Dot, Dash dot, 
Dash double-dot. You can also set the styles before creating the 2D 
line using the LS Modeless Commands.

 Restriction:
Available for 2D Line types only.

Shape settings area

Scale factor Change the Scale Factor to resize the selected shape. Values greater 
than 1 will increase the size while values less than 1 will shrink the 
object. A scale value of 2 will double the shape's size, a scale value of 
0.5 will halve the shape's size. The object will scale up or down from 
the origin of the shape. The line width does not scale. An arc is too 
large if its radius is greater than 14 inches or its center is outside the 
database coordinate area. The database coordinate area is (-28, -28) 
to (28, 28) inches.

Arc approximation error Specifies the allowable approximation error for scaling arcs. 
Arcs are converted to a set of straight-line segments that 
approximate the arc. The approximation error is the perpendicular 
distance from the approximation segment to the actual 

arc.

Rotation Specifies the rotation of the object

Track clearance Displays the clearance value between the drafting object and objects 
around it.

Solid copper Fills the shape with solid copper despite the Width and Copper Hatch 
grid values which normally dictate the fill pattern of copper objects.

Flood & Hatch Options button Opens the Flood and Hatch Options  on page 1381 dialog box.

 Restriction:
This button is available only for Copper Plane drafting objects.
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Table  185. Drafting Properties Dialog Box Fields  (continued)

Field Description

Layer list Specifies the layer on which this object is located.

 Restriction:
Copper and copper planes cannot be placed on <All Layers>. If you 
need the object on all layers, you must copy the object to the other 
layers.
 Tip
When defining keepouts in the PCB Decal Editor, you can also 
assign keepouts to an <Opposite Side> layer. You cannot do this in 
the Layout Editor.

Net assignment area

Net assignment list Specifies the net to assign to the drafting object.
You can also use the Assign Net by Click  button also found in this 
dialog box.

 Restriction:
• Available for electrical drafting objects only.

• Not available when the Bridge check box is selected. Multiple nets 
apply when using the copper as a bridge. Associate the nets using 
the Nets to bridge button instead.

Assign Net by Click button Assign nets to electrical drafting objects by clicking objects in the 
design. You can click objects such as a pin, via, trace, net, copper, or 
unroute to assign the netname of the object to the copper shape.
You can also select a net from the list in the Net assignment area of 
this dialog box.

 Restriction:
Not available when the Bridge check box is selected. Multiple nets 
apply when using the copper as a bridge. Associate the nets using 
the Nets to bridge button instead.

Show plane nets only When selected, limits the display of nets in the “Net assignment” list to 
only plane nets.
Use this feature when you want to assign nets to plane areas on a 
split/mixed plane, and you want to limit the list to display only those 
nets assigned for use on the plane layer.
This check box appears only when you select “Copper Plane” as the 
object type and you select a split/mixed plane layer from the Layer list.
You can define the list of plane nets in the Layers Setup dialog box 
by clicking the Assign Nets  button for a Split/Mixed layer (choose the 
Setup > Layer Definition  menu item to open the Layers Setup dialog 
box).

Copper bridge, Select the 
nets to Bridge...

When selected, designates the drafting object as a copper to bridge 
two or more nets. Click the Nets to bridge  button to associate the 
bridge nets to the copper.
This ensures that with design rule checking (DRC) enabled, the bridge 
copper is not flagged as a violation when it is physically bridging 
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Table  185. Drafting Properties Dialog Box Fields  (continued)

Field Description
different nets. Only the bridge copper is not flagged by DRC; other 
objects accidentally connecting the nets will be flagged as a violation 
by DRC and/or caught by a Verify Design Clearance check. The 
Connectivity check also catches bridge copper that is not physically 
connected to its assigned nets.

 Restriction:
This is option available only to Copper drafting objects.

See also: “Bridging Nets with Copper”.

Nets to bridge button Opens the Net Association dialog box  on page 1486 in order to select 
the nets to bridge using the copper.
Restriction: This is only available when Copper bridge, Select the nets 
to Bridge check box is selected.
See also: “Bridging Nets with Copper”.

Net button Opens the Net Properties dialog box  on page 1487 in order to view 
and change the properties of the net assigned to the drafting object.

 Restriction:
The net does not function if there is no net assigned to the drafting 
object.

Keepout Restrictions area
This area is only available to Keepout drafting objects. If you set a layer before assigning restrictions, 
there are restrictions that are not available.

Placement Prevents placement of components within the keepout area when 
design rule checking is enabled. When used in combination with the 
Component height check box, it prevents placement only of those 
components with heights greater than the Component height value.

 Tip
When set on a decal-level keepout, this prevents placement of 
other components, not itself.

Component height Prevents placement of components with heights greater than the 
specified height within the keepout area when design rule checking 
is enabled. Type the maximum height value in the box to the right of 
Component Height.

 Tip
The height restriction does not apply to the component that has the 
keepout but other components in the design.

See also: “Restricting Heights in Areas of Component Layers”.

 Restriction:
Unavailable unless you select the Placement check box.

Component drill Prevents placement of components that contain drilled through holes 
within the keepout area, when design rule checking is enabled. (Allows 
only surface mount placement.)

 Restriction:
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Table  185. Drafting Properties Dialog Box Fields  (continued)

Field Description

• Unavailable unless you set the Layer list to <All Layers>.

• Unavailable when creating or editing a decal-level keepout.

Select All button Selects all check boxes in the Restrictions area except Component 
drill.

Trace and copper Prevents the placement of traces within the keepout area, when design 
rule checking is enabled.

 Restriction:
Copper areas are always placed with design rules disabled. 
Placement of copper areas is not prevented but the Verify Design 
utility reports any copper located within the keepout area.

Copper plane Prevents copper planes from flooding within the keepout area when 
design rule checking is enabled.

Via and jumper Prevents the placement of vias and jumpers within the keepout area 
when design rule checking is enabled.

Test point Restricts the placement of test points within the keepout area, when 
design rule checking is enabled.

Accordions Restricts the placement of accordions within the keepout area, when 
design rule checking is enabled.

 Tip
• While you can set this option in SailWind Layout, it applies to 

SailWind Router only.

• Accordion keepouts should be used for batch and interactive routing 
only. Design Verification does not detect accordions that are placed 
on accordion keepouts.

Related Topics
Drafting Object Properties
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Drill Symbols Dialog Box
To access:

• Click the File > CAM  menu item > click the Add  button > select “Drill Drawing” from the 
Document Type dropdown list > select a layer > click the Options  button > click the Drill 
Symbols  button

• Click the File > CAM  menu item > select a drill drawing from the Document Name list > Click Edit 
> click the Options  button > click the Drill Symbols  button

Use the Drill Symbols dialog box to include or exclude the use of certain drill symbols for a selected 
document.

Note:
To change any settings in the dialog box, click Global Drill Symbols.
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Objects

Field Description

Global Drill 
Symbols

Opens the “Global Drill Symbols dialog box”  on page 1387, enabling you to edit 
drill drawing legend and marker parameters that are read-only in this dialog box.

Drill Chart area

Letter Height Displays the global height setting of letters in the drill drawing in design units.

Chart Line 
Width

Displays the width of the chart lines in design units.

Drill symbol markers area

Height (letter) Displays the letter height of the drill symbol marker.

Line Width Displays the line width for the drill marker symbol and for all text.

Height (symbol) Displays the line width for the drill marker symbol.

Unique 
Through/Partial 
drill symbols

When selected (in the Global Drill Symbols dialog box), the Through/Partial 
column displays in the drill data table of this dialog box. This column enables 
you to differentiate between partial and through-hole drills.

Drill Data area

Drill size units Displays the units to use for the drill size.

Default 
tolerance

Displays the tolerance that appears by default in the Tolerance column of the 
table.

Table Contents — Displays the drill data of symbols that are defined in the Global Drill Symbols 
dialog box and assigned to items in the drill drawing through the Select Items Dialog Box. For 
example, if no pads or vias are added from the electrical layers, the chart does not display drill 
information pertaining to those locations.

“Use” check 
box

Select the check box for each symbol that you want to enable for the selected 
drill drawing.
You can edit the symbols by clicking Global Drill Symbols  to open the “Global 
Drill Symbols dialog box.”  on page 1387.

Symbol and 
Size columns

Displays the symbols that are assigned in the order that the drill sizes are read 
into the table; for a manually created entry, the next available symbol is used. 
Symbol usage is exclusive to a drill size. The symbol assignment order for the 
64 supported symbols is as follows:

• Six of the 12 available graphical symbols are used first: +, X, Rectangle, 

Diamond, Hour Glass, and Bow Tie (      )

• Letter symbols +A through +Z are assigned (  - )
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Field Description

• Six more graphical symbols are assigned: Rectangle +, Rectangle X, 

Diamond +, Diamond X, Circle +, and Circle X (      )

• Rectangle +A through Rectangle +Z are assigned (  - )

Quantity 
column

Displays the count of each drill size in the design. It may contain a zero value for 
drill sizes loaded from the cam.defaults  file, or for alternate drill sizes contained 
in the design database, but not currently used in the design.

Plated column The Plated column displays whether the plating type for each drill size is plated 
(Yes) or non-plated (No). Duplicate drill sizes can appear in the table if each has 
a unique plating type.

Through/Partial 
column

Indicates whether the drill is for a partial or through-type hole.

 Tip
• This column displays only if the Unique Through/Partial column check box in 

the “Drill symbol markers” area is selected.

• When this column displays, if both through and partial drills of a given drill 
size exist, they are counted separately and appear in separate rows. When 
this column does not display, through and partial drills of a given size are 
totaled together and appear in a single row.

Tolerance Displays the tolerance of the drill size.

Related Topics
Global Drill Symbols Dialog Box
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Drill Pairs Setup Dialog Box
To access: Setup  > Drill Pairs

Use the Drill Pairs Setup dialog box to define which layers to drill and plate together during 
manufacturing. Define these layers first to prevent defining or installing partial vias that cross layers that 
do not drill together.

Objects

Field Description

# Shows the number of the layer in the drill pair.

Starting Layer Sets the starting layer of the drill pair.

# Shows the number of the layer in the drill pair.

Ending Layer Sets the ending layer of the drill pair.

Add Adds a row to the table.

Delete Removes the selected row.

Edit Makes the selected cell available for editing.

Related Topics
Defining Drill Pairs
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DXF Export Dialog Box
To access: File  > Export  menu item > select DXF Files > Save

Use the DXF Export dialog box to export DXF formatted files.

Description
PADS DXF export attempts to preserve as much of the PADS information as possible. The translator 
maintains all your defined colors except the background color.

Objects are exported as follows:

• Dimension objects — are exported to layers DIMENSIONx_nn (where x is the object number, and 
nn is the layer of origin in the PCB design).

• General PCB information — is exported as text to layer PCB_PARAMS

• Layer information — is exported as text to layer DBLAYERS (display colors, type of layer, 
thickness, etc.)
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The .dxf  file format is revision 12.

Objects

Field Description

DXF File Name The name of the DXF file you are importing.

Export Type

Standard Select this option to create an intelligent output that creates blocks, nested 
blocks, and an extensive layer setup.
For example, the objects that make up a decal are made into a complete block. 
When you select a part of the decal, the whole decal is selected.

Flat Select this option to create an output that creates a flat result with no blocks, 
and a basic layer setup.
For example, the objects that make up a decal are not arranged in a block and 
each object can be moved independently.

 Restriction:
When you select the flat output option, the Setup DXF Drill Size and 
Symbols Dialog Box  is unavailable.

Layer Selection area — Select layers to export layer definition information and to permit the export of items on 
those Selected layers of your SailWind Layout design. Items exported from the layer have the SailWind Layout 
layer number appended to its AutoCAD layer name.
For example, if you exported text from the top PCB layer, in AutoCAD it would be placed on layer TEXT_01. 
(Layer 0 or All Layers in SailWind Layout is layer 00 in AutoCAD. In the PCB Decal Editor, the Opposite Layer 
maps to -1 in AutoCAD and the Inner Layers setting maps to -2 in AutoCAD.)

Available Lists the layers available for export.

Selected Lists the layers selected for export.

Add > Moves the selected layer from the Available list to the Selected list.

Add All >> Moves all of the layers from the Available list to the Selected list.

< Remove Moves the selected layer from the Selected list to the Available list.

<< Remove All Moves all of the layers from the Selected list to the Available list.

Select Input Items Area — Use these check boxes to select the design items you want to export to the layers in 
the Selected list. These selections are global and apply to all the layers in the selected list.

Board Select to export the board outline and cutouts. Standard export outputs a 
polyline outline of real width to layer BOARD_OUTLINE_00. Creates a Block 
called BOARD_1 from the outline shapes of the board and any existing cut outs.

2-D Lines Select to export 2D lines. Standard export outputs polylines of real width to 
layers 2D_LINE_nn (where nn is the layer of origin in the PCB design).

Copper Select to export copper objects. Standard export outputs polylines of real width 
to layers COPPER_nn (where nn is the layer of origin in the PCB design).
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Field Description

 Tip
Copper cut outs are exported as polylines of real width to layers 
COPPER_CUTOUT_nn (where nn is the layer of origin in the PCB design).

Select this check box to export copper planes.
This exports either hatch outlines or pour outlines depending on the Display 
mode setting in the “Hatch and Flood options”  on page 1511.

• If the Display mode is set to Pour outline, selecting this under Standard 
export outputs copper pour objects as polylines of real width to layers 
POUR_HEADER_nn (where nn is the layer of origin in the PCB design).

• If the Display mode is set to Hatch outline, selecting this under Standard 
export outputs hatch outline objects as polylines of real width to layers 
POUR_OUTLINE_nn (where nn is the layer of origin in the PCB design).

Export includes the following:
• Global “Hatch and Flood options”  on page 1511: Minimum Hatch Area, 

Smoothing Radius, View, and Display Mode.

• Individual custom Flood  on page 1381 settings if they exist as Copper Plane 
attributes: Hatch Grid, Smoothing Radius, Hatch Direction, and Flood over 
Vias.

 Tip
Flood data brought in from PADS can be seen by performing a Hatch using 
a solid fill.

Copper Plane

Copper Plane Cut Outs
Either Pour outline cut outs or Hatch outline cut outs are exported depending on 
the Display mode setting in the “Hatch and Flood options”  on page 1511.

• If the Display mode is set to Pour outline, under Standard export, 
Pour outline cut outs are exported as polylines of real width to layers 
POUR_VOID_nn (where nn is the layer of origin in the PCB design).

• If the Display mode is set to Hatch outline, under Standard export, 
Hatch outline cut outs are exported as polylines of real width to layers 
POUR_VOID_nn (where nn is the layer of origin in the PCB design).

Text Select to export text objects. Standard export outputs text to layers TEXT_nn 
(where nn is the layer of origin in the PCB design). Right-reading text strings are 
supported.
See also: “Working With Labels”.

Parts-Top Select to export parts mounted on the top layer of the PCB. Standard export 
outputs blocks with the name PART_TOP_x (where x is a consecutive number 
for each additional part) to layer PART_TOP.
The translator exports height information if the part has either of the following 
properties:

• Geometry.Height general attribute

• Text string on layer 30 of form $height or $height1 height2 (where height and 
height1 indicate the component height and height2 indicates the component 
mounting offset)
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DXF Export Dialog Box

Field Description

For details of how keepouts are constructed in AutoCAD, see the Keepouts 
section below.

• Component names  — are exported, under Standard export, as text on layer 
PART_NAME_TOP.

• Decal names  — are exported, under Standard export, to the SYM_NAME 
layer.

• Drill symbols  — are exported, under Standard export, to the 
DRIL_SYMBOL layer.

• Jumper silkscreen  — is exported, under Standard export, as a polyline on 
layer JUMPER_BOX.

• Outlines/Text  — is exported, under Standard export, as sub blocks on layers 
BODY_nn (where nn is the layer of origin in the PCB design).

• Pad Stacks  — are exported, under Standard export, as polyline outlines 
of real width on layers PADS_TOP, PADS_INNER, PADS_INNER_ANTI, 
PADS_BOT, DRIL_PLTE_THRU_nn, DRIL_NPLTE_THRU_nn, 
DRIL_PLTE_PRTL_nn, DRIL_NPLTE_PRTL_nn.

• Part 2D lines — are exported, under Standard export, to layers 
PART_TOP_2DLINE_nn (where nn is the layer of origin in the PCB design).

• Part types  — are exported, under Standard export, as blocks on layer 
PART_INFO

• Part type names  — are exported, under Standard export, as text on layer 
PART_TYPE_TOP

• Thermal reliefs  — are exported, under Standard export, as polyline 
segments of real width on layers POUR_PADTHERM_nn

Select to export parts mounted on the bottom layer of the PCB. Standard export 
outputs blocks with the name PART_BOTTOM_x to layers PART_BOTTOM.
The translator exports height information if the part has either of the following 
properties:

• Geometry.Height general attribute

• Text string on layer 30 of form $height or $height1 height2 (where height and 
height1 indicate the component height and height2 indicates the component 
mounting offset)

For details of how keepouts are constructed in AutoCAD, see the Keepouts 
section below.

Parts-Bottom

• Component names  — are exported, under Standard export, as text on layer 
PART_NAME_BOT

• Decal names  — are exported, under Standard export, to the SYM_NAME 
layer

• Drill symbols  — are exported, under Standard export, to the 
DRIL_SYMBOL layer

• Jumper silkscreen  — is exported, under Standard export, as a polyline on 
level JUMPER_BOX

• Outlines/Text  — is exported, under Standard export, as sub blocks on layers 
BODY_nn (where nn is the layer of origin in the PCB design).
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Field Description

• Pad Stacks  — are exported, under Standard export, as polyline outlines 
of real width on layers PADS_TOP, PADS_INNER, PADS_INNER_ANTI, 
PADS_BOT, DRIL_PLTE_THRU_nn, DRIL_NPLTE_THRU_nn, 
DRIL_PLTE_PRTL_nn, DRIL_NPLTE_PRTL_nn.

• Part 2D lines — are exported, under Standard export, to layers 
PART_BOT_2DLINE_nn (where nn is the layer of origin in the PCB design).

• Part types  — are exported, under Standard export, as blocks on layer 
PART_INFO

• Part type names  — are exported, under Standard export, as text on layer 
PART_TYPE_nn (where nn is the layer of origin in the PCB design).

• Thermal reliefs  — are exported, under Standard export, as polyline 
segments of real width on layers POUR_PADTHERM_nn (where nn is the 
layer of origin in the PCB design).

Select to export Traces and Vias. Standard export outputs traces as polylines 
of real width(s) to layers TRACE_nn (where nn is the layer of origin in the PCB 
design), and vias as blocks to layer VIA.

Routes

• Connections  — are exported, under Standard export, as lines on layer 
LINK_nn (where nn is the layer of origin in the PCB design).

• Drill symbols  — are exported, under Standard export, to the 
DRIL_SYMBOL layer

• Signals  — are exported, under Standard export, as linetype with name and 
information

• Teardrops  — are exported, under Standard export, as blocks to layers 
TEAR_nn (where nn is the layer of origin in the PCB design).

• Thermal reliefs  — are exported, under Standard export, as polyline 
segments of real width on layers POUR_VIATHERM_nn (where nn is the 
layer of origin in the PCB design).

Keepout Select to export board keepouts. (Decal keepout are exported with Parts.) 
Standard export outputs keepouts as closed polylines to layer KEEPOUT_nn 
(where nn is the layer of origin in the PCB design). Each keepout is also made 
into a Block with the name KEEPOUT_x (where the x is a consecutive number 
for each additional keepout).
Keepouts are also given a Linetype of KEEPOUT_ABCDEFGHx to store its 
Restriction settings (where A=Placement, B=Component height, C=Component 
drill (this can only be used if you assign the keepout to All Layers), D=Trace 
and copper, E=Copper pour and plane area, F=Via and jumper, G=Test 
point, H=Accordions, and x=the value for the component height when used in 
conjunction with A & B. The value is set in database units. For example 1 mil 
=3810000 database units.
Values for ABCDEFGH are either 0 or 1. A value of 0 means a cleared check 
box and a 1 means a selected check box.
The translator uses the “"Reverse for Keepout" Hatch Direction”  on page 1511.
The translator uses the Keepout hatch grid setting  on page 1537.

Attributes Select to export the attribute dictionary, individual attributes and value 
assignments, attribute labels, and attribute status (read only, system, ECO 
Registered, or hidden). The attribute hierarchy is not exported.
Attribute names are exported, under Standard export, to the LABEL_INFO layer.
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Field Description

Attribute values are exported, under Standard export, to the 
LABEL_ATTRIBUTE layer.

 Tip
• DXF supports the increase in reference designator length to 15 characters.

• Import is different - Reference designators, part types, attribute labels, and 
attribute status (read only, system, ECO Registered, or hidden). Jumper 
names are treated as reference designator labels.

See also: “Working With Labels”, Setting Up Jumpers”.

All Items Toggles all the check boxes of Input Items on or off.

DXF-File Unit The unit that will be used in the DXF file.

Setup Opens the Setup DXF Drill Size and Symbols Dialog Box.

Related Topics
Exporting DXF Files

DXF Format
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DXF Import Dialog Box
To access: Drafting Toolbar  button > Import DXF File  button > Open a .dxf  file

You can import specialized shapes of DXF format into your decal or into the design using the AutoCAD 
2004 DXF format.

Tip
There are two interfaces to import DXF files. This interface is optimized for importing RF shapes 
and only converts into 2D Lines and Copper objects. It allows you to map DXF layers to SailWind 
Layout layers. If you require more advanced import of any and all design objects, use the other 
DXF Import Dialog Box. It imports the design objects from specially named block and layers 
names in AutoCAD. But its mapping is hard-coded and cannot be changed.

Restriction:
DXF import only supports the following geometries: POINT, LINE, ARC, CIRCLE, ELLIPS, 
TRACE, SOLID, 3DFACE, POLYLINE, LWPOLYLINE (AutoCAD R14), and BLOCKS with 
hierarchy.
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DXF Import Dialog Box

Objects

Field Description

DXF File Name The name of the .dxf  file you opened.

DXF-File Unit The units used in this .dxf  file: Mils, Metric, Inches.

DXF Layer Lists the DXF layers available in this .dxf  file.

Add Specifies whether to import this layer.

PCB Layer Specifies the PCB Layer to which you want to import the DXF 
items.

 Restriction:
A PCB layer set to <All Layers> cannot be imported as copper. 
You cannot have copper items on <All Layers> in a PCB decal.

Type Specifies the type of item on the layer: 2D line or copper.

Related Topics
Importing RF Shapes in DXF Format

DXF Format
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DXF Import Dialog Box
To access: File  > Import  menu item > set file type to DXF Files (*.dxf) > select a DXF file > Open

Use the DXF Import dialog box to import files of the AutoCAD 2004 DXF format into the design.

Restriction:
Assigning unique colors in AutoCAD may result in translation back to PADS as black if the color is 
not one of the PADS colors.

Tip
There are two interfaces to import DXF files. This interface is designed for advanced import of any 
and all design objects. It imports the design objects from specially named block and layers names 
in AutoCAD. This mapping is hard-coded and cannot be changed. This allows a whole design, 
exported from SailWind Layout, to be re-imported from AutoCAD. If you need to simply import RF 
shapes into the decal or into the design, use the other DXF Import Dialog Box. It allows you to 
map the DXF layers to SailWind Layout layers.
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Objects

Field Description

DXF File Name The name of the DXF file you are importing.

Layer Selection area  — Select layers to accept imported items. Items exported to the layer have the 
SailWind Layout layer number appended to its AutoCAD layer name.
For example, if you import text to the top PCB layer, in AutoCAD it is placed on layer TEXT_01. (Layer 
0 or All Layers in SailWind Layout is layer 00 in AutoCAD. In the PCB Decal Editor, the Opposite Layer 
maps to -1 in AutoCAD and the Inner Layers setting maps to -2 in AutoCAD.)

Available Lists the layers available for import.

Selected Lists the layers selected for import.

Add > Moves the selected layer from the Available list to the Selected list.

Add All >> Moves all of the layers from the Available list to the Selected list.

< Remove Moves the selected layer from the Selected list to the Available list.

<< Remove All Moves all of the layers from the Selected list to the Available list.

Select Input Items Area — Use these check boxes to select the design items you want to import to the 
layers in the Selected list. These selections are global and apply to all the layers in the selected list.

Board Select to import the board outline and cutouts. Imports a polyline outline 
of real width from layer BOARD_OUTLINE_00. The outline shapes of the 
board and any existing cut outs must be in a Block called BOARD_1.
See also: “Importing a Board Outline and Cut Out from AutoCAD”.

2-D Lines Select to import 2D lines. Imports polylines of real width from layers 
2D_LINE_nn (where nn is the layer of origin in the PCB design).

Copper Select to import copper objects. Imports polylines of real width from layers 
COPPER_nn (where nn is the layer of origin in the PCB design).

 Tip
Copper cut outs are imported as polylines of real width from layers 
COPPER_CUTOUT_nn (where nn is the layer of origin in the PCB 
design).

Copper Plane Select this check box to import copper planes.
• Imports pour outline objects from polylines of real width on layers 

POUR_HEADER_nn (where nn is the layer of origin in the PCB design).

• Imports hatch outline objects from polylines of real width on layers 
POUR_OUTLINE_nn (where nn is the layer of origin in the PCB 
design).

Import includes the following:
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Field Description

• “Copper Planes / Hatch and Flood options”  on page 1511: Minimum 
Hatch Area, Smoothing Radius, View, and Display Mode.

• Individual custom Flood  on page 1381 settings if they exist as Copper 
Pour attributes: Hatch Grid, Smoothing Radius, Hatch Direction, and 
Flood over Vias.

Copper Plane Cut Outs
Either Pour outline cut outs or Hatch outline cut outs are imported.

• Plane outline cut outs are imported from polylines of real width on layers 
POUR_VOID_nn (where nn is the layer of origin in the PCB design).

• Hatch outline cut outs are imported from polylines of real width on 
layers POUR_VOID_nn (where nn is the layer of origin in the PCB 
design).

Text Select to import text objects. Imports text from layers TEXT_nn (where 
nn is the layer of origin in the PCB design). Right-reading text strings are 
supported.
See also: “Working With Labels”.

Select to import parts mounted on the top layer of the PCB. Imports blocks 
with the name PART_TOP_x (where x is a consecutive number for each 
additional part) to layer PART_TOP.
For details of how keepouts are constructed in AutoCAD, see the Keepouts 
section below.

Parts-Top

• Component names  — are imported from text on layer 
PART_NAME_TOP.

• Decal names  — are imported from the SYM_NAME layer.

• Drill symbols  — are imported from the DRIL_SYMBOL layer.

• Jumper silkscreen  — is imported from a polyline on layer 
JUMPER_BOX.

• Outlines/Text  — is imported from sub blocks on layers BODY_nn 
(where nn is the layer of origin in the PCB design).

• Pad Stacks  — are imported from polyline outlines of real width 
on layers PADS_TOP, PADS_INNER, PADS_INNER_ANTI, 
PADS_BOT, DRIL_PLTE_THRU_nn, DRIL_NPLTE_THRU_nn, 
DRIL_PLTE_PRTL_nn, DRIL_NPLTE_PRTL_nn.

• Part 2D lines — are imported from layers PART_TOP_2DLINE_nn 
(where nn is the layer of origin in the PCB design).

• Part types  — are imported from blocks on layer PART_INFO

• Part type names  — are imported from text on layer PART_TYPE_TOP

• Thermal reliefs  — are imported from polyline segments of real width on 
layers POUR_PADTHERM_nn

Parts-Bottom Select to import parts mounted on the bottom layer of the PCB. Imports 
blocks with the name PART_BOTTOM_x from layers PART_BOTTOM.
For details of how keepouts are constructed in AutoCAD, see the Keepouts 
section below.
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Field Description

• Component names  — are imported from text on layer 
PART_NAME_BOT

• Decal names  — are imported from the SYM_NAME layer

• Drill symbols  — are imported from the DRIL_SYMBOL layer

• Jumper silkscreen  — is imported from a polyline on level 
JUMPER_BOX

• Outlines/Text  — is imported from sub blocks on layers BODY_nn 
(where nn is the layer of origin in the PCB design).

• Pad Stacks  — are imported from polyline outlines of real width 
on layers PADS_TOP, PADS_INNER, PADS_INNER_ANTI, 
PADS_BOT, DRIL_PLTE_THRU_nn, DRIL_NPLTE_THRU_nn, 
DRIL_PLTE_PRTL_nn, DRIL_NPLTE_PRTL_nn.

• Part 2D lines — are imported from layers PART_BOT_2DLINE_nn 
(where nn is the layer of origin in the PCB design).

• Part types  — are imported from blocks on layer PART_INFO

• Part type names — are imported from text on layer PART_TYPE_nn 
(where nn is the layer of origin in the PCB design)

• Thermal reliefs  — are imported from polyline segments of real width 
on layers POUR_PADTHERM_nn (where nn is the layer of origin in the 
PCB design)

Select to import Traces and Vias. Imports traces from polylines of real 
width(s) on layers TRACE_nn (where nn is the layer of origin in the PCB 
design), and vias as blocks to layer VIA.

Routes

• Connections  — are imported from lines on layer LINK_nn (where nn is 
the layer of origin in the PCB design).

• Drill symbols  — are imported from the DRIL_SYMBOL layer

• Signals  — are imported from linetypes with name and information

• Teardrops  — are imported from blocks to layers TEAR_nn (where nn is 
the layer of origin in the PCB design).

• Thermal reliefs  — are imported from polyline segments of real width 
on layers POUR_VIATHERM_nn (where nn is the layer of origin in the 
PCB design).

Keepout Select to import board keepouts. (Decal keepout are imported with Parts.) 
Imports keepouts from closed polylines on layer KEEPOUT_nn (where nn 
is the layer of origin in the PCB design). Each keepout must also be made 
into a Block with the name KEEPOUT_x (where the x is a consecutive 
number for each additional keepout).
Keepouts are also given a Linetype of KEEPOUT_ABCDEFGHx to store 
its Restriction settings (where A=Placement, B=Component height, 
C=Component drill (this can only be used if you assign the keepout to All 
Layers), D=Trace and copper, E=Copper pour and plane area, F=Via and 
jumper, G=Test point, H=Accordions, and x=the value for the component 
height when used in conjunction with A & B. The value is set in database 
units. For example 1 mil =3810000 database units.
Values for ABCDEFGH are either 0 or 1. A value of 0 means a cleared 
check box and a 1 means a selected check box.
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Field Description

The translator uses the Keepout hatch grid setting  on page 1537.

Attributes Select to import reference designators, part types, attribute labels, and 
attribute status (read only, system, ECO Registered, or hidden). Jumper 
names are treated as reference designator labels.
Attribute names are imported from the LABEL_INFO layer.
Attribute values are imported from the LABEL_ATTRIBUTE layer.

 Tip
• All attributes are imported with ECO registration off. If the attribute 

already exists in the attribute dictionary, it is not changed.

• DXF supports the increase in reference designator length to 15 
characters.

• Export is different - Attribute dictionary, individual attributes and value 
assignments, attribute labels, and attribute status (read only, system, 
ECO Registered, or hidden). The attribute hierarchy is not exported.

See also: “Working With Labels”, Setting Up Jumpers”.

All Items Toggles all the check boxes of Input Items on or off.

DXF-File Unit The unit that will be used in the DXF file. When it is not necessary to set 
the Unit, this list is unavailable.

Mode  area

New Specifies to import a DXF file that was exported from SailWind Layout. 
Reads SailWind Layout layer and via information in the file.

Add Specifies to import a native AutoCAD DXF file. Reads 2D line, text, 
keepout, and copper items in the file. You can also use this option to ignore 
layer and via information in a DXF file exported from SailWind Layout.

Related Topics
Importing DXF Files

DXF Format
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Chapter 49
GUI Reference Elements E Through G

Read the sections that follow to learn about dialog box elements in SailWind Layout.

ECO Options Dialog Box
EDC Parameters Dialog Box
Edit CAM Document Dialog Box
Edit Button Image Dialog Box
Edit Die Size Dialog Box
Electrical Net Rules Dialog Box
Electrical Nets Dialog Box
Electrodynamic Check Dialog Box
Enable/Disable Layers Dialog Box
Error Detected Dialog Box
Export Dialog Box
Extension Properties Dialog Box
Fabrication Checking Setup Dialog Box
Fanout Rules Dialog Box
Find Dialog Box
Flood and Hatch Options Dialog Box
Font Replacement Dialog Box
From SPECCTRA Dialog Box
Global Drill Symbols Dialog Box
Generate Drafting Shape Dialog Box
Get Drafting Item from Library Dialog Box
Get Part Type from Library Dialog Box
Get PCB Decal From Library Dialog Box
Grid/Width Dialog Box
Group Rules Dialog Box
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ECO Options Dialog Box
To access:

• Tools  > ECO Options  menu item

• ECO Toolbar  button (when you select it the first time in a session)

• ECO Toolbar  button > ECO Options  button

Use the ECO Options dialog box to specify whether and how an ECO file is written when you make 
engineering (netlist) changes to a design using the ECO Toolbar.

Objects
Table  186. ECO Options Dialog Box Fields

Field Description

Write ECO File Select to record all ECO operations to a file. You can use this file to 
back-annotate your schematic.
See also: “Table 187”.

Append To File Select to append ECO operations to the end of an existing .eco  file 
named in the Filename box.
Clear to overwrite an existing .eco  file named in the Filename box.
If the named file does not exist, a new file is created.
See also: “Table 187”.
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Table  186. ECO Options Dialog Box Fields  (continued)

Field Description

ECO Filename Type a pathname or click the Browse button to select an existing file.

Write ECO File After Closing 
ECO Toolbar

Select to update the .eco  file when you close the ECO Toolbar to leave 
ECO mode. This allows you to review the file immediately, but clears 
the undo buffer, so undo capabilities are lost.
Clear to continue to have undo capabilities after you close the ECO 
toolbar - until you save the design, when the .eco  file is written and the 
undo buffer is cleared.
See also: “Table 187”.

Expand Part Attributes Records attributes from higher levels in the design hierarchy, such as 
from the Part Type. It also moves the attributes to the highest level 
readable by a schematic capture program.

Expand Net Attributes Records attributes from higher levels in the design hierarchy, such 
as from the board in the .eco  file. It also moves the attributes to the 
highest level readable by a schematic capture program.

Output Only ECO Registered 
Parts

Select to specify that objects must be ECO-registered to be included in 
the ECO file.
See also: “ECO-Registered Parts”

Output Decal Changes Select to record decal changes to the ECO file. If this option is selected 
and if SailWind Layout is not in ECO mode:

• When you try to right-click and click the Edit Decal  popup menu 
item, you get the error message “You can modify decals only in 
ECO mode or if ECO option Output Decal Change is off.” You must 
simply open the ECO Toolbar to edit the decal.

• When you try to change the Pad stack of a decal through the Pin 
Properties  on page 1632, you get the prompt message “You can 
modify decal pad stacks only in ECO mode. Continue?” You can 
edit the pad stack without needing to open the ECO Toolbar.

• When you try to change the decal of a component to an alternate 
decal using the Component Properties dialog box,  on page 1191
you get the prompt message “You can modify decals only in ECO 
mode or if ECO option Output Decal Changes is off.” You must 
simply open the ECO Toolbar to edit the decal.

Table  187. ECO Options - Check Box Combinations

Check Box Combination Result

Creates a new .eco  file according to the pathname in the 
Filename box. Overwrites any existing .eco  file with the same 
name at that location with the start of a new software session. 
During the software session, retains appended additional ECO 
changes in memory, until the changes are saved to the .eco 
file whenever you:

• Close the ECO Toolbar and you Save the .pcb  file.

• Exit the software or open a new design.
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Table  187. ECO Options - Check Box Combinations  (continued)

Check Box Combination Result

Creates a new .eco  file according to the pathname in the 
Filename box, or if it already exists, appends to the .eco  file 
listed in the Filename box. Appends additional ECO changes 
to the .eco  file, even when you start a new software session.
Writes changes to the .eco  file whenever you:

• Close the ECO Toolbar and you Save the .pcb  file.

• Exit the software or open a new design.

Creates a new .eco  file according to the pathname in the 
Filename box. Overwrites any existing .eco  file with the same 
name at that location with the start of a new software session. 
During the software session, retains appended additional ECO 
changes in memory, until the changes are saved to the .eco 
file whenever you:

• Close the ECO Toolbar.

• Exit the software or open a new design.

Creates a new .eco  file according to the pathname in the 
Filename box, or if it already exists, appends to the .eco  file 
listed in the Filename box. Appends additional ECO changes 
to the .eco  file, even when you start a new software session.
Writes changes to the .eco  file whenever you:

• close the ECO Toolbar.

• exit the software or open a new design.

Related Topics
Comparing Designs

Recording ECO Changes
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EDC Parameters Dialog Box
To access: Tools  > Verify Design  menu item > High Speed check > Setup  button > Parameters  button

Use the EDC Parameters dialog box to define global rules like layer thickness and copper thickness. You 
can also specify how detailed a design verification report you want.

Objects

Field Description

Layer Definitions table • Name  — The name of the layer.

• Type  — The type of layer: Prepeg or Substrate.

• Thickness  — Specifies the required coating. Exception: If no 
coating is required, set thickness to zero.

• Dielectric  — Specifies the dielectric constant value.

Board Thickness Displays the total value of material and layer thicknesses in the current 
design units.

Edit button Allows you to edit a selected table cell.
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Field Description

Layers button Opens the Layers Setup Dialog Box.

Copper Thickness Units Specifies the copper thickness unit you want to use:
• Weight (oz)  — Weight of copper in ounces, per square foot.

• Design Units  — Same unit of measure as the current database unit 
of measure

Parallelism Check Against Specifies the extent of checking.
• Nets/Pin Pairs  — Checks the parallelism and tandem rules against 

the entire net or pin pair.

• Segments  — Checks the parallelism and tandem rules against only 
individual segments.

Parallelism Report Detail Specifies the extent of reporting.
• Net Names Only  — Displays only net names and violations.

• Aggressors/Victims  — Displays specific aggressor and victim 
nets.

• Segments  — Displays segment coordinates and layers in addition 
to aggressor and victim nets.

Daisy Chain Report Detail Specifies the extent of reporting.
• Net Names Only  — Include the number of T points and whether the 

net is daisy chained.

• Stubs  — Include the group of pins within each stub, the total stub 
length for each group, the number of T points, and whether or not 
the net is daisy chained.

• Pin Pairs  — Include the pin to pin length of all pin pairs, the total 
pin pair length added together to form stubs, the number of T points, 
and whether the net is daisy chained.

• Segments  — Include the coordinates and layer of all track corners, 
the pin to pin length of all pin pairs, the total pin pair length added 
together to form stubs, the number of T points, and the nets being 
daisy chained.

Other Checks Check Against Specifies the extent of checking of Length and Delay rules.
• Nets/Pin Pairs  — Check the Length and Delay rules against the 

entire net or pin pair.

• Segments  — Check the Length and Delay rules against individual 
segments.

Other Checks Report Detail Specifies the extent of reporting for capacitance, impedance, delay, 
and length.
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Field Description

• Nets  — Include the starting and ending pins of nets and net values 
for capacitance, impedance, delay, and length.

• Pin Pairs  — Include pin-to-pin points, pin pair values, and net 
values for capacitance, impedance, delay, and length.

• Segments  — Include individual segment coordinates and segment 
values for capacitance, impedance, delay, and length.

Include Copper Specifies to include copper polygons with signal names in the 
capacitance calculations.

Use FieldSolver for 
Calculations

Specify to calculate electric parameters of transmission lines such as: 
impedance, delay (per unit length), and capacitance (per unit length).
See also: “PADS HyperLynx SI/PI Guide”.

Report Segment Coordinates Specifies to include segment coordinates in reports where “Segments” 
has been selected in the Report Detail in any one of the Parallelism, 
Daisy Chain, or Other Checks sections.

Report Violations Only Specifies to list only items that contain violations in the high-speed 
report.

Remove Segments Under 
Pads

Specifies to exclude trace segments under pads from calculations. 
When routing, traces are routed into the middle of pads. This final 
segment is excluded.

Related Topics
Setup of EDC Parameters

Edit CAM Document Dialog Box
This dialog box is documented in a combined topic (Add/Edit Document dialog box).

See: Add/Edit Document Dialog Box
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Edit Button Image Dialog Box
To access: Tools  > Customize  menu item > Commands  tab > New  button > Select User-Defined Image 
> New  or Edit

Use the Edit Button Image dialog box to create or edit button icons.

Objects

Field Description

Colors area Select a color to use with the tools

Tools area Select a tool to draw/edit the picture or icon of the button
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Edit Die Size Dialog Box
To access: BGA Toolbar  button > Wire Bond Editor  button > click the BGA > right-click > Edit Die Size 
popup menu item

Use the Edit Die Size dialog box to change the size of a die.

Note:
This information applies only to the BGA toolkit.

Objects

Field Description

Length Specifies the new length of the die.

Width Specifies the new width of the die.

Height Specifies the physical height of the die, for programs that use this 
value.

Related Topics
Editing the Die Size
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Electrical Net Rules Dialog Box
To access:

• Setup  > Design Rules  menu item > Electrical Nets  button

• Select an electrical net > right-click > Show Rules  popup menu item

Use the Electrical Net Rules dialog box to select a list of electrical nets. You can also assign HiSpeed 
rules or clear all rules defined for them.

Description

Objects

Field Description

Electrical Nets list Lists the electrical nets in the design.

 Tip
(H) identifies electrical nets having existing rules.

HiSpeed button Opens the HiSpeed Rules Dialog Box, where you 
can define min/max length rules and create matched 
length groups for the selected electrical nets.

Show electrical nets with rules Lists only the electrical nets that have rules.

Default button Removes all rules from the selected electrical nets.
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Electrical Nets Dialog Box
To access: Setup  > Electrical Nets  menu item

Set options for electrical nets and create electrical nets based on component reference designators. The 
options set limits on the number of nets allowed in an electrical net, and on the number of pins allowed in 
a single net included in an electrical net.

Objects

Field Description

Maximum net count per electrical 
net

Specify the maximum number of nets to allow in an electrical net 
to prevent creating electrical nets with an unreasonable number of 
nets.
This limit applies to all methods of creating electrical nets.

Maximum non-plane-net pin count Specify the maximum pin count for nets included in electrical nets 
to prevent potential plane nets from being included in an electrical 
net. The electrical net can be split, truncated, or not created at all, 
depending on the location of the faulty net. (Plane nets are not 
allowed in electrical nets.) Virtual pins are not included in a net’s 
pin count.
This limit applies to all methods of creating electrical nets.
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Field Description

Discrete component prefixes Specify the refdes prefixes of the associating components to 
create new electrical nets. Examples:
R specifies all R<num> components, where <num> is a non-empty 
number.
#R specifies all <num1>R<num2> components; <num1> can be 
empty.
#_R specifies all <num1>_R<num2> components, where 
<num1>and <num2> are non-empty numbers.
Discrete Type column — the categories are only for convenience; 
prefixes for any type of component can be entered in any field.
If a selected component has more than two pins, the following 
conditions must apply, or the component cannot be an associating 
component, that is, the electrical net cannot go through the 
component:

• All pins must connect to a gate.

• Each gate must have exactly two pins.

Delete refdes prefixes of existing associating components to 
remove them from electrical nets.

Related Topics
Conditions Governing Electrical Net Creation
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Electrodynamic Check Dialog Box
To access: To access: Tools  > Verify Design  menu item > High Speed check > Setup  button

Use the Electrodynamic Check dialog box to enable high-speed checks for individual nets and classes or 
for the whole design.

Restriction:
You must have specified your plane layers in the Layers Setup Dialog Box  before you run an 
electrodynamic check. For a two-layer board, temporarily identify one of the layers as a plane 
layer.

Objects

Field Description

Task List Lists the specific checks of certain nets or classes you want to check. 
You can enable different checks for each items in the Task list.

 Tip
(N) is added to Task list items that are nets and (C) is added to 
items that are classes.

Add Nets button Opens the Add Net Tasks dialog box  on page 1057.

Add Classes button Opens the Add Class Tasks dialog box  on page 1057.

Delete button Removes the task from the Task List.

SailWind Layout Guide and Reference 1363



GUI Reference Elements E Through G
Electrodynamic Check Dialog Box  

Field Description

Check Capacitance A function of line length. Capacitance values change when the routed 
length of a track changes. Use the HiSpeed Rules Dialog Box  to 
specify minimum and maximum capacitance values.

Check Impedance Calculated based on track width and copper thickness. Modifying the 
track width or changing the copper thickness changes the Impedance 
values. Use the HiSpeed Rules Dialog Box  to specify minimum and 
maximum impedance values.

Check Parallelism You can search for tracks on the same layer that may run parallel 
closely enough or long enough to cause cross talk problems. Use the 
HiSpeed Rules Dialog Box  to define the maximum permissible parallel 
lengths, the minimum gap, and if a net is an aggressor or a victim.

Check Tandem You can search for tracks on different layers that run parallel closely 
enough or long enough to cause crosstalk problems. Use the HiSpeed 
Rules  on page 1402 or Conditional Rule Setup  on page 1199 dialog 
box to define the maximum permissible tandem lengths, the minimum 
gap, and if a net is an aggressor or a victim.

Check Length You can determine mismatched signal lengths. Use the HiSpeed Rules 
Dialog Box  to specify minimum and maximum lengths.

Check Delay Calculated based on track length. The delay value changes when the 
track length changes. Use the HiSpeed Rules Dialog Box  to specify 
minimum and maximum delay values.

Check Stubs Stub length is important to proper line termination. Use the HiSpeed 
Rules Dialog Box  to specify a maximum stub length.

Check Loops A daisy-chained net has no loops or T-junctions.

Parameters button Opens the EDC Parameters Dialog Box.

Rules  button Opens the Rules Dialog Box.

Open  button Opens the File Open dialog box where you can retrieve settings from 
an .edp  file.

Save  button Stores your settings to an .edp  file in the \SailWind Projects  folder 
using the same name as your design.

Save As  button Opens the File Save As dialog box where you can store your settings 
to an .edp  file using the location you want and the file name you want.

Related Topics
Setup of High Speed (Electrodynamic) Checking
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Enable/Disable Layers Dialog Box
To access: Setup  > Layer Definition  menu item >Enable/Disable  button

Use the Enable/Disable Layers dialog box to specify which nonelectrical layers to enable or disable. This 
shows or hides layers in layer lists, such as the Layer list on the Standard Toolbar, or the Layers Setup 
and Display Colors dialog boxes.

Tip
Switching to increased layer mode does not affect the enabled or disabled status of a layer.

Objects

Field Description

Enabled Indicates whether the specified layer is enabled.

Has data Indicates whether the specified layer contains data.

Name Indicates the name of the specified layer.

Type Indicates the type of the specified layer.
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Related Topics
Hiding or Displaying Non-electrical Layers in Layer Lists

Hiding Layers
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Error Detected Dialog Box
To access: This dialog box is inaccessible unless the software crashes and crash detection is enabled in 
the software .ini  file.

The Crash Detected dialog box opens at a crash and allows you to save a report of the SailWind 
environment as well as pertinent files into a compressed Dump File. You can then submit this file to 
SailWind Software Customer Support. You can attach feedback to this report, and optionally, the BMW 
media and project files.

Objects

Field Description

Comments box You can describe what you were doing when the error occurred 
or anything else you can think of that might help when 
investigating the crash.

Attach BMW data check box You can include BMW data and your project files. This will allow 
customer support to play back what you were doing in your 
design that led up to the crash. This check box is unavailable if 
the BMW feature is not enabled.
See also: “BMW and BLT”.

Save button You must click the Save button if you want to create a report file. 
When you click the Save button, you are prompted with a Save 
As dialog box. The file that is created is called a PADS Dump 
File and is compressed in the .zip  format. This is the file that 
you must send to customer support. It will include the report, the 
BMW data and the project files.
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Export Dialog Box
To access: SailWind 3D window  > 3D General Toolbar  > Export button

Specify the content and file format to export from the 3D view.

Objects

Object Description

Type The following file types to output: STEP (*.step), 3D PDF (*.pdf), 
BMP (*.bmp), GIF (*.gif), JPG (*.jpg), PNG (*.png), SAT (*.sat), STEP 
(*.step), TIF (*.tif).
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Export Dialog Box

Object Description

 Note:
The Options fields are available for SAT and STEP file types only.

Save in The location to save the file. If there’s an attempt to output files to a 
directory where some files of the same name already exist, those files 
and all others with the same root name will be deleted in order not to 
have files with potentially stale data.

Name The filename to save. Separate files are created for the board and 
components, each copper layer, the Silkscreen and Soldermask. 
All the files have the same root name as entered in the Name field 
but with different suffixes appended, for example, _Silkscreen, 
_Soldermask, _CopperTop.

Mechanical Model Options Choose whether to include all mechanical models that were imported 
into the 3D view, or to export only models for which the “Include with 
board export” check box is selected (in the model’s Properties dialog 
box).
These options are only available for SAT and STEP file types.

Metal Element Options These items can be included with or omitted from the general items 
that are exported. Only available for SAT and STEP file types.

• Component Pads — Controls the output of component pads only. If 
the Holes check box is checked, the holes in those pads will also be 
generated in the board STEP file.

• Metal: Top & Bottom — All the other copper data on the outer board 
layers.

• Metal: Internal — Data on any internal copper layers will be 
exported. This option needs to be selected if you want the pads 
on internal layers. Copper on internal layers is generally only 
consumed by tools like Simcenter Flotherm XT where they want to 
do a thermal analysis.

• Via Holes — Outputs the via holes in the board STEP file with the 
option to include the blind via holes too. Holes take a lot of time to 
process. If there are many blind via holes you can save a lot of time 
by not exporting them. If you export Soldermask it will cover up the 
via holes unless you have a Soldermask pad on the Soldermask 
layer which is not usually the case for vias.

• Export as sheets — If selected, exports copper data as an infinitely 
thin sheet without any thickness. Depending upon the use-case, 
this may be fine for the target system. If cleared, the copper 
data is output with the same thickness as seen in the 3D view. 
The advantage of using this option is that you can typically see 
a reduction in file size and a reduction in load time in the target 
system. If you simply want this data for visualization purposes then 
consider using this option

• All Nets/Selected Nets — Of the object types selected to export 
(pads, planes, traces), select all nets to export all those objects or 
limit the objects by choosing nets in the Select Nets Dialog Box.

Fabrication Element Options For STEP file types only. Select the check box of the fabrication 
element type (Silkscreen or Soldermask) that you want to export.
Export as sheets — If selected, exports the silkscreen or soldermask 
data as an infinitely thin sheet without any thickness. Depending upon 
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Object Description
the use-case, this may be fine for the target system. If cleared, the 
silkscreen or soldermask data is output with the same thickness as 
seen in the 3D view. The advantage of using this option is that you can 
typically see a reduction in file size and a reduction in load time in the 
target system. If you simply want this data for visualization purposes 
then consider using this option

Related Topics
Exporting the 3D Image to a 3D PDF File

Exporting the 3D Image as a Mechanical Model

Exporting the 3D Image to a Graphics File Type
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Extension Properties Dialog Box
To access: Select an extension > right-click > Properties  popup menu item

The Extension Properties dialog box displays coordinate information for the selected extension line and 
provides several areas for modifications.

Description
The Extension Properties dialog box remains open until you click OK  or Cancel. Selecting another 
extension line while the dialog box is open updates the information for the selected object.

Objects

Field Description

X and Y Lists the X and Y coordinate locations of the selected object.

Layer list Lists the current working layer. Select a new layer from the list.

Line Width Lists the current line width used for the dimension object. Type a new 
value to change the line width.

Pick Gap Lists the current gap between the selection point and the end of the 
extension line. Type a new value to change the gap.

Arrow Offset Lists the current length that the extension line extends beyond the 
arrow. Type a new value to change the length.

Parent button Opens the Dimension Properties Dialog Box  for the dimension object 
with which the selected object is associated.

Related Topics
Dimensioning Process
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Fabrication Checking Setup Dialog Box
To access: Tools  > Verify Design  menu item > Fabrication check > Setup  button

Use the Fabrication Checking Setup dialog box to enable fabrication checks, or to load DFF errors from a 
preexisting CAM350 database and annotate into the design.

Restriction:
You need the CAM350 Link license option to use this.

Objects

Field Description

Run Fabrication Checks Runs the fabrication checks in SailWind Layout.
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Fabrication Checking Setup Dialog Box

Field Description

Acid Traps Flags small areas where acid will pool up. The check is run on all 
visible electrical layers as defined in the CAM documents.

• Maximum Size  — Specifies the maximum value of the acid traps 
to detect. The areas of the “pools” that are flagged will be less than 
this value.

• Maximum Angle  — Specifies the maximum angle for traces, pads, 
or any other data that exists on the layer. Any items that form an 
angle smaller than this will be flagged as an acid trap.

Slivers Flags copper sliver and solder mask sliver areas. This compares the 
top solder mask layer against the top electrical layer and the bottom 
solder mask layer against the bottom electrical layer as defined in the 
CAM documents.

• Minimum Copper  — Specifies the minimum value for copper 
slivers. This flags slivers with less area than this value.

• Minimum Mask  — Specifies the minimum value for solder mask 
slivers. This flags the slivers with a width less than this value, 
checking the top and bottom solder mask layers if they are visible.

Starved Thermals Flags invalid thermals where adjacent data overlaps the thermal 
spokes.

 Restriction:
Starved Thermals are only checked on (negative) CAM planes.

• Minimum Clearance  — Specifies the percentage of the thermal's 
spoke that can be unblocked by another object. Any less of an 
opening will be considered “starved.”

• Minimum Spokes  — Specifies the minimum allowable number of 
the thermal's spokes that cannot be blocked by another object. Any 
less will be considered “starved.”

Trace Width/Pad Size Flags traces and pads that are too small. Checks all electrical layers as 
defined in the CAM documents.

• Minimum Trace  — Specifies the minimum trace width value. This 
flags traces with a width less than this value. This check runs on all 
visible electrical layers.

• Minimum Pad  — Specifies the minimum pad size. This flags pads 
with a diameter of less than this value. This check runs on all visible 
electrical layers.

Silkscreen Over Pads Flags silkscreen over pads on top and bottom layers as defined in the 
CAM documents.

• Minimum Gap  — Specifies the minimum allowable distance 
between silkscreen features and a region exposed by solder mask.

Annular Ring Flags minimum annular rings on top and bottom layers, comparing 
electrical, drill, and mask layers.

Pad to Mask Flags minimum clearance distances between a pad and its solder mask 
opening. The offset and annular ring is checked against the specified 
clearance value. This compares the top electrical layer against the 
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Field Description
top solder mask layer or the bottom electrical layer against the bottom 
solder mask layer.

• Layers list  — Specifies the layer to use for checking.

 Restriction:
You must select the Annular Ring check box to enable this 
fabrication check.

Drill to Mask Flags minimum clearance distances between a drill and its solder mask 
opening. The offset and annular ring is checked against the specified 
clearance value. This compares the top drill layer against the top solder 
mask layer or the bottom drill layer against the bottom solder mask 
layer.

• Layers list  — Specifies the layer to use for checking.

 Restriction:
You must select the Annular Ring check box to enable this 
fabrication check.

Drill to Pad Flags minimum clearance distances between a drill and its associated 
pad. Checks the drill to pad value against the <pad size - drill size> 
values in your design. The offset and annular ring is checked against 
the specified clearance value. This check can be run on each electrical 
layer.

• Layers list  — Specifies the layer to use for checking.

 Tip
You must select the Annular Ring check box to enable this 
fabrication check.

Solder Bridges Flags solder mask bridging. Solder can bridge and cause a connection 
to an adjacent object within the same mask opening. If the adjacent 
object is farther from the pad than this distance, even if it is exposed 
by the mask layer, it will not be identified as a bridge. This compares 
the top solder mask layer against the top electrical layer or the bottom 
solder mask layer against the bottom electrical layer as defined in the 
CAM documents.

• Minimum Gap  — Specifies the minimum clearance value.

• Layers list  — Specifies the layer to use for checking.

Annotate DFF Errors Loads DFF errors from a CAM350 file. Select this if you use CAM350 
for checking your fabrication errors.

CAM350 File Name Specifies the .cam  path and file name of a file to back-annotate DFF 
errors into SailWind Layout for design verification.
Click Browse  to navigate to the location.

Related Topics
Fabrication Checking
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Fanout Rules Dialog Box
To access:

• Setup  > Design Rules  menu item > Default  button > Fanout  button

Use the Fanout Rules dialog box to specify fanout rules. Use fanouts to make routing easier and to 
ensure that connections are made. SailWind Router optimally places fanout vias and routes from vias to 
corresponding pins for ordered components or separate pins. Fanouts are most useful for some complex 
SMDs, like BGAs.

Tip
While you can define these rules in either SailWind Layout or SailWind Router, the rules are used 
only in SailWind Router.

Restriction:
In SailWind Layout, you can define fanout rules for only SOIC/QUAD type components. Use 
SailWind Router to also define fanout rules for BGA and staggered BGA fanout patterns.
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Objects

Area Description

Alignment Specify the via placement:
• Aligned  — Aligns fanout vias on the SailWind Router fanout grid.

• Alternate  — Staggers the direction of fanout vias. For example, the first pin 
fans out to the left and the second pin fans out to the right, and the pattern 
repeats.

• Multi-row  check box — Specifies to create two rows of vias on each side of 
the component that has pins.

Direction Specify where you want to locate the fanout vias, relative to the component 
outline:

• Inside  — All fanout vias are located inside the component outline.

• Outside  — All fanout vias are located outside of the component outline.

• Both Sides  — Fanout vias are located both inside and outside of the 
component outline.

Via Spacing Specify the fanout via spacing you want:
• Use Grid  — Place fanout vias on the fanout grid.

• 1 Trace  — Width of one trace. This sets a via grid that enables SailWind 
Router to route one wire between adjacent vias.

• 2 Trace  — Width of two traces. This sets a via grid that enables SailWind 
Router to route two wires between adjacent vias.

Pin Sharing Specify all the connections on the same net that SailWind Router can use while 
routing from the pin to the escape via:

• Through pins  — Connect to a through pin if the cost is lower than the cost to 
use a via.

• SMD pins  — Connect to an SMD  on page 1860 pin if the cost is lower than 
the cost to use a via. If this is disabled, SailWind Router routes each SMD pad 
directly to a pin or via.

• Vias  — Connect to a shared via. If this is disabled, SailWind Router creates 
unique vias for each surface-mount pad.

• Trace  — Connect to a shared trace, which creates a T-Junction  on 
page 1864.

Nets Specify the types of nets where fanouts can be created:
• Plane  — Create fanouts for pins belonging to plane nets  on page 1849.

• Signal  — Create fanouts for pins belonging to signal nets.

• Unused pins  — Create fanouts for pins that do not belong to signal nets or 
plane nets.

Fanout length Specify whether or not to restrict fanout lengths:
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Area Description

• Unlimited  — Specifies that you do not want to restrict fanout lengths.

• Maximum  — Specifies the restriction to the fanout length if you clear the 
Unlimited check box.

Preview Shows the fanout layout based on your selections.

Delete button Removes non-default fanout rules at the current level of the rules hierarchy.

 Restriction:
You cannot delete the Default fanout rules.

Tip
Fanning out an entire design is not generally recommended because it creates many vias. 
However on component-dense PCBs requiring many layers, it may be necessary to fan out all 
SMD components.

Related Topics
Design Rule Hierarchy
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Find Dialog Box
To access: Edit  > Find  menu item

Use Find to locate and select single or multiple objects by reference designator, part type, line width, or 
other attributes.

Description
Find works two ways, depending on your selection mode  on page 115:

• Select mode — Find ignores the Selection Filter  on page 114 settings and selects whatever you 
ask it to.

• Verb mode — Find only looks for items that are logical for verb mode.

Objects

Field Description

Find by object type list Specifies how you want to search. You can find by:
• Reference designator

• Nets

• Line width

• Part type

• Pin pair

• Via type
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Field Description

• Decals

• Net class

• Groups

• Reuse type (physical design reuse)

• Clusters

• Unions

• Hatch outline

• Isolated hatch outline

• Pad size

• Thermal attributes (custom pad stack thermals)

• Jumper via

• Keepouts

• Attribute

• Label fonts

• Text fonts

• Nets with bridges

• Test point types

Action Specifies the action to perform on items you find.
• Select

• Highlight

• Unhighlight

• Rotate 90

• Flip Side

• Move Sequential

Exception:  You cannot use Rotate 90, Flip Side, or Move 
Sequential on test points.

 Tip
When you select objects with the Find dialog box, the shortcut 
menus change to the relevant commands for modifying the 
items.

Value Narrows the search by the value you type. You can use wildcards 
or expressions  on page 155.

Add to Selection Select the check box to increase the selection of objects in the 
design by any items you select with the Find dialog. Objects are 
not deselected when you select another object.
This feature is essential if you want to select a variety of object 
types using the Find dialog.
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Field Description

 Tip
When you select objects with the Find dialog box, the shortcut 
menus change to the commands relevant for modifying the 
items.

Selected Items Preview area Displays the selected items in the Selections color  on page 1318.

Find lists The content and title of these lists change depending on what 
you select from the Find By list. For example, if you are finding by 
reference designator, the first list displays reference designator 
prefixes. When you select a reference designator prefix to 
search by, for example D, the second list displays all reference 
designators with the D prefix. If you select only the D prefix, all 
components with the D prefix will selected. You can further limit 
the search by choosing a specific D reference designator prefix to 
search by, such as D2.

Abort Specifies that you want to cancel the find process if it is taking a 
long time.

Filter Opens the Selection Filter  on page 114. Unless you are in a

Related Topics
Object Finding

Use of the Find Dialog Box During Placement
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Flood and Hatch Options Dialog Box

Flood and Hatch Options Dialog Box
To access: Select edge of pour or plane area > right-click > Select Shape  popup menu item > right-click > 
Properties  popup menu item > Options  button

Use the Flood and Hatch Options dialog box to establish unique display settings for copper planes.

Objects

Field Description

Options area Default check box  — Specifies to use the default settings as found 
on the Grids  on page 1537 and “Hatch and Flood”  on page 1511
subcategories of the Options dialog box. Clear this check box to access 
the hatch settings.
Hatch grid  — Specifies the distance between hatch lines.
Smoothing radius  — Controls the radius of copper plane corners.
<corner radius> = <shape outline width> * <smoothing radius>
The smoothing radius parameter can be set between 0 and 5.
Hatch direction  — Specifies the hatch line orientation.

Flood over vias Specifies to flood over any vias within the copper plane that are part of 
the same net.

 Tip
• When this setting is changed and applied to the selected object, the 

changed setting becomes the default for all newly-created copper 
planes. Existing objects (except the selected one) are not affected.

• When you flood over vias, a Thermal Relief Error report, therm.err, 
is generated and automatically appears in the default text editor. 
The report lists the vias that use different flood over settings than 
those established in the Thermals  tab.
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Field Description

Ignore board clearance Specifies to ignore the board-to-copper clearance setting and have the 
copper plane flood outside the board area.

Flood priority Specifies to add a flood priority to the selected object. An object with a 
lower priority number will be flooded before an object with a higher one. 
Copper planes on different layers are processed independently.
See also: “Setting Flooding Order of Overlapping Copper Planes”  on 
page 788 and “Copper Plane Flood Priorities”  on page 783.
Requirements:

• Type a value from 0 to 250.

• If you create an embedded plane, the smaller inner plane must have 
a lower flood priority than the larger outer plane or the smaller plane 
area will be flooded over by the outer plane.

See also: “Embedded Copper Planes”  on page 685.

Related Topics
Creating a Copper Plane Manually

Flood Over Vias in a Copper Plane
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Font Replacement Dialog Box

Font Replacement Dialog Box
To access: When you open a design created with fonts that are not installed on your system, the Font 
Replacement dialog box opens automatically.

Use the Font Replacement dialog box to manage how missing fonts are replaced in your design.

Tip
If the design uses fonts or character sets that are not installed on your system, empty boxes will 
appear where you expect to find text or symbols. Once the font replacement process completes, 
the symbols display properly.

Objects

Field Description

Mode Specifies the mode to replace this font.
• Automatic  — Specifies to replace the font automatically with 

the one selected by SailWind Layout.

• Manual  — Specifies to replace the font with one you select 
from the Replace with font list.

• Skip  — Specifies to preserve the original font.

Missing font The name of the font in this design that is missing from your 
system.
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Field Description

Replace with font If you chose Manual, lists the fonts available for you to replace the 
missing font.
If you chose Automatic, lists the font SailWind Layout chose to 
replace the missing font.

• Tips:

◦ You can select some fonts for automatic replacement, select others for manual 
replacement, and choose that other font replacements be skipped entirely.

◦ You can have a combination of stroke font and system fonts within the same design.

◦ You must set up fonts for each text string and/or label you create in your design. Once 
you set up fonts for a text string or label, you can then use the Properties dialog to 
apply a font and font characteristics to all objects that you select for modification with 
the Properties dialog box.

• Restrictions:

◦ If the design uses fonts or character sets that are not installed on your system, a 
font substitution process begins automatically when the file is loaded. During this 
process, you are asked to choose fonts to substitute for those that are missing from 
your system.

◦ System font text is supported in RS274X Gerber format when Fill mode is on. System 
font text is output to Gerber format as a set of filled polygons.

◦ System fonts are not supported in the RS-274D CAM output format. If you attempt to 
use this format with system fonts, the program displays a warning message. If you 
proceed, system fonts will not be output. Instead, you should use the 274X format with 
system fonts.

◦ Type 1 fonts are not supported.

Related Topics
Replacing Missing Fonts

Finding Fonts
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From SPECCTRA Dialog Box
To access: Use Windows Explorer to navigate to your C:\<install_folder>\SailWind<version>\Programs 
directory, and double-click pads2sp.exe  and then click the From SPECCTRA  button

Use the From SPECCTRA dialog box to translate design data modified by SPECCTRA back into a .pcb 
design file.

Objects

Field Description

SPECCTRA Routes Specifies the routing information file that is returned by SPECCTRA 
after processing. Include the command to write this file after 
autorouting at the end of the .do  file.
Click Browse  to locate the file.

Session File Specifies the placement and routing information file. You do not need 
to supply this file name if you did not use any of the SPECCTRA 
placement capabilities.
Click Browse  to locate the file.

Original PCB File Specifies the original (source) .pcb  file.
Click Browse  to locate the file.

New PCB File Specifies the file to be created from the SPECCTRA file.
Click Browse  to locate the file.

Options button Opens the Options dialog box  on page 1727.
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Related Topics
Translating Design Data from SPECCTRA to SailWind Layout
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Global Drill Symbols Dialog Box
To access:

• Click the File > CAM  menu item > Drill Symbols  button

• Click the File > CAM  menu item > click the Add  button > select “Drill Drawing” from the 
Document Type list > select a layer > click the Options  button > click the Drill Symbols  button > 
click the Global Drill Symbols  button

Use the Global Drill Drawing Options dialog box to set drill drawing legend and marker parameters, such 
as which symbol to use for a drill size and how tall to make text displayed on the drill drawing.

Note:
Use the Global Drill Symbols dialog box to set up global symbol options. You can set which 
symbols to include in a particular drill drawing through the “Drill Symbols dialog box”  on 
page 1334.
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Objects

Field Description

Drill Chart area

Letter Height Specifies the height of letters in design units.

Chart Line Width Specifies the width of the chart lines in design units.

Drill Symbol Markers area
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Global Drill Symbols Dialog Box

Field Description

Drill Symbol Markers • Height(letter)  — Specifies the letter height of the drill symbol 
marker.

• Line Width  — Specifies the line width for the drill marker symbol 
and for all text.

• Height(Symbol)  — Specifies the drill marker symbol height.

• Unique Through/Partial drill symbols  — Enables or disables the 
display of the Through/Partial column in the table.

Drill Data area

Drill size units Specifies the units to use for the drill size.

Default tolerance Specifies the tolerance to use in the Tolerance column of the table.

Chart Contents  — the chart only displays the drill data of items that are added to the drill drawing in 
the Select Items Dialog Box. For example, if no pads or vias are added from the electrical layers, the 
chart does not display drill information for those locations.

Symbol and Size columns Symbols are assigned in the order that the drill sizes are read into the 
table; for a manually created entry, the next available symbol is used. 
Symbol usage is exclusive to a drill size. The symbol assignment order 
for the 64 supported symbols is as follows:

• Six of the 12 available graphical symbols are used first: +, X, 

Rectangle, Diamond, Hour Glass, and Bow Tie (    

 )

• Letter symbols +A through +Z are assigned (  - )

• Six more graphical symbols are assigned: Rectangle +, Rectangle 

X, Diamond +, Diamond X, Circle +, and Circle X (    

 )

• Rectangle +A through Rectangle +Z are assigned (  - )

Quantity column The Quantity column displays the count of each drill size in the design. 
 It may contain a zero value for drill sizes loaded from the cam.defaults 
file, or for alternate drill sizes contained in the design database but 
not currently used in the design. See the Save As Defaults button 
description in this table for more information.

Plated column The Plated column displays whether the plating type for each drill size 
is plated (Yes) or non-plated (No). Duplicate drill sizes can appear in 
the table if each has a unique plating type.

Through/Partial column Indicates whether the drill is for a partial or through-type hole.

 Tip
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Field Description

• This column displays only if you first select the Unique 
Through/Partial column check box in the “Drill symbol markers” 
area.

• When this column displays, if both through and partial drills of a 
given drill size exist, they are counted separately and appear in 
separate rows. When this column does not display, through and 
partial drills of a given size are totaled together and appear in a 
single row.

Tolerance Specifies the tolerance of the drill size.

Add Plated button Opens the Enter Drill Size dialog box so you can add a specific plated 
drill size to the drill table. The new entry is assigned the next-available 
drill symbol.

 Tip
To manually add a slotted hole to the drill table, use the format 
<width> X <slot_length> (for example, 0.020 X 1.000).

Add NonPltd button Opens the Enter Drill Size dialog box so you can add a specific 
non-plated drill size to the drill table. The new entry is assigned the 
next-available drill symbol.

 Tip
To manually add a slotted hole to the drill table, use the format 
<width> X <slot_length> (for example, 0.020 X 1.000).

Delete button Removes selected drill size entries from the table.
To select multiple entries for removal, press the Ctrl or Shift key and 
click to select them.

Augment button Automatically creates (appends) drill sizes for items in the current 
design file that are not already defined in the list.
Your list could be pre-populated by a set of drill sizes that may or may 
not be in use in the current design. See the Save As Defaults button 
description in this table for more information. Using Augment retains 
any unused hole/drill size listings.

 Tip
The drill table reflects entries for slotted holes if they exist in the 
design database after you click Augment.

• If you have sorted data before clicking Augment  or Regenerate, 
the appropriate data is formatted in the order currently specified by 
the open CAM document or the settings from the current editing 
session.

• If you have not sorted in the current session, but you have saved a 
set of sorting defaults, clicking Augment  or Regenerate  populates 
the table in accordance with your saved defaults.

Regenerate button Clears the drill table and replaces all existing data with the data from 
the design database.
Your list could be prepopulated by a set of drill sizes that may or may 
not be in use in the current design. See the Save As Defaults button 
description in this table for more information. Clicking Regenerate 
clears and creates a list of only the hole/drill sizes used in the design.
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Global Drill Symbols Dialog Box

Field Description

 Tip
The drill table reflects entries for slotted holes if they exist in the 
design database after you click Regenerate.

• If you have sorted data before clicking Augment  or Regenerate, 
the appropriate data is formatted in the order currently specified by 
the open CAM document or the settings from the current editing 
session.

• If you have not sorted in the current session, but you have saved a 
set of sorting defaults, clicking Augment  or Regenerate  populates 
the table in accordance with your saved defaults.

Save As Defaults button If you manually build your own drill table, or you want to reuse the 
contents of the table as the defaults for all CAM drill drawings you can 
save the contents as the default.
This creates a cam.defaults  file located in the following location (default 
installation):
C:\<install_folder>\<version>\Settings

 Restriction:
The drill chart location is not saved when you click Save As 
Defaults.

Related Topics
Drill Symbols Dialog Box

Creating CAM Outputs to Manufacture Your PCB
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Generate Drafting Shape Dialog Box
To access: Tools  > PCB Decal Editor  menu item > select terminal > right-click and click Generate 
Drafting Shape  popup menu item

You can use the outline of a terminal as the basis to create new drafting shapes.

Objects

Field Description

Type Lists the type of drafting shapes available to generate.

Layer Lists the layers available for placement of the shape.

Width Sets the line width of the new shape.

Oversize/Undersize value Sets the size of the new shape:
• To create a new drafting shape larger than the terminal outline 

by the typed value, type a positive number.

• To create a new drafting shape equal in size to the terminal, 
type 0 (zero).

• To create a new drafting shape smaller than the terminal outline 
by the typed value, type a negative number.

Create Completes this new shape and keeps the dialog box open for the 
creation of new shapes.

Complete Completes this new shape and closes the dialog box.

Related Topics
Generating Drafting Shapes from Terminals
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Get Drafting Item from Library Dialog Box

Get Drafting Item from Library Dialog Box
To access: Drafting Toolbar  button > From Library  button

Use the Get Drafting Item from Library dialog box to add a drafting item into your design from the library. 
You can also save a drafting item to a library.

Objects

Field Description

Preview area Shows the selected drafting item.

Drafting Items Lists the drafting items in the selected library. The number of objects 
that appear depends on the filter settings.

Library list Specifies the library you want to use.

Items Narrows the search. You can use wildcards or expressions  on 
page 155. An asterisk (*) displays all parts in the list.

Apply button Searches the library for the specified item.

Related Topics
Adding Drafting Items from a Library
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Get Part Type from Library Dialog Box
To access:

• ECO Toolbar  > Add Component  button

• ECO Toolbar  > Change Component  button

Use the Get Part Type from Library dialog box to Retrieve parts from a library when you add or update 
parts.

Description
The dialog box is slightly different depending on if you are adding or updating parts.

Figure 179. Add Component View
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Figure 180. Change Component View

Objects

Field Description

Preview area Shows the selected part type.

Part Types Part search results based on the Filter Settings appear in this list where 
you can select the part you want to use. The viewer to the left of this 
window displays the decal of each part as you select them.

Add button Adds the selected party type to the design.

 Restriction:
Available for the Add Part command only.

Replace button Replaces the part type selected in the design with the part type 
selected in the Part Types list.

 Restriction:
Available for the Change Part command only.

Update Part Type from 
Library

Updates the part type data for the selected parts based on the part 
types in the library.

 Restriction:
Available for the Change Part command only.

Library list Specifies the library you want to use.

Items Narrows the search. You can use wildcards or expressions  on 
page 155. An asterisk (*) displays all parts in the list.

Apply button Searches the library for the specified item.
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Related Topics
Adding a Component in ECO Mode

Changing a Component in ECO Mode
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Get PCB Decal From Library Dialog Box

Get PCB Decal From Library Dialog Box
To access: Tools  > PCB Decal Editor  menu item > Open  button

Use the Get PCB Decal from Library dialog box to open the decal you want to edit.

Objects

Field Description

Preview area Shows the item selected in the PCB Decals list.

PCB Decals list Lists the decals available to you in the selected library.

Library list Lists all libraries available to you.

Items Narrows down your PCB Decals list.
You can use wildcards in this box.

Apply Executes the filter arguments.

Related Topics
Editing a Library Decal
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Grid/Width Dialog Box
To access: In the PCB Decal Editor, Setup  > Grid and Width  menu item. The dialog box can also be left 
open when you exit the PCB Decal Editor in order to use it within the Design Editor. It can no longer be 
opened from the Status Bar.

Use the Grid/Width dialog box to quickly change grid and width settings.

Objects

Field Description

Design Grid Sets the spacing of the design grid, which controls the general 
placement of parts. The design grid uses positions relative to the 
origin. Type X and Y values for the grid in current design units.

Via Grid Sets the spacing of the via grid which controls the placement of vias. 
Type X and Y values for the grid in current design units.

 Restriction:
This section is unavailable in the PCB Decal Editor.

Width Sets the current drafting width.

Snap to Grid Snaps parts from grid point to grid point instead of freely and smoothly 
through the design space as you move or place the part. With this 
check box on, you cannot place a part off the current grid.

Radial Move Setup Opens the Radial Move Setup Dialog Box  where you can set up the 
polar grid.
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Group Rules Dialog Box

Group Rules Dialog Box
To access: Setup  > Design Rules  menu item > Group  button

Use the Group Rules dialog box to add and manage groups of pin pairs, and to define design rules that 
apply to them.

Objects

Field Description

Group name Specifies the name of the group.

Group list Lists all group names.

Add Adds the group name to the Group list.

Delete Removes the selected group from the Group list.

Rename Renames the group selected in the Group list with the text in the Group 
Name box.

Clearance Opens the Clearance Rules Dialog Box.

Routing Opens the Routing Rules Dialog Box.

HiSpeed Opens the HiSpeed Rules Dialog Box.
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Field Description

Report Opens the Rules Report Dialog Box.

Picture below rule button The picture below each type of rule button identifies which rules 
hierarchy level is used for that rule type. The meaning of the picture 
corresponds to the button in the Hierarchy area of the Rules Dialog 
Box. For example, if you select a class in the Class list and a green 
polygon appears below the Clearance button, then the default values 
apply to the class.

Show groups with rules Specifies to show only groups that have rules.

Default Removes non-default rules from the selected classes, so that only 
default rules apply.

From Net Lists all available nets.

Connections Available list Lists the connections available for this group.

 Tip
Connections cannot exist in more than one group. The Available list 
displays only connections that have not been assigned to a group.

Connections Selected list Lists the connections selected for this group.

Add >> Moves the connection from the Available list to the Selected list.

<< Remove Moves the connection from the Selected list to the Available list.

Related Topics
Creating Group Design Rules

Deleting a Design Rule Group

Adding Pin Pairs to an Existing Design Rule Group

Removing Pin Pairs from a Design Rule Group

Modifying Group Design Rules

Renaming a Design Rule Group

Resetting Group Rules to Default Rules

Displaying the Pin Pairs of a Design Rule Group
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Chapter 50
GUI Reference Elements H Through J

Read the sections that follow to learn more about dialog box elements in SailWind Layout.

HiSpeed Rules Dialog Box
HiSpeed Rules Dialog Box, Electrical Nets
HYP Export Dialog Box
IDF Export Dialog Box
IDF Import Dialog Box
Increase Maximum Layer Number Dialog Box
Intelligent Layout Dialog Box
Installed Options Dialog Box, License File Tab
IPC Export Dialog Box
JEDEC Array Pinning Dialog Box
Jumper Name Properties Dialog Box
Jumper Pin Properties Dialog Box
Jumper Properties Dialog Box
Jumpers Dialog Box
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HiSpeed Rules Dialog Box
To access: Setup  > Design Rules  menu item > choose a hierarchy level > High Speed  button

Use this dialog box to set up high-speed rules.

Note:
The Electrodynamic Checking (EDC) licensed option is required to check high-speed rules.

Objects

Area Description

Parallelism • Parallelism  — Specifies Length and Gap values for parallelism  on page 1845.

Parallelism rules specified in the Conditional Rule Setup Dialog Box  override rules 
specified in this dialog box.

• Tandem  — Specifies Length and Gap values for tandem  on page 1864.

Tandem rules specified in the Conditional Rule Setup Dialog Box  override rules 
specified in this dialog box.

• Aggressor  — Specifies that objects in this set act as aggressors  on page 1808.

Shielding • Shield  check box — Specifies to automatically route traces connected to a plane 
layer in order to shield selected nets from electromagnetic interference.

Exception:  Shielding rules do not apply when shielding with vias.
 Restriction:

• Options in the Shielding area are unavailable if the design has no plane layers.

• SailWind Layout does not automatically route shielding nets and it does not 
check shielding rules.

• Gap  — Specifies the clearance between the shielding and shielded nets.

• Use net  list — Lists all nets associated with the plane layer you want to 
implement the shielding traces with.
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HiSpeed Rules Dialog Box

Area Description

Rules  area

Length Specifies the minimum and maximum length allowed. Includes half the Discrete 
length value of each connected pin of components that have a Discrete length 
assigned.

Stub length Specifies the maximum distance from the T-Junction  on page 1864 to the end of the 
trace.

Delay (ns) Specifies the minimum and maximum delay allowed. The baseline delay calculations 
use the trace parameters, the board material values you set in the Layer Parameter 
Setup Dialog Box, and require at least one adjacent plane. A maximum of two 
adjacent planes are used in calculations. If the plane layer is a split/mixed plane 
layer, you must have a plane shape on the layer. The location and outline of the 
shape and cutouts of the plane area are all ignored in the calculation.
Delay values can be viewed in the Pin Pair Properties  on page 1627 and Net 
Properties  on page 1487 dialog boxes.

 Restriction:
• This rule is only verified when you run Tools > Verify Design  on page 1775 after 

you set up a High Speed check  on page 1363 to check Delay. It is not verified by 
online DRC  on page 1843.

Capacitance 
(pF)

Specifies the minimum and maximum capacitance allowed. The baseline 
capacitance calculations use the trace parameters, the board material values you set 
in the Layer Parameter Setup Dialog Box, and require at least one adjacent plane. 
A maximum of two adjacent planes are used in calculations. If the plane layer is a 
split/mixed plane layer, you must have a plane shape on the layer. The location and 
outline of the shape and cutouts of the plane area are all ignored in the calculation.
Capacitance values can be viewed in the Net Properties  on page 1487 dialog box.

 Restriction:
• Capacitance cannot be set for Pin Pairs.

• This rule is only verified when you run Tools > Verify Design  on page 1775 after 
you set up a High Speed check  on page 1363 to check Capacitance. It is not 
verified by online DRC  on page 1843.

Impedance 
(Ohm)

Specifies the minimum and maximum impedance allowed. The baseline impedance 
calculations use the trace parameters, the board material values you set in the Layer 
Parameter Setup Dialog Box, and require at least one adjacent plane. A maximum 
of two adjacent planes are used in calculations. If the plane layer is a split/mixed 
plane layer, you must have a plane shape on the layer. The location and outline of 
the shape and cutouts of the plane area are all ignored in the calculation.
Impedance values can be viewed in the Pin Pair Properties  on page 1627 and Net 
Properties  on page 1487 dialog boxes.

 Restriction:
This rule is only verified when you run Tools > Verify Design  on page 1775 after 
you set up a High Speed check  on page 1363 to check Impedance. It is not 
verified by online DRC  on page 1843.

Matching Some routers can automatically route traces with matched lengths. For example, 
traces for differential pairs have matched lengths in order to avoid signal timing skew 
between the signals.
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Area Description

• Match lengths check box  — Specifies to automatically route traces with 
matched lengths.

• Tolerance  — Specifies the maximum permissible difference between the shortest 
and longest lengths between traces in the matched-length group.

 Restriction:
SailWind Layout does not check length-matching rules.

Delete button Removes non-default hispeed rules at the current level of the rules hierarchy.

 Restriction:
You cannot delete the Default High Speed rules.

Tip
Parallelism and tandem rules specified in the Conditional Rule Setup Dialog Box  override rules 
specified in this dialog box.

Related Topics
Design Rule Hierarchy
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HiSpeed Rules Dialog Box, Electrical Nets

HiSpeed Rules Dialog Box, Electrical Nets
To access: Electrical Net Rules dialog box > HiSpeed  button

Assign min/max length rules and create matched length groups for electrical nets.

Tip
The Electrodynamic Checking (EDC) licensed option is required to check high-speed rules.

Objects

Field Description

Length Set the minimum and maximum length for the 
electrical nets you selected in the “Electrical Net 
Rules Dialog Box”  on page 1360. Includes half 
the Discrete length value of each connected pin of 
components that have a Discrete length assigned.

Match lengths Select this check box to make the electrical nets you 
selected in the “Electrical Net Rules Dialog Box”  on 
page 1360 members of a matched length group.
Clear the check box to remove the selected electrical 
nets from an existing matched length group.

Tolerance Set the tolerance value for length-matching.

Related Topics
Design Rule Hierarchy
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HYP Export Dialog Box
To access: Choose the File > Export  menu item and select “Hyp Files (*.hyp)” from the “Save as type” 
dropdown list; then click Save

Use the HYP Export dialog box to export the design in the form of a HYP file.

Description
For information about the format of the HYP file and creating a “BoardSim-friendly” design, see the PADS 
HyperLynx online Help. SailWind Layout passes the Value, Tolerance, Voltage, PADS HyperLynx, and 
PowerGround attributes to the HYP file. BoardSim uses these attributes to obtain values for resistors and 
capacitors, and to transfer information about fixed voltage nets.

Note:
Only PADS HyperLynx v8.0 or newer can open the file that is exported by this dialog box. The 
.hyp  file that is created is a v2.34 format file.

Objects

Field Description

Output area

Attributes for Nets and Net 
Classes

Exports attributes for nets and net classes.
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HYP Export Dialog Box

Field Description

Attributes for Power and Ground 
nets

Exports attributes for power and ground nets.

.REF IC Automapping file Creates a PADS HyperLynx .ref  file, which maps IC reference 
designators in the design to the BoardSim models that represent 
the ICs. BoardSim uses the mappings to automatically load IC 
models when you select a net for simulation.

 Restriction:
This check box is only available if a component has the 
HyperLynx.Model attribute with a value.

Unrouted Exports unrouted nets.

Copper Planes Exports copper plane information using the following options:
• Export hatch outlines for copper planes  — Exports hatch 

outlines for pours and plane areas.

Requirement: This setting creates extra constructs in the .hyp 
file and is required for power-integrity analysis.

• Export copper plane outlines  — Exports copper plane 
outlines only (no hatching).

Unroutes Options area

 Tip
Available only if Unrouted is selected in the Output area.

Assumed Layer Specifies the layer on which to implement the unrouted nets.

Percent Excess over Manhattan 
Length

Specifies the value to estimate the routing lengths.

 Tip
This value adds a percentage of the Manhattan length to the 
route length, to account for indirect routing paths. Net lengths 
are based on the Manhattan distance between pin pairs, which 
is Delta X plus Delta Y.

Related Topics
Exporting to PADS HyperLynx BoardSim
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IDF Export Dialog Box
To access: File  > Export  menu item > Select IDF File > Save

Use the IDF Export dialog box to exchange design data between SailWind Layout and a mechanical 
design system. You can export IDF files to export board outlines, keepouts, components, and holes to a 
mechanical design system.

Tip
Set any IDF-specific part height  on page 303 information, drilled hole  on page 302 information, or 
part outline  on page 302 information for a more accurate IDF export.

Objects

Field Description

IDF File Names The names of the files you are exporting. The .emn  (board and 
placement) and .emp  (part library) files are created.

Shape Layer Specifies the layer containing the outline information  on page 302
for the decals in your design that you want to send to the 
mechanical design system.

Format Specifies the IDF version to use.
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IDF Export Dialog Box

Field Description

Pro/ENGINEER Wildfire support Select this check box to convert characters to underscores (_) 
when they are illegal characters to Pro/ENGINEER Wildfire.
Clear this check box to allow all characters to export in the IDF 
files.

Select Export Items area Use these check boxes to select the items you want to export to 
the layer in the Shape Layer list.
Click All Items to select everything in this area.

• Board Outline  — Board outline, cutouts, and holes.

• Board Drills  — Drilled holes associated with mounting holes, 
including drill diameter and plated status.

• Parts-Top  — Components mounted on the top of the board, 
including their locations.

• Parts-Bottom  — Components mounted on the bottom of the 
board, including their locations.

• Part Drills  — Drilled holes associated with a part pin, including 
drill diameter and plated status. This option is unavailable for 
IDF 2.0 or if the Parts-Top and Parts-Bottom check boxes are 
cleared.

• Via Drills  — Drilled holes associated with a via, including drill 
diameter and plated status. This option is unavailable for IDF 
2.0 and during import.

• Place Keepouts  — Placement keepouts, including keepouts 
with height restrictions, and their locations. IDF files can contain 
the following information:

• Board-level placement keepouts

• Top and bottom component height restrictions defined for the 
whole board in the Options dialog box > Drafting  category 
Text and Lines subcategory  on page 1553.

• Routing Keepouts  — Trace keepouts and their locations. Only 
trace keepouts on top, bottom, both, inner (IDF 3.0 only), and 
All layers are supported. Trace keepouts on a single inner layer 
are not supported.

 Restriction:
This option is unavailable for IDF 2.0.

• Via Keepouts  — Via keepouts and their locations. IDF supports 
only via keepouts that apply to all layers. Imported via keepouts 
are always set on all layers. This option is unavailable for IDF 
2.0.

Top/Bottom Specifies the minimum height of components you want to export.

 Tip
Components less than these heights are not exported. If a part 
is not exported because of a minimum height value, a message 
is written to the status log file.

Design Units Specifies the design units for this file.
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Related Topics
Exporting IDF Files

1410 SailWind Layout Guide and Reference



 
GUI Reference Elements H Through J
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IDF Import Dialog Box
To access: File  > Import  > Select IDF File > Open

Use the IDF Import dialog box to import board outlines, keepouts, components, and holes from a 
mechanical design system. SailWind Layout cannot import the information in the .emp  library file.

Objects

Field Description

IDF File Name The name of the file you are importing.

Select Import Items area Use these check boxes to select the items you want to import.
Click All Items to select everything in this area.

• Board Outline  — Board outline, cutouts, and holes.

• Board Drills  — Drilled holes associated with mounting holes, 
including drill diameter and plated status.

• Parts-Top  — Components mounted on the top of the board, 
including their locations.

• Parts-Bottom  — Components mounted on the bottom of the 
board, including their locations.

• Part Drills  — Drilled holes associated with a part pin, including 
drill diameter and plated status. This option is unavailable for 
IDF 2.0 or if the Parts-Top and Parts-Bottom check boxes are 
cleared.

• Via Drills  — Drilled holes associated with a via, including drill 
diameter and plated status. This option is unavailable for IDF 
2.0 and during import.

• Place Keepouts  — Placement keepouts, including keepouts 
with height restrictions, and their locations. IDF files can contain 
the following information:
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Field Description

• Board-level placement keepouts

• Top and bottom component height restrictions defined for the 
whole board.

Find this setting in the Options dialog box > Text and Lines 
subcategory  on page 1553

• Routing Keepouts  — Trace keepouts and their locations. Only 
trace keepouts on top, bottom, both, inner (IDF 3.0 only), and 
All layers are supported. Trace keepouts on a single inner layer 
are not supported.

This option is unavailable for IDF 2.0.

• Via Keepouts  — Via keepouts and their locations.IDF supports 
only via keepouts that apply to all layers. Imported via keepouts 
are always set on all layers. This option is unavailable for IDF 
2.0.

Related Topics
Importing IDF Files
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Increase Maximum Layer Number Dialog Box
To access: Setup  > Layer Definition  menu item > Max Layers  button

Use the Increase Maximum Layer Number dialog box to increase the number of available electrical and 
documentation layers from 30 to 250.

Objects

Field Description

Maximum number of layers 
will be increased to 250

The default layer setup contains a total of 30 layers. There are 20 
electrical and 10 non-electrical (documentation) layers.
You can increase this layer setup to 250 layers. The increase would 
allow up to 64 electrical layers and 186 non-electrical layers.

Warning: Layer numbers for 
all nonelectrical layers will be 
increased by 100

In the default layer setup, the documentation layers start at level 21 
- the Solder Mask Top layer. In the increased layer setup, this layer 
becomes layer 121.

Related Topics
Increasing the Maximum Number of Available Layers

Layer Modes
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Intelligent Layout Dialog Box
To access: AI  > Intelligent Layout  menu item

Objects

Field Description

Table area: Lists the intelligent identified component groups along with their layout state and rule set 
correspondingly.

 Note:
Rule set is not currently supported.

Rule setup  button Opens the Rule Setup Dialog Box.

Module Analysis  button Initiates the module analysis.

Module Layout  button Initiates the layout process.

Cluster Create  button Creates clusters from the component groups.

Cluster Layout  button Opens the Cluster Placement Dialog Box.
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Installed Options Dialog Box, License File Tab
To access: Help  > Installed Options  menu item > License File  tab

If you are using node-locked licensing, you can view the contents of a license file. If you are using floating 
licenses, you cannot view the actual license file, but you can view the status of the features associated 
with a server license.

Objects

Field Description

License File column Displays the location of the license file(s) found on your computer.

Source column Displays the source of the license.

View button Click to display the contents of the license file in the License 
Information box.

 Restriction:
Node-locked only.

Status button Click to display the status of this license in the License Information box.

 Restriction:
Floating License only.

License Information box Displays the contents (Node-locked) or the status (Floating) of the 
selected license.

Suite Configuration button Opens the SailWind Suite Configuration Dialog Box.
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Field Description

 Restriction:
Available only with floating/server-based licenses, a mix of different 
SailWind Suites, or a mix of unbundled licenses and suites.

Related Topics
Viewing a Node Locked License File

Viewing the Floating License Status
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IPC Export Dialog Box
To access: File  > Export  > Select IPC356 Files > Save

Use this dialog box to choose between IPC-D-356 netlist formats.

Objects

Field Description

IPC-D-356 Select this option to create a bare board test-information netlist in the basic 
356 format.

IPC-D-356A Select this option to create a bare board test-information netlist in the more 
advanced 356 revision A format.

Related Topics
The IPC-D-356 Netlist

Exporting an IPC-D-356 Netlist
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JEDEC Array Pinning Dialog Box
To access: Tools  > PCB Decal Editor  menu item > Tools  > Assign JEDEC Array Pinning

Use the JEDEC Array Pinning dialog box to assign an alphanumeric string to each pin in an array 
following the JEDEC standard.

Description
Pin rows are lettered from top to bottom starting with A. The letters I, O, Q, S, X, and Z are not used.

Pin columns are numbered starting with 1. For component type, column numbering is left to right and for 
substrate type, right to left. For arrays with more than 20 rows, row 21 is designated AA and subsequent 
rows are designated AB, AC, and so on.

Objects

Field Description

Specify Decal Type Specifies whether the decal is a component or substrate type.

Preview area Displays the alphanumeric assignment orientation for Component 
or Substrate decal type.

Related Topics
Assigning JEDEC Pinning
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Jumper Name Properties Dialog Box
To access:

• Select a jumper name > right-click > Properties

• Select a jumper > right-click > Properties  > Label  button

Use the Jumper Name Properties dialog box to modify the jumper name and its attributes.

Objects

Field Description

Attribute The attributes available to you. If you are creating labels for jumpers, 
Reference Designator is the only available attribute.
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Field Description

 Tip
Hidden attributes do not appear in the Attribute list unless the 
attribute was selected for the label before it was set as a hidden 
attribute.

Value for The value of the selected attribute.

 Tip
• Unavailable if you selected Reference Designator or Part Type 

from the Attribute list, if the attribute is read-only, or if you open the 
Properties dialog box for labels of different attribute types. However, 
if the labels you select belong to attributes of the same type, you 
can edit this box.

• If the attributes have different values, the box is blank. You can 
type a new value in the box to apply it to all of the selected attribute 
labels and their parent objects.

• Value is also unavailable if the attribute is ECO-registered and 
SailWind Layout is not in ECO mode.

Show Controls the visibility of the label.
• None  — Turns visibility off.

• Value  — Displays only the label value.

• Name and Value  — Displays the name and value.

• Full Name and Value  — When labeling a structured attribute  on 
page 1862, displays the full structured name and value.

 Tip
Labels are invisible regardless of this setting unless you use the 
Display Colors Setup Dialog Box  to change the color of labels to a 
color different from that of the background.

Font The fonts available to you.

 Tip
• Select stroke font or a system font.

• For system fonts, you can also click a font style button, or any 
combination of styles: B for bold, I for italic, or U for underlined.

Layer The layers available to you.

Relative to Places the label at the X and Y location relative to the component or 
the jumper. If you clear this check box, the label is placed at the X and 
Y location relative to the design origin.

X,Y Places the decal label in a specified location.

Rotation Specifies the rotation angle of the label.

Size Specifies the size of the font.
Size (pts): This is font size in points and appears for system fonts
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Field Description

Size (mils): This is font character height and appears for stroke fonts. 
The size refers to the height of the tallest characters.

Line Width Specifies the line width for stroke fonts only.

Mirrored Flips the label - text is considered readable from the bottom side of the 
board.

Horizontal, Vertical Sets the horizontal and vertical justification of the text to ensure proper 
positioning between objects when text, attribute values, size, or width 
change.

 Tip
• For vertical justification, click Left, Center, or Right. For horizontal 

justification, choose Up, Center, or Down.

• Optionally, set justification by selecting the text, then right-clicking 
and clicking Justify Horizontally, and then clicking Left, Center, or 
Right; and by right-clicking and clicking Justify Vertically, and then 
clicking Up, Center, or Down.

Right reading Controls whether labels are readable (from left to right, or from bottom 
to top if the label is rotated). Click the None, Orthogonal, or Angled 
button to indicate the direction of reading you want.

Jumper button Opens the Jumper Properties Dialog Box  where you can modify the 
jumper.

Related Topics
Modifying Jumper Name Properties

Modifying Jumper Pin Properties

Modifying Jumper Properties

Jumpers

Jumper Pin Properties Dialog Box

Jumper Properties Dialog Box
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Jumper Pin Properties Dialog Box
To access: Select a jumper pin > right-click > Properties  popup menu item

Use the Jumper Pin Properties dialog box to display the net to which the jumper pin belongs, the 
reference designator, pin number, connection to which the jumper pin is attached, and the coordinates of 
the selected jumper pin.

Objects

Field Description

Signal The designation of the net to which the jumper belongs.

Reference Name The reference designator of the jumper.

Pin Number The number of the pin in the jumper. Pin one is the first pin you entered 
in the jumper.

X/Y The X and Y location of the selected pin. Type in these fields to change 
the pin location.

Connections The connection to which the jumper is attached.

Plane Thermal Determines whether the pin or via is eligible to receive a thermal  on 
page 1866. The status of a thermal is set individually by pin and via, 
and the thermal indicators will appear on plane layers only. Click to 
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Field Description
clear this check box if you do not want the via or pin to connect to any 
plane.
Once a pin or via is eligible, it is not automatically assigned a thermal 
attribute.

Test Point Makes the via or pin a test point. This is a three-state check box  on 
page 1866.
See also: “Performing a Test Point Audit”.
You can make all selected vias or pins test points by turning Test Point 
on and choosing Apply. You can remove the test point from all selected 
vias or pins by turning Test Point off and choosing Apply. When you 
click Apply the pad stack is automatically checked to see if the via or 
pin can be a test point; for example, you cannot make buried vias test 
points because a probe cannot access a buried via.

 Tip
When the via or pin is flagged as a test point, and Show Test 
Points is checked in the Options dialog box > Routing  category 
>General subcategory  on page 1542, an arrow is drawn on it in the 

design:

Top Access Attempts to probe the test point from the top and bottom in DFT Audit. 
The default is bottom; so with Top Access off, DFT Audit automatically 
tries to probe the test point from the bottom.
See also: “Performing a Test Point Audit”.
When you click Apply, the pad stack is automatically checked to see if 
top access is valid; for example, you must assign Top Access to partial 
vias with only top access if you want to use the vias as test points.
You can only set the Top Access option if the via or pin is a test point 
(Test Point is on).

Pad Stack button Opens the jumper pin in the Jumper Parameters Properties Dialog Box 
on page 1427. You can change the pad stacks for individual pins in the 
jumpers.
See also: “Editing a Pad Stack in the PCB Decal Editor”.
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Field Description

Jumpers button Opens the Jumper Properties Dialog Box  where you can edit the 
settings for the entire jumper.

Attributes button Opens the Object Attributes Dialog Box  and displays attribute 
information for the selected objects. You can view and modify nail 
diameter and nail number pin attributes for component pins, vias, and 
jumper pins, including test point attributes.

Related Topics
Modifying Jumper Name Properties

Modifying Jumper Pin Properties

Modifying Jumper Properties

Jumpers

Jumper Name Properties Dialog Box

Jumper Properties Dialog Box
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Jumper Properties Dialog Box
To access: Select a jumper > right-click > Properties

Use the Jumper Properties dialog box to modify jumper location, label, and size.

Figure 181. Jumper Properties Dialog Box

Objects

Field Description

Reference Name The reference designator of the jumper.

Signal The designation of the net to which the jumper belongs.

X1/Y1 boxes The X and Y location of pin one. Type in these fields to change the 
location.

Rotation The jumper rotation. Type in this field to change the rotation.

Length The jumper length. Type in this field to change the length. The value 
must be within the minimum and maximum length values.

X2/Y2 The X and Y location of pin two. Type in these fields to change the 
location.

Minimum Length Specifies the minimum length of the jumper.
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Field Description

Maximum Length Specifies the maximum length of the jumper.

Increment Specifies the increment at which you can stretch the jumper between 
the minimum and maximum lengths.

Display Silk Enables the display of a silkscreen outline for the jumper.

 Tip
• For CAM output, you must enable Component Outlines for the layer 

on which the jumper resides before jumper outlines will plot.

• The outline for jumpers is set at 10 mils; you cannot modify this 
setting.

Label Lists existing labels for reference designator, part type, and attributes. 
To edit an existing label, click a label from the list and click the button 
in this tab. A label is selected instead of the component, and the 
corresponding Labels Properties dialog box appears where you can 
modify the label.
To create a new label, click <new> from the list and click the button in 
this tab. The Add New Part Label Dialog Box  appears where you can 
set up the new label.

 Tip
When modifying the Properties of a jumper name, Reference 
Designator is the only available label.

Opens the appropriate Label Properties dialog box if an existing label is 
selected in the Label list.

 Tip
When the current color for labels is set to the background color, this 
option is unavailable. To activate Label, assign a non-background 
color to labels in the Display Colors Setup Dialog Box.

Opens the Add New Part Label Dialog Box  if <new> is selected in the 
Label list.

Pad Stack button Opens the jumper pin in the Jumper Parameters Properties Dialog Box 
on page 1427. You can change the pad stacks for individual pins in the 
jumpers.
See also: “Editing a Pad Stack in the PCB Decal Editor”.

Related Topics
Modifying Jumper Name Properties

Modifying Jumper Pin Properties

Modifying Jumper Properties

Jumpers

Jumper Name Properties Dialog Box

Jumper Pin Properties Dialog Box
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Jumpers Dialog Box
To access: Setup  > Jumpers  menu item (Jumpers Dialog Box)

• Select a jumper > right-click > Properties  popup menu item > Pad Stack  button (Jumper 
Parameters Properties Dialog Box)

Use the Jumpers dialog box to set up and modify jumpers and jumper pad stacks. You can create and 
modify SMD jumpers (single layer jumpers) on the top or bottom mounting layer.

Description
The Jumpers dialog box controls change depending on what you have selected for the Pad Style. The 
three major differences are shown in the figures below:

Figure 182. Jumpers Dialog Box - Pad
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Figure 183. Jumpers Dialog Box - Thermal Settings

Figure 184. Jumpers Dialog Box - Antipad Settings

Objects
Table  188. Jumpers Dialog Box Fields

Field Description

Apply to Default  — Specifies that you are setting up the default jumper.
Design  — Specifies that you are setting up the jumper for this 
specific design.
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Table  188. Jumpers Dialog Box Fields  (continued)

Field Description

Reference Name Lists the available reference names.

Shape, Size, and Layer Lists the layers on which you can make jumper pad stack changes.
Exceptions:  When modifying Design jumpers, you can add 
individual layers of the design to the list for customizing the 
design jumper. Use the Add or Delete button to maintain the 
Shape/Size/Layer list.

Add Opens the Add Layer dialog box.

Delete Removes the selected shape

Pin list Lists the pins available to you.

Add Pin Opens the Add Pin Dialog Box  where you can add an existing pin 
to the Pin list.

Delete Pin Deletes the selected pin from the Pin list.

Min. Length Specifies the minimum length of the jumper.

Max Length Specifies the maximum length of the jumper.

Increment Specifies the increment at which you can stretch the jumper 
between the minimum and maximum lengths.

Use Global Defaults Sets thermal and antipad shapes to those specified in the Options 
dialog box > Copper Planes  category > Thermals subcategory  on 
page 1514.

 Restriction:
This option is available when the Pad Style list is set to 
Thermal or Antipad.

See also: “Design Rule Versus Pad Stack - Thermals and 
Antipads”  on page 797.

Pad Style Specifies the style of pad: normal pad, thermal pad, or antipad.
Thermal and Antipad display configuration controls the size and 
shape of thermals and antipads used on split/mixed layers and 
CAM negative planes (for RS-274X output).
See also: “Design Rule Versus Pad Stack - Thermals and 
Antipads”  on page 797.

 Tip
• Beginning with PADS 9.2, the size, shape and orientation of 

thermals for slotted pads are no longer derived from the length, 
drill size and orientation of the slotted hole, but are inherited 
from the normal pad.

• Set the Inner Diam and Outer Diam values to be the same 
for a solid connection to the plane (flood over). The current 
pad diameter is used as the inner diameter with the outer 
diameter set at the default same-net pad to corner rule. For 
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Table  188. Jumpers Dialog Box Fields  (continued)

Field Description
antipads, diameters are initially set to follow the current default 
pad to copper design rule. If you select Use Design Rules 
for Thermals and Antipads in the Options dialog box Copper 
Planes  category > Thermals subcategory  on page 1514, 
the outer diameter is ignored and the clearance rule is used 
instead, except when the outer diameter is less than the inner 
diameter. Inner and outer diameter options always, however, 
control flood over.

The length of an antipad having a non-zero drill size equals the slot 
length minus the drill size, plus the width.

 Tip
You cannot create antipads on outer layers. When you 
select an outer layer in the Size, Shape, Layer list, Antipad is 
unavailable.

Shape buttons Assigns a pad shape to the layer selected in the Size, Shape, 
Layers list. You can assign via pads as round, square, annular, 
oval or rectangular, odd.

• Annular lets you specify an inner pad diameter, bringing the 
inner diameter of the pad inside the drill outline. A pilot dimple 
at the center of the copper pad appears as an aid to hand 
fabrication of some prototypes.

• Odd is useful for drawn items such as moiré pads or registration 
marks. It is a circular outline only, and is usually used for 
marking areas for airgap checking. This setting should not be 
confused with trying to create a custom shaped (odd shaped) 
pad.

See “Creation of Custom Pad Shapes” for more information.

Pad size relative to drill size Displays inner and outer pad sizes relative to the drill size.

Flood over Specifies that the pad requires no thermal relief and should be 
flooded over, irrespective of any default flooding options for a 
normal pad of this shape.

 Restriction:
Available only when Pad style is Thermal and a pad shape 
button is selected.

Pad Parameters area The options for sizing the pad shape vary according to the shape 
you choose.
Round  — Diameter (if hole is not slotted), Width (if hole is slotted). 
If the pad style is thermal: Inner Diam, Outer Diam, Spokes, Spoke 
Angle, Spoke Width.
Square  — Size, Width (if hole is slotted), Corner type and Radius. 
If the pad style is thermal: Inner Size, Outer Size, Spokes, Spoke 
Angle, Spoke Width.
Annular  — Diameter and Inner Diameter
Odd  — Diameter
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Table  188. Jumpers Dialog Box Fields  (continued)

Field Description

Figure 185. Radius Examples

Drill Size Specifies the drill size if the jumper is a through hole jumper.

 Tip
Type a drill size of zero if you want a surface mount jumper 
with round pads.

Display Silk Specifies to display the silkscreen outline for the jumper.

 Tip
• For CAM output, you must enable Component Outlines for the 

layer on which the jumper resides before jumper outlines will 
plot.

• The outline for jumpers is set at 10 mils; you cannot modify this 
setting.

Pad Preview Shows pad shape and size for the current options.

Negative Changes the preview area to a negative view.

 Restriction:
Thermal Pad Style only.

Related Topics
Setting Up Jumpers
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Chapter 51
GUI Reference Elements K Through O

Read the sections that follow to learn more about dialog box elements in SailWind Layout.

Latium Checking Setup Dialog Box
Layer Association Dialog Box
Layer Parameter Setup Dialog Box
Layers Setup Dialog Box
Layout Area Assessment Dialog Box
Leader Segment Properties Dialog Box
Library List Dialog Box
Library Manager Dialog Box
Log Test Dialog Box
Logic Families Dialog Box
Make Reuse Dialog Box
Map Hole Features Dialog Box
Manage Library Attributes Dialog Box
Manage Mappings Dialog Box
Markups Dialog Box
Matching Result Dialog Box
MCAD Collaborator
Mechanical Model Properties Dialog Box
Media Wizard Dialog Box
Missing Height Dialog Box
Mixed Plane Setup Dialog Box
Modeless Command Dialog Box
Modify Electrical Layer Count Dialog Box
NC Drill Options Dialog Box
NC Drill Setup Dialog Box
Net Assignment Dialog Box
Net Properties Dialog Box of a Netlist Project
Net Properties Dialog Box - Design Reuse
Net Rules Dialog Box
Nudge Parts and Unions Dialog Box
Object Attributes Dialog Box
ODB++ Export Dialog Box
Object Filter Dialog Box
Options Dialog Box, Design Category
Options Dialog Box, Die Component Category
Options Dialog Box, Copper Planes Category, Hatch and Flood Subcategory
Options Dialog Box, Copper Planes Category, Thermals Subcategory
Options Dialog Box, Dimensioning Category, Alignment and Arrows Subcategory
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Options Dialog Box, Dimensioning Category, General Subcategory
Options Dialog Box, Dimensioning Category, Text Subcategory
Options Dialog Box, Display Category
Options Dialog Box, Global Category, Backups Subcategory
Options Dialog Box, Global Category, File Locations Subcategory
Options Dialog Box, Global Category, General Subcategory
Options Dialog Box, Global Category Synchronization Subcategory
Options Dialog Box, Grids and Snap Category, Grids Subcategory
Options Dialog Box, Grids and Snap Category, Object Snap Subcategory
Options Dialog Box, Routing Category, General Subcategory
Options Dialog Box, Routing Category, Teardrops Subcategory
Options Dialog Box, Routing Category, Tune and Diff Pairs Subcategory
Options Dialog Box, Text and Lines Category
Options Dialog Box, Via Patterns Category
Output Window
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Latium Checking Setup Dialog Box
To access: Tools  > Verify Design  menu item > Latium Design Verification check > Setup  button

Use the Latium Checking Setup dialog box to set the rules to check using SailWind Router.

Objects

Field Description

Net to All Checks clearance rules on each net or hierarchical level against any 
other obstacle type.

Board Outline Checks clearance rules for the board outline and board cut outs.

Off Board Text Checks for off-board text and to flag all instances of off-board text as 
clearance errors.

Keepout Checks for keepout restriction violations.

Same Net Checks clearances between objects along the same net, as specified in 
the Clearance Rules Dialog Box.

Drill to Drill Checks clearances between all drill holes. Pad stack drill size plus the 
drill oversize value calculate the diameter for plated holes.

 Tip
Drill to drill errors are reported for only one layer in a drill pair.

Trace Width Checks traces in excess of minimum and maximum widths, specified in 
the Clearance Rules Dialog Box.

Placement Outline • In default layer mode, check outline against outline on layer 20, not 
on electrical layers.

• In increased layer mode, check outline against outline on layer 120.
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Field Description

 Tip
You can create outlines on layer 20 (or 120) that do not exactly 
match the actual component outline. By setting a larger outline on 
this layer, you can leave an area near a component open for other 
purposes. This check ensures this area is left open.

Via at SMD Checks for via at SMD restriction violations.

Differential Pairs Checks for differential pair restriction violations.

Trace Length Checks for length restriction violations.

Test Point Checks test points on the design. Test Points checks for probe 
clearances, minimum via/pad sizes for probing, SMD pin probing, test 
points on component pin on the component side, test point count per 
net settings and nail diameter settings, and compares the settings 
against the setting in the DFT Audit program.

Related Topics
Setting Up Latium Checking

Cut Outs Absorbed by Copper
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Layer Association Dialog Box
To access: Add/Edit CAM Document dialog box  on page 1044 > select a document type from the 
Document Type list (not Custom)

Use the Layer Association dialog box to specify the layer to use for the CAM Document from among all 
the layers available for the document type that you choose.

Objects

Field Description

Layer Select the layer to use for the CAM Document Type you have 
chosen to create.

 Restriction:
This list displays only the layers that are available for the type 
of CAM document you are creating.

Related Topics
Creating CAM Outputs to Manufacture Your PCB
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Layer Parameter Setup Dialog Box
To access: Setup  > Layer Definition  menu item > Advanced  button

Use the Layer Parameter Setup dialog box to define electrical layer and dielectric material layer 
thickness, dielectric constant and other information for impedance calculation. When you verify your 
design, the electrodynamic check also uses this information.

Tip
Set these definitions before you run an electrodynamic check. You must have specified your plane 
layers in the Layers Setup Dialog Box  before you run an electrodynamic check. For a two-layer 
board, temporarily identify one of the layers as a plane layer.

Description
Traces on high-speed printed circuit boards can act like transmission lines that “broadcast” interference 
to adjacent conductors. Using the high-speed rules module, you can use Rules to set clearances on a 
net class, net, or pin to pin connection basis; then use high-speed checking to report on properties such 
as impedance, delay, track length, daisy chaining, and parallel routing. These issues cause interference 
and create costly problems in prototyping. You can run checks against the entire board or against specific 
nets.

Objects

Field Description

# Displays the electrical layer number, which corresponds to Lev.  in 
the Layers Setup Dialog Box.

Name Displays the name of the layer, which corresponds to that defined 
in the Layers Setup Dialog Box.

Type Specifies the type of layer. The only layers available for edit are 
dielectric. You have the choice of Substrate or Prepeg in this list.

Material Specifies the material of each layer. You can choose one from the 
drop-down list.

Thickness Specifies the thickness of the layer.
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Field Description

The input range varies from the material type and current design 
units:

• For dielectric material, its thickness must be within 5.08 
mm/200 mil/0.2 inch.

• For copper, its thickness must be within 0.25 mm/10 mil/0.2 
inch.

Tip:  If no coating is required, set thickness to zero.

Dk Specifies the dielectric constant value.

Df Specifies the dielectric loss tangent.
Range: 0—1

Drum SR Specifies the roughness of the drum side.
The input range varies from the current design units:

• Mils: 0—1

• Metric: 0—0.02540

• Inches: 0—0.001

Matte SR Specifies the roughness of the matte side.
The input range is silmilar to that of the drum side.

Ref. Plane Specifies the electrical layer as reference layer or not.
Note:  Plane layers specified in the Layers Setup Dialog Box  are 
set to reference layers by default.

SE Width Specifies the single-ended trace width.
The input range varies from the current design units as follows and 
the same rule applies to that of DIFF Width as well as DIFF Space.

• Mils: 0—100

• Metric: 0—2.54

• Inches: 0—0.001

SE Z0 (ohm) Displays the single-ended impedance calculated by clicking 
Calculate Impedance.

DIFF Width Specifies the trace width of differential pairs.

DIFF Space Specifies the spacing between differential pairs.

DIFF Z0 (ohm) Displays the differential impedance calculated by clicking 
Calculate Impedance.

Edit Makes the selected cell available for editing.
Exception:  Cells that are grayed out or blank are unavailable for 
editing.
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Field Description

Weight (oz) Specifies to view and edit copper thicknesses by ounces per 
square foot.

Design (") Specifies to view and edit copper thicknesses in the same unit of 
measure as the current database.

Board Thickness The total value of material and layer thicknesses in the current 
design units.

Calculate Impedance Clicks to start impedance calculation.

Import Clicks to import a XML file.

Export Clicks to export a XML file.

Related Topics
Setting Layer Parameters
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Layers Setup Dialog Box
To access: Setup  > Layer Definition  menu item

Use the Layers Setup dialog box to define each layer in your design.

Objects

Field Description

Layers list • Lev. column  — Displays the layer number. Layer one and the last electrical 
layer are used for components and routing and are automatically assigned 
as component layers for the top and bottom of the board. When you add 
additional electrical layers the last electrical layer becomes the new bottom 
layer.

See also: “Modifying the Number of Electrical PCB Layers”.
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Field Description

Layers in the list below the last electrical layer are nonelectrical or 
documentation layers. Apply text or drafting lines for specific purposes like 
assembly drawings or solder or paste mask output to these layers.

• Type column  — Identifies the layer type:
• CM  — Component and No Plane

• RT  — Routing and No Plane

• PL  — Routing and CAM Plane

• CP  — Component and CAM Plane

• CX  — Component and Split/Mixed Plane

• RX  — Routing and Split/Mixed Plane

• Dir. column  — Identifies the specified routing direction, Horizontal (H), 
Vertical (V), Any (A), 45 (/), or -45 (\).

• Name column  — Specifies the name of the selected layer.

Name The name for the layer which defines its function. You can type a unique name 
for each layer to identify it. This name appears in all layer listings.

Electrical Layer Type 
area

The Component and Routing options are available only when you have 
selected a top or bottom layer. If you want to place components on the 
selected outer layer, you must select Component.

• Component  — Sets the layer as a placement and routing layer. When a top 
or bottom layer is set as a component layer, you can use the Associations 
button to “map” (called associating) which documentation layers go with the 
selected layer. You can set only the top and bottom layers as component 
layers, indicating they will be used for placement; you cannot set inner 
layers as Component layers.

• Routing  — Sets the layer as a routing layer. If you want to prevent the 
placement of components on an outer layer, select Routing; you cannot 
place components on this layer.

Plane Type area Assigns a layer type to the layer selected in the Layers list. When a layer is 
selected as a plane or split/mixed plane layer, use the Assign Nets button to 
assign which nets to connect to it. The available types are:

• No Plane  — A signal routing layer allowing copper planes. If a No Plane 
layer is changed to a Split/Mixed or CAM Plane layer, nets belonging to the 
new plane are excluded from Electrical Nets.

• CAM Plane  — Sets the entire layer to be solid copper and connected to 
only one net. The CAM Plane layer is a negative image, and the copper 
does not appear in the design as it normally does for all other copper 
objects. You can not manipulate the shape/outline of the copper on this 
layer since it is generated automatically and covers the entire layer. This is 
an outmoded layer type. You can not route traces on a CAM Plane layer. 
Copper Planes cannot be created on CAM Plane layers.

• Split/Mixed Plane  — A dedicated copper plane layer allowing multiple 
copper planes and routing. Routes can be placed within or outside copper 
planes. Copper planes avoid traces within their outline by a clearance area 
defined in the design rules.
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Field Description

Routing Direction 
area

You must assign a primary routing direction to all electrical layers. Choose 
from:

• Horizontal

• Vertical

• Any

• positive 45 degrees

• negative 45 degrees

 Tip
Nonelectrical layers are not assigned a routing direction.

The routing direction affects the manual and autorouting performance. For 
example, if you select Horizontal but most of the traces on the layer need to be 
vertical, route editing performance is slow. Also, selecting Any can adversely 
affect route editing performance.

Associations Opens the Component Layer Associations Dialog Box.
The Associations button becomes available when you select a component 
layer in the Layers list.

Assign Nets Opens the Plane Layer Nets  on page 1640 dialog box.
The Assign Nets button becomes available when you select either a CAM 
plane or split/mixed layer in the Layers list.

Single-sided board Specifies the following:
• Connectivity checking will not report connectivity errors for component pins 

with non-plated drill holes. Components and jumpers placed on the top layer 
are considered as connected to pads on the bottom layer with solder joints.

• In CAM output, all through-hole pins and vias are treated as non-plated 
regardless of definition in pad stacks.

 Tip
• Available only for boards with two electrical layers.

• When selected, Modify button is unavailable.

See also: “Designating a Board as Single-sided”.

Modify Opens the Modify Electrical Layer Count  on page 1480 dialog box.
See also: “Modifying the Number of Electrical PCB Layers”.

Reassign Opens the Reassign Electrical Layers  on page 1655 dialog box.
See also: “Reassigning Electrical Layers”.

Enable/Disable Opens the Enable/Disable Layers  on page 1365 dialog box.
See also: “Hiding or Displaying Non-electrical Layers in Layer Lists”.

Max Layers Opens the Increase Maximum Layer Number  on page 1413 dialog box.
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Field Description

 Tip
When you change to increased layer mode, layer numbers for all 
nonelectric layers increase by 100.

See also: “Increasing the Maximum Number of Available Layers”.

Advanced Opens the Layer Parameter Setup  dialog box.

Related Topics
Setting Up an Outer Layer

Setting Up an Inner Layer

Setting Up a Documentation Layer

Layer Modes
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Layout Area Assessment Dialog Box
To access: AI  > Layout Area Assessment  menu item

Objects

Field Description

Options Settings area

One-sided Layout Select this option to enable the single-sided layout.

Allow 45 Degrees Select to allow rotating components by 45 degrees.

Border Spacing Specify the minimum clearance from the component body to the board outline.

Max Iteration Number Specify the number of algorithm iterations, with an upper limit of 100.

Decal Type area

Class Decal Name Specify the name of the class.

Class list Lists all class names.

Add  button Add the class name to the Class list.

Delete  button Remove the selected class from theClass list.
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Field Description

Rename  button Renames the class selected in the Class list with the text in the Class Decal 
Name box.

Usable list Lists the PCB decals available for the class in selection.

Selected list Lists the PCB decals of the class in selection.

Add  button Moves the selected items from the Usable list to the Selected list.

Remove  button Moves the selected items from the Selected list to the Usable list.

The Spacing Rule of the Same Surface Element area: Define the clearance rule between classes.
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Leader Segment Properties Dialog Box
To access: Select the first segment of a dimensioning leader segment, the segment with the arrow > right-
click > Properties  popup menu item

The Leader Segment Properties dialog box displays coordinate information for the selected dimensioning 
arrow and provides several areas for modifications.

Note:
The Leader Segment Properties dialog box remains open until you click OK  or Cancel. Selecting 
another leader segment while the dialog box is open updates the information for the selected 
object.

Objects

Field Description

X and Y Lists the x and y coordinates of the dimension object. The coordinates 
are calculated from the bottom of one of the extension lines or from the 
radius point of an arc. Type new values to change the location.

Parent button Opens the Dimension Properties Dialog Box  for the dimension object 
with which the selected object is associated.

Layer list Lists the current working layer. Select a new layer from the list.

Line Width Lists the current line width used for the dimension object. Type a new 
value to change the line width.

Related Topics
Dimensioning Process
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Library List Dialog Box
To access: File  > Library  > Manage Lib. List  button

Use the Library List dialog box to specify the libraries available to the design, library search order, and 
other search-related options.

Objects

Field Description

Library list The libraries currently listed in the Library Manager Library list.

Read Only A status indicator only; this box is always unavailable.

Shared Shares the library over the network. This enables more than one 
user to access the library file at the same time.

Allow Search Includes the library when performing operations that involves 
libraries, such as adding parts.

Add Adds a library to the Library list.

Remove Removes a library from the Library list.

Up/Down Moves the order of the libraries in the Library list.

Synchronize with SailWind Logic Specifies to push the library settings from SailWind Layout to 
SailWind Logic.

Related Topics
Library Availability and Search Options
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Library Manager Dialog Box
To access: File  > Library

Use the Library Manager dialog box to create libraries, to display the contents of libraries, and to manage 
the contents of libraries.

Description
Tips:

• The Library Manager supports up to 65,536 components.

• The picture in the Library Manager dialog box displays the selected item for decals, CAE decals, 
and lines. For parts, the picture displays the first-assigned decal.
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Objects

Field Description

Library list The list of libraries available to you.

Create New Lib Opens the New Library window where you can specify a new library name 
and location.

Manage Lib. List Opens the Library List Dialog Box.
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Field Description

Attr Manager Opens the Manage Library Attributes Dialog Box.

Preview area Shows the item selected in the Filter list.

Filter area Narrows down the Filter list by Decals, Parts, Lines, or Logic. You can 
further narrow the list using wildcards  on page 155 in the Filter box.

 Tip
Add an asterisk (*) to the box to display all items.

Filter list The results from your filter area selections.

New The action taken is dependent on the filter.
• Decals  — Opens the PCB Decal Editor on a new decal.

• Parts  — Opens the Part Information Dialog Box,  on page 1588 Gates 
Tab on an unnamed part.

• Lines  — Unavailable. There is no special library lines editor. Use 
drafting tools to create or edit lines and save them to the library.

• Logic  — Unavailable. Use SailWind Logic to create or edit CAE decals.

 Restriction:
This button is unavailable when the Library is set to All Libraries.

See also: “Adding Items to a Library”.

Edit The action taken is dependent on the filter.
• Decals  — Opens the PCB Decal Editor on the selected decal.

• Parts  — Opens the Part Information Dialog Box,  on page 1588 Gates 
Tab on the selected part.

• Lines  — Unavailable. There is no special library lines editor. Use 
drafting tools to create or edit lines and save them to the library.

• Logic  — Unavailable. Use SailWind Logic to create or edit CAE decals.

 Restriction:
This button is unavailable when the Library is set to All Libraries.

See also: “Editing Items in a Library”.

Delete Removes the selected item from the library.

 Restriction:
This button is unavailable when the Library is set to All Libraries.

See also: “Deleting Items from a Library”.

Copy Copies the selected item to another name or another library.

 Restriction:
This button is unavailable when the Library is set to All Libraries.

See also: “Copying a Library Item”.

Import Import library data from an ASCII file. The file type is dependent on the 
filter.
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Field Description

 Restriction:
This button is unavailable when the Library is set to All Libraries.

See also: “Importing Library Data”.

Export Export library data to an ASCII file. The file type is dependent on the filter.

 Restriction:
This button is unavailable when the Library is set to All Libraries.

See also: “Exporting Library Data”.

List to File The action taken is dependent on the filter.
• Decals  — Generates a list of PCB Decals in a single library.

• Parts  — Generates a list of Parts in a single library or all libraries along 
with chosen attributes.

• Lines  — Generates a list of line items in a single library.

• Logic  — Generates a list of CAE decals or Logic symbols in a single 
library.

 Restriction:
When the Library is set to All Libraries, this button is unavailable for all 
but Parts.

Related Topics
Creating a New Library

Library Availability and Search Options

Deleting All Items in a Library

Library Attribute Management

Creating a Report of the Parts in a Library

Creating a Report of Decals, Lines or Logic Symbols in a Library
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Log Test Dialog Box
To access: type BLT > press the Enter key

Use the Basic Log Test (BLT) to replay session playback media created by the Basic Media Wizard 
(BMW).

Tip
If nothing happens, close SailWind Layout and restart it.

Objects

Field Description

Media Directories Lists the session playback media files.

New name Specifies to rename the selected media directory.

Rename Renames the selected media directory to the name in the New name 
box.

Related Topics
Replaying Session Playback Media with BLT
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Logic Families Dialog Box
To access: File  > Library  > select a Library > Parts  button > select part > New  or Edit  button > General 
tab > Families  button

Use the Logic Families dialog box to add, delete, or edit logic family names or their reference designator 
prefix. Logic Families are abbreviated names for categories of parts. The abbreviated names are 
assigned a reference designator prefix. When creating a new part, you select a logic family to specify the 
reference designator prefix.

Objects

Field Description

Family The abbreviated name for the category of the part. The name 
is limited to 3 characters. For an explanation of the list of logic 
families that install with the software, see “Default Logic Families” 
below.

Prefix The prefix of the Logic family. Multiple characters are allowed.

Add Inserts a row at the bottom of the list where you can add a new 
Logic family.

Edit Makes the selected cell available for editing. You can also 
double-click a cell to edit the contents.

Delete Removes the selected row.

Default Logic Families
• The following is a list of the default logic family abbreviations along with their assigned reference 

designator prefixes and long description.

◦ ANA (U) - Analog

◦ BGA (U) - Ball Grid Array
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◦ BPF (U) - Band Pass Filter

◦ BQF (U) - PQFP (Bumpered Quad Flat Package)

◦ CAP (C) - Capacitor

◦ CFP (U) - Ceramic Flat Pack

◦ CLC (U) - CLCC (Ceramic Leadless Chip Carrier)

◦ CMO (U) - CMOS (Complimentary Metal Oxide Semiconducotor)

◦ CON (J) - Connector

◦ CQF (U) - CQFP (Ceramic Quad Flat Pack)

◦ DIO (D) - Diode

◦ DIP (U) - Dual Inline Package

◦ ECL (U) - Emitter Couple Logic

◦ EDG (P) - Edge Connector

◦ FUS (F) - Fuse

◦ HMO (U) - HMOS (High density, short channel Metal Oxide Semiconductor)

◦ HOL (X) - Hole

◦ IND (L) - Inductor

◦ LCC (U) - Leadless Chip Carrier

◦ MOS (U) - Metal Oxide Semiconductor

◦ OSC (Y) - Oscillator

◦ PFP (U) - Power Flat Package

◦ PGA (U) - Pin Grid Array

◦ PLC (U) - PLCC (Plastic Leaded Chip Carrier)

◦ POT (P) - Potentiometer
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◦ PQF (U) - PQFP (Plastic Quad Flat Package)

◦ PSO (U) - PSOP (Plastic Small Outline Package)

◦ QFJ (U) - Quad Flat Pack with J-lead

◦ QFP (U) - Quad Flat Pack

◦ QSO (U) - QSOP (Quarter-Sized Outline Package)

◦ RES (R) - Resistor

◦ RLY (K) - Relay

◦ SCR (SC) - Thyristor

◦ SKT (U) - Socket

◦ SOI (U) - SOIC (Small Outline Integrated Circuit)

◦ SOJ (U) - Small Outline J-lead

◦ SOP (U) - Small Outline Package

◦ SSO (U) - SSOP (Shrink Small Outline Package)

◦ SWI (S) - Switch

◦ TQF (U) - TQFP (Thin Profile Quad Flat Pack)

◦ TRX (Q) - Transistor

◦ TSO (U) - TSOP (Thin Small Outline Plastic)

◦ TTL (U) - Transistor-Transistor Logic

◦ VSO (U) - Variable Speed Oscillator

◦ XFR (T) - Transformer

◦ ZEN (Z) - Zener Diode
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Make Reuse Dialog Box
To access: Select the objects you want to include > right-click > Make Reuse  popup menu item

Use the Make Reuse dialog box to specify a reuse type and reuse name for the physical design reuse 
you are creating.

Objects

Field Description

Reuse Type Describes the physical design reuse and its function. The reuse type 
is similar to a library part type. Type a reuse type, up to 255 characters 
long, for the physical design reuse. Illegal characters are slashes (\ /), 
colon (:), asterisk (*), question mark (?), quotation marks ("), less than 
and greater than signs (< >), and pipe (|). You can include spaces in 
the type, but you cannot use them as the first or last character.
The reuse type is checked to ensure it is not already in use. If it is 
already used, an error message appears and you can specify a 
different type.

 Tip
There is no way to display the reuse name and reuse type in the 
design.

Reuse Name Indicates a name that uniquely identifies this instance of the physical 
design reuse. Type a name, up to 15 characters long, for the physical 
design reuse. Illegal characters are comma (,), brackets ({ }), asterisk 
(*), period (.), and space.
The default name is based on the reuse type. For example, if the reuse 
type is Power Supply, the default reuse name is Power_Supply_1.
The reuse name is checked to ensure it is not already in use. If it 
is already used, an error message appears and you can specify a 
different name.

 Tip
There is no way to display the reuse name and reuse type in the 
design.
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Field Description

Save to File Saves the physical design reuse to a file for use in another design. The 
content of the current start-up file is also saved with the physical design 
reuse.
See also: “Creating Start-up Files”.
If this is selected, the Reuse Save As dialog box appears when you 
click OK. Indicate the folder in which to save the newly created physical 
design reuse. The default folder is \SailWind Projects\Reuse.
Reuse files have a .reu  extension and can be opened by clicking Open 
from the File menu. You must change the file type to SailWind Layout 
Reuse Files (*.reu).

Deselection Report Creates the report file report.rep  in the 
C:\<install_folder>\<version>\Settings  folder and opens the file in the 
default text editor. The file contains a list of items removed from the 
selection because they were not valid for inclusion in the physical 
design reuse.

 Restriction:
The deselection report and the selection report are created using 
the same file name. If you want to save this file, do so in the default 
text editor using a different file name.

Selection Report Creates the report file report.rep  in the 
C:\<install_folder>\<version>\Settings  folder and opens the file in 
the default text editor. The file contains a list of items included in the 
physical design reuse.

 Restriction:
The deselection report and the selection report are created using 
the same file name. If you want to save this file, do so in the default 
text editor using a different file name.

OK The OK  button is unavailable until you enter a Reuse Type and a 
Reuse Name.

Related Topics
Reusing Designs or Parts of Designs
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Map Hole Features Dialog Box
To access: Select a mechanical model in the 3D Window and click the Create Board Outline  button; then 
click a point on the model to use as the board origin.

Use the Map Hole Features dialog box to map holes in an imported mechanical model to hole types 
(such as cutouts or mounting holes) if you want to use them in your board outline. Holes from an imported 
mechanical model that are not mapped to a specific hole type are discarded by default.

Objects

Field Description

Inferred Hole 
Data

Displays an identifying description of the hole; for example, “A hole of dia 
228 (th).” SailWind Layout generates the description based on data from the 
imported mechanical model.

Hole Type Indicates how SailWind Layout should regard the hole. Select from the 
dropdown list by clicking in the table cell. Available choices include “Discard,” 
“Contour,” or “MountingHole.”
SailWind Layout ignores any holes with the “Discard” selection.
If you choose “MountingHole,” you must also select a corresponding attribute 
from the “Hole Attribute” column.
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Field Description

Hole Attribute Select an appropriate decal or pad stack to use for the hole by clicking in the 
table cell and selecting from the dropdown list. SailWind Layout populates the 
list with all mounting holes currently defined in the design.

 Restriction:
You must have at least one mounting hole already defined for your design 
before using this feature.

The list becomes available only if you select “MountingHole” as the Hole Type.

Highlight Select the check box if you want SailWind Layout to highlight the associated 
hole in the 3D Window.
Highlighting the hole provides a means of quickly locating it.

Related Topics
Creating a Board Outline From an Imported Mechanical Model
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Manage Library Attributes Dialog Box
To access: File  > Library  > Attr Manager  button

Use the Manage Library Attributes dialog box to manage attributes on a library-by-library basis. You can 
add, delete, and rename attributes for all parts or decals in an individual library or in all libraries. You can 
also display all the attributes in a library, whether the attributes apply to all items or to individual items.

Objects

Field Description

Select Library list The list of libraries available to you.

Item Types list Filters the type of items in the Attributes in Library list.

Browse Lib. Attr Opens the Browse Library Attributes Dialog Box.

Edit New Name Makes the selected attribute Name editable.
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Field Description

 Tip
This is available only when an attribute in the New Name 
column in the Attributes Selected for Rename list is selected.

Attributes in Library list The list of attributes in the selected library.

 Tip
This is available only when an attribute in the New Name 
column in the Attributes Selected for Rename list is selected.

Add >> Adds the selected attribute to the Rename list.

<< Remove Removes the selected attribute from the Rename list.

<< Remove All Removes all of the attributes from the Rename list.

Attributes Selected for Rename 
list

The list of attributes you have selected to rename.

Add Attr Opens the Add New Attribute to Library Dialog Box.

Delete Attrs Deletes the selected attribute from the selected library.

Rename Attrs Renames all of the attributes you gave a new name to in the 
selected library.
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Manage Mappings Dialog Box
To access: Open the 3D view (View  > SailWind 3D), then click the Manage Mappings  button .

Use this dialog box to reassign or reuse 3D models for parts on the rendered PCB design. For example, if 
you want to assign an SOIC 3D model to other SOIC devices on the PCB that appear physically identical, 
you can use this dialog box to make the assignment to the other devices.

Restriction:
You cannot reassign a 3D model to a part if the part is already saved in the library with a 3D 
model.

Objects

Field Description

Parts mapped to models Lists all 3D models and corresponding model information 
currently associated with parts in the PCB design.
Model Name  — Displays the model name associated with a 
part. If you map a model to more than one part in the design, the 
model name appears more than once in the list.
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Field Description

Part Number  — Displays the number of the part associated with 
the model. You can only assign one model to a part; therefore, 
part numbers appear only once in the list.
Cells  — Displays the decal name associated with the part.
Mapping  — Indicates whether the model assignment is mapped 
locally or in the part library. You can change model assignments 
for a part locally; however, if the part is saved with a model in the 
library, you cannot change the model assignment.

Parts without model Lists information about all of the parts that are not mapped to 
3D models. Parts not mapped to 3D models are represented by 
either 2D or 2.5D (extruded) models instead.
Part Number  — Displays the number of the unmapped part. 
Selecting the check box next to the part number allows you to 
map it to a model in the “Parts mapped to models” list.
Cells  — Displays the decal name associated with the part.

Click the right arrow to remove the mapping information from the 
selected part model in the Parts mapped to models  list, thereby 
moving it to the Parts without models  list.

Click the left arrow to map the part selected in the Parts without 
models  list to the model selected in the Parts mapped to 
models  list.
This button is unavailable if you do not also select a model in the 
“Parts mapped to models” list.
You can map more than one part to a model.
If the alignment data for the 3D model is already associated with 
a different decal, the software enables you to choose to reuse 
the alignment data or perform a manual alignment.

Enable cross probing Select this check box to enable you to interactively select a part 
in the design workspace and make it selected also in the Parts 
mapped to models  list or the Parts without models  list.
This check box is cleared by default each time the dialog box 
closes.
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Markups Dialog Box
To access: Edit  > Markups  menu item

Use the Markups dialog box to view or log issues concerning the design. You can add 2D line markups 
to issues, to outline or highlight their location. You can also link design objects to markups. Then you can 
export the issues alone or export the design and any issues for viewing and logging additional information 
in visECAD.
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Objects

Field Description

Add Topic Click to add a new topic to the Collaboration Data tree.

1466 SailWind Layout Guide and Reference



 
GUI Reference Elements K Through O

Markups Dialog Box

Field Description

Add Issue Click to add a new issue to the tree under the currently active topic

Add Markup Click to add a new markup to the currently active issue.

Delete Delete the active item in the Collaboration Data tree

Import Click to browse for, and Import a collaboration data file (*.clb, or 
*.cle).

Export Click to Export the encrypted collaboration data to a file name of 
your choosing (*.cle).

Collaboration Data Tree This is the top tree in the dialog box and it displays the 
collaboration data in a hierarchical form.

Elements Tree This lists the elements linked to any markup.

User Type your name in this box to associate your name with the active 
Collaboration Tree item.

Date Displays the date and time of creation of the currently active 
collaboration item.

Comment Type to add comments for the currently active collaboration item.

Text This displays the text of a markup. This is unavailable in SailWind 
Layout, but will display text associated with markups created in 
other software.

File When you export or import a collaboration file, this displays the 
path and filename.

Related Topics
Adding Markups

Exporting Markups Using the Markups Dialog Box

Exporting Markups Using File > Export

Importing Markups Using the Markups Dialog Box

Importing Markups Using File > Import
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Matching Result Dialog Box
To access:

• On the Design Toolbar click the Make Like Reuse button, and then select a reuse type/file in the 
"Select Reuse Module" dialog box.

• Select a Reuse in the design, and then right-click and click the Make Like Reuse  popup menu 
item, or on the Design Toolbar click the Make Like Reuse button.

Use this dialog box to see whether a match to the selected reuse is found in the design. If yes, you can 
make a new physical reuse design with it; if not, you can view the matching report in detail.

Objects
Table  189. Parameter Description

Area Object Description

Ref. Des.

Part Type

The first three colums

Pin Count

Displays part information of the selected reuse.

Equivalent Decal Name

Equivalent Part Type

The last three colums

Equivalent Ref. Des.

Displays information of parts equivalent to those in 
the selected reuse, which changes depending on 
the selection made in the Filter area.
If no match is found in the Equivalent Ref. Des. 
list, you can clear the Value check box to have 
another try.

Filter area Value Specifies whether to match parts by comparing 
Value.
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Table  189. Parameter Description  (continued)

Area Object Description

 Note:
Value refers to part attributes Value and 
Tolerance.

- Matching Report Opens the report file Layout.err  in your default text 
editor.
The file contains operations and matching results 
from the Make Like Reuse command, which is 
created in your working folder.

- OK  button Close the dialog box. Note that if a match is 
found, the new physical design reuse dynamically 
attaches to the pointer.
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MCAD Collaborator
To access: Open the SailWind 3D window (View  > SailWind 3D), then click the MCAD Collaborator 

button .

Use this dialog box to exchange mechanical design change information between the PCB design team 
and the mechanical design team. This dialog box allows you to create and annotate change proposals in 
a .idx, .idxz, or .xml  file, which you can then exchange with mechanical designers.

Objects

Field Description

Files  section — Displays the file names of the change proposal files you have already processed.

History  section — Displays a reverse chronological log (the most recent first) of all of the change files 
for the current design.

Clear Deletes all of the change files displayed in the History  pane.

 Note:
If you clear the History, you cannot restore the change files 
later.

Communications  section — Defines the file and communication parameters for the mechanical 
collaboration. Use this section to ensure change proposal information exchanged with the mechanical 
designers is coordinated.
For example, define the schema units in this section so the scale of any proposed changes is 
understood between the mechanical designers and board layout designers.

Write Options Defines the units and file type for the change data files.
• Schema Version  — Allows the selection of Schema 

Version 2.0 or 3.0. See “Supported Design Objects for Data 
Exchange”  on page 561.

• Schema units  — Defines the units for the change data files 
(millimeters, inches, microns, thousandths).

• File Type  — Defines the file type/extension for the change 
data files: .idx, idxz (zipped) or .xml.

• Data Transfer  — Defines the method for exchanging the 
change data files (email, file).

• Email Notification  check box — Enables or disable selection 
of Email as the method of communication.

• Email Server  — Specifies the type of email server protocol to 
use. Select either SMTP  or Outlook  (MAPI).

Receiver Info Specifies the recipient information for communicating by email.
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Field Description

• Name  — Defines the name of the receiver.

• Company  — Defines the company name of the receiver.

• Email ID  — Defines the email address of the receiver.

Sender Info Specifies the sender information for communicating by email.
• Name  — Defines the name of the sender.

• Company  — Defines the company name of the sender.

• Email ID  — Defines the email address of the sender.

Data Path Defines the shared directory path for the change data files. You 
can type the path directly or browse for it by clicking the browse 

button. 

Collaboration Data section — Displays the file name of the change file you are processing and a tree 
list of all of the design elements that are impacted by the change request.

Out of Sync Data Notification Indicates whether the data is synchronized between PCB and 
MCAD. If the data is out of sync, a highlighted message appears. 
Click the button to synchronize the data.

File Type Selector Defines the type of file for the change. Choose one of the 
following options from the dropdown list:

• Baseline  — Initial design data file.

• Proposal — Proposed change data file.

• Response  — Response data file with acceptance or rejection 
of proposed change.

Tree List Displays all of the change items in the selected change file. 
The items are grouped by the type of design element. The icon 
for each item indicates the type of change: added, deleted, 
modified.
Checked, the item is accepted.
Unchecked, the item is rejected.

Add Adds a new change request.

Delete Deletes an existing change request.

Modify Modifies an existing change request.

Highlight/Unhighlight Graphics Enables 3D animation of the selected change in the 3D View. 
The design elements impacted by the change are highlighted.
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Field Description

Expand Tree Data Expands the entire Tree List.

Collapse Tree Data Collapses the entire Tree List.

Filter Objects Opens the Object Filter dialog box.

Update Tree Data Updates the Collaboration Data list and shows only the object 
types you selected in the Collaboration Objects Filter list.

Properties  section — Displays the properties for the change you are processing. The information 
displayed in the Properties  pane changes according to what type of item you have selected (change 
file, design element).

• Green text indicates added elements.

• Red text indicates deleted elements.

• Blue text indicates modified elements.

Related Topics
Exchanging Data with Mechanical Designers
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Mechanical Model Properties Dialog Box
To access: Select View  > SailWind 3D  menu item, then click the Mechanical Model Properties  button in 

the toolbar of the 3D dialog box .

The Mechanical Model Properties dialog box allows you to associate mechanical models such as 
mounting brackets or covers with a PCB design. Use this dialog box to also modify certain properties 
(such as position) of mechanical model instances in your design.

Objects

Field Description

Instance Displays the name of a mechanical model instance used in the 
design.
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Field Description

• Click Add  ( ) to add a new mechanical model to the 
design. Clicking the add button opens the Import Mechanical 
Model dialog box to allow you to select a mechanical model. 
The imported model appears in the dropdown list with a 
default instance name of “Temp name x” where x  is an 
iterative mechanical model instance.

• Click Delete  ( ) to remove an existing model from the 
dropdown list. The model is also removed from the design.

When the Mechanical Model Properties dialog box is open, 
select any mechanical model in the design (such as a bracket) 
to view its corresponding instance name in the box. You can also 
select a mechanical model from the dropdown list to select it.
If desired, you can edit a mechanical model’s instance name by 
typing directly in the box.

Filename Displays the filename and directory path for the model definition 
file.

Type Defines the model type. Defining a model type for the 
mechanical model categorizes the model to allow you to apply 
specific 3D clearances (in the 3D Clearances Dialog Box) to the 
model.

• Assembly  — The model is used for assembly purposes 
(alignment hole, card rail, and so forth).

• Mechanical — The model is a mechanical part (mounting 
hole, card ejector, and so forth).

• PCB  — The model is a daughter PCB that is connected to the 
PCB.

Save with design Selecting the check box saves the modified model properties 
(such as its Rotation, Offset, and Type settings) with the current 
PCB layout design.
This check box is selected by default.

Include with board export Selecting this check box saves the mechanical model with the 
PCB design when you select the Board only  option during 
design export.

 Tip
Alternatively, you can select the All mechanical models 
option in the Export window to save all mechanical models 
with the design.

Movement Defines the type of values for the Rotate and Offset options:
• Absolute  — The values you enter are absolute coordinate 

values based on a fixed XYZ origin.

• Delta — The values you enter are difference values from the 
current XYZ location coordinates for the model.
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Field Description

• Rotate  — Defines the X, Y, and Z axis rotations for the 
model. Click the appropriate icon to set the orientation of the 
model.

• Offset — Defines the X, Y, and Z axis offsets for the model 
location.

Allow interactive mechanical model 
movement (disable all other)

Selecting this check box allows you to reposition the mechanical 
model by dragging it with the mouse.
When cleared, you can reposition the mechanical model using 
only the Movement  fields.

Undo/Redo buttons Allows you to undo or redo alignment and rotation actions.
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Media Wizard Dialog Box
To access: type BMW > press the Enter key

BMW (Basic Media Wizard) is a tool for recording and playing back SailWind Logic, SailWind Layout, and 
SailWind Router sessions. It is particularly useful as a means of supplying information to PADS Technical 
Support engineers trying to identify and resolve any problematical behavior you may encounter.

Objects

Field Description

Media Wizard area Specifies what you want the Media Wizard to do:
• Create Media from Current Session  — Use this procedure when 

the session you are recreating did not cause a SailWind tool crash.

• Create Media from Previous Session  — Use this procedure when 
the session you are recreating caused the SailWind tool to crash, 
and the automatic procedure described in Automatically Creating 
Session Playback Media for a Crashed Session  cannot be used due 
to one of the restrictions listed in that section.

• Stop Logging  — Specifies to stop the Media Wizard from logging 
any further actions.

User Initials Specifies your initials. They are included in the playback media 
filenames to identify the files as yours.

Delete Actions Before Last 
Save

Specifies to delete all entries in the session log file between the first 
Open and the last Save command. You can do this to eliminate any 
actions you may have performed before beginning the series of actions 
that produced the problematical behavior. This makes it easier for the 
Tech Support engineer to identify the problem.

Related Topics
BMW and BLT
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Missing Height Dialog Box
To access: The Missing Height dialog box appears when the Geometry.Height attribute does not exist or 
is set to zero height for any part type and decal pair exported to IDF.

Use the Missing Height dialog box to specify missing heights when exporting the design to IDF.

Objects

Field Description

Can’t Find Height For Part 
Type

Displays the part type with the missing height.

Using Decal Displays the decal associated with the part type.

Height Specifies the package and mounting height for the part type and decal 
pair.

 Tip
If you specify the height as zero, the mechanical design system 
may prompt you to enter a height when you import the IDF file.

Design Units Lists the design units.

For All Parts Specifies to apply the height for all part type and decal pairs.
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Mixed Plane Setup Dialog Box
To access: Tools  > Verify Design  menu item> Plane check > Setup  button

Use the Mixed Plane Setup dialog box to set the type of plane checking.

Objects

Field Description

Type area • Check thermal connectivity only  — Specifies to check your 
design for split/mixed or CAM plane thermal connectivity. Use this 
check to find pins or vias that do not have the thermal attribute set, 
or to find pins that are not within a plane area (thermals will not 
connect). You can set the thermal attribute in Jumper Pin, Pin, or 
Via Properties dialog boxes.

• Check clearance and connectivity  — Specifies to check your 
design for split/mixed plane clearance and net connectivity errors. 
If the split/mixed plane is not connected in the design, the plane is 
flooded before the check is run.

Same Layer Connectivity Ensures that plane areas are continuous on the split/mixed plane layer. 
Plane areas of a particular net must have copper contact with each 
other without going to another layer.

Related Topics
Plane Checking Setup
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Modeless Command Dialog Box
To access: Type the modeless command (shortcut key) for the command you want.

You can set or change some settings and functions at any time using a shortcut key for the command 
called a modeless command.

Objects

Field Description

Command Type a modeless command  on page 83 and then press the Enter key to execute.
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Modify Electrical Layer Count Dialog Box
To access: Setup  > Layer Definition  menu item > Modify  button

Use the Modify Electrical Layer Count dialog box to increase or decrease the number of electrical layers 
in the design.

Objects

Field Description

Current number of electrical 
layers

Lists the current number of electrical layer.

Enter new number of 
electrical layers (must be 
between _ and _)

Type a new number of electrical layers. You can add or delete layers. 
The number must be between the two values above the text box.

 Restriction:
You cannot delete layers that have data on them. For example, 
you want to reduce a 2 layer board to a 4 layer board. if you have 4 
layers and they all have content, you must move the content from 
the layers to be deleted. The statement above the text box will state 
“must be between 4 and 20” since you cannot delete any layers 
because of data.

Related Topics
Modifying the Number of Electrical PCB Layers

Reassigning Electrical Layers

Reassign Electrical Layers Dialog Box

Layers Setup Dialog Box
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NC Drill Options Dialog Box
To access:

• File  > CAM  menu item > Add  button > select NC Drill from the Document Type list > Drill  button 
> Options  button

• File  > CAM  > select a document name > Edit  button > select NC Drill from the Document Type 
list > Drill  button > Options  button

Use the NC Drill Options dialog box to define NC Drill Output plotting options when adding an NC drill 
document or editing an existing one.

Objects

Field Description

Rotation Define how to rotate the drill drawing. Your choices are 0, 90, 180, or 
270 degrees of counterclockwise rotation.

Origin Offset X/Y Specifies how much to move the board so the design origin coincides 
with the drill machine origin. A positive X shift moves the board to the 
right: a positive Y shift moves the board up.

Mirror Image Specifies to mirror the image.

Count X/Y Specifies how many times the Pattern is repeated.

Distance X/Y Specifies the distance between adjacent patterns; the distances should 
be greater than or equal to the board dimensions to avoid any overlap. 
If all box values are zero, then there is no step and repeat.

Through vias Specifies to drill through vias.
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Field Description

Partial Vias Specifies to drill partial vias.

 Restriction:
Available only if you have set up Drill Pairs  on page 1337.

Drill Pair Specifies which layer pair to drill.

 Restriction:
Available only if you have specified to drill partial vias.

Plated Pins Specifies to drill plated pins.

Non-Plated Pins Specifies to drill non-plated pins. Non-plated pins are usually mounting 
holes.

Test Points Specifies to plot test point locations.

Generate Listing Creates a listing of the drill hole sizes by location. An additional CAM 
file is produced with a .lst  extension when you run the NC Drill CAM 
Document.

Related Topics
Creating an NC Drill File

Creating CAM Outputs to Manufacture Your PCB
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NC Drill Setup Dialog Box
To access:

• File  > CAM  menu item > Add  button > select NC Drill from the Document Type list > Drill  button 
> Device Setup  button

• File  > CAM  menu item > select a document name > Edit  button > > select NC Drill from the 
Document Type list > Drill  button > Device Setup  button

Use the NC Drill Setup dialog box to set Excellon output or Drill Listing parameters.

Description

Figure 186. Excellon Tab
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Figure 187. Drill Listing Tab

Figure 188. NC Drill Setup Dialog Box

Objects
Table  190. NC Drill Setup Dialog Box Fields

Field Description

Output Type Specifies the output file you want: ASCII or EIA-244 (Electronic 
Industries Association RS-244 Standard format)

Units Specifies the units to use: Metric or English.

 Tip
The Units list on the Excellon  tab allows multiple selections with 
predetermined leading and trailing digits.

Type column Displays the format string type.
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NC Drill Setup Dialog Box

Table  190. NC Drill Setup Dialog Box Fields  (continued)

Field Description

String column Lists the format string. Double click to edit.

 Tip
• Default strings on the Excellon  tab are different than those on the 

Drill Listing  tab.

• See the header of the drill.dat  file in the <product_name>/Settings 
folder for more detailed format information.

# of Digits area Specifies the number of digits before (leading) and after (trailing) the 
decimal point position. This defines the output file coordinate precision.
Exception:  The # of Digits fields are unavailable on the Excellon 
tab since the Units list selections contain predetermined leading and 
trailing digits.

Zero Suppress Specifies the zeros to suppress.
• None  — retains both leading and trailing zeros.

• Leading  — suppresses leading zeros.

• Trailing  — suppresses trailing zeros.

Coordinate Specifies the coordinate type.
• Absolute  — absolute coordinates.

• Incremental  — relative coordinates.

Speed/Feed table Controls the drill speed and feed rates. Double-click to modify an 
existing entry. Edit the size range, drill speed (surface feet per minute), 
and feed rate (inches per minute) values in the boxes.

 Tip
Drilling feed rates can be set between 10 and 500 IPM (4 and 212 
mm/s if metric) in increments of 1 IPM (1 mm/s if metric).

Add button Adds a new row at the bottom of the table.

Delete button Removes the selected row from the table.

Verify button Ensures that you have values in the Size Range box which satisfy 
each drill on your board. A prompt tells you whether the drill sizes are 
accurate or if drill size ranges are missing from the Size Ranges box.

Related Topics
Creating an NC Drill File

Creating CAM Outputs to Manufacture Your PCB
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Net Assignment Dialog Box
To access: Add copper to the design or open the properties of copper and in the Add Drafting or Drafting 
Properties dialog box  on page 1054, select the “Copper bridge. Select the nets to bridge...” check box and 
then click the Nets to bridge  button.

Use the Net Assignment dialog box to select nets to associate to copper being used to bridge two or more 
nets. This ensures that when you enabled online Design Rule Checking (DRC), SailWind Layout does not 
flag the bridge copper as a violation, but catches all other accidental physical connections between the 
nets.

Objects

Field Description

Available nets Specifies the nets that are available for adding to the Nets to 
bridge list to associate to the copper bridge. This list is filtered by 
selecting either Plane nets or All nets.

Nets to bridge Specifies the nets to associate to the copper bridge. The copper 
can bridge these nets with design rules enabled.

Plane nets Filters the Available nets list to display only those assigned to 
planes (CAM or split/mixed layers), as set up in the Layers Setup 
Dialog Box.

All nets Filters the Available nets list to display all the nets in the design.

Related Topics
Bridging Nets with Copper
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Net Properties Dialog Box of a Netlist Project
To access: Select a net > right-click > Properties  popup menu item

Displays the netname, the list of pin-to-pin connections, routing information, and rules data of one or more 
selected nets in a netlist project.

Description
You can also:

• set route protection for nets.

• set the trace width

• make settings that control the creation of electrical nets.

Restriction:
Some options in this dialog box are unavailable if the net is part of a physical design reuse 
or contains protected routes.
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Objects

Field Description

Net Displays the name of the net.

Connection Lists the pin pair connections available in the net.

Layout Data area Displays all layout data about the selected net.
• Unrouted Length  — Displays the length of the net that is unrouted.

• Routed Length  — Displays the length of the net that is routed. Includes 
half the Discrete length value of each connected pin of components that 
have a Discrete length assigned. When routed to the pad, measurements 
are made to the origin of the pad.

• Via Count  — Displays the number of vias that are used in the net.

• Capacitance (pf)  — displays a baseline capacitance value of the net. This 
calculation uses the trace parameters, the board material values you set in 
the Layer Parameter Setup Dialog Box, and requires at least one adjacent 
plane to display values. A maximum of two adjacent planes are used in the 
calculation. If the plane layer is a split/mixed plane layer, you must have a 
plane shape on the layer. The location and outline of the shape and cutouts 
of the plane area are all ignored in the calculation.

You can set a Minimum and Maximum Capacitance rule in the HiSpeed 
Rules Dialog Box, but it is only verified when you run Tools > Verify Design 
on page 1775 after you set up a High Speed check  on page 1363 to check 
Capacitance. It is not verified by online DRC  on page 1843.

• Impedance (ohm)  — displays a baseline impedance value of the net. This 
calculation uses the trace parameters, the board material values you set in 
the Layer Parameter Setup Dialog Box, and requires at least one adjacent 
plane to display values. A maximum of two adjacent planes are used in the 
calculation. If the plane layer is a split/mixed plane layer, you must have a 
plane shape on the layer. The location and outline of the shape and cutouts 
of the plane area are all ignored in the calculation.

You can set a Minimum and Maximum Impedance rule in the HiSpeed 
Rules Dialog Box, but it is only verified when you run Tools > Verify Design 
on page 1775 after you set up a High Speed check  on page 1363 to check 
Impedance. It is not verified by online DRC  on page 1843.

• Delay (ns)  — displays a baseline delay value of the net. This calculation 
uses the trace parameters, the board material values you set in the Layer 
Parameter Setup Dialog Box, and requires at least one adjacent plane 
to display values. A maximum of two adjacent planes are used in the 
calculation. If the plane layer is a split/mixed plane layer, you must have a 
plane shape on the layer. The location and outline of the shape and cutouts 
of the plane area are all ignored in the calculation.

You can set a Minimum and Maximum Delay rule in the HiSpeed Rules 
Dialog Box, but it is only verified when you run Tools > Verify Design  on 
page 1775 after you set up a High Speed check  on page 1363 to check 
Delay. It is not verified by online DRC  on page 1843.

Protect Routes Protects selected routes  on page 1855 or traces  on page 1867 from being 
moved. Similar to gluing components but you can allow protected traces to be 
edited by SailWind Router in the Routing Rules  on page 1666.
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Field Description

See also: “Route and Unroute Protection”.

Protect Unroutes Protects unrouted connections and the unrouted portions of partial routes  on 
page 1846. If you are in a routing mode, you will not be able to select the 
unroute to begin routing. If you select one of the pins of the pair, you will not 
be able to complete routing of the pin pair. If you attempt to finish the trace on 
the pin pair, you will only see a partial route-completion target  on page 1854
instead of the full route-completion target  on page 1854.
See also: “Route and Unroute Protection”.

Rules Data area Displays some rule information for the selected net.
• Class  — If the net is included in a Class rule, the Class name is displayed.

• Rule Hierarchy  — Displays one of the following from lowest priority to 
highest priority:

• “Default” is shown if the net is using the Default rules.

• “Class” is shown if the net is getting its rules from a Class rule. The class 
name will be shown immediately above.

• “Net” is shown if the net has its own rules.

• Trc/Trc Clearance  — Displays the Trace to Trace clearance value from the 
Clearance Rules Dialog Box. See the Rule Hierarchy above to determine if 
the value is from the Default, Class, or Net level rules. Conditional rules are 
not shown.

• Width  — Displays the Recommended Trace Width from the Clearance 
Rules dialog box.  on page 1167 See the Rule Hierarchy above to determine 
if the value is from the Default, Class, or Net level rules.

Trace Width Modifies the trace width. Type a new value in the box. You are restricted to 
the range of Trace widths you have specified in the Clearance Rules dialog 
box.  on page 1167 This option is unavailable if the Protect Routes checkbox is 
selected.

Rules button Opens the Net Rules Dialog Box  with the net preselected in order to apply Net 
Level rules.

Name: If one or more nets belonging to a single electrical net are selected, displays 
the name of the electrical net to which the selected net(s) belong.
If nets belonging to more than one electrical net are selected, no electrical net 
names are listed.
An electrical net name has a suffix of three caret symbols.

Create electrical net Select the check box to create an electrical net with one or more attached 
components.

 Tip
You can also set this check box (and create electrical nets) using the 
Create Electrical Net popup command for selected nets. See “Electrical Net 
Creation”  on page 338.

Clear the check box to remove any selected net that is part of an electrical net.
Clear both check boxes to exclude the selected nets from inclusion in any 
electrical net.
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Field Description

Allow electrical 
net creation by 
components

Select the check box to allow the selected nets to be included in electrical nets 
by:

• Specifying, in the Electrical Nets dialog box, the refdes prefix of the nets’ 
joining component, or

• Selecting the Create electrical net check box in the Component Properties 
dialog box.

Clear the check box to disable electrical net creation by component (including 
by refdes prefix).

 Tip
This check box is also cleared by the Disable Electrical Net Creation popup 
command for selected nets.
 Restriction:
Nets that have the Create electrical net check box selected are not disabled 
from electrical net creation by clearing this check box. Clear both check 
boxes to exclude the selected nets from inclusion in any electrical net.

Related Topics
Modifying Net Properties
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Net Properties Dialog Box - Design Reuse
To access: Select a reuse with nets > right-click > Properties  popup menu item > Net Properties  button

Use the Net Properties dialog box to resolve netname conflicts between netnames in a physical design 
reuse and netnames in the design.

Restriction:
You cannot rename and merge a net. For example, if you have GND in the physical design reuse 
and GND1 in the design, there is no available method to rename GND to GND1 and then merge. 
You must add GND and then manually merge the nets using ECO.

Description
Only netnames from route and polygon elements in the physical design reuse appear in this dialog box. 
Net properties are applied to route and polygon elements. For example, assigning a merge status for 
net GND merges all physical design reuse net and polygon objects using net GND with net GND in the 
design.

Objects

Field Description

Rename in Design (Private) Lists nets in the physical design reuse to rename in the design. Nets 
are renamed using the Rename Preferences settings.
If nets exist that should remain intact, and not be merged with nets in 
the design, place them in this list. These nets are called private nets 
because they are internal to the reuse and are not connected to other 
nets in the design, nor do they have the same netname.
If you want the net to be merged with a net in the design, move it to the 
Add/Merge in Design (Public) list.
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Field Description

Add/Merge in Design (Public) Lists nets in the physical design reuse to either add to the design 
(because the net does not exist in the design) or to merge with a net in 
the design (because the net does exist in the design). These nets are 
called public nets because they are used in both the physical design 
reuse and the design.
If you want the net to remain separate from the net in the design, move 
it to the Rename in Design list.

Net Append Options Indicates whether to rename a net using a prefix or a suffix. Affixes 
(prefixes and suffixes) can be up to four characters long. Illegal 
characters are brackets ({ }), asterisk (*), space, and period (.). You 
can, however, leave the box empty, and that is considered a valid 
entry.
The value you type here is checked against the design to ensure 
that duplicate netnames are not created. If duplicates occur, an error 
message appears and you can specify a different affix.

 Tip
If you are not in ECO mode when you access this dialog box from 
the Reuse Properties Dialog Box, the Net Append Options are 
unavailable.

Arrow Buttons Move selected nets between the list boxes. Click the >>> button 
to move selected nets in the Rename in Design (Private) list into 
the Add/Merge in Design (Public) list. Click the <<< button to move 
selected nets in the Add/Merge in Design (Public) list into the Rename 
in Design (Private) list. This is useful if you specifically want a net to 
remain separate from a net that exists in the design.
When you access this dialog box from the Reuse Properties Dialog 
Box, these buttons are unavailable. This prevents you from modifying 
physical design reuse nets. You can however, change the suffix and 
prefix for netnames if you are in ECO mode.

Related Topics
Reusing Designs or Parts of Designs
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Net Rules Dialog Box
To access: Setup  > Design Rules  menu item > Net  button

Use the Net Rules dialog box to define design rules that apply to nets.

Objects

Field Description

Nets list Lists all nets in the design.

Show Nets with rules Specifies to show only nets that have rules.

Clearance Opens the Clearance Rules Dialog Box.

Routing Opens the Routing Rules Dialog Box.

HiSpeed Opens the HiSpeed Rules Dialog Box.

Report Opens the Rules Report Dialog Box.

Picture below rule button The picture below each type of rule button identifies which rules 
hierarchy level is used for that rule type. The meaning of the picture 
corresponds to the button in the Hierarchy area of the Rules Dialog 
Box. For example, if you select a class in the Class list and a green 
polygon appears below the Clearance button, then the default values 
apply to the class.
See also: “Non-Default Rules Indicators”.

Selected Lists the net(s) selected in the Nets list.

Default Removes non-default rules from the selected nets, so that only default 
rules apply.
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Related Topics
Creating Net Design Rules

Resetting Net Rules to Default Rules

Design Rule Hierarchy
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Nudge Parts and Unions Dialog Box

Nudge Parts and Unions Dialog Box
To access: Automatic or Prompt mode must be set in the Nudge area of Tools  > Options  menu item > 
Design  category. Move a part or a union over another part or union. The dialog box opens.

Use the Nudge Parts and Unions dialog box to control the nudge process.

Objects

Field Description

Direction Indicates the direction you want to nudge the overlapping part.

Run Performs a nudge.

Skip Does not perform a nudge on the selected part and continues to the 
next overlapping part.

Back Returns to the last skipped part.

Undo Returns parts to their original positions, prior to nudging.

Related Topics
Nudge Overlapping Parts
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Object Attributes Dialog Box
To access: Select object(s) > right-click > Attribute  popup menu item

Use the resizable Object Attributes dialog box to add, modify, or remove attributes of single objects or 
multiple objects of the same type.

Objects

Field Description

Group Filters the Attributes list. You can choose an attribute group  on 
page 1811 to view.

Attributes for Specifies the attribute hierarchy level for which you want to assign an 
attribute. The hierarchy levels change, depending on the object you 
selected in step 1.
You cannot select a hierarchy level if you have multiple objects 
selected. The attribute is assigned at the current level; for example, 
if you select multiple parts, attributes are assigned at the Component 
level.

Attribute table Lists the attributes assigned to the object.

Edit Makes the selected cell available for editing.

Add Adds a row to the bottom of the list where you can select a new 
attribute for the object.

Delete Removes the selected attribute.
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Object Attributes Dialog Box

Related Topics
Design Object Attributes
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ODB++ Export Dialog Box
To access: Choose the File > Export  menu item and choose “ODB++ (*.tgz)” from the “Save as type” 
dropdown list; then click Save.

Use this dialog to export a design to an ODB++ file.

Tip
Virtual pins in the design are exported as vias.

Objects

Field Description

Export IPC-2581 Exports IPC-2581 standard data for assembly and fabrication. Creates 
the file <design name>.xml in the same location as the ODB++ .tgz file.

Neutralize Nets Renames nets numerically.

Prefer closed shapes Specify how to determine component outlines:
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ODB++ Export Dialog Box

Field Description

• Select to search for a closed shape to use as the component 
outline, beginning with the layer specified in the Component Outline 
Layer setting. If none is found on the Component Outline Layer, 
it then proceeds to layer 20, then layer 0 (all layers), then layer 1 
(mounted side). If no closed shape is found, it creates a bounding 
box of all shapes found.

• Clear this check box to just create a bounding box of all shapes that 
are found.

Format Choose the output format (v7 or v8) required by your manufacturer.
The v8 format contains the addition of impedance constraints from nets 
(layer, minimum and maximum impedance, and the impedance value).

Unhatched copper planes Specify what to do with unhatched copper planes:
• Fill  — Flood all copper planes before translating.

• Discard  — Discard unhatched copper planes.

This list is unavailable if there are no unhatched copper planes in the 
design. If you want unhatched copper planes, close and reopen the 
design.

Non Shape Pins Specify what to do with pins for which no pad shape is defined or when 
you do not want to use the defined pin shape. Non-shape pins are 
pins for which the design contains no pin definition, or for which the 
pin definition has zero shape or a very small shape of one or two basic 
units (one basic unit = 1/400,000 MM).
By default, when such a situation is encountered, the translator 
attempts to extract a pin shape from the padstack that is assigned to 
the pin. If there is no padstack, or if the shape based on the padstack is 
very small, the translator tries to use the shape of the padstack drill.
You can use parameter None Shape Pins to control how to generate 
shapes for non-shape pins, or to specify from which section of the file 
to take pin shapes.

• Discard  — Do not translate these pins. (Do not use this option for 
pins assigned to a net.)

• Add empty  — Translate these pins as-is (with no shape).

• Use Drill  — Use the drill shape as the pin shape.

• Use Stack  — Use the pad stack shape as the pin shape.

Specify what to do with pins regardless of whether a pad shape is 
defined:

• Prefer Drill  — Use the drill shape instead of the pin pad shape.

• Prefer Stack  — Use the padstack pad shape instead of the pin 
shape.

• Prefer Piece  — If the padstack pin contains associated coppers, 
use these instead of the pin shape.

Component Outline Layer Specify the preferred component outline layer.

Export action Choose an export action:
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Field Description

• Export only  — creates the .tgz  file that you specified.

• View generated ODB++  — creates the .tgz  file that you specified 
and loads your ODB++ data into the CAM Compare software to 
view the data.

• Perform CAM Compare  — creates the .tgz  file that you specified 
and loads both the ODB++ data and your CAM documents into the 
CAM Compare software to allow you to compare them.

 Tip
When the CAM Compare software is active, press the F1 key to 
open the CAM Compare help documentation.

Location of CAM file Specify the location of the CAM documents to use when comparing 
with the ODB++ data.

 Restriction:
This is only available when you select Perform CAM Compare as 
the Export action.

Related Topics
Exporting ODB++ Files
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Object Filter Dialog Box
To access: Open the SailWind 3D window (View  > SailWind 3D  menu item), click the PADS MCAD 

Collaborator  button  , then click the Object Filter  button 

Use this dialog to specify the objects to include in the change data files generated by MCAD Collaborator.

Figure 189.
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Objects

Field Description

Component Options section  — Defines the component elements to include in the change data files.

Write Mounting Holes Checked, include all component mounting holes.

Write Pin Holes Checked, include all component pin holes.

Replace 0 Height Components With: Defines a replacement value for zero height components.
• Top or Bottom Copper Thickness  — Checked, replaces 

the “0” height value for a zero height component with the 
thickness of the copper cladding on the top or bottom layer, 
depending on where the component is placed.

• Custom Height  — Defines a custom height value as 
a replacement for the “0” height value of a zero height 
component.

Board Options section  — Defines the board elements to include in the change data files.

Write Cutouts (Contours and 
Cavities)

Checked, includes all cutouts (contours and cavities).

Collaboration Objects Filter section  — Defines the Collaboration Data objects to include in the 
change data files.
Checked items are included in the generated data files.
Unchecked items are not included in the generated data files.

 Note:
The following additional objects (not shown in the list) are extracted if you check specific objects. If 
you check “Pads, Traces and Vias”, then fiducials are also extracted.
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Options Dialog Box, Design Category
To access: Tools  > Options  > Design  category

Use the Design category to specify place and route options.

Objects

Field Description

Stretch traces 
during component 
move

Specifies whether to reroute traces, or create an unroute, for nets connected to 
the moved, or pin-swapped part.

• Select the check box to create new routes between tacks at the old pin 
positions and the new pin positions after you complete the move.

• Clear the check box to create an unroute connection after swapping pins or 
moving a part.
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Field Description

See also: “Moving Items With Stretch Traces During Component Move”

Move preference 
area

Specifies which, of various locations on the part being moved, should attach to 
the pointer:

• Move by origin  — Pointer attaches to the part origin.

• Move by cursor location  — Pointer attaches to the part from its current 
location. Example: If you start the Move operation with the pointer at 
X=200,Y=500 and the selected part at X=0,Y=0, move the pointer to 
X=1200,Y=1500, the part moves to X=1000,Y=1000.

• Move by midpoint  — Pointer attaches to the center of a rectangle enclosing 
the part.

 Tip
While you are moving the part, you can modify the pointer attachment 
location from the following shortcut menus:

• Move in the Layout Editor

• Move Sequential in the Layout Editor

• Move Terminal in the PCB Decal Editor

• Radial Move in the Layout Editor and the PCB Decal Editor

Nudge area Specifies how to use nudge  on page 500 to prevent parts from overlapping when 
you finish moving the part or using the Tools > Nudge Component command.

• Automatic  — Nudge automatically moves apart overlapping parts when you 
finish moving the part.

• Prompt  — Opens the Nudge Parts and Unions Dialog Box  for each 
overlapping part when you finish moving the parts, enabling you to control the 
nudge operation.

• Nudge Off  — Disables nudge.

Length minimize 
area

Specifies when to recalculate, or minimize, unrouted net lengths when moving 
parts.

• During Move  — Recalculate length of unrouted pin pairs as you move a part. 
The closest viable connections are displayed in progress.

• After Move  — Recalculate length of unrouted pin pairs when you finish a 
move. This option consumes less display memory.

• Off  — Do not recalculate length of unrouted pin pairs.

 Tip
To specify the topology type (which determines length recalculation behavior) 
per net, per class, and so on, use the Routing Rules Dialog Box.

Group editing area Specifies selection and editing options for multiple object operations.
• Keep signal and part names  — Maintains signal and part names when you 

insert data using Edit menu > Paste. When items are copied to a new .pcb 
database you can set Keep Signal and Part Names to retain the netnames of 
traces and the reference designators. However, if you paste into an existing 
design and these netnames or reference designators already exist, incoming 
netnames or reference designators are sequentially updated. The default is 
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Field Description
to automatically generate new default reference designators and netnames 
when you paste to a new file.

• Include traces not attached  — Selects all traces passing through the 
selection rectangle, even if they do not connect to any parts within the 
selection rectangle.

• Keep stitching vias  — Prevents the deletion of stitching vias, or free vias.
 Tip
This option distinguishes between stitching vias and regular routing vias. 
When this check box is selected, stitching vias are preserved during the 
following operations:

• ECO delete connection  on page 829, delete component  on page 829, 
swapping a pin  on page 839, swapping all pins  on page 838, change 
component  on page 826

• Unroute

For operations related to ECO, this option is respected whether they are 
performed interactively or by an ECO import operation. In general, this option 
is respected by any ECO operation that deletes traces and vias.

When the this check box is cleared, stitching vias may be deleted during the 
operations listed above.

• Apply reuse Ref Des placement  — When using Make Like Reuse, the 
properties of the reference designators match the reuse definition instead 
of the properties of those existing in the design. All properties of a reference 
designator are matched to the reuse - the location, font style, height, width, 
rotation, number of labels, layers on which they are placed, and so on.

Line/trace angle 
area

Specifies angle options when adding or moving a line or trace (corner, or pad 
entry/exit).

• Diagonal  — Angle must be 45 degrees or a multiple of 45 degrees.

• Orthogonal  — Angle must be 90 degrees or a multiple of 90 degrees.

• Any Angle  — No angle restriction.

Miters area • Diagonal Miter  — Create miters as lines at 45-degree angles.

• Arc  — Create miters as arcs.

• Auto miter check box  — Creates miters automatically while adding drafting 
objects (for example, 2D lines and copper). To auto miter traces with 90 
degree corners, you must select pin pairs or nets, right-click and click the Add 
Miters  popup menu item.

• Ratio  — Affects the size of a diagonal miter or the radius of an arc miter.
 Tip

• For diagonal miters, in the case of drafting items, the distance from the 
virtual corner to either of the breakpoints is created by the Ratio multiplied 
by the drafting line width. For example, a 10-mil line and a ratio of 5 
produces a 45-degree angle 50 mils apart from the virtual corner. For 
angles less than 90 degrees, the distance becomes longer. For angles 
greater than 90 degrees, the distance becomes shorter.

In the case of traces the distance from the virtual corner to either of the 
breakpoints is created by the Ratio multiplied by half the trace width. For 
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Field Description
example, a 10-mil trace and a ratio of 5 produces a 45-degree angle 25 
mils apart from the virtual corner.

• For arc miters, the radius is set to the ratio multiplied by half the trace 
width. For example, a ratio of one sets the arc radius equal to the half the 
trace width. Also, a 10-mil trace and a ratio of 5 produces a radius of 25 
mils.

• Angle  — Specifies the maximum corner at which miters are created.

On-line DRC area Specifies the response to design rule errors.
• Prevent Errors  — Prevents you from violating design rules.

• Warn Errors  — Prompts you with a warning when you try to violate the 
design rules, but does not prevent you from placing the part.

• Ignore Clearance  — Ignores clearance design rules - allows parts to touch 
but not overlap each other.

• Off  — Disables design rule checking. You can violate design rules.
 Tip
If you use the Layout Editor without Design Rule Checking (DRC) 
enabled, use Verify the Design  to check the design in progress for 
clearance violations.

See also: “Design Rule Checking.”

Drill oversize Type a value to globally apply an oversize to plated holes. Since hole sizes are 
finished size with plating, the drill oversize value is required to verify against 
design rules to ensure that the larger holes drilled during manufacture are not 
going to cause problems. Clearance, and Latium Design Verification checking 
use the value.
This value is ignored if Single-sided board is selected on the Layers Setup Dialog 
Box.

 CAUTION:
The Drill oversize value does not apply to the Drill Drawing table, or NC 
Drill outputs - those values are finished hole sizes. The value affects copper 
plane flooding clearances, based on the drill-to-copper clearance and its 
CAM output (if the “Use design rules for thermals and antipads” setting is 
enabled in the Copper Planes  category > Thermals  subcategory). Your 
PCB fabricator normally oversizes plated holes to match the drill size that 
you specify in the pad stacks (finished hole size). Your PCB fabricator may 
also increase the apertures of antipads in pour areas using pre-production 
software and you may need to disable the drill oversize value after you have 
verified your design is production ready and you are ready to create your 
gerber files.
 Tip
The oversize is measured from the center of the pad, not the perimeter. For 
example, a 3 mil oversize represents 1.5 mils in all directions from the center 
of the pad.

For more information, see the Drill Size and Plated settings in the Pad Stacks 
Properties Dialog Box.

Laser drill oversize Type a value to globally apply an oversize to partial vias that will be laser drilled. 
Partial vias are set as laser drilled in the “Pad Stacks Properties Dialog Box”  on 
page 1566. See the “Drill oversize” description for more information.
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Options Dialog Box, Die Component Category
To access: Tools  > Options  > Die Component  category

Use the Die Component category to specify die part creation and modifying options.

Note:
This information applies only to the BGA toolkit.
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Objects

Field Description

Create die data on layers area Specifies on which layers to create new die decal items, which are 
represented as decal drawings. Choose the layer for the die outline 
and pads, the wire bonds, and the substrate bond pad guides.

Wire bond editor area
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Snap SBP to Guide Enables snap-to-guide mode when moving substrate bond pads.
If selected, the position of the SBP will automatically snap to the 
nearest SBP Guide if it is within the distance specified in Snap 
Threshold. This enables snap-to-guide mode when you are moving 
substrate bond pads.
If you are moving multiple SBPs, each SBP is snapped to the 
nearest guide independently.

Snap threshold Specifies the distance in current design units at which a moved 
substrate bond pad snaps to the nearest substrate bond pad 
guide. Snap SBP to guide does not work above this value. The 
threshold value applies to all SBP guides for all die components in 
the design.

Keep SBP focus Automatically rotates the substrate bond pad to match the direction 
of the wire bond.

Show SBP clearance If selected, the clearance outline is added to the display, showing 
the clearance area that must exist between two SBPs. This 
shows the SBP clearance outline around moved substrate bond 
pads when you are moving, adding  on page  , spinning  on 
page 1861 SBPs, or adding fanouts  on page  . The clearance 
value is derived as follows:

• If the SBP is not part of a design net, or if its net and pin pair 
do not have specific rules defined, then the SMD to SMD 
clearance is used from the Default Rules hierarchy.

• If the SBP layer has a specific clearance rule set under layer 
rules, then the specific SMD to SMD rule is used. For more 
information, see “The Formatting for Conditional Clearance 
Rules in the ECO File”.

• If the SBP is part of a design net, and the related net class, net, 
group, or pin pair has a specific clearance rule set, then the 
specific SMD to SMD rule is used.

• If the net class, net, group, or pin pair has a layer-specific 
clearance rule set, then the clearance assigned to the SBP 
layer is used.

The SBP clearance outline appears in both DRC On and DRC 
Off modes. For more information, see Design Rule Checking”.

Show wire bond length angle If selected, the length of the wire bond and the size of the wire 
bond angle appear on the display as WB Length and WB Angle, 
and change dynamically when you are moving, adding  on 
page  , spinning  on page 1861 SBPs, or adding fanouts  on 
page   or wire bonds  on page  .
If you are moving multiple SBPs, WB Length and WB Angle 
appear only for the first selected SBP.
If the SBP has no attached wire bond, the text does not appear. If 
the SBP has several wire bonds, the displayed values apply only to 
the first wire bond in the database.
WB Length and WB Angle appear in both DRC On and DRC Off 
modes.
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Related Topics
Moving a Substrate Bond Pad in the Layout Editor

Adding Substrate Bond Pads

Spinning a Substrate Bond Pad

Adding Wire Bonds
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Options Dialog Box, Copper Planes Category, 
Hatch and Flood Subcategory
To access: Choose the Tools > Options  menu item > Copper Planes  category >

Use the Hatch and Flood  subcategory to view and edit options for copper planes.
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Objects

Field Description

Hatch View area Specifies the display of the hatching. Choose from:
• Normal  — Display hatching.

• No Hatch  — Remove hatching.

• See Through  — Display hatching with non-intersecting lines.

Hatch Direction area Specifies the hatch orientation in the workspace. Choose from:
• Orthogonal  — Hatching consists of vertical and horizontal lines.

• Diagonal  — Hatching consists of diagonal lines.

• Reverse for keepout  check box — Distinguishes keepout hatching 
from all other hatching by reversing the orientation. Example: If this 
option is enabled and the hatch orientation is Orthogonal, hatching for 
keepout areas is diagonal.

Autohatch on file load Hatches the copper planes automatically when you load the file. If you 
do not enable this feature, you must apply hatching through the Copper 
Plane Manager each time you open the file.

Flood area

Min. hatch area Specifies the square root, in current design units, of the minimum hatch 
outline area - the smallest island area created by flooding. Any areas that 
are smaller do not flood.
Example: If you do not want to display islands smaller than 9 square 
design units, type 3 into the box.

Smoothing radius Controls the radius of copper plane corners.
<corner radius> = <shape outline width> * <smoothing radius>
The smoothing radius parameter can be set between 0 and 5.

Display mode area • Pour Outline  — Display the copper plane outline with no hatching

• Hatch Outline  — Display the copper plane outline and hatching

 Note:
If you attempt to flood a copper plane with a Hatch outline, you 
are warned, “To generate new thermals turn off hatch display prior 
to flooding.” You must change the outline to a Pour outline before 
flooding.

Auto separate gap Specifies the plane-to-plane gap used by the “Auto Separate”  on 
page 683 command and when “generating a copper plane from the board 
outline”  on page 668.

 Tip
The default value is the Board-to-Trace clearance.

Remove isolated copper Specifies to automatically remove isolated copper areas, which are areas 
not connected to nets, during the flood operation of copper planes.
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Field Description

Create cutouts around 
embedded copper planes

Automatically creates cutouts around copper planes if the copper plane is 
placed inside another.

 Tip
The cutout is combined with the external area.

Save to PCB file Use these options to specify whether to save various forms of copper 
plane data in the design file.

• Copper Plane polygon outlines  — Saves only the mixed plane area 
polygons in the SailWind Layout file. Discards generated thermals and 
antipads. Saving only the plane polygon outlines results in a smaller 
SailWind Layout file and a faster design load time.

• All copper plane data  — Saves all data associated with mixed 
planes in the SailWind Layout file.

 Note:
The fill or hatching of copper planes is never saved in the design file.

Prompt to discard plane 
data

Specifies to display the Discarding Plane Data dialog box every time you 
save the design.

 Tip
This option is unavailable if the “All copper plane data” option is 
selected.

Enable dynamic copper 
healing in SailWind Router

Opens the design in SailWind Router with the dynamic copper healing 
feature enabled automatically.
Dynamic copper healing displays real-time edits you make to copper 
flooding in SailWind Router, such as changes to clearances around 
pads, vias, and other objects. Refer to the SailWind Router Help for more 
information.
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Options Dialog Box, Copper Planes Category, 
Thermals Subcategory
To access: Choose the Tools > Options  menu item >

Use the Copper Planes  category > Thermals  subcategory to specify options for copper planes that 
SailWind Layout automatically generates for existing plane outlines.

Note:
Some of these options only apply to copper planes when there are no custom thermals in the pad 
stack or when the “Use design rules for thermals and antipads” check box is selected.
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Objects

Field Description

Thermal Shape/Size Table  — Drilled thermal settings are for through hole pad stacks and SMT 
thermals are for surface mount or any non-drilled thermal.

Width Specifies the line width for the thermal relief in current design units.

Min. Spoke Specifies the minimum number (1-4) of spokes.

 Tip
If the pad intersects the boundary of a copper plane, it may not 
be possible to create all four spokes. A warning appears when 
thermals are created with fewer spokes than the minimum.

Pad shapes - Round, Square, 
Rectangle, Oval

Specifies the shape of the thermal relief: Round, Square, Rectangle, or 
Oval

Relief Shape • Orthogonal  — Creates orthogonal-shaped thermal reliefs.

• Diagonal  — Creates diagonal-shaped thermal reliefs.

• Flood Over  — Creates thermal reliefs that flood over the pad. You 
can also configure the copper plane to flood over vias.

See also: “Flood and Hatch Options Dialog Box”.

• No Connect  — Creates no thermal reliefs.

Add thermals to routed 
component pads

Enables you to place thermals on routed pads. Thermals are normally 
generated only on unrouted pads, and vias.

 Tip
Small left-over trace segments attached to a pad prevents a pad 
from receiving thermals if the Routed Pad Thermals option is not 
enabled. Set the Selection Filter to Traces, Corners, and Tacks to 
select and remove trace segments attached to the pad.

Show general copper plane 
indicators

Enables the display of a general copper plane thermal indicator if a 
connection to a CAM or split/mixed plane exists somewhere within a 
pad stack. The physical appearance of this indicator resembles a small 
x in the center of the pad. Disable this option if you do not want to view 
indicators.

 Tip
• General copper plane indicators are independent of the current 

layer. For example, the actual indicator may not be on the current 
layer, but on one or more internal layers of the pad stack.

• General copper plane indicators can sometimes be covered during 
editing. Redraw the screen to view all of the indicators.

Update unroute visibility Makes unroutes invisible when a connection is made to the split/mixed 
plane.

Update thermal indicator 
visibility

Updates the plane thermal indicator visibility status of pads.
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Field Description

Remove unused pads Removes unused pads and replaces them with antipads. All pads are 
removed on all internal “No Plane” and “Split/Mixed” layers unless 
the pin is connected to a trace or a copper plane on that layer. Prior 
to PADS VX.2.4, unused pads were removed only from “Split/Mixed” 
layers.

 Tip
CAM planes using custom antipads defined in the Pad Stacks 
require this setting, otherwise the default antipad setting is used 
instead.

Preserve via pads on start 
and end layers

For partial vias, specifies to not remove the Start pad or End pad if the 
pad is on a plane layer.

 Tip
This check box is unavailable if Remove Unused Pads is disabled.

Use design rules for thermals 
and antipads

When flooding a plane, specifies to use the hierarchical Pad to Copper 
clearance rule for thermals and the Drill to Copper clearance rule for 
antipads.

 Tip
• Enabling this option ignores the outer width/diameter/size settings 

for custom thermals and the width/diameter/size settings for custom 
antipads. Also, the external outlines of thermals and antipads are 
not displayed.

• This option does not affect custom thermals for which the 
outer width/diameter/size is less than, or equal to, the inner 
width/diameter/size in the flood over settings.

Related Topics
Customizing Design Rule Thermals

Flood Over Pads in a Copper Plane
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Options Dialog Box, Dimensioning Category, Alignment and Arrows Subcategory

Options Dialog Box, Dimensioning Category, 
Alignment and Arrows Subcategory
To access: Tools  > Options  menu item >Dimensioning  category > Alignment and Arrows 
subcategory

Use the Alignment and Arrows  subcategory to specify the appearance of dimensioning alignment tools 
and arrows. Options in this subcategory affect the appearance of text, lines, and so on, used to show 
clearances.
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Objects

Field Description

Preview type Specifies the way the image is shown in the Preview area. You 
have the choice of:
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Field Description

• Horizontal

• Vertical

• Aligned

• Angular

• Circular

Alignment tool area

Specifies the shape of the dimensioning alignment tool appears on 
the screen. Choose any combination of these shapes.

Size Specifies the alignment tool shape length or diameter in screen 
pixels.

Line Width Specifies the alignment tool line width in screen pixels.

Arrows area

Specifies how dimensioning arrows appear on the screen.

 Tip
The right-most shape represents datum lines. With datum lines, 
no arrows are drawn and the dimensions are placed above the 
extension line. Datum lines are created when using Baseline 
Dimensioning.

Arrow Length Specifies the distance between the arrow tip and the end of the 
arrowhead.

 Restriction:
Unavailable for Datum Lines.

Arrow Size Specifies the width of the arrowhead.

 Restriction:
Unavailable for Datum Lines.

Tail Length Specifies the minimum length of the arrow tail.

 Restriction:
Unavailable for Datum Lines.

Line Width Specifies the width of the tail and arrow lines.

 Restriction:
Unavailable for Datum Lines.

Text Gap Specifies the distance between the tail, which is the line extending 
behind the arrowhead, and the measurement text.

 Restriction:
Unavailable for Datum Lines.
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Options Dialog Box, Dimensioning Category, 
General Subcategory
To access: Tools  > Options  menu item >Dimensioning  category General  subcategory

Use the General  subcategory to specify the layers used to display dimensioning text and lines, the 
appearance of extension lines, and how to measure circles. Options in this subcategory affect the 
appearance of text, lines, and so on, used to show clearances.
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Objects

Field Description

Preview type Specifies the way the image is shown in the Preview area. You 
have the choice of:

• Horizontal

• Vertical

• Aligned

• Angular

• Circular

Layers area Specifies the layers to use for dimensioning text and lines.

 Tip
• Dimensioning items ignore the current layer set in the Layer list 

on the Standard Toolbar, so you must specify layers here.

• Use the Dimension Properties dialog box to reset the layer for a 
selected dimension object or any of its dimension elements.

• Items placed on layer 0 appear on all layers.

Extension lines area

Draw 1st Specifies that you want to display an extension line for the first 
point you select.

Draw 2nd Specifies that you want to display an extension line for the second 
point you select.

Pick gap Specifies the distance between the selection point and the tip of 
the extension line. All numerical values are in current design units.

Arrow offset Specifies the overhang of the extension line beyond the 
arrowhead. All numerical values are in current design units.

Width Specifies the width of the extension line. All numerical values are 
in current design units.

Circle dimension area Specifies the circle measurement method you want.
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Options Dialog Box, Dimensioning Category, 
Text Subcategory
To access: Tools  > Options  menu item >Dimensioning  category Text  subcategory

Use this subcategory to specify the appearance of dimensioning text that denotes clearances in your 
design.
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Objects

Field Description

Preview type Specifies the way the image is shown in the Preview area. You 
have the following choices:

• Horizontal

• Vertical

• Aligned

• Angular

• Circular

Setting parameters area

Height Specifies the height of text characters.

Line Width Specifies the width of one character.

Suffix Specifies the suffix characters that follow the dimensioning 
measurement.

Precision area

Linear Specifies linear measurement precision: type the number of 
decimal places, in current design units.

Angular Specifies angular measurement precision: type the number of 
decimal places, in degrees.

Default orientation area Specifies how you want to orient the dimensioning text relative to 
the screen or to the dimensioning arrows.

• Horizontal  — Orient text horizontally on the screen, regardless 
of the arrow angle.

• Vertical  — Orient text vertically on the screen, regardless of the 
arrow angle.

• Same As Arrows  — Orient text parallel to the arrows.

Default position area Specifies to position text outside the extension lines, or inside the 
extension lines if possible.

Displacement area

Manual Position Specifies to position text manually, by attaching the text to the 
pointer when you add the dimension.

Omit Text Specifies to create dimensioning lines and arrows without 
displaying dimensioning text.

Displacement Specifies to position text relative to the arrow axis. You have the 
following choices:
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Field Description

• Above  — Position text above the arrow axis.

• Centered  — Position text on the arrow axis.

• Below  — Position text below the arrow axis.

• Custom  — Position text at the position you specify.

Zero centers the text, positive numbers place the text above the 
arrow, and negative numbers place the text below the arrow.
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Options Dialog Box, Display Category
To access: Tools  > Options  menu item > Display  category

Use this category to set the text size of displayed net names and pin numbers, and the maximum 
allowable gap between net names on traces.

Objects

Field Description

Minimum Specifies the minimum size of displayed net names and pin numbers, 
in pixels.

Maximum Specifies the maximum size of displayed net names and pin numbers, 
in pixels.

Maximum gap between net 
names on traces, pixels

Specifies the maximum allowable gap between displayed net names in 
traces, in pixels.
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Tip
The display of net names is controlled by the Net Name column check box, by the color tiles on 
each layer, and the Show net names on Traces, Vias, Pins check boxes in the Display Colors 
Setup Dialog Box.
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Options Dialog Box, Global Category, Backups 
Subcategory
To access: Tools  > Options  menu item > Global  category > Backups  subcategory

Use this subcategory to specify design data backup options.
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Objects

Field Description

Automatic backups area

Interval (minutes) Specifies the time in minutes between backups.

Number of backups Specifies the quantity (1-9) of different backup files to create.

Backup file Opens the Backup File dialog box where you can change to folder 
or name of the backup file.
By default, backup files are named <design_name>.#, where # is 
a sequential number. For example, Layout1.pcb, Layout2.pcb, and 
so on.

Use design name in backup file 
name

Specifies to use the design name in your backup file name. Click to 
clear if you want to use Layout as the file name.

Create backup files in design 
directory

Specifies to place all of your backup files in the same directory 
as the design. Click to clear if you want your backup files in one, 
common backup directory.
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Options Dialog Box, Global Category, File 
Locations Subcategory
To access: Tools  > Options  menu item > Global  category > File Locations  subcategory

Use this subcategory to specify default design file location options.
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Objects

Field Description

File Type Specifies the type of file for which to set the location.

Location Specifies the location of the corresponding file type.
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Options Dialog Box, Global Category, General 
Subcategory
To access: Tools  > Options  menu item > Global  category > General  subcategory

Use this subcategory to specify various workspace and design unit options.
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Objects

Field Description

Cursor area

Style Specifies the pointer shape. Choose from:
• Normal  — Arrow

• Small cross  — Small plus sign +

• Large cross  — Large plus sign +

• Full screen  — Full screen crosshair

Pick radius Specifies the selection accuracy - the maximum distance in pixels 
that the pointer can be from an object and still select it.
Larger values mean the pointer can select objects further away, 
but this can cause you to select incorrect objects.

Diagonal Specifies to rotate the pointer shape diagonally, so that it 
resembles an x instead of a plus sign +.

 Restriction:
This option is unavailable for the Normal pointer shape.

Disable double click Specifies to disable double-click operations, such as adding vias, 
opening the Properties of objects, or completing a drafting object 
polygon.

Drag moves area Specifies the behavior when you try to drag objects with the 
pointer.

• Drag and Attach  — Attaches the object to the pointer when 
you click it and begin to drag it. While the object is attached 
to the pointer, release the left button and move the object to 
the new location. Click to finish the move. After placement the 
object remains selected.

• Drag and Drop  — Same as Drag and Attach, but the move is 
finished when you release the left button.

• No Drag Moves  — Prohibits drag type moves.

 Tip
• Because it is possible to accidentally start a move sequence 

when performing an area select, enable No Drag Moves to 
make area selection in dense areas of the design.

• When No Drag Move is enabled, you can move the selected 
object: Right-click, click the Move  popup menu item, move the 
object to the new location, and click to finish the move.

Drawing area

Keep same view on window resize Specifies to maintain the area view of the design when you resize 
the SailWind Layout window, by automatically zooming in or out.
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Field Description

Active layer comes to front Specifies to display the active layer on top of all other layers.

 Tip
Specify the active layer in the Layers list on the Standard 
Toolbar.

Minimum display width Specifies the minimum width in current design units of lines you 
want to draw at actual width. Lines smaller than this width are 
drawn only as center lines to save memory and redraw time.

 Tip
• Set this value to zero to display all lines at actual width.

• Set this to a value larger than the trace width. This displays 
traces as center lines and makes selecting small trace 
segments easier. Use this in combination with a reduced Pick 
radius value for optimal results.

OLE Document Server area

Display OLE objects Specifies to display linked or embedded objects inserted in 
SailWind Layout.
You may want to disable this option to decrease redraw times 
when SailWind Layout contains many linked or embedded objects.

Update on redraw Specifies to update the linked or embedded object in the container 
application.

 Restriction:
This option applies only when you are modifying the SailWind 
Layout object in a separate window and you click the Redraw 
button in the separate window.
 Tip
To increase performance, disable this option.

Draw background Specifies to draw the SailWind Layout background color in the 
linked or embedded object.
When this option is disabled, the background of the SailWind 
Layout object is transparent and you can see through the object at 
the container application's background.

Text encoding area Specifies the language you want.
Text encoding determines how text characters are interpreted. 
Each character in any text string has a unique digital signature. 
Within each system font are graphics (for instance, an image of 
the letter A) associated with each digital signature. Most system 
fonts have multiple images for the same character in order to 
accommodate regional differences in font styles.

 Tip
Changing the text encoding option may result in blank spaces 
or non-printing characters.

Example: When you load a design created in Japan with Japanese 
text encoding on an American system, the file may have text 
encoding set to Japanese. If you change it from Japanese to 
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Field Description
English, Japanese kanji characters may be interpreted (and 
displayed) as non-printing characters.

 Restriction:
The default text encoding cannot be changed. It is 
automatically set by the Regional and Language settings of the 
operating system.

Design units area Specifies the design measurement units.
• Mils  — 1/1000 of an inch, accurate to 2 places after the 

decimal

• Metric  — 1mm (1/1000 of a meter), accurate to 5 places after 
the decimal

• Inches  — accurate to 5 places after the decimal

Designs typically contain a mixture of metric and English 
(imperial/inch) components. And depending on the ratio 
of components in your design, you may want to use one 
measurement instead of the other. You can also switch design 
units as often as you like. This is done smoothly and efficiently 
since the accuracy of each unit of measure is the same.
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Options Dialog Box, Global Category 
Synchronization Subcategory
To access: Tools  > Options  menu item > Global  category > Synchronization  subcategory

Use this subcategory to specify the SailWind Layout and SailWind Router synchronization options
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Objects

Field Description

Layout and Router Synchronization area
See also: “Synchronization Mode”.

Enable Specifies to turn Layout and Router Synchronization mode on. 
Click to clear to turn Synchronization mode off.

 Note:
Warning: You must restart Layout for the change in 
Synchronization mode to take effect.

Restore DRC mode on return Specifies, if you return to SailWind Layout from SailWind Router 
after switching, to change the DRC mode back to what you had 
before you switched: DRC Prevent, Warn, or Ignore.

 Tip
• Switching to SailWind Router automatically places your 

design in SailWind Layout in DRC Off mode; the DRC mode in 
SailWind Router is not affected.

• Depending on the size of your design, restoring the DRC mode 
may take a few minutes; therefore, it is recommended to not 
restore your DRC mode upon return.

Warn about switching to DRC Off 
mode

Specifies to show a warning to remind you that Synchronization 
mode puts SailWind Layout into DRC Off mode.
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Options Dialog Box, Grids and Snap Category, 
Grids Subcategory
To access: Tools  > Options  menu item > Grids and Snap  category > Grids subcategory

Use this subcategory to specify grid options.

Objects

Field Description

Design grid area Establishes the minimum snap distance for the pointer when 
editing (placing objects, drawing/editing drafting objects). The 
current Design grid settings appear to the right of the Status bar 
but when you move an object or use a drafting command, the grid 
readout is replaced by a Delta X and Y reading, calculated from 
the cursor selection point when the command starts. Negative 
numbers indicate left and down.
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Field Description

The design grid is based on the origin. If you move a part across 
the board during design, the cursor may move smoothly but with 
Snap to Grid enabled, the part snaps from grid point to grid point 
and you cannot place a part off the design grid.

• X  — Specifies the distance between grid lines on the X axis in 
current design units.

• Y  — Specifies the distance between grid lines on the Y axis in 
current design units.

• Snap to grid  — Specifies to snap objects from grid point to grid 
point, instead of freely and smoothly as you move or place the 
object. If the Snap to Grid check box is selected, you cannot 
place a part off the grid.

See also: “Setting the Design Grid”.

Via grid area Controls the initial placement of vias. If you move a via after initial 
placement, the Design grid is used.

• X  — Specifies the distance between grid lines on the X axis in 
current design units.

• Y  — Specifies the distance between grid lines on the Y axis in 
current design units.

• Snap to grid  — Specifies to snap objects from grid point to grid 
point, instead of freely and smoothly as you move or place the 
object. If the Snap to Grid check box is selected, you cannot 
place a via off the grid.

Fanout grid area Controls the placement of substrate bond pads on a die and the 
placement of fanout vias.

 Restriction:
This data is not used within SailWind Layout but is only passed 
to SailWind Router.

• X  — Specifies the distance between grid lines on the X axis in 
current design units.

• Y  — Specifies the distance between grid lines on the Y axis in 
current design units.

• Snap to grid  — Specifies to snap objects from grid point to grid 
point, instead of freely and smoothly as you move or place the 
object.

Snap to test point grid Enable snap to test point grid in SailWind Router.

Display grid area Specifies the visible dot grid - a field of white dots that is a valuable 
drafting aid. Set the display grid to either match the Design grid or 
at larger multiples of the Design grid.

• X  — Specifies the distance between grid lines on the X axis in 
current design units.

• Y  — Specifies the distance between grid lines on the Y axis in 
current design units.
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Field Description

 Tip
If you want to make the dot grid invisible, set the X and Y 
values to 0.

See also: “Setting the Display Grid”.

Hatch grid area Specifies the distance between hatch lines of copper and keepout 
areas. The hatch grid, when combined with the line width, is used 
to create varying degrees of hatch through to a solid pattern. For 
more information, see “The Fill of Copper, and Copper Planes”  on 
page 617.

• X  — Specifies the distance between grid lines on the X axis in 
current design units.

• Y  — Specifies the distance between grid lines on the Y axis in 
current design units.

Radial Move Setup Opens the Radial Move Setup Dialog Box  to specify the polar grid 
for radial moves. See also: “Setting Up a Polar Grid”.
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Options Dialog Box, Grids and Snap Category, 
Object Snap Subcategory
To access: Tools  > Options  menu item > Grids and Snap  category > Object Snap  subcategory

Use this subcategory to specify options for “snapping to” various objects when creating or modifying 
drafting shapes, placing components, or using the Q modeless command (Quick Measure).
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Objects

Field Description

Snap to objects Snap to the specified object type(s) instead of to the grid.

 Tip
You can use the OS modeless command  on page 83 to toggle 
this setting.

Object type Indicates the object type(s) to snap to:
• Corner  — corner of a drafting shape or line end.

• Center  — center of a circle or an arc

• Intersection  — cross point of two lines or arcs

• Midpoint  — midpoint of a line or arc

• Quadrant  — four orthogonal points on a circle or arc

• Component origin
• Pin/via origin

You can use the OS <n> Modeless Commands  to set the object 
types.

Show markers Specifies to show the object type markers in your design as your 
pointer enters the Snap radius:

• Corner  — 

• Center  — 

• Intersection  — 

• Midpoint  — 

• Quadrant  — 

• Component origin  — 

• Pin/via origin  — 

Snap radius Specifies the radius of the “searching area” around the cursor in 
which snapping points are activated. Uses current Design units  on 
page 1531.
You can use the OSR modeless command  on page 83 to specify 
this value.

Related Topics
Object Snap

Set Values Before Creating a Drafting Object
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Options Dialog Box, Routing Category, 
General Subcategory
To access: Tools  > Options  menu item > Routing  category > General  subcategory

Use this subcategory to specify routing options.
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Objects

Field Description

Options area

Generate teardrops Specifies to automatically create teardrops to existing and new 
trace segments that enter or exit a pad or via.

Show guard band If On-line DRC is set to prevent, specifies to display an octagon 
shape at the tip of the current route to illustrate a clearance 
violation.

Highlight current net When you start routing the selected pin pair, specifies to highlight 
the net with a complementary color.

Show drill holes Specifies to display the inside diameter of all pads. The modeless 
command “DO” toggles this setting. The drill hole is given a 
complementary color.

Show tacks Specifies to display tacks on routes.

 Tip
If displayed tacks hinder routing or viewing the design, disable 
this option.

Show protection Specifies to display protected routes as outlines when Outline View 
Mode  is off, and as normal traces when Outline View mode is on.
In the image below, the left-most trace is 
protected and the other traces are not protected. 

Show test points Specifies to display test points.
When the via or pin is flagged as a test point, an arrow is drawn on 

it in the design:
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Field Description

Lock test points Specifies to prevent moving test points when moving components.
Locked test points are not deleted when you do any of the 
following:

• Unroute pin pairs or nets

• Delete trace segments, vias, or jumpers

• Change the layer for a segment

Show trace length Specifies to display the trace length monitor at the pointer. The 
status bar always reports trace length.

 Tip
• You can also use the shortcut key combination Ctrl+PageUp to 

toggle the display the trace length monitor.

• Displaying or hiding the trace length monitor with the modeless 
command does not end the current routing command, so you 
can continue to route.

Auto protect traces Specifies to protect traces from smoothing, stretching, moving, 
shoving, or ripup operations.
This option affects manual routing (Route or Add Route command) 
and dynamic routing.

Any angle pad entry Specifies to allow traces to enter or exit a pad at any angle, despite 
the current Line/trace angle setting on the Design Options  tab.

Layer pair area Specifies the pair of layers to use for routing when manually 
adding vias.
See also: “The Layer Pair”, “Layer Changes While Routing”.

 Tip
• When you add a via while manually routing, the layer 

automatically switches to the other layer in the layer pair.

• If you specify the layer pair as the two layers on which you 
expect to do most of your routing, you can reduce the number 
of times you manually specify layers when adding a via.

• If the current layer is not in the layer pair when adding a via, the 
layer automatically switches to the layer specified in the First 
list.

Unrouted path double click area Specifies a routing operation to start when you double-click 
unroutes.

• Dynamic Route  — Start a dynamic route

• Add Route  — Start a manual route

 Restriction:
These options are unavailable unless On-line DRC is set 
to Prevent Errors in the Design options (or using the “DRP” 
modeless command.
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Field Description

Smoothing control area

Smooth bus route traces Specifies to run smoothing after bus routing.
This option affects only the Bus Route command, and it inhibits the 
global smoothing pass for all traces of the current bus.

Smooth pad entry/exit Specifies to have traces that enter a pad at a 90-degree angle 
converted to a 45-degree angle during a trace segment smoothing 
operation.

Centering area Maximum channel width  — Limits the number of channels in 
which traces are automatically centered by specifying a maximum 
channel width. Traces in channels larger than this width are not 
eligible for centering.

 Restriction:
This option is used only by SailWind Router.
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Options Dialog Box, Routing Category, 
Teardrops Subcategory
To access: Tools  > Options  menu item > Routing  category > Teardrops  subcategory

Use this subcategory to specify the display and physical appearance of teardrops on newly routed traces.

Tip
Use the Routing  category > General subcategory  on page 1542 to enable teardrops.
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Objects

Field Description

Parameters area

Display teardrops Specifies whether to display teardrops. Hiding the teardrops could 
reduce the redraw time. Although you hide the teardrops in the design, 
they will be visible in CAM output.
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Field Description

 Tip
You create the teardrops using the Generate teardrops check box 
on the Routing  category > General subcategory  on page 1542.
 Note:
Warnings:

• If you clear this checkbox and hide the teardrops, you will not 
be able to verify any clearance errors created by the teardrops. 
Clearance checking only checks objects that are displayed.

• If you flood an area while hiding the teardrops, the flood procedure 
will not account for the teardrops. If you do not flood the shape 
again prior to generating your CAM documents, you will create a 
CAM document without enough clearance around all the teardrops.

Auto adjust Specifies to have SailWind Layout attempt to adjust the length of 
teardrops on traces where the trace corner is inside the pad or via, or 
where the segment is too short to contain the specified length ratio.

 Restriction:
You can specify teardrop length and width ratios only if you select 
the Line or Curved teardrop shape.

Opens the Check Teardrop Dialog Box  where you can check the 
design for teardrop errors and report them.

 Restriction:
The Check button is unavailable unless the Generate teardrops 
check box on the Routing  tab is selected.

Shape area — these settings only apply to traces routed after the Generate Teardrops check box 
is selected in the Routing  category > General  subcategory. They do not apply to teardrops that are 
generated on existing trace segments connected to pads and vias.

Specifies the detailed physical appearance of teardrops. The Preview 
area shows the current teardrop shape.

• Default  — Standard shape.
 Restriction:
You cannot set the length or width ratio for the Default shape.

• Line  — Outer teardrop edges are straight.

• Curved  — Outer teardrop edges are curved.

 Tip
If the board has high-frequency analog circuits or very dense 
connections, you may want to specify either the Line or Curved 
shape.

Length ratio Specifies the length ratio in percent of pad diameter.

 Restriction:
• You cannot set a ratio over 1000.

• Not available for the Default shape.
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Field Description

 Tip
This option sets the length of the teardrop relative to the attached 
pad. The formula used to calculate the teardrop length follows:

teardrop length = (pad diameter) * (length ratio 
 in %)

Example: If the length ratio is 200 (200% of the pad diameter) and the 
pad diameter is 60 mils, then the length of the teardrop is 120 mils.

Width ratio Specifies the width ratio in percent of pad diameter.
Restrictions:

• You cannot set a ratio over 100.

• Not available for the Default shape.

 Tip
This option sets the width of the teardrop relative to the attached 
pad.
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Options Dialog Box, Routing Category, Tune 
and Diff Pairs Subcategory
To access: Tools  > Options  menu item > Routing  category > Tune/Diff Pairs  subcategory

Use this subcategory to specify options for using accordions in routing to length constraints and tuning 
differential pairs.

Restriction:
While you can define these options in either SailWind Layout or SailWind Router, the settings are 
only used in SailWind Router.

Description
Use routing to length constraints to adjust the length of length-controlled traces. This feature automatically 
maintains length-based design rules for nets, classes, pin pairs, groups, and differential pairs during 
autorouting. These settings use the tune pass to adjust or rip up traces based on their compliance with 
minimum and maximum trace length rules. The pass increases net and pin pair lengths to satisfy length 
rules by introducing accordion patterns to the trace.

Tip
You can set length rules in Class, Net, Pin Pair, Differential Pair, and (SailWind Router only) 
Matched Length Properties dialog boxes.
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Objects

Field Description

Accordion area

Minimum amplitude Specifies the minimum height (for horizontal accordions) or width (for 
vertical accordions).
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Field Description

Maximum amplitude Specifies the maximum height (for horizontal accordions) or width (for 
vertical accordions).

Minimum gap Specifies the edge to edge distance between accordions.
The gap is equal to the value of the parameter times the trace-to-corner 
clearance. However, if the trace to corner clearance equals 0, then the 
gap is equal to the trace width times the value of the gap parameter.

Max hierarchy level Specifies how many steps are used to create the accordion. See also: 
“Maximum Hierarchy Level” in theTune Pass

Max ratio Specifies the miter ratio for accordion corners.

Use arcs in miters Specifies to use an arc instead of a diagonal segment in the accordion.

Extra length added above 
required by matched length 
tolerance, percent

Specifies how much extra length is added above the required matched 
length group tolerance (in percent of the tolerance).
Example: If you type 0, the tuned net will be <Leader length - 
tolerance> length. If you type 100, the net will get the same length as 
the group leader. The leader net is the net in the matched length group 
that has the longest length.

Ignore length rules when 
required to complete traces

Specifies to ignore length rules so you can complete traces.

Differential pairs area

Add diff pair correction 
accordions when tuning

Specifies to use an accordion to make differential pairs the same 
length.

Do not create correction 
accordions in gap portion

Specifies that you do not want to allow correction accordions where two 
traces go together at the gap.

Create correction accordions 
only when length difference 
is greater than the matched 
length tolerance

Ensures that correction accordions are not created when the differential 
pair net length difference is less than the tolerance of the matched 
length group.
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Options Dialog Box, Text and Lines Category
To access: Choose the Tools > Options  menu item > Text and Lines  category

Use this category to view and edit options for drafting objects.

Objects

Field Description

Default width Specifies the default width to use when adding drafting objects.

 Tip
• To change the width of an existing shape, select the shape, 

right-click, and click the Properties  popup menu item.

• To search for and change all shapes of a similar width, on the 
Edit menu, click Find.

Prompt for net name at 
completion of copper

Specifies whether you are prompted to assign a net to the new 
copper or copper plane.
When you complete drafting a copper shape, the Add Drafting 
Dialog Box  opens automatically. Assign the net to the copper by 
using the Net assignment list to select the net from a list, or by 
using the Assign Net by Click button to click on an object in the 
design with the net name you want to assign.

Board component height 
restriction area

Specifies the height restriction in current design units for the top 
and bottom side layers.
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Field Description

Sets the maximum height for all design components that use 
the Geometry.Height attribute. See also: “Restricting Heights on 
Component Layers.”

 Tip
• You can set height restrictions for individual components by 

creating a Component keepout with a height restriction. See 
also: “Restricting Heights in Areas of Component Layers.”

• Use On-line DRC to prevent placement of components that 
exceed height restrictions. Use Verify the Design  to check for 
violations after placement.

• See also: “Attribute Dictionary”

Default font area Specifies the default font and style for all newly created text strings 
and labels.
Select <PADS Stroke Font> to use the default stroke font installed 
on your system or choose a font name from the list of fonts 
installed on your system.

 Restriction:
Type 1 fonts are not supported.
 Tip

• The font in use is highlighted at the top of the list.

• The fonts listed above the horizontal line are used in the design.

• If you select a system font, you can also click one or more 
buttons to specify a font style: B for bold, I for italic, or U for 
underlined.

Text area Specify text options for design drafting text.
• Line width  — Specifies the text line width in current design 

units.

• Size  — Specifies the text height in current design 

units.

Reference designators Specifies the default width and height for reference designator 
labels, pin numbers, and pin names. The PCB Decal Editor Add 
New Decal Label Dialog Box  and the Layout Editor Add New Part 
Label Dialog Box  use the default width value set on this tab.
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Field Description

• Line width  — Specifies the reference designator line width in 

current design units.
 Restriction:
Reference designator width is stored in the library, but the 
pin number is not.

• Size  — Specifies the reference designator height in current 

design units.

 Tip
If you modify the default width and height, the physical 
appearance of existing pin numbers updates to the new 
values, but the physical appearance of existing labels does not 
change. To change the label, select the label, right-click, and 
click the Properties  popup menu item.
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Options Dialog Box, Via Patterns Category
To access: Tools  > Options  menu item > Via Patterns  category

Use this category of the Options dialog box to set options for the via shielding and via stitching 
operations. The Add Via Shield and Via Stitch operations do not move traces in order to make room for 
the vias. For best results, you should add via shielding or via stitching early in design layout when your 
design has fewer traces.

Tip
You must have a design open in order to set Via Patterns options and set the Via Patterns options 
before using the Add Via Shield or Via Stitch commands.

1556 SailWind Layout Guide and Reference



 
GUI Reference Elements K Through O

Options Dialog Box, Via Patterns Category

Objects

Name Description

When shielding area — Use these options to specify the via type and spacing of vias used for shielding.

Add vias from net Specify the net assigned to the vias used for shielding. This also filters 
the Via type list to only display the vias selected in the Routing rules  on 
page 1666 for use with the net you have chosen.
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Name Description

Via type Specify the via type of vias used for shielding. If you need to create a new 
via for shielding, see “Via Setup”.

 Note:
Recommendation:  First, select the net to assign to the shielding vias 
in the Add vias from net list in order to choose a via that is available 
for use with the net. The Routing rules  on page 1666 determine which 
via types are available for the selected net.

Shielding spacing area Specify the distance from the shielding vias to the trace or shape they are 
shield

ing

 Note:
Recommendation:  Select the Ignore via grid check box. Otherwise, 
vias snap to the via grid.

Select one of the following:
• Use design rules — Design rules determine the distance from vias 

to the object being shielded. The Add Via Shield operation uses Via 
to Trace and Via to Copper clearances to place vias in relation to a 
selected trace or copper. Exception:  Although design rule values 
are used to place vias in relation to the selected trace or copper, that 
placement can violate clearances with other objects—another trace, 
for example. To prevent addition of any via that causes clearance 
errors, set On-line DRC (Design Rule Checking) to Prevent Errors. 
For more information, see “DRC and the Via Stitching and Shielding 
Operations”.

• Via to edge  — Select this option to specify via spacing different 
from the design rules for minimum Via to Trace and Via to Copper 
clearances.

Select this option and type a value in the Specified value box. The 
value can be 0 to 1000 mils. A value of 0 causes the vias and the edge 
of the trace (or shape) to touch.

 Tip
To specify a value smaller than the minimum Via to Trace or Via to 
Copper clearances, set DRC to Off. If the DRC setting is Prevent 
Errors, an Add Via Shield operation fails and no vias are added.
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Name Description

• Via to ground edge  — Specifies the distance from the vias to the 
edge of the copper ground area (for example, a hatch outline). Select 
this option and type a value in the Specified value box.

 Tip
The via to trace distance equals the value of Via to 
ground edge plus the value of the copper to trace 

clearance.

When Stitching Shapes area — Specifies the via type used in stitching a copper shape for a given net. To 
prevent addition of any via that causes clearance errors, set On-line DRC (Design Rule Checking) to Prevent 
Errors. For more information, see “DRC and the Via Stitching and Shielding Operations”.

Nets/Via Type list Specify the via type used per net for stitching shapes. By default, this list 
is empty. The Routing rules  on page 1666 determine which via types are 
available for the selected net.
If you need to create a new via for shielding, see “Via Setup”.
Use the following buttons to modify the list:

• Add  — Adds a row at the bottom of the When Stitching Shapes table.

• Edit  — Makes the selected cell available for editing.

• Remove  — Removes a line (Net/Via Type) from the list.

Pattern area Specifies the stitching mode (Fill or Perimeter) for placing the pattern of 
vias in the shape. You have the following choices:

• Fill  — Fills the shape with the pattern (Aligned or Staggered).

• Perimeter  — Places vias inside the perimeter of the shape.

 Tip
To override the Pattern (Fill or Perimeter) setting for a selected shape, 
use the Via Stitch Mode command. By default, the Via Stitch operation 
does not place vias around a void within a shape. For information, see 
“Surrounding a Void with Vias”.

Via to shape Specifies the distance from the edge of the shape you are filling to the 
edge of the via pattern. The value can be 0 to 1000 mils, 0 to 1 inch, or 0 
to 25.4 mm. A value of 0 causes the edge of the via and the fill outline to 

touch. for example:
The default value is the same as the default Copper-to-Via clearance.
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Name Description

Fill selected hatch outline only Use this setting when you have a single copper plane polygon that, when 
flooded, is separated into two or more distinct hatch outlines.

• Select this option to fill only the selected hatch outline with the pattern 
of vias when you use the Via Stitch command. (This is the default 
setting.)

• Clear the check box to fill the main plane outline of which the selected 
hatch outline is a part.

For example:

Use the settings below for both the Add Via Shield and Via Stitch commands.

Via spacing Specifies the distance between vias (center to center) added by the Add 
Via Shield and Via Stitch operations. Type a value of 0 to 1000 mils, 0 to 
1 inch, or 0 to 25.4 mm.
If you specify a value of 0 or any value that is less than half 
of the diameter of the via, vias touch but do not overlap. For 

example:.

 Tip
• To use this option, select the Ignore via grid check box.

• To specify a value smaller than via diameter plus same net Via to Via 
clearance, set DRC to Off. If the DRC setting is Prevent Errors, an Add 
Via Shield or Via Stitching operation fails. (The operation adds some 
vias but skips those that create violations.)

Glue vias as they are added Specifies to glue each via added by the Add Via Shield and Via Stitch 
operations. Also sets each via’s property to Glued and stores the setting 
in the design database.

Ignore via grid Allows the Add Via Shield and Via Stitch operations to ignore the via grid 
setting. (Vias do not snap to the via grid.) Instead, the operations place 
vias according to the settings you specified in the Shielding spacing area 
and the Via spacing field.
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Output Window

Related Topics
DRC and the Via Stitching and Shielding Operations

Adding a Via Shield

Filling a Shape with a Pattern of Vias

Placing Vias Inside the Perimeter of a Shape

Output Window
Use the Output window for displaying reports and session logs, macro editing and debugging, and custom 
programming and debugging.

To access: Click the Output Window  button

The Output window is located in the lower left section of the display window. You can dock or float the 
Output window. You can also open or close the Output window.

The Output window has two tabs:

• Status Tab  - Displays information on the current session.

• Macro Tab  - Allows you to run, edit and debug macro scripts.

Status Tab
The Status  tab displays information about the current session. It specifies the file name of the opened 
PCB file and the name of the test integrity file that is saved. It also reports routing statistics and messages 
when routing a board. If the Status  tab is closed, and you get an error while autorouting - or performing 
other tasks - the Output window opens with the Status  tab active and the error appearing in red. The 
Output window reappears in its most recent state (floating or docked).

To access: Click the Output Window  button and then click the Status  tab.

Figure 190. Status Tab

Macro Tab
You can edit, run, and debug macro scripts in the Macro  tab. You can open multiple macros and nest 
macros using the macro editor.

To access: Click the Output Window button and then click the Macro  tab.
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A macro is any combination of commands, keystrokes, and mouse clicks that you record to replay as a 
single action. You can record virtually any set of procedural steps for replay, thereby simplifying redundant 
activities, such as setting preferences and layer/display settings.

Figure 191. Macro Tab

Related Topics
User Interface Elements

The Status Tab

Macros and the Macro Language [SailWind Layout Command Reference Manual]
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Chapter 52
GUI Reference Elements P

Read the sections that follow to learn more about dialog box elements in SailWind Layout.

Pad Entry Rules Dialog Box
Pad Stacks Properties Dialog Box
Pad Stack Properties for Pin Dialog Box
Pads for Die Pin Dialog Box
SailWind Router Link Dialog Box
Part Information Dialog Box, Attributes Tab
Part Information Dialog Box, Connector Tab
Part Information Dialog Box, Gates Tab
Part Information Dialog Box, General Tab
Part Information Dialog Box, PCB Decals Tab
Part Information Dialog Box, Pins Tab
Part Information Dialog Box, Pin Mapping Tab
Part Label Properties Dialog Box
Part Type List for Decal Dialog Box
PCB Decal Editor
PDF Configuration Dialog Box
Pen Plotter Advanced Setup Dialog Box
Pen Plotter Setup Dialog Box
Photo Plotter Advanced Setup Dialog Box
Photo Plotter Setup Dialog Box
Pin Numbers Dialog Box
Pin Pair Properties Dialog Box
Pin Pair Rules Dialog Box
Pin Properties Dialog Box
Place Clusters Setup Dialog Box
Place Parts Setup Dialog Box
Plane Layer Nets Dialog Box
Plot Options Dialog Box
Process Status Dialog Box
Project Explorer
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Pad Entry Rules Dialog Box
To access:

• Setup  > Design Rules  menu item > Default  button > Pad Entry  button

Use the Pad Entry Rules dialog box to specify how traces enter and exit pads.

Restriction:
While you can define these rules in either SailWind Layout or SailWind Router, the rules are only 
used in SailWind Router.

Objects

Area Description

Pad entry quality Specify the options that SailWind Router can use while routing from the pad:
• Allow side exit  — For rectangular pads only, enable routing to exit through 

the long side of the pad.

• Allow corner exit  — For rectangular pads only, enable routing to exit 
through the pad corner or arc.

• Allow any angle exit  — For rectangular and round pads, enable routing to 
exit at any angle, not just 45 or 90 degrees.
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Pad Entry Rules Dialog Box

Area Description

• Soft first corner rules  — For rectangular and round pads, enable routing 
to ignore first corner clearance rules and to exit at an angle less than 90 
degrees.

 Tip
If you select this check box, acid traps may result. On the other hand 
if you clear this check box, lower completion rates and slower routing 
may result. Use DRC in SailWind Layout to locate possible acid traps. 
You can ignore first corner clearance rules, because it is a soft rule  on 
page 1860.

Via at SMD Specify to enable SailWind Router to place vias on SMD pads while routing.

 Restriction:
For pins with associated copper, the via is not placed on the SMD pad. Only 
one via can be placed on an SMD pad.

• Vias at SMD  — Place vias on SMD pads while routing.
 Restriction:
Only one via can be placed on an SMD pad.

• Fit inside  — Fit the via entirely inside the SMD pad.

• Center  — Place the via at the geometric center (not pad origin) of the SMD 
pad.

• Ends  — For rectangular or oval pads, place the via at the end of the SMD 
pad. When using square pads, place the via at the midpoints of the sides of 
the pad. Round pads are ignored.

Delete button Removes non-default pad entry rules from the current level of the rules 
hierarchy.

 Restriction:
You cannot delete the Default pad entry rules.

Related Topics
Design Rule Hierarchy

Pad Entry Properties [SailWind Router User's Guide]
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Pad Stacks Properties Dialog Box
To access: Setup  > Pad Stacks  menu item

Establish the size and shape of each pad and drilled hole in a given pad stack, including component, via, 
and virtual pin pad stacks.

Description

Figure 192. Pad Stacks Properties Dialog Box
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Pad Stacks Properties Dialog Box

Figure 193. Pad Style Pad Tab

Figure 194. Pad Style Thermal Tab
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Figure 195. Pad Style Antipad Tab

Objects

Area Field Description

Decal Accesses component pad stack options.Pad Stack Type

Via Makes the Vias area of the dialog box available so you can 
define a via type. Options related to decal or pin pad stacks are 
now unavailable.
See also: “Via Setup”.

Decal Name Lists the available decal names for decals or vias, whichever is 
selected in the Pad Stack Type area.

Add Via Adds a via type to the Decal Name list. Available only when Via 
is selected in the Pad Stack Type area.
See also: “Creating a Through-hole Via Type”, Creating a 
Partial Via Type”.

Delete Via Deletes the selected via type from the Decal Name list. 
Available only when Via is selected in the Pad Stack Type area. 
You cannot delete a via if it is already used in the design.

This area is available only when Via is selected in the Pad Stack Type area.

Name Assigns a name for a new via type.

Through Sets the current via type as a through via, through all layers of 
the board.

Vias

Partial Sets the current via type as a partial via, through certain layers 
of the board. Click Partial and click a Start Layer and an End 
Layer.
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Area Field Description

Start Layer/End 
Layer

Sets the start and end layer for a partial via type. Available only 
when Via is selected in the Pad Stack Type area, and Partial is 
the type of via.

Pin number and plated status. You can select one or more pins and customize the pad 
stacks for your selection. The Pin, Plated setup does not apply to via pad stacks; all vias 
are considered plated. Available only when Decal is selected in the Pad Stack Type 
area.

Add Opens the Add Pin Dialog Box.

Pin: Plated:

Delete Removes the selected Pin.

Shape, Size, Layer. Select one or more layers to specify the shape and size of the 
available pad, thermal, and/or antipad.
In the shape column, the characters describe the shapes of the pad, thermal and 
antipad. C=circular, S=square, A=annular, O=oval, R=rectangular, D=odd. “N” indicates 
that none has been defined.
Inner layers are drawn with a slightly larger pad size because they are often used for 
plane layers, where the pad size becomes an insulation area when output as a plane 
plot.

Add Opens the Add Layer dialog box.

Delete Removes custom layers.

Sh.: Sz.: Layer:

Copy/Paste Copy the shape and size information from one layer to one or 
multiple layers. Paste into other decals also. Via layer shape 
and size settings can be copied to a decal, but decal layer 
shape and size settings cannot be copied to a via. If antipad 
information is copied to a layer that does not support antipads 
(Mounted Side, Opposite Side) the antipad settings are ignored. 
Drill size value, Plated setting and Slot Parameters are not 
copied.
See also: “Control of Solder Mask and Paste Mask”.

Parameters
Specify the shape and size of the pad, thermal, and antipad for each layer in the list. Thermals and Antipads apply 
to plane areas on split/mixed layers and CAM negative planes (for RS-274X output). If thermals and antipads 
are not specified in the pad stack, they will be generated based on the design rules. For more information, see 
“Design Rule Versus Pad Stack - Thermals and Antipads”  on page 797.

Use Global Defaults When the Thermal or Antipad tab is active, sets thermal 
or antipad shapes to those specified in the Options dialog 
box > Copper Planes category > Thermals subcategory  on 
page 1514.
See also: “Design Rule Versus Pad Stack - Thermals and 
Antipads”  on page 797.

Pad  tab
Assign a pad shape to the pad style for the selected layers in the Sh: Sz: Layers: list. If a 
layer in the selection already has an assigned shape it will be reassigned if you click one 
of the shapes. You can assign pad shapes as round, square, annular, oval, rectangular 
or odd.
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Annular pad shape Lets you specify an inner pad diameter, bringing the inner 
diameter of the pad inside the drill outline. A pilot dimple at the 
center of the copper pad appears as an aid to hand fabrication 
of some prototypes.

Odd pad shape Is useful for drawn items such as moiré pads or registration 
marks. It is a circular outline only, like an antipad, and is usually 
used for marking areas for airgap checking. This setting should 
not be confused with trying to create a custom shaped (odd 
shaped) pad.
See “Creation of Custom Pad Shapes” for more information.

Orientation/Offset Sets the orientation and offset for pads. Used for SMD decals 
and edge finger connectors. Available when you click the oval 
or rectangular shaped button. For orientation, 90 degrees 
is perpendicular to the part body and 0 is parallel to the part 
body. You can type any degree of rotation. By specifying the 
offset, you can move the rectangular or oval pad slightly off its 
electrical center for two purposes:

• Pads that are concentric on the display, as they are in edge 
fingers, are difficult to select and work with during routing. 
Offsetting one of the layers makes it easier to identify the top 
and bottom layers.

• To extend the pad out from the component body, leaving the 
electrical centers unmoved.

The maximum amount of offset you can assign is one half of 
the pad's length. If you exceed this limit, the pad fails to appear 
in the Preview dialog box for CAM.

Figure 196. Offset Example

Maximum offset = ½ length or (1000/2) = 500

Thermal  tab The size, shape and orientation of thermals are inherited 
from the normal pad. Prior to version 9.2, the size, shape and 
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orientation of thermals for slotted pads were derived from the 
length, drill size and orientation of the slotted hole.
You can also set the Inner Diam and Outer Diam values to 
be the same for a solid connection to the plane (flood over). 
The current pad diameter is used as the inner diameter with 
the outer diameter set at the default same-net pad to corner 
rule. For antipads, diameters are initially set to follow the 
current default pad to copper design rule. If you select Use 
Design Rules for Thermals and Antipads in the Options dialog 
box > Copper Planes category > Thermals subcategory  on 
page 1514, the outer diameter is ignored and the clearance rule 
is used instead, except when the outer diameter is less than 
the inner diameter. Inner and outer diameter options always, 
however, control flood over.

• Flood over check box  — Specifies that the pad requires 
no thermal relief and should be flooded over, irrespective of 
any default flooding options for a normal pad of this shape. 
Available only when a pad shape button is selected.

Antipad The length of an antipad with a non-zero drill size equals the 
slot length minus the drill size, plus the width.
You cannot create antipads using the Mounted Side or 
Opposite side layers. You must add the actual layer to the list. 
When you select a Mounted or Opposite Side layer in the Sh: 
Sz: Layer: list, Antipad is unavailable.

Pad size relative to 
drill size

Displays inner and outer pad sizes relative to the drill size.

Corner type Available for only Square and Rectangular shapes. The figure 
below illustrates the rounded and chamfered corner types.

Radius Available only when Chamfered or Rounded corners are 
selected as a corner type.

Drill Size Specifies the finished hole size. If the hole is plated, this value 
remains the same. Drill holes are normally oversized by the 
fabricator in order to achieve the specified drill size value after 
the hole is plated. See the Drill Oversize setting in the Options 
Dialog Box, Design Category.

Plated Sets whether the drill hole is plated with copper. Normally, pad 
stacks with a hole are plated. To create a non-plated hole with 
no copper, such as a mounting hole, clear this Plated check 
box. Non-plated holes are drilled to true drill diameter, without 
oversize, and any drill oversize does not apply to them.
Tips:
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• The batch clearance checking functions consider the added 
(plated hole) drill and laser drill oversize value when flagging 
errors. The oversize settings are found in the Options Dialog 
Box, Design Category.

• If the board is marked as Single-sided in the Layers Setup 
Dialog Box, this check box is ignored.

Laser Sets the partial via as a laser drilled via to use the separate 
“Laser drill oversize” setting in the Options Dialog Box, Design 
Category. Available only when creating the pad stack of a 
partial via.
For more information, see “Creating a Partial Via Type”  on 
page 330.

When slotting Round pads, the Diameter value becomes the Width. When slotting 
Square pads, the Size value becomes the width.

Slotted check box Enables a slotted hole for the selected pad stack or pin. You 
must select this check box to activate the Length, Orientation, 
and Offset boxes.

Length Sets the length of the slotted hole.

Orientation Sets the orientation of the slotted hole. A custom thermal or 
antipad for a slotted hole has the same orientation as the slot.

Slot Parameters

Offset Sets the slotted hole offset. Slot offset moves the center of the 
slotted hole relative to the electrical center of the pin–always 
in the opposite direction of the pad offset. A custom thermal or 
antipad for a slotted hole has the same offset as the slot.
The maximum amount of offset you can assign is one half of 
the slot's length. If you exceed this limit, the slotted hole display 
is suppressed in the Preview dialog box in CAM.
See also: “Slotted Holes”.

Decal Units Shows and sets the current units of the selected decal. This 
area is unavailable if you select Via in the Pad Stack Type 
area or when you use this dialog box in the PCB Decal Editor. 
Switching the decal units can cause errors if rounding off 
occurs.

List Produces a report describing the selected pad stack showing 
pad stack, slotted hole, and unit information. Vias are output in 
design units.
For more information, see “Pad Stack Report”  on page 189.

List All Produces a report describing the selected pad stack showing 
pad stack, slotted hole, and unit information. Vias are output in 
design units.
For more information, see “Pad Stack Report”  on page 189.

Preview Shows pad style, shape and size for the current options. When 
multiple layers are selected and there are different shapes 
assigned, the preview displays the last selected layer shape. 
When you see the message “Multiple Layer Values” it indicates 
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that multiple layers are selected in the Sh.: Sz.: Layer: list and 
the values of one or more fields are different. The field that 
is different between selected layers is blank and missing any 
specific value.

Negative check box Changes the preview area to a negative view for only the 
Thermal pad style.

Related Topics
Customizing Pad Stacks of Decal Pins

Flood Over Pads in a Copper Plane

Flood Over Vias in a Copper Plane

Pad Stack Report

Pad Sizes and Pad Stacks

Slotted Hole Offset Versus Pad Offset
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Pad Stack Properties for Pin Dialog Box
To access: PCB Decal Editor > select a terminal > right-click > Pad Stacks  popup menu item

Use the Pad Stack Properties for Pin dialog box to modify the size and shape of one or more selected 
terminals or slotted holes while in the PCB Decal Editor.

Description

Figure 197. Pad Stack Properties for Pin
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Figure 198. Pad Tab

Figure 199. Thermal Tab
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Figure 200. Antipad Tab

Objects

Field Description

Pin Number and Plated For Decal pad stacks, you need to specify the pins to which to 
apply the pad stack edits. Use the Pin, Plated column to select the 
pin you want to edit. The Pin, Plated setup does not apply to via 
pad stacks; all vias are considered plated.

Shape, Size, and Layer For both via and component pad stacks, you can set the size and 
shape of a pad on selected layers.
Inner layers are drawn with a slightly larger pad size because they 
are often used for plane layers, where the pad size becomes an 
insulation area when output as a plane plot.

• Add  — Opens the Add Layer dialog box.

• Delete  — Removes custom layers.

• Copy/Paste  — Copy the shape and size information from one 
layer to one or multiple layers. Paste into other decals also. If 
antipad information is copied to a layer that does not support 
antipads (Mounted Side, Opposite Side) the antipad settings 
are ignored. Drill size value, Plated setting and Slot Parameters 
are not copied.

See also: “Pad Sizes and Pad Stacks”.

Assign to all selected pins When multiple terminals are selected simultaneously, modifies 
all the terminals listed under the Pin No: Plated list to match the 
terminal currently selected within the Pin No: Plated list.

Use Global Defaults When the Thermal or Antipad tab is active, sets thermal or antipad 
shapes to the defaults specified in the Options dialog box > 
Copper Planes  category > Thermals subcategory  on page 1514.
See also: “Design Rule Versus Pad Stack - Thermals and 
Antipads”  on page 797.
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Pad Style Specify the shape and size of the pad, thermal, and antipad for 
each layer in the list. Thermals and Antipads apply to plane areas 
on split/mixed layers and CAM negative planes (for RS-274X 
output). If thermals and antipads are not specified in the pad 
stack, they will be generated based on the design rules. For more 
information, see “Design Rule Versus Pad Stack - Thermals and 
Antipads”  on page 797.
Pad size relative to drill size  — Displays inner and outer pad 
sizes relative to the drill size.

Thermal notes Beginning with PADS 9.2, the size, shape and orientation of 
thermals for slotted pads are no longer derived from the length, 
drill size and orientation of the slotted hole, but are inherited from 
the normal pad.
Flood over check box  — Specifies that the pad requires no 
thermal relief and should be flooded over, irrespective of any 
default flooding options for a normal pad of this shape. Available 
only when a pad shape button is selected.
You can also set the Inner Diam and Outer Diam values to be the 
same for a solid connection to the plane (flood over). The current 
pad diameter is used as the inner diameter with the outer diameter 
set at the default same-net pad to corner rule. For antipads, 
diameters are initially set to follow the current default pad to copper 
design rule. If you select “Use Design Rules for Thermals and 
Antipads” in the Options dialog box > Copper Planes  category > 
Thermals subcategory  on page 1514, the outer diameter is ignored 
and the clearance rule is used instead, except when the outer 
diameter is less than the inner diameter. Inner and outer diameter 
options always, however, control flood over.

Antipad notes The length of an antipad with a non-zero drill size equals the slot 
length minus the drill size, plus the width.

 Restriction:
You cannot create antipads using the Mounted Side or 
Opposite Side layers. You must add the actual layer to the list. 
When you select a Mounted or Opposite Side layer in the Sh: 
Sz: Layer: list, Antipad is unavailable.

Shape notes Assigns a pad shape to the pad style for the selected layers in 
the Sh: Sz: Layers: list. If a layer in the selection already has an 
assigned shape it will be reassigned if you click one of the shapes. 
You can assign pad shapes as round, square, annular, oval, 
rectangular or odd.

• Annular  —lets you specify an inner pad diameter, bringing 
the inner diameter of the pad inside the drill outline. A pilot 
dimple at the center of the copper pad appears as an aid to 
hand fabrication of some prototypes.

• Odd  — is useful for drawn items such as moiré pads or 
registration marks. It is a circular outline only, like an antipad, 
and is usually used for marking areas for airgap checking. This 
setting should not be confused with trying to create a custom 
shaped (odd shaped) pad.
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See “Creation of Custom Pad Shapes” for more information.

• Square and Rectangular  — The figure below illustrates the 
rounded and chamfered corner types.

Orientation/Offset Sets the orientation and offset for pads. Used for SMD decals 
and edge finger connectors. Available when you click the oval or 
rectangular shaped button.
For orientation, 90 degrees is perpendicular to the part body and 0 
is parallel to the part body. You can type any degree of rotation.
By specifying the offset, you can move the rectangular or oval pad 
slightly off its electrical center for two purposes:

• Pads that are concentric on the display, as they are in edge 
fingers, are difficult to select and work with during routing. 
Offsetting one of the layers makes it easier to identify the top 
and bottom layers.

• To extend the pad out from the component body, leaving the 
electrical centers unmoved.

The maximum amount of offset you can assign is one half of the 
pad's length. If you exceed this limit, the pad fails to appear in the 
Preview dialog box for CAM.

Figure 201. Offset Example

Maximum offset = ½ length or (1000/2) = 500

Drill size Sets the drill size of the pad.

Plated Sets whether the pad is plated with copper.
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Normally, pads with a hole are plated. To create a nonplated hole 
with no copper, such as a mounting hole, click to clear Plated. 
Nonplated holes are drilled to true drill diameter, without oversize, 
and any drill oversize does not apply to them.

 Tip
The batch clearance checking functions consider the added 
drill oversize value when flagging errors. When Plating is 
cleared, batch clearance checking applies to the true drill 
value.

Slot Parameters When slotting Round pads, the Diameter value becomes the 
Width. When slotting Square pads, the Size value becomes the 
width.

• Slotted check box  — Enables a slotted hole for the selected 
pad stack or pin. You must select this check box to activate the 
Length, Orientation, and Offset boxes.

• Length  — Sets the length of the slotted hole.

• Orientation  — Sets the orientation of the slotted hole. A 
custom thermal or antipad for a slotted hole has the same 
orientation as the slot.

• Offset  — Sets the slotted hole offset. Slot offset moves the 
center of the slotted hole relative to the electrical center of the 
pin–always in the opposite direction of the pad offset. A custom 
thermal or antipad for a slotted hole has the same offset as the 
slot.

The maximum amount of offset you can assign is one half of 
the slot's length. If you exceed this limit, the slotted hole display 
is suppressed in the Preview dialog box in CAM.

See also: “Slotted Holes”.

Preview Shows pad style, shape and size for the current options. When 
multiple layers are selected and there are different shapes 
assigned, the preview displays the last selected layer shape. 
When you see the message “Multiple Layer Values” it indicates 
that multiple layers are selected in the Sh.: Sz.: Layer: list and the 
values of one or more fields are different. The field that is different 
between selected layers is blank and missing any specific value.

Related Topics
Customizing Pad Stacks of Decal Pins

Pad Sizes and Pad Stacks
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Pads for Die Pin Dialog Box
To access: BGA Toolbar  button > select a BGA Pin > double-click in a BGA Pad cell > Ellipsis  button

Use the Pads for Die Pin dialog box to specify which label to use for the die part's substrate bond pad.

Restriction:
This information applies only to the BGA toolkit.

Objects

Field Description

BGA Pad Lists all BGA pin pad labels that are connected to the die part pin 
selected in the Add BGA Pin Labels Dialog Box. Select the pin pad 
labels to use in the substrate bond pad's label.

Select All button Selects all BGA pin pad labels in the BGA Pad list.

Apply to All Applies the current die pin number and BGA pad setup to all die pin 
numbers that have multiple BGA pin pads.
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SailWind Router Link Dialog Box
To access: Tools  > SailWind Router

The contents of the SailWind Router Link dialog box depend on your Synchronization mode settings.

Description
When you are not in Synchronization mode, the SailWind Router Link sets up autorouting options for 
SailWind Router and passes information from SailWind Layout to SailWind Router. Data is stored in the 
design file. Using the link you can either run SailWind Router and automatically open the current design 
file in the foreground, so you can view the autorouter's progress, or you can run SailWind Router in the 
background.

When you are in Synchronization mode, the SailWind Router link sets up autorouting options for 
SailWind Router and switch to SailWind Router. Using the link you can either run SailWind Router and 
automatically open the current design file in the foreground, so you can view the autorouter's progress, or 
you can run SailWind Router in the background.

Figure 202. SailWind Router Link Dialog Box
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Figure 203. SailWind Router Link Dialog Box - Synchronization Mode

Objects
Table  191. SailWind Router Link Dialog Box Fields

Field Description

Action Specifies the action you want to perform. The options are:
• Open SailWind Router  — Opens SailWind Router and loads 

the design file into it. You can make changes to the design file 
in SailWind Router (rather than SailWind Layout) before routing. 
Non-Synchronization mode only.

• Switch to SailWind Router  — Links SailWind Router and SailWind 
Layout. Any changes you make to the design file in SailWind Router 
are reflected in SailWind Layout. Synchronization mode only.

• Autoroute in Background  — Opens SailWind Router and SailWind 
Router Monitor, but runs SailWind Router in the background. Layout 
commands are disabled and a wait cursor shown until autorouting is 
completed or the Stop button is selected in the Router Monitor.

• Autoroute in Foreground  — If you are not in Synchronization 
mode, opens SailWind Router and SailWind Router Monitor, 
and runs SailWind Router in the foreground making it the active 
program. If you are in Synchronization mode, opens SailWind 
Router and runs it in the foreground making it the active program.

Setup button Opens the Routing Strategy Dialog Box.

Options Specifies the Options dialog box tab you want to open when you click 
the Setup button.

Setup button Opens the Options dialog box to the tab you specified above.

Proceed Autoroutes the design with the settings you specified.
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Related Topics
Autorouting Your Design Using SailWind Router

Synchronization Mode
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Part Information Dialog Box, Attributes Tab
To access: File  > Library  menu item > select a library > Parts  button > select part > New  or Edit  button > 
Attributes  tab

Manage attributes for the selected part, and save as default attributes for new parts.

Objects

Object Description

Save As Default Save a default set of attributes to automatically use 
for each new part. Attribute values are not saved - 
only the names. Once the list of attributes is correct, 
click the button. The default attribute list is saved to 
C:
\<install_folder>\PADS<latest_release>\Settings\defaultattribute.txt, 
which is shared between SailWind Logic and SailWind Layout.
For more information, see “Defining Default Attributes for New 
Parts”  on page 244.

Reset Undo all changes for this tab only.
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Attribute/Value list The attributes are added automatically if they do not already 
exist. They are added during the creation of new parts, during 
synchronization, and during migration of libraries.
The attributes are placed in the SailWind Designer symbol instances 
and are used during design packaging.

Edit Click a cell and then click this button to edit the contents. As a faster 
alternative, double-click a cell to edit the contents.
The attribute is edited for only the selected part. To manage 
attributes design-wide or in all libraries, use the “Manage Library 
Attributes Dialog Box”  on page 1461.

Add Start a new row with the cursor active in the Attribute cell ready to 
type the attribute name. Tab over to the Value cell to type the value. 
Net attributes are added to the Part level of the attribute hierarchy. 
For more information see “Attribute Hierarchy”  on page 356.

Delete First click a cell in the row to be deleted and then click the delete 
button to remove the row.

Copy Click in a cell of the row to copy and then click the button.

Paste Add a new empty row and then paste the contents.

Browse Lib. Attr Opens the “Browse Library Attributes Dialog Box”  on page 1139
where you can search for an existing attribute in all libraries.

Check Part Checks for missing or inconsistent information.

 Tip
Even if you do not click the Check Part button, when you exit the 
tab, the assigned decals are checked to ensure that they contain 
physical pin numbers for all the gate and signal pins defined in 
the Pins  tab.

Related Topics
Adding and Modifying Part Type Attributes
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Part Information Dialog Box, Connector Tab
To access: File  > Library  menu item > select a library > Parts  button > select part > New  or Edit  button > 
Connector  tab

Use the Connector  tab in the Part Information dialog box to assign one or more pin decals, or Special 
Symbols, to a connector. This allows you to use any of the special symbols as alternate pins of the 
connector. Instead of being displayed as a single symbol, the connector is broken up into individual pin 
symbols in the schematic. You can place the pins all together, or wherever you like on a single page, or 
even across multiple pages.

Restriction:
This tab is unavailable when the Connector check box on the General  tab is cleared, or when a 
gate has been assigned to the part on the Gates  tab.

Objects

Field Description

Picture Displays a picture of the selected Special Symbol.
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Attribute table • Special Symbol  — The name of a connector pin decal for use in the 
schematic.

• Pin Type  — The function of the special symbol.

Opens the Browse for Special Symbols Dialog Box  where you can browse 
for a pin decal.

Reset Undoes all changes you made in the Connector  tab.

Edit Makes the selected cell available for editing.
You can also double-click the cell to edit the contents.

Add Adds a new row at the bottom of the table.

Delete Removes the selected row.

Check Part Checks for missing or inconsistent information.

 Tip
Even if you do not click the Check Part button, when you exit the tab, 
the assigned decals are checked to ensure that they contain physical 
pin numbers for all the gate and signal pins defined in the Pins  tab.

Save As Opens the Save Part Type to Library dialog box.

Related Topics
Creating a Connector Part Type

Creation of a New Part Type
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Part Information Dialog Box, Gates Tab
To access: File  > Library  menu item > select a library > Parts  button > select part > New  or Edit  button > 
Gates  tab

Use the Gates  tab in the Part Information dialog box to assign gate information, such as CAE decals and 
gate swap options to a part.

Objects

Field Description

Preview area Shows the item selected in the Decal cell.

Reset Undoes all changes you made in the Gates  tab.

Edit Makes the selected cell available for editing. Also displays the 
Browse button.

Opens the Assign Decal to Gate Dialog Box.
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 Tip
This button is available only in the CAE Decal columns, and 
only when the cell is available for editing.

Add Adds a new row with the next Gate letter at the bottom of the Gate 
table.

Delete Removes the selected row from the Gate table.

Gate table • Gate column  — Displays the letter of the gate.

• Pins column  — Displays the number of pins for the gate. Gate 
pins are added on the Pins  tab.

• Swap column  — Displays the swap ID from 0 to 100. To 
uncross connections and facilitate routing, gates with the same 
swap ID (except for 0) can be swapped within a part or with 
another part of the same type. Type 0 to disable swapping.

• CAE Decal N column  — Displays the CAE Decal name. The 
decal listed for CAE Decal 1 is the default decal and is used 
when you add the part to the schematic. Additional decals are 
alternates. You can assign up to four CAE decals to a part. 
Double-click to Type a decal name or click the “...” (Browse) 
button to search for a decal from a library

Check Part Checks for missing or inconsistent information.

 Tip
Even if you do not click the Check Part button, when you exit 
the tab, the assigned decals are checked to ensure that they 
contain physical pin numbers for all the gate and signal pins 
defined in the Pins  tab.

Save As Opens the Save Part Type to Library dialog box.

Related Topics
Creation of a New Part Type
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Part Information Dialog Box, General Tab
To access: File  > Library  menu item > select a library > Parts  button > select part > New  or Edit  button > 
General  tab

Use the General  tab in the Part Information dialog box to specify pin count, logic family, and various 
options for a part.

Objects

Field Description

Part Statistics All the statistics in the Part Statistics area are read-only. Pin Count 
lists the total number of pins - gate pins, signal pins, and unused 
pins. If multiple decals are assigned with different pin counts, a 
range of smallest to largest decal pin counts is shown.

Logic Family list Specifies the Logic Family (reference designator prefix) to use for 
the part. You can also create a new logic family or edit the existing 
reference designator prefix designations by clicking the families 
button.
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 Note:
Beginning with PADS 9.0, die parts and flip chips are no longer 
identified by their family designations (DIE or FLP), but instead 
by the Special Purpose settings on this tab. With this change, 
you can assign any reference designator (logic family) to a die 
part or flip chip without losing the special properties of these 
parts (such as the ability to move the part's substrate bond 
pads in the design).

Ref Prefix Displays the prefix for the selected Logic family.

Families Opens the Logic Families Dialog Box, where you can add, edit, or 
delete a logic family.

Define mapping of Part Type pin 
numbers to PCB Decal

Activates the Pin Mapping  on page 1600 tab, where you map the 
numerical physical pins in the decal to the alphanumeric logical 
pins in the part type.

 Restriction:
• The check box is unavailable once you add one or more 

alphanumeric decals to the part type. Remove the assigned 
alphanumeric decals to make the check box available.

• You must assign a numeric decal to use the Pin Mapping  tab.

• Only decals with sequential numerical pin numbers can be used 
with pin mapping.

Special Purpose Check this box, then select the appropriate radio button:
Connector  — Select to identify the part as a connector and make 
the Connector  on page 1586 tab available. Connectors do not 
require a prefix list or gate definitions.

 Restriction:
• This check box is automatically selected when you create or 

modify connectors. It is unavailable if you open a part other 
than a connector.

• The Gate Decals  tab is unavailable when the Connector check 
box is selected.

• Some Pins  tab controls not applicable to connector parts are 
disabled.

Die Part  — Select to identify the part as a die part. This also 
allows you to move the substrate bond pads in the design.
Flip Chip  — Select Flip Chip to identify the part as a flip chip. This 
also allows you to move the substrate bond pads in the design.

 Note:
Beginning with PADS 9.0, die parts and flip chips are identified 
by these Special Purpose settings instead of by their family 
designation (DIE or FLP). With this change, you can assign any 
reference designator (logic family) to a die part or flip chip.

ECO registered part Identifies the part as eligible for transfer between the design file 
and the schematic file during forward annotation or backward 
annotation. You can override this setting when creating the ECO 
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file. You can specify it when generating an .eco  file using either 
the ECO Toolbar  on page 1352, or the Compare/ECO dialog 
box  on page 1181. Typically you do not select this check box for 
non-electrical parts. For example, if you create a mounting hole 
to add to your design, you would not need the part (mounting 
hole) to pass back to the schematic software when you perform a 
backward annotation of the design.

Prefix list Applies the part information to other parts in the library. Use the 
prefix with wildcards to identify the parts you want.

 Note:
Examples:

• Question mark ? in a prefix acts as a wildcard for one character. 
The prefix “?4” is the equivalent of “54” or “74”.

• If you type “\02” as the suffix, the edits are applied to all parts 
ending in 02.

 Note:
Warning:  The contents of the Prefix List box are applied when 
you click OK or Save As on other tabs in the Part Information 
dialog box.

Check Part Checks for missing or inconsistent information.
Even if you do not click the Check Part button, when you exit the 
tab, the assigned decals are checked to ensure that they contain 
physical pin numbers for all the gate and signal pins defined in the 
Pins  tab.

Save As Opens the Save Part Type to Library dialog box.

Related Topics
Creation of a New Part Type
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Part Information Dialog Box, PCB Decals Tab
To access: File  menu > Library  > select a Library > Parts  button > select part > New  or Edit  button > 
PCB Decals tab

Use the PCB Decals  tab in the Part Information dialog box to specify the decal, or footprint, for a part. 
The decal determines the number of pins in the part.

Objects

Field Description

Preview area Shows the item selected in the Assigned Decals list.

Reset Undoes all changes you made in the PCB Decals  tab.

Library list Lists all your available libraries. Filters the Unassigned Decals list 
to only the selected library.

Filter Narrows down your unassigned decals list.

 Tip
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Field Description

• You can use wildcards  on page 155 in this box.

• Type * (asterisk) in the Filter box to display all decals.

Pin Count Narrows down your unassigned decals list by displaying only the 
decals with the specified number of pins.
Delete all numbers in the Pin Count box to display all decals. This 
box is always available as a filter to allow decals of differing pin 
counts to be assigned.

Apply Executes the filter arguments.

Show only Decals with pin 
numbers matching Part Type

Filters out decals that do not have pin numbers matching existing 
gate and signal pins on the Pins  tab, or the physical pin numbers 
on the Pin Mapping  tab.

Unassigned Decals list Lists all unassigned decals available to assign from the selected 
library.
Double-click a decal to assign it without needing to click the Assign 
button.

Assign >> Moves the selected decal from the Unassigned Decals list to the 
Assigned Decals list.
Assigned PCB decals can have a different number of pins, but you 
must assign a decal with enough pins for all the defined gate pins 
and signal pins on the Pins  tab.

 Restriction:
Only decals with sequential numerical pin numbers can be 
used with pin mapping.

<< Unassign Moves the selected decal from the Assigned Decals list to the 
Unassigned Decals list.

Assigned Decals list Lists all assigned decals. Assigned PCB decals can have a 
different number of pins, but you must assign a decal with enough 
pins for all the defined gate pins and signal pins on the Pins  tab.
You can assign up to 16 PCB decals to a part.

 CAUTION:
• Decals are switched to alternates using the Component 

Properties dialog box and can be changed outside of ECO 
mode. An .eco  file created by the ECO Toolbar will not contain 
decal changes to alternates unless you select the Output Decal 
Changes check box in the ECO Options  on page 1352.  If you 
have not specified to record decal changes in the .eco  file 
written by the ECO Toolbar, you can use the Compare/ECO 
dialog box to create an .eco  file that lists changes to alternate 
decals.

• If you update a part in the library to have alternate decals and 
you use the Update from Library  on page 1763 tool, but you do 
not select PCB decals to be updated, the updated alternates 
will not be listed in the Decal list for selection in the Component 
Properties Dialog Box.
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Field Description

 Tip
• The decal at the top of the list is the default decal and is used 

when you add the part to the design.

• When you assign a decal, the pin numbers from the decal are 
automatically populated into the Pins  tab table. PCB Decal pin 
numbers can be alphanumeric or numeric and the pin numbers 
in the PCB Decal must match the pin numbers listed in the Pins 
tab table.

When your logic symbol uses alphanumeric pin numbering 
and the PCBDecal uses numeric pin numbering, you use the 
Pin Mapping  tab to map the alphanumeric symbol pins to the 
numeric decal pins.

Assign New Opens the Assign New PCB Decal Dialog Box  where you can type 
the name for a decal that does not yet exist in a library. In order 
to use this part in a design, you must either acquire or create this 
decal.

 Restriction:
When you assign a decal that exists, it pre-populates the Pins 
on page 1596 tab with pin numbers. When you assign a new 
PCB decal, you must enter the pin numbers manually. See 
“Adding a Series of Pins to the Pins Table” for a procedure to 
quickly add a series of pins.

Up/Down buttons Moves the selected Decal up or down.
The decal at the top of the list is the default decal and is used 
when you add the part to the design.

Check Part Checks for missing or inconsistent information.
Even if you do not click the Check Part  button, when you exit the 
tab, the assigned decals are checked to ensure that they contain 
physical pin numbers for all the gate and signal pins defined in the 
Pins  tab.

Save As Opens the Save Part Type to Library dialog box.

Related Topics
Creation of a New Part Type
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Part Information Dialog Box, Pins Tab
To access: File  menu > Library  > select a Library > Parts  button > select part > New  or Edit  button > 
Pins tab

Use the Pins  tab in the Part Information dialog box to assign gate pins, signal pins, and unused pins to 
the part. Typically, pin numbers on the Pins tab need to match those of the PCB decal. If your logical 
schematic symbol uses alphanumeric pin numbering and the PCB decal uses numeric pin numbering, 
use the Pin Mapping  tab to overlay logical (schematic) alphanumeric pin numbers onto the physical 
numeric PCB decal.

Objects

Field Description

Pins Table Double-click a column to sort the column by ascending order.

 Tip
Sorting by pin Sequence number or Pin Group has the same 
effect, it sorts by Pin Group and then by sequence number 
within each gate.

Pin Group column Select from Gate, Signal Pin, Connector Pin or Unused Pin.
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Field Description

• Gate Pins  — Assign to gates you have added to the part on the 
Gates  on page 1588 tab.

• Signal Pins  — Assign to implicit pins (pins which are not 
displayed on any gate in the schematic). Typically, ground and 
power pins are the only implicit pins. You are not required to 
use Signal Pins. Instead, you can add power and ground pins 
to a gate or create a separate gate for power and/or ground 
pins. For the parts in the libraries shipped with SailWind Logic, 
the standard ground signal name is GND. The standard power 
signal name is +5V.

• Connector Pins  — Assign to connector pins instead of using 
Gate pins. With a connector, every pin is its own gate in 
order to spread each connector pin throughout the schematic 
as needed, instead of having to create gates for each pin. 
You designate a part type as a connector on the General  on 
page 1590 tab.

• Unused Pins  — You can assign a pin to be an unused pin. An 
unused pin is a pin that is defined in a PCB decal but has no 
electrical function in the part type. The unused pin information 
is not saved in the part type, but is derived automatically based 
on the number of assigned gate and signal pins to the number 
of pins in the assigned PCB decal.

Number column Specifies the pin number for the pin.
The pin number must match the PCB decal. For example, 
alphanumeric to alphanumeric.

 Tip
If your logical schematic symbol uses alphanumeric pin 
numbering and the PCB decal uses numeric pin numbering, 
use the Pin Mapping  tab to overlay logical (schematic) 
alphanumeric pin numbers onto the physical numeric PCB 
decal.

Name column Specifies the pin signal or function name of the pin. The pin must 
have a name to be valid.

Type column Specifies the type of pin. This column is used with gate pins only.

Swap column Specifies an identical number between pins that can be swapped. 
Type 0 to disable swapping.

Seq. column Specifies the sequence number. The sequence number 
determines the mapping of CAE gate pins to PCB decal pins. 
The sequence is automatically shared with alternate CAE decals. 
For example, it shows how pin numbers appear on the CAE gate 
decal; therefore, in Gate A, sequence number 1 could be pin 1, but 
in Gate B, sequence number 1 would be pin 4.

Reset button Undoes all changes you made in the Pins  tab.

Edit button Makes the selected cell available for editing. Press the Ctrl key 
or the Shift key and click to select multiple cells from the same 
column, then click Edit to make the same changes to the selected 
cells. The action of the edit button depends on the cells you select:
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Field Description

• Pin Group column  — Opens the Update Pin Gate Dialog Box.

• Number column  — Opens the Renumber Pins Dialog Box.

• Name column  — Opens the Update Pin Name Dialog Box.

• Type column  — Opens the Update Pin Type Dialog Box.

• Swap column  — Opens the Update Pin Swap Dialog Box.

• Seq. column  — Not available for multiple cell edits.

Add Pin button Adds a new row below the selected row. If it's the first pin to be 
added it takes the default of belonging to Gate-A. If pins already 
exist, the new pin takes the Pin Group of the currently selected pin.
You must add a pin number to make the pin valid.

 Tip
• You can add all pins automatically by adding a decal.

• To add a series of pins, click the Add Pins button.

• To import pins using a comma separated value (.csv) file, click 
the Import CSV button.

Add Pins button Opens the Add Terminals Dialog Box.

 Restriction:
Total pins for the part can not exceed 32,767 pins.
 Tip

• You can add all pins automatically by adding a decal.

• To add a single pin, click the Add Pin button.

• To import pins using a comma separated value (.csv) file, click 
the Import CSV  button.

Delete Pins button Removes the selected row.

Renumber button Opens the Renumber Pins Dialog Box.

Copy button Places the selected cell information in the paste buffer.
You can also copy from Microsoft Excel.

Paste button Pastes the information from the paste buffer. The selected cell in 
the table is the paste origin. Data is pasted below and to the right 
of the paste origin.

 Restriction:
When the pasted data includes either Pin Group or Pin Number 
data, extra pin rows are added automatically, otherwise the 
paste will fail if the number of rows and columns in the pasted 
data does not match those available in the table below and to 
the right of the paste origin.

Import CSV button Opens the Library Import File dialog box where you select the .csv 
file to import.
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Field Description

 Tip
• The entire contents of the Pins  tab table is replaced with the 

data of the CSV file.

• CSV field names must correspond to the column headers in 
the Pins  tab table. Only the first two characters of the header 
must match. For example, “Pi” for the Pin Group column. Gate 
or “Ga” are acceptable alternatives to the Pin Group header.

• The sample Part_Pins_Template.csv  file is located in your 
\SailWind Projects\Samples  folder.

Check Part button Checks for missing or inconsistent information.
Even if you do not click the Check Part button, when you exit the 
tab, the assigned decals are checked to ensure that they contain 
physical pin numbers for all the gate and signal pins defined in the 
Pins  tab.

Save As button Opens the Save Part Type to Library dialog box where you choose 
your library and type a name for the part.

Related Topics
Adding a Series of Pins to the Pins Table

Editing Pins Table Data

Renumbering Pins in the Pins Table

Creation of a New Part Type
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Part Information Dialog Box, Pin Mapping Tab
To access: File  menu > Library  > select a Library > Parts  button > select part > New  or Edit  button > Pin 
Mapping tab

Use the Pin Mapping  tab in the Part Information dialog box to overlay alphanumeric pin numbers onto 
numeric PCB decal pins. Prior to PADS 2007, you could not save alphanumeric pin numbers in PCB 
decals.

Description

Note:
Requirements:

• On the General  tab, select the “Define mapping of Part Type pin numbers to PCB Decal” check 
box to make the Pin Mapping  tab available.

• On the PCB Decals  tab, assign a decal with sequential numerical pin numbers to use the Pin 
Mapping  tab. The decal determines the number of pins in the part.
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Objects

Field Description

Decal list Lists the decals available to you for which you can map 
alphanumeric pins.

Reset Undoes all changes you made in the Pin Mapping  tab.

Unmapped Pins list Lists all unmapped pins available to map in the Mapping table.

Map >> Moves the selected pin from the Unmapped pins list to the 
selected cell in the Mapping table.

<< Unmap Moves the selected decal number from the Mapping table to the 
Unmapped Pins list.

Mapping table • Decal column  — The pin numbers assigned to the pins in the 
Decal.

• Part Type column  — The pin numbers that are mapped to the 
Part Type. These pin numbers represents the values assigned 
to the pins on the schematic symbol. These can be derived 
from the Unassigned Pins list (if a decal has been assigned on 
the Pins  tab) or they can be manually entered in this table.

 CAUTION:
If there are any errors in the pin numbering that has been 
automatically populated from the Pins  tab, correct them 
by editing the table on the Pins  tab. Do not attempt to 
renumber pins in the table on the Pin Mapping  tab.

Edit Makes the selected cell available for editing.
You can also double-click the cell to edit the contents.

Copy Map Places the map information into the paste buffer to paste into 
Microsoft Excel where you can make mass edits.
Copy Map only works with the whole pin mapping table and not 
selective rows.

Paste Map Pastes the map information from the paste buffer.
Paste Map only works with the whole pin mapping table and not 
selective rows.

Preview area Shows the item selected in the Decal list.
You can assign unmapped pins to decal pins by selecting the pins 
in the preview window. Select an alphanumeric in the Unmapped 
Pins list and double-click the pin in the decal preview window to 
map the alphanumeric to the pin. The next row in the Unmapped 
Pins list becomes the next selected alphanumeric for mapping. In 
the preview window, you can click and drag to define a zoom box, 
or use Shift+click or Shift+right-click to zoom in or out by a factor 
of two. You can zoom in up to 16X the original scale. The preview 
window will only zoom out to fit the decal entirely in the view.

Check Part Checks for missing or inconsistent information.
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Field Description

Even if you do not click the Check Part button, when you exit the 
tab, the assigned decals are checked to ensure that they contain 
physical pin numbers for all the gate and signal pins defined in the 
Pins  tab.

Save As Opens the Save Part Type to Library dialog box.

Related Topics
Creating a Part Type with Different Schematic and Layout Pin Numbering

Mapping Alphanumeric Pin Numbers to Numeric Decals

Creation of a New Part Type
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Part Label Properties Dialog Box
To access: Select a part label > right-click > Properties  popup menu item

Use the Part Label properties dialog box to modify a label and to change the attribute the label displays.

Tip
If you select multiple labels, settings in this dialog box apply to all selected labels.

Objects

Field Description

Attribute The attributes available to you. If you are creating labels for 
jumpers, Reference Designator is the only available attribute.

SailWind Layout Guide and Reference 1603



GUI Reference Elements P
Part Label Properties Dialog Box  

Field Description

 Tip
Hidden attributes do not appear in the Attribute list unless 
the attribute was selected for the label before it was set as a 
hidden attribute.

Value for The value of the selected attribute.

 Tip
• Unavailable if you selected Reference Designator or Part Type 

from the Attribute list, if the attribute is read-only, or if you open 
the Properties dialog box for labels of different attribute types. 
However, if the labels you select belong to attributes of the 
same type, you can edit this box.

• If the attributes have different values, the box is blank. You 
can type a new value in the box to apply it to all of the selected 
attribute labels and their parent objects.

• Value is also unavailable if the attribute is ECO-registered and 
SailWind Layout is not in ECO mode.

Show Controls the visibility of the label.
• None  — Turns visibility off.

• Value  — Displays only the label value.

• Name and Value  — Displays the name and value.

• Full Name and Value  — When labeling a structured attribute 
on page 1862, displays the full structured name and value.

 Tip
Labels are invisible regardless of this setting unless you use 
the Display Colors Setup Dialog Box  to change the color of 
labels to a color different from that of the background.

Font The fonts available to you.

 Tip
• Select stroke font or a system font.

• For system fonts, you can also click a font style button, or any 
combination of styles: B for bold, I for italic, or U for underlined.

Layer The layers available to you.

Relative to Places the label at the X and Y location relative to the component 
or the jumper. If you clear this check box, the label is placed at the 
X and Y location relative to the design origin.

X,Y Places the decal label in a specified location.

Rotation Specifies the rotation angle of the label.

Size Specifies the size of the font.
Size (pts): This is font size in points and appears for system fonts
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Field Description

Size (mils): This is font character height and appears for stroke 
fonts. The size refers to the height of the tallest characters.

Line Width Specifies the line width for stroke fonts only.

Mirrored Flips the label - text is considered readable from the bottom side of 
the board.

Horizontal, Vertical Sets the horizontal and vertical justification of the text to ensure 
proper positioning between objects when text, attribute values, 
size, or width change.

 Tip
• For vertical justification, click Left, Center, or Right. For 

horizontal justification, choose Up, Center, or Down.

• Optionally, set justification by selecting the text, then 
right-clicking and clicking the Justify Horizontally  popup 
menu item, and then clicking Left, Center, or Right; and by 
right-clicking and clicking the Justify Vertically  popup menu 
item, and then clicking Up, Center, or Down.

Right reading Controls whether labels are readable (from left to right, or from 
bottom to top if the label is rotated). Click the None, Orthogonal, or 
Angled button to indicate the direction of reading you want.

Component button Opens the Component Properties Dialog Box.

Related Topics
Modifying Part Label Properties
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Part Type List for Decal Dialog Box
To access:

• Opens automatically when you open a decal in the Decal Editor

• Tools  > PCB Decal Editor  menu item > Tools  > Part Types  menu item

Use the Part Type List for Decal dialog box to check your part for errors. You can check to ensure the pins 
match the pins listed in the Part Type > Pins  tab table, or when pin mapping exists - on the Part Type > 
Pin Mapping  tab.

Objects

Field Description

Library column Displays the associated part type library.

Part Type column Displays the part type name.

Pin Mapping column Displays whether a pin mapping is defined.

Error Status column • No Errors  — No errors exist within the part type.

• Logical Errors  — Errors exist within the part type.

• Mismatched Pins  — The decal does not contain all the pin 
numbers defined in the part type.

Edit Part Opens the Part Information dialog box  on page 1590.
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Field Description

Show Errors Create and opens a report with details of the errors.

Refresh Updates the dialog box with any fixes you have made.

Check Decal Checks the decal against all associated part types to show all 
mismatched pin number errors.

Related Topics
Checking for Errors Between Part Types and Assigned PCB Decals

PCB Decal Editor
To access: Tools  > PCB Decal Editor

SailWind Layout uses components from the parts libraries. Every part in the library has a decal 
associated with a part type in a parts library. Use the PCB Decal Editor to create or edit these decals. 
Many of the drafting operations in the PCB Decal Editor are identical to those in the Layout Editor.

When the PCB Decal Editor opens, the open design is stored and the PCB Decal Editor interface 
replaces the Layout Editor. Use the File commands to save information and exit the PCB Decal Editor as 
you would a stand-alone program. When you exit the PCB Decal Editor, you return to the open design in 
SailWind Layout.

If during a PCB Decal Editor session you try to change the decal to increased layer mode and the current 
design is in default layer mode, the message “You will not be able to apply decal changes to the design. 
Continue?” appears. Either click Cancel to return to the Layers Setup Dialog box without changing the 
decal to increased layer mode, or click OK  to proceed to the Increase Maximum Layer Number dialog 
box. You can save the decal changes to library and choose to exit the PCB Decal Editor without applying 
changes. Then switch the current design to increased layer mode and update the decal.

Tip
• SailWind Layout supports 16 alternate decals per part type. The PCB Decal Editor supports up 

to 65,536 components.
• You can use Dimensioning within the PCB Decal Editor; however, dimensions are converted to 

2D lines and text when you save the decal.

Note:
Recommendation:  Place free text and attribute values on the Silkscreen Top layer to avoid DRC 
violations or shorts.

Related Topics
Creation of a New Part Type
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PDF Configuration Dialog Box
To access: File  > Create PDF  menu item

Use this dialog box to save one or more layers of your design as images in a PDF document. You can 
specify the contents of the document, its format, and its behavior, including the kinds of design items 
readers can search for, and how they are displayed.

Description
This dialog box displays its controls in two views--a “document” view and a “page” view.

The document view appears when the root item (a PDF configuration) is selected in the page list at the 
top left of the dialog box. Settings made in the Document view affect all pages in the document.

Figure 204. PDF Configuration Dialog Box, Document View

The page view appears when a single page is selected in the page list. Its controls affect only the 
selected page.
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Figure 205. PDF Configuration Dialog Box, Page View

Objects
Table  192. PDF Configuration Dialog Box Controls

Control/Area Description

Page-list Toolbar (Both views)

Add Page button Adds a page at the bottom of the Page list.

Import Configuration button Imports a PDF configuration from a .pdc  file.

Export Configuration button Exports the current dialog box settings (that is, the current 
configuration) to a new or existing configuration (.pdc) file.
Use this button to save the current dialog box settings and 
reuse them for other designs.

Delete Page button Deletes the selected page from the page list.

Move Page Up button Moves the selected page up in the Page list.

Move Page Down button Moves the selected page down in the Page list.

Page-list area (Both views)
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Table  192. PDF Configuration Dialog Box Controls  (continued)

Control/Area Description

Select the top of the Page list (the PDF configuration name) to 
display the Document view, where you specify options for the 
PDF document as a whole.
Select any individual page to display the Page view, where 
you specify options for the selected page.

 Tip
The Composite page, by default, includes all the selected 
layers. You can modify the layer assignments for this page 
(like all the other pages) with the Add layer and Remove 
layer buttons in the Selected layers area.

Preview area (Both views)

Shows the position of the selected design layer image(s) on 
the PDF page, as follows:

• The grey outer rectangle shows the available image area 
inside the margins and the header and footer.

• The dashed-line box shows the image boundary (scaled, if 
Scale to fit is selected).

• Inside the image boundary, the board outline is shown 
(scaled, if Scale to fit is selected).

Page <page_number>: edit box

Displays the name of the page selected in the page list. You 
can edit the page name here.

Image area (Both views)

Justification Specifies the position of the design layer image(s) on the PDF 
page. Select Bottom Left, Bottom Right, Centered, Top Left, 
Top Right, or Use offset.

X offset Specifies the distance of the lower left corner of the image 
boundary from the left side of the PDF page boundary.

Y offset Specifies the distance of the lower left corner of the image 
boundary from the bottom of the PDF page boundary.

 Tip
When the PDF Configuration is selected, this checkbox 
may display a greyed-out check mark or a small square; 
these indicate that the settings of the individual pages 
vary.

Scale Specifies the size of the PDF image as a percentage of the 
actual design size. For example:
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Control/Area Description

• 100%  — The image is displayed actual size.

• 50%  — The image is displayed half-size.

• 200%  — The image is displayed double-size.

Scale to fit Specifies that the PDF image should be enlarged or reduced 
to fit within the margins of the PDF sheet.

 Tip
When the PDF Configuration is selected, this check box 
may display a greyed-out check mark or a small square; 
these indicate that the settings of the individual pages 
vary.

Mirror image Flips the PDF image left/right.

 Tip
When the PDF Configuration is selected, this check box 
may display a greyed-out check mark or a small square; 
these indicate that the settings of the individual pages 
vary.

Mirror labels Flips standard and attribute labels left/right.

 Tip
When the PDF Configuration is selected, this check box 
may display a greyed-out check mark or a small square; 
these indicate that the settings of the individual pages 
vary.

Page area (Document view only)

Size Select a PDF page size, or select “Custom” to specify a 
non-standard sheet size.

X Specifies the width of the custom sheet in current design 
units.

Y Specifies the height of the custom sheet in current design 
units.

Orientation area (Document view only)

Specifies the orientation of the design image on the PDF 
sheet(s): Portrait, Landscape, or Best fit.

Color Scheme area (Document view only)

Specifies the color scheme for the PDF: Color (with design 
background color), Color with white background, or Black and 
White.

Bookmarks area (Document view only)
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Table  192. PDF Configuration Dialog Box Controls  (continued)

Control/Area Description

Create bookmarks for Create PDF bookmarks (Table of Contents entries) for the 
items selected (Components, Component pins, Net pins)

Highlight selection Specifies that the Acrobat PDF viewer should:
• Highlight an item when it is selected.

• If the item is located outside the PDF document window, 
pan to move it to the center of the window.

Pan to selection Specifies that the Acrobat PDF viewer should pan to an item 
when it is selected. The item will appear in the upper left 
corner of the PDF document window.

Zoom to selection Specifies that the PDF viewer should pan and zoom to an 
item when it is selected, using the zoom factor set in the 
Zoom factor field. The item will appear in the center of the 
PDF document window.

Zoom factor Sets the factor to be used when zooming to a selected item:
• 100% is the maximum; the item will occupy the entire 

window.

• 10% is the minimum; the item will occupy 10% of the 
window area.

Annotations area (Document view only)

Create annotations that will
display part attributes

Creates popup notes that display a part’s attributes when you 
left-click on the item. The list of attributes and their order is 
hard coded. Attributes cannot be added to the list. Here is the 
list and order:

• Ref Des

• Description

• Manufacturer #1

• PCB Decal

• Part Number

• Part Type

Visible rectangle around
object with annotations

Draws a dotted line rectangle around each annotated item.

 Note:
Clickable boxes around components are created as 
follows:

• Clickable boxes for top-mounted components will only be 
created on pages that include the top layer, solder mask 
top layer, paste mask top layer, silkscreen top layer or 
assembly top layer.

• Clickable boxes for bottom-mounted components will only 
be created on pages that include the bottom layer, solder 
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Table  192. PDF Configuration Dialog Box Controls  (continued)

Control/Area Description
mask bottom layer, paste mask bottom layer, silkscreen 
bottom layer or assembly bottom layer.

• For pages that do not contain specific references to the 
layers associated with top or bottom component layers, no 
clickable boxes are created.

Fonts area (Document view only)

Replace stroke font for labels
with:

Uses the font selected in the box to display labels that use 
Stroke font in the design.

B, I, and U buttons Applies any or all of Bold, Italic and Underline styles to labels 
converted from Stroke font.

Header and Footer area (Document view only)

Specifies optional text for the left, right and center of the 
header and footer. At the bottom of the list, select Custom 
to open the Custom String Dialog Box  and type your own 
custom text.

Assembly Options area (Page view only)

Use assembly variant Includes in the PDF document only components belonging to 
the variant selected in the Name: box.
The visibility of the following design items is affected:

• Component outlines top

• Component outlines bottom

• RefDes labels

• Part type labels

• Component attribute labels

Board Items area (Page view only)

Includes in the PDF document PCB design items not 
belonging to a specific layer. Select any or all of Board 
outline, Unrouted connections, Through-holes plated, and 
Through-holes non-plated.

Selected Layers area (Page view only)

List box Lists the layers that will be shown on this page of the PDF 
document.

Add Layer button Opens the Layer Selection dialog, where you can edit the list 
of layers assigned to this PDF page.

Remove Layer button Removes the selected layer(s) from the list.
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Table  192. PDF Configuration Dialog Box Controls  (continued)

Control/Area Description

Items on selected layer(s) area (Page view only)

Includes items in this page of the PDF document. Select any 
or all of Through-hole pads, SMD pads, Traces, 2D-Lines, 
Vias, Coppers, Hatch outlines, Pour outlines, Keepouts, 
Ref. des. labels, Part type labels, Text, Attribute labels, 
Component outlines top, Component outlines bottom, Test 
points, Partial drills, and Pin numbers.
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Pen Plotter Advanced Setup Dialog Box
To access:

• File  > CAM  menu item > Add  button > Pen  button > Device Setup  button > Advanced  button

• File  > CAM  menu item > select a document name > Edit  button > Pen button > Device Setup 
button > Advanced button

Use the Pen Plotter Advanced Setup dialog box to add a new pen plotter to the Device list of available 
plotters.

Restriction:
You cannot modify the PADS-supplied plotter advanced settings - you only edit the data for an 
existing plotter if it was created originally from this dialog box. The new plotter must support one 
of the two supported interface languages: HPGL or HGML. Other plotter languages or formats are 
not yet supported.

Objects

Field Description

Plotter Device Name Specifies the name of a different pen plotter you want to use.

 Restriction:
You cannot reuse one of the existing, supplied device names.

Device Type Specifies the interface language the plotter uses: HPGL or HGML.

Plotter Units area Sets the plotter resolution by providing a scaling ratio. The ratio defined 
is the scale factor to convert from mils (0.001 in) to plotter units.
Example: Most Hewlett-Packard plotters have a resolution of 0.025 mm 
or 1/40 mm. This means that a distance of one inch (1000 mils) is 1016 
plotter units (25.4 X 40). So a ratio of 1016 to 1000 would be defined. 
The ratio actually used is 254 to 250 which is the same as 1016 to 
1000.

Origin at Center Specifies that the origin of the plotter is at the center of the paper. Clear 
this check box if the origin is in the lower left corner or other location.
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Related Topics
Pen Plotter Setup Dialog Box

Creating CAM Outputs to Manufacture Your PCB
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Pen Plotter Setup Dialog Box

Pen Plotter Setup Dialog Box
To access:

• File  > CAM  menu item > Add  button > Pen  button > Device Setup  button

• File  > CAM  menu item > select a document name > Edit  button > Pen  button > Device Setup 
button

Use the Pen Plotter Setup dialog box to set various pen plot options.

Objects

Field Description

Number of pens Specifies the number of pens in your device (1-16).

Pen line width Specifies the line width of your pen in mils.

Rotate axis Reverses the X and Y axes of the design

Pen colors Specifies the color of each pen. To assign colors, select a color tile 
from the Selected color area and then click a pen number.
Tip: The assigned colors are used to customize CAM document objects 
through the Select Items Dialog Box.

Selected color Specifies the colors available for your Pen colors.

Plotting Size area Specifies the plotting size you want to use.
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Field Description

 Tip
To define a custom size, select Custom (mm) or Custom (inches), 
and then type the X and Y dimensions to use.

Device Specifies the plotter device to use. If you can't find your device in the 
list, click Advanced to open the Pen Plotter Advanced Setup Dialog 
Box and create a new device listing.

Advanced Opens the Pen Plotter Advanced Setup Dialog Box.

Related Topics
Creating CAM Outputs to Manufacture Your PCB
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Photo Plotter Advanced Setup Dialog Box
To access: File  > CAM  menu item > Add  or Edit  button > Photo  button > Device Setup  button > 
Advanced  button

Use the Photo Plotter Advanced Setup dialog box to customize the output of photo plot files.

Objects

Field Description

Units Sets the CAM file measurement units.
• English  — mils

• Metric  — millimeters

Leading Specifies the precision of the output file coordinates; the number of 
digits that should lead the decimal point.

Trailing Specifies the precision of the output file coordinates; the number of 
digits that should trail the decimal point.

Coordinates Sets the coordinates for the output file.
• Absolute  — referenced to the origin.

• Incremental  — measured relative to the previous coordinate.

Suppress repeated coords Eliminates repeated coordinates from the output file.

Zero suppress Defines how to handle zero suppression in the output file.

SailWind Layout Guide and Reference 1619



GUI Reference Elements P
Photo Plotter Advanced Setup Dialog Box  

Field Description

• None  — retains leading and training zeros.

• Leadin  — suppresses zeros before the decimal point.

• Trailing  — suppresses zeros after the decimal point.

Circular interpolation Defines how to draw arcs and circles:
• None — Specifies that your photo plotter does not support circular 

interpolation. Arcs and circles are drawn as small straight-line 
segments.

• Quadrant — Specifies that your photo plotter does not support full, 
360-degree circular interpolation.

• Full  — Specifies that your photo plotter supports full, 360-degree 
circular interpolation.

 Restriction:
These options are only available for the RS-274-D format. If you 
select RS-274-X format, these options are unavailable and is 
automatically set to Full. All devices that support RS274X support 
this setting.
 Tip
Use RS-274-X output to avoid generating a large number of hatch 
lines in the Gerber output. This also applies to copper chamfered 
paths.

Output format Specifies the output format you want to use. The RS-274-X data format 
has more features and contains embedded aperture information while 
the RS-274-D format is older and uses a separate file for aperture 
information.

 Restriction:
When you select RS274X:

• The Circular Interpolation options are unavailable and is 
automatically set to Full. All devices that support RS274X support 
this setting.

• The Aperture Count in the Photo Plotter Setup Dialog Box  is 
unavailable and is automatically set to 989. All devices that support 
RS274X support this setting.

 Tip
The Output Format setting is saved in the devicesn.dat  file with all 
other photo plotter data.

Plotting size list Sets the plotting size, select a standard Plotting size from the list, 
or select Custom (Inches) or Custom (mm) and enter the X and Y 
dimensions to define a custom size.

Use fill mode (G36, G37) Uses fill mode to draw all filled regions (including solid shapes and 
system font texts) in the design. Fill mode avoids generating a large 
number of hatch lines in the Gerber output. This also applies to copper 
chamfered paths.

 Restriction:
Cleared and unavailable when RS-274D is selected as the output 
format.
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Field Description

 Tip
When this option is selected, the “Use fill mode for solid shapes” 
and “Use fill mode for system font texts” options are selected and 
unavailable.

Note: This option uses G36, G37 pairs to draw filled regions. All filled 
regions for which fill mode is not specified by one of these commands 
are plotted as hatched by strokes.

Use fill mode for solid shapes Uses fill mode to draw shapes having the “solid copper” property. Fill 
mode avoids generating a large number of hatch lines in the Gerber 
output. This also applies to copper chamfered paths.

 Restriction:
• Cleared and unavailable when RS-274D is selected as the output 

format.

• Selected and unavailable when “Use fill mode(G36, G37)” is 
selected.

 Note:
This option uses G36, G37 pairs to draw filled regions. All filled 
regions for which fill mode is not specified by one of these 
commands are plotted as hatched by strokes.

Use fill mode for system font 
texts

Uses fill mode to draw system font texts. Fill mode avoids generating 
a large number of hatch lines in the Gerber output. This also applies to 
copper chamfered paths.

 Restriction:
• Cleared and unavailable when RS-274D is selected as the output 

format.

• Selected and unavailable when “Use fill mode(G36, G37)” is 
selected.

 Note:
This option uses G36, G37 pairs to draw filled regions. All filled 
regions for which fill mode is not specified by one of these 
commands are plotted as hatched by strokes.

Use aperture macros Defines aperture macros for associated pin copper in the RS-274-X 
Gerber files. When this option is off, associated coppers are hatched 
coppers, as in RS-274-D output. This prevents the reuse of D-codes 
that are not supported in some software.

Related Topics
Creating CAM Outputs to Manufacture Your PCB

RS-274-X Format
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Photo Plotter Setup Dialog Box
To access:

• File  > CAM  menu item > Add  button > Photo  button > Device Setup  button

• File  > CAM  menu item > select a document name > Edit  button > Photo button > Device Setup 
button

Use the Photo Plotter Setup dialog box to set up photo plotting and send your output to a plotter

Objects

Field Description

D-Code Contains the apertures required for the Photo Plotter. The D-Code 
list can be created automatically or you can maintain it manually. The 
D-Code list contains all defined apertures.

 Tip
Before you generate your CAM files, regenerate your list of 
apertures.

Add button Adds a new D-code to the D-Code list.
Type a value excluding the “D” prefix.

Delete button Removes the selected D-code from the D-Code list.

Augment button Automatically generates D-codes for items in the design file that are not 
in the current list.
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Field Description

 Tip
Augment adds oval and rectangular flash apertures for orthogonal 
orientations only.

Regenerate button Clears the current D-code list and automatically adds D-codes for all 
items in the design.

 Tip
Regenerate adds oval and rectangular flash apertures for 
orthogonal orientations only.

Flashes Sets a flash aperture.

Lines Sets a line aperture.

 Restriction:
Unavailable if Same aperture for flashes/lines is selected.

Same aperture for 
flashes/lines

Specifies to draw lines and flashed items with the same aperture.

Width Specifies a width for square, rectangle, and oval shapes or the outer 
diameter of round and thermal shapes.

 Restriction:
This box is unavailable if a value is not appropriate for the specified 
shape.

Height Specifies a height for oval and rectangular shapes.

 Restriction:
This box is unavailable if a value is not appropriate for the specified 
shape.

Inner diam Specifies an inner diameter for annular ring shapes

 Restriction:
This box is unavailable if a value is not appropriate for the specified 
shape.

Augment on-the-fly Automatically adds apertures as you add information to the design.

Aperture count Specifies the maximum aperture count.

 Restriction:
When you click RS-274-X format in the Photo Plotter Advanced 
Setup Dialog Box, the aperture count is set to 989 and is 
unavailable.

Fill width Specifies the width used for shapes to be filled. An example shape 
is a non-orthogonal pad. Larger widths decrease photo plot time but 
provide a less precise approximation of the shape.

Texts fill width Specifies the width used for hatching of system texts. Larger widths 
decrease photo plot time but provide a less precise approximation of 
the text.

SailWind Layout Guide and Reference 1623



GUI Reference Elements P
Photo Plotter Setup Dialog Box  

Field Description

Advanced button Opens the Photo Plotter Advanced Setup Dialog Box

Related Topics
Creating CAM Outputs to Manufacture Your PCB
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Pin Numbers Dialog Box
To access: (PCB Decal Editor) Setup  > Pin Numbers  menu item

Use the Pin Numbers dialog box to interactively renumber the terminals in the design area. Selecting pin 
numbers in the dialog box selects the matching pins in the design area, and selecting pins in the design 
area selects the matching pins in the dialog box.

Objects

Field Description

Number The number of the pin available for renumbering.

Edit Makes the selected pin number available for editing.

Renumber Opens the Renumber Pins Dialog Box.

Copy Places the selected pin numbers into the paste buffer.

Paste Pastes the pin number information from the paste buffer.
Data only pastes into selected cells.
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Related Topics
Renumber Using the Pin Numbers Dialog Box
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Pin Pair Properties Dialog Box
To access: Select a pin pair > right-click > Properties  popup menu item

The Pin Pairs Properties dialog box displays the netname of which the pin pair is part, the pin-to-pin 
connection, routing information, and rules data.

Restriction:
Several of the options in this dialog box are unavailable if the pin pair is part of a physical design 
reuse or contains protected routes.

Description
The Pin Pair Properties dialog box remains open until you click OK  or Cancel. If you select another pin 
pair while the dialog box is open, the information updates for the selected pin pair.

Objects

Field Description

Net Displays the net name of the pin pair.

Connection Displays the component pin and/or virtual pin connections that define the pin 
pair. For each component pin connection point, the reference designator of the 
component is listed first, followed by a period, then the pin number. For each 
virtual pin, the instance of the virtual pin in the format VP<number> is listed

Layout Data area Displays all layout data about the selected pin pair.
• Coordinates  — Display the coordinates of pins that define the pin pair.

• Unrouted Length  — Displays the length of the pin pair that is unrouted. 
Includes half the Discrete length value of each connected pin of components 
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Field Description
that have a Discrete length assigned. When routed to the pad, measurements 
are made to the origin of the pad.

• Routed Length  — Displays the length of the pin pair that is routed.

• Via Count  — Displays the number of vias that are used in the pin pair.

• Impedance (ohm)  — displays a baseline impedance value of the pin pair. 
This calculation uses the trace parameters, the board material values you set 
in the Layer Parameter Setup Dialog Box, and require at least one adjacent 
plane to display values. A maximum of two adjacent planes are used in the 
calculation. If the plane layer is a split/mixed plane layer, you must have a 
plane shape on the layer. The location and outline of the shape and cutouts 
of the plane area are all ignored in the calculation.

You can set a Minimum and Maximum Impedance rule in the HiSpeed Rules 
Dialog Box, but it is only verified when you run Tools > Verify Design  on 
page 1775 after you set up a High Speed check  on page 1363 to check 
Impedance. It is not verified by online DRC  on page 1843.

• Delay (ns)  — displays a baseline delay value of the pin pair. This calculation 
uses the trace parameters, the board material values you set in the Layer 
Parameter Setup Dialog Box, and require at least one adjacent plane 
to display values. A maximum of two adjacent planes are used in the 
calculation. If the plane layer is a split/mixed plane layer, you must have a 
plane shape on the layer. The location and outline of the shape and cutouts 
of the plane area are all ignored in the calculation.

You can set a Minimum and Maximum Delay rule in the HiSpeed Rules 
Dialog Box, but it is only verified when you run Tools > Verify Design  on 
page 1775 after you set up a High Speed check  on page 1363 to check 
Delay. It is not verified by online DRC  on page 1843.

Protect Routes Protects selected routes  on page 1855 or traces  on page 1867 from being 
moved. Similar to gluing components but you can allow protected traces to be 
edited by SailWind Router in the Routing Rules  on page 1666.
See also: “Route and Unroute Protection”.

Protect Unroutes Protects unrouted connections and the unrouted portions of partial routes  on 
page 1846. Protected unroutes cannot be modified or routed.
See also: “Route and Unroute Protection”.

Rules Data area Displays some rule information for the selected pin pair.
• Group  — If the pin pair is included in a Group rule, the Group name is 

displayed.

• Rule Hierarchy  — Displays one of the following from lowest priority to 
highest priority:

• “Default” is shown if the pin pair is using the Default rules.

• “Class” is shown if the pin pair is getting its rules from a Class rule. Click 
the Net button to open the Net Properties and see the name of the Class 
to which the net belongs.

• “Net” is shown if the pin pair is getting its rules from the Net rules.

• “Group” is shown if the pin pair is getting its rules from a Group rule. The 
group name will be shown immediately above.

• Pin Pair” is shown if the pin pair has its own rules.
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Field Description

• Trc/Trc Clearance  — Displays the Trace to Trace clearance value from the 
Clearance Rules Dialog Box. See the Rule Hierarchy above to determine 
if the value is from the Default, Class, Net, Group or Pin Pair level rules. 
Conditional rules are not shown.

• Width  — Displays the Recommended Trace Width from the Clearance Rules 
dialog box.  on page 1167See the Rule Hierarchy above to determine if the 
value is from the Default, Class, Net, Group or Pin Pair level rules.

Trace Width Modifies the trace width. Type a new value in the box. You are restricted to the 
range of Trace widths you have specified in the Clearance Rules dialog box.  on 
page 1167This option is unavailable if the Protect Routes checkbox is selected.

Rules button Opens the Pin Pair Rules Dialog Box  with the pin pair preselected in order to 
apply Pin Pair level rules.

Net button Opens the Net Properties dialog box  on page 1487 of the net to which the pin 
pair belongs.

Related Topics
Modifying Pin Pair Properties
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Pin Pair Rules Dialog Box
To access: Setup  > Design Rules  menu item > Pin Pairs  button

Use the Pin Pair Rules dialog box to define design rules that apply to pin pairs.

Objects

Field Description

Connections list Lists all connections in the design.

Show pin pairs with rules Specifies to show only pin pairs that have rules.

From net Specifies to display pin pairs for a specific net.
Select (All_nets) to display all pin pairs.

Clearance Opens the Clearance Rules Dialog Box.

Routing Opens the Routing Rules Dialog Box.

HiSpeed Opens the HiSpeed Rules Dialog Box.

Report Opens the Rules Report Dialog Box.

Picture below rule button The picture below each type of rule button identifies which rules 
hierarchy level is used for that rule type. The meaning of the picture 
corresponds to the button in the Hierarchy area of the Rules Dialog 
Box. For example, if you select a class in the Class list and a green 
polygon appears below the Clearance button, then the default values 
apply to the class.
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Net: Lists the net(s) associated with the pin pair(s) selected in the 
Connections list.

Selected: Lists the pin pair(s) selected in the Connections list.

Default Removes non-default rules from the selected connections, so that only 
default rules apply.

Related Topics
Creating Pin Pair Design Rules

Resetting Pin Pair Rules to Default Rules

Design Rule Hierarchy
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Pin Properties Dialog Box
To access: Select a pin > right-click > Properties  popup menu item

The Pin Properties dialog box displays the component's reference designator, the pin number, pin type, 
function (pin name), swap identification, netname, and coordinates of the selected pin.

Note:
If you select another pin while the dialog box is open, the dialog box updates with information 
about the newly selected pin.

Objects

Field Description

Ref. Des. Displays the reference designator name.

Pin No Displays the numeric or alphanumeric pin number. This is the logical 
pin number if a pin mapping exists in the part type, otherwise the 
physical pin number is displayed.
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Field Description

Decal Pin Displays the decal pin number when pin mapping exists in the part 
type. The physical pin number is shown since the Pin No item only 
displays the logical pin number when there is pin mapping.

Pin type Displays the pin type. For example, S is shown for a source pin, P is 
shown for a Power pin.

Function Displays the pin name.

Connection Lists the connection of which the pin pair is a part.

Teardrops Turn off the Teardrops check box to remove teardrops from the 
selected pin.
If Generate Teardrops is not turned on in the Options dialog box > 
Routing  category > General subcategory  on page 1542, this option is 
unavailable.

Plane Thermal Determines whether the pin or via is eligible to receive a thermal  on 
page 1866.

 Restriction:
This check box is unavailable if the pin is a no-connect.

The status of a thermal is set individually by pin and via, and the 
thermal indicators will appear on plane layers only. Click to clear this 
check box if you do not want the via or pin to connect to any plane.
Once a pin or via is eligible, it is not automatically assigned a thermal 
attribute.
See also: “Setting Pins and Vias as Thermals  on page 797”.

Test Point Makes the via or pin a test point. This is a three-state check box  on 
page 1866.
See also: “Performing a Test Point Audit”.
You can make all selected vias or pins test points by turning Test Point 
on and choosing Apply. You can remove the test point from all selected 
vias or pins by turning Test Point off and choosing Apply. When you 
click Apply the pad stack is automatically checked to see if the via or 
pin can be a test point; for example, you cannot make buried vias test 
points because a probe cannot access a buried via.

 Tip
When the via or pin is flagged as a test point, and Show Test 
Points is checked in the Options dialog box > Routing  category > 
General subcategory  on page 1542, an arrow is drawn on it in the 

design:

Top Access Attempts to probe the test point from the top and bottom in DFT Audit. 
The default is bottom; so with Top Access off, DFT Audit automatically 
tries to probe the test point from the bottom.
See also: “Performing a Test Point Audit”.
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Field Description

When you click Apply, the pad stack is automatically checked to see if 
top access is valid; for example, you must assign Top Access to partial 
vias with only top access if you want to use the vias as test points.
You can only set the Top Access option if the via or pin is a test point 
(Test Point is on).

Pad Stacks button Opens the Pad Stacks Properties Dialog Box  where you can modify the 
pad stack.
If you make a change to the pad stack and the pin or via is locked, the 
Warning: Test Point Locked dialog box  on page 995 opens.

Component button Opens the Component Properties Dialog Box  where you can edit the 
component location.

Attributes button Opens the Object Attributes Dialog Box  and displays attribute 
information for the selected objects. You can view and modify nail 
diameter and nail number pin attributes for component pins, vias, and 
jumper pins, including test point attributes.

Related Topics
Modifying Pin Properties
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Place Clusters Setup Dialog Box
To access: Tools  > Cluster Placement  menu item > Place Clusters  button > Setup  button

Use the Place Clusters Setup dialog box to place the clusters based on connectivity and topology. Place 
Clusters treats all top-level objects with glued members as glued. Place Clusters assumes that pin 
positions of top-level cluster members are located in the center of the top-level cluster regardless of the 
glued member positions.

Objects

Field Description

Board Outline Clearance Determines how much clusters spread out within the board outline. 
This option works like Percent Part Expansion for positioning parts 
within the board outline.

 Tip
Place Part Rules are shared between Place Clusters Setup 
and Place Parts Setup; changing the value in one dialog box 
automatically updates the other.

Percent Part Expansion Controls the amount of free space around parts relative to the total 
board area. A setting of 0% places parts as close together as possible. 
Set this value to 100% to place parts as far apart as possible.

• Auto  — Sets a default value of 75%.

• Manual  — Sets a user-defined value.

 Tip
Place Part Rules are shared between Place Clusters Setup 
and Place Parts Setup; changing the value in one dialog box 
automatically updates the other.
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Field Description

Efforts area Adjusts the pass options in the lower half of this dialog box.
• Recommended  — Uses the default values for Number of Iterations 

and Attempts per Iteration.

• High  — Doubles the default values for Number of Iterations and 
Attempts per Iteration.

• Let Me Specify  — Enables the four Iteration and Swapping options 
so you can specify the values.

Place Clusters Enables placement operations. Clear this option to use only the Refine 
Pass portions of the routine for minor adjustments to already placed 
clusters.

Start Point area • Current Position  — Bases automatic placement of clusters on 
the part's current position. This is useful when clusters are already 
located in the board outline; because it tries to maintain the current 
position.

• Random Position  — Bases placement of clusters on a random 
position. This option advanced algorithms to place clusters that exist 
outside the board outline.

Display On Screen Displays an outline of each part and its movement throughout the 
automatic placement process.

Adjust Clusters Adjusts placed clusters using different values for number of iterations, 
attempts, swapping, and clearance values set in the Efforts area. To 
activate, click Let Me Specify.

Number of Iterations Specifies the number of placement passes to make. The default value 
accommodates most average designs. Use a lower number for small 
designs and faster processing. Use a higher number for large or dense 
designs.

Attempts per Iteration Within each iteration, attempts are made to position parts, minimize net 
lengths, reduce part overlaps, and keep parts inside the board outline. 
Increase this value to group parts closer together and closer to glued 
parts during an iteration.

Percent from Part Swapping During each iteration, parts, clusters, and unions are either swapped 
with other parts or repositioned to improve placement. Use this feature 
to increase the amount of swapping that occurs instead of moving 
parts.

Component Clearance Determines the distance that clusters spread out within the board 
outline. This option works like the Percent Part Expansion option for 
positioning parts within the board outline.

Related Topics
Automatic Placement

Cluster Placement
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Place Parts Setup Dialog Box
To access: Tools  > Cluster Placement  menu item > Place Clusters  button > Setup  button

Use the Place Parts Setup dialog box to control how SailWind Layout handles parts during Automatic 
Placement.

Objects

Field Description

Board Outline Clearance Determines how much clusters spread out within the board outline. 
This option works like Percent Part Expansion for positioning parts 
within the board outline.

 Tip
Place Part Rules are shared between Place Clusters Setup 
and Place Parts Setup; changing the value in one dialog box 
automatically updates the other.

Percent Part Expansion Controls the amount of free space around parts relative to the total 
board area. A setting of 0% places parts as close together as possible. 
Set this value to 100% to place parts as far apart as possible.

• Auto  — Sets a default value of 75%.

• Manual  — Sets a user-defined value.

 Tip
Place Part Rules are shared between Place Clusters Setup 
and Place Parts Setup; changing the value in one dialog box 
automatically updates the other.
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Field Description

Place Parts Enables part placement operations. Clear this option to use only 
the Improve Pass portions of the routine for overlap and alignment 
operations.

Efforts area Adjusts the pass options in the lower half of this dialog box.
• Recommended  — Uses the default values for Number of Iterations 

and Attempts per Iteration.

• High  — Doubles the default values for Number of Iterations and 
Attempts per Iteration.

• Let Me Specify  — Enables the four Iteration and Swapping options 
so you can specify the values.

Start Point area • Current Position  — Bases automatic placement of unglued 
parts on the part's current position. This is useful when parts are 
already located in the board outline; because the current position is 
maintained when possible.

• Random Position  — Bases placement of parts on a random 
position. This uses advanced placement algorithms to create new 
placements.

Number of Iterations Specifies the number of placement passes to make. The default value 
accommodates most average designs. Use a lower number for small 
designs and faster processing. Use a higher number for large or dense 
designs.

Attempts per Iteration Within each iteration, attempts are made to position parts, minimize net 
lengths, reduce part overlaps, and keep parts inside the board outline. 
Increase this value to group parts closer together and closer to glued 
parts during an iteration.

Percent from Part Swapping During each iteration, parts, clusters, and unions are either swapped 
with other parts or repositioned to improve placement. Use this feature 
to increase the amount of swapping that occurs instead of moving 
parts.

Percent Equivalent Swaps During part swapping, either equivalent or non equivalent swaps are 
made. An equivalent swap would be between two parts (or unions) 
that have the same extents. Setting this value to 100% to swap only 
equivalent parts.

Eliminate Overlaps Moves overlapping parts without violating the Percentage Part 
Expansion setting. The Percentage Part Expansion setting is lowered 
if necessary to eliminate overlaps, but will not exceed the setting for 
Minimum Percentage Expansion Allowed.

Minimum Percentage 
Expansion Allowed

Sets the lowest Percentage Part Expansion setting allowed during the 
eliminate overlaps pass.

Align Parts Enables an alignment pass that adjusts neighboring parts to improve 
routability.

Only if No Overlaps Prohibits the alignment pass if overlaps are present.
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Place Parts Setup Dialog Box

Field Description

Display On Screen Displays an outline of each part and its movement throughout the 
automatic placement process.

Related Topics
Automatic Placement

Cluster Placement
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Plane Layer Nets Dialog Box
To access: Setup  > Layer Definition  menu item > select a plane layer > Assign Nets  button

Use the Plane Layer Nets dialog box to assign or unassign nets with plane layers. CAM (Negative) planes 
should only have one net assigned. Split/Mixed may have multiple nets assigned. Plane layers contain 
large copper areas that components can access for ground and power. CAM output produces thermal 
relief connection pads for nets associated with the plane layer.

Objects

Field Description

All Nets Lists all nets in the design which you can associate to the plane 
area.

Assigned Nets Lists the nets associated with the plane.

Add >> Adds the net selected in the All Nets list to the Assigned Nets list, 
thus associating the net with the plane.

<< Remove Removes the net selected in the Assigned Nets list to the All Nets 
list, thus breaking the association between the net and the plane.

Related Topics
Setting Up an Outer Layer

Setting Up an Inner Layer
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Plot Options Dialog Box
To access:

• File  > CAM  menu item > Add  button > Options  button

• File  > CAM  menu item > select a document name > Edit  button > Options  button. If you selected 
NC Drill as the Document Type, the NC Drill Options Dialog Box  opens instead.

Use this dialog box to set plotting options.

Note:
You can also use this dialog box to gain access to the “Drill Symbols dialog box”  on page 1334.

Description
Use the Plot Positioning settings to create the best view of your design on the page that you print or 
pen plot. But more importantly, use the Plot Positioning settings to ensure that all the documents of the 
layers of your design align perfectly with one another. The most efficient way to correctly align your layers 
involves using board or global fiducials and using the two-adjacent-sides types of plot justification.

Use the Preview window to help determine the correct positioning with regard to your output - whether a 
file or a page.

Tip
Jumper pins of SMD jumpers are output on the paste mask layer, similar to SMD component 
output.

SailWind Layout Guide and Reference 1641



GUI Reference Elements P
Plot Options Dialog Box  

Objects

Field Description

Orientation list Sets the orientation angle of the design. Choose from 0, 90, 180 or 270 
degrees rotation.

Justification list Specifies the justification for the plot. Edge style/corner justifications 
use the outermost object and are best used in conjunction with 
board/global fiducials. Choose from:

• Centered  — Centers the design within the output media 
boundaries.

• Bottom Left  — Aligns output to the bottom left corner of the output 
media.

• Bottom Right  — Aligns output to the bottom right corner of the 
output media.

• Top Left  — Aligns output to the top left corner of the output media.
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Field Description

• Top Right  — Align output to the top right corner of the output 
media.

• Offset  — Aligns output origin to the x and y offsets.

• Scale to Fit  — Scale to Fit automatically adjusts the scaling so that 
the entire output is visible within the output media boundaries.

Scaling Defines the plot-size to actual- size ratio.

 Tip
Two to one (2:1) scaling results in a plot that is twice the actual 
size.

X/Y Offset Defines margin offsets which lets you move the design within the 
output media boundaries. The values used for the offset place the 
origin of the design at that point.

 Restriction:
Unavailable for Centered and Scale to Fit justifications.

Mirror Image Specifies to mirror the image.

Mirror Ref. Des. Specifies to mirror reference designators.

Suppress Ref. Des Specifies the reference designators you want to suppress.
Type the prefixes of all reference designators, a specific reference 
designator, or specify a range of reference designators, separated by 
commas. Use use a tilde to suppress a range of designators. Do not 
add spaces between listings. For example,   J,U1,R2~5.

Exclude Pads Specifies to exclude the parts represented by the reference designators 
specified in the Ref. Des. box from the CAM document.

 Restriction:
This check box is only available for Solder Mask and Paste Mask 
outputs.

Plot Job Name Specifies to plot the .pcb  name, time, and date on the plot.

 Restriction:
This option is unavailable if the output device is a photo plotter.

Plot Window Specifies to plot only the current view in the Layout Editor. Clear this 
option to plot the entire design.

 Tip
Pad flashes only appear in the plot output if the flash center is 
within the layout window.

Plot OLE Objects Specifies to plot OLE objects. This option is only available when you 
print the output. You cannot photoplot or pen plot OLE objects.

 Restriction:
You cannot select this option unless the orientation is set to zero.
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Field Description

 Tip
OLE objects do not appear in the CAM Preview Dialog Box, 
but they are used in the calculation when the plot location is 
determined.

Filled Lines/Pads Specifies to plot filled lines and pads. Drawing times are faster when 
lines and pads are unfilled.

Over(under)size Pads By Creates global oversized or undersized pads and vias with positive or 
negative values.
See also: “Control of Solder Mask and Paste Mask”  on page 209.

 Restriction:
Beginning with PADS2007, the Over(Under)size value only applies 
to electrical layers. To apply the value to all layers, see “Applying 
the Over(Under)size Value to All Layers”  on page 960.
 Tip

• In plane plots, this option also creates clearances. A positive value 
increases the plotted pad size; a negative value decreases the 
plotted pad size.

• You can also use this option to oversize or undersize a pad or 
thermal shape on a plane layer. When defining pads or thermals 
using this option, you cannot define different undersize or oversize 
amounts per pad, but you gain design time because you do not 
have to set size or layer requirements in the library or pad stacks.

Generate CAM Plane Via 
Thermals

Creates thermals for vias associated with the plane net. If this option is 
cleared, thermals are not created, and solid connections to all plane net 
associated vias are output. This option is available only for CAM plane 
plots.

Use Custom Thermal Settings Specifies to use thermal and aperture settings defined in the Pad 
Stacks Properties dialog box.  on page 1566
If you disable this setting, CAM plane thermals are generated 
according to a set of parameters. See the Results section of “Creating 
a CAM Plane Gerber-format File”  on page 951.

 Note:
Requirement:  CAM planes using custom antipads defined in the 
Pad Stacks require that you select the Remove Unused Pads 
check box in the Options dialog box > Copper Planes  category > 
Thermals subcategory  on page 1514. Default antipad settings are 
used if this setting is not enabled.

This option is available only for CAM plane plots and only when 
RS-274-X is selected as the photo plotter output format. Custom 
thermals, by default, use the pad size plus the clearance to define 
thermal spokes, whereas default CAM plane thermals use the pad 
size for the outer width of the thermal spokes. When brought into 
CAM350, these shapes are too large. Modify these pads accordingly 
for CAM350.

 Restriction:
Custom thermals for CAM plane layers do not work with the 
RS-274-D photo plotter output format selected.
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Field Description

Drill Symbols button Opens the “Drill Symbols dialog box”  on page 1334 where you can 
select the drill symbols you want to use with the drill drawing.

 Restriction:
The Drill Symbols button is only available when you select the Drill 
Drawing document type.

Preview area Displays the positioning of the design with regard to the plot area or 
printed page as you make changes to the options. document.
The blue outline shows the board outline of your design with respect 
to the plot area. When creating a drill drawing, the preview area 
also displays the position of the Drill Chart (if enabled) with a 
magenta-colored rectangular outline. You may need to reposition the 
drill chart to keep from overlapping your design. See “Creating a Drill 
Drawing with Drill Table”  on page 954 for more information.

Draw Chart Specifies to include the drill chart in the plot.

X/Y Location Specifies the location of the drill chart in design units.

Related Topics
Creating CAM Outputs to Manufacture Your PCB

SailWind Layout Guide and Reference 1645



GUI Reference Elements P
Process Status Dialog Box  

Process Status Dialog Box
To access: Compare/ECO dialog box  on page 1185 > select Generate ECO File check box > click Run.

Use the Process Status dialog box to monitor the .eco  (and .asc) generation progress, display the reports, 
or cancel the process being run by the Compare/ECO process when creating an .eco  file.

Description
This dialog box has two different views depending on whether Forward Annotation or Backward 
Annotation are occurring.

• Forward Annotation dialog  — described in Table 193.

• Backward Annotation dialog  — described in Table 194.

Figure 206. Process Status Dialog Box - Forward Annotation

Figure 207. Process Status Dialog Box - Backward Annotation
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Objects
Table  193. Process Status Dialog Box - Forward Annotation Contents

Field Description

Loading Library Parts to SailWind 
Layout

Displays the status of importing the library part changes into 
SailWind Layout.
This option only appears when you choose to update part types in 
the library by importing the .p  file generated by PADS Designer.

Producing ECO file by comparing 
Designs

Displays the status of generating the .eco  by comparing designs.
Click Show Report to display the .eco  file and the .log  file.

Loading ECO file to Original 
Design

Displays the status of importing the .eco  file into SailWind Layout 
to update the design with changes forward annotated from the 
schematic software.
This option only appears when you choose to update the original 
design on forward annotation
Click Show Report to display the eco.err  file.

Table  194. Process Status Dialog Box - Backward Annotation Contents

Field Description

Producing ECO file by comparing 
Designs

Displays the status of generating the .eco  by comparing designs.
Click Show Report to display the .eco  file and the .log  file.

Producing SailWind Layout ASCII 
file for backward annotation

Displays the status of exporting the .asc  file used in backward 
annotation to PADS Designer.

 Restriction:
This item is only shown when performing back annotation and 
when you select the Generate ASCII File for Back Annotation 
to Schematic check box.

Click Show Report to display the Layout.err  file.
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Project Explorer
To access: Click the Project Explorer  button. The Project Explorer is not available in the PCB Decal 
Editor.

The Project Explorer shows a hierarchical structure for the objects in your design. It provides access 
to objects and rules. When you update your design, the hierarchical structure updates automatically to 
reflect the changes you make.

Tip
The Hierarchical structure is available only when a design is open.

Objects
In the right-click menu, if you enable the "Expand all on selection" option, the corresponding branch is 
expanded when an object is selected in the design. For example you select a net in the design and it 
expands the Nets branch of the Project Explorer.

Objects in the Project Explorer are placed in object groups. Object groups are of two types: primary and 
secondary. You cannot remove or rename primary object groups. Modification of secondary group items is 
only available in SailWind Router.

The following table lists and describes the primary and secondary object groups.
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Table  195. Object Groups and Subgroups

Primary Group Secondary Group Description

Electrical layers Lists all electrical layers, including plane 
layers and routing layers

Layers

General layers Lists all other layers except electrical

Components Lists all components and pin pairs

Part decals/PCB decals Lists all part decals in the design or all 
components that use the selected part decal

Nets Lists all nets in the design

PCB decals Lists the PCB decals used in the design

Related Topics
Selecting Design Objects Using the Project Explorer

Zooming to a Design Object Using the Project Explorer
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Chapter 53
GUI Reference Elements Q Through R

Read the sections that follow to learn more about dialog box elements in SailWind Layout.

Radial Move Setup Dialog Box
Reassign Electrical Layers Dialog Box
Rename Net Dialog Box
Renumber Pins Dialog Box
Report Manager Dialog Box
Reports Dialog Box
Reuse Properties Dialog Box
Routing Rules Dialog Box
Routing Strategy Dialog Box
Rules Dialog Box
Rule Setup Dialog Box
Rules Report Dialog Box
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Radial Move Setup Dialog Box
To access: Tools  > Options  > Grids  tab > Radial Move Setup  button

Use the Radial Move Setup dialog box to set up the polar grid origin for radial moves, radial move 
options, and other information related to moving objects radially.

Objects

Name Description

Polar Grid Origin Area Sets the x-coordinate and y-coordinate for the polar grid origin in 
current design units.

Inner Radius Sets the radius of the inner ring of the polar grid or circular array in 
current design units. You cannot use zero or negative values.

Delta Radius Sets the radial distance between neighboring rings of the polar grid or 
circular array in current design units.
For Radial Move, zero sets the Delta Radius equal to the Inner Radius. 
You cannot use negative values.

Auto Rotate Automatically adjusts the orientation of the selected objects on the grid.

Disperse Arranges all of the selected objects on grid sites without overlapping. 
When Disperse is selected, the angular distance between neighboring 
objects is equal to or greater than the Delta Angle value. Disperse 
is useful for initial placing of a group of objects on the grid. Also, 
when Disperse is selected, text and reference designators are sorted 
alphabetically.
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Radial Move Setup Dialog Box

Name Description

In the Decal Editor, Disperse allows intersecting objects. Terminals are 
sorted by increasing pin number.

Use Discrete Radius Sets the mode of radial displacement: smooth or discrete. Discrete 
snaps to points along the polar grid.

Use Discrete Angle Sets the mode of angular displacement: smooth or discrete. Discrete 
snaps to points along the polar grid.

Polar Orientation area Sets the orientation of all selected objects.
• Initial  — Retains the individual orientation values of the selected 

objects from their starting positions.

• Let Me Specify  — Assigns the same polar orientation to the 
selected objects. Type the orientation in the box.

Sort by Reference Designator Sorts selected items by reference designator when creating or 
modifying an array or during a Radial Move.
When this option is cleared, items are sorted by the order in which they 
were selected.

Start Angle Sets the polar angle, in degrees, of the first grid or circular array site. 
You can type a value between 0.000 and 359.999.

Angle Range Sets the range within which you want to place objects. 360 sets a full 
circle grid or array; smaller values set sector-shaped grids or arrays.

Delta Angle Sets the angular distance between neighboring sites within a ring.

Sites Per Ring Sets the number of sites for each ring of the grid or array. Type a value 
equal to or greater than 2. You cannot use zero or negative values.

Locked Controls the automatic adjustment of Angle Range, Delta Angle, and 
Sites Per Ring for Radial Move. Controls the automatic adjustment of 
Count, Angle, and Angle Range for Polar Step and Repeat.
The three settings above, Angle Range, Delta Angle, and Sites per 
Ring, are interdependent; each value depends on the values in the 
other two. Set one of the values and lock it. Set one of the unlocked 
values; the other unlocked value automatically updates. For example, 
if you set Angle Range to 360 and Sites Per Ring to 36, Delta Angle 
updates to 10.

Direction Sets how the sites are placed on the grid or circular array: Clockwise or 
Counterclockwise.

Circular Arrays Lists all circular arrays and unions in the design. If you double-click an 
item from the list, the values in that array or union appear in the dialog 
box.
Create and name circular arrays using Create Array. Create and name 
unions using Create Union.

 Tip
You can only use this option in the Layout Editor.
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Related Topics
Setting Up a Polar Grid

Moving Design Objects Radially

Component Arrays
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Reassign Electrical Layers Dialog Box
To access: Setup  > Layer Definition  menu item > Reassign  button

Use the Reassign Electrical Layers Dialog box to move data from one electrical layer to another.

Objects

Name Description

# of Electrical Layers • Old Layer Number  — The layer on which the data exists 
before you reassign the layer.

• Has Data  — Indicates whether or not data exists on the 
selected layer.

• New  — Displays the new layer number after reassignment. If 
you delete a layer, this column displays <delete> in that row.

Old Layer # The number of the old layer selected in the # of Electrical Layers 
list.

New Layer # Displays the layer where the data exists after you reassign the 
layer.

Delete This is enabled when you decrease the number of layers and the 
selected layer has no data. For each layer you delete, <delete> 
appears in that layer's row under the New column.

Related Topics
Reassigning Electrical Layers
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Rename Net Dialog Box
To access: Select a net > ECO Toolbar  > Rename Net  button

Use the Rename Net dialog box to change the name of a net. Changing the name of a net also changes 
the netlist. It is therefore considered an engineering change and requires ECO mode.

Restriction:
A protected route or physical design reuse element can prevent you from renaming a net in ECO 
mode. You must unprotect the route or break the reuse to proceed. If you are recording changes 
to an ECO file, the action of removing the protection on traces or breaking out reuse elements is 
not saved.

Objects

Name Description

New Name Type a new name.

 Restriction:
The maximum netname length is 47 characters.

See also: “Illegal Characters in Netnames and Part Names”.

Related Topics
Renaming a Net in ECO Mode
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Renumber Pins Dialog Box
To access:

• PCB Decal Editor  > select a starting terminal > right-click > Renumber Terminals  popup menu 
item

• Part Information dialog box > Pins tab  on page 1596 > select pin(s) > Renumber  button

Use the Renumber Pins dialog box to renumber pins (terminals). You can renumber decal pins from the 
PCB Decal Editor, or part type pins from the Pins tab of the Part Information dialog box.

Objects

Name Description

Number of pins The number of pins available for renumbering.

Prefix/Suffix For a single pin number, use either Prefix or Suffix box, and void 
the other box. Use both boxes if you want to increment one of the 
values.
Alphabetic and numeric values can be used in either box.

Pin numbers A preview of pin numbers based on your prefix/suffix input.

Increment prefix Sets the prefix as the part of the pin number to increment.

Increment suffix Sets the suffix as the part of the pin number to increment.

Step value Sets the step value. Type a positive or negative number by which 
to increase or decrease the pin number with consecutive or 
stepped values.
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Name Description

 Restriction:
Step value must be non-zero and be in the range -10 to +10. 
Zero would replicate a single pin number and is not allowed.

Verify valid JEDEC pin numbering If using alphanumerics, you can select the Verify valid JEDEC pin 
numbering check box to ensure that legal alphanumeric values are 
used.

 Tip
This option only ensures that legal alpha and numeric 
combinations are used. To arrange rows and columns 
according to JEDEC, use the Assign JEDEC Pinning option on 
the Tools Menu.
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Report Manager Dialog Box
To access: File  > Library  menu item > filter by Parts > List to File  button

Use the Report Manager dialog box to generate a report about the parts in a library. You can specify the 
parts and the attributes to include in the report.

Objects

Field or Button Description

Available attributes All attributes of the part types in the selected library.
Click an attribute in the list of select it. (To select additional attributes, press 
the Ctrl key and click each attribute.) Click Include >>  to include selected 
attributes in the report.

Selected attributes Attributes in the report.
Click an attribute in the list of select it. (To select additional attributes, press 
the Ctrl key and click each attribute.) Click << Exclude  to remove selected 
attributes from the report.
The order of attributes in the list is the order of columns in the report. Select 
an attribute and click Up  or Down  to change the order.
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Field or Button Description

Include >> Includes the selected attributes in the report (moves the attributes to the 
Selected attributes list). Select one or more attributes on the Available 
attributes list and click Include >>.

<< Exclude Excludes the selected attributes from the report (moves the attributes from 
the Selected attributes list back to the Available attributes list).
Select one or more attributes on the Selected attributes list and click<< 
Exclude.

Up / Down Moves a selected attribute up or down on the Selected attributes list. List 
order determines the order in which columns appear in the report.

Part Filter Specifies the part types to include in the report.
Type a part type name in the field or use wildcards (*) to specify a group of 
part types. For example:
* Specifies all part types in the library.
+5* Specifies all part types that begin with the characters +5, such as +5volt 
and +5LS07.

Apply Filters the part types.

Parts Lists part types included in the report (as determined by the Part Filter).

Run Generates the report and lets you save it either in lst for viewing or printing or 
in csv format for use with MS Excel.

Close Cancels the operation and closes the dialog box.

Related Topics
Creating a Report of the Parts in a Library

Creating a Report of Decals, Lines or Logic Symbols in a Library
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Reports Dialog Box
To access: File  > Reports  menu item

You can use the Reports dialog box to create reports containing properties or netlist information for the 
design. In addition to several predefined report formats, you can create custom report formats.

Objects

Name Description

Path Displays the path to where the reports are located.

Select Report Files for Output Lists the report files (formats) available to you.

Add Opens the Report Format File dialog box where you can browse to the 
format file you want.

Delete Removes the report format from the list and changes the file name 
extension from .fmt  to .del.

Use Assembly Variant Specifies to create a report based on an assembly variant instead of 
the base design.

Name list Specifies the variant you want to use.

 Restriction:
Available only when Use Assembly Variant is selected.

Related Topics
Running a Report
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Reuse Properties Dialog Box
To access: Select a reuse > right-click > Properties  popup menu item

Use this dialog box to modify the selected physical design reuse.

Description

Figure 208. Reuse Properties Dialog Box When Adding a Reuse
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Reuse Properties Dialog Box

Figure 209. Reuse Properties Dialog Box of Reuse in the Design

Objects
Table  196. Reuse Properties Dialog Box Fields

Name Description

X/Y coordinates Displays the current coordinates of the physical design reuse origin. 
Type new values to move the physical design reuse to a new location.

Rotation Displays the current rotation of the physical design reuse. Type a new 
value or use the arrow buttons to change the rotation angle.

Glued Sets whether the physical design reuse is glued. Turn on Glued to glue 
the physical design reuse to the board and prevent moving the physical 
design reuse.
If multiple physical design reuses are selected, and some of them are 
glued and others are not, this check box is unavailable. You can click 
Glued to glue all selected physical design reuses or click to clear to 
unglue all selected physical design reuses.
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Table  196. Reuse Properties Dialog Box Fields  (continued)

Name Description

Reuse Name Displays the name of the currently selected physical design reuse. 
Type a new name in the box to rename the physical design reuse. The 
default reuse name is based on the reuse type  on page 1854.
The reuse name is checked to ensure it is not already used. If it 
is already used, an error message appears and you can specify a 
different name.

 Tip
There is no way to display the reuse name and reuse type in the 
design.

Reuse Type Displays the Reuse Type name.

 Tip
There is no way to display the reuse name and reuse type in the 
design.

Designator Preferences area  — Renames the reference designators for component elements and 
jumpers in the physical design reuse. By specifying a renaming method, you avoid creating duplicate 
reference designators between the physical design reuse and the design.
This section is not available unless you are in ECO mode with the ECO Toolbar open.

Same or Next Highest Adds each component with the reference designator defined in the 
physical design reuse. If the reference designator is already used in the 
design, the next highest unused reference designator is assigned. For 
example, if you click this option, and R2 is already used in the design, 
then R1 in the physical design reuse is assigned R1 in the design, but 
R is assigned R3 in the design. Also, R1R1 is assigned R1R2 and R1R 
is assigned R2R. The reuse name is checked to ensure it is not already 
in use. If it is already used, an error message appears and you can 
specify a different name.

Start at Adds each component with a reference designator starting at the 
number you specify here. The numbering starts at the lowest, 
numbered reference designator. For example, if the Start at value is 
100, R1 in the physical design reuse is assigned R100 in the design. 
R is also assigned R100 in the design, causing duplicate reference 
designators. In this case, an error would occur. Values range from 1 to 
9999. The value you type here is checked against the design to ensure 
that duplicate reference designators are not created. If duplicates 
occur, an error message appears and you can specify a different value.

Increment by Increments the reference designator by the specified number. For 
example, if the Increment by value is 100, the R1 in the physical design 
reuse is assigned R101 in the design. Legal characters are 1-9999. 
The value you type here is checked against the design to ensure that 
duplicate reference designators are not created. If duplicates occur, an 
error message appears and you can specify a different value.

Add Suffix Adds the specified suffix, up to four characters long, to each reference 
designator.
For example, with an A suffix, R1 in the physical design reuse is 
assigned R1A in the design. Illegal characters are brackets ({ }), 
asterisk (*), space, and period (.). You can, however, leave the Suffix 
box empty, and that is considered a valid entry. The value you type 
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Table  196. Reuse Properties Dialog Box Fields  (continued)

Name Description
here is checked against the design to ensure that duplicate reference 
designators are not created. If duplicates occur, an error message 
appears and you can specify a different value.

Add Prefix Adds the specified prefix, up to four characters long, to each reference 
designator.
For example, with an A prefix, R1 in the physical design reuse is 
assigned AR1 in the design. Illegal characters are brackets ({ }), 
asterisk (*), space, and period (.). You can, however, leave the Prefix 
box empty, and that is considered a valid entry. The value you type 
here is checked against the design to ensure that duplicate reference 
designators are not created. If duplicates occur, an error message 
appears and you can specify a different value.

Net Properties  button Opens the Net Properties dialog box  on page 1491 where you can 
resolve netname conflicts between netnames in a physical design 
reuse and netnames in the design.

Related Topics
Modifying Reuse Properties in the Design
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Routing Rules Dialog Box
To access:

• Setup  > Design Rules  menu item > choose a hierarchy level > Routing  button

• PCB Decal Editor > Setup  > Design Rules  menu item > Routing  button

Use the Routing Rules dialog box at any level of the hierarchy to specify the topology type of the ratsnest 
connections, general and autorouting options, and layer and via biasing. You can access the Routing 
Rules dialog box from within SailWind Layout or from within the Decal Editor.

Description
When you open the Routing Rules dialog box from the Decal Editor, only options in the Vias area are 
available.

When you set up Routing rules for pin pairs, groups, components, or decals, the following rule settings 
are unavailable: topology type, copper sharing, maximum number of vias.

Figure 210. Routing Rules Dialog Box

1666 SailWind Layout Guide and Reference



 
GUI Reference Elements Q Through R

Routing Rules Dialog Box

Figure 211. Vias Area of PCB Decal Editor Routing Rules Dialog Box

Objects
Table  197. Routing Rules Dialog Box

Area Description

Topology type Specifies the topology  on page 1867 of the connections (ratsnest  on page 1852) to 
provide a visual pin-to-pin order when routing interactively or moving a part.

 Restriction:
The Serial source, Parallel source, and Mid-driven settings will only function if 
you have correctly set the pin Type (such as Source, Load, Terminator) of the 
parts.

• Protected  — Do not change the order of the connectivity of the connections.
 Tip
This option disables length minimization  on page 1837 but still allows 
routing of the net.

For information about protecting the unroutes to prevent routing, see Protecting 
Unroutes in a Net  and Protecting Unroutes in a Pin Pair.

• Minimized  — Order the net by the shortest distance between pins. Net reorder 
or reconnect is permitted.

• Serial source  — Order the net in a series order from source pins to load pins to 
a terminator.

• Parallel source  — Same as “Serial source” except order the net with parallel 
branches for each source-to-load connection.

• Mid-driven  — Divide the net into two branches and order each branch in a 
source to load to terminator order.

See also: “Placement and Length Minimization  on page 474”.
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Table  197. Routing Rules Dialog Box  (continued)

Area Description

Routing options • Copper sharing  — Allow vias or traces to share copper with another 

object.
 Restriction:
This rule is used only in SailWind Router, although you can define this rule in 
SailWind Logic, SailWind Layout, or SailWind Router.

• Priority  — Assign a priority from 0 to 100. Nets with higher priority are routed 
first.

 Restriction:
SailWind Router does not use the priority value. This rule applies only to 
SPECCTRA.

• Auto Route  — Allow the autorouter to route nets.

• Allow Ripup  — Unroute existing traces and reroute the nets.
 Tip
Enable this option to ripup traces while DRC Warn or Prevent is enabled.

• Allow Shove  — Move unprotected traces aside to create room for new traces.
 Tip
Enable this option to shove traces while DRC Warn or Prevent is enabled.

• Allow Shove Protected  — Move protected traces aside to make room for 
new traces.

Layer biasing Layers in the Available layers list can not be used for routing and vias can not 
start or end on those layers. Only layers in the Selected layers list can be used for 
routing.

 Tip
Double-click a layer to instantly move it to the opposite list, or use the Add>> or 
<<Remove buttons to move one or more layers at a time.

Vias Vias in the Available vias list can not be used during routing. Only vias in the 
Selected vias list can be used during routing. All other vias are restricted vias.

 Tip
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Table  197. Routing Rules Dialog Box  (continued)

Area Description

• Double-click a via to instantly move it to the opposite list, or use the Add>> or 
<<Remove buttons to move one or more vias at a time. Alternatively, use the 
Thru>> or Partials>> buttons to move through-hole vias or partial vias to the 
Selected vias list.

• This is one of the main criteria for automatic via selection (another is the active 
layer pair). Autoselect allows only vias that begin and end on the Layer Pair 
shown on the Routing  tab of the Options dialog box.

Via definition  — This button is only available in the PCB Decal Editor version of 
the Routing Rules dialog box. This opens the Setup Via Dialog Box. The Setup Via 
dialog box does not know about via padstacks in the design. Use this dialog box to 
set up only via names, not the internal structure of the pad stacks. These via names 
should reference the real vias in your design, where the internal padstack structure 
is defined.

Maximum number of 
vias

Restriction: This setting is only used by the autorouter. The autorouter considers this 
to be a hard rule  on page 1833. Interactive routing and design verification check 
this rule. This option is available only when setting rules for default, net, and class 
properties.

• Unlimited Vias  — Allow an unlimited number of vias to be used.

• Maximum of  — Constrain the number of vias to be used per net. Type the 
number, 0 to 50000, in the box.

 Tip
An insufficient maximum number of vias might increase autorouting runtime 
and reduce completion rates.

Delete button Removes non-default routing rules at the current level of the rules hierarchy.

 Restriction:
You cannot delete the Default Routing rules.

Tip
To specify default trace widths, use the Clearance Rules dialog box.

Related Topics
Creating Via Routing Rules in the Decal Editor

Design Rule Categories

Design Rule Hierarchy

Protecting Unroutes in a Net

Protecting Unroutes in a Pin Pair
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Routing Strategy Dialog Box
To access: Tools  > SailWind Router  menu item > Setup  button

Use the Routing Strategy dialog box to define a strategy for autorouting your design in SailWind Router. 
You indicate what passes SailWind Router should perform, whether to protect the resulting traces, and 
what intensity to assign to objects.

Objects

Name Description

Pass Type Lists the types of passes that SailWind Router can make. SailWind 
Router uses the following pass types:

• Center pass  — Places traces equidistant from component pins or 
vias and each other to evenly distribute any available space in the 
channel.

• Fanout pass  — Places vias for inaccessible SMD component pins 
and routes, from the vias to the pins.
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Name Description

• Miters pass  — Converts all 90 degree route corners to diagonal 
corners.

• Optimize pass  — Analyzes each route and tries to improve the 
quality of the route pattern by removing extra segments, reducing 
via usage, and shortening routed trace lengths. This pass includes 
glossing and smoothing processes.

• Patterns pass  — Finds and routes groups of unrouted connections 
that can be completed using typical “c” routing patterns, “z” routing 
patterns, and memory patterns.

• Route pass  — The core pass that performs the majority of 
autorouting. During this pass, SailWind Router attempts to 
sequentially route each unroute until all connections are attempted. 
The Route pass contains serial, rip up and retry, push and shove, 
and touch and cross processes.

• Test point pass  — Analyzes the testability of the design, 
determines which nets require testing, adjusts the routes, and 
inserts test points to improve testability. You can select whether to 
add test points during routing or after routing. See also: “Adding 
Test Points While Interactively Routing”, “Assigning Test Points 
During Autorouting” and “Assigning Test Points After Autorouting” 
topics in the SailWind Router Help for more information.

• Tune pass  — Adjusts the length of length-controlled traces. The 
pass examines trace lengths for only completely routed nets or pin 
pairs. The pass analyzes the current length of each net or pin pair if 
length rules and length control are enabled, based on the following 
conditions:

• If the cumulative length of the adjacent trace segments is within 
the range of minimum and maximum trace length, the tune pass 
skips the trace and does not adjust it.

• If the trace is longer than the maximum trace length, the tune 
pass rips it up and places it in a queue for routing.

• If the trace length is less than the minimum trace length, the tune 
pass changes the length by adding accordion patterns.

Pass Enables or disables the corresponding autorouting pass type.

Protect Enables or disables the protection of traces and vias completed during 
the corresponding pass type. Protected objects cannot be moved or 
modified. Traces are protected and vias are glued.

Pause Enables or disables a pause at the end of the corresponding pass type.

 Tip
When you pause autorouting in SailWind Router, the pass and the 
point within the pass are stored. When you resume autorouting, 
SailWind Router begins where it was paused. Pause does not work 
when routing in background mode.

Intensity Sets the level of rip-up effort and number of subpasses to apply to each 
pass. There are three intensity options:
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Name Description

• Low  — Sets low effort, routing as quickly as possible with a low 
completion rate, using maximum vias and trace length. Use this 
setting when you want to complete autorouting quickly. The trade-off 
is your completion percentage.

• Medium  — Sets medium effort, routing more slowly with a higher 
completion rate, using fewer vias and shorter traces. Use this 
setting when you want to balance autorouting time and completion 
percentage.

• High  — Sets high effort, routing slowly with the highest completion 
rate, using the fewest vias and shortest traces possible. Use this 
setting when you want to complete all traces. Your trade-off is the 
time required to complete routing.

Routing Order List Displays the routing order of components, nets, and net classes for the 
selected pass.
This list is empty until you click objects from the Object list and click 
Selected. Set the routing order using the controls in the Routing Order 
area.

Done Displays the status of each routing pass. When a pass completes, a 
check mark appears in this column.

Select by list Lists the objects in the design. Select an object type (components, 
differential pairs, differential pair pin pair groups, matched lengths, 
matched length pin pair groups, nets, or net classes) from the list to 
update the Available area.

Available area Lists all of the available objects of the object type selected in the Select 
by list. Click individual objects to add to the routing order.

Default Resets all controls to the default strategy settings.

Selected Adds selected objects from the Object list to the Routing Order list.
To enable Selected, select a pass type and select an object in the 
Object list.

All Nets Adds all nets not currently in the Routing Order list to the Routing Order 
list. The All Nets entry appears in the Routing Order list.
To enable All Nets, select a pass type and select an object in the 
Object list.

Plane Nets Adds nets associated with plane layers to the Routing Order list. The 
Plane Nets entry appears in the Routing Order list.
To enable Plane Nets, select a pass type and select an object in the 
Object list.

Clear button Deletes all items from the Routing Order. To delete only one item, click 
Delete in the Routing Order area.

Routing Order Displays the routing order of components, nets, and net classes for the 
selected pass. This list is empty until you click a pass type.
To add an object to the routing order, click the object and click 
Selected.
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Name Description

The following options are available for altering the routing order:

•  — Deletes selected nets from the Routing Order list. Nets are 
not deleted from the design; they are only removed from the routing 
order.

•  — Moves the selected object up one position in the routing 
order.

•  — Moves the selected object down one position in the routing 
order.
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Rules Dialog Box
To access: Setup  > Design Rules

Use the Rules dialog box to assign place and route constraints to the design.

Objects

Name Description

Default Opens the Default Rules Dialog Box.

Class Opens the Class Rules Dialog Box.

Net Opens the Net Rules Dialog Box.

Group Opens the Group Rules Dialog Box.

Pin Pairs Opens the Pin Pair Rules Dialog Box.

Decal Opens the Decal Rules Dialog Box.

 Restriction:
You can define Decal Rules in SailWind Layout; however, these 
rules are used in SailWind Router only.

Component Opens the Component Rules Dialog Box.

 Restriction:
You can define Component Rules in SailWind Layout; however, 
these rules are used in SailWind Router only.

Conditional Rules Opens the Conditional Rule Setup Dialog Box.

Differential Pairs Opens the Differential Pairs Dialog Box.
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Name Description

 Restriction:
You can define Differential Pairs Rules in SailWind Layout; 
however, these rules are used in SailWind Router only.

Electrical Nets Opens the “Electrical Net Rules Dialog Box”  on page 1360.

Report Opens the Rules Report Dialog Box.

Related Topics
Design Rule Hierarchy
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Rule Setup Dialog Box
To access: AI  > Intelligent Layout  menu item > Rule Setup  button

Use this dialog box to define a layout strategy for componnets by intelligently identified group.

Objects

Name Description

Allow rotation Selects to allow rotating components by 90 degrees.

Layout style Selects the layout style from the drop-down list.

One-sided Layout Selects this option to enable the single-sided layout.
By default, this option is unchecked for double-sided layout.

Key part safety spacing Specifies the minimum clearance from the intelligently identified key 
component within a group.
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Rules Report Dialog Box
To access:

• Setup  > Design Rules  menu item > Report  button

• Setup  > Design Rules  menu item > choose a hierarchy level > Report  button

Use the Rules Report dialog box to create reports containing information about design rules for the 
design.

Objects

Name Description

Rules Type area Specifies the rule types on which you want to report.

Pin Pairs area Specifies the pin pairs on which you want to report.
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Name Description

 Tip
Select All pin pairs to report on all of them.

Net Filters the contents of the Pin pair list.

Groups area Specifies the groups on which you want to report.

 Tip
Select All groups to report on all of them.

Components area Specifies the components on which you want to report.

 Tip
Select All components to report on all of them.

Nets area Specifies the nets on which you want to report.

 Tip
Select All nets to report on all of them.

Classes area Specifies the classes on which you want to report.

 Tip
Select All classes to report on all of them.

Decals area Specifies the decals on which you want to report.

 Tip
Select All decals to report on all of them.

Default rules Specifies to report the default rules for each enabled rule type in the 
Rules Types area.

Output area • Rule Sets  — Report all rules that are different from the default 
rules.

• Rule Values  — Report the values of all rules, even if they match the 
default rules values.

Related Topics
Creating a Report of the Design Rules
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Chapter 54
GUI Reference Elements S

Read the sections that follow to learn more about dialog box elements in SailWind Layout.

SailWind Suite Configuration Dialog Box
Save CAE Decal to Library Dialog Box
Save Configuration Dialog Box
Save Configuration Dialog Box in the Decal Wizard Options
Save Drafting Item to Library Dialog Box
Save Part Types and Decals to Library Dialog Box
Save Part Type to Library Dialog Box
Save PCB Decal to Library Dialog Box
Save View Dialog Box
SBP Naming Dialog Box
SBP Properties Dialog Box
Select Assembly Variant Dialog Box
Select Color Dialog Box for 3D Options and Objects
Select Color Dialog Box for 3D Models
Select Graphically Dialog Box
Select Items Dialog Box
Select Nets Dialog Box
Select Reuse Module Dialog Box
Selected List Dialog Box
Selection Filter Dialog Box, Layer Tab
Selection Filter Dialog Box, Object Tab
Set Start-up File Dialog Box
Setup DXF Drill Size and Symbols Dialog Box
Setup SPECCTRA Finish Dialog Box
Setup SPECCTRA Startup Dialog Box
Setup Via Dialog Box
Show Attributes Dialog Box
SPECCTRA DO File Dialog Box
SPECCTRA Link Dialog Box
SPECCTRA Options Dialog Box
SPECCTRA Setup Dialog Box
Start-up File Output Dialog Box
Status Dialog Box
Step and Repeat Dialog Box
Synchronize Die Part Dialog Box
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SailWind Suite Configuration Dialog Box
To access:

• Help  > Installed Options  menu item > Suite Configuration  button

• Optional: Opens on program startup

Use the SailWind Suite Configuration dialog box to manage SailWind Suite (composite) licenses.

Objects

Field Description

Control suite license checkout and 
select from the following list

Enables the Suite License table for you to control checkouts.

Suite Name column Lists the name of the suite for which the license works.

License Feature column Lists the specific features available for each license.

License status column Lists the status of the licenses when you click the Check status 
button.

Check Status button Specifies to check the status of all licenses listed in the table and 
displays the status in the License status column.
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SailWind Suite Configuration Dialog Box

Field Description

Reset List button Specifies to reset the list of suite licenses to only those detected in 
your licensing environment.

Move up button Moves the selected license up one row.

Move down button Moves the selected license down one row.

Select all button Selects all of the listed licenses.

Select none button Deselects all of the listed licenses.

Show this dialog box on program 
startup

Specifies to open the SailWind Suite Configuration dialog box 
when SailWind Layout starts.

Automatically check license status 
on dialog box startup

Specifies to check the status of the licenses when you open the 
SailWind Suite Configuration dialog box.

Related Topics
Installed Options Dialog Box, Options Tab

Checking Out Suite Licenses
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Save CAE Decal to Library Dialog Box
To access: File  > Library  menu item > select a library > Logic  filter button > select a CAE decal > Copy

Use the Save CAE Decal to Library dialog box to copy a CAE decal to another name or another library.

Objects

Field Description

Library Select the library for the copied CAE decal.

Name of CAE Decal Type the name for the copied CAE decal.

Related Topics
Copying a Library Item
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Save Configuration Dialog Box

Save Configuration Dialog Box
To access: Setup  > Display Colors  > Save  button

Use the Save Configuration dialog box to save the color assignments and settings you have made in the 
Display Colors Setup dialog box.

Objects

Field Description

text box Type the name of the new color configuration. The name will appear in the 
Configuration list in the Display Colors Setup dialog box.

Related Topics
Display Colors Setup Dialog Box

Display Colors Setup Dialog Box in the Decal Editor
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Save Configuration Dialog Box in the Decal 
Wizard Options
To access: Decal Wizard Options  on page 1252 dialog box > Save As  button

Use the Save Configuration dialog box to save the settings you have made in the Decal Wizard Option 
dialog box.

Objects
Table  198. Save (Decal Wizard Options) Configuration Dialog Box Content

Field Description

text box Type the name of the new Decal Wizard Options configuration. The name will 
appear in the Configuration name list in the Decal Wizard Options dialog box  on 
page 1252.
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Save Drafting Item to Library Dialog Box
To access:

• File  > Library  menu item > select a library > 2D Lines  filter button > select a line item > Copy

• Select a drafting shape in the design > right-click > Save to Library  popup menu item

Use this dialog box to add a drafting shape from the design into the library or to save a library item under 
a different name or into a different library.

Objects
Table  199. Save Drafting Item to Library Dialog Box Content

Field Description

Library Select the library for the copied line item.

Name of Item Type the name for the copied line item.

Related Topics
Copying a Library Item

Saving a Drafting Item to a Library
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Save Part Types and Decals to Library Dialog 
Box
To access: Select one or more components in the design> right-click > Save to Library  popup menu item

Use this dialog box to save modified decals or parts to libraries.

Objects

Field Description

Part Types The list of Part Types available to save to the library.

Decals The list of Decals available to save to the library.

Select All Selects all items in the list above the button.

Select None Deselects all items in the list above the button.

Part Type Library A list of all the libraries available to which to save this Part Type.

Decal Library A list of all the libraries available to which to save this Decal.

Related Topics
Saving Modified Decals and Parts to Libraries
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Save Part Type to Library Dialog Box
To access: File  > Library  menu item > select a library > Parts  filter button > select a part type > Copy

Use this dialog box to copy a Part Type to another name or another library.

Objects

Field Description

Library Select the library for the copied part type.

Name of Part Type Type the name for the copied Part Type.

Related Topics
Copying a Library Item
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Save PCB Decal to Library Dialog Box
To access: File  > Library  menu item > select a library > Decal  filter button > select a PCB decal > Copy

Use this dialog box to copy a PCB decal to another name or another library.

Objects

Field Description

Library Select the library for the copied PCB decal.

Name of PCB Decal Type the name for the copied PCB decal.

Related Topics
Copying a Library Item
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Save View Dialog Box
To access: View  > Save View  menu item

Use the Save View dialog box to save a work area view. You can save up to nine different views.

Objects

Field Description

View Name The different views available to you.

Preview area Shows the view selected in the View Name list.

Capture Opens the Capture a New View dialog box.

Apply Applies the selected view.

Delete Removes the selected view from the View Name list.

Related Topics
Saving and Restoring a View
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SBP Naming Dialog Box
To access: BGA Toolbar  > Wire Bond Wizard  button > SBP Naming  button

Use the SBP Naming dialog box to specify the numbers and functions of all newly created substrate bond 
pads, if different from the defaults.

Note:
This information applies only to the BGA toolkit.

Objects

Field Description

CBP column Lists the numbers of the component bond pads.

CBP Function column Lists the function names of the component bond pads.

SBP column Use this column to view and specify the numbers of the substrate bond 
pads listed in the same row.

SBP Function column Use this column to view and specify the functions of the substrate bond 
pads listed in the same row.

Reset button Resets the substrate bond pad numbers and functions to the default, 
which matches them to the component bond pads of the same number 
and function.

Derive from Netlist button Imports substrate bond pad functions from a PADS-ASCII format netlist 
file. Choose the file you want to load from the Open File dialog box.
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SBP Naming Dialog Box

Related Topics
Setting SBP Names

SailWind Layout Guide and Reference 1691



GUI Reference Elements S
SBP Properties Dialog Box  

SBP Properties Dialog Box
To access: BGA Toolbar  > Wire Bond Editor  button > select an SBP > right-click > Properties  popup 
menu item

The SBP Properties dialog box displays the pin name, function, position, and dimensions of the selected 
substrate bond pad. In the Wire Bond Editor, with one or more SBPs selected, right-click and click the 
Properties  popup menu item to edit the SBP Properties.

Restriction:
This information applies only to the BGA toolkit.

Note:
If you have multiple objects selected, only those properties that are common to all selected 
objects will appear.
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Objects

Field Description

Pin Name Assigns a pin name to the currently selected substrate bond pad.

Function Defines the function of the currently selected bond pad.

Guide Displays the name of the SBP Guide to which the specified SBP is 
assigned. If the SBP is not assigned to any guide, this field is blank.

Wirebond Displays the name of the substrate bond pad and the component bond 
pad that are connected by the wire bond.

Layer list Lists all electrical layers for creating SBPs, allowing you to create an 
SBP on a specific layer.

X and Y Displays the X and Y coordinates of the bond pad. Type new values to 
move the bond pad.

Rotation Assigns a rotation angle, in degrees, for the currently selected 
substrate bond pad.

Shape list Assigns a shape to the currently selected bond pad: Rectangle or Oval.

Length Assigns a physical length, in current design units, for the currently 
selected bond pad.

Width Assigns a physical width, in current design units, for the currently 
selected bond pad.

CBP  button Opens the CBP Properties Dialog Box  for the component bond pad 
connected to the currently selected substrate bond pad. This button is 
unavailable if there is no connected component bond pad.

WB  button Click WB to open the Wire Bond Properties Dialog Box  for the 
wire bond connected to the currently selected pad. This button is 
unavailable if there is no connected wire bond.

Related Topics
Editing Substrate Bond Pad Properties
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Select Assembly Variant Dialog Box
To access:

• File  > CAM  menu item > Add  button > select Assembly from the Document Type list > Assembly 
button

• File  > CAM  menu item > select a document name > Edit  button > select Assembly from the 
Document Type list > Assembly  button

You can create assembly drawings of your assembly variants by selecting a variant in the Select 
Assembly Variant dialog box.

Objects

Field Description

Use Assembly Variant Specifies to use an assembly variant as your design input for the 
assembly drawing.

 Tip
Clear the check box to use all parts in the database, known as the 
raw database  on page 1853.

Name Specifies the variant you want to use.

Related Topics
Creating CAM Outputs to Manufacture Your PCB
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Select Color Dialog Box for 3D Options and 
Objects
To access: SailWind 3D window  > 3D General Toolbar  > 3D Display Control button  > click a color 
tile for a model listed under Options or Objects

Set the color and transparency for Options and Objects in the 3D Display Control dialog box. The color 
tile might show the letter “P” if no custom color is assigned, indicating that the model is displaying the 
default photorealistic color.

Objects

Object Description

Color and Grayscale palettes Choose a color or a scale of gray from the palettes. The color 
appears in the New color preview.

Transparency slider Move the slider to set the transparency of the assigned color. The 
transparency appears in the New color preview.

button

Click and apply the selected color to other color tiles in the 3D 
Display Control. The Select color dialog remains open.

Current and Previous color 
preview

Previews the new color selected and displays the current color to be 
replaced. Shows the camera icon if the color of the object is set to 
photo-realistic. Previews the transparency of the color also.

Revert button Cancels a new color selection and replaces it with the Current color.
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Select Color Dialog Box for 3D Models
To access: SailWind 3D window  > 3D General Toolbar  > 3D Display Control button  > click a color 
tile for a model listed under Components, Assemblies, Mechanicals, or PCBs

Set the color and transparency for 3D Models listed in the 3D Display Control dialog box. The color tile 
might show the letter “P” if no custom color is assigned, indicating that the model is displaying the default 
photorealistic color.

Objects

Object Description

Color and Grayscale palettes Choose a color or a scale of gray from the palettes. The color 
appears in the New color preview.

Transparency slider Move the slider to set the transparency of the assigned color. The 
transparency appears in the New color preview.

button

Click and apply the selected color to other color tiles in the 3D 
Display Control. The Select color dialog remains open.

Current and Previous color 
preview

• Previews the new color selected and displays the current color to 
be replaced.

• Shows the camera icon if the color of the object is set to 
photo-realistic.

• Previews the transparency of the color also.

Revert button Cancels a new color selection and replaces it with the Current color.
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Select Color Dialog Box for 3D Models

Object Description

button

Applies a photo-realistic color to the model.
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Select Graphically Dialog Box
To access: BGA Toolbar  button > Route Wizard  button > Select Pads  tab > Select Graphically  button

Graphical Selection mode has two modes, namely “Include” and “Exclude.” The default mode is Include 
mode. The work area highlights pins that are currently included on the Substrate Bond Pads and BGA 
Pins lists.

Restriction:
This information applies only to the BGA toolkit.

Objects

Field Description

Select Pins to 
Include/Exclude

Places Graphical Selection in Include or Exclude mode.

Included/Excluded BGAs and 
SBPs

Lists the number of BGA pads and SBP pins currently selected for 
inclusion in or exclusion from processing.
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Select Items Dialog Box
To access:

• File  > CAM  menu item > Add  button > Layers  button

• File  > CAM  menu item > select a document name > Edit  button > Layers  button

When you are adding a CAM document, you can use the Select Items dialog box to define which layers 
and items should appear in a particular document. You can also define colors for layers and items.

Objects

Field Description

Available list Lists the layers available for display in the output.
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Field Description

Selected list Lists the layers you selected from the Available list.

Add button Moves the layer from the Available list to the Selected list.

 Tip
The layers you select are not saved as defaults when you click 
Save As Defaults on the Add Document dialog box.

Remove button Moves the layer from the Selected list to the Available list.

Other area Specifies the color you want for the Board Outline, Connections, Plated 
Slots, and Non-plated Slots.

Items on Primary area Select a check box to enable the display of the object from the 
Selected layer.

• Pads—  Displays pads on the selected layer.

• Traces—  Displays traces on the selected layer.

• Lines—  Displays 2D lines on the selected layer.

• Vias—  Displays vias on the selected layer.

• Copper—  Displays copper on the selected layer.

• Keepouts—  Displays keepouts on the selected layer.

• Ref. Des.—  Displays Reference Designator labels on the selected 
layer.

• Part Type—  Displays Part Type labels on the selected layer.

• Text —  Displays text on the selected layer.
 Note:
Exception:  Text that is combined with 2D lines is made visible 
when you select 2D Lines. Combined text is not affected by the 
Text check box.

• Attributes—  Displays Attribute labels on the selected layer.
 Note:
CAM does not generate output for attribute labels unless you 
choose to make the labels visible in the design. To display the 
labels, use the Show list in the Labels Properties dialog box  on 
page 590.

• Outlines—  Displays component outlines on the selected layer.

• Test Points  — Displays all test points (component pins and vias) on 
the specified layer.

By default, test points are located on the bottom side of the board. 
When creating a solder mask document of the top side of your 
design, only test points marked as Top Access in the Properties 
dialog box will display in the CAM document. For solder mask 
documents, test points are added by default. This unmasks test 
points - specifically test point vias. Typically, vias are covered 
in solder mask which appears white when previewing the CAM 
document.
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Select Items Dialog Box

Field Description

Pins with Associated Copper 
area

CAM interprets pads and other objects differently when they are 
associated with copper in the PCB Decal Editor. Interpretation is as 
follows:

• Terminals with associated copper are interpreted as vias.

• Closed copper shapes are interpreted as pads.

• Open copper (a path drawn with copper) is interpreted as a trace.

 Tip
Using the Vias, Pads, and Traces check boxes along with those in 
the Pins with Associated Copper area will give you total control over 
what appears in your CAM document.

Click Advanced Selection  to enable the selection of the object check 
boxes. These options allow for selection of associated copper items 
independently of regular options for pads, vias and traces.

• Pads  — displays pads with associated copper.

• Open Copper  — displays the open copper that is associated to 
pins. Open copper is drawn using the Path setting.

• Filled Copper  — displays the closed copper shapes that are 
associated to pins. Filled copper is drawn using the Polygon, Circle, 
and Rectangle settings.

 Tip
Once a pin has copper associated with it, it receives special 
handling, even if the layer you are outputting is not specifically the 
one that the associated copper is placed on. A through hole pin with 
associated copper is treated as a via in CAM so you can choose 
to enable vias on the solder mask layer for “Items on primary” or 
you can enable the “Advanced Selection” check mark for the solder 
mask layer and add a check mark for pads.

For more information, see “Associating Copper with Terminals”.

Component outlines area Specifies the color you want for outlines that are Top Mounted and 
Bottom Mounted.

Color by Net Specifies to use the View Nets colors in the output.

 Restriction:
This feature is only available if you select a printer or a plotter as 
your Output Device. It is not available for Photo output.

Selected Color Provides a palette of grayscale or colors to use for objects in the output 
document. This helps distinguish items in the printout or pen plot.

 Restriction:
This feature is only available if you select a printer or a plotter 
as your Output Device. It is not available for Photo output. The 
color palette only shows colors that the printer or plotter can 
output. If your device can only print grayscale, the palette will show 
grayscale.
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Field Description

 Tip
Click a color in the palette and then click the box beside a design 
object. You must select the check box of a design object before the 
object color swatch appears. You can assign colors to the items in 
the Other, Component outlines, and Items on Primary areas.

Preview Opens the CAM Preview Dialog Box  displaying the document with 
selections assigned in this dialog.

Related Topics
Colors in CAM Documents

Creating CAM Outputs to Manufacture Your PCB
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Select Nets Dialog Box

Select Nets Dialog Box
To access: SailWind 3D window  > 3D General Toolbar  > Export button  > select one of the Copper 
Element Options  > Selected Nets  > Choose Nets

Limit the export of pads, planes or traces to specific nets in a SAT or STEP file from the SailWind 3D 
window by selecting their nets.

Objects

Object Description

Net name list Lists the nets in the design. Unconnected pins display as (Net0).
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Object Description

Unselect All Clears the check boxes of all nets in the Net name list.

Enable cross probing Enables you to select nets in the 2D design space instead of the 
dialog.
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Select Reuse Module Dialog Box
To access: Design Toolbar  > Make Like Reuse

Use this dialog box to select the reuse type, based on which to make a new physical reuse design.

Objects

Object Description Remark

Filter box Used to filter the reuse type within the design.
To filter the reuse, type a wildcard or expression  in 
the box and click Apply  or press the Enter  key.

Reuse Module list Lists the reuse type within the design or matched by 
the filter.

Total Displays the total number of what in the Reuse 
Module list.

OK Opens the Matching Result Dialog Box.
Select a reuse type in the list prior to clicking the OK 
button.

Browse Opens the "Open Reuse File" dialog box, in which 
to select a reuse file (.reu) locally and click Open  to 
open the Matching Result Dialog Box.

You can select a reuse in 
either of the two ways.
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Selected List Dialog Box
To access: With object(s) selected in the workspace, right-click to choose Selected List  in the pop-up 
menu

Use this dialog box to filter what you want from the selected more efficiently and precisely.

Objects
Table  200. Parameter Description

Field Description Remark

Selects the check boxes for the object(s) you 
want, which will be highlighted in the highlight 
color in the workspace.

Object Displays the object type.

Name Displays the object name: reference designators 
for parts and blank cells for other objects 
requiring no name.

Description Displays the object information: PCB decal for 
parts and coordinate location for other objects.

Net Name Displays all nets with which the object is 
associated.

Net Class Displays all net classes to which the nets belong.

Layer Displays the layer(s) on which the object is 
placed.

Length

Width

Displays the length and width of the objects, in 
current design units.

Blank cells indicate that no 
such information is found.

Fit to View Fits selected objects into the workspace.
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Selected List Dialog Box

Table  200. Parameter Description  (continued)

Field Description Remark

Remove Removes the selected item(s) from the list, 
which will then be deselected in the workspace.

To clear the list, you can also 
click in an empty area of the 
workspace.

Export Exports what currently in the list to a local CSV 
file.

Name Filters objects by name, with operations as 
follows:
1. Type a wildcard or expression  in the Name 

box. If you do not want to restrict the results 
with a filter, you can display all items by 
typing * (asterisk).

2. Click Filter  or press the Enter key.
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Selection Filter Dialog Box, Layer Tab
To access: Edit  > Selection Filter  menu item > Layer  tab

The Layer  tab displays a list of enabled layers (available for selection). Select layers to expand the 
selection of objects specified in the Object  tab. Click the check box accompanying the layer name.

Tip
By selecting multiple layer names, you can change their selectability in a single step.

Objects

Field Description

Layers list Specifies the layers on which you want to enable selection.
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Selection Filter Dialog Box, Layer Tab

Field Description

Anything Specifies that you want to select anything in the design.

 Note:
Exception:  Clusters, unions, stitching vias, pin pairs, nets, and 
board outline shapes are not selected.

Nothing Specifies that you do not want to select anything in the design.

Related Topics
The Selection Filter
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Selection Filter Dialog Box, Object Tab
To access: Edit  > Selection Filter  > Object  tab

Use the Selection Filter Object  tab to specify which objects you can select. Select a check box to enable 
the object for selection or clear the check box to disable the object for selection.

Objects

Field Description

Design Items Specifies the design items you want to be able to select in the 
design.

 Tip
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Field Description

• When Parts is selected, but Glued Parts is clear, you enable 
the selection of all parts except Glued Parts. When both Parts 
and Glued Parts are selected, you enable the selection of both 
glued and unglued parts. Selecting Glued Parts does not modify 
the jumper selection or selection of unions and reuses.

• When Vias is selected, but Stitching is clear, you enable the 
selection of all vias except stitching vias. When both Vias and 
Stitching are selected, you enable the selection of both vias and 
stitching vias.

Drafting Items Specifies the design items you want to be able to select in the 
design.

Anything Specifies that you want to select anything in the design.

 Note:
Exception:  Clusters, unions, stitching vias, pin pairs, nets, and 
board outline shapes are not selected.

Nothing Specifies that you do not want to select anything in the design.

Related Topics
The Selection Filter
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Set Start-up File Dialog Box
To access: File  > Set Start-up File  menu item

Use the Set Start-up File dialog box to select the startup file to use for new design files. A startup file 
contains global settings such as layer definitions, grids, clearance rules, the attribute dictionary, and so 
on.

Note:
The startup file affects only new designs and specifying a new startup file does not affect existing 
designs.

Objects

Field Description

Current Start-up File The name of the start-up file you are creating.

Start-up designs A list of the design types available.

Description A description of the design type.

Don’t display again Specifies to use the selected type for all new design files.

Related Topics
Creating Start-up Files

Specifying the Start-up File

Start-up Files
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Setup DXF Drill Size and Symbols Dialog Box

Setup DXF Drill Size and Symbols Dialog Box
To access: File  > Export  > select DXF File > Save  button > Setup  button

Use the Setup DXF Drill Size and Symbols dialog box to specify drill sizes and symbols in the DXF 
export. You can also substitute 2D line library items for each drill size in the design.

Objects

Field Description

Drill Size Library Equivalent A list of the items using a 2D-line library item to draw a specific drill 
size instead of using the default drill symbol.

Drill Size Specifies the drill size of the drill hole for the item selected in the 
Drill Size Library Equivalent list.

Library Equivalent Specifies the 2D-line library item equivalent for the item selected in 
the Drill Size Library Equivalent list.

Add Adds a row at the bottom of the Drill Size Library Equivalent list.

Delete Removes the selected row from the Drill Size Library Equivalent 
list.

System Units The units of the symbols.

Symbol Size Specifies the length/width of the drill hole.

 Tip
By default, drill holes appear in the DXF file as plus signs (+).

Line Width Specifies the line size used to draw the plus sign.

 Tip
By default, drill holes appear in the DXF file as plus signs (+).
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Related Topics
Specifying DXF Drill Sizes and Symbols
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Setup SPECCTRA Finish Dialog Box
To access: File  > Export  > select SPECCTRA Files > Save  button > in the SPECCTRA Link > DO File 
button > Finish  button

Use the Setup SPECCTRA Finish dialog box to specify output file locations. Use this dialog to also set 
instructions for the SPECCTRA router regarding actions to perform when routing is completed, such as 
running the mitering pass, running re-cornering, and inserting test points.

Objects

Field Description

Wire File Specifies the location of the wires file.

 Tip
Click Browse to locate the file.

Route File Specifies the location of the route file.

 Tip
Click Browse to locate the file.

Session File Specifies the location of the session file.
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Field Description

 Tip
Click Browse to locate the file.

Test Points area Specifies the options you want for test points installed by SPECCTRA.
See also: “Data Passed to SPECCTRA”, “Testpoint” topic in the 
SPECCTRA Help

Miter area Specifies the miter conversion type: Normal, Diagonal, Round.

Recorner area Specifies the recornering options: Normal, Diagonal, Round.

Delete Conflicts Specifies to remove crossover and clearance violations

Critic Specifies to eliminate notches and remove extra bends.

Spread Specifies to add extra space if there is room. Type the value of the 
spread in the Extra box.

Report area Specifies the type of data you want to include in the report: Class, 
Class to Class, Conflicts, Corners, Crosstalk, Group, Group Set, 
Keepouts, Length, No fanout, Padstack, Pairs, Regions, Status, 
Testpoints, Unconnect, Vias.

Report File Name Specifies the name of the report.

 Tip
Click Browse to locate the file.

Clear selections button Clears all box entries, check boxes, and radio button selections you 
have made.

Related Topics
SPECCTRA Output File Location and Router Settings
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Setup SPECCTRA Startup Dialog Box
To access: File  > Export  menu item > select SPECCTRA Files > Save  > in the SPECCTRA Link, type a 
name or browse to the file you want in the DO File Name box > Do File  button > Startup  button

Use the Setup SPECCTRA Startup dialog box to include a line referencing previously entered routes, 
saved in Wires or Best Save files, in your .do  file.

Description
SPECCTRA refers to these files upon startup. You can also include the name of the status file and 
parameters for Via at SMD, Seed Via, and Seed Via minimum distance.

For details on these files and functions see the SPECCTRA Design Language Reference PDF file 
spdlr.pdf  in the SPECCTRA group.

Objects

Field Description

Wires File Specifies the wires file.
Click Browse to locate the file.

Status File Specifies the status file.
Click Browse to locate the file.

Best Save Specifies the best save file.
Click Browse to locate the file.

Vias at SMD area Specifies whether to allow vias at SMD: On or Off.

Grid area Specifies whether the via is on a grid point: On or Off.
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Field Description

Fit area Specifies whether the via fits within the pad: On or Off.

Seed Via Specifies to break up two-pin connections that are larger than a certain 
length. Type the length value in the Distance box.

Force Specifies to force the break up of two-pin connections as indicated 
above.

Clear Selections  button Clears all selections made.

Related Topics
Setting up SPECCTRA .do File Startup Options
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Setup Via Dialog Box

Setup Via Dialog Box
To access: PCB Decal Editor > Setup  > Design Rules  menu item > Routing  button > Via definition 
button

Use the Setup Via dialog box to add new via names to the Available Vias list. The Setup Via dialog box 
does not reference via padstacks in the design. These via names should reference the real via names in 
your design, where the internal padstack structure is defined.

Objects

Field Description

Vias list Lists the vias defined and available for the Vias section of the 
Routing Rules Dialog Box. Select a name in the list to rename or 
delete the via.

Name box Type a new name in the dialog box and then click Add  to add it to 
the list.
Use the Name box to rename vias in the Vias list.

Add button Type a new name in the Name list and then click Add to add the 
via name to the Vias list.

 Restriction:
The button is unavailable until you type a name in the Name 
box.

Rename button With a via name selected in the Vias list, type a new name in the 
Name field and click Rename  to edit the name of the via within the 
Vias list.

Delete button With a via name selected in the Vias list, click Delete  to delete the 
name of the via.

Related Topics
Routing Rules Dialog Box

Creating Via Routing Rules in the Decal Editor
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Show Attributes Dialog Box
To access: Edit  > Attribute Manager  menu item > Show  button

Use the Show Attributes dialog box to select attributes to list in the multi-column list of the Attribute 
Manager.

CAUTION:
Hidden attributes are not available to the Attribute Manager and are not listed in the Show 
Attributes dialog box.

Objects

Field Description

Group Filters the Attributes list. You can choose an attribute group  on 
page 1811 to view.

Attributes list Specifies the attributes you want to view in the Attribute Manager 
Dialog Box.

Summary Creates summaries of every value of an attribute assigned to a 
particular objects type. In other words, summaries will appear at the 
bottom of attribute columns.
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Field Description

• Sum  — Shows the total of the attribute values. The summary 
applies to the attribute you select in the Attributes list. The summary 
displays in the Attribute Manager Dialog Box.

• Max  — Shows the maximum value used by the attribute. The 
summary applies to the attribute you select in the Attributes list 
box. The summary displays in the Attribute Manager Dialog Box. To 
create a summary that is the range of attribute values, click both the 
Min and Max check boxes.

• Min  — Shows the minimum value used by the attribute. The 
summary applies to the attribute you select in the Attributes list 
box. The summary displays in the Attribute Manager Dialog Box. To 
create a summary that is the range of attribute values, click both the 
Min and Max check boxes.

• Average  — Shows the average of the attribute values. The average 
is the sum of all attribute values divided by the number of values 
assigned. The summary applies to the attribute you select in the 
Attributes list. The summary displays in the Attribute Manager 
Dialog Box.

 Restriction:
Summaries are available only for Number, Decimal Number, and 
Measure attribute types.

Select All Selects all check boxes in the Attributes list.

Unselect All Clears all check boxes in the Attributes list.

Related Topics
Attribute Manager
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SPECCTRA DO File Dialog Box
To access: File  > Export  > select SPECCTRA Files > Save  > in the SPECCTRA Link, type a name or 
browse to the file you want in the DO File Name box > Do File  button

The .do  file is an editable batch script file, which controls SPECCTRA operation. You can add or edit 
command lines in a .do  file. When you start the editor, it reads the .do  file you specify in the SPECCTRA 
Link dialog box for editing.

Objects

Field Description

Setup area The contents of the Setup area change according to the options you 
select in the Setup area.

• Order  — change the original net ordering and control whether nets 
are routed in daisy-chain or starburst fashion. See also: “Order” 
and “Choosing Starburst or Daisy-Chain Wiring” topics in the 
SPECCTRA Help
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SPECCTRA DO File Dialog Box

Field Description

• Action  — control wire rerouting, net routing, and the availability 
of connections, vias, and layers for autorouting. See also: 
“Protect/Unprotect”,” “Fix/Unfix,” and “Select/Unselect” topics in the 
SPECCTRA Help

• Cost  — control routing costs and override the autorouter internal 
cost table. See also: “Cost,” “Limit,” “Tax,” and “Using Standard 
Autorouting Commands” topics in the SPECCTRA Help

• If you click Cost in the Cost area and Layer in the All area, options 
in the Type area appear. See also: “Type,” “Length,” “Way (Cost),” 
and “Way (Limit)” topics in the SPECCTRA Help

• Test Point Rule  — control passing DFT Audit test point placement 
options to SPECCTRA for its test point placement routine. See also: 
“Data Passed to SPECCTRA” and the “Testpoint” and “Testpoint 
Antennas” topics in the SPECCTRA Help.

All area Limits actions to certain selected objects. The content of this area 
changes depending on the options you select in the Setup area.

Only area Limits actions to certain selected objects.

Test Points area Available only when Test Points is selected.
• Insert Test Points  — Allows insertion of test points and makes the 

options in the Test Points area available.

• Allow Points at Pins  — Allows placement of test points on 
component pins. There is no equivalent in DFT Audit; test points are 
always allowed on pins.

• Allow Antennas  — Allows antennas. Set a length. There is no 
equivalent in DFT Audit.

• Max Length  — Sets the length restriction for antennas. The default 
maximum length is negative one (-1), no length restriction.

• Center to Center  — The distance between the centers of test 

points. 

• Center to Comp Edge  — The distance between the center of the 

test point and the component outline.

• Image Outline Clearance  — The clearance between the 
component outline and the test point carrier (via or component 
pin). If the Image Outline Clearance is negative, a zero (0) is set. 

• Test Side  — Searches the specified side for test point placement.
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Field Description

• Use Via  — Uses vias as test points.

• Grid X, Y  — The test point grid. See also: “Options Dialog Box, 
Grids and Snap Category, Grids Subcategory  on page 1537”.

Routing area Set fanout rules: direction, pin type, and maximum length. Set the Bus 
direction, and enter the number of passes for each type.

Clear selections button Clears all of the settings for the area.

Smart Route button Specifies to autoroute your design based on how your design is 
converging.
See also: the SPECCTRA Help.

Apply to Editor button Specifies to write the commands from this area to the .do  file.

Editor area The contents of the .do  file. Command appear here when you click the 
Apply to Editor button.

Continue button Starts the conversion and loading process.

Save As button Specifies that you want to save the .do  file with a specific name and 
location.

Startup button Opens the Setup SPECCTRA Startup Dialog Box.

Finish button Opens the Setup SPECCTRA Finish Dialog Box.

Related Topics
Creating or Editing a .do File
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SPECCTRA Link Dialog Box
To access:

• File  > Export  menu item > select SPECCTRA Files > Save

• Use Windows Explorer to navigate to your C:\<install_folder>\SailWind<version>\Programs 
directory, and double-click pads2sp.exe

When you start SPECCTRA from within SailWind Layout, the SPECCTRA Link dialog box enables you to 
load in and out of SPECCTRA automatically.

Note:
If you start SPECCTRA independently of SailWind Layout, use the Stand-alone SPECCTRA Link 
dialog box to load in and out of SPECCTRA manually  on page 1012.

Figure 212. SPECCTRA Link Dialog Box - from Layout

Figure 213. SPECCTRA Link Dialog Box - Stand-alone
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Objects
Table  201. SPECCTRA Link Dialog Box Fields

Field Description

DO File Name Specifies the DO file you want to use.
Click Browse to locate the file.

 Restriction:
From Layout only.

Continue button Loads the design into SPECCTRA and the router runs in batch mode.

Setup button Opens the SPECCTRA Setup Dialog Box.

DO File button Opens the SPECCTRA DO File Dialog Box.

 Restriction:
From Layout only.

Options button Opens the Options dialog box  on page 1727.

 Restriction:
From Layout only.

To SPECCTRA button Opens the To SPECCTRA Dialog Box.

 Restriction:
Stand alone only.

From SPECCTRA button Opens the From SPECCTRA Dialog Box.

 Restriction:
Stand alone only.

Related Topics
Loading In and Out of SPECCTRA Automatically
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SPECCTRA Options Dialog Box
To access: File  > Export  menu item > select SPECCTRA Files > Save  > in the SPECCTRA Link, click 
the Options  button

The Options dialog box also appears when you click the Options button on the TO SPECCTRA dialog box 
(stand-alone), or the FROM SPECCTRA dialog box (stand-alone).

Description
This dialog box controls options for sending via keepout information, passing advanced rules to 
SPECCTRA, setting a mode for trace arc translation, and returning the unused pins net from SPECCTRA. 
For additional related information, see “Unused Pins Net”.

Objects

Field Description

Layer Containing Via Keepout 
Shapes list

Specifies the layer that contains the via keepout areas, and that you 
want to send them from your decals to SPECCTRA.

Pass Default Advanced Rules Specifies to pass default Selected Layer and Selected Via rules to 
SPECCTRA.
These rules require the Advanced Rules option in SPECCTRA. Turn 
this option on if you have this SPECCTRA option; otherwise, leave this 
option off.
See also: “SailWind Layout to SPECCTRA Rules Conversion”.
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Field Description

Trace Arc Translation area Specifies the mode to perform trace arc translation.
• To Single Segment  — Replaces each trace arc with a single 

segment. This is the default mode.

• To Multiple Segments  — Replaces a trace arc with multiple 
segments. The original trace arc is divided into smaller arcs (equal 
to approximately 5 degrees) and then each smaller arc is replaced 
by a single segment. The result is a polyline of multiple segments 
instead of the arc.

• To Quarter Arcs (QARCs)  — Breaks existing arcs into quarter arcs 
and other segments. (Quarter arcs are arcs whose start and end 
points are exactly 0–90, 90–180, 180–270, and 270–360 degrees.) 
The quarter arcs are translated to the SPECCTRA QARC structure. 
The remaining parts of arcs are translated to polylines.

Return Options area Specifies to return unused pin and fanout information to SailWind 
Layout. Type the name of the net in the SailWind Layout design that 
will contain the unused pins. Provide a new name if you do not want to 
use the default.
Clear this option to ignore unused pin and fanout information when 
returning to SailWind Layout.

 Tip
SPECCTRA names the unused pins net +UNUSED_PINS+ while 
previous versions named it *UNUSED_PINS*. The SPECCTRA 
Translator interprets both names.

The maximum netname length in SailWind Layout is 47 characters. 
You can use any alphanumeric characters except for brackets{ }, 
asterisks *, or spaces.

Related Topics
Setting SPECCTRA Options
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SPECCTRA Setup Dialog Box
To access: File  > Export  menu item > select SPECCTRA Files > Save  > in the SPECCTRA Link, click 
the Setup  button

Use the SPECCTRA Setup dialog box to set SPECCTRA automatic startup information.

Objects

Field Description

Executable Specifies the executable needed to run SPECCTRA.

Password/Server Specifies the password file needed to run SPECCTRA.

 Tip
For teal key node-locked or floating licensing, point to your 
license server in the standard port@host format. For example, 
7508@myserver.

Message Output Specifies the SPECCTRA message output file.

Status Specifies the SPECCTRA status file.

Color Mapping Specifies the SPECCTRA color mapping file.

No Graphics Specifies to disable the SPECCTRA graphic display and make 
SPECCTRA run faster.

Quit After Do Specifies to close SPECCTRA after it processes the .do  file 
commands.

No Preroutes Specifies to delete all prerouted traces before entering SPECCTRA.
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Field Description

Don’t Strip Orphan Shapes Specifies to ignore copper without net assignments, which have no net 
association in SPECCTRA.

Simplify Polygons Specifies to convert one-inch square, or smaller, polygons to simple 
rectangles.

Licensing Type area Select the licensing type you want: Floating, Node-locked with Flexid 
Key, or Node-locked with SSI key.

Launch SailWind Layout 
session

Specifies to reload the routed design back into SailWind Layout after it 
processes the .do  file commands.

Related Topics
Setting the SPECCTRA Automatic Startup Information
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Start-up File Output Dialog Box

Start-up File Output Dialog Box
To access: File  > Save as Start-up File

Use the Start-up File Output dialog box to create a startup file that contains global settings such as layer 
definitions, grids, clearance rules, the attribute dictionary, and so on. You can create different startup files 
and specify which one to use when creating a new design file. This capability enables you to save setup 
time when creating a new design by reusing global settings that you save in the startup file.

Objects

Field Description

Filename The name of this startup file.

Select All Selects all check boxes in the Sections list.

Unselect All Deselects all check boxes in the Sections list.

Sections The items available to you to include in the startup file.
• PCB Parameters  — Global information, such as colors, layer 

definitions, and grids

• Vias  — Via information, such as default via type, jumpers, 
padstack definitions and locations

• Layer Data  — Layer information specified in the Layers Setup 
Dialog Box, such as number of layers, layer names, routing 
direction for the layer, electrical type, and associations

• Rules  — Rules information, such as clearance, routing, and 
high-speed

• CAM  — CAM information related to the plot file configurations
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Field Description

• Attributes  — Attribute information, such as the attribute 
dictionary, all attributes assigned to objects in the design, and 
attribute status (read only, system, ECO registered, or hidden). 
Values in the attribute hierarchy are not saved.

Format Sets the format for this startup file.

Units Sets the units you want to use for this startup file.

 Tip
Current units provide more information than Basic units, such 
as grid positions.

Startup File Description A place to type a brief description of the global settings you are 
saving. The description appears when you select the startup file in 
the Set Start-up File Dialog Box, and should help remind you of the 
settings in the startup file.

Related Topics
Creating Start-up Files

Specifying the Start-up File

Start-up Files
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Status Dialog Box
To access: Ctrl+Alt+S

Use the Status window to view selection information and gain access to frequently used Options settings.

Objects

Field Description

Information area (blank area in 
figure)

Displays information about the currently selected object.

Snap To Grid Toggles the Snap to grid check box of the Design grid in the Grids 
Options  on page 1537.

Line/Trace Angle Toggles the Line/trace angle of the Design Options  on page 1503.

On-line DRC Toggles the On-line DRC setting of the Design Options  on 
page 1503.

 Restriction:
If the On-line DRC is set to Off, this button is unavailable and 
you must enable it from the Options dialog box.

Nudge Toggles the Nudge setting of the Design Options  on page 1503.

Layer Pair Toggles the Layer pair setting of the Routing Options  on 
page 1542.

Postage Stamp Displays a miniature of the current view.
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Step and Repeat Dialog Box
To access: PCB Decal Editor > select one or more terminals, 2D line items, text items, copper items, 
copper cut outs, or keepouts > right-click > Step and Repeat  popup menu item

You can define complex, repetitive array patterns of objects in the PCB Decal Editor using the Step 
and Repeat dialog box. You can select multiple or single items for replication. Step and Repeat also 
automatically increments text and pin numbers.

Description
Three types of Step and Repeat array replications are available and are controlled by the three tabs of the 
dialog box. The lower section of the dialog box is used to control the incrementing of pin numbers or text.

• Linear Tab  — For planar replication, in the horizontal and vertical directions. Described in Table 
202.

• Polar Tab  — For angular replication, rotation around the decal origin. This is useful for creating 
polar arrays of terminals. Described in Table 203.

• Radial Tab  — For radial replication, along the radial direction starting from the decal’s origin. This 
is useful for creating polar arrays of terminals. Described in Table 204.

• Pin numbering section — Used to specify the incrementing format of pin numbers. Described in 
Table 205.

• Text section  — Used to specify the incrementing of text. Described in Table 206.

Figure 214. Step and Repeat Dialog Box Linear Tab
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Step and Repeat Dialog Box

Figure 215. Step and Repeat Dialog Box Polar Tab

Figure 216. Step and Repeat Dialog Box Radial Tab
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Figure 217. Step and Repeat Dialog Box - Pin Numbering

Figure 218. Step and Repeat Dialog Box - Texts

Objects
Table  202. Linear Tab Contents

Command Description

Direction Sets the direction of the replication in the array: Up, Down, Left, or Right.

Count Sets the number of replications in the array.

Distance Sets the distance in the array: X distance in current units when the Linear Direction 
is Left or Right; Y distance in current units when the Linear Direction is Up or Down. 
Negative values reverse the direction.

Table  203. Step and Repeat Polar Tab Contents

Command Description

Direction Sets the direction of replication in the array: Counterclockwise or Clockwise.

Locked area Controls the automatic adjustment of Angle Range, Delta Angle, and Sites Per Ring 
for Radial Move. Controls the automatic adjustment of Count, Angle, and Angle 
Range for Polar Step and Repeat.
These three settings are interdependent; each value depends on the values in the 
other two. Set one of the values and lock it. Set one of the unlocked values; the 

1736 SailWind Layout Guide and Reference



 
GUI Reference Elements S

Step and Repeat Dialog Box

Table  203. Step and Repeat Polar Tab Contents  (continued)

Command Description
other unlocked value automatically updates. For example, if you set Angle Range 
to 360 and Sites Per Ring to 36, Delta Angle updates to 10.

Count Sets the number of replications in the array.

Angle Specifies the angle of the replication in the array. Negative values reverse the 
direction. You can type angle values with .001 degree precision. When you perform 
an angular replication on a terminal with noncircular pads, the pad stacks are 
copied and the pad stack offset value is maintained.

 Restriction:
• When you try to rotate a text item or a terminal with a noncircular pad with .001 

degree precision, replication angles are rounded to the nearest whole degree 
value.

• When replicating square-shaped pads, SailWind Layout converts them to 
rectangular-shaped pads during angular replication.

Angle Range Sets the range within which you want to place objects. 360 sets a full circle grid or 
array; smaller values set sector-shaped grids or arrays.

Table  204. Radial Tab Contents

Command Description

Direction Sets the direction of replication in the array; away from the PCB Decal Editor origin 
(Away From Origin) or towards the PCB Decal Editor origin (Towards Origin).

Count Sets the number of replications in the array.

Distance Specifies the linear distance, or the distance along the radius, between neighboring 
copies of each replicated object. Negative values reverse the direction.

Table  205. Pin Numbering Area Contents

Command Description

Prefix/Suffix For a single pin number, use either Prefix or Suffix box, and void the other box. Use 
both boxes if you want to increment one of the values.
A preview of the pin numbers based on your input is displayed below the boxes. 
For example, A1 or 1A.
Alphabetic and numeric values can be used in either box.

Increment prefix/ 
Increment suffix

Choose to increment the value of either the Prefix or Suffix box.

Step value Type a positive or negative number by which to increase or decrease the pin 
number with consecutive or stepped values.

 Restriction:
Step value must non-zero and be in the range -10 to +10. Zero would replicate 
a single pin number and is not allowed.
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Table  205. Pin Numbering Area Contents  (continued)

Command Description

Use JEDEC pin 
numbering

If using alphanumerics, you can select the Use JEDEC pin numbering check box to 
ensure that legal alphanumeric values are used.

 Tip
This option only ensures that legal alpha and numeric combinations are used. 
To arrange rows and columns according to JEDEC, use the Assign JEDEC 
Pinning option on the Tools Menu.

Table  206. Texts Area Contents

Command Description

Prefix/Suffix For a single text string, use either Prefix or Suffix box, and void the other box. Use 
both boxes if you want to increment one of the values.
A preview of the texts based on your input is displayed below the boxes.
Alphabetic and numeric values can be used in either box.

Increment prefix/ 
Increment suffix

Choose to increment the value of either the Prefix or Suffix box.

Step value Type a positive or negative number by which to increase or decrease the Text 
string with consecutive or stepped values. You can use a value of zero to repeat 
the exact same text and prevent the text string from incrementing.

 Restriction:
Step value must be in the range -10 to +10.

Related Topics
Using Step and Repeat to Add an Array of Terminals
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Synchronize Die Part Dialog Box
To access: BGA Toolbar  > Synchronize Die Parts  button

Library IQ is outmoded by the Wire Bond Wizard. This dialog box was used to synchronize die part data 
between SailWind Layout and Library IQ — a primitive Visual Basic tool to help reuse text-based die part 
data.

Restriction:
This information applies only to the BGA toolkit.

Note:
Beginning with PADS 9.0, dies and flip chips are identified by the Special Purpose settings in 
the Part Type rather than by the DIE and FLP logic families. With this change, any reference 
designator (logic family) can be assigned to a die or flip chip. If you are exporting to LIQ, and 
you have dies or flip chips of a family other than DIE or FLP in your design, remember that all 
parts lose their family designation when exported to LIQ, and are assigned either the DIE or FLP 
family when imported back into SailWind Layout; so the original family designation (and reference 
designator) of these parts is lost in the export/import process.
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Objects

Field Description

Preview area Displays the Library IQ die part selected in the Die Part list.

File The die part filename

Modified The last modification date

Chip Bond Pads The number of chip bond pads in the die part

Substrate Bond Pads The number of substrate bond pads in the die part

Wire Bonds The number of wire bonds in the die part

Flip Chip The Flip Chip identification for the die part

File The die part filename

Modified The last modification date

Chip Bond Pads The number of chip bond pads in the die part

Die Part Lists all Library IQ die parts in the current folder.

Look in Displays the die part search folder.
Click Browse to look for a folder.

Apply  button Sets the die part search folder.

Update LIQ button Updates die part data in Library IQ with die part data from the design.

Update Design button Updates die part data in the design with die part data from Library IQ.

Export LIQ button Saves die part data files to the default \My Documents\SailWind 
Projects  folder. The .liq  extension is automatically added to the saved 
file.

Design area • Part Type  — Lists all die part components in the design by part 
type.

• Component  — Lists all die part components in the design by 
reference designator.

Die Outline and Pads Sets the layer on which the die outline and pads appear. Select a layer 
from the list.

Wire Bonds Sets the layer on which the wire bonds appear. Select a layer from the 
list.

Update Names of Attached 
Nets

The name of the net is updated when the following conditions occur:
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Field Description

• The net has the same name as the updated pin name.

• There are no other component pins in the net with a pin name 
matching the netname.

• The new netname does not duplicate netnames in the design.

The graphic on the left shows a die part with pin names and netnames. 
If the previously described conditions are met when you update die 
parts, the graphic on the right occurs. This only occurs when this option 
is selected.
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Chapter 55
GUI Reference Elements T Through Z

Read the sections that follow to learn more about dialog box elements in SailWind Layout.

Tack or Trace Corner Properties Dialog Box
Teardrop Properties on Traces Dialog Box
Terminal Number Properties Dialog Box
Terminal Properties Dialog Box
Text Properties Dialog Box
To SPECCTRA Dialog Box
Trace Copy Dialog Box
Trace Loop Created Dialog Box
Trace Properties Dialog Box
Union Properties Dialog Box
Update Library Dialog Box
Update from Library Dialog Box
Update Models Dialog Box
Update Pin Gate Dialog Box
Update Pin Name Dialog Box
Update Pin Swap Dialog Box
Update Pin Type Dialog Box
Variant/Substitute Dialog Box
Verify Design Dialog Box
Via Properties Dialog Box
Vias Dialog Box
View Clearance Dialog Box
View Nets Dialog Box
Virtual Pin Properties Dialog Box
Warning: Test Point Locked Dialog Box
Wire Bond Checking Setup Dialog Box
Wire Bond Properties Dialog Box
Wire Bond Rules Dialog Box
Wire Bond Wizard Dialog Box
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Tack or Trace Corner Properties Dialog Box
To access: Select a trace corner > right-click > Properties  popup menu item

Use the Tack or Trace Corner Properties dialog box to obtain information on and to modify a selected 
trace corner or tack.

Objects

Field Description

Net Displays the name of the net.

Connection Lists the connections available in the design.

X/Y The X and Y location of the tack. Type in these fields to change the 
location.

Project Status Shows whether the net (to which the tack belongs) is protected.

Layer Displays the layer on which the tack is located.

Trc/Trc Clearance Displays the trace to trace clearance for this tack.

Rule Hierarchy Displays the rule hierarchy for this tack.

Pin Pair button Opens the Pin Pair Properties Dialog Box.

Net button Opens the Net Properties dialog box  on page 1487.

Rules button Opens the Pin Pair Rules Dialog Box.
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Tack or Trace Corner Properties Dialog Box

Related Topics
Modifying Trace Corner or Tack Properties
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Teardrop Properties on Traces Dialog Box
To access: Select one or more traces to which the teardrop is attached > right-click > Teardrop 
Properties  popup menu item

Use the Teardrop Properties on Traces dialog box to modify the teardrop shape, length ratio, and width 
ratio for any selected teardrop, teardrops on all layers, or all teardrops. You can also remove an individual 
teardrop from a design.

Objects

Field Description

Auto Adjust Use Auto Adjust to set a custom length and width ratio. With Auto 
Adjust selected, SailWind Layout attempts to adjust the length of the 
teardrop on traces where the trace corner is inside the pad or via or the 
segment is too short to contain the specified length ratio.

Action area • Add  — Adds a teardrop to the selected trace or to the setting in 
the Apply To area. Once you add a teardrop, you can modify its 
settings by choosing Modify. When you add teardrops to several 
traces, those traces already containing teardrops retain the existing 
teardrops with their original settings.

• Mod  — Modifies the teardrop on the selected trace and applies 
changes to what you click in the Apply to area.

• Del  — Deletes teardrops from the selected trace and applies 
changes to the setting in the Apply To area.

Apply to area Applies changes in the Teardrop Properties dialog box to teardrops 
within the Selection, the Layer, or All teardrops.

Shape area

Default button Creates a standard teardrop shape that is compatible with early 
SailWind Layout (that is, PowerPCB) versions.

 Restriction:
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Field Description

• You cannot set a length or width ratio with a Default-shaped 
teardrop.

• You cannot place default-shaped teardrops on square pads.

Line button Uses a line-shaped teardrop. You can set a length and width ratio for 
this teardrop. You may want to use line- or curved-shaped teardrops 
on high-frequency analog boards or very dense boards for smoother 
connections.

 Restriction:
This button is unavailable if you do not have the Analog license 
feature.

Curved button Uses a curved-shaped teardrop. You can set a length and width ratio 
for this teardrop. You may want to use curved- or line-shaped teardrops 
on high-frequency analog boards or very dense boards for smoother 
connections.

 Restriction:
This button is unavailable if you do not have the Analog license 
feature.

Length ratio Sets the length of the teardrop relative to the pad to which it is 
attached. You cannot set a ratio over 1000. The formula to calculate 
the length ratio is:
(pad diameter) * (length ratio in %) = length of the teardrop
For example, if the length ratio is 200 (200% of the pad diameter) and 
the pad diameter is 60 mils, then the length of the teardrop is 120 mils.

 Restriction:
This setting is not available for the Default teardrop shape.

Width ratio Sets the width of the teardrop relative to the pad to which it is attached. 
You cannot set a ratio over 100.

 Restriction:
This setting is not available for the Default teardrop shape.

Preview Shows the currently configured teardrop.

Related Topics
Modifying Teardrop Properties

Teardrops
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Terminal Number Properties Dialog Box
To access: PCB Decal Editor > select a terminal number > right-click > Properties  popup menu item

Use the Terminal Number Properties dialog box to modify the properties of the terminal number.

Objects

Field Description

X, Y The X,Y coordinates of the selected terminal number.

Pin No The pin number of the selected terminal number

Related Topics
Modifying Terminal Number Properties
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Terminal Properties Dialog Box
To access: PCB Decal Editor > select a terminal > right-click > Properties  popup menu item

Use this dialog box to modify terminal properties.

Objects

Field Description

X, Y The X,Y coordinates of the selected terminal.

Pin No The pin number of the selected terminal

Pad stack Opens the Pad Stack Properties for Pin Dialog Box.

Associated copper Clear the check box to disassociate copper from the terminal.

 Restriction:
The check box is only used to disassociate copper. For 
instructions on associating copper, see “Associating Copper 
with Terminals.”

Related Topics
Modifying Terminal Properties
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Text Properties Dialog Box
To access: Select text > right-click > Properties  popup menu item

Use the Text Properties dialog box to modify free text. You can change the font, font style, layer 
assignment, orientation, rotation, size, line width, justification, and mirror settings. You can also access 
the parent object if the text string is combined with a drafting object.

Restriction:
Text can only be added one line at a time into the design. See “Creating Reusable Fabrication 
Notes” for a tip on saving multiple lines of text to the library for reuse.

Objects

Field Description

Text The text string you want to use.

 Restriction:
There is a maximum of 128 characters per text string.

Font The fonts available to you.

 Tip
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Field Description

• Select stroke font or a system font.

• For system fonts, you can also click a font style button, or any 
combination of styles: B for bold, I for italic, or U for underlined.

Layer The layers available to you on which to place the text.

X,Y Lists the X and Y location of the text. Type new values to change the 
location.

Rotation Specifies the rotation angle of the text.

Size Specifies the size of the font.
Size (pts): This is font size in points and appears for system fonts
Size (mils): This is font character height and appears for stroke fonts. 
The size refers to the height of the tallest characters.

Line Width Specifies the line width for stroke fonts only.

Mirrored Flips the label - text is considered readable from the bottom side of the 
board.

Horizontal, Vertical Sets the horizontal and vertical justification of the text to ensure proper 
positioning between objects when text, attribute values, size, or width 
change.

 Tip
• For vertical justification, click Left, Center, or Right. For horizontal 

justification, choose Up, Center, or Down.

• Optionally, set justification by selecting the text, then right-clicking 
and clicking the Justify Horizontally  popup menu item, and then 
clicking Left, Center, or Right; and by right-clicking and clicking the 
Justify Vertically  popup menu item, and then clicking Up, Center, 
or Down.

Parent Opens the Drafting Properties Dialog Box  for the parent object if a text 
string is combined with a drafting object.

Clearance Specifies clearance values between the text and objects around it.
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Related Topics
Modifying Text Properties

1752 SailWind Layout Guide and Reference



 
GUI Reference Elements T Through Z

To SPECCTRA Dialog Box

To SPECCTRA Dialog Box
To access: In Windows Explorer, navigate to your C:\<install_folder>\SailWind<version>\Programs 
directory, and double-click pads2sp.exe  and then click the To SPECCTRA  button

Use the To SPECCTRA dialog box to translate a .pcb  design file into a SPECCTRA design file.

Objects

Field Description

PCB File Specifies the file to send to SPECCTRA.
Click Browse to locate the file.

Design File Specifies the design file (.dsn) that SPECCTRA inputs.
Click Browse to locate the file.

Do File Specifies the .do  file to send to SPECCTRA. The .do  file is the script 
file that controls SPECCTRA operation.
Click Browse to locate the file.

Did File Specifies the output file (.did) that SPECCTRA creates. This file serves 
as an input .do  file in a subsequent SPECCTRA session.
Click Browse to locate the file.

Startup SPECCTRA Specifies to start SPECCTRA after the batch conversion is complete.

DO File button Opens the SPECCTRA DO File Dialog Box.

Options button Opens the Options dialog box  on page 1727.
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Related Topics
Translating Design Data from SailWind Layout to SPECCTRA
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Trace Copy Dialog Box
To access: Appears when you perform a group operation that causes an illegal trace installation. These 
dialog boxes may appear when you move, rotate, or paste a group.

The dialog boxes describe the error with the trace and allow you to manage the error on the fly.

Figure 219. Trace Copy Dialog Box

Objects

Field Description

Unroute button Creates an unroute instead of installing the trace.

Ignore button Ignores the error and installs the trace. You are responsible for 
manually correcting the error.

Don't display this message 
again check box

Applies the action you click in this dialog box to all subsequent traces 
and prevents this dialog box from appearing again.
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Trace Loop Created Dialog Box
To access: Automatically opens when you create a trace loop.

Use the Trace Loop Created dialog box to delete a trace loop, cycle through which trace in the loop you 
want to delete, or keep the loop.

Objects

Field Description

OK Specifies to delete the loop that was created.

Cycle Specifies to cycle through the traces in the loop to determine which one 
you want to delete.

Create loop Specifies to not delete the loop you just created.
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Trace Properties Dialog Box
To access: Select a trace > right-click > Properties  popup menu item

Use the Trace Properties dialog box to edit connection information, coordinate locations for both 
corners, segment length, and layer information. You can modify the trace width and beginning or ending 
coordinates on routed traces.

Objects

Field Description

Net Displays the name of the net to which this trace belongs.

Connection Lists where the trace is connected.

X1/Y1 The X and Y starting location of the trace. Type in these fields to 
change the location.

X2/Y2 The X and Y ending location of the trace. Type in these fields to 
change the location.

Width Specifies the width of the trace.
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Field Description

 Restriction:
You cannot enter a value that is not within the minimum and 
maximum trace width settings in the Clearance Rules  on 
page 1167. If you enter an illegal value, you get the error message, 
“Wrong width value.”

Length Displays the routed length of the trace. Does not include any Discrete 
lengths.

Protect Status Shows whether the net (to which the trace or trace corner belongs) is 
protected.

Layer Lists the layer on which the trace or trace corner is located. You can 
also change the layer on which the trace resides.
See also: “Modifying Trace Segment Properties”.

Trc/Trc Clearance Displays the trace to trace clearance for this trace.

Rule Hierarchy Displays which rules are apply to the trace.

Pin Pair button Opens the Pin Pair Properties Dialog Box.

Net button Opens the Net Properties dialog box  on page 1487.

Rules button Opens the Pin Pair Rules Dialog Box.

TearDrop button Opens the Teardrop Properties on Traces Dialog Box.

Related Topics
Modifying Trace Segment Properties
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Union Properties Dialog Box
To access: Select a union > right-click > Properties  popup menu item

Use the Union Properties dialog box to obtain information on, and to modify, a selected union.

Objects

Field Description

Name Name of the currently selected union. To rename the union type a new 
name.

X/Y Coordinates Current coordinates of the union. To move the union to a new location 
type new values.

Rotation Current rotation of the union. For a different rotation angle type new 
values.

Layer list Layer on which the union members exist. To flip the union click a 
different layer.

Glued Prevents the union from moving through manual or automatic 
placement processes.

Members Individual parts that are members of the selected union.

Base list Identifies the part used to determine the XY location of the union.
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Field Description

Skip while Building Cluster Ignores the union or cluster during Grow Incremental and Grow 
Automatic operations.

Cluster Info Opens the Cluster Information Properties Dialog Box.

Related Topics
Unions
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Update Library Dialog Box
To access: View  > SailWind 3D  menu item > click the Update Library  button  .

Use this dialog box to export 3D model mappings from a PCB design to the Reuse folder location. 
Exporting 3D model mappings is optional; however, exporting them allows you to reuse the 3D model with 
the associated decal in future designs.

Objects

Field Description

Part Number Displays the part type of all components in the PCB design.

Cell(s) Displays the decal name associated with each part in the PCB 
design.

Filename Provides the file name of the 3D model mapped to each decal in 
the PCB design.

Alignment Indicates whether the 3D model has been aligned manually or 
automatically.
SailWind Layout imports 3D models into the PCB design in the 
default layout with which they were originally created (automatic 
alignment). You can manually adjust the alignment of the 3D 
model using the Align 3D Models Dialog Box.
Updating a decal in the Reuse folder location with a 3D model 
that has been manually aligned results in a new default 
alignment.
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Field Description

In Central Library Indicates whether or not the 3D model mapping is already saved 
in the Reuse folder location.

Overwrite policy  dropdown list Select one of three options when encountering any change 
conflicts in the central library:

• Do not overwrite Library —  Prevents overwriting of any 
existing 3D model mappings. Decals mapped in the PCB 
to 3D models that differ from those mappings in the Reuse 
folder location remain in the PCB design only.

• Overwrite all in Library —  Overwrites any existing 3D model 
mappings already in the Reuse folder location with those in 
the PCB design.

• Prompt for each conflict —  Provides a warning whenever 
encountering a conflict with Reuse folder location, allowing 
you to overwrite the existing 3D model mapping or retain it.

Enable cross probing  check box Select this check box to enable you to interactively select a part 
in the design workspace and make it selected also in the Update 
Library  list.

Related Topics
Assigning a 3D Model to a Component

3D Model Mapping
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Update from Library Dialog Box

Update from Library Dialog Box
To access: Tools  > Update from Library

Use the Update from Library dialog box to update a design with part types and decals from the library, or 
to compare part types and decals in a design with those in the library.

Tip
To update only selected components, select them before opening the dialog box.
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Objects

Control Description

Generate comparison report Select to compare library and design items and generate a report 
file. No changes are made to the design.

Update design from library Select to compare library and design items, update the design from 
the library, and generate a report file.

Include items with identical 
timestamps

Select this check box to include in the compare/update items 
whose timestamps are the same in the library and design.
Clear it to exclude these items from the compare/update.

 Tip
It is possible for items with identical timestamps to have 
different content in the library and design. For example, if you 
export a design to an ascii file, manually edit a part type in the 
ascii file, and import the design back into SailWind Layout, the 
timestamp of the part type will be unchanged, but the content 
will be different.

Part types Select this check box to include part types in the 
comparison/update.

PCB decals Select this check box to include PCB decals in the 
comparison/update.
Select this check box to update design components with the 
alternate decals information from the PCB Decals tab of the Part 
Information dialog box  on page 1593.

Decal rules Select this check box to include decal rules in the 
comparison/update.

Attributes and labels Select this check box to include part type attributes and decal 
attributes and labels in the comparison/update. Clear it to exclude 
them.

 Tip
A decal’s standard Name and Part labels—not just attribute 
labels—are included in the comparison/update.

Update item in design even if 
library item is older

Select this check box to update a design item even when its 
timestamp is newer than the library item’s timestamp. Clear it to 
prevent replacing a design item with an older library item.

Update item even if timestamps 
are identical

Select this check box to update a design item even when its 
timestamp is identical to the library item’s timestamp.

 Tip
If this check box is not set, design items with identical 
timestamps will not be updated, even if their content is 
different.

Preserve alternative decals not 
found in library

Use this check box to specify what you want to do with alternative 
decals in a design part type that do not exist in the corresponding 
library part type:
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Update from Library Dialog Box

Control Description

• Select the check box to preserve the alternative decals in the 
design part type.

• Clear the check box to remove them from the design part type 
(that is, leave only the alternative decals that exist in the library 
version).

Preserve decal rules not found in 
library

Use this check box to specify what you want to do with decal rule 
sets that are found in the design version of a decal, but not in the 
library version:

• Select the check box to preserve these rule sets in the design 
decal.

• Clear it to remove them from the design decal.

Preserve design attributes not 
found in library

Use this check box to specify what you want to do with attributes 
that are found in the design but not in the library:

• Select the check box to keep these attributes in the design item.

• Clear it to remove them from the design item.

Add new attributes not found in 
design

Use this check box to specify what you want to do with attributes 
that are found in the library but not in the design. See the “Label” 
check boxes below for additional attribute-related controls.

• Select the check box to add these attributes to the design item.

• Clear it to preserve the design item as it is (that is, do not add 
them to the design item.

Update common attributes Use this check box to specify what you want to do with attributes 
found in both the design and the library.

• Select the check box to update the design attribute with the 
library attribute’s values.

• Clear it to preserve the design attribute’s values (that is, do not 
update them).

Add labels missing in components Compares the labels on components in the design against those 
of the library decal and adds labels that might have been deleted 
from the component in the design or added to the decal in the 
library after the part was placed in the design. For example, a 
silkscreen Reference Designator deleted from the component 
in the design, or a second Reference Designator added to the 
assembly layer in the library.
Labels that exist in the library decals are propagated to all 
instances of decals in the design.
For an exact match of library labels to component labels, select the 
“Delete labels not existing in the library” check box also and clear 
the three “Preserve design labels” check boxes.

Delete labels not existing in the 
library

Compares the labels on components in the design against those of 
the library decal and deletes labels that might have been added to 
the component in the design or deleted from the decal in the library 
after the part was placed in the design.
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Control Description

 Note:
Requirement:  You must also clear the three check boxes in 
the “Preserve design labels” area.

Labels on components in the design are removed if matching 
labels are not found in the library decals.
For an exact match of library labels to component labels, select the 
“Add labels missing in components” check box also and clear the 
three “Preserve design labels” check boxes.

Preserve design labels Select the attribute properties you want to preserve in the design:
• Visibility  — Specifies whether and how an attribute associated 

with a label is displayed (none, value, name and value, full 
name and value).

• Location  — Specifies label x,y coordinates, layer, and rotation.

• Label properties  — Includes font, justification and right reading 
settings.

 Tip
These check boxes need to be cleared if you have selected the 
“Delete labels not existing in the library.

Summary and details
Summary only

See “How to Read the Update Report”.

Hide identical results Select this check box to see only the differences between library 
and design items in the Detailed Comparison Data section of the 
report.
Clear it to see all comparison data.

Hide graphics comparison details Select this check box to exclude graphical data of drawings, 
coppers, associated coppers and decal outlines from the report. 
Clear it to include graphical data.

Remove selected items Click this button to remove items currently selected in the Design 
Items lists.

 Tip
The items appearing in these lists are determined as follows: 
If one or more design components are selected when Update 
from Library is started, only the part types and decals of the 
selected components appear in the lists. If no components are 
selected, the part types and decals of all design components 
appear in the lists.

Related Topics
Updating a Design from the Library
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Update Models Dialog Box
To access: Open the 3D view (View  > SailWind 3D  menu item), then click the Update Models button 

.

Use this dialog box to update the 3D models in the PCB design with 3D model information from the 
Reuse folder location.

Objects

Field Description

Status of 3D models Displays a short report on the current state of all parts in the 3D 
design and their current 3D model mappings:

• Parts with a local 3D model (no 3D model available in 
library)  — Displays a list of all parts that have 3D models 
mapped to them in the PCB design but do not have 3D 
models mapped in the Reuse folder location.

• Parts with a local 3D model (A 3D model is available in 
library)  — Displays a list of parts in the PCB design that have 
a 3D model with differences from the 3D model mapped to 
the part in the Reuse folder location.

• Parts without 3D model in library  — Displays a list of 
parts in the PCB design that have not been mapped to a 3D 
model. Parts not mapped to 3D models are represented by 
2D extruded models instead.

• Parts with up-to-date 3D model  — Displays a list of parts in 
the PCB design that have 3D models mapped in the Reuse 
folder location that have information unchanged from the 
corresponding 3D model information in the PCB design.

• Parts with modified 3D model mapping  — Displays a list of 
parts with 3D model information in the PCB layout that require 
updating with 3D model changes saved in the central library 
or Reuse folder location.
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Field Description

Update button If any parts in the PCB design are mapped to 3D models in both 
the local PCB design and the Reuse folder location, and the 3D 
models in the Reuse folder location have differences, you can 
update the corresponding 3D models in the local PCB design by 
clicking Update
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Update Pin Gate Dialog Box
To access:

• File  > Library  menu item > select a Library > Parts  button > New  > Pins tab  on page 1596 > 
select cells in the Pin Group column > Edit  button

• File  > Library  menu item > select a Library > Parts  button > select a part > Edit  button > Pins 
tab > select cells in the Pin Group column > Edit  button

Use the Update Pin Gate dialog box to update the Pin Group column of selected pins in the Pins table on 
the Pins tab of the Part Information dialog box.

Objects

Field Description

Pin Gate list Specifies the setting to assign selected pins in the pins table.
Possible settings include:
Gate-n  — assign to gate pins. This selection is only available if you 
have added gates on the Gates tab  on page 1588.
Signal pin  — assign to implicit pins (not shown on the schematic)
Unused pin  — assign to unused pins
Connector pin  — assign to connector pins. This selection is only 
available if the part is set as a Special Purpose > Connector on the 
General tab  on page 1590.
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Update Pin Name Dialog Box
To access:

• File  > Library  menu item > select a library > Parts  button > New  > Pins tab  on page 1596 > 
select cells in the Name column > Edit  button

• File  > Library  menu item > select a library > Parts  button > select a part > Edit  button > Pins tab 
on page 1596 > select cells in the Name column > Edit  button

Use this dialog box to update the Name column of selected pins in the Pins table (on the Pins tab) of the 
Part Information dialog box.

Objects

Field Description

Pin Name box Specifies the name to assign selected pins in the pins table.
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Update Pin Swap Dialog Box
To access:

• File  > Library  menu item > select a library > Parts  button > New  > Pins tab  on page 1596 > 
select cells in the Swap column > Edit  button

• File  > Library  menu item > select a library > Parts  button > select a part > Edit  button > Pins tab 
on page 1596 > select cells in the Swap column > Edit  button

Use the Update Pin Swap dialog box to update the Swap column of selected pins in the Pins table on the 
Pins tab of the Part Information dialog box.

Objects

Field Description

Pin Swap box Specifies the swap number to assign selected pins in the pins table.
Pins with the same swap number can have their connections swapped 
in the design using the Swap Pin or Auto Swap Pin features on the 
ECO Toolbar.
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Update Pin Type Dialog Box
To access:

• File  > Library  menu item > select a library > Parts  button > New  > Pins tab  on page 1596 > 
select multiple cells in the Type column > Edit  button

• File  > Library  menu item > select a library > Parts  button > select a part > Edit  button > Pins tab 
on page 1596 > select multiple cells in the Type column > Edit  button

Use the Update Pin Type dialog box to update the Type column of multiple selected pins in the Pins table 
(on the Pins tab) of the Part Information dialog box.

Objects

Field Description

Pin Type list Specifies the type to assign selected pins in the pins table.
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Variant/Substitute Dialog Box
To access: Tools  > Assembly Variants  and then one of the following:

• Click an Assembly Variant in which you want to substitute the component from the Variant Name 
list, select the component name to change, and click Substituted in the Status area.

• Select a component in the multicolumn list, and click Substitute in the Status area.

• Click Substitute from the Verb Mode list, and select a component in the Layout Editor.

The Variant/Substitute dialog box appears when you choose to substitute a component in an assembly 
variant. When you substitute a component, the substitution is referred to as the active component. The 
original component that you substituted is referred to as the default. The default component is what exists 
in the base option and the raw database.

Objects

Field Description

Current Displays the state before you click Substituted.

New Displays the state after you click Substituted.
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Field Description

Show difference Specifies to display only the differing values of the Default and Active 
component in the Variant table.

Browse Opens the Get Part Type from Library Dialog Box.

Variant Displays the name of the selected variant.

Variant table Displays the attributes (Value) of the component you are substituting, 
its Default  on page 1820 value, and its Active  on page 1808 value (the 
substitution).

Preview Opens the Preview for dialog box where you can see the substitutions 
you have made.

Related Topics
Substitute a Component for Assembly Variants
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Verify Design Dialog Box
To access: Tools  > Verify Design

You can check for individual or all design errors using the Verify Design dialog box. Check for the 
following types of errors: clearance, connectivity, high speed, number of vias, plane connection, test point, 
fabrication, wire bond. You cannot use this dialog box to check reference designator, part type, or attribute 
labels for clearance violations.

Objects

Field Description

Location list Lists the error for the type of check you selected in the Check area.

Explanation list Displays the reason for the error selected in the Location list.

Clear Errors button Clears the Error Markers  on page 885.

 CAUTION:
This does not clear the actual errors.

Disable Panning Prevents the design area from panning to the error you select in the Location 
list.

Display summary prompt Enables the error-summary prompt window. The prompt window appears 
after the check has run and lists the total number of errors found.
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Field Description

Check area Specifies the type of check you want to run, set up, view, or specify a report 
for.

• Clearance  — Performs clearance checking on only the visible area and 
visible objects of the design. For example, if you have a trace running 
across the via pad of a different net on inner layer 4 and you have the 
color for vias assigned the same color as the background color, the 
clearance check will not identify any clearance error on that via and trace 
short. See also: “Clearance Checking Setup Dialog Box.”

 Tip
When clearance checking against the board outline, the edge of the 
object is checked against the centerline of the board outline.

• Connectivity  — Performs connectivity checking on the entire design.
 Tip

• The connectivity check also detects instances where a drill size is 
larger than the pad it is assigned to.

• Connectivity checking recognizes copper as a valid conductor, like a 
trace.

For troubleshooting errors, see Subnet Errors.

• High Speed  — Performs high-speed checking on the entire design. See 
also: “Electrodynamic Check Dialog Box”.

Traces on high-speed printed circuit boards can act like transmission 
lines that “broadcast” interference to adjacent conductors. Using the 
high-speed rules module, you can use Rules to set clearances on a net 
class, net, or pin to pin connection basis; then use high-speed checking 
to report on properties such as impedance, delay, track length, daisy 
chaining, and parallel routing. These issues cause interference and 
create costly problems in prototyping. You can run these checks against 
the entire board or against specific nets.

• Maximum Via Count  — Performs maximum via count checking on the 
entire design.

• Plane  — Performs plane checking on the entire design. Checks whether 
a pad exists in the connecting pad stack for the plane layer. For a pad 
size to exist it must be more than 0 or the drill size must exceed the 
pad size. For links to SMD pads, Plane checks whether the pad-to-via 
connection connects to the plane. See also: Mixed Plane Setup Dialog 
Box.

 Tip
To view Plane clearance or connectivity errors after performing 
a Plane check, return to the Verify Design dialog box and click 
Clearance  or Connectivity.

Check area (con’t) • Test Points  — Performs test point checking on the entire design. Test 
Points checks for probe clearances, minimum via/pad sizes for probing, 
SMD pin probing, test points on component pin on the component side, 
test point count per net settings and nail diameter settings, and compares 
the settings against the setting you make in the DFT Audit program.

 Tip
DFT treats virtual pins as pins. See also: “Performing a Test Point 
Audit”.
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Field Description

 Tip
Test point checking is the same whether you enable the checking 
on the Verify Design dialog box or on the Latium Checking Setup 
Dialog Box. If you plan to perform Latium Design Verification, you 
can eliminate an extra design transfer between SailWind Layout and 
SailWind Router by running test point checking along with the other 
Latium checks.

• Fabrication  — Performs DFF error checking on designs by either using 
CAM documents in SailWind Layout or by using errors that are backward 
annotated from CAM350.

 Note:
Requirement:  You need the CAM350 Link license option to 
use this. See also: Fabrication Checking Setup Dialog Box  and 
“Back-annotating CAM350 Files”.

• Latium Design Verification  — Performs clearance checking on only the 
visible area of the design. Any Latium rule  on page 1835 errors found 
appear in the Location list. The design is passed to SailWind Router to 
perform the verify design check, and is passed back to SailWind Layout 
when the process is complete. If you used SailWind Router to work on 
your design, it might contain advanced rules (differential pairs, vias at 
SMD, matched length traces) which only SailWind Router can check.

The Latium Design Verification:
a. Saves the current SailWind Layout database to a temporary file

b. Starts SailWind Router (if not already running)

c. Starts the SailWind Router Monitor  on page   in Verify Design 
Mode

d. Loads the saved SailWind Layout design into SailWind Router

e. Executes the selected checking operations

f. Saves the file in SailWind Router

g. Re-loads the SailWind Router file into SailWind Layout

• Wire Bonds  — Performs clearance checking on the entire design. 
Checks wire bond length, width, angle, and the clearance between wire 
bonds and substrate bond pads for all die parts in the design.

 Tip
Rules for individual die parts are set using the Wire Bond Rules 
Dialog Box  when in the Wire Bond Editor  on page  .

Start button Runs the check with your specified options.

Setup button Opens the setup dialog box for the check you have selected.
• Clearance  — Clearance Checking Setup Dialog Box

• Connectivity  — Connectivity Checking Setup Dialog Box

• High Speed  — Electrodynamic Check Dialog Box

• Maximum Via Count  — Unavailable

• Plane  — Mixed Plane Setup Dialog Box
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Field Description

• Test Points  — Unavailable

• Fabrication  — Fabrication Checking Setup Dialog Box

• Latium Design Verification  — Latium Checking Setup Dialog Box

• Wire Bonds  — Wire Bond Checking Setup Dialog Box

View Report button Opens the report in a text editor for the check you have selected. These 
reports are saved in the \SailWind Projects  folder by default.

• Clearance  — clear.lst

• Connectivity  — connect.lst

• High Speed  — hispeed.lst

• Maximum Via Count  — viacount.lst

• Plane  — chtie.lst

• Test Points  — testpt.lst

• Fabrication  — DFF.lst

• Latium Design Verification  — latium.lst

• Wire Bonds  — diecheck.lst

Report File button Specifies where you want to save your report file. You can set a different 
location and name for each type of check.

Preview button After you run a Fabrication check that reports errors, you can preview 
the CAM layer document associated with the error. The Preview button is 
available only when fabrication checking is enabled and lists errors.

Errors Displays the number of errors for the type of check you ran after you click 
Start.

Related Topics
Verify the Design
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Via Properties Dialog Box
To access: Select a via > right-click > Properties  popup menu item

The Via Properties dialog box displays the netname to which the via belongs, the via name, coordinates, 
and the place where the via is connected.

Objects

Field Description

Net Displays the name of the net to which this via belongs.

Connection Lists where the via is connected.

X/Y The X and Y location of the via. Type in these fields to change the 
location.

 Restriction:
These fields are not available when the Stitching check box is 
selected.

Via Name Lists the via type. You can click a different type from the list and apply 
it.

 Tip
If Lock Test Point in the Options dialog box > Routing  category > 
General subcategory  on page 1542 is on, you cannot reassign a 
via type. If you reassign a via type that is a locked test point, the 
Warning: Test Point Locked dialog box  on page 995 appears.

Trc/Trc Clearance Displays the trace to trace clearance for this via.
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Field Description

Rule Hierarchy Displays which rules are apply to the via.
See also: “Design Rule Hierarchy”.

Glued Glues the via so you cannot move it. If you try to move the via, a 
message will appear notifying you that the via is glued. You can 
override the glue setting.
You can fix a via's location on the fabrication board by turning on the 
Glued check box in the Via Properties dialog box. The points of a bed 
of nails test apparatus are matched to the test point locations, which 
can be vias. So if you redesign and remanufacture the board, the 
glued test points prevent the vias from moving in the new design, thus 
preventing costly retooling of the test equipment.

Test Point Makes the via or pin a test point.
This is a three-state check box that depends on the state of the 
selected objects. If all of the selected vias or pins are a test point, then 
it is on. If none of the selected vias or pins are a test point, then it is off. 
If some of the selected vias or pins are a test point and some are not, 
then it is undefined.
You can make all selected vias or pins test points by turning Test Point 
on and choosing Apply. You can remove the test point from all selected 
vias or pins by turning Test Point off and choosing Apply. When you 
click Apply the pad stack is automatically checked to see if the via or 
pin can be a test point; for example, you cannot make buried vias test 
points because a probe cannot access a buried via.

 Tip
When the via or pin is flagged as a test point, and Show Test 
Points is checked in the Options dialog box > Routing  category > 
General subcategory  on page 1542, an arrow is drawn on it in the 

design:

Plane Thermal Determines whether the pin or via is eligible to receive a thermal  on 
page 1866. The status of a thermal is set individually by pin and via, 
and the thermal indicators will appear on plane layers only. Click to 
clear this check box if you do not want the via or pin to connect to any 
plane.
Once a pin or via is eligible, it is not automatically assigned a thermal 
attribute.
See also: “Setting Pins and Vias as Thermals  on page 797.”

Stitching Determines that this is a stitching via. Vias that are not added during 
the process of routing a trace are marked as stitching vias. These vias 
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Field Description
are treated differently from regular vias (which can be ripped up or 
shoved by the dynamic router).

Top Access Attempts to probe the test point from the top and bottom in DFT Audit. 
The default is bottom; so with Top Access off, DFT Audit automatically 
tries to probe the test point from the bottom.
See also: “Performing a Test Point Audit.”
When you click Apply, the pad stack is automatically checked to see if 
top access is valid; for example, you must assign Top Access to partial 
vias with only top access if you want to use the vias as test points.
You can only set the Top Access option if the via or pin is a test point 
(Test Point is on).

Pin Pair button Opens the Pin Pair Properties Dialog Box.

Net button Opens the Net Properties dialog box  on page 1487.

Rules button Opens the Pin Pair Rules Dialog Box.

Pad Stack button Opens the Pad Stacks Properties Dialog Box.

Attributes button Opens the Object Attributes Dialog Box.

Related Topics
Modifying Via Properties
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Vias Dialog Box
To access: Type v > press the Enter key

Use the Vias dialog box to specify how SailWind Layout should determine the via type to use when you 
add a via or a virtual pin. When you choose a via type, SailWind Layout uses it with the Add Via, Add Via 
to Guide, and Add Virtual Pin commands.

Tip
You can also change the via type during routing.

Objects

Field Description

Via Mode area • Automatic  — When you add a via or virtual pin, SailWind Layout 
chooses from all via types, through or partial, that can handle 
the particular layer change, if any. (Virtual pins, unlike vias, do 
not necessarily change layers.) If SailWind Layout finds partial 
via types dedicated to the layer change, it chooses from them. If 
SailWind Layout cannot find a dedicated partial via type, it selects 
any through via types for a through or partial layer change even 
if the via type is not one that is specifically selected in the Via list. 
It then checks the Routing Rules Dialog Box  for via types that are 
allowed for the net to which you are adding a via or virtual pin. If 
more than one via type still passes, SailWind Layout installs the one 
with the smallest drill diameter or smaller pad size.

Automatic allows only via types that begin and end on the Layer 
Pair shown in the Options dialog box > Routing  category > General 
subcategory  on page 1542. To use automatic via mode, the layer 
pair for routing and the layer pair for the partial via type need to 
match. For example, if you have a partial via type set up for layers 1 
through 4, and the layer pair for routing is set for layers 1 through 8, 
automatic mode will not insert a via.

• Partial  — The automatic via selection still occurs, but it is limited to 
the partial via types only.
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Field Description

• Through  — The list of through via types becomes active. Click the 
via type you want to use as the default and click Apply. This is the 
via type which will be installed every time you add a via or virtual 
pin.

Via List Lists through hole via types available in the design; partial via types are 
not listed.

Related Topics
Via Types

Changing the Via Type While Routing
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View Clearance Dialog Box
To access: View  > Clearance  menu item > click the button for the type of clearance > select two items in 
the design

Use the View Clearance dialog box to find the minimum clearance between two items.

Objects

Field Description

Selected Items Displays information about selected nets and items. The clearance 
button you select determines valid selections

 Tip
Jumper outlines, text, and teardrops are not valid item types for 
clearance.

Min Clearance Displays the minimum clearance between the selected items, the 
selected net and its closest item, or between the selected nets.

Pan to Minimum Clearance 
Marker

Pans the view so the minimum clearance marker is in the center of the 
main workspace. This is available only for Net to Item and Net to Net.

Item to Item button Finds the minimum clearance between two selected items and
dimensions appear on the design showing the location and size of the 
minimum clearance.
Supported item types are board outlines, pads, vias, jumpers, traces, 
2D lines, copper, and component outlines.

 Tip
Jumper outlines, text, and teardrops are not valid item types for 
clearance.

Clearances are measured on the current layer. When one or both 
selected items are not on the current layer, the clearance is measured 
to the centerline of the item that is not on the current layer.

1784 SailWind Layout Guide and Reference



 
GUI Reference Elements T Through Z

View Clearance Dialog Box

Field Description

Net to Item button Finds the minimum clearance between a selected net and the closest 
item. Items include: pads, vias, jumpers, traces, 2D lines, copper, and 
component outlines.

Net to Net button Finds the minimum clearance between two selected nets.

Options button Opens the Options dialog box > Dimensioning  category > General 
subcategory  on page 1520, where you can control the extension lines 
and arrows used to show minimum clearance.

 Tip
To modify the appearance of the text, lines, arrows, and so on, used 
to show clearances, use the Options dialog box > Dimensioning 
category > General subcategory  on page 1520.

Related Topics
Viewing the Clearance Between Items and Annotating Dimensions

Viewing the Clearance Between a Net and an Item

Viewing the Clearance Between Nets
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View Nets Dialog Box
To access: View  > Nets

Use the View Nets dialog box to selectively hide or display connections or to hide or show routed or 
unrouted paths by netname.

CAUTION:
If View Nets hides unrouted connections, neither Verify Design nor Find can see them. Make sure 
View Nets does not disable any nets or traces you want to search for.

Objects

Field Description

Net list Lists all of the nets available in the design.

View list Lists all of the nets for which you want to set view properties.

Add/Remove buttons Add moves selected net names into the View List box where you can 
highlight net names and set view details for them. Use Ctrl for multiple 
selections. Click Remove  to move the net from the View List to the Net 
List.

Select By list Click a command from this list box to change the available nets in the 
Net List and View List boxes.

Color by Net area Sets a color to a selected net in the View Nets list. When you assign a 
color to a net, pads, unroutes, and vias on all layers, as well as traces 
optionally appear in that color, making it easier to identify nets when 
splitting planes. When you split planes, you can assign colors to the 
critical signals and then create correct copper planes with greater ease. 
All net color assignments are saved with the design.

1786 SailWind Layout Guide and Reference



 
GUI Reference Elements T Through Z

View Nets Dialog Box

Field Description

Use Color by Net to:
• Assign color to a net class or a class with rules.

• Assign power and ground colors and turn off the visibility of 
their unroutes. Pins appear in the color you set. This aids in the 
placement of capacitors and resistors; you do not need to view the 
power and ground unroutes.

• Assign color for critical nets so their static unroutes are clearly 
visible during placement.

Enable Color by Net Allows assignment of colors to pads, vias, and unroutes. Selecting this 
check box also allows you to optionally select the “Color Traces by Net” 
check box to apply color assignments to traces and pins. You can also 
use the modeless command Y to toggle this setting.
Clearing this check box returns colors to their default assignments (as 
assigned in the Display Colors Setup Dialog Box).

 Note:
Re-selecting this check box restores any previously defined net 
color assignments.

Include Net Colors on Traces Shows traces, for nets in the View List box, using the assigned color. 
Traces, pins, copper, and copper planes appear in the assigned color.
Selecting the “Enable Color by Net” check box enables this check box.

Lock Nets Specifies whether to lock the net(s) currently selected in the View List. 
Note the following:

• To lock or unlock multiple nets, use Ctrl/Shit for multiple selections. 
Nets are locked/unlocked immediately after this checkbox is 
selected/cleared.

• Options made in the View Unroutes Details area also affect the 
state of the Lock Nets checkbox: option "None" for selecting the 
checkbox automatically; the others for clearing this checkbox.

• For locked nets, you can neither change their display color by 
"Assign Color to Net" feature nor toggle the display of unrouted 
connections by commands Show All Connection or Hide All 
Connection.

Traces Plus the Following 
Unroutes check box

Enables filtering of the unrouted connections, where you can set the 
commands in the View Unroutes Details area.

View Unroute Details area The Unroute Details area options are:
• All — Displays all unroutes.

• All Except Connected Plane Nets  — Displays all unroutes except 
for those on plane nets whose connection to the plane have been 
satisfied. This option does not display unroutes to stitching vias that 
are embedded in copper planes, or CAM planes.

• Unrouted Pin Pairs  — Displays only unroutes on fully unrouted pin 
pairs.

• None  — Displays no unroutes.
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Related Topics
Modifying Net Properties

Assigning Colors to Nets

Net Properties Dialog Box of a Netlist Project
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Virtual Pin Properties Dialog Box

Virtual Pin Properties Dialog Box
To access: Select a virtual pin > right-click > Properties  popup menu item

The Virtual Pin Properties dialog box displays the netname to which the virtual pin belongs, the virtual pin 
padstack name, coordinates, and the place where the virtual pin is connected.

Objects

Field Description

Name Displays the reference designator of the virtual pin.

Net Displays the name of the net to which this virtual pin belongs.

Connection Lists pin pairs to which the virtual pin belongs.

X/Y The X and Y location of the virtual pin. Type in these fields to change 
the location.

Via Name Lists the name of the via type used by the virtual pin.
You can click a different via type from the list and apply it.

Trc/Trc Clearance Displays the trace to trace clearance for this virtual pin.

Rule Hierarchy Displays which rules are apply to the virtual pin.
See also: “Design Rule Hierarchy”.

Glued Glues the virtual pin so you cannot move it. If you try to move the 
virtual pin, the following message appears in the Output window on 
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Field Description
the Status  tab “At least one object is glued, cannot proceed with 
command.”

Test Point Makes the virtual pin a test point. This is a three-state check box  on 
page 1866.
When you click OK or Apply, the pad stack is automatically checked to 
see if the virtual pin can be a test point; for example, you cannot make 
a buried virtual pin a test points because a probe cannot access a 
buried virtual pin. If it cannot be made a test point, a warning message 
pops up and the Test Point check box is automatically cleared.

 Tip
When the virtual pin is flagged as a test point, and Show Test 
Points is checked in the Options dialog box > Routing  category > 
General subcategory  on page 1542, an arrow is drawn on it in the 

design:
 Tip
The points of a bed of nails test apparatus are matched to the test 
point locations, which can be virtual pins. So if you redesign and 
remanufacture the board, glued test points prevent the virtual pins 
from moving in the new design, thus preventing costly retooling of 
the test equipment. Consider locking test points with the Lock test 
points check box in the Routing options  on page 1542.

Top Access Attempts to probe the test point from the top and bottom in DFT Audit.

 Restriction:
This check box is unavailable unless you select the Test point 
check box first.

The default is bottom; so with Top Access off, DFT Audit automatically 
tries to probe the test point from the bottom.
See also: “Performing a Test Point Audit”.
When you click OK or Apply, the pad stack is automatically checked 
to see if top access is valid; for example, you must assign Top Access 
to partial vias with only top access if you want to use the vias as test 
points.

Pin Pair button Opens the Pin Pair Properties Dialog Box.

Net button Opens the Net Properties dialog box  on page 1487.

Rules button Opens the Pin Pair Rules Dialog Box.

Pad Stack button Opens the Pad Stacks Properties Dialog Box.

Related Topics
Virtual Pins
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Warning: Test Point Locked Dialog Box

Warning: Test Point Locked Dialog Box
To access: Modify any of the following:

• A cluster that contains test points

• Vias, pins, virtual pins or jumper pins that are locked test points

• Routes that are connected to locked test points

This warning dialog box performs different functions depending on whether you are modifying vias, pins, 
virtual pins, or routes.

Objects

Field Description

Disable Lock Test Points Turns the Lock Test Points check box off in the Options dialog box > 
Routing  category > General subcategory  on page 1542

OK button Applies the change and maintains the test point status.

Related Topics
Warning: Test Point Locked Dialog Box
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Wire Bond Checking Setup Dialog Box
To access: Tools  > Verify Design  > Wire Bonds check > Setup  button

Use the Wire Bond Checking Setup dialog box to specify which wire bond rules to check during a Wire 
Bonds verification.

Objects

Field Description

Wire Bond to Wire Bond 
Clearance

Assigns the clearance required, in current units, between adjacent wire 
bonds. All checking is done edge to edge.

Wire Bond to Substrate Bond 
Pad Clearance

Assigns the clearance required, in current units, between wire bonds 
and adjacent substrate bond pads. All checking is done edge to edge.

Minimum Length Assigns the minimum length, in current units, for all wire bonds in the 
die part.

Maximum Length Assigns the maximum length, in current units, for all wire bonds in the 
die part.

Maximum Angle Assigns the maximum angle, in degrees, at which you can place wire 
bonds in the die part.

Related Topics
Setting Up Wire Bond Checking
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Wire Bond Properties Dialog Box

Wire Bond Properties Dialog Box
To access: BGA Toolbar  > Wire Bond Editor  button > select a wire bond > right-click > Properties 
popup menu item

Use the Wire Bond Properties dialog box to edit the wire bond.

Restriction:
This information applies only to the BGA toolkit.

Note:
If you have multiple objects selected, properties that are not common to all selected objects will 
not appear.

Objects

Field Description

CBP Offset Specifies the X and Y values, with respect to the CBP orientation, at 
which to offset the wire bond from the center of the component bond 
pad.
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Field Description

SBP Offset Specifies the X and Y values, with respect to the SBP orientation, at 
which to offset the wire bond from the center of the substrate bond pad.

Width Type a width for the wire bond. The valid range is from 0 through 250 
mils. If you enter 0, the display line has a width of 0.01 mil.

Length Displays the length, in current design units, of the currently selected 
wire bond.

Angle Displays the angle, in degrees, of the currently selected wire bond.

Rules Data Displays the current wire bond rules information taken from the Wire 
Bond Rules Dialog Box.

CBP button Opens the CBP Properties Dialog Box  for the component bond pad 
connected to the currently selected substrate bond pad. This button is 
unavailable if there is no connected component bond pad.

SBP button Opens the SBP Properties Dialog Box  for the substrate bond pad 
connected to the currently selected component bond pad. This button 
is unavailable if there is no connected substrate bond pad.

WB Rules button Opens the Wire Bond Rules Dialog Box.
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Wire Bond Rules Dialog Box

Wire Bond Rules Dialog Box
To access:

• BGA Toolbar  button > Wire Bond Wizard  button > Wire Bond Rules  button

• BGA Toolbar  button > Wire Bond Editor  button > select a die component > right-click and click 
the Wire Bond Rules  popup menu item

• In the layout editor select a substrate bond pad, right-click and click the Wire Bond Rules  popup 
menu item

Use the Wire Bond Rules dialog box to define rules that apply to wire bonds in the die part. All checking is 
done edge to edge.

Restriction:
This information applies only to the BGA toolkit.

Objects

Field Description

WB to WB Clearance Assigns the clearance required, in current units, between adjacent wire 
bonds. The rule is not checked unless you select it and enter a value. 
All checking is done edge to edge.

 Tip
Unchecked rules appear in the Wire Bond Report  as “Not Set.”

WB to SBP Clearance Assigns the clearance required, in current units, between wire bonds 
and adjacent substrate bond pads. The rule is not checked unless you 
select it and enter a value. All checking is done edge to edge.

Min Length Assigns the minimum length, in current units, for all wire bonds in the 
die part. The rule is not checked unless you select it and enter a value.

 Tip
Unchecked rules appear in the Wire Bond Report  as “Not Set.”
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Field Description

Max Length Assigns the maximum length, in current units, for all wire bonds in the 
die part. The rule is not checked unless you select it and enter a value.

 Tip
Unchecked rules appear in the Wire Bond Report  as “Not Set.”

Max Angle Assigns the maximum angle, in degrees, at which you can place wire 
bonds in the die part. The rule is not checked unless you select it and 
enter a value.

 Tip
Unchecked rules appear in the Wire Bond Report  as “Not Set.”

Import button Imports wire bond rules saved in the Wire Bond Wizard Dialog Box 
from the Wire Bond Wizard Setup file, and assigns the values as rules 
for the currently open die part when you click OK  in the Wire Bond 
Rules dialog box.

Related Topics
Wire Bond Rules Checks
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Wire Bond Wizard Dialog Box

Wire Bond Wizard Dialog Box
To access: BGA Toolbar  > Wire Bond Wizard  button > select die part

Use the Wire Bond Wizard dialog box to define the SBP rings, set rules, assign the component bond pads 
to rings, define the wire bond fanout geometry, and create a wire bond fanout.

Description
The Die Wizard also has 4 tabs as shown below the main graphic.

• “Figure 221”  on page 1799 with details

• “Figure 222”  on page 1799

• “Figure 223”  on page 1800

• “Figure 224”  on page 1800

The features of those tabs are described in tables at the end of this topic.
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Figure 220. Wire Bond Wizard Dialog Box
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Wire Bond Wizard Dialog Box

Figure 221. Wire Bond Wizard, Guide tab

Figure 222. Wire Bond Wizard, Fanout Prefs tab
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Figure 223. Wire Bond Wizard, Strategy tab

Figure 224. Wire Bond Wizard, CBPs tab

Objects
Table  207. Wire Bond Wizard Dialog Box Fields

Field Description

Die Component Displays the selected Die Component.

SBP Rings list Lists all currently defined SBP rings. Select an SBP ring or rings to 
view, edit, or define.
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Wire Bond Wizard Dialog Box

Table  207. Wire Bond Wizard Dialog Box Fields  (continued)

Field Description

You can also add new rings, delete rings, and rename rings.

Add button Opens the Add SBP Ring dialog box  on page 1072, where you can 
insert a new SBP ring for the die.

Delete button Deletes the selected SBP ring. This also unassigns all component bond 
pads assigned to this ring and deletes SBPs and wire bonds, but only 
if the CBPs are assigned to a single SBP ring. If a CBP is assigned 
to two or more SBP rings, and one of the rings is deleted, the CBP 
remains assigned to the remaining ring, and the corresponding SBPs 
and WBs are kept.

Rename button Opens the Rename SBP Ring dialog box  on page 1072, where you can 
rename the currently selected SBP ring.

tabs • Table 208  on page 1802

• Table 209  on page 1803

• Table 210  on page 1803

• Table 211  on page 1804

Save Setup button Saves Wire Bond Wizard dialog box settings from the current design to 
use in another design. The settings are stored in a text file with a .wbw 
extension.
Use Load Setup to open .wbw  files and apply the settings to other 
designs.

Load Setup button Loads the settings from the text setup file and uses them in the current 
design. The settings are stored in a text file with a .wbw  extension.
Use Save Setup to save .wbw  files to use them in another design.

SBP to SBP Clearance Rules Displays the default value for the SBP–to–SBP clearance rule, 
represented by SMD-to-SMD default clearance rules set on the 
Clearance Rules Dialog Box.

Design Rules button Opens the Rules Dialog Box, where you can change the value for the 
SMD-to-SMD default clearance rule settings affecting the SBP-to-SBP 
clearance. From the Rules dialog box, click Default, then Clearance.

Wire Bonds area Displays the settings for all wire bond rules for the currently selected 
die component.

Wire Bond Rules button Opens the Wire Bond Rules Dialog Box, where you 
can specify the wire-bond-to-wire-bond clearance, 
wire-bond-to-substrate-bond-pad-clearance, wire bond minimum and 
maximum lengths, and wire bond maximum angle.

Assign CBPs button Opens the Assign CBPs to Rings Dialog Box, where you can assign 
component bond pads to one or more rings.
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Table  207. Wire Bond Wizard Dialog Box Fields  (continued)

Field Description

SBP Naming button Opens the SBP Properties Dialog Box, where you can specify 
substrate bond pad numbers and substrate bond pad function names 
for newly created substrate bond pads.

Generate Fanout for area Select component bond pads for fanout processing.
• Sides  — Select the SBP ring side or sides to process. Wire Bond 

Wizard processes all component bond pads assigned to the 
selected side or sides of the SBP rings.

• Selected CBPs  — Select component bond pads in the layout 
window.

Allow Gaps Allows gaps when placing wire bonds in the wire bond fanout. 
Otherwise, Wire Bond Wizard evenly distributes all wire bond fanouts 
into a compact group.

Fit to Guide Fits the substrate bond pads along the SBP guide using the preferred 
spacing values for the SBP rings. Otherwise, Wire Bond Wizard uses a 
smaller value, up to the minimum spacing allowed by the rules.

Preview Fanout button Displays a wire bond fanout preview using the current settings. You can 
repeatedly view and modify the fanout until it satisfies the wire bond 
rules.
If you change any of the settings that affect the fanout pattern, the 
fanout changes to Preview of CBP Assignment mode.

Report Generates a report containing created object and wire bond rule 
violations.

Error Markers Generates and displays error markers in the fanout preview.

Create Fanout button Creates the new fanout and saves its settings in the design. This 
also generates a report that lists created objects and wire bond rule 
violations.

Table  208. Guide tab contents

Field Description

Size area Defines the size of the SBP guide:
• Distance from Die  — Click to enter X and Y values for the distance 

of the substrate bond pad guide box from the die outline.

• Size  — Click to set an absolute size for the guide box.

Shape list Defines the shape of the SBP guide. Available selections are: 
rectangle, rounded rectangle, arced, and tent. If you select arced or 
tent, you can also select a height.

By Side Creates a substrate bond pad guide with mixed shapes.

Shape by Side area Defines a shape for each side of the SBP guide.
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Wire Bond Wizard Dialog Box

Table  208. Guide tab contents  (continued)

Field Description

To define a shape for a side, click Enable. In the Shape column, select 
a shape type for that side. When you select the arced or tent shape, 
select a height in the Height column.
You can create the SBP guide with one or more sides missing.

Table  209. Fanout Prefs contents

Field Description

Shape Select a shape for the substrate bond pads to create in the fanout of 
the currently selected SBP rings. Choices are Rectangle and Oval.

Length Select a length for the substrate bond pads to create in the fanout of 
the currently selected SBP rings.

Width Select a width for the substrate bond pads to create in the fanout of the 
currently selected SBP rings.

Layer Select an electrical layer for the substrate bond pads of the currently 
selected SBP rings.

Focus area Select the area on which you want the focus: Ortho, CBP, Center. or 
X/Y location.

Width Select a width for the wire bond for the fanout of the currently selected 
SBP rings.

Offset Select an offset for the wire bond for the fanout of the currently 
selected SBP rings.

Table  210. Strategy tab contents

Field Description

SBP to SBP for This Ring Displays the substrate-bond-pad-to-substrate-bond-pad clearance 
value for the layer to create the substrate bond pads for the selected 
rings. The clearance value for this ring may be different from the default 
SBP–to–SBP clearance if specific design rules are used for the layer 
specified on the Fanout Prefs  tab. The layer is specific to the substrate 
bond pads of this ring.
The SBP–to–SBP clearance rule is represented by SMD-to-SMD 
clearance rules set on the Clearance Rules Dialog Box.

SBP to SBP Spacing Defines the preferred spacing from substrate bond pad to substrate 
bond pad for the selected ring. The value must be equal to or larger 
than the current SBP–to–SBP rule, represented by SMD-to-SMD 
clearance rules set on the Clearance Rules Dialog Box.

WB to SBP Spacing Defines the preferred spacing from wire bonds to substrate bond pads 
for the selected rings. The value must be equal to or larger than the 
WB–to–SBP rule set on the Wire Bond Rules Dialog Box.
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Table  210. Strategy tab contents  (continued)

Field Description

Force Preferred Spacing Prevents automatic switching to the smallest allowed spacing when 
fitting the substrate bond pads of the selected rings along the substrate 
bond pad guide.
If Fit to Guide is selected, you can affect the spacing of the wire bonds 
of the selected rings by clearing the Force Preferred Spacing option.

Create Nets from Pin 
Function

Incorporates all new substrate bond pads with the same function name 
into the net of the same function name. If this net does not already 
exist, Wire Bond Wizard creates it.

Ignore SBP to SPB Clearance Ignores the SBP to SBP Clearance rules.

Table  211. CBPs tab contents

Field Description

CBP column Lists the numbers of all component bond pads assigned to the selected 
ring.

CBP Function column Lists the functions of all component bond pads assigned to the selected 
ring.

SBP Function Lists the functions of all substrate bond pads assigned to the selected 
ring.

Select All  button Selects all component bond pads in the CBP list to assign to the 
currently selected rings.

Invert Selected  button Inverts all selections currently in the list. If one item is currently 
selected, this button will deselect that one item and select all other 
items instead.

Show Only CBPs for Selected 
Sides

Displays only component bond pads specified in the Generate Fanout 
for area of the Wire Bond Wizard Dialog Box. If you do not select this 
option, the list displays all component bond pads, no matter what the 
current settings are in the Generate Fanout for area.

Unassign  button Removes the assignments of the selected component bond pads 
from their rings and returns those component bond pads to the list of 
unassigned component bond pads, if the CBPs belong to a single SBP 
ring. Otherwise the CBPs still belong to the remaining rings to which 
they were assigned.

Reassign To Opens the Reassign CBPs to Rings dialog box, where you can select a 
ring or rings in the list to reassign component bond pads.
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Related Topics
Creating a Wire Bond Fanout
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Glossary
absolute coordinates

Coordinates of a location based upon their distance from the origin (coordinates 0,0) of the design 
area.

accelerator keys
Key sequences used to invoke commands and change system settings without using the mouse. 
Accelerator keys are called shortcut keys in the SailWind product documentation.

accessible nets
Nets for which you can define test points. DFT Audit analyzes all nets. If DFT Audit determines that 
test probes can access them, the nets are accessible (also called adaptable).

accordion
A trace pattern resembling a signal wave that adds length to traces. The trace patterns are 
contiguous and do not include layer changes.

accordion gap
The gap of an accordion sets the pitch between chords. The gap is a user-definable number 
multiplied by the same net trace-to-corner clearance.

If the same-net trace-to-corner distance equals zero, then Trace Width is used for the gap 
calculation.

See also accordion, amplitude, pair routing gap
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acid trap
An acid trap is a location where acid gets trapped in an area due to the surface tension of the 
etching. This acid causes over-etching, which hurts yield.

active component
The active substituted component in an assembly variant. Active means that this substitution of the 
component is used in the current variant.

See also default.asc

active layer
The design layer to which new information is added. You select the active layer by choosing the 
layer in the Layer list on the Standard Toolbar. You can also do this by using the L modeless 
command  on page 83.

ACTM#
The 16-digit number found on your security key.

adaptable nets
See accessible nets

adhesive
A substance used to attach the bodies of devices to a PC board.

aggressor nets
When using the Electrodynamic Checking program (EDC), a net or pin pair that is considered a 
source of interference.

align
To reposition placed parts to match the alignment of another part.

alignment tool
A small, temporary marker at each location where dimensioning occurs.

alpha pins
Pins with descriptive letters that are substituted for pin numbers. For example, GND for the ground 
pin. Alphanumeric pin assignments are made in the Library Manager's part type editor.

alphanumeric pins
Pins with alphanumeric pin numbers. An alphanumeric name consists of a prefix and suffix. The 
prefix or the suffix can contain either alpha letters or numeric numbers. For example, A1, 1A, or 
even DATA07 (consists of the prefix “DATA” and the suffix “07”).

amplitude
The amplitude of an accordion sets the accordion height (for horizontal accordions) or accordion 
width (for vertical accordions). The amplitude is a user-definable number, multiplied by the same net 
trace-to-corner clearance.
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analog board

If the same-net trace-to-corner distance equals zero, then Trace Width is used for the amplitude 
calculation.

See also accordion, gap (accordion)

analog board
A board with mostly discrete components and minimal integrated circuits.

analog circuit
A design composed of discrete components such as capacitors, resistors, and diodes.

angstrom
1/10,000 of a micrometer (10-4um).

annotation (forward and backward)
Forward annotation refers to the process of updating the design file to match the schematic file. 
Backward annotation refers to updating the schematic file to match the design file.

annular pad
A pad shape that enables you to specify an inside and an outside diameter. This creates a donut 
shape because the inner hole was used to center the drill bit when boards were hand-drilled on a 
drill press. Though obsolete, the annular pad is still offered for special circumstances.

annular ring
The conductive pad material surrounding the hole. The annular ring radius = pad diameter-(finished 
hole size) / 2.

antipad
For plane layers, a slightly oversized pad diameter that plots as a clearance for through-hole pins 
that should not connect to the plane.

any-angle coupling trace
Part of a route that connects SBP fanouts to serpentine routes.

aperture
A uniquely shaped window or hole that is attached to an aperture wheel on a photoplotting machine.
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aperture table
A table that matches the line widths necessary to print your design with the plotter setup. SailWind 
Layout can prepare the table automatically, or you can prepare it manually.

Artwork for printed circuit manufacturing is created by exposing clear film to light that is passed 
though the aperture. Although the aperture wheel has been made obsolete by laser plotters, an 
aperture table is still necessary to drive laser plotters.

apl.dcr
A setup file for Novell network security.

application-specific integrated circuit
An IC designed to meet a specific customer requirement.

area select
A method for selecting an object or a group of objects. If you enable area select by clicking Filter on 
the Edit menu, a selection rectangle is created and all items within the rectangle are selected.

array
A group of items, such as bonding pads, that are arranged in rows and columns.

artwork
Clear film with darkened areas representing pads and connecting traces, and used for 
manufacturing a printed circuit board. Each layer of a design has its own unique artwork, such as 
silkscreen and solder mask.

.asc
The file extension used to identify a proprietary PADS-format ASCII file.

ASCII format
A translation format that uses ASCII text to define the PCB design. ASCII format is widely used 
to list the parts and connections in a design, to import and export design items, and to check the 
design for binary corruption.

ASIC
An acronym for application-specific integrated circuit.

assembly drawing
A final design document that provides the part name, type, and orientation for each device on a 
printed circuit board. An assembly drawing is used for assembly of the final product.

assembly variant
A specific manufacturing configuration of a PCB. Assembly variants specify which components 
are used, which are not used, and which are substituted with a different decal part type. Several 
assembly variants can exist for a single PCB.

associated net
See electrical net.
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associating component

associating component
A component through which an electrical net passes.

associating copper
Copper combined with the terminals in the PCB Decal Editor.

attribute groups
A group of structured attributes. For example, the DFT group includes the following attributes:

• DFT.Nail Count Per Net

• DFT.Nail Number

• DFT.Nail Diameter

attributes
Attributes contain information you have associated with an object in your design. Attributes contain 
the types of part information that can be included in the parts library description and exported to a 
parts list. Examples are part manufacturer, package type, order number, and so on.

Auto Dimensioning tab
The tab on the Options dialog box that determines the appearance of newly created dimensions.

automation
A way for heterogeneous applications to communicate with each other. SailWind products make 
some data, such as the database in use, and some functionality, such as opening files or selecting 
objects, available to other applications.

autorouter pass types
Pass types are part of an autorouting strategy that determines how the autorouter routes a design.

Pass Description

Center Places traces equidistant from component pins or vias and each other to evenly 
distribute any available space in the channel.

Fanout Places vias for inaccessible SMD component pins and routes from the vias to the 
pins.

Miters Converts all route corners of a specified angle to diagonal corners.

Optimize Analyzes each trace and tries to improve the quality of the route pattern by removing 
extra segments, reducing via usage, and shortening trace lengths.

Patterns Searches for groups of unrouted connections that can be completed using typical C 
routing patterns, Z routing patterns, and memory patterns and then routes them.

Route Sequentially routes each unroute until all connections are attempted.
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Pass Description

Test Point Analyzes the testability of the design, determines which nets require testing, adjusts 
the routes, and inserts test points to improve testability.

Tune Adjusts the length of length-controlled traces. The Tune pass tunes all routed traces 
with length rules, and automatically adjusts length-controlled traces to meet design 
rules.

axial lead
A connection pin that protrudes straight out from the component body and bends at 90 degrees for 
insertion into the PC board. An axial lead is usually associated with discrete components such as 
resistors, capacitors, or diodes.

back-annotate
Update a schematic file to match its design file.

ball bonding
A bonding technique that provides increased contact between a gold wire and a chip bond pad. This 
method uses thermal compression to melt gold wire to form a ball.

ball grid array
A packaging method that uses a substrate to interconnect one or more die to an array of solder 
alloy spheres.

base part
When making a union, the part type of the first selected part. Base parts can either be left in 
position and joined by secondary parts, or repositioned to imitate the first selected prototype part.

baseline dimensioning
A type of dimensioning in which a series of dimensions have a common start point, such as datum 
dimensioning.

basic units
A basic unit is the smallest unit of measurement in a PADS database. All values in the database are 
stored in binary format basic unit and are converted to the current user units (mils, mm, or inches) 
for screen display. If you need to re-import the information to .pcb  format, export in basic units.

Conversions are:

• 1 mil = 38100 basic units

• 1 millimeter = 1500000 basic units

BGA
An acronym for ball grid array.

BGA fanout
A single-segment fanout that connects BGA array pads to BGA vias. This single-segment fanout 
always ends in a via.
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BGA/PGA decals

BGA/PGA decals
A full matrix decal for BGAs and PGAs, including staggered array patterns.

biased pin pair
A layer biased pin pair is any pin pair with a design rule specifying a layer bias to one or more, but 
not all, electrical routing layers.

blind via
A via that connects an outer layer to one or more inner layers, without passing through all other 
layers of a printed circuit board.

bmp
An image file that can be pasted into documents or other programs such as Microsoft Word. 
SailWind products use the Copy Bitmap command to capture these as screen images.

board markings
Designers usually include identification information on a board. These may include the board part 
number, the assembly part number, the company name, the product name, the revision level, the 
serial number, the copyright notice, an anti-static symbol, warning messages, UL labels, test labels 
and many other types of information. This information may be in ink on the silkscreen layers, in 
copper on the top and/or bottom layer or some combination of the two. These are typically referred 
to as board markings.

Add text to an electrical layer and it will be created in copper. Add text to a Fabrication, Assembly, 
and Documentation Layer and it will be created during the silkscreen process.

Use the Text command to add board markings to your design.

See also Adding Free Text  on page 629

board outline
The actual shape of the printed circuit board, defined by line segments and arcs. The board outline 
is entered on layer 0 and displayed on all layers.

bonding pads
Metallization areas placed around the perimeter of the integrated circuit die, to which aluminum or 
gold wires connect the die to the component package.

bounding rectangle
The smallest rectangle that encloses all nontext graphics on all layers.

breakpoint marker
A small brown dot in the Output window gutter that indicates a breakpoint in a script or macro.

bumped chip
A die or chip that has been specifically processed with buffer metals over the I/O pads, followed 
by an addition of solder or gold bumps to provide bonding areas for direct chip attachment onto a 
substrate.
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buried via
A via that connects only inner layers.

bus
A series of connections that share a common use, such as memory array or data array, and are 
usually routed parallel to each other.

bus routing
Routing two or more pin pairs simultaneously and in close proximity to each other in neat, flowing 
patterns.

C routing pattern
A collection of routes that form a pattern resembling the letter C.  

CAD
An acronym for Computer-Aided Design or Computer-Aided Drafting.

CAE
An acronym for Computer-Aided Engineering.

CAE Decal
The graphical representation of schematic symbols in SailWind products.

CAM
An acronym for Computer-Aided Manufacturing.

CAM document
A combination of plot type and output device you create and save with the design. For example, 
you can include "Silkscreen Top, Photoplot" and "Silkscreen Top, Laser Printer" on your CAM 
Documents List and run them selectively when needed.

CAMDir
The SailWindpcb.ini  file entry that enables you to specify the CAM master folder for creating CAM 
output.

capacitance
The ratio of charge within a trace that is a factor of the trace length and signal delay.
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CBGA
An acronym for ceramic ball grid array.

CBP
An acronym for chip bond pad.

center pass
An autorouting pass that places traces equidistant from component pins or vias and each other to 
evenly distribute any available space in the channel.

CGA
An acronym for column grid array.

chamfered
A rectangle with the square corners cut off to create beveled edges on the corners.

chamfered path
A solid filled copper that, like a trace, acts as a conductor connecting pins and vias similar to a 
trace. But unlike a trace, which is created with a round aperture producing rounded outside corners, 
chamfered path copper allows for sharp specific outlines with a filled interior. When creating a 
chamfered path, you set options to create shapes with square or chamfered corners. The copper 
created by chamfered path has a Solid Copper property which overrides the Copper Hatch Grid and 
Drafting Line Width settings to make it a solid fill. Clearance rules for the chamfered path copper are 
also changed to match the clearance rules of a trace.

checking
Verifying the design meets previously defined rules, such as clearance and connectivity.

chip
An integrated circuit without packaging. A chip is also called a die.

chip bond pad
Interconnect areas on the die on which wire bonds are connected to the substrate.

chip carrier
A square or rectangular IC package, with I/O connections on four sides.

chip on board
The packaging configuration in which a chip is bonded directly to a circuit board or substrate.

Chip Scale Package
A packaging configuration in which the dimension of the substrate is 1.2 times larger than the die.

chord
Half of an accordion.
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See also accordion,amplitude, gap (accordion)

clam shell fixing
A test fixture that tests both the top and bottom side of the PCB.

class
A collection of nets with a common set of design rules.

clearance
The measured space between routed objects such as trace-to-trace, trace-to-pad, or pad-to-pad.

closed cluster
Clusters that you cannot delete or replace during automatic cluster creation.

cluster
In Cluster Placement, a group of parts that must be placed close to each other.

CMOS
An acronym for Complementary Metal Oxide Semiconductor.

COB
An acronym for Chip On Board.

coefficient of thermal expansion
A quantity used to determine the length change of a material due to temperature change. Thermal 
expansion differences between the die and substrate must be considered for quality assurance.

collapse
To relocate the members of a cluster from their current placement to the center of the cluster.

column grid array
Similar to a ball grid array, but columns are used to improve the stresses of different thermal 
expansion between the board and the component.

Com port
Abbreviation for communications port. This port provides a connection between your computer and 
peripheral devices, such as plotters, modems, and other computers.
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combine
Joining lines, or lines and text, together as one selectable object.

component side
The top or front side of a printed circuit board where devices are normally mounted.

composite fanout
A fanout from a pin that is common to two subnets. Often created by autorouting operations.

Composite fanouts provide access to component pins that may otherwise be inaccessible.

See also fanout, subnets

composite rule trace
A trace that is attached to a pin (typically an SMD) shared by two subnets. This type of trace is 
typically created by autorouting operations.

See also composite fanout, subnets

conditional rules
Rules placed on a signal that apply only if the signal is routed near another specified signal. 
Conditional rules are also known as against rules.

conductor
A material that causes heat or electrical current flow. For printed circuit design, a conductor is a 
piece of metal that connects pins of components together.

connected islands
A maximum set of subnet items already connected by a trace, copper unroute, or jumper.

See also subnets, subnet

connections
Points of connectivity, such as a pin pair or a net.

connector
A unique component used to connect a portion of a printed circuit board with other devices.

container application
An application that can incorporate embedded or linked items into its own documents. The 
documents managed by a container application must be able to store and display both OLE 
components, and data created by the application itself. A container application must also allow 
users to insert new items or edit existing items.

When you insert objects into a SailWind product, the SailWind product is the container application. 
When you insert a SailWind file into another application, the other application is the container 
application.
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controlled gap area
The part of the differential pair where the traces are drawn routed in parallel and separated by the 
pair routing gap. The controlled gap zone area starts at the gathering point and ends at the split 
point.

See also gathering point, pair routing gap, split point

controlled gap length
For a differential pair, the ratio of the controlled gap area routing length to the overall routing length, 
in percentage.

See also differential pairs

controlled length net
A net that has length rules, or contains pin pairs that have length rules.

The following high-speed rules are net length rules:

• Minimum/maximum length

• Matched length

• Differential pairs

converting database
The process that converts a non-native file, such as an .asc  file or a .dxf  file, to a PADS native 
format, or .pcb, file.

copper connectivity
Means unroutes are always connected to a copper at some point in the copper outline. A copper 
outline can include arcs. The following graphic illustrates how copper connects to a net.

See also coppers, overlapping coppers
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copper plane
A copper shape with insulation areas around traces and pins that pass through the copper, but are 
not attached or connected to the copper. Can be placed on any layer, except CAM plane layers.

coppers
Polygons on an electrical layer representing an area of the PCB to fill with metal.

When a copper is assigned to a net, it is joined to the net with a trace or via. Coppers are obstacles 
to net objects unless the copper and the net belong to the same net.

See also overlapping coppers, copper connectivity

copy route
The duplication of a trace or series of traces, using copy and paste.

corner
Point where a trace or line changes direction. The Selection Filter enables or disables picking 
geometric or route corners.

cost
Reduces usage of a layer. The higher the cost, the less a layer is used for routing.

cross-probing
Uses a link between PADS programs to reflect, in one PADS application, selections made in 
another PADS application.

cross-reference file
A file that maps design objects between two environments, such as SailWind Layout and PADS 
Designer.

CSP
An acronym for chip scale package.

CTE
An acronym for coefficient of thermal expansion. It is also referred to as TCE.

cutouts
A closed polygon in a copper, copper plane, or board outline. In copper or copper planes, a cutout 
results in an area absent of copper.

See also overlapping cutouts

cycle picking
To sequentially select objects in the vicinity of the selection point using the Tab key.

dangling route
Dangling routes are stubs or spurs off of traces that are not tied to any pin by a ratsnest. See also 
partial route.
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database units
The use of mils, metric, or inches within a design.

datum dimensioning
A style of dimensioning in which all dimensions are measured from a common starting point. The 
origin extension line is marked as zero, with each dimension reflecting the measurement from that 
point.

See also Creating Baseline Dimensions  on page 922

D-codes
Specific numbers assigned to photoplot machine apertures for program identification. D-CODES are 
included in the aperture table.

decal
The physical representation, or footprint, of a part.

decal copper
Open, closed, or associated copper produced within the physical representation of a component.

decal text
Documentation text produced within the physical representation of a component.

default component
The original component, before being replaced in the current assembly variant. The default 
component is always in the raw database

See also active component

default layer mode
A layer mode in which a design can consist of up to 30 electrical layers, or a combination of 
electrical and nonelectrical layers. You change from default layer mode to increased layer mode by 
clicking the Max Layers button in the Layers Setup dialog box.

default.asc
The ASCII file accessed for new file creation. This file provides startup design information such as 
grid sizes, default colors, or other information.

default.cam
A file usually found in the C:\<install_folder>\<version>\Programs  folder that contains default 
apertures, speed and feed settings, and drill symbols for CAM output. This file must exist in the 
same folder as specified by the UserDir variable in the SailWindpcb.ini  file.

See also increased layer mode

defaults
Conditions or options that are set when the SailWind product starts.
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delay

delay
The time it takes for a signal to travel through a trace.

delete
To remove information from a design.

design area
The actual work area where a design is created.

design on the fly
To use ECO Operations to create a new design without first providing a netlist or parts list from 
schematic software. This can also be called design.

Design category
The Options category that controls design conditions, general routing conditions, and certain display 
and part movement method settings.

design rules
Established spacing and general routing constraints for electrical properties, or conductors, which 
are verified by clicking Verify Design from the Tools menu.

devicesn.dat
A file usually found in the C:\<install_folder>\<version>\Programs  folder that contains CAM 
printer and plotter driver data. This file must exist in the same folder specified by the UserDir 
SailWindpcb.ini  variable.

DFM
An acronym for Design for Manufacturing.

DFT Audit
DFT Audit analyzes every net for accessibility (adaptability) and creates a board report that 
identifies all inaccessible (non-adaptable) nets.

dice
The plural of die.

die
A single square or rectangular piece of semiconductor material into which a specific electrical circuit 
has been fabricated.

die bonding
To attach the semiconductor die to the package substrate with epoxy adhesives, gold eutectic, or 
solder alloy. It is also referred to as Die Attachment.

die flag
Metal shapes placed under a die for thermal management and/or electrical connection; also 
referred to as a flower pattern.
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die side of CBP
The side of the die on which the CBP lies. Usually the die side of the CBP is the same as its fanout 
side, but in some cases more complex patterns of wire bond fanout may mean that the two sides 
are not the same.

Die Wizard
This feature creates die part definitions parametrically or imports the die description using GDSII or 
formatted ASCII files. The Die Wizard replaces Component IQ by providing die capture directly in 
the Advanced Packaging Toolkit layout editor. This eliminates the need to transfer .ciq  files.

dielectric
A non-conductor of current; an insulator.

dielectric constant
A value given for manufacturing materials, such as FR-4, to describe electrical characteristics.

differential pairs
A group of two nets or two pin pairs routed side-by-side and separated by the pair routing gap for 
as much of the overall length as practical. A differential pair typically transmits two electrical signals 
that are driven 180 degrees out of phase from each other.

See also pair routing gap

digital board
A board with mostly integrated circuits in proportion to the analog components.

DIP
An acronym for Dual In-line Package.

DisableCaching
A SailWindpcb.ini  file entry that, when set at 1, shuts off graphics optimization and, when set at 0, 
enables graphics optimization.

discrete device
A device that contains one circuit element. For example, a resistor or toggle switch.

disperse
A command that is active on several levels of Cluster Placement. When selected, it clears the board 
of all parts or clusters that are not glued down, and arranges them around the outside of the board 
outline according to decal type.

dispersion routes
Partial routes, ending in vias, which tie surface mount components to plane layers.

do file
The SPECCTRA router ASCII setup file that contains user-defined router commands to initiate 
batch routing.
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dock

dock
To take an isolated application dataset and pull the changes within the dataset into the main design 
project. Any conflicts with the merged data must be manually resolved.

documentation layers
Layers higher than the electrical layers in a SailWind Layout database that contain text and lines to 
illustrate assembly, annotation, and provide instructions for manufacturing.

double-click
Two mouse clicks, in immediate succession, that usually initiate an edit action or complete the 
current action.

double-sided board
A printed circuit board made up of two routing layers, and which has no internal layers.

double-sided die
A die that has substrate bond pads on one side, and a BGA grid array on the other side. The two 
sides are connected through vias.

See also single-sided die

drafting operations
Any operation that involves adding nonelectrical information, not associated with placement or 
routing, to a design.

drawn pads
Photoplot pads, usually finger pads, that are produced by opening the aperture and moving the 
board, with the aperture remaining open, to produce a pad shape.

DRC
An acronym for Design Rules Check.

drill chart
A diagram, produced on a drill drawing, that shows drill symbols matched with drill hole sizes. This 
is also referred to as a drill legend.

drill oversize
A factor applied to plated through holes for DRC purposes to account for drill oversizing during the 
PCB fabrication process.

drill pairs
Primarily for buried and blind vias, drill pairs define which layers are to be drilled and plated together 
during the fabrication process.

drill symbols
Unique symbols on a drill drawing plot that represent the various drill hole locations and sizes.
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drill.dat
A user-definable ASCII file that determines settings for NC Drill output format options. This file must 
exist in the same folder specified by the UserDir variable in the SailWindpcb.ini.

DXF
An acronym for Data eXchange Format, a standard ASCII format for sharing graphics database files 
between different environments.

dxfset.dat
A file that contains the information for drill size and library name equivalents in basic units for the 
DXF Setup dialog box.

dynamic route
To create a route using the Dynamic Route tool, which automatically creates turns and pushes other 
routes aside to complete the connection.

ecad hint.map
A user-defined text file that you create, edit, and maintain. This file enables the replacement of 
approximated parts from SailWind Layout, with geometrically accurate components previously 
modeled in Pro/ENGINEER. This file must exist in either the current working folder or in the Pro/
ENGINEER software loadpoint\text folder.

ECO
An acronym for Engineering Change Order. This refers to a file with netlist changes that needs to be 
annotated to update either the schematic or layout that has become out of sync with the new design 
changes.

ECO mode
A mode that SailWind Layout enters when the ECO Toolbar is open. Changes that affect the 
connection list or parts list can be recorded in a file for backward annotation.

See also ECO

ECO Options
The setup choices available for the ECO output file in the ECO Options dialog box  on page 1352.

ECO registration of attributes
Only ECO-registered attributes, set on the Objects tab of the Attribute Properties dialog box, can be 
added, deleted, or changed during the ECO process. Via attributes are not registered attributes and 
cannot be added, deleted, or changed during the ECO process.

You can modify ECO-registered attributes only in ECO mode.

Non-ECO-registered attributes are never recorded in an .eco  file during ECO operations.

To compare ECO-registered attributes, use the Compare Only ECO Registered Attributes option on 
the Comparison tab in the Compare/ECO Tools dialog box.

EDA
An acronym for Electronic Design Automation.
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EDC

EDC
An acronym for Electrodynamic Checking.

edge
One side of a polygon.

edge die
The two or three rows of dice along the outer circumference of a wafer.

edges
The Selection Filter preference that enables or disables selection of geometric segments.

editing
Any action that modifies a design.

electrical layers
Layers enabled for routing that are checked by DRC.

electrical net
A series of nets connected by one or more components. Length, differential pair and matched 
length rules can be applied to an electrical net as though it were a single net.

embedded objects
An object, including all of its data and the information needed to manage the object, that is 
contained within the framework of, and is a part of, the container application document.

See also linked objects

EnableMacroLanguage
The SailWindpcb.ini  file entry that, when equal to one, enables loading of all macro parameters on 
startup and, when equal to zero, disables loading of macro parameters upon startup.

end component
A component having at least one pin which is a final pin of an electrical net.

end no via
The mode initiated in the routing shortcut menus that, while routing, ends a partial route without a 
via.

end via
The mode initiated in the routing shortcut menus that, while routing, ends a partial route with a via.

end zone
The part of the differential pair between the split point and destination pins.
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The labels in the above graphic correspond to routing that starts at the left-hand set of pins and 
ends at the right-hand set of pins. The label positions are reversed if the routing starts at the right-
hand set of pins.

See also differential pairs, split point

ending layer
The finishing layer for a drill pair or via definition. Enter information about ending layer in the Pad 
Stacks Properties dialog box.

engineering change order (ECO) operations
Any processes that modify the connection list or parts list.

entry angle
The angle at which a route enters a pad.

Esc
To use the Escape or Cancel keys to stop a current action.

estimated total length
The trace length monitor calculates estimated length as the combined total of routed length (Rt), 
plus the routed length for the entire net—including overlapping segments— (Nt), the unrouted 
length (U1) of the trace being routed, and includes half the Discrete length value of each connected 
pin of components that have a Discrete length assigned (not shown).

Overlapping segments are counted only once.

See also routed length, unrouted length
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eutectic solder
A tin/lead alloy (63% tin, 37% lead) that melts at optimum temperatures.

export
The translation command used to convert a design file into PADS-format ASCII or DXF.

extended rules
Clearance, routing, and high-speed rules consisting of classes (one or more nets), groups (one 
or more pin pairs), individual pin pairs, decals, components and differential pairs. Without the 
Extended Rules option, you can assign rules on the net level only.

extension lines
Lines extending from the points being measured.

extents
The limits of the x and y coordinate area that is occupied by all items within a design. This includes 
information external to the board outline, such as dimensions or fabrication notes.

Fabless
A semiconductor company that subcontracts wafer manufacturing because it does not have its own 
wafer manufacturing facility.

fabrication
With semiconductor manufacturing, the front-end process of making devices in semiconductor 
wafers only, not the package assembly or back-end stages.

fanout
A segment of trace or copper shape added to SMD pads to facilitate routing. A fanout typically 
consists of one or more trace segments connecting a component pad to a via, enabling the signal 
on an outer layer to connect to one or more internal signal layers or planes. A specialized repeated 
pattern is often necessary to break out multiple pads on the same component far enough from the 
component to enable easy routing.

Use fanouts to:

• enable on-grid access by autorouters that cannot handle off-grid pads.

• make routing easier, and ensure connections are made.

• connect SMD pins to an inner plane layer using vias.

• connect an SMD pad to an inner signal layer where more routing space is available.

fanout pass
An autorouting pass that places vias for inaccessible SMD component pins and routes, from the 
vias to the pins.
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fanout side of CBP
The side of the SBP Guide to which the CBP should be wire bonded. Usually the fanout side of the 
CBP is the same as its die side, but in some cases more complex patterns of wire bond fanout may 
mean that the two sides are not the same.

FCBGA
An acronym for flip chip ball grid array.

feature size
The smallest line width or spacing between lines or features on a semiconductor die.

feed-through hole
A drilled and plated hole that passes conductivity from one layer to another. This is also called a via.

fiducials
Fiducials are alignment marks, a type of target, used for calibration before placing objects.

There are at least three types of fiducials:

• Panel fiducials  — used for alignment and calibration of images on a multi-board panel.

• Board fiducials  — used align components on a specific board (on or off a panel). Fiducials 
are (typically) round solid targets placed near three corners of each board on each side 
of the board that will receive components. The pick and place system scans the board for 
these targets (shiny circles approximately .040" in diameter) and uses them to align the 
machine before it starts placing parts.

• Component (local) fiducials  — used for close tolerance placement of high pin-count 
components with fine pitch leads. The footprint (PCB decal) of a fine pitch component will 
typically contain two component fiducials at opposite corners of the footprint. This enables 
the pick and place machine to align the fine pitch component exactly on the footprint.

field upgrade
Programming options on your security key by entering in a key unlock code using plicense.exe or 
equivalent.

file sharing
Multiple users accessing the same file or files through a network.

file.dir
The SailWindpcb.ini  file entry that specifies the default location of your design files.

filter
A settings dialog box within that controls which types of objects can be selected.

find
The PADS command that locates, and optionally selects, an object or group of objects in the 
database.
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finger pad
One of many long pads placed in a series to represent an edge connector.

finished hole size
The size of a drilled or routed hole after plating and/or solder reflow has been applied.

flashed pads
Pads produced on a photoplotter by opening the aperture momentarily, without moving the board, to 
produce a pad shape.

flat pack
A component package where the leads extend away from the component and remain on a parallel 
plane with the base of the component.

flip
The command that moves the selected items to the opposite side of the board.

flip chip
An IC designed for face-down mounting by means of controlled-collapse solder pillars on a device's 
I/O bonding pads.

floating license
A method of licensing where a central security server manages a pool of licenses for use by a large 
number of clients.

floating toolbars
Toolbars you can undock from the sides of the application window and place anywhere on screen.

flood
To fill a previously defined copper plane.

flower pattern
Metal shapes placed under a die for thermal management and/or electrical connection; also 
referred to as a die flag.

A ceramic, surface-mounted hermetic package.

FlushUndoBeyondSize
The SailWindpcb.ini  file entry that determines the maximum size of the undo buffer before SailWind 
Layout removes previous commands from the undo buffer to make room for the current command. 
If adding the current command causes the undo buffer to exceed this maximum size, SailWind 
Layout removes previous commands until the undo buffer can store the current command.

follow route
The connections or pin pairs that are part of the bus routing, and which are routed following the 
guide route's path.
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footprint
The arrangement of pads for a given part decal. For example, the footprint of a fourteen DIP is two 
rows of seven pads, spaced 100 mils in the Y direction, and 300 mils in the X direction.

forward-annotate
Update a design file using data from a schematic.

FR-4
An acronym for Fire Retardant Number Four, an epoxy-resin substrate material used in laminate 
applications.

free copper
Open or closed copper that is not associated to other copper or pads.

free disk space
The physical amount of space available on your hard drive that is available for use by programs.

gap (accordion)
The gap of an accordion sets the pitch between chords. The gap is a user-definable number 
multiplied by the same net trace-to-corner clearance.

If the same-net trace-to-corner distance equals zero, then Trace Width is used for the gap 
calculation.

See also accordion, amplitude, pair routing gap

gate
An element of an electronic circuit whereby one or more signals are input, with one output being 
dependent on the state of the input(s) and the type of logic used to interpret the input.

Pin swapping involves exchanging like inputs

Gate swapping involves exchanging the entire element for a like element.

gate array
An IC consisting of a regular arrangement of gates that are interconnected to provide custom 
functions.
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gathering point
The point near the source pins where differential pair traces can start to be routed together at the 
pair routing gap.

The labels in the above graphic correspond to routing that starts at the left-hand set of pins and 
ends at the right-hand set of pins. The label positions are reversed if the routing starts at the right-
hand set of pins.

See also differential pairs

GDI memory
Memory reserved for Windows devices and graphics.

Geometry.Height
This attribute is used to indicate the height of the part. The attribute enables SailWind Layout to 
prevent the component from being placed in an area of the PCB which is height restricted.

In SailWind Layout, you can set board height restrictions for the top and bottom layers in the 
Drafting Options  on page 1553 or area height restrictions using a Keepout area with a “Component 
height” restriction. This attribute is also passed from SailWind Layout to mechanical tools where it 
can be used in 3D simulations to determine whether the part will meet spatial requirements.

In addition to the value, use one of the following units:

• Use the quotation symbol " for inches. The SailWind Layout Attribute Dictionary specifies 
the following limits of acceptable values. Min=0.00000", Max=25.00000".

Example:  GEOMETRY.HEIGHT=3.26548"

• Use the abbreviation mil in upper or lower case. The SailWind Layout Attribute Dictionary 
specifies the following limits of acceptable values. Min=0.00mil, Max=25000.00mil

Example:  GEOMETRY.HEIGHT=12654.83mil

• Use the abbreviation mm in upper or lower case. The SailWind Layout Attribute Dictionary 
specifies the following limits of acceptable values. Min=0.00000mm, Max=635.00000mm.

Example:  GEOMETRY.HEIGHT=123.21348mm

Gerber
The language used to drive a photoplot machine. This language is an ASCII file with instructions for 
selecting an aperture, moving the light source, and turning the light source on and off.

Global tab
Options tab that includes settings that affect an entire design, such as units of measurement and 
pointer size.
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Glue
Anchors component(s) in their current location so they cannot be moved

grab bars
The two vertical or horizontal bars to the left or top of the window.

graphics cache
The PADS setting used to optimize graphics. This is handled by the DisableCaching entry in the 
SailWindpcb.ini  and SailWindlogic.ini  files.

green dot
The status indicator located in the upper left corner of the workspace. It is green when the system 
is idle or ready for operation. It is red when the workspace cannot receive user input, such as when 
producing CAM drawings.

grid
A division of the workspace into measurement steps to facilitate accurate spacing between placed 
parts and routed lines. Also refers to the display; small white dots locating the measurement steps

ground plane
A design layer completely filled with copper, except for clearances around nonconnected pads and 
vias.

group
A collection of pin pairs that share common design rules.

grow
An cluster placement feature that adds additional parts to an existing cluster.

guard band
An octagonal shape that appears at the end of a trace during routing operations whenever the head 
of the trace meets a clearance obstacle that it cannot shove. The guard band only appears when 
online design rules are enabled.

gui
An acronym for Graphical User Interface. The GUI includes such things as menus and commands 
that allow for interaction between the user and the software program.

guide route
A route segment that is used for the first connection and that is the lead for laying down two or more 
pin pairs simultaneously in neat flowing patterns.
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hard rule
A rule that is always followed. See also soft rule, and Hard and Soft Rules.

hard breakout
Use of associated copper within a surface mount decal to simulate a dispersion route. The 
disadvantage to this method is that routing channels will possibly be blocked.

hatch
A copper fill pattern that uses horizontal and vertical lines at a specified width and spacing.

HDI
An acronym for High Density Interconnect.

heat dissipating component
While all components generate heat, these components generally have a published wattage 
rating. Care must be taken to ensure components or materials adjacent to these heat generating 
components do not exceed their max temperature ratings. If more than one of these components 
are used in a design, they should be spread out and should also be positioned to not impede 
airflow.

heat sink
An assembly that serves to dissipate, carry away, or radiate heat into the surrounding atmosphere.

high density interconnect
A class of packaging involving boards, substrates, and components using extremely small trace and 
spacing dimensions.

highlight
A user-defined color, usually white, used to denote that an object is selected.

high-speed checking
Using the Electrodynamic Checking utility. A simulator-type check that finds traces that may run 
parallel to each other close enough, and for a long enough distance, to cause cross talk.

hole plating
A fabrication process where solder flows through a drilled hole to connect the pads on either side of 
the hole, to provide connectivity between two or more layers.

HPGL
An acronym for Hewlett Packard Graphics Language, a standard pen plotter interface language.

IC (Integrated Circuit)
An acronym for Integrated Circuit.

IDF
Intermediate Data Format. An industry standard format used for exchanging data between electrical 
and mechanical design systems.
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IMAPS
An acronym for International Microelectronics and Packaging Society.

impedance
Resistance to the flow of current in a trace. Measured in ohms.

in circuit testing
An exhaustive and thorough test of a PCB in final production that tests nets and unused pins for 
such things as correct voltage, correct parts, or bridging. Test point placement is critical for in circuit 
testing.

inaccessible nets
Nets for which you cannot define test points. DFT Audit analyzes all nets. If DFT Audit determines 
that test probes cannot access them, the nets are inaccessible (also called non-adaptable).

increased layer mode
A layer mode in which a design can consist of more than the default of 30 layers up to a maximum 
of 250 layers. The maximum number of electrical layers is 64, and the maximum number of non-
electrical layers is 186.

See also delay

INI file
An ASCII file, with the .ini  filename extension, that contains startup parameters.

An INI file for Windows might contain the following information: graphics drivers, mouse drivers, 
fonts, and so on.

An INI file for programs might contain the following information: folder structure, display colors, 
default editors, and so on.

inner layers
Design layers other than those on the top or bottom of a printer circuit board. Inner layers may be 
routing layers, plane layers, or a combination of both.

instruction pointer
A small yellow arrow in the Output window gutter that indicates the current line in a script or macro.

insulator
A material used to inhibit heat or electrical properties, such as current flow.

integrity check
A database check runs whenever a .job, .dxf, or .asc  file loads. You can also initiate an integrity 
check while you are working. Type the I modeless command, then press the Enter key.

intensity
A value assigned to objects such as vias to weigh decisions made during the autorouting process 
in SailWind Router. The higher the intensity, the less the item is used. For example, set a high 
intensity for via usage to minimize the amount of vias added to the design.

1834 SailWind Layout Guide and Reference



 
Glossary

interconnect

interconnect
A conductive connection between two or more circuit elements.

IPC
An acronym for Interprocess Communications within the SailWind product.

irregular trace length
Sections or segments of differential pair traces not routed at the pair routing gap.

See also differential pairs

islands
Small, isolated sections of copper plane that are not attached to anything.

JEDEC
An acronym for Joint Electron Device Engineering Council.

Joint Electron Device Engineering Council
JEDEC is the semiconductor engineering standardization body of the Electronic Industries Alliance, 
a trade association that represents all areas of the electronics industry.

jumper
A physical part used to cross over traces on most one layer PCB designs. Jumpers can be 0 Ohm 
resistors or wires stretched between jumper pads.

keepout areas
Areas that automatically ban objects. Depending on the keepout Properties, these areas may be set 
to prevent: placement of components, components that exceed a specified height, component drill 
holes, traces and copper, copper planes, vias and jumpers, and test points.

keyview.exe
An executable file used to list the options programmed into your key. When you run keyview.exe, it 
creates a file named keyview.txt  that contains a listing of your key options.

label
A label is a display instance of a component or jumper attribute. If you want to make an attribute 
visible in the design, you must instantiate it as a label associated with a component or jumper. You 
can do this in the Design Editor or the Decal Editor. You can have multiple labels based on the 
same attribute. An attribute has two parts—a name, and a value. A label of an attribute can have 
one of four visibility settings—None, Value, Name and Value, and Full Name and Value.

Latium rules
Latium rules are for advanced functionality in SailWind Router. Some constraints that you can 
set in Layout are only used by SailWind Router. For examples, see the Tune/Diff Pairs options 
on page 1550, Fanout Rules  on page 1375, Pad Entry Rules.  on page 1564The Latium checks 
include:
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• component clearance rules

• component routing rules

• differential pair rules

• via at SMD rules

layer biased net
A layer biased net is any net with a design rule specifying a layer bias to one or more, but not all, 
electrical routing layers

layer pair
The assignment of two routing layers to switch between using the Layer Toggle command. On two 
layer boards, the toggle is automatically set between 1 (top) and 2 (bottom).

layer toggle
To switch between layer pairs while routing.

layers
A standard CAD database feature that separates graphical information into sheets of similar 
information such as dimensions, construction lines, or text. For PCB applications, this enables the 
various fabrication layers to be created and output separately.

layout-driven design
A PCB design process in which no schematic is created, and both the logical (netlist) and physical 
conformations of the board are defined in a layout tool. Also, a design created using this process. 
See also schematic-driven design.

Layout.rep
The error report file that is created by the database integrity test and which is written to the 
\SailWind Projects  folder.

LCC
An acronym for Leadless Chip Carrier.

lead frame
A sheet metal framework that is etched to form an array of metal traces.

lead pitch
The sum of the lead width and lead spacing.

lead spacing
The distance between a component's adjacent leads.
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Leadless Chip Carrier
(LCC) Ceramic IC package with no physical lead. There are only pads on the bottom of the package 
around the edges.

length matching
A same-length requirement where the entered value represents a minimum/maximum length 
tolerance for nets belonging to the same class.

length minimization
A routing feature that configures unroutes to the shortest available distances, or in a specific 
topology, to facilitate high speed routing.

LGA
An acronym for land grid array.

LibDir
The SailWindpcb.ini  file entry that specifies the location of your library files.

libraries
The collection of part types, part decals, and drawn items included with a SailWind product or 
created by the user.

Library Manager
The SailWind feature that provides access to, and allows for modifying, the library of parts.

linked objects
When an object is linked, a presentation of the object and link to the source is contained within the 
framework of, and is a part of, the container application  document. The object is linked to its source, 
and the source continues to physically reside wherever it was initially created. Therefore, the file 
that contains the object is smaller than if the object were and embedded object. See also embedded 
objects.

Whenever you open the file that contains the linked object, the object checks the source to see if it 
changed since you last saved the file. If the source changed, then the linked object automatically 
updates.

LogCompressionMode
A SailWindpcb.ini  file entry that controls recorded mouse movements in a log file. When set to one, 
the default, recording of compressed mouse movement is enabled. When set to zero, recording of 
all mouse movement is enabled.

logic family
The assignment of an electrical type by name, such as CAP (capacitor) or RES (resistor), to 
indicate the appropriate reference designator prefix such as C or R.

LOGMode
A SailWindpcb.ini  file entry for online macro recording to a log file. When set to 0, the default, 
recording is disabled. When set to one, macro recording is enabled, and the next.log  file is created.
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loop
A pin pair that contains a route that branches off the original route, then branches back into the 
same route to form a loop.

loop routing
Used to create a loop in an existing route.

LPT port
A parallel printer port, usually referred to as LPT1 or LPT2.

macro
Internal objects that are handled using the macro engine vocabularies, and may or may not have 
the automation interface.

Manhattan distance (delta x + delta y)
Used to approximate unrouted net length for BoardSim. Add a percentage multiplier to account for 
indirect routing paths.

masking
The inhibiting of electrical interference between two traces on different layers due to separation by a 
ground or power plane.

material condition
There are three material conditions when creating component decals. They are Maximum (providing 
the most robust solder joint), Nominal (providing a general purpose solder joint) and Minimum 
(providing the least possible solder joint for very dense designs).

MCM
An acronym for multichip module.

memory pattern
A collection of routes between memory devices that form a distinctly repeatable pattern.

menufile.dat
The file containing the structure and text of all lists and shortcut menus. The menufile.dat  file must 
be located in the same folder as SailWindPCB.exe.
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micrometer
One-millionth (10-6) of a meter; about 40 millionths of an inch. Micrometer is synonymous with 
micron.

micron
A term used for micrometer. One-millionth (10^-6) of a meter; 25.4 microns = 1 mil.

microvia
Vias that have a narrow drill hole. Because of their specific diameter to depth ratio, they are typically 
blind or buried vias and do not pass through many layers of the design.

minimum geometry
The smallest line width or spacing between lines or features on a semiconductor die.

miter
A diagonal segment or arc that replaces a corner.

miters pass
An autorouting pass that converts all 90 degree route corners to diagonal corners.

mixed plane layer
A plane layer that contains obstacles other than pads, such as routes, copper, or text.

modeless command
A command invoked through the keyboard. Commands include display options, design settings, 
and mouse click substitutions.

modify
To change information for a selected object.

moiré
Target-shaped objects located in the corners of finished artwork that are used to properly align each 
layer to others for design verification and fabrication.

monolithic device
A device whose circuitry is completely contained on a single die or chip.

mounted side
The side of the printed circuit board, either front or back, on which components are mounted.

mounting holes
Many (but not all) boards have mounting holes. Mounting holes are typically located around the 
perimeter of a board (most often in the corners). They are drilled holes, used to mount a printed 
circuit board to the finished product (for example, a mother board mounted to the computer casing), 
or used to attach bolt-on components to the printed circuit board (for example, stiffeners and ejector 
tabs).
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There are two types of mounting holes: plated and non-plated. Plated mounting holes have 
copper inside the hole and usually have a large annular ring of copper on both sides of the board 
connected by this copper cylinder (plating) inside the hole. These holes are typically connected to 
the GROUND bus or plane on the board and provide a method for grounding the board circuitry to 
the enclosure (for shielding purposes). The mounting hole ring diameter is usually slightly larger 
than the diameter of the head of the screw that will be used to fasten the board to the mounting 
device within the enclosure. Non-plated mounting holes are used for the same purpose, the only 
difference being that they are not internally plated and do not have a copper ring, therefore they are 
not used for grounding the board to the enclosure.

Plated mounting holes cannot be used as tooling holes as the thickness of the copper plating can 
vary and violate the close tolerance required by a tooling hole. Non-plated mounting holes can 
sometimes work double duty as tooling holes because there is no internal plating, therefore the 
tolerance of the hole size can be more closely controlled and fit within the requirements of a tooling 
hole.

Use the Decal Editor and the Pad Stacks dialog box to create tooling holes. Save the single-
terminal object as a part to the library for reuse.

See also Creating and Adding Board Mounting Holes  on page 268 in the SailWind Layout User’s 
Guide and Reference Manual

multichip module
A package with multiple dice that is 20% or more silicon, has 100 or more I/O on a substrate, and 
four or more layers.

multilayer PC board
A design that contains routing and/or plane layers, in addition to those on the front and back side.

nail diameter
The diameter of the test probe.

NC drill
An abbreviation for numerical control drill. This technology involves producing an output file 
containing the x-y location and drill size for each hole, then feeding this information into a machine 
for automated hole drilling.

negative
A photographically produced reverse image of a plane layer. This allows cleared areas, or airgaps, 
to be created using normal drawing techniques. When reversed, all areas not drawn for clearance 
become the actual planes.

nested embedding
Nested embedding occurs when you insert an object using OLE into another object. For example, 
inserting a SailWind Logic schematic into your SailWind Layout Design or inserting a Microsoft 
Word document into a schematic.

nested macros
Macros called from other macros.

net
All pin pairs composing one individual signal. Nets contain at least one subnet, but may contain 
more than one.
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See also subnets

net class
A collection of nets with a common set of design rules.

net length rules
Rules that control a net's or pin pair's routing length.

The following high-speed rules are examples of net length rules: minimum/maximum length, 
matched length, and differential pairs.

The phrase controlled length net refers to nets that have length rules, or nets with pin pairs that 
have length rules.

net name
A specific name given to a net to describe its function; for example, GND, PWR, or DATA0.

The maximum net name length is 47 characters. You can use any alphanumeric characters except 
{ } * and space.

netlist
A point-to-point connection list for each signal in a design, providing the reference designator (part 
name) and pin number.

netlist file
A PADS ASCII file containing all of the nets in a design, including all component pins that make up 
the nets. The file may also contain a list of all parts in a design, and/or the settings that control the 
substrate bond pad numbers and functions for newly created substrate bond pads.

netlist.fmt
The ASCII setup file for the report format that produces a netlist without pin information.

network security
Use of one security key, programmed with multiple options, for network use with one or more 
systems at a time.

next.ini
A file produced in the C:\<install_folder>\<version>\Programs  folder when the SailWindpcb.ini  entry 
LOGMode is equal to one. The next.ini  file is a copy of your SailWindpcb.ini  file at the time next.log 
is written.

next.log
A file produced in the C:\<install_folder>\<version>\Programs  folder when the powerpcb.ini entry 
LOGMode is equal to one. The next.log  file records all activities within a SailWind Layout session so 
that they can be replayed to reproduce a series of steps or used to illustrate a problem.

node
A point along a trace where traces join other traces (T junction), where traces transition to other 
layers, or where traces end at pins, virtual pins, vias, or floating endpoints. Specifically, a node can 
be any pin, virtual pin, via, copper, trace junction, virtual point, or trace end.
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See also virtual point

node-locked
A license for a specific Host ID.

non-ECO-registered parts
These parts are found in the schematic and layout design. Parts not selected as an ECO-
Registered Part on the General tab of the Part Information dialog box are non ECO registered parts.

• A schematic non-ECO-registered part is required in the schematic but has no place in the 
layout of the circuit board. For example, a chip socket shown in the schematic for inventory 
tracking in the bill of materials.

• A layout non-ECO-registered part is required in the layout design but has no place in the 
schematic. For example, a plated and grounded mounting hole.

non-electrical parts
Parts with no pins. For example, a mounting screw shown in the schematic for inventory tracking in 
the bill of materials.

non-plated holes
Pads that are not reflowed with solder, usually reserved for mounting holes. Non-plated holes are 
not drilled with an oversize to accommodate the solder flow.

To determine plating status, in SailWind Layout, use the Pad Stacks Properties dialog box. In 
SailWind Router, use the Pad Stack tab in the Pin Properties dialog box.

nudge
A placement feature that relocates parts to make room for new parts being placed. Movement is 
based on previously defined clearance rules.

object
One discrete item in the design. For example, an object may be a route segment, a part, a drawing 
line, or a via.

object mode
Start a command by selecting one or more objects and then selecting the command to perform on 
them.

See also verb mode
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obstacles
Objects that block routing, for example protected pins, vias, traces, keepouts, and board outlines.

odd pad shape
A pad that requires a special aperture, or plot sequence, to create. In SailWind Layout, in the Pad 
Stacks Properties dialog box, the odd shape setting should not be confused with trying to create a 
custom shaped pad which is accomplished by drawing copper in the decal and associating it to the 
pad.

offline plot
A plot that is sent to a file before it is copied to a printer or plotter for processing.

offset
The distance by which rectangular or oval pads are moved away from the electrical center of the 
pad stack.

offset pads
Rectangular or oval pads moved off the electrical center of the pad stack to facilitate identification/
selection, or for a special design consideration.

one pin nets
A net that contains only one pin. Also called single pin net. In SailWind products, a net must have a 
minimum of two pins.

online DRC
A SailWind feature that actively checks established-design rules during routing or placement 
operations.

online plot
A plot sent directly to a printer or plot.

open cluster
Clusters that you can delete or replace during automatic cluster creation.

optimization
Rearranging placed parts and/or swapping pins and gates on parts to minimize trace lengths and 
reduce the number of vias required for routing.

optimize pass
An autorouting pass that analyzes each route and tries to improve the quality of the route pattern 
by removing extra segments, reducing via usage, and shortening routed trace lengths. This pass 
includes glossing and smoothing processes.

overlapping coppers
Overlapping coppers are combined into one copper area, with possible cutouts.
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See also coppers, copper connectivity

overlapping cutouts
Overlapping cutouts are combined into one cutout area.

See also cutouts

overlapping segments
Multiple trace segments stacked on top of one another on one layer.

package
The protective container for an electronic component with terminals to provide electrical access to 
the die components inside.

pad entry
The point where a trace entering or exiting a pin first crosses the edge of a pad.

pad entry angle
The command in SailWind Layout and Router that establishes the angle at which a trace enters a 
pad. This may be orthogonal (90 degrees), diagonal (45 degrees), or any angle.

pad function
The die signal name to which the component bond pad is connected.
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pad number
The number of the component bond pad.

pad oversize
On plane layers, pads that are larger than normal, to generate proper clearances when the image of 
the pad is printed in a negative format.

Pad oversize is measured from the center of the pad, not the perimeter. For example, if you have a 
3 mil oversize, the measurement is actually1.5 mils in each direction from the center of the pad.

pad stacks
The combination of pads, drills, and pastes, for example, on a pin or via, for each layer of a design, 
stacked directly on top of one another.

pair routing gap
The fixed edge-to-edge clearance between the traces in the controlled gap area for a differential 
pair.

See also controlled gap area, differential pairs.

paired layer
The start and end layers used by the layer toggle command when changing layers while routing. It 
defines the default layers to use when you make layer changes.

palette
A user-definable color chart in the Display Colors dialog box.

pan
Up and down or side-to-side movement of the screen without zoom or redraw. Use the scroll bars or 
postage stamp to pan.

panning
Moving the view horizontally or vertically without changing the size of the design on your screen.

parallel port
A printer port, usually referred to as LPT1 or LPT2.

parallelism
Traces on the same layer that are checked for running parallel to each other.

The traces are subject to crosstalk if they run parallel to each other too long and the gap between 
them is too short.
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parasitic
An undesirable stray capacitance, inductive coupling, resistance leakage, or undesired transistor 
actions.

parent object
The object to which individual design elements, such as lines, arcs, or corners, belong.

part decal
The physical representation of a part, or footprint, assigned to the part type.

part list
An output listing of all parts belonging to the same design. This normally includes the reference 
designation, part name, and part type, and total number of each type.

part name
The text for each part that indicates the reference designator.

part outline width
The line width of 2D line shapes, created in the PCB Decal Editor, that represent silkscreen or 
documentation data within a part decal. The shapes do not include text, reference designators, or 
copper with the decal.

partial route
Partial routes are uncompleted routes where the ratsnest flightline is still visible. This occurs when 
you click End while routing or bus routing, or when you delete a trace segment. See also dangling 
route.

partial via
A via that does not travel through all of the board's electrical layers. The blind via  and buried via  are 
both types of partial vias.

parts1.fmt
An ASCII part list format file for the report file generator that consists of a reference designator, part 
type, and logic type.

parts2.fmt
An ASCII part list format file for the report file generator that consists of a part type, reference 
designator, and part description.

paste
A substance used to attach each pin of a surface mount device to a PC board.

paste mask
An artwork layer with a paste location for all pads of surface mount components.

patterns pass
An autorouting pass that searches for, and routes, groups of unrouted connections that can be 
completed using a typical C routing pattern, Z routing pattern, and memory pattern.
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PBGA
An acronym for plastic ball grid array.

PDF configuration
A set of PDF Configuration dialog box control settings. A PDF configuration can be saved as a .pdc 
file and reused to create PDF documents for multiple designs.

PGA
An acronym for pin grid array.

photoplotting
Using a machine to create printed circuit board fabrication artwork. The machine creates artwork by 
exposing clear film to light or by rasterizing an image onto clear film.

physical design reuse
A collection of design objects that you want to reuse, which are associated with one another. The 
collection of objects can be saved to a file.

physical design reuse elements
The objects that compose the reuse. They can include components, routes, vias, text items, and 
other elements.

pick and place
An automatic printed circuit board assembly machine, driven by outputting the part type, location, 
and orientation of suitable parts from a design.

pin
The through-hole or surface mount terminal that represents a connection to a part. Pins are also 
referred to as pads in pad stacks.

pin array/pin grid array
A package with pins distributed over much or all of the bottom surface of the package in rows and 
columns.

For more information, see Decal Wizard Dialog Box, BGAPGA Tab  on page 1232.

See also pin types.

pin number
Within a component, the numeric or alphanumeric designation that distinguishes pins from each 
other.

In the Status bar, pins are identified using the following format:

Pin:[Component name].[Pin number].[Pin type]

For example:

Pin:Y1.N.Nonelectrical
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See also pin types.

pin pair
The combination of a trace or unroute, and the pins on either side. A net can contain one or more 
pin pairs.

pin pair group
A collection of pin pairs that share common design rules.

pin type
A designation that indicates the electrical characteristics of the pin such as Source (S), Load (L), 
Terminator (Z), and Undefined (U). For example, U1.1.S may appear on the status bar.

pin types
Pins and pin pairs can be identified by one of the following pin types:

• Source

• Bidirectional

• Open Collector

• Or-Tieable Source

• Tristate

• Load

• Terminator

• Power

• Ground

• Nonelectrical

Pin types make up the last portion of the pin identifier in the Status bar. For example:

Pin:U10.C.Open Collector

See also pin number

placement check prints
Generate a CAM Assembly drawing to make a placement check print.

After the PCB Designer receives a schematic and a netlist from an Engineer, they (typically) place 
the components onto the board in a manner that best suits the routing of the board. Sometimes, 
the placement better suits the intentions of the Board Designer than the Engineer, so before 
routing proceeds, the Engineer will request to see a set of Placement Check Prints. Placement 
Check Prints show the placement of all components on both sides of the board, so  the Engineer 

1848 SailWind Layout Guide and Reference



 
Glossary

placement operations
can review the locations and confirm the Designer has correctly placed the components. These 
Placement Check Prints typically require agreement from both the Designer and the Engineer 
before routing can proceed.

placement operations
Operations where parts are relocated or added to a design to optimize an existing placement.

plane hatch outline
The outline of a copper plane shape after it has been flooded to differentiate it from the plane pour 
outline  as originally drawn. When you draw the copper plane pour outline and then flood the shape, 
the outline often changes to accommodate the design rules. You can switch plane display modes 
using the shortcut modeless command PO.

plane layers
A design layer where the entire surface is covered by copper, except for information not connected 
to the plane.

plane nets
Nets assigned to plane layers.

plane pour outline
The outline of a plane shape after it has been drawn to differentiate it from the plane hatch outline 
after it has been flooded. You can switch plane display modes using the shortcut modeless 
command PO.

plastic ball grid array
A surface mount package with an array of solder sphere-shaped interconnects arranged across the 
bottom surface of the package substrate.

plastic leaded chip carrier
A common surface mount package with leads on all four sides, used as a socket for devices that 
cannot withstand the heat of the reflow process, and/or to allow for easy component replacement.

plated holes
Drilled holes that have copper covering the inside surface of the hole, and which are connected to a 
pad on each side. Plated holes pass connectivity from one layer to others.

plating tail
A route that connects BGA vias to a plating bar or bus bar.

PLCC
An acronym for plastic leaded chip carrier.

plicense.exe
The program used to verify and program your security key during a field upgrade process.

polar decal
A single-radius, circular pattern decal with through-hole pins.
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polar SMD decal
A single-radius, circular pattern decal with SMD rectangular or finger pads.

polygon
A closed shape consisting of three or more line segments.

positive
An image of a plane layer where cleared areas, or airgaps, are created using normal drawing 
techniques. When reversed to create a negative, all areas not drawn for clearance become the 
actual planes.

power board
A board that is designed to control power to other circuit boards.

power plane
The plane layer where power supplied to the printed circuit board is dispersed to the proper pins of 
each component requiring a power source.

SailWindpcb.ini
The SailWind Layout initialization file for default settings.

powerpcb.mdb
The SailWind Layout message file that contains error messages, prompts, and other miscellaneous 
text strings. This file must be located in the same folder as SailWindPCB.exe.

powerpcb.reg
A file that defines all Registry keys required for the proper registration of SailWind Layout OLE 
components. In addition, other programs acting as clients access the SailWind Layout Automation 
Server through this Registry file.

The installation program automatically creates this file and saves it in the same folder as 
SailWindPCB.exe.  If errors occur in the Registry, or if this file is corrupted, you can restore the 
contents of the file.

preferred routing direction
In the main GUI combo box, the Horizontal [H] or Vertical [V] designation next to a routing layer 
name. This designation indicates optimal direction for routing completion and can be set by the user 
or the system.

prepreg
A resin pre-impregnated sheet used to bond substrate laminate-pair layers together when a 
multilayer board is pressed together.

preset files
Library IQ files that enable you to save the preference settings you have established for a die 
design and use them in other designs. The Bond Pad Preferences files have a .pre  file extension.
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preview of CBP assignments

preview of CBP assignments
A preview that displays the substrate bond pads and wire bonds created when component bond 
pads are assigned to rings. This preview appears in the work area when the Assign CBPs to Rings 
dialog box is active.

preview of SBP guides
A real-time preview that displays any changes made to the number, geometry, or location of SBP 
guides. This preview appears in the work area when the Wire Bond Wizard dialog box is active.

well as in the design in which you place the reuse.

See also private nets

primary component side
The mounted side of the board when using through-hole components. See also secondary 
component side

primary objects
Primary object groups in the Object View tab of the Project Explorer contain non-removable design 
elements shown in a high-level object hierarchy. Primary objects are:

• layers

• components

• part decals

• net objects (including nets and pin pairs)

• via types

private nets
Nets that are contained completely within a physical design reuse.

See also public nets

probing
The testing of individual IC dice using very fine probes to temporarily connect each to a test 
computer to verify operation.

properties
A set of dialog boxes used to view or edit information about the selected object.

protect
Glues the routes and attached vias and prevents the autorouter from modifying them in any way.

protected routes
Traces that are placed in a protected state by Route Protection. This means that they cannot be 
moved or modified.
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protected traces
Traces placed in a protected state (cannot be moved, or modified).

protected unroutes
Unrouted connections, or the unrouted portion of a partial route, that are placed in a protected state 
by the Route Protection feature. This means that they cannot be routed, moved, or modified.

public nets
Nets that are partially contained within a physical design reuse. Public nets exist in the reuse, as 
preferred routing direction

In the main GUI combo box, the Horizontal [H] or Vertical [V] designation next to a routing layer 
name. This designation indicates optimal direction for routing completion and can be set by the user 
or the system.

pulling an arc
Creating an arc from an existing line segment, where the diameter is derived from the line length.

QFP
An acronym for quad flat package - a surface mount IC with leads on each four sides.

quad
A square-shaped IC with pads on each of its four sides.

Quick Filter Settings
The shortcut menu selections available when no items are selected. These choices set the 
selection filter for commonly used tasks, enable quick access to the Find command, and Select All 
items as specified by the Selection Filter.

quick measure command
The Q modeless command  which attaches a measurement line to the pointer and displays dx, dy 
and hypotenuse information, depending on pointer movement.

radial lead
A discrete part with pins that protrude straight down and do not extend beyond the perimeter of the 
component body. An example of this is a capacitor.

RAM
An acronym for Random Access Memory. The volatile (on chip rather than on disk) memory area 
available to the system for program operation.

range select
To select a series of geometric or route segments by first clicking on the start segment, then 
pressing and holding Shift and right-clicking on the end segment.

ratsnest
A term used to describe the display of all of the unrouted connections in a design. Also known as air 
lines or unroutes.
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raw database

raw database
The raw database contains all components in the open database, regardless of assembly variants. 
When created, new assembly variants are based on the raw database, meaning that until you 
uninstall or substitute, a new assembly variant includes every component in the raw database.

read-only attribute
An attribute whose value cannot be changed in SailWind product dialog boxes. You can, however, 
modify attribute properties and the Attribute Dictionary entry, and can modify the attribute value in 
the library.

real width
To display traces at their specified width, as opposed to displaying them as one pixel centerlines.

real-time redraw
A feature that enables active regeneration of objects in the display any time the screen is redrawn. 
When you disable real-time redraw, regeneration occurs in the background, and the display is 
refreshed all at once after the background regeneration process is completed. Screen regeneration 
is quickest when real-time redraw is disabled.

record locking
Allowing two or more users to access the same library component at one time. However, only one 
user has access to save the component.

recover
Resolving an installation or operational issue, or salvaging a corrupt database by executing a 
specified series of steps.

redo
Repeats actions which have been undone.

redraw
Refreshes the display of the current screen image and the cursor.

reference designator
An identification assigned to each of a design's parts to distinguish them from other parts of the 
same type when placed on the printed circuit board. A reference designator is usually in the form 
of a letter that represents the part type, followed by a number. For example, C2 may represent the 
second capacitor in the design. SailWind Layout permits you to renumber the reference designators 
in one of several specific patterns enabling you to quickly find a part among thousands on the 
manufactured board. The reshuffled numbers that are rearranged in SailWind Layout are backward 
annotated to the schematic software to keep the designs synchronized.

relative coordinates
Coordinates that are based on a start point instead of the system origin.

rename
To assign a different name to a part or net.
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reroute
Specifying that a trace, or a portion of a trace, follow a path different than the one currently being 
taken.

restricted layer
Layers that are either disabled for routing or have been disallowed by layer biasing rules. When a 
layer is restricted, routing is not permitted on the layer. Layers can be restricted for specific objects, 
such as a net or a pin pair.

restricted via
A via that is not permitted for use in the Routing Rules  on page 1666 of SailWind Layout or Via 
Biasing properties  in SailWind Router at any level of the rule hierarchy.

reuse
See preview of CBP assignments.

reuse definition
The master copy of the physical design reuse that is saved to a file. The saved version of the 
physical design reuse is the version you should use in other designs. All resulting instances of the 
physical design reuse are based on this file.

reuse type
A name that identifies the type of reuse being created. A reuse type is equivalent to a library part 
type.

ring geometry
The shape of the die flag ring. The following shapes, or ring geometries, are supported: rectangle, 
rounded rectangle, chamfered rectangle, and arced shape.

romansim.fnt
The default file that contains definitions for the graphics for the SailWind stroke font, used to display 
text in SailWind products when system fonts are not in use.

rotate
The command that rotates by 90 degrees a component or object around its axis or selection point.

route
To create a metal etch trace of a specified width between pads.

route-completion target
This crosshair or bullseye symbol appears when routing from one pin of a pin pair to another pin or 
when rerouting a trace segment.

The partial target appears when you are overtop of an electrically compatible pin, but you have 
settings that are preventing you from routing to it - for example, the unroute of the pin pair you are 
routing is protected (you have selected the Protect Unroutes check box in the Pin Pair Properties  on 
page 1627).
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route loops

route loops
A pin pair that contains a route that branches off the original route, then branches back into the 
same route to form a loop.

route pass
The autorouting pass that is the core pass that performs the majority of autorouting. During 
this pass, SailWind Router attempts to sequentially route each unroute until all connections are 
attempted. The Route pass contains serial, rip up and retry, push and shove, and touch and cross 
processes.

routed length
The trace length monitor calculates routed length as the cumulative length of the trace. Includes 
half the Discrete length value of each connected pin of components that have a Discrete length 
assigned. If you start routing from the endpoint of a partially routed trace, the routed length includes 
the partially routed trace length. If the trace has branches, then the length is calculated from the 
branch point.

See also estimated total length, unrouted length

routes
A series of traces that represents routed connectivity.

routing angle
The angle applied to adjacent segments as new corners are added to traces. For example, an 
orthogonal routing angle means adjacent segments will be created at 90-degree angles to each 
other.

routing order
The order in which the autorouter routes components, nets, and net classes.

routing pass types
There are several pass types, each of which is designed to complete a specific task. Each pass 
may use more than one algorithm and may also perform a number of subpasses.

• center pass

• fanout

• miters pass

• optimize pass

• patterns pass

• route pass

• test point pass

• tune pass
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routing strategy
The collective information SailWind Router uses to autoroute a design. This information includes 
which pass types SailWind Router should perform, whether to protect  the resulting traces, and what 
intensity  to assign to objects.

ru.cfg
A configuration file used by the nrus.exe program for Novell network security support.

rule values
The values of any item, regardless of its default rules or rules set assignments.

rules
An established set of conditions for a given net or design.

rules set
A specific set of user-assigned nondefault rules such as pin pair, groups, or classes.

same net checking
Checks clearances between objects along the same net, as specified in the Clearance Rules dialog 
box. Object to object checking includes:

• Pad edge to pad edge.

• Pad edge to inside corner of trace.

• SMD edge to pad edge.

• SMD edge to inside corner of trace.

This check prevents solder bridging during board manufacturing caused by acute angles between 
conductive objects such as the acute angle between pad and trace shown below.
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same net rules

same net rules
Specifying conditional settings, such as spacing, for connections belonging to the same signal 
name or net, rather than against other nets.

SBP
An acronym for Substrate Bond Pad.

SBP fanout
A single-segment fanout that connects SBPs to any-angle coupling traces.

SBP guide
The virtual snap line along which substrate bond pads are aligned during wire bond fanout 
generation. Each SBP guide determines the alignment of the substrate bond pads that are 
associated with the SBP ring aligned with this SBP guide.

SBP ring
A set of substrate bond pads aligned along an SBP guide. A substrate bond pad belongs to the ring 
on which it is aligned. In creating a wire bond fanout, you assign each component bond pad to a 
specific SBP ring.

schematic-driven design
The “standard” PCB design process, in which a netlist is first created in a schematic tool, and then 
passed to a layout tool, where the parts are laid out on the board and the connections routed. See 
also layout-driven design.

scribe line or saw line
The separation between adjacent dies on the wafer. This path is used as the cutting area in sawing 
a wafer into the individual dies.

search
To locate specified information. One search method is to use the Find command.

secondary component side
The side opposite the mounted side for through-hole components. This side is typically wave 
soldered.

See also primary component side

secondary objects
Secondary object groups break primary objects into a more detailed hierarchy. You can add 
individual items to and remove individual items from secondary groups. Secondary objects include:
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• net class

• pin pair group

• conditional rule

• matched length net group

• matched length pin pair group

• differential pair

seed
A part used by Cluster Placement, during cluster building, to search outward for other parts to add 
to the cluster.

segment
A single drafting line, path, or trace, defined by a beginning x/y coordinate and an ending x/y 
coordinate.

segmentation fault
The termination of a SailWind product due to a system crash or illegal instruction executed.

Select All
The Edit menu command that lets you select all items of a type specified in the Selection Filter. This 
option is also accessible from the shortcut menu when nothing is selected.

select mode
Point to the object and click the left mouse button. Select the command to perform on the object.

selecting
To highlight an object for editing, moving, viewing properties, or deleting.

selection filter
The dialog box inhibiting or enabling the selection of specific items.

serpentine route
A route that connects an any-angle coupling trace and a BGA pad, forming a snake-like pattern as it 
travels through the BGA.

session log
Information on the current session that appears in the Status tab of the Output window.

shape
The Selection Filter setting that enables or disables selection of an entire geometric object, not just 
its individual segments.
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shared libraries

shared libraries
Libraries that can be accessed by more than one user across a network.

shielding
Specifying that one net be routed around another to provide protection from interference.

shortcut keys
A key sequence that starts a command directly from the keyboard and without navigating through 
menus.

shortcut menu
A menu listing the possible actions to perform, based on the selected object.

shoulder
The part of the differential pair trace between the source pin and the gathering point, or between the 
split point and the destination pin.

See also differential pairs, gathering point, split point.

signal
Voltage or current that is transferred between component pins by an electrical conductor.

signal pins
Pins that have a signal net, such as GND, assigned by the schematic capture program SailWind 
Logic during part type creation.

signal via
Via used to continue a signal from one layer to another.

silkscreen
An artwork layer containing the reference designator and component outline of all parts, used for 
the final board fabrication process.

single-sided board
A design where all pads, routing, and parts are placed on one side of the board.

single-sided die
A die that has substrate bond pads and a BGA grid array on the same side of the die.

See also documentation layers

sizing handles
Small, black squares that appear at the corners and along the sides of a rectangular area that 
surrounds a selected nontext object.
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sketch route
A SailWind Layout command that reroutes existing traces by enabling you to draw a new route path 
using the pointer.

slice
Another term for wafer.

slotted holes
Oval holes in a printed circuit board, which may be plated or non-plated.

SMD
An acronym for Surface Mounted Device: the pin of a component that is attached to the PCB only 
on an outer surface and does not require drilled holes for component mounting.

smoothing
A command that automatically removes unneeded corners and segments and centers trace 
patterns between route obstacles.

SMT
An acronym for Surface Mount Technology.

snap modes
Various modes, available during dimensioning, that force the pointer to pick points based on of the 
following parameters: intersection, any point on a line, any point in space, entire segments, the 
center point of an arc, and so on.

soft rule
A rule that is ignored if it alone prevents route completion. See also hard rule, and Hard and Soft 
Rules, in the SailWind Router Guide.

SOIC
An acronym for Small-Outline Integrated Circuit.

solder
A metal alloy used to attach each pin of a device to a printed circuit board.

solder dam
A small amount of solder mask used to limit molten solder from spreading further onto solderable 
conductors, in an area where solder mask is purposefully absent.

solder mask
The artwork layer for a nonconductive material that covers the entire board, except for pad 
locations. The solder mask provides a protective covering and prevents shorts during wave and 
reflow solder processes.

solder mask reliefs
Some components have large areas that need to dissipate heat. Others have large metallized areas 
(that are not pins) that need to be soldered to the board. To expose the copper area beneath these 

1860 SailWind Layout Guide and Reference



 
Glossary

solder side
parts for soldering, the solder mask layer must have a cutout representing these areas. These 
cutouts are called solder mask reliefs. When the distance between pads of a fine pitch component 
is too small, the webs or fingers of solder mask between pads can break and wander on the board 
surface. To prevent this, a solder mask relief is applied to entire pad areas of a component. This is 
commonly called gang relief or a gang opening.

solder side
The back or bottom side of a printed circuit board. Solder side is named for the post assembly 
process, where the board is run through a special bath to solder all pins.

source
A pin type that indicates a signal radiating from the pin.

SPECCTRA
The product name for the Cadence Design Systems autorouter.

special symbols
Alternate decals that you specify as connectors. You can associate a logical pin type with each 
alternate to provide a graphical indication of the connector pin function in a schematic.

spider bonding
A method of connecting an integrated circuit die to its package leads. A lead frame is placed over 
the chip and all connections are made by just one operation of a bonding machine. TAB  methods 
use this approach to interconnection.

spin
The command that rotates a component or object around its axis or selection point.

split
The command that creates a new corner at the pick point of the selected trace, enabling it to be 
rerouted.

split plane
A solid copper plane layer divided into two or more sections to isolate electrical signals from each 
other.

split point
The point near the destination pins where differential pair traces are no longer routed together and 
where the traces are routed individually to completion.

See also differential pairs, pair routing gap
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ssiact.exe
A program used to recommend set statement settings to properly adjust port access times for a 
security key.

stackup
The metal and dielectric layers used to implement the body of a printed circuit board. A signal metal 
layer carries signal traces. A plane metal layer is tied to a DC voltage. A dielectric layer is made 
from non-conducting material and separates two metal layers or coats the board surface.

start zone
The part of the differential pair between the source pins and gathering point.

See also differential pairs, gathering point

starting layer
The first layer in a drill pair or via definition.

step-by-step mode
A mode in which the debugger runs a single line of code at a time.

stitching vias
Any SMD via, through-hole via, or partial via added to nets (on traces or within plane areas) in a 
repetitive manner. You can add these vias, also called free vias, for various purposes, including 
current and thermal needs. For example, you can place stitching vias in a plane area to provide 
conduction between two plane areas. You must assign stitching vias to a net, but they do not have 
to have traces attached to them.

strategy
A set of options that defines how a board should be autorouted.

strong
Places cluster members as close together as possible during placement operations. The minimum 
distance for placement is the same as the distance for part clearances in Design Rules.

structured attributes
Attributes that are related to each other by the prefix in their name. For example, the DFT attributes 
such as DFT.Nail Count Per Net, DFT.Nail Number, and DFT.Nail Diameter are structured attributes. 
Together, these structured attributes make an attribute group.
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stub
A trace that enters another to create a T-junction. Stub lengths can be checked by the EDC 
program.

submicron
Dimensions smaller than one micron.

subnet
A collection of all traces and vias connecting two pins. Subnets are joined only through their 
common component pins and not through other nodes, such as a trace junctions, vias, or virtual 
points.

Subnets help to avoid errors or confusion caused when pin pairs of a net have unique, rather than 
common, design rules.

See also node, subnet, connected islands, virtual point.

Figure 225. One subnet in a net

subnets
If a net has at least one pin pair with a unique design rule, such as a trace width difference, the 
net is automatically divided into subnets. If two pin pairs having the same rules are separated by 
at least one pin pair with different rules, the pin pairs are considered separate subnets. Therefore, 
subnets are islands of pin pairs that form an unbroken fragment within the net, where each fragment 
has uniform rules.

See also differential pairs, differential pairs.

Figure 226. Multiple subnets in a net

substrate
A material between copper laminate layers that comprise a laminate pair, or a laminate set in the 
case of completed multilayer boards.

substrate bond pads
Copper areas on the substrate to which a die's wire bonds are connected.
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surface mount device
Pads are glued to the board rather than inserted.

swap file
The file created when a program runs out of RAM memory and writes memory to disk.

swapping
A placement optimization process that exchanges pins, gates, or entire parts.

The product .ini  file entry that specifies the path for the SailWind product configuration files.

system attribute
An attribute that is set by, used by, and critical to a SailWind product, an external program, or 
Automation script (such as Sax Basic). You cannot modify the properties of a system attribute or 
modify the Attribute Dictionary entry for a system attribute.

system toolbars
System toolbars are specific to the PADS programs. They feature several system toolbars, such as 
standard, routing, selection filter.

SystemDir
The product .ini  file entry that specifies the path for the SailWind product configuration files.

T junction
A trace that branches into another.

TAB
An acronym for source.

tacks
Small, diamond-shaped objects that anchor traces to their current location. Tacks are automatically 
generated under certain conditions and may also be manually added to a selected trace.

tandem traces
Traces on different layers that are checked for running parallel to each other.

The traces are subject to crosstalk if they run parallel to each other too long and the gap between 
them is too short.
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Tape Automated Bonding (TAB)

Tape Automated Bonding (TAB)
A packaging method where silicon chips are joined to patterned metal traces, or leads, on polymer 
tape to form inner lead bonds which are attached to the next level of the assembly, typically a 
substrate or board.

Tape Ball Grid Array (TBGA)
A TAB packaging method in which tape automated bonding leads are replaced by a ball grid array.

TBGA
An acronym for Tape Ball Grid Array (TBGA).

teardrop
A triangle shape that provides a smooth transition from a trace to a pad.

tented vias
Vias that are covered by solder mask on both sides of the board to seal the hole and protect it from 
wave solder.

terminal
The electrical center of a pin, as defined in the part decal.

terminator
A pin type for high-speed circuit configurations that indicates a terminating resistor to match 
impedance of the trace. Terminators are used to reduce signal reflections that cause poor circuit 
performance.

test point
A test point is a group of objects that serve as a contact between the electrical element of the board 
and the probe of the testing device. A test point can also be a point on a node of a net, component 
pin, or via. Test points can also be a point on an unused component pin, such as a component pin 
that is not incorporated into any net.

When the via or pin is flagged as a test point, and Show Test Points is checked on the Routing tab 
of the Options dialog box, a down arrow symbol is drawn on the via or pad in the design:

test point pass
This autorouting pass analyzes the testability of the design, determines which nets require testing, 
adjusts the routes, and inserts test points to improve testability. You can select whether to add test 
points during routing or after routing.

testpnts.fmt
An ASCII file containing information about test points, including the test point name, the signal 
name, and the x/y coordinates. The report file generator creates this file.
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thermal
A multi-spoke connection of a through hole pin pad, via, or surface mount pad to a copper plane.

thermal compression bonding
A method of wire bonding that does not use an intermediary metal or melting, but rather the 
flow of materials resulting from the combination of heat and pressure. It is also referred to as 
thermocompression bonding.

thermal relief
A spoke-shaped pattern that connects a via or pin, in the same net as the copper plane, to the 
surrounding copper. Thermal reliefs provide good pin soldering by preventing heat from dissipating 
throughout the plane layer.

thermal via
Via used to dissipate heat from an area or component.

thick-film process
A hybrid microelectronic process where conductors, insulators, and passive components are 
screened from special pastes onto the substrate.

thin-film process
The use of deposited films of conductive or insulating material, which may be patterned to form 
electronic components and conductors on a substrate or used as insulation material between 
successive layers of components.

three-state check box
A three-state check box helps to identify the state of the check box in a collection of objects.

Check box Description

Cleared check box. The item or collection of items all have the check box in the 
cleared or unchecked state.

Selected check box. The item or collection of items all have the check box in the 
selected or checked state.

Indeterminate or mixed state check box. The collection of items have different 
states of the check box.

through holes
Although there are non-plated through holes, this term is used interchangeably with plated through 
holes. It indicates that the hole has internal plating. There are two basic types of components that 
can be placed on a circuit board: Surface Mount Technology (SMT) where the parts are soldered 
to the surface of the board, and through hole (TH) components, where the components have wire 
leads that are soldered into plated holes that go through the board (sometime written as thru-holes).

through-hole via
A via that passes through all electrical layers of the PCB design (as opposed to a partial via).

This is sometimes also called a through via.
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tooling holes
Every board requires at least two tooling holes that the blank board manufacturer uses for layer 
alignment purposes during the manufacturing process. If you do not include them in the design, 
the manufacturer will add them to the board. Tooling holes are typically .125" non-plated holes with 
a tolerance of +/-.002". If the board is so small that the tooling holes will not fit, the manufacturer 
will add them to an area outside of the board outline. (These would typically get removed after final 
assembly.) There are two types of tooling holes: board tooling holes and panel tooling holes. Most 
boards are manufactured by stepping and repeating the single board image onto a larger panel so 
that multiple boards can be processed on a single panel. So, the board tooling holes are used for 
alignment purposes for individual boards, while the panel tooling holes are used for alignment of the 
entire panel during the manufacturing and assembly processes.

Use the Decal Editor and the Pad Stacks dialog box to create tooling holes. Save the single-
terminal object as a part to the library for reuse.

See also Editing Pad Stacks  on page 188

ToolTips
ToolTips appear below buttons and provide a command name or description for the buttons.

topology
The pattern of the trace and the order in which to connect pins in a net.

total length
The current routed length plus the total Manhattan length for remaining unroutes of the electrical net 
or pin pair. Includes half the Discrete length value of each connected pin of components that have a 
Discrete length assigned.

Total length is reported for pin pairs when all the following are true: length rules are defined for the 
pin pair, the electrical net is a high-speed net, and copper sharing is disabled.

If pin pair rules are reported, the estimated total length of the pin pair is shown; otherwise, total 
length for nets is reported.

trace
A line segment that represents physical etch. A trace can appear as a single pixel line or as a 
double line to indicate its actual width.

trace corner
The vertex at which two trace segments are joined. A trace corner can also be the endpoint of a 
partially routed trace. The trace segments may be in line.
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trace paths
A continuous sequence of trace segments in the same trace on the same layer. Paths start and end 
at nodes, and cannot pass through a node.

trace segment
One section of a trace. A trace segment has one starting point and one ending point. A trace 
segment can be arced.

Trace segments are contiguous when they are joined end to end, in one continuous path, and 
belong to the same trace.

transparent layers
The mode that displays layers in a see-through mode so you can view multiple objects stacked 
upon each another. This is the modeless command T.

TrueLayer
The default mode of operation in SailWind Layout whereby an object on a documentation layer 
moves with a component if the component is moved from one side of the board to the other. For 
example, when you place a component on the top layer of the board, the reference designator of 
that component is visible on the Silkscreen Top layer (the documentation layer associated with the 
top layer of the board). Moving the component to the bottom side of the board automatically moves 
the reference designator for the component to the Silkscreen bottom layer.

TrueLayer also correctly plots paste masks of documentation-level pad shapes in CAM. The layer 
that the definitions move to is set in the Component Layer Associations dialog box  on page 1189.

By default, TrueLayer mode is enabled. To disable it, use the /NTL command-line switch. See 
Software Launch Options  on page 50.

TTL
Acronym for Transistor-Transistor Logic.
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tune pass
This autorouting pass adjusts the length of length-controlled traces. The pass examines trace 
lengths for only completely routed nets or pin pairs. The pass analyzes the current length of each 
net or pin pair if length rules and length control are enabled, based on the following conditions:

• If the cumulative length of the adjacent trace segments is within the range of minimum and 
maximum trace length, the tune pass skips the trace and does not adjust it.

• If the trace is longer than the maximum trace length, the tune pass rips it up and places it in 
a queue for routing.

• If the trace length is less than the minimum trace length, the tune pass changes the length 
by adding accordion patterns.

ultrasonic bonding
A wire bonding technique that uses ultrasonic energy and pressure to form the bond without heat.

underfill
Material injected under the die to ensure interconnect reliability against cross-reference file 
mismatch between the die and the substrate in a flip chip  configuration.

undo
A command that enables you to remove the effects of the last command invoked.

undock
To isolate an application dataset from the main design project so it can be edited regardless of the 
network or the physical location of the dataset. The isolated dataset has no dependence on the 
main design project.

UndoMemorySize
The SailWindpcb.ini  file entry that limits the maximum size of the buffer that is used to store ECO 
operations for Undo.

unions
Parts assigned to each other in fixed relative positions using Cluster Placement. These positions 
are maintained whenever a union is moved in Cluster Placement. A common example is the 
relationship between bypass capacitors and ICs.

units of measure
A commonly used set of measurements.

unroute
To convert a trace back into a connection.

unrouted length
The trace length monitor calculates unrouted length as the distance from the endpoint of the current 
trace segment (attached to the pointer) to its destination.

The unroute length calculation depends on the current routing angle:
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Routing mode: The calculation:

Orthogonal Manhattan Length

Diagonal   The length of the shortest diagonal path between unroute ends

Any Angle Point-to-point distance

The unrouted length is recalculated as the unroute dynamically reconnects to connection points. 
The routing angle also effects this calculation.

See also routed length, estimated total length

unroutes
Thin, straight segments joining pins or coppers to indicate connectivity. Also called a link.

unused pins
Pins that are not connected to a net.

UserDir
An .ini  file setting that specifies the path for SailWind product configuration files.

verb mode
Start a command by attaching a command to the pointer and then selecting objects to which you 
apply the command.

You can enter verb mode by selecting a command when no objects are selected. A small V 
attaches to the pointer to show that the selected command is active. The command remains 
attached to the pointer until you cancel verb mode.

See also object mode

vertex
A single point in the work area, defined by x and y coordinates.

via
A drilled and plated hole that passes conductivity from one layer to another.

via pair
A pair of vias used to change the routing layer for a differential pair when routing the controlled gap 
area.

See also via, differential pairs.

via type
A via or virtual pin padstack definition that is defined and named in SailWind Layout in the Pad 
Stacks Properties dialog box.

victim net
Nets that are interfered with by those tagged as aggressor nets during High-Speed or 
Electrodynamic Checking.
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virtual memory
Writing memory areas to disk in the form of a swap file when RAM is filled. The size of the swap file 
is based on the free disk space or the limits imposed by the operating system.

virtual pin
A net object that, like a component pin, serves as a pin pair end, but uses the pad stack of a via. 
The pad stack can be through-hole or partial, or it can be a single-layer pad.

virtual point
A point along a trace segment that identifies a change in design rules, usually between trace rules 
and component rules. Virtual points are inserted into nets automatically when necessary, usually 
during autorouting operations. You cannot create, position, or otherwise edit a virtual point.

See also subnets

Visual Basic
Visual Basic is a scripting language developed by the Microsoft Corporation to enable users to 
customize applications using a standard scripting language.

visual editing
Visual Editing occurs when the source application for a linked or embedded OLE object opens 
within the container application.

wafer
A thin disk of semiconductor material (usually silicon) on which many separate chips can be 
fabricated.

wafer sort
The electrical testing of each die on the wafer  while still in wafer form.

WB
An acronym for wire bond.

wedge bonding
A form of thermal compression wire bonding where the bond shapes the wire into a wedge shape.

width
The thickness of a trace or line.

wire bond
Fine wires, usually aluminum or gold, connecting the bonding pads on a die to the component 
package.

Wire Bond Editor
The Wire Bond Editor opens (explodes) a selected die part, so you can move, add, delete, and edit 
individual component bond pads and wire bonds in addition to substrate bond pads. You can also 
edit the die size.
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wire bond fanout
A pattern of wires (typically gold) that arc out from component bond pads to substrate bond pads to 
provide connectivity between the die pins and the substrate package pins.

Wire Bond Wizard
A BGA toolbox feature that creates and places substrate bond pads and generates an automatic 
wire bond fanout between component bond pads and substrate bond pads.

wire bonder
The machine that connects wires between the chip bond pads and the substrate bond pads.

wire bonding
The process of electrically connecting a chip to the next level package with fine wires. The wires are 
either gold or aluminum.

workspace
The actual work area where a design is created.

yield
The ratio of the number of acceptable units to the maximum number possible.

Z routing pattern
A collection of routes that form a pattern resembling the letter Z.

zoom
Modifying the view to make objects appear larger or smaller. Zooming in or out affects the amount 
of what can be viewed in the work area.

See also protect.
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Third-Party Information
Details on open source and third-party software that may be included with this product are available in the 
<your_software_installation_location>/ThirdParty directory.
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